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New features

New Features in Version 4.3.0

Splitting notes by duration
● You can now split notes into multiple, shorter notes. See Splitting notes by duration.

Repeat barlines
● When you add start repeat barlines to a range of selected items, Dorico SE now 

automatically adds end repeat barlines at the end of the selection. See Inputting barlines 
with the popover and Inputting barlines with the panel.

Restorative clefs
● When you add clefs to a range of selected items, Dorico SE now automatically adds 

restorative clefs at the end of the selection. See Inputting clefs with the popover and 
Inputting clefs with the panel.

Layout transposition token
● A new token that displays whether layouts are concert or transposed pitch is available. It 

uses your instrument language setting by default, but you can override the text in each 
layout independently. See Tokens and Editing layout transposition text.

Key Editor improvements
● You can now show multiple instruments in the Key Editor simultaneously, allowing you 

to input data, such as MIDI CC points, for all selected instruments simultaneously. See 
Showing instruments in the Key Editor.

● You can now copy MIDI CC and dynamic points from the primary instrument in the Key 
Editor to all secondary instruments, making it easy to sync data across tracks. See Copying 
dynamic points to other instruments and Copying MIDI points to other instruments.

● The Histogram and Transform tools are now available in the MIDI CC editor, in addition to 
the Velocity editor. See Histogram tool and Transform tool.

● You can now save configurations of editors in the Key Editor, allowing you to open those 
editors again quickly. See Key Editor configurations.

Chord diagram fingering improvements
● When editing chord diagram fingerings, you can now enter 0 to show no fingering and T 

for thumb fingerings on the lowest string. See Edit Chord Diagram dialog.

Lyric improvements
● It is now possible to export all lyrics in the project as plain text. See Exporting lyrics.

Text improvements
● You can now select different border styles for text items. See Changing the style of text 

item borders.

Tremolos in tie chains
● You can now specify that single-note tremolos should not appear on the first or last note in 

tie chains when inputting tremolos. See Tremolos in tie chains, Inputting tremolos with the 
popover, and Inputting tremolos with the panel.
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New Features in Version 4.2.0

Key Editor improvements
● MIDI CC, MIDI pitch bend, and dynamic points are now copied automatically when you 

copy the notes to which they apply. However, you can disable this behavior if required. See 
Disabling automatic copying of MIDI data when pasting.

● The percussion editor has been returned to the Key Editor. You can also now use the 
Drumstick tool to input notes with a different rhythmic duration for each unpitched 
percussion instrument independently. See Inputting notes using the Drumstick tool.

New Features in Version 4.1.0

Color improvements
● A new Colors page has been added to Preferences. It includes new options that allow 

you to control colors used for various purposes in the music area, including the first eight 
voices on each staff, and to invert music/page colors, which by default shows white music 
on a black background. See Changing music area colors and Inverting colors.

Printing/Exporting flows
● You can now specify the flows that you want to print or export. Dorico SE then prints/

exports all pages on which the selected flows appear. See Print Flows dialog.

Properties panel
● You can now activate properties in the Properties panel by clicking their name in addition to 

their activation switch. See Properties panel.

Lyrics improvements
● You can now edit the formatting of individual lyrics, such as making single characters 

underlined. See Edit Lyric dialog.
● You can override the paragraph style used for individual lyrics. For example, if you want to 

use a paragraph style with less stretch for lyrics on tightly spaced systems. See Changing 
the paragraph style used for lyrics.

New Features in Version 4.0.0

Highlights

Jump bar
● The new jump bar allows you to perform commands and go to locations using only your 

computer keyboard. See Jump bar.
● You can assign jump bar aliases to specific commands; for example, so you can use shorter 

entries for your favorite commands. See Assigning jump bar aliases.

Player sorting
● By default, players are now automatically sorted in orchestral order, regardless of the order 

in which you add them to the project. You can change the player sorting setting in the 
Players panel in Setup mode. See Players panel.

● You can now designate players as soloists, such as in a concerto for solo violin and 
orchestra. Soloists are treated differently, such as their instruments not being numbered 
with other instruments of the same type and being automatically positioned in the 
conventional score position; that is, above the strings. See Designating players as soloists.

New features
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Capos
● You can now define capos for individual fretted instruments. You can then control how 

capos affect notated pitches and chord symbols/diagrams independently of each other to 
suit a range of requirements. See Capos.

Lower zone
● The lower zone, formerly known as the “bottom panel”, now contains multiple different 

panels, including Keyboard, Fretboard, and Drum Pads panels that you can use to input 
notes and the Mixer and Key Editor panels that you can use to adjust playback. See Lower 
zone (Write mode).

MIDI improvements
● During MIDI recording, Dorico SE now automatically transcribes multiple simultaneous 

parts into separate voices, such as in contrapuntal piano music. Depending on your 
settings for MIDI recording and quantization, Dorico SE can also detect slurs, tremolos, 
trills, pedal lines, tuplets, and grace notes. See MIDI recording.

Insert mode scope
● Insert mode has been given additional functionality, allowing you to change the scope of 

its impact. For example, you can now set Insert mode to affect all players in flows and also 
change the duration of the current bar. See Insert mode scopes.

● You can also now set a stop position in each flow, which prevents any material beyond the 
stop point being affected by inserted notes. See Setting Insert mode stop positions.

Play mode
● Play mode has had a complete refresh in both appearance and functionality. Tracks now 

appear in a track overview, with editing options available in the Track Inspector and Key 
Editor. See Project window in Play mode.

● The piano roll now appears in the Key Editor, rather than in the track overview (previously 
known as the “event display”). See Key Editor.

● Powerful histogram controls have been introduced as part of the new Key Editor, allowing 
you to perform various editing operations, including for non-consecutive notes. See 
Histogram tool.

● The Mixer has also been completely refreshed in appearance and functionality. In addition 
to the Mixer window, it can also appear as a panel in the lower zone in Write mode and 
Play mode. See Mixer.

Library
● Dialogs for visual items and options in the library are now accessible on a new Library 

menu. This also allows you to access these dialogs from all modes. See Library.

Numbered bar regions
● Numbered bar regions allow you to show bar counts in specific regions without additional 

notations. This can help performers keep track of how many bars have passed when 
playing repetitive music. See Numbered bar regions.

More New Features

Language improvements
● Changing the application language now takes effect immediately, without the need to 

restart Dorico SE. See Changing the application language.

Hub redesign
● The Hub has been redesigned, and now includes a Create New page where you can set up 

basic project information, including adding the project title, selecting a time signature, and 
specifying a starting number of bars. See Hub.

New features
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Ensemble picker
● When adding ensembles, you can now build custom ensembles and save them for future 

projects. The ensemble picker has also been given a default key command. See Ensemble 
picker and Building and saving custom ensembles.

Write mode toolboxes
● Some functions in the Notes toolbox now have additional options available when you click 

and hold their button, including allowing you to open the tuplets popover. See Notes 
toolbox.

● You can now switch between accessing panels and popovers from the Notations toolbox in 
Write mode. See Notations toolbox.

Insert Music Text dialog
● The new Insert Music Text dialog makes it easier to add music symbols, such as note 

glyphs and accidentals, to text items and in text frames. See Insert Music Text dialog.

Figured bass improvements
● You can now input tasto solo indications and bracketed figures, including only showing a 

single bracket on each figure. See Figured bass popover and Showing single brackets on 
figured bass.

Note spelling
● A new automatic note respelling dialog has been added, allowing you to specify the notes 

you want to respell and apply general preferences to the selection. See Respell Notes 
Automatically dialog.

● You can now copy note spellings to other layouts, for example, if you originally respelled 
notes in a part layout but want those spellings to appear in the full score layout as well. See 
Copying note spellings to other layouts.

● Additionally, you can reset changes to note spellings in either the current layout only or in 
all layouts. See Resetting note spellings.

Casting off improvements
● Additionally, there is now a preference for whether system/frame breaks are allowed within 

bars. Disallowing breaks within bars lets you select anything in the bar at the start of which 
you want a system/frame break. See Allowing/Disallowing breaks within bars.

Chord symbol improvements
● You can change the arrangement of polychord and altered bass note chord symbols. See 

Changing the arrangement of compound chord symbols.
● You can now show parentheses around chord symbols, including showing only a single 

left or right bracket on individual parenthesized chord symbols. See Parenthesized chord 
symbols.

● For players set to show chord diagrams, you can now show only the chord symbol or chord 
diagram for individual chord symbols. See Showing only chord symbols or chord diagrams.

Chord diagram fingerings
● You can now show fingerings in chord diagrams, either inside dots or at the ends of 

strings. You can change individual fingerings when editing chord diagram shapes. See 
Hiding/Showing fingerings in chord diagrams and Edit Chord Diagram dialog.

Percussion improvements
● You can now interact with rests belonging to unpitched percussion instruments, including 

moving rests vertically and deleting rests. See Moving rests vertically and Deleting rests.

Staff label improvements
● You can now show player names instead of instrument names for each player in each 

layout independently, and set both full and short player names for each player. For 
example, in works with multiple percussionists, showing “Percussion 1” in staff labels 
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regardless of their current instrument is sometimes preferred. See Showing instrument/
player names in staff labels and Renaming players.

● Additional options have been added for the appearance and position of instrument 
transpositions in staff labels, including parenthesizing instrument transpositions and 
showing them after the instrument number. See Changing the appearance/position of 
instrument transpositions in staff labels.

● You can now show vertical labels for player groups to the left of staff labels, as is 
sometimes used in large-scale works. See Player group labels.

Last but Not Least

Saving, resetting, and removing defaults in options dialogs
● A Reset to Factory option has been added to the Preferences dialog, allowing you to 

restore the factory defaults for application preferences if necessary. See Preferences dialog.
● All four ways of saving, resetting, and removing defaults in options dialogs are now always 

shown. Previously, it was necessary to hold a modifier key to access other options if you 
had existing saved defaults. See Layout Options dialog.

Project preview
● When you save projects, Dorico now generates preview images of the layout open in the 

music area. PNG files are used on the Open Recent page in the Hub. See Project Info 
dialog.

Pedal line improvements
● You can now add retakes and pedal level changes to, and remove them from, multiple 

rhythmic positions simultaneously. See Adding retakes with the popover, Adding retakes 
with the panel, and Removing retakes and pedal level changes.

Changing voices
● You can now change the voice of existing notes using the same methods as creating and 

switching between voices during note input. See Changing the voice of existing notes.

Page templates
● The templates for achieving consistent page formatting that used to be known as “master 

pages” have been renamed, and are now known as “page templates” throughout Dorico. 
See Page templates.

Bar number improvements
● You can now hide numbers in subordinate bar number sequences and only show 

alphabetical letters, such as “a”, “b”, and “c”. See Adding subordinate bar numbers.

Beaming improvements
● You can now force centered beams for beams that include notes only on one side of the 

middle staff line using the new Custom Centered Beam dialog. See Creating centered 
beams.

Grace notes
● You can now turn existing notes into grace notes and vice versa. See Turning existing notes 

into grace notes and Turning grace notes into normal notes.
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Introduction

Thank you very much for downloading Dorico SE.

We are delighted that you have chosen Steinberg's scoring application and hope that you will 
enjoy using it for years to come.

Dorico is a next-generation application for producing beautiful sheet music, whether you are 
a composer, arranger, music engraver, publisher, instrumentalist, teacher, or student. Whether 
you want to print your music or share it in a digital format, Dorico is the most sophisticated 
program available.

Like all of Steinberg's products, Dorico has been designed from the ground up by a team of 
musicians who understand your needs and who are dedicated to producing a tool that is both 
easy to learn and use, but also capable of results of the highest quality. Dorico also integrates 
with your existing workflow and can import and export files in a variety of formats.

Dorico thinks about music the same way a human musician does and has a deeper 
understanding of the elements of music and musical performance than other scoring 
applications. Its unique design allows an unprecedented degree of flexibility, in music input and 
editing, in score layout, in rhythmic freedom, and many other areas besides.

Most sincerely yours,

The Steinberg Dorico Team

Platform-independent documentation
This documentation applies to the operating systems Windows and macOS.

Features and settings that are specific to one of these platforms are clearly indicated. In all other 
cases, the descriptions and procedures in the documentation are valid for Windows and macOS.

Some points to consider:

● The screenshots are taken from macOS and use the dark theme in Dorico SE.

● Some functions that are available on the File menu on Windows can be found in the 
program name menu on macOS.

Usage of musical terms
This documentation uses American terminology for musical items.

The following table lists all the notes and notations that have different names in American and 
British English:

American name British name

Double whole note Breve

Whole note Semibreve

13
Dorico SE 4.3.30



American name British name

Half note Minim

Quarter note Crotchet

Eighth note Quaver

Sixteenth note Semiquaver

Thirty-second note Demisemiquaver

Sixty-fourth note Hemidemisemiquaver

Hundred twenty-eighth note Semihemidemisemiquaver

Two hundred fifty-sixth note Demisemihemidemisemiquaver

Half-step Semitone

Whole step Whole tone

Staff Stave

Bar/Measure

NOTE

This documentation only uses “bar”.

Bar

Documentation structure
In our documentation, we divide information into three different types of topics, according to 
their content.

Descriptions of the user interface
Topics that describe the functionality of user interface items and list the options and 
settings of dialogs, panels, or other items.

Descriptions of basic concepts
Topics that describe concepts and explain the functionality of a specific software 
feature.

Descriptions of procedures
Topics that provide step-by-step instructions for how to perform a specific task. These 
topics often provide an example for why you might want to follow the steps and a brief 
summary of the result, including consequences to be aware of.

Because of this division of information, our documentation structure functions as a reference 
you can consult for specific information or instructions as required, rather than a guide you must 
read from start to finish.

Introduction
Documentation structure 
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TIP

Descriptive topics do not describe how to perform a task, and procedural topics do not explain 
what something is. To find general information about items or concepts, we recommend 
searching for them by name, such as “dynamics”. To find instructions for performing particular 
actions, we recommend including a relevant verb in your search, such as “moving”.

Links at the bottom of topics guide you to further relevant content. You can also check the 
sidebar for nearby, related topics in the documentation structure.

Typographical conventions
In our documentation, we use structural and markup elements to present information according 
to its purpose.

Structural elements

Prerequisite
Describes any actions or conditions you must have fulfilled before starting a 
procedure.

Procedure
Lists the steps that you must take to achieve a specific result.

Important
Informs you about serious issues; for example, issues that affect the system, the 
connected hardware, or that risk data loss.

Note
Informs you about issues or other relevant information.

Tip
Adds further information or useful suggestions.

Example
Provides you with an example.

Result
Describes the result of the procedure.

After Completing This Task
Informs you about actions or tasks that you can perform after completing the 
procedure.

Related Links
Lists related topics that you can find in this documentation.

Markup

Bold text indicates the name of a menu, option, function, dialog, window, and so on.

EXAMPLE
To open the Project Info dialog, choose File > Project Info.

Introduction
Typographical conventions 
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If bold text is separated by a greater-than symbol, this indicates either a sequence of different 
menus to open, or directions to follow for navigation inside the dialog named at the start of the 
sequence.

EXAMPLE
Choose Edit > Notations > Voices > Change Voice > [Voice].

You can change this option in Preferences > Note Input and Editing > Editing.

File names and folder paths are shown in a different font.

EXAMPLE
example_file.txt

Key commands
Key commands are sets of keys that perform defined tasks when pressed together. They are 
also known as “keyboard shortcuts” or “hotkeys”. Many key commands are the same on different 
operating systems but some are not, and this guide distinguishes them.

When key commands use equivalent modifier keys depending on the operating system, the 
modifier keys are indicated separated by a slash, with the Windows modifier key first and the 
macOS modifier key second.

EXAMPLE
Ctrl/Cmd-Alt/Opt-Down Arrow  means: press Ctrl - Alt - Down Arrow  on Windows, Cmd - Opt -
Down Arrow  on macOS.

When key commands require entirely different keys depending on the operating system, they are 
indicated with the Windows key command first, followed by the macOS key command.

EXAMPLE
# (Windows) or \ (macOS)  means: press #  on Windows, \  on macOS.

In this documentation, we use key commands that match the language of the documentation. 
For example, key commands in the English documentation correspond to the English keyboard 
language.

RELATED LINKS
Key commands in Dorico on page 25
Key Commands page in the Preferences dialog on page 54
Changing the keyboard language on page 59
Changing the application language on page 48

How you can reach us
You can access additional information from the Help menu.

The menu contains links to various Steinberg web pages. Selecting one of these menu items 
automatically launches your web browser and opens the page. On these pages, you can find 
support and compatibility information, answers to frequently asked questions, information 
about updates and other Steinberg products, and so on.

Introduction
Key commands 
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Dorico concepts

Dorico is based on a number of key concepts that come from its design philosophy.

We recommend familiarizing yourself with these concepts, as this will greatly enhance your 
ability to work efficiently with Dorico and to navigate more easily through this documentation.

Design philosophy and higher-level concepts
Deep design considerations are required to create a notation software like Dorico, which might 
be of particular interest to users familiar with scoring applications. Dorico has a forward-thinking 
design that is led by musical concepts rather than computational convenience, and this provides 
many benefits.

In most other graphically-orientated scoring applications, the highest-level concept is the staff or 
the instrument definition that creates a staff or staves. When setting up your full score in such 
programs, you start by adding the correct number of staves, and you are immediately forced 
into making decisions about the layout. This means that you must know in advance whether two 
flutes share a staff or have their own individual staves, or whether there should be two trumpets 
or three. Many of these decisions have significant effects throughout the process of inputting, 
editing, and producing individual instrumental parts.

Typically, every system of a score must contain the same number of staves, even if some 
are hidden on particular systems. This requires the user to manage common conventions for 
themselves, such as multiple players of the same instrument sharing staves. This can be time-
consuming and is naturally error-prone.

By contrast, Dorico is designed to conform more closely to how music is performed in the real 
world and to make the score a flexible expression of the practical choices that go into a musical 
performance, rather than to make the musical performance subservient to the way the score was 
initially prepared.

To that end, the highest-level concept of Dorico is the group of human musicians that performs 
a score. A score can be written for one or more groups; for example, a double choir, or an 
orchestra plus off-stage chamber ensemble, and so on. Each group includes one or more players 
which correspond to the humans who play one or more instruments. Players may either be 
individuals who play more than one instrument, such as an oboist doubling cor anglais, or 
groups in which everyone plays only one instrument, such as eight desks of violinists.

One crucial difference between Dorico and other scoring applications is that the musical content 
exists independently of the score layout in which it is viewed.

The actual music played by the group in your score belongs to one or more flows. A flow is 
any span of music that stands alone; for example, a whole song, a movement of a sonata or 
symphony, a number in a musical show, or even a short scale or exercise. Players might or might 
not have any music to play in a given flow. For example, all the brass players might be omitted 
from the slow movement of a classical symphony, or certain players might have nothing to play 
in some cues in a movie score. This is no problem as you can combine players in flows in any 
combination.

Dorico’s design philosophy provides several benefits. Chief among them is its ability to produce 
multiple layouts that share the same musical content, but each having customized appearances 
to suit different requirements. For example, in the same project you can create a conductor’s 
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score with as many instruments as possible condensed onto a smaller number of staves, a full 
score with each player’s music on separate staves, a custom score layout containing just the 
piano and vocal staves for choral rehearsals, and an instrumental part for each player that only 
contains the music belonging to them.

This means it is not necessary to extract flows or parts as separate files: all this information can 
co-exist in the same Dorico project file.

RELATED LINKS
Condensing on page 543
Assigning players to layouts on page 153

Projects in Dorico
A project is an individual file that you create within Dorico. It can contain multiple separate pieces 
of music of any duration, written for any combination of instruments, and use as many layouts as 
required.

For example, you can create a single project that contains all the preludes and fugues in Bach’s 
“The Well-Tempered Clavier” as separate flows. You could then have one layout that contains only 
the flows for Book 1 and another layout that contains the flows for Book 2.

In addition to the notated music, projects save other relevant information, such as the playback 
template applied.

Dorico projects are saved as .dorico files.

RELATED LINKS
Flows in Dorico on page 19
Layouts in Dorico on page 23
Page templates in Dorico on page 24
Playback templates on page 471

Modes in Dorico
Modes in Dorico represent a logical sequence of the workflow phases of preparing music, but 
you can switch between them at any time as required for your own workflow.

Dorico SE contains the following modes:

Setup
In Setup mode, you can set up the fundamental elements of the project: instruments 
and the players that hold them, flows, layouts, and videos. You can also determine how 
they interact with each other; for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and 
layouts, but you cannot select or interact with anything in the music area in Setup 
mode.

Write
In Write mode, you can input and edit your music, including changing the rhythmic 
positions of items, changing the pitch of notes, and deleting notes and items. The 
available toolboxes and panels allow you to input all the notes and notation items that 
are most commonly used.

By design, you cannot move notes and items graphically on the page in Write mode. 
Graphical adjustments are only possible in Engrave mode in Dorico Pro.

Dorico concepts
Projects in Dorico 
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Play
In Play mode, you can change how your music sounds in playback. You can do this by 
changing the playback template and assigning VST instruments, inputting automation, 
adjusting the mix, and changing the sounding duration of notes in playback without 
affecting their notated duration.

Print
In Print mode, you can print your layouts or export them as graphics files. When 
printing layouts, you can specify the paper size and other options, such as duplex or 
booklet printing. When exporting layouts, you can specify different graphics file types, 
such as PDF or PNG, and the information you want to include in their exported file 
names.

RELATED LINKS
Setup mode on page 93
Write mode on page 172
Print mode on page 486
Play mode on page 439

Flows in Dorico
Flows are separate spans of music that are completely independent in musical content; for 
example, a single song in an album, a movement in a sonata or symphony, a number in a stage 
musical, or a short scale or sight-reading exercise of only a few bars in length. A single project 
can contain any number of flows.

Each flow can contain music for any combination of players, independently of other flows. For 
example, brass players are often tacet in the second movements of Classical-period symphonies, 
so you can remove brass players from the flow for the second movement but leave them in the 
flows for other movements. In a set of cues for a movie, for example, specific players might not 
be required in some cues, so the corresponding flows can contain only those players who have 
anything to play.

The correct assignment of players to flows allows Dorico, for example, to generate tacet sheets 
automatically for individual instrumental parts.

RELATED LINKS
Players, layouts, and flows on page 105
Flows on page 148
Tacets on page 541
Flow headings on page 550

Players in Dorico
In Dorico, a player can represent an individual musician or multiple musicians in the same 
section. Players hold instruments, so you must add at least one player to your project before you 
can add instruments.

● A single player represents one person who can play one or more instruments. For example, 
a clarinettist who doubles on alto saxophone or a percussionist who plays bass drum, clash 
cymbals, and triangle.

● A section player represents multiple people who all play the same instrument. For example, 
a violin section player might represent all eight desks of the Violin I section in an orchestra, 
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or a soprano section player might represent the whole soprano section in a mixed voice 
choir.

NOTE

Section players can only hold one instrument.

By using the concept of players, Dorico makes it much easier to handle, for example, instrument 
changes, divisi, and condensing music for multiple players onto a smaller number of staves.

You can also group players together; for example, to separate off-stage players from on-stage 
players in a large-scale work. Grouping players together means they are positioned together in 
the score, numbered independently of players outside the group, and are bracketed together 
according to the ensemble type set for each layout.

Players can be assigned to any combination of layouts and flows.

RELATED LINKS
Players, layouts, and flows on page 105
Players on page 107
Player groups on page 144
Divisi on page 1047
Condensing on page 543
Brackets according to ensemble type on page 709

Instruments in Dorico
In Dorico, an instrument is an individual musical instrument, such as a piano, a flute, or a violin. 
Human voices, such as soprano or tenor, are also considered instruments.

In Dorico, instruments are held by players, just as real instruments are held by human players. 
Section players can only hold one instrument but single players can hold multiple instruments. 
This allows you to handle instrument changes easily, such as when an oboist doubling the cor 
anglais switches from one instrument to the other.

Each instrument automatically gets its own staff, but when instrument changes are allowed, the 
music for multiple instruments held by the same single player can appear on the same staff as 
long as no notes overlap.

Dorico has a database of information about the properties of each instrument. These include 
the playable range, common and uncommon playing techniques, notational conventions, 
transposition properties, tunings, clef, number of staves, type of staff, and so on. Having these 
properties predetermined makes it easier and quicker to set up projects correctly. For example, 
selecting the horn instrument with the appropriate transposition and clef setting for its part 
layout means you do not have to input a layout-specific clef. Similarly, there is a timpani 
instrument that automatically hides all key signatures.

RELATED LINKS
Instruments on page 114
Instrument changes on page 117
Transposing instruments on page 119

Dorico concepts
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Popovers
Popovers allow you to input different notations and perform tasks, such as transposing a 
selection of notes, using only your computer keyboard. They are temporary value fields that use 
text entries for different items and tasks, and there are specific popovers for different purposes.

The dynamics popover with an example entry

One of the key benefits of popovers is that you can use them as you input notes: for example, 
once you reach the position where you want to input a new time signature, you can open the 
time signatures popover, input the time signature you want, and then continue inputting notes.

Although specific entries are required for many notations, the correct entries for different 
notations are consistently and logically structured. For example, tuplets are always expressed as 
a ratio, such as 3:2 or 5:4. Key signatures are expressed using capital letters for major keys and 
lowercase letters for minor keys. Time signatures are expressed as a pair of separated numbers; 
common time signatures use a slash, such as 3/4 or 6/8.

During note input, and depending on the notation you are inputting with the respective popover, 
notations are input either on the currently selected note, which is usually the last note you input, 
or at the current rhythmic position, indicated by the caret.

You can always identify popovers by the icon on their left-hand side, which are the same icons 
used in the Notations toolbox on the right of the window. The Notations toolbox allows you to 
hide/show the corresponding notation’s panel, which is another way you can input notations.

You can only use popovers in Write mode, as that is the only mode where you can input notes 
and items together and change the pitch of notes. Popovers open above the top staff on which 
the caret is active or an item is selected, and at the caret position or the rhythmic position of the 
earliest selected item.

RELATED LINKS
Caret on page 191
Note input on page 196
Notations input on page 246
Notations toolbox on page 178
Right zone (Write mode) on page 181

Notes and rests in Dorico
In Dorico, the notation and division of notes and rests is determined semantically by rules based 
on convention. This means that note and rest durations can change and appear differently later 
than when you first input them.

Dorico is able to update how notes and rests are notated depending on their context because of 
the following key concepts:

1. Notes are treated as a single unit, even if they appear as a tie chain that contains multiple 
notes tied together.

Dorico concepts
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2. Implicit rests automatically fill the gaps between the notes you input.

In combination with time signatures and Dorico’s understanding of their corresponding meters, 
this allows you to input only the notes you want with the duration required. It is not necessary 
to input rests between notes or input ties for notes that cross the half-bar, for example. If you 
subsequently change the time signature or move notes rhythmically to start earlier or later, 
Dorico updates how notes and rests are notated, such as by notating a quarter note as two tied 
eighth notes if it now straddles a barline or consolidating two eighth note rests into a single 
quarter note rest if they are now in the same bar.

If you tie existing notes together, you might find that they turn into a single note, such as a 
half note instead of two tied quarter notes, or into a tie chain containing more notes. This is 
because tie chains are treated as single notes in Dorico, and Dorico automatically notates and 
beams notes appropriately depending on their duration, the prevailing time signature, and their 
position in the bar. Similarly, notes can change after you input notes immediately following them 
as this changes the context, such as a quarter note tied to an eighth note becoming a dotted 
quarter note when it is followed by an eighth note rather than a rest.

TIP

In Write mode, selecting any part of a tie chain selects the whole tie chain because it is a single 
note. However, you can still input notations, such as dynamics, in the middle of tie chains by 
activating the caret and moving it to the required rhythmic position within the tie chain.

You can force the duration of individual notes and rests; for example, if you want to specify 
subdivisions within a tie chain that are different than the prevailing meter.

RELATED LINKS
Notes on page 840
Ties on page 1074
Implicit vs. explicit rests on page 1009
Note and rest grouping on page 705
Beam grouping according to meters on page 689
Caret on page 191
Inputting notes on page 197
Forcing the duration of notes/rests on page 238
Inputting ties on page 223

Rhythmic position
In Dorico, notes and items exist at rhythmic positions, which are calculated using their place in 
musical time in the flow rather than their position in a specific bar that has a particular time 
signature.

In Dorico, musical time is the number of beats starting from the beginning of each flow. For 
example, instead of a note existing on beat 3 in bar 4 in a 4/4 time signature, Dorico considers 
that note to exist at beat 15, regardless of the time signature and its position in a bar.

This approach allows for a lot of flexibility. For example, because notes and items exist 
independently of bars and time signatures in Dorico, you can change the time signature without 
changing when notes happen in relation to each other or adding rests at the end of each 
bar. Instead, the barlines simply move to different positions and note grouping is updated as 
required, such as notating a quarter note as two tied eighth notes if it now straddles a barline or 
crosses the half-bar. You can even start writing notes without inputting a time signature at all.

Dorico concepts
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Similarly, you can easily push notes to later rhythmic positions or pull them in to earlier ones 
using Insert mode without the risk of them being incorrectly notated. It also means you can 
think of items existing in the music independently of notes, because items exist at a particular 
rhythmic position, rather than being attached to notes. To input items at rhythmic positions that 
do not coincide with the start of notes, such as dynamics in the middle of tie chains, you can 
either select any other item at that position, or activate the caret and input items at the caret 
position.

In Dorico, the rhythmic position of notes and items is separate from their graphical position on 
the page. The benefit of this is that you can input items at the position in the music where they 
must apply and then move them graphically without causing them to apply to different notes or 
inadvertently split multi-bar rests. For example, if you want strings to play pizzicato from the start 
of a bar, but because of tight vertical spacing you want to move the pizz. indication slightly to 
the side. Attachment lines link items to the rhythmic positions to which they apply, so it is always 
clear where they belong, but are not printed.

RELATED LINKS
Note and rest grouping on page 705
Beaming on page 689
Time signatures on page 1084
Inputting notes in Insert mode on page 212
Notes on page 840
Caret on page 191
Insert mode on page 408
Rhythmic grid on page 190
Annotations on page 507

Layouts in Dorico
Layouts combine musical content, as represented by flows and players, with rules for page 
formatting and music engraving, and allow you to produce paginated music notation that can be 
printed or exported in various formats. For example, part layouts typically only show the music 
for one player, whereas full score layouts show the music of all players in the project.

A typical project for an ensemble contains several layouts. By default, Dorico projects contain a 
single full score layout that contains the music for all players, and a part layout for each player 
that only contains their music. However, you can also create as many layouts as required.

When you add the first player to a project, Dorico automatically creates a full score layout and 
a part layout. For all subsequent players you add to the project, Dorico creates a part layout for 
each player and assigns them all to the existing full score layout.

Layouts can contain any combination of players and flows. They share the musical content of 
these players and flows, such as the notes each instrument plays. For example, when you change 
the pitch of a note in the full score, that note’s pitch is also updated in the corresponding part 
layout.

You can control practically every aspect of page formatting in each layout independently, 
including note spacing, staff size, page size, margins, and casting off; that is, the positions of 
system breaks and page turns. Changing these aspects in one layout does not affect other 
layouts. For example, inserting systems breaks in a part layout does not change the casting off in 
the full score.

Similarly, you can change the visual appearance of many items only in one layout, without 
affecting other layouts, using local properties. For example, you can hide text items in the full 
score layout but show them in part layouts.

Dorico concepts
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The default formatting of pages in layouts is determined by page templates. By default, full score 
layouts use a different page template set to part layouts; however, you can apply a different page 
template set to each layout.

Deleting layouts does not delete any music from the project.

RELATED LINKS
Layouts on page 151
Players, layouts, and flows on page 105
Page formatting on page 508
Casting off on page 535
Condensing on page 543
Properties on page 560
Local vs. global properties on page 561
Page templates on page 547
Page template sets on page 548
Types of page templates on page 549
Applying page template sets to layouts on page 511
Printing layouts on page 491
Exporting layouts as graphics files on page 495

Page templates in Dorico
Page templates in Dorico SE allow you to achieve consistent page formatting by applying the 
same arrangements of frames to multiple pages and in different layouts.

Frames are boxes in which you can display text, music, and graphics. The default page templates 
contain a large music frame that takes up most of the page and text frames at the top and 
bottom. On the first page of music, text frames display the project title, lyricist, and composer. 
On the second page of music onwards, text frames display the page number and flow title for the 
top flow on that page in scores, and the layout name in parts.

All pages in your scores and parts inherit their default formatting from page templates.

Dorico SE provides different types of page templates so that there is appropriate page 
formatting for first pages independently of subsequent pages, as the first page typically includes 
additional information, such as the title, composer, and copyright. Dorico SE uses tokens to 
display this additional information.

Page templates are contained in page template sets. By default, Dorico SE provides separate 
page template sets for full score and part layouts. Page template sets are automatically applied 
to every layout that you create.

NOTE

● In Dorico SE, you cannot edit page templates or create new ones; this is only available in 
Dorico Pro.

● Changing individual pages in layouts is considered a page template override in Dorico SE. 
This includes, for example, editing the title or running header in Write mode. Pages with 
page template overrides are not automatically deleted, even if they are empty because the 
layout became shorter.

If you want to change the information shown at the tops of pages, that is, the title and 
running header text that you cannot select, we recommend that you do so in the Project 
Info dialog to avoid page template overrides. The big title at the top of the first page is the 
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project title. The running header on subsequent pages uses the flow title for the top flow on 
that page in scores, and the layout name in parts.

RELATED LINKS
Page template sets on page 548
Page templates on page 547
Types of page templates on page 549
Frames on page 551
Project Info dialog on page 70
Tokens on page 552

Key commands in Dorico
Dorico’s key commands have been designed to be logical, consistent, and accessible using a 
standard computer keyboard, without needing a number pad.

EXAMPLE

● The arrow keys on their own navigate the selection around the music area.

● Alt/Opt  modifies selected items.

For example, in Write mode, adding Alt/Opt  to the up/down arrow keys transposes notes by 
staff position; adding Alt/Opt  to the right/left arrow keys moves notes/items rhythmically.

● Shift - Alt/Opt  changes the duration of notes/items in Write mode.

For example, Shift-Alt/Opt-Right Arrow  lengthens notes/items by the current rhythmic 
grid resolution.

● Ctrl/Cmd  increases the amount by which selected items are modified.

For example, in Write mode, adding Ctrl/Cmd - Alt/Opt  to the up/down arrow keys 
transposes notes by an octave; Ctrl/Cmd-Shift-Alt/Opt-Right Arrow  doubles the duration 
of notes.

● Shift  plus letter keys opens popovers in Write mode.

For example, Shift-D  opens the dynamics popover; Shift-O  opens the ornaments popover.

The default key commands in Dorico depend on your keyboard language setting, which follows 
your application language setting by default.

You can view available key commands in the following ways:

● Choose Help > Key Commands to open the Dorico Key Commands window, which provides 
an overview of all available key commands.

● Search for key commands of specific functions or menu items in Preferences > Key 
Commands. In this dialog, you can also assign new key commands or change default key 
commands.

● When you move the mouse over a tool or a function that has a key command, a tooltip with 
the corresponding key command in brackets is shown.

RELATED LINKS
Interactive Dorico key commands map on page 56
Preferences dialog on page 53
Key Commands page in the Preferences dialog on page 54
Searching for the key commands of functions on page 57
Assigning key commands on page 58
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Changing the keyboard language on page 59
Changing the application language on page 48
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User interface

The user interface of Dorico SE is designed to keep all of the important tools at your fingertips. 
This chapter introduces you to key aspects of the user interface.

Project window
Dorico SE’s main project window allows you to access all the options and tools you need to 
work on a project. You can open multiple project windows for the same project or for different 
projects.

The project window comprises the following areas:

1 Toolbar

Allows you to access the modes, the workspace options, the Mixer, the Video window, and 
the main transport options.

2 Tab bar

Displays all open tabs. If you split the music area and open several tabs, tab groups are 
shown. Available in Setup mode and Write mode.

3 Project start area/Music area/Track overview/Print preview area

The central part of the project window where you work on your project. When you start a 
new empty project, this area shows the project start area that allows you to add your first 
players. Once you have added a player or an ensemble, this area becomes the music area 
that shows the music notation of the currently selected layout.

In Play mode, this area contains a track overview that displays your music in a similar way to 
that used in a digital audio workstation, or “DAW”, such as Cubase.
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In Print mode, the print preview area shows a preview of how your project will appear when 
printed onto paper or exported into a graphics file format.

4 Zones

Zones on the left, right, and lower edges of the project window contain panels that provide 
the notes, notations, and functions that you need to create and edit your music. Different 
panels are available in each zone according to the mode.

5 Toolboxes

Toolboxes provide access to items and tools that you can use to input and edit your music. 
Different toolboxes contain different items and tools according to the mode.

6 Status bar

Allows you to choose a different view and page arrangement of the music area. It also 
contains zoom options and a summary of your current selection in the music area.

RELATED LINKS
Starting new projects on page 66
Opening multiple project windows on page 46
Showing multiple tabs in the same project window on page 45
Switching between layouts on page 40
Project window in Setup mode on page 93
Project window in Write mode on page 172
Project window in Play mode on page 439
Project window in Print mode on page 486

Toolbar
The toolbar allows you to access modes and workspace options as well as the Mixer and main 
transport options. It is located at the top of the project window and is available in all modes.

You can hide/show the toolbar in any of the following ways:

● Press Ctrl/Cmd-6 .

● Choose Window > Show Toolbar.

The toolbar contains the following:

1 Modes

Selectable workspaces in the project window that represent different phases in the workflow 
of preparing a score. If the width of the main project window becomes sufficiently small, the 
mode buttons become a menu.

2 Workspace options

Provide options that allow you to select different layouts to open in the music area and to 
change the working environment.

3 Show Video

Hides/Shows the Video window.

4 Show Mixer

Hides/Shows the Mixer window.

5 Mini transport
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Allows you quick access to the main transport functions, including Play, Record, and Click.

6 Show Transport Bar

Hides/Shows the Transport window, which contains playback and MIDI recording functions.

7 Undo

Allows you to undo previous actions.

8 Redo

Allows you to restore previous actions that were undone using Undo.

RELATED LINKS
Hub on page 64
Modes in Dorico on page 18
Mini transport on page 30
Transport window on page 468
Videos on page 166
Mixer window on page 613

Workspace options
The workspace options in the middle of the toolbar provide options that allow you to select 
different layouts and to change the working environment.

Layout selector

Allows you to select other layouts to show in the current tab.

Show Tabs
Shows/Hides the tab bar above the music area.

Show Tabs when the tab bar is hidden Show Tabs when the tab bar is shown

Hide/Restore Zones
Shows/Hides all open zones.

Hide/Restore Zones when zones are shown Hide/Restore Zones when all zones were 
previously shown but are now all hidden

RELATED LINKS
Layouts on page 151
Switching between layouts on page 40
Zones and panels on page 35
Hiding/Showing zones on page 41
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Mini transport
The mini transport on the right of the toolbar provides quick access to the main transport 
functions of Dorico SE.

Activate Project

Activates/Deactivates playback in the project. When playback is deactivated, transport 
and playback functions are disabled.

Time display
Shows the position of the playhead in one of the following formats:

● Bars, beats, and ticks

● Elapsed time in the following order of units: hours, minutes, seconds, milliseconds

● Timecode in the following order of units: hours, minutes, seconds, frames

Time display showing bars 
and beats

Time display showing 
elapsed time

Time display showing the 
timecode

You can change the content shown in the time display by clicking it.

Rewind to Beginning of Flow

Moves the playhead back to the beginning of the flow.

Play
Starts/Stops playback, either from the playhead position or the earliest selected item, 
depending on your setting on the Play page in Preferences.

Play when playback is stopped Play during playback

Record
Starts/Stops MIDI recording.

Record outside of MIDI recording Record during MIDI recording

Click

Plays/Mutes the metronome click during playback and recording.

Tempo Mode
Displays the tempo used for both playback and recording. The value changes 
according to the playhead position, and its appearance changes according to its mode.
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● You can change the tempo mode by clicking the beat unit.

● You can change the metronome mark value used in fixed tempo mode by clicking 
the number to show a slider, then dragging the slider to the right/left.

Fixed Tempo Mode Follow Tempo Mode

TIP

The Transport window contains additional transport functions.

RELATED LINKS
Transport window on page 468
Playing back music on page 457
Moving the playhead on page 456
Changing the tempo mode on page 458
Changing the content shown in the transport display on page 471
Changing the sound used for the click on page 450
MIDI recording on page 240
Mixer window on page 613
Preferences dialog on page 53
Timecodes on page 971

Tab bar
The tab bar in Dorico SE allows you to display different layouts within the same project window. It 
is located between the toolbar and the music area.

● You can hide/show the tab bar by clicking Show Tabs  in the toolbar.

The tab bar contains the following:

1 Tabs

Displays all open tabs, with their position from left to right reflecting the order in which you 
opened them. Each tab is labeled with the name of the selected layout. The tab currently in 
view in the music area is highlighted.

When you hover over an individual tab, an x appears that allows you to close the tab.

2 New Tab

Allows you to open a new tab. Tabs can contain a different layout, or an additional view of a 
layout that is already open in another tab or window.

TIP

You can change whether the tab bar is hidden or shown in new projects by default in 
Preferences > General > View.

User interface
Project window 

31
Dorico SE 4.3.30



RELATED LINKS
Preferences dialog on page 53

Project start area
The project start area is displayed in the middle of the project window in Setup mode and Write 
mode when you set up a new empty project. When you add at least one player, the view changes 
into the music area.

The project start area shows cards that allow you to add players to the project.

Project start area

RELATED LINKS
Adding players on page 108

Music area
In Setup mode and Write mode, the music area shows the music notation of the currently 
selected layout. It is the central part of the project window where you work on your project.
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Music area showing a new choir piece in page view

The music area displays layouts in either galley view or page view. The tab bar above the music 
area allows you to open multiple layouts in the project simultaneously and switch between them. 
The scroll bars to the right and to the bottom of the music area allow you to scroll within the 
layout.

You can use the layout selector in the toolbar to show other layouts in the music area.

When zones are open on the right, left, and lower edges of the window, the size of the music 
area can be reduced. You can hide/show zones when necessary.

RELATED LINKS
Toolbar on page 28
Switching to galley/page view on page 47
Switching between layouts on page 40
Hiding/Showing zones on page 41
Navigation on page 402
Layouts on page 151
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Print preview area
The print preview area is the central part of the project window in Print mode that shows a 
preview of what will be printed or exported as a graphic.

Print preview area displaying a score set to print 2-up

The print preview area shows a preview of the first layout selected in the Layouts panel. You 
can scroll through the pages that are shown, but you cannot edit layouts. If you want to make 
changes, you must switch to Setup or Write mode.

TIP

You can go directly to the first page in the layout by pressing Home , and to the last page 
by pressing End . You can change these key commands on the Key Commands page in 
Preferences.

If you select multiple layouts to be printed as part of the same print job, the print preview area 
only displays the first layout. If you want to show the expected page arrangement for each layout 
in the print preview, you must check each layout individually before you start printing.

RELATED LINKS
Project window in Print mode on page 486
Layouts panel (Print mode) on page 487
Key Commands page in the Preferences dialog on page 54
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Zones and panels
Zones on the left, right, and lower edges of the project window contain panels that provide 
the notes, notations, and functions that you need to set up, write, edit, and format your music. 
Different panels are available in each zone according to the mode.

You can hide/show each zone individually or all of them at the same time.

1 Left zone. In Write mode, this contains the Notes panel.

2 Right zone. In Write mode, this can display different panels, according to the current 
selection in the Notations toolbox.

3 Lower zone. In Write mode, this can display different panels, including the Properties panel 
and Mixer.

The zones contain different panels in each mode in Dorico SE.

Modes and their panels

Mode Left Zone Right Zone Lower Zone

Setup Players panel Layouts panel Flows panel

Write Notes panel Notations panels Properties, Keyboard, 
Fretboard, Drum Pads, 
Mixer, and Key Editor 
panels

Play Track Inspector and 
VST and MIDI panel

n/a Mixer and Key Editor 
panels

Print Layouts panel Print Options panel n/a

RELATED LINKS
Modes in Dorico on page 18
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Hiding/Showing zones on page 41
Project window in Setup mode on page 93
Project window in Write mode on page 172
Project window in Play mode on page 439
Project window in Print mode on page 486
Players panel on page 94
Layouts panel (Setup mode) on page 101
Flows panel on page 104
Notes panel on page 177
Right zone (Write mode) on page 181
Lower zone (Write mode) on page 182
Properties panel on page 560
Track Inspector on page 442
Key Editor panel on page 564
Mixer panel on page 612
Layouts panel (Print mode) on page 487
Print Options panel on page 488

Toolboxes
Toolboxes are located on the right and left edges of the project window in some modes. They 
contain different tools and options according to the current mode, but in general they allow you 
to input and modify notes/items and to show different panels in the corresponding zone.

Write mode

● Notes toolbox on the left of the project window

● Notations toolbox on the right of the project window

RELATED LINKS
Project window on page 27
Notes toolbox on page 173
Notations toolbox on page 178

Status bar
The status bar at the bottom of the project window allows you to choose different views and 
page arrangements for the music area.

NOTE

Not all options in the status bar are available in all modes.

Status bar in Write mode

1 Rhythmic Grid selector

Allows you to change the rhythmic grid resolution, which affects certain aspects of inputting 
and editing, such as the amount by which items move.

2 Status display

Displays information about the current layout and selection, divided in up to three sections, 
which are, from left to right:
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● Transposition of the current layout

● The bar/range of bars of the current selection

● Summary of the selection; for example, the pitch and voice of a single selected note, or 
the implied chord of multiple selected notes

3 Disclosure arrow

Allows you to show/hide the lower zone in Setup mode and Write mode.

4 Selection tools

Allow you to switch between using the Marquee Tool and the Hand Tool in Write mode.

5 View type selector

Allows you to select one of the provided view types for the music area in Setup and Write 
mode.

6 Page arrangement options

Allow you to choose between different horizontal and vertical arrangements of either 
individual pages or pairs of pages, which are called spreads.

7 Zoom options

Allow you to change the zoom factor of the music area and its musical contents. There are 
preset zoom levels but you can also use a custom zoom level.

8 MIDI activity indicator/Audio engine connection warning

Indicates that there might be MIDI or audio problems that require your attention.

● A brief green light  indicates that Dorico SE is receiving MIDI input from a connected 
device. If the green light is persistent, a connected MIDI device is sending lots of data, 
which can cause problems.

● A warning icon  indicates that Dorico SE is unable to send MIDI events to the audio 
engine; for example, if no device is chosen or the sample rate is wrong. You can click the 
warning icon to open the Device Setup dialog, where you can fix the problem in most 
cases.

RELATED LINKS
Rhythmic grid on page 190
View types on page 38
Page arrangements for page view on page 39
Zoom options on page 39
MIDI recording on page 240
Playing back music on page 457
Enabling/Disabling MIDI input devices on page 246

Selection tools
The status bar in Dorico SE contains selection tools that you can use to select items and change 
the music shown within the music area.

Marquee Tool

Allows you to drag a rectangle to select multiple notes and notations.

Hand Tool

Allows you to move the view within the music area.
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TIP

● You can press Alt/Opt-H  to switch between selection tools.

● To use the other tool briefly without selecting it, Shift -drag with the mouse.

● You can change the default selection tool for all future projects on the Note Input and 
Editing page in Preferences.

RELATED LINKS
Selecting notes/items on page 387
Selecting multiple items using marquee selections on page 389
Moving the view in the music area on page 405
Preferences dialog on page 53

View types
In Dorico SE there are different ways to view your layouts.

The following view types are available:

Galley View
Lays out all the staves in the current layout and flow on a single continuous system.

This view type is most useful during the process of inputting the music as it allows 
you to focus on the musical content of your project. Because it shows all staves, galley 
view is particularly useful when inputting notes for single players holding multiple 
instruments.

By default, bar numbers are shown every bar above every staff. Staff labels are also 
shown above every staff, and follow the view as you scroll so they are always visible.

NOTE

Note spacing is unjustified in galley view and there is no automatic vertical collision 
avoidance, so notes and items might overlap. You can change the default gaps 
between staves in galley view for each layout independently.

Page View
Displays your layout paginated exactly as it appears when you print or export it.

This view type is useful for determining appropriate page turns, for example.

NOTE

● The view type is reset to your default setting when you switch layouts.

● You can change the default view type used for all future projects in the View section of the 
General page in Preferences.

RELATED LINKS
Preferences dialog on page 53
Switching to galley/page view on page 47
Changing the staff spacing in galley view on page 532
Page formatting on page 508
Players on page 107
Instruments on page 114
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Page arrangements for page view
Page arrangement options in the status bar allow you to change the way pages are arranged in 
the music area, for layouts shown in page view.

Spreads Horizontally

Displays pages in pairs as two-page spreads, with each pair laid out from left to right in 
a row.

Spreads Vertically

Displays pages in pairs as two-page spreads, with each pair laid out from top to bottom 
in a column.

Single Pages Horizontally

Displays individual pages laid out from left to right.

Single Pages Vertically

Displays individual pages laid out from top to bottom.

RELATED LINKS
Status bar on page 36
Switching to galley/page view on page 47

Zoom options
Zoom options in the status bar allow you to change the displayed size of pages in the music area.

Custom Zoom

Opens a dialog that allows you to set a custom zoom percentage.

Set Zoom

Allows you to select one of the preset zoom scaling factors. You can set a permanent 
zoom factor for all future projects on the General page in Preferences.

Zoom Out

Decreases the size of notes and notations in the music area.

Zoom In

Increases the size of notes and notations in the music area.

RELATED LINKS
Status bar on page 36
Preferences dialog on page 53
Zooming in/out of the music area on page 406
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Disclosure arrows
Disclosure arrows indicate that objects, areas, and menus can be expanded/collapsed, either 
vertically or horizontally.

In Dorico SE, disclosure arrows are commonly used to expand/collapse sections in panels and 
cards, such as player cards in the Players panel in Setup mode.

Disclosure arrow for a player card
Disclosure arrows for sections in the Tempo panel

RELATED LINKS
Players panel on page 94
Instruments on page 114

Workspace setup
Dorico SE enables you to set up your workspace according to your working style. For example, 
you can open multiple tabs to display multiple layouts in the same window. You can also open 
the same project in multiple project windows.

RELATED LINKS
Navigation on page 402
Hiding/Showing zones on page 41
Starting new projects on page 66

Switching between layouts
You can change which layout is displayed in the current tab in the music area in Setup mode and 
Write mode, or in the track overview in Play mode. For example, if you want to check individual 
part layouts.

NOTE

You can only switch between layouts to which players are assigned.

PROCEDURE

● Switch to another layout in any of the following ways:

● To switch to the next layout, press Shift-Alt/Opt-] .

● To switch to the previous layout, press Shift-Alt/Opt-[ .

● Select an item on a staff or in the piano roll of the player whose layout you want to open 
and press W .

● In the toolbar, click the layout selector and select a layout from the menu.
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RESULT
The selected layout is opened in the music area. It replaces the layout previously open in the tab.

TIP

You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Layouts on page 151
Implicit vs. explicit rests on page 1009
Players, layouts, and flows on page 105
Assigning players to layouts on page 153
Switching to galley/page view on page 47
Switching between flows in the track overview on page 441
Piano roll editor on page 575

Hiding/Showing zones
You can hide/show individual zones or all zones simultaneously; for example, to increase the 
space available for displaying music in the music area, or to access options in a specific panel.

NOTE

In some modes, not all methods are available.

PROCEDURE

1. Hide/Show the left zone in any of the following ways:

● Press Ctrl/Cmd-7 .

● In the toolbox on the left, click Show Left Zone .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Zone.

2. Hide/Show the right zone in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● In the Notations toolbox, click the button for any panel you want to show, or the active 
button for the panel you want to hide.

● Choose Window > Show Right Zone.
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3. Hide/Show the lower zone in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Lower Zone.

4. Hide/Show all zones in any of the following ways:

● Press Ctrl/Cmd-0 .

● In the toolbar, click Hide/Restore Zones .

● Choose Window > Hide/Restore Zones.

RESULT
The corresponding zones are hidden/shown.

If you hide all active zones, the Hide/Restore Zones button in the toolbar indicates which zones 
were previously active but are now hidden.

TIP

● You can assign key commands for showing specific panels in the lower zone on the Key 
Commands page in Preferences.

● You can choose to hide the right/left zones when the lower zone is shown, and vice versa, 
automatically in all future projects in Preferences > General > Window.

EXAMPLE

Hide/Restore Zones button when zones are shown Hide/Restore Zones button when all zones were 
previously shown but are now all hidden

RELATED LINKS
Zones and panels on page 35
Toolbar on page 28
Disclosure arrows on page 40
Properties panel on page 560
Preferences dialog on page 53
Key Commands page in the Preferences dialog on page 54

Opening new tabs
You can open multiple tabs in the same project window, which you can use to display multiple 
layouts or different views of the same layout. For example, you can show your full score layout in 
page view in one tab and in galley view in another tab.

Each tab can contain a separate layout or a different view of a layout already open in another tab 
or window. Whenever you open a new tab, you are prompted to select a layout that you want to 
display in the tab.

You can find tabs in the tab bar, located at the top of the music area, below the toolbar. If no tabs 
are shown, click Show Tabs  in the toolbar.

User interface
Workspace setup 

42
Dorico SE 4.3.30



PROCEDURE

1. Open a new tab in any of the following ways:

● Press Ctrl/Cmd-T .

● At the right end of the tab bar, click New Tab .

● Choose Window > New Tab.

A new tab opens that shows recent layouts at the top and a list of other layouts in the project 
at the bottom. If the tab bar was hidden, it is now shown.

2. Select a layout to open in the new tab in any of the following ways:

● Click one of the icons.

● In the list at the bottom, select a layout.

● In the toolbar, click the layout selector and select a layout.

RESULT
The layout that you choose opens in the active tab.

TIP

You can also switch between different layouts within the same tab.

RELATED LINKS
Tab bar on page 31
Toolbar on page 28
Switching between layouts on page 40
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Closing tabs
You can close individual tabs of layouts that you no longer need, and you can close multiple tabs 
at the same time.

PROCEDURE

● Close tabs in any of the following ways:

● Select the tab you want to close and press Ctrl/Cmd-W .

● Hover over the tab you want to close and click x.

● Right-click the single tab you want to close and choose Close Tab from the context 
menu.

● Right-click the tab you do not want to close and choose Close Other Tabs from the 
context menu.

NOTE

You cannot close the last tab in a window. If only one tab is open and you no longer want to 
see the tabs, deactivate Show Tabs in the main toolbar. The tab is no longer displayed, but 
the corresponding layout is still shown.

RESULT
If you selected a single tab and closed it, the selected tab and its corresponding layout are 
closed.

If you selected a single tab and closed other tabs, all open tabs except for the selected tab are 
closed.

Switching between tabs
You can switch between different open tabs to show different layouts in the music area.

PROCEDURE

● Switch tabs in any of the following ways:

● To cycle forwards through all open tabs, press Ctrl-Tab .

● To cycle backwards through all open tabs, press Ctrl-Shift-Tab .

● Click the tab to which you want to switch.

TIP

● You can choose to keep selected items in view automatically when switching between 
tabs and windows on the General page in Preferences.

● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Preferences dialog on page 53
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Changing the order of tabs
You can move tabs to a different position on the tab bar.

PROCEDURE

● Click and drag a tab to the new position.

The other tabs move to show where the dragged tab will be positioned.

Showing multiple tabs in the same project window
You can split your project window to display two tabs at the same time. The split can be either 
vertical or horizontal, allowing you to display different layouts either side by side or above one 
another.

PROCEDURE

1. Select the tab of the layout that you want to move to a new tab group.

2. Split the view in one of the following ways:

● To show layouts side by side, choose Window > Vertical Split.

● To show layouts above one another, choose Window > Horizontal Split.

RESULT
The project window is split to display two tabs at the same time. The selected tab is moved to the 
new tab group.

Moving tabs to another tab group
You can move tabs to other tab groups. For example, if you want to compare different layouts or 
two views of the same layout.

PREREQUISITE
You have opened at least two tabs, and they are both shown in the same project window.

PROCEDURE

● Click and drag the tab into the target tab group.

Moving tabs to other windows
You can move tabs to another open window of the same project to show the corresponding 
layouts in a new window. For example, if you want to compare two layouts on two displays.

NOTE

● The layouts must belong to the same project. If you attempt to move a tab to a window of a 
different project, a new window is created for the project to which the layout belongs.

● You can only move tabs to other windows if you have opened at least two tabs.

PROCEDURE

● Do one of the following:
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● To create a new project window with the tab inserted, either click and drag the tab away 
from the tab bar and release it, or choose Window > Move Tab To New Window. You 
can also right-click tabs and choose this option from the context menu.

● To move the tab to an existing project window, click and drag the tab onto the tab bar in 
the corresponding project window.

Opening multiple project windows
You can open multiple project windows for the same project; for example, if you want to work 
on multiple layouts at the same time. You can also show a different mode of the same project in 
each window, such as having one window show Write mode and another show Play mode.

During playback, all windows that belong to the same project show the playhead and move the 
view to follow the music.

PROCEDURE

● Open a new project window in any of the following ways:

● Press Ctrl/Cmd-Shift-T .

● Choose Window > New Window.

RESULT
A duplicate of the window opens. It contains the same tabs and the same view options as the 
original window.

TIP

You can choose to keep selected items in view automatically when switching between tabs and 
windows on the General page in Preferences.

RELATED LINKS
Playhead on page 455
Switching between tabs on page 44

Switching to full screen view
You can maximize the amount of screen space available for your music by making any project 
window cover the whole screen.

You can also hide the desktop elements provided by your operating system; for example, the 
task bar in Windows or the system menu bar and Dock in macOS.

Within Dorico SE, you can also hide/show the zones on the edges of the window.

PROCEDURE

● Choose View > Full Screen.

AFTER COMPLETING THIS TASK
To return to the default view, choose View > Full Screen again.

RELATED LINKS
Hiding/Showing zones on page 41
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Zooming in/out of the music area on page 406

Switching to galley/page view
You can switch between different view types in the music area in Setup mode and Write mode. 
For example, if a flute player in your project is doubling piccolo, you can switch to galley view to 
see the piccolo staff in addition to the flute staff.

PROCEDURE

1. Switch to galley or page view in any of the following ways:

● To switch to galley view, press Ctrl/Cmd-Alt/Opt-2 .

● To switch to page view, press Ctrl/Cmd-Alt/Opt-1 .

● In the status bar, select Galley View or Page View from the view selector.

2. Optional: If you selected Page View, choose one of the available page arrangements in the 
status bar.

● To show display pages in pairs as two-page spreads, with each pair laid out from left to 
right in a row, choose Spreads Horizontally .

● To display pages in pairs as two-page spreads, with each pair laid out from top to 
bottom in a column, choose Spreads Vertically .

● To display individual pages laid out from left to right, choose Single Pages Horizontally 

● To display individual pages laid out from top to bottom, choose Single Pages Vertically 
.

RESULT
The view type in the music area is changed. In page view, only staves containing notes or items 
are shown by default. For players holding multiple empty instruments, only the top instrument is 
shown in full scores.

In galley view, all staves in the project are shown. By default, guide bar numbers are shown 
above each staff and guide instrument labels are shown above each instrument. For players 
holding multiple instruments, the player name is also shown in guide instrument labels.

NOTE

● Note spacing is unjustified in galley view and there is no automatic vertical collision 
avoidance, so notes and items might overlap. You can change the default gaps between 
staves in galley view for each layout independently.

● The view type is reset to your default setting when you switch layouts.

● You can change the default view type used for all projects in Preferences > General > View.

● You can assign a key command for Toggle View Type on the Key Commands page in 
Preferences. This command switches between galley view and page view.

● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.
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AFTER COMPLETING THIS TASK
In galley view, you can use instrument filters to show only specific staves.

RELATED LINKS
Music area on page 32
View types on page 38
Switching between layouts on page 40
Status bar on page 36
Page arrangements for page view on page 39
Changing the staff spacing in galley view on page 532
Per-layout vertical spacing options on page 530
Preferences dialog on page 53
Key Commands page in the Preferences dialog on page 54
Moving the view in the music area on page 405
Hiding/Showing guide bar numbers on page 680
Renaming players on page 159

Changing the application language
You can change the language used for the user interface in the current project and all future 
projects you open; for example, if your operating system language is different to the language 
you want to use in Dorico SE.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the General section, select the language you want to use from the Language menu.

4. Click Apply, then Close.

RESULT
The language used for the user interface in the current project and all future projects is changed. 
If your keyboard language is set to Default, the keyboard language is also changed.

RELATED LINKS
Preferences dialog on page 53
Changing the keyboard language on page 59

Changing your preferred unit of measurement
You can change your default preferred unit of measurement to be used throughout Dorico SE for 
options that use absolute measurements, such as the size of page margins in Layout Options.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the General section, select one of the following options from the Preferred unit of 
measurement menu:

● Points (pt)

● Millimeters (mm)
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● Inches (in)

● Centimeters (cm)

4. Click Apply, then Close.

Color setup
Dorico SE allows you to change the colors used in different contexts, including for project 
windows and pages in each type of layout.

RELATED LINKS
Annotations on page 507
Hiding/Showing voice colors on page 1135
Hiding/Showing colors for notes out of range on page 847

Changing the window color theme
You can change the color theme used throughout Dorico SE; for example, you might switch to 
the light theme if you prefer to read dark text on a light background. By default, Dorico SE uses 
the dark theme, which shows light text on a dark background.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Window section, select one of the following options from the Theme menu:

● Dark

● Light

4. Click Apply, then Close.

RESULT
The color theme used in Dorico SE is changed. This affects the current project immediately and 
all future projects you open, until you next change your setting.

EXAMPLE

Dark theme Light theme
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Changing the page color
You can change the color of pages in each of the different layout types; for example, to help you 
identify whether you are in a part layout or full score layout, or to make reading the music easier 
or more comfortable.

By default, full score and custom score layouts have white pages, while part layouts have cream 
pages.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Page Colors section, change the page color for Full score layouts, Part layouts, 
and/or Custom score layouts in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

4. Click Apply, then Close.

RESULT
The page color in layouts of the corresponding type is changed in the current project and 
all future projects you open. This does not affect the resulting page color when exporting or 
printing layouts.

TIP

You can reset page colors back to the default factory settings by clicking Reset  for each layout 
type.

RELATED LINKS
Layouts on page 151
Printing layouts on page 491
Exporting layouts as graphics files on page 495

Changing the background color
You can change the background color of the music area. The background can be a gradient of up 
to four colors or a single block color.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Background Colors section, choose one of the following options for Use for Write 
mode:

● Gradient

● Single Color

4. Change the background color in one of the following ways:

● If you chose Gradient and want to use a preset selection of colors, select it from the 
Preset menu.
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● If you chose Gradient and want to use a custom selection of colors, either click each 
color preview and select a color in the dialog that opens, or enter color codes into the 
value fields.

● If you chose Single Color, either click the Stop 1 color preview and select a color in the 
dialog that opens, or enter a color code into the value field.

RESULT
The background color is changed in the current project and all future projects you open.

TIP

● The background color set for Write mode is also used in Setup mode.

● You can reset background colors back to the default factory settings by clicking Reset .

Changing music area colors
You can change the colors used for various purposes in the music area, including the first eight 
voice colors on each staff and the color of selected items. For example, if you find specific color 
combinations easier to read than others.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Voice Colors section, change the color for each voice in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

4. In the Other Colors section, change the color for each item in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

5. Click Apply, then Close.

RESULT
The color of the corresponding voices and items is changed in the current project and all future 
projects you open.

TIP

You can reset colors back to the default factory settings by clicking Reset  for each voice or 
item.

RELATED LINKS
Preferences dialog on page 53
Annotations on page 507
Hiding/Showing voice colors on page 1135
Hiding/Showing colors for notes out of range on page 847
Selecting notes/items on page 387
Caret on page 191
MIDI recording on page 240
Playhead on page 455
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Tablature on page 1048
Linked dynamics on page 767
Linked slurs on page 1027

Inverting colors
You can invert the colors used for music and pages in Dorico SE, which by default shows white 
music on black pages. You can then customize the inverted page color; for example, to show 
white music on a blue background.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Page Colors section, activate Invert colors for music (white on black).

4. Change the inverted page color in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

5. Click Apply, then Close.

RESULT
The colors for music and pages are inverted in the current project and all future projects you 
open. Music always appears white, while pages use the inverted page color you set. This does 
not affect the resulting colors when exporting or printing layouts.

Deactivating Invert colors for music (white on black) returns music/page colors to their non-
inverted configuration.

TIP

You can reset the inverted page color back to the default factory setting by clicking Reset .

Changing the color of items
You can change the color of individual notes and items; for example, to distinguish specific items 
when creating educational worksheets. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items whose color you want to change.

2. In the Properties panel, activate Color in the Common group.

3. Click the color preview to open the Select Color (Windows)/Colors (macOS) dialog.

4. Select or create the color you want.

5. Click OK to save your changes and close the dialog.
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RESULT
The color of the selected items is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Preferences dialog
The Preferences dialog allows you to change how Dorico SE functions by default across all 
projects.

You can open Preferences in any of the following ways:

● Press Ctrl/Cmd-, .

● Choose Edit > Preferences (Windows) or Dorico > Preferences (macOS).

The Preferences dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section
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Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

NOTE

The arrangement of options on the Key Commands page is significantly different to other 
pages in the Preferences dialog. This page is described separately in further detail.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .

● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Reset to Factory

Resets all the options in the dialog back to the default factory settings.

RELATED LINKS
View types on page 38
Zoom options on page 39
Selection tools on page 37
Layout Options dialog on page 622
Key commands on page 16
Changing values in numeric value fields on page 562

Key Commands page in the Preferences dialog
The Key Commands page in the Preferences dialog allows you to view all the functions to which 
you can assign key commands, change existing key commands, and assign new key commands 
to functions that have no key command assigned by default.

Assigning your own key commands can be helpful for items or actions that you find yourself 
performing regularly, such as setting specific rhythmic grid resolutions or exporting all layouts to 
PDF.

● You can find the Key Commands page by opening the Preferences dialog and clicking Key 
Commands in the category list.
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The Key Commands page comprises the following:

1 Search field

Allows you to search for functions to view, change, or add key commands. Because there 
are multiple levels of disclosure arrows before you reach many functions, this is often the 
quickest way to find what you are looking for.

2 Functions

Displays the functions that can be assigned key commands. The list can be filtered using 
the Search field. Disclosure arrows beside options indicate that further options are available 
when the option is expanded.

Hovering over functions shows a tool tip, which is helpful for some functions with 
particularly long names.

3 Key Commands section

Displays any existing key commands set in the current keyboard language for the function 
selected in the list of assigned key commands, and allows you to assign new key commands.

● Keyboard language: Allows you to change the keyboard language used for key 
commands.

● Add Key Command: Adds the key command you pressed to the selected function.

NOTE

● You can assign multiple key commands to the same function.

● If you enter a key command that is already assigned to another function, a warning 
is shown.

● Remove Key Command: Removes the selected key command from the selected 
function.

● Print Summary: Directs you to an offline page in a web browser that displays your key 
commands on an interactive keyboard.

● Reset Key Commands: Resets all of your key commands to their defaults.

4 MIDI Learn section

Allows you to assign MIDI controllers, notes, and combinations of notes to control functions.
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● MIDI Learn : Prepares Dorico SE to receive the MIDI input data that you want to save 
as a command.

● Add MIDI Command: Adds the MIDI controllers or notes you changed or pressed to the 
selected function.

● Remove MIDI Command: Removes the MIDI command from the selected function.

5 Jump Bar Alias section

Allows you to assign aliases that you can enter into the jump bar to perform the 
corresponding function.

● Alias field: Allows you to enter a jump bar alias for the selected function.

● Add Alias: Adds the characters you entered as the jump bar alias for the selected 
function.

● Remove Alias: Removes the existing jump bar alias from the selected function.

RELATED LINKS
Key commands in Dorico on page 25
Assigning key commands on page 58
Assigning MIDI commands on page 58
Jump bar on page 60

Interactive Dorico key commands map
The interactive Dorico Key Commands map shows a virtual computer keyboard, with keys that 
have been assigned key commands highlighted in different colors according to the modifier 
keys they contain. All key commands for the selected keyboard language layout are listed below, 
divided into global and mode-specific groups.

You can open the Dorico Key Commands map in any of the following ways:

● Choose Help > Key Commands.

● In the Preferences dialog, click Key Commands in the category list, then click Print 
Summary in the Key Commands section.
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The interactive key commands map as it appears when US English is selected

The Dorico Key Commands map opens in a web browser. It allows you to do any of the 
following:

● To see the available key commands, select a context. The context of a key command is the 
mode in which it can be used. Key commands that have a global context work in all modes.

● To highlight the keys that you can press in combination with modifier keys to form a key 
command, press one or more modifier keys on your computer keyboard, such as Shift  or 
Ctrl/Cmd - Alt/Opt , or click a modifier key on the virtual keyboard. The virtual computer 
keyboard highlights the pressed/clicked keys and displays the assigned functions on each 
key.

● To search for a specific key command, enter one or multiple words in the search field.

● To get an overview of all available key commands, browse the key commands that are listed 
below the virtual keyboard. The key commands are listed according to the context in which 
they can be used.

RELATED LINKS
Changing the keyboard language on page 59

Searching for the key commands of functions
You can search for key commands that are assigned to functions or menu items in Dorico SE.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Enter the name of a function in the Search field.

The entries that are listed below are filtered according to the words that you enter.

4. Expand an entry and select the function for which you want to see the key command.
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For particularly long names, you can hover over them to see a tool tip.

RESULT
If the function has a key command, it is shown in the list of assigned key commands.

TIP

You can also search for functions in the interactive key commands map.

Assigning key commands
You can assign key commands to many functions; for example, for functions you use frequently 
but that do not have a key command assigned by default. You can also change existing key 
commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Search for the name of a function and select it.

For particularly long names, you can hover over them to see a tool tip.

4. Optional: If the function already has an assigned key command, click Remove Key 
Command in the Key Commands section.

If you assign a new key command without removing an existing one, you can use either key 
command.

5. Click the Press shortcut input field.

6. Press the key command that you want to assign on your computer keyboard.

7. Click Add Key Command.

8. Click Apply, then Close.

RESULT
The key command you pressed is added to the list of assigned key commands for the selected 
menu item or function. You can use it immediately.

RELATED LINKS
Resetting key commands on page 60

Assigning MIDI commands
You can assign specific keys or buttons on your MIDI keyboard to perform functions and access 
menu items. For example, if you want to navigate using MIDI keys during chord symbol input.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Select the menu item or function to which you want to assign MIDI commands.

For particularly long names, you can hover over them to see a tool tip.

4. In the MIDI Learn section, click MIDI Learn .
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5. Press the key or button on your MIDI keyboard that you want to assign to the selected 
parameter.

6. Click Add MIDI Command.

7. Click Apply, then Close.

Changing the keyboard language
You can change the keyboard language used for key commands in Dorico SE; for example, if the 
application language is set to German, but you are using an English keyboard and want to use 
English key commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Select the keyboard language you want to use for key commands from the Keyboard 
language menu.

NOTE

Default follows the application language.

4. Click Apply, then Close.

RESULT
The keyboard language used for key commands in the current project and all future projects is 
changed.

RELATED LINKS
Changing the application language on page 48

Removing key commands
You can remove individual key commands from a function.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Search for the name of a function and select it.

4. In the Key Commands section, click Remove Key Command.

5. Click Apply, then Close.

RESULT
The key command is removed from the selected function.

RELATED LINKS
Searching for the key commands of functions on page 57
Removing jump bar aliases on page 63
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Resetting key commands
You can reset all the key commands in your project to their defaults.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. In the Key Commands section, click Reset Key Commands.

4. Click Apply, then Close.

RESULT
All custom key commands are deleted and the default key commands are reinstated.

Jump bar
The jump bar is a temporary value field that allows you to perform commands and go to 
locations in the current layout using only your computer keyboard.

● You can show the jump bar in Setup, Write, and Play modes by pressing J .

Jump bar in Commands mode with an example entry

Commands

In Commands mode, you can use the jump bar to perform commands, such as opening the 
Layout Options dialog with the specified page already selected.

● You can switch the jump bar to Commands mode by pressing Alt-C (Windows) or 
Ctrl-1 (macOS) .

When you start entering text into the jump bar in Commands mode, a menu appears that shows 
valid commands containing the letters/words you enter.

If you show the jump bar in Commands mode after performing a command, your previous entry 
is shown with its text selected.

You can press Down Arrow  to show a list of up to five commands that you perform most 
frequently.
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NOTE

● You can only perform commands using the jump bar in the same contexts as you can 
perform the corresponding action. For example, you can only perform Setup mode-specific 
actions in Setup mode.

● You can assign jump bar aliases to specific commands; for example, so you can use shorter 
entries for your favorite commands.

● If commands have a corresponding key command or jump bar alias, they are shown in the 
menu of valid commands.

Go To

In Go To mode, you can use the jump bar to go to bars, rehearsal marks, pages, and flows.

● You can switch the jump bar to Go To mode by pressing Alt-G (Windows) or Ctrl-2 (macOS) .

Example move Jump bar entry

Go to bar number [n]; for example, bar 
number 32

b[n]; for example, b32 or b+32

Go to rehearsal mark [n]; for example, 
rehearsal mark K

r[n]; for example, rK or rk

Go to page number [n]; for example, page 6 p[n]; for example, p6 or p+6

Go to flow number [n]; for example, flow 3 f[n]; for example, f3 or f+3

Go to the next flow fn

Go to the previous flow fp

EXAMPLE
To go to bar 20 in flow 3, enter f3b20.

RELATED LINKS
Navigation on page 402
Key commands in Dorico on page 25
Key Commands page in the Preferences dialog on page 54
Properties panel on page 560
Popovers on page 21
Notations input on page 246
Layout Options dialog on page 622

Going to locations with the jump bar
You can use the jump bar to go to bars, rehearsal marks, pages, and flows in Setup, Write, and 
Play modes.

PROCEDURE

1. Press J  to show the jump bar.
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2. Optional: Press Alt-G (Windows) or Ctrl-2 (macOS)  to switch to Go To mode.

3. Enter the appropriate entry for the location to which you want to go.

For example, enter f3b20 to go to bar 20 in flow 3.

4. Press Return .

Performing commands with the jump bar
You can use the jump bar to perform commands, such as opening the Layout Options dialog 
with the specified page already selected, in Setup, Write, and Play modes.

PREREQUISITE
If you want to perform mode-specific commands, you are in the corresponding mode.

PROCEDURE

1. Press J  to show the jump bar.

2. Optional: Press Alt-C (Windows) or Ctrl-1 (macOS)  to switch to Commands mode.

3. Select the command you want to perform in any of the following ways:

● Enter relevant text into the jump bar.

When you start entering text into the jump bar in Commands mode, a menu appears 
that shows valid commands containing the letters/words you enter, which you can select 
by pressing Up Arrow / Down Arrow .

● Enter the appropriate jump bar alias into the jump bar.

● To show a list of up to five commands that you perform most frequently, press 
Down Arrow , then press Up Arrow / Down Arrow  to select a command.

4. Press Return .

Assigning jump bar aliases
You can assign jump bar aliases to specific commands; for example, so you can use shorter 
entries for your favorite commands.

PROCEDURE

1. Press J  to show the jump bar.

2. Optional: Press Alt-C (Windows) or Ctrl-1 (macOS)  to switch to Commands mode.

3. Enter the command to which you want to assign an alias into the jump bar.

TIP

To ensure the command is entered correctly, select it from the menu of valid commands by 
pressing Up Arrow / Down Arrow .

4. Immediately after the command, enter = followed by the characters you want to use as the 
jump bar alias.

For example, to assign the jump bar alias rr to the Remove Rests command, enter Remove 
Rests=rr.

5. Do one of the following:

● To perform the command and assign the jump bar alias, press Return .
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● To assign the jump bar alias only, without performing the command, press Alt/Opt-
Return .

RESULT
The characters you entered after the = are assigned as the jump bar alias for the specified 
command.

TIP

You can also assign jump bar aliases on the Key Commands page in Preferences.

RELATED LINKS
Jump bar on page 60
Key Commands page in the Preferences dialog on page 54

Removing jump bar aliases
You can remove jump bar aliases you have assigned to specific commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Search for the name of a function and select it.

4. In the Jump Bar Alias section, click Remove Alias.

5. Click Apply, then Close.

RESULT
The jump bar alias is removed from the selected function.
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Project and file handling

In addition to opening and importing/exporting projects and other file formats, project and file 
handling also includes auto-save and project backups.

RELATED LINKS
Starting new projects on page 66
Opening projects/files on page 67
File import and export on page 73
Auto-save on page 89
Project backups on page 91

Hub
The Hub allows you to access recent projects, start new projects, and keep up-to-date with 
learning materials including tutorials, videos, and blog updates. The Hub opens automatically 
when you start Dorico SE.

● You can also open the Hub by choosing Window > Hub.

The Hub contains the following pages:

Open Recent
Allows you quick access to the projects that you worked on last. You can scroll through 
the list to access recent projects out of view. You can navigate through recent projects 
by pressing Up Arrow / Down Arrow .

Double-clicking a recent project, or selecting it and pressing Return , opens the 
project.

You can choose one of the following view types for recent projects:

● Grid view 
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● List view 

When recent projects are shown in the grid view, you can click the menu button  for 
each project to access the following options:

● Remove from Recent Projects: Removes the project from the Recent Projects 
page.

● Open Enclosing Folder: Opens the File Explorer/macOS Finder and shows the 
folder where the project is saved.

Create New
Allows you to start new projects from project templates or choose an empty project.

The Choose a template list on the left allows you to select a project template category, 
with available project templates in the selected category listed in the middle. The 
Empty project template creates a project with no players or flows.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two. 
Only categories and project templates containing one or two players are available.

On the right, the Project Options section provides the following options:

● Project title: Allows you to enter the project title.

● Composer: Allows you to enter the project composer.

● Page size: Allows you to select the page size for the full score layout.

● Page orientation: Allows you to choose whether the page orientation in the full 
score layout is Portrait  or Landscape .

● Rastral size: Allows you to select the staff size for the full score layout.

● Project will use multiple flows: When activated, flow headings are shown in 
all layouts, and flow titles are shown in running headers in score layouts. When 
deactivated, flow headings are hidden in all layouts, and the project title is shown 
in running headers in score layouts.

● Music font: Allows you to select the music font used in the project.

● Text font: Allows you to select the font family used throughout the project by 
default.

● Time signature: Allows you to specify a time signature for the project. When 
deactivated, the project starts with no time signature, which is treated as open.

● Bars: Allows you to set the number of bars you want the project to contain.

● Key signature: Allows you to specify a key signature for the project. When 
deactivated, the project starts with no key signature, which is treated as atonal.

At the bottom of the Hub, Create project creates a new project using the selected 
project template and project options. You can also double-click project templates to 
start a new project.

Learn
Provides access to learning materials. Dorico SE displays a notification when new 
materials are available.

● Hands-on tutorials: Displays available practical tutorials that introduce you to 
common operations directly in Dorico demo projects.

● Videos: Displays recent Dorico video tutorials. Double-clicking a video tutorial, or 
selecting it and clicking Watch Now, opens it in a web browser.

Project and file handling
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You can find more tutorial videos and information about new features on the 
Dorico YouTube channel.

● Forum: Links you to the Steinberg user forum.

● Manual: Links you to the online documentation. A PDF version is also available on 
steinberg.help.

● Dorico Blog: Displays recent entries in the Dorico blog. Clicking a blog entry opens 
it in a web browser.

At the bottom of the Hub, Open or Import File allows you to search for and open MusicXML, 
MIDI, and Dorico project files.

At the top of the Hub, Upgrade links you to the Steinberg online shop where you can upgrade to 
Dorico Elements or Dorico Pro.

RELATED LINKS
Toolbar on page 28
Opening recent projects from the Hub on page 68
Project templates on page 73
Project Info dialog on page 70
Types of page templates on page 549
Staff size on page 527

Starting new projects
You can start new projects from project templates, such as for orchestra or a vocal ensemble. 
You can also start empty projects.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two. Only 
categories and project templates containing one or two players are available.

PROCEDURE

1. Optional: If the Hub is not open, choose Window > Hub to open the Hub.

2. In the Hub, click Create New to show the Create New page.

3. Choose one of the following project template categories:

● Band

● Chamber

● Choral

● Empty

● Jazz

● Orchestral

● Solo

4. Choose a project template.

5. In the Project Options section, add or change information and settings as required.

NOTE

The Project Options section does not affect Empty project templates.
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6. Create a new project in any of the following ways:

● Click Create project.

● Double-click the project template.

RESULT
A new project is created using the selected project template.

TIP

● You can start a new, empty project at any time by pressing Ctrl/Cmd-N  or choosing File > 
New.

● You can also start a new project from a project template by choosing File > New From 
Project Template > [Project template category] > [Project template].

AFTER COMPLETING THIS TASK
You can customize your project, such as by adding or deleting players/instruments.

RELATED LINKS
Hub on page 64
Project templates on page 73
Brackets according to ensemble type on page 709
Adding players on page 108
Adding instruments to players on page 120
Deleting players on page 112
Deleting instruments on page 123

Opening projects/files
You can open Dorico projects at any time and in addition to other open projects; for example, if 
the project you want to open is not listed as a recent project in the list in the Hub. You can also 
open MusicXML and MIDI files.

PROCEDURE

1. Open the File Explorer/macOS Finder in any of the following ways:

● In the Hub, click Open or Import File.

● Choose File > Open.

● Choose File > Open Recent > [Project file name].

2. Locate and select the files you want to open.

3. Click Open.

RESULT
The selected files are opened.

If you opened MusicXML or MIDI files, Dorico SE creates new project files from the MusicXML or 
MIDI content, which you can save as default Dorico projects.

If MusicXML files include page size, margin, and staff size settings, Dorico SE imports those 
values. If they are not included, Dorico SE creates suitable settings according to the number of 
instruments in the file.
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NOTE

● You can also import MusicXML and MIDI files as new flows in existing projects, rather than 
opening them as separate projects.

● In Dorico SE, the maximum number of players you can have in a single project is two. If you 
open a project that contains more than two players, it opens in read-only mode.

RELATED LINKS
Read-only mode on page 92
Hub on page 64
Importing MusicXML files on page 77
Importing MIDI on page 80

Opening recent projects from the Hub
You can open projects you have recently worked on from the Hub.

PROCEDURE

1. Optional: If the Hub is not open, choose Window > Hub to open the Hub.

2. In the Hub, click Open Recent to show the Open Recent page.

3. Double-click the recent project you want to open.

RESULT
The selected Dorico project is opened.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two. If you open 
a project that contains more than two players, it opens in read-only mode.

Projects from different versions of Dorico
You can open projects that were last saved in other versions of Dorico than the one you have. In 
such cases, Dorico SE shows a warning message to make you aware of any implications.

The contents of the warning message vary according to the version of Dorico in which the project 
was last saved:

● When opening a project last saved in an older version, it shows the version number the 
project was last saved in and informs you that the project will be updated to your current 
version.

● When opening a project last saved in a newer version, it shows only that the project is from 
a newer version. It also informs you that items and notations from that version might not 
appear and will be deleted if you save the project in your current version.

In both cases, opening the project is non-destructive. This means that its contents and 
formatting are unaffected if you do not save it.

You can prevent Dorico SE from showing you warnings about projects from different versions 
in the Files section of the General page in Preferences. In the same section, you can also tell 
Dorico SE to prompt you to choose a new location for projects from different versions when you 
save them. This reduces the risk of you overwriting them by mistake.

Project and file handling
Projects from different versions of Dorico 

68
Dorico SE 4.3.30



RELATED LINKS
Preferences dialog on page 53

Missing Fonts dialog
The Missing Fonts dialog appears when you open a project that contains a font that you do not 
have installed on your computer. It allows you to select replacement fonts that are installed on 
your computer as substitutes.

The Missing Fonts dialog displays a table with multiple columns that identify the specific font 
families and styles that are missing for font, character, and paragraph styles and text items. 
Every place in the project where a font is missing has its own row. For example, if the bold style 
of a font family is used in three different paragraph styles, three rows are shown in the dialog, 
one for each paragraph style.

The Missing Fonts dialog comprises the following:

1 Missing Family

Contains a list of font families included in the project but missing on your computer.

2 Missing Style

Contains a list of the specific styles within the corresponding font families that are included 
in the project but missing on your computer.

3 Used By

Contains a list of the places in the project where the corresponding font is used.

4 Replacement Family

Allows you to select replacement font families. You can select replacement font families by 
double-clicking entries, then either entering the font family you want or clicking the arrow 
and selecting a font family from the menu. Once selected, their names are displayed in the 
corresponding entry.

5 Replacement Style
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Allows you to select any of the available styles within the corresponding replacement font 
families. You can select replacement font styles by double-clicking entries, then either 
entering the font style you want or clicking the arrow  and selecting a font style from 
the menu. Once selected, the styles are displayed in the corresponding entry.

6 Fonts

Contains a list of all the available fonts installed on your computer. You can access the menu 
in the Replacement Family and Replacement Style columns by double-clicking any entry.

TIP

● You can choose whether or not the Missing Fonts dialog appears when you open a project 
containing fonts not installed on your computer on the General page in Preferences.

● You can change the width of columns in the Missing Fonts dialog. Their widths are 
remembered in future projects.

RELATED LINKS
Preferences dialog on page 53
Text editor options in Write mode on page 357

Project Info dialog
The Project Info dialog allows you to specify information about the whole project and each 
flow within it separately, such as the title, composer, and lyricist, as these might be different for 
different flows. You can then refer to these entries using tokens in text frames.

You can open the Project Info dialog in any mode in any of the following ways:

● Press Ctrl/Cmd-I .

● Choose File > Project Info.
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The Project Info dialog comprises the following:

1 Flows list

Contains all the flows in the project, with a separate entry for the project as a whole at the 
top. You can select individual or multiple flows in the flows list.

NOTE

The flows list uses the names of flows as shown in the Flows panel in Setup mode, which can 
be different to their entry in the Title field if you have changed their flow title.

The action bar at the bottom of the list contains the following options:

● New Flow : Creates a new flow with no information. Its default name is New Flow.

● Duplicate Flow : Creates a new flow with all the information of the selected flow. Its 
default name is Copy of [selected flow].

● Rename Flow : Opens the Rename Flow dialog, which allows you to change the name 
of the flow.

NOTE

If you have already manually changed the flow title, changing the name of the flow does 
not automatically change the flow title.

● Move Down : Moves the selected flows down the flows list, which changes their order 
in the project.
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● Move Up : Moves the selected flows up the flows list, which changes their order in the 
project.

● Delete Flow : Deletes the selected flows.

2 Information fields

Allow you to enter information about the currently selected flows or the whole project in 
the corresponding field, such as Composer and Lyricist. If you have selected multiple flows 
with different entries in the same fields, such as flows with different composers, those fields 
display Mixed.

3 Generate preview thumbnails when saving

When activated, Dorico SE generates the following preview images of the layout open in the 
music area when you save the project:

● PNG file of the first page. This is displayed on the Open Recent page in the Hub.

● PDF file of the whole layout.

When deactivated, Dorico SE does not generate preview images. This reduces the file size 
and can make saving large projects quicker.

4 Copy info from menu

Allows you to select another flow or the whole project whose information you want to copy; 
for example, for a project containing multiple flows that all have the same composer and 
lyricist.

5 Copy

Copies all the information from the specified flow/project to the selected flows/project.

NOTE

● The information you add in Project Info only appears on pages where the corresponding 
tokens exist. For example, if you want to display a dedication above the project title, you 
must add the dedication token to the First page template.

● You cannot specify line breaks in single-line fields. However, you can enter line breaks in 
larger fields, namely Copyright and Other information, which you can then copy into 
single-line fields.

● By default, First page templates have tokens that refer to project information. If you only 
enter information for individual flows in the Project Info dialog, that information does not 
automatically appear on pages that use the First page template.

RELATED LINKS
Tokens on page 552
Flows on page 148
Flow names and flow titles on page 164
Reordering flows on page 150
Starting new projects on page 66
Opening projects/files on page 67
Front matter on page 801
Page templates on page 547
Types of page templates on page 549
Hub on page 64
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Project templates
Project templates allow you to start new projects that already contain a particular set of players 
and project library settings. For example, full score layouts in orchestral project templates have 
larger page sizes than in chamber ensemble project templates.

Dorico SE provides the following project template categories:

Band
Ensembles containing mostly woodwind and brass instruments, such as brass band or 
pit band.

Chamber
Typically small ensembles containing only a few players, such as string quartet.

Choral
Ensembles containing voices, including popular choir arrangements, such as SATB 
unaccompanied.

Empty
An empty project template.

Jazz
Popular ensembles commonly used to perform jazz, such as big band or jazz trio.

Orchestral
Large ensembles containing most Western instruments, including strings, woodwinds, 
brass, and percussion.

Solo
Ensembles containing only a single player/instrument, such as a solo organ, guitar with 
tablature, or lead sheet.

RELATED LINKS
Brackets according to ensemble type on page 709
Starting new projects on page 66
System objects on page 1044
Page formatting on page 508
Page templates on page 547
Library on page 622
Hub on page 64

File import and export
External files are files in different formats than Dorico projects, such as MIDI, MusicXML, or 
tempo tracks. It is possible in Dorico SE both to import and export different types of files.

This can be useful if, for example, you want to share your project with others who use a different 
notation software, or to convert the notes, audio, or time signatures and tempo information in 
your project into other formats.

RELATED LINKS
Exporting lyrics on page 826
Exporting layouts as graphics files on page 495

Project and file handling
Project templates 

73
Dorico SE 4.3.30



Importing flows
You can import individual flows into existing projects; for example, if you want to bring together 
multiple existing pieces into one project for publishing, or if you have an empty project file with 
your preferred settings saved and want to reuse those settings.

PROCEDURE

1. Choose File > Import > Flows to open the File Explorer/macOS Finder.

2. Locate and select the project files of the flows you want to import.

3. Click Open to open the Flow Import Options dialog for the first selected project.

4. In the Flow Import Options dialog, choose one of the following options for Player 
handling:

● Create All New Players

● Merge with Existing Players Where Possible

5. In the Import flows list, activate the checkbox for each flow you want to import.

You can also click Select All or Select None at the bottom of the list.

6. Click OK to import the selected flows and close the dialog.

7. Optional: If you selected multiple projects from which to import flows, repeat steps 4 to 6 for 
each project. The Flow Import Options dialog reopens automatically for each project.

RESULT
The selected flows are imported into the project.

● If you chose Create All New Players, new players are added as required for each flow.

● If you chose Merge with Existing Players Where Possible, any players that the imported 
flows and existing project have in common are merged; for example, if you imported a flow 
containing one piano into a project containing a piano and viola, the imported flow is added 
to the existing piano player.

NOTE

● Players are not automatically added to flows that you imported into the project.

● You can also open flows directly if you want them to be separate projects, rather than new 
flows in existing projects.

RELATED LINKS
Opening projects/files on page 67
Flows on page 148
Adding flows on page 148
Duplicating flows on page 149
Reordering flows on page 150
Deleting flows on page 151

Flow Import Options dialog
The Flow Import Options dialog allows you to determine whether players in imported flows are 
merged with existing players in the project and which flows from within other projects you want 
to import.

● You can open the Flow Import Options dialog by choosing File > Import > Flows and 
opening a Dorico project from the File Explorer/macOS Finder.
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The Flow Import Options dialog comprises the following:

1 Player handling

Allows you to determine how imported flows are assigned to players.

● Create All New Players adds separate players for each imported flow.

● Merge with Existing Players Where Possible merges players from imported flows with 
any existing compatible players in the project.

2 Import flows

Contains a list of all the flows in the selected project. Flows are included in the import when 
their checkbox is activated.

3 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to import.

Exporting flows
You can export individual flows from projects; for example, to save small excerpts of large 
projects separately.

NOTE

These steps export flows as separate Dorico projects. If you want to export flows as other file 
formats, such as MusicXML or MP3, there are different methods.

PREREQUISITE
If you want the exported flows to include all players and layouts in the project, including players 
with no music, you have deactivated Omit excluded players and layouts when exporting flows 
in Preferences > General > Files.

PROCEDURE

1. Choose File > Export > Flows to open the Export Flows dialog.

2. Activate/Deactivate Export each selected flow as a separate file.

3. In the Select flows to export list, activate the checkbox for each flow you want to export.

You can also click Select All or Select None at the bottom of the list.
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4. Activate/Deactivate Export layouts as separate files.

5. Optional: If you activated Export layouts as separate files, activate the checkbox for each 
layout you want to export in the Select layouts to export list.

You can also click Select All or Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Choose to insert the new path in the Export to field.

9. Activate/Deactivate Create folder for exported files.

10. Click OK to export the selected flows and layouts and close the dialog.

RELATED LINKS
Flows on page 148
Exporting MusicXML files on page 79
Exporting MIDI on page 82
Exporting tempo tracks on page 85
Exporting audio on page 86

Export Flows dialog
The Export Flows dialog allows you to save individual flows and layouts as separate Dorico files.

● You can open the Export Flows dialog by choosing File > Export > Flows.

The Export Flows dialog contains the following options and lists:

1 Export each selected flow as a separate file

Allows you to export each flow as a separate file instead of all the selected flows as a single 
file.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.
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3 Export layouts as separate files

Allows you to export each layout in the project as a separate file instead of as a single file.

4 Select layouts to export

Contains a list of all the layouts in the project. Layouts are included in the export when their 
checkbox is activated. Only available if you have activated Export layouts as separate files.

5 Selection options

Allow you to select/deselect all the flows/layouts in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

6 Create folder for exported files

Controls whether or not Dorico SE generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name; for example, “Flows from Smyth - String Quintet”.

7 Export to field

Displays the export path where exported flows will be saved.

8 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Importing MusicXML files
You can import MusicXML files into existing Dorico SE projects as separate flows; for example, to 
continue work on a piece started in a different notation software.

PREREQUISITE
You have set your preferences for importing MusicXML files as appropriate for the file on the 
MusicXML Import page in Preferences.

PROCEDURE

1. Choose File > Import > MusicXML to open the File Explorer/macOS Finder.

2. Locate and select the MusicXML files you want to import.

3. Click Open to open the Flow Import Options dialog for the first selected MusicXML file.

4. In the Flow Import Options dialog, choose one of the following options for Player 
handling:

● Create All New Players

● Merge with Existing Players Where Possible

5. Click OK to import the selected flows and close the dialog.

6. Optional: If you selected multiple MusicXML files, repeat steps 4 and 5 for each file. The Flow 
Import Options dialog reopens automatically for each file.

RESULT
The selected MusicXML files are imported into the project as new flows.

● If MusicXML files include page size, margin, and staff size settings, Dorico SE imports those 
values. If they are not included, Dorico SE creates suitable settings according to the number 
of instruments in the file.

● If you chose Create All New Players, new players are added as required for each MusicXML 
file.
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● If you chose Merge with Existing Players Where Possible, any players that the imported 
MusicXML files and existing project have in common are merged; for example, if you 
imported a MusicXML file containing one piano into a project containing a piano and viola, 
the imported MusicXML file is added to the existing piano player.

TIP

You can also open MusicXML files directly if you want them to be separate projects, rather than 
new flows in existing projects.

RELATED LINKS
Flow Import Options dialog on page 74
Opening projects/files on page 67
Preferences dialog on page 53

Unpitched percussion imported from MusicXML files
Unpitched percussion music can be expressed in a number of ways in MusicXML. Scoring 
applications take different approaches to what data is exported and how it is encoded. Therefore, 
the results of importing MusicXML into Dorico SE vary considerably.

Dorico SE identifies each instrument in kits explicitly and then combines them dynamically onto 
five-line staves. Other scoring applications and MusicXML have a different approach to how 
unpitched percussion music is represented. For example, a drum set may be effectively notated 
as pitched notes on a five-line staff and annotated with additional information to help identify 
which instrument corresponds to each staff position.

Because of these different approaches, mapping information between the MusicXML 
representation and the Dorico SE representation can be challenging, so Dorico SE employs 
heuristics to improve the quality of results.

Typically, drum set instruments in MusicXML files exported from both Sibelius and Finale are 
imported quite cleanly into Dorico SE.

Results are particularly good, and more likely to be imported correctly, if the voicing of the drum 
set is consistent, such as consistently notating the snare drum in a down-stem voice. If the 
voicing changes from bar to bar, it is possible that some notes are either identified incorrectly or 
not imported at all.

Other kinds of percussion that are notated on five-line staves produce more variable results. 
In most cases, Finale includes information about which percussion instrument maps onto each 
staff position, but Sibelius does not. As a result, you might find that Dorico SE chooses different 
instruments than you expected, but you can change instruments using the Edit Percussion Kit 
dialog.

RELATED LINKS
Edit Percussion Kit dialog on page 136
Changing instruments in percussion kits on page 139
Adding instruments to percussion kits on page 139
Percussion editor on page 576
Importing MIDI on page 80
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Exporting MusicXML files
You can export flows and layouts as separate MusicXML files; for example, if you want to export 
just the soloist’s layout containing the first flow.

PROCEDURE

1. Choose File > Export > MusicXML to open the Export MusicXML dialog.

2. Choose one of the following file format options:

● Export compressed XML (.mxl)

● Export uncompressed XML (.xml)

3. In the Select flows to export list, activate the checkbox for each flow you want to export.

You can also click Select All or Select None at the bottom of the list.

4. Activate/Deactivate Export layouts as separate files.

5. Optional: If you activated Export layouts as separate files, activate the checkbox for each 
layout you want to export in the Select layouts to export list.

You can also click Select All or Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Choose to insert the new path in the Export to field.

9. Activate/Deactivate Create folder for exported files.

10. Click OK to export the selected flows/layouts as MusicXML files and close the dialog.

Export MusicXML dialog
The Export MusicXML dialog allows you to save individual flows and layouts as separate 
MusicXML files.

● You can open the Export MusicXML dialog by choosing File > Export > MusicXML.
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The Export MusicXML dialog contains the following options and lists:

1 File format options

Allows you to choose the MusicXML file format you want to export. Compressed MusicXML 
files contain the same information as uncompressed MusicXML files but have a smaller file 
size.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

3 Export layouts as separate files

Allows you to export each layout in the project as a separate file instead of as a single file.

4 Select layouts to export

Contains a list of all the layouts in the project. Layouts are included in the export when their 
checkbox is activated. Only available if you have activated Export layouts as separate files.

5 Selection options

Allow you to select/deselect all the flows/layouts in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

6 Create folder for exported files

Controls whether or not Dorico SE generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name; for example, “Flows from Smyth - String Quintet”.

7 Export to field

Displays the export path where exported files will be saved.

8 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Importing MIDI
You can import MIDI files into existing Dorico SE projects, as either separate flows or into existing 
flows; for example, to work on a different version of a section of a piece.

PREREQUISITE
You have set the options on the Play page in Preferences as required for the MIDI files you want 
to import.

PROCEDURE

1. Choose File > Import > MIDI to open the File Explorer/macOS Finder.

2. Locate and select the MIDI files you want to import.

3. Click Open.

RESULT
The selected MIDI files are imported into the project. Dorico SE uses an algorithm on imported 
MIDI notes to produce the correct enharmonic spelling.

If the MIDI files contained markers, they are also imported. If they have SMPTE offset values 
defined, Dorico SE uses them to set the timecode position for the start of the flow.
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TIP

You can also open MIDI files directly if you want them to be separate projects, rather than new 
flows in existing projects.

RELATED LINKS
Preferences dialog on page 53
Opening projects/files on page 67
Requantizing notes on page 243
Changing the sustain pedal controller settings for MIDI recording/import on page 245
Importing tempo tracks on page 83
Exporting tempo tracks on page 85

Quantization options
Quantization options allow you to customize the quantization you want to apply to notes when 
importing MIDI files, inputting notes using MIDI recording, or requantizing notes.

You can access the available quantization options in any of the following ways:

● In Preferences > Play > Quantization.

● When at least one note is selected in the music area, choose Edit > Requantize.

The following quantization options are available:

Quantization unit
Allows you to set the smallest beat unit to which you want notes to be quantized. For 
example, if the smallest intentional note duration in your imported file is an eighth 
note, set Quantization unit to eighth notes.

Detect tuplets
Allows you to control whether off-beat notes can be considered tuplets. If you know 
there are no intentional tuplets in your imported MIDI file, deactivating Detect tuplets 
ensures no notes are imported as tuplets.

Quantization unit for tuplets
Allows you to set the smallest beat unit to which you want tuplet notes to be quantized. 
For example, if the smallest intentional tuplet note duration in your imported file is a 
quarter note, set Quantization unit for tuplets to quarter notes.
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Fill gaps
Allows you to determine whether Dorico SE fills in gaps between short notes. If you are 
importing already precisely quantized music, we recommend that you deactivate Fill 
gaps to ensure that note and rest durations are notated exactly as quantized.

Detect grace notes
Allows you to determine whether Dorico SE interprets grace notes. When deactivated, 
Dorico SE turns grace notes into normal notes.

RELATED LINKS
MIDI recording on page 240
Requantizing notes on page 243
Tuplets on page 1104
Grace notes on page 803

Exporting MIDI
You can export flows as separate MIDI files; for example, if you want to edit the audio in further 
detail in a DAW. MIDI files exported from Dorico SE contain any markers in the project by default.

PREREQUISITE
You have opened a layout in the music area that contains the players whose MIDI you want to 
export.

PROCEDURE

1. Choose File > Export > MIDI to open the Export MIDI dialog.

2. In the Select flows to export list, activate the checkbox for each flow you want to export.

You can also click Select All or Select None at the bottom of the list.

3. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

4. Locate and select the destination folder you want.

5. Click Choose to insert the new path in the Export to field.

6. Activate/Deactivate Create folder for exported files.

7. Click OK to export the selected flows as MIDI files and close the dialog.

RESULT
The selected flows are exported as MIDI files. They contain the MIDI of all the players assigned to 
the layout open in the music area.

RELATED LINKS
Switching between layouts on page 40
Opening new tabs on page 42
Assigning players to layouts on page 153
Importing tempo tracks on page 83
Exporting tempo tracks on page 85

Export MIDI dialog
The Export MIDI dialog allows you to save individual flows as separate MIDI files.

● You can open the Export MIDI dialog by choosing File > Export > MIDI.
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The Export MIDI dialog comprises the following:

1 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

2 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to export.

3 Create folder for exported files

Controls whether or not Dorico SE generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name; for example, “Flows from Smyth - String Quintet”.

4 Export to field

Displays the export path where exported files will be saved.

5 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Importing tempo tracks
You can import tempo tracks into individual flows and new flows in existing projects; for 
example, if you are writing music for a film and changes to the footage require tempo and 
time signature changes. This does not overwrite the notes and notations in the flow.

PROCEDURE

1. Choose File > Import > Tempo Track to open the File Explorer/macOS Finder.

2. Locate and select the MIDI file whose tempo track you want to import.

3. Click Open to open the Import Tempo Track dialog.

4. In the Import into flow list, select the flow into which you want to import the tempo track.

5. In the Import and replace section, activate the checkbox for each tempo track aspect you 
want to include.

6. Optional: If you activated the checkbox for Markers as, choose one of the following options:
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● Markers

● System-attached Text

7. Optional: If you chose System Text for Markers as, activate/deactivate Show border 
around system-attached text markers.

8. Click OK to import the tempo track and close the dialog.

RESULT
The tempo track is imported into the selected flow. If you selected New Flow in the Import into 
flow list, a new flow is added to the project. All selected aspects are applied to the existing music 
or the new flow, and notes and tempo marks are adjusted as required.

RELATED LINKS
Flows on page 148
Exporting tempo tracks on page 85
Importing MIDI on page 80
Exporting MIDI on page 82

Import Tempo Track dialog
The Import Tempo Track dialog allows you to import tempo tracks to individual flows within 
projects and to control which aspects of the tempo track you want to apply to the flow.

● You can open the Import Tempo Track dialog by choosing File > Import > Tempo Track 
and opening a MIDI file from the File Explorer/macOS Finder.

The Import Tempo Track dialog comprises the following:

1 Import into flow

Contains a list of all the flows in the project. The currently selected flow is highlighted.

NOTE

You can only import tempo tracks into a single flow at a time.

2 Import and replace

Allows you to control which tempo track aspects you want to include in your import and 
apply to the selected flow.
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● Timecode display offset sets the initial timecode position at the start of the flow.

● Tempo changes replaces all immediate and gradual tempo changes in the flow with the 
tempo changes from the MIDI file.

● Time signatures replaces all time signatures in the flow with time signatures from the 
MIDI file.

● Markers as adds any markers from the MIDI file to the flow as either Markers or 
System-attached Text.

Importing markers as Markers replaces any existing markers in the flow with markers 
from the MIDI file, while importing markers as System-attached Text does not replace 
any existing markers or system-attached text items.

● Show border around system-attached text markers adds borders to markers 
imported as system-attached text items when activated. Only available if you have 
chosen System-attached Text for Markers as.

Exporting tempo tracks
You can export flows as separate tempo tracks; for example, if you want to apply the tempo 
marks and time signatures of one flow to a different flow, which can be in the same project.

PROCEDURE

1. Choose File > Export > Tempo Track to open the Export Tempo Track dialog.

2. Activate the checkbox for each flow you want to export as a tempo track.

You can also click Select All or Select None at the bottom of the list.

3. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

4. Locate and select the destination folder you want.

5. Click Choose to insert the new path in the Export to field.

6. Activate/Deactivate Create folder for exported files.

7. Click OK to export the selected flows as tempo tracks and close the dialog.

RELATED LINKS
Importing tempo tracks on page 83
Importing MIDI on page 80
Exporting MIDI on page 82

Export Tempo Track dialog
The Export Tempo Track dialog allows you to save individual flows as separate tempo tracks in 
the format of MIDI files.

● You can open the Export Tempo Track dialog by choosing File > Export > Tempo Track.
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The Export Tempo Track dialog comprises the following:

1 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

2 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to export.

3 Create folder for exported files

Controls whether or not Dorico SE generates a new folder for the selected flows within the 
selected export path. The automatic folder name is “Flows from” followed by the project file 
name; for example, “Flows from Smyth - String Quintet”.

4 Export to field

Displays the export path where exported files will be saved.

5 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Exporting audio
You can export projects as audio files in MP3, FLAC, or WAV formats, including exporting flows 
and players as separate files. For example, if you want to share an audio mock-up of only the 
soloist’s part in the second flow.

PREREQUISITE
You have opened a layout in the music area that contains the players whose audio you want to 
export.

PROCEDURE

1. Choose File > Export > Audio to open the Export Audio dialog.

2. Activate/Deactivate Export each selected flow as a separate file.

3. In the Select flows to export list, activate the checkbox for each flow you want to export as 
audio.
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You can also click Select All or Select None at the bottom of the list.

4. Activate/Deactivate Export players as separate files.

5. Optional: If you activated Export players as separate files, activate the checkbox for each 
player you want to export in the Select players to export list.

You can also click Select All or Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Choose to insert the new path in the Export to field.

9. In the Audio Export Options section, choose one of the following audio file formats:

● MP3 (.mp3)

● FLAC (.flac)

● WAV (.wav)

10. Optional: If you chose FLAC (.flac) or WAV (.wav), choose one of the following bit depths:

● 16-bit

● 24-bit

● 32-bit (WAV files only)

11. Optional: If you chose WAV (.wav), activate/deactivate Broadcast WAVE.

12. Change the reverb tail duration by changing the value in the Reverb tail (s) value field.

13. Click OK to export the selected flows/players with the set audio export options and close the 
dialog.

RELATED LINKS
Reordering layouts on page 156
Layouts panel (Setup mode) on page 101
Assigning players to layouts on page 153

Export Audio dialog
The Export Audio dialog allows you to export projects as audio files in MP3, FLAC, or WAV 
formats, including exporting flows and players as separate files.

● You can open the Export Audio dialog by choosing File > Export > Audio.
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The Export Audio dialog contains the following options and lists:

1 Export each selected flow as a separate file

Allows you to export each flow in the project as a separate audio file instead of as a single 
audio file.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

3 Export players as separate files

Allows you to export each player in the project as a separate audio file instead of all players 
in a single audio file.

4 Select players to export

Contains a list of all the players in the project. Players are included in the export when their 
checkbox is activated. Only available if you have activated Export players as separate files.

5 Selection options

Allow you to select/deselect all the flows/players in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

6 Export to field

Displays the export path where exported audio files will be saved.

7 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

8 Audio Export Options
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Contains the following options that allow you to control the audio file format and export:

● File format: Allows you to export audio as an MP3 (.mp3), FLAC (.flac) or WAV (.wav) 
file.

● Bit depth: Allows you to export FLAC files as 16-bit or 24-bit, and WAV files as 16-bit, 
24-bit, or 32-bit.

● Broadcast WAVE: Allows you to export audio in Broadcast WAVE format, which includes 
start timecodes and markers.

● Reverb tail (s): Allows you to change the duration of time added to the end of the 
exported audio to accommodate reverb effects.

Auto-save
The auto-save function stores a version of the currently active project at regular intervals, 
including new projects you have not explicitly saved yet. This reduces the chances of losing 
significant amounts of work if you accidentally close a project without saving or in the unlikely 
event that Dorico SE or your computer crashes.

Dorico SE saves auto-saved projects in an AutoSave folder inside the application data folder for 
your user account. You cannot change this location.

NOTE

● Dorico SE might become less responsive briefly in order to perform auto-saves, particularly 
for larger projects.

● Dorico SE does not generate preview images when auto-saving.

Auto-save with multiple projects open

Only the currently activated project is auto-saved at each auto-save interval if you have multiple 
projects open. This is because only a single project at a time can be activated for playback. If 
you are switching between multiple projects frequently, we recommend that you set a smaller 
auto-save interval.

Removal of auto-save files

All files in the AutoSave folder are automatically deleted when you close their corresponding 
projects and also when you quit Dorico SE. You can find deleted auto-saved projects in the bin 
on your computer. Dorico SE automatically adds “[AutoSave]” to the end of auto-saved project file 
names so you can identify them.

IMPORTANT

When Dorico SE deletes files from the AutoSave folder, this includes any files in the folder, not 
just auto-saved Dorico projects. Therefore, it is important that you do not manually save anything 
in the AutoSave folder.

TIP

If you want to access earlier versions of projects, you can use project backups.

RELATED LINKS
Project backups on page 91
Toolbar on page 28
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Recover Auto-saved Projects dialog
The Recover Auto-saved Projects dialog allows you to recover individual auto-saved projects; 
for example, if you accidentally closed a project without saving, or if Dorico SE or your computer 
crashed.

The Recover Auto-saved Projects dialog contains the following:

Auto-saved projects list
Contains all the auto-saved projects that are available for recovery. Displays the file 
name of each project and the date and time of the auto-save.

You can activate the checkbox for each project you want to recover.

Discard All
Deletes all auto-saved projects in the list and moves them to the bin on your computer.

Recover Selected Projects
Recovers the selected auto-saved projects and opens them in separate project 
windows.

RELATED LINKS
Changing the auto-save frequency on page 91

Recovering auto-saved projects
If Dorico SE crashes, you can recover the most recent auto-saved version of each project that was 
open.

PROCEDURE

1. Reopen Dorico SE.

2. In the Recover Auto-saved Projects dialog that opens after the Dorico SE splash screen, 
activate the checkbox for each auto-saved project you want to recover.

NOTE

Any auto-saved projects you do not recover are permanently deleted once you close the 
dialog.

3. Click Recover Selected Projects to recover the selected auto-saved projects and close the 
dialog.

RESULT
The selected auto-saved projects are recovered and opened in separate project windows.
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AFTER COMPLETING THIS TASK
You can save auto-saved projects permanently in any folder location and with new file names if 
required.

Changing the auto-save frequency
You can change how frequently Dorico SE auto-saves projects. By default, the auto-save interval 
is five minutes for the currently active project.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, change the value for Auto-save every [n] minutes.

4. Click Apply, then Close.

Disabling auto-save
You can disable auto-save completely; for example, if it is significantly affecting the performance 
of a large project.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, deactivate Auto-save every [n] minutes.

4. Click Apply, then Close.

Project backups
Dorico SE stores backup versions of your projects each time you save them explicitly. By default, 
the previous five saves are stored as backups.

Their default location is in a folder named after the corresponding project file name in 
the Backup Projects folder in the Dorico Projects folder, whose default location is in the 
Documents folder for your user account.

You can find deleted project backups in the bin on your computer.

Changing the number of backups per project
You can change the number of backups that Dorico SE stores for each project; for example, if you 
want to store a greater range of changes.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, change the value for Number of backups per project.

4. Click Apply, then Close.
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Changing the backup location
You can change the folder that Dorico SE uses to store project backups. By default, Dorico SE 
uses the Backup Projects folder inside your Dorico Projects folder, whose default location is in 
the Documents folder for your user account.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, click Choose beside the Project backup folder field to open the File 
Explorer/macOS Finder.

4. Locate and select the folder where you want to save project backups.

5. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Project backup 
folder field.

6. Click Apply, then Close.

RESULT
The default folder for project backups is changed. If the folder specified does not exist, Dorico SE 
creates it.

Read-only mode
Projects that contain more than your maximum number of players open in read-only mode. In 
read-only mode, you can view, play back, and print projects, but you cannot edit or save them.

● Read-only projects are indicated by the text [Read-only] after their file name in the project 
window.

RELATED LINKS
Opening projects/files on page 67
Playing back music on page 457
Printing layouts on page 491
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Setup mode

Setup mode allows you to set up the fundamental elements of the project: instruments and the 
players that hold them, flows, layouts, and videos. You can also determine how they interact with 
each other; for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and layouts, but 
you cannot select or interact with anything in the music area in Setup mode.

Project window in Setup mode
The project window in Setup mode contains panels with all the tools and functions that allow you 
to add players and instruments as well as to create layouts and flows for your project.

You can switch to Setup mode in any of the following ways:

● Press Ctrl/Cmd-1 .

● In the toolbar, click Setup.

● Choose Window > Setup.

The following panels are available in Setup mode:

1 Players

Lists the players, instruments, and groups in your project. By default, players are assigned to 
all flows, all full score layouts, and their own part layout.

2 Layouts

Lists the layouts in your project. A single full score layout and a part layout for each player 
are created automatically, but you can create and delete layouts as required. By default, 
layouts contain all flows and full score layouts contain all players.

3 Flows
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Shows the flows in your project, ordered left to right. By default, flows contain all players and 
are assigned to all layouts.

The three panels work together to allow you to control how and where the players, layouts, and 
flows in your project are used. When you select an item in one of the panels, that panel and the 
selected item are highlighted in a different color and checkboxes appear in cards in the other 
panels. You can activate/deactivate these checkboxes independently to change how material is 
distributed across players, layouts, and flows.

RELATED LINKS
Players, layouts, and flows on page 105
Project window on page 27
Layouts panel (Setup mode) on page 101
Flows panel on page 104
Starting new projects on page 66

Players panel
The Players panel contains all the players and groups in the project, shown in a list. It is located 
on the left of the window in Setup mode.

You can hide/show the Players panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-7 .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Zone.
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The order in which players are listed in the Players panel sets the default player order used in all 
layouts. You can also set a custom player order in each layout independently.

In the Players panel, each player is shown as a card that contains the instruments held by that 
player. Each player card shows the following:

1 Disclosure arrow

Expands/Collapses the player card.

2 Player type

Shows the type of player from the following options:

● Single player 

● Section player 

3 Player name

Shows the name of the player. By default, player names contain the names of all instruments 
held by the player. You can also rename players manually.

4 Add instruments icon

Opens the instrument picker from which you can select an instrument for the player.

5 Instrument labels

Each instrument assigned to a player has its own instrument label. The instrument menu 
in each instrument label opens a menu with further options that allow you to, for example, 
change the instrument names or move the instrument to another player.

Instrument labels appear blue. Kit instrument labels appear green.

The action bar at the bottom of the panel contains the following options:

Add Single Player

Adds a single player to your project. Dorico SE also automatically adds a part layout for 
the player in the Layouts panel.

Add Section Player

Adds a section player to your project. Dorico SE also automatically adds a part layout 
for the player in the Layouts panel.

Add Ensemble

Adds multiple players to your project. Dorico SE also automatically adds part layouts 
for each player in the Layouts panel.

Setup mode
Project window in Setup mode 

95
Dorico SE 4.3.30



Add Group

Adds a player group to your project. If no players were selected, an empty player group 
is added. If existing players were selected, they are grouped together.

Sort Players

Sorts all players in the Players panel according to the current player sorting setting.

You can click and hold or right-click Sort Players to change the setting to one of the 
following options:

● None: New players are added at the bottom of the players list, regardless of their 
instrument.

● Orchestral: New players are sorted according to the accepted orchestral order 
convention. For example, woodwinds positioned above brass and strings.

● Band: New players are sorted according to the accepted wind/concert band 
convention. For example, strings positioned between brass and percussion.

Player Settings

Allows you to access settings and controls for the selected player; for example, to 
rename them or show chord symbols above their staves.

You can also access player settings by right-clicking players.

Delete Player

Deletes selected players or groups from the project. When you delete a player, a 
warning message appears that allows you to delete only the player but leave their part 
layouts in the project, delete both the player and their part layouts, or cancel.

RELATED LINKS
Players on page 107
Ensembles on page 112
Layouts panel (Setup mode) on page 101
Layout Options dialog on page 622
Changing the default player order on page 110
Setting custom player orders on page 110
Renaming players on page 159
Player groups on page 144

Instrument picker
The instrument picker allows you to find and add instruments to your project. It contains 
multiple versions of some instruments that have specific formatting and tuning requirements, 
such as French Horn, which has a version whose part layouts are always in treble clef.

The instrument picker uses the application language.

You can open the instrument picker in Setup mode in any of the following ways:

● Add a new player.

● In the Players panel, click Add Instrument to Player  in player cards.
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● In the Players panel, select a player and press Shift-I .

● In the Players panel, select a player, then click Player Settings  in the action bar and 
choose Add Instrument to Player. You can also right-click players and choose this option 
from the context menu.

The instrument picker contains the following sections and options:

1 Search field

Allows you to enter the instrument you are searching for directly. You can enter only part of 
the instrument name, such as cello for Violoncello.

2 Instrument family column

Contains instrument families to help you focus your search.

3 Instrument column

Contains the instruments available in the selected instrument family.

4 Instrument type column

Contains options for multiple possible transpositions, tunings, key signature options, or 
different behavior in part layouts for the selected instrument. This column is not populated 
for instruments that do not have further options.

5 Create Empty Kit

Adds an empty percussion kit to the player.

6 Import Kit

Imports an existing percussion kit previously exported as a library file.

7 Add

Adds the selected instrument to the project.

In addition to entering the instrument you want directly into the Search field, you can click 
options in the instrument picker to select them, and you can also select other items in the same 
column by pressing Up Arrow / Down Arrow .

Setup mode
Project window in Setup mode 

97
Dorico SE 4.3.30



You can cycle forwards through the instrument picker by pressing Tab , which navigates in the 
following order: Search field, Instrument, Instrument type, Instrument family. You can also 
cycle backwards by pressing Shift-Tab , which navigates in the opposite direction.

An enclosure line shows which instrument family or instrument is selected when using the 
keyboard to navigate.

RELATED LINKS
Players on page 107
Instruments on page 114
Transposing instruments on page 119
Fretted instrument tuning on page 124
Capos on page 128
Adding players on page 108
Adding instruments to players on page 120
Changing instruments on page 122
Adding ensembles on page 113
Adding empty percussion kits to players on page 121
Importing percussion kits on page 1123
Changing the application language on page 48

Ensemble picker
The ensemble picker allows you to find and add ensembles containing multiple players to your 
project. You can select existing ensembles and build new ones.

The ensemble picker uses the application language.

You can open the ensemble picker in Setup mode in any of the following ways:

● Press Shift-E .

● In the Players panel, click Add Ensemble .

● In empty projects, click Add Ensemble  in the project start area.

The ensemble picker contains Build and Choose tabs. You can switch between them using the 
options in the top left of the ensemble picker.
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Build tab

The Build tab contains the following:

1 Search field

Allows you to specify the instruments you want to include in the ensemble in the following 
ways:

● Enter the name of an existing ensemble, such as String Section.

● Enter the names or abbreviations of instruments, with each name/abbreviation 
separated by a comma. You can prefix instruments with a number followed by a space. 
For example, enter 2 vln, 3 cl,bsn,tuba,marim to build an ensemble containing two 
violins, three clarinets, a bassoon, a tuba, and a marimba.

● Enter the corresponding orchestral shorthand, with or without separators. For example, 
enter 2picc.2.2.2 / 4.3.3.1 to add two flutes, one piccolo, two oboes, two clarinets, and 
two bassoons followed by four horns, three trumpets, three trombones, and one tuba.

To specify only brass instruments, prefix orchestral shorthand entries with br, such as 
br4331.

NOTE

You can only use single digit numbers for each instrument type.

2 Player list

Contains the instruments currently in the ensemble based on your entries in the Search 
field.

By default, instruments are held by single players. You can change the player type by double-
clicking players in the list. Icons show the current player type from the following options:

● Single player 

● Section player 

3 Save

Opens the Save Custom Ensemble dialog, which allows you to name and save your 
ensemble for reuse in future projects.

4 Add
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Adds the players in the custom ensemble to the project.

Choose tab

The Choose tab contains the following:

1 Search field

Allows you to enter the ensemble you are searching for directly.

2 Ensemble category column

Contains ensemble categories to help you focus your ensemble search.

3 Ensemble column

Contains the ensembles available in the selected instrument family.

4 Ensemble contents column

Displays the instruments included in the selected ensemble.

5 Add

Adds the players in the selected ensemble to the project.

RELATED LINKS
Ensembles on page 112
Adding ensembles on page 113
Players on page 107
Adding players on page 108
Project templates on page 73
Changing the application language on page 48
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Save Custom Ensemble dialog

The Save Custom Ensemble dialog allows you to name and save custom ensembles for reuse in 
future projects.

● You can open the Save Custom Ensemble dialog in Setup mode from inside the ensemble 
picker by building a custom ensemble and clicking Save.

The Save Custom Ensemble dialog contains the following options:

Category
Allows you to select an ensemble category for the custom ensemble.

Name
Allows you to enter a name for the custom ensemble.

RELATED LINKS
Adding ensembles on page 113
Building and saving custom ensembles on page 114

Layouts panel (Setup mode)
The Layouts panel contains all the layouts in the project, shown in a list. In Setup mode, it is 
located on the right of the window.

You can hide/show the Layouts panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Zone.
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In the Layouts panel, each layout is shown as a card. Each layout card shows the following:

1 Disclosure arrow

Expands/Collapses the layout card.

2 Layout type

Shows the type of layout from the following options:

● Full score layout 

● Instrumental part layout 

● Custom score layout 

3 Layout name

Shows the name of the layout. Dorico SE automatically adds default names depending 
on the name of the instrument that is assigned to a player and on the type of layout 
that is added. For example, if you assign a flute to a player, the instrumental part layout 
automatically gets the same name. If you add an empty instrumental part layout, the layout 
name shows Empty part and an incremental number if you add multiple empty part layouts.

4 Page size and orientation
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Shows the size and orientation of the layout as set on the Page Setup page in Layout 
Options.

5 Space size

Shows the space size between two staff lines in points, as set on the Page Setup page in 
Layout Options. This indicates the size of staves in the layout.

6 Layout number

Allows you to set a unique number for the layout that can be used as part of its file name 
when exported as a graphic. This can be useful to ensure exported part layout files are 
organized in their orchestral order, as this is usually different to their alphabetical order.

There is a different layout number sequence for each layout type. For example, full score 
layouts are numbered independently of part layouts.

The action bar at the bottom of the panel contains the following options:

Add Full Score Layout

Adds a full score layout to your project. By default, every player and flow is included in 
the layout.

Add Instrumental Part Layout

Adds an empty instrumental part layout to your project. You can then assign one or 
multiple players to the layout. By default, part layouts contain all flows that originated 
in the project.

Add Custom Score Layout

Adds an empty custom score layout to your project. You can then assign players and 
flows to the layout.

Sort Layouts

Sorts all layouts in the Layouts panel according to their type in the following order: full 
score layouts, instrumental part layouts, custom score layouts.

You can click and hold or right-click Sort Layouts to change the setting to one of the 
following options:

● Layout Number: Sorts layouts within each category according to their current 
layout number.

● Instrument Score Order: Sorts layouts within each category according to the 
corresponding player order in the Players panel.

Layout Options

Opens the Layout Options dialog for the selected layouts.

Layout Settings

Allows you to access settings and controls for the selected layout; for example, to 
rename the layout.
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You can also access layout settings by right-clicking layouts.

Delete Layout

Deletes selected layouts from the project.

RELATED LINKS
Project window in Setup mode on page 93
Layouts on page 151
Layout Options dialog on page 622
Layouts panel (Print mode) on page 487
File import and export on page 73
Assigning players to layouts on page 153
Assigning flows to layouts on page 154

Flows panel
The Flows panel contains all the flows in the project, shown in a horizontal list. It is located at the 
bottom of the window in Setup mode.

You can hide/show the Flows panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Lower Zone.

In the Flows panel, each flow is shown as a card. Each flow card shows the following:

1 Flow name

Shows the name of the flow. If you create multiple flows without renaming them, each flow 
name shows a number that increments with each new flow that you create.

2 Film reel icon

Indicates the flow has an attached video.

3 Flow timecode

Shows the start timecode for the flow.

4 Flow number
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Shows the number of the flow. The number increments with each new flow that you create 
or import. The number also indicates the position of the flow in a layout.

The Flows panel contains the following options:

Add Flow

Adds a new flow to your project. By default, every new flow is included in all layouts, 
and every player is added to the new flow.

Delete Flow

Deletes the selected flows from the project.

RELATED LINKS
Project window in Setup mode on page 93
Flows on page 148
Videos on page 166

Players, layouts, and flows
In Dorico SE, players, layouts, and flows are all connected to each other. Because they exist in the 
project rather than in a single score, you can, for example, have players and flows saved in the 
project without showing them in the full score.

● Players can be assigned to any combination of layouts and flows. For example, you can 
assign a single player to both the full score layout and their own part layout, and remove 
them from flows in which they do not play. By default, players are assigned to all flows that 
originated in the project, all full score layouts, and their own part layout.

● Layouts can contain any combination of players and flows. For example, you can assign all 
the singers to a single part layout, then remove the flows in which they do not sing from the 
layout. By default, layouts contain all flows and full score layouts contain all players.

● Flows can contain any combination of players and be assigned to/removed from layouts. By 
default, flows contain all players and are assigned to all layouts.

NOTE

● If you remove a player from a flow, any notes you have already input for that player in that 
flow are deleted.

● Removing a flow from a layout automatically removes that layout from the flow, and vice 
versa. The same is true for players and layouts, and players and flows.

When you select a card in one of the panels in Setup mode, each card in the other panels 
shows a checkbox. Connected cards appear highlighted and have activated checkboxes, while 
unconnected cards are not highlighted and have deactivated checkboxes. For example, if you 
select a player card in the Players panel, all the flows to which the player is assigned are 
highlighted and activated in the Flows panel, and all layouts to which the player is assigned are 
highlighted and activated in the Layouts panel.
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A piano player selected in the Players panel with connected flows and layouts highlighted in the Flows and 
Layouts panels

EXAMPLE
A work for string quartet and choir is divided into three movements. The string quartet is tacet 
for the third movement, which the choir sings a cappella.

The Dorico project contains three flows (one for each movement), four single players for the 
string quartet, four section players for the choir, and another single player for a piano reduction. 
It uses the following layouts to produce the required performance materials:

● Four instrumental part layouts, one for each string quartet player. Each part layout contains 
all three flows but because the string players are not assigned to the third flow, automatic 
tacets are shown for it.

● One full score layout containing all three flows, the string quartet players, and the choir 
players but omitting the piano reduction player.

● One custom score layout for the vocal score. It contains all three flows, the choir players, and 
the piano reduction player.

RELATED LINKS
Project window in Setup mode on page 93
Project Info dialog on page 70
Flows on page 148
Layouts on page 151
Assigning flows to layouts on page 154
Assigning players to layouts on page 153
Assigning players to flows on page 149
File import and export on page 73
Tacets on page 541
Flow headings on page 550
Condensing on page 543
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Players
In Dorico SE, a player can represent an individual musician or multiple musicians in the same 
section. Players hold instruments, so you must add at least one player to your project before you 
can add instruments.

In Dorico SE, there are the following types of players:

Single player
Represents an individual person who can play one or more instruments. For example, 
a clarinettist who doubles on alto saxophone or a percussionist who plays bass drum, 
clash cymbals, and triangle.

Section player
Represents multiple people who all play the same instrument. For example, a violin 
section player might represent all eight desks of the Violin I section in an orchestra, or 
a soprano section player might represent the whole soprano section in a mixed voice 
choir.

NOTE

Section players can only hold one instrument.

You can designate both single and section players as soloists, such as in a concerto for solo violin 
and orchestra.

When you add a player in Dorico SE, the following happens automatically:

● A part layout is created and the new player is assigned to it.

● The player is added to any full score layouts that already exist. If no full score layouts exist, a 
new full score layout is created.

● The player is assigned to all existing flows that originated in the project. It is not added to 
any flows that you imported into the project.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two. If you open 
a project that contains more than two players, it opens in read-only mode.

RELATED LINKS
Read-only mode on page 92
Players, layouts, and flows on page 105
Flows on page 148
Layouts on page 151
Instruments on page 114
Adding players on page 108
Adding ensembles on page 113
Designating players as soloists on page 111
Changing the default player order on page 110
Setting custom player orders on page 110
Player, layout, and instrument names on page 158
Staff labels on page 1029
Showing instrument/player names in staff labels on page 1032
Brackets according to ensemble type on page 709
Instrument numbering on page 115
Instrument changes on page 117
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Adding players
You can add both single and section players to your project. Single players can hold multiple 
instruments, while section players can only hold one instrument.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two.

PROCEDURE

1. In Setup mode, add an empty-handed player and open the instrument picker in any of the 
following ways:

● To add a single player, press Shift-P .

● To add a section player, press Shift-Alt/Opt-P .

● In the Players panel, click Add Single Player .

● In the Players panel, click Add Section Player .

● In an empty project, click Add Single Player  in the project start area.

● In an empty project, click Add Section Player  in the project start area.

TIP

You can also open the instrument picker by selecting an existing empty-handed or single 
player in the Players panel and pressing Shift-I .

2. Select the instrument you want in the instrument picker.

3. Press Return  to add the selected instrument.

RESULT
The single/section player is added and is automatically named after the selected instrument. The 
player’s order in the Players panel depends on your current player sorting setting.

The player is assigned to its own new part layout, all full score layouts, and all flows that 
originated in the project.

Dorico SE automatically loads sounds for the instrument according to the current playback 
template.

NOTE

● Players are not automatically added to flows that you imported into the project.

● If you want to add multiple instruments to your project at the same time, you can add 
ensembles or use a project template.

AFTER COMPLETING THIS TASK

● If you added a single player and you want them to hold multiple instruments, you can add 
other instruments to the single player.

● You can designate the player as a soloist.

● You can change the default order of players in all layouts and set custom player orders in 
each layout independently.

RELATED LINKS
Players panel on page 94
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Instrument picker on page 96
Players, layouts, and flows on page 105
Player, layout, and instrument names on page 158
Staff labels on page 1029
Showing instrument/player names in staff labels on page 1032
Instrument numbering on page 115
Designating players as soloists on page 111
Changing the default player order on page 110
Adding instruments to players on page 120
Adding ensembles on page 113
Renaming players on page 159
Changing instrument names on page 161
Layouts on page 151
Project start area on page 32
Project templates on page 73
Playback templates on page 471
File import and export on page 73

Duplicating players
You can duplicate existing players. This adds another player of the same type holding the same 
instruments as the original.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two.

PROCEDURE

1. In Setup mode, in the Players panel, select the player you want to duplicate.

2. In the action bar, click Player Settings  and choose Duplicate Player.

RESULT
A new player is added, with the same instruments as the original player and is named after those 
instruments. By default, the player appears below the original player in the Players panel. The 
original and new players are automatically numbered to ensure their names are unique.

The new player is assigned to its own new part layout, all full score layouts, and all flows that 
originated in the project.

NOTE

● Any existing music belonging to the original player is not duplicated.

● You can also duplicate players by right-clicking them in the Players panel and choosing 
Duplicate Player from the context menu.

RELATED LINKS
Players panel on page 94
Renaming players on page 159
Players, layouts, and flows on page 105
Arranging tools on page 412
Copying and pasting notes/items on page 414
Setting custom player orders on page 110
Duplicating flows on page 149
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Changing the default player order
You can change the default order in which players’ staves appear in all layouts; for example, if 
your project requires an unconventional instrument order.

PROCEDURE

1. In Setup mode, in the Players panel, select the players whose default position you want to 
change.

2. Click and drag the selected players upwards/downwards.

An insertion line indicates where the players will be positioned.

RESULT
The default player order is changed. This does not change the player order in layouts with 
custom player orders.

TIP

You can also automatically sort players according to their type by clicking Sort Players  in the 
Players panel.

You can click and hold or right-click Sort Players  to change the setting to one of the following 
options:

● None

● Orchestral

● Band

We recommend changing the setting to None when using an unconventional default player 
order.

RELATED LINKS
Players panel on page 94
Adding players on page 108

Setting custom player orders
You can change the order in which players’ staves appear in each layout independently; for 
example, if you want to have a different player order in a custom score layout than the default 
player order for your other layouts, as set by the order of players in the Players panel.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layout in which you want to set a custom player order.

NOTE

You can only set custom player orders in one layout at a time. By default, the layout currently 
open in the music area is selected when you open the dialog.

3. In the category list, click Players.

4. In the Players section, activate Uses custom player order.

5. In the list, select a player whose position you want to change.
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6. Change its position relative to other players in one of the following ways:

● Click Move up.

● Click Move down.

7. Optional: Repeat steps 5 to 6 for other players in the selected layout whose position you 
want to change.

8. Click Apply, then Close.

RESULT
The player order in the selected layout is changed. This overrides the default player order. Any 
subsequent changes you make to the default player order in the Players panel are not reflected 
in layouts with custom player orders.

RELATED LINKS
Layouts on page 151
Layout Options dialog on page 622

Designating players as soloists
You can designate both single and section players as soloists, such as in a concerto for solo violin 
and orchestra. You can have multiple soloists in a single project.

PREREQUISITE
You have added the players you want to designate as soloists.

PROCEDURE

1. In Setup mode, in the Players panel, select the player you want to designate as a soloist.

2. In the action bar, click Player Settings  and choose Soloist.

RESULT
The selected player is designated as a soloist.

Instruments held by players designated as soloists are not automatically numbered. Provided 
they have default instrument names, they are automatically given the prefix “Solo”, which 
appears in staff labels.

Soloists are automatically positioned in the conventional score position; that is, above the strings, 
and are bracketed separately from other players.

Choosing Soloist again, so that no tick appears beside it in the menu, returns soloists to being a 
normal player of their type.

TIP

You can also designate players as soloists by right-clicking them in the Players panel and 
choosing Soloist from the context menu.

RELATED LINKS
Players panel on page 94
Adding players on page 108
Instrument numbering on page 115
Brackets according to ensemble type on page 709
Changing the default player order on page 110
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Staff labels on page 1029
Staff label contents on page 1032

Deleting players
You can delete players from your project, which also deletes all instruments held by those 
players.

IMPORTANT

Deleting instruments permanently deletes any music that you have input on their staves.

PROCEDURE

1. In Setup mode, in the Players panel, select the players that you want to delete.

2. Delete the selected players in any of the following ways:

● Press Backspace or Delete .

● In the Players panel, click Delete Player .

3. Choose one of the following options in the warning message that appears:

● Delete Player Only: Deletes the player and the music that you created for the 
instruments belonging to that player.

● Delete Player and Part Layouts: Deletes the player, the music, and all part layouts to 
which the player is assigned.

NOTE

The part layout cannot be deleted if it also contains other players.

RELATED LINKS
Players panel on page 94
Deleting instruments on page 123
Deleting layouts on page 157
Restoring default layouts on page 157

Ensembles
Ensembles are sets of multiple players that are commonly used together, such as a double 
woodwind section that contains two flutes, two oboes, two clarinets, and two bassoons. Dorico 
SE provides predefined ensembles, but you can also build custom ensembles.

Ensembles can contain single and/or section players, depending on the ensemble. For example, 
woodwind ensembles contain single players whereas string ensembles contain section players.

You can use ensembles to add multiple players to your project simultaneously and build up the 
instrumentation quickly.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two. If you open 
a project that contains more than two players, it opens in read-only mode.
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RELATED LINKS
Players on page 107
Ensemble picker on page 98
Save Custom Ensemble dialog on page 101
Project templates on page 73

Adding ensembles
You can add multiple players simultaneously by adding ensembles, such as a complete string 
section or four-part choir. You can select existing ensembles and build new ones.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two. Only 
ensembles containing one or two players are available.

PROCEDURE

1. In Setup mode, open the ensemble picker in any of the following ways:

● Press Shift-E .

● In the Players panel, click Add Ensemble .

● In an empty project, click Add Ensemble  in the project start area.

2. Select or build the ensemble you want in the ensemble picker.

3. Optional: If you built a new ensemble that you want to reuse in future projects, click Save to 
open the Save Custom Ensemble dialog and save your ensemble.

4. Click Add.

RESULT
The players in the selected ensemble are added to the Players panel, as either single or section 
players depending on the ensemble type. They are assigned to all flows that originated in the 
project.

TIP

You can use project templates to start projects with multiple players.

RELATED LINKS
Players panel on page 94
Ensemble picker on page 98
Save Custom Ensemble dialog on page 101
Renaming players on page 159
Project start area on page 32
Starting new projects on page 66
Project templates on page 73
Opening projects/files on page 67
Players, layouts, and flows on page 105
File import and export on page 73
Key Commands page in the Preferences dialog on page 54
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Building and saving custom ensembles
You can build custom ensembles in the ensemble picker and save them for reuse in 
future projects; for example, if you frequently write music for an ensemble with unusual 
instrumentation.

PROCEDURE

1. In Setup mode, open the ensemble picker in any of the following ways:

● Press Shift-E .

● In the Players panel, click Add Ensemble .

● In an empty project, click Add Ensemble  in the project start area.

2. Click Build to switch to the Build tab.

3. Enter the instruments you want into the Search field.

For example, enter 2 vln, 3 cl,bsn,tuba,marim to build an ensemble containing two violins, 
three clarinets, a bassoon, a tuba, and a marimba.

TIP

You can also use orchestral shorthand to specify instruments.

4. Optional: To confirm the instruments identified by your current entry and clear the Search 
field, press Tab .

5. Optional: To change the player type, double-click players in the list.

The icons for each player show whether they are single players  or section players .

6. Click Save to open the Save Custom Ensemble dialog.

7. Select an ensemble category from the Category menu.

8. Enter a name for your ensemble in the Name field.

9. Click Save to save your ensemble and close the Save Custom Ensemble dialog.

10. Optional: Click Add to add the ensemble to the project and close the ensemble picker.

RESULT
Your ensemble is saved, allowing you to add it to future projects. If you clicked Add in the 
ensemble picker, the players in the ensemble are added to the project.

RELATED LINKS
Ensemble picker on page 98
Save Custom Ensemble dialog on page 101
Players on page 107
Adding players on page 108

Instruments
In Dorico SE, an instrument is an individual musical instrument, such as a piano, a flute, or a 
violin. Human voices, such as soprano or tenor, are also considered instruments.

In Dorico SE, instruments are held by players, just as real instruments are held by human players. 
Section players can only hold one instrument but single players can hold multiple instruments, 
which allows you to handle instrument changes easily, such as when an oboist doubling the cor 
anglais switches from one instrument to the other.
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This means that before you can add instruments to a project, you must first add players or 
ensembles, which may in turn also be assigned to groups if needed. If you add ensembles, the 
appropriate instruments for the ensemble are automatically added to the players.

Each instrument automatically gets its own staff, but when instrument changes are allowed, the 
music for multiple instruments held by the same single player can appear on the same staff 
as long as no notes overlap. By default, Dorico SE allows instrument changes in all layouts and 
automatically shows instrument change labels. This means that only the top instrument held by 
players is shown automatically in the music area. You can see staves for all instruments in galley 
view, and you can allow/disallow instrument changes in each layout independently. You can also 
hide/show empty staves in each layout independently.

Instruments in Dorico SE do not have limited ranges; it is possible to notate any pitch in any 
register on every instrument. However, in the piano roll editor, only pitches that fall in the MIDI 
note range 0-127 can be represented. Similarly, if you input a pitch beyond the range of samples 
in the assigned VST instrument, the pitch does not sound in playback.

There are multiple versions of some instruments that have specific formatting and tuning 
requirements, such as French Horn, which has a version whose part layouts are always in treble 
clef.

You can change instruments at any time, add/delete them from players, and move them 
between players.

RELATED LINKS
Players on page 107
Piano roll editor on page 575
Track Inspector on page 442
Unpitched percussion on page 1115
Instrument picker on page 96
Inputting notes on page 197
Adding players on page 108
Adding instruments to players on page 120
Player, layout, and instrument names on page 158
Staff labels on page 1029
Brackets according to ensemble type on page 709
Changing the open pitches of fretted instrument strings on page 126
Changing instruments on page 122
Moving instruments on page 123
Designating players as soloists on page 111
Changing the default player order on page 110
Deleting instruments on page 123
Switching to galley/page view on page 47
Allowing/Disallowing instrument changes on page 117
Hiding/Showing empty staves on page 515
Edit Percussion Kit dialog on page 136

Instrument numbering
It is customary to number instruments when there is more than one in a piece so that they can 
be easily identified, such as Horn 1 and Horn 2. Dorico SE automatically numbers instruments 
where there are multiple instruments of the same type in the same project.

For example, if there is only one flute in a project, it is called Flute, but if there are three flutes, 
they are automatically called Flute 1, Flute 2, and Flute 3.
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One violin with no number Adding a second violin automatically generates 
numbers for both violins

Instrument numbering applies to individual instruments, rather than players. For example, if an 
ensemble contains two flute players and a piccolo player, but the second flute is also holding a 
piccolo, then the instruments are numbered in the following way:

● Flute 1

● Flute 2 & Piccolo 1

● Piccolo 2

TIP

You can move individual instruments to different players if you want to change which numbered 
instruments are held by each player. For example, if you want the second flute to double second 
piccolo rather than first piccolo, you can swap the piccolo instruments between the players.

Dorico SE automatically generates instrument numbers for players if the following criteria are 
met:

● The project contains multiple instruments with identical instrument names.

● The instruments have the same transposition.

● The players holding them are the same type, either single or section.

● The players are in the same group.

For example, if you have two flutes in your project, but one flute is a section player and the other 
flute is a single player, they are not numbered automatically. Similarly, if the two flutes are in 
different player groups, they are not numbered automatically.

NOTE

Instruments held by players designated as soloists are not automatically numbered.

RELATED LINKS
Player, layout, and instrument names on page 158
Changing instrument names on page 161
Player groups on page 144
Instrument transpositions in staff labels on page 1033
Moving instruments on page 123
Designating players as soloists on page 111
Staff label contents on page 1032
Transposing instruments on page 119
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Instrument changes
Instruments changes are when a player holding multiple instruments switches from playing one 
instrument to a different instrument. They are usually indicated in full scores and parts with text 
indications both after the last note before the change and at the first note after the change.

An instrument change from Oboe to Cor Anglais

Dorico SE handles instrument changes automatically, including showing the appropriate 
instrument change labels, when the following criteria are met:

● You have added a single player holding at least two instruments.

● You have input notes on at least two instrument staves held by the single player, such as 
inputting oboe notes on the Oboe staff and cor anglais notes on the Cor Anglais staff.

● Notes for different instruments held by the same single player do not overlap.

● Instrument changes are allowed in the layout.

You can see staves for all instruments in galley view, and you can allow/disallow instrument 
changes in each layout independently.

RELATED LINKS
Allowing/Disallowing instrument changes on page 117
Adding players on page 108
Adding instruments to players on page 120
Switching to galley/page view on page 47
Inputting notes on page 197
Hiding/Showing instrument change labels at the start of flows on page 1035
Changing instruments on page 122

Allowing/Disallowing instrument changes
You can allow/disallow instrument changes in each layout independently; for example, if you 
want to show multiple percussion instruments on as few staves as possible in the score, but on 
separate staves for each percussion instrument in the percussion part.

Disallowing instrument changes shows all instrument staves in the selected layouts, including 
multiple instruments held by one single player.

TIP

If you want to input notes for other instruments held by single players but keep instrument 
changes in the layout, you can switch to galley view to see all staves in the project.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to allow/disallow instrument 
changes.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, activate/deactivate Allow instrument changes.

5. Click Apply, then Close.

RESULT
Instrument changes are allowed in the selected layouts when Allow instrument changes is 
activated, and disallowed when it is deactivated.

NOTE

Multiple instruments can only appear on the same staff with an instrument change if none of 
their notes overlap. If any of their notes do overlap, multiple staves are shown.

RELATED LINKS
Instruments on page 114
Inputting notes on page 197
Hiding/Showing empty staves on page 515
Hiding/Showing instrument change labels at the start of flows on page 1035
Changing instruments on page 122

Editing the default instrument change label text
You can change the default instrument change label prefix and whether instrument change 
labels show full or short instrument names by default in each layout independently; for example, 
if you want to show full instrument names in part layouts but short instrument names in full 
score layouts.

Using custom prefixes/suffixes also allows you to show instrument change labels in a different 
language; for example, if you want to recreate a French score.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default content in 
instrument change labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, choose one of the following options for Instrument 
names to use in change labels:

● Full Names

● Short Names

5. Choose one of the following options for Prefix for instrument change warnings:

● To

● Take

● Custom
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6. Optional: If you chose Custom, enter the text you want in the following fields, individually or 
together:

● Custom prefix

● Custom suffix

7. Click Apply, then Close.

RESULT
The length of instrument names and prefixes/suffixes in all instrument change labels in the 
selected layouts is changed.

RELATED LINKS
Hiding/Showing instrument change labels at the start of flows on page 1035
Staff labels on page 1029

Transposing instruments
While most instruments produce notes at concert pitch, transposing instruments produce a note 
that is different to the one that is written. For example, two common orchestral transposing 
instruments are clarinet in B♭ and horn in F.

When a clarinet in B♭ plays a C, the sound produced is a B♭, one whole step (tone) below. 
When a horn in F plays a C, the sound produced is an F, a fifth below. Other instruments 
that conventionally produce a pitch different to the one notated include the piccolo (sounding 
an octave above written), double bass (sounding an octave below written), and glockenspiel 
(sounding two octaves above written).

Dorico SE stores all note information in concert pitch and automatically transposes notes as 
appropriate for the transposition of the instrument. This means notes, key signatures, and chord 
symbols are automatically changed in transposing layouts compared to non-transposing layouts. 
You can also change instruments at any time, and the music is adjusted automatically to ensure 
the correct pitches are shown.

You can also change the octave of individual clefs.

RELATED LINKS
Instrument picker on page 96
Instrument numbering on page 115
Instrument transpositions in staff labels on page 1033
Concert vs. transposed pitch on page 155
Making layouts transposing/concert pitch on page 155
Editing layout transposition text on page 801
Changing fretted instrument transpositions on page 131
Enharmonic equivalent key signatures on page 819
Changing instruments on page 122
Hiding/Showing clefs according to layout transpositions on page 739
Clefs with octave indicators on page 741
Fretted instrument tuning on page 124
Capos on page 128
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Adding instruments to players
You can add instruments to both single and section players. Single players can hold multiple 
instruments, while section players can only hold one instrument.

PREREQUISITE
You have added at least one player.

PROCEDURE

1. In Setup mode, in the Players panel, select the player to which you want to add instruments.

NOTE

● You can only add instruments to one player at a time.

● You cannot add instruments to section players who are already holding one instrument.

2. Open the instrument picker in any of the following ways:

● Press Shift-I .

● Click the plus symbol  in the player card.

3. Select the instrument you want in the instrument picker.

4. Press Return  to add the selected instrument.

RESULT
The selected instrument is added to the selected player. Dorico SE automatically loads sounds for 
the instrument according to the current playback template.

NOTE

● Before you have input any notes, only the first instrument held by single players is shown in 
full scores in page view. All instrument staves are shown in galley view, so we recommend 
switching to galley view to input notes for any other instruments held by single players; for 
example, to create instrument changes.

● If you want to add multiple players to your project at the same time, you can add ensembles 
or use a project template.

RELATED LINKS
Players on page 107
Players panel on page 94
Instrument picker on page 96
Adding players on page 108
Adding ensembles on page 113
Designating players as soloists on page 111
Starting new projects on page 66
Switching to galley/page view on page 47
Playback templates on page 471
Instrument changes on page 117
Player, layout, and instrument names on page 158
Changing instrument names on page 161
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Adding empty percussion kits to players
You can add empty percussion kits to players, to which you can then add unpitched percussion 
instruments.

NOTE

You cannot add percussion kits to section players that are already holding one instrument.

PREREQUISITE
You have added at least one player.

PROCEDURE

1. In Setup mode, in the Players panel, open the Edit Percussion Kit dialog in any of the 
following ways:

● Select a player, press Shift-I , and click Create Empty Kit in the instrument picker.

● Click the plus symbol  in a player card and click Create Empty Kit in the instrument 
picker.

● Select a player, then click Player Settings  in the action bar and choose Create Empty 
Kit. You can also right-click players and choose this option from the context menu.

2. Add the percussion instruments you want to the kit in the Edit Percussion Kit dialog.

RELATED LINKS
Players panel on page 94
Percussion kits vs. individual percussion instruments on page 1121
Edit Percussion Kit dialog on page 136
Instrument picker on page 96
Percussion kit presentation types on page 1126

Combining individual percussion instruments into kits
If a player is holding one or more individual percussion instruments, you can combine them into 
a percussion kit.

PROCEDURE

1. In Setup mode, in the Players panel, select the player whose percussion instruments you 
want to combine into a kit.

2. In the action bar, click Player Settings  and choose Combine Instruments into Kit to 
open the Edit Percussion Kit dialog.

TIP

You can also right-click players and choose this option from the context menu.

3. Edit the new percussion kit.

For example, you can change the order in which the instruments appear in a grid or on a 
five-line staff.

RESULT
A new kit is created containing all the instruments held by the player.
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NOTE

If the player was already holding one or more kit instruments, all individual instruments and any 
other kits are combined into the first kit.

Changing instruments
You can change the type of instruments without affecting any music already entered onto their 
staves; for example, if your Clarinet part is very low and you want to change it to a Bass Clarinet, 
or you want to change the tuning of a guitar.

NOTE

● You cannot change percussion kits into other instruments, you can only change individual 
unpitched percussion instruments.

● You cannot change a pitched instrument into an unpitched instrument, and vice versa.

● These steps describe changing the instrument type, not an instrument change where a 
performer switches from one instrument to another partway through a flow.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player whose instrument you 
want to change.

The card lists the instruments held by the player.

2. In the instrument label, click the instrument menu  and choose Change Instrument to 
open the instrument picker.

3. Select the instrument you want in the instrument picker.

4. Press Return  to change to the selected instrument.

RESULT
The selected instrument is changed without affecting any music on its staff.

Where appropriate, different clefs are used by default. This means that notes can appear 
differently so that they are notated correctly according to the new clef.

AFTER COMPLETING THIS TASK
You can change the player order; for example, if the new instrument requires a different position 
according to orchestral convention.

RELATED LINKS
Players panel on page 94
Instrument picker on page 96
Fretted instrument tuning on page 124
Transposing instruments on page 119
Edit Strings and Tuning dialog on page 124
Instrument changes on page 117
Hiding/Showing instrument transpositions in staff labels on page 1033
Changing the default player order on page 110
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Moving instruments
You can move individual instruments without affecting any music already input for those 
instruments. You can move instruments between players, or to a different position in the 
instrument list for a single player; for example, if you want to change the order of staves in 
the score.

Changing the order of instruments held by a single player also affects its player name, if you 
have not already renamed the player.

PREREQUISITE
You have added the players to which you want to move instruments.

PROCEDURE

1. In Setup mode, in the Players panel, expand the cards of the players holding the 
instruments you want to move.

2. Move instruments in any of the following ways:

● To change the order of instruments for a single player, click and drag a single 
instrument to the required position, then release the mouse.

● To move instruments to another player, click and drag a single instrument to the 
required player card, then release the mouse.

● To move instruments to another player, click the instrument menu  in the instrument 
label and choose Move Instrument to Player > [Player].

RELATED LINKS
Players panel on page 94
Adding players on page 108
Changing the default player order on page 110
Renaming players on page 159
Resetting player names on page 159

Deleting instruments
You can delete individual instruments without deleting the player holding them or other 
instruments held by the same player.

IMPORTANT

Deleting instruments permanently deletes any music that you have input on their staves.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the instrument 
you want to delete.

2. In the instrument label, click the instrument menu  and choose Delete Instrument.

3. Click OK.

RESULT
The instrument is deleted from the player.
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TIP

If you want to delete all instruments held by a single player, you can also delete the player.

RELATED LINKS
Players panel on page 94
Deleting players on page 112

Fretted instrument tuning
Fretted instruments can have different numbers of strings and frets. In order to display tablature 
for fretted instruments in Dorico SE, you must specify information about the tuning of fretted 
instruments.

Dorico SE requires the following information to display tablature:

● The number of strings the instrument has

● The open pitch of each string

● The number of frets

● The fret number at which each string starts, such as for the fifth string on a banjo

● The pitch intervals between frets

● The fret number of the capo, if applicable

When you add a fretted instrument or change an existing instrument, any available tunings for 
that instrument are shown in the instrument picker.

You can also customize all aspects of fretted instruments in the Edit Strings and Tuning dialog, 
including adding capos.

RELATED LINKS
Instrument picker on page 96
Changing instruments on page 122
Capos on page 128

Edit Strings and Tuning dialog
The Edit Strings and Tuning dialog allows you to customize the tuning of individual fretted 
instruments by changing the number of strings and frets they have, the pitches of their open 
strings, and the spacing of their frets. It also allows you to add/remove capos and change the 
fretted instrument transposition.

● You can open the Edit Strings and Tuning dialog in Setup mode by expanding the card of 
the player holding the fretted instrument in the Players panel, then clicking the instrument 
menu  in its instrument label and choosing Edit Strings and Tuning.
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The Edit Strings and Tuning dialog comprises the following:

1 Instrument

Displays the name of the selected fretted instrument.

2 Compatible preset tunings

Allows you to select preset fretted instrument tunings with the same number of strings as 
the selected fretted instrument. If your changes in the dialog match a preset tuning, it is 
automatically selected.

3 String editor

Allows you to select and edit individual or all strings of the fretted instrument. The 
arrangement of strings in the editor matches that of the real instrument. The pitch and 
total number of frets of each string is shown to the left of the vertical line that represents the 
nut.

You can navigate through strings by pressing Up Arrow / Down Arrow , and to top/bottom 
strings by pressing Page Up/Page Down.

4 Capo representation

Indicates the fret position and extent of the capo added to the fretted instrument.

5 Controls

Allow you to edit individual or multiple strings. The following controls are available when at 
least one string is selected in the string editor:

● Open pitch: Allows you to set the open pitch of the string using the note name and 
octave, such as C4 for middle C. If necessary, you can add # for sharp and b for flat.

● No. of frets: Allows you to set the number of frets for the selected strings.

● Starting fret: Allows you to set the number of the first fret on the selected strings. For 
example, the fifth string on the banjo starts at fret 5.

● Tune Up Half-Step: Allows you to raise the open pitch of the selected strings by a 
half-step (semitone).

● Tune Down Half-Step: Allows you to lower the open pitch of the selected strings by a 
half-step (semitone).

● Irregular fret spacing: Allows you to set non-chromatic fret arrangements for 
instruments with fretboards that correspond to other scales, such as the dulcimer. Enter 
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1 for a half-step and 2 for a whole step, with each step separated by a comma. For 
example, enter 2,2,1,2,2,2,1 to set the pattern for a major scale.

6 Action bar

Contains options that allow you to change the number and arrangement of strings.

● Add String : Adds a new string below the lowest currently selected string. The new 
string is a duplicate of the lowest currently selected string.

● Add String at Top : Adds a new string at the top of the fretboard. The new string is a 
duplicate of the previous top string.

● Select all: Selects all strings at once.

● Move string buttons: Allow you to move the currently selected strings up/down the 
fretboard.

● Reset to Default: Returns all strings and corresponding tunings to the factory default 
settings for the fretted instrument.

● Delete String : Deletes the selected strings.

7 Capo section

Contains options that allow you to change the capo and fretted instrument transposition.

● Capo: Opens the Capo Definition dialog, which allows you to add full and partial capos 
to fretted instruments.

● In staff notation, written C4 sounds as: Allows you to change the transposition of 
the selected fretted instrument. The pitch determines the spelling of notes and chord 
symbols for the corresponding number of half-steps.

8 Import Tuning

Opens the File Explorer/macOS Finder, where you can select the .doricotuning file that 
you want to import and apply to the fretted instrument.

9 Export Tuning

Opens the File Explorer/macOS Finder, where you can select the location to which you want 
to export the strings and tuning settings of the fretted instrument as a .doricotuning file. 
You can then import the .doricotuning file into other instruments/projects and share it 
with other users.

RELATED LINKS
Players panel on page 94
Chord diagrams on page 727
Tablature on page 1048
Fretted instrument tuning on page 124
Capos on page 128

Changing the open pitches of fretted instrument strings
You can change the open pitch of each fretted instrument string independently; for example, if 
your project requires an unconventional tuning that is not available as an instrument type in the 
instrument picker.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose open pitches you want to change.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.
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3. Select the string whose open pitch you want to change.

4. Change the Open pitch value; for example, to G2.

5. Optional: Repeat steps 3 and 4 to change the open pitch of other strings.

6. Click OK to save your changes and close the dialog.

RESULT
The open pitches of the selected strings are changed. This affects the tuning of the instrument 
and the pitch of all fret positions on those strings.

The new tuning becomes available for chord diagrams.

RELATED LINKS
Players panel on page 94
Chord diagrams on page 727
Hiding/Showing chord diagrams on page 728

Importing fretted instrument tunings
You can import custom fretted instrument tunings that you have already created and apply them 
to instruments. This allows you to reuse tunings without having to create them from scratch.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument to which you want to apply an imported tuning.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. Click Import Tuning at the bottom of the dialog to open the File Explorer/macOS Finder.

4. Locate and select the .doricotuning library file you want to import.

5. Click Open.

RESULT
The selected .doricotuning file is applied to the fretted instrument. The imported tuning 
becomes available for chord diagrams.

Exporting fretted instrument tunings
You can export fretted instrument tunings so you can reuse them for other instruments and in 
other projects. Fretted instrument tunings are exported as .doricotuning library files.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose tuning you want to export.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. Click Export Tuning at the bottom of the dialog to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.
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RESULT
The tuning of the selected fretted instrument is exported and saved as a .doricotuning library 
file.

AFTER COMPLETING THIS TASK
You can import the library file into other projects to reuse the fretted instrument tuning.

Capos
Capos are devices that performers clamp onto the necks of fretted instruments to depress 
strings at a single fret position. This raises the sounding pitch of open strings affected by the 
capo, allowing performers to use the same fingerings and chord shapes but produce higher 
pitches.

In Dorico SE, you can allow capos to affect your notated music in the following ways, 
independently of each other:

● You can change the pitches shown on tablature by adding capos to fretted instruments. 
Dorico SE treats capos as fret 0 for fret numbers on tablature. Capos added to individual 
fretted instruments appear at the corresponding fret position and crossing the specified 
strings in the Edit Strings and Tuning dialog and in the Fretboard panel.

● You can change fretted instrument transpositions to reflect capos or detuned fretted 
instruments, and optionally allow fretted instrument transpositions to affect pitches on 
notation staves and in main chord symbols.

● You can define capos for chord symbols/diagrams in the music and/or used chord diagrams 
grids, and show only main chords, only capo chords, or both.

For example, you can show capo pitches on tablature but show sounding pitches on notation 
staves. You can also show both main and capo chords in chord symbols in layouts that do not 
contain a fretted instrument, such as when creating lead sheets in vocal part layouts.

RELATED LINKS
Edit Strings and Tuning dialog on page 124
Fretboard panel on page 185
Chord symbols on page 713
Chord diagrams on page 727
Fretted instrument tuning on page 124
Defining capos for chord symbols/diagrams on page 133
Defining capos for used chord diagrams grids on page 135
Layouts on page 151
Making layouts transposing/concert pitch on page 155
Assigning players to layouts on page 153

Capo vs. main chords
For the same chord symbol, Dorico SE can show its original pitch only, its sounding pitch based 
on the defined capo only, or both with capo chords above or below main chords.

Main chord
The original chord symbol you input. Its displayed pitches depend on whether the 
layout is transposing or concert pitch, and whether the layout uses fretted instrument 
transpositions for main chord symbols. For example, in the transposed pitch part 
layout for a trumpet in B♭, a C7 chord symbol appears as D7.
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Capo chord
The chord that the fretted instrument must play in order to produce the desired main 
chord, according to the fret position of the capo. For example, if a guitarist with a capo 
on the second fret plays Gm7, the chord that sounds is Am7.

Capo chords appear in italics when shown alongside main chords.

RELATED LINKS
Concert vs. transposed pitch on page 155
Changing fretted instrument transpositions on page 131
Hiding/Showing capo chord symbols on page 133
Hiding/Showing capo chord symbols in used chord diagrams grids on page 136
Respelling chord symbols on page 720

Adding capos to fretted instruments
You can add capos to individual fretted instruments. This affects the pitches shown on tablature 
for the corresponding instruments, as Dorico SE treats capos as fret 0. For example, if each flow 
in a project for guitar requires a capo at a different fret, you might add multiple players, each 
holding a guitar instrument with the required capo.

NOTE

These steps do not affect pitches on notation staves, chord symbols/diagrams in the music, or 
used chord diagram grids.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument to which you want to add a capo.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. In the Capo section, click Capo to open the Capo Definition dialog.

4. Choose one of the following options for Capo:

● Full Capo

● Partial Capo

5. Change the fret position of the capo by changing the value for Fret.

6. Optional: If you chose Partial Capo, change the strings across which the capo extends.

7. Click OK to save your changes and close the Capo Definition dialog.

8. Click OK to save your changes and close the Edit Strings and Tuning dialog.

RESULT
A capo is added to the selected instrument according to your settings. The capo appears at the 
corresponding fret position and crossing the specified strings in the Edit Strings and Tuning 
dialog and in the Fretboard panel for the selected instrument.
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EXAMPLE

No capo Capo added to the third fret

RELATED LINKS
Players panel on page 94
Edit Strings and Tuning dialog on page 124
Fretboard panel on page 185
Changing fretted instrument transpositions on page 131
Defining capos for chord symbols/diagrams on page 133
Defining capos for used chord diagrams grids on page 135

Capo Definition dialog

The Capo Definition dialog allows you to add full and partial capos to fretted instruments.

● You can open the Capo Definition dialog from inside the Edit Strings and Tuning dialog by 
clicking Capo in the Capo section.

The Capo Definition dialog contains the following options:

Capo
Allows you to choose one of the following capo types:

● None

● Full Capo

● Partial Capo

Fret
Allows you to change the fret position of the capo.

From string [n] to [n]
Allows you to set the first and last strings across which the capo extends. Only available 
when Partial Capo is chosen for Capo.
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Removing capos from fretted instruments

You can remove capos from individual fretted instruments. This affects the pitches shown on 
tablature for the corresponding instruments.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose capo you want to remove.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. In the Capo section, click Capo to open the Capo Definition dialog.

4. Choose None for Capo.

5. Click OK to save your changes and close the Capo Definition dialog.

6. Click OK to save your changes and close the Edit Strings and Tuning dialog.

Changing fretted instrument transpositions
You can change the transposition of individual fretted instruments; for example, to reflect capos 
added to them, or for a fretted instrument whose strings have all been detuned. This can affect 
the pitches shown on notation staves and in main chord symbols in the music, depending on 
your per-layout setting for using fretted instrument transpositions.

NOTE

● You can find different tunings for each fretted instrument in the instrument picker.

● You can also change the open pitch of individual fretted instrument strings.

● Fretted instrument transpositions do not affect pitches shown on tablature, which use the 
instrument’s capo, or used chord diagram grids.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose transposition you want to change.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. In the Capo section, change the pitch for In staff notation, written C4 sounds as.

The pitch determines the spelling of notes and chord symbols for the corresponding number 
of half-steps.

4. Click OK to save your changes and close the dialog.

RELATED LINKS
Players panel on page 94
Edit Strings and Tuning dialog on page 124
Instrument picker on page 96
Changing the open pitches of fretted instrument strings on page 126
Making layouts transposing/concert pitch on page 155
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Using fretted instrument transpositions

You can show transposed pitches on notation staves and in main chord symbols, according to 
the corresponding fretted instrument’s transposition, in each layout independently and for each 
player holding at least one fretted instrument independently.

For example, if you have added a capo to a fretted instrument and want notation staves and 
main chord symbols to show the pitches the performer must play in order to produce the desired 
sounding pitch.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to use fretted instrument 
transpositions for notation staves and main chord symbols.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Fretted Instruments section, activate Use fretted instrument transposition for 
each player holding at least one fretted instrument in your project.

5. Choose one of the following options:

● For notation

● For notation and main chord symbols

6. Click Apply, then Close.

RESULT
Transpositions set for the corresponding fretted instruments are used for either notation staves 
only or both notation staves and main chord symbols in the selected layouts.

For example, you might choose For notation for fretted instruments with capos that are set 
to show capo chord symbols, and For notation and main chord symbols for detuned fretted 
instruments.

EXAMPLE

Fretted instrument transposition 
(reflecting capo at fret 3) not used 
for notation staff or main chord 
symbols

Fretted instrument transposition 
used for notation staff only

Fretted instrument transposition 
used for notation staff and main 
chord symbols

RELATED LINKS
Layout Options dialog on page 622
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Players on page 107
Capo vs. main chords on page 128
Chord symbols on page 713
Hiding/Showing notation staves and tablature on page 1049
Hiding/Showing capo chord symbols on page 133

Defining capos for chord symbols/diagrams
You can define capos for chord symbols and chord diagrams on a per-player basis. This affects 
chord diagram shapes and the transposition of capo chord symbols. For example, you might 
show both main and capo chord symbols for the voice player when creating a lead sheet.

NOTE

These steps do not affect used chord diagram grids or pitches on notation staves/tablature.

PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to define a capo for 
chord symbols/diagrams.

2. In the action bar, click Player Settings  and choose Chord Symbols > Capo Chord Symbol 
Definition to open the Capo Chord Symbol Definition dialog.

TIP

You can also right-click players and choose this option from the context menu.

3. Change the pitch for In capo chord symbols, written C4 sounds as.

The pitch determines the spelling of capo chord symbols for the corresponding number of 
half-steps.

4. Click OK to save your changes and close the dialog.

RESULT
A capo with the set transposition and spelling is set for the selected player.

Hiding/Showing capo chord symbols

You can show only main chords, only capo chords, or both in chord symbols on a per-player 
basis. For example, if you want to show both for the guitar player but only main chords for the 
singer.

NOTE

Chord diagrams always reflect the capo set for the player.

PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to hide/show capo 
chords in chord symbols.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show only main chords, choose Chord Symbols > Show Main Chord Symbol for 
Capo.

● To show only capo chords, choose Chord Symbols > Show Transposed Chord Symbol 
for Capo.
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● To show capo chords above main chords, choose Chord Symbols > Show Capo Chord 
Symbol Above Main.

● To show capo chords below main chords, choose Chord Symbols > Show Capo Chord 
Symbol Below Main.

TIP

You can also right-click players and choose these options from the context menu.

RESULT
Main and/or capo chords are shown in chord symbols, according to the instrument staves and 
layouts set to show chord symbols for the selected player. Capo chords appear in italics when 
shown alongside main chords.

In layouts where chord symbols are only shown above the top staff in each system, the visibility 
of main/capo chords in chord symbols is determined by the setting for the player at the top of 
each system.

EXAMPLE

Main chords shown only Capo chords shown only Capo chords shown 
above main chords

Capo chords shown 
below main chords

RELATED LINKS
Capo vs. main chords on page 128
Positions of chord symbols on page 714
Hiding/Showing chord symbols on page 714
Hiding/Showing chord symbols in layouts on page 716
Showing chord symbols above one/multiple staves on page 716
Hiding/Showing empty staves on page 515
Showing only chord symbols or chord diagrams on page 730
Hiding/Showing chord diagrams on page 728
Inputting chord symbols on page 291

Showing only main or capo chord symbols

You can show only the main or capo chord in individual chord symbols on staves set to show 
both. For example, if you want to show both the first time each chord symbol appears but only 
show main chords for subsequent instances. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The players on whose staves you want to show only main or capo chords are set to show 
both.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the chord symbols whose shown chords you want to change.

2. In the Properties panel, activate Show only in the Chord Symbols group.

3. Choose one of the following options:

● Main Chord

● Capo Chord

RESULT
The selected chord symbols show only main or capo chords. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Both main and capo chords shown in all chord 
symbols

Only main chords shown in some chord symbols

Defining capos for used chord diagrams grids
You can define capos for used chord diagrams grids in each layout independently. This affects 
chord diagram shapes and the transposition of capo chord symbols. For example, you might 
show both main and capo chord symbols in used chord diagrams grids in the voice part layout 
when creating a lead sheet.

NOTE

These steps do not affect chord symbols/diagrams in the music or pitches on notation staves/
tablature.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts for which you want to define capos for used chord 
diagrams grids.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, change the pitch for Use capo with transposition.

The pitch determines the spelling of capo chord symbols for the corresponding number of 
half-steps.

5. Click Apply, then Close.
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RELATED LINKS
Hiding/Showing used chord diagrams grids on page 731
Capo vs. main chords on page 128
Adding capos to fretted instruments on page 129
Inputting chord symbols on page 291

Hiding/Showing capo chord symbols in used chord diagrams grids

You can show only main chords, only capo chords, or both in used chord symbol grids in each 
layout independently. For example, if you want to show both in the guitar part layout but only 
main chords in the vocal part layout.

NOTE

Chord diagrams in used chord diagrams grids always reflect the capo set for the layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show capo chord symbols in 
used chord diagrams grids.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, select one of the following options from the Capo chord 
symbols menu:

● To show only main chords, select Show Only Main Chord Symbol.

● To show only capo chords, select Show Only Transposed Chord Symbol.

● To show capo chords above main chords, select Show Above Main Chord Symbol.

● To show capo chords below main chords, select Show Below Main Chord Symbol.

5. Click Apply, then Close.

RESULT
Main and/or capo chords are shown in used chord diagrams grids in the selected layouts. Capo 
chords appear in italics when shown alongside main chords.

Edit Percussion Kit dialog
The Edit Percussion Kit dialog allows you to make changes to percussion kits, including which 
instruments are included in them and how instruments are arranged in the different available kit 
presentations.

● The Edit Percussion Kit dialog opens automatically when you create empty kits or combine 
existing instruments into a kit.

● You can also open the Edit Percussion Kit dialog manually for existing percussion kit 
instruments by expanding the card of the player holding the percussion kit in the Players 
panel in Setup mode, then clicking the instrument menu  in its kit instrument label and 
choosing Edit Percussion Kit.

Setup mode
Instruments 

136
Dorico SE 4.3.30



NOTE

Percussion kit instrument labels are green in the Players panel in Setup mode.

1 Name

Allows you to enter or change the full name for the percussion kit. This is used in Full staff 
labels for percussion kits that use the five-line staff presentation type.

2 Short name

Allows you to enter or change the abbreviated name for the percussion kit. This is used in 
Abbreviated staff labels for percussion kits that use the five-line staff presentation type.

3 Drum set

Percussion kits are defined as drum sets when the checkbox is activated. Percussion kits that 
are defined as drum sets have different default settings, including for voicing and default 
stem directions.

4 Presentation types

Allows you to select a percussion kit presentation type in order to edit how the selected 
percussion kit appears in that presentation type.

● 5-line Staff: Kit instruments are shown on a five-line staff. You can determine which 
instruments are shown on each line and in each space of the staff. A single staff label 
containing the name of the kit is shown.

● Grid: Kit instruments are shown on a grid, with each instrument on its own line. You can 
customize how large the gaps between each line are. Staff labels are shown for each 
instrument in a smaller font than normal staff labels.

● Single-line Instruments: Kit instruments are shown as individual instruments with their 
own lines. Normal-sized staff labels are shown for each instrument.
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5 Editor

Displays the current arrangement of instruments in the selected percussion kit presentation 
type. You can change the order of instruments and the layout of lines and spaces in the grid 
presentation type by using the controls.

6 Controls

Allows you to change the order and stem direction of instruments in the selected percussion 
kit presentation type. It also allows you to add slash voices to the kit.

● Edit Names: Opens the Edit Instrument Names dialog, which allows you to change the 
names of the currently selected instrument.

NOTE

This changes the appearance of percussion instrument names in all presentations. 
Depending on the percussion kit presentation type, staff labels might use different 
information than these instrument names.

● Edit Percussion Playing Techniques: Opens the Percussion Instrument Playing 
Techniques dialog, which allows you to change how combinations of noteheads, 
articulations, and tremolos affect playback for the currently selected instrument.

● Edit Noteheads: Opens the Override Percussion Noteheads dialog, which allows you 
to override the noteheads used by the currently selected instrument in five-line staff kit 
presentations.

7 Action bar

Contains options that apply to all presentation types.

● Add New Instrument : Opens the instrument picker, which allows you to choose a 
new unpitched percussion instrument to be added to the kit.

● Add Existing Instrument From Player : Shows a menu listing the other players in 
your project that are holding individual percussion instruments not in kits. You can 
select a percussion instrument from another player to move to this kit, bringing its 
music with it.

● Remove Instrument From Kit : Removes the selected instrument from the kit, so 
it appears as an individual instrument. You can move individual instruments to other 
players or into other kit instruments.

● Change Instrument : Opens the instrument picker, which allows you to choose a new 
unpitched instrument to replace the selected instrument while retaining its music.

● Delete Instrument : Deletes the instrument from the kit, including its music.

8 Export Kit

Allows you to export the percussion kit as a library file so you can use it in other projects.

RELATED LINKS
Percussion kits and drum sets on page 1122
Voices in percussion kits on page 1131
Staff labels for percussion kits on page 1037
Percussion kit presentation types on page 1126
Edit Instrument Names dialog on page 161
Percussion Instrument Playing Techniques dialog on page 1116
Override Percussion Noteheads dialog on page 1118
Playing techniques for unpitched percussion instruments on page 1115
Playing technique-specific noteheads on page 1116
Specifying the stem direction/voice of instruments in percussion kits on page 1132
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Adding instruments to percussion kits
You can add new instruments to percussion kits within the Edit Percussion Kit dialog.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit to which 
you want to add instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Add New Instrument  to open the instrument picker.

4. Select the percussion instrument you want in the instrument picker.

5. Press Return  to add the selected instrument.

6. Click Close.

RESULT
The selected instrument is added to the percussion kit.

RELATED LINKS
Players panel on page 94
Percussion kit presentation types on page 1126

Changing instruments in percussion kits
You can change existing instruments in percussion kits while retaining any existing music for that 
instrument.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit in which 
you want to change instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click the instrument you want to change.

4. Click Change Instrument  in the action bar to open the instrument picker.

5. Select the percussion instrument you want in the instrument picker.

6. Press Return  to change to the selected instrument.

7. Click Close.

RESULT
The instrument is changed to the one selected in the instrument picker. Any music input for the 
previous instrument is retained.

NOTE

Playing techniques expressed using playing technique-specific noteheads are not retained.
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Defining percussion kits as drum sets
You can define individual percussion kits as drum sets. Drum sets use a different voicing than 
percussion kits when using the five-line staff presentation.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit you want 
to define as a drum set.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Activate Drum set in the top right of the dialog.

4. Click Apply, then Close.

RESULT
The selected percussion kit is defined as a drum set. The arrangement of voices for instruments 
in the kit when using the five-line staff presentation type follows the default settings for drum 
sets.

NOTE

If you no longer want a percussion kit to be defined as a drum set, you can deactivate Drum set 
in the Edit Percussion Kit dialog for that kit.

RELATED LINKS
Players panel on page 94
Percussion Instrument Playing Techniques dialog on page 1116

Creating groups of instruments within grid presentation percussion kits
You can create groups of instruments within percussion kits that use the grid presentation type 
in order to have a better overview of the instruments in the kit.

In grid presentation percussion kits, the name of each individual instrument is shown in the staff 
label. You can simplify the staff label of grid presentation percussion kits by creating groups; for 
example, to show “Wood Blocks” instead of “Wood Block (High)”, “Wood Block (Medium)”, and 
“Wood Block (Low)”.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit in which 
you want to create groups in the grid presentation.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the first instrument you want to include in the group.

5. Shift -click the last instrument you want to include in the group.

NOTE

You can only include adjacent instruments in groups.
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6. Click Add .

RESULT
A group is created containing the selected instruments. The group is given a default name that 
you can change.

RELATED LINKS
Players panel on page 94
Percussion kit presentation types on page 1126

Renaming groups in grid presentation percussion kits
Group names are shown as instrument labels. You can change the names of groups in 
percussion kits using the grid presentation type.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit whose 
grid presentation groups you want to rename.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Double-click the group you want to rename to open the Edit Percussion Grid Group Names 
dialog.

Groups are shown as colored blocks in the column to the left of the list of percussion kit 
instruments.

5. Enter the names you want to give the group in the corresponding fields in the Edit 
Percussion Grid Group Names dialog:

● Full Name

● Short Name

6. Click OK to save your changes and close the dialog.

RESULT
The name of the group is changed. This also changes the staff label for the group.

NOTE

Staff labels for groups in grid presentation percussion kits use a different paragraph style to the 
staff labels for non-grouped instruments in grid presentation percussion kits.
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EXAMPLE

Ungrouped grid presentation percussion kit Grid presentation percussion kit with wood blocks 
grouped

RELATED LINKS
Staff labels for percussion kits on page 1037

Deleting groups within grid presentation percussion kits
You can delete groups in percussion kits using the grid presentation type without deleting the 
instruments within the group.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit from 
whose grid presentation you want to delete groups.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the group you want to delete.

Groups are shown as colored blocks in the column to the left of the list of percussion kit 
instruments.

5. Click Delete .

RESULT
The group is deleted. The individual staff labels for each instrument in the group are restored.

Changing the positions of instruments within percussion kits
You can change the positions of instruments within percussion kits of all presentation types 
to change the order in which the instruments appear in the score and parts. In five-line staff 
presentation types, you can also change the staff position of slash voices.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit in which 
you want to change the positions of instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click the kit presentation type in which you want to change the order of instruments.

For example, click Grid to change the order of instruments when the kit uses the grid 
presentation type.
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4. Click the percussion instruments and/or slash voices whose position you want to change.

NOTE

When using the mouse, you can only move one instrument or slash voice at a time.

5. Change the position of the selected instruments/slash voices in any of the following ways:

● Click Move up arrow to move them upwards.

● Click Move down arrow to move them downwards.

● Click and drag a single instrument upwards/downwards (five-line staff presentation 
only).

6. Optional: Repeat these steps for other instruments in the percussion kit, and for other kit 
presentation types for the same percussion kit.

7. Click Apply, then Close.

RESULT
The positions of the selected instruments and/or slash voices within the kit is changed. Multiple 
instruments can share the same staff position, but we recommend that they use different 
noteheads so that the player can tell them apart.

RELATED LINKS
Players panel on page 94
Moving notes to different instruments in percussion kits on page 1124

Changing the size of gaps between lines in percussion grids
You can change the size of gaps between lines in percussion kits using the grid presentation 
type.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player in whose percussion kit 
you want to change the size of gaps in the grid presentation.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the instruments below which you want to change the gap size.

5. Change the value for Gap.

6. Click Apply, then Close.

RESULT
The size of the gaps below the selected instruments is changed.
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Removing individual instruments from percussion kits
You can remove individual instruments from percussion kits without affecting other instruments 
in the kit. For example, if you want to move an instrument from one percussion kit to another 
player.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit from 
which you want to remove instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click the instruments you want to remove from the kit.

4. Click Remove Instrument From Kit  in the action bar.

5. Click Close.

RESULT
The selected instruments are removed from the percussion kit. They appear as individual 
instruments belonging to the same player.

AFTER COMPLETING THIS TASK
You can move the instruments to other players if required.

RELATED LINKS
Players panel on page 94
Moving instruments on page 123

Player groups
A player group represents a collection of musicians that are considered together, such as one 
choir in a work for double choir or an off-stage ensemble. Player groups can have their own 
brackets, depending on the bracket grouping set for each layout.

Grouping players together means they are positioned together in the default player order, 
numbered independently of players outside the group, and are bracketed together according 
to the ensemble type set for each layout.

For example, if your project is for double choir (SATB/SATB), all voices are joined by a single 
bracket by default because they are in the same family. However, if you add each choir to its own 
group, they are bracketed separately. This is useful in works containing multiple groups, such as 
in Britten's “War Requiem”, which has three distinct groups, or in Walton's “Belshazzar's Feast” 
which requires two separate off-stage brass groups.

You can add as many player groups as required; for example, to allow easy separation of 
forces, or to prevent automatic instrument numbering for percussion instruments when multiple 
percussion players hold the same instrument to accommodate instrument changes.

You can also show player group labels for player groups in each layout independently.

RELATED LINKS
Instrument numbering on page 115
Brackets and braces on page 707
Brackets according to ensemble type on page 709
Changing the default player order on page 110
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Setting custom player orders on page 110
Player group labels on page 1036
Player, layout, and instrument names on page 158

Adding player groups
You can organize players into groups; for example, if you want to bracket them together. Players 
in different groups are also numbered separately.

PROCEDURE

1. Optional: If you want to add a group that includes existing players, select those players in 
the Players panel in Setup mode.

2. In the Players panel, click Add Group .

RESULT
A new player group is added to the Players panel. If you selected players, those players are 
added to the group. If you did not select players, the new group is empty.

AFTER COMPLETING THIS TASK

● You can add players to groups and move them between groups.

● You can rename player groups and show player group labels.

RELATED LINKS
Players panel on page 94
Adding players to groups on page 145
Moving players between groups on page 147
Renaming player groups on page 146
Player group labels on page 1036

Adding players to groups
You can add new players to existing player groups.

NOTE

In Dorico SE, the maximum number of players you can have in a single project is two.

PROCEDURE

1. In Setup mode, in the Players panel, select the group to which you want to add new players.

2. Add new players in one of the following ways:

● To add a single player, click Add Single Player  in the action bar.

● To add a section player, click Add Section Player  in the action bar.

The instrument picker opens.

TIP

You can also open the instrument picker by selecting an existing player in the Players panel 
and pressing Shift-I .

3. Select the instrument you want in the instrument picker.
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4. Press Return  to add the selected instrument.

RESULT
The corresponding type of player is added to the selected group.

TIP

You can also move existing players to, from, or between groups.

RELATED LINKS
Players panel on page 94
Instrument picker on page 96
Adding players on page 108
Moving players between groups on page 147
Player group labels on page 1036

Renaming player groups
You can change the name of player groups after you have added them. This changes the name 
shown in player group labels.

PROCEDURE

1. In Setup mode, in the Players panel, select the player group you want to rename.

2. In the action bar, click Player Settings  and choose Rename Player Group to open the 
Rename Player Group dialog.

TIP

You can also right-click player groups and choose this option from the context menu.

3. Enter new names or edit the existing names in the following fields:

● Full name

● Short name

4. Click OK to save your changes and close the dialog.

RESULT
The corresponding names for the selected player group are changed.

Player group labels show full player group names by default. Short player group names are used 
when the full player group name is longer than the bracket.

RELATED LINKS
Players panel on page 94
Player group labels on page 1036
Player, layout, and instrument names on page 158
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Deleting player groups
You can delete groups of players; for example, if you no longer need a group of players that you 
created when importing a MIDI file. When deleting player groups, you can choose to keep the 
players within the group or delete them as well.

PROCEDURE

1. In Setup mode, in the Players panel, select the groups that you want to delete.

2. Delete the selected groups in any of the following ways:

● Press Backspace or Delete .

● In the Players panel, click Delete Player .

3. Choose one of the following options in the warning message that opens:

● Keep Players: Deletes the group but keeps the players.

● Delete Players: Deletes the group and the players it contains.

Moving players between groups
You can move players to, from, or between player groups. For example, you can move 
ungrouped players into existing groups and move players from one group to another.

PROCEDURE

1. In Setup mode, in the Players panel, select the players that you want to move.

2. Click and drag the selected players to the position you want.

An insertion line indicates where the players will be positioned.

RESULT
The players are moved to the new position.

TIP

● You can also add existing players to existing groups by right-clicking them in the Players 
panel and choosing Add Player to Group > [Group] from the context menu.

● You can also add new players to player groups.

RELATED LINKS
Adding players to groups on page 145

Removing players from groups
You can remove players from groups.

PROCEDURE

● In Setup mode, in the Players panel, remove players from groups in any of the following 
ways:

● Select multiple players, then click and drag them out of the group.
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● Select one player, then click Player Settings  in the action bar and choose Remove 
Player from Group. You can also right-click players and choose this option from the 
context menu.

RESULT
The players are removed from their groups but remain in the project as individual players.

Flows
Flows are separate spans of music that are completely independent in musical content, meaning 
they can contain completely different players from each other and have different time signatures 
and key signatures. A single project can contain any number of flows.

Depending on the purpose of each project, a flow could be, for example, a single song in an 
album, a movement in a sonata or symphony, a number in a stage musical, or a short scale or 
sight-reading exercise of only a few bars in length.

Dorico SE automatically adds a flow to projects once you have added at least one player. You 
cannot add flows until you have added at least one player to the project.

When you add a flow in Dorico SE, the following happens automatically:

● The flow is assigned to all full score and part layouts in the project.

● All players are assigned to the new flow.

By default, all layouts include all flows in the project. If necessary, you can change the layouts to 
which flows are assigned and which players are assigned to flows.

IMPORTANT

If you exclude a player from a flow, any notes that you have already input for that player in that 
flow are deleted.

RELATED LINKS
Flows panel on page 104
Players on page 107
Layouts on page 151
Tacets on page 541
Players, layouts, and flows on page 105
Importing flows on page 74
Exporting flows on page 75
Starting new projects on page 66
Opening projects/files on page 67
Flow headings on page 550

Adding flows
You can add any number of new flows to your project; for example, when engraving a large work 
that comprises multiple movements.

PROCEDURE

● In Setup mode, add a flow in any of the following ways:

● Press Shift-F .
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● In the Flows panel, click Add Flow .

RESULT
A new flow is added to your project. All existing players are assigned to new flows, and new flows 
are automatically assigned to all existing full score and part layouts.

AFTER COMPLETING THIS TASK

● You can rename the flow.

● You can change the players assigned to the flow and the layouts to which the flow is 
assigned.

RELATED LINKS
Flows panel on page 104
Importing flows on page 74
Exporting flows on page 75
Starting new projects on page 66
Opening projects/files on page 67
Renaming flows on page 165
Adding players on page 108
Assigning players to flows on page 149
Assigning flows to layouts on page 154

Duplicating flows
You can duplicate flows; for example, if you want to experiment with some ideas without 
affecting the original flow, or if you want to copy material with any barlines you have added.

PROCEDURE

● In Setup mode, in the Flows panel, right-click the flow you want to duplicate and choose 
Duplicate Flow from the context menu.

RESULT
A new flow is added, containing all the music and players of the original flow. It is automatically 
added to all full score and part layouts.

Assigning players to flows
By default, all players in your project are added to all flows that originated in the project. You can 
assign players to and remove players from flows manually; for example, if the soloists in a choral 
work do not sing for an entire flow.

NOTE

If you remove a player from a flow, any notes you have already input for that player in that flow 
are deleted.

PROCEDURE

1. In Setup mode, in the Flows panel, select the flow whose assigned players you want to 
change.

2. In the Players panel, activate the checkbox in the card of each player you want to assign to 
the flow.
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TIP

You can Shift -click to activate/deactivate the checkboxes in multiple player cards at once.

RESULT
Players are assigned to the selected flow when the checkbox in their player card is activated, and 
removed from the flow when the checkbox is deactivated.

RELATED LINKS
Flows panel on page 104
Tacets on page 541
Assigning flows to layouts on page 154
Assigning players to layouts on page 153

Reordering flows
You can change the order of flows; for example, if you want an imported flow to be the first flow 
rather than the last.

PROCEDURE

1. In Setup mode, in the Flows panel, select the flows whose order you want to change.

2. Click and drag the selected flows to the right/left.

RESULT
The selected flows are moved to the specified position. Their flow numbers are automatically 
updated, as is their order in the Project Info dialog and in layouts by default.

TIP

You can also reorder flows in the Project Info dialog by selecting them in the flows list and 
clicking Move Down  or Move Up  in the action bar. This can be an easier method of 
reordering flows in projects that contain many flows.

RELATED LINKS
Project Info dialog on page 70
Flow names and flow titles on page 164
Importing flows on page 74
Flow headings on page 550
Tokens on page 552
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Deleting flows
You can delete flows that you no longer need. This deletes all music for all instruments and 
players in the flows.

PROCEDURE

1. In Setup mode, in the Flows panel, select the flows you want to delete.

2. Delete the selected flows in any of the following ways:

● Press Backspace or Delete .

● In the Flows panel, click Delete Flow .

RELATED LINKS
Importing flows on page 74
Exporting flows on page 75

Layouts
Layouts combine musical content, as represented by flows and players, with rules for page 
formatting and music engraving, and allow you to produce paginated music notation that can be 
printed or exported in various formats. For example, part layouts typically only show the music 
for one player, whereas full score layouts show the music of all players in the project.

Layouts can contain any combination of players and flows. They share the musical content of 
these players and flows, such as the notes each instrument plays. For example, when you change 
the pitch of a note in the full score, that note’s pitch is also updated in the corresponding part 
layout.

You can control practically every aspect of page formatting in each layout independently, 
including note spacing, staff size, page size, margins, and casting off; that is, the positions of 
system breaks and page turns. Changing these aspects in one layout does not affect other 
layouts. For example, inserting systems breaks in a part layout does not change the casting off in 
the full score.

Similarly, you can change the visual appearance of many items only in one layout, without 
affecting other layouts, using local properties. For example, you can hide text items in the full 
score layout but show them in part layouts.

The default formatting of pages in layouts is determined by page templates. By default, full score 
layouts use a different page template set to part layouts; however, you can apply a different page 
template set to each layout.

Dorico SE provides the following layout types:

Full score
A full score layout includes all players and all flows in your project by default. Full score 
layouts are concert pitch by default.

Dorico SE automatically creates a single full score layout in every project.

Part
A part layout is automatically created when you add a player to your project. You can 
also create empty part layouts and assign players to them manually.

By default, instrumental part layouts contain all flows. They are also transposed pitch 
by default.

You can propagate the formatting of part layouts.
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Custom score
A custom score layout initially does not contain any players or flows. This allows you 
to create your score manually and, for example, assign only one flow instead of all 
flows or only vocal and piano players to create a vocal score. Custom score layouts are 
concert pitch by default.

TIP

● You can create as many layouts of each type in each project as required.

● You can combine players, layouts, and flows together in any combination. For example, 
you might add all percussion players to a single part layout so that the performers can 
manage instrument changes themselves. In a large-scale work, you might also create a 
piano reduction for choir rehearsals, but only assign that piano player to the vocal score, 
meaning it does not appear in the orchestral full score at all.

● By default, respelling notes in score layouts also affects their spelling in all other layouts, but 
respelling notes in part layouts only affects their spelling in the current part layout.

● You can save options set in Layout Options as the default for score and part layouts 
independently. For example, full scores and part layouts often require different page and 
staff sizes.

● Deleting layouts does not delete any music from the project.

RELATED LINKS
Page formatting on page 508
Part formatting propagation on page 544
Flows on page 148
Players on page 107
Players, layouts, and flows on page 105
Page templates on page 547
Page template sets on page 548
Types of page templates on page 549
Applying page template sets to layouts on page 511
Properties on page 560
Local vs. global properties on page 561
Layout Options dialog on page 622
Player, layout, and instrument names on page 158
Renumbering layouts on page 156
Renaming layouts on page 160
Switching between layouts on page 40
Switching to galley/page view on page 47
Hiding/Showing staff labels on page 1030
Brackets according to ensemble type on page 709
Casting off on page 535
Condensing on page 543
Divisi on page 1047
Editing layout transposition text on page 801
Respelling notes on page 428
Hiding/Showing text items on page 1073
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Creating layouts
You can create any number of full score, custom score, and part layouts in each project. By 
default, Dorico SE creates a single full score layout and a part layout for each player.

PROCEDURE

● In Setup mode, in the Layouts panel, click one of the following layout types:

● Add Full Score Layout 

● Add Instrumental Part Layout 

● Add Custom Score Layout 

RESULT
The layout is added to the list of layouts in the Layouts panel.

NOTE

● Layouts are not available in the layout selector until you have assigned at least one player to 
them.

● You can also add new custom score layouts by pressing Shift-L .

AFTER COMPLETING THIS TASK

● You can assign players and flows to the layout.

● If you want to change the position of the new layout in the layouts list, you can reorder and 
renumber layouts.

RELATED LINKS
Layouts panel (Setup mode) on page 101
Workspace options on page 29
Reordering layouts on page 156
Renumbering layouts on page 156
Switching between layouts on page 40
Switching to galley/page view on page 47
Opening new tabs on page 42

Assigning players to layouts
By default, all players are included in full score layouts and each player is automatically assigned 
its own part layout. You can assign players to and exclude players from layouts manually; for 
example, if you want to remove unnecessary players from the full score, or you want to add the 
soloists’ music to the part for the accompanist.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout whose assigned players you want to 
change.

2. In the Players panel, activate the checkbox in the card of each player you want to assign to 
the layout.
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TIP

You can Shift -click to activate/deactivate the checkboxes in multiple player cards at once.

RESULT
Players are assigned to the selected layout when the checkbox in their player card is activated, 
and removed from the layout when the checkbox is deactivated. If you have not changed the 
name of the layout, it is automatically updated to reflect the players included in the layout.

RELATED LINKS
Players panel on page 94
Layouts panel (Setup mode) on page 101
Player, layout, and instrument names on page 158
Renaming layouts on page 160
Assigning players to flows on page 149

Assigning flows to layouts
By default, all flows in your project are added to all layouts. You can exclude flows that you do not 
want to show in a layout. You can assign flows to and remove flows from layouts manually; for 
example, if a flow in your project contains specific performance instructions for strings that you 
want to show in string part layouts but not in other part layouts.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout whose assigned flows you want to 
change.

2. In the Flows panel, activate the checkbox in the flow card of each flow you want to assign to 
the layout.

TIP

You can Shift -click to activate/deactivate the checkboxes in multiple flow cards at once.

RESULT
Flows are assigned to the selected layout when the checkbox in their flow card is activated, and 
removed from the layout when the checkbox is deactivated.

Dorico SE automatically creates enough pages to display the flows assigned to the layout.

RELATED LINKS
Layouts panel (Setup mode) on page 101
Flows panel on page 104
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Making layouts transposing/concert pitch
You can change whether each layout in your project is transposing or concert pitch. In Dorico SE, 
full score layouts are concert pitch and part layouts are transposing by default.

For example, full scores are often concert pitch, to show notes at their sounding pitch, but part 
layouts are transposing so the player can read the notes they must play in order to achieve the 
desired sounding pitch.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts you want to make transposing/non-transposing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Players section, activate/deactivate Transposing layout.

5. Click Apply, then Close.

RESULT
The selected layouts are transposed pitch when Transposing layout is activated, and concert 
pitch when it is deactivated.

TIP

You can also make layouts transposing by choosing Edit > Transposed Pitch, and concert pitch 
by choosing Edit > Concert Pitch. This automatically updates the layout option but only for the 
layout currently open in the music area.

RELATED LINKS
Transposing instruments on page 119
Fretted instrument tuning on page 124
Transposing selections on page 424
Changing the input pitch setting on page 203
Hiding/Showing clefs according to layout transpositions on page 739
Editing layout transposition text on page 801

Concert vs. transposed pitch
Layouts in Dorico SE can use concert or transposed pitch. This affects the pitches and key 
signatures on staves belonging to transposing instruments.

Concert pitch
When music is in concert pitch, all notes are written as they sound. This means that 
players with transposing instruments reading music in concert pitch must transpose 
the music themselves. For example, if a clarinet in B♭ reads a C in concert pitch, they 
must play the note D on their instrument to produce the sounding note C.
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Transposed pitch
When music is in transposed pitch, the notes written are the ones each instrument 
must play in order to produce the desired sounding pitch. For example, if a clarinet in 
B♭ reads a D in transposed pitch, the pitch that sounds from the instrument is C.

Transposed pitch layouts automatically transpose key signatures and chord symbols according to 
the transposition of the instrument. Transposing and concert pitch layouts can also use different 
clefs.

RELATED LINKS
Transposing selections on page 424
Enharmonic equivalent key signatures on page 819
Clefs with octave indicators on page 741
Capo vs. main chords on page 128
Editing layout transposition text on page 801

Reordering layouts
You can change the order in which layouts appear in the Layouts panel and the layout selector; 
for example, if you added a custom score layout and want it to be positioned at the top next to 
the full score layout.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layouts whose order you want to change.

2. Click and drag the selected layouts upwards/downwards.

RESULT
The selected layouts are moved to the specified position. This does not affect their layout 
numbers.

TIP

You can also automatically sort layouts according to their type by clicking Sort Layouts  in the 
Layouts panel, which positions all full score layouts at the top, all part layouts in the middle, and 
all custom score layouts at the bottom.

You can click and hold or right-click Sort Layouts  to change the setting to one of the following 
options:

● Layout Number

● Instrument Score Order

RELATED LINKS
Layouts panel (Setup mode) on page 101

Renumbering layouts
You can renumber all layouts according to their current position in the Layouts panel in Setup 
mode; for example, after you have dragged layouts to different positions.

PROCEDURE

1. In Setup mode, in the Layouts panel, select any layout.

2. In the action bar, click Layout Settings  and choose Renumber Layouts.
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TIP

You can also right-click layouts and choose this option from the context menu.

RESULT
All layouts are renumbered according to their current position in the panel. Full score layouts, 
custom score layouts, and part layouts are all numbered separately.

Deleting layouts
You can delete layouts without removing the corresponding music from the project. For example, 
if you only want to use a combined Violin I and II part layout, you can delete their separate part 
layouts.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layouts that you want to delete.

2. Delete the selected layouts in any of the following ways:

● Press Backspace or Delete .

● In the Layouts panel, click Delete Layout .

RESULT
The selected layouts are deleted without removing any music from the project.

AFTER COMPLETING THIS TASK
You can later restore all the part layouts that Dorico SE provides by default.

RELATED LINKS
Layouts panel (Setup mode) on page 101
Players, layouts, and flows on page 105

Restoring default layouts
You can recreate all the part layouts that Dorico SE provides by default; for example, if you 
accidentally deleted some part layouts.

PROCEDURE

● In Setup mode, choose Setup > Create Default Part Layouts.

RESULT
The default set of part layouts is restored, recreating a single part layout for each player that 
contains all flows in the project. Any part layouts that were recreated are added at the bottom 
of the Layouts list. Their order matches the order of the corresponding players in the Players 
panel.
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Player, layout, and instrument names
In Dorico SE, you can use three different names to refer to the same player in different contexts. 
This allows you to show relevant information in different places, such as in staff labels and at the 
top of part layouts.

The following names relate to players and instruments:

Player name
The name of each player in the Players panel. They can be used in staff labels instead 
of instrument names.

Player names are automatically generated when you add instruments, and are linked 
to the corresponding instrument names until you rename the player.

Layout name
The name for each layout in the Layouts panel. By default, layout names appear with 
borders at the top of pages in part layouts that use the First page template.

Layout names for part layouts are automatically generated when you add instruments 
to the corresponding players, and are linked to the corresponding players’ names until 
you rename the layout.

Instrument names
Used in staff labels by default. This means that the instrument label on each staff 
is relevant to the instrument or percussion kit currently being played by that player, 
rather than listing all instruments that player is playing in the flow.

For example, if a clarinettist is doubling bass clarinet, the staff label where the player 
plays clarinet automatically shows Clarinet, and the staff label automatically shows 
Bass Clarinet where the player plays bass clarinet.

All instruments in Dorico SE come with a set of instrument names that you can change 
for individual instruments, independently of other players in the project holding the 
same instrument. You can also save changes to instrument names as default, which 
are then used whenever you add that instrument again in the current project and all 
future projects.

NOTE

● Changing the default instrument names does not change the instrument names of 
existing instruments of that type in your project.

● You can change various aspects of how instrument names appear in staff labels 
without changing instrument names, such as whether instrument transpositions 
are shown before or after instrument names.

RELATED LINKS
Instrument numbering on page 115
Page templates on page 547
Types of page templates on page 549
Tokens on page 552
Staff labels on page 1029
Instrument transpositions in staff labels on page 1033
Showing instrument/player names in staff labels on page 1032
Percussion legends on page 1128
Players on page 107
Layouts on page 151
Assigning players to layouts on page 153
Changing instrument names on page 161

Setup mode
Player, layout, and instrument names 

158
Dorico SE 4.3.30



Renaming player groups on page 146

Renaming players
You can change the player names of players, and reset renamed players to their default names. 
Player names appear in guide instrument labels in galley view for players holding multiple 
instruments and can appear in staff labels.

PROCEDURE

1. In Setup mode, in the Players panel, select the player you want to rename.

2. In the action bar, click Player Settings  and choose Rename Player to open the Rename 
Player dialog.

TIP

You can also right-click players and choose this option from the context menu.

3. Enter new names or edit the existing names in the following fields:

● Full name

● Short name

4. Click OK to save your changes and close the dialog.

RESULT
The corresponding names for the selected player are changed. If you have not already renamed 
the corresponding part layout, its layout name is updated.

NOTE

● This does not affect staff labels that show instrument names, or the name at the top of 
part layouts if you have already renamed the layout. You can change instrument and layout 
names separately.

● Player names you have changed no longer get updated when you change the instruments or 
names of instruments held by the player.

RELATED LINKS
Players panel on page 94
Tokens on page 552
Changing instrument names on page 161
Renaming player groups on page 146
Moving instruments on page 123
Staff labels on page 1029
Showing instrument/player names in staff labels on page 1032
Switching to galley/page view on page 47

Resetting player names
You can reset both full and short player names to their defaults simultaneously. Default player 
names automatically update when you change the instruments or names of instruments held by 
the player.

PROCEDURE

1. In Setup mode, in the Players panel, select the player whose names you want to reset.
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2. Press Return  to open the player name text field.

3. Click Reset to Default .

RESULT
Both the full and short names for the corresponding player are reset to their defaults.

Renaming layouts
You can rename layouts and reset renamed layouts to their default name. By default, layout 
names appear with borders at the top of pages in part layouts that use the First page template.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout you want to rename.

2. Press Return  to open the layout name text field.

3. Rename the layout in any of the following ways:

● Enter a new layout name or edit the existing name.

● To revert the layout name to the player name, click Reset to Default .

TIP

If you want to include an accidental in the instrument transposition, you can enter the 
appropriate token, such as {@flat@} for ♭.

4. Press Return .

RESULT
The selected layout is renamed, or reverted to its default name.

NOTE

● Renaming layouts does not affect staff labels, which show either instrument or player 
names.

● Part layout names you have changed no longer get updated when you rename the 
corresponding players.

RELATED LINKS
Player, layout, and instrument names on page 158
Layouts panel (Setup mode) on page 101
Tokens on page 552
Page templates on page 547
Types of page templates on page 549
Staff labels on page 1029
Staff label contents on page 1032
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Changing instrument names
By default, instrument names are used in staff labels and instrument change labels shown above 
the staff. You can change the different instrument names used for each instrument; for example, 
if you want them to appear in a different language.

NOTE

Changing instrument names does not change the name shown at the top of part layouts if you 
have already renamed the layout. You can rename layouts separately.

PROCEDURE

1. In Setup mode, in the Players panel, click the disclosure arrow in the card of the player 
holding the instrument whose names you want to change.

This expands the card to show the instruments held by the player.

2. In the instrument label, click the instrument menu  and choose Edit Names to open the 
Edit Instrument Names dialog.

3. Enter new names in any of the name fields.

4. Optional: Activate Save as default for instrument.

5. Click OK to save your changes and close the dialog.

RESULT
The instrument names for the selected instrument are changed. If you have not already renamed 
the corresponding player, its player name is updated.

● If you did not save your changes as default, only the names of the selected instrument are 
changed. Any instruments of the same type added later or in future projects use the original 
default names.

● If you saved your changes as default, any instruments of the same type added later 
or in future projects use your new instrument names. This does not affect any existing 
instruments of that type unless you reset their names.

RELATED LINKS
Players panel on page 94
Instruments on page 114
Instrument changes on page 117
Instrument numbering on page 115
Player, layout, and instrument names on page 158
Staff labels on page 1029
Showing instrument/player names in staff labels on page 1032
Changing the appearance/position of instrument transpositions in staff labels on page 1034
Editing the default instrument change label text on page 118

Edit Instrument Names dialog
The Edit Instrument Names dialog allows you to change the content and formatting of each 
instrument’s names, which are used in staff labels and instrument change labels shown above 
the staff. You can edit both singular/plural full instrument names and singular/plural short 
instrument names.

● You can open the Edit Instrument Names dialog in Setup mode by clicking the instrument 
menu  in an instrument label in the Players panel and choosing Edit Names.
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The Edit Instrument Names dialog contains the following options and sections:

1 Editing instrument

Displays the permanent underlying name of the instrument.

2 Editing

Allows you to switch between editing the Singular names and Plural names of the selected 
instrument.

Singular names are used when the staff contains one player, Plural names are used when 
the staff contains multiple players.

3 Full name section

Contains options that allow you to edit the appearance of the full instrument name.

4 Full name text editor options

Allows you to customize the font, size, and formatting of the selected part of the full 
instrument name.

5 Full name text editing area

Shows the current long name for the selected instrument, as it appears in Full staff labels. 
You can select any part of the instrument name and edit it independently of other parts; for 
example, if you want to add additional information on a new line and in italics. However, 
instrument names in instrument change labels are always shown on a single line.

Staff labels are right-aligned by default, so appear at the right edge of the text editing area.

6 Short name section

Contains options that allow you to edit the appearance of the short instrument name.

7 Short name text editor options
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Allows you to customize the font, size, and formatting of the selected part of the short 
instrument name.

8 Short name text editing area

Shows the current short staff label for the selected instrument, as it appears in Abbreviated 
staff labels. You can select any part of the instrument name and edit it independently of 
other parts; for example, if you want to add additional information on a new line and in 
italics. However, instrument names in instrument change labels are always shown on a 
single line.

Staff labels are right-aligned by default, so appear at the right edge of the text editing area.

9 Show transposition

Allows you to choose when the transposition is shown in the instrument name for the 
selected instrument. It is common to see the transposition included in the name of 
transposing instruments, such as Clarinet in B♭.
You can choose when the transposition is shown from the following options:

● Always: Instrument transpositions are shown even if you have chosen to hide them on 
the Staves and Systems page in Layout Options.

● Follow Layout Options: Instrument transpositions can be hidden and shown, 
depending on your per-layout settings in Layout Options.

● Never: Instrument transpositions are never shown, even if you have chosen to show 
them in Layout Options.

10 Save as default for instrument

Activating the checkbox saves your changes in the dialog as the default. This affects all new 
instruments of that type that you add to the project and all future projects. It does not affect 
any existing instruments of that type unless you reset their names.

11 Reset to Default

Removes all your changes to the names of the selected instrument type and reverts them to 
the current default settings. If you changed the default name for an instrument type after 
adding an instrument, resetting its names changes them to your new default names.

NOTE

Staff labels always use the horizontal alignment set for the paragraph style, they do not use the 
alignment set in the Edit Instrument Names dialog. This ensures consistent alignment across 
the whole system.

RELATED LINKS
Layout Options dialog on page 622
Resetting instrument names on page 163
Staff labels on page 1029
Hiding/Showing staff labels on page 1030
Text editor options in Write mode on page 357

Resetting instrument names
You can reset all your changes to the names of individual instruments and revert them to the 
current default settings for their instrument type.

NOTE

Resetting instrument names does not change the name shown at the top of part layouts. If you 
want to change the name used at the top of part layouts, rename the layout.
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PROCEDURE

1. In Setup mode, in the Players panel, click the disclosure arrow in the card of the player 
holding the instrument whose names you want to reset.

This expands the card to show the instruments held by the player.

2. In the instrument label, click the instrument menu  and choose Edit Names to open the 
Edit Instrument Names dialog.

3. Click Reset to Default.

4. Click OK to save your changes and close the dialog.

RESULT
The instrument names for the selected instrument are reset to the current default settings for 
its instrument type. If you changed the default name for the instrument type after adding the 
instrument, resetting its names changes them to your new default names.

TIP

You can assign a key command for Reset Instrument Names on the Key Commands page in 
Preferences, which resets all instrument names in the project to their default settings.

RELATED LINKS
Players panel on page 94
Key Commands page in the Preferences dialog on page 54
Renaming layouts on page 160

Flow names and flow titles
Whenever you add a flow to a project, the default name of a flow is Flow plus an incremental 
number. In Dorico SE, flows have both a flow name and a flow title, which are the same by 
default but can be different if, for example, you want to organize sketch versions of flows without 
affecting their displayed titles in the music.

Flow names
Set either in the Flows panel in Setup mode or in the flows list in the Project Info 
dialog.

Flow titles
Set in the Title field for each flow in the Project Info dialog.

Flow titles automatically match the flow name until you change the flow title independently. 
Changing flow titles removes the link between their flow title and flow name.

Titles shown in layouts are linked to the Title fields in the Project Info dialog, using the 
{@projectTitle@} and {@flowTitle@} tokens. This allows you to organize flows with different 
names to their displayed title in the music.

TIP

You can change both flow names and flow titles in the Project Info dialog, and you can also 
change flow names in the Flows panel in Setup mode.

RELATED LINKS
Tokens on page 552
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Project Info dialog on page 70
Flows panel on page 104

Renaming flows
You can change the names of flows in Setup mode. This automatically updates the title of the 
corresponding flow until you change the title in the Project Info dialog.

PROCEDURE

1. In Setup mode, in the Flows panel, double-click the card of the flow you want to rename to 
open the flow name text field.

2. Enter a new name for the flow or edit the existing name.

3. Press Return .

RESULT
The name of the flow is changed. If you have not entered a different title for the flow in the 
Project Info dialog, the title shown in the music area is updated to match the new flow name.

TIP

You can also rename flows in the Project Info dialog.

RELATED LINKS
Flows panel on page 104

Changing flow titles
You can change flow titles in the Project Info dialog. Once you have done so, flow titles are no 
longer automatically changed if you change their flow name.

PROCEDURE

1. Press Ctrl/Cmd-I  to open the Project Info dialog.

2. Select the flow whose title you want to change in the flows list.

3. Enter a new title in the Title field.

4. Optional: Repeat steps 2 and 3 for other flows in your project.

5. Click OK to save your changes and close the dialog.

RESULT
The titles of the selected flows are changed.

NOTE

This breaks the link between flow names and the title shown in the music area.

RELATED LINKS
Project Info dialog on page 70
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Videos
Dorico SE supports the use of videos within the program as well as the associated notations, 
such as markers and timecodes, and allows you to find appropriate tempos based on where 
important markers occur.

Videos are a fast sequence of images that create the impression of a moving image. They can be 
any length, from only a few seconds up to several hours for feature-length films.

Videos in Dorico SE are shown in a separate Video window and play back in sync with the music. 
Any existing audio in the video is also played back, and you can control the volume of this audio 
independently of the volume of the music.

TIP

You can use these features, including setting a project frame rate, without having a video 
attached.

RELATED LINKS
Adding videos on page 168
Frame rates on page 171
Timecodes on page 971
Markers on page 967
Changing the volume of video audio on page 170

Supported video formats
Dorico SE uses the same video engine that was introduced in Cubase and Nuendo in 2017. It 
supports the most commonly-used video formats.

The following video formats are supported:

● MOV: Including H263, H264, Apple ProRes, DV/DVCPro and Avid DNxHR codecs

● MP4: Including H263 and H264

● AVI: Including DV/DVCPro and MJPEG/PhotoJPEG

All the common frame rates, such as 23.976, 24, 24.975, 25, 29.97, and 30 frames per second, are 
fully supported in Dorico SE.

NOTE

● Videos with variable frame rates are not supported.

● Support for more formats is planned for future versions.

You can consult the Steinberg support site for more information about the supported formats as 
well as how to identify and change video formats.

RELATED LINKS
Frame rates on page 171

Setup mode
Videos 

166
Dorico SE 4.3.30



Video Properties dialog
The Video Properties dialog allows you to change video-related settings, including their frame 
rate and start position.

● You can open the Video Properties dialog in Setup mode by right-clicking a flow in the 
Flows panel and choosing Video > Properties from the context menu.

It also opens automatically when you add a new video.

The Video Properties dialog contains the following fields and options:

Video file
Shows the location of the video file on your computer. This field is read-only.

Video frame rate
Shows the frame rate of the video file. This field is read-only.

Project frame rate
Allows you to select a frame rate for your project from the menu. You can only have a 
single frame rate across the project.

Use video frame rate
Sets the project frame rate to be the same as the video file.

Flow attachment position
Allows you to set the rhythmic position at which the video attaches. This is set using 
the Beat count and Beat unit settings in combination, such as eight dotted quarter 
notes.

Video start offset
Allows you to set a position within the video that syncs with the flow attachment 
position; for example, you can set the fifth second of the video to attach to the start of 
the third bar.

Timecode start
Allows you to set the timecode at the start of the video. This also affects the timecode 
of the flow, but the initial timecode of the flow adjusts to accommodate the video. For 
example, if the initial timecode of the video is 02:00:00:00 but the video does not start 
until the start of the third bar in 4/4, the initial timecode of the flow is eight beats of 
time less than 02:00:00:00; if the tempo is 60 bpm, this makes the initial flow timecode 
01:59:52:00.
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NOTE

Flow timecodes are shown in their flow cards in the Flows panel.

RELATED LINKS
Timecodes on page 971
Flows panel on page 104

Adding videos
You can add a video to each flow in your project. You can also follow these steps to reload videos 
previously added to the project that Dorico SE can no longer locate.

Flows with missing videos show a warning icon  instead of the video icon in the flow card in the 
Flows panel. This can happen if you send a project to someone else without the video file.

PREREQUISITE
You have added at least one player to the project.

PROCEDURE

1. In Setup mode, in the Flows panel, right-click the flow to which you want to add/reload a 
video and choose Video > Attach from the context menu to open the File Explorer/macOS 
Finder.

2. Locate and select the video file you want to add.

3. Click Open to open the Video Properties dialog.

4. Change the settings as required.

5. Click OK to save your changes and close the dialog.

RESULT
The selected video file is added to the flow and is shown in the Video window. A video reel icon 
appears in the flow card in the Flows panel, beside a timecode indicating the combination of the 
Video start offset and Timecode start.

If you reloaded a video, all your previous settings are retained.

RELATED LINKS
Flows panel on page 104
Adding players on page 108
Timecodes on page 971
Changing the initial timecode value on page 972

Changing the start position of videos
You can change both the rhythmic position in the music at which videos start, and the position in 
the video that coincides with that rhythmic position; for example, if you want the fifth second of a 
video to sync with the start of the third bar of music.

PROCEDURE

1. In Setup mode, open the Video Properties dialog in one of the following ways:

● Add a video to a flow.
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● In the Flows panel, right-click a flow and choose Video > Properties from the context 
menu.

2. Change the values for the following options, individually or together:

● Flow attachment position

● Video start offset

3. Click OK to save your changes and close the dialog.

RESULT
Changing the value for Flow attachment position changes the rhythmic position in the music at 
which the video starts.

Changing the value for Video start offset changes the position in the video that occurs at the 
Flow attachment position.

For example, if you change the Video start offset to 00:00:05:00 and the Flow attachment 
position to 8, then the fifth second in the video happens on the eighth beat in the music.

NOTE

● The initial rhythmic position is 0. Therefore, if the Flow attachment position is set to 8 and 
the time signature is 4/4, the flow attachment occurs on the first beat in the third bar.

● Changing the Video start offset changes what part of the video coincides with the Flow 
attachment position, but this does not cut the video before this point. Any preceding video 
material is shown as long as it happens within the flow.

Hiding/Showing the Video window
You can hide and show the Video window at any time and in any mode; for example, if you do 
not want it in view when working on the music in the music area.

PROCEDURE

● Hide/Show the Video window in any of the following ways:

● Press F4 .

● In the toolbar, click Show Video .

● Choose Window > Video.

RELATED LINKS
Toolbar on page 28
Markers track on page 451

Changing the size of the Video window
You can change the size of the Video window at any time.

PREREQUISITE
The Video window is shown.

PROCEDURE

● Change the size of the Video window in any of the following ways:

● Click and drag the corners/edges in any direction.
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● Shift -click and drag a corner/edge to change the size without changing the shape.

RESULT
The size of the Video window is changed. Dorico SE saves the new size and shape and uses this 
for all projects until you change the size again.

Removing videos
You can remove videos from each flow independently.

PROCEDURE

● In Setup mode, in the Flows panel, right-click the flow from which you want to remove a 
video and choose Video > Detach from the context menu.

RESULT
The video is removed from the selected flow.

RELATED LINKS
Flows panel on page 104

Changing the volume of video audio
Any audio that is part of a video you have added is played back in sync with the music in the 
project. You can change the video volume manually.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

1. Optional: If the Video channel is not shown in the Mixer, click Video in the Mixer toolbar.

2. Do one of the following:

● To change the volume of video audio, click and drag the Video channel fader upwards/
downwards.

● To mute video audio, click Mute  in the Video channel.

RESULT
The volume of audio from videos in your project is changed.

RELATED LINKS
Mixer panel on page 612
Mixer window on page 613
Muting/Soloing tracks on page 461
Deactivating mute/solo instrument states on page 462
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Frame rates
The frame rate of a video is the number of still images that are used per unit of time in order to 
create the impression of a moving image, commonly measured in frames per second, or “fps”.

The number of frames per second required to create the impression of a moving image is 
determined by how fast the human eye processes movement, and so the most common frame 
rate is around 24 fps. However, recent major films have been released at 48 fps, which results in 
sharper images.

Dorico SE supports frame rates from 23.976 fps to 60 fps. For example, the US and Canadian 
broadcast standard NTSC uses 29.97 fps.

Frame rates are closely linked to timecodes, as timecodes include both the time and the current 
frame position.

All the common frame rates, such as 23.976, 24, 24.975, 25, 29.97, and 30 frames per second, are 
fully supported in Dorico SE.

By default, Dorico SE uses the same frame rate for the project as the video file, but you can 
manually choose a different frame rate.

RELATED LINKS
Timecodes on page 971

Changing the project frame rate
By default, Dorico SE uses the video frame rate as the project frame rate. You can change the 
project frame rate if you want it to be different; for example, if your project contains multiple 
videos with different frame rates.

TIP

You can change the frame rate even if there are no videos in the project.

PROCEDURE

1. In Setup mode, open the Video Properties dialog in one of the following ways:

● Add a video to a flow.

● In the Flows panel, right-click a flow and choose Video > Properties from the context 
menu.

2. Select the frame rate you want to use for the project from the Project frame rate menu.

3. Click OK to save your changes and close the dialog.

RESULT
The project frame rate is changed.
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Write mode

Write mode allows you to input and edit your music, including changing the rhythmic positions 
of items, changing the pitch of notes, and deleting notes and items. The available toolboxes and 
panels allow you to input all the notes and notation items that are most commonly used.

By design, you cannot move notes and items graphically in Write mode. Graphical adjustments 
are only possible in Engrave mode in Dorico Pro.

Project window in Write mode
The project window in Write mode contains toolboxes and panels with the tools and functions 
required to write your music.

You can switch to Write mode in any of the following ways:

● Press Ctrl/Cmd-2 .

● In the toolbar, click Write.

● Choose Window > Write.

The following zones and toolboxes are available in Write mode:

1 Notes toolbox

Contains tools that affect note input and editing.

2 Left zone

Contains the Notes panel. The Notes panel provides the note durations, accidentals, and 
articulations that are most commonly used during note input.

3 Right zone
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Can display different panels, according to the current selection in the Notations toolbox. 
Panels in the right zone contain notation items that you can add to your music, such as 
dynamics and playing techniques, divided into separate categories.

4 Notations toolbox

Contains either panel or popover buttons, depending on whether Panels  or Popovers 
is active.

Allows you to show panels for different notations in the right zone, open popovers, and input 
certain items directly, such as rehearsal marks and text.

5 Lower zone

Can display different panels, according to the current selection in the lower zone toolbar. 
Panels in the lower zone include the Properties panel, which allows you to make individual 
modifications to the currently selected notes and notations, and the Keyboard panel, which 
allows you to input notes.

RELATED LINKS
Lower zone (Write mode) on page 182
Properties panel on page 560
Mixer panel on page 612
Copying property settings to other layouts/frame chains on page 547

Notes toolbox
The tools in the Notes toolbox allow you to start note input, modify notes, and change the type 
and scope of notes you input. The Notes toolbox is located on the left of the window in Write 
mode.

Show Left Zone

Hides/Shows the left zone.

Select

Activates/Deactivates mouse input. When Select is activated, mouse input is 
deactivated and you cannot input notes by clicking on the staff.

TIP

You can assign a key command for Disable Mouse Input on the Key Commands page 
in Preferences.

Start Note Input

Starts/Stops note input by showing/hiding the caret. If a note, rest, or item is selected 
in the music area, note input starts at the selected rhythmic position. If nothing is 
selected in the music area, note input starts at the earliest rhythmic position on the top 
staff in view.

Pitch Before Duration
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When this option is activated, you can select the pitch before specifying the duration 
during note input. This allows you to experiment with pitches without having to stop 
note input because you only input the note when you specify the duration.

You can also activate/deactivate Pitch Before Duration by pressing K .

Chords

Allows you to add multiple notes at the same rhythmic position in order to build a 
chord during note input. This function prevents the caret from advancing automatically 
after inputting a note. Chord mode also affects some edits outside of note input, such 
as copying/pasting notes and items without overwriting existing material.

You can also start/stop chord input by pressing Q .

Insert

Allows you to insert notes before existing notes in the current voice ahead of the caret, 
instead of overwriting them, during note input. Insert mode also affects some edits 
outside of note input, such as deleting notes or changing their duration. For example, 
reducing the duration of notes with Insert mode activated pulls them closer together 
without leaving rests between the notes.

When inputting or changing time signatures, Insert mode instructs Dorico SE to add 
any extra beats required to fill bars.

You can click and hold or right-click Insert to access the following options:

● Voice : Insert mode only affects the selected voices.

● Player : Insert mode affects all voices and instruments belonging to the selected 
players.

● Global : Insert mode affects all players in the flow.

● Global Adjustment of Current Bar : Insert mode affects all players in the flow, 
changes the duration of the current bar, and updates its time signature to reflect 
its new duration.

You can also activate/deactivate Insert mode by pressing I . You can cycle through the 
different Insert mode scopes by pressing Alt/Opt-I .

Lock to Duration

Allows you to maintain the duration of notes while you change their pitches. Only 
available during note input.

You can also activate/deactivate Lock to Duration by pressing L .

Force Duration

Allows you to input notes/rests with the explicit duration you have selected during note 
input, and fixes the current notated duration of existing notes outside of note input. 
For example, you can activate Force Duration to force the input of a dotted quarter 
note on the second quarter beat of 4/4, where Dorico SE splits the note with a tie by 
default.
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IMPORTANT

You can get unexpected results if you force the duration of notes and later change the 
time signature or move barlines, for example.

You can remove Force Duration from selected notes by resetting their appearance.

You can also activate/deactivate Force Duration by pressing O .

Create Voice

Allows you to create a new voice on the current staff into which you can input notes 
during note input. Outside of note input, Create Voice allows you to change the voice 
of existing notes.

You can click and hold or right-click Create Voice to access the following options:

● Create Voice : Creates a new voice on the current staff. You can also use the key 
command Shift-V .

● Create Slash Voice : Creates a new slash voice with each click. For example, 
the third new slash voice is stemless. You can also use the key command Shift-Alt/
Opt-V .

● Next Voice : Cycles through active voices on the staff. You can also use the key 
command V .

Dotted Notes

Allows you to input dotted notes/rests based on the currently selected duration during 
note input. Outside of note input, Dotted Notes allows you to add rhythm dots to, and 
remove rhythm dots from, existing notes/rests.

You can click and hold or right-click Dotted Notes to access the following options:

● One Rhythm Dot : Inputs notes/rests with one rhythm dot during note input. 
Adds one rhythm dot to selected existing notes/rests outside of note input.

● Two Rhythm Dots : Inputs notes/rests with two rhythm dots during note input. 
Adds two rhythm dots to selected existing notes/rests outside of note input.

● Three Rhythm Dots : Inputs notes/rests with three rhythm dots during note 
input. Adds three rhythm dots to selected existing notes/rests outside of note 
input.

● Four Rhythm Dots : Inputs notes/rests with four rhythm dots during note input. 
Adds four rhythm dots to selected existing notes/rests outside of note input.

You can also activate/deactivate Dotted Notes by pressing . . You can cycle through 
the different numbers of rhythm dots by pressing Alt/Opt-. .

Rests

Allows you to input rests of the currently selected duration instead of notes.

You can also start/stop rest input by pressing , .
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NOTE

If Force Duration is not activated, Dorico SE automatically combines adjacent rests as 
appropriate for their position in relation to notes and according to the current meter.

Tuplets

Inputs a triplet based on the currently selected note duration at the caret position or at 
the selected rhythmic position.

You can click and hold or right-click Tuplets to access the following options:

● 2:3 : Inputs a duplet; that is, two notes in the space of three.

● 3:2 : Inputs a triplet; that is, three notes in the space of two.

● 4:3 : Inputs a quadruplet; that is, four notes in the space of three.

● 5:4 : Inputs a quintuplet; that is, five notes in the space of four.

● 6:4 : Inputs a sextuplet; that is, six notes in the space of four.

● 7:8 : Inputs a septuplet; that is, seven notes in the space of eight.

● x:y : Opens the tuplets popover, into which you can enter any tuplet ratio.

Grace Notes

Allows you to input grace notes instead of normal notes at the caret position. Only 
available during note input.

You can click and hold or right-click Grace Notes to access the following options:

● Unslashed Grace Notes : Selects unslashed grace notes.

● Slashed Grace Notes : Selects slashed grace notes.

You can also start/stop grace note input by pressing / . You can switch between 
slashed/unslashed grace notes by pressing Alt/Opt-/ .

Tie

During note input, this ties the next note you input to the previous note of the same 
pitch, in the same voice, and on the same staff. Outside of note input, you can use this 
tool to tie together notes of the same pitch in different voices or to tie grace notes to 
rhythmic notes.

You can also activate Tie by pressing T .

NOTE

You cannot deactivate Tie. If you want to delete ties, you must use Scissors.

Scissors

Splits notes and explicit rests in two at the caret position during note input. Outside of 
note input, it deletes all ties in tie chains.

You can also activate Scissors by pressing U .
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RELATED LINKS
Key Commands page in the Preferences dialog on page 54
Activating/Deactivating mouse input on page 205
Inputting notes with rhythm dots on page 205
Inputting chords on page 226
Inputting grace notes on page 225
Inputting tuplets on page 229
Tuplets popover on page 230
Input methods for time signatures and pick-up bars on page 258
Resetting the appearance of items on page 401

Notes panel
The Notes panel contains buttons that allow you to select note and rest durations, and to input 
accidentals, slurs, and articulations. It is located on the left of the window in Write mode.

You can hide/show the Notes panel in any of the following ways:

● Press Ctrl/Cmd-7 .

● In the toolbox on the left, click Show Left Zone .

● Choose Window > Show Left Zone.

The upper part of the Notes panel contains note durations that you can select for input or to 
change the duration of existing notes. By default, only the most common note durations are 
shown. You can see all note durations by clicking the Show/Hide All Notes disclosure arrows at 
the top and bottom of the section.

In the middle part of the Notes panel, you can activate/deactivate accidentals and activate slurs.

In the bottom part of the Notes panel, you can activate/deactivate articulations.

RELATED LINKS
Inputting notes on page 197
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Inputting accidentals on page 219
Inputting articulations on page 246
Inputting slurs on page 248
Inputting nested slurs on page 1025
Deleting notes/items on page 412
Deleting accidentals on page 655
Deleting articulations on page 662

Notations toolbox
The Notations toolbox allows you to access panels and popovers, which you can use to input the 
different notations available. It is located on the right of the window in Write mode.

Panels

Allows you to access panels from the Notations toolbox. Panels allow you to input 
notations by clicking them in the panel.

Popovers

Allows you to access popovers from the Notations toolbox. Popovers allow you to input 
notations by typing entries on your computer keyboard. Popovers open above the top 
staff on which the caret is active or an item is selected, and at the caret position or the 
rhythmic position of the earliest selected item.

NOTE

Popovers are only available during note input or when at least one note/item is 
selected in the music area.

Panel buttons

Clefs

Hides/Shows the Clefs panel, which contains sections for clefs and octave lines.

Key Signatures, Tonality Systems, and Accidentals

Hides/Shows the Key Signatures, Tonality Systems, and Accidentals panel, which 
contains sections for key signatures, tonality systems, and accidentals. You can also 
create and edit custom tonality systems from this panel.

Time Signatures (Meter)

Hides/Shows the Time Signatures (Meter) panel, which contains sections for the 
different types of time signatures, including a section where you can create custom 
time signatures, such as interchangeable time signatures and time signatures with 
pick-up bars.

Tempo
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Hides/Shows the Tempo panel, which contains sections for the different types of tempo 
changes, including gradual tempo changes, metronome marks, and tempo equations.

Dynamics

Hides/Shows the Dynamics panel, which contains sections for the different types of 
dynamics, including immediate, gradual, and custom combined dynamics.

Ornaments

Hides/Shows the Ornaments panel, which contains sections for ornaments, arpeggio 
signs, glissando lines, and guitar techniques.

Repeat Structures

Hides/Shows the Repeat Structures panel, which contains sections for the different 
types of repeat structures, including repeat endings and segments, repeat markers, 
single-note and multi-note tremolos, bar repeats, and slash regions.

Bars and Barlines

Hides/Shows the Bars and Barlines panel, which contains sections for bars, bar rests, 
and barlines.

Holds and Pauses

Hides/Shows the Holds and Pauses panel, which contains sections for fermatas, breath 
marks, and caesuras.

Playing Techniques

Hides/Shows the Playing Techniques panel, which contains sections for the various 
instrument family groups. Each section contains playing techniques for the 
corresponding instrument family.

Lines

Hides/Shows the Lines panel, which contains sections for horizontal and vertical lines.

Video

Hides/Shows the Video panel, which allows you to open the Video Properties dialog, 
view and edit markers in the current flow, and to calculate suitable tempos for 
important markers.

Comments

Hides/Shows the Comments panel, which allows you to view, edit, and export 
comments in the current flow.
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Popover and direct input buttons

Clefs

Opens the clefs and octave lines popover.

Key Signatures, Tonality Systems, and Accidentals

Opens the key signatures popover.

Time Signatures (Meter)

Opens the time signatures popover.

Tempo

Opens the tempo popover.

Dynamics

Opens the dynamics popover.

Ornaments

Opens the ornaments popover.

Repeat Structures

Opens the repeats popover.

Bars and Barlines

Opens the bars and barlines popover.

Holds and Pauses

Opens the holds and pauses popover.

Playing Techniques

Opens the playing techniques popover.

Rehearsal Marks

Inputs a rehearsal mark.
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Text

Opens the text editor for inputting text items.

Lyrics

Opens the lyrics popover.

Chord Symbols

Opens the chord symbols popover.

Note Tools

Opens the note tools popover.

Fingering

Opens the fingerings popover.

Figured Bass

Opens the figured bass popover.

RELATED LINKS
Project window in Write mode on page 172
Notations input on page 246
Note tools popover on page 233
Text editor options in Write mode on page 357
Video Properties dialog on page 167
Comment dialog on page 433

Right zone (Write mode)
The right zone in Write mode can display different panels for the available notation items, 
according to your selection in the Notations toolbox. You can use panels in the right zone to 
input notations. The right zone is located on the right of the window in Write mode.

You can hide/show the right zone in any of the following ways; for example, if you want to find a 
notation to input but then want to increase the size of the music area after inputting it:

● Press Ctrl/Cmd-9 .

● In the Notations toolbox, click the button for any panel you want to show, or the active 
button for the panel you want to hide.

● Choose Window > Show Right Zone.

RELATED LINKS
Hiding/Showing zones on page 41
Clefs panel on page 302
Key Signatures, Tonality Systems, and Accidentals panel on page 254
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Time Signatures (Meter) panel on page 260
Tempo panel on page 271
Dynamics panel on page 286
Ornaments panel on page 315
Repeat Structures panel on page 376
Bars and Barlines panel on page 278
Holds and Pauses panel on page 308
Playing Techniques panel on page 340
Lines panel on page 353
Video panel on page 370
Comments panel on page 434

Lower zone (Write mode)
The lower zone in Write mode can display different panels for inputting notes and editing notes/
items.

You can hide/show the lower zone in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Lower Zone.

You can use the panel selectors in the top left of the lower zone to display the corresponding 
panel:

Properties

Shows the Properties panel, which allows you to edit individual notes and notations, 
such as by changing their appearance or position.

Keyboard

Shows the Keyboard panel, which allows you to input notes using a piano keyboard 
layout and displays the pitches of selected notes as depressed keys.

Fretboard

Shows the Fretboard panel, which allows you to input notes for fretted instruments 
using the corresponding fretboard layout for the selected instrument type.

Drum Pads

Shows the Drum Pads panel, which allows you to input notes for unpitched percussion 
instruments using a drum pads layout.

Mixer

Shows the Mixer panel, which allows you to control the sounds produced in playback 
by instruments in the project, both for the master output and each individual 
instrument’s channel.

Write mode
Project window in Write mode 

182
Dorico SE 4.3.30



Key Editor

Shows the Key Editor panel, which allows you to view and edit notes belonging to the 
selected instrument in a continuous piano roll.

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Mixer panel on page 612
Key Editor panel on page 564
Note input on page 196
Notations input on page 246

Keyboard panel
The Keyboard panel allows you to input notes using a piano keyboard layout, and displays 
selected notes and sounding notes in playback as depressed keys with blue dots. It is located in 
the lower zone at the bottom of the window in Write mode.

During note input, the notes you press in the Keyboard panel are input. Outside of note input, 
Dorico SE plays the notes you press using the instrument sounds of your most recent selection 
but does not input them.

● You can show the Keyboard panel by showing the lower zone, then clicking Keyboard  in 
the lower zone toolbar.

Between the toolbar and the keyboard, there is a keyboard range selector. The brighter keys 
indicate the keys shown in the panel. The shaded keys at each end of the range allow you to 
change the keys shown in the panel; for example, if you want to show fewer, wider keys.

The Keyboard panel toolbar contains the following options:

Advance Caret

Advances the caret by the currently selected note duration without inputting notes. 
Extends notations with duration, such as gradual dynamics and pedal lines. Only 
available during note input.

You can also advance the caret by pressing Space .

Delete Left
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Deletes notes at the previous rhythmic position and moves the caret back to that 
position. Only available during note input.

You can also delete notes/items during note input by pressing Backspace .

TIP

You can delete notes/items outside of note input by pressing Backspace or Delete .

Set Note Duration

Allows you to select a note duration, both for the next notes you input during note 
input and to change the duration of existing notes outside of note input.

You can also select note durations by pressing the corresponding key command or by 
clicking note durations in the Notes panel in the left zone.

Slur

Inputs a slur, starting from the currently selected note or spanning the selected notes. 
During note input, slurs extend automatically as you input notes.

You can also input slurs by pressing S .

Set Articulation

Allows you to activate/deactivate articulations, both for the next notes you input during 
note input and to add articulations to existing notes.

You can also activate/deactivate articulations by pressing the corresponding key 
command.

NOTE

Notes cannot have both accent and marcato articulations, or both staccato and tenuto 
articulations.

Respell Using Note Name Above

Respells the selected notes upwards to show the enharmonic equivalent using the note 
name above; for example, respelling F♯ as G♭.

Respell Using Note Name Below

Respells the selected notes downwards to show the enharmonic equivalent using the 
note name below, such as respelling G♭ as F♯.

Resize Lower Zone

Allows you to change the height of the lower zone.
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RELATED LINKS
Caret on page 191
Notes panel on page 177
Hiding/Showing zones on page 41
Inputting notes on page 197
Inputting chords on page 226
Deleting notes/items on page 412
Selecting note/rest durations on page 235
Inputting slurs on page 248
Inputting articulations on page 246
Respelling notes on page 428

Fretboard panel
The Fretboard panel allows you to input notes for fretted instruments using the corresponding 
fretboard layout for the selected instrument type, and displays the pitches of the earliest 
selected notes as stopped strings with blue dots. It is located in the lower zone at the bottom of 
the window in Write mode.

During note input, the notes you press in the Fretboard panel are input. Outside of note input, 
Dorico SE plays the notes you press using the instrument sounds of your most recent selection 
but does not input them.

● You can show the Fretboard panel by showing the lower zone, then clicking Fretboard  in 
the lower zone toolbar.

The Fretboard panel toolbar contains the following options:

Advance Caret

Advances the caret by the currently selected note duration without inputting notes. 
Extends notations with duration, such as gradual dynamics and pedal lines. Only 
available during note input.

You can also advance the caret by pressing Space .

NOTE

When inputting notes using the Fretboard panel, the caret never advances 
automatically.

Delete Left

Deletes notes at the previous rhythmic position and moves the caret back to that 
position. Only available during note input.

You can also delete notes/items during note input by pressing Backspace .
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TIP

You can delete notes/items outside of note input by pressing Backspace or Delete .

Set Note Duration

Allows you to select a note duration, both for the next notes you input during note 
input and to change the duration of existing notes outside of note input.

You can also select note durations by pressing the corresponding key command or by 
clicking note durations in the Notes panel in the left zone.

RELATED LINKS
Caret on page 191
Notes panel on page 177
Hiding/Showing zones on page 41
Inputting notes on page 197
Inputting notes on tablature on page 217
Inputting chords on page 226
Deleting notes/items on page 412
Selecting note/rest durations on page 235
Fretted instrument tuning on page 124
Tablature on page 1048
Hiding/Showing notation staves and tablature on page 1049

Drum Pads panel
The Drum Pads panel allows you to input notes for unpitched percussion instruments using a 
drum pads layout. It is located in the lower zone at the bottom of the window in Write mode.

During note input, the notes you press in the Drum Pads panel are input. Outside of note input, 
Dorico SE plays sounds for the instruments and techniques you press but does not input them.

● You can show the Drum Pads panel by showing the lower zone, then clicking Drum Pads 
in the lower zone toolbar.

The Drum Pads panel toolbar contains the following options:

Advance Caret

Advances the caret by the currently selected note duration without inputting notes. 
Extends notations with duration, such as gradual dynamics and pedal lines. Only 
available during note input.
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You can also advance the caret by pressing Space .

Delete Left

Deletes notes at the previous rhythmic position and moves the caret back to that 
position. Only available during note input.

You can also delete notes/items during note input by pressing Backspace .

TIP

You can delete notes/items outside of note input by pressing Backspace or Delete .

Set Note Duration

Allows you to select a note duration, both for the next notes you input during note 
input and to change the duration of existing notes outside of note input.

You can also select note durations by pressing the corresponding key command or by 
clicking note durations in the Notes panel in the left zone.

Reorder Drum Pads

Allows you to move drum pads in relation to each other; for example, to create a 
different arrangement for easier input in different circumstances.

Resize Lower Zone

Allows you to change the height of the lower zone.

RELATED LINKS
Caret on page 191
Notes panel on page 177
Hiding/Showing zones on page 41
Inputting notes for unpitched percussion on page 213
Deleting notes/items on page 412
Selecting note/rest durations on page 235
Unpitched percussion on page 1115
Percussion kits and drum sets on page 1122
Percussion kit presentation types on page 1126
Voices in percussion kits on page 1131

Inputting vs. editing
Dorico SE distinguishes the processes for inputting and editing music.

Inputting

If you can see the caret, you are inputting new music. The caret must be activated in order to 
input notes and notations. If the caret is activated, selecting tools or items in the Notes toolbox 
and the Notes panel affects the note or chord that you are about to input, as you can specify 
the duration, rhythm dot, accidentals, and articulations. Then you specify the pitch by clicking the 
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note into the score, by pressing the letter name of the note on your computer keyboard, or by 
playing the note or chord on your MIDI keyboard.

When the caret is activated, notes and notations are input at the caret position.

If no notes or chords are selected in the music area and you select a duration, either by pressing 
its key command or by clicking it in the Notes panel, mouse input is activated. If you move the 
mouse pointer over the staff, a shadow note is displayed to indicate where the note will be input 
if you click.

NOTE

Deactivating mouse input prevents Dorico SE from starting mouse input in this circumstance.

Editing

If you cannot see the caret, you can edit existing music. Editing music includes deleting notes 
and notations, which you can only do in Write mode, although you can also delete notes in the 
Key Editor. You can switch back and forth between inputting and editing at any time.

When the caret is not activated, new items are input at the position of the first selected item in 
the music area. If there is no selection, the mouse pointer is loaded with the new item. The item 
is then created at the location where you click.

To edit existing notes and notations, you must select them in the music area. This allows 
you to update the selected notes or items when you select, for example, new note durations, 
accidentals, or articulations in the Notes panel.

We recommend that you spend a moment to understand the difference between how Dorico SE 
behaves if the caret is shown and if it is not. In the latter case, all editing functions operate on the 
items that you have selected in the music area.

NOTE

The results of some edits outside of note input, including copying/pasting notes, can be affected 
by Insert mode and Chord mode.

RELATED LINKS
Editing items on page 395
Selecting notes/items on page 387
Caret on page 191
Note input on page 196
Notations input on page 246
Rhythmic grid on page 190
Insert mode on page 408
Chord mode on page 228
Key Editor on page 564

Mouse input settings
There are a number of different settings that you can choose from to determine how mouse 
input functions in Dorico SE.

You can set your preferences for mouse input in the Editing section of the Note Input and 
Editing page in Preferences.

You can choose between the following options for mouse input:
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● Create item at selection: Items are input at the position of selected items or notes in the 
music area.

● Load pointer with item: Items are loaded onto the mouse pointer so you can click in the 
music area where you want to input the item.

You can also activate/deactivate Allow multiple items to be created with the mouse. When 
this option is activated, you can load an item onto your mouse pointer and input the same item 
in the music area multiple times without having to reselect the item each time you input it. When 
this option is deactivated, you can only input an item loaded onto your mouse pointer once. If 
you want to input the item at multiple positions, you must reselect it each time.

NOTE

Changing your preferences permanently changes the functionality for the current project and all 
new projects.

RELATED LINKS
Preferences dialog on page 53

Changing your mouse input settings
You can change your mouse input settings; for example, if you want to load a playing technique 
on the pointer once and input it in multiple places without having to reselect the playing 
technique each time.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Editing section, choose one of the following options for Creating items with the 
mouse:

● Create item at selection

● Load pointer with item

4. Optional: If you chose Load pointer with item, activate/deactivate Allow multiple items to 
be created with the mouse.

5. Click Apply, then Close.

RESULT
Your mouse input settings are changed in the current project and for all future projects.

RELATED LINKS
Notations input on page 246
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Rhythmic grid
The rhythmic grid is a unit of rhythmic duration whose value affects certain aspects of inputting 
and editing, such as the amount by which items move. However, it does not control the duration 
of notes and items that you input.

Rhythmic grid set to eighth notes (quavers) shown above the staff

The current rhythmic grid resolution is shown by the note value in the status bar, and by ruler 
markings above the staff on which the caret is active. Longer lines in the rhythmic grid indicate 
beat divisions, while shorter lines indicate beat subdivisions.

The rhythmic grid controls the following:

● The possible input positions when using the caret or the mouse, and when copying and 
pasting. For example, setting the rhythmic grid resolution to 32nd notes allows you to input 
notes and items at a greater number of possible rhythmic positions than when the rhythmic 
grid is set to quarter notes.

● The amount by which the caret moves when using Right Arrow / Left Arrow .

● The amount by which notes and items are lengthened/shortened.

● The amount by which notes and items move.

● The duration by which notes are split.

RELATED LINKS
Rhythmic position on page 22
Caret on page 191
Moving the caret manually on page 196
Changing the Key Editor rhythmic grid resolution on page 571
Inputting notes on page 197
Splitting notes by duration on page 238
Changing music area colors on page 51

Changing the rhythmic grid resolution
You can change the resolution of the rhythmic grid; for example, you might decrease the 
rhythmic grid resolution so you can shorten notes by smaller increments. The resolution is 
indicated by the note value symbol in the status bar and by the beat divisions/subdivisions in the 
ruler markings above the caret.

The rhythmic grid resolution is set to eighth notes (quavers) by default.

PROCEDURE

● Change the resolution of the rhythmic grid in any of the following ways:

● To decrease the rhythmic grid resolution, press Alt/Opt-] .

● To increase the rhythmic grid resolution, press Alt/Opt-[ .

● Choose Write > Rhythmic Grid > Decrease Grid Resolution.

● Choose Write > Rhythmic Grid > Increase Grid Resolution.

● Choose Write > Rhythmic Grid > [Beat division].
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● Select a value from the Rhythmic Grid selector in the status bar.

RESULT
Decreasing the rhythmic grid resolution makes it finer by making the note value shorter. 
Increasing the rhythmic grid resolution makes it coarser by making the note value longer.

RELATED LINKS
Status bar on page 36
Changing the Key Editor rhythmic grid resolution on page 571
Changing the duration of notes on page 236
Lengthening/Shortening items on page 396
Moving notes/items rhythmically on page 417

Caret
In Dorico SE, the caret is a vertical line that extends above and below five-line staves but appears 
shorter on percussion staves and tablature. It shows the rhythmic position at which notes, 
chords, or notation items are input, which can be partway through tie chains.

A caret is a mark that is commonly used when proofreading published text to denote the position 
at which something should be inserted or added; for example, a missing letter or a word. In 
software, the caret shows where something is inserted. The caret is also known as an “insertion 
point” or “cursor”. In this documentation, we use “caret” to refer to the line that appears during 
note input, and “cursor” to refer to the line that appears during text input.

If you are inputting notes, the caret advances to the next rhythmic position automatically. If you 
are inputting chords or notes on tablature, the caret does not move automatically, and you must 
move it to the next rhythmic position manually.

The caret has a note symbol beside it, which indicates the stem direction and type of the 
currently selected voice. It is accompanied by a + symbol if the voice is new.

The caret

The appearance of the caret changes depending on the input mode and the currently selected 
voice number.

Multiple staves
The caret extends vertically across all the staves onto which notes and notations will be 
input. This allows you to input, for example, the same dynamics or playing techniques 
on multiple staves simultaneously or play in chords on a MIDI keyboard and distribute 
the notes in those chords onto multiple staves. The note symbol and rhythmic grid also 
appear for each included staff.
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Caret when inputting notes onto multiple staves

Insert
The caret shows V and inverted V shapes at the top and bottom. Dotted lines are 
shown on staves affected by the Insert mode scope across which the caret does not 
already extend. In Insert mode, inserted notes shift existing notes after the caret along 
by the input duration instead of overwriting them.

Caret when Insert (Voice) is 
active

Caret when Insert (Player) 
is active

Caret when either Insert 
(Global) or Insert (Global 
Adjustment of Current Bar) 
is active

NOTE

Insert mode also affects some edits outside of note input, such as copying/pasting, 
deleting, and lengthening/shortening notes.

Chords
The caret shows a plus symbol at the top left. During chord input, you can input 
multiple notes at the same rhythmic position.

Caret when inputting chords
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NOTE

Chord mode also affects some edits outside of note input, such as copying/pasting and 
lengthening/shortening notes and items.

Lock to Duration
The caret is dashed. Lock to Duration allows you to repitch notes without changing 
their duration or rhythm.

Caret when Lock to Duration is activated

Grace Notes
The caret is shorter than the default caret. It allows you to input grace notes at the 
caret position.

Caret when inputting grace notes

Voices
To identify voices, the caret shows the following:

● An up-stem or down-stem note symbol to indicate the stem direction of the voice

● The voice number into which you are about to input notes, for second voices and 
above

● A plus symbol at the bottom left, if the voice is new

Caret when inputting notes 
into the first up-stem voice

Caret when inputting notes 
into a new down-stem voice

Caret when inputting notes 
into a new, second up-stem 
voice

Slash voices
To identify slash voices, the caret shows the following:

● An up-stem or down-stem slash note symbol, indicating the stem direction of the 
slash voice, and whether it has stems or is stemless

● The number of the slash voice into which you are about to input notes, for second 
voices and above
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● A plus symbol on the left at the bottom, if the slash voice is new

Caret when inputting notes 
into an up-stem slash voice

Caret when inputting notes 
into a new, second up-stem 
slash voice

Caret when inputting notes 
into a new, stemless slash 
voice

Percussion kits
The caret appears significantly smaller than usual when inputting notes into 
percussion kits. The name of the kit instrument into which you are currently inputting 
notes is shown above the rhythmic grid.

Caret when inputting notes into percussion kits

Tablature
The caret appears significantly smaller than usual when inputting notes into tablature. 
On tablature, the caret behaves as if chord input is always active, meaning you must 
advance the caret and move it to other string lines manually.

Caret when inputting notes on tablature

RELATED LINKS
Chord mode on page 228
Insert mode on page 408
Inputting chords on page 226
Inputting notes in Insert mode on page 212
Repitching notes without changing their rhythm on page 427
Inputting grace notes on page 225
Inputting notes into multiple voices on page 207
Inputting notes for unpitched percussion on page 213
Inputting notes on tablature on page 217
Changing music area colors on page 51
Ties on page 1074
Splitting tie chains on page 1083
Splitting notes by duration on page 238
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Activating/Deactivating the caret
When the caret is activated, you can input notes and notations at the caret position; for example, 
if you want to input a dynamic in the middle of a tie chain. When the caret is deactivated, you 
cannot input notes, instead you can select and edit items in the music area.

PROCEDURE

1. In Write mode, activate the caret and start note input in any of the following ways:

● Select an item and press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click a rhythmic position on a staff.

2. Deactivate the caret and stop note input in any of the following ways:

● Press Shift-N , Return , or Esc .

● If you have deactivated mouse input, click any selectable item in the music area.

● In the Notes toolbox, click Start Note Input .

● Switch to another mode.

RELATED LINKS
Moving the caret manually on page 196
Activating/Deactivating mouse input on page 205
Inputting notes on page 197
Notations input on page 246

Extending the caret to multiple staves
You can extend the caret so it spans multiple staves. This allows you to input notes and notations 
onto multiple staves simultaneously, including automatically exploding the notes in chords that 
you play on a MIDI keyboard onto the appropriate staves.

PROCEDURE

1. In Write mode, activate the caret in any of the following ways:

● Select an item and press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click a rhythmic position on a staff.

2. Extend the caret to other staves in any of the following ways:

● To extend to the staff above, press Shift-Up Arrow .

● To extend to the staff below, press Shift-Down Arrow .

3. Optional: Repeat step 2 as many times as you require.

RELATED LINKS
Notes toolbox on page 173
Inputting notes and notations onto multiple staves on page 210
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Moving the caret manually
During normal note input, the caret moves automatically as you input notes, but you can also 
move it manually. For example, the caret does not move automatically when inputting chords or 
when using the Fretboard panel.

PROCEDURE

● In Write mode, move the caret in any of the following ways:

● To move the caret according to the current rhythmic grid resolution or to the next/
previous note/rest, whichever is closest, press Right Arrow / Left Arrow .

● To advance the caret according to the note value currently selected, press Space  or click 
Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

● To move the caret to the staff above/below, press Up Arrow / Down Arrow .

● To move the caret to the top/bottom staff in the system, press Ctrl/Cmd-Up Arrow /
Ctrl/Cmd-Down Arrow .

RELATED LINKS
Inputting chords on page 226
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Rhythmic grid on page 190

Note input
In Dorico SE, you can only input notes during note input, which is when the caret is activated. 
This reduces the risk of you adding notes to staves accidentally.

You can also input notations at the same time as inputting notes. Notations are input at the caret 
position or on the selected note.

You can input notes in different ways and using any of the following devices, including switching 
between them at any time:

● MIDI keyboard

● Computer keyboard

● Mouse or touchpad

● Keyboard, Fretboard, and Drum Pads panels

TIP

A MIDI keyboard can be the fastest way to input notes.

RELATED LINKS
Notes on page 840
Inputting notes on page 197
Accidental selection during MIDI input on page 220
Keyboard panel on page 183
Fretboard panel on page 185
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Drum Pads panel on page 186
Notations input on page 246
Arranging tools on page 412

Inputting notes
You can input notes into your project during note input, which is when the caret is activated. You 
can input notes with a computer keyboard, with the mouse, using panels in the lower zone, or by 
playing notes with a MIDI keyboard.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● These steps describe selecting rhythm dots, articulations, and accidentals not in the 
prevailing key signature before inputting notes. However, you can also select them after 
inputting notes. If you change this setting, you must perform step 7 before steps 4 to 6.

● You do not have to input rests between notes, as Dorico SE automatically shows implicit rests 
of the appropriate duration between the notes you input. Similarly, you do not have to input 
ties, as Dorico SE shows notes as tie chains if necessary.

● You can also input notations alongside notes without deactivating note input.

PREREQUISITE

● You have chosen the appropriate input pitch setting.

● You have chosen the appropriate note-based notation input setting.

● You have connected any MIDI devices you want to use for note input.

● If you want to select note durations using the Notes panel, the left zone is shown.

● If you want to input notes into multiple instruments held by a single player or instruments 
not visible in the score in page view, you are in galley view.

● If your music requires a key signature, you have input that key signature.

PROCEDURE

1. In Write mode, start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

You can also press Return ; however, if you select a notation, such as a dynamic, 
pressing Return  opens the corresponding popover instead of starting note input.

● Select a note or rest on the staff where you want to input notes and click Start Note 
Input  in the Notes toolbox.

● Double-click the staff where you want to input notes.

2. Optional: If you want to input notes onto multiple staves at once, extend the caret to those 
staves.

3. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.
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For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

4. Optional: Select any required rhythm dots.

5. Optional: If you want to input a pitch whose accidental is not in the prevailing key signature, 
select the appropriate accidental.

6. Optional: Select any required articulations.

7. Input the pitches you want in any of the following ways:

● Press the corresponding letters on your computer keyboard.

TIP

Dorico SE automatically selects the note whose register is the smallest interval away 
from the previously input note. However, you can force a different register.

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the 
letter for the note; for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or 
Ctrl (macOS)  as well as the letter for the note; for example, Ctrl-Alt-A (Windows) 
or Ctrl-A (macOS) .

● Click the staff at the rhythmic position of each note you want to input.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● In the Keyboard, Fretboard, or Drum Pads panel, play the notes you want.

● Play the notes on a MIDI keyboard.

8. Optional: Advance the caret by the currently selected note duration without inputting notes 
in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

TIP

You can also move the caret in different ways and by different increments.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input with the selected duration at the caret position or where you click and are played 
back as you input them by default. Their pitch follows the prevailing key signature. For example, 
if you press F  in G major, an F♯ is input automatically.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them. However, accidentals not in the prevailing key signature are only added to the 
first note you input after selecting them.
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Dorico SE notates and beams notes appropriately according to their duration, the prevailing time 
signature, and their position in the bar. This includes showing notes as tie chains if required.

If you advance the caret without inputting notes, Dorico SE fills the gaps between notes with 
implicit rests of the appropriate duration.

If you input notes on notation staves belonging to fretted instruments, Dorico SE automatically 
allocates these notes to the strings on which they can be played closest to the nut. Because this 
calculation is done for each note separately, multiple notes can be allocated to the same string. 
In such cases, the notes are shown next to each other on tablature and are colored green. You 
can then select them individually and make your own string allocation.

NOTE

● The notes you input overwrite existing notes at the caret position in the voice indicated by 
the quarter note symbol beside the caret. If you want to add notes to an existing voice, you 
can input chords. You can also input notes into new voices.

● You can specify custom beat groupings within individual time signatures.

AFTER COMPLETING THIS TASK

● You can move notes to different rhythmic positions and other staves after they have been 
input.

● You can also show brackets on noteheads individually.

RELATED LINKS
Notes toolbox on page 173
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Inputting notes using pitch before duration on page 200
Changing the note-based notation input setting on page 204
Changing the input pitch setting on page 203
Hiding/Showing zones on page 41
Switching to galley/page view on page 47
Accidental selection during MIDI input on page 220
Respelling notes on page 428
Notes panel on page 177
Rhythmic grid on page 190
Caret on page 191
Selecting note/rest durations on page 235
Inputting notes with rhythm dots on page 205
Inputting accidentals on page 219
Inputting articulations on page 246
Inputting chords on page 226
Inputting notes into multiple voices on page 207
Inputting rests on page 221
Inputting tuplets on page 229
Adding notes above/below existing notes on page 232
Moving notes/items rhythmically on page 417
Creating cross-staff beams/tremolos on page 697
Note and rest grouping on page 705
Beam grouping according to meters on page 689
Notations input on page 246
Playing/Muting notes during note input/selection on page 394
Changing the allocated string for notes on tablature on page 1050
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Enabling/Disabling MIDI input devices on page 246
Implicit vs. explicit rests on page 1009
Ties on page 1074
Key signatures on page 815
Arranging tools on page 412
Bracketed noteheads on page 849

Register selection during note input
Dorico SE automatically selects the register of pitches during note input, but you can override 
this and select the register manually.

During note input, Dorico SE automatically selects the note whose register is the smallest interval 
away from the previously input note. For example, if you input an F and then press A , an A is 
input a third above the F, rather than a sixth below.

You can override this automatic register selection in the following ways:

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the letter for 
the note; for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or Ctrl (macOS) 
as well as the letter for the note; for example, Ctrl-Alt-A (Windows) or Ctrl-A (macOS) .

Register selection when inputting chords

During chord input, Dorico SE automatically inputs notes above the highest note at the caret 
position. For example, if you press A  then E  then A , a chord of A-E-A is input at the caret 
position.

You can input notes below the lowest note at the caret position instead by pressing Ctrl-
Alt (Windows) or Ctrl (macOS)  as well as the letter for the note name; for example, Ctrl-Alt-
A (Windows) or Ctrl-A (macOS) .

RELATED LINKS
Changing the pitch of individual notes on page 424
Accidental selection during MIDI input on page 220
Respelling notes on page 428

Inputting notes using pitch before duration
You can input notes into your project by specifying their pitch before their duration, meaning you 
can test pitches before inputting them without leaving note input. You can input notes with a 
computer keyboard, with the mouse, using panels in the lower zone, or by playing notes with a 
MIDI keyboard.

By default in Dorico SE, you must specify the duration before the pitch of notes.

NOTE

● These steps describe selecting the pitch before the duration when inputting notes. However, 
you can also specify the duration before the pitch instead, which is the default note input 
behavior in Dorico SE.

● These steps describe selecting rhythm dots, articulations, and accidentals not in the 
prevailing key signature before inputting notes. However, you can also select them after 
inputting notes. If you change this setting, you must perform steps 7 and 8 before steps 4 to 
6.
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● When inputting notes on tablature using pitch before duration, you must select note 
durations by clicking them in the Notes panel.

● You do not have to input rests between notes, as Dorico SE automatically shows implicit rests 
of the appropriate duration between the notes you input. Similarly, you do not have to input 
ties, as Dorico SE shows notes as tie chains if necessary.

● You can also input notations alongside notes without deactivating note input.

PREREQUISITE

● You have chosen the appropriate input pitch setting.

● You have chosen the appropriate note-based notation input setting.

● You have connected any MIDI devices you want to use for note input.

● If you want to select note durations using the Notes panel, the left zone is shown.

● If you want to input notes into multiple instruments held by a single player or instruments 
not visible in the score in page view, you are in galley view.

● If your music requires a key signature, you have input that key signature.

PROCEDURE

1. In Write mode, start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

You can also press Return ; however, if you select a notation, such as a dynamic, 
pressing Return  opens the corresponding popover instead of starting note input.

● Select a note or rest on the staff where you want to input notes and click Start Note 
Input  in the Notes toolbox.

● Double-click the staff where you want to input notes.

2. Activate Pitch Before Duration in any of the following ways:

● Press K .

● In the Notes toolbox, click Pitch Before Duration .

3. Optional: If you want to input notes onto multiple staves at once, extend the caret to those 
staves.

4. Optional: If you want to input a pitch whose accidental is not in the prevailing key signature, 
select the appropriate accidental.

5. Optional: Select any required articulations.

6. Optional: Select any required rhythm dots.

7. Select a pitch in any of the following ways:

● Press the corresponding letters on your computer keyboard.

TIP

Dorico SE automatically selects the note whose register is the smallest interval away 
from the previously input note. However, you can force a different register.

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the 
letter for the note; for example, Shift-Alt/Opt-A .
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● To input a note below the previously input note, press Ctrl-Alt (Windows) or 
Ctrl (macOS)  as well as the letter for the note; for example, Ctrl-Alt-A (Windows) 
or Ctrl-A (macOS) .

When inputting notes using pitch before duration, you can press these key commands 
multiple times to select higher/lower octaves.

● Click the staff at the rhythmic position of each note you want to input.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● In the Keyboard, Fretboard, or Drum Pads panel, play the notes you want.

● Play the notes on a MIDI keyboard.

Once you have selected a pitch, a shadow note of the corresponding pitch appears at the 
caret position. You can release the pitch after selecting it.

8. Select a note duration and input the note in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

NOTE

When inputting notes on tablature, you must click durations in the Notes panel.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

9. Optional: Advance the caret by the currently selected note duration without inputting notes 
in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

TIP

You can also move the caret in different ways and by different increments.

10. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input with the selected duration at the caret position or where you click and are played 
back as you input them by default. Their pitch follows the prevailing key signature. For example, 
if you press F  in G major, an F♯ is input automatically.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them. However, accidentals not in the prevailing key signature are only added to the 
first note you input after selecting them.

Dorico SE notates and beams notes appropriately according to their duration, the prevailing time 
signature, and their position in the bar. This includes showing notes as tie chains if required.
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If you advance the caret without inputting notes, Dorico SE fills the gaps between notes with 
implicit rests of the appropriate duration.

If you input notes on notation staves belonging to fretted instruments, Dorico SE automatically 
allocates these notes to the strings on which they can be played closest to the nut. Because this 
calculation is done for each note separately, multiple notes can be allocated to the same string. 
Similarly, when you input chords on tablature using pitch before duration with a MIDI keyboard, 
all notes in the chord are allocated to the same string. In such cases, the notes are shown next to 
each other on tablature and are colored green. You can then select them individually and make 
your own string allocation.

NOTE

● The notes you input overwrite existing notes at the caret position in the voice indicated by 
the quarter note symbol beside the caret. If you want to add notes to an existing voice, you 
can input chords. You can also input notes into new voices.

● You can switch between using pitch before duration and duration before pitch note input at 
any time by pressing K  or clicking Pitch Before Duration . For example, duration before 
pitch can be easier when inputting a sequence of notes with the same duration.

● You can specify custom beat groupings within individual time signatures.

● You can change whether note input uses pitch before duration or duration before pitch by 
default on the Note Input and Editing page in Preferences.

AFTER COMPLETING THIS TASK
You can move notes to different rhythmic positions and other staves after they have been input.

You can also show brackets on noteheads individually.

RELATED LINKS
Changing the note-based notation input setting on page 204
Changing the input pitch setting on page 203
Notes toolbox on page 173
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Inputting notes on page 197
Register selection during note input on page 200
Accidental selection during MIDI input on page 220
Hiding/Showing zones on page 41
Switching to galley/page view on page 47
Notes panel on page 177
Rhythmic grid on page 190
Caret on page 191
Inputting chords on page 226
Inputting notes into multiple voices on page 207
Adding notes above/below existing notes on page 232
Notations input on page 246
Enabling/Disabling MIDI input devices on page 246

Changing the input pitch setting
You can input and record notes at either sounding pitch or written pitch; for example, if you want 
to record notes at their sounding pitch in transposing part layouts.

In concert pitch layouts, written pitch and sounding pitch are the same.
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PROCEDURE

● In Write mode, choose one of the following input pitch settings:

● To input/record notes at their written pitch, choose Write > Input Pitch > Written Pitch.

● To input/record notes at their sounding pitch, choose Write > Input Pitch > Sounding 
Pitch.

RESULT
The resulting pitch notated or recorded is changed. For example, if you input a C in a Horn in F 
transposing part layout with the input pitch set to Sounding Pitch, the note is written as a G.

RELATED LINKS
Inputting notes on page 197
Inputting notes using MIDI recording on page 241
Concert vs. transposed pitch on page 155

Changing the note-based notation input setting
You can change your default setting for whether rhythm dots, accidentals, and articulations 
apply to the last input note or the next note you input during note input. This setting also affects 
whether or not the last input note remains selected after entry when using pitch before duration 
for inputting notes.

For example, changing the setting to After inputting note when using pitch before duration 
for notes ensures the last input note remains selected after you input it, making it easier to 
change its enharmonic spelling when inputting notes using a MIDI keyboard. The last input note 
is always selected when using duration before pitch for notes, regardless of your note-based 
notation input setting.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, choose one of the following options for Specify accidental, 
rhythm dot and articulations in the Pitch and Duration subsection:

● After inputting note

● Before inputting note

4. Click Apply, then Close.

RESULT
The setting is changed in the current project and for all future projects. If you chose Before 
inputting note, notes do not remain selected after you input them during pitch before duration 
note input.

RELATED LINKS
Inputting notes on page 197
Inputting notes using pitch before duration on page 200
Inputting accidentals on page 219
Inputting notes with rhythm dots on page 205
Inputting articulations on page 246
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Activating/Deactivating mouse input
You can activate/deactivate mouse input; for example, if you only want to input notes using your 
computer keyboard or MIDI device. Deactivating mouse input also allows you to click other items 
to stop note input.

PROCEDURE

● In Write mode, in the Notes toolbox, activate/deactivate Select .

RESULT
Mouse input is activated in the current project when Select  is deactivated. Mouse input is 
deactivated in the current project when Select  is activated.

TIP

You can change the default setting for whether mouse input is activated/deactivated by 
activating/deactivating Enable note input using the mouse on the Note Input and Editing 
page in Preferences.

RELATED LINKS
Notes toolbox on page 173
Preferences dialog on page 53

Inputting notes with rhythm dots
The Dotted Notes tool allows you to input notes with rhythm dots and add rhythm dots to 
existing notes. You can input notes with up to four rhythm dots.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● These steps describe selecting rhythm dots before inputting notes. However, you can 
change this setting if you prefer to specify rhythm dots after inputting notes.

● You cannot add rhythm dots to grace notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select existing notes to which you want to add rhythm dots.

2. Optional: If you want to input notes with rhythm dots onto multiple staves at once, extend 
the caret to those staves.

3. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.
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● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

4. Activate Dotted Notes in any of the following ways:

● Press . .

● In the Notes toolbox, click Dotted Notes .

5. Optional: Change the number of rhythm dots in any of the following ways:

● Press Alt/Opt-.  to cycle through different numbers of rhythm dots.

● In the Notes toolbox, click and hold Dotted Notes , then click the number of rhythm 
dots you want.

Dotted Notes  in the Notes toolbox updates to indicate the current number of rhythm 
dots. You can input notes with up to four rhythm dots.

6. Optional: Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

If Force Duration  is not activated, the notes you input might be shown as tied notes 
rather than dotted notes, depending on their position in the bar and the prevailing meter.

7. Input the dotted notes you want.

Dotted Notes  remains activated until you either select a different note duration or 
deactivate it.

8. Press .  or click Dotted Notes  again to deactivate Dotted Notes.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
During note input, notes are input as dotted notes until you deactivate Dotted Notes or change 
the note duration.

When you add rhythm dots to multiple existing notes that would then overlap, Dorico SE adjusts 
the duration of notes in the selection to avoid deleting notes at the end of the selection.

EXAMPLE

A phrase containing eighth notes After adding rhythm dots to the whole selection

RELATED LINKS
Note and rest grouping on page 705
Notes toolbox on page 173
Notes panel on page 177
Caret on page 191
Insert mode on page 408
Chord mode on page 228
Selecting note/rest durations on page 235
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Activating/Deactivating the caret on page 195
Extending the caret to multiple staves on page 195
Inputting notes in Insert mode on page 212
Changing the note-based notation input setting on page 204

Inputting notes into multiple voices
By default, notes are input into the first up-stem voice, as indicated by the symbol of an up-stem 
quarter note beside the caret. You can input notes directly into other voices during note input, 
and switch between voices as required.

You can also create new voices on staves with existing notes and input notes into those voices 
anywhere else on those staves.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input multiple voices.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Select the voice into which you want to input notes in one of the following ways:

● To create a new voice, press Shift-V  or click Create Voice  in the Notes toolbox.

When a new voice is added, a + sign appears beside the symbol of a quarter note beside 
the caret. The quarter note symbol indicates the stem direction, and the number beside 
the quarter note indicates the voice number if applicable.

Caret when adding the first down-stem voice

TIP

You can press Shift-V  as many times as you require. For example, on a staff containing 
no notes, creating one new voice allows you to input notes into the first down-stem 
voice, but you can also create another new voice immediately if you want to input notes 
into the second up-stem voice.

Only voices that contain notes are preserved.

● To select an existing voice, press V  or click Next Voice  in the Notes toolbox to cycle 
through active voices on the staff.

NOTE

● You can switch between voices as often as you like.

● If you have three or more voices on a single staff, you can only cycle through all 
the voices in a set order. For example, if you have two up-stem voices and two 
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down-stem voices, the order is: first up-stem voice, first down-stem voice, second 
down-stem voice, second up-stem voice.

4. Input the notes you want.

5. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input into the voice indicated by the quarter note symbol beside the caret.

If you are inputting notes into a new voice on a staff that already contains notes in another 
voice, the stem directions of existing notes at the same rhythmic position change automatically 
as necessary. Rests appear as required around notes in different voices.

NOTE

● Any voices that you created, but did not input notes into, are deleted.

● You can show voice colors to check which notes are in which voice. Additionally, when you 
select single notes or multiple notes in the same voice at the same rhythmic position, their 
pitches are shown in the status bar and as depressed keys in the Keyboard panel.

EXAMPLE

Caret when inputting notes into 
the first up-stem voice

Caret when inputting notes into 
the first down-stem voice

Caret when inputting notes into a 
new, second up-stem voice

RELATED LINKS
Caret on page 191
Notes toolbox on page 173
Notes panel on page 177
Rhythmic grid on page 190
Inputting notes on page 197
Inputting notes using pitch before duration on page 200
Inputting bar rests into specific voices on page 222
Adding notes above/below existing notes on page 232
Changing the voice of existing notes on page 422
Voices on page 1134
Stem direction on page 854
Implicit rests in multiple-voice contexts on page 1010
Unused voices on page 1138
Status bar on page 36
Keyboard panel on page 183
Hiding/Showing notes alongside slash regions on page 1000
Hiding/Showing voice colors on page 1135
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Inputting notes into slash voices
You can input notes into multiple slash voices; for example, if you want to indicate a precise 
rhythm without specifying pitches. By default, the first slash voice is up-stem, but you can add 
extra slash voices both with and without stems, and switch between them as often as you want.

You can also input notes into new slash voices on a staff with existing notes. Once you have 
created a slash voice somewhere on a staff, you can input notes into that slash voice anywhere 
else on the same staff.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input slash voices.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Select the slash voice into which you want to input notes in one of the following ways:

● To create a new slash voice, press Shift-Alt/Opt-V . You can also click and hold Create 
Voice  in the Notes toolbox, then click Create Slash Voice .

When a new slash voice is added, a + sign appears beside the symbol of a note beside 
the caret, which now appears as a slash note. The slash note symbol indicates the stem 
direction, and the number beside the slash note symbol indicates the voice number if 
applicable.

Caret when adding the first down-stem slash voice

TIP

You can press Shift-Alt/Opt-V  as many times as you require. For example, on a staff 
containing no notes in slash voices, creating one new slash voice allows you to input 
notes into the first up-stem slash voice.

You can also create a second new slash voice immediately if you want to input notes 
into a down-stem slash voice, or a third new slash voice if you want to input notes into a 
stemless slash voice.

Only voices that contain notes are preserved.

● To select an existing slash voice, press V  or click Next Voice  in the Notes toolbox to 
cycle through active voices on the staff.

4. Input the notes you want.

Notes in slash voices appear at the same staff position, regardless of their pitch. By default, 
this is the middle line of the staff, but this changes in multiple-slash-voice contexts.

5. Stop note input in any of the following ways:

● Press Esc  or Return .
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● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input into new slash voices, as indicated by the caret indicator. The slash note symbol 
beside the caret changes to indicate which voice is currently selected and into which notes are 
input.

You can switch between voices as often as you like.

NOTE

● If you are inputting notes into a new slash voice on a staff that already contains notes in 
other voices/slash voices, the stem directions of existing notes and the staff positions of 
slash voices at the same rhythmic position change automatically as necessary. Rests appear 
as required around notes in different voices.

● If you have three or more voices of any type on a single staff, you must cycle through all the 
voices in a set order. For example, if you have two up-stem voices, two down-stem voices, 
and a slash voice, the order is: first up-stem voice, first down-stem voice, second down-stem 
voice, second up-stem voice, slash voice.

● Any voices that you created, but did not input notes into, are deleted.

EXAMPLE

Caret when inputting 
notes into the first up-
stem slash voice

Caret when inputting 
notes into the first down-
stem slash voice

Caret when inputting 
notes into a new 
stemless slash voice

Caret when inputting 
notes into a new, second 
up-stem slash voice

RELATED LINKS
Notes toolbox on page 173
Slash voices on page 1005
Rhythm slashes on page 997
Inputting slash regions on page 384
Changing the voice of existing notes on page 422
Stem direction on page 854
Implicit rests in multiple-voice contexts on page 1010
Unused voices on page 1138

Inputting notes and notations onto multiple staves
You can input notes and notations onto multiple staves simultaneously, including automatically 
exploding the notes in chords that you play on a MIDI keyboard onto the appropriate staves. 
For example, if you want to input notes onto both piano staves or input the same dynamics for 
multiple instruments.

Inputting notes and notations onto multiple staves is most useful for multiple adjacent pitched 
instruments whose music is only a single voice.
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PREREQUISITE
If you want to explode individual notes in chords onto multiple staves during note input, you 
have connected a MIDI keyboard. You can only input the different notes in chords onto separate 
staves when using a MIDI keyboard.

PROCEDURE

1. In Write mode, select an item at the rhythmic position where you want to input notes/
notations onto multiple staves.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Extend the caret to another staff in any of the following ways:

● To extend to the staff above, press Shift-Up Arrow .

● To extend to the staff below, press Shift-Down Arrow .

4. Optional: Repeat step 3 for as many staves as you require.

5. Input the notes and notations you want.

NOTE

You must input notes using a computer keyboard or MIDI keyboard. If you use the mouse, 
notes are only input on the staff you click. Similarly, you must use the corresponding 
popover to input notations on multiple staves. When inputting notations using the 
corresponding panel, they are only input on the top staff.

6. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
The notes and notations you input are input at the caret position on all staves across which the 
caret extends. If the caret extends across both staves of a grand staff instrument, notes are input 
on either the top or bottom staff according to their pitch. However, this does not apply to grand 
staff instruments with extra staves.

When inputting notes using a MIDI keyboard, the individual notes in any chords you input are 
automatically exploded across the staves.

RELATED LINKS
Caret on page 191
Notes panel on page 177
Inputting notes on page 197
Inputting chords on page 226
Inputting notes using pitch before duration on page 200
Notations input on page 246
Preferences dialog on page 53
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Inputting notes in Insert mode
In Insert mode, you can input notes before existing notes in a single voice without overriding 
them. This allows you to push existing notes ahead at the same time as inputting new notes at 
their previous positions.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● You can only input chords in Insert mode when using a MIDI keyboard.

PROCEDURE

1. In Write mode, start note input.

2. Activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

In Insert mode, the caret shows V and inverted V shapes at the top and bottom. Dotted 
lines are shown on staves affected by the Insert mode scope across which the caret does not 
already extend.

3. Choose the appropriate Insert mode scope.

4. Optional: If the Insert mode scope is set to Voice , press V  until the voice you want is 
selected.

5. Optional: If the Insert mode scope is set to Player  or Voice  and you want to input notes 
in Insert mode onto multiple staves at once, extend the caret to those staves.

6. Input the notes you want.

7. Optional: Press I  or click Insert  again to deactivate Insert mode and return to normal 
note input.

8. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are inserted at the caret position or where you click without overwriting any existing notes 
at rhythmic positions after the caret. Instead, existing notes after the caret are pushed ahead to 
subsequent rhythmic positions.

The voices and staves affected by Insert mode depend on the Insert mode scope.

RELATED LINKS
Caret on page 191
Insert mode on page 408
Insert mode scopes on page 409

Write mode
Note input 

212
Dorico SE 4.3.30



Changing the Insert mode scope on page 410
Notes toolbox on page 173
Rhythmic grid on page 190
Inputting notes on page 197
Inputting chords on page 226
Moving the caret manually on page 196

Inputting notes for unpitched percussion
You can input notes for individual unpitched percussion instruments and on all percussion 
instruments in percussion kits using any presentation type, including selecting playing 
technique-specific noteheads for individual instruments.

When inputting notes in percussion kits, the caret is smaller than when inputting notes on 
pitched instrument or individual percussion instrument staves. Instead of occupying the whole 
height of the staff, the caret in percussion kits is positioned at a particular staff position.

The name of the percussion instrument or slash voice currently selected by the caret, and any 
applicable playing technique, is shown directly above the rhythmic grid display.

NOTE

● You can only input notes into slash voices in percussion kits when using the five-line staff 
presentation type.

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

Inputting notes on instruments with five-line staff kit presentation

PREREQUISITE
If you want to use additional playing technique-specific noteheads for percussion instruments, 
you have defined these in the Percussion Instrument Playing Techniques dialog for each 
instrument.

PROCEDURE

1. In Write mode, select an item on the unpitched percussion instrument/kit staff and at the 
rhythmic position where you want to input notes.

2. In Write mode, start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

You can also press Return ; however, if you select a notation, such as a dynamic, 
pressing Return  opens the corresponding popover instead of starting note input.

● Select a note or rest on the staff where you want to input notes and click Start Note 
Input  in the Notes toolbox.

● Double-click the staff where you want to input notes.
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3. Optional: When inputting into percussion kits, move the caret up/down to other instruments 
in the kit in any of the following ways:

● To move it up, press Up Arrow .

● To move it down, press Down Arrow .

4. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

5. Select an appropriate playing technique for the instrument currently selected by the caret 
before inputting notes.

● To cycle upwards through playing techniques, press Alt/Opt-Up Arrow .

● To cycle downwards through playing techniques, press Alt/Opt-Down Arrow .

● Play the pitch for the playing technique you want on a MIDI keyboard.

NOTE

You can define MIDI pitches for playing techniques on the Note Input and Editing page 
in Preferences.

6. Input notes in one of the following ways:

● Any kit presentation type/Individual instruments: Press Y  to input notes for the 
instrument and playing technique shown above the rhythmic grid.

● Any kit presentation type/Individual instruments: Click on the staff where you want to 
input notes, and at the rhythmic positions where you want them.

● Five-line staff presentation type: Press letters on a computer keyboard or play notes on 
a MIDI keyboard, corresponding to staff positions for the clef set in Preferences. For 
example, press B  to input notes for the instrument assigned to the middle line of a 
five-line staff when Treble G clef is set.

● Grid and single-line instruments presentation types/Individual instruments: Press the 
letter of any note name A  to G  on a computer keyboard or play any note on a 
MIDI keyboard to input notes for the instrument on whose line the caret is currently 
positioned.

NOTE

Notes played on MIDI keyboards are interpreted differently, depending on whether Use 
percussion map or Use staff position is set for the different kit presentation types in 
the Note Input section of the Note Input and Editing page in Preferences.

7. Optional: Advance the caret by the currently selected note duration without inputting notes 
in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .
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TIP

You can also move the caret in different ways and by different increments.

8. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input at the caret position or where you click with the selected duration and are 
played back as you input them by default. If you selected playing techniques, their noteheads 
appear as set in the Percussion Instrument Playing Techniques dialog for the corresponding 
instrument and playing technique, or in the Override Percussion Noteheads dialog for five-line 
staff presentations only.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them.

Dorico SE notates and beams notes appropriately according to their duration, the prevailing time 
signature, and their position in the bar. This includes showing notes as tie chains if required.

If you advance the caret without inputting notes, Dorico SE fills the gaps between notes with 
implicit rests of the appropriate duration.

TIP

You can specify custom beat groupings within individual time signatures.

RELATED LINKS
Notes toolbox on page 173
Notes panel on page 177
Caret on page 191
Percussion kits vs. individual percussion instruments on page 1121
Percussion kits and drum sets on page 1122
Playing techniques for unpitched percussion instruments on page 1115
Playing technique-specific noteheads on page 1116
Percussion Instrument Playing Techniques dialog on page 1116
Changing playing technique-specific noteheads on page 1119
Inputting notes using pitch before duration on page 200
Note and rest grouping on page 705
Beam grouping according to meters on page 689
Deleting rests on page 1012
Inputting notes on page 197

Note input setup for percussion kits
Inputting music for unpitched percussion instruments works differently than for pitched 
instruments. You can use any of the usual methods for unpitched percussion input, but using 
a MIDI keyboard or a computer keyboard is most efficient.

● You can find options relating to note input for percussion in the Note Input section of the 
Note Input and Editing page in Preferences.

There is one set of options for input onto five-line staves, and another set of options for input 
onto grids and individual instruments.
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The main choice affects input via MIDI keyboards and computer keyboards.

Use percussion map
A percussion map defines which MIDI notes produce which sound for a particular 
patch in a sound library. For example, in General MIDI percussion, C2 (note 36) 
produces bass drum, and D2 (note 38) produces snare drum, and so on.

If you know a particular mapping well, you may find it helpful to use the mapping 
directly for input.

Use staff position
This option uses the staff position defined in the Edit Percussion Kit dialog. For 
example, on a drum set, the bass drum is normally positioned in the bottom space 
of the staff, while the snare drum is positioned in the third space from the bottom.

You can think of staff positions relative to what they would be when using a treble G 
clef (F4 and C5 respectively) or using a bass F clef (A2 and E3 respectively).

You can choose which clef is used to interpret staff positions for five-line staves:

● Treble G clef

● Bass F clef

When you select Use staff position, you can designate one octave of your MIDI keyboard to 
input playing techniques.

By default, the Input techniques from MIDI key option is set to MIDI note 48, which is C3, the 
C one octave below middle C (C4 = MIDI note 60). You can click the MIDI learn button and then 
play a note on your MIDI keyboard to change the starting pitch. Assuming a starting pitch of C3, 
ascending notes operate as follows:

● C3 (48): Previous playing technique

● C♯3 (49): Next playing technique

● D3 (50): First mapped playing technique

● E♭3 (51): Second mapped playing technique

● E3 (52): Third mapped playing technique

And so on, up to:

● B3 (59): Tenth mapped playing technique

In general, we recommend that you set Use staff position for percussion input. Use percussion 
map is normally only useful when you are inputting notes onto a drum set and you have already 
memorized the General MIDI percussion map.

RELATED LINKS
Preferences dialog on page 53
Edit Percussion Kit dialog on page 136
Inputting notes for unpitched percussion on page 213
Changing playing technique-specific noteheads on page 1119
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Default note selection during note input for percussion kits
During note input in percussion kits, you can press the letters on a computer keyboard that 
correspond to staff positions for kits using the five-line staff presentation type. For example, you 
can press F  to input a note on the F space or line.

In Preferences, you can set options for inputting notes into percussion kits in the Note Input 
section of the Note Input and Editing page. For example, if you want to use staff positions to 
determine notes, choose Use staff position for Input onto kit or grid.

If you have the staff positions set relative to Treble G clef, then F could mean either the bottom 
space on the staff or the top line on the staff. In a standard drum set, this means either the kick 
drum in the bottom space, or the ride cymbal on the top line.

When inputting notes in pitched instruments, Dorico SE chooses the lower or upper possible staff 
position based on which is closer to the current position of the caret.

However, when inputting notes in percussion kits, Dorico SE chooses the staff position of the 
note with the same stem direction as the last input note, rather than the staff position that is 
closest to the current position of the caret. This makes it easier to input common note patterns 
used in percussion kits.

For example, inputting kick drum and snare drum notes on a standard drum set is a common 
pattern. The kick drum is in the bottom space, and the snare drum is two spaces above: five staff 
positions away from the bottom space, and four staff positions away from the top line.

You can press F  for the kick drum and C  for the snare drum.

The default stem direction behavior for inputting notes in kits in Dorico SE means that you can 
alternate pressing F  and C , and the notes are input at the positions of the kick drum and snare 
drum, even though the top line is the closer position after inputting a snare drum note.

This is because the kick drum uses the same stem direction, and therefore voice, as the snare 
drum.

NOTE

Dorico SE automatically changes the directions of stems according to the positions of notes on 
the staff when only one voice on the staff contains notes, regardless of their voice.

RELATED LINKS
Stem direction on page 854

Inputting notes on tablature
You can input notes directly into tablature in the same ways as inputting normal notes. When 
inputting notes on tablature, the caret is smaller than when inputting notes on standard five-line 
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staves and behaves as if chord input is always active, meaning you must advance the caret 
manually to input notes at other rhythmic positions.

NOTE

These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting notes on tablature using pitch before duration, you must select note durations 
by clicking them in the Notes panel.

PROCEDURE

1. In Write mode, select an item on the tablature and at the rhythmic position where you want 
to input notes.

NOTE

If both notation staves and tablature are shown in the current layout, you must select an 
item on the notation staff and then move the caret to the tablature after starting note input.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Select a note duration in any of the following ways:

● To select the next longer duration, press = .

● To select the next shorter duration, press - .

● In the Notes panel, click the duration you want.

● In the Fretboard panel toolbar, click the duration you want.

4. Input the pitch you want for the current string in any of the following ways:

● Press the number on your computer keyboard or numeric keypad that corresponds to 
the fret number you want. For example, press 6  for fret 6.

For fret numbers 10 and above, press the two digits quickly.

● Press the corresponding letters on your computer keyboard.

NOTE

When using letters, Dorico SE automatically chooses the octave closest to the nut on the 
corresponding string.

● In the Fretboard panel, click the corresponding string and fret position.

● Play the note on a MIDI keyboard.

5. Move the caret up/down to input notes on different strings at the same rhythmic position in 
any of the following ways:

● To move it up, press Up Arrow .

● To move it down, press Down Arrow .

6. Move the caret to other rhythmic positions in any of the following ways:

● To move the caret according to the current rhythmic grid resolution, press 
Right Arrow / Left Arrow .

Write mode
Note input 

218
Dorico SE 4.3.30



● To advance the caret according to the note duration currently selected, press Space  or 
click Advance Caret  in the Fretboard panel toolbar.

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

RESULT
Notes are input at the caret position with the selected duration on the string indicated by the 
caret and are played back as you input them by default. Notes continue to be input at the caret 
position until you move the caret manually and overwrite any previous note on the same string. 
If you attempt to input a note that is impossible on the current string, it is input on the closest 
available string in addition to any existing notes.

If you have input two or more notes on the same string at the same rhythmic position, they 
are shown next to each other on tablature and are colored green. Similarly, when you input 
chords on tablature using pitch before duration with a MIDI keyboard, all notes in the chord 
are allocated to the same string. You can then select them individually and change their string 
allocation.

RELATED LINKS
Caret on page 191
Moving the caret manually on page 196
Fretboard panel on page 185
Tablature on page 1048
Hiding/Showing notation staves and tablature on page 1049
Changing the allocated string for notes on tablature on page 1050
Inputting notes using pitch before duration on page 200

Inputting accidentals
You can input accidentals during note input and by adding them to existing notes. You can also 
change the accidentals of existing notes.

NOTE

● Accidentals that are part of the prevailing key signature are input automatically. For example, 
if you press F  in G major, an F♯ is input automatically. You would only need to specify an 
accidental if you want to input an F♮, for example.

This also applies if you are using a MIDI keyboard, though you can respell notes if the 
accidentals chosen automatically are not the ones that you expected.

● These steps describe selecting accidentals before inputting each note. However, you can 
change this setting if you prefer to specify accidentals after inputting notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the existing notes to which you want to add accidentals or whose accidentals you 
want to change.

2. Select the accidental you want to input in one of the following ways:

● For a flat accidental, press - .

● For a sharp accidental, press = .
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● For a natural accidental, press 0 .

● In the Notes panel, click the accidental you want.

TIP

You can find more accidentals, such as double sharps/flats or microtonal accidentals, in the 
Accidentals section of the Key Signatures, Tonality Systems, and Accidentals panel on the 
right of the window.

3. Optional: During note input, input the note you want with your selected accidental.

RESULT
The accidental is added to the selected existing notes. If you selected existing notes with 
different accidentals, they are changed to have the accidental you selected.

During note input, the selected accidental is only input on the next note you input. You must 
reselect the accidental for each subsequent note.

NOTE

● Due to the default accidental duration rule in Dorico SE, subsequent accidentals for the same 
note in the same register do not appear in the same bar.

● If you input notes using a MIDI device, Dorico SE automatically shows an accidental if 
necessary. It selects a sharp, flat, or natural based on key signature and context. You 
can later respell notes so they are shown as their enharmonic equivalents with different 
accidentals.

RELATED LINKS
Notes panel on page 177
Hiding/Showing zones on page 41
Accidentals on page 655
Inputting notes on page 197
Changing the note-based notation input setting on page 204
Respelling notes on page 428
Changing the pitch of individual notes on page 424
Accidental duration rules on page 660

Accidental selection during MIDI input
Dorico SE interprets MIDI data to create accidentals, and automatically determines the spelling of 
notes according to preset rules.

Dorico SE automatically displays an accidental if one is required. It selects a sharp or flat based 
on key signature and context.

The algorithm for this takes into account the key signature and the intervals between successive 
notes and chords. Therefore Dorico SE prefers sharp accidentals in a key with sharps, and flats 
in a key with flats. If you change the spelling of an accidental, Dorico SE follows your spelling 
preference whenever that note is used again in the score.

If you input notes with accidentals outside the key signature, Dorico SE uses sharps if the figure 
is rising, and flats if it is falling. The spelling is also calculated vertically, meaning a simpler 
interval is produced where possible, such as a major third rather than a diminished fourth.
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By default, Dorico SE makes retrospective changes to how it has spelled accidentals, depending 
on how your music develops. For example, in C major, if you input a sequence of pitches C-E-G♯, 
but then input a G♭, the G♯ is respelled as an A♭.

Inputting rests
Dorico SE automatically shows rests as appropriate in the gaps between the notes you input. 
However, you can also input rests manually; for example, to show fermatas on specific beats for 
players without notes in that bar.

NOTE

These steps describe selecting the duration before inputting rests. However, you can also input 
rests when Pitch Before Duration is active, in which case step 7 is unnecessary.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input rests.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to input rests onto multiple staves at once, extend the caret to those 
staves.

4. Start rest input in any of the following ways:

● Press , .

● In the Notes toolbox, click Rests .

5. Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

6. Select the rest duration you want.

7. Input rests in any of the following ways:

● Press Y  or any of the letters from A  to G .

● Click the staff at the rhythmic position of each rest you want to input.

A shadow rest appears when inputting with the mouse to indicate where the rest will be 
input.

● Play notes on a MIDI keyboard.

8. Optional: Press ,  or click Rests  again to stop rest input.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .
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RESULT
Rests of the selected duration are input. If Force Duration is not activated, Dorico SE 
automatically combines adjacent rests as appropriate for their position in relation to notes and 
according to the current meter.

RELATED LINKS
Rests on page 1008
Implicit vs. explicit rests on page 1009
Note and rest grouping on page 705
Notes toolbox on page 173
Notes panel on page 177
Caret on page 191
Extending the caret to multiple staves on page 195
Selecting note/rest durations on page 235
Forcing the duration of notes/rests on page 238
Inputting notes on page 197
Inputting notes using pitch before duration on page 200

Inputting bar rests into specific voices
When inputting music in multiple voices, rests are normally created automatically when there is a 
gap in the secondary voice. However, if you want secondary voices to begin with explicit bar rests 
in strict contrapuntal music, you can input a bar rest into those voices.

For music in a single voice, you do not have to input bar rests as they appear in each new bar 
automatically when you advance the caret. You can also hide/show bar rests in all empty bars in 
each layout independently.

PROCEDURE

1. In Write mode, start note input.

2. Select the appropriate secondary voice by pressing V  until the voice direction indicator 
shows the correct voice.

Alternatively, if you want to input bar rests into a new voice, press Shift-V  until the voice 
direction indicator shows the correct voice.

3. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

4. Enter rest into the popover to add a bar rest.

5. Press Return  to close the popover.

6. Press Ctrl/Cmd-Right Arrow  to advance the caret to the start of the next bar after the bar 
rest.

7. Optional: If you want to show bar rests in multiple bars for the selected voice, repeat steps 3 
to 6 as many times as required.

RESULT
Bar rests are input into the selected voice at the caret position. If the caret position is within a bar 
that contains notes for the selected voice, these notes are replaced by the bar rest.
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NOTE

Alternatively, you can click Insert Bar Rest in the Insert Bar Rest section of the Bars and 
Barlines panel to input bar rests during note input.

RELATED LINKS
Bars on page 667
Bars and barlines popover on page 276
Hiding/Showing bar rests in empty bars on page 1014
Inputting notes into multiple voices on page 207
Caret on page 191

Inputting ties
You can input ties manually to join two notes of the same pitch, both during note input and by 
joining two existing notes with a tie. You can tie existing notes in different voices or on different 
staves belonging to the same instrument, or that are not rhythmically adjacent.

For example, you might have input a melody across multiple voices in order to accommodate 
passing notes, but want to tie two notes together even though they are in different voices. 
Similarly, you might have written multiple notes before a chord that are all held down and want 
to reduce the number of tied notes.

TIP

Dorico SE automatically creates ties as required for note durations in each meter. For example, 
if you want to input a tie between two quarter notes across a barline, you can input a half note 
at the rhythmic position where you want to input the first quarter note. Dorico SE automatically 
splits the half note into two quarter notes, one on each side of the barline, and joins them with a 
tie.

PREREQUISITE
If you want to preserve the durations of existing notes, you have forced their duration. For 
example, if you want to specify subdivisions within a tie chain that are different than the 
prevailing meter.

We also recommend starting ties from the first note in the tie chain, as tied notes become a 
single note whose settings, including forced durations, come from the first note.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the note from which you want the tie to start. If you want to input a tie between 
two specific notes or between a grace note and a normal note, select those two notes.

NOTE

The two notes must be the same pitch, but can be in different voices or on different 
staves belonging to the same instrument.

2. Optional: During note input, input the note that you want at the start of the tie.

3. Input a tie in any of the following ways:

● Press T .
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● In the Notes toolbox, click Tie .

4. Optional: During note input, input the note that you want at the end of the tie.

NOTE

The second note must be the same pitch as the first note.

RESULT
During note input, the two notes input are joined by a tie.

If you selected a single existing note, it is joined by a tie to the next note of the same pitch in the 
same voice and staff. If you selected two existing notes, they are tied together, provided they are 
the same pitch and belong to the same instrument.

NOTE

● During note input, Dorico SE ties the first note you input after inputting the tie to the 
previous note of the same pitch in the same voice and staff, even if there are other notes of 
other pitches between them.

● Depending on the prevailing time signature and the position of the start of the note in 
the bar, inputting a tie between two notes can instead create a single note of a different 
duration, such as a half note instead of two tied quarter notes. You can override your note 
grouping settings and fix your notated rhythm by forcing their duration. Dorico SE then 
notates your input notes with the rhythmic durations specified, as long as they can fit inside 
the bar.

EXAMPLE

Ties between adjacent notes Ties between non-adjacent notes Ties between grace notes 
and normal notes

RELATED LINKS
Inputting notes on page 197
Forcing the duration of notes/rests on page 238
Notes toolbox on page 173
Ties on page 1074
Ties vs. slurs on page 1075
Note and rest grouping on page 705
Beam grouping according to meters on page 689
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Inputting grace notes
You input grace notes in the same ways as normal notes, and they can have any rhythmic note 
value, accidental, and articulation.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● You cannot add rhythm dots to grace notes.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input grace notes.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to input grace notes onto multiple staves at once, extend the caret to 
those staves.

4. Start grace note input in any of the following ways:

● Press / .

● In the Notes toolbox, click Grace Notes .

5. Press the number for the note duration you want. For example, press 5  for eighth grace 
notes.

6. Optional: Switch between inputting slashed/unslashed grace notes in any of the following 
ways:

● Press Alt/Opt-/ .

● In the Notes toolbox, click and hold Grace Notes , then click Unslashed Grace Notes 
 or Slashed Grace Notes .

Grace Notes  in the Notes toolbox updates to indicate the current grace note type.

7. Input the grace notes you want.

TIP

There is no limit to the number of grace notes that can exist at the same rhythmic position.

8. Press /  or click Grace Notes  again to stop grace note input and return to normal note 
input.

RESULT
The pitches you enter are input as grace notes at the caret position.

TIP

● You can also change the type of grace notes after they have been input.

● Slashed and unslashed grace notes are handled differently in playback.
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RELATED LINKS
Grace notes on page 803
Grace notes in playback on page 808
Notes toolbox on page 173
Notes panel on page 177
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Caret on page 191
Extending the caret to multiple staves on page 195
Inputting notes on page 197
Selecting note/rest durations on page 235
Inputting ties on page 223
Inputting accidentals on page 219
Inputting articulations on page 246
Changing the type of grace notes on page 807
Turning existing notes into grace notes on page 805
Turning grace notes into normal notes on page 806
Inputting notes using pitch before duration on page 200

Inputting chords
You can input chords during note input when both note input and Chords are activated. You can 
input notes with a computer keyboard, with the mouse, using panels in the lower zone, or by 
playing notes with a MIDI keyboard.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting chords using pitch before duration, you must use your computer keyboard 
or a MIDI keyboard and complete step 6 before step 5.

● You can only input chords in Insert mode when using a MIDI keyboard.

● You can input chords without activating Chords when using the Keyboard panel, Fretboard 
panel, or a MIDI keyboard.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input chords.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Start chord input in any of the following ways:

● Press Q .

● In the Notes toolbox, click Chords .

In chord input, a + sign appears at the top of the caret. This allows you to input multiple 
notes at the caret position.
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4. Optional: If you want to input chords onto multiple staves at once, extend the caret to those 
staves.

5. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

6. Input the pitches you want in any of the following ways:

● Press the corresponding letters on your keyboard.

TIP

Dorico SE automatically inputs notes above the highest note at the caret position when 
Chords  is activated.

You can input notes below the lowest note at the caret position instead by pressing Ctrl-
Alt (Windows) or Ctrl (macOS)  as well as the letter for the note name; for example, 
Ctrl-Alt-A (Windows) or Ctrl-A (macOS) .

● Click the staff at the rhythmic positions where you want to input notes.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● In the Keyboard, Fretboard, or Drum Pads panel, play the notes you want.

● Play the notes on a MIDI keyboard.

7. Optional: Advance the caret to input chords at other rhythmic positions in any of the 
following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

During chord input, notes are input at the same rhythmic position and above the previous 
note until you advance the caret manually.

TIP

You can also move the caret in different ways and by different increments.

8. Press Q  or click Chords  again to stop chord input.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .
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RESULT
Multiple notes are input at the caret position.

● If entering pitches by clicking with the mouse, you can put the same pitch into the chord 
twice by clicking again on the same line.

● If entering pitches with the keyboard, repeated notes are automatically input an octave 
above. You can change the register of notes by forcing the register selection during note 
input, or by transposing them after they have been input.

NOTE

● You can stop chord input and immediately continue inputting notes as before, with a single 
note at each rhythmic position and the caret advancing automatically to the next rhythmic 
position.

● When chords contain two pitches in the same register but with different accidentals, that is 
known as an altered unison. Altered unisons are shown as split stems by default in Dorico SE.

● When you input chords on tablature using pitch before duration with a MIDI keyboard, all 
notes in the chord are allocated to the same string. In such cases, the notes are shown next 
to each other on tablature and are colored green. You can then select them individually and 
make your own string allocation.

RELATED LINKS
Notes toolbox on page 173
Notes panel on page 177
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Register selection during note input on page 200
Caret on page 191
Extending the caret to multiple staves on page 195
Moving the caret manually on page 196
Altered unisons on page 658
Inputting notes using pitch before duration on page 200
Changing the note-based notation input setting on page 204

Chord mode
Chord mode changes how notes are input and how edits you make outside of note input affect 
the music. When Chord mode is activated, notes can overlap or stack on top of each other to 
create chords rather than overwriting existing notes. During chord input, the caret does not 
advance automatically.

Edits outside of chord input that are affected by Chord mode include copying/pasting notes or 
changing their duration. For example, if you copy four notes and paste them to a staff that 
already has notes with Chord mode activated, the existing notes are not overwritten but instead 
combine with the new notes to make chords.

● You can activate/deactivate Chord mode in Write mode by pressing Q  or clicking Chords 
in the Notes toolbox.

NOTE

You cannot have both Insert mode and Chord mode activated simultaneously.
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RELATED LINKS
Insert mode on page 408
Caret on page 191
Copying and pasting notes/items on page 414
Changing the duration of notes on page 236
Inputting notes with rhythm dots on page 205

Inputting tuplets
You can input all types of tuplets using the tuplets popover. Tuplets can contain notes of any 
duration, such as a quarter note at the start of an eighth note triplet.

NOTE

These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting tuplets using pitch before duration, Dorico SE determines the base value of the 
tuplet on either the first note you input after specifying the tuplet or the note value included in 
your tuplet ratio.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input tuplets.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to input tuplets onto multiple staves at once, extend the caret to those 
staves.

4. Open the tuplets popover in any of the following ways:

● Press ; .

● In the Notes toolbox, click and hold Tuplets , then click x:y .

When inputting tuplets with the keyboard, Dorico SE automatically continues inputting notes 
as the specified tuplet.

5. Enter the tuplet you want into the popover as a ratio followed by the beat unit.

For example, enter 3:2e to input eighth note triplets or 5:4x to input sixteenth note 
quintuplets.

NOTE

If you do not specify the beat unit, the tuplet is based on the note value currently selected in 
the Notes panel.

6. Press Return  to close the popover.

The tuplet is entered.

7. Optional: Change the selected note duration.

For example, you can input a tuplet based on eighth notes but input a quarter note within 
that tuplet.
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8. Enter or play in the pitches you want.

When inputting tuplets with the keyboard, Dorico SE automatically continues inputting notes 
as the specified tuplet.

9. Optional: Advance the caret to continue inputting tuplets of the same ratio at later rhythmic 
positions in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

10. Stop tuplet input in one of the following ways:

● To return to inputting normal notes, press :  or move the caret with the arrow keys.

● To stop note input completely, press Esc .

RESULT
The pitches you enter or play in are input as tuplets, starting from the caret position.

If you want to input a different type of tuplet immediately after inputting tuplets, you must stop 
the first type of tuplet before inputting the second type. If you do not stop the first type, the 
second type is input as a nested tuplet.

TIP

You can also input tuplets by clicking and holding Tuplets  in the Notes toolbox, then clicking 
the tuplet you want.

RELATED LINKS
Tuplets on page 1104
Nested tuplets on page 1104
Turning existing notes into tuplets on page 1106
Turning tuplets into normal notes on page 1106
Notes toolbox on page 173
Notes panel on page 177
Notations toolbox on page 178
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Caret on page 191
Inputting notes on page 197
Extending the caret to multiple staves on page 195
Inputting notes using pitch before duration on page 200

Tuplets popover
The tuplets popover allows you to input tuplets of any ratio and based on any note duration. The 
table contains examples of what you can enter into the tuplets popover to input different types 
of tuplets.

You can open the tuplets popover in Write mode during note input or when notes are selected in 
any of the following ways:

● Press ; .

As tuplets are often described in ratios, such as 3:2, the tuplets popover uses the semicolon 
key to be memorable.

● In the Notes toolbox, click and hold Tuplets , then click x:y .
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● Choose Write > Create Tuplet.

The icon on the left-hand side of the popover matches the corresponding button in the Notes 
toolbox on the right of the window.

Tuplets popover with an example entry
Tuplets button in the Notes toolbox

When inputting tuplets with the keyboard, Dorico SE continues to input notes as the specified 
tuplet until any of the following happens:

● You press :  to return to inputting normal notes.

● You move the caret with the arrow keys.

● You stop note input.

Type of tuplet Popover entry

Triplet, three notes in the space of two 3, 3:2, 3/2, or 3 2

Triplet, three notes in the space of four 3:4, 3/4, or 3 4

Quadruplet, four notes in the space of three 4:3, 4/3, or 4 3

Quintuplet, five notes in the space of two 5:2, 5/2, or 5 2

Quintuplet, five notes in the space of four 5:4, 5/4, or 5 4

Sextuplet, six notes in the space of four 6:4, 6/4, or 6 4

Septuplet, seven notes in the space of four 7:4, 7/4, or 7 4

Nonuplet, nine notes in the space of eight 9:8, 9/8, or 9 8

Duplet, two notes in the space of three. Often 
used in compound meters.

2:3, 2/3, or 2 3

Quintuplet, five notes in the space of six. Often 
used in compound meters.

5:6, 5/6, or 5 6

Quintuplet, five dotted quarter notes in the 
space of four

NOTE

When using a number to specify the beat unit, 
you must separate the tuplet ratio from the 
beat unit using a space or hyphen.

5:4q., 5/4q., 5 4q., or 5:4-6.

Write mode
Note input 

231
Dorico SE 4.3.30



This list is not comprehensive. It is intended to illustrate how you can structure your entry to 
input different tuplets.

NOTE

Unless you specify a beat unit in your entry, the total duration of the tuplet depends on the note 
value selected when you open the popover. For example, if a quarter note is selected when you 
input a triplet, the triplet input is three quarter notes in the space of two.

Tuplet beat units

Tuplet beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)

RELATED LINKS
Turning existing notes into tuplets on page 1106
Selecting note/rest durations on page 235

Adding notes above/below existing notes
You can add notes above/below existing notes. You can add multiple notes at the same time, 
according to their intervals relative to the existing notes.

PROCEDURE

1. In Write mode, select the notes to which you want to add notes.

2. Open the note tools popover in any of the following ways:

● Press Shift-I .

● In the Notations toolbox, click Popovers , then Note Tools .

3. Enter the intervals of the notes you want, relative to your selected notes.

For example, enter -m3,4 to add notes a minor third below and a fourth above the selected 
notes.
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4. Press Return  to close the popover.

RESULT
Notes are added to the selected notes according to the intervals specified.

RELATED LINKS
Notations toolbox on page 178
Note tools popover on page 233

Note tools popover
The note tools popover allows you to add notes above and below existing notes, and also 
transpose existing notes.

You can open the note tools popover in Write mode in any of the following ways when notes are 
selected, including during note input:

● Press Shift-I .

● In the Notations toolbox, click Popovers , then Note Tools .

● Choose Write > Add Intervals.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Note tools popover with an example entry
Note Tools button in the Notations toolbox

Intervals

Interval or quality Popover entry

Interval degree

Unison, second, third, fourth, fifth, and so on, 
up to two octaves

1, 2, 3, 4, 5, and so on, up to 15

Major M, maj, or major

Minor m, min, or minor

Perfect p, per, or perf

Diminished d, dim, or diminished

Augmented a, aug, or augmented

Diatonic diat or diatonic

[n] octave divisions in any tonality system [n] d, [n] div, or [n] divisions
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Interval or quality Popover entry

[n] half-steps (semitones) in 12-EDO [n] s, [n] st, [n] semi, or [n] semitones

[n] quarter tones in 24-EDO [n] q, [n] qt, or [n] quartertones

NOTE

● You must include an interval degree before a specified total number of octave divisions, such 
as 5 8 div. Together, they specify the desired note name and accidental.

● M and m entries for major and minor are case-sensitive.

Note additions

Type of addition Popover entry

Add notes a third above 3 or 3rd

Add notes a fourth below -4 or -4th

Add notes [n] octave divisions above, using the 
note name a fifth above

5 8 div in any tonality system

5 8 st in 12-EDO

5 16 qt in 24-EDO

Add notes [n] octave divisions below, using the 
note name a sixth below

-6 9 div in any tonality system

-6 9 st in 12-EDO

-6 18 qt in 24-EDO

Add chords containing multiple notes 3,6 or -3,3,4

Add notes only to the top notes in chords top

Add notes only to the bottom notes in chords bottom

NOTE

● When adding multiple notes, you must separate notes with commas, not spaces.

● If you do not specify the interval quality, the interval degree follows the prevailing key 
signature. For example, in C major, if you enter 3 to add a third above a D♮, the added note 
is an F♮. You can specify the interval quality by including it before the interval degree, such as 
maj3.

EXAMPLE

● To add notes a major second below and minor third above the bottom notes in the selected 
chords, enter -M2,m3 bottom.

● To add G♯s above C♮s in 24-EDO, enter 5 16 qt.
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Transposition

Example transposition Popover entry

Transpose notes upwards by a third t3

Transpose notes downwards by a sixth t-6

Transpose notes upwards by [n] octave 
divisions, using the note name a fifth above

t 5 8 div in any tonality system

t 5 8 st in 12-EDO

t 5 16 qt in 24-EDO

Transpose notes downwards by [n] octave 
divisions, using the note name a sixth below

t -6 9 div in any tonality system

t -6 9 st in 12-EDO

t -6 18 qt in 24-EDO

EXAMPLE
To transpose C♮ upwards by nine quarter tones in 24-EDO, you can enter t 3 9 qt for E or t 4 9 qt 
for F.

RELATED LINKS
Notations toolbox on page 178
Large selections on page 389
Equal Division of the Octave (EDO) on page 820
Adding notes above/below existing notes on page 232
Transposing existing notes with the note tools popover on page 427
Arranging tools on page 412
Inputting notes on page 197

Note durations
In Dorico SE, you can change note durations both during note input and for existing notes.

RELATED LINKS
Notes and rests in Dorico on page 21
Note and rest grouping on page 705
Played vs. notated note durations on page 584

Selecting note/rest durations
You can select different durations for notes/rests, both during note input and for existing notes/
rests.

PROCEDURE

1. Optional: If you want to select a note duration not shown in the Notes panel, click the Show/
Hide All Notes disclosure arrows at the top and bottom of the notes list to show more note 
durations.

2. Select a note/rest duration in any of the following ways:
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● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

3. Optional: Add rhythm dots to the duration in one of the following ways:

● For a single rhythm dot, press . .

● For multiple rhythm dots, press Alt/Opt-.  to cycle through different numbers of rhythm 
dots. You can specify up to four rhythm dots.

● In the Notes toolbox, click Dotted Notes  to add the displayed number of rhythm 
dots.

● In the Notes toolbox, click and hold Dotted Notes  to access different numbers of 
rhythm dots.

NOTE

You cannot add rhythm dots to grace notes.

RELATED LINKS
Notes toolbox on page 173
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Notes panel on page 177
Caret on page 191
Key commands in Dorico on page 25
Inputting notes on page 197

Changing the duration of notes
You can lengthen/shorten the duration of notes after they have been input.

PROCEDURE

1. In Write mode, select the notes whose duration you want to change.

NOTE

If you want to extend a note to the end of the current selection, select both that note and an 
item at the rhythmic position to which you want to extend the note.

2. Change the duration in any of the following ways:

● Press the key command of the duration you want. For example, press 4  for a 16th note 
(semiquaver).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

● To lengthen notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .
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● To shorten notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To double the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Right Arrow .

● To halve the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● To lengthen notes by the current rhythmic grid resolution, choose Write > Edit 
Duration > Lengthen Duration by Grid Value.

● To shorten notes by the current rhythmic grid resolution, choose Write > Edit 
Duration > Shorten Duration by Grid Value.

● To double the length of notes, choose Write > Edit Duration > Double Note Duration.

● To halve the length of notes, choose Write > Edit Duration > Halve Note Duration.

● To lengthen notes up to the next existing note in their voice, choose Write > Edit 
Duration > Extend to Next Note.

NOTE

This does not apply to grace notes.

● To lengthen a single note up to the rhythmic position of the end of the current selection, 
choose Write > Edit Duration > Extend to End of Selection.

● To shorten overlapping notes in the same voice so that they no longer overlap, choose 
Write > Edit Duration > Shorten to Next Note.

RESULT
The duration of the selected notes is changed. Dorico SE automatically notates and beams the 
notes appropriately according to their new duration, the prevailing time signature, and their 
position in the bar.

When extending notes, their duration fills in any intervening rests. Extending notes to the end 
of the current selection does not delete any intervening notes, instead they combine with the 
extended note to create chords where necessary.

TIP

You can assign your own key commands to lengthen/shorten notes by specific durations and to 
extend them. You can find these by searching for Shorten duration by, Lengthen duration by, 
and Extend to on the Key Commands page in Preferences.

RELATED LINKS
Notes panel on page 177
Notes toolbox on page 173
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Rhythmic grid on page 190
Key Commands page in the Preferences dialog on page 54
Insert mode on page 408
Chord mode on page 228
Lengthening/Shortening items on page 396
Played vs. notated note durations on page 584
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Splitting notes by duration
You can split notes by either a specific duration, the current rhythmic grid resolution, or the 
duration between the start of the note and the caret position; for example, to turn a long tie 
chain into a sequence of eighth notes.

PROCEDURE

1. In Write mode, select the notes you want to split.

2. Split the selected notes in any of the following ways:

● To split them by the current rhythmic grid resolution, press Alt/Opt-U  or choose 
Write > Edit Duration > Split by Rhythmic Grid Resolution.

● To split them by the duration between the start of the note and the caret position, 
activate the caret, extend it across the required staves, move the caret to the required 
position, then press Alt/Opt-U .

● To split them by a specific duration, choose Write > Edit Duration > Split by Note 
Duration > [Note duration].

RESULT
The selected notes, or notes across which the caret extends, are split into multiple, shorter notes 
of the corresponding duration. If multiples of the selected duration do not fit exactly into the 
original notes, the final note is shortened.

EXAMPLE

A phrase containing long notes Up-stem notes split into eighth notes

RELATED LINKS
Rhythmic grid on page 190
Caret on page 191
Activating/Deactivating the caret on page 195
Moving the caret manually on page 196
Extending the caret to multiple staves on page 195
Deleting ties on page 1082
Splitting tie chains on page 1083

Forcing the duration of notes/rests
Dorico SE automatically notates and beams notes/rests appropriately according to the prevailing 
time signature and their position in the bar. You can force the duration of notes/rests to specify 
their notation.

For example, if you input a half note at the start of a 6/8 bar, it is notated as a dotted quarter 
note (crotchet) tied to an eighth note (quaver). This is because, according to convention, 6/8 bars 
are subdivided into two groups of three eighth notes. To reflect this for a half note (four eighth 
notes), Dorico SE automatically divides the note to show the correct grouping, but you can force 
the note duration to show a half note instead.
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TIP

If you want to force the duration of all notes on a staff to imply a different meter, for example, 
to show three quarter note groups in 6/8 to indicate a hemiola, you can also input a time 
signature only on those staves to group notes according to that meter. You can then hide the 
time signatures if required.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select existing notes whose duration you want to force.

TIP

If you later want to tie notes together, we recommend forcing the duration of all notes 
you want in the tie chain.

2. Optional: If you want input rests with forced durations, start rest input in any of the following 
ways:

● Press , .

● In the Notes toolbox, click Rests .

3. Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

4. Select the note/rest duration you want.

TIP

If you want tie chains to appear as single noteheads with the same total duration, you must 
first reduce their duration, then change it to the duration you want.

5. Optional: During note or rest input, input the notes or rests you want.

RESULT
During note or rest input, any notes you input are notated with their whole rhythmic value, 
whatever their position in the bar. If you move them later, they keep the same notation. Rests are 
input as explicit rests. Notes that cross barlines are notated as tied notes.

Forcing the duration of existing notes or rests preserves their current duration or any duration to 
which you subsequently change them.

TIP

● Force position and duration in the Notes and Rests group of the Properties panel is 
activated automatically for rests input with forced durations. You can also use this property 
to force the duration and position of rests.

● You can choose whether or not Force Duration retains its previous state when you stop and 
restart note input in Preferences > Note Input and Editing > Note Input.

Write mode
Note durations 

239
Dorico SE 4.3.30



EXAMPLE

Default notation of notes in 6/8 Notes in the down-stem voice input with forced 
durations

RELATED LINKS
Implicit vs. explicit rests on page 1009
Notes toolbox on page 173
Notes panel on page 177
Caret on page 191
Inputting notes on page 197
Inputting rests on page 221
Inputting ties on page 223
Selecting note/rest durations on page 235
Changing the duration of notes on page 236
Beam grouping according to meters on page 689
Note and rest grouping on page 705
Creating custom beat groupings for meters on page 705
Turning explicit rests into implicit rests on page 1011

MIDI recording
MIDI recording is a way of inputting notes into Dorico SE by playing them in real time on a MIDI 
device. This can be particularly useful if, for example, you prefer to improvise your music rather 
than plan pitches and note durations in advance.

In Dorico SE, you can record MIDI notes using any MIDI device.

Dorico SE automatically transcribes multiple simultaneous parts into separate voices, such as 
in contrapuntal piano music. Depending on your settings for MIDI recording and quantization, 
Dorico SE can also detect slurs, tremolos, trills, pedal lines, tuplets, and grace notes.

Outside of note input, Dorico SE uses the instrument sounds of your most recent selection for 
the notes you play on your MIDI device. In Play mode, this is the most recent track header you 
clicked, while in Write mode, this is the last instrument staff on which you selected an item, 
started note input, or into which you recorded MIDI. During note input, Dorico SE always uses 
the instrument sounds of the instrument into which you are recording notes.

TIP

You can enable/disable MIDI thru on the Play page in Preferences. For example, if you do not 
want to hear sounds in Dorico SE when playing on your MIDI keyboard.

As you play notes on your MIDI device, Dorico SE uses an algorithm to produce the correct 
enharmonic spelling for those notes.

RELATED LINKS
Optimization for MIDI recording on page 244
Preferences dialog on page 53
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Quantization options on page 81
Voices on page 1134
Pedal lines on page 925
Slurs on page 1016
Tremolos on page 1099
Trills on page 870
Tuplets on page 1104
Grace notes on page 803

Inputting notes using MIDI recording
You can input notes by recording what you play on a MIDI device in real time. You can record 
notes in both concert and transposed pitch.

PREREQUISITE

● You have connected the MIDI device you want to use.

● You have set the quantization and recording options on the Play page in Preferences as 
required for the music you intend to record.

● You have input enough bars or empty rhythmic space for the amount of music you want to 
record. Dorico SE does not automatically add extra bars or rhythmic space.

● If you want to hear a click during your recording, you have input a time signature. There is 
no click in open meter or when there is no time signature.

● You have chosen the appropriate input pitch setting.

PROCEDURE

1. Select a note or rest on the staff/instrument track into which you want to record notes, at the 
position from which you want to record. You can do this in Write mode and Play mode.

NOTE

● In Play mode you cannot select rests, meaning you can only record into instrument 
tracks that already contain at least one note.

● You can also record MIDI during note input, but this prevents Dorico SE from using both 
staves in grand staff instruments.

2. Optional: If you want to record notes without overwriting any existing notes on the staff, 
activate Chord mode in any of the following ways:

● Press Q .

● In the Notes toolbox, click Chords .

3. Optional: If you want to record into a specific voice on the staff, in Write mode, press Shift-N 
to start note input, then do one of the following:

● If the voice you want already exists on the staff, press V  until the note symbol beside 
the caret indicates the correct voice.

● If the voice you want does not exist on the staff yet, press Shift-V  until the note symbol 
beside the caret indicates the correct voice.

4. Press Ctrl/Cmd-R  to start recording.

During recording, the playhead appears red and moves along in time. By default, there is 
one bar of count-in before the playhead reaches the rhythmic position of either your original 
selection or the caret.

5. Play the notes you want on your MIDI device.
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NOTE

Notes do not appear until you stop recording.

6. Press Space or Enter  or Ctrl/Cmd-R  to stop recording.

RESULT
The notes you played on the MIDI device are input onto the selected staff.

If you did not specify the voice, notes are recorded into voices according to what you played. 
For example, if you played notes in rhythmic unison, they are recorded into a single voice. If you 
played notes with different rhythms, they are recorded into separate voices, up to two voices per 
staff.

If you activated Chords, the notes you played are merged into the first available voice on the 
staff without overwriting any existing notes.

The notated duration of the notes follows your quantization options, but their played durations 
are retained for playback.

AFTER COMPLETING THIS TASK

● If the notes you played in are not notated as you intended, you can requantize them.

● If you do not want to retain played durations for playback, you can reset playback overrides.

RELATED LINKS
Quantization options on page 81
Optimization for MIDI recording on page 244
Enabling/Disabling MIDI input devices on page 246
Changing the input pitch setting on page 203
Changing the sustain pedal controller settings for MIDI recording/import on page 245
Repeats in MIDI recording on page 243
Input methods for bars, beats, and barlines on page 275
Input methods for time signatures and pick-up bars on page 258
Inputting notes into multiple voices on page 207
Turning existing notes into grace notes on page 805
Resetting playback overrides on page 585
Preferences dialog on page 53

Retrieving played notes that you did not record
During playback, you can play notes on your MIDI keyboard and hear them without recording 
them into the score. You can use retrospective recording to retrieve these notes and input them 
into the project without previously explicitly recording them. For example, if you only intended to 
experiment with ideas, but afterwards decided you wanted to keep them.

PREREQUISITE
You have started playback, played notes on a MIDI device alongside playback, then stopped 
playback.

PROCEDURE

1. In Write mode, select a note or rest on the staff where you want to input the retrieved notes.

2. Optional: If you want to input retrieved notes without overwriting any existing notes on the 
staff, press Q  to activate Chords.

3. Retrieve the notes you played in any of the following ways:
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● Press Ctrl/Cmd-Alt/Opt-R .

● In the Transport window, click Retrospective Record .

RESULT
All the notes you played on your MIDI device during the previous playback are input on the 
selected staff, starting from the selected rhythmic position. They are input into the first available 
voice on the staff and overwrite any existing notes in that voice by default. If you activated 
Chords, the retrieved notes are merged into the first available voice on the staff without 
overwriting any existing notes.

NOTE

The retrospective recording buffer is cleared each time you start playback, meaning you cannot 
retrieve music you played before the most recent playback.

RELATED LINKS
Playing back music on page 457
Transport window on page 468

Repeats in MIDI recording
When recording MIDI into flows that contain repeat structures, such as repeat barlines, Dorico 
SE records the notes you play during each playthrough and merges them together into the same 
voice.

Any differences in rhythms between the recordings are notated according to the current meter.

Requantizing notes
You can requantize notes using different quantization options. For example, if you want to 
change notated rhythms after importing MIDI or recording notes using a MIDI device. This does 
not affect the played duration of notes in playback.

PROCEDURE

1. Select all the notes you want to requantize. You can do this in Write mode and Play mode.

2. Choose Edit > Requantize to open the Requantize dialog.

3. Change the quantization options as required.

4. Click OK to save your changes and close the dialog.

RESULT
The notated durations of all selected notes are changed according to the quantization options. 
This does not affect their played duration in playback.

RELATED LINKS
Quantization options on page 81
Resetting playback overrides on page 585
Large selections on page 389
Selecting/Deselecting notes and items individually on page 387
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Optimization for MIDI recording
Depending on your operating system and the MIDI devices you use for recording, you might find 
that the notes you record are not notated with the durations or at the rhythmic positions you 
expected. Optimizing the settings related to MIDI recording can help you achieve better results.

● You can find options that affect MIDI recording on the Play page in Preferences.

Because there can be a time latency between you pressing keys on a MIDI device and the notes 
being picked up by Dorico SE, we recommend that you check the latency by inputting a simple 
rhythm against the click; for example, recording quarter notes in a 4/4 time signature.

Depending on the results, there are different settings you can change:

● If your notes are notated with incorrect durations, such as sixteenth notes notated as eighth 
notes, we recommend that you change the quantization options.

● If notes are input with missing or incorrect notations, we recommend that you change the 
detected notations in Preferences > Play > Recording.

● If your notes are notated ahead of the beat, we recommend that you increase the latency 
compensation value.

● If your notes are notated behind the beat, we recommend that you reduce the buffer size 
for your audio device to the lowest possible value that still produces stable playback with no 
drop-outs.

NOTE

The built-in audio device on Windows computers cannot always achieve a low enough 
latency for reliable input in real time. In such cases, we recommend that you use an external 
USB audio interface with ASIO support.

RELATED LINKS
Quantization options on page 81
Changing the sustain pedal controller settings for MIDI recording/import on page 245
Turning existing notes into grace notes on page 805
Changing the sound used for the click on page 450
Preferences dialog on page 53
Pedal lines on page 925
Slurs on page 1016
Tremolos on page 1099
Trills on page 870
Tuplets on page 1104
Grace notes on page 803

Changing the MIDI latency compensation value
You can change the MIDI latency compensation value to correct any discrepancy between when 
you press keys during MIDI recording and where the corresponding notes are notated relative to 
the beat.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Recording subsection, change the value for MIDI input latency compensation.
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4. Click Apply, then Close.

RESULT
Increasing the latency compensation value increases the time between pressing the key and the 
note being notated. This is useful if the notes you record were previously notated ahead of the 
beat.

Decreasing the latency compensation value decreases the time between pressing the key and 
the note being notated. This is useful if the notes you record were previously notated behind the 
beat.

Changing the audio device buffer size
You can change the audio buffer size; for example, if the current buffer size is causing notes 
input using MIDI recording appear significantly after the beat.

NOTE

● If the notes you play when recording MIDI are notated behind the beat, we recommend 
that you reduce the buffer size for your audio device to the lowest possible value that still 
produces stable playback with no drop-outs.

● The built-in audio device on Windows computers cannot always achieve a low enough 
latency for reliable input in real time. In such cases, we recommend that you use an external 
USB audio interface with ASIO support.

PROCEDURE

1. Choose Edit > Device Setup to open the Device Setup dialog.

2. Select the audio device whose buffer size you want to change from the ASIO Driver menu.

3. Click Device Control Panel to open the device settings dialog for the selected audio device.

4. In the audio device settings dialog, change the buffer size in one of the following ways, as 
appropriate for your operating system:

● For Windows systems, in the Audio buffer size section, either drag the slider to a 
different position or activate User definable and change the value in the Selected 
buffer size field.

● For macOS systems, select a sample rate from the Buffer Size menu.

5. Click OK (Windows)/Close (macOS) to close the audio device settings dialog.

6. Click Close to close the Device Setup dialog.

Changing the sustain pedal controller settings for MIDI recording/
import

You can change your default setting for whether Dorico SE interprets sustain pedal controllers as 
pedal lines when recording MIDI and importing or opening MIDI files.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Recording subsection, activate/deactivate Import CC64 as pedal lines.
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4. Optional: If you activated Import CC64 as pedal lines, activate/deactivate Snap pedal lines 
to previous beat.

5. Click Apply, then Close.

RESULT
When Import CC64 as pedal lines is activated, the MIDI controller CC64 is interpreted as pedal 
lines.

When Snap pedal lines to previous beat is activated, the start of pedal lines is automatically 
moved back to the start of the beat.

RELATED LINKS
Preferences dialog on page 53

Enabling/Disabling MIDI input devices
By default, Dorico SE accepts MIDI input from all connected MIDI devices, including virtual 
MIDI cables and inter-application buses. You can enable/disable MIDI devices individually; for 
example, if you are using devices that continuously output MIDI data or if you want particular 
devices to remain routed exclusively to another application.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the MIDI Input Devices subsection, activate/deactivate the checkbox for each MIDI input 
device.

4. Click Apply, then Close.

Notations input
You can input many types of notations, both during note input and by adding them to existing 
notes and music. In Dorico SE, “notation” is a broad term that includes many different items, 
including articulations, slurs, dynamics, and more.

In Dorico SE, you can input most notations with the keyboard by using popovers and with the 
mouse by using panels.

Inputting articulations
You can input notes with articulations during note input, and you can add articulations to notes 
after they have been input.

NOTE

These steps describe selecting articulations before inputting notes. However, you can change 
this setting if you prefer to specify articulations after inputting notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select the existing notes to which you want to add articulations.

2. Optional: If you want to input notes with articulations onto multiple staves at once, extend 
the caret to those staves.

3. Select the articulations you want to input in any of the following ways:

● Press the key commands for the articulations you want.

● In the Notes panel, click the articulations you want.

● In the Keyboard panel toolbar, click the articulations you want.

4. Optional: During note input, input the notes or chords you want with your selected 
articulations.

RESULT
The selected articulations are added to the selected notes. They are positioned between 
noteheads or stems and tuplet brackets, so they are closer to the notes than tuplet brackets 
or tuplet numbers/ratios.

During note input, the selected articulations are added to all notes that are input until the 
articulations are deactivated.

NOTE

Some combinations of articulations on the same notes are not possible. For example, you cannot 
have both staccato and staccatissimo marks on the same notes, as both articulations indicate 
that notes are played shorter.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have slurs in one voice and staccatos in 
another voice.

RELATED LINKS
Articulations on page 661
Note input on page 196
Notes panel on page 177
Keyboard panel on page 183
Extending the caret to multiple staves on page 195
Hiding/Showing zones on page 41
Enabling independent voice playback on page 460

Key commands for articulations
In addition to clicking them in the Notes panel, you can input common articulations by pressing 
key commands on your computer keyboard.

You can use the following key commands to input articulations with the keyboard:

Type of articulation Key command

Accent:  [

Marcato:  '
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Type of articulation Key command

Stressed:  {

Unstressed:  @ (Windows) or " (macOS)

Staccato:  ]

Tenuto:  # (Windows) or \ (macOS)

Staccatissimo: , , or  }

Combined tenuto and staccato:  ~ (Windows) or | (macOS)

Inputting slurs
You can input slurs, both during note input and by adding them to existing notes. You can also 
add slurs to existing notes on multiple staves at the same time, and to notes in different voices 
or on different staves belonging to the same instrument; for example, when phrases span both 
staves of grand staff instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add slurs.

TIP

● If you only select a single note, the slur connects that note to the next note in the 
same voice on the staff. To input slurs between notes in different voices, you must 
select both notes; for example, by selecting the first note then Ctrl/Cmd -clicking 
the second note.

● For instruments with multiple staves, such as piano and harp, you can select two 
existing notes, each on a different staff, to create cross-staff slurs. However, you 
cannot create cross-staff slurs between different instruments.

● You can select notes on multiple staves to input slurs on those staves 
simultaneously.

2. Optional: If you want to input notes and slurs onto multiple staves at once, extend the caret 
to those staves.

3. Input a slur in any of the following ways:

● Press S .

● In the Notes panel, click Slur .

● In the Keyboard panel toolbar, click Slur .

NOTE

If you added slurs to existing notes, stop here.

4. During note input, input the notes you want.
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The slur extends automatically, even if there are rests between the notes you input.

5. During note input, end the slur on the currently selected note in any of the following ways:

● Press Shift-S .

● In the Keyboard panel toolbar, click Slur .

RESULT
During note input, slurs begin from the currently selected note on all staves across which the 
caret extends, not from the caret position. Slurs extend automatically as you input notes, and 
end on the currently selected note.

When adding slurs to existing notes, the selected notes are connected by slurs. For example, if 
you select two notes belonging to one instrument and two notes belonging to another, two slurs 
are input connecting the notes on each selected staff. If you selected notes on different staves 
belonging to the same instrument, a cross-staff slur is input.

Slurs are placed either above or below the notes, depending on the stem direction of the notes 
within the selection.

TIP

When nothing is selected, you can also click Slur  in the Notes panel or Keyboard panel 
toolbar, and then click and drag to input a slur and extend it to your preferred length.

AFTER COMPLETING THIS TASK

● You can enable independent voice playback for individual instruments to hear different 
sounds in different voices simultaneously; for example, if you have slurs in one voice and 
staccatos in another voice.

● You can change the curvature direction of individual slurs.

RELATED LINKS
Notes panel on page 177
Keyboard panel on page 183
Hiding/Showing zones on page 41
Slurs on page 1016
Inputting nested slurs on page 1025
Inputting notes on page 197
Extending the caret to multiple staves on page 195
Slurs in playback on page 1028
Enabling independent voice playback on page 460
Cross-staff and cross-voice slurs on page 1024
Changing the curvature direction of slurs on page 1023
Moving notes/items rhythmically on page 417
Lengthening/Shortening items on page 396

Inputting fingerings
You can input fingerings on existing notes using the fingerings popover, both during note input 
and by adding them to existing notes.

NOTE

● You can only add fingerings to notes at one rhythmic position at a time, and you can only 
input as many fingerings as there are notes at each rhythmic position. For example, you can 
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input three fingerings at the rhythmic position of a chord containing three notes, but only 
one fingering at the rhythmic position of a single note.

● If you select notes in multiple voices, fingerings are only input into the top voice.

● Although they contain two numbers, substitution fingerings are considered one fingering, 
meaning you can add substitution fingerings to single notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an existing note on a single staff to which you want to add fingering.

If you want to add fingerings to all notes in a chord, select all the notes in the chord.

2. Optional: During note input, input at least one note.

3. Open the fingerings popover in any of the following ways:

● Press Shift-F .

● In the Notations toolbox, click Popovers , then Fingerings .

4. Optional: If you are inputting fingerings for fretted instruments, change the hand in one of 
the following ways:

● To switch to the right hand, press Down Arrow .

● To switch to the left hand, press Up Arrow .

The popover icon updates to show the current hand.

Fingerings popover when inputting right-hand 
fingerings

Fingerings popover when inputting left-hand 
fingerings

5. Enter the fingerings you want into the popover.

For example, enter:

● 3-2 for a substitution fingering from the third finger to the second finger.

● 1,3,5 for a chord.

● 12 to show the first two valves should be depressed on a valved brass instrument.

● p for a right-hand thumb fingering or t for a left-hand thumb fingering.

● 2/ for a fingering with a shift indicator.

6. Optional: When adding fingerings to existing notes, move the popover in one of the 
following ways:

● To advance the popover to the next note/chord in the current voice, press Space .

● To move the popover back to the previous note/chord in the current voice, press Shift-
Space .

● To advance the popover to the first note/chord in the current voice in the next bar, press 
Tab .

● To move the popover back to the first note/chord in the current voice in the previous 
bar, press Shift-Tab .
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● To move the cursor and popover to the right/left and to the next/previous note/fingering 
in the current voice, press Right Arrow / Left Arrow .

7. Press Return  to close the popover.

RESULT
The fingerings are input on the selected notes, including during note input. The popover 
advances through notes in the voice as indicated by the caret or in the same voice as your 
initial selection.

RELATED LINKS
Fingering on page 783
Changing the rhythmic position of substitution fingerings on page 785
Fingerings for valved brass instruments on page 794
Deleting fingerings on page 788
Hiding/Showing fingerings in chord diagrams on page 732

Fingerings popover
The following tables contain examples of what you can enter into the fingerings popover to input 
the different types of fingerings available. The fingerings popover behaves differently for fretted 
instruments compared to other instruments, so there is a separate table for fretted instrument 
fingerings.

You can open the fingerings popover in Write mode in any of the following ways when either a 
note is selected or the caret is active:

● Press Shift-F .

● In the Notations toolbox, click Popovers , then Fingerings .

● Choose Write > Create Fingerings.

When inputting fingerings for non-fretted instruments, the icon on the left-hand side of the 
popover matches the corresponding button in the Notations toolbox. When inputting fingerings 
for fretted instruments, the icon on the left-hand side of the popover indicates whether you are 
inputting left-hand or right-hand fingerings.

Fingerings popover with an 
example entry for inputting a non-
fretted instrument fingering

Fingerings popover with an 
example entry for a left-hand 
fretted instrument fingering

Fingering button in the Notations 
toolbox

Fingerings popover with an 
example entry for a right-hand 
fretted instrument fingering
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Non-fretted instruments

Type of fingering Example popover entry

Single fingerings for individual notes, including 
for brass valve numbers and trombone slide 
positions

1, 2, 3, and so on

Valved brass instruments 12

Single fingerings for each note in chords

For keyboard instruments, Dorico SE 
automatically orders numbers appropriately 
according to the hand playing the notes. The 
default is:

● Right hand for the upper staff

● Left hand for the lower staff

1,3,5

Left-hand fingerings (non-fretted instruments) L2, G2, S5, I2, or H2

Right-hand fingerings (non-fretted 
instruments)

R5, D5, or M5

Thumb indicator (non-fretted instruments) T

Multiple fingerings for individual notes; for 
example, for ornaments such as mordents or 
turns

2343

Single fingerings for multiple notes: enter 
the same fingering number for two adjacent 
notes.

For example, in keyboard music the thumb 
may depress two keys simultaneously.

1,1

Alternative fingerings 2(3)

Editorial fingerings [4]

Finger substitutions 1-3

Fingering shift indicator (string instruments) 2/

Fretted instruments

Type of fingering Example popover entries

Left-hand fingerings 0, 1, 2, 3, 4, 5
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Type of fingering Example popover entries

Left-hand thumb t

Right-hand fingerings 1, 2, 3, 4, 5

p, i, m, a, e

Right-hand thumb p, t, or 1

Right-hand pinky finger e, x, c, o, or 5

These lists are not comprehensive as there are many possible fingerings. It is intended to 
illustrate how you can structure your entries to input different types of fingerings.

NOTE

Finger substitutions are shown as immediate by default, but you can change the rhythmic 
position of the substitution by changing the deferral duration.

RELATED LINKS
Notations toolbox on page 178
Fingering on page 783
Changing the rhythmic position of substitution fingerings on page 785
Fingerings for valved brass instruments on page 794
Hiding/Showing fingerings in chord diagrams on page 732

Input methods for key signatures
You can input key signatures with the keyboard by using the key signatures popover, and with 
the mouse by using the Key Signatures, Tonality Systems, and Accidentals panel.

RELATED LINKS
Key signatures on page 815

Key signatures popover
The table contains the entries for the key signatures popover that you can use to input the 
different key signatures available.

You can open the key signatures popover in Write mode in any of the following ways when either 
an item is selected or the caret is active:

● Press Shift-K .

● In the Notations toolbox, click Popovers , then Key Signatures .

● Select an existing key signature and press Return .

● Choose Write > Create Key Signature.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.
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Key signatures popover with an example entry
Key Signatures, Tonality Systems, and Accidentals 
button in the Notations toolbox

Type of key signature Popover entry

Open or atonal key signature open or atonal

Major keys (capital letters) C, D, G#, Ab, and so on

Minor keys (lowercase letters) g, d, f#, bb, and so on

Number of sharps

NOTE

Assumes the major key for that many sharps.

3s, 2#, and so on

Number of flats

NOTE

Assumes the major key for that many flats.

4f, 5b, and so on

This list is not comprehensive as you can input every possible key signature. It is intended to 
illustrate how you can structure your entry to input different types of key signatures.

RELATED LINKS
Notations toolbox on page 178
Key signatures on page 815
Types of key signatures on page 817

Key Signatures, Tonality Systems, and Accidentals panel
The Key Signatures, Tonality Systems, and Accidentals panel allows you to create and input 
common key signatures. It is located in the right zone in Write mode.

● You can hide/show the Key Signatures, Tonality Systems, and Accidentals panel by clicking 
Panels , then Key Signatures, Tonality Systems, and Accidentals  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Key Signatures, Tonality Systems, and Accidentals panel contains the following sections:

Used in This Flow
Contains all the key signatures currently used in the flow.

Key Signatures
Allows you to create key signatures.
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The Key Signatures section contains the following parts:

1 Major/Minor

Allow you to choose whether your key signature is Major or Minor.

2 More Sharps/Fewer Flats

Each time you click, you add one sharp accidental to the key signature, or remove 
one flat accidental from the key signature.

3 Fewer Sharps/More Flats

Each time you click, you remove one sharp accidental from the key signature, or 
add one flat accidental to the key signature.

4 Input key signature

Shows how the key signature looks on a staff. Clicking this button inputs the 
displayed key signature. If nothing in the project is selected, the key signature is 
loaded onto the mouse pointer.

Accidentals
Contains all accidentals available in the currently selected tonality system.

RELATED LINKS
Notations toolbox on page 178
Key signatures on page 815
Tonality systems on page 820

Inputting key signatures with the popover
You can input key signatures using the key signatures popover, both during note input and by 
adding them to existing music. You can also input key signatures only on single staves.

NOTE

It is not necessary to input different key signatures for transposing instruments, as Dorico SE 
automatically shows the appropriate key signatures for transposing instruments in transposing 
layouts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a key signature. If you 
want to input a key signature on a single staff, select an item that belongs to that staff 
only.
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2. Optional: If you want to input key signatures onto multiple specific staves at once, extend the 
caret to those staves.

3. Open the key signatures popover in any of the following ways:

● Press Shift-K .

● In the Notations toolbox, click Popovers , then Key Signatures .

4. Enter the key signature you want into the popover.

For example, enter:

● G or 1s for G major.

● g for G minor.

● open for an atonal key signature.

5. Input the key signature and close the popover in one of the following ways:

● To input a key signature on all staves, press Return .

● To input a key signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
During note input, key signatures are input at the caret position, even if this is in the middle of a 
bar. However, it is preferable to input key signature changes at barlines.

When adding key signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines and clefs, and to the left of other 
items, even if this is in the middle of an existing bar. If you selected an existing key signature, the 
new key signature directly replaces the existing one.

All subsequently input notes follow the input key signature, until the next existing key signature 
or the end of the flow, whichever comes first. If playing in notes using a MIDI keyboard, 
accidentals are spelled according to the key signature.

Key signatures that do not show accidentals, such as A minor or open key signatures, are 
indicated by signposts.

NOTE

An individual key signature on a single staff is not intended for transposing instruments. 
Transpositions of notes and key signatures are done automatically for transposing instruments.

RELATED LINKS
Key signatures popover on page 253
Extending the caret to multiple staves on page 195
Accidental selection during MIDI input on page 220
Key signatures on page 815
Moving notes/items rhythmically on page 417
Transposing instruments on page 119
Making layouts transposing/concert pitch on page 155
Respelling notes on page 428
Changing the pitch of individual notes on page 424
Transposing selections on page 424
Signposts on page 407
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Inputting key signatures with the panel
You can input key signatures using the Key Signatures, Tonality Systems, and Accidentals panel, 
both during note input and by adding them to existing music. You can also input key signatures 
only on single staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● It is not necessary to input different key signatures for transposing instruments, as Dorico 
SE automatically shows the appropriate key signatures for transposing instruments in 
transposing layouts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a key signature. If you 
want to input a key signature on a single staff, select an item that belongs to that staff 
only.

2. In the Notations toolbox, click Panels , then Key Signatures, Tonality Systems, and 
Accidentals  to show the Key Signatures, Tonality Systems, and Accidentals panel.

3. Optional: If you have not already used the key signature you want in the current flow, create 
the key signature you want using the Key Signatures editor in the Key Signatures, Tonality 
Systems, and Accidentals panel.

4. Input the key signature you want in one of the following ways:

● To input a key signature on all staves, click it in the Key Signatures, Tonality Systems, and 
Accidentals panel.

● To input a key signature on the selected staff only, Alt/Opt -click it in the Key Signatures, 
Tonality Systems, and Accidentals panel.

RESULT
During note input, key signatures are input at the caret position, even if this is in the middle of a 
bar. However, it is preferable to input key signature changes at barlines.

When adding key signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines and clefs, and to the left of other 
items, even if this is in the middle of an existing bar. If you selected an existing key signature, the 
new key signature directly replaces the existing one.

All subsequently input notes follow the input key signature, until the next existing key signature 
or the end of the flow, whichever comes first. If playing in notes using a MIDI keyboard, 
accidentals are spelled according to the key signature.

Key signatures that do not show accidentals, such as A minor or open key signatures, are 
indicated by signposts.

NOTE

An individual key signature on a single staff is not intended for transposing instruments. 
Transpositions of notes and key signatures are done automatically for transposing instruments.
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RELATED LINKS
Notations toolbox on page 178
Key Signatures, Tonality Systems, and Accidentals panel on page 254
Key signatures on page 815
Accidental selection during MIDI input on page 220
Moving notes/items rhythmically on page 417
Changing your mouse input settings on page 189
Transposing instruments on page 119
Making layouts transposing/concert pitch on page 155
Respelling notes on page 428
Changing the pitch of individual notes on page 424
Transposing selections on page 424
Signposts on page 407

Input methods for time signatures and pick-up bars
You can input time signatures, including time signatures with pick-up bars, with the keyboard 
by using the time signatures popover, and with the mouse by using the Time Signatures (Meter) 
panel.

NOTE

You can create most types of custom time signatures using the Create Time Signature section 
of the Time Signatures (Meter) panel, but certain time signatures are only possible using the time 
signatures popover. For example, you can only specify beat subdivisions with the time signatures 
popover.

RELATED LINKS
Preferences dialog on page 53
Time signatures on page 1084
Types of time signatures on page 1085

Time signatures popover
The table contains the entries for the time signatures popover that you can use to input the 
different types of time signatures available.

You can open the time signatures popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

● Select an existing time signature and press Return .

● Choose Write > Create Time Signature.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Time signatures popover with an example entry
Time Signatures (Meter) button in the Notations 
toolbox
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Time signatures

Type of time signature Popover entry

Simple time signatures

For example, 2/2 (two half notes per bar), 2/4 
(two quarter notes per bar), 6/8 (six eighth 
notes per bar), 3/4, 5/4, and so on

2/2, 2/4, 6/8, 3/4, 5/4, and so on

Alternating time signatures, such as 6/8+3/4 6/8 + 3/4

NOTE

You must include spaces either side of the plus 
sign.

Common time, the equivalent of 4/4 c

Cut common time, the equivalent of 2/2 cutc, cut, or ¢

Open meter indicated by X X or x

Open meter with no indication

NOTE

A time signature signpost is shown at the 
position of the open meter.

open

Additive time signature with explicit beat 
grouping

3+2+2/8, 3+2/4, and so on

Beat grouping specified but not shown in the 
time signature

For example, a time signature of 7/8 is shown 
but beams are subdivided into 2+3+2 eighth 
notes.

[2+3+2]/8

Aggregate time signature with dashed barlines 
shown in each bar, indicating the divisions 
between the different meters

2/4|6/8

Aggregate time signature without dashed 
barlines shown in each bar

2/4:6/8
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Type of time signature Popover entry

Interchangeable time signature with different 
styles: parenthesized, slash, equals sign, and 
dashed

2/4 (6/8), 2/4 / 6/8, 2/4 = 6/8, or 2/4 – 6/8

NOTE

You must include spaces either side of the 
slashes, equals signs, or dashes, and before 
opening parentheses.

Pick-up bars

Example time signature with pick-up bar Popover entry

4/4 time signature with a dotted quarter note 
pick-up

4/4,1.5

6/8 time signature with a pick-up of two eighth 
notes

6/8,2

2/2 time signature with a quarter note pick-up 2/2,0.5

TIP

The number after the comma indicates multiples of the rhythmic unit specified by the 
denominator of the time signature.

These lists are not comprehensive, as there are many possible time signatures and pick-up 
bars. They are intended to illustrate how you can structure your entry to input different time 
signatures and pick-up bars.

RELATED LINKS
Notations toolbox on page 178
Time signatures on page 1084
Types of time signatures on page 1085
Time signature styles on page 1091
Inputting time signatures with the popover on page 262
Inputting pick-up bars with the popover on page 264
Creating custom beat groupings for meters on page 705
Ending interchangeable time signatures on page 1097

Time Signatures (Meter) panel
The Time Signatures (Meter) panel allows you to input different time signatures. In the Create 
Time Signature section of the panel, you can create uncommon time signatures. It is located in 
the right zone in Write mode.

● You can hide/show the Time Signatures (Meter) panel by clicking Panels , then Time 
Signatures (Meter)  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .
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The Time Signatures (Meter) panel contains the following sections:

Used in This Flow
Contains any time signatures already used in the current flow.

Common
Contains common time signatures, such as 4/4, 3/4, 6/8, and 7/8.

Create Time Signature
Allows you to design your own time signatures, including alternating time signatures 
and aggregate time signatures.

The Create Time Signature section contains the following parts:

1 Time signature type menu

Allows you to select one of the following types of time signatures:

● Regular

● Additive

● Interchangeable

● Aggregate

● Alternating

2 Time signature spaces

Allows you to combine up to four time signatures. For example, you can specify 
only one time signature for a regular time signature, but for an alternating time 
signature, you might want to include three time signatures.

3 Pick-up bar of

Allows you to include a pick-up bar before the time signature. A pick-up bar is 
not a complete bar, and so allows you to include only a few beats before the first 
complete bar.

You can select one of the following options for the number of beats in a pick-up 
bar:

● 1/2 beat

● 1 beat
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● 2 beats

● 3 beats

4 Input time signature button

Click the button that displays the time signature to input it. If nothing in the project 
is selected, the time signature is loaded onto the mouse pointer.

RELATED LINKS
Notations toolbox on page 178
Time signatures on page 1084
Types of time signatures on page 1085
Time signature styles on page 1091
Inputting time signatures with the panel on page 263
Inputting pick-up bars with the panel on page 266

Inputting time signatures with the popover
You can input time signatures using the time signatures popover, both during note input and by 
adding them to existing music. You can also input time signatures only on single staves.

NOTE

Dorico SE does not automatically add beats to fill bars according to the new time signature at the 
end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature. If you 
want to input a time signature on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want to input time signatures onto multiple specific staves at once, extend 
the caret to those staves.

3. Optional: If you want Dorico SE to add beats at the end of the region affected by the new 
time signature if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

4. Open the time signatures popover in any of the following ways:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

5. Enter the time signature you want into the popover.

For example, enter 4/4 for a 4/4 time signature or [2+2+3]/8 for a 7/8 time signature with a 
custom beat grouping.

6. Input the time signature and close the popover in one of the following ways:

● To input a time signature on all staves, press Return .

● To input a time signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .
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RESULT
During note input, time signatures are added at the caret position, even if this is in the middle of 
an existing bar.

When adding time signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines, key signatures, and clefs, and to the 
left of other items, even if this is in the middle of an existing bar. If you selected an existing time 
signature, the new time signature directly replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico SE automatically inputs and moves barlines as 
required so that subsequent music is barred correctly. However, in open meters, you must input 
barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

RELATED LINKS
Time signatures popover on page 258
Extending the caret to multiple staves on page 195
Time signatures on page 1084
Pick-up bars on page 1088
Time signature styles on page 1091
Changing the separator style of interchangeable time signatures on page 1094
Inputting pick-up bars with the popover on page 264
Inputting barlines with the popover on page 281
Inputting bars/beats with the popover on page 278
Insert mode on page 408
Ending interchangeable time signatures on page 1097
Rhythmic position on page 22

Inputting time signatures with the panel
You can input time signatures using the Time Signatures (Meter) panel, both during note input 
and by adding them to existing music. You can also input time signatures only on single staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Dorico SE does not automatically add beats to fill bars according to the new time signature at 
the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature. If you 
want to input a time signature on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want Dorico SE to add beats at the end of the region affected by the new 
time signature if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .
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3. In the Notations toolbox, click Panels , then Time Signatures (Meter)  to show the Time 
Signatures (Meter) panel.

4. Optional: If you want to input a time signature that is not available in the Used in This Flow 
or Common sections, select the type of time signature you want to input from the menu in 
the Create Time Signature section.

5. Optional: Enter the time signatures you want into the available spaces.

6. Input the time signature you want in one of the following ways:

● To input a time signature on all staves, click it in the Time Signatures (Meter) panel.

● To input a time signature on the selected staff only, Alt/Opt -click it in the Time 
Signatures (Meter) panel.

RESULT
During note input, time signatures are added at the caret position, even if this is in the middle of 
an existing bar.

When adding time signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. They appear to the right of barlines, key signatures, and clefs, and to the 
left of other items, even if this is in the middle of an existing bar. If you selected an existing time 
signature, the new time signature directly replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico SE automatically inputs and moves barlines as 
required so that subsequent music is barred correctly. However, in open meters, you must input 
barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

RELATED LINKS
Notations toolbox on page 178
Time Signatures (Meter) panel on page 260
Changing your mouse input settings on page 189
Time signatures on page 1084
Pick-up bars on page 1088
Time signature styles on page 1091
Changing the separator style of interchangeable time signatures on page 1094
Inputting pick-up bars with the panel on page 266
Inputting barlines with the panel on page 282
Inputting bars/beats with the popover on page 278
Insert mode on page 408
Ending interchangeable time signatures on page 1097
Rhythmic position on page 22

Inputting pick-up bars with the popover
You can input pick-up bars as part of time signatures using the time signatures popover, both 
during note input and by adding them to existing music. You can also input time signatures with 
pick-up bars only on single staves.

NOTE

Dorico SE does not automatically add beats to fill bars according to the new time signature at the 
end of the affected region unless Insert mode is activated.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a pick-up bar. If you 
want to input a pick-up bar on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want to input a pick-up bar onto multiple specific staves at once, extend the 
caret to those staves.

3. Optional: If you want Dorico SE to add beats at the end of the region affected by the pick-up 
bar if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

4. Open the time signatures popover in any of the following ways:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

5. Enter the time signature and the number of pick-up beats you want into the popover.

For example, enter 3/4,0.75 for a 3/4 time signature with a dotted eighth note (dotted 
quaver) upbeat or 4/4,1 for a 4/4 time signature with one quarter note upbeat. The number 
after the comma indicates multiples of the rhythmic unit specified by the denominator of the 
time signature.

6. Input the pick-up bar and close the popover in one of the following ways:

● To input a pick-up bar on all staves, press Return .

● To input a pick-up bar only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
During note input, pick-up bars are added at the caret position as part of the specified time 
signature, even if this is in the middle of an existing bar.

When adding pick-up bars to existing music, they are added at the rhythmic position of the 
earliest selected item as part of the specified time signature. They appear to the right of barlines, 
key signatures, and clefs, and to the left of other items, even if this is in the middle of an existing 
bar. If you selected an existing time signature, the new time signature with pick-up bar directly 
replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico SE automatically inputs and moves barlines as 
required so that subsequent music is barred correctly. However, in open meters, you must input 
barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

NOTE

● Dorico SE does not automatically insert beats at the start of existing music to which you add 
time signatures with pick-up bars. If you add a pick-up bar at the start of a flow, that flow 
now begins in the pick-up bar, not in the first full bar. You can insert beats at the start to 
push existing music to later rhythmic positions.
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● You can use the Global Adjustment of Current Bar Insert mode scope to create and delete 
pick-up bars by deleting notes/rests in the first bar in the flow. You can also use it to shorten 
the last bar in flows that start with a pick-up bar.

RELATED LINKS
Time signatures popover on page 258
Pick-up bars on page 1088
Defining partial bars as pick-up bars or irregular bars on page 1088
Inputting time signatures with the popover on page 262
Inputting bars/beats with the popover on page 278
Inputting barlines with the popover on page 281
Rhythmic position on page 22
Inputting notes in Insert mode on page 212
Insert mode on page 408
Insert mode scopes on page 409
Ending interchangeable time signatures on page 1097

Inputting pick-up bars with the panel
You can input pick-up bars as part of time signatures using the Time Signatures (Meter) panel, 
both during note input and by adding them to existing music. You can also input time signatures 
only on single staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Dorico SE does not automatically add beats to fill bars according to the new time signature at 
the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a pick-up bar. If you 
want to input a pick-up bar on a single staff, select an item that belongs to that staff 
only.

2. Optional: If you want Dorico SE to add beats at the end of the region affected by the pick-up 
bar if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

3. In the Notations toolbox, click Panels , then Time Signatures (Meter)  to show the Time 
Signatures (Meter) panel.

4. In the Create Time Signature section, select the type of time signature you want from the 
menu.

5. Enter the time signatures you want into the available spaces.

6. Activate Pick-up bar of and select one of the following options:

● 1/2 beat

● 1 beat

Write mode
Notations input 

266
Dorico SE 4.3.30



● 2 beats

● 3 beats

NOTE

Not all pick-up bar lengths are possible when using the panel. For example, you cannot 
produce a single eighth note upbeat in 6/8 with the available options. In such cases, you 
must use the time signatures popover.

7. Input the pick-up bar in one of the following ways:

● To input a pick-up bar on all staves, click the input time signature button in the Create 
Time Signature section.

● To input a pick-up bar on the selected staff only, Alt/Opt -click the input time signature 
button in the Create Time Signature section.

RESULT
During note input, pick-up bars are added at the caret position as part of the specified time 
signature, even if this is in the middle of an existing bar.

When adding pick-up bars to existing music, they are added at the rhythmic position of the 
earliest selected item as part of the specified time signature. They appear to the right of barlines, 
key signatures, and clefs, and to the left of other items, even if this is in the middle of an existing 
bar. If you selected an existing time signature, the new time signature with pick-up bar directly 
replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico SE automatically inputs and moves barlines as 
required so that subsequent music is barred correctly. However, in open meters, you must input 
barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

NOTE

● Dorico SE does not automatically insert beats at the start of existing music to which you add 
time signatures with pick-up bars. If you add a pick-up bar at the start of a flow, that flow 
now begins in the pick-up bar, not in the first full bar. You can insert beats at the start to 
push existing music to later rhythmic positions.

● You can use the Global Adjustment of Current Bar Insert mode scope to create and delete 
pick-up bars by deleting notes/rests in the first bar in the flow. You can also use it to shorten 
the last bar in flows that start with a pick-up bar.

RELATED LINKS
Notations toolbox on page 178
Time Signatures (Meter) panel on page 260
Pick-up bars on page 1088
Inputting pick-up bars with the popover on page 264
Defining partial bars as pick-up bars or irregular bars on page 1088
Inputting bars/beats with the popover on page 278
Inputting barlines with the panel on page 282
Rhythmic position on page 22
Inputting notes in Insert mode on page 212
Insert mode on page 408
Insert mode scopes on page 409
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Ending interchangeable time signatures on page 1097
Changing your mouse input settings on page 189

Input methods for tempo marks
You can input tempo marks with the keyboard by using the tempo popover, with the mouse by 
using the Tempo panel, and in the Tempo editor. You can input a tempo mark containing just a 
text instruction, just a metronome mark, or a combination of the two.

RELATED LINKS
Tempo marks on page 1052
Tempo editor on page 601
Inputting tempo changes in the Tempo editor on page 602

Tempo popover
The following tables contain examples of what you can enter into the tempo popover to input 
tempo marks, tempo equations, and rhythmic feels for swing playback.

When you start entering a tempo into the tempo popover, a menu appears with suggestions 
containing the letters/words you enter. You can select one of these suggestions to input, or enter 
your own tempo into the popover.

You can open the tempo popover in Write mode in any of the following ways when either an item 
is selected or the caret is active:

● Press Shift-T .

● In the Notations toolbox, click Popovers , then Tempo .

● Select an existing tempo mark and press Return .

● Choose Write > Create Tempo.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Tempo popover with an example entry

Tempo button in the Notations toolbox

Tempo marks

Example tempo mark Popover entry

Adagio Adagio

Presto  = 176 Presto q = 176 or Presto q=176

Largo ( = 52) Largo (q = 52) or Largo (q=52)

 = 96-112 q = 96-112, q=96-112, 6 = 96-112, or 6=96-112
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Example tempo mark Popover entry

  = 84 q. = 84, q.=84, 6. = 84, or 6.=84

 = 60 h = 60, h=60, 7 = 60, or 7=60

 = 120 e = 120, e=120, 5 = 120, or 5=120

rit. rit. or rit

ritardando ritardando

accel. accel. or accel

accelerando accelerando

più più

meno meno

Rubato Rubato

Faster, with energy Faster, with energy

This list is not comprehensive as you can enter tempos freely and there are many possible 
metronome marks and tempo marks. It is intended to illustrate how you can structure your entry 
to input different types of tempo marks and metronome marks.

NOTE

The tempo popover is case-sensitive. If you want your tempo mark to start with a capital letter, 
you must enter a capital letter into the popover.

Metronome mark beat units

Metronome mark beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8
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Metronome mark beat unit Popover entry

Double whole note 2w or 9

Rhythm dot . (period)

Tempo equations

Example tempo equation Popover entry

 =   e = e. or e=e.

 =  q = e or q=e

 =  q. = h or q.=h

This list is not comprehensive as there are many possible tempo equations. It is intended to 
illustrate how you can structure your entry to input different tempo equations.

NOTE

Tempo equations do not yet include tuplet durations. This is planned for future versions.

Rhythmic feels for swing playback

Rhythmic feel Popover entry

Light 16th note swing rhythmic feel light swing 16ths

Light eighth note swing rhythmic feel light swing 8ths

Medium 16th note swing rhythmic feel medium swing 16ths

Medium eighth note swing rhythmic feel medium swing 8ths

Heavy 16th note swing rhythmic feel heavy swing 16ths

Heavy eighth note swing rhythmic feel heavy swing 8ths

Straight rhythmic feel straight (no swing)

Triplet 16th fixed rhythmic feel 2:1 swing 16ths (fixed)

Triplet 8th fixed rhythmic feel 2:1 swing 8ths (fixed)

Dotted 16th-32nd fixed rhythmic feel 3:1 swing 16ths (fixed)

Dotted 8th-16th fixed rhythmic feel 3:1 swing 8ths (fixed)
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RELATED LINKS
Notations toolbox on page 178
Tempo marks on page 1052
Types of tempo marks on page 1053
Tempo mark components on page 1054
Swing playback on page 465
Enabling swing playback on page 467
Changing the order of metronome marks on page 1061

Tempo panel
The Tempo panel contains the different types of tempo marks available in Dorico SE, organized 
into sections. It is located in the right zone in Write mode.

● You can hide/show the Tempo panel by clicking Panels , then Tempo  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

Used in This Flow
Contains any tempo marks already used in the flow, including custom tempo marks 
added using the tempo popover.

Tap Tempo
Allows you to create an absolute tempo change based on the speed with which you 
click the Tap button. It appears as a metronome mark with no text by default. The 
metronome mark value is always rounded to the nearest integer.

You can use the available options to set the beat unit on which you want to base the 
tempo.

Absolute Tempo Change
Contains a range of tempos with both an Italian tempo indication and a metronome 
mark. You can later choose to show or hide the metronome mark for individual tempo 
marks.

You can change the range shown in the list by adjusting the slider at the top.
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Gradual Tempo Change
Contains tempo marks that indicate a change in tempo over a defined period of time, 
such as rallentando or accelerando.

You can add modifiers to gradual tempo changes. Available modifiers are shown at the 
top of the section.

Relative Tempo Change
Contains tempo marks that indicate a change in tempo that is relative to the previous 
tempo, such as mosso (movement, or with movement). They often include modifiers 
that qualify the change, such as poco meno mosso (a little less movement), and are not 
defined by a metronome mark.

You can add modifiers to relative tempo changes. Available modifiers are shown at the 
top of the section.

You can later set a relative metronome mark change as a percentage of the previous 
metronome mark for individual tempo marks.

Reset Tempo
Contains tempo marks that indicate a return to the previous tempo, such as A tempo, 
or a previously defined tempo, such as Tempo primo.

Tempo Equation
Allows you to input a tempo equation, using beat units from 16th notes to whole notes 
and up to two rhythm dots.
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RELATED LINKS
Notations toolbox on page 178
Tempo marks on page 1052
Types of tempo marks on page 1053
Tempo mark components on page 1054
Changing the metronome mark value on page 1059

Inputting tempo marks with the popover
You can input tempo marks using the tempo popover, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a tempo mark. If you 
want to input a gradual tempo change across a duration, select items that span that 
duration.

2. Open the tempo popover in any of the following ways:

● Press Shift-T .

● In the Notations toolbox, click Popovers , then Tempo .

3. Enter the tempo you want into the popover.

For example, enter q=72 or Allegretto.

When you start entering a tempo into the tempo popover, a menu appears that shows 
suggested tempos containing the letters/words you enter. You can select one of these 
suggestions or you can enter your own tempo into the popover.
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NOTE

If you want to show gradual tempo changes separated into syllables spread across their 
duration, such as rit-e-nu-to, we recommend selecting a suggested entry from the menu. 
Only gradual tempo changes with valid full text appear separated into syllables.

4. Press Return  to close the popover.

RESULT
During note input, tempo marks are input at the caret position. Gradual tempo changes, such as 
rallentando, are also input at the caret position with a default duration of a quarter note. Gradual 
tempo changes do not extend as you input notes.

When adding tempo marks to existing music, they are added at the rhythmic position of the 
earliest selected item. Gradual tempo changes span the duration of the selected items.

NOTE

Metronome mark values appear as integers without decimal places, even if you input decimal 
places. However, the exact metronome mark value you input is always reflected in playback.

AFTER COMPLETING THIS TASK
You can lengthen/shorten gradual tempo changes.

RELATED LINKS
Tempo marks on page 1052
Tempo track on page 450
Tempo editor on page 601
Tempo mark components on page 1054
Gradual tempo changes on page 1062
Metronome marks on page 1058
Tempo equations on page 1064
Lengthening/Shortening items on page 396
Changing the style of gradual tempo changes on page 1063
Changing the order of metronome marks on page 1061

Inputting tempo marks with the panel
You can input tempo marks using the Tempo panel, both during note input and by adding them 
to existing music.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● You cannot specify decimal places for metronome marks using the panel. You can specify 
decimal places using the popover or by changing the metronome mark value of existing 
tempo marks.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select an item at the rhythmic position where you want to input a tempo mark. If you 
want to input a gradual tempo change across a duration, select items that span that 
duration.

2. In the Notations toolbox, click Panels , then Tempo  to show the Tempo panel.

3. In the Tempo panel, click the tempo mark you want.

TIP

If you want Dorico SE to calculate the metronome mark for you, you can click Tap in the Tap 
Tempo section multiple times at the required speed.

4. Optional: Select a modifier from the available options.

NOTE

You can only add modifiers to a Gradual Tempo Change or a Relative Tempo Change.

RESULT
During note input, tempo marks are input at the caret position. Gradual tempo changes, such as 
rallentando, are also input at the caret position with a default duration of a quarter note. Gradual 
tempo changes do not extend as you input notes.

When adding tempo marks to existing music, they are added at the rhythmic position of the 
earliest selected item. Gradual tempo changes span the duration of the selected items.

AFTER COMPLETING THIS TASK
You can lengthen/shorten gradual tempo changes.

RELATED LINKS
Notations toolbox on page 178
Changing your mouse input settings on page 189
Tempo marks on page 1052
Tempo mark components on page 1054
Gradual tempo changes on page 1062
Metronome marks on page 1058
Tempo equations on page 1064
Changing the metronome mark value on page 1059
Changing the style of gradual tempo changes on page 1063
Changing the order of metronome marks on page 1061

Input methods for bars, beats, and barlines
You can input both bars and barlines with the keyboard by using the bars and barlines popover, 
and also with the mouse by using the available options in the Bars and Barlines panel. The bars 
and barlines popover also allows you to input beats. Additionally, you can input bars and beats 
using the system track.

Normally you do not need to create bars in Dorico SE, as they are created automatically as 
needed when you input music. However, you can add bars in advance if, for example, you are 
copying or arranging an existing piece of music.

RELATED LINKS
Bars on page 667
Barlines on page 672
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System track on page 390
Inputting bar rests into specific voices on page 222
Repeats in playback on page 463

Bars and barlines popover
The following tables contain examples of what you can enter into the bars and barlines popover 
to add and delete bars and beats, and the entries you can use to input the different barlines 
available.

You can open the bars and barlines popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

● Choose Write > Create Bar or Barline.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Bars and barlines popover with an 
example entry for inputting bars

Bars and barlines popover with an 
example entry for a barline

Bars and Barlines button in the 
Notations toolbox

Bars

Example action Popover entry

Add two bars 2 or +2

Add fourteen bars 14 or +14

Delete one bar –1

Delete six bars –6

Add a bar rest rest

Delete empty bars at the end of the flow trim

This list is not comprehensive, as you can add and delete any number of bars using the popover. 
This table is intended to illustrate how you can structure your entry to input and delete bars, and 
input bar rests.

Beats

You can specify a number of beats that you want to add/delete by entering the number of beats 
you want followed by either the number that corresponds to the beat unit, such as 5 for eighth 
notes, or the letter that corresponds to the beat unit, such as h for half notes. When using 
numbers for both the number of beats and the beat unit, you must separate them with a space 
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or hyphen. You can also specify beats in the form of a time signature, such as 3/4 for three 
quarter note beats.

Example action Popover entry

Add one whole note beat 1w, 1-8, 1 8, or 4/4

Add two quarter note beats 2q, 2-6, 2 6, or 2/4

Add four eighth note beats 4e, 4-5, 4 5, 4/8, or 2/4

Delete two quarter note beats –2q, -2-6, -2 6, or -2/4

Delete empty beats at the end of the flow trim

This list is not comprehensive, as you can add and delete any number of beats using the 
popover. This table is intended to illustrate how you can structure your entry to input and delete 
beats.

Beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)

Barlines

Type of barline Popover entry

Normal (Single) |, single, or normal

Double || or double

Final |] or final
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Type of barline Popover entry

Start repeat |: or start

End repeat :| or end

End/Start repeat :|:, :||:, end-start, or endstart

RELATED LINKS
Notations toolbox on page 178
Inputting bar rests into specific voices on page 222
Bars on page 667
Barlines on page 672
Deleting bars/beats on page 667
Repeats in playback on page 463

Bars and Barlines panel
The Bars and Barlines panel allows you to input bars, bar rests, and different types of barlines. It 
is located in the right zone in Write mode.

● You can hide/show the Bars and Barlines panel by clicking Panels , then Bars and Barlines 
 in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Bars and Barlines panel contains the following sections:

Insert Bars
Allows you to determine how many bars you want to insert and where to insert them, 
such as at the end of the flow.

Insert Bar Rest
Allows you to insert a bar rest.

Create Barline
Contains the different barlines you can input.

RELATED LINKS
Notations toolbox on page 178
Repeats in playback on page 463
Hiding/Showing zones on page 41

Inputting bars/beats with the popover
You can input bars/beats using the bars and barlines popover, both during note input and by 
adding them to or inserting them into existing music. For example, if you want to extend a 
cadenza in an open meter.

PREREQUISITE
If you want to input bars, you have input a time signature.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select an item at the rhythmic position where you want to add bars/beats. If you want to 
add bars/beats to a single staff, select an item that belongs to that staff only.

Bars/Beats are added after selected barlines and before other selected items, including 
time signatures.

2. Optional: If you want to input bars/beats onto multiple specific staves at once, extend the 
caret to those staves.

3. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

4. Enter the number of bars/beats you want to input.

For example, enter 2 to input two bars or 2q to input two quarter note beats.

5. Input the bars/beats and close the popover in one of the following ways:

● To input bars/beats for all staves, press Return .

● To input bars/beats only on the selected staff or staves across which the caret extends, 
press Alt/Opt-Return .

RESULT
The number of bars or beats specified is input.

During note input, bars/beats are input from the caret position. If the caret is in the middle of 
the bar when inputting bars, sufficient beats are added to ensure that the final bar created has 
the correct number of beats. The caret position stays at its previous position so you can continue 
inputting music from the same position.

When you add bars/beats to existing music, they are added after selected barlines and before 
other selected items, including time signatures.

TIP

Another way to add bars is by choosing a note duration, such as a whole note when in a 4/4 time 
signature, and pressing Space  repeatedly during note input.

RELATED LINKS
Bars and barlines popover on page 276
Bars on page 667
Inputting time signatures with the popover on page 262
Types of time signatures on page 1085

Inputting bars with the panel
You can input bars using the Bars and Barlines panel, both during note input and by inserting 
them into existing music.

PREREQUISITE
You have input a time signature.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an existing barline after which you want to input bars.
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● Select an existing item before which you want to input bars.

2. In the Notations toolbox, click Panels , then Bars and Barlines  to show the Bars and 
Barlines panel.

3. In the Insert Bars section of the Bars and Barlines panel, change the number of bars you 
want to input by changing the value in the value field.

4. Select one of the following options for where you want to input bars:

● Start of Flow: Bars are input at the beginning of the flow.

● Start of Selection: Bars are input from the selected note or rest.

● End of Flow: Bars are input at the end of the flow.

NOTE

If you want to input bars from the caret position, make sure that you have selected Start 
of Selection from the menu.

5. Click Insert Bars.

RESULT
The number of bars specified is input. During note input, bars are input from the caret position.

If you selected Start of Selection, bars are input directly after a selected barline, and directly 
before a selected note, bar, or time signature.

TIP

Another way to add bars is by choosing a note duration, such as a whole note when in a 4/4 time 
signature, and pressing Space  repeatedly during note input.

RELATED LINKS
Notations toolbox on page 178
Bars on page 667
Inputting time signatures with the panel on page 263

Inputting bars/beats with the system track
You can insert bars/beats into existing music using the system track; for example, if you decide 
you want to repeat several bars before the next section. You can insert whole bars and just a few 
beats.

NOTE

You cannot use the system track during note input.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In the system track, select the region whose duration you want to insert.

For example, if you want to insert two bars, select two bars in the system track immediately 
before where you want the two new bars to be input.

2. Click Add above the system track.
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Add button above the system track The Add button is highlighted when you hover 
over it

RESULT
The rhythmic duration selected in the system track is added immediately after the end of the 
selection. Existing music after the selection is pushed back after the inserted bars/beats.

RELATED LINKS
System track on page 390
Hiding/Showing the system track on page 392
Selecting bars with the system track on page 392
Selecting beats with the system track on page 393

Inputting barlines with the popover
You can input barlines using the bars and barlines popover, both during note input and by 
adding them to existing music. You can also change the type of existing barlines.

PREREQUISITE
If you want to input barlines onto single staves only, you have input an independent time 
signature on those staves.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a barline. If you want to 
input a barline on a single staff, select an item that belongs to that staff only.

TIP

If you want to add repeat barlines at the start/end of a region simultaneously, select 
items that span the required duration.

2. Optional: If you want to input barlines onto multiple specific staves at once, extend the caret 
to those staves.

3. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

4. Enter the barline you want into the popover.

For example, enter || for a double barline, or |: for a start repeat barline.

5. Input the barline and close the popover in one of the following ways:

● To input a barline on all staves, press Return .

● To input a barline only on the selected staff or staves across which the caret extends, 
press Alt/Opt-Return .
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NOTE

You can only input barlines onto single staves that already have an independent time 
signature.

RESULT
During note input, barlines are input at the caret position.

When you add barlines to existing music, they are added at the rhythmic position of the earliest 
selected item. They appear to the right of clefs and to the left of other items. If you selected an 
existing barline, the new barline directly replaces the existing one.

When you add start repeat barlines with a range of items selected, end repeat barlines are also 
added at the end of the selection.

Surrounding music automatically adjusts to accommodate the barline. For example, note 
grouping, rests, and tied notes all adjust if necessary. Inputting final barlines at the end of the 
last bar of flows can automatically trim the flow if there is no further music and depending on the 
time signature.

NOTE

Normal barlines that you have input directly, such as to replace an existing double barline, 
are still considered explicit barlines and break multi-bar rests. Deleting barlines resets them 
completely.

RELATED LINKS
Bars and barlines popover on page 276
Barlines on page 672
Inputting notes on page 197
Inputting time signatures with the popover on page 262
Extending the caret to multiple staves on page 195
Deleting notes/items on page 412
Deleting bars/beats on page 667
Repeats in playback on page 463
Changing the number of playthroughs at repeat barlines on page 464

Inputting barlines with the panel
You can input barlines using the Bars and Barlines panel, both during note input and by adding 
them to existing music. You can also change the type of existing barlines.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PREREQUISITE
If you want to input barlines onto single staves only, you have input an independent time 
signature on those staves.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select an item at the rhythmic position where you want to input a barline. If you want to 
input a barline on a single staff, select an item that belongs to that staff only.

TIP

If you want to add repeat barlines at the start/end of a region simultaneously, select 
items that span the required duration.

2. In the Notations toolbox, click Panels , then Bars and Barlines  to show the Bars and 
Barlines panel.

3. Input the barline you want in one of the following ways:

● To input a barline on all staves, click it in the Create Barline section.

● To input a barline on the selected staff only, Alt/Opt -click it in the Create Barline 
section.

NOTE

You can only input barlines onto single staves that already have an independent time 
signature.

RESULT
During note input, barlines are input at the caret position.

When you add barlines to existing music, they are added at the rhythmic position of the earliest 
selected item. They appear to the right of clefs and to the left of other items. If you selected an 
existing barline, the new barline directly replaces the existing one.

When you add start repeat barlines with a range of items selected, end repeat barlines are also 
added at the end of the selection.

Surrounding music automatically adjusts to accommodate the barline. For example, note 
grouping, rests, and tied notes all adjust if necessary. Inputting final barlines at the end of the 
last bar of flows can automatically trim the flow if there is no further music and depending on the 
time signature.

NOTE

Normal barlines that you have input directly, such as to replace an existing double barline, 
are still considered explicit barlines and break multi-bar rests. Deleting barlines resets them 
completely.

RELATED LINKS
Notations toolbox on page 178
Barlines on page 672
Bars and barlines popover on page 276
Inputting notes on page 197
Inputting time signatures with the panel on page 263
Changing your mouse input settings on page 189
Repeats in playback on page 463
Changing the number of playthroughs at repeat barlines on page 464
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Input methods for dynamics
You can input dynamics with the keyboard by using the dynamics popover, and with the mouse 
by using the Dynamics panel.

You can also input dynamic points that affect playback, but do not appear in the music, in the 
Dynamics editor.

RELATED LINKS
Dynamics on page 746
Inputting dynamics with the popover on page 287
Inputting dynamics with the panel on page 290
Niente markings on page 763
Adding modifiers to existing dynamics on page 755
Dynamics editor on page 590

Dynamics popover
The table contains examples of what you can enter into the dynamics popover to input the 
different dynamics available.

You can open the dynamics popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-D .

● In the Notations toolbox, click Popovers , then Dynamics .

● Select an existing dynamic and press Return .

● Choose Write > Create Dynamic.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Dynamics popover with an example entry
Dynamics button in the Notations toolbox

Dynamics popover entries

Dynamic or modifier Popover entry

pianissimo:  pp

piano:  p

mezzo piano:  mp

mezzo forte:  mf

forte:  f

fortissimo:  ff
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Dynamic or modifier Popover entry

fortepiano without separator:  fp

fortepiano with separator, such as - f-p, f:p, or f/p

subito subito, sub, or sub.

possibile possibile, poss, or poss.

poco poco

molto molto

più piu or più

meno meno

mosso mosso

crescendo:  <

cresc. (text) cresc

diminuendo:  >

dim. (text) dim

messa di voce hairpin:  (crescendo then 
diminuendo)

<>

messa di voce hairpin:  (diminuendo then 
crescendo)

><

A pair of grouped hairpins that looks like a 
messa di voce hairpin

NOTE

You must separate hairpins with a space.

< > or > <

niente hairpins that start/end with a small circle o< or >o

niente hairpins that start/end with the letter “n” n< or >n

sforzando:  sfz

rinforzando:  rfz
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This list is not comprehensive as you can enter anything as a dynamic modifier. It is intended to 
illustrate how you can structure your entry to input different types of dynamics.

NOTE

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

● You can input hairpins and messa di voce hairpins directly, without using the popover.

● For a crescendo hairpin, press < .

● For a diminuendo hairpin, press > .

● For a crescendo/diminuendo messa di voce hairpin, press Shift-Alt/Opt-, .

● For a diminuendo/crescendo messa di voce hairpin, press Shift-Alt/Opt-. .

● You can also change the appearance of individual gradual dynamics after they have been 
input.

Inputting modifiers into the dynamics popover

You can enter modifiers into the dynamics popover, such as poco, molto, subito, espressivo, or 
dolce. It appears in the correct italic font beside the dynamic. However, you must also enter 
an accompanying immediate dynamic, such as p or f, and separate the two with a space; for 
example, f molto or p espressivo.

You can hide immediate dynamics if you only want to show the modifier.

RELATED LINKS
Notations toolbox on page 178
Dynamics on page 746
Dynamic modifiers on page 754
Gradual dynamics on page 757
Messa di voce hairpins on page 761
Niente markings on page 763
Groups of dynamics on page 765
Hiding/Showing immediate dynamics on page 752
Changing the appearance of gradual dynamics on page 758
Hiding/Showing combined dynamic separators on page 752
Changing the appearance of sforzando/rinforzando dynamics on page 753
Changing the appearance/position of subito modifiers on page 756

Dynamics panel
The Dynamics panel contains the different dynamics available in Dorico SE, including gradual 
dynamics and dynamic modifiers, such as poco and possibile. It is located in the right zone in 
Write mode.

● You can hide/show the Dynamics panel by clicking Panels , then Dynamics  in the 
Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Dynamics panel contains the following sections:

Immediate Dynamics
Contains dynamics such as  and , and modifiers, such as subito and possibile. 
Available modifiers are shown at the top of the section in boxes.
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You can only input modifiers alongside a dynamic.

Gradual Dynamics
Contains dynamics such as  and , and modifiers, such as poco and niente. Available 
modifiers are shown at the top of the section in boxes.

You can only input modifiers alongside a dynamic.

NOTE

Pairs of separate hairpins are treated differently than messa di voce hairpins. For 
example, separate hairpins each have start and end handles in Write mode, whereas 
messa di voce hairpins share a single center handle.

Force/Intensity of Attack
Contains dynamics such as  and .

Combined Dynamics
Allows you to create custom combinations of dynamics, such as . The controls 
allow you to increase and decrease the dynamic on each side, and to swap their order.

RELATED LINKS
Notations toolbox on page 178
Dynamics on page 746
Dynamic modifiers on page 754
Gradual dynamics on page 757
Messa di voce hairpins on page 761
Niente markings on page 763
Hiding/Showing combined dynamic separators on page 752

Inputting dynamics with the popover
You can input dynamics and modifiers using the dynamics popover, both during note input 
and by adding them to existing music. You can also input different dynamics into each voice 
independently in multiple-voice contexts; for example, to give the separate staves of grand staff 
instruments different dynamics.

TIP

● If you want to input dynamics in the middle of tie chains, start note input, then move the 
caret to the required rhythmic position.

● You can also change dynamics during note input by following these steps when the caret is 
at the rhythmic position of the dynamic you want to change.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

NOTE

If you want to input voice-specific dynamics, the caret must be active.

● Select an item on each staff and at the rhythmic position where you want to input 
dynamics. If you want to input dynamics across a duration, select items on the staff that 
span that duration.

2. Optional: If you want to input notes and dynamics onto multiple staves at once, extend the 
caret to those staves.

3. Open the dynamics popover in any of the following ways:

● Press Shift-D .

● In the Notations toolbox, click Popovers , then Dynamics .

4. Enter the dynamic you want into the popover.

For example, p, p<f>p, or f>.

5. Input the dynamics and close the popover in one of the following ways:

● To input the dynamics for all voices/staves belonging to the instrument, press Return .

● During note input, input the dynamics only into the voice indicated by the caret indicator 
by pressing Alt/Opt-Return .

6. Optional: During note input, advance the caret and extend open-ended gradual dynamics, 
such as p<, in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

Open-ended gradual dynamics also extend automatically as you continue inputting notes.

7. Optional: During note input, stop open-ended dynamics in any of the following ways:

● Press ? .

● Open the dynamics popover and input an immediate dynamic, such as f.

RESULT
The specified dynamics are input. Unless you input voice-specific dynamics, dynamics apply to 
all voices on all staves belonging to a single instrument, including grand staff instruments. Voice-
specific dynamics are placed on the default side of the staff for the instrument type, regardless of 
the voice’s stem direction.

Adjoining dynamics, or dynamics that were input together or in sequence, are automatically 
grouped together, both during note input and when adding dynamics to existing music.

During note input, dynamics are input at the caret position, and extend automatically if 
you included an open-ended gradual dynamic. Voice-specific dynamics are input in the voice 
indicated by the quarter note symbol beside the caret.

Outside of note input, immediate dynamics are added to the first selected item on each selected 
staff, while gradual dynamics are added across each selection on each selected staff.
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NOTE

● If you entered a dynamic phrase into the popover during note input, such as p<f>p, each 
gradual dynamic lasts a quarter note (crotchet). You can lengthen/shorten gradual dynamics 
and groups of dynamics later.

● Some modifiers, such as molto, appear before immediate dynamics rather than after them, 
even if you do not enter them in that order. This follows the generally accepted practice for 
the placement of that text.

You can add modifiers before and after existing dynamics. You can also hide immediate 
dynamics later if you only want to show the modifier.

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

● You can input hairpins and messa di voce hairpins directly, without using the popover.

● For a crescendo hairpin, press < .

● For a diminuendo hairpin, press > .

● For a crescendo/diminuendo messa di voce hairpin, press Shift-Alt/Opt-, .

● For a diminuendo/crescendo messa di voce hairpin, press Shift-Alt/Opt-. .

AFTER COMPLETING THIS TASK
You can move dynamics within dynamic phrases and change the placement of dynamics relative 
to the staff.

RELATED LINKS
Caret on page 191
Moving the caret manually on page 196
Extending the caret to multiple staves on page 195
Dynamics on page 746
Voice-specific dynamics on page 754
Notations toolbox on page 178
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186
Dynamics editor on page 590
Gradual dynamics on page 757
Messa di voce hairpins on page 761
Niente markings on page 763
Changing the appearance of gradual dynamics on page 758
Adding niente markings to existing gradual dynamics on page 764
Groups of dynamics on page 765
Dynamic modifiers on page 754
Changing the appearance/position of subito modifiers on page 756
Hiding/Showing combined dynamic separators on page 752
Changing dynamic levels on page 751
Moving notes/items rhythmically on page 417
Lengthening/Shortening items on page 396
Hiding/Showing immediate dynamics on page 752
Changing the staff-relative placement of items on page 400
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Inputting dynamics with the panel
You can input dynamics and modifiers using the Dynamics panel, both during note input 
and by adding them to existing music. You can also input different dynamics into each voice 
independently in multiple-voice contexts; for example, to give the separate staves of grand staff 
instruments different dynamics.

NOTE

● If you want to input dynamics in the middle of tie chains, start note input, then move the 
caret to the required rhythmic position.

● You can also change dynamics during note input by following these steps when the caret is 
at the rhythmic position of the dynamic you want to change.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

NOTE

If you want to input voice-specific dynamics, the caret must be active.

● Select an item on each staff and at the rhythmic position where you want to input 
dynamics. If you want to input dynamics across a duration, select items on the staff that 
span that duration.

2. In the Notations toolbox, click Panels , then Dynamics  to show the Dynamics panel.

3. Input the dynamics you want in one of the following ways:

● To input dynamics for all voices/staves belonging to the instrument, click them in the 
Dynamics panel.

● During note input, input the dynamics only into the voice indicated by the caret indicator 
by Alt/Opt -clicking them in the Dynamics panel.

NOTE

● If you want to add expressive or qualifying text to the dynamics, do not deselect them.

● When inputting voice-specific dynamics, you can release Alt/Opt  once you have input 
the dynamic level, such as .

● Gradual dynamics have a default duration of a quarter note. You can lengthen/shorten 
gradual dynamics later.

4. Optional: In the Dynamics panel, click the expressive/qualifying texts you want in the 
Immediate Dynamics and Gradual Dynamics sections.

RESULT
The specified dynamics are input. Unless you input voice-specific dynamics, dynamics apply to 
all voices on all staves belonging to a single instrument, including grand staff instruments. Voice-
specific dynamics are placed on the default side of the staff for the instrument type, regardless of 
the voice’s stem direction.

Adjoining dynamics, or dynamics that were input together or in sequence, are automatically 
grouped together, both during note input and when adding dynamics to existing music.
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During note input, dynamics are input at the caret position. Gradual dynamics are input with a 
default duration of a quarter note. Voice-specific dynamics are input in the voice indicated by the 
quarter note symbol beside the caret.

Outside of note input, immediate dynamics are added to the first selected item on each selected 
staff, while gradual dynamics are added across each selection on each selected staff.

NOTE

● Some modifiers, such as molto, appear before immediate dynamics rather than after them, 
even if you do not enter them in that order. This follows the generally accepted practice for 
the placement of that text.

You can add modifiers before and after existing dynamics. You can also hide immediate 
dynamics later if you only want to show the modifier.

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

● You can also input gradual dynamics by clicking the gradual dynamic you want in the 
Dynamics panel when nothing is selected in the music area. Then click and drag to input 
the gradual dynamic and extend it to the length you want.

AFTER COMPLETING THIS TASK
You can move dynamics within dynamic phrases and change the placement of dynamics relative 
to the staff.

RELATED LINKS
Notations toolbox on page 178
Caret on page 191
Moving the caret manually on page 196
Dynamics on page 746
Voices on page 1134
Changing the appearance of sforzando/rinforzando dynamics on page 753
Hiding/Showing combined dynamic separators on page 752
Changing dynamic levels on page 751
Hiding/Showing immediate dynamics on page 752
Changing your mouse input settings on page 189

Inputting chord symbols
You can input chord symbols using the chord symbols popover with the computer keyboard and 
any connected MIDI keyboard, both for all instruments or only for individual instruments. You 
can also open the chord symbols popover during note input; however, inputting a chord symbol 
stops note input.

PREREQUISITE
If you want to input chord symbols using a MIDI device, you have connected the MIDI device you 
want to use.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input a chord symbol.

2. Open the chord symbols popover in any of the following ways:

● Press Shift-Q .
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● In the Notations toolbox, click Popovers , then Chord Symbols .

NOTE

If you selected an item on a staff that has local chord symbols at earlier rhythmic positions, 
the chord symbols popover is automatically set to input local chord symbols when it opens.

3. Optional: Change the type of chord symbol you want to enter in one of the following ways:

● To input local chord symbols, press Alt/Opt-L .

● To input global chord symbols, press Alt/Opt-G .

The popover icon updates to show the current type.

Chord symbols popover when inputting a global 
chord symbol

Chord symbols popover when inputting a local 
chord symbol

4. Enter the chord symbol you want into the chord symbols popover in any of the following 
ways:

● Enter the appropriate letters and numbers using the computer keyboard. For example, 
enter D#sus4 for a D#sus4 chord symbol or CM7|D for a Cmaj7/D polychord chord 
symbol.

● Play the chord in the Keyboard panel.

● Play the chord using a MIDI keyboard.

TIP

● To input a polychord chord symbol, play the first chord and keep the keys 
depressed, then play the second chord.

● To input a chord symbol that consists only of the root note, just play a single note.

● You can indicate root notes in any of the following ways:

● First play the root with one finger, and then play the remaining notes of the 
chord while still holding down the root.

● Play all the notes of the chord together, then release them all, then replay the 
root note.

● You can indicate altered bass notes in any of the following ways:

● Play all notes of the chord together with the altered bass note at the bottom.

● Play the chord and its altered bass note separately: Hold down the keys for the 
chord, then play the altered bass note while keeping the rest of the keys of the 
chord depressed.

5. Optional: Press Space  to advance the popover to the next beat according to the prevailing 
time signature.

TIP

You can also navigate the popover forwards and backwards by different amounts.

6. Optional: To input an individual local chord symbol when the popover is set to global, and 
vice versa, press Alt/Opt-Return  to input the chord symbol.
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7. Press Return  to close the popover.

RESULT
The chord symbol specified is input. If you selected an item belonging to an instrument that 
was not already set to show chord symbols in the current layout, the corresponding player is 
automatically updated to show chord symbols for all instruments.

Global chord symbols apply to all instruments in the project and appear on all staves set to show 
chord symbols. Local chord symbols only apply to the selected instrument. Local chord symbols 
always appear, even if global chord symbols exist at the same rhythmic positions.

NOTE

● The chord symbol may look different to what you entered into the popover because Dorico 
SE provides a single default chord symbol appearance preset that applies to all chord 
symbols.

● When you input chord symbols using a MIDI keyboard, the voicing you used is retained 
for chord symbol playback. You can reset the voicing of chord symbols input using MIDI 
keyboards.

AFTER COMPLETING THIS TASK
You can hide/show chord symbols above specific staves and hide/show chord diagrams 
alongside them.

RELATED LINKS
Notations toolbox on page 178
Keyboard panel on page 183
Chord symbols on page 713
Hiding/Showing chord symbols on page 714
Hiding/Showing chord symbols in layouts on page 716
Hiding/Showing chord diagrams on page 728
Inputting chord symbol regions on page 299
Inputting slash regions on page 384
Enabling/Disabling MIDI input devices on page 246
Chords track on page 452
Enabling chord symbol playback on page 453
Resetting the voicing of chord symbols on page 454

Chord symbols popover
The following tables contain examples of what you can enter into the chord symbols popover to 
input the different possible chord symbol components. You can enter them in any combination.

You can open the chord symbols popover in Write mode in any of the following ways when either 
an item is selected or the caret is active:

● Press Shift-Q .

● In the Notations toolbox, click Popovers , then Chord Symbols .

● Select an existing chord symbol and press Return .

● Choose Write > Create Chord Symbol.

When inputting global chord symbols, the icon on the left-hand side of the popover matches the 
corresponding button in the Notations toolbox. When inputting local chord symbols, the icon on 
the left-hand side of the popover appears smaller and includes the icon for a single player.
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Chord symbols popover with an 
example entry for a global chord 
symbol

Chord symbols popover with an 
example entry for a local chord 
symbol

Chord Symbols button in the 
Notations toolbox

NOTE

You can combine multiple types of entries to create more complex chord symbols if you enter 
them one after another into the chord symbols popover without spaces between them. For 
example, enter Eblocrian for the following chord symbol:

Chord symbol roots

Type of chord symbol root Popover entry

English note names

C, D♭, F♯, B, and so on

C, Db, F#, B, and so on

German note names

C, D♭, F♯, H, and so on

C, Des, Fis, H, and so on

Fixed-do solfège

C, D♭, F, F♯, B, and so on

do, reb, fa, fa#, ti, and so on

Nashville numbers representing scale degrees

Assuming C major:

C, D♭, F♯, B, and so on

1, 2b, 4#, 7, and so on

TIP

When using a MIDI keyboard, you can also indicate root notes in any of the following ways:

● First play the root with one finger, and then play the remaining notes of the chord while still 
holding down the root.

● Play all the notes of the chord together, then release them all, then replay the root note.

Chord symbol qualities

Chord symbol quality Popover entry

Major maj, M, ma, or nothing after entering the root.

Minor m, min, or mi
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Chord symbol quality Popover entry

Diminished dim, di, or o

Augmented aug, au, ag, or +

Half-diminished half-dim, halfdim, or hd

6/9 6/9, 69, or %

NOTE

M and m entries for major and minor are case-sensitive.

Chord symbol intervals

Interval Popover entry

Major 7th ^7 or ^

Major 9th ^9, maj9, or 9maj7

Chord symbol alterations

Type of chord symbol alteration Popover entry

Alterations b5, -5, #9, +9, b10, and so on

Added notes add#11, add+11, addb9, add-9, addF#, 
addBb, and so on

Suspensions sus4, sus9, and so on

Omissions omit3, no7, and so on

Chord symbols with altered bass notes

Example altered bass note chord symbols Popover entry

G7/D G7/D, G7,D, Gmaj7/D or Gmaj7,D

C(♭5)/E♭ CMb5/Eb, CMb5,Eb, Cmajb5/Eb, or Cmajb5,Eb

Fm/D♯ Fm/D#, Fm,D#, Fmi/D#, or Fmi,D#
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TIP

When using a MIDI keyboard, you can also indicate altered bass notes in any of the following 
ways:

● Play all notes of the chord together with the altered bass note at the bottom.

● Play the chord and its altered bass note separately: Hold down the keys for the chord, then 
play the altered bass note while keeping the rest of the keys of the chord depressed.

Polychord chord symbols

Example polychord chord symbols Popover entry

G/E G|E, G;E, Gmaj|E, or Gmaj;E

Cmaj7/D CM7|D, CM7;D, Cmaj7|D, or Cmaj7;D

Fm/D♯ Fm|D#, Fm;D#, Fmi|D#, or Fmi;D#

TIP

When using a MIDI keyboard, you can also input polychord symbols by playing the first chord 
and keeping the keys depressed, then playing the second chord.

No chord symbols

No chord symbol Popover entry

No chord N.C., NC, no chord, or none

Modal chord symbols

Modal chord symbol Popover entry

Ionian ionian

Dorian dorian

Phrygian phrygian

Lydian lydian

Mixolydian mixolydian

Aeolian aeolian

Locrian locrian

Write mode
Notations input 

296
Dorico SE 4.3.30



Modal chord symbol Popover entry

Melodic minor melodicminor

Harmonic minor harmonicminor

Whole tone wholetone

Half-whole diminished or octatonic diminishedhalfwhole, 
diminishedsemitonetone, 
octatonichalfwhole, or 
octatonicsemitonetone

Whole-half diminished or octatonic diminishedwholehalf, 
diminishedtonesemitone, 
octatonicwholehalf, or 
octatonictonesemitone

This list is not comprehensive, as there are many possible chord symbols. It is intended to 
illustrate the different components you can use to input different chord symbols.

NOTE

The appearance of the resulting chord symbols is determined by Dorico SE’s default settings. The 
structure of your entry in the chord symbols popover is not considered. For example, entering a 
C major chord as C, Cmaj, or CM results in the same chord symbol.

Parenthesized chord symbols

Example parenthesized chord symbol Popover entry

(Cmaj7) (Cmaj7)

Chord symbol regions

Chord symbol region Popover entry

New chord symbol region reg

RELATED LINKS
Notations toolbox on page 178
Chord symbols on page 713
Parenthesized chord symbols on page 723
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Navigation during chord symbol input

You can move the chord symbols popover manually by different amounts to input chord symbols 
at other positions without closing and reopening the popover each time.

Navigating with a computer keyboard

Popover navigation Key command

Advance the popover to the next beat, 
according to the prevailing time signature.

Space

Move the popover back to the previous beat, 
according to the prevailing time signature.

Shift-Space

Advance the popover to the start of the next 
bar.

Tab

Move the popover back to the start of the 
previous bar.

Shift-Tab

Move the cursor and popover to one of the 
following positions, whichever is closest:

● Next/Previous note or rest

● Next/Previous rhythmic grid position

● Next/Previous character in existing chord 
symbol’s entry

Right Arrow / Left Arrow

Move the popover to the next/previous chord 
symbol.

Ctrl/Cmd-Right Arrow / Ctrl/Cmd-Left Arrow

Navigating with a MIDI keyboard

When inputting chord symbols using a MIDI keyboard, by default the popover advances 
automatically to the next beat after you play a chord.

You can define specific keys or buttons on your MIDI keyboard to trigger different navigation 
behaviors. Use the MIDI Learn button on the Key Commands page in Preferences to assign 
specific keys to the Note Input > Advance Chord Symbol Input commands.

RELATED LINKS
Key Commands page in the Preferences dialog on page 54
Assigning MIDI commands on page 58
Assigning key commands on page 58
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Inputting chord symbol regions
You can input specific regions in which you want to show chord symbols; for example, if an 
instrument that does not need chord symbols for most of the project has an improvisation 
section that requires chord symbols to be shown.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the region on the staff where you want to show chord symbols.

2. Open the chord symbols popover in any of the following ways:

● Press Shift-Q .

● In the Notations toolbox, click Popovers , then Chord Symbols .

3. Enter reg into the popover.

4. Press Return  to close the popover.

RESULT
During note input, chord symbol regions are input spanning the duration of the selected note or 
item, which is usually the last input note. When adding chord symbol regions to existing music, 
they span the selected duration.

The player holding the corresponding instrument is automatically set to show chord symbols in 
chord symbol regions and slash regions, even if it was set to hide all chord symbols before.

TIP

You can also input chord symbol regions by choosing Write > Create Chord Symbol Region. You 
can assign a key command for this option on the Key Commands page in Preferences.

RELATED LINKS
Chord symbols popover on page 293
Chord symbol regions on page 718
Hiding/Showing chord symbols on page 714
Inputting slash regions on page 384
Key Commands page in the Preferences dialog on page 54

Input methods for clefs and octave lines
You can input clefs and octave lines with the keyboard by using the clefs and octave lines 
popover, and also with the mouse by using the Clefs panel.

Clefs and octave lines share the same popover and panel as both affect the pitch and register of 
notes.

RELATED LINKS
Clefs on page 738
Octave lines on page 742
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Clefs and octave lines popover
The following tables contain the entries for the clefs and octave lines popover that you can use to 
input the different clefs and octave lines available.

You can open the clefs and octave lines popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-C .

● In the Notations toolbox, click Popovers , then Clefs .

● Select an existing clef or octave line and press Return .

● Choose Write > Create Clef.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Clefs and octave lines popover 
with an example entry for a clef

Clefs and octave lines popover 
with an example entry for an 
octave line

Clefs button in the Notations 
toolbox

Clefs

Type of clef Popover entry

Treble G clef g, G, g2, sol, or treble

Bass F clef f, F, f4, fa, or bass

Tenor C clef ct, CT, c4, ut4, or tenor

Alto C clef ca, CA, c3, ut3, or alto

Treble G clef, octave below g8ba, G8ba, g8d, G8d, treble8ba, or treble8d

Unpitched percussion perc

4-string tablature tab4

6-string tablature tab6

TIP

The rectangular percussion clef is available in the Clefs panel.
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Octave shifts for clefs

Function of octave shifts Popover entry

Shift notes up by one octave +1

Shift notes up by two octaves +2

Shift notes down by one octave -1

Shift notes down by two octaves -2

Set octave shift for concert pitch c

Set octave shift for transposed pitch t

For example, enter treble+1t for a treble clef shifted up one octave in transposed pitch layouts, 
causing notes after the clef in transposed pitch layouts to appear an octave lower than they 
appear with a normal treble clef.

Octave lines

Function of octave line Popover entry

Shift notes up by one octave 8va, 8, 8u, or 1u

Shift notes up by two octaves 15ma, 15, 15u, or 2u

Shift notes up by three octaves 22ma, 22, 22u, or 3u

Shift notes down by one octave 8ba, 8vb, 8d, or 1d

Shift notes down by two octaves 15ba, 15vb, 15d, or 2d

Shift notes down by three octaves 22ba, 22vb, 22d, or 3d

Loco indication loco

End of octave line

For example, enter stop to specify where an 
octave line ends during note input.

| or stop

RELATED LINKS
Notations toolbox on page 178
Clefs on page 738
Octave lines on page 742
Changing the octave of clefs on page 740

Write mode
Notations input 

301
Dorico SE 4.3.30



Clefs panel
The Clefs panel contains the different types of clefs and octave lines available in Dorico SE. It is 
located in the right zone in Write mode.

● You can hide/show the Clefs panel by clicking Panels , then Clefs  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Clefs panel contains the following sections:

Common Clefs
Contains the clefs you are most likely to need, including treble clef and bass clef.

Octave Lines
Contains octave lines, indicating up to three octaves above and below, and a loco line.

RELATED LINKS
Notations toolbox on page 178
Clefs on page 738
Octave lines on page 742
Inputting clefs with the panel on page 303
Inputting octave lines with the panel on page 305

Inputting clefs with the popover
You can input clefs using the clefs and octave lines popover, both during note input and by 
adding them to existing music. You can also use the popover to change the type of existing clefs.

NOTE

● If you do not want to show any clef in any layout, you must input an invisible clef. You can 
also hide/show clefs according to the layout transposition.

● Many instruments in Dorico SE have different types that show alternative clefs by default. 
You can select the appropriate instrument type from the instrument picker when adding or 
changing instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a clef. If 
you want to add a restorative clef at a later position, select items on the staff that span 
the required duration.

2. Optional: If you want to input clefs onto multiple staves at once, extend the caret to those 
staves.

3. Open the clefs and octave lines popover in any of the following ways:

● Press Shift-C .

● In the Notations toolbox, click Popovers , then Clefs .

4. Enter the appropriate entry for the clef you want into the popover.

For example, enter bass for a bass clef, alto for an alto clef, or treble+1t for a treble clef 
shifted up one octave in transposed pitch layouts.
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5. Press Return  to close the popover.

RESULT
During note input, clefs are input at the caret position. Note input continues after inputting the 
clef, so you can continue inputting notes and clefs as required.

When you add clefs to existing music, clefs are added directly before a selected notehead, and 
apply to all notes on that staff until the next clef, or the end of the flow. When you add clefs to a 
range of selected items, restorative clefs are also added at the end of the selection.

Clefs apply to all notes on the staff until the next clef or the end of the flow, whichever comes 
first.

RELATED LINKS
Clefs on page 738
Extending the caret to multiple staves on page 195
Hiding/Showing clefs according to layout transpositions on page 739
Changing the octave of clefs on page 740
Changing instruments on page 122
Adding instruments to players on page 120

Inputting clefs with the panel
You can input clefs using the Clefs panel, both during note input and by adding them to existing 
music.

NOTE

● If you do not want to show any clef in any layout, you must input an invisible clef. You can 
also hide/show clefs according to the layout transposition.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Many instruments in Dorico SE have different types that show alternative clefs by default. 
You can select the appropriate instrument type from the instrument picker when adding or 
changing instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a clef. If 
you want to add a restorative clef at a later position, select items on the staff that span 
the required duration.

2. In the Notations toolbox, click Panels , then Clefs  to show the Clefs panel.

3. In the Clefs panel, click the clef you want.

RESULT
During note input, clefs are input at the caret position. Note input continues after inputting the 
clef, so you can continue inputting notes and clefs as required.

When you add clefs to existing music, clefs are added directly before a selected notehead, and 
apply to all notes on that staff until the next clef, or the end of the flow. When you add clefs to a 
range of selected items, restorative clefs are also added at the end of the selection.
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Clefs apply to all notes on the staff until the next clef or the end of the flow, whichever comes 
first.

RELATED LINKS
Notations toolbox on page 178
Clefs on page 738
Changing your mouse input settings on page 189
Universal Indian Drum Notation on page 1133

Inputting octave lines with the popover
You can input octave lines using the clefs and octave lines popover, both during note input and 
by adding them to existing music. You can also input octave lines only into specific voices in 
multiple-voice contexts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add an octave line. If you want to add an octave 
line for a single voice, only select notes in that voice.

2. Optional: If you want to input octave lines onto multiple staves at once, extend the caret to 
those staves.

3. Open the clefs and octave lines popover in any of the following ways:

● Press Shift-C .

● In the Notations toolbox, click Popovers , then Clefs .

4. Enter the appropriate entry for the octave line you want into the popover.

For example, enter 8va for an octave line that shifts notes up one octave.

5. Input the octave line and close the popover in one of the following ways:

● To input an octave line for all voices on the staff, press Return .

● To input an octave line only for the currently selected voice, press Alt/Opt-Return .

6. Optional: During note input, advance the caret and extend the octave line in any of the 
following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

The octave line also extends automatically as you continue inputting notes.

7. Optional: During note input, stop any octave line by opening the clefs and octave lines 
popover again and entering | or stop.

RESULT
During note input, octave lines are input from the caret position. When you stop octave lines, 
they end at the caret position.

When adding octave lines to existing music, they are input either above or below your selection, 
depending on whether the octave line indicates that notes are played higher or lower than 
notated.

The pitches of notes within octave lines are adjusted automatically. For example, notes within 
octave above lines appear an octave lower than they do without the octave above line.
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TIP

You can also lengthen/shorten octave lines after they have been input.

RELATED LINKS
Clefs and octave lines popover on page 300
Octave lines on page 742
Lengthening/Shortening items on page 396
Changing the pitch of individual notes on page 424
Extending the caret to multiple staves on page 195
Notations toolbox on page 178
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186

Inputting octave lines with the panel
You can input octave lines using the Clefs panel, both during note input and by adding them to 
existing music. You can also input octave lines only into specific voices in multiple-voice contexts.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add an octave line. If you want to add an octave 
line for a single voice, only select notes in that voice.

2. In the Notations toolbox, click Panels , then Clefs  to show the Clefs panel.

3. Input the octave line you want in one of the following ways:

● To input an octave line for all voices on the staff, click it in the Octave Lines section.

● To input an octave line only for the currently selected voice, Alt/Opt -click it in the 
Octave Lines section.

Alternatively, when adding octave lines to existing music, you can click the octave line you 
want in the Clefs panel first, and then click and drag it to the length you want.

RESULT
During note input, octave lines are input at the caret position. They are input with a default 
duration of a quarter note.

When adding octave lines to existing music, they are input either above or below your selection, 
depending on whether the octave line indicates that notes are played higher or lower than 
notated.

The pitches of notes within octave lines are adjusted automatically. For example, notes within 
octave above lines appear an octave lower than they do without the octave above line.
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TIP

You can also lengthen/shorten octave lines after they have been input.

RELATED LINKS
Notations toolbox on page 178
Octave lines on page 742
Lengthening/Shortening items on page 396
Changing the pitch of individual notes on page 424
Changing your mouse input settings on page 189

Input methods for holds and pauses
You can input holds and pauses with the keyboard by using the holds and pauses popover in 
Write mode, and with the mouse by using the Holds and Pauses panel.

RELATED LINKS
Holds and pauses on page 809
Correct positioning for caesura input on page 310

Holds and pauses popover
The table contains the entries for the holds and pauses popover that you can use to input the 
different holds and pauses available.

You can open the holds and pauses popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-H .

● In the Notations toolbox, click Popovers , then Holds and Pauses .

● Select an existing hold or pause and press Return .

● Choose Write > Create Hold or Pause.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Holds and pauses popover with an example entry
Holds and Pauses button in the Notations toolbox

Fermatas

Type of fermata Popover entry

Fermata fer or fermata

Very long fermata fermataverylong

Long fermata fermatalong
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Type of fermata Popover entry

Short fermata fermatashort

Very short fermata fermataveryshort

Short fermata (Henze) fermatashorthenze

Long fermata (Henze) fermatalonghenze

Curlew (Britten) curlew

NOTE

The Curlew mark was originally devised by Benjamin Britten for “Curlew River”, a parable for 
church performance inspired by Japanese Noh theater. It indicates that a player should hold a 
note or a rest until a synchronization point in asynchronous music.

Caesuras

Type of caesura Popover entry

Caesura caes, caesura, or //

Thick caesura caesurathick, thickcaesura, or thick//

Curved caesura caesuracurved, curvedcaesura, or curved//

Short caesura caesurashort, shortcaesura, or short//

Single-stroke caesura caesurasingle, singlecaesura, or single//

Breath marks

Type of breath mark Popover entry

Breath mark (Comma-like) breathmarkcomma, comma, or , (comma)

Breath mark (Tick-like) breathmarktick

Breath mark (Upbow-like) breathmarkupbow

Breath mark (Salzedo) breathmarksalzedo

RELATED LINKS
Notations toolbox on page 178
Holds and pauses on page 809
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Types of fermatas on page 810
Types of caesuras on page 811
Types of breath marks on page 811

Holds and Pauses panel
The Holds and Pauses panel allows you to input all the different types of holds and pauses 
available in Dorico SE, including alternative versions of fermatas. It is located in the right zone in 
Write mode.

● You can hide/show the Holds and Pauses panel by clicking Panels , then Holds and 
Pauses  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Holds and Pauses panel contains the following sections:

● Fermatas

● Breath Marks

● Caesuras

NOTE

Holds and pauses do not currently have an effect in playback, but this is planned for future 
versions.

RELATED LINKS
Notations toolbox on page 178
Inputting holds and pauses with the panel on page 309
Holds and pauses on page 809
Types of fermatas on page 810
Types of caesuras on page 811
Types of breath marks on page 811

Inputting holds and pauses with the popover
You can input holds and pauses using the holds and pauses popover, both during note input and 
by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a hold or pause. If you 
want to input a breath mark on a specific staff, select an item that belongs to that staff 
only.

NOTE

You can only input one hold or pause at a time.

2. Optional: If you want to input breath marks onto multiple staves at once, extend the caret to 
those staves.

3. Open the holds and pauses popover in any of the following ways:

● Press Shift-H .
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● In the Notations toolbox, click Popovers , then Holds and Pauses .

4. Enter the hold or pause you want into the popover.

For example, enter fermata for a pause or caesura for a caesura.

5. Press Return  to close the popover.

RESULT
During note input, the specified hold or pause is input at the caret position. When adding holds 
or pauses to existing music, they are input at the rhythmic position of the earliest selected item.

● Fermatas appear on all staves at the rhythmic position of the note, chord, or rest that 
corresponds with the end of the fermata.

● Breath marks appear to the right of the caret or selected note.

● Caesuras appear on all staves to the left of the caret or selected note.

RELATED LINKS
Extending the caret to multiple staves on page 195
Holds and pauses on page 809
Types of fermatas on page 810
Types of breath marks on page 811
Types of caesuras on page 811
Positions of holds and pauses on page 811

Inputting holds and pauses with the panel
You can input holds and pauses using the Holds and Pauses panel, both during note input and 
by adding them to existing music.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a hold or pause. If you 
want to input a breath mark on a specific staff, select an item that belongs to that staff 
only.

NOTE

You can only input one hold or pause at a time.

2. In the Notations toolbox, click Panels , then Holds and Pauses  to show the Holds and 
Pauses panel.

3. In the Holds and Pauses panel, click the hold or pause you want.

RESULT
During note input, the specified hold or pause is input at the caret position. When adding holds 
or pauses to existing music, they are input at the rhythmic position of the earliest selected item.
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● Fermatas appear on all staves at the rhythmic position of the note, chord, or rest that 
corresponds with the end of the fermata.

● Breath marks appear to the right of the caret or selected note.

● Caesuras appear on all staves to the left of the caret or selected note.

RELATED LINKS
Notations toolbox on page 178
Holds and pauses on page 809
Positions of holds and pauses on page 811
Changing your mouse input settings on page 189

Correct positioning for caesura input
Caesuras are commonly placed at the end of a bar, before a barline. In Dorico SE, caesuras must 
be attached to the note immediately after the position where you want it to appear, as then 
Dorico SE can automatically position them correctly.

If you input caesuras with your mouse input preference set to Load pointer with item, you must 
click the first note in the next bar for a caesura to appear to the left of the barline. You can also 
click directly on the barline.

A correctly input caesura. The dotted attachment 
lines are attached to the notehead after the barline, 
meaning the caesura is correctly positioned before 
the barline.

An incorrectly input caesura. By clicking to the left of 
the barline, the caesura is attached to the last eighth 
note in the bar.

When input correctly, the dotted attachment lines link the caesura to the notehead immediately 
after the barline.

If your dotted attachment lines do not link the caesura to the notehead immediately after 
the barline, delete the caesura and re-input it. Caesuras can cause spacing issues when input 
incorrectly.

RELATED LINKS
Holds and pauses on page 809
Types of caesuras on page 811

Input methods for ornaments, arpeggio signs, glissando lines, and 
jazz articulations

You can input ornaments, including arpeggio signs, glissando lines, and jazz articulations with 
the keyboard by using the ornaments popover, and with the mouse by using the Ornaments 
panel.

You can input ornaments and arpeggio signs during note input and by adding them to existing 
notes, but you cannot input glissando lines during note input. You can only input glissando lines 
by adding them to existing notes.

You can specify the type/length of jazz articulations when using the Ornaments panel but not 
when using the ornaments popover.
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RELATED LINKS
Ornaments on page 867
Arpeggio signs on page 883
Glissando lines on page 889
Jazz articulations on page 911
Jazz ornaments on page 912
Lines on page 946
Input methods for lines on page 352

Ornaments popover
The following tables contain the entries for the ornaments popover that you can use to input the 
different ornaments, arpeggio signs, glissando lines, and jazz articulations available.

You can open the ornaments popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

● Select an existing ornament and press Return .

● Choose Write > Create Ornament.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Ornaments popover with an example entry
Ornaments button in the Notations toolbox

Ornaments

Type of ornament Popover entry

Trill:  tr or trill

Short trill:  shorttr

Mordent:  mor or mordent

Turn:  turn

Inverted turn:  invturn or invertedturn
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Trill intervals

Trill interval or quality Popover entry

Interval degree

Unison, second, third, fourth, fifth, sixth, 
seventh, octave

1, 2, 3, 4, 5, 6, 7, 8

Major M, maj, or major

Minor m, min, or minor

Perfect p, per, or perf

Diminished d, dim, or diminished

Augmented a, aug, or augmented

EXAMPLE
To input a trill with a perfect fifth interval, enter tr p5.

Jazz ornaments

Type of jazz ornament Popover entry

Bend brassbend

Flip flip

Jazz turn jazz or shake

Smear smear

Jazz articulations

Type of jazz articulation Popover entry

Plop (bend) plop

Plop (smooth) plopsmooth

Scoop scoop

Doit (bend) doit

Doit (smooth) doitsmooth
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Type of jazz articulation Popover entry

Fall (bend) fall

Fall (smooth) fallsmooth

TIP

Other ornaments are available in the Ornaments panel. You can specify the type/length of jazz 
articulations when using the Ornaments panel but not when using the ornaments popover.

Arpeggio signs

Type of arpeggio sign Popover entry

Up arpeggio sign arp, arpup, or arpeggioup

Down arpeggio sign arpdown or arpeggiodown

Non arpeggio sign nonarp or nonarpeggio

Curved arpeggio sign slurarp

Glissando lines

Type of glissando line Popover entry

Default style glissando line gliss

Straight glissando line glissstraight

Wavy glissando line glisswavy

Guitar techniques

Type of guitar technique Popover entry

Guitar bend bend

Vibrato bar dive and return vibbend

Vibrato bar scoop vibscoop

Vibrato bar dip vibdip
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Type of guitar technique Popover entry

Vibrato bar line

NOTE

Must have duration to show its line.

wbar or w/bar

Hammer-on

NOTE

You must select at least two notes assigned 
to the same string with ascending pitch 
directions, such as C-D.

ho or hammer

Pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

po or pull

Hammer-on then pull-off or pull-off then 
hammer-on (ligado)

NOTE

You must select at least three notes assigned 
to the same string with alternating pitch 
directions, such as C-D-C or D-C-D.

hp, hopo, hammerpull, lig, or ligado

Right-hand tapping tap

Right-hand tapping with pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

tappull

Left-hand tapping lhtap
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Type of guitar technique Popover entry

Left-hand tapping with pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

lhtappull

RELATED LINKS
Notations toolbox on page 178
Inputting arpeggio signs with the popover on page 318
Inputting glissando lines with the popover on page 319
Inputting jazz articulations with the popover on page 321
Inputting guitar bends with the popover on page 324
Inputting vibrato bar dives on page 326
Inputting vibrato bar dives and returns with the popover on page 328
Inputting vibrato bar scoops with the popover on page 330
Inputting vibrato bar dips with the popover on page 332
Inputting hammer-ons/pull-offs on page 334
Inputting tapping on page 336
Assigning notes to strings on page 846
Changing the allocated string for notes on tablature on page 1050
Ornaments on page 867
Trill intervals on page 873
Arpeggio signs on page 883
Glissando lines on page 889
Guitar bends on page 894
Guitar techniques on page 904
Jazz articulations on page 911
Jazz ornaments on page 912
Playing technique duration on page 941

Ornaments panel
The Ornaments panel allows you to input all the different types of ornaments available, including 
jazz articulations, as well as arpeggio signs, glissando lines, guitar bends, and vibrato bar 
techniques. It is located in the right zone in Write mode.

● You can hide/show the Ornaments panel by clicking Panels , then Ornaments  in the 
Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Ornaments panel contains the following sections:

Jazz
Contains ornaments and pitch alterations commonly used in jazz music, such as bends, 
scoops, and falls.

Baroque and Classical
Contains ornaments commonly used in Baroque and Classical music, such as 
mordents, turns, and trills.

Write mode
Notations input 

315
Dorico SE 4.3.30



Arpeggiation
Contains the different types of arpeggio signs.

NOTE

You cannot input arpeggio signs with the mouse during note input.

Glissandi
Contains the different types of glissando lines.

Guitar
Contains techniques and pitch alterations commonly associated with guitars, such as 
guitar bends and vibrato bar scoops.

RELATED LINKS
Notations toolbox on page 178
Inputting ornaments/trills with the panel on page 317
Inputting arpeggio signs with the panel on page 319
Inputting glissando lines with the panel on page 320
Inputting jazz articulations with the panel on page 322
Input methods for guitar bends and guitar techniques on page 323

Inputting ornaments/trills with the popover
You can input ornaments, trills, and jazz ornaments using the ornaments popover, both during 
note input and by adding them to existing notes. When inputting trills, you can specify the trill 
interval, such as a minor third.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input an 
ornament. If you want to input a trill with a specific duration, select items on the staff 
that span that duration.

2. Optional: If you want to input ornaments onto multiple staves at once, extend the caret to 
those staves.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter the appropriate entry for the ornament you want into the popover.

For example, enter tr m3 for a trill with a minor third interval or mor for a mordent.

5. Press Return  to close the popover.

6. Optional: When inputting trills during note input, input a note or press Space  to advance 
the caret and input the trill.

RESULT
During note input, ornaments are input at the caret position. Trills last the duration of the 
rhythmic value of the note input at the caret position or the duration by which the caret 
advanced. Trills have a default interval of a second, either major or minor depending on the 
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context. If you specified an interval for your trill, the interval applies only to the first note in the 
selection, but you can also change the interval partway through trills.

When adding ornaments to existing music, they are input at the rhythmic position of the earliest 
selected item. Trills are input at the rhythmic position of the earliest selected item, with an 
extender line across the rest of the selection.

RELATED LINKS
Ornaments on page 867
Trills on page 870
Trill intervals on page 873
Changing trill intervals on page 875
Changing trill intervals partway through trills on page 876
Trill interval appearance on page 878
Jazz ornaments on page 912
Inputting notes on page 197
Inputting jazz articulations with the popover on page 321
Extending the caret to multiple staves on page 195

Inputting ornaments/trills with the panel
You can input ornaments, trills, and jazz ornaments using the Ornaments panel, both during 
note input and by adding them to existing notes.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input an 
ornament. If you want to input a trill with a specific duration, select items on the staff 
that span that duration.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Ornaments panel, click the ornament you want.

RESULT
During note input, ornaments are input at the caret position. Trills are input with a default 
duration of a quarter note.

When adding ornaments to existing music, they are input at the rhythmic position of the earliest 
selected item. Trills are input at the rhythmic position of the earliest selected item, with an 
extender line across the rest of the selection.

TIP

You can specify trill intervals when inputting trills using the popover.

RELATED LINKS
Notations toolbox on page 178
Ornaments panel on page 315
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Inputting jazz articulations with the panel on page 322
Changing your mouse input settings on page 189

Inputting arpeggio signs with the popover
You can input arpeggio signs using the ornaments popover, both during note input and by 
adding them to existing notes. You can also input arpeggio signs across notes in multiple voices 
and on different staves that belong to the same instrument, such as piano or harp.

NOTE

You can only input one arpeggio sign at a time.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select at least one note in each voice to which you want to add an arpeggio sign.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff arpeggio signs. However, you cannot 
create cross-staff arpeggio signs between different instruments.

● Arpeggio signs are added to all notes in the selected voices at the selected rhythmic 
position.

2. Optional: If you started note input, press Q  to start chord input.

NOTE

You can only input arpeggio signs during chord input.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter the appropriate entry for the arpeggio sign you want into the popover.

For example, enter arpup for an up arpeggio sign or arpdown for a down arpeggio sign.

5. Press Return  to close the popover.

6. Optional: During chord input, input the notes you want.

RESULT
During chord input, arpeggio signs are input at the caret position.

When adding arpeggio signs to existing notes, they are input to the left of the selected notes.

Arpeggio signs automatically span the pitch range of all notes at that rhythmic position in 
the current voice during chord input, and all notes in the selected voices/staves when adding 
arpeggio signs to existing notes.

RELATED LINKS
Ornaments popover on page 311
Arpeggio signs on page 883
Inputting notes on page 197
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Inputting chords on page 226

Inputting arpeggio signs with the panel
You can input arpeggio signs on existing notes using the Ornaments panel. You can also input 
arpeggio signs across notes in multiple voices and on different staves that belong to the same 
instrument, such as piano or harp.

NOTE

● You can only input one arpeggio sign at a time, and you cannot input arpeggio signs with 
the mouse during note input.

● These steps describe inputting with the default mouse input preference Create item at 
selection. You cannot create cross-staff and cross-voice arpeggio signs if your preference is 
set to Load pointer with item.

PROCEDURE

1. In Write mode, select at least one note in each voice to which you want to add an arpeggio 
sign.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff arpeggio signs. However, you cannot 
create cross-staff arpeggio signs between different instruments.

● Arpeggio signs are added to all notes in the selected voices at the selected rhythmic 
position.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Arpeggiation section, click the arpeggio sign you want.

RESULT
The arpeggio sign specified is input to the left of the selected note or chord. Arpeggio signs 
automatically span the pitch range of all notes in the selected voices/staves at that rhythmic 
position.

RELATED LINKS
Notations toolbox on page 178
Ornaments panel on page 315
Arpeggio signs on page 883
Changing your mouse input settings on page 189

Inputting glissando lines with the popover
You can input glissando lines between existing notes using the ornaments popover. You can 
input glissando lines between both adjacent and non-adjacent notes.

NOTE

You cannot input glissando lines during note input or on the last note on a staff. Instead, you can 
input a jazz articulation.

PREREQUISITE
You have input at least two notes that you want to join with a glissando.
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PROCEDURE

1. In Write mode, select the two notes you want to join with a glissando line.

For example, select a grace note and a normal note, two notes in different voices, or two 
notes on different staves belonging to the same instrument.

2. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

3. Enter the appropriate entry for the glissando line you want into the popover.

● For a default style glissando line, enter gliss.

● For a straight glissando line, enter glissstraight.

● For a wavy glissando line, enter glisswavy.

4. Press Return  to close the popover.

RESULT
The glissando line specified is input between the selected notes.

NOTE

● If you select a single note and input a glissando line, the glissando line specified starts from 
the selected note and ends at the next note in the same voice on the staff, even if this 
crosses rests.

● Glissando lines do not automatically adjust around any notes or rests between the selected 
notes. If glissando text is shown, the text can collide with notes or rests, in which case we 
recommend that you make further adjustments, such as not showing glissando text for that 
glissando line.

● By default, glissando line text is hidden on staves belonging to fretted instruments. However, 
you can show glissando line text manually.

RELATED LINKS
Ornaments popover on page 311
Glissando lines on page 889
Changing glissando line text on page 891
Changing when glissando line text is shown on page 891
Changing the style of glissando lines on page 890
Inputting jazz articulations with the panel on page 322

Inputting glissando lines with the panel
You can input glissando lines between existing notes using the Ornaments panel. You can input 
glissando lines between both adjacent and non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection. If your preference is set to Load pointer with item, you can only input glissando 
lines between the note you click on and the note immediately following it.

● You cannot input glissando lines during note input or on the last note on a staff. Instead, you 
can input a jazz articulation.
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PREREQUISITE
You have input at least two notes that you want to join with a glissando.

PROCEDURE

1. In Write mode, select the two notes you want to join with a glissando line.

For example, select a grace note and a normal note, two notes in different voices, or two 
notes on different staves belonging to the same instrument.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Glissandi section, click the style of glissando line you want.

● Glissando (Straight) 

● Glissando (Wavy) 

RESULT
The glissando line specified is input between the selected notes.

NOTE

● If you select a single note and input a glissando line, the glissando line specified starts from 
the selected note and ends at the next note in the same voice on the staff, even if this 
crosses rests.

● Glissando lines do not automatically adjust around any notes or rests between the selected 
notes. If glissando text is shown, the text can collide with notes or rests, in which case we 
recommend that you make further adjustments, such as not showing glissando text for that 
glissando line.

● By default, glissando line text is hidden on staves belonging to fretted instruments. However, 
you can show glissando line text manually.

RELATED LINKS
Notations toolbox on page 178
Ornaments panel on page 315
Glissando lines on page 889
Changing glissando line text on page 891
Changing when glissando line text is shown on page 891
Inputting jazz articulations with the panel on page 322
Changing your mouse input settings on page 189

Inputting jazz articulations with the popover
You can input jazz articulations using the ornaments popover, both during note input and by 
adding them to existing notes.

NOTE

You can input jazz ornaments, such as flips or jazz turns, in the same ways as inputting 
ornaments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add jazz articulations.

2. Optional: If you want to input jazz articulations onto multiple staves at once, extend the caret 
to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the jazz articulation you want into the popover.

For example, enter scoop for a scoop or fall for a fall.

6. Press Return  to close the popover.

RESULT
The jazz articulation you specify is input on all selected notes. During note input, this is usually 
the last note you input.

NOTE

When using the popover, all jazz articulations are input with a default line style for their type. You 
can change their type/length after they have been input.

When using the panel, you can specify the line style of jazz articulations when you input them.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different jazz 
articulations in different voices simultaneously.

RELATED LINKS
Ornaments popover on page 311
Inputting ornaments/trills with the popover on page 316
Extending the caret to multiple staves on page 195
Jazz articulations on page 911
Changing the type/length of existing jazz articulations on page 913
Changing the line style of smooth jazz articulations on page 913
Enabling independent voice playback on page 460
Playback techniques on page 649

Inputting jazz articulations with the panel
You can input jazz articulations using the Ornaments panel, both during note input and by 
adding them to existing notes.

NOTE

● You can input jazz ornaments, such as flips or jazz turns, in the same ways as inputting 
ornaments.
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● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add jazz articulations.

2. Optional: If you want to input jazz articulations onto multiple staves at once, extend the caret 
to those staves.

3. Optional: During note input, input at least one note.

4. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

5. In the Jazz section, click the jazz articulation you want.

RESULT
The jazz articulation you specify is input on all selected notes. During note input, this is usually 
the last note you input.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different jazz 
articulations in different voices simultaneously.

RELATED LINKS
Notations toolbox on page 178
Ornaments panel on page 315
Inputting ornaments/trills with the panel on page 317
Extending the caret to multiple staves on page 195
Changing your mouse input settings on page 189
Enabling independent voice playback on page 460
Playback techniques on page 649

Input methods for guitar bends and guitar techniques
You can input guitar bends (including pre-bends and post-bends), vibrato bar techniques 
(including dips, dives, scoops, and dives and returns) and tapping, hammer-on, and pull-off 
indications with the keyboard by using the ornaments popover, and with the mouse by using the 
Ornaments panel.

You can also input guitar pre-bends, post-bends, and vibrato bar pre-dives using properties in 
the Properties panel.

You can input guitar techniques during note input and by adding them to existing notes, but you 
cannot input guitar bends during note input. You can only input guitar bends by adding them to 
existing notes.

RELATED LINKS
Ornaments popover on page 311
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Ornaments panel on page 315
Guitar bends on page 894
Guitar pre-bends and pre-dives on page 896
Guitar post-bends on page 897
Vibrato bar dives and returns on page 899
Vibrato bar techniques on page 904
Tapping on page 905
Hammer-ons and pull-offs on page 906

Inputting guitar bends with the popover
You can input guitar bends between existing notes, including between grace notes and normal 
notes, using the ornaments popover. You can input guitar bends between both adjacent and 
non-adjacent notes.

NOTE

You cannot input guitar bends during note input or on the last note on a staff.

PREREQUISITE
You have input at least two notes that you want to join with a guitar bend.

PROCEDURE

1. In Write mode, select the two notes you want to join with a guitar bend.

For example, select a grace note and a normal note or two notes in different voices.

2. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

3. Enter bend into the popover.

4. Press Return  to close the popover.

RESULT
The guitar bend is input between the selected notes.

Guitar bends automatically appear as guitar bends or returns on tablature according to the pitch 
direction of the notes they join.

TIP

● If you select a single note and input a guitar bend, the guitar bend starts from the selected 
note and ends at the next note in the same voice on the staff, even if this crosses rests.

● You can assign a key command for Create Guitar Bend on the Key Commands page in 
Preferences.

RELATED LINKS
Ornaments popover on page 311
Guitar bends on page 894
Inputting guitar pre-bends/pre-dives on page 325
Inputting guitar post-bends on page 326
Key Commands page in the Preferences dialog on page 54
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Inputting guitar bends with the panel
You can input guitar bends between existing notes, including between grace notes and normal 
notes, using the Ornaments panel. You can input guitar bends between both adjacent and 
non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection. If your preference is set to Load pointer with item, you can only input guitar 
bends between the note you click on and the note immediately following it.

● You cannot input guitar bends during note input or on the last note on a staff.

PREREQUISITE
You have input at least two notes that you want to join with a guitar bend.

PROCEDURE

1. In Write mode, select the two notes you want to join with a guitar bend.

For example, select a grace note and a normal note or two notes in different voices.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Guitar Bend .

RESULT
The guitar bend is input between the selected notes.

Guitar bends automatically appear as guitar bends or returns on tablature according to the pitch 
direction of the notes they join.

TIP

● If you select a single note and input a guitar bend, the guitar bend starts from the selected 
note and ends at the next note in the same voice on the staff, even if this crosses rests.

● You can assign a key command for Create Guitar Bend on the Key Commands page in 
Preferences.

RELATED LINKS
Notations toolbox on page 178
Ornaments panel on page 315
Guitar bends on page 894
Changing your mouse input settings on page 189

Inputting guitar pre-bends/pre-dives
You can input guitar pre-bends on any existing notes belonging to fretted instruments. You can 
also specify that pre-bends should be played using the vibrato bar, a technique that is known as 
a “pre-dive”.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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PROCEDURE

1. Select the notes before which you want to input guitar pre-bends/pre-dives.

2. In the Properties panel, activate Pre-bend interval in the Guitar Pre-bends group.

3. Change the interval as required.

4. Optional: To turn the guitar pre-bends into guitar pre-dives, activate Vibrato bar pre-bend 
and the corresponding checkbox in the Guitar Pre-bends group.

RESULT
Guitar pre-bends of the specified interval are input before the selected notes. They are shown as 
guitar pre-dives when Vibrato bar pre-bend and the corresponding checkbox are both activated.

RELATED LINKS
Guitar pre-bends and pre-dives on page 896
Vibrato bar techniques on page 904
Properties panel on page 560

Inputting guitar post-bends
You can input guitar post-bends on any existing notes belonging to fretted instruments. You can 
also specify that post-bends are microtonal.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the notes after which you want to input guitar post-bends.

2. In the Properties panel, activate Post-bend interval in the Guitar Post-bends group.

3. Do one of the following:

● Change the interval as required.

● To turn the guitar post-bends into microtonal post-bends, activate Microtone bend in 
the Guitar Post-bends group.

RESULT
Guitar post-bends of the specified interval are input after the selected notes. They are shown as 
microtonal when Microtone bend is activated.

RELATED LINKS
Guitar post-bends on page 897
Properties panel on page 560
Inputting guitar bends with the popover on page 324

Inputting vibrato bar dives
You can input vibrato bar dives, both during note input and by adding them to existing notes.

Vibrato bar dives are notated using a smooth fall jazz articulation combined with a vibrato bar 
indication.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar dives.

2. Optional: If you want to input vibrato bar dives onto multiple staves at once, extend the caret 
to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter fallsmooth into the popover to input a smooth fall jazz articulation.

6. Press Return  to close the popover.

7. Optional: During note input, move the caret back to the position of the note with the smooth 
fall.

8. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

9. Enter wbar into the popover to input a vibrato bar indication.

10. Press Return  to close the popover.

11. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar indication.

RESULT
The smooth fall jazz articulation is input on all selected notes. During note input, this is usually 
the last note you input.

During note input, vibrato bar indications are input at the caret position. When adding vibrato 
bar indications to existing music, they are added at the rhythmic position of the earliest selected 
item.

NOTE

When using the popover, all jazz articulations are input with a default line style for their type. You 
can change their type/length after they have been input.

You can also input both smooth fall jazz articulations and vibrato bar indications using the 
Ornaments panel. When using the panel, you can specify the line style of jazz articulations when 
you input them.

AFTER COMPLETING THIS TASK
If you want vibrato bar indications to show a line, you can lengthen them to give them duration.
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RELATED LINKS
Vibrato bar techniques on page 904
Notations toolbox on page 178
Ornaments popover on page 311
Ornaments panel on page 315
Extending the caret to multiple staves on page 195
Moving the caret manually on page 196
Jazz articulations on page 911
Inputting jazz articulations with the popover on page 321
Inputting jazz articulations with the panel on page 322
Changing the type/length of existing jazz articulations on page 913
Changing the line style of smooth jazz articulations on page 913
Deleting jazz articulations on page 914
Lengthening/Shortening items on page 396
Playing technique duration on page 941

Inputting vibrato bar dives and returns with the popover
You can input vibrato bar dives and returns between existing notes using the ornaments 
popover. You can input vibrato bar dives and returns between both adjacent and non-adjacent 
notes.

NOTE

You cannot input vibrato bar dives and returns during note input or on the last note on a staff.

PREREQUISITE
You have input at least three notes with alternating pitch directions, such as D-C-D, that you want 
to join with a vibrato bar dive and return.

PROCEDURE

1. In Write mode, select the two notes you want to join with a vibrato bar dive.

NOTE

The notes must be on the same staff and have a descending pitch direction, such as D-C.

2. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

3. Enter vibbend into the popover to input the dive.

4. Press Return  to close the popover.

5. Select the two notes you want to join with a vibrato bar return.

NOTE

The notes must be on the same staff and have an ascending pitch direction, such as C-D.

6. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

7. Enter vibbend into the popover to input the return.
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8. Press Return  to close the popover.

RESULT
Vibrato bar dives are input between notes with descending pitch directions, and vibrato bar 
returns are input between notes with ascending pitch directions. If a vibrato bar dive ends on 
the same note that a vibrato bar return starts on, they appear as a V on tablature with the bend 
interval shown at the point. If you input vibrato bar dives on consecutive notes with the same 
pitch direction, such as E-D-C, they are notated on tablature with an additional line protrusion 
beyond the staff and bend interval for each vibrato bar dive.

Vibrato bar dives and returns automatically point upwards or downwards on tablature according 
to the pitch direction of the notes they join.

RELATED LINKS
Ornaments popover on page 311
Vibrato bar dives and returns on page 899
Vibrato bar techniques on page 904
Guitar bends on page 894
Inputting guitar bends with the popover on page 324

Inputting vibrato bar dives and returns with the panel
You can input vibrato bar dives and returns between existing notes using the Ornaments panel. 
You can input vibrato bar dives and returns between both adjacent and non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection. If your preference is set to Load pointer with item, you can only input vibrato 
bar dives and returns between the note you click on and the note immediately following it.

● You cannot input vibrato bar dives and returns during note input or on the last note on a 
staff.

PREREQUISITE
You have input at least three notes with alternating pitch directions, such as D-C-D, that you want 
to join with a vibrato bar dive and return.

PROCEDURE

1. In Write mode, select the two notes you want to join with a vibrato bar dive.

NOTE

The notes must be on the same staff and have a descending pitch direction, such as D-C.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Guitar Bend with Vibrato Bar  to input the vibrato bar dive.

4. Select the two notes you want to join with a vibrato bar return.

NOTE

The notes must be on the same staff and have an ascending pitch direction, such as C-D.

5. Click Guitar Bend with Vibrato Bar  to input the vibrato bar return.
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RESULT
Vibrato bar dives are input between notes with descending pitch directions, and vibrato bar 
returns are input between notes with ascending pitch directions. If a vibrato bar dive ends on 
the same note that a vibrato bar return starts on, they appear as a V on tablature with the bend 
interval shown at the point. If you input vibrato bar dives on consecutive notes with the same 
pitch direction, such as E-D-C, they are notated on tablature with an additional line protrusion 
beyond the staff and bend interval for each vibrato bar dive.

Vibrato bar dives and returns automatically point upwards or downwards on tablature according 
to the pitch direction of the notes they join.

RELATED LINKS
Notations toolbox on page 178
Ornaments panel on page 315
Vibrato bar dives and returns on page 899
Vibrato bar techniques on page 904
Guitar bends on page 894
Inputting vibrato bar dives on page 326
Changing your mouse input settings on page 189

Inputting vibrato bar scoops with the popover
You can input vibrato bar scoops using the ornaments popover, both during note input and by 
adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar scoops.

2. Optional: If you want to input vibrato bar scoops onto multiple staves at once, extend the 
caret to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter vibscoop into the popover.

6. Press Return  to close the popover.

RESULT
Vibrato bar scoops are input on the selected notes. During note input, this is usually the last note 
you input.

By default, vibrato bar scoops only appear on notation staves, not tablature. They are positioned 
to the left of notes.
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AFTER COMPLETING THIS TASK
You can input vibrato bar indications to clarify the vibrato bar scoops should be played using the 
vibrato bar.

RELATED LINKS
Ornaments popover on page 311
Vibrato bar techniques on page 904
Inputting vibrato bar indications/lines with the popover on page 333
Deleting guitar techniques on page 910

Inputting vibrato bar scoops with the panel
You can input vibrato bar scoops using the Ornaments panel, both during note input and by 
adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar scoops.

2. Optional: If you want to input vibrato bar scoops onto multiple staves at once, extend the 
caret to those staves.

3. Optional: During note input, input at least one note.

4. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

5. In the Guitar section, click Vibrato Bar Scoop .

RESULT
Vibrato bar scoops are input on the selected notes. During note input, this is usually the last note 
you input.

By default, vibrato bar scoops only appear on notation staves, not tablature. They are positioned 
to the left of notes.

AFTER COMPLETING THIS TASK
You can input vibrato bar indications to clarify the vibrato bar scoops should be played using the 
vibrato bar.

RELATED LINKS
Notations toolbox on page 178
Ornaments panel on page 315
Vibrato bar techniques on page 904
Inputting vibrato bar indications/lines with the panel on page 334
Deleting guitar techniques on page 910
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Inputting vibrato bar dips with the popover
You can input vibrato bar dips using the ornaments popover, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff at the rhythmic position where you want to input a vibrato 
bar dip.

2. Optional: If you want to input vibrato bar dips onto multiple staves at once, extend the caret 
to those staves.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter vibdip into the popover.

5. Press Return  to close the popover.

6. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar dip.

RESULT
During note input, vibrato bar dips are input at the caret position. When adding vibrato bar dips 
to existing music, they are input at the position of the earliest selected item.

By default, vibrato bar dips have half step intervals, are placed above the staff, and only appear 
on notation staves, not tablature.

RELATED LINKS
Ornaments popover on page 311
Vibrato bar techniques on page 904
Changing vibrato bar dip intervals on page 908
Inputting vibrato bar indications/lines with the popover on page 333
Changing the staff-relative placement of items on page 400

Inputting vibrato bar dips with the panel
You can input vibrato bar dips using the Ornaments panel, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff at the rhythmic position where you want to input a vibrato 
bar dip.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Vibrato Bar Dip .
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RESULT
During note input, vibrato bar dips are input at the caret position. When adding vibrato bar dips 
to existing music, they are input at the position of the earliest selected item.

By default, vibrato bar dips have half step intervals, are placed above the staff, and only appear 
on notation staves, not tablature.

RELATED LINKS
Notations toolbox on page 178
Ornaments panel on page 315
Vibrato bar techniques on page 904
Changing vibrato bar dip intervals on page 908
Inputting vibrato bar indications/lines with the panel on page 334
Changing the staff-relative placement of items on page 400

Inputting vibrato bar indications/lines with the popover
You can input vibrato bar indications/lines using the ornaments popover, both during note input 
and by adding them to existing music. When vibrato bar indications are input across a range of 
items, they are input with duration and show a duration line, which is dashed by default.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
vibrato bar indication. If you want to input a vibrato bar line, select items on the staff 
that span the required duration.

2. Optional: If you want to input vibrato bar indications onto multiple staves at once, extend the 
caret to those staves.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter wbar into the popover to input the vibrato bar indication.

5. Press Return  to close the popover.

6. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar indication.

RESULT
During note input, vibrato bar indications are input at the caret position.

When adding vibrato bar indications to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding vibrato bar indications to a range of selected 
items, they are input at the rhythmic position of the earliest selected item and have duration, 
which applies until the end of the selection. Vibrato bar indications with duration show a duration 
line, which is dashed by default.

By default, vibrato bar indications/lines are placed below the staff and only appear on notation 
staves, not tablature.

RELATED LINKS
Ornaments popover on page 311
Vibrato bar techniques on page 904
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Extending the caret to multiple staves on page 195
Lengthening/Shortening items on page 396
Playing technique duration on page 941

Inputting vibrato bar indications/lines with the panel
You can input vibrato bar indications/lines using the Ornaments panel, both during note input 
and by adding them to existing music. When vibrato bar indications are input across a range of 
items, they are input with duration and show a duration line, which is dashed by default.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
vibrato bar indication. If you want to input a vibrato bar line, select items on the staff 
that span the required duration.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Vibrato Bar Line .

RESULT
During note input, vibrato bar indications are input at the caret position.

When adding vibrato bar indications to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding vibrato bar indications to a range of selected 
items, they are input at the rhythmic position of the earliest selected item and have duration, 
which applies until the end of the selection. Vibrato bar indications with duration show a duration 
line, which is dashed by default.

By default, vibrato bar indications/lines are placed below the staff and only appear on notation 
staves, not tablature.

RELATED LINKS
Ornaments panel on page 315
Vibrato bar techniques on page 904
Lengthening/Shortening items on page 396
Playing technique duration on page 941

Inputting hammer-ons/pull-offs
You can input hammer-ons/pull-offs on any notes belonging to fretted instruments using the 
ornaments popover, both during note input and by adding them to existing notes. If you select 
multiple notes, Dorico SE automatically inputs the appropriate slurs. You can also add tapping 
with hammer-ons/pull-offs to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add hammer-ons/pull-offs.

Write mode
Notations input 

334
Dorico SE 4.3.30



NOTE

● If you want to input hammer-ons, you must select at least two notes assigned to the 
same string with ascending pitch directions, such as C-D.

● If you want to input pull-offs or tapping with pull-offs, you must select at least two 
notes assigned to the same string with descending pitch directions, such as D-C.

● If you want to input ligados, you must select at least three notes assigned to the 
same string with alternating pitch directions, such as C-D-C for a hammer-on then 
pull-off or D-C-D for a pull-off then hammer-on.

2. Optional: If you want to input hammer-ons/pull-offs onto multiple fretted instrument staves 
at once, extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the hammer-on/pull-off you want into the popover.

For example, enter ho for a hammer-on or hopo for a hammer-on then pull-off.

6. Press Return  to close the popover.

RESULT
The hammer-on/pull-off you specify is input on the selected notes. During note input, this is 
usually the last note you input.

If you selected multiple adjacent notes assigned to the same string, Dorico SE automatically 
inputs slurs spanning the selected notes and centers hammer-on/pull-off indications on the 
slurs. For slurs with multiple hammer-on/pull-off indications, each indication is centered over the 
range of notes in the corresponding direction.

By default, hammer-ons/pull-offs appear on both notation staves and tablature and are placed 
above the staff.

TIP

You can also add hammer-ons/pull-offs to existing notes by selecting them, activating Technique 
in the Guitar Techniques group of the Properties panel, and selecting the appropriate indication 
from the menu. To show hammer-on/pull-off indications centered on slurs, select all notes except 
the first note under each slur.

RELATED LINKS
Ornaments popover on page 311
Hammer-ons and pull-offs on page 906
Changing the staff-relative placement of guitar techniques on page 909
Assigning notes to strings on page 846
Changing the allocated string for notes on tablature on page 1050
Deleting guitar techniques on page 910
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Inputting tapping
You can input right-hand and left-hand tapping indications on any notes belonging to fretted 
instruments using the ornaments popover, both during note input and by adding them to 
existing notes. You can also add tapping with hammer-ons/pull-offs to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tapping indications.

NOTE

If you want to input tapping with pull-offs, you must select at least two notes assigned to 
the same string with descending pitch directions, such as D-C.

2. Optional: If you want to input tapping onto multiple fretted instrument staves at once, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the tapping indication you want into the popover.

For example, enter tap for right-hand tapping or lhtappull for left-hand tapping with pull-
off.

6. Press Return  to close the popover.

RESULT
The tapping indication you specify is input on the selected notes. During note input, this is 
usually the last note you input.

By default, tapping indications appear on both notation staves and tablature and are placed 
above the staff.

TIP

You can also add tapping indications to existing notes by selecting them, activating Technique 
in the Guitar Techniques group of the Properties panel, and selecting the appropriate indication 
from the menu.

RELATED LINKS
Ornaments popover on page 311
Tapping on page 905
Changing the staff-relative placement of guitar techniques on page 909
Assigning notes to strings on page 846
Changing the allocated string for notes on tablature on page 1050
Extending the caret to multiple staves on page 195
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Deleting guitar techniques on page 910

Input methods for playing techniques, pedal lines, string indicators, 
and harp pedal diagrams

You can input playing techniques with the keyboard by using the playing techniques popover, 
and with the mouse by using the Playing Techniques panel. Pedal lines are considered playing 
techniques in Dorico SE because both affect the sound that the instrument produces.

You can input string indicators outside the staff in the same ways, using either the playing 
techniques popover or Playing Techniques panel. However, you can only input harp pedal 
diagrams using the playing techniques popover.

You can input string indicators inside the staff using a property in the String Indicators group of 
the Properties panel.

RELATED LINKS
Playing techniques on page 937
Pedal lines on page 925
Harp pedaling on page 918
String indicators on page 797
Inputting playing techniques with the popover on page 341
Inputting playing techniques with the panel on page 343
Inputting pedal lines with the popover on page 344
Inputting pedal lines with the panel on page 346
Inputting harp pedal diagrams on page 348
Inputting string indicators outside the staff with the popover on page 349
Inputting string indicators outside the staff with the panel on page 350
Inputting string indicators inside the staff on page 351

Playing techniques popover
The following tables contain the entries for the playing techniques popover that you can use to 
input playing techniques, pedal lines, and retakes.

When you start entering a playing technique into the playing techniques popover, a menu 
appears that shows valid playing techniques containing the letters/words you enter. You can 
then select one of these playing techniques to input.

You can open the playing techniques popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

● Select an existing playing technique and press Return .

● Choose Write > Create Playing Technique.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.
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Playing techniques popover with 
an example entry for inputting a 
playing technique

Playing techniques popover with 
an example entry for inputting a 
pedal line

Playing Techniques button in the 
Notations toolbox

Playing techniques

Playing technique Popover entry

Vibrato vibrato

Senza vibrato senza vibrato

Naturale (nat.) nat

Con sord. con sord

Strong air pressure strong air pressure

Double-tongue double-tongue

Down bow downbow

Up bow upbow

Sul ponticello sul pont

Sul tasto sul tasto

Poco sul tasto pst

Pizzicato pizz

Spiccato spicc

Arco arco

Tongue click (Stockhausen) tongue click

Finger click (Stockhausen) finger click

Vibraphone motor on motor on

Vibraphone motor off motor off

Open open
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Playing technique Popover entry

Damp damp

Damp (large) damp large

Full barré full barre

Half barré half barre

Strum up strum up

Strum down strum down

Left hand lh

Right hand rh

This list is not comprehensive as there are many valid playing techniques. It is intended 
to illustrate how you can structure your entry to input different types of common playing 
techniques.

If you do not know the correct entry for a playing technique, start entering part of the playing 
technique and see if it becomes available in the popover menu.

NOTE

● To give playing techniques duration, add -> at the end of your entry, such as vibrato->. 
During note input, the duration of the playing technique extends as you continue inputting 
notes or advance the caret. When adding playing techniques to existing music, they are 
added as a group.

● As playing techniques correspond to specific samples, they must be input as described or 
selected from the popover menu.

Pedal lines

Type of pedal line or retake Popover entry

Sustain pedal line ped

Retake in sustain pedal line ^, notch, or retake

Remove retake in sustain pedal line nonotch

Stop sustain pedal line *

Sostenuto pedal line sost

Stop sostenuto pedal line s*
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Type of pedal line or retake Popover entry

Una corda pedal line unacorda

Stop una corda pedal line u*

Harp pedaling

Example harp pedaling Popover entry

D, C, B♭, E♭, F, G, A DCBbEbFGA, BbEb, or --^|^---

D, C♯, B, E, F♯, G♯, A DC#BEF#G#A, C#F#G#, or -v-|-vv-

TIP

The pipe character is optional.

String indicators outside the staff

Example string indicator Popover entry

1 string1

3 string3

RELATED LINKS
Notations toolbox on page 178
Playing techniques on page 937
Groups of playing techniques on page 943
Pedal lines on page 925
Sustain pedal retakes and pedal level changes on page 926
Harp pedaling on page 918
String indicators on page 797
Adding retakes with the popover on page 345
Inputting harp pedal diagrams on page 348
Inputting string indicators outside the staff with the popover on page 349

Playing Techniques panel
The Playing Techniques panel contains the different playing techniques available in Dorico SE, 
divided into instrument families. It is located in the right zone in Write mode. Pedal lines are 
included in the Keyboard section.

● You can hide/show the Playing Techniques panel by clicking Panels , then Playing 
Techniques  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Playing Techniques panel contains the following sections:
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Common
Contains commonly used playing techniques that also apply to multiple different 
instrument families, such as “mute” and “legato”.

Wind
Contains playing techniques typically only used for wind instruments, such as “key 
clicks” and “whistle tones”.

Brass
Contains playing techniques typically only used for brass instruments, such as “cup 
mute” and “stopped”.

Unpitched Percussion
Contains playing techniques typically only used for unpitched percussion instruments, 
such as “rim” and “scrape”.

Pitched Percussion
Contains playing techniques typically only used for pitched percussion instruments, 
such as “motor on” and “½ Ped.” for vibraphones.

Keyboard
Contains playing techniques typically only used for keyboard instruments, such as 
“Ped.” and different pedal depression levels.

Choral
Contains playing techniques typically only used for the voice, such as “mouth open” 
and “tongue click”.

Strings
Contains playing techniques typically only used for string instruments, such as “col 
legno battuto” and “down bow”.

Guitar
Contains playing techniques typically only used for guitars and fretted instruments, 
such as string indicators, “half barré”, and “strum up”.

TIP

You can hover your mouse pointer over the options in each section to show the name of each 
playing technique.

RELATED LINKS
Notations toolbox on page 178
Inputting string indicators outside the staff with the panel on page 350
Playing techniques on page 937
Pedal lines on page 925
String indicators on page 797

Inputting playing techniques with the popover
You can input playing techniques using the playing techniques popover, both during note input 
and by adding them to existing music.

NOTE

● You can only enter one playing technique into the popover during note input. You can 
enter two playing techniques when adding playing techniques to existing music if they are 
separated by ->.
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● If you want to input playing techniques in the middle of tie chains, start note input, then 
move the caret to the required rhythmic position.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
playing technique. If you want to input playing techniques with duration, select items on 
the staff that span that duration.

2. Optional: If you want to input playing techniques onto multiple staves at once, extend the 
caret to those staves.

3. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

4. Enter the appropriate entry for the playing technique you want into the popover.

For example, enter pizz or non vibrato->.

When you start entering a playing technique into the playing techniques popover, a menu 
appears that shows valid playing techniques containing the letters/words you enter, which 
you can select. If you want the playing technique to have duration, you can add -> at the end.

5. Press Return  to close the popover.

Open-ended playing techniques, such as non vibrato->, automatically extend during note 
input as you continue inputting notes, or if you advance the caret by pressing Space  or 
clicking Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

6. Optional: During note input, stop open-ended playing techniques by opening the playing 
techniques popover again and entering one of the following entries:

● To end the current playing technique with another playing technique, enter that playing 
technique. For example, enter vibrato. This joins the current playing technique to the 
following one with a continuation line.

● To end the current playing technique with another open-ended playing technique, enter 
that playing technique followed by ->. For example, enter vibrato->. This joins the 
current playing technique to the following one with a continuation line.

● To end the current playing technique without inputting another playing technique, 
enter ? into the popover. This leaves the current playing technique with a duration line 
rather than a continuation line.

RESULT
The specified playing techniques are input. They are considered voice-specific by default, 
meaning they only apply to the voice indicated by the caret indicator during step input or the 
selected voice when adding playing techniques to existing notes. They are automatically placed 
above the staff for up-stem voices and below the staff for down-stem voices.
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Adjoining playing techniques, or playing techniques that were input together or in sequence, are 
automatically grouped together, both during note input and when adding playing techniques to 
existing notes.

During note input, playing techniques are input at the caret position and extend automatically if 
you included an open-ended playing technique with duration.

When adding playing techniques to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding playing techniques to a range of selected 
items, they are input at the rhythmic position of the earliest select item and have duration, which 
applies until the end of the selection. For playing techniques whose continuation type is set to 
show lines, the appropriate continuation line is shown.

AFTER COMPLETING THIS TASK

● You can move playing techniques within playing technique groups, lengthen/shorten playing 
techniques, and hide/show playing technique duration lines.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques in different voices simultaneously.

RELATED LINKS
Groups of playing techniques on page 943
Playing technique continuation lines on page 940
Hiding/Showing playing technique duration lines on page 942
Lengthening/Shortening items on page 396
Moving notes/items rhythmically on page 417
Caret on page 191
Moving the caret manually on page 196
Extending the caret to multiple staves on page 195
Enabling independent voice playback on page 460
Playback techniques on page 649

Inputting playing techniques with the panel
You can input playing techniques using the Playing Techniques panel, both during note input and 
by adding them to existing music.

NOTE

● You cannot input playing techniques with duration in sequence, which automatically groups 
them, when using the panel. If you want to input playing techniques with duration in 
sequence, you can use the popover.

● If you want to input playing techniques in the middle of tie chains, start note input, then 
move the caret to the required rhythmic position.

● These steps describe inputting with the default mouse input preference Create item at 
selection. If you want to input the same playing technique in multiple places, change your 
mouse input preference to Load pointer with item so that you do not have to reselect the 
playing technique for each note.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a 
playing technique. If you want to input playing techniques with duration, select items on 
the staff that span that duration.
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2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, click the playing technique you want.

RESULT
The specified playing technique is input. It is considered voice-specific by default, meaning it only 
applies to the voice indicated by the caret indicator during step input or the selected voice when 
adding playing techniques to existing notes. It is automatically placed above the staff for up-stem 
voices and below the staff for down-stem voices.

During note input, playing techniques are input at the caret position, even if your preference is 
set to Load pointer with item.

When adding playing techniques to a single selected item, they are input at that rhythmic 
position only and have no duration. When adding playing techniques to a range of selected 
items, they are input at the rhythmic position of the earliest select item and have duration, which 
applies until the end of the selection. For playing techniques whose continuation type is set to 
show lines, the appropriate continuation line is shown.

AFTER COMPLETING THIS TASK

● If you want to show transition lines between playing techniques, you can group them 
together.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques in different voices simultaneously.

RELATED LINKS
Notations toolbox on page 178
Changing your mouse input settings on page 189
Caret on page 191
Moving the caret manually on page 196
Lengthening/Shortening items on page 396
Grouping playing techniques together on page 944
Enabling independent voice playback on page 460
Playback techniques on page 649

Inputting pedal lines with the popover
You can input pedal lines using the playing techniques popover, both during note input and 
by adding them to existing music. Because pedal lines extend automatically as you input notes 
during note input, you can also input retakes when you reach the appropriate rhythmic position.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● On the staff where you want to input a pedal line, select items that span the required 
duration.

2. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

3. Enter the appropriate entry for the pedal line you want into the popover.

For example, enter ped for a sustain pedal line.
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When you start entering a pedal line into the playing techniques popover, a menu appears 
that shows valid pedal lines containing the letters/words you enter, which you can select.

4. Press Return  to close the popover.

The pedal line is input.

5. Optional: During note input, advance the caret and extend the pedal line in any of the 
following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

The pedal line also extends automatically as you continue inputting notes.

6. Optional: During note input, input retakes by opening the playing techniques popover again 
at the appropriate rhythmic position and entering ^ or retake into the popover.

7. Optional: During note input, stop the pedal line by opening the playing techniques popover 
again and enter the appropriate entry into the popover.

For example, enter * to stop a sustain pedal line.

8. Press Return  to close the popover.

RESULT
During note input, pedal lines start at the caret position, and end at the caret position.

When you add pedal lines to existing music, pedal lines are added across the selected items.

NOTE

Retakes only appear for sustain pedal lines with the Line continuation type.

AFTER COMPLETING THIS TASK
You can change the continuation type used for individual pedal lines; for example, to show a sign 
at the end.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 926
Positions of pedal lines on page 927
Changing the pedal line continuation type on page 933
Inputting notes on page 197
Notations toolbox on page 178
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186

Adding retakes with the popover

You can add retakes to sustain pedal lines using the playing techniques popover, both during 
note input and by adding them to existing music.
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NOTE

You cannot add retakes to sostenuto or una corda pedal lines. Retakes only appear for sustain 
pedal lines with the Line continuation type.

PREREQUISITE
You have input a sustain pedal line.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff and at each rhythmic position where you want to input 
retakes.

2. Optional: If you want to input notes and retakes onto multiple staves with sustain pedal lines 
at once, extend the caret to those staves.

3. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

4. Enter ^ or retake into the popover.

5. Press Return  to close the popover.

RESULT
During note input, retakes are input at the caret position.

Outside of note input, retakes are input at each selected rhythmic position on each selected staff.

TIP

You can also input retakes by selecting notes within the ranges of sustain pedal lines and 
choosing Edit > Notations > Pedal Lines > Add Retake. You can also choose this option from 
the context menu.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 926
Playing techniques popover on page 337
Changing the pedal line continuation type on page 933
Moving the caret manually on page 196
Removing retakes and pedal level changes on page 927

Inputting pedal lines with the panel
You can input pedal lines using the Playing Techniques panel.

NOTE

● When using the panel, you cannot input pedal lines during note input.

● These steps describe inputting with the default mouse input preference Create item at 
selection.
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PROCEDURE

1. In Write mode, select items on the staff where you want to input a pedal line that span the 
required duration.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Keyboard section.

4. Click the pedal line you want.

RESULT
The pedal line is input across the selected range.

TIP

Alternatively, when nothing is selected, you can click the pedal line you want in the Keyboard 
section of the Playing Techniques panel, then click and drag in the music area to input a pedal 
line and extend it to the duration you want.

AFTER COMPLETING THIS TASK

● You can change the continuation type used for individual pedal lines; for example, to show a 
sign at the end.

● You can add retakes within the ranges of sustain pedal lines.

NOTE

Retakes only appear for sustain pedal lines with the Line continuation type.

RELATED LINKS
Playing Techniques panel on page 340
Sustain pedal retakes and pedal level changes on page 926
Changing the pedal line continuation type on page 933
Changing your mouse input settings on page 189

Adding retakes with the panel

You can add retakes to existing sustain pedal lines using the Playing Techniques panel.

NOTE

You cannot add retakes to sostenuto or una corda pedal lines. Retakes only appear for sustain 
pedal lines with the Line continuation type.

PREREQUISITE
You have input a sustain pedal line.

PROCEDURE

1. In Write mode, select an item on each staff and at each rhythmic position where you want to 
input retakes.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Keyboard section.
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4. Click Retake Pedal .

RESULT
The retake is input at each selected rhythmic position on each selected staff.

TIP

● Alternatively, when nothing is selected in the music area, you can click Retake Pedal in the 
Keyboard section of the Playing Techniques panel, and then click at each rhythmic position 
where you want to input the retake.

● You can also input retakes by selecting notes within the ranges of sustain pedal lines and 
choosing Edit > Notations > Pedal Lines > Add Retake. You can also choose this option 
from the context menu.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 926
Playing Techniques panel on page 340
Changing the pedal line continuation type on page 933
Removing retakes and pedal level changes on page 927

Inputting harp pedal diagrams
You can input harp pedal diagrams using the playing techniques popover, both during note input 
and by adding them to existing music.

If you do not input any harp pedaling, Dorico SE assumes all harp pedals are in their natural 
setting, as they would be for C major. Any pitches that do not fit with the current harp pedaling, 
excluding the two lowest harp strings, appear red when colors for notes out of range are shown.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input on a harp staff.

● Select an item on a harp staff at the rhythmic position where you want to input a harp 
pedal diagram.

2. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

3. Enter the appropriate entry for the harp pedals you want.

For example, enter C#F#G# for C♯, F♯, and G♯ pedals, such as in A major, or BbEb for B♭ and E♭ 
pedals, such as in B♭ major.

4. Press Return  to close the popover.

RESULT
The corresponding harp pedal diagram is input at the selected rhythmic position. Depending on 
your per-layout settings, it is either displayed as a diagram, using note names, or not shown and 
instead indicated by a signpost.

During note input, harp pedal diagrams are input at the caret position.
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RELATED LINKS
Playing techniques popover on page 337
Harp pedaling on page 918
Hiding/Showing harp pedaling in layouts on page 920
Changing the appearance of harp pedal diagrams on page 919
Hiding/Showing colors for notes out of range on page 847

Calculating harp pedal diagrams based on existing music

You can automatically calculate suitable harp pedal diagrams based on the notes you have 
already input, either from a single point onwards or within a selected region.

If you do not input any harp pedaling, Dorico SE assumes all harp pedals are in their natural 
setting, as they would be for C major. Any pitches that do not fit with the current harp pedaling, 
excluding the two lowest harp strings, appear red when colors for notes out of range are shown.

PROCEDURE

1. In Write mode, select the region you want to use to calculate harp pedaling in one of the 
following ways:

● Select an existing single note from which you want to calculate harp pedaling.

● Select a range of notes for which you want to calculate harp pedaling.

NOTE

Dorico SE ignores the lowest two harp strings, C and D, when calculating harp pedals.

2. Choose Write > Calculate Harp Pedals.

RESULT
A harp pedal diagram is input at the start of your selection. Depending on your per-layout 
settings, it is either displayed as a diagram, using note names, or not shown and instead 
indicated by a signpost.

Inputting string indicators outside the staff with the popover
You can input string indicators outside the staff using the playing techniques popover, both 
during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a string 
indicator outside the staff. If you want to input a string indicator with a duration line, 
select items on the staff that span that duration.

2. Optional: If you want to input string indicators onto multiple staves at once, extend the caret 
to those staves.

3. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

4. Enter the appropriate entry for the string indicator you want into the popover.
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For example, enter string1 for just a string 1 indicator or string3-> for a string 3 indicator 
with duration.

5. Press Return  to close the popover.

Open-ended string indicators, such as string3->, automatically extend during note input as 
you continue inputting notes, or if you advance the caret by pressing Space  or clicking 
Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

6. Optional: During note input, stop open-ended string indicators by opening the playing 
techniques popover again and entering ?  into the popover.

This leaves the current string indicator with a duration line. You can also enter another string 
indicator into the popover, but this joins the current string indicator to the following one 
with a continuation line rather than a duration line, which is a less common notation.

RESULT
The specified string indicators are input. They are considered voice-specific by default, meaning 
they only apply to the voice indicated by the caret indicator during step input or the selected 
voice when adding string indicators to existing notes. They are automatically placed above the 
staff for up-stem voices and below the staff for down-stem voices.

During note input, string indicators are input at the caret position, and extend automatically if 
you included an open-ended string indicator with duration.

When adding string indicators to a single existing note, they are added to the selected note only 
and have no duration. When adding string indicators to a range of notes, they are added to the 
first note in the selection and have duration, which applies until the end of the selection.

By default, string indicators have dashed duration lines with a hook cap at the end.

AFTER COMPLETING THIS TASK

● If you input string indicators without duration but want to show dashed duration lines, you 
can add them.

● You can change the staff-relative placement of string indicators.

RELATED LINKS
Playing techniques popover on page 337
String indicators on page 797
Lengthening/Shortening items on page 396
Extending the caret to multiple staves on page 195
Changing the staff-relative placement of items on page 400
Notations toolbox on page 178
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186

Inputting string indicators outside the staff with the panel
You can input string indicators outside the staff using the Playing Techniques panel, both during 
note input and by adding them to existing music.

NOTE

● You cannot input string indicators with duration during note input when using the panel. 
You can only do so when using the popover.

● These steps describe inputting with the default mouse input preference Create item at 
selection. If you want to input the same string indicator in multiple places, change your 
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mouse input preference to Load pointer with item so that you do not have to reselect the 
string indicator for each note.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input a string 
indicator outside the staff. If you want to input a string indicator with a duration line, 
select items on the staff that span that duration.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Guitar section.

4. Click the string indicator you want.

RESULT
The specified string indicator is input. It is considered voice-specific by default, meaning it only 
applies to the voice indicated by the caret indicator during step input or the selected voice when 
adding string indicators to existing notes. It is automatically placed above the staff for up-stem 
voices and below the staff for down-stem voices.

During note input, string indicators are input at the caret position, even if your preference is set 
to Load pointer with item.

When adding string indicators to a single existing note, they are added to the selected note only 
and have no duration. When adding string indicators to a range of notes, they are added to the 
first note in the selection and have duration, which applies until the end of the selection.

By default, string indicators have dashed duration lines with a hook cap at the end.

AFTER COMPLETING THIS TASK

● If you input string indicators without duration but want to show dashed duration lines, you 
can add them.

● You can change the staff-relative placement of string indicators.

RELATED LINKS
Playing Techniques panel on page 340
Changing your mouse input settings on page 189

Inputting string indicators inside the staff
You can show a string indicator inside the staff for each fretted instrument note. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains. Dorico SE 
automatically detects a string that each pitch could be played on, but you can also specify the 
string manually.

NOTE

These steps only apply to notes belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes belonging to fretted instruments beside which you want to show string 
indicators.

2. In the Properties panel, activate Show in the String Indicators group.

RESULT
String indicators are shown in the staff beside each selected note. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

Unless you have specified a string for each note, the string number shown in the string 
indicators is calculated automatically. String indicators inside the staff for open strings appear 
as a bold number zero without a circle enclosure.

By default, string indicators appear on the left of noteheads without left-hand fingerings and on 
the right of noteheads with left-hand fingerings.

AFTER COMPLETING THIS TASK

● You can specify the string on which notes are played, which affects the number shown in 
their corresponding string indicators.

● You can change the notehead-relative position of string indicators.

RELATED LINKS
String indicators on page 797
Fingerings for fretted instruments on page 789
Fretted instrument tuning on page 124
Assigning notes to strings on page 846
Changing the notehead-relative position of string indicators on page 799
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Input methods for lines
You can input both horizontal and vertical lines by using the Lines panel. There is no popover for 
lines.

TIP

If you want lines to represent specific notations that affect playback if applicable, you can instead 
input these notations directly. For example, dynamics, arpeggios, glissandi, and trills all have 
dedicated features in Dorico SE.

RELATED LINKS
Lines on page 946
Input methods for dynamics on page 284
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Input methods for clefs and octave lines on page 299
Input methods for tempo marks on page 268
Input methods for repeats and tremolos on page 372
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Lines panel
The Lines panel contains the different types of lines available in Dorico SE. It is located in the 
right zone in Write mode.

● You can hide/show the Lines panel by clicking Panels , then Lines  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Lines panel contains the following sections:

Horizontal
Contains the different horizontal lines available. The options at the top of the section 
allow you to determine the attachment type for the start and end of horizontal lines 
you subsequently input. Horizontal lines can be attached to noteheads, barlines, or 
rhythmic positions, and the start and end can have different attachment types.

Vertical
Contains the different vertical lines available.

RELATED LINKS
Notations toolbox on page 178
Lines on page 946
Line components on page 948

Inputting horizontal lines
You can input horizontal lines between existing notes or spanning a specified duration using the 
Lines panel. Horizontal lines can be attached to noteheads, barlines, or rhythmic positions, and 
can have different attachment types at their start and end.

You can also input barline-/rhythmic position-attached lines that apply to all staves.

NOTE

● You cannot change the attachment type of horizontal lines after they have been input.

● If you want to input notehead-attached horizontal lines to represent glissandi, you can 
instead input glissando lines directly.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, select one of the following:

● If you want to input a notehead-attached line, select the notes you want to join with a 
line.

TIP

The notes can be in different voices, on different staves, and belong to any instruments 
held by the same player.
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● If you want to input a barline-/rhythmic position-attached line, select items that span the 
required duration of the line.

● If you want to input a horizontal line that is attached to noteheads at one end but 
barlines/rhythmic positions at the other end, select the required note and any item at 
the required rhythmic position of the other end.

2. In the Notations toolbox, click Panels , then Lines  to show the Lines panel.

3. In the Horizontal section, choose one of the following options for both Start and End:

● Attach to notehead 

● Attach to barline (where available) 

● Attach to rhythmic position 

4. Input a line with the specified attachments in one of the following ways:

● To input a notehead-attached line or barline-/rhythmic position-attached line on the 
selected staff only, click it in the Horizontal section.

● To input a barline-/rhythmic position-attached line that applies to all staves, Alt/Opt -
click it in the Horizontal section.

RESULT
A horizontal line with the specified attachments is input. They are positioned according to their 
attachment types and their rhythmic positions.

Horizontal lines that apply to all staves are categorized as system objects. Therefore, they follow 
your per-layout settings for the visibility and positioning of system objects.

AFTER COMPLETING THIS TASK

● You can change the placement and staff position of barline-/rhythmic position-attached 
lines.

● You can add text to lines.

RELATED LINKS
Notations toolbox on page 178
Lines on page 946
Positions of lines on page 949
Length of lines on page 953
System objects on page 1044
Changing the positions of system objects on page 1045
Adding text to lines on page 958
Changing the placement of horizontal lines on page 951
Inputting glissando lines with the popover on page 319
Mouse input settings on page 188

Inputting vertical lines
You can input vertical lines on existing notes using the Lines panel, including across notes in 
multiple voices and on different staves that belong to the same instrument, such as piano or 
harp.

NOTE

● If you want to input vertical lines to represent arpeggios, you can instead input arpeggio 
signs directly.

● You can only input one vertical line at a time.
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● These steps describe inputting with the default mouse input preference Create item at 
selection. You cannot create cross-staff and cross-voice vertical lines if your preference is set 
to Load pointer with item.

PROCEDURE

1. In Write mode, select at least one note at the same rhythmic position in each voice to which 
you want to add a vertical line.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff vertical lines. However, you cannot create 
cross-staff vertical lines between different instruments, even if they are held by the same 
player.

● Vertical lines are added to all notes in the selected voices at the selected rhythmic 
position.

2. In the Notations toolbox, click Panels , then Lines  to show the Lines panel.

3. In the Vertical section, click the line you want.

RESULT
The vertical line specified is input to the left of the selected notes. Its length is adjusted 
automatically so that it spans the range of all notes in the selected voices/staves at that rhythmic 
position.

AFTER COMPLETING THIS TASK

● You can change the order of lines when multiple exist at the same rhythmic position and 
show vertical lines on the right of notes.

● You can lengthen/shorten vertical lines.

● You can add text to lines.

RELATED LINKS
Notations toolbox on page 178
Lines on page 946
Length of lines on page 953
Lengthening/Shortening vertical lines on page 954
Adding text to lines on page 958
Showing vertical lines on the right/left of notes on page 950
Changing the horizontal order of vertical lines on page 950
Inputting arpeggio signs with the popover on page 318
Changing your mouse input settings on page 189

Inputting text items
You can input text at specific rhythmic positions in the score using text items. You can input 
staff-attached text for single staves or input system-attached text that applies to all staves and 
appears in all applicable layouts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select an item on the staff and at the rhythmic position where you want to input text.

2. Open the text editor in any of the following ways:

● To input staff-attached text, press Shift-X  or click Popovers , then Text  in the 
Notations toolbox.

● To input staff-attached text with a specific paragraph style, choose Write > Create 
Text > [Paragraph style].

● To input system-attached text, press Shift-Alt/Opt-X .

● To input system-attached text with a specific paragraph style, choose Write > Create 
System Text > [Paragraph style].

3. Enter the text you want.

● To insert a music symbol, right-click in the text item and choose Insert Music Text from 
the context menu to open the Insert Music Text dialog. Select the music symbol you 
want to insert, then click OK.

● To insert a line break, press Return .

4. Optional: Format the text using the text editor options.

5. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
During note input, the text you entered into the text editor is input at the caret position. When 
adding text to existing music, it is input at the position of the earliest selected item.

If you did not change or specify the paragraph style, the text item uses the Default Text 
paragraph style.

Text items are automatically placed above the staves to which they apply and follow the default 
settings for the vertical position of text.

NOTE

● In Dorico SE, system-attached text is categorized as a system object. Therefore, system-
attached text follows your per-layout settings for the visibility and positioning of system 
objects.

● You can assign key commands for inputting text with specific paragraph styles, for both 
Create Text and Create System Text, on the Key Commands page in Preferences.

RELATED LINKS
Notations toolbox on page 178
Changing the staff-relative placement of items on page 400
Types of text on page 1066
Text items on page 1065
System objects on page 1044
Key Commands page in the Preferences dialog on page 54
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Text editor options in Write mode
The text editor allows you to add and format text. In Write mode, it opens when you add or edit 
text items.

The text editor provides the following options:

1 Character Style

Allows you to change the appearance of selected text within paragraphs. This overrides the 
paragraph style applied to the corresponding paragraph.

2 Paragraph Style

Allows you to change the paragraph style applied to the whole text item. Depending on the 
paragraph style, this can change the appearance, formatting, and alignment of the text.

3 Font

Allows you to change the font family of selected text.

4 Font Style

Allows you to change the font style of selected text.

NOTE

● Depending on the font selected, some font styles might not be available.

● You can also change the font style using the following standard key commands:

● Ctrl/Cmd-B  for bold

● Ctrl/Cmd-I  for italic

5 Font Size

Allows you to change the size of selected text.

TIP

You can also change the font size using the following key commands:

● Ctrl/Cmd-Shift-.  to increase the font size

● Ctrl/Cmd-Shift-,  to decrease the font size

6 Font Stretch

Allows you to make selected text wider or narrower.

7 Baseline Shift

Allows you to shift the baseline of selected text gradually up or down.

8 Letter Spacing

Allows you to increase/decrease the space between the characters of selected text.

9 Word Spacing

Allows you to increase/decrease the space between the words of selected text.

10 Alignment
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Allows you to choose one of the following alignments for the text item relative to its rhythmic 
position:

● Align Left

● Align Center

● Align Right

11 Line Types

Allows you to show any of the following types of lines, in any combination, on selected text:

● Underline

● Overline

● Strikethrough

TIP

You can also make selected text underlined by pressing Ctrl/Cmd-U .

12 Script Types

Allows you to position selected text in one of the following positions relative to the text on 
the baseline:

● Superscript

● Subscript

13 Foreground Color

Allows you to change the color of selected text.

14 Background Color

Allows you to change the background color of selected text.

RELATED LINKS
Types of text on page 1066
Text items on page 1065
Missing Fonts dialog on page 69

Insert Music Text dialog
The Insert Music Text dialog allows you to add music symbols, such as accidentals and note 
symbols, to text items.

● You can open the Insert Music Text dialog when inputting or editing text in a text item by 
right-clicking and choosing Insert Music Text from the context menu.
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The Insert Music Text dialog comprises the following:

1 Search field

Allows you to search for music symbols by their SMuFL name. When you start entering text, a 
menu appears that shows valid music symbols containing the letters/words you enter, which 
you can select.

2 Range menu

Allows you to select which SMuFL glyph range is available in the music symbol selector. By 
default, Recently used is selected, which contains common accidentals and note symbols in 
addition to music symbols you have used in recent projects.

3 Music symbol selector

Contains the available music symbols in the selected range or that match your entry.

4 Name

Displays the SMuFL name and description, where available, of the selected music symbol.

5 OK

Inserts the selected music symbol at the cursor position with the Music Text character style 
applied to them automatically.

You can also insert music symbols by pressing Return .

Editing text in text items
You can edit the text shown in text items; for example, to replace individual words or to change 
their formatting.

PROCEDURE

1. Open the text editor for an existing text item in any of the following ways:

● Select the text item and press Return .

● Double-click the text item.

2. Edit the text in the text item.

For example, you can format the text using the text editor options.

3. Press Esc  or Ctrl/Cmd - Return  to close the text editor.
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Inputting lyrics
You can input lyrics by entering text into the lyrics popover, and you can advance the lyrics 
popover to the next note on the staff without closing and reopening it for every note.

PROCEDURE

1. In Write mode, select the note on the staff from which you want to start inputting lyrics.

2. Open the lyrics popover in any of the following ways:

● Press Shift-L .

● In the Notations toolbox, click Popovers , then Lyrics .

3. Optional: Change the type of lyric in one of the following ways:

● To change the lyric line number, press Down Arrow .

● To input lyrics above the staff, press Shift - Up Arrow .

● To input chorus lines, press Up Arrow .

● To input lyric line translations, press Alt/Opt - Down Arrow .

4. Enter the word or syllable you want to add to the selected note into the popover.

● To enter multiple words on a single note, press Shift-Alt/Opt-Space .

● To include a hyphen within a single word or syllable, press Alt/Opt--  (hyphen).

● To include an elision in a lyric, press _  (underscore).

5. Advance the popover to the next note in one of the following ways:

● If you entered a complete word, or the final syllable in a multi-syllabic word, press 
Space .

● If you entered one syllable of a multi-syllabic word that is not the final syllable, press - 
(hyphen).

● If you do not want the syllable to be followed by an extension line or hyphen, press 
Right Arrow .

TIP

For lyrics sung over multiple notes, you can press these key commands multiple times until 
the lyrics popover reaches the note where you want to input the next lyric.

6. Continue entering words and syllables into the popover for the rest of the notes to which 
you want to add lyrics.

7. Press Return  or Esc  to close the popover.

The popover closes automatically when you reach the last note on the staff.

RESULT
The text you entered into the popover is input as lyrics of the type indicated by the icon on the 
left-hand side of the popover.

When you advance the popover to the next note by pressing - , a hyphen appears after the last 
entered lyric. This is used for multi-syllabic words across multiple notes.

When you advance the popover by pressing Space , a gap appears after the last entered lyric. 
This is used for single-syllable words or for the final syllable in multi-syllabic words.
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TIP

● You can later change whether a gap or a hyphen appears between lyrics by changing their 
syllable type.

● You can also input lyrics by copying and pasting them; for example, from an external text 
editor.

RELATED LINKS
Notations toolbox on page 178
Copying and pasting lyrics on page 824
Lyrics on page 821
Navigation during lyric input on page 362
Types of lyrics on page 821
Types of syllables in lyrics on page 823
Lyric line numbers on page 835
Lyric hyphens and lyric extender lines on page 835
Elision slurs on page 838
Lyric text editing on page 831

Lyrics popover
You can input lyrics, including chorus lines and lyric line translations, using the lyrics popover. 
You can use key commands to change the type of lyric being input at any time.

You can open the lyrics popover in Write mode in any of the following ways when either an item 
is selected or the caret is active:

● Press Shift-L .

● In the Notations toolbox, click Popovers , then Lyrics .

● Select an existing lyric and press Return .

● Choose Write > Create Lyrics.

Lyric lines
The popover automatically opens ready to input lyrics into Line 1, except if you are 
changing an existing lyric.

The number shown on the left-hand side of the lyrics popover indicates the lyric line 
into which the lyric is input.

The lyrics popover with an example entry for Line 1

You can change the lyric line number by pressing Up Arrow  and Down Arrow  when 
the lyrics popover is open.

The lyrics popover with an example entry for Line 2

Lyric lines above the staff
You can input lyrics into lines above the staff by pressing Shift - Up Arrow  when the 
lyrics popover is open.

You can then press Up Arrow  and Down Arrow  to change the lyric line number 
above the staff.
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Chorus lines
You can input chorus lines by pressing Up Arrow  when the lyrics popover is open. You 
can do this when inputting lyrics below the staff and above the staff.

A c, for “chorus lines”, is shown on the left-hand side of the popover.

The lyrics popover with an example entry for a chorus line

Lyric line translations
You can input lyric line translations by pressing Alt/Opt - Down Arrow  when the lyrics 
popover is open.

An asterisk (*) is shown beside the lyric line number for which you are inputting a lyric 
line translation on the left-hand side of the popover.

The lyrics popover with an example entry for a lyric line translation

Navigation during lyric input
You can move the lyrics popover to input new lyrics and edit existing lyrics without having to 
close and reopen the lyrics popover.

Popover navigation Key command

Finish the current word and advance the 
popover to the next note or chord.

Space

Finish the current syllable and advance the 
popover to the next note or chord.

-  (hyphen)

Advance the popover to the next note without 
showing an extension line or hyphen.

Right Arrow

Move the cursor to the next/previous letter. If 
the next/previous letter is in another lyric, the 
popover advances to that lyric.

Right Arrow / Left Arrow

Move the popover forwards/backwards from 
syllable to syllable within lines of lyrics.

Alt/Opt-Right Arrow / Alt/Opt-Left Arrow

Add spaces within a word or syllable without 
advancing the popover.

Shift-Alt/Opt-Space

Add a hyphen within a single word or syllable 
without advancing the popover.

Alt/Opt--  (hyphen)

Add an elision slur within a word or syllable. _  (underscore)
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Inputting figured bass
You can input figured bass using the figured bass popover, both for all instruments or only for 
individual instruments. You can also open the figured bass popover during note input; however, 
inputting a figure stops note input.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
start inputting figured bass.

2. Open the figured bass popover in any of the following ways:

● Press Shift-G .

● In the Notations toolbox, click Popovers , then Figured Bass .

NOTE

If you selected an item on a staff that has local figures at earlier rhythmic positions, the 
figured bass popover is automatically set to input local figures when it opens.

3. Optional: Change the type of figure you want to enter in one of the following ways:

● To input local figures, press Alt/Opt-L .

● To input global figures, press Alt/Opt-G .

The popover icon updates to show the current type.

Figured bass popover when inputting a global 
figure

Figured bass popover when inputting a local 
figure

4. Enter the figure you want into the figured bass popover.

For example, enter 4->3d=4r=2 for a 4-3 suspension that lasts a whole note, with the 
resolution to the third after a half note. For bracketed figures, include parentheses around 
the required figures or accidentals, such as (#)64(3).

If you want Dorico SE to follow your entry exactly, include O, o, or ! at the start of your entry. 
For example, to force Dorico SE to show 5,3 figures.

5. Optional: Press Space  to advance the popover to the next beat according to the prevailing 
time signature.

TIP

You can also navigate the popover forwards and backwards by different amounts.

6. Optional: To input an individual local figure when the popover is set to global, and vice versa, 
press Alt/Opt-Return  to input the figure.

7. Press Return  to close the popover.

RESULT
The figured bass specified is input. If you selected an item belonging to an instrument that was 
not already set to show figured bass in the current layout, its player is automatically updated to 
show them. If Dorico SE cannot identify the bass note at the position of a figure, such as if you 
input a figure on a rest, it appears as a signpost.
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Dorico SE calculates and saves the pitches implied by the figures you enter in relation to the 
lowest note at that rhythmic position. This semantic understanding of the harmony implied by 
figures allows Dorico SE to update the displayed figures on different staves and if you transpose 
or change the pitch of notes.

Global figures apply to all instruments in the project and appear on all staves whose players are 
set to show figured bass. Local figures only apply to the selected instrument, and by default refer 
to its lowest staff. Local figures always appear, even if global figures exist at the same rhythmic 
positions.

NOTE

●

Unless you included an entry for Follow input literally at the start of your popover entry, the 
appearance of the resulting figure is determined by the default settings in Dorico SE

EXAMPLE
Entering 4->3d=4r=2 into the figured bass popover produces a 4-3 suspension that lasts a whole 
note, with the resolution to the third after a half note.

AFTER COMPLETING THIS TASK

● You can hide/show figured bass above specific players in each layout independently.

● You can simplify compound figures; that is, figures 9 and above.

● You can show figures on individual rests.

RELATED LINKS
Figured bass on page 771
Figured bass hold lines on page 774
Navigation during figured bass input on page 367
Hiding/Showing figured bass in layouts on page 772
Hiding/Showing figured bass hold/suspension lines on page 775
Lengthening/Shortening figured bass hold lines on page 776
Moving figured bass resolutions on page 779
Showing single brackets on figured bass on page 774
Showing brackets on figured bass hold lines on page 777
Simplifying figured bass compound intervals on page 780
Showing figured bass on rests on page 773
Fixing the current appearance of figured bass on page 781

Figured bass popover
The following tables contain examples of what you can enter into the figured bass popover to 
input the different possible figured bass figures, including alterations and suspensions.

You can open the figured bass popover in Write mode in any of the following ways when either a 
note is selected or the caret is active:

● Press Shift-G .

● In the Notations toolbox, click Popovers , then Figured Bass .
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● Choose Write > Create Figured Bass.

When inputting global figured bass, the icon on the left-hand side of the popover matches the 
corresponding button in the Notations toolbox. When inputting local figured bass, the icon on 
the left-hand side of the popover appears smaller and includes the icon for a single player.

Figured bass popover with an 
example entry for a global figure

Figured bass popover with an 
example entry for a local figure

Figured Bass button in the 
Notations toolbox

Figures and suspensions

Type of figure Example popover entry

Figures (1-19) 1, 2, 3, and so on, up to 19

Bracketed figures or accidentals (#643), #64(3), (#)643, and so on

Figures determined by chord symbols

Dorico SE automatically converts chord 
symbols, as you would enter into the chord 
symbols popover, into correct figured bass.

Em7, Amaj7, or G/B, and so on

tasto solo ts or tasto

Hold duration d=2 (number of quarter notes) or d=1/2n 
(fraction of bass note duration)

Multiple figures

TIP

You can separate figures with commas to 
remove ambiguity.

6#42 or 6,#4,2

Hide figures <3> or {3}

Suspensions 4->3, 4_3, or 4~3

Suspension duration; that is, the duration 
between suspension and resolution figures

r=2 (number of quarter notes) or r=1/2n 
(fraction of bass note duration)

Hold and suspension durations both specified

For example, a 4-3 suspension that lasts a 
whole note, with the resolution to the third 
after a half note.

4->3d=4r=2 or 4->3d=1nr=1/2n
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Type of figure Example popover entry

Follow Engraving Options for this figure only

NOTE

Must be at the start of the popover entry.

R, r, V, v, or ?

Follow input literally for this figure only

NOTE

Must be at the start of the popover entry.

O, o, or !

This list is not comprehensive. It is intended to illustrate how you can structure your entry to 
input different figures.

NOTE

Unless you include an entry for Follow input literally at the start of your popover entry, the 
appearance of resulting figures is determined by Dorico SE’s default settings.

EXAMPLE
Entering 4->3d=4r=2 into the figured bass popover produces a 4-3 suspension that lasts a whole 
note, with the resolution to the third after a half note.

Accidentals and alterations

Type of accidental/alteration Popover entry

Sharp

TIP

For raised thirds, you can enter just without 
the number.

# or s

Flat b or f

Natural N or n

Double sharp x, ##, or ds

Triple sharp x#, #x, ###, or ts
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Type of accidental/alteration Popover entry

Double flat bb or db

Triple flat bbb or tb

Raise figure by a half-step (semitone) +

Lower figure by a half-step (semitone) -

Diminished figure d

Unaltered figure u

RELATED LINKS
Notations toolbox on page 178
Figured bass on page 771
Figured bass hold lines on page 774
Hiding/Showing figured bass hold/suspension lines on page 775
Lengthening/Shortening figured bass hold lines on page 776
Showing brackets on figured bass hold lines on page 777
Showing single brackets on figured bass on page 774
Chord symbols popover on page 293

Navigation during figured bass input
You can move the figured bass popover manually by different amounts to input figured bass 
figures at other positions without closing and reopening the popover each time.

Popover navigation Key command

Advance the popover to the next beat, 
according to the prevailing time signature.

Space

Move the popover back to the previous beat, 
according to the prevailing time signature.

Shift-Space

Advance the popover to the start of the next 
bar.

Tab

Move the popover back to the start of the 
previous bar.

Shift-Tab

Move the cursor and popover to one of the 
following positions, whichever is closest:

● Next/Previous note or rest

● Next/Previous rhythmic grid position

● Next/Previous character in existing figure’s 
entry

Right Arrow / Left Arrow
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Popover navigation Key command

Move the popover to the next/previous figure. Ctrl/Cmd-Right Arrow / Ctrl/Cmd-Left Arrow

RELATED LINKS
Key Commands page in the Preferences dialog on page 54

Inputting rehearsal marks
You can input rehearsal marks with the mouse and the keyboard. You can input rehearsal marks 
during note input and later by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a rehearsal mark. For 
example, a barline or a note.

NOTE

You can only input one rehearsal mark at a time, even if multiple items are selected.

2. Input a rehearsal mark in any of the following ways:

● Press Shift-A .

● In the Notations toolbox, click Popovers , then Rehearsal Marks .

RESULT
A rehearsal mark is input at the selected barline, or at the rhythmic position of other selected 
items.

The order of rehearsal marks is updated automatically, meaning you can input them in any 
order, including before and between existing rehearsal marks.

AFTER COMPLETING THIS TASK
If you want to change the letter/number displayed in the rehearsal mark, you can change its 
index and/or sequence type.

RELATED LINKS
Notations toolbox on page 178
Rehearsal marks on page 963
Changing the index of rehearsal marks on page 964
Changing the rehearsal mark sequence type on page 965
Adding prefixes/suffixes to rehearsal marks on page 966
Going to rehearsal marks on page 405
Mouse input settings on page 188
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Inputting markers/timecodes
You can input markers at specific positions in time. In Dorico SE, timecodes are automatically 
shown alongside markers.

PROCEDURE

1. In Write mode, move the playhead to the time position where you want to input a marker.

2. Press Shift-Alt/Opt-M  to open the Add Marker dialog.

3. Enter the marker text you want into the Text field.

4. Optional: Change the timecode in the Timecode field.

5. Click OK to input the marker and close the dialog.

RESULT
A marker is input at the timecode position set in the Add Marker dialog, which by default is the 
position of the playhead. It shows the text you entered, or the default text “Marker” if you did not 
change the marker text, and a timecode reflecting its position.

TIP

You can also input markers by clicking Add Marker  in the Markers section of the Video panel, 
or by using the Markers track in Play mode.

RELATED LINKS
Markers on page 967
Timecodes on page 971
Moving the playhead on page 456
Editing marker text on page 969
Changing the timecodes of markers on page 969
Video panel on page 370
Markers track on page 451

Add Marker dialog
The Add Marker dialog allows you to input markers with custom text at specific timecodes.

● The Add Marker dialog opens automatically when you input markers in Write mode, either 
by pressing Shift-Alt/Opt-M  or by clicking Add Marker  in the Markers section of the 
Video panel.

The Add Marker dialog contains the following options:
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Text
Allows you to enter custom text that is shown in the marker.

Timecode
Allows you to specify the timecode at which you want to input the marker. For example, 
if you already know the timecodes for each marker, you can enter them directly rather 
than positioning the playhead at the position of each marker.

Valid range
Displays the timecode range of the flow.

Video panel
The Video panel in Write mode allows you to access the Video Properties dialog, and to input 
and edit markers and timecodes. You can also define markers as important and calculate suitable 
tempos for them. It is located in the right zone in Write mode.

● You can hide/show the Video panel by clicking Panels , then Video  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

In the Video section of the Video panel, you can click Properties to open the Video Properties 
dialog.

The Markers section of the Video panel contains a table of markers, divided into the following 
columns:

Timecode
Shows the timecode of the marker. You can edit the timecode by double-clicking in the 
field.

Text
Shows the text of the marker. You can edit the text by double-clicking in the field.

Imp.
Stands for “important”. Allows you to define markers as important by activating their 
checkbox in this column.

When markers are defined as important, their entry uses a bold font in the table and 
they are considered when finding a suitable tempo in the Find Tempo dialog.

The action bar at the bottom of the table contains the following options:

● Add Marker : Adds a marker at the playhead position.

● Delete Marker : Deletes the selected marker.

NOTE

You can only delete one marker at a time.

RELATED LINKS
Notations toolbox on page 178
Video Properties dialog on page 167
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Find Tempo dialog
The Find Tempo dialog allows you to calculate tempos that best accommodate your important 
markers; for example, by identifying which tempos cause markers to coincide as closely as 
possible with strong beats.

● You can open the Find Tempo dialog in Write mode by clicking Find Tempo in the Markers 
section of the Video panel.

NOTE

● The Find Tempo dialog only considers markers in a single flow. You can change which flow 
by selecting an item in the corresponding flow and then opening the dialog.

● The Find Tempo dialog is only available if you have input at least one marker in the flow and 
defined at least one marker as important.

The Find Tempo dialog contains the following options and sections:

Flow
Shows the name of the flow whose tempo you are determining. This field is read-only.

Beat unit
Allows you to change the beat unit considered for the tempo. For example, if the time 
signature for the flow is 6/8, you might want to change the beat unit to a dotted 
quarter note.

Tempo range
Allows you to set the minimum/maximum tempos you want to consider.

Tempo increments
Allows you to filter the suggested tempos according to their precision.

● Integral only: Only whole number tempos, that is, tempos without decimal places, 
are suggested.

● Allow increment by 0.25: Allows tempos with decimal places of .25, .5, and .75 to 
be suggested.
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Tempos found
Contains a list of possible tempos that you can select to see how they affect the 
position of your markers relative to beats. The list is updated automatically when you 
change options such as Tempo range and Beat unit.

The list contains columns for the following information:

● BPM: Stands for “beats per minute”. Lists different possible tempos according to 
their metronome mark value.

● IFO: Stands for “important frames off”. Indicates the average number of frames by 
which important markers miss significant beats, either before or after.

● NFO: Stands for “non-important frames off”. Indicates the average number of 
frames by which non-important markers miss significant beats, either before or 
after.

● AFO: Stands for “all frames off”. Indicates the average number of frames by which 
all markers in the flow miss significant beats, either before or after.

Found tempos are listed in descending order of average frames off for important 
markers.

Markers
Shows the impact that the tempo currently selected in the Tempos found list would 
have on each marker in the flow in more detail.

● Timecode: Shows the exact timecode of each marker.

● Text: Shows the marker text of each marker to help you identify them.

● Imp.: Indicates whether a marker has been defined as important.

● Fr. Off: Stands for “frames off”. Shows the average number of frames by which 
each marker misses being aligned to beats.

● Time Diff.: Stands for “time difference”. Shows the time difference between the 
position of the marker and the position of the nearest beat, expressed in fractions 
of a second.

● Not. Diff.: Stands for “notated difference”. Shows the notated difference between 
the position of the marker and the position of the nearest beat, expressed in 
fractions of a whole note.

Selected tempo
Displays the currently selected tempo for the flow.

Apply
Applies the selected tempo to the flow by inputting it as a tempo mark at the 
beginning of the flow. Any other tempo marks in the flow are automatically deleted.

RELATED LINKS
Defining markers as important on page 970
Metronome marks on page 1058

Input methods for repeats and tremolos
You can input repeats and tremolos, including repeat endings, repeat markers, and rhythm 
slashes, with the keyboard by using the repeats popover, and with the mouse by using the 
Repeat Structures panel.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.
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TIP

To indicate repeats using repeat barlines, you can input repeat barlines using the available input 
methods for barlines.

RELATED LINKS
Input methods for bars, beats, and barlines on page 275
Barlines on page 672
Types of barlines on page 672
Repeat endings on page 975
Repeat markers on page 979
Tremolos on page 1099
Rhythm slashes on page 997
Bar repeats on page 985
Numbered bar regions on page 992
Repeats in playback on page 463

Repeats popover
The following tables contain the entries for the repeats popover that you can use to input the 
different tremolos, repeat markers, repeat endings, and bar repeat, slash, and numbered bar 
regions available.

You can open the repeats popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

● Select an existing repeat marker, slash region, or bar repeat and press Return .

● Choose Write > Create Repeat.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Repeats popover with an example entry
Repeat Structures button in the Notations toolbox

Repeat endings

Part of repeat ending Popover entry

Whole repeat ending end or ending

Additional repeat ending segment add
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Repeat markers

Type of repeat marker Popover entry

D.C. dc, D.C., da capo, and so on

D.C. al Fine dcalf, DC al Fine, D.C. al Fine, and so on

D.C. al Coda dcalc, DC al Coda, D.C. al Coda, and so on

D.S. ds, D.S., dal segno, and so on

D.S. al Fine dsalf, DS al Fine, D.S. al Fine, and so on

D.S. al Coda dsalc, DS al Coda, D.S. al Coda, and so on

to Coda toc, tc, to coda, To Coda, and so on

Segno s, seg, segno, and so on

Fine f, fin, fine, and so on

Coda c, co, coda, and so on

The list of entries for repeat markers is not comprehensive, as the flexibility of the popover 
means you can enter any reasonable version or abbreviation of the type of repeat marker you 
want, and the popover recognizes it in most cases.

Single-note tremolos

Type of tremolo Popover entry

One stroke /, \, or 1

Two strokes //, \\, or 2

Three strokes ///, \\\, or 3

Four strokes ////, \\\\, or 4

Z on stem (buzz roll) z or zonstem

Tremolo with release; for example, two-strokes 
with release

rel; for example, //rel or 2rel

Tremolo with attack; for example, two-strokes 
with attack

att; for example, //att or 2att

Remove all tremolos 0 or clear
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Multi-note tremolos

Type of tremolo Popover entry

One stroke /2, \2, or 12

Two strokes //2, \\2, or 22

Three strokes ///2, \\\2, or 32

Four strokes ////2, \\\\2, or 42

Remove all tremolos 0 or clear

Slash regions

Slash region Popover entry

New slash region slash

Numbered bar regions

Numbered bar region Popover entry

New numbered bar region nb, num, numbars, or number bars

Bar repeats

Type of bar repeat Popover entry

Repeat last bar % or %1

Repeat last 2 bars %2

Repeat last 4 bars %4

Repeat last bar, group in 2 %1,2

Repeat last bar, group in 4 %1,4

Repeat last 2 bars, group in 4 %2,4

RELATED LINKS
Notations toolbox on page 178
Inputting repeat endings with the popover on page 377
Inputting repeat markers with the popover on page 380
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Inputting tremolos with the popover on page 381
Inputting slash regions on page 384
Inputting bar repeats on page 385
Inputting numbered bar regions on page 386
Bars and barlines popover on page 276
Repeat endings on page 975
Repeat markers on page 979
Tremolos on page 1099
Rhythm slashes on page 997
Bar repeats on page 985
Numbered bar regions on page 992

Repeat Structures panel
The Repeat Structures panel contains the different types of repeat notations available in Dorico 
SE, including repeat endings, tremolos, and bar repeats. It is located in the right zone in Write 
mode.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

● You can hide/show the Repeat Structures panel by clicking Panels , then Repeat 
Structures  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Repeat Structures panel contains the following sections:

Repeat Endings
Contains options that allow you to input new repeat endings and add additional 
endings to existing repeat endings.

Repeat Jumps
Contains different types of repeat markers that instruct players to jump to a specific 
point in the piece, such as “D.S. al Coda”.

Repeat Sections
Contains different sections used in conjunction with repeat jumps, such as “Coda”.

Tremolos
Contains different types of single-note and multi-note tremolos.

Rhythm Slashes
Allows you to input a region that displays rhythm slashes that are automatically 
formatted to be compatible with the prevailing time signature.

Bar Repeats
Allows you to input a region that indicates that the preceding bar is repeated without 
re-notating the bar.

TIP

You can input bar repeat regions with different bar groupings when using the repeats 
popover.

Numbered Bars
Allows you to input a region that displays bar counts without additional notations.
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RELATED LINKS
Notations toolbox on page 178
Repeats popover on page 373

Inputting repeat endings with the popover
You can input repeat endings using the repeats popover, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select at least one item in each bar that you want to include in the first ending.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter end or ending into the popover.

4. Press Return  to close the popover.

RESULT
The repeat ending is input, with the first ending segment covering the bars in which you selected 
items, and a second ending segment created automatically in the following bar.

An end repeat barline is created at the end of the first ending if none exists already.

RELATED LINKS
Repeats popover on page 373
Repeat endings on page 975

Adding additional repeat endings with the popover

You can have more than two possible endings in each repeat ending structure by adding 
additional segments using the repeats popover. You can add repeat ending segments both 
during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the bars that you want to include in the additional ending.
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NOTE

Your selection must start from the first bar following the previous repeat ending 
segment.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter add into the popover.

4. Press Return  to close the popover.

5. Optional: Repeat these steps as many times as required for the number of additional 
endings you want.

RESULT
A new repeat ending segment is added. The existing previous repeat ending segment now ends 
with a closed line, with an end repeat barline created if necessary.

TIP

You can also add additional repeat ending segments by selecting the repeat ending and 
changing the value for No. endings in the Repeat Endings group of the Properties panel.

However, No. endings only adds additional repeat ending segments that contain one bar, and 
does not automatically input or reposition repeat barlines. You must input repeat barlines as 
appropriate manually.

EXAMPLE

Default repeat ending structure with two 
endings

Repeat ending structure with additional third ending

Inputting repeat endings with the panel
You can input repeat endings using the Repeat Structures panel, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select at least one item in each bar that you want to include in the first ending.
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2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Repeat Endings section, click Create Repeat Ending .

RESULT
The repeat ending is input, with the first ending segment covering the bars in which you selected 
items, and a second ending segment created automatically in the following bar.

An end repeat barline is created at the end of the first ending if none exists already.

RELATED LINKS
Repeat Structures panel on page 376

Adding additional repeat endings with the panel

You can have more than two possible endings in each repeat ending structure by adding 
additional segments using the Repeat Structures panel. You can add repeat ending segments 
both during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the bars that you want to include in the additional ending.

NOTE

Your selection must start from the first bar following the previous repeat ending 
segment.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Repeat Endings section, click Add Section To Repeat Ending .

NOTE

If increasing the number of endings makes the repeat ending collide with any part of 
another repeat ending, the other repeat ending is deleted. However, its repeat barlines are 
not deleted.

4. Optional: Repeat these steps as many times as required for the number of additional 
endings you want.

RESULT
A new repeat ending segment is added. The existing previous repeat ending segment now ends 
with a closed line, with an end repeat barline created if necessary.
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TIP

You can also add additional repeat ending segments by selecting the repeat ending and 
changing the value for No. endings in the Repeat Endings group of the Properties panel.

However, No. endings only adds additional repeat ending segments that contain one bar, and 
does not automatically input or reposition repeat barlines. You must input repeat barlines as 
appropriate manually.

EXAMPLE

Default repeat ending structure with two 
endings

Repeat ending structure with additional third ending

Inputting repeat markers with the popover
You can input repeat markers, including repeat jumps and repeat sections, using the repeats 
popover, both during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select an item at the rhythmic position where you want to input a repeat marker.

For repeat jumps, we recommend that you select the barline with which you want the 
end of the jump instruction to align. For repeat sections, we recommend that you select 
the barline with which you want the start of the section marker to align.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter the appropriate entry for the type of repeat marker you want into the popover.

For example, enter coda to input a coda section or enter $ to input a segno.

4. Press Return  to close the popover.

RESULT
During note input, repeat markers are input at the caret position. Coda sections are 
automatically formatted so that there is a gap between the coda and the preceding material.

When adding repeat markers to existing music, they are input at the rhythmic position of the 
earliest selected item.
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Repeat markers that indicate the end of a section, such as Fine and D.C. al Coda, are right-aligned 
with the selected rhythmic position.

RELATED LINKS
Repeats popover on page 373
Repeat markers on page 979
Repeats in playback on page 463
Hiding/Showing repeat markers on page 981

Inputting repeat markers with the panel
You can input repeat markers using the Repeat Structures panel, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select an item at the rhythmic position where you want to input a repeat marker.

For repeat jumps, we recommend that you select the barline with which you want the 
end of the jump instruction to align. For repeat sections, we recommend that you select 
the barline with which you want the start of the section marker to align.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. Click the repeat marker you want to input in any of the following sections:

● Repeat Jumps

● Repeat Sections

RESULT
During note input, repeat markers are input at the caret position. Coda sections are 
automatically formatted so that there is a gap between the coda and the preceding material.

When adding repeat markers to existing music, they are input at the rhythmic position of the 
earliest selected item.

Repeat markers that indicate the end of a section, such as Fine and D.C. al Coda, are right-aligned 
with the selected rhythmic position.

Inputting tremolos with the popover
You can input both single-note and multi-note tremolos using the repeats popover, both during 
note input and by adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tremolos.

NOTE

If you want to input multi-note tremolos, you must select at least two notes that are in 
the same voice, have the same duration, and are notated using a single notehead. The 
notes can also be tuplets and cross-staff notes.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter the appropriate entry for the type of tremolo you want into the popover.

For example, enter:

● // for single-note tremolos with two strokes.

● ///2 for multi-note tremolos with three strokes.

● //rel for two-stroke single-note tremolos with release.

4. Press Return  to close the popover.

RESULT
Single-note tremolos are input on the selected notes with the number of tremolo strokes 
specified. They appear on all notes in tie chains.

Tremolos with release show single-note tremolo strokes on all notes in tie chains apart from the 
last note. Tremolos with attack show single-note tremolo strokes on all notes in tie chains apart 
from the first note.

Multi-note tremolos with the number of tremolo strokes specified are input between selected 
individual notes and the notes immediately after them, or between selected pairs of notes. The 
notated duration of notes in multi-note tremolos is automatically updated. For example, two 
quarter notes joined by a multi-note tremolo both appear as half notes.

When tuplets are selected, multi-note tremolos are input across the selected tuplets, with the 
tremolo strokes positioned in the center of all notes in the tuplet. The tuplet bracket is hidden, 
and a signpost is shown at the start of each tuplet indicating its ratio.

EXAMPLE

Multi-note tremolos with three tremolo strokes 
across tuplets

Tremolo with release added to tie chain

Write mode
Notations input 

382
Dorico SE 4.3.30



AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have tremolos in one voice and slurs in 
another voice.

RELATED LINKS
Repeats popover on page 373
Tremolos on page 1099
Tremolos in tie chains on page 1101
Deleting tremolos on page 1102
Enabling independent voice playback on page 460
Forcing the duration of notes/rests on page 238
Creating cross-staff beams/tremolos on page 697
Tuplets on page 1104

Inputting tremolos with the panel
You can input both single-note and multi-note tremolos using the Repeat Structures panel, both 
during note input and by adding them to existing notes.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tremolos.

NOTE

If you want to input multi-note tremolos, you must select at least two notes that are in 
the same voice, have the same duration, and are notated using a single notehead. The 
notes can also be tuplets and cross-staff notes.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Tremolos section, click the tremolo you want to input.

For example, click:

● Two Strokes Single-note Tremolo  for single-note tremolos with two strokes.

● Three Strokes Multi-note Tremolo  for multi-note tremolos with three strokes.

● Tremolo With Release  for three-stroke single-note tremolos with release.

RESULT
Single-note tremolos are input on the selected notes with the number of tremolo strokes 
specified. They appear on all notes in tie chains.
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Tremolos with release show single-note tremolo strokes on all notes in tie chains apart from the 
last note. Tremolos with attack show single-note tremolo strokes on all notes in tie chains apart 
from the first note.

Multi-note tremolos with the number of tremolo strokes specified are input between selected 
individual notes and the notes immediately after them, or between selected pairs of notes. The 
notated duration of notes in multi-note tremolos is automatically updated. For example, two 
quarter notes joined by a multi-note tremolo both appear as half notes.

When tuplets are selected, multi-note tremolos are input across the selected tuplets, with the 
tremolo strokes positioned in the center of all notes in the tuplet. The tuplet bracket is hidden, 
and a signpost is shown at the start of each tuplet indicating its ratio.

EXAMPLE

Multi-note tremolos with three tremolo strokes 
across tuplets

Tremolo with release added to tie chain

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have tremolos in one voice and slurs in 
another voice.

RELATED LINKS
Repeat Structures panel on page 376
Enabling independent voice playback on page 460
Forcing the duration of notes/rests on page 238
Creating cross-staff beams/tremolos on page 697
Tuplets on page 1104

Inputting slash regions
You can input slash regions using the repeats popover.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● On the staff where you want to input a slash region, select items that span the required 
duration.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter slash into the popover.

4. Press Return  to close the popover.
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RESULT
During note input, slash regions are input spanning the duration of the selected note or item, 
which is usually the last input note. When adding slash regions to existing music, they span the 
selected duration.

Slash regions are automatically formatted as appropriate for the meter. If you later change the 
time signature, slash regions retain their duration but the appearance of slashes within them 
automatically updates.

TIP

You can also input slash regions by clicking Create Slash Region in the Rhythm Slashes section 
of the Repeat Structures panel, or by choosing Write > Create Slash Region. You can assign a 
key command for this option on the Key Commands page in Preferences.

RELATED LINKS
Repeats popover on page 373
Repeat Structures panel on page 376
Rhythm slashes on page 997
Slash regions on page 997
Slash voices on page 1005
Inputting chord symbol regions on page 299
Hiding/Showing chord symbols on page 714
Lengthening/Shortening items on page 396
Key Commands page in the Preferences dialog on page 54

Inputting bar repeats
You can input bar repeat regions when at least one bar before the region contains notes.

PROCEDURE

1. In Write mode, on the staff where you want to input a bar repeat region, select items that 
span the required duration.

NOTE

You cannot input bar repeat regions in the first bar of a flow.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter the appropriate entry for the type of bar repeat region you want into the popover.

For example, enter %2,4 to repeat the previous two bars, grouped in four.

4. Press Return  to close the popover.

RESULT
A region of the selected duration is input, in which the specified type of bar repeat symbol is 
shown in the staff at the intervals specified.
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NOTE

● You can also input bar repeat regions during note input; however, this inputs bar repeat 
regions from the bar containing the currently selected note. As bar repeats are mostly 
shown in empty bars, this is likely to produce unintended results.

● You can also input one-bar repeat regions by clicking Create Bar Repeat Region in the Bar 
Repeats section of the Repeat Structures panel, or by choosing Write > Create Bar Repeat 
Region. You can assign a key command for this option on the Key Commands page in 
Preferences.

AFTER COMPLETING THIS TASK
You can change how bar repeats are grouped.

RELATED LINKS
Bar repeats on page 985
Bar repeat grouping on page 990
Changing bar repeat grouping on page 990

Inputting numbered bar regions
You can input numbered bar regions using the repeats popover.

PROCEDURE

1. In Write mode, on the staff where you want to number bars, select items that span the 
required duration.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter numbars into the popover.

4. Press Return  to close the popover.

RESULT
A numbered bar region spanning the selected duration is input.

By default, bar counts are shown on every bar in the region. If the numbered bar region lasts 
four or more bars, Dorico SE adds the total range in parentheses to the count on the first bar, 
such as showing “1 (-8)” on the first bar in a numbered bar region lasting eight bars.

NOTE

● You can also input numbered bar regions during note input; however, this only inputs a 
numbered bar region in the bar containing the currently selected note.

● You can also input numbered bar regions by clicking Create Numbered Bar Region in 
the Numbered Bars section of the Repeat Structures panel, or by choosing Write > 
Create Numbered Bar Region. You can assign a key command for this option on the Key 
Commands page in Preferences.

● Numbered bar regions are hidden in full score layouts and shown in part layouts by default, 
but you can choose to hide/show numbered bar regions in any layout.

RELATED LINKS
Repeats popover on page 373
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Repeat Structures panel on page 376
Numbered bar regions on page 992
Numbered bar region counts on page 993
Hiding/Showing numbered bar regions on page 993
Lengthening/Shortening items on page 396

Selecting notes/items
In Dorico SE, there are multiple different ways you can select notes and items in your project, 
from selecting items individually to making large selections covering multiple staves. You can 
also change whether notes play back during note input/selection.

RELATED LINKS
Large selections on page 389
System track on page 390
Filters on page 393
Selection tools on page 37
Playing/Muting notes during note input/selection on page 394
Playing all/individual notes in chords during note input/selection on page 395
Selecting items in the Key Editor on page 572

Selecting/Deselecting notes and items individually
You can select/deselect existing notes and other notation items individually in the music area; 
for example, if you want to add articulations to a selection of notes or delete a short passage of 
music.

TIP

If you want to select a large number of notes/items, we recommend that you use one of the 
larger selection methods.

PROCEDURE

1. Select individual notes/items in the music area in any of the following ways:

● Click a single note/item.

TIP

If the item you want to select is behind another item, Shift - Alt/Opt -click it.

● Ctrl/Cmd -click individual notes/items.

● Shift -click adjacent notes/items.

● To select all notes in a beam group, click the beam.

● To select all notes in a chord, click the stem.

● To select everything in a bar, click on the staff in that bar, but not on any notes, stems, or 
items.

● Make a marquee selection around multiple notes/items.

● Navigate to other items from an existing selection.

● If nothing is selected in the music area, press any arrow key on your computer keyboard 
to select the first note, rest, or other item on the top staff in the current layout.

2. Deselect all currently selected items in any of the following ways:
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● Press Ctrl/Cmd-D .

● Choose Edit > Select None.

● Click outside of the staves within the music area.

RELATED LINKS
Selecting multiple items using marquee selections on page 389
Selecting items in the Key Editor on page 572
Playing/Muting notes during note input/selection on page 394
Navigating to other items in the music area on page 403
Filters on page 393

Selecting more items of the same type
You can incrementally extend your current selection to more items of the same type and notes 
in the same voices, which is particularly helpful if you want to select multiple different items at 
once, such as dynamics and lyrics.

PROCEDURE

1. Select the notes and items you want to select more of.

TIP

You can select notes and items on multiple staves and in specific voices; for example, if you 
only want to select notes in up-stem voices on four staves.

2. Press Ctrl/Cmd-Shift-A  to expand your selection.

3. Optional: Continue pressing Ctrl/Cmd-Shift-A  to extend your selection further.

RESULT
More of the same types of items and notes in the same voices as your original selection are 
selected, with the range of selected items expanding each time you press the key command: 
firstly to the boundaries of the bar, secondly to the boundaries of the system, and finally to the 
rest of the flow. If there are no other items available in the bar, Dorico SE automatically advances 
to the second expansion. In galley view, the second expansion is to the entire flow directly as 
there is only a single system in galley view.

For items that span multiple bars and systems, they are selected in the earliest bar/system in 
which they exist.

NOTE

Dorico SE selects the following items differently if you select only a single one of them:

● Lyrics: The selection expands only to other lyrics with the same line number, placement, and 
line type as the originally selected lyric.

● Dynamics: The first expansion is to all other dynamics in the same group and on the same 
staves as the original selection, with further expansions selecting other dynamics in other 
groups.

● Playing techniques: The selection expands only to playing techniques of the same category, 
such as Strings or Choral. Additionally, if you select either an up bow or down bow playing 
technique, the selection expands only to other up bow and down bow playing techniques. It 
does not select any other playing techniques.
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Selecting multiple items using marquee selections
You can use a marquee selection to select multiple notes and notations at the same time within a 
specific area in Write mode and Play mode.

PROCEDURE

1. In the status bar, click Marquee Tool .

2. In the music area, click and drag across the area where you want to select everything.

A gray rectangle indicates which notes and notations will be selected. We recommend that 
you click in one corner of the area you want to select and drag diagonally across to the other 
corner.

RESULT
When you release the mouse, all notes and notations in the area within the gray rectangle are 
selected.

NOTE

Only items completely within the area are selected. However, if any part of a note/tie chain is 
within the area, the whole note/tie chain is selected.

RELATED LINKS
Status bar on page 36
Selection tools on page 37
Selecting items in the Key Editor on page 572
Changing values using the Transform tool on page 609

Large selections
You can make large selections, including selecting the contents of whole staves or the whole 
flow.

Select everything in a specific area
You can use the Marquee Tool  to specify an area in which you want to select 
everything.

Select everything in the whole flow

● Press Ctrl/Cmd-A .

● Choose Edit > Select All.

Select everything on a single staff

● Select the first note on the staff, hold down Shift , then select the last note on the 
staff.

● Select the first note on the staff and choose Edit > Select To End Of System or 
Edit > Select To End Of Flow.

Select everything on multiple adjacent staves

● Select one whole staff at the top/bottom of the range of staves you want to select 
and press Shift-Up Arrow  or Shift-Down Arrow  until all the staves you want are 
selected.

● Select one whole staff at the top/bottom of the range of staves you want to select 
and Shift -click the staff at the other end of the range of staves you want to select.
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Select more of the currently selected types of items
You can use Edit > Select More ( Ctrl/Cmd-Shift-A ) to expand your current selection 
horizontally and incrementally to other items of the same types and in the selected 
voices and staves in Write mode. For items that span multiple bars and systems, they 
are selected in the earliest bar/system in which they exist.

1. The first expansion is to the boundaries of the current bar, both to the left and 
right. If there is nothing to select within the bar, such as if you selected a whole 
note in a 4/4 bar, Dorico SE automatically advances to the second expansion.

2. The second expansion in page view is to the boundaries of the current system, 
both to the left and right. In galley view, the second expansion is to the rest of the 
flow, as there is only a single system in galley view.

3. In page view, the third expansion is to the entire flow.

Select everything in the system within a range of beats/bars
You can use the system track to select a region of beats/bars and then select 
everything on all staves in the system within that region.

TIP

If you want to select only a certain type of item, such as lyrics or dynamics, you can then use the 
corresponding filters.

RELATED LINKS
Filters on page 393
Selecting/Deselecting notes and items individually on page 387
Selecting items in the Key Editor on page 572
Selecting more items of the same type on page 388
Histogram tool on page 604

System track
The system track is a translucent line above the top of each system in Write mode. It allows you 
to add and delete bars and beats, and to select everything on all staves in the system.

The system track above a staff, showing bars The system track above a staff, showing beat 
units reflecting the current rhythmic grid resolution 
(available when you hold Alt/Opt )

The color of the system track changes depending on how you are interacting with it.

● When you hover the mouse over it, it becomes more opaque.

● When you select a region in the system track, it appears highlighted.
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The system track when the mouse pointer hovers 
over it

The system track with a region selected

When you have selected a region in the system track, the following options are available:

1 Set Edit Stop Position

Allows you to set and delete Insert mode stop positions.

2 Delete

Allows you to delete the selected region.

NOTE

When you hover over Delete, the highlight color of the selected region changes.

3 System Track Select

Allows you to select all items, including system objects, on all staves in the system across the 
selected region.

4 Add

Allows you to add bars or beats of the same duration as the selection in the system track. 
The extra time is inserted immediately after the end of the selection.

NOTE

Selections on the system track are cleared whenever you make any other kind of selection, or 
when you switch layouts. However, selections on the system track are retained when switching 
between page and galley view.

RELATED LINKS
Inputting bars/beats with the system track on page 280
Deleting bars/beats with the system track on page 668
System objects on page 1044
Rhythmic grid on page 190
Insert mode on page 408
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Hiding/Showing the system track
The system track is shown by default in new projects, but you can hide/show it in Write mode at 
any time.

PROCEDURE

● Hide/Show the system track in any of the following ways:

● Press Alt/Opt-T .

● Choose View > System Track.

RESULT
The system track is hidden/shown.

TIP

If you do not want the system track to be shown in all future projects by default, deactivate Show 
system track in new projects in the View section of the General page in Preferences.

RELATED LINKS
Preferences dialog on page 53

Selecting bars with the system track
The system track allows you to select all items, including system objects, on all staves in the 
system across the selected bars.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In Write mode, click a bar in the system track.

2. Optional: Select additional bars in any of the following ways:

● Shift -click bars to the right/left along the system track.

● Click and drag to the right/left along the system track.

3. Click System Track Select  in the system track. It can also appear above the system track if 
your selection is narrow.

System Track Select  appears filled in when you hover your mouse pointer over it.

RESULT
Everything on all staves in the selected bars is selected and highlighted, including system objects, 
notations, and signposts.

NOTE

If you then delete your selection, any signposts included are also deleted. This can affect the 
page layout; for example, by removing ossia staves whose signposts were included in the 
selection.
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Selecting beats with the system track
The system track allows you to select all items, including system objects, on all staves in the 
system across the selected beats.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In Write mode, press and hold Alt/Opt .

Grid lines that match the current rhythmic grid resolution appear in the system track.

2. Without releasing Alt/Opt , click and drag to the right/left along the system track.

NOTE

You cannot Shift -click when selecting beats.

3. Click System Track Select  in the system track. It can also appear above the system track if 
your selection is narrow.

System Track Select  appears filled in when you hover your mouse pointer over it.

RESULT
Everything on all staves in the selected beats is selected and highlighted, including system 
objects, notations, and signposts.

NOTE

If you then delete your selection, any signposts included are also deleted. This can affect the 
page layout; for example, by removing ossia staves whose signposts were included in the 
selection.

RELATED LINKS
Deleting the contents of bars on page 669
Deleting bars/beats with the system track on page 668
System objects on page 1044
Rhythmic grid on page 190

Filters
Filters in Dorico SE allow you to select only a specific type of item from a larger selection. Dorico 
SE includes a filter for every notation item.

● You can find the available filters by choosing Edit > Filter > [Item] > [Item type]. You can 
also choose filters from the context menu.

All significant notation items have their own filter; for example, arpeggio signs, chord symbols, 
key signatures, and playing techniques. You can also filter for note spacing changes.

The following items have multiple filters because they have multiple types:

Notes
Allows you to filter notes, grace notes, and chords. You can also filter notes according 
to their position in chords.
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Voices
Allows you to filter voices according to their stem direction. You can also filter slash 
voices.

Dynamics
Allows you to filter all dynamics, or just gradual or immediate dynamics.

Tempos
Allows you to filter all tempo marks, or just absolute, relative, or gradual tempo 
changes.

Lyrics
Allows you to filter all lyrics, or just lyrics with a specific line number, type, or staff-
relative placement.

NOTE

There is no filter for barlines. You also cannot filter notations that are considered part of the 
notes to which they apply, including fingerings, beams, articulations, and tremolos.

RELATED LINKS
Filters for lyrics on page 826
Selecting more items of the same type on page 388

Changing filters to select/deselect
You can change whether the available filter options select or deselect the specified items. By 
default, filters select items, meaning that the resulting selection only includes the item being 
filtered.

When filters are set to deselect, the resulting selection includes everything except the item being 
filtered.

PROCEDURE

● Change the filter behavior in one of the following ways:

● To change filters to select, choose Edit > Filter > Select Only.

● To change filters to deselect, choose Edit > Filter > Deselect Only.

TIP

You can also choose these options from the context menu.

Playing/Muting notes during note input/selection
You can change your default setting for whether notes are played back as you input them or not. 
By default, notes are played back with the prevailing dynamic but you can set a fixed volume 
instead.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Play notes during note input and selection 
in the Auditioning subsection.
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4. Optional: If you want notes to play back with a fixed volume instead of the prevailing 
dynamic, activate Use fixed volume to play selected notes and change the value in the 
value field.

5. Click Apply, then Close.

RESULT
When the option is activated, notes play back as you input them during note input and when you 
select them. When it is deactivated, notes do not play back.

When Use fixed volume to play selected notes is activated, notes play back with the set 
volume. When it is deactivated, notes play back with the prevailing dynamic.

RELATED LINKS
Inputting notes on page 197
Selecting/Deselecting notes and items individually on page 387
Playing back music on page 457
Mixer panel on page 612
Input methods for dynamics on page 284

Playing all/individual notes in chords during note input/selection
You can change your default setting for whether all notes in chords are played when you select 
any note in the chord or whether only the selected notes are played.

PREREQUISITE
Notes are played during note input/selection.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Play all notes in chord when any is selected 
in the Auditioning subsection.

4. Click Apply, then Close.

RESULT
When the option is activated, all notes in chords are played when any note in the chord is 
selected. When it is deactivated, only the selected notes are played.

Editing items
In Dorico SE, there are editing methods that are common to most notations, including 
lengthening/shortening items and changing their staff-relative placement.

RELATED LINKS
Selecting notes/items on page 387
Arranging tools on page 412
Moving notes/items rhythmically on page 417
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Lengthening/Shortening items
You can lengthen/shorten items with duration rhythmically after they have been input; for 
example, if you want an octave line to cover more/fewer notes.

Lengthening figured bass or playing techniques, including string indicators outside the staff and 
vibrato bar indications, that were input without a specified duration gives them duration and 
shows duration or hold lines if required.

PREREQUISITE
You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In Write mode, select the items you want to lengthen/shorten.

NOTE

● When multiple items are selected, you can only lengthen/shorten them by the current 
rhythmic grid resolution.

● You can only lengthen/shorten one of the following items at a time: slurs, gradual 
dynamics, groups of gradual dynamics, and bar repeat regions.

● When using the mouse, you can only lengthen/shorten a single item at a time. Figured 
bass and playing techniques, including string indicators and vibrato bar lines, must have 
duration already.

● When lengthening/shortening multiple figured bass or playing techniques using the 
keyboard, they must all have duration already.

● You can only lengthen/shorten non-grouped playing techniques or the last playing 
technique in a group.

● You can only lengthen/shorten cross-staff slurs to notes on the same staff as the 
corresponding endpoint, and you can only lengthen/shorten cross-voice slurs to notes in 
the same voice as the corresponding endpoint.

2. Lengthen/Shorten the selected items in any of the following ways:

● To lengthen them by the current rhythmic grid resolution or to the next notehead, 
whichever is closer, press Shift-Alt/Opt-Right Arrow .

● To shorten them by the current rhythmic grid resolution or to the previous notehead, 
whichever is closer, press Shift-Alt/Opt-Left Arrow .

NOTE

Bar repeat regions are lengthened/shortened by the duration of their grouping.

● To lengthen a single item to the next notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Right Arrow .

● To shorten a single item to the previous notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Left Arrow .

● Click and drag the circular handle at the start/end to the right/left.

NOTE

Playing technique groups only have a single handle at their start and end, not individual 
handles for each playing technique within the group.
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RESULT
The selected items are lengthened/shortened by moving their end rhythmically to the right/left. 
Most items are lengthened/shortened either by the current rhythmic grid resolution or to the 
next/previous notehead, whichever is closer, or directly to the next/previous notehead.

Bar repeat regions are lengthened/shortened by the duration of their grouping. Numbered bar 
regions are lengthened/shortened by bars. Slurs are lengthened/shortened to notes.

If figured bass or playing techniques previously had no duration, they now have duration and 
show duration or hold lines if required.

If any part of slash regions now overlap rhythmic positions with other slash regions, the staff 
positions of slashes are automatically adjusted to accommodate multiple slash regions at the 
same positions.

Dynamic groups are lengthened/shortened proportionally by lengthening/shortening the 
gradual dynamics and moving any other type of dynamic in the group. This retains the relative 
durations of the gradual dynamics in the group.

NOTE

● The minimum length of a bar repeat region is one bar. If you shorten regions with longer 
groupings, such as every four bars, the length of the region is halved until a one-bar repeat 
region remains.

● Only a single bar repeat region or chord symbol region can exist at each rhythmic position 
on each staff. If a bar repeat region or chord symbol region collides with another item of 
the same type when it is lengthened/shortened, the existing item is deleted or shortened 
accordingly. For bar repeat regions, this can mean the grouping of other bar repeat regions 
is changed.

You can undo this action and restore the previous lengths of the other regions. However, if 
you lengthened/shortened a bar repeat region or chord symbol region using the mouse and 
it overwrote another region of the same type completely, the other region is permanently 
deleted.

EXAMPLE
In the example, lengthening the phrase moves the  at the end two quarter notes to the right, 
but moves the  in the middle only one quarter note to the right. This keeps the lengths of the 
gradual dynamics equal.

Original dynamic phrase Lengthened dynamic phrase

RELATED LINKS
Rhythmic grid on page 190
Changing the duration of notes on page 236
Lengthening/Shortening segments in repeat endings on page 976
Moving notes/items rhythmically on page 417
Hiding/Showing playing technique duration lines on page 942
Notations input on page 246
Bar repeat grouping on page 990

Write mode
Editing items 

397
Dorico SE 4.3.30



Playing technique continuation lines on page 940
Playing technique duration on page 941
Pedal line start signs, hooks, and continuation lines on page 930
Sustain pedal retakes and pedal level changes on page 926
Slashes in multiple-voice contexts on page 999
Cross-staff and cross-voice slurs on page 1024
Groups of dynamics on page 765
Hiding/Showing figured bass hold/suspension lines on page 775

Changing existing items
You can change all items that have an associated popover, rather than deleting them and 
inputting new ones. For example, if you want to change an 8va octave line into a 15va octave line 
or change a short fermata into a long fermata.

PROCEDURE

1. Select the item or the signpost of the item you want to change.

2. Open the popover for that item in any of the following ways:

● Press Return .

● Double-click the item.

3. Change the existing entry in the popover.

For chord symbols, you can also play the new chord on your MIDI keyboard.

4. Press Return  to close the popover.

RESULT
The selected item is changed according to the new entry in the popover. This changes different 
parameters for different items, such as the duration of a hold or pause or the volume of a 
dynamic.

NOTE

● Any properties previously set on the item are reset.

● If you change a fermata to a breath mark, only the fermata on the top staff is changed to 
a breath mark. If you change a caesura to a breath mark, a breath mark is input on the top 
staff at the end of the bar to which the caesura is attached. However, the existing caesura 
also remains on all staves.

● If you open the playing techniques popover in this way, Dorico SE inputs your new entry as a 
separate playing technique and does not delete the previous one.

● If you change an immediate dynamic to a combined dynamic, such as  to , or vice versa, 
Dorico SE inputs your new entry as a separate dynamic and does not delete the previous 
one.

RELATED LINKS
Popovers on page 21
Properties panel on page 560
Changing the text of existing lyrics on page 831
Assigning key commands on page 58
Changing dynamic levels on page 751
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Changing the size of notes/items
You can change the size of individual notes and items using the default scale sizes for cues, grace 
notes, a custom scale size, or a custom scale size in addition to a default scale size. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

TIP

If you want to change the size of notes because you want them to be grace notes or cues, you 
can input them as either grace notes or cues instead.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/items whose size you want to change.

2. In the Properties panel, activate any of the following properties in the Common group:

● If you want to use a default scale size, activate Scale.

● If you want to use a custom scale size, activate Custom scale.

● If you want to use a custom scale size based on a default scale size, activate both Scale 
and Custom scale.

3. Optional: If you activated Scale, select one of the following options from the menu:

● Normal

● Grace

● Cue

● Cue grace

4. Optional: If you activated Custom scale, change the value in the value field.

RESULT
The size of the selected notes/items is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

● If you activated Scale, the selected notes/items are changed to the selected default scale 
size.

● If you activated Custom Scale, the selected notes/items are changed to the custom 
percentage scale size you set.

● If you activated both Scale and Custom Scale, the selected notes/items are changed to the 
custom percentage scale size of the selected default scale size. For example, if you selected 
Grace for Scale then set Custom Scale to 50, the size of the selected notes/items is half the 
size of grace notes.

RELATED LINKS
Grace notes on page 803
Inputting grace notes on page 225
Cues on page 745
Notehead set designs on page 841
Changing the property scope on page 562
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Copying property settings to other layouts/frame chains on page 547

Changing the staff-relative placement of items
You can flip any item that can be placed both above/below the staff to change their staff-relative 
placement; for example, if you want to change the stem direction of notes quickly. For many 
items, you can do this for the current layout and frame chain only or for all layouts and frame 
chains.

NOTE

These steps do not apply to text in text frames or pedal lines.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items you want to flip.

NOTE

● You cannot flip items during note input. You cannot flip text items when the text editor is 
open.

● To select multiple items of the same type, you can use large selections and/or filters.

2. Press F .

RESULT
The staff-relative placement of the selected items is changed by setting Placement, Position, or 
Direction properties appropriately in the corresponding groups of the Properties panel. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain for items whose staff-relative placement properties are local.

Deactivating these properties resets items to their default placement.

NOTE

If you flipped multiple multi-segment slurs or tuplet brackets with different hook directions at the 
same time, all selected items are set to either above or below the staff, unless they all originally 
had compatible directions set.

RELATED LINKS
Filters on page 393
Large selections on page 389
Local vs. global properties on page 561
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Changing the stem direction of notes on page 856
Changing the staff-relative placement of beams on page 693
Changing the staff-relative placement of fingerings on page 786
Changing the staff-relative placement of tuplet brackets on page 1110
Positions of lyrics on page 827
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Resetting the appearance of items
You can reset all changes you have made to the appearance of individual items, which returns 
them to the default settings. For some items, you can do this for the current layout and frame 
chain only or for all layouts and frame chains.

Properties relating to the appearance of items include those that change their style, type, and 
some additions, such as poco a poco text for dynamics.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items whose appearance you want to reset.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Choose Edit > Reset Appearance.

RESULT
All properties that affect the appearance of the selected items are reset to their default settings. 
If the property scope was set to Locally, any properties that are layout-specific and frame 
chain-specific are only reset in the current layout and frame chain.

RELATED LINKS
Local vs. global properties on page 561
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Filters on page 393
Large selections on page 389

Resetting the position of items
You can reset the position of individual items you have moved graphically, which returns them 
to their default position. For some items, you can do this for the current layout and frame chain 
only or for all layouts and frame chains.

Properties relating to the position of items include horizontal and vertical offsets, beat-relative 
position, and staff-relative placement.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items whose position you want to reset.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Choose Edit > Reset Position.
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RESULT
All properties that affect the position of the selected items are reset to their default settings. 
If the property scope was set to Locally, any properties that are layout-specific and frame 
chain-specific are only reset in the current layout and frame chain.

Hiding non-printing elements
You can temporarily hide all visible elements that do not print, such as signposts and selection 
highlights. This allows you to view the current layout as it will appear when printed/exported 
without switching to Print mode.

PROCEDURE

● Press and hold \ (Windows) or ` (macOS) .

RESULT
All non-printing elements in the current layout are hidden until you release the key command. 
Printing elements appear as they will when printed/exported.

TIP

You can also hide/show individual non-printing elements permanently.

RELATED LINKS
Annotations on page 507
Printing layouts on page 491
Exporting layouts as graphics files on page 495
Signposts on page 407
Hiding/Showing signposts on page 407
Hiding/Showing the system track on page 392
Hiding/Showing guide bar numbers on page 680
Hiding/Showing colors for notes out of range on page 847
Hiding/Showing voice colors on page 1135
Hiding/Showing region highlights on page 987
Hiding/Showing slash region highlights on page 998

Navigation
There are different ways you can navigate around the layout currently open in the music area, 
such as moving the selection to different items or bringing specific bar numbers or pages into 
view. Many navigation methods function in multiple modes.

If you have an item selected, you can navigate to other notes/items, which moves the selection to 
those notes/items.

RELATED LINKS
Workspace setup on page 40
Going to locations with the jump bar on page 61
Jump bar on page 60
Moving the caret manually on page 196
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Navigating to other items in the music area
You can navigate to other notes and items in the music area after you have selected a note/item; 
for example, if you want to move the selection to other notes along the staff without using the 
mouse.

PROCEDURE

1. Select an item in the music area.

● If you want to navigate through notes, select a note.

● If you want to navigate through a particular type of item, such as rehearsal marks, select 
an item of that type.

NOTE

You can only navigate forwards/backwards through items on the same staff. You cannot 
navigate to other items of the same type on other staves.

2. Navigate to other notes or items in any of the following ways:

● To navigate to the next item or note in the same voice, press Right Arrow .

● To navigate to the previous item or note in the same voice, press Left Arrow .

● To navigate to the closest note above the current selection, press Up Arrow .

This navigates to any existing notes on the same staff first, then to the lowest note/rest 
on the staff above. If a whole chord was selected, this leaves the bottom note in the 
chord selected.

● To navigate to the closest note below the current selection, press Down Arrow .

This navigates to any existing notes on the same staff first, then to the highest note/rest 
on the staff below. If a whole chord was selected, this leaves the top note in the chord 
selected.

● To navigate forwards to the note/rest at the start of the next bar, press Ctrl/Cmd-
Right Arrow .

● To navigate backwards to the note/rest at the start of the previous bar, press Ctrl/Cmd-
Left Arrow .

● To navigate to the top staff in the system, press Ctrl/Cmd-Up Arrow .

● To navigate to the bottom staff in the system, press Ctrl/Cmd-Down Arrow .

3. Optional: Switch the selection to another type of item at the same rhythmic position in one 
of the following ways:

● To cycle forwards through items, press Tab .

● To cycle backwards through items, press Shift-Tab .

NOTE

You cannot switch the selection to system objects, such as system-attached text or rehearsal 
marks. However, you can select system objects directly and navigate through them.

4. Optional: After switching the selection to another type of item, navigate to other items of 
that type.

RELATED LINKS
System objects on page 1044
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Going to flows
You can go to the next/previous flow in the current layout, which automatically brings the start of 
that flow into view in the music area. This is particularly useful when navigating around layouts 
that contain many flows.

These steps function in Setup mode and Write mode.

PROCEDURE

● Go to a different flow in one of the following ways:

● To go to the previous flow in the layout, choose Edit > Go To > Go To Previous Flow.

● To go to the next flow in the layout, choose Edit > Go To > Go To Next Flow.

RESULT
The music area updates to show the start of the corresponding flow. Dorico SE automatically 
positions the top staff towards the top left of the music area.

TIP

You can assign key commands to both Go To Previous Flow and Go To Next Flow on the Key 
Commands page in Preferences.

Going to pages
You can go to any specified page in the current layout using its page number; for example, to 
jump quickly to the exact page that requires changes when editing music.

These steps function in Setup mode and Write mode.

PROCEDURE

1. Choose Edit > Go To > Go To Page to open the Go To Page dialog.

2. Enter the page number to which you want to go into the Page field.

3. Click OK.

RESULT
The music area updates to show the start of the corresponding page. Dorico SE automatically 
centers the top of the page in the music area.

TIP

● You can assign a key command for Go To Page on the Key Commands page in Preferences.

● You can also move the view and navigate to other pages in the layout in other ways.

RELATED LINKS
Key Commands page in the Preferences dialog on page 54
Page arrangements for page view on page 39
Moving the view in the music area on page 405
Zooming in/out of the music area on page 406
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Going to bars
You can go to any specific bar in any flow in the current layout; for example, to jump quickly to 
the exact bar that requires changes when editing music.

These steps function in Setup, Write, and Play modes.

PROCEDURE

1. Press Ctrl/Cmd-G  to open the Go To Bar dialog.

2. Select the flow containing the bar to which you want to go from the Flow menu.

3. Enter the bar number to which you want to go into the Bar field.

4. Click OK.

RESULT
The music area updates to show the corresponding bar. Dorico SE automatically positions the 
top staff towards the top left of the music area.

In Play mode, the playhead moves to the start of the corresponding bar. Dorico SE automatically 
positions the playhead at the start of the ruler.

Going to rehearsal marks
You can go to any specific rehearsal mark in any flow in the current layout; for example, to jump 
quickly to passages that require changes when editing music.

These steps function in Setup mode and Write mode.

PROCEDURE

1. Choose Edit > Go To > Go To Rehearsal Mark to open the Go To Rehearsal Mark dialog.

2. Select the flow containing the rehearsal mark to which you want to go from the Flow menu.

3. Enter the rehearsal mark to which you want to go into the Rehearsal mark field.

4. Click OK.

RESULT
The music area updates to show the corresponding rehearsal mark.

TIP

You can assign a key command for Go To Rehearsal Mark on the Key Commands page in 
Preferences.

Moving the view in the music area
You can move the view in the music area to show different parts of layouts. For example, you can 
scroll through a layout to view each page in sequence.

PROCEDURE

● Move the view in any of the following ways:

● To move the view upwards/downwards, scroll upwards/downwards on a mouse wheel or 
swipe upwards/downwards on a touchpad.
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● To move the view to the right/left, Shift -scroll upwards/downwards on a mouse wheel 
or swipe to the right/left on a touchpad.

● To navigate to the next page, press End (horizontal page arrangements) or Page 
Down (vertical page arrangements) .

● To navigate to the previous page, press Home (horizontal page arrangements) or 
Page Up (vertical page arrangements) .

● To navigate to the first page, press Ctrl/Cmd-Home .

● To navigate to the last page, press Ctrl/Cmd-End .

● In the status bar, click Hand Tool , then click and drag in any empty space within the 
page boundaries in the music area.

The mouse pointer changes into a hand symbol during the move.

RESULT
The view in the music area is moved.

TIP

● You change the maximum overscroll amount, that is, how far beyond the edges of pages you 
can move the view, on the General page in Preferences.

● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Status bar on page 36
Selection tools on page 37

Zooming in/out of the music area
You can change the zoom level in the music area; for example, if you want a larger overview 
when inputting notes, but want to see notes and notations more closely when making detailed 
graphical amendments.

PREREQUISITE
If you want to keep a specific item in the center of the music area when you zoom in/out, you 
have selected that item.

PROCEDURE

1. Zoom in in any of the following ways:

● Press Ctrl/Cmd-= or Z .

● Spread two fingers outwards on a touchpad.

● Ctrl/Cmd -scroll upwards on a mouse wheel.

● Use the zoom options  in the status bar.

2. Zoom out in any of the following ways:

● Press Ctrl/Cmd-- or X .

● Pinch two fingers together on a touchpad.

● Ctrl/Cmd -scroll downwards on a mouse wheel.

● Use the zoom options  in the status bar.
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RESULT
The zoom level in the music area is changed. If you had anything selected, Dorico SE uses your 
selection as the focal point of the zoom. If you had nothing selected, Dorico SE focuses on the 
area previously in the center of the view.

RELATED LINKS
Zoom options on page 39
Zooming in/out of tracks on page 455
Workspace setup on page 40

Signposts
In Dorico SE, signposts indicate the positions of important items or changes that cannot be 
seen in the score, such as key signatures with no accidentals, hidden items, and rhythmic feel 
changes.

Signposts have different colors depending on the item they mark because many items can 
show signposts, such as hidden bar numbers and time signatures. They are selectable, meaning 
you can use signposts to change properties of hidden/invisible items; for example, by selecting 
system break signposts in order to change the staff size from that position. Selected signposts 
appear solid, while unselected signposts appear translucent.

Signposts include a text summary of the hidden/invisible item to help you identify it. For 
example, time signature signposts include the time signature, expressed as a fraction, and its 
beat subdivision.

When multiple signposts exist at the same rhythmic position or in close proximity to each other, 
they stack vertically so that they do not overlap and remain legible.

Multiple signposts for different items above the staff, with time signature signposts selected

NOTE

By default, signposts are not printed or included when you export graphics files.

RELATED LINKS
Annotations on page 507

Hiding/Showing signposts
You can hide/show all signposts or only hide/show signposts for specific items at any time in 
Setup mode and Write mode.
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PROCEDURE

● Hide/Show signposts in any of the following ways:

● To hide/show all signposts, choose View > Signposts > Hide Signposts.

● To hide/show signposts for specific items, choose View > Signposts > [Type of item].

Insert mode
Insert mode changes how notes are input and how edits you make outside of note input affect 
the music. When Insert mode is activated, notes are pushed to subsequent rhythmic positions 
instead of being overwritten if you input new notes or lengthen existing notes. Similarly, deleting 
notes or reducing their duration with Insert mode activated pulls surrounding notes closer 
together without leaving rests between them.

For example, if you input four quarter notes with Insert mode activated, all subsequent notes are 
pushed four quarter note beats back to accommodate the new notes.

Edits outside of note input that are affected by Insert mode include copying/pasting notes, 
deleting notes, changing the duration of notes including by adding/removing rhythm dots, or 
inputting time signatures.

The voices and staves affected by Insert mode depend on the Insert mode scope. The current 
Insert mode scope is indicated in the Notes toolbox and by the caret during note input.

You can set a single rhythmic position in each flow as an Insert mode stop position, which 
prevents any material beyond the stop point being affected by inserted notes. For example, if 
you want to insert notes at the start of a flow but want to preserve material from a specific 
position later in the flow. Stop positions appear as a vertical translucent line that spans all staves.

● You can activate/deactivate Insert mode in Write mode by pressing I  or clicking Insert  in 
the Notes toolbox.

NOTE

You cannot have both Insert mode and Chord mode activated simultaneously.

When Insert mode is not activated, Dorico SE does not add extra beats before an existing time 
signature if you change a previous time signature. When Insert mode is activated, Dorico SE 
inserts beats before existing time signatures to fill the final bar.

3/4 time signature input without Insert mode 
activated

3/4 time signature input with Insert mode activated

RELATED LINKS
Inputting notes in Insert mode on page 212
Rhythmic position on page 22
Chord mode on page 228
Caret on page 191
System track on page 390
Inputting notes on page 197
Copying and pasting notes/items on page 414
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Changing the duration of notes on page 236
Inputting notes with rhythm dots on page 205
Deleting notes/items on page 412

Insert mode scopes
Insert mode has different scopes, from affecting only selected voices to affecting all players and 
changing the duration of the current bar. All scopes apply until the Insert mode stop position or 
the end of the flow, whichever comes first.

You can change the Insert mode scope in Write mode in any of the following ways:

● Press Alt/Opt-I  to cycle through the different Insert mode scopes.

● In the Notes toolbox, click and hold Insert , then click the scope you want.

● Choose Write > Insert Scope > [Scope].

In Dorico SE, there are the following Insert mode scopes:

Voice

Insert mode only affects the selected voices. During note input, this is the voice 
indicated by the caret indicator. Outside of note input, this includes all selected voices, 
such as when you copy and paste material across multiple staves.

Player

Insert mode affects all voices and instruments belonging to the selected players. 
During note input, dotted lines are shown on staves affected by the Insert mode scope 
across which the caret does not already extend.

Global

Insert mode affects all players in the flow. During note input, dotted lines are shown 
on staves affected by the Insert mode scope across which the caret does not already 
extend.

Global Adjustment of Current Bar

Insert mode affects all players in the flow, changes the duration of the current bar, 
and updates its time signature to reflect its new duration. For example, inputting notes 
extends the duration of bars while deleting notes shortens the duration of bars.

During note input, dotted lines are shown on staves affected by the Insert mode scope 
across which the caret does not already extend.

TIP

You can use the Global Adjustment of Current Bar Insert mode scope to create and 
delete pick-up bars by deleting notes/rests in the first bar in the flow. You can also use 
it to shorten the last bar in flows that start with a pick-up bar.

RELATED LINKS
Caret on page 191
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Deleting notes/items on page 412
Arranging tools on page 412
Players on page 107
Voices on page 1134
Time signatures on page 1084
Pick-up bars on page 1088

Changing the Insert mode scope
You can change the Insert mode scope; for example, if you want to switch from inserting notes 
into the selected voice only to inserting rhythmic time for all players.

The current Insert mode scope is indicated in the Notes toolbox and by the caret during note 
input.

PROCEDURE

● In Write mode, change the Insert mode scope in any of the following ways:

● Press Alt/Opt-I  to cycle through the different Insert mode scopes.

● In the Notes toolbox, click and hold Insert , then click the scope you want.

● Choose Write > Insert Scope > [Scope].

RELATED LINKS
Notes toolbox on page 173
Caret on page 191
Inputting notes in Insert mode on page 212

Setting Insert mode stop positions
You can set a single rhythmic position in each flow as an Insert mode stop position, which 
prevents any material beyond the stop point being affected by inserted notes. For example, if 
you want to insert notes at the start of a flow but want to preserve material from a specific 
position later in the flow.

PROCEDURE

1. In Write mode, select the rhythmic position that you want to be the Insert mode stop 
position in any of the following ways:

● Select an item in the music area.

● In the system track, select the bar whose start barline you want to set as the stop 
position.

2. Set the Insert mode stop position in any of the following ways:

● Press Shift-Alt/Opt-I .

● In the system track, click Set Edit Stop Position .

● Choose Write > Insert Scope > Set Edit Stop Position.

RESULT
The Insert mode stop position for the flow is set at the selected rhythmic position. It appears as a 
vertical translucent line that spans all staves.

Because each flow can only have a single stop position, any existing stop position elsewhere in 
the flow is deleted.

Write mode
Insert mode 

410
Dorico SE 4.3.30



When Insert mode is activated, existing notes that would otherwise be pushed beyond the stop 
position are deleted.

TIP

You can also move stop positions to barlines by clicking the top handle and dragging to the 
right/left.

EXAMPLE

Insert mode stop position across two piano staves

RELATED LINKS
System track on page 390

Deleting Insert mode stop positions
You can delete Insert mode stop positions after they have been set.

PROCEDURE

● In Write mode, delete Insert mode stop positions in any of the following ways:

● Select an item at the rhythmic position of the Insert mode stop position and press 
Shift-Alt/Opt-I .

● In the system track, click Set Edit Stop Position  above existing stop positions.

● Click the stop position top handle and drag it in any direction until the mouse pointer is 
outside the music, then release the mouse.
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TIP

When the mouse pointer is in the correct position, the stop position appears as a dotted 
line.

Arranging tools
Arranging tools in Dorico SE allow you to allocate notes to different staves and voices quickly and 
efficiently.

These tools include copying notes and items to multiple staves at the same time, and multiple 
times within a selected range, moving notes between staves, and changing the voices of notes.

RELATED LINKS
Filters on page 393
Transposing tools on page 423
Selecting notes/items on page 387
Changing the duration of notes on page 236
Repitching notes without changing their rhythm on page 427
Splitting notes by duration on page 238
Rhythmic grid on page 190
Insert mode on page 408
Chord mode on page 228

Deleting notes/items
You can delete any notes/items you have input into your project independently of each other, 
such as deleting repeat endings without deleting the notes in them. However, you must be in 
Write mode. You cannot delete notes and items in Setup mode or Print mode.

You can also delete notes in the Key Editor, but not other notation items.

NOTE

You cannot delete initial clefs at the start of flows or clefs shown automatically at the start of 
each system. If you do not want any clef to appear on a staff, you can input an invisible clef.

PROCEDURE

1. In Write mode, select the notes, items, and/or the signposts of items you want to delete.

NOTE

● You must select barlines directly, not their signposts.

● If you delete some but not all dynamics from a dynamics group that is linked to other 
staves, the selected dynamics are also deleted from all linked staves.

● Deleting only tuplets does not delete the notes within them, and vice versa.

● To select multiple items of the same type, you can use large selections and/or filters.

2. Press Backspace or Delete .
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RESULT
All selected notes/items are deleted from your project. Dorico SE moves your selection to the 
most logical and nearby item to the deleted items. For example, if you deleted a note, Dorico SE’s 
first choice is the nearest note in the same voice.

If Insert mode was activated, notes following deleted notes move up to fill the gap. If Insert 
mode was deactivated, deleted notes are replaced by implicit rests as appropriate.

TIP

You can also delete markers by selecting them in the Markers section of the Video panel and 
clicking Delete in the action bar.

If a slur began or ended on a deleted note, the slur is automatically repositioned to the next/
previous notehead. If only one note is left under a slur, the slur is automatically deleted.

Holds and pauses are not automatically deleted if they are not selected when you delete notes. 
They are positioned above the note/rest closest to their rhythmic position, or over whole bar 
rests if you delete all notes in a bar.

Any repeat barlines input as part of repeat endings are not deleted automatically when you 
delete repeat endings.

When you delete barlines, the two bars on either side combine into one bar, containing the same 
number of beats but without changing the time signature. This might cause note, rest, and beam 
groupings to change.

When you delete time signatures, subsequent bars are re-barred according to the previous time 
signature in the score, up until the next time signature or the end of the flow, whichever comes 
first. Flows without time signatures are notated in an open meter, but notes and items retain 
their duration and positions.

When you delete clefs and key signatures, the pitches of notes are not changed but they are 
automatically notated according to the previous clef and key signature on the staff, such as 
with additional accidentals, up to the next existing one or the end of the flow, whichever comes 
first. Flows without any key signatures are treated as if there were an open/atonal key signature 
rather than A minor or C major.

When you delete octave lines, any notes to which the deleted octave lines previously applied are 
shown at either concert pitch or transposed pitch, depending on your current setting for the 
layout.

If you delete some but not all dynamics in a dynamics group that is linked to other staves, the 
selected dynamics are also deleted from all linked staves. However, if you select and delete the 
whole group of dynamics from a single staff, those dynamics are not deleted from other linked 
staves. Deleting immediate dynamics immediately before/after hairpins can automatically adjust 
the length of hairpins, depending on the context.

When you delete rehearsal marks, any subsequent rehearsal marks are adjusted until the next 
change in the sequence or the end of the flow, whichever comes first. For example, if you delete 
the first rehearsal mark, the second rehearsal mark shows either the letter A, the number 1, or 
the bar number, depending on your choice of sequence type.

Deleting tempo marks also removes them from the Tempo editor and the Tempo track in Play 
mode. The tempo in playback follows the previous tempo mark, or the default tempo of 120 bpm 
if there is no previous tempo mark.

AFTER COMPLETING THIS TASK
If you deleted notes/items because you want to change where they occur, you can input new 
notes/items at the new positions.
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RELATED LINKS
Signposts on page 407
Editing items on page 395
Selecting notes/items on page 387
Filters on page 393
Selecting lyrics using filters on page 827
Deleting rests on page 1012
Deleting notes in the Key Editor on page 583
Note and rest grouping on page 705
Turning existing notes into tuplets on page 1106
Turning tuplets into normal notes on page 1106
Insert mode on page 408
Insert mode scopes on page 409
Groups of dynamics on page 765
Linked dynamics on page 767
Accidental duration rules on page 660
Changing the rehearsal mark sequence type on page 965
Inputting notes on page 197
Notations input on page 246

Copying and pasting notes/items
You can copy and paste items, including notes and notations, to other rhythmic positions and 
staves in different ways.

PROCEDURE

1. In Write mode, select the notes/items you want to copy.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Copy the selected notes/items to other rhythmic positions in any of the following ways:

● Alt/Opt -click each position to which you want to paste them.

● Press Ctrl/Cmd-C , select the position to which you want to paste them, then press Ctrl/
Cmd-V .

● To repeat the material directly after itself, press R .

● To copy notes/items to the staff above, select them and choose Edit > Paste Special > 
Duplicate to Staff Above.

● To copy notes/items to the staff below, select them and choose Edit > Paste Special > 
Duplicate to Staff Below.

RESULT
The selected notes/items are copied without deleting them from their original positions. By 
default, any MIDI CC points in the copied range are also pasted.

If you copied dynamics or slurs to other staves at the same rhythmic position, they are 
automatically linked by default.

TIP

You can assign key commands for Duplicate to Staff Above and Duplicate to Staff Below on 
the Key Commands page in Preferences.
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RELATED LINKS
Disabling automatic copying of MIDI data when pasting on page 417
Copying and pasting lyrics on page 824
Copying and pasting notes in the Key Editor on page 582
Copying and pasting points in the Key Editor on page 573
Copying dynamic points to other instruments on page 594
Copying MIDI points to other instruments on page 600
Filters on page 393
Large selections on page 389
Selecting/Deselecting notes and items individually on page 387
Moving notes/items to other staves on page 421
Resetting notes crossed to other staves on page 701
Moving notes/items rhythmically on page 417
Lengthening/Shortening items on page 396
Changing the duration of notes on page 236
Splitting notes by duration on page 238
Disabling automatic linking of dynamics and slurs when pasting on page 417
Repitching notes without changing their rhythm on page 427
Key Commands page in the Preferences dialog on page 54
Linked dynamics on page 767
Linked slurs on page 1027
Numbered bar regions on page 992
Insert mode on page 408
Chord mode on page 228

Copying and pasting notes/items to multiple staves
You can copy and paste notes and other items to multiple staves at once; for example, to copy a 
single phrase to all the woodwind staves when they are playing in unison.

PROCEDURE

1. In Write mode, select the notes/items you want to copy to multiple staves.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Press Ctrl/Cmd-C  to copy the selected notes/items.

3. Select an item on each staff to which you want to paste the selected items.

NOTE

The earliest selected item on the top selected staff determines the rhythmic position for 
pasted items on all staves.

4. Press Ctrl/Cmd-V  to paste the selected notes/items.

RESULT
The selected notes/items are copied to all of the selected staves. By default, any MIDI CC points 
in the copied range are also pasted.

If you copied dynamics or slurs to other staves at the same rhythmic position, they are 
automatically linked by default.
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TIP

If you selected a range of notes/items on each staff, the selected notes/items are also pasted 
multiple times to fill the selected range.

RELATED LINKS
Filters on page 393
Large selections on page 389
Disabling automatic copying of MIDI data when pasting on page 417
Linked dynamics on page 767
Linked slurs on page 1027
Resetting notes crossed to other staves on page 701

Copying and pasting notes/items to fill a selected range
You can copy and paste items, including notes and notations, multiple times within a selected 
range at once; for example, if you want to fill multiple bars with the same phrase.

NOTE

You can only copy and paste items that have a duration to fill a selection. For example, you can 
copy and paste gradual dynamics to fill a selection but not immediate dynamics.

PROCEDURE

1. In Write mode, select the notes/items you want to copy throughout a range.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Press Ctrl/Cmd-C  to copy the selected notes/items.

3. Select the range throughout which you want to paste the selected notes/items.

4. Press Ctrl/Cmd-V  to paste the selected notes/items.

RESULT
The selected notes/items are copied as many times as will fit within the selected range without 
extending beyond it. By default, any MIDI CC points in the copied range are also pasted.

If you copied dynamics or slurs to other staves at the same rhythmic position, they are 
automatically linked by default.

TIP

If you selected a range on multiple staves, the selected items are also pasted to multiple staves.

RELATED LINKS
Filters on page 393
Large selections on page 389
Splitting notes by duration on page 238
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Disabling automatic linking of dynamics and slurs when pasting
By default, dynamics and slurs are automatically linked when you copy them to other staves at 
the same rhythmic position. You can disable this behavior so dynamics and slurs are not linked 
by default.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Editing section, deactivate Link dynamics and slurs to existing items when 
pasting.

4. Click Apply, then Close.

RELATED LINKS
Preferences dialog on page 53
Linked dynamics on page 767
Linked slurs on page 1027

Disabling automatic copying of MIDI data when pasting
By default, all MIDI CC, MIDI pitch bend, and dynamic points are copied when you copy the notes 
to which they apply. You can disable this behavior for all future projects on your computer.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, deactivate Include MIDI CC, pitch bend and dynamics from Key 
Editor when copying music.

4. Click Apply, then Close.

RELATED LINKS
Preferences dialog on page 53
Copying and pasting notes/items on page 414
Copying and pasting notes in the Key Editor on page 582

Moving notes/items rhythmically
You can move notes and items to new rhythmic positions to the right/left along staves after they 
have been input. For example, if you want a cresc. dynamic to start a beat later. You can also 
move individual dynamics and playing techniques within a group.

NOTE

● These steps do not apply to the following items: barlines, notehead brackets, glissando lines, 
notehead-attached horizontal lines, fingerings and fingering slides, jazz articulations, guitar 
bends, vibrato bar dives/returns, pedal retakes, and tremolo strokes. If you want to change 
the rhythmic positions of these items, you must delete them from their original positions 
and input new ones at the new positions.
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We recommend deleting and inputting new arpeggio signs and vertical lines rather than 
moving them. If you move arpeggio signs and vertical lines to the rhythmic position of a rest, 
they are deleted.

● Because markers have a fixed position in time, moving markers relative to the notated music 
automatically changes the tempo on either side of the marker. If you want to move a marker 
to a new time position, you must change the timecode of the marker; for example, if you 
want to move it from 25 seconds to 28 seconds.

PREREQUISITE
You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In Write mode, select the notes, items, or signposts that you want to move.

NOTE

● If you want tuplet notes to remain tuplets, you must also select their tuplet numbers/
ratios, brackets, or tuplet signposts, otherwise notes become normal notes of their 
rhythmic value when you move them beyond the boundaries of tuplets.

● You can only move a single slur, marker, repeat ending, or bar repeat region at a time.

● When using the mouse, you can only move a single item at a time. You cannot 
move notes or the following items using the mouse: tuplets, lyrics, slash regions, time 
signatures, arpeggio signs, and vertical lines.

● You can only select clefs that you have input. You cannot select initial clefs at the start of 
flows or clefs shown automatically at the start of each system.

● To move a single dynamic within a group, you must click and drag it with the mouse. If 
you use the key commands, the whole group is moved.

● Moving multiple playing techniques or dynamics in the same group at the same time 
ungroups them.

2. Optional: If you selected notes and do not want them to overwrite existing notes they pass 
over as part of their move, activate one of the following:

● If you want the selected notes to overlap with existing notes, activate Chord mode by 
pressing Q  or clicking Chords  in the Notes toolbox.

● If you want the selected notes to move through existing notes, activate Insert mode in 
Write mode by pressing I  or clicking Insert  in the Notes toolbox.

NOTE

Moving notes rhythmically with Insert mode activated can affect the durations of 
existing notes the selected notes move through.

3. Move the notes, items, and/or signposts in any of the following ways:

● To move them to the right, press Alt/Opt-Right Arrow .

● To move them to the left, press Alt/Opt-Left Arrow .

NOTE

Most items move according to the current rhythmic grid resolution. A single selection 
of the following items moves to adjacent noteheads, bars, or barlines: dynamics, 
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ornaments, slurs, lines, octave lines, pedal lines, playing techniques, rehearsal marks, 
repeat endings, and bar repeat regions.

● To move items to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move items to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

● Click and drag the selected item to the right/left.

NOTE

The following items move to adjacent noteheads, bars, or barlines: dynamics, 
ornaments, slurs, horizontal lines, octave lines, pedal lines, playing techniques, rehearsal 
marks, repeat endings, and bar repeat regions.

RESULT
The selected notes, items, and/or signposts are moved to new rhythmic positions. Attachment 
lines link items to the rhythmic positions to which they apply.

Most items move according to the current rhythmic grid resolution. However, a single selection 
of some items automatically moves to adjacent noteheads, bars, or barlines. When multiple 
items are selected, they move as a block according to the current rhythmic grid resolution.

NOTE

Only a single instance of many items, such as tempo marks and clefs, can exist at each rhythmic 
position on each staff. If an item passes over another item of the same type as part of its move, 
the existing item is deleted or shortened accordingly.

You can undo this action, but any items deleted in the process are only restored if you moved 
items using the keyboard.

Items that can have multiple instances at the same rhythmic position on the same staff include 
dynamics, octave lines, playing techniques, horizontal lines, slash regions, and text items. 
However, if you move multiple items together, any existing items of the same type between the 
selected items or that they pass over as part of the move are deleted or shortened accordingly 
unless Insert mode is activated.

Notes are automatically positioned according to their rhythmic duration and position relative to 
other notes.

If a tuplet number/ratio or tuplet bracket is included in the selection, the whole tuplet is moved 
along the staff. If it crosses a barline, the tuplet is automatically adjusted to compensate. 
However, tuplets are not automatically adjusted at the mid-point of bars, where it is convention 
to split tuplets to show the beat division. You must enter two tuplets manually to show the beat 
division at the mid-point of bars.

Items such as clefs, key signatures, and time signatures take effect from their new positions until 
the next item of the same type or the end of the flow, whichever comes first. Barlines on either 
side of a moved time signature are automatically updated up to the previous/next existing time 
signature, or the start/end of the flow.

If you moved divisi change signposts, any music on divisi staves outside of divisi passages 
is automatically hidden, and any unison ranges before/after divisi passages are automatically 
updated.

If you moved harp pedal diagrams and colors are shown for notes out of range, any notes that 
no longer fit with the prevailing harp pedal diagram appear red.
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The position of holds and pauses you have moved might not appear to change. For example, if 
one staff has a bar rest and you move a fermata rhythmically within the bar, the fermata still 
appears above the bar rest.

The rhythmic duration of slurs is usually maintained. However, depending on the rhythms they 
cross as they move, slurs may cover longer/shorter durations than before the move.

Moving repeat endings does not automatically input, delete, or move repeat barlines.

When you move markers, their fixed position in time is not changed. Therefore, the tempo 
immediately preceding the marker automatically updates so that the marker occurs at the 
correct time. For example, moving a marker to the right increases the preceding tempo. Any 
gradual tempo changes between the preceding tempo change or the start of the flow and the 
marker are removed. The tempo change affects the positions of all other markers in the flow 
relative to the notated music.

RELATED LINKS
Rhythmic grid on page 190
Notes toolbox on page 173
Note spacing on page 533
Chord mode on page 228
Insert mode on page 408
Note and rest grouping on page 705
Tuplet brackets on page 1109
Tuplet numbers/ratios on page 1112
Changing the duration of notes on page 236
Lengthening/Shortening items on page 396
Changing the staff-relative placement of items on page 400
Moving notes/items to other staves on page 421
Creating cross-staff beams/tremolos on page 697
Moving figured bass resolutions on page 779
Moving the center of messa di voce hairpins on page 762
Splitting pedal lines on page 929
Hiding/Showing colors for notes out of range on page 847
Groups of dynamics on page 765
Groups of playing techniques on page 943
Deleting notes/items on page 412
Input methods for lines on page 352
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Input methods for guitar bends and guitar techniques on page 323
Input methods for clefs and octave lines on page 299
Input methods for repeats and tremolos on page 372
Adding retakes with the popover on page 345
Adding retakes with the panel on page 347
Inputting fingerings on page 249
Hiding/Showing fingering slides on page 793
Showing brackets on noteheads on page 850
Changing the timecodes of markers on page 969
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Moving notes/items to other staves
You can move notes and items to other staves of any type; for example, if you want to move 
individual notes from one keyboard staff to another after importing a keyboard part from a MIDI 
file.

NOTE

● These steps do not apply to pedal lines or system objects.

● If you want notes to appear on a different staff but remain attached to their original staff, 
such as to create a cross-staff beam, you can cross notes to other staves instead.

PROCEDURE

1. In Write mode, select the notes and/or items you want to move to another staff.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Move the selected notes/items another staff in one of the following ways:

● To move them to the staff above, press Alt/Opt-N .

● To move them to the staff below, press Alt/Opt-M .

● Choose Edit > Paste Special > Move to Staff Above.

● Choose Edit > Paste Special > Move to Staff Below.

TIP

You can also choose these options from the context menu.

RESULT
The selected notes and/or items are moved to another staff by cutting them from their original 
staff and pasting them to the new staff. By default, notes are pasted into the first voice active on 
that staff.

Notes within tuplets remain tuplets even if you did not select the tuplet bracket, tuplet number/
ratio, or tuplet signpost.

RELATED LINKS
Filters on page 393
Large selections on page 389
Creating cross-staff beams/tremolos on page 697
Moving notes/items rhythmically on page 417
Copying and pasting notes/items to multiple staves on page 415
Changing the duration of notes on page 236
Changing the pitch of individual notes on page 424
Changing the positions of system objects on page 1045
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337

Write mode
Arranging tools 

421
Dorico SE 4.3.30



Changing the voice of existing notes
You can change the voice of notes after they have been input, including notes in slash voices. For 
example, you can change notes in an up-stem voice to a down-stem voice or a slash voice.

PROCEDURE

1. In Write mode, select the notes whose voice you want to change.

TIP

You can use large selections and filters to select many notes in the same voice quickly.

2. Change the voice in any of the following ways:

● To change the selected notes to a new normal voice, press Shift-V  or click Create Voice 
 in the Notes toolbox.

● To change the selected notes to a new slash voice, press Shift-Alt/Opt-V . You can also 
click and hold Create Voice  in the Notes toolbox, then click Create Slash Voice .

● To change the selected notes to an existing voice, press V  or click Next Voice  in the 
Notes toolbox to cycle through active voices on the staff.

RESULT
The voice of the selected notes is changed, which might cause Dorico SE to change the stem 
directions of the selected notes and other notes on the staff. Rests appear as required around 
notes in different voices.

If you changed notes to a slash voice, they no longer play back.

TIP

You can also change the voice of selected notes by choosing Edit > Notations > Voices > Change 
Voice > [Voice]. You can also choose these options from the context menu. If there is only one 
voice on the staff, you can create a new voice for your selected notes.

AFTER COMPLETING THIS TASK

● You can later delete or hide rests and change the stem direction of notes manually.

● You can also change whole voices into slash voices.

RELATED LINKS
Notes toolbox on page 173
Hiding/Showing voice colors on page 1135
Inputting notes into multiple voices on page 207
Inputting notes into slash voices on page 209
Large selections on page 389
Filters on page 393
Implicit rests in multiple-voice contexts on page 1010
Deleting rests on page 1012
Changing the stem direction of notes on page 856
Changing the slash voice type on page 1006
Changing the duration of notes on page 236
Tuplets on page 1104
Signposts on page 407
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Swapping the contents of voices
You can swap the contents of two voices that contain musical material.

PROCEDURE

1. In Write mode, select the notes in two voices that you want to swap.

2. Choose Edit > Notations > Voices > Swap Voice Contents. You can also choose this option 
from the context menu.

RESULT
The contents of the voices are swapped. For example, the notes previously in an up-stem voice 
are now in a down-stem voice, and the notes previously in a down-stem voice are now in an 
up-stem voice.

NOTE

Depending on the pitches involved in the swap and their stem directions, the notes might 
overlap. Dorico SE automatically positions notes with the noteheads partially overlapping, in 
order to minimize the horizontal space they occupy and maintain the clarity of the rhythm. 
However, if you want to change this arrangement, you can change the order of voices or change 
the voice column index.

EXAMPLE

An E is in the up-stem voice, an F in the down-stem 
voice.

After swapping their voice contents, the E is in the 
down-stem voice, and the F is in the up-stem voice.

RELATED LINKS
Swapping the order of voices on page 1137
Voice column index on page 1137

Transposing tools
In Dorico SE, you can change the pitches of existing notes in a variety of ways.

RELATED LINKS
Arranging tools on page 412
Transposing instruments on page 119
Concert vs. transposed pitch on page 155
Transposing notes in the piano roll editor on page 581
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Changing the pitch of individual notes
You can raise/lower the pitch and register of individual notes, including grace notes, after they 
have been input by octave divisions, staff position, and octaves.

PROCEDURE

1. In Write mode, select the notes whose pitches you want to change.

2. Raise/Lower the pitches of the selected notes in any of the following ways:

● To move notes up one staff position, such as from C to D, press Alt/Opt-Up Arrow .

● To move notes down one staff position, such as from D to C, press Alt/Opt-
Down Arrow .

● To transpose notes up a single octave division, such as a half-step (semitone) in 12-EDO 
or a quarter tone in 24-EDO, press Shift-Alt/Opt-Up Arrow .

● To transpose notes down a single octave division, such as a half-step (semitone) in 
12-EDO or a quarter tone in 24-EDO, press Shift-Alt/Opt-Down Arrow .

● To transpose notes up an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To transpose notes down an octave, press Ctrl/Cmd-Alt/Opt-Down Arrow .

RESULT
The pitch or register of the selected notes is changed. Any figured bass shown on the affected 
staves is updated automatically.

If the pitch is now impossible to play on a fretted instrument, such as if a note would have to be 
played below the nut on the lowest string, it appears on tablature as a question mark.

NOTE

You can press Alt/Opt-Up Arrow  and Alt/Opt-Down Arrow  to change the staff positions of 
notes in percussion kits using grid and five-line staff presentation types. However, this also 
changes the instrument playing the note.

RELATED LINKS
Equal Division of the Octave (EDO) on page 820
Adding notes above/below existing notes on page 232
Respelling notes on page 428
Inputting accidentals on page 219
Transposing notes in the piano roll editor on page 581
Figured bass on page 771
Arranging tools on page 412

Transposing selections
You can transpose whole flows or specific selections, including selected key signatures, using the 
Transpose dialog.

TIP

Dorico SE automatically shows the appropriate key signatures for transposing instruments in 
transposing layouts.

Write mode
Transposing tools 

424
Dorico SE 4.3.30



PROCEDURE

1. Optional: In Write mode, select the region you want to transpose.

NOTE

● If you want to transpose key signatures, you must include them in your selection.

● If nothing is selected, the whole flow in which you last selected a note/item is 
transposed.

2. Choose Write > Transpose to open the Transpose dialog.

3. Adjust the parameters required for your transposition, such as interval and quality.

TIP

● We recommend using the Calculate interval section to determine your required 
settings; for example, if you want to transpose from G♭ major to G major.

● Different intervals have different possible qualities. For example, you can specify a major 
third but not a major octave. Therefore, if you want to set your transposition parameters 
manually, we recommend selecting the interval before the quality.

4. Optional: If you want to transpose any key signatures in the flow or included in your 
selection, activate Transpose key signatures.

5. Click OK to save your changes and close the dialog.

RESULT
All notes in your selection, or all notes in the flow if nothing was selected, are transposed 
according to the interval or number of divisions of the octave specified in the Transpose dialog. 
If your selection included key signatures and you activated Transpose key signatures, all key 
signatures in the selection are also transposed.

Any figured bass shown on the affected staves is also transposed accordingly.

Key signatures that apply to all staves are transposed on all staves in the layout, even if your 
selection did not include all staves. Key signatures that apply only to single staves are transposed 
if they are included in a selection, but this does not affect any other staff in the layout.

RELATED LINKS
Large selections on page 389
Selecting/Deselecting notes and items individually on page 387
Figured bass on page 771
Enharmonic equivalent key signatures on page 819
Concert vs. transposed pitch on page 155
Making layouts transposing/concert pitch on page 155

Transpose dialog
The Transpose dialog allows you to transpose whole flows or selections of notes, including key 
signatures. You can transpose according to an interval and quality or by a set number of octave 
divisions.

● You can open the Transpose dialog in Write mode by choosing Write > Transpose.
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The Transpose dialog contains the following sections:

1 Transposition options

Contains options that allow you to specify the transposition you want. For example, you can 
choose to transpose by an interval quality, such as a major third, or by a set number of 
divisions of the octave. You can choose the direction of the transposition, whether it includes 
octaves, and the interval and quality or number of divisions by which you want to transpose 
your selection.

According to convention, different intervals have different possible qualities. For example, 
you can specify a major third but not a major octave. Therefore, we recommend selecting 
the interval before the quality.

Additional options also allow you to transpose any key signatures included in your selection, 
keep relative respelled notes and chord symbols where possible, and avoid double and triple 
accidentals.

NOTE

You can only use Respell to avoid double and triple sharps and flats when transposing 
music in tonality systems that are compatible with 12-EDO.

2 Calculate interval

Allows you to set transposition options according to a starting note and the resulting note 
you want. For example, if you want to transpose a selection relative to a C♮ becoming a G♯ 
but you are not certain of the interval and quality required, you can enter those two notes 
in the Calculate interval section, click Apply, and Dorico SE automatically sets the required 
transposition options for you.

NOTE

The Transpose dialog does not allow transpositions that would result in impossible notations, 
such as sharper than a triple sharp, or that require a microtonal accidental that does not exist in 
the tonality system in place at the position of your selection.
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RELATED LINKS
Note tools popover on page 233
Equal Division of the Octave (EDO) on page 820
Tonality systems on page 820
Arranging tools on page 412

Transposing existing notes with the note tools popover
You can change the pitch of notes after they have been input using the note tools popover.

PROCEDURE

1. In Write mode, select the notes you want to transpose.

2. Open the note tools popover in any of the following ways:

● Press Shift-I .

● In the Notations toolbox, click Popovers , then Note Tools .

3. Enter the transposition interval you want into the popover.

For example, enter t3 to transpose the notes up a third, or t-min6 to transpose the notes 
down a minor sixth.

4. Press Return  to close the popover.

RESULT
The selected notes are transposed by the degree specified. Any figured bass shown on the 
affected staves is also transposed accordingly.

RELATED LINKS
Notations toolbox on page 178
Note tools popover on page 233
Figured bass on page 771

Repitching notes without changing their rhythm
You can repitch notes after you have input them while keeping their durations the same. For 
example, if you want to duplicate the rhythm but have different pitches.

PROCEDURE

1. In Write mode, select the first note you want to repitch.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to repitch notes on multiple staves at once, extend the caret to those 
staves.

4. Activate Lock to Duration in any of the following ways:

● Press L .

● In the Notes toolbox, click Lock to Duration .

5. Enter the pitches you want.
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6. Optional: Press L  or click Lock to Duration  again to deactivate Lock to Duration.

NOTE

Lock to Duration automatically deactivates when you reach the last existing note on the 
staff. By default, normal note input continues using the previous note value selected before 
you activated Lock to Duration.

RESULT
Existing notes on the selected staff are repitched without their rhythms being changed. The caret 
automatically advances from note to note, even if there are large rests between notes on the 
staff.

TIP

You can set a maximum number of rests over which you want to advance when repitching notes 
in Preferences > Note Input and Editing > Note Input > Lock Duration.

RELATED LINKS
Caret on page 191
Extending the caret to multiple staves on page 195
Arranging tools on page 412
Preferences dialog on page 53

Respelling notes
You can change the enharmonic spelling of notes so they are shown as their enharmonic 
equivalents; for example, to show the stepwise movement in a phrase clearly, or to avoid altered 
unisons in a chord. You can do this for all layouts or only in the current part layout.

By default, Dorico SE uses an algorithm that automatically decides the spelling of pitches, based 
on key signature and context.

There are always at least three options for every pitch, as Dorico SE allows enharmonic spellings 
to show up to two accidental glyphs. This means the same note can be spelled four ways if the 
original pitch can be spelled with the note name either two notes below or two notes above, 
using a maximum of two accidental glyphs. For example, B is a possible enharmonic spelling of 
G♯ because a triple-flat uses a single accidental glyph, whereas an F♯ uses two accidental glyphs.

PROCEDURE

1. In Write mode, open the layout in which you want to respell accidentals.

NOTE

By default, respelling notes in score layouts also affects their spelling in all other layouts, but 
respelling notes in part layouts only affects their spelling in the current part layout.

2. Select the notes you want to respell.

3. Respell the selected notes in any of the following ways:

● To respell them upwards, press Alt/Opt-=  or click Respell Using Note Name Above 
in the Keyboard panel toolbar.

● To respell them downwards, press Alt/Opt--  or click Respell Using Note Name Below 
 in the Keyboard panel toolbar.
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● To respell them automatically, choose Write > Respell > Respell Notes Automatically 
to open the Respell Notes Automatically dialog.

4. Optional: If you opened the Respell Notes Automatically dialog, change the settings for 
respelling as required, then click OK to close the dialog and respell the selected notes.

RESULT
The enharmonic spelling of the selected notes is changed.

EXAMPLE

A G sharp When respelled 
downwards, the G sharp 
becomes an F triple-
sharp

When respelled upwards, 
the G sharp becomes an 
A flat

When respelled upwards 
again, the G sharp 
becomes a B triple-flat

AFTER COMPLETING THIS TASK
You can copy note spellings to other layouts, such as if you respelled notes in a part layout but 
want the same spelling to appear in the full score layout.

RELATED LINKS
Keyboard panel on page 183
Switching between layouts on page 40
Selecting notes/items on page 387
Accidentals on page 655
Accidental selection during MIDI input on page 220
Key signatures on page 815
Tonality systems on page 820
Input methods for key signatures on page 253
Copying note spellings to other layouts on page 431
Resetting note spellings on page 431

Respell Notes Automatically dialog
The Respell Notes Automatically dialog allows you to simplify the note spelling of all notes in 
specific selections based on the musical context, including respelling some notes upwards and 
other notes downwards.

● You can open the Respell Notes Automatically dialog in Write mode when at least one note 
is selected in the music area by choosing Write > Respell > Respell Notes Automatically.
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The Respell Notes Automatically dialog contains the following options:

Additional context at start
Allows you to specify additional musical context before the selected notes that you 
want Dorico SE to consider when calculating automatic note spellings.

● None: Only notes in the selection.

● To start of bar: Includes notes back to the start of the earliest selected bar.

● Previous bar: Includes notes back to the start of the previous bar.

● Previous notes: Includes a specified number of notes before the selection.

● Number of additional notes: Allows you to specify the number of additional notes 
you want to consider. Only available if you have activated Previous notes.

Additional context at end
Allows you to specify additional musical context after the selected notes that you want 
Dorico SE to consider when calculating automatic note spellings.

● None: Only notes in the selection.

● To end of bar: Includes notes up to the end of the last selected bar.

● Next bar: Includes notes up to the end of the next bar.

● Following notes: Includes a specified number of notes after the selection.

● Number of additional notes: Allows you to specify the number of additional notes 
you want to consider. Only available if you have activated Following notes.

Prefer accidentals used most in this flow
Allows you to specify whether to choose accidentals based on how frequently they are 
used in the flow or the default accidental for the corresponding pitch delta. Useful in 
tonality systems that contain multiple accidentals with the same pitch delta.

Preserve accidentals on unchanged pitches
Allows you to specify whether existing accidentals on notes that are not respelled are 
retained or chosen according to your setting for Prefer accidentals used most in this 
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flow. Useful in tonality systems that contain multiple accidentals with the same pitch 
delta.

RELATED LINKS
Selecting notes/items on page 387
Respelling notes on page 428
Changing the pitch of individual notes on page 424
Inputting accidentals on page 219
Accidental selection during MIDI input on page 220
Tonality systems on page 820

Copying note spellings to other layouts
You can copy note spellings to other layouts; for example, if you originally respelled notes in a 
part layout but want those spellings to appear in the full score layout as well.

PROCEDURE

1. In Write mode, open the layout containing the note spellings you want to copy.

2. Select the notes you want to respell.

3. Choose Write > Respell > Propagate Note Spellings.

RESULT
The spellings of the selected notes in the current layout are copied to all other layouts in which 
those notes appear.

RELATED LINKS
Switching between layouts on page 40
Part formatting propagation on page 544

Resetting note spellings
You can reset changes to note spellings so they follow the spelling in score layouts; for example, 
if you want future revisions to note spellings you make in the full score layout to affect notes 
whose spelling you previously overrode in a part layout. You can do this in either one part layout 
only or in all layouts.

PROCEDURE

1. Optional: If you want to reset note spellings in one part layout only, open that layout in the 
music area.

2. In Write mode, select the notes whose spellings you want to reset.

3. Reset their note spellings in one of the following ways:

● Choose Write > Respell > Reset Note Spellings in Current Layout.

● Choose Write > Respell > Reset Note Spellings in All Layouts.

RESULT
The spellings of the selected notes are reset either in the current part layout only or in all layouts. 
Their link to the score note spelling is restored, meaning all future changes you make to the 
spelling of the selected notes in score layouts also affect their spelling in either the current part 
layout or all layouts.
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RELATED LINKS
Switching between layouts on page 40
Respelling notes on page 428
Transposing selections on page 424

Splitting flows
You can split flows at specific rhythmic positions. For example, if you want the music from a 
specific bar onwards to be a new flow, separate from the preceding music.

PROCEDURE

1. In Write mode, select a note or item at the position where you want to split the flow.

2. Choose Write > Split Flow.

RESULT
The flow is split into two flows: the existing flow, and a new flow that begins from the position 
of the item you selected. By default, new flows in full score layouts start on a new page in page 
view, and are shown on a separate background in galley view.

RELATED LINKS
Flows on page 148
Adding flows on page 148
Duplicating flows on page 149
Deleting flows on page 151
Deleting empty bars/beats at the end of flows on page 669
Allowing/Disallowing multiple flows on the same page on page 519
Switching between layouts on page 40
Switching to galley/page view on page 47

Comments
Comments allow you to add notes or instructions at precise positions in your project without 
affecting the music. They are considered annotations in Dorico SE, meaning they are not printed 
by default.

Comments exist outside of the music, so they do not affect note spacing, vertical spacing, or 
casting off. However, you can attach them to specific items and staves in order to show the 
precise subject of each comment.

A passage with comments and replies
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By default, comments are shown in the music area. They appear as speech bubble symbols as 
close as possible to their attached position. Comments that are replies are stacked vertically 
below the original comment.

All comments in the current layout are listed in the Comments panel in Write mode. Clicking a 
comment, either in the Comments panel or in the music area, automatically moves the view to 
bring that rhythmic position into focus.

In addition to its content, each comment identifies the following:

● Author of the comment, using either the current user account name or a custom name

On macOS, the user account name uses the long account name; on Windows, it uses the 
full name associated with the account. If Dorico SE cannot determine your account name, a 
dialog appears into which you can add the name and initials you want to use for comments. 
You can also change these in Preferences.

● Date the comment was added

● Instrument to which the comment applies

● Bars to which the comment applies

NOTE

In the music area, only the initials of the author are shown. In the Comments panel, all 
information is shown.

You can hide/show comments at any time, and you can choose to include them, alongside other 
view options, when printing/exporting layouts.

RELATED LINKS
Deleting notes/items on page 412
Changing the author name used for comments on page 437
Annotations on page 507

Comment dialog
The Comment dialog allows you to enter and edit text as comments.

● You can open the Comment dialog by adding a comment, replying to a comment, or double-
clicking an existing comment, either in the music area or in the Comments panel.
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Comments panel
The Comments panel shows all the comments in the current layout as a list. Replies to comments 
are indented to indicate their relationship to the original comment. The Comments panel is 
located in the right zone in Write mode.

● You can hide/show the Comments panel by clicking Panels , then Comments  in the 
Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

Comments panel

Each comment in the panel shows the following:

1 Author name: This uses either the current user account or a custom name, depending on 
the preference that was set when the comment was added.

2 Comment content

3 Date the comment was added to the project

4 Instrument to which the comment applies

5 Bars to which the comment applies
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The action bar at the bottom of the panel contains the following options:

Create Comment

Adds a comment to the selected rhythmic position and staff.

Edit Comment

Opens the selected comment in the Comment dialog and allows you to change its 
content.

Reply to Comment

Adds a comment that is a reply to the selected comment. Replies are shown indented 
in the Comments panel and stacked in the music area.

Export Comments

Exports all the comments in the project as an HTML file, which opens automatically in 
your default web browser. The HTML file is automatically saved in the same location as 
the project.

Delete Comment

Deletes the selected comments.

RELATED LINKS
Notations toolbox on page 178
Changing the author name used for comments on page 437
Exporting comments on page 437

Adding comments
You can add comments at any rhythmic position in your project, including adding different 
comments to multiple staves at the same rhythmic position.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
add a comment. If you want your comment to apply to a range, select multiple items.

2. Press Alt/Opt-C  to open the Comment dialog.

3. Enter your comment into the dialog.

4. Click OK to close the dialog and add the comment.

RESULT
The text you entered into the dialog is saved as a comment. In the music area, it is indicated by a 
speech bubble symbol that contains your initials. In the Comments panel, the text you entered is 
shown alongside your full username, the date, and the instrument and bar number to which you 
added the comment.
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TIP

You can also add comments by clicking Create Comment  in the Comments panel, or by 
choosing Write > Create Comment.

EXAMPLE

A comment in the music area

Replying to comments
You can add replies to existing comments, which is useful when co-ordinating with others as this 
organizes the list of comments in the Comments panel into clear sections.

PROCEDURE

1. In Write mode, select the comment to which you want to reply. You can do this in the music 
area and in the Comments panel.

2. Press Alt/Opt-R  to open the Comment dialog.

3. Enter your reply into the dialog.

4. Click OK to close the dialog and add the reply.

RESULT
The text you entered into the dialog is saved as a reply to the selected comment. In the music 
area, it is indicated by a speech bubble symbol that contains your initials and is positioned 
immediately below the selected comment.

In the Comments panel, the reply is indented below the selected comment.

TIP

You can also reply to comments by clicking Reply to Comment  in the Comments panel, or by 
choosing Write > Reply to Comment.

EXAMPLE

A reply to a comment
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Editing existing comments
You can change the contents of existing comments after you have added them; for example, to 
correct misspellings or add further information.

PROCEDURE

1. Double-click the comment you want to edit to open the Comment dialog. You can do this in 
the music area and in the Comments panel.

2. Change the text in the dialog.

3. Click OK to save your changes and close the dialog.

Changing the author name used for comments
You can change the author name used for comments to either your user account name or a 
custom name. This affects subsequent comments you add to the project without changing the 
author name used for existing comments.

For the custom name, you can specify both the full name that is shown in the Comments panel 
and the initials shown in the music area.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Comments subsection, choose one of the following options for Author name for 
comments:

● User Name

● Custom Name

4. Optional: If you chose Custom Name, enter the full name you want to use into the Full 
name field.

5. Optional: If you chose Custom Name, enter the initials you want to use into the Initials 
field.

6. Click Apply, then Close.

Exporting comments
You can export all comments from all flows in the layout currently open in the music area to an 
HTML file. For example, if you want to view them all in a single place.

PROCEDURE

1. In Write mode, open the layout whose comments you want to export.

2. In the Notations toolbox, click Panels , then Comments  to show the Comments panel.

3. In the Comments section action bar, click Export Comments .

RESULT
All comments in the layout currently open in the music area are saved as an HTML file, which 
opens automatically in your default web browser. The comments are displayed in a table.

Write mode
Comments 

437
Dorico SE 4.3.30



The HTML file is automatically saved in the same location as the project. Its file name includes the 
layout name.

RELATED LINKS
Switching between layouts on page 40
Annotations on page 507
Printing layouts on page 491
Exporting layouts as graphics files on page 495
Exporting lyrics on page 826

Hiding/Showing comments
You can hide/show comments at their positions in the music; for example, if you want to hide 
them when inputting music but show them when engraving.

Comments are considered annotations in Dorico SE, meaning they are not printed by default.

PROCEDURE

● Choose View > Comments.

RESULT
Comments are hidden/shown. When shown, comments appear in the music as speech bubbles.
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Play mode

Play mode allows you to change how your music sounds in playback, including by adjusting the 
mix, changing the playback template, and assigning VST instruments.

Project window in Play mode
The project window in Play mode contains all the tools and functions for setting up your project 
for playback. In Play mode, your project appears in a similar way to that used in a digital audio 
workstation, or “DAW”, such as Cubase.

You can switch to Play mode in any of the following ways:

● Press Ctrl/Cmd-4 .

● In the toolbar, click Play.

● Choose Window > Play.

The project window in Play mode comprises the following:

1 Left zone

Can display either the Track Inspector or VST and MIDI panel, according to the current 
selection at the top of the left zone.

2 Track overview

Allows you to view the tracks in the selected flow, mute/solo instrument tracks, and select 
the track whose music you want to show in the Key Editor or whose sounds you want to edit 
in the Track Inspector.

3 Lower zone

439
Dorico SE 4.3.30



Can display either the Key Editor panel or Mixer panel, according to the current selection in 
the lower zone toolbar.

RELATED LINKS
Project window on page 27
Track overview on page 440
Track Inspector on page 442
VST and MIDI panel on page 445
Key Editor panel on page 564
Mixer panel on page 612
Hiding/Showing zones on page 41

Track overview
The track overview allows you to view the tracks in the selected layout and flow, and to mute and 
solo instrument tracks. It also allows you to select a single track whose music you want to show 
in the Key Editor, if it is unlocked, or whose sounds you want to edit in the Track Inspector. It is 
the central part of the window in Play mode.

The track overview contains the following:

1 Flow selector

Allows you to select the flow you want to show in the track overview. Only a single flow can 
be shown at a time. Only available when nothing is selected in any flow.

2 Track height button

Allows you to cycle through different heights for all tracks in the track overview.

3 Track visibility buttons

Allow you to hide/show the corresponding track.

● Tempo : Hides/Shows the Tempo track.

● Markers : Hides/Shows the Markers track.

● Chords : Hides/Shows the Chords track.

4 Mute /Solo  buttons

Allow you to mute/solo tracks. Shown in track headers when tracks are sufficiently tall, and 
at the top of the track overview when tracks appear short. They apply to the corresponding 
track when shown in track headers, and the selected track when shown at the top of the 
track overview.

5 Ruler

Displays bar numbers and shows beat divisions.

6 Track headers
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Display the name of each track and contain appropriate options for the track type.

7 Tracks

Rows that display an overview of the corresponding musical element, such as notes in 
instrument tracks and chord symbols in the chord symbols track.

8 Playhead

Shows the current rhythmic position in playback.

RELATED LINKS
Tracks on page 448
Instrument tracks on page 449
Tempo track on page 450
Markers track on page 451
Chords track on page 452
Key Editor on page 564
Showing instruments in the Key Editor on page 568
Track Inspector on page 442
Hiding/Showing tracks on page 454
Muting/Soloing tracks on page 461
Playhead on page 455
Changing the height of tracks on page 454
Zooming in/out of tracks on page 455
Hiding/Showing zones on page 41
Switching between layouts on page 40

Switching between flows in the track overview
You can change which flow is displayed in the track overview in Play mode manually. Only a 
single flow can be shown at a time.

PREREQUISITE
You have deselected all notes/items. You cannot switch flows when notes/items are selected.

PROCEDURE

● In Play mode, click the flow selector at the top of the track overview and select a flow from 
the menu.

RELATED LINKS
Selecting/Deselecting notes and items individually on page 387
Switching between layouts on page 40
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Track Inspector
The Track Inspector allows you to edit sounds for the track currently selected in the track 
overview. It is located in the left zone in Play mode.

The Track Inspector contains the following sections:

Routing

Allows you to change the sound routing of the selected track.

The following routing controls are available:

Audio plug-in menu

Allows you to select the VST or MIDI instrument plug-in you want to use for the 
selected track. Only plug-ins already loaded in the project are available.

Port field
Allows you to change the endpoint to which the selected track is assigned by entering 
the port you want to use. Only necessary when using a plug-in that has multiple ports 
of 16 channels.

Channel field
Allows you to change the endpoint to which the selected track is assigned by entering 
the channel you want to use in the loaded VST or MIDI instrument.

NOTE

● You must assign a VST or MIDI instrument and a channel for the Chords track in 
order to hear chords in playback.

● If you manually load sounds into the channel you selected for your Chords 
track and later add more instruments to your project, the sounds for the new 
instruments overwrite the sounds you manually loaded in that channel.

Enable independent voice playback

Allows you to enable independent voice playback for the selected instrument track. 
This shows each voice belonging to the instrument as a separate voice track below the 
instrument track.
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Dorico SE automatically loads enough additional channels, and additional plug-in 
instances if necessary, to accommodate all voices belonging to the corresponding 
instrument project-wide, according to the current playback template. Voices are 
automatically assigned to endpoints according to their voice order.

Disable independent voice playback

Allows you to disable independent voice playback for the selected instrument track and 
return it to using a single endpoint for all voices.

Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

Edit Instrument

Opens the corresponding VST or MIDI instrument in a window, which allows you to edit 
its settings.

Edits apply to
Allows you to determine whether changing the routing of the selected voice affects the 
current flow only or all flows in the project. Only applies to future changes you make 
immediately after choosing either This flow or All flows. Only available for voice tracks 
belonging to instruments with independent voice playback enabled.

Insert Effects

Allows you to add and manage inserts on the Mixer channel for the selected instrument track. 
Each instrument track’s Mixer channel has four insert slots.

Each slot contains the following:

Activate Insert

Activates/Deactivates the insert slot.

Insert menu

Allows you to select an insert to load into the slot.
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Edit Insert

Opens the corresponding effect in a window, which allows you to edit its settings.

TIP

● You can also access inserts for all channels in the Mixer.

● For more information about the plug-ins included with Dorico SE, see the separate document 
Plug-in Reference.

Channel

Shows the Mixer channel strip for the selected track and allows you to adjust the channel.

TIP

You can also access all channels in the Mixer.

RELATED LINKS
Track overview on page 440
Instrument tracks on page 449
Endpoint Setup dialog on page 479
Mixer on page 612
Mixer channel strips on page 616
Enabling independent voice playback on page 460
Changing the sound used for chord symbol playback on page 453
Loading VST/MIDI instruments manually on page 447
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VST and MIDI panel
The VST and MIDI panel contains the VST and MIDI instruments available and used in your 
project, and allows you to edit their settings. It is located in the left zone in Play mode.

VST Instruments

The VST Instruments section of the panel contains plug-in instances that each contain a VST 
instrument plug-in. Dorico SE automatically loads plug-ins and enough plug-in instances for the 
instruments you add to your project according to the current playback template, but you can also 
load VST instruments manually.

NOTE

Dorico SE only shows VST 3 instruments in the VST Instruments section by default. If you also 
want VST 2 instruments to be available, you must allow them. Only Kontakt and NotePerformer 
are allowed by default.

Each VST plug-in instance contains the following:

1 Activate Instance

Activates/Deactivates the plug-in instance.

2 Name

Displays the number and name of the plug-in instance. Plug-in instances are automatically 
numbered to help you differentiate between instances when you have multiple instances of 
the same plug-in.

3 VST Instruments menu

Displays the VST instrument currently loaded in the plug-in instance and allows you to select 
another available VST instrument from the menu.

4 Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

5 Edit Instrument

Opens/Closes the VST instrument window.

The action bar at the bottom of the section contains the following options:

● Add : Adds a new empty plug-in instance.

● Duplicate : Creates a copy of the selected plug-in instance that you can edit separately 
from the original.

● Save Endpoint Configuration : Opens the Save Endpoint Configuration dialog, which 
allows you to save the current state of all plug-in instances in the section as a custom 
endpoint configuration.

● Delete : Deletes the selected plug-in instance.
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MIDI Instruments

The MIDI Instruments section of the panel contains plug-in instances that each contain a MIDI 
device to use for output during playback. Which MIDI devices are available depends on your 
operating system.

● On Windows, you can select any MIDI device that is plugged into your computer.

● On macOS, you can select any MIDI device that is plugged into your computer, and any other 
device set up in the Audio MIDI Setup application. For example, this allows you to use MIDI 
from one application in another application.

TIP

We recommend plugging MIDI devices into your computer before starting Dorico SE. Similarly, if 
your device is not recognized, we recommend restarting Dorico SE.

Each MIDI plug-in instance contains the following:

1 Name

Displays the number and name of the plug-in instance. Plug-in instances are automatically 
numbered to help you differentiate between instances when you have multiple instances of 
the same plug-in.

2 MIDI Instruments menu

Displays the MIDI device currently loaded in the plug-in instance and allows you to select 
another available MIDI device from the menu.

3 Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

The action bar at the bottom of the section contains the following options:

● Add : Adds a new empty plug-in instance.

● Save Endpoint Configuration : Opens the Save Endpoint Configuration dialog, which 
allows you to save the current state of all plug-in instances in the section as a custom 
endpoint configuration.

● Delete : Deletes the selected plug-in instance.

RELATED LINKS
Project window in Play mode on page 439
Playback templates on page 471
Endpoints on page 479
Endpoint Setup dialog on page 479
Custom endpoint configurations on page 481
Save Endpoint Configuration dialog on page 483
Allowing/Blocking VST plug-ins on page 459
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Loading VST/MIDI instruments manually
Dorico SE automatically loads plug-in instances as required, according to the instruments in the 
project and the current playback template. However, you can also load VST/MIDI instruments 
manually, either into new plug-in instances or into existing ones to replace existing VST/MIDI 
instruments.

PREREQUISITE

● Any VST instruments you want to use are saved on your computer.

● You have connected any MIDI devices you want to use.

TIP

We recommend plugging MIDI devices into your computer before starting Dorico SE. 
Similarly, if your device is not recognized, we recommend restarting Dorico SE.

PROCEDURE

1. In Play mode, choose VST and MIDI in the left zone to show the VST and MIDI panel.

2. Optional: If you want to load a VST/MIDI instrument into a new plug-in instance, click Add 
in the corresponding section of the VST and MIDI panel.

3. In the plug-in instance into which you want to load a new VST/MIDI instrument, select the 
one you want to load from the menu.

4. Optional: If you loaded a VST instrument, click Edit Instrument  to open the VST/MIDI 
instrument window, where you can load sounds into channels.

AFTER COMPLETING THIS TASK

● You can assign instruments/voices and expression/percussion maps to endpoints in the VST/
MIDI instruments you loaded.

● If you loaded a MIDI instrument, we strongly recommend disabling it for MIDI input to avoid 
feedback loops.

RELATED LINKS
Playback templates on page 471
VST and MIDI panel on page 445
Endpoint Setup dialog on page 479
Assigning instruments/voices to endpoints on page 484
Assigning expression/percussion maps to endpoints on page 485
Enabling/Disabling MIDI input devices on page 246
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Tracks
Tracks are rows that represent a musical element across time, extending from left to right. They 
allow you to control multiple musical elements in a project simultaneously but independently of 
each other.

The term was established when audio mixing was done on tapes, and multitracking allowed 
separate elements of the music to be recorded and edited independently of each other before 
being combined into the final piece of music.

In modern programs, such as Cubase, tracks can contain many types of sounds, including 
audio recordings and software instruments. Tracks containing audio recordings often display the 
waveform of the audio, while tracks containing software instruments often display the pitches as 
rectangular note events positioned horizontally in time and vertically in pitch on a piano roll.

Dorico SE provides the following types of tracks in Play mode:

Instrument tracks
Display previews of the notes belonging to the corresponding instrument. Each 
instrument in the project has its own instrument track, including when a single player 
holds multiple instruments.

Selecting an instrument track shows its music in the Key Editor, if it is unlocked, and its 
track settings in the Track Inspector.

Tempo track
Displays a preview of any tempo changes in the flow. Each project contains a single 
Tempo track.

Selecting the Tempo track shows the Tempo editor in the Key Editor panel, if it is 
unlocked, and its track settings in the Track Inspector.

Markers track
Displays any markers in the flow, including their text. Each project contains a single 
Markers track.

Chords track
Displays any chord symbols in the flow. Each project contains a single Chords track.

Selecting the Chords track shows its track settings in the Track Inspector.

RELATED LINKS
Track overview on page 440
Track Inspector on page 442
Key Editor on page 564
Showing instruments in the Key Editor on page 568
Tempo track on page 450
Chords track on page 452
Markers track on page 451
Changing the height of tracks on page 454
Hiding/Showing tracks on page 454
Hiding/Showing zones on page 41
Mixer channels on page 614
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Instrument tracks
Instrument tracks allow you to preview notes belonging to the corresponding instrument and 
select the instrument you want to show in the Key Editor.

Each instrument in the project has its own instrument track in Play mode, including when a 
single player holds multiple instruments. Instrument tracks are labeled using the full instrument 
name set for each instrument.

When independent voice playback is enabled, each voice belonging to the corresponding 
instrument appears as a separate voice track below the instrument track.

Instruments are automatically assigned a color according to their player order in the current 
layout, so that you can tell them apart more easily. This color is used consistently for the 
corresponding instrument, including in the Mixer and Key Editor.

When an instrument track is selected in the track overview, you can do the following:

● View and edit its notes and data in the Key Editor panel, if it is unlocked.

● Use the Track Inspector to change the routing of the track.

Piano instrument track with two voice tracks below

Each instrument track comprises the following:

1 Track name

Shows the name of the track.

● Instrument tracks display the full instrument name set for the instrument.

● Voice tracks display the stem direction and number of the corresponding voice. For 
instruments with multiple staves, the staff of the corresponding voice is also included.

2 Mute /Solo  buttons

Allow you to mute/solo the track. Shown in track headers when tracks are sufficiently 
tall, and at the top of the track overview when tracks appear short. They apply to the 
corresponding track when shown in track headers, and the selected track when shown at the 
top of the track overview.

3 Track preview

Displays a preview of notes belonging to the instrument.

RELATED LINKS
Key Editor on page 564
Piano roll editor on page 575
Percussion editor on page 576
Showing instruments in the Key Editor on page 568
Velocity editor on page 587
Dynamics editor on page 590
Playing Techniques editor on page 586
MIDI CC editor on page 596
Player, layout, and instrument names on page 158
Changing instrument names on page 161
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Inputting notes into multiple voices on page 207
Voices on page 1134
Endpoint Setup dialog on page 479
Muting/Soloing tracks on page 461
Enabling independent voice playback on page 460
Assigning instruments/voices to endpoints on page 484
Changing the default player order on page 110
Setting custom player orders on page 110
Changing the height of tracks on page 454

Tempo track
The Tempo track displays tempo changes in the selected flow. It appears at the top of the track 
overview in Play mode, and is one of the tracks you can hide/show. Each project contains a single 
Tempo track.

Tempo track

When the Tempo track is selected in the track overview, you can do the following:

● Edit and input tempo changes in the Tempo editor in the Key Editor panel, if it is unlocked.

● Use the Track Inspector to change the sound used for the click.

RELATED LINKS
Hiding/Showing tracks on page 454
Track Inspector on page 442
Key Editor on page 564
Tempo editor on page 601
Showing instruments in the Key Editor on page 568
Tempo marks on page 1052
Input methods for tempo marks on page 268
Changing the type and appearance of absolute tempo changes on page 1055
Signposts on page 407
Hiding/Showing tempo marks on page 1058
Exporting MIDI on page 82

Changing the sound used for the click
You can change the sound used for the click in playback by assigning the Tempo track to the 
required endpoint, including loading a new sound manually if required; for example, if you want 
to use a sound that is not provided by default.

PREREQUISITE

● The Tempo track is shown.

● You have loaded the VST/MIDI instrument you want to use for the click.

PROCEDURE

1. In Play mode, select the Tempo track in the track overview.

2. In the Track Inspector, in the Routing section, select the VST/MIDI instrument plug-in you 
want to use for the click from the audio plug-in menu.
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3. Optional: If the sound you want to use is not already loaded in the plug-in instance, click Edit 
Instrument  to open the corresponding VST or MIDI instrument in a window, then load 
the required sound into an available channel.

4. Select the required endpoint in the plug-in instance using the following value fields, 
individually or together:

● To assign the Tempo track to a different port in the selected plug-in instance, enter the 
required port in the Port field.

NOTE

Only necessary when using a plug-in that has multiple ports of 16 channels.

● To assign the Tempo track to a different channel in the selected port, enter the required 
channel in the Ch. field.

RELATED LINKS
Loading VST/MIDI instruments manually on page 447
Track Inspector on page 442
Endpoints on page 479
Endpoint Setup dialog on page 479

Markers track
The Markers track displays markers in the selected flow and allows you to input new markers. 
It appears at the top of the track overview in Play mode, and is one of the tracks you can hide/
show. Each project contains a single Markers track.

The Markers track comprises the following:

1 Add Marker

Opens the Add Marker dialog, which allows you to input a marker.

2 Markers

Show the position of each marker in the flow, including their text.

RELATED LINKS
Hiding/Showing tracks on page 454
Markers on page 967
Videos on page 166
Editing marker text on page 969

Inputting markers in the Markers track
You can input markers directly into the Markers track in Play mode.

PREREQUISITE
The Markers track is shown.

PROCEDURE

1. In Play mode, move the playhead to the time position where you want to input a marker.
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NOTE

You cannot input markers in negative time, such as when a video starts three bars into the 
flow, causing the initial timecode of the flow to be in negative time.

2. In the Markers track header, click Add Marker  to open the Add Marker dialog.

3. Enter the marker text you want into the Text field.

4. Optional: Change the timecode in the Timecode field.

5. Click OK to input the marker and close the dialog.

RESULT
A marker is input at the position of the playhead. It shows the text you entered, or the default 
text “Marker” if you did not change the marker text.

EXAMPLE

Marker in the Markers track

RELATED LINKS
Moving the playhead on page 456
Add Marker dialog on page 369
Editing marker text on page 969
Changing the start position of videos on page 168

Chords track
The Chords track displays chord symbols in the selected flow and allows you to hear the 
corresponding chords in playback. It appears at the top of the track overview in Play mode, 
and is one of the tracks you can hide/show. Each project contains a single Chords track.

When the Chords track is selected in the track overview, you can use the Track Inspector to 
change its routing.

The Chords track comprises the following:

1 Enable Chords Playback

Allows you to include chords in, or exclude chords from, playback.

2 Chords

Indicates where chord symbols exist in the flow and shows the chord symbol name.

RELATED LINKS
Chord symbols on page 713
Track Inspector on page 442
Loading VST/MIDI instruments manually on page 447
Hiding/Showing tracks on page 454
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Enabling chord symbol playback
You can include chord symbols in playback. They are played as sustained chords, with their 
duration taken from the gap between one chord symbol and the next. Chord symbols input via 
a MIDI keyboard use the voicing you played when inputting them, whereas chord symbols input 
via a computer keyboard use a default voicing.

PREREQUISITE
The Chords track is shown.

PROCEDURE

● In Play mode, activate Enable Chords Playback  in the Chords track header.

RELATED LINKS
Hiding/Showing tracks on page 454
Track overview on page 440

Changing the sound used for chord symbol playback
You can change the sound used for chord symbol playback by assigning the Chords track to the 
required endpoint, including loading a new sound manually if required; for example, if you want 
to use a sound that is not used by any of the instrument tracks in your project.

PREREQUISITE

● The Chords track is shown.

● You have loaded the VST/MIDI instrument you want to use for chord symbol playback.

PROCEDURE

1. In Play mode, select the Chords track in the track overview.

2. In the Track Inspector, in the Routing section, select the VST/MIDI instrument plug-in you 
want to use for chord symbol playback from the audio plug-in menu.

3. Optional: If the sound you want to use is not already loaded in the plug-in instance, click Edit 
Instrument  to open the corresponding VST or MIDI instrument in a window, then load 
the required sound into an available channel.

4. Select the required endpoint in the plug-in instance using the following value fields, 
individually or together:

● To assign the Chords track to a different port in the selected plug-in instance, enter the 
required port in the Port field.

NOTE

Only necessary when using a plug-in that has multiple ports of 16 channels.

● To assign the Chords track to a different channel in the selected port, enter the required 
channel in the Ch. field.

RELATED LINKS
Loading VST/MIDI instruments manually on page 447
Track Inspector on page 442
Endpoints on page 479
Endpoint Setup dialog on page 479
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Resetting the voicing of chord symbols
When you input chord symbols via a MIDI keyboard, the voicing you used is retained for chord 
symbol playback. You can reset the voicing of chord symbols input using MIDI keyboards; for 
example, if you prefer to hear the default voicing for that chord symbol in playback.

PROCEDURE

1. In Write mode, select the chord symbols whose voicing you want to reset.

2. Choose Edit > Notations > Chord Symbols and Diagrams > Clear Chord Symbol Played 
Pitches. You can also choose this option from the context menu.

RELATED LINKS
Inputting chord symbols on page 291

Hiding/Showing tracks
You can hide/show the Tempo, Markers, and Chords tracks at the top of the track overview 
independently of each other.

NOTE

You cannot hide/show player and instrument tracks.

PROCEDURE

● At the top of the track overview, hide/show tracks in the following ways:

● To show/hide the Tempo track, activate/deactivate Tempo .

● To show/hide the Markers track, activate/deactivate Markers .

● To show/hide the Chords track, activate/deactivate Chords .

RELATED LINKS
Track overview on page 440
Tracks on page 448
Key Editor panel on page 564

Changing the height of tracks
You can change the height of all types of tracks; for example, to preview more tracks 
simultaneously. This does not affect the width of tracks.

PROCEDURE

● In Play mode, click Track height  at the top left of the track overview to cycle through 
different track heights.

NOTE

When tracks appear short, Mute  and Solo  buttons appear at the top of the track 
overview. They only appear in each track header when there is sufficient vertical space.
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RELATED LINKS
Changing the height of the Key Editor on page 570
Zooming in/out of the Key Editor on page 570

Zooming in/out of tracks
You can change the width of tracks in the track overview; for example, to preview more bars 
simultaneously. This does not affect the height of tracks.

PROCEDURE

1. Zoom in horizontally in any of the following ways:

● Click in the ruler and drag upwards.

● Ctrl/Cmd -scroll upwards in the ruler.

● Click Zoom In  at the bottom of the track overview.

2. Zoom out horizontally in any of the following ways:

● Click in the ruler and drag downwards.

● Ctrl/Cmd -scroll downwards in the ruler.

● Click Zoom Out  at the bottom of the track overview.

RELATED LINKS
Tracks on page 448
Track overview on page 440
Key Editor panel on page 564
Piano roll editor on page 575
Zooming in/out of the Key Editor on page 570

Playhead
The playhead is a vertical line that moves during playback, showing the current rhythmic 
position. It is also known as a “playback line”.

The playhead appears at all times in Play mode and during playback in other modes, and its 
current position is displayed in both the Transport window and the mini transport in the toolbar. 
You can also choose to show the playhead when playback is stopped in other modes.

The playhead in the Key Editor

Dorico SE automatically keeps the playhead in view during playback by moving it along with the 
music, but you can also move the playhead manually. Dorico SE tries to keep systems in the same 
place on the screen when it scrolls along with the playhead for consistency as you follow your 
music.
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NOTE

The playhead never appears in Print mode.

RELATED LINKS
Transport window on page 468
Mini transport on page 30
Hiding/Showing the playhead on page 457
Changing music area colors on page 51

Moving the playhead
The playhead automatically moves along with the music during playback, but you can also move 
the playhead manually in any mode.

You can move the playhead both when it is stopped and during playback, but not all methods of 
moving the playhead work during playback.

By default, the playhead is only shown during playback but you can choose to show the playhead 
at all times.

PROCEDURE

● Move the playhead in any of the following ways:

● To move the playhead forwards, press Num +  (plus on a numeric keypad) or click Fast 
Forward  in the Transport window.

● To move the playhead backwards, press Num -  (minus on a numeric keypad) or click 
Rewind  in the Transport window.

● To move the playhead back to the start of the flow, press Num .  (period on a numeric 
keypad) or click Rewind to Beginning of Flow  in the Transport window or mini 
transport.

● To move the playhead to the start of the earliest selected item, press Alt/Opt-P .

● To move the playhead forwards by frames, press Ctrl/Cmd-Num + or Ctrl/Cmd-F9 .

● To move the playhead backwards by frames, press Ctrl/Cmd-Num - or Ctrl/Cmd-F7 .

● In Play mode or the Key Editor, click the ruler at any position.

NOTE

You cannot click the ruler to move the playhead during playback.

RELATED LINKS
Transport window on page 468
Mini transport on page 30
Preferences dialog on page 53
Frame rates on page 171
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Hiding/Showing the playhead
You can hide/show the playhead when playback is stopped; for example, to help line up your 
music when working with timecodes and video. By default, the playhead is hidden when playback 
is stopped, except in Play mode, where it always appears.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Playhead subsection, activate/deactivate Show playhead when stopped.

4. Click Apply, then Close.

RESULT
The playhead is shown outside of playback when Show playhead when stopped is activated, 
and hidden when it is deactivated.

NOTE

This does not apply to Play mode or Print mode. The playhead always appears in Play mode and 
never appears in Print mode.

Playing back music
You can listen to the music you have written from the beginning of your project or from a specific 
point. You can use playback key commands in any mode.

PREREQUISITE

● You have applied a playback template to the project that includes sounds for the instruments 
in your project.

● If you want to use different sounds for different voices, you have enabled independent voice 
playback for those instruments.

PROCEDURE

1. Start playback in one of the following ways:

● To play back from the earliest selected item, make a selection, then either press P , 
click Play From Selection  in the Transport window, or choose Play > Play From 
Selection.

TIP

● To play back all instruments, select a single note.

● To play back only a single staff, select multiple items on the staff.

● To play back multiple staves, select items on multiple staves.

This does not affect which channels are soloed or muted in the Mixer.

● To continue playback from the playhead position, either press Space or Enter , click Play 
 in the mini transport, click Play From Playhead Position  in the Transport window, 

or choose Play > Play From Playhead Position.
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● To play back from the last playback start position, press Shift-Space  or choose Play > 
Play From Last Start Position. This works even if you have since deselected the item at 
that position.

● To play back from the start of the flow, press Shift-Alt/Opt-Space  or choose Play > Play 
From Start of Flow.

● To play back from the start of the project, choose Play > Play From Start of Project.

2. Optional: Move the playhead during playback to later/earlier positions.

3. Optional: To enable/disable the metronome click, click Click  in the Transport window or 
mini transport.

TIP

You can assign a key command for Enable Click on the Key Commands page in 
Preferences.

4. Stop playback in any of the following ways:

● Press Space or Enter  or P .

● Press Num 0  (0 on a numeric keypad).

● In the mini transport, click Stop .

● In the Transport window, click Stop .

TIP

If you notice a change in sound when stopping playback, you can deactivate Reset 
controllers and send ‘all notes off’ when stopping playback on the Play page in 
Preferences.

RELATED LINKS
Playback templates on page 471
Applying/Resetting playback templates on page 476
Allowing/Blocking VST plug-ins on page 459
Enabling independent voice playback on page 460
Playhead on page 455
Mixer on page 612
Muting/Soloing tracks on page 461
Endpoint Setup dialog on page 479
Transport window on page 468
Mini transport on page 30
Key Commands page in the Preferences dialog on page 54
Status bar on page 36
Preferences dialog on page 53

Changing the tempo mode
You can switch the tempo mode at any time between using a single fixed tempo and following 
tempo changes; for example, if you have a project with multiple tempo changes but want to use 
a single fixed tempo when recording MIDI.

PROCEDURE

1. Change the tempo mode in any of the following ways:
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● Click Tempo Mode  in the toolbar.

● Choose Play > Fixed Tempo Mode.

Fixed Tempo Mode Follow Tempo Mode

2. Optional: When Fixed Tempo Mode  is active, change the metronome mark value by 
clicking the Fixed Tempo Mode number in the toolbar to show a slider, then dragging the 
slider to the right/left.

RESULT
In follow tempo mode, the tempo for playback and recording is set by tempo marks in the 
project.

In fixed tempo mode, the tempo for playback and recording is a single tempo, as determined by 
the Fixed Tempo Mode metronome mark value.

RELATED LINKS
Toolbar on page 28
Tempo marks on page 1052
Tempo track on page 450
Tempo editor on page 601
MIDI recording on page 240
Playing back music on page 457
Transport window on page 468

Allowing/Blocking VST plug-ins
You can allow individual VST 2 instrument plug-ins that you want to use in Dorico SE and block 
plug-ins you want to prevent Dorico SE from using. Allowed plug-ins are subsequently available 
in any project.

Dorico SE automatically blocks plug-ins that crash and plug-ins that Steinberg has not already 
qualified for use with Dorico SE. Only Kontakt and NotePerformer are allowed by default.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click VST Plug-ins.

3. In the Allowed VST 2 Plug-ins subsection, allow plug-ins in any of the following ways:

● To allow individual blocked plug-ins, select them in the Blocked Plug-ins list and click 
Allow selected plug-ins  in the action bar.

● To allow all blocked plug-ins, click Allow All in the Blocked Plug-ins list action bar.
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● To allow a plug-in not included in the Blocked Plug-ins list, click Add plug-in name  in 
the Allowed Plug-ins list action bar, then enter the name of the plug-in in the new entry.

4. Block plug-ins in any of the following ways:

● To block individual allowed plug-ins, select them in the Allowed Plug-ins list and click 
Block selected plug-ins  in the action bar.

● To block all allowed plug-ins, click Block All in the Allowed Plug-ins list action bar.

5. Click Apply, then Close.

6. Quit Dorico SE.

RESULT
When Dorico SE next opens, your allowed VST plug-in entries are available for use in the 
program.

RELATED LINKS
Preferences dialog on page 53
Track Inspector on page 442
Playing back music on page 457
Playback templates on page 471

Enabling independent voice playback
By default, all voices belonging to a single instrument, including divisi staves, use the same 
endpoint for playback. You can enable independent voice playback for individual instruments; for 
example, to hear the different playing techniques in playback for a string divisi where some parts 
are pizzicato and some parts are arco.

NOTE

You cannot enable independent voice playback for unpitched percussion instruments and 
percussion kits.

PROCEDURE

1. In Play mode, in the track overview, select the instrument track for which you want to enable 
independent voice playback.

2. In the Track Inspector, click Enable Independent Voice Playback  in the Routing section.

RESULT
Independent voice playback is enabled for the selected instrument. Each voice belonging to the 
instrument appears as a separate voice track below the instrument track.

Dorico SE automatically loads enough additional channels, and additional plug-in instances if 
necessary, to accommodate all voices belonging to the corresponding instrument project-wide, 
according to the current playback template. Voices are automatically assigned to endpoints 
according to their voice order.

NOTE

When independent voice playback is enabled, you can only change the routing and effects of 
each voice track.
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AFTER COMPLETING THIS TASK
You can change the routing and effects of each voice track, including in each flow independently; 
for example, if some voices in some flows require a solo sound instead of an ensemble one.

RELATED LINKS
Track overview on page 440
Track Inspector on page 442
Playback templates on page 471
Endpoints on page 479
Instrument tracks on page 449
Piano roll editor on page 575
Velocity editor on page 587
Dynamics editor on page 590
MIDI CC editor on page 596
Playing Techniques editor on page 586
Assigning instruments/voices to endpoints on page 484

Disabling independent voice playback
You can disable independent voice playback for individual instrument tracks and return them to 
using a single endpoint for all voices.

PROCEDURE

1. In Play mode, in the track overview, select the instrument track for which you want to disable 
independent voice playback.

NOTE

You must select the instrument track, not any of its voice tracks.

2. In the Track Inspector, click Disable Independent Voice Playback  in the Routing section.

RESULT
Independent voice playback is disabled for the selected instrument. Its voice tracks disappear 
from the track overview, and all voices belonging to the instrument return to using a single 
endpoint for playback.

Muting/Soloing tracks
You can mute/solo individual tracks, instruments, and voices belonging to instruments with 
independent voice playback enabled. This can be useful if you want to ensure only certain 
instruments are played back while you are working on a specific section of a project.

PROCEDURE

1. Mute tracks in any of the following ways:

● In the Mixer, click Mute  in the corresponding channels.

● In Play mode, click Mute  for the corresponding tracks in the track overview.

2. Solo tracks in any of the following ways:

● In the Mixer, click Solo  in the corresponding channels.

● In Play mode, click Solo  for the corresponding tracks in the track overview.
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● To solo selected instruments and mute other instruments, select at least one note 
belonging to each instrument you want to solo, then press Alt/Opt-S  or choose Play > 
Solo Selected Instruments.

RESULT
The corresponding tracks are muted/soloed. This affects playback until you change which tracks 
are muted/soloed, meaning you do not have to reselect the tracks you want to hear each time.

NOTE

● Soloing tracks automatically mutes all other tracks. If you solo a track that was muted, it is 
automatically unmuted.

● You can also play back only specific tracks/staves temporarily by selecting notes/items on 
each track/staff you want to hear, then starting playback.

EXAMPLE

Mute when enabled Solo when enabled

RELATED LINKS
Track overview on page 440
Mixer on page 612
Playing back music on page 457

Deactivating mute/solo instrument states
You can deactivate the mute and solo states of all instruments in your project; for example, if you 
want to hear all instruments in playback after soloing a small selection.

PROCEDURE

● Deactivate mute/solo instrument states in the following ways:

● To deactivate all mute instrument states, press Alt/Opt-U  or click Deactivate All Mute 
States  in the Mixer.

● To deactivate all solo instrument states, press Shift-Alt/Opt-S  or click Deactivate All 
Solo States  in the Mixer.

RESULT
All instruments in the project have the corresponding state removed. For example, removing 
both mute and solo instrument states reverts all instruments to their default state, causing all 
instruments to be included in playback.
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Muting notes/items individually
You can mute individual notes and items to exclude them from playback without deleting them; 
for example, to hear chords without their arpeggios, a passage with multiple dynamics at a 
single volume level, or without tempo changes from specific tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. In Write mode, select the notes/items you want to mute.

2. In the Properties panel, activate Suppress playback in the Common group.

RELATED LINKS
Properties panel on page 560
Hiding/Showing zones on page 41
Changing the tempo mode on page 458

Hiding/Showing colors for muted notes/items
You can hide/show colors for individual notes/items whose playback you have suppressed, which 
causes them to appear gray.

PROCEDURE

● Choose View > Note And Rest Colors > Suppressed Playback.

RELATED LINKS
Hiding/Showing rest colors on page 1011
Hiding/Showing voice colors on page 1135

Repeats in playback
Dorico SE supports the playback of repeat structures, including repeat endings, repeat barlines, 
and repeat markers, provided all the correct jumps and sections are in place.

There is no limit to the number of repeat structures you can have in a single flow and still obtain 
correct playback.

By default, Dorico SE plays sections between repeat barlines twice and includes repeats in 
playback, except after repeat jumps, such as D.S. al Coda.

During playback, the bars/beats and time displays in the mini transport and Transport window 
reflect the playhead position in repeat structures.

Dynamics and tempo marks are reflected in repeats. Repeats are also included in both audio and 
MIDI exports.

NOTE

When repeat structures are unbalanced and would play back infinitely, Dorico SE automatically 
excludes repeats from playback.
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RELATED LINKS
Transport window on page 468
Mini transport on page 30
Repeat endings on page 975
Repeat markers on page 979
Types of barlines on page 672
Tremolos on page 1099
Rhythm slashes on page 997
Bar repeats on page 985

Including/Excluding repeats in playback after repeat jumps
By default, Dorico SE plays back all playthroughs in all types of repeat structures. You can 
manually include/exclude repeats indicated by repeat markers, repeat endings, and repeat 
barlines in playback after individual repeat jumps.

NOTE

You can only include/exclude repeats after repeat jumps, such as D.C. al Fine and D.S. al Coda.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the repeat jumps after which you want to include/exclude repeats in playback.

2. In the Properties panel, activate Replay repeats in the Repeat Markers group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Repeats are included in playback after the selected repeat jumps when the checkbox is activated, 
and excluded from playback when the checkbox is deactivated.

Changing the number of playthroughs at repeat barlines
End repeat barlines typically indicate that the preceding music is played through twice. You can 
change the number of playthroughs for each end repeat barline individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the end repeat barlines whose number of playthroughs you want to change.

2. In the Properties panel, activate Play n times in the Time Signatures group.

3. Change the value in the value field.
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NOTE

The minimum value is 2.

RESULT
The number of times the music preceding the selected end repeat barlines is played through is 
changed.

When repeats are included in playback, repeat counts are shown at system object positions for 
end repeat barlines set to have three or more playthroughs.

EXAMPLE

Final repeat barline with the default 2 playthroughs 
set

Final repeat barline with 4 playthroughs set and 
repeat count shown

RELATED LINKS
Repeat counts on page 983
Types of barlines on page 672
Input methods for bars, beats, and barlines on page 275
Including/Excluding repeats in playback after repeat jumps on page 464
Changing the total number of playthroughs in repeat endings on page 975
Properties panel on page 560

Swing playback
Swing is a style of performance where equally-notated notes are played in a regular pattern of 
alternating longer and shorter notes, which commonly entails eighth notes being played as a 
quarter note triplet followed by an eighth note triplet.

A swing phrase with simplified straight notation How the same phrase sounds with a 2:1 swing ratio

Swing playback allows you to hear the uneven rhythms you want whilst retaining their simplified 
notation, including if the second eighth note beat is divided into two 16th notes. In Dorico SE, 
you can enable swing playback for certain sections and for individual instruments only. You can 
swing either eighth notes or 16th notes.
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Based on academic research into the rendering of swing by musicians, swing patterns in Dorico 
SE are tempo-dependent by default. This means that the swing feels more pronounced at lower 
tempos, and straighter at higher tempos.

RELATED LINKS
Enabling swing playback on page 467

Swing ratios and rhythmic feels
Swing ratios express the strength of the swing using beat units. For example, a swing ratio of 2:1 
means the first note in each pair is twice as long as the second, creating a triplet swing.

A swing ratio of 1:1 means the music is played straight, while a swing ratio of 5:1 means each 
pair of notes is played as if they were sextuplets, with the first note in the pair lasting five 
divisions and the second note lasting one.

Swing ratio 1:1 Swing ratio 5:1

The following rhythmic feels and swing ratios are provided by default in Dorico SE:

2:1 swing 16ths (fixed)
Extends the first note in a pair of 16th notes to be twice as long as the second, creating 
a strict triplet 2:1 ratio. This is also known as a “triplet swing”. This ratio is maintained 
regardless of the tempo by default.

2:1 swing 8ths (fixed)
Extends the first note in a pair of eighth notes to be twice as long as the second, 
creating a strict triplet 2:1 ratio. This is also known as a “triplet swing”. This ratio is 
maintained regardless of the tempo by default.

3:1 swing 16ths (fixed)
Extends the first note in a pair of 16th notes to be three times as long as the second, 
creating a dotted 16th-32nd ratio (dotted semiquaver-demisemiquaver). This ratio is 
maintained regardless of the tempo by default.

3:1 swing 8ths (fixed)
Extends the first note in a pair of eighth notes to be three times as long as the 
second, creating a dotted eighth-16th ratio (dotted quaver-semiquaver). This ratio is 
maintained regardless of the tempo by default.

Heavy swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 3:1 at low tempos and 
1.5:1 at high tempos.

Heavy swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 3:1 at low tempos 
and 1.5:1 at high tempos.

Light swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 1.5:1 at low tempos 
and 1:1 at high tempos.
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Light swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 1.5:1 at low tempos 
and 1:1 at high tempos.

Medium swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 2:1 at low tempos and 
1.5:1 at high tempos.

Medium swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 2:1 at low tempos 
and 1.5:1 at high tempos.

Straight (no swing)
Produces no swing; that is, even eighth notes in the ratio 1:1 at all tempos.

You can change the swing ratio used for specific sections and for individual players.

Enabling swing playback
You can enable swing playback for specific sections in your project and for individual instruments 
independently; for example, if you want only the trumpet player to swing for a twelve-bar 
section, or if you only want swing playback in one flow.

PROCEDURE

1. In Write mode, select one of the following:

● If you want to enable swing playback from a specific rhythmic position onwards, select 
a single item at the start of the bar where you want swing playback/a different rhythmic 
feel to start.

● If you want to enable swing playback within a section then return to straight playback, 
select multiple items that span the duration where you want swing playback/a different 
rhythmic feel.

NOTE

● If you want to enable swing playback for a single instrument, select items that belong to 
that instrument only.

● If you select an item in the middle of a bar, the rhythmic feel change only takes effect 
from the start of the next bar.

2. Open the tempo popover in any of the following ways:

● Press Shift-T .

● In the Notations toolbox, click Popovers , then Tempo .

3. Enter the appropriate entry for the rhythmic feel you want into the popover.

When you start entering a rhythmic feel into the tempo popover, a menu appears that shows 
valid rhythmic feels containing the letters/words you enter, which you can select.
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NOTE

If you do not enter the name of a rhythmic feel that exists in your project, the text you 
entered into the popover is input as a tempo mark and does not enable swing playback.

4. Input the rhythmic feel change and close the popover in one of the following ways:

● To input a rhythmic feel change for all staves, press Return .

● To input a rhythmic feel change only for the selected instrument, press Alt/Opt-Return .

RESULT
The rhythmic feel used for swing playback is changed from the start of the bar containing the 
earliest selected item, or the start of the next bar if you selected an item in the middle of a bar.

If you selected multiple items, the rhythmic feel is automatically reset at the position of the last 
selected item.

If you pressed Alt/Opt-Return , the rhythmic feel change only applies to the instrument on 
whose staff you selected an item or items. Rhythmic feels added to single instruments apply to 
all staves belonging to those instruments.

A signpost appears showing the name of the rhythmic feel you input. It is shown above the top 
staff in the system for rhythmic feel changes that apply to all staves, and directly above the top 
staff of the instrument for rhythmic feel changes that apply only to single instruments.

RELATED LINKS
Tempo popover on page 268
Signposts on page 407
Hiding/Showing signposts on page 407

Deleting rhythmic feel changes
You can delete rhythmic feel changes you have enabled for specific sections or for individual 
players only.

PREREQUISITE
Rhythmic change signposts are shown.

PROCEDURE

1. In Write mode, select the signposts of the rhythmic changes you want to delete.

2. Press Backspace or Delete .

RESULT
The rhythmic changes are deleted. The affected staves return to the default non-swing playback 
until the next existing rhythmic change signpost, if applicable.

Transport window
The Transport window contains playback and MIDI recording functions, such as rewinding 
and fast-forwarding. It contains additional and more precise versions of the playback functions 
available in the toolbar.

You can hide/show the Transport window in any of the following ways:

● Press F2 .
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● In the toolbar, click Show Transport Bar .

The Transport window contains the following information and functions:

Bars/Beats display

Shows the position of the playhead relative to bars and beats in the current flow in the 
following order of units: bars, beats, 16th notes, 120ths of a 16th note.

Time display
Shows the position of the playhead in one of the following formats:

● Elapsed time in the following order of units: hours, minutes, seconds, milliseconds

● Timecode in the following order of units: hours, minutes, seconds, frames

Time display showing elapsed time Time display showing the timecode

You can change the content shown in the time display by clicking it.

Activate Project

Activates/Deactivates playback in the project. When playback is deactivated, transport 
and playback functions are disabled.

Rewind to Beginning of Flow

Moves the playhead back to the beginning of the flow.

Rewind

Moves the playhead back by a half note each time you click.

Fast Forward

Moves the playhead forwards by a half note each time you click.

Stop

Stops playback.
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Play From Playhead Position

Plays back from the position of the playhead.

Play From Selection

Plays back from the position of the first selected item in the music area.

If you select items on multiple staves, or multiple items on a single staff, only the 
selected staves are played back.

Record
Starts/Stops MIDI recording.

Record outside of MIDI recording Record during MIDI recording

Retrospective Record

Retrieves any MIDI notes you played during the previous playback and allows you to 
input them on any staff, even if you were not recording them explicitly.

Click

Plays/Mutes the metronome click during playback and recording.

Tempo Mode
Displays the tempo used for both playback and recording. The value changes 
according to the playhead position, and its appearance changes according to its mode.

● You can change the tempo mode by clicking the beat unit.

● You can change the metronome mark value used in fixed tempo mode by clicking 
the number to show a slider, then dragging the slider to the right/left.

Fixed Tempo Mode Follow Tempo Mode

RELATED LINKS
Toolbar on page 28
Mini transport on page 30
Playing back music on page 457
Changing the tempo mode on page 458
MIDI recording on page 240
Changing the sound used for the click on page 450
Timecodes on page 971
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Changing the content shown in the transport display
You can switch between showing the timecode, the total elapsed time, and the current rhythmic 
position of the playhead expressed in bars, beats, and ticks in both the mini transport in the 
toolbar and the Transport window.

PROCEDURE

● In either the mini transport in the toolbar or the Transport window, click the transport 
display until the content you want appears.

In the Transport window, this is the display on the right.

RESULT
Each time you click in the mini transport display, it cycles through showing the rhythmic position 
of the playhead, elapsed time, and the timecode.

In the Transport window, it only switches between the timecode and elapsed time, as the 
rhythmic position of the playhead is shown permanently on the left of the window.

TIP

You can change what is shown in the mini transport by default for all future projects on the Play 
page in Preferences.

RELATED LINKS
Toolbar on page 28
Mini transport on page 30
Timecodes on page 971
Preferences dialog on page 53

Playback templates
Dorico SE uses playback templates to allocate sounds from VST instruments and MIDI devices to 
the instruments in your project.

Playback templates combine the following information in order to obtain correct playback:

● The instrument sounds, articulations, and playback techniques provided by plug-ins, such as 
VST instruments

● The expression/percussion maps required to obtain those sounds

● The endpoint configurations required for the sounds for each instrument

When you add instruments to players in a project, Dorico SE automatically loads plug-ins for 
them according to the current playback template and sets up expression maps and percussion 
maps as required. Dorico SE also automatically loads enough plug-in instances, as many plug-ins 
can only load a limited number of sounds in each instance.

You can override playback templates and make your own manual changes to the sounds used 
by instruments in your project, such as by changing the expression maps assigned to endpoints. 
You can then save such changes as custom endpoint configurations, which you can include in 
your own custom playback templates.

You can also export custom playback templates; for example, to share them with other users. 
Playback templates are saved as .dorico_pt files.
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NOTE

● Playback templates are available in all projects you open or create on your computer, 
meaning any changes you make to playback templates affect all projects that use those 
playback templates.

● Dorico SE automatically loads sounds for any new instruments you add to the project, 
using the sounds included in the current playback template. Therefore, we recommend that 
you always include a factory default playback template at the bottom of custom playback 
templates as a fallback to ensure that all instruments are assigned sounds.

● Any changes you make within plug-ins are saved when you save the project but are not 
communicated to Dorico SE, which can lead to unexpected low notes sounding in playback 
because Dorico SE is still using the expression and percussion maps for the original sounds. 
If you make changes in plug-ins, you must manually assign the correct expression and 
percussion maps to the appropriate endpoints.

RELATED LINKS
Edit Playback Template dialog on page 474
Applying/Resetting playback templates on page 476
Creating custom playback templates on page 477
Exporting playback templates on page 478
Endpoint Setup dialog on page 479
Assigning expression/percussion maps to endpoints on page 485
Endpoints on page 479
Custom endpoint configurations on page 481
Edit Endpoint Configurations dialog on page 483
Allowing/Blocking VST plug-ins on page 459

Apply Playback Template dialog
The Apply Playback Template dialog allows you to change the playback template applied to the 
current project and to import/export playback templates. It also allows you to access the Edit 
Playback Template dialog.

● You can open the Apply Playback Template dialog by choosing Play > Playback Template.

The Apply Playback Template dialog shows all the playback templates available on your 
computer in a table. Dorico SE provides the following factory default playback templates:

● HSSE (Elements): Intended for use with HALion Sonic SE.

● HSSE+HSO (Pro): Intended for use with both HALion Sonic SE and HALion Symphonic 
Orchestra.

● Silence: Prevents Dorico SE from loading sounds.

TIP

● Choosing the Silence template makes Dorico SE project files significantly smaller; for 
example, if you want to send them electronically.

● We recommend that you only use the HSSE+HSO (Pro) playback template if you own a 
separate HALion Symphonic Orchestra license, as Dorico SE only includes HALion Sonic SE.
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The Apply Playback Template dialog comprises the following:

1 Search field

Allows you to filter playback templates in the list according to your entry.

2 Name column

Contains a list of the playback templates available on your computer. You can click the 
column header to change the sorting order.

3 Factory column

Contains the factory symbol if the playback template in the corresponding row is a factory 
default playback template. You can click the column header to change the sorting order.

4 Action bar

Contains the following options for playback templates:

● Add Playback Template : Opens the Edit Playback Template dialog and allows you 
to create a new playback template.

● Duplicate Playback Template : Opens the Edit Playback Template dialog and allows 
you to create a new playback template that starts as a duplicate of the selected one.

● Edit Playback Template : Opens the Edit Playback Template dialog and allows you 
to edit the existing selected playback template.

NOTE

You cannot edit factory default playback templates.

● Show Factory : Allows you to hide/show factory default playback templates in the 
table.

● Export: Opens the File Explorer/macOS Finder, where you can select the location to 
which you want to export the currently selected playback templates as .dorico_pt 
files. You can then import the .dorico_pt files into Dorico SE on other computers and 
share them with other users.

● Import: Opens the File Explorer/macOS Finder, where you can select the .dorico_pt 
files that you want to import as playback templates.

Play mode
Playback templates 

473
Dorico SE 4.3.30



● Delete : Deletes the selected playback templates.

NOTE

You cannot delete factory default playback templates.

5 Apply and Close

Applies the selected playback template to the project and closes the dialog.

RELATED LINKS
Edit Endpoint Configurations dialog on page 483

Edit Playback Template dialog
The Edit Playback Template dialog allows you to create new custom playback templates and 
edit existing ones. You can use any combination of custom endpoint configurations and existing 
playback templates and specify the order in which they should be used.

Playback templates are available in all projects you open or create on your computer.

● You can open the Edit Playback Template dialog from inside the Apply Playback Template 
dialog by clicking Add Playback Template , Duplicate Playback Template , or Edit 
Playback Template .

The Edit Playback Template dialog contains the following sections and options:

1 Playback template data
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Allows you to specify the following identifying information for the selected custom playback 
template:

● Name: Allows you to set the name of the playback template that appears in the 
program; for example, in the Apply Playback Template dialog.

● ID: Allows you to set the unique ID of the playback template. Dorico SE automatically 
populates the ID field with the information you enter into the Name field.

● Creator: Allows you to name the creator if you are sharing your playback template with 
other users.

● Version: Allows you to indicate the playback template version so you can identify the 
most recent one; for example, you can increase the Version number each time you 
make changes to the playback template.

● Description: Allows you to add any other information about the playback template.

NOTE

All fields in the playback template data section, except for Name, are locked by the Lock Info 
button. You must click this button in order to change the information in the fields.

2 Entries

Contains a table of all the custom endpoint configurations and existing playback templates 
used by the selected custom playback template. Entries are listed in order of priority, 
meaning that Dorico SE assigns sounds from the top entry first. We recommend that you 
always include a factory default playback template at the bottom of the list as a fallback to 
ensure that all instruments are assigned sounds.

In most cases, listing entries in your order of preference in the Entries section is sufficient 
to achieve your desired playback. However, if multiple entries in your custom playback 
template provide sounds for the same instrument, you must set family and/or instrument 
overrides; for example, if you only want to use woodwind sounds from the first entry and use 
all other sounds from the second entry.

The column on the right identifies the type of the entry in the corresponding row.

● Manual: Entries that cannot load sounds automatically, including custom endpoint 
configurations

● Auto: Entries that can load sounds automatically; that is, factory default playback 
templates

The action bar at the bottom of the section contains the following options:

● Add Manual: Allows you to add a manual entry to the playback template.

● Add Automatic: Allows you to add an automatic entry to the playback template.

● Move Up : Moves the selected entry up the list.

● Move Down : Moves the selected entry down the list.

● Delete : Removes the selected entry from the playback template.

3 Family Overrides

Contains a list of family overrides applied to the selected entry and allows you to add/
remove overrides. Family overrides allow you to specify the instrument family sounds you 
want to use; for example, if you only want to use the woodwind sounds from an entry that 
also includes brass and string sounds.

The action bar at the bottom of the section contains the following options:

● Add Instrument Family : Allows you to select an instrument family to apply as an 
override to the selected entry.
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● Delete Instrument Family : Removes the selected family override from the selected 
entry.

4 Instrument Overrides

Contains a list of instrument overrides applied to the selected entry and allows you to add/
remove overrides. Instrument overrides allow you to specify individual instrument sounds 
you want to use; for example, if you only want to use a solo violin sound from an entry that 
also includes ensemble string sounds.

The action bar at the bottom of the section contains the following options:

● Add Instrument : Allows you to select an instrument to apply as an override to the 
selected entry.

● Delete Instrument : Removes the selected instrument override from the selected 
entry.

5 Endpoint Configurations

Opens the Edit Endpoint Configurations dialog, which allows you to rename and delete 
custom endpoint configurations, and view the plug-ins and players they contain.

RELATED LINKS
Endpoints on page 479
Edit Endpoint Configurations dialog on page 483
Custom endpoint configurations on page 481

Applying/Resetting playback templates
You can change the playback template applied to the current project; for example, if you want to 
use a different sound library for playback. Re-selecting playback templates resets them to their 
default settings.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Select the playback template you want to use.

3. Click Apply and Close.

RESULT
The playback template applied to the current project is changed. If you re-selected the playback 
template already in use, the playback template is reset.

Sounds are loaded into plug-in instances in their score order.

TIP

● You can change the default playback template used for all future projects on the Play page 
in Preferences.

● You can also load sounds just for instruments without assigned sounds by choosing Play > 
Load Sounds for Unassigned Instruments.

RELATED LINKS
Preferences dialog on page 53
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Creating custom playback templates
You can create custom playback templates that can include combinations of factory default 
playback templates, custom endpoint configurations, and other non-factory default playback 
templates that cannot load sounds automatically.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Open the Edit Playback Template dialog to create a new playback template in one of the 
following ways:

● To create an empty playback template, click Add Playback Template  in the action 
bar.

● To create a copy of an existing playback template, select it and click Duplicate Playback 
Template  in the action bar.

3. In the Edit Playback Template dialog, click Lock Info  to unlock the data fields.

4. Enter information for your playback template in the relevant fields.

5. In the Entries section, add the custom endpoint configurations and/or factory default 
playback templates you want.

● To add a custom endpoint configuration or non-factory default playback template, click 
Add Manual and select the one you want from the menu.

● To add a factory default playback template, click Add Automatic and select the one you 
want from the menu.

TIP

We recommend that you always include a factory default playback template at the bottom of 
the list as a fallback to ensure that all instruments are assigned sounds.

6. Optional: To change the order of entries and their order of preference in the playback 
template, select an entry and click one of the following options in the action bar:

● To move the selected entry upwards, click Move Up .

● To move the selected entry downwards, click Move Down .

7. Optional: Repeat step 6 until all the entries are in the correct order of preference.

8. Optional: Select an entry for which you want to specify instrument family overrides.

9. In the Family Overrides section action bar, click Add Instrument Family  and select the 
one you want from the menu.

For example, if you only want to use the woodwind sounds from a sound library that also has 
string sounds, select Woodwinds.

10. Optional: Select an entry for which you want to specify individual instrument overrides.

11. In the Instrument Overrides section action bar, click Add Instrument  and select the one 
you want in the instrument picker.

For example, if you only want to use the piano sound from a sound library that has other 
keyboard instrument sounds, select Piano.

12. Optional: Repeat steps 8 to 11 for other entries for which you want to specify instrument 
family and instrument overrides.

13. Click OK to save your changes and close the dialog.
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RESULT
Your new custom playback template is created. It is available to use in the current project and all 
projects you create/open on your computer.

RELATED LINKS
Apply Playback Template dialog on page 472
Edit Playback Template dialog on page 474
Endpoint Setup dialog on page 479
Custom endpoint configurations on page 481
Allowing/Blocking VST plug-ins on page 459

Importing playback templates
You can import playback templates into projects; for example, if someone you are working 
with exported their custom playback template for you to use. Playback templates are saved 
as .dorico_pt files.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Click Import to open the File Explorer/macOS Finder.

3. Locate and select the playback template file you want to import.

4. Click Open.

RESULT
The selected playback template is imported. It becomes available in the current project and all 
projects you create/open on your computer.

TIP

You can also import playback templates by dragging .dorico_pt files into a Dorico SE project 
window.

Exporting playback templates
You can export playback templates so you can send them to other users or use them on other 
computers. By default, any playback templates you create are available in all projects on your 
computer.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Select the playback templates you want to export.

3. Click Export to open the File Explorer/macOS Finder.

4. Specify a name and location for the playback template files.

5. Click Choose.

RESULT
The selected playback templates are exported and saved in the selected location as 
separate .dorico_pt files.

Play mode
Playback templates 

478
Dorico SE 4.3.30



Endpoints
“Endpoint” is the term used for the unique combination of inputs and outputs that together allow 
the correct sounds to be played for each instrument.

In Dorico SE, each endpoint brings together the following:

● A VST instrument or MIDI output device instance

● A specific channel on that VST instrument or MIDI output device

● The patch or program assigned to that channel

● The expression map and/or percussion map that describes the instrument or instruments 
that can be played by that patch or program, and the playback techniques and articulations 
provided

Each instrument in your project is connected to a specific endpoint. Assigning an expression/
percussion map to the same endpoint allows Dorico SE to translate any playing technique 
changes and articulations you input into the key switches and controller switches necessary to 
produce the required sounds for the instrument in playback.

When you use a factory default playback template, Dorico SE sets up endpoints and expression/
percussion maps automatically. If you want to load other plug-ins or change the patches within 
HALion Sonic SE, you can do so in the Endpoint Setup dialog.

NOTE

Any changes you make within plug-ins are not communicated to Dorico SE; for example, 
changing a sound that the expression map expects to use a modulation wheel for dynamics to 
one that uses note velocity instead. This can lead to unexpected low notes sounding in playback 
because Dorico SE is still using the expression and percussion maps for the original sounds. If 
you make changes in plug-ins, you must manually assign the correct expression and percussion 
maps to the appropriate endpoints.

You can then save your changes as a custom endpoint configuration if you want to reuse them in 
other projects.

RELATED LINKS
Custom endpoint configurations on page 481
Edit Endpoint Configurations dialog on page 483

Endpoint Setup dialog
The Endpoint Setup dialog displays which expression and percussion maps are currently linked 
to each endpoint in the corresponding plug-in instance, and allows you to change these settings. 
It also allows you to save your current settings as custom endpoint configurations, which you can 
then include in custom playback templates.

● You can open the Endpoint Setup dialog by clicking Endpoint Setup  in each plug-in 
instance in the VST and MIDI panel, or in the Routing section of the Track Inspector.
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The Endpoint Setup dialog contains the following options and sections:

1 Name

Allows you to change the name of the selected plug-in instance. This affects the name shown 
in the VST and MIDI panel and in the Mixer.

2 Number of MIDI ports

Displays the number of MIDI ports the corresponding plug-in instance currently uses.

You can change the number of MIDI ports; for example, if you are using a plug-in that uses 
more than one port. Dorico SE does not load multiple MIDI ports by default.

3 Number of MIDI channels

Displays the number of MIDI channels the corresponding plug-in instance currently uses.

You can change the number of channels; for example, if you have a monotimbral plug-in 
such as a piano sampler which only has one MIDI channel, or a multitimbral plug-in with 16 
MIDI channels and 16 audio outputs.

4 Set

Sets the plug-in instance to have the number of MIDI ports and channels specified in the 
Number of MIDI ports and Number of MIDI channels value fields. This changes the 
number of rows in the table.

5 Endpoint setup table

Contains the settings for the corresponding plug-in instance, arranged into the following 
columns:

● Port: Displays the port used by the instrument in the corresponding row of the table.

NOTE

You cannot change the port from within the Endpoint Setup dialog. You must change 
the port in the Track Inspector.
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● Channel: Displays the channel used by the instrument in the corresponding row of the 
table.

NOTE

You cannot change the channel from within the Endpoint Setup dialog. You must 
change the channel in the Track Inspector.

● Assigned Instruments: Displays the full name of the instrument in the corresponding 
row, as set for that instrument in the Edit Instrument Names dialog, and its instrument 
number, if applicable.

● Expression map: Displays the expression map currently assigned to the instrument in 
the corresponding row. You can change the expression map by double-clicking it and 
selecting another expression map from the menu.

● Percussion map: Displays the percussion map currently assigned to the instrument in 
the corresponding row. You can change the percussion map by double-clicking it and 
selecting another percussion map from the menu.

6 Number of audio outputs to show in Mixer

Allows you to change the number of audio outputs shown in the Mixer; for example, if you 
want to hide unused outputs when using plug-ins that provide more audio outputs than 
Dorico SE uses.

7 Save Endpoint Configuration

Opens the Save Endpoint Configuration dialog, which allows you to enter a name for the 
current endpoint configuration and save it as a custom endpoint configuration.

RELATED LINKS
Track Inspector on page 442
VST and MIDI panel on page 445
Playback templates on page 471
Expression Maps dialog on page 626
Edit Instrument Names dialog on page 161
Mixer on page 612

Custom endpoint configurations
Custom endpoint configurations save the current state and settings of plug-ins in your project, 
such as the number and type of VST/MIDI instruments loaded and the instruments and 
expression/percussion maps assigned to endpoints.

You can save custom endpoint configurations that include the settings for all plug-ins currently 
loaded or only a single one.
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Custom endpoint configurations are available in all projects you open or create on your 
computer. You can view, rename, and delete the custom endpoint configurations on your 
computer in the Edit Endpoint Configurations dialog.

Saving custom endpoint configurations
You can save any overrides you have made to endpoint configurations, such as changing the 
instruments and expression maps assigned to particular endpoints. This allows you to use these 
overrides in custom playback templates and re-use the same endpoint configurations in other 
projects.

PREREQUISITE

● You have opened a project containing all instruments and plug-ins that are necessary for the 
custom endpoint configuration.

● You have created any necessary expression maps and playback technique combinations.

● You have created any necessary custom playing techniques.

PROCEDURE

1. Load the plug-ins you want.

You can do this by applying a playback template or by adding plug-in instances manually in 
the VST and MIDI panel in Play mode.

2. Change the settings for the endpoints as required.

For example, change the instruments or expression maps assigned to each endpoint.

3. Open the Save Endpoint Configuration dialog in one of the following ways:

● To save a custom endpoint configuration for only a single plug-in instance, open the 
Endpoint Setup dialog for that plug-in instance and click Save Endpoint Configuration.

● To save a custom endpoint configuration that includes all VST instrument or MIDI 
instrument plug-in instances, click Save Endpoint Configuration  in the action bar 
of the corresponding section of the VST and MIDI panel.

4. Enter a name for your custom endpoint configuration in the Name field.

NOTE

If you enter a name that already exists, or select an existing custom endpoint configuration 
from the menu, the existing custom endpoint configuration is overwritten.

5. Click OK to save your changes and close the dialog.

RESULT
The current state of either the selected plug-in instance or all plug-in instances in the 
corresponding section is saved as a custom endpoint configuration. This includes any custom 
playing techniques included in any of the expression/percussion maps.

AFTER COMPLETING THIS TASK
You can include custom endpoint configurations in custom playback templates, which allows you 
to use endpoint configurations in other projects.

RELATED LINKS
Playback templates on page 471
Adding/Editing switches in expression maps on page 640
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Save Endpoint Configuration dialog
The Save Endpoint Configuration dialog allows you to save the current state and settings of 
plug-ins in your project. Saving custom endpoint configurations allows you to re-use them in 
other projects and include them in custom playback templates.

You can open the Save Endpoint Configuration dialog in Play mode in any of the following 
ways:

● In the VST and MIDI panel, click Save Endpoint Configuration in the VST Instruments 
or MIDI Instruments action bar. This saves the current state of all plug-ins in the 
corresponding section of the panel.

● In the Endpoint Setup dialog, click Save Endpoint Configuration. This saves the current 
state of the selected plug-in only.

The Save Endpoint Configuration dialog contains a Name field that allows you to enter a name 
for the endpoint configuration you are saving. The arrow at the end of the field allows you to 
select an existing custom endpoint configuration to use to populate the field.

If you enter a name that already exists, you can overwrite the existing custom endpoint 
configuration. When you overwrite existing custom endpoint configurations, Dorico SE moves 
the previous version to your recycle bin.

Edit Endpoint Configurations dialog
The Edit Endpoint Configurations dialog allows you to rename and delete custom endpoint 
configurations, and view the plug-ins and players they contain.

● You can open the Edit Endpoint Configurations dialog by clicking Endpoint Configurations 
in the Edit Playback Template dialog.

The Edit Endpoint Configurations dialog comprises the following:

1 Endpoint configurations list
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Contains all the endpoint configurations on your computer.

Delete Endpoint Configuration  in the action bar at the bottom of the list allows you to 
delete the selected endpoint configuration from your computer.

2 Name

Allows you to set the name of the selected endpoint configuration that appears in the 
program; for example, in the Edit Playback Template dialog.

3 Plug-ins and players list

Contains all the plug-ins and players contained within the selected endpoint configuration. 
If the endpoint configuration contains multiple instances of the same plug-in, each plug-in 
instance is listed separately.

Assigning instruments/voices to endpoints
You can assign instruments to any endpoint; for example, if you have loaded a plug-in with 
multiple ports and want to change the endpoint of an existing instrument to an endpoint on 
one of your new ports. For instruments with independent voice playback enabled, you can assign 
each voice to a different endpoint.

PREREQUISITE

● If you want to assign different voices belonging to the same instrument to different 
endpoints, you have enabled independent voice playback.

● If you want to assign instruments to endpoints in specific plug-in instances, you have loaded 
those plug-in instances. You can do this by applying a suitable playback template or by 
loading VST/MIDI instruments manually.

PROCEDURE

1. In Play mode, in the track overview, select the instrument/voice track whose assigned 
endpoint you want to change.

2. Optional: If you selected a voice track, choose one of the following options for Edits apply to 
in the Routing section of the Track Inspector:

● To change the assigned endpoint for the selected voice in the current flow only, choose 
This flow.

● To change the assigned endpoint for the selected voice in all flows, choose All flows.

3. Optional: To assign the instrument/voice to an endpoint in a different plug-in instance, 
select that plug-in instance from the audio plug-in menu in the Routing section of the Track 
Inspector.

4. Change the endpoint using the following value fields, individually or together:

● To assign the instrument/voice to a different port in the selected plug-in instance, enter 
the required port in the Port field.

NOTE

Only necessary when using a plug-in that has multiple ports of 16 channels.

● To assign the instrument/voice to a different channel in the selected port, enter the 
required channel in the Ch. field.

RELATED LINKS
Track overview on page 440
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Track Inspector on page 442
Endpoints on page 479
Expression Maps dialog on page 626
Instrument tracks on page 449
Applying/Resetting playback templates on page 476
Loading VST/MIDI instruments manually on page 447
Enabling independent voice playback on page 460

Assigning expression/percussion maps to endpoints
You can assign expression/percussion maps to the endpoints in your project; for example, if you 
have created a custom percussion map and must link it to the endpoint for the corresponding 
VST patch.

PREREQUISITE
You have made or imported any expression/percussion maps that you require but do not exist 
on your computer.

PROCEDURE

1. In Play mode, in the VST and MIDI panel, click Endpoint Setup  in the plug-in instance in 
which you want to change the expression/percussion maps assigned to endpoints to open 
the Endpoint Setup dialog.

2. Double-click the expression/percussion map you want to change.

3. Click the disclosure arrow to the right of the field.

A menu appears containing all maps of the same type currently loaded in your project.

4. Select the expression/percussion map you want from the menu.

5. Press Return .

6. Optional: Repeat steps 2 to 5 for any other endpoints whose assigned expression/percussion 
maps you want to change.

7. Click OK to save your changes and close the dialog.

RELATED LINKS
VST and MIDI panel on page 445
Expression maps on page 625
Percussion maps on page 643
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Print mode

Print mode allows you to print your layouts or to export them as graphics files, such as PDF and 
SVG.

● When printing layouts, you can specify the paper size and other options, such as duplex or 
booklet printing.

● When exporting layouts, you can specify different graphics file types and the information 
you want to include in their exported file names.

Project window in Print mode
The project window in Print mode contains the print preview area and panels that provide all the 
necessary tools and functions for printing and exporting layouts.

You can switch to Print mode in any of the following ways:

● Press Ctrl/Cmd-5 .

● In the toolbar, click Print.

● Choose Window > Print.

The following panels and options are available in Print mode:

1 Layouts panel

Shows a list of all layouts in your project and allows you to select the layouts you want to 
print or export.
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NOTE

The layout selector in the toolbar is disabled in Print mode. To show a different layout in the 
print preview area, select it in the Layouts panel.

2 Print Options panel

Contains options for printing or exporting your layouts.

3 System Dialogs (macOS only)

Contains macOS-specific printing options.

4 View options

Allows you to change the print preview area to show pages in one of the following views:

● Page Width: The page fills the width of the print preview area, which might not show 
the whole page depending on the orientation and format of the page.

● Whole Page: Shows the whole page in the print preview area.

TIP

You can go directly to the first page in the layout by pressing Home , and to the last page 
by pressing End . You can change these key commands on the Key Commands page in 
Preferences.

RELATED LINKS
Project window on page 27
Print Options panel on page 488
Toolbar on page 28
Print preview area on page 34
Key Commands page in the Preferences dialog on page 54

Layouts panel (Print mode)
In Print mode, the Layouts panel shows a list of all layouts in your project and allows you to 
select layouts to preview, print, and export. It is located on the left of the window.

You can hide/show the Layouts panel in Print mode in any of the following ways:

● Press Ctrl/Cmd-7 .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Zone.
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The Layouts panel contains all the layouts in your project, displayed as cards. Each layout card 
shows the following:

1 Disclosure arrow

Expands/Collapses the layout card.

2 Layout type

Shows the type of layout from the following options:

● Full score layout 

● Instrumental part layout 

● Custom score layout 

3 Layout name

Shows the name of the layout. Dorico SE automatically adds default names depending 
on the name of the instrument that is assigned to a player and on the type of layout 
that is added. For example, if you assign a flute to a player, the instrumental part layout 
automatically gets the same name. If you add an empty instrumental part layout, the layout 
name shows Empty part and an incremental number if you add multiple empty part layouts.

4 Page size and orientation

Shows the size and orientation of the layout as set on the Page Setup page in Layout 
Options.

5 Layout length

Shows the number of pages in the layout. You can use this in combination with its page size 
and orientation to determine the best job type for printing/exporting.

TIP

A layout with two pages might best be printed as 2-up, while a layout with five pages might 
best be printed as spreads with the final page printed on a different paper size. A layout with 
12 pages might best be printed as a booklet.

The selected layouts are printed/exported when you click Print or Export in the Print Options 
panel. If you have selected some layouts set to print and some set to export graphics, the button 
reads Print and Export.

RELATED LINKS
Project window in Print mode on page 486
Page arrangements for printing/exporting on page 500
Booklet printing on page 501

Print Options panel
The Print Options panel contains options for printing or exporting your layouts. It is located on 
the right of the window in Print mode.

You can hide/show the Print Options panel in any of the following ways:
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● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Zone.

All the options that you set in the Print Options panel are saved with your project. The options 
are divided into the following sections:

Destination
Allows you to select a physical printer for printing or a file location for exporting a 
graphics file.

● For layouts set to print, you can change the number of copies.

● For layouts set to export as graphics files, you can specify the format, color mode, 
image resolution, file name, and directory of the saved file.

Job Type
Allows you to choose the pages to be printed or exported, and how they are arranged. 
You can choose all pages, a range of pages, or a range of flows.

Page Setup
Allows you to set the paper size and orientation. You can specify the scale factor of the 
image to be printed or exported.
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Duplex Printing
Allows you to specify whether to print on one or on both sides of each sheet of paper. 
Only available when Printer is selected in the Destination section.

Annotations
Allows you to activate options that are often required by publishing houses or printing 
agencies, such as crop marks or a border around the printed image.
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Print button
Allows you to print/export selected layouts according to the settings you have set in 
the Print Options panel.

Depending on your selection, the print button can appear in one of the following ways:

● Print

● Export

● Print and Export

For example, if you selected layouts that are all set to print, Print is shown. If you 
selected some layouts set to export graphics and some layouts set to print, Print and 
Export is shown.

RELATED LINKS
Project window in Print mode on page 486
Exporting layouts as graphics files on page 495
Printers on page 499
Duplex printing on page 502
Page arrangements for printing/exporting on page 500
Page vs. paper size on page 503
Graphics file formats on page 505
Annotations on page 507

Printing layouts
You can print hard copies of individual layouts or multiple layouts together. You can specify print 
settings for each layout independently; for example, you can set different numbers of copies or 
select different printers for layouts in the same project.

Dorico SE uses settings for layouts to create automatic print settings, so you might find that 
many print options are already appropriate for the layouts you want to print. For example, if you 
are connected to a printer that can print A3 paper and the page size of your full score layout is 
set to A3 in Layout Options, Dorico SE automatically selects A3 in the Page Setup section of the 
Print Options panel.

TIP

● If you want to save layouts in graphics files formats, such as PDF or PNG, we recommend 
that you export them.

● You can select individual layouts and set up their printing options without printing straight 
away. Once you have set up the printing options you want for different layouts, you can 
then select all the layouts you want to print and click Print. Your existing print settings are 
applied, even if your selection contains layouts with different print settings.

For example, you can set your full score layout to print 3 booklet copies and the part layouts 
to print 1 2-up copy each. You can then select all layouts to print them together and the 
previously set values are followed.

PROCEDURE

1. In the Layouts panel, select the layouts that you want to print.
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NOTE

The layout selector in the toolbar is disabled in Print mode. To show a different layout in the 
print preview area, select it in the Layouts panel.

2. In the Print Options panel, enter the number of copies you want into the Copies field in the 
Destination section.

NOTE

The Copies field appears blank when you have selected layouts with different values.

3. Activate/Deactivate Collate copies.

4. In the Destination section, choose Printer and select a printer from the menu.

5. In the Job Type section, select the page arrangement you want from the menu.

6. Optional: Specify a range of pages/flows.

7. In the Page Setup section, select a paper size from the menu.

8. Choose the paper orientation you want.

9. Optional: If you selected Spreads or 2-up for the job type, activate/deactivate Print odd final 
page on to specify the paper size on which you want to print final pages for layouts with odd 
numbers of pages.

10. Select a paper size and paper orientation for the odd final page.

11. Choose one of the following size options:

● Fit to Paper

● Custom Scale

12. Optional: If you selected Custom Scale, enter the scale factor you want into the Scale factor 
field.

13. In the Duplex Printing section, select one of the printing options from the Print on menu.

14. Optional: If you selected a duplex printing option, use the bottom two menus to select how 
the printed image is flipped when printing on the reverse side of the paper.

15. In the Annotations section, activate each annotation you want to add to the selected 
layouts.

16. Click Print.

RESULT
The selected layouts are printed according to the print settings you have applied.

If your selection included part layouts set to concert pitch that contain transposing instruments, 
Dorico SE shows a warning and offers to switch them all to transposed pitch before printing/
exporting. You can also select which layouts you want to switch to transposed pitch or proceed 
anyway with no changes.

TIP

● You can choose to show a warning when printing/exporting concert or transposed pitch full 
score and custom score layouts in Preferences > General > Files.

● You can assign key commands to different printing and exporting commands on the Key 
Commands page in Preferences.
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RELATED LINKS
Preferences dialog on page 53
Key Commands page in the Preferences dialog on page 54
Printers on page 499
Paper size and orientation setup on page 504
Export File Names dialog on page 498
Page arrangements for printing/exporting on page 500
Print Options panel on page 488
Duplex printing on page 502
Annotations on page 507
Changing the page size and/or orientation on page 510
Exporting layouts as graphics files on page 495

Specifying ranges of pages/flows
By default, Dorico SE prints/exports all pages in the selected layouts. You can specify ranges of 
either pages or flows for each layout independently.

NOTE

You can only print booklets using the complete range of pages. You cannot specify page or flow 
ranges.

PROCEDURE

1. In the Layouts panel, select the layouts for which you want to specify ranges of pages/flows.

2. In the Print Options panel, in the Job Type section, choose one of the following options for 
Print range:

● To specify ranges of pages, choose Pages.

● To specify ranges of flows, choose Flows.

3. If you chose Pages, enter the pages you want into the value field.

● To specify a range of pages, enter the first page and last page separated with a dash, 
such as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated with 
commas, such as 1,3,5-8.

NOTE

Separate ranges are exported as separate files.

4. If you chose Flows, click Choose to open the Print Flows dialog. Select the flows you want to 
print/export, then click OK.

RESULT
The pages set to be printed/exported from the selected layouts are changed. Ranges of flows 
include all pages on which those flows appear, in full or in part.

RELATED LINKS
Print Options panel on page 488
Export File Names dialog on page 498
Page arrangements for printing/exporting on page 500
Exporting flows on page 75
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Print Flows dialog
The Print Flows dialog allows you to select the flows you want to print/export from the selected 
layouts. Ranges of flows include all pages on which those flows appear, in full or in part.

● You can open the Print Flows dialog in Print mode by clicking Choose in the Job Type 
section of the Print Options panel. Choose is available when the selected layouts are set to 
print/export a range of flows.

1 Flows to print or export

Contains a list of all the flows in the selected layouts. Flows are included in the page range to 
be printed/exported when their checkbox is activated.

2 Selection options

Allow you to select/deselect flows. The following selection options are available:

● Select All: Selects all flows.

● Select None: Deselects all flows.

● Invert Selection: Switches your selection to include all flows not previously selected.

Specifying printing options (macOS only)
Dorico SE allows you to access the standard printing options of your operating system.

NOTE

If you use the standard printing options of your operating system, the settings in the Print 
Options panel are ignored. macOS-specific print settings are not saved with your project. These 
must be set each time you want to print, whereas the Dorico SE print options are always saved 
with your project.

PROCEDURE

1. In the Layouts panel, click Page Setup in the OS X Dialogs section to open the macOS Page 
Setup dialog.

2. In the Page Setup dialog, set the paper size.

3. Click OK.

4. In the OS X Dialogs section, click Print to open the macOS Print.

5. In the Print dialog, set up the printing options you want.
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Exporting layouts as graphics files
You can export layouts as a variety of graphics files, such as PDF or PNG.

TIP

You can export layouts with different image settings and export paths simultaneously.

PROCEDURE

1. In the Layouts panel, select the layouts you want to export.

NOTE

The layout selector in the toolbar is disabled in Print mode. To show a different layout in the 
print preview area, select it in the Layouts panel.

2. In the Print Options panel, choose Graphics in the Destination section.

3. Optional: Change the image settings for the selected layouts.

4. Optional: Change the export path for the selected layouts.

5. Optional: If you want to change the file name recipe, click File Name Options to open the 
Export File Names dialog.

6. Optional: In the Export File Names dialog, change the file name recipe for your selected 
graphics file formats.

TIP

We recommend including the Page number token for PNG, SVG, and TIFF files as each page 
in layouts using these formats is exported as a separate file.

7. Optional: Specify a range of pages/flows.

8. In the Page Setup section, choose the page orientation you want.

9. In the Annotations section, activate each annotation you want to add to the selected 
layouts.

NOTE

Watermarks are only included in layouts exported as Color graphics.

10. Click Export.

RESULT
The selected layouts are exported as the selected graphics format using the file name recipe set 
for their graphics file format in the Export File Names dialog. They are saved in the folder set in 
the Destination folder field, or in the same folder as the project file if the set export path is no 
longer accessible.

Exported layouts use the page size set for the layout on the Page Setup page in Layout Options.

If your selection included part layouts set to concert pitch that contain transposing instruments, 
Dorico SE shows a warning and offers to switch them all to transposed pitch before printing/
exporting. You can also select which layouts you want to switch to transposed pitch or proceed 
anyway with no changes.

Print mode
Exporting layouts as graphics files 

495
Dorico SE 4.3.30



TIP

● You can choose to show a warning when printing/exporting concert or transposed pitch full 
score and custom score layouts in Preferences > General > Files.

● You can assign key commands to different printing and exporting commands on the Key 
Commands page in Preferences.

RELATED LINKS
Specifying ranges of pages/flows on page 493
Changing the page size and/or orientation on page 510
Export File Names dialog on page 498
Annotations on page 507
Graphics file formats on page 505
Image resolution on page 505
Monochrome and color graphics processing on page 506
Embedding of fonts in PDF and SVG files on page 506
Preferences dialog on page 53
Key Commands page in the Preferences dialog on page 54
Layout Options dialog on page 622
Page vs. paper size on page 503
Exporting flows on page 75

Changing the image settings for layouts
You can change the graphics file format, color mode, and image resolution of layouts 
individually; for example, if you want to export some layouts as PDF files but others as PNG 
files.

PROCEDURE

1. In the Layouts list, select the layouts whose export path you want to change.

2. In the Print Options panel, choose Graphics in the Destination section.

3. Select a graphics file format from the menu.

4. Optional: If you selected PNG or TIFF, select a resolution from the Resolution menu.

TIP

The Resolution setting does not affect PDF and SVG files as they are vector formats.

5. Choose a color mode.

● Mono exports the graphic in black and white.

● Color exports the graphic in full color.

NOTE

● For layouts that you want to export with watermarks, or that contain colored or not 
completely transparent elements, you must choose Color. If you select Mono, such 
elements appear black in the exported file.

● When exporting graphics files with a resolution of 72 dpi, we recommend that you select 
Color. If you select Mono, staff lines can disappear.

Print mode
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RESULT
The image settings for the selected layouts are changed. This also changes the file name recipe 
used for the corresponding layouts when you export them.

RELATED LINKS
Graphics file formats on page 505
Image resolution on page 505
Monochrome and color graphics processing on page 506
Embedding of fonts in PDF and SVG files on page 506

Changing the export path for layouts
You can specify an export path to any folder to which you want to export layouts as 
graphics files. You can specify a different export path for each layout and still export them all 
simultaneously.

By default, Dorico SE exports graphics files into the same folder as your project file. If you have 
not saved your project yet, graphics files are saved in your Dorico Projects folder.

PROCEDURE

1. In the Layouts list, select the layouts whose export path you want to change.

2. In the Destination section of the Print Options panel, click Choose Folder  beside the 
Destination folder field to open the File Explorer/macOS Finder.

3. Locate and select the destination folder you want.

4. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Destination 
folder field.

5. Optional: Repeat steps 1 to 4 for other layouts whose export path you want to change.

6. Optional: If you want to change the file name recipe, click File Name Options to open the 
Export File Names dialog.

7. Optional: In the Export File Names dialog, change the file name recipe for your selected 
graphics file formats.

TIP

We recommend including the Page number token for PNG, SVG, and TIFF files as each page 
in layouts using these formats is exported as a separate file.

RESULT
The export path for the selected layouts is changed. When exported, the layouts use the file 
name recipe set for their graphics file format in the Export File Names dialog.

NOTE

If the export path specified is no longer accessible, such as if you receive a project from someone 
who uses a different operating system, Dorico SE automatically updates the export path to the 
same location as the project file.

Print mode
Exporting layouts as graphics files 
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Export File Names dialog
The Export File Names dialog allows you to determine the contents of file names for each 
graphics file format independently. You can use universal ingredients that update to show the 
correct information for each layout automatically, and you can enter text that is the same for all 
layouts.

You can open the Export File Names dialog in any of the following ways:

● In Print mode, click File Name Options in the Destination section of the Print Options panel 
when the currently selected layout is set to Graphics.

● In Preferences > General > Exporting Files, click Edit.

NOTE

Your settings are linked between both ways of accessing the dialog and are saved as the default 
for all future projects.

The Export File Names dialog contains the following options:

1 File names for

Allows you to select different graphics file formats. You can set different file name recipes for 
each graphics file format.

2 Preview

Displays an example file name based on the current recipe. The layout used for the preview 
is the one shown in the layout selector in the toolbar.

For example, the preview for a full score PDF file name using the default recipe might be 
01 - Full score - Lieder.pdf.

3 File name recipe

Displays the recipe for the selected graphics file format. You can enter text directly into this 
field, and click ingredients to add them automatically.

For example, the default PDF file name recipe is $n - $l - $t.

Print mode
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4 Reset to Default

Resets the file name recipe to the default for the selected graphics file format.

5 Copy to All

Copies the file name recipe to all layouts in the project.

6 File name ingredients

Allow you to add ingredients to the file name recipe quickly that are automatically populated 
as appropriate for each layout. For example, the ingredient $l becomes Piano when used to 
export a piano part layout.

The buttons for each ingredient display both the information to which the ingredient refers 
and the characters for it.

When you click file name ingredients, they are added to the end of the file name recipe. They 
are automatically separated from the previous ingredient using the default separator.

NOTE

The page number ingredient is not available for the PDF file name recipe as it is a multi-page 
format.

7 Default separator

Allows you to set the characters used to separate ingredients in the file name recipe by 
default.

RELATED LINKS
Exporting layouts as graphics files on page 495

Printers
You can print layouts from Dorico SE projects to any printer to which your computer is 
connected.

You can select different printers for each layout in your project. This allows you to send layouts 
to the most appropriate printer for their requirements. You can select a printer when Printer is 
chosen in the Destination section of the Print Options panel.

Dorico SE uses the same printer as designated by the operating system by default, unless you 
specify another printer. In this case, the settings in the following sections in the Print Options 
panel can change:

● In the Page Setup section, the list of available paper sizes lists only paper sizes that the 
chosen printer provides.

● In the Duplex Printing section, the option for automatic duplex printing is only available if 
the chosen printer has this function.

NOTE

The printer menu in the Destination section only shows the name of a printer if all currently 
selected layouts are set to print to the same printer. If you select a new printer from the menu, 
all selected layouts are set to print to that printer.

RELATED LINKS
Print Options panel on page 488
Printing layouts on page 491

Print mode
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Page arrangements for printing/exporting
Dorico SE provides several page arrangements that you can use for printing/exporting your 
layouts.

In the Job Type section of the Print Options panel, you can specify how you want the layouts to 
be printed/exported. You can select the following job types from the Job Type menu:

Normal
Prints one page on each sheet of paper. This produces single-sided pages; for example, 
for instrumental parts that do not have regular page turns and must be bound in a 
continuous line.

Spreads
Prints two pages on each sheet of paper, with odd-numbered pages on the right-hand 
side and even-numbered pages on the left-hand side.

You can also specify a paper size on which to print odd final pages; for example, if you 
are printing a layout containing five pages.

2-up
Prints two pages on each sheet of paper. The first page in the range is printed on the 
left-hand side of the first sheet of paper. This can be useful for printing instrument 
parts as it reduces the number of edges that must be bound, because pages can also 
be folded in half.

You can also specify a paper size on which to print odd final pages; for example, if you 
are printing a layout containing five pages.

Booklet
Prints two pages on each sheet of paper according to imposition requirements. This 
means that if the paper is folded, the pages are laid out like a book. This can be 
useful for scores and choir parts in particular as they often contain more pages than 
instrumental parts.

NOTE

You can only print booklets using the complete range of pages. You cannot specify 
page or flow ranges.

NOTE

● Depending on the job type that you choose, Dorico SE switches the page orientation 
automatically. The changed orientation is immediately displayed in the music area. If this 
is not what you want, you can override the orientation in the Page Setup section.

● All of the job types allow printing either onto a single side of each sheet of paper or on both 
sides of the paper.

● It is usual to print booklets, spreads, and 2-up onto paper in landscape orientation. Printing 
one page to each sheet typically uses portrait orientation, unless the layout itself uses 
landscape orientation.

Also in the Job Type section, you can choose which pages you want to print/export.

All
Allows you to print/export all pages in the selected layouts.

Print mode
Page arrangements for printing/exporting 
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Pages
Allows you to set a range of pages to be printed/exported. Choosing Pages makes the 
value field available.

● To specify a range, enter the first page and last page separated with a dash, such 
as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated 
with commas, such as 1,3,5-8.

Flows
Allows you to set a range of flows to be printed/exported. When Flows is chosen, you 
can click Choose to open the Print Flows dialog, which allows you to select the flows 
you want to print/export.

RELATED LINKS
Paper size and orientation setup on page 504
Specifying ranges of pages/flows on page 493
Margins on page 524

Booklet printing
Booklets are documents printed on both sides of the paper and folded to resemble the pages in 
a book. When printed as a booklet, pages are reordered so that you can fold the printed pages 
and read the content in the same order as they were in the project.

Printing layouts as a booklet can be much quicker than printing pages single-sided or double-
sided. For example, if your full score is twenty pages long and you print it on both sides 
automatically, you must then bind one edge of the printed pages in order to keep them together. 
However, if you print the full score as a booklet, you can simply fold the printed pages in the 
middle.

Booklet printing settings reorder pages so that they appear in the correct order on the printed 
page. For example, a layout containing four pages printed as a booklet is laid out as follows:

● First side: page four on the left, page one on the right

● Reverse side: page two on the left, page three on the right

If the layout you are printing as a booklet contains an odd number of pages, Dorico SE 
automatically places any empty last pages at the end of the booklet. This follows the convention 
of showing odd-numbered pages on the right. For example, if you print a layout containing six 
pages as a booklet, a total of eight pages are printed with the last two pages in the booklet left 
blank. If you want the empty pages to be positioned differently, you can add extra pages to the 
layout; for example, a title page.

NOTE

● You can only print booklets using the complete range of pages. You cannot specify page or 
flow ranges.

● If the order of inward pages is incorrect when you are printing booklets using manual 
duplexing, you can activate Reverse order of outward pages in the Duplex Printing section 
of the Print Options panel, which instructs Dorico SE to output the first set of pages in the 
opposite order.

RELATED LINKS
Printing layouts on page 491
Duplex printing on page 502
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Duplex printing
Dorico SE allows duplex printing, which means that you can print on both sides of each sheet of 
paper.

If your printer supports automatic duplex printing, you can use this function in Dorico SE. If your 
printer can only print on one side of each sheet of paper, there is a manual duplex printing 
option.

The Print on menu in the Duplex Printing section of the Print Options panel contains the 
following options:

One side only
Prints on one side of each sheet of paper.

Both sides manually
Prints on both sides of each sheet of paper. Use this option if you printer lacks an 
automatic duplex printing function. After all outward pages have been sent to the 
printer, a message box informs you to turn over the stack of printed pages and put 
them back into the printer. Click OK to continue printing the inward pages.

Both sides automatically
Prints on both sides of each sheet of paper automatically. This option is only available if 
your printer supports this type of printing.

The other menus in the Duplex Printing section allow you to set how the printed image is 
flipped when printing on the reverse side of the paper.

Flip image (portrait)

Determines how the image is flipped for reverse side printing in portrait orientation.

● Flip automatically uses the printer’s default settings for printing on the reverse 
side. If you find that the printer flips on a different edge than expected, use one of 
the other options.

● Flip long side sets the printer to flip the pages on the long edge.

● Flip short side sets the printer to flip the pages on the short edge.

Flip image (landscape)

Determines how the image is flipped for reverse side printing in landscape orientation.

● Flip automatically uses the printer’s default settings for printing on the reverse 
side. If you find that the printer flips on a different edge than expected, use one of 
the other options.

● Flip long side sets the printer to flip the pages on the long edge.

● Flip short side sets the printer to flip the pages on the short edge.

Reverse order of outward pages at the bottom of the section instructs Dorico SE, when 
activated, to output the first set of pages in the opposite order when printing booklets using 
manual duplexing. This is necessary for some printers so that you do not have to reverse sort the 
pages manually before returning them to the printer to print the other sides.

RELATED LINKS
Printing layouts on page 491
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Page vs. paper size
In Dorico SE, page sizes and paper sizes use different settings. This means that you can print 
layouts with any page size onto paper with a different paper size.

For each layout in your project, you can define a page size on the Page Setup page in Layout 
Options, which sets the dimensions of the layout.

When exporting layouts as graphics files, the layout’s page size is always used. When printing 
layouts, you must usually choose a paper size that is provided by the printer that you are using.

Normally, the layout's page size and the printed paper size match. However, if you define a 
layout with an unusual page size that is not supported by your printer, such as 10" x 13", one of 
the standard page sizes for instrumental parts, you may have to print the layout onto a different 
paper size. You can change the paper size in the Page Setup section of the Print Options panel 
according to your needs. As long as your printer supports sufficiently large paper for your page 
size settings, and they match a standard paper size, your dimensions are included in the menu. 
Changing the paper size has no effect on your layout's page size, and does not, therefore, affect 
the way the music is laid out.

If you do not select a specific paper size, Dorico SE automatically chooses a paper size that is 
based on your computer's locale settings. For example, if these are set to a European country, 
an international ISO standard might be used, such as A4. If they are set to a North American 
country, one of their typical standards might be used, such as US Letter.

If you have defined a page size for your layout that is larger than a typical standard, Dorico SE 
automatically chooses the next larger paper size, provided that your printer supports this. For 
example, if the layout's page size is larger than A4/US Letter, A3/Tabloid is used.

If you print to a different paper size than the layout's page size, Dorico SE automatically scales 
the image to fit the paper. You can change this setting by specifying a custom scale factor in the 
Page Setup section.

RELATED LINKS
Layout Options dialog on page 622
Changing the page size and/or orientation on page 510
Printing layouts on page 491
Exporting layouts as graphics files on page 495
Margins on page 524

Paper orientation
Paper orientation is the direction of rectangular paper for viewing and printing. Paper can have 
either landscape or portrait orientation.

Instrumental parts are most often printed using portrait orientation, as this allows two or three 
pages to be spread out at a time on most music stands.

Full scores for conductors are also commonly printed using portrait orientation, as this allows 
more staves to fit on the page than with landscape orientation. However, full scores for small 
ensembles might use landscape orientation as fewer staves have to fit on the page. Having more 
horizontal room on the page allows more bars to fit on each page, reducing the number of page 
turns required.

In Dorico SE, you can set the orientation of pages independently of the paper orientation; for 
example, you can print portrait pages on landscape paper. You can also separately set the paper 
orientation of the odd final page in layouts using the Spreads and 2-up page arrangements.

Print mode
Page vs. paper size 
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RELATED LINKS
Changing the page size and/or orientation on page 510

Paper size and orientation setup
Layouts can have different paper sizes and orientation settings.

NOTE

If you have selected Graphics in the Destination section of the Print Options panel, you can only 
change the paper orientation. No other options are available.

The Page Setup section of the Print Options panel contains the following options when you have 
chosen Printer in the Destination section:

Paper size
Allows you to select one of the available paper sizes from the menu. The paper sizes 
available depend on the capabilities of the selected printer.

Paper orientation
Allows you to choose one of the following paper orientation options:

● Portrait 

● Landscape 

Print odd final page on
For Spreads and 2-up job types only: If this is activated, you can select a different 
paper size or orientation for the odd final page.

This setting is useful when printing layouts with an odd number of pages on A3 paper 
in landscape orientation. For example, if your layout contains five pages, the first four 
pages fit onto two sheets of A3, while the fifth page would occupy only the left-hand 
side of a third sheet of A3. This setting allows you to print the odd final page on A4 
paper in portrait orientation instead.

Fit to Paper
The whole page is scaled to fit the paper size selected. For example, if you select a 
layout with a page size of A4 and select a paper size of A3, pages in the layout are 
enlarged to fit the larger paper size.

Custom Scale
The page is scaled to the set percentage of its original size. For example, if you are 
printing a layout with a page size of A3, select a paper size of A4, and set Custom Scale 
to 100, the original page remains at its original size, exceeding the boundaries of the 
A4 paper.

RELATED LINKS
Page arrangements for printing/exporting on page 500
Changing the page size and/or orientation on page 510
Margins on page 524
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Graphics file formats
Dorico SE supports multiple graphics file formats as which you can export your layouts.

PDF
Stands for Portable Document Format. Exporting layouts to PDF allows you to create 
a platform-independent document that contains a fixed version of each layout; for 
example, to send to someone who does not have access to Dorico SE.

PNG
Stands for Portable Network Graphics. PNG files are losslessly compressed, meaning 
they produce high-quality images.

SVG
Stands for Scalable Vector Graphics. Because SVG is an XML-based text format, it can 
be scaled to any size without any loss of quality. Dorico SE renders SVG graphics using 
drawing instructions rather than rasterizing them, resulting in better resolutions and 
smaller file sizes.

TIFF
Stands for Tagged Image File Format. TIFF files are not compressed, which means their 
file sizes can be larger than other formats and the quality of the image is not reduced.

RELATED LINKS
Exporting layouts as graphics files on page 495
Monochrome and color graphics processing on page 506
Embedding of fonts in PDF and SVG files on page 506

Image resolution
Image resolution refers to the number of pixels contained in an image. The larger the number of 
pixels, the sharper and clearer the image appears.

In Dorico SE, you can export PNG and TIFF files with different image resolutions. The image 
resolution is measured in dots per inch, or “dpi”.

● 72

● 150

● 300

● 600

● 1200

NOTE

A resolution of 72 dpi is suitable for display on screen so that you can embed the graphic in an 
e-mail or on a web page. If you choose 300, 600, or 1200 dpi, a high-resolution image is saved 
that you can include as an illustration in a word processing or desktop publishing document.

RELATED LINKS
Exporting layouts as graphics files on page 495
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Monochrome and color graphics processing
Dorico SE applies different settings when you export monochrome and color graphics. The most 
appropriate setting depends on your intended purpose for the graphics.

Most musical scores are monochrome, meaning they use only black ink and are normally 
printed on white/near-white paper. Some educational books occasionally use colors to highlight 
particular notations; for example, to identify clefs, or to color notes according to their pitch. If 
you export graphics files and print them with your own printer, you can leave Color selected in 
the Destination section.

However, if you export graphics files in PDF format for direct printing on a platesetter or for 
further production work in a page layout program, select Mono, unless your layout actually 
contains elements with color or opacity set. If you select Mono, Dorico SE uses a different color 
space for the resulting PDF, ensuring that the printed image only uses black ink. If you choose 
Color, then the black items in your layout are exported as rich black; that is, black produced 
by combining multiple colored inks. This can cause problems in production when making color 
separations at the pre-press stage.

Dorico SE specifies colors using the RGB color model, rather than the CMYK color model that 
is used by platesetters and other professional printing machines. If you have colored objects in 
your layouts and your layouts are printed professionally, you must post-process the graphics files 
that are exported from Dorico SE in another graphics application to convert the colors from RGB 
to CMYK.

Embedding of fonts in PDF and SVG files
How fonts are handled in PDF and SVG files mainly depends on the fonts that you use in the 
project.

PDF Files
The music and text fonts, and their sub-sets, that are supplied with Dorico SE are 
embedded in PDF files during the export. If you open the PDF files on a different 
computer, they look the same, even if that computer does not have the fonts installed 
that are used in the document. If you use different fonts, make sure that these permit 
embedding.

SVG Files
SVG (Scalable Vector Graphics) files do not embed fonts directly. Some font characters, 
such as note heads, articulations, and accidentals, are converted into outlines, so that 
they do not depend on the font from which they are taken. Other font characters, such 
as time signature and tuplet digits, are only encoded using references to the font from 
which they are taken. The latter also applies to regular text, such as staff labels, tempo 
instructions, and dynamics. This means that the SVG file looks incorrect if rendered by 
a web browser on a computer that does not have the fonts installed. The appearance 
of SVG files depends on the browser or the rendering software, and on the fonts that 
are installed on the computer.

To ensure that the SVG file appears correctly if embedded in a web page, you can open 
the SVG file in an illustration program and convert all font characters to outline paths, 
then re-export the SVG file and embed that file. Alternatively, you can use web fonts to 
ensure that the necessary fonts are available on the web server.

SVG graphics that are exported from Dorico SE conform to the SVG Tiny 1.1 
specification, which defines a subset of features in the full SVG specification.

For information about using web fonts with SVG, refer to the Help Center on the 
Steinberg website.

Print mode
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RELATED LINKS
Exporting layouts as graphics files on page 495
Graphics file formats on page 505
Image resolution on page 505
Monochrome and color graphics processing on page 506

Annotations
Annotations provide additional information for printed or exported documents, such as the 
date and time it was printed. Publishers and printing agencies can use these to identify and 
register printed images correctly or to embed exported graphics files into a desktop publishing 
application.

When printing/exporting your layouts for publication, you can include typical annotations. You 
can also allow Dorico SE to print or export any view options that you have activated in your 
project.

NOTE

Crop marks and the border can only be printed if the page size is smaller than the paper size.

The Annotations section of the Print Options panel contains the following options:

Crop marks
Adds short vertical and horizontal lines at each of the four corners of the page.

Border
Adds an outline around the edge of the page dimensions.

Date and time
Adds the date and time of printing at the bottom of each page.

Watermark
Adds large translucent text across the middle of each page. This is useful for indicating 
that this version is a draft, proof, or perusal score.

In the Watermark field at the bottom of the section, you can enter the text that you 
want to show on each page.

TIP

Watermarks are only included in layouts exported as Color graphics.

View options
Adds all active view options, such as signposts, comments, and note and rest colors, to 
the printout or exported graphic.

RELATED LINKS
Signposts on page 407
Comments on page 432
Printing layouts on page 491
Exporting layouts as graphics files on page 495
Hiding non-printing elements on page 402
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Annotations 

507
Dorico SE 4.3.30



Layout and formatting

There are various ways you can control the layout and formatting of pages in your project, 
including changing the size of pages and adjusting note spacing.

NOTE

In Dorico SE, you cannot edit all the objects and settings used to determine page formatting, 
such as frames and page templates. However, we have included basic information about these 
topics in this documentation for your information.

RELATED LINKS
Page templates on page 547
Page formatting on page 508
Note spacing on page 533
Staff spacing on page 529

Page formatting
The formatting of pages in Dorico SE is determined by a number of factors, including the layout’s 
staff size, page margins, the page template applied to them, any casting off values applied to 
them, system and frame breaks, and frame padding.

The most important factors that determine how pages are formatted in Dorico SE are:

Staff size
Staff size refers to the distance between the top and bottom lines of staves. The most 
appropriate staff size depends on the intended purpose and contents of the layout. In 
many cases, changing the staff size is the quickest way to produce legible layouts.

Staff spacing
Staff spacing mostly involves the height of staves and the necessary gaps between 
staves and systems.

Casting off
“Casting off” is the term used to encompass fixing the layout of pages of music, such as 
setting the number of systems per page.

System and frame breaks
System and frame breaks allow you to adjust layouts at a more granular level, by 
determining which bars are shown on each system and where music is pushed into the 
next frame.

Page margins
Page margins determine the dimensions of pages in layouts. Frames cannot exceed 
the boundaries set by the margins of the layout, which you can change on the Page 
Setup page in Layout Options. You can change the size of margins on each edge of 
each page.

Page templates
All pages in your layouts inherit their layout formats from page templates. Although 
you cannot create or edit page templates in Dorico SE, we recommend being familiar 
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with them as a concept, so you are aware of how pages are formatted. For example, 
if you override a page template, such as by editing the title directly in the music area, 
empty pages that are no longer required might not be deleted automatically.

TIP

The default page templates in Dorico SE contain tokens for the project title, lyricist, and 
composer on the first pages in layouts, and the flow title (score layouts) or layout name 
(part layouts) at the top of subsequent pages. Part layouts also automatically show the 
layout name in the top left of the first page. These tokens refer to information in the 
Project Info dialog, so we recommend entering information in the Project Info dialog 
in order to show it in your layouts.

Flow headings
Flow headings show the number and title of each flow immediately above their first 
system automatically. They have no fixed vertical position and follow the music if it 
moves. The default flow heading contains tokens to display the flow number and flow 
title; in a new project, this appears as “1. Flow 1”. In Dorico SE, you cannot edit flow 
headings or create new ones.

You can hide/show flow headings on a per-layout basis. Deleting or editing individual 
flow headings is considered a page template override, which is a type of page format 
change.

Music frame margins
Music frames have margins at the top and bottom. Music frame margins provide 
padding to ensure that musical material displayed within the frame remains on the 
page. For example, if music frames have no padding, the top line on the top staff in the 
frame is positioned at the top of the frame. Any notes that require ledger lines above 
the staff might then be positioned off the top of the page. You can change the music 
frame margins for each layout.

We recommend familiarizing yourself with these concepts, and how to use them together and in 
different contexts, in order to produce well-formatted layouts.

RELATED LINKS
Layout Options dialog on page 622
Staff size on page 527
Staff spacing on page 529
Casting off on page 535
System breaks on page 537
Frame breaks on page 539
Page templates on page 547
Flow headings on page 550
Hiding/Showing flow headings on page 521
Tacets on page 541
Margins on page 524
Hiding/Showing empty staves on page 515
Hiding/Showing used chord diagrams grids on page 731
Layouts on page 151
Flows on page 148
Players on page 107
Project Info dialog on page 70
Project templates on page 73

Layout and formatting
Page formatting 
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Changing the page size and/or orientation
You can change the page size and/or orientation of each layout independently. For example, you 
can use a large, landscape page in full score layouts and a small, portrait page for part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the page size and/or 
orientation.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Size section, select a page size from the Size menu.

For example, you can select fixed page sizes, such as A3 or Letter, or select Custom to 
define your own page size.

5. Optional: If you selected Custom, change the Width and Height of the page by changing 
the values in the value fields.

6. Choose one of the following options for Orientation:

● Portrait

● Landscape

7. Optional: Repeat steps 2 to 6 for other layouts whose page size/orientation you want to 
change.

8. Click Apply, then Close.

RESULT
The page size and/or orientation is changed for all the selected layouts.

NOTE

Changing the page size of layouts might not change the paper size automatically selected for 
those layouts in the Print Options panel in Print mode. For example, if your default printer 
cannot print the page size selected for layouts, the largest paper size the printer can handle is 
selected. Similarly, if you had already set options for printing layouts before changing the page 
size in Layout Options, Dorico SE attempts to preserve your original print options.

Similarly, the page orientation is independent of the paper orientation. We recommend that you 
check that layouts have the correct paper orientation set for their page orientation in the Print 
Options panel in Print mode before printing/exporting, as it is possible to print landscape layouts 
on portrait paper and vice versa.

RELATED LINKS
Paper size and orientation setup on page 504
Printing layouts on page 491
Exporting layouts as graphics files on page 495
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Changing page margins
You can change the page margins of each layout independently; for example, if you want wider 
margins for layouts in your project that will be spiral bound.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the page margins.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Margins section, choose one of the following options for Page margins:

● Same: All pages in the selected layouts have the same margins.

● Different: Left and right pages in the selected layouts can have completely different 
margins.

● Mirrored: Left and right pages in the selected layouts use the same margin values but 
they correspond to the inside/outside edges of pages.

5. Optional: Change the margins by changing the values in the value fields.

6. Click Apply, then Close.

RESULT
The page margins in the selected layouts are changed.

RELATED LINKS
Margins on page 524
Changing the first system indent on page 1046
Hiding/Showing staff labels on page 1030
Hiding/Showing used chord diagrams grids on page 731

Applying page template sets to layouts
You can change the page template set used by each layout in your project; for example, if you 
want a custom score layout to use the Default Part page template set because that set shows 
the layout name on the first page.

By default, full score and custom score layouts use the Default Full Score page template set and 
part layouts use the Default Part page template set.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose page template set you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.
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4. In the Page Template section, select the page template set you want from the Page 
template set menu.

5. Click Apply, then Close.

RESULT
The selected page template set is applied to the selected layouts.

RELATED LINKS
Page template sets on page 548
Changing when the First page template is used on page 520
Allowing/Disallowing multiple flows on the same page on page 519
Hiding/Showing flow headings on page 521

Changing the default staff size
You can change the default size of staves in each layout independently. For example, you can 
have a small staff size in full score layouts but a larger staff size in part layouts.

NOTE

If the size of system object font styles is set to Staff-relative, the staff size of the top staff in each 
instrument family group affects the size of system objects if they are shown above that bracketed 
group. Font styles that are set to Absolute are unaffected by staff size.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose staff size you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Space Size section, select the staff size you want from the Rastral size menu.

NOTE

If you select Custom, you can set a custom value in the Space size field, expressed in your 
preferred unit of measurement.

You can also set a Custom value by changing the value when any Rastral size is selected.

5. Optional: Repeat steps 2 to 4 for other layouts.

6. Click Apply, then Close.

RESULT
The staff size is changed throughout the selected layouts.

TIP

You can also change the size of individual staves.
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RELATED LINKS
Staff size on page 527
Brackets and braces on page 707
System objects on page 1044

Changing the default staff/system spacing
You can change the default gaps between staves and systems in each layout independently. For 
example, you can have smaller gaps between staves in full score layouts to accommodate more 
staves, and larger gaps between systems in part layouts to give players space to add pencil 
markings.

TIP

● If the staves in a layout are very close together, just decreasing the staff size might be 
sufficient to produce good results.

● We recommend that you set the ideal gaps to the minimum value acceptable to you, as 
Dorico SE automatically allocates additional space for other items, such as system objects 
and dynamics, and avoids collisions between notes and staves above/below.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default staff/system 
spacing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Ideal Gaps section, change the values for the different contexts as required.

5. Click Apply, then Close.

RESULT
The minimum gaps between staves and systems in the corresponding contexts are changed. This 
affects how much space Dorico SE allows for staves/systems in its casting off estimations and 
whether frames are considered full enough to justify vertically automatically.

RELATED LINKS
Staff spacing on page 529
Note spacing on page 533
Changing the first system indent on page 1046
Hiding/Showing staff labels on page 1030
Hiding/Showing empty staves on page 515
Changing the default player order on page 110

Changing the vertical justification of staves/systems
You can change the minimum fullness threshold above which Dorico SE automatically vertically 
justifies staves and systems, which means they are evenly distributed to fill the height of frames. 
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You can also control whether staves and systems are both vertically justified or only systems are 
vertically justified.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the automatic vertical 
justification of staves/systems.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Ideal Gaps section, choose one of the following options for Gap to use for divisi 
staves:

● Staff to staff

● Braced staff to braced staff

5. In the Vertical Justification section, change the values for the following options, individually 
or together:

● Justify distance between staves and systems when frame is at least [n]% full

● Justify distance only between systems when frame is at least [n]% full

6. Activate/Deactivate Justify staves when frame with single system is above this threshold.

7. Click Apply, then Close.

RESULT
The automatic vertical justification of staves and systems in the selected layouts is changed. 
Braced staves are never vertically justified.
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EXAMPLE

A page with staves and systems both justified The same page with only systems justified

RELATED LINKS
Per-layout vertical spacing options on page 530

Hiding/Showing empty staves
You can hide/show empty staves differently in each layout independently. For example, you can 
show all staves, including empty staves, in a full score layout for the conductor but hide empty 
staves in a full score layout intended for reference only.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show empty staves.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Staff Visibility section, choose one of the following options for Hide empty staves:

● After first system

● All systems

● Never

5. Activate/Deactivate Allow individual staves of multi-staff instruments to be hidden.

6. Optional: For Players excluded from Hide Empty Staves, activate the checkbox for each 
instrument you want to be shown regardless of your choice for Hide empty staves.
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7. Click Apply, then Close.

RESULT
Empty staves in the selected layouts are hidden/shown according to your choice. If you activated 
Allow individual staves of multi-staff instruments to be hidden, any single empty staves in 
multi-staff instruments, such as piano or harp, can be hidden in the selected layouts.

RELATED LINKS
Extra staves on page 1041
Divisi on page 1047
Per-layout vertical spacing options on page 530
Hiding/Showing blank staves after final flows on page 517
Changing the default player order on page 110
Hiding/Showing system dividers on page 1043

Hiding/Showing staves from system/frame breaks
You can manually change staff visibility from the rhythmic positions of system/frame breaks 
onwards by hiding, showing, and resetting individual staves. For example, if you have hidden 
empty staves in the layout but want specific empty staves to appear in some sections, or you 
want to hide staves with music on them in some layouts.

PROCEDURE

1. Optional: If you want to change staff visibility manually from a rhythmic position that does 
not yet have a system/frame break, select an item at the position from which you want to 
change staff visibility.

2. Open the Manual Staff Visibility dialog in one of the following ways:

● If a system/frame break signpost exists at the position where you want to change staff 
visibility, select it and press Return  or double-click it.

● If no system/frame break exists, choose Edit > Notations > Staff > Manual Staff 
Visibility. You can also choose this option from the context menu.

3. Change staff visibility as required.

For example, you can activate and change the setting for individual staves, or use the 
options in the action bar to change the setting for all staves simultaneously.

4. Click OK to save your changes and close the dialog.

RESULT
Staff visibility is changed from the selected rhythmic position or system/frame break signpost 
onwards until the next staff visibility change or the end of the flow, whichever comes first and 
whether the staves are empty or not.

If a system/frame break signpost did not yet exist at the selected rhythmic position, a system 
break with your staff visibility settings is inserted at the selected rhythmic position.

RELATED LINKS
Frame breaks on page 539
System breaks on page 537
Staff spacing on page 529
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Manual Staff Visibility dialog
The Manual Staff Visibility dialog allows you to hide, show, and reset individual staves manually 
from system/frame breaks.

You can open the Manual Staff Visibility dialog in Write mode in any of the following ways:

● Choose Edit > Notations > Staff > Manual Staff Visibility when an item is selected in the 
music area. You can also choose this option from the context menu.

● Select a system/frame break signpost and press Return , or double-click a system/frame 
break signpost.

The Manual Staff Visibility dialog comprises the following:

1 Staff list

Contains all the staves that exist at the selected rhythmic position, including hidden empty 
staves. Activating staves includes them in the manual staff visibility change.

For each staff, the following staff visibility options are available:

● Reset: Resets the visibility of the staff to the default setting in the layout, as set on the 
Vertical Spacing page in Layout Options.

● Show: Shows the staff from the selected rhythmic position onwards, whether it is empty 
or not.

● Hide: Hides the staff from the selected rhythmic position onwards, whether it is empty 
or not.

2 Action bar

Contains options that allow you to change the staff visibility setting of all staves 
simultaneously.

● Clear All: Deactivates all staves.

● Reset All: Activates all staves and sets them to Reset.

● Show All: Activates all staves and sets them to Show.

● Hide All: Activates all staves and sets them to Hide.

Hiding/Showing blank staves after final flows
You can hide/show additional blank staves to fill the page after the final flow in each layout 
independently; for example, if you want to emulate the convention of showing additional blank 
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staves between the final system and the bottom of the page when formatting part layouts for 
recording sessions.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show blank staves after the 
ends of flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, activate/deactivate Fill frame with blank staves.

5. If you activated Fill frame with blank staves, activate/deactivate Show blank staves in 
systems identical to final flow.

6. Customize the appearance of blank staves in one of the following ways:

● If you activated Show blank staves in systems identical to final flow and want to 
show clefs that follow the previous flow on blank staves, choose Include clefs.

● If you activated Show blank staves in systems identical to final flow and want to hide 
clefs on blank staves, choose Exclude clefs.

● If you deactivated Show blank staves in systems identical to final flow, change the 
number of staff lines in blank staves by changing the value for Number of staff lines 
for blank staves.

RESULT
Blank staves are shown after the final flow in the selected layouts when Fill frame with blank 
staves is activated, and hidden when it is deactivated. When shown, blank staves appear below 
the final system in the final flow and fill the width of the final system if it is not fully horizontally 
justified.

When Show blank staves in systems identical to final flow is activated, blank staves follow the 
staff grouping of the final flow, such as two bracketed staves in a part layout with two players 
assigned to it. When it is deactivated, single blank staves without clefs are shown.

NOTE

You cannot input music or change brackets/braces on blank staves.

RELATED LINKS
Per-layout vertical spacing options on page 530
Changing the horizontal justification of final systems on page 522
Staff labels on page 1029
Brackets and braces on page 707
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Starting layouts on left-hand pages
By default, all layouts start on a right-hand page, as convention dictates that odd numbered 
pages are always on the right-hand page. However, you can set individual layouts to start on a 
left-hand page; for example, to facilitate page turns better in that layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts you want to start on a left-hand page.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Numbers section, change the value for Initial page number to an even 
number.

5. Click Apply, then Close.

RESULT
The first page in the selected layouts is shown on a left-hand page when the initial page number 
is even.

Allowing/Disallowing multiple flows on the same page
You can allow/disallow new flows to be shown on the same page as previous flows if there is 
space; for example, to reduce the number of pages required for parts in works with multiple 
movements. By default, new flows are allowed on the same page in part layouts and are not 
allowed in full score layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to allow multiple flows to be shown 
on each page.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for New flows:

● Always start new page

● Allow on existing page

5. Click Apply, then Close.

RESULT
Always start new page ensures flows in the selected layouts always begin at the start of the 
next page after the end of the previous flow.

Allow on existing page allows flows in the selected layouts to continue immediately after each 
other, including within the same music frame if there is sufficient space. Flow headings are 
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automatically shown above the start of flows if you have chosen to show flow headings in the 
selected layouts.

NOTE

Flows are not automatically split into separate music frames. You must insert frame breaks 
manually to divide flows into separate music frames if required.

RELATED LINKS
Tokens on page 552
Casting off on page 535
Assigning flows to layouts on page 154
Assigning players to flows on page 149
Hiding/Showing information in running headers above flow headings on page 521
Hiding/Showing blank staves after final flows on page 517

Changing when the First page template is used
You can change the circumstances when the First page template is used in each layout 
independently; for example, if you want to use it for the start of every flow in the full score 
but only want to use it for the first flow in part layouts, even when subsequent flows start at the 
top of the page.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change when the First page 
template is used.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for Use ‘First’ page template:

● Never

● First flow only

● Any flow starting at top of page

5. Click Apply, then Close.

RESULT

● Choosing Never means the First page template is not used for any page in the selected 
layouts.

● Choosing First flow only means the First page template is used for the first page in the 
layout but no other pages, even if some subsequent flows start at the top of a page.

● Choosing Any flow starting at top of page means the First page template is used for all 
pages in the layout that begin with the start of a flow.

RELATED LINKS
Layout Options dialog on page 622
Types of page templates on page 549
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Hiding/Showing flow headings
You can hide/show flow headings in each layout independently; for example, if your project only 
contains a single flow and you only want to show the project title. You can also hide the heading 
for the first flow but show flow headings for subsequent flows.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show flow headings.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for Show flow headings:

● Never

● Not for first flow

● For all flows

5. Click Apply, then Close.

RESULT
Flow headings are shown above the first system in each flow in the selected layouts when you 
choose For all flows, hidden when you choose Never, and hidden above the first system in the 
first flow but shown above all other flows when you choose Not for first flow.

They are automatically positioned above each flow and below the preceding flow according to 
the margins set for each layout.

NOTE

Hiding flow headings does not hide the flow title shown at the top of the second page onwards 
by default.

RELATED LINKS
Flow headings on page 550
Allowing/Disallowing multiple flows on the same page on page 519
Hiding/Showing information in running headers above flow headings on page 521
Changing when the First page template is used on page 520

Hiding/Showing information in running headers above flow 
headings

You can hide/show flow titles, page numbers, and flow page numbers separately when they 
appear above flow headings at the top of a new page in each layout independently. Hiding such 
information in running headers is a custom in publishing.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show information in running 
headers above flow headings.
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By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for Flow title in header:

● Show above flow heading

● Hide above flow heading

5. Choose one of the following options for Page number in header:

● Show above flow heading

● Hide above flow heading

6. Choose one of the following options for Flow page number in header:

● Show above flow heading

● Hide above flow heading

7. Click Apply, then Close.

RESULT
The corresponding information is hidden/shown when they appear above flow headings at the 
top of the page.

NOTE

In order to hide running header information, the top of the music frame containing the 
flow heading frame must be lower than the top of text frames containing the corresponding 
information. If the top of the music frame is the same height as a running header text frame, any 
corresponding information in the text frame is shown, regardless of your setting.

RELATED LINKS
Frames on page 551
Page templates on page 547
Hiding/Showing page numbers on page 916

Changing the horizontal justification of final systems
You can change whether the final systems of flows always fill the width of frames or only do so 
above a certain fullness threshold in each layout independently. By default in Dorico SE, the final 
systems of flows only justify to the full width of the frame when they are more than half full.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the justification of the 
final systems in flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Note Spacing.
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4. Change the justification of final systems in flows in one of the following ways:

● If you always want the final systems in flows to justify fully, deactivate Only justify final 
system in flow when more than [n]% full.

● If you want to change the minimum fullness of final systems before they justify, change 
the value for Only justify final system in flow when more than [n]% full.

5. Click Apply, then Close.

RESULT
The automatic justification of the final systems in flows in the selected layouts is changed.

TIP

You can also change the width of individual systems independently of your default settings by 
changing their start/end positions.

EXAMPLE

Final system below fullness threshold, unjustified Final system justified

RELATED LINKS
Note spacing on page 533
Changing the first system indent on page 1046
Fixing the number of bars per system on page 535
Hiding/Showing blank staves after final flows on page 517
Hiding/Showing bar rests in empty bars on page 1014
Deleting rests on page 1012
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Margins
Margins determine the spacing around music on pages, such as on all four edges of each page 
and above/below flow headings.

In Dorico SE, there are the following types of margins:

1 Page margins

The gaps between the four edges of pages and the boundary of the content on them. For 
example, systems that are horizontally justified span the full width of pages between the left 
and right page margins. You cannot position frames beyond the page margins.

2 Music frame margins

The gaps at the top and bottom of music frames. Also known as “music frame padding”.

● Top music frame margins set the gap between the top edges of music frames and the 
top staff line of the highest staff in the frame.

● Bottom music frame margins set the gap between the bottom edges of music frames 
and the bottom staff line of the lowest staff in the frame.

3 Flow heading margins

The gaps above and below flow headings. When flow headings are positioned at the top of 
music frames, the flow heading bottom margin sets the gap at the top of the music frame, 
rather than the music frame margin.

● Flow heading top margins set the gap between the top of flow headings and the bottom 
staff line of the preceding flow, if applicable.

● Flow heading bottom margins set the gap between the bottom of flow headings and the 
top staff line of the next flow.
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NOTE

Notes and notations above the highest staff and below the lowest staff extend into margins.

RELATED LINKS
Flow headings on page 550
Changing page margins on page 511
Changing the margins above/below tacets on page 543
Changing the page size and/or orientation on page 510
Changing the default staff/system spacing on page 513
Changing the vertical justification of staves/systems on page 513
Changing the horizontal justification of final systems on page 522

Changing the margins above/below flow headings
You can change the margins both above and below flow headings, which control the gap 
between the preceding flow and the flow heading, and the gap between the flow heading and 
the start of the next flow.

PREREQUISITE
Flow headings are shown in the layouts in which you want to change the margins above/below 
flow headings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the margins above/below 
flow headings.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, change the values for the following options, individually or together:

● Flow heading top margin

● Flow heading bottom margin

5. Click Apply, then Close.

RESULT
The margins above/below flow headings in the selected layouts are changed.

● Flow heading top margin sets the gap between the top of flow headings and the end of the 
preceding flow.

● Flow heading bottom margin sets the gap between the bottom of flow headings and the 
start of the next flow.

For example, when the bottom margin is set to 0, the bottom of the lowest frame in the flow 
heading aligns with the top staff line of the first system in the flow below the flow heading.
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EXAMPLE

Flow heading with default margins above/below Flow heading with decreased margins above/below

RELATED LINKS
Flow headings on page 550
Per-layout vertical spacing options on page 530
Hiding/Showing used chord diagrams grids on page 731
Changing the margins above/below tacets on page 543

Changing the default music frame margins
You can change the default margins in all music frames in each layout independently. For 
example, you might want more padding at the top of music frames in part layouts containing lots 
of notes above the staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose music frame margins you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Music Frame Margins section, change the values for the following options, 
individually or together:

● Top

● Bottom

5. Click Apply, then Close.

RESULT
The margins within all music frames in the selected layouts are changed.

● Top sets the gap between the top edges of music frames and the top staff line of the highest 
staff in the frame.

● Bottom sets the gap between the bottom edges of music frames and the bottom staff line of 
the lowest staff in the frame.

For example, when the bottom music frame margin is set to 0, the bottom staff line of the lowest 
staff in the frame aligns with the bottom edge of the music frame.
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NOTE

Notes and notations above the highest staff and below the lowest staff extend into music frame 
margins.

RELATED LINKS
Changing page margins on page 511
Changing the default staff/system spacing on page 513
Hiding/Showing used chord diagrams grids on page 731

Staff size
Staff size refers to the distance between the top and bottom lines of staves, and can be 
expressed as a point size or in another supported unit of measurement, such as millimeters. 
For individual staves, you can use a scale size of the default staff size in the layout. The most 
appropriate staff size depends on the intended purpose of the layout.

For example, full orchestral scores that are quite dense need a much smaller staff size than 
individual parts, which require large enough notes so that performers can read them easily. 
Staves can overlap and the music can become illegible if the staff size is too large in dense 
scores.

In Dorico SE, you can set the staff size using the rastral size and the space size, depending on 
which measurement is more appropriate for the selected layouts.

1 Rastral size is the size of the full staff, measured from the bottom line to the top line.

2 Space size is the distance between two staff lines.

When changing the staff size of each layout in Layout Options, we recommend that you use one 
of the preset rastral sizes, as these are based on traditional and generally accepted staff sizes 
that are all widely used in music engraving.

NOTE

The size of staves can affect the size of system objects.

RELATED LINKS
System objects on page 1044
Changing your preferred unit of measurement on page 48
Changing the default staff size on page 512
Staff spacing on page 529
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Changing the size of staves for individual players
You can change the size of all staves belonging to individual players in each flow, independently 
of other players’ staves and your layout settings. For example, piano accompaniment parts often 
include the solo line of the instrument the piano is accompanying on a smaller staff.

You can change the size of staves to a set scale size, expressed as a percentage of the normal 
staff size in the layout, or set a custom scale.

TIP

If you want to change the staff size to represent an alternative version of a passage, you can 
instead add an ossia staff, which you can show for specific regions.

PROCEDURE

1. Select an item on the staff whose size you want to change.

NOTE

You can only change the size of a single staff at a time.

2. Choose Edit > Notations > Staff Size > [Staff size]. You can also choose this option from the 
context menu.

3. Optional: If you chose Custom Staff Size, set the staff size in the Custom Staff Size dialog 
that opens.

RESULT
The size of the selected staff is changed in the current flow. This also works in combination with 
the other ways of changing the staff size, such as changing the size of all staves in the layout or 
changing the size of staves from specific system/frame breaks.

NOTE

● Changing the size of individual staves affects all staves belonging to the same player and for 
the whole flow.

● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

EXAMPLE

A piano part with smaller staff above

RELATED LINKS
Brackets and braces on page 707
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System objects on page 1044

Custom Staff Size dialog
The Custom Staff Size dialog allows you to change the size of individual staves by a custom scale 
factor.

● You can open the Custom Staff Size dialog by selecting an item on a staff and choosing 
Edit > Notations > Staff Size > Custom Staff Size.

The Custom Staff Size dialog contains the following options:

Default staff size
Displays the default size of staves in the current layout. This size is set on the Page 
Setup page in Layout Options.

The default staff size is expressed as both a point size and in your preferred unit of 
measurement.

Rastral size
Allows you to select the rastral size on which you want to base your custom staff size.

Scale factor
Sets the custom staff size, expressed as a percentage of the selected rastral size.

New staff size
Displays the new custom staff size for the selected staff as a result of the changes you 
have made in the dialog.

The new staff size is expressed as both a point size and in your preferred unit of 
measurement.

Staff spacing
The vertical positioning of staves and systems within frames is known as staff spacing. Staff 
spacing calculations consider the height of staves and the necessary gaps between staves and 
systems.

● You can change the default vertical and staff spacing settings for each layout independently 
on the Vertical Spacing page in Layout Options.

The options available allow you to set your ideal spacing, which Dorico SE then produces as 
closely as possible. We recommend familiarizing yourself with the available vertical spacing 
options.
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RELATED LINKS
Layout Options dialog on page 622
Staff size on page 527
Staves on page 1040
Changing the default staff/system spacing on page 513
Changing the staff spacing in galley view on page 532
Changing the default staff size on page 512
Margins on page 524
Casting off on page 535
Frame breaks on page 539
Fixing the number of systems per frame on page 536
Note spacing on page 533

Per-layout vertical spacing options
Dorico SE provides multiple options that you can use to control the default vertical spacing and 
justification of staves and systems in each layout.

● You can access per-layout vertical spacing options by opening the Layout Options dialog 
and clicking Vertical Spacing in the category list.

The Vertical Spacing page contains the following sections and options:

Ideal Gaps

Contains multiple scenarios that allow you to set the gap you want Dorico SE to allow between 
staves and systems in the corresponding context, including the default scaling of these gaps in 
galley view, as Dorico SE does not automatically avoid collisions between staves and items in 
galley view. The options are accompanied by diagrams to help you visualize the contexts to which 
each option applies.

We recommend setting the ideal gaps to the minimum value acceptable to you because Dorico 
SE never reduces the gap between staves to less than your set values. Setting smaller values 
gives Dorico SE greater flexibility when determining staff spacing, particularly in very full frames, 
such as reducing the space between staves with no dynamics to allow more space between 
staves with dynamics. Similarly, we recommend setting vertical spacing options after you have 
finished inputting notes and items, as this allows you to consider the entire project when setting 
these options.

Depending on the context, the options are affected by automatic vertical justification in different 
ways:

● Staff to staff, Staff group to staff, Staff to staff group, Staff group to staff group, 
Inter-system gap, and Timecode staff to staff

These gaps do not apply in frames that are automatically justified.

● Braced staff to braced staff and Ossia staff to staff

These gaps always apply, including in frames that are automatically justified, because braced 
and ossia staves are never justified. This includes extra staves.

NOTE

● Divisi staves are vertically justified when they use the Staff to staff gap. When they use the 
Braced staff to braced staff gap, the staves in each divisi section use only the gap set for 
braced staves and are not vertically justified.

● If the staves in a layout are very close together, just decreasing the staff size might be 
sufficient to produce good results.
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● When calculating the number of systems that can fit in each frame in a layout, Dorico SE 
considers the height of staves, the minimum gaps between staves, the maximum distances 
between very high/low notes and staves, and other items that require vertical space, such as 
pedal lines and tempo marks. However, this calculation happens before horizontal spacing 
is finalized, which can result in either more or fewer systems being allocated to frames than 
ideally fit. In such circumstances, you can use fixed casting off settings and system/frame 
breaks to change which systems appear in frames.

Minimum Gaps

Contains options for the minimum gaps you want Dorico SE to allow for items in addition to the 
staff spacing gaps.

● Automatically resolve collisions between adjacent staves and systems: When activated, 
Dorico SE automatically allows extra space between staves and systems to avoid collisions. 
When deactivated, Dorico SE only uses your set gaps for vertical spacing, which produces 
evenly-spaced staves and systems but with the possibility of collisions between items.

● Minimum inter-staff gap with content: Allows you to set the extra space you want to allow 
between staves when items are present.

● Minimum inter-system gap with content: Allows you to set the extra space you want to 
allow between systems when items are present.

NOTE

Minimum gaps do not affect casting off. For example, increasing the Minimum inter-system 
gap with content value changes the space above/below systems on a page but does not push 
systems to later pages. Instead, you can change the ideal gaps.

Vertical Justification

Contains options that allow you to control the frame fullness thresholds above which you want 
staves and/or systems to justify vertically automatically.

● Justify distance between staves and systems when frame is at least [n]% full: When 
frames are filled above this threshold, the staves and systems they contain are all 
automatically vertically justified, meaning they are evenly distributed to fill the height of 
the frame. Frames filled below this threshold are not automatically justified, instead staves 
follow your ideal gap settings. This can leave gaps between the bottom staff/system and the 
bottom of the frame.

● Justify distance only between systems when frame is at least [n]% full: When frames are 
filled above this threshold, only the distance between systems in the frame is justified. Staves 
follow your per-layout ideal gap settings. This helps keep a clear distance between systems 
on very full pages.

● Justify staves when frame with single system is above this threshold: When activated, 
all the staves in a single system taller than the set threshold are vertically justified, which 
distributes them evenly to fill the height of the frame.

Staff Visibility

Contains options allowing you to control when and which empty staves are hidden in the layout.

● Hide empty staves: Allows you to control when empty staves are hidden. For example, it is a 
common practice to show all staves in the first system even if some are empty, but this is not 
always required.
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● Allow individual staves of multi-staff instruments to be hidden: Allows you to control 
whether individual empty staves belonging to multi-staff instruments can be hidden 
independently or all multi-staff instrument staves must always be shown.

● Players excluded from Hide Empty Staves: Allows you to identify specific players whose 
staves you always want to show, even if their staff is empty on systems where you have 
hidden empty staves.

RELATED LINKS
Layout Options dialog on page 622
Changing the default staff/system spacing on page 513
Page formatting on page 508
Casting off on page 535
Margins on page 524
Staff size on page 527
Brackets and braces on page 707
Staves on page 1040
Ossia staves on page 1042
Tablature on page 1048
Hiding/Showing staves from system/frame breaks on page 516
Changing the vertical position of markers on page 968
Changing the vertical position of timecodes on page 972

Changing the staff spacing in galley view
You can change the vertical space between staves in galley view in each layout independently, 
expressed as a percentage of the set ideal gaps. Increasing the gaps between staves in layouts 
with very high/low notes can be useful because Dorico SE does not perform automatic collision 
avoidance in galley view.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff spacing in galley 
view.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Ideal Gaps section, change the value for In galley view, expand ideal staff gaps to.

5. Click Apply, then Close.

RELATED LINKS
Switching to galley/page view on page 47
Switching between layouts on page 40
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Note spacing
The positions of notes and rests relative to each other, and the automatic gaps between them, 
are known as note spacing.

● You can change the default note spacing values for each layout independently on the Note 
Spacing page in Layout Options.

The options available include changing the default space for quarter notes (crotchets) and the 
scale space for grace notes and cues. You can also change the minimum percentage value for 
how full final systems must be before they are justified.

RELATED LINKS
Layout Options dialog on page 622
Staff spacing on page 529
Changing the default staff size on page 512
Changing the horizontal justification of final systems on page 522

Changing the default note spacing
You can change the default note spacing in each layout independently. For example, you can 
have tighter note spacing in full score layouts compared to part layouts. The options available 
include changing the default space for quarter notes and the scale space for grace notes and 
cues.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change note spacing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Note Spacing.

4. Change the values of the options you want to change.

5. Click Apply, then Close.

RESULT
The default note spacing is changed in the selected layouts.

RELATED LINKS
Changing the horizontal justification of final systems on page 522
Positions of lyrics on page 827
Casting off on page 535

Per-layout note spacing options
Dorico SE provides multiple options that you can use to control the default note spacing in each 
layout. You can also change how full the final system in flows must be before it is automatically 
justified.

● You can access per-layout note spacing options by opening the Layout Options dialog and 
clicking Note Spacing in the category list.
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The Note Spacing page in Layout Options contains the following options:

Default space for crotchet/quarter note
Sets the default note spacing for quarter notes (crotchets). The spacing of other 
durations is scaled proportionally. Increasing the value increases note spacing, 
decreasing the value decreases note spacing. This is reflected in the preview as you 
change the value.

Minimum space for short notes
Sets the minimum note spacing for notes with short durations. This can be 
independent of the default note spacing value.

Custom spacing ratio
Sets the spacing of notes in relation to other notes according to their rhythmic values. 
For example, setting Custom spacing ratio to 2 means half notes (minims) take up 
twice as much space as quarter notes, and eighth notes (quavers) take up half as much 
space as quarter notes.

Scale space for grace notes by
Sets the note spacing for grace notes as a percentage of the note spacing normally 
used for notes of their duration. The value cannot be greater than 100%. Increasing the 
value increases the note spacing for grace notes, decreasing the value decreases the 
note spacing for grace notes.

Scale space for cue notes by
Sets the note spacing for cues as a percentage of the note spacing normally used for 
notes of their duration. The value cannot be greater than 100%. Increasing the value 
increases the note spacing for cues, decreasing the value decreases the note spacing 
for cues.

Make space for lyrics
Controls whether or not lyrics are included in note spacing calculations. When 
deactivated, lyrics are excluded from note spacing calculations, producing a result 
where notes are spaced as if lyrics were not there.

We recommend using this option with caution and only if you intend to space lyrics 
manually, such as in tightly-spaced hymnals.

Only justify final system in flow when more than [n]% full
Allows you to change how full the final system in each flow must be before it is justified 
to the full width of the frame. By default, final systems that are 50% full or less are not 
justified.

Use optical spacing for beams between staves
When activated, stems in cross-staff beams are evenly spaced, which can mean the 
noteheads are unevenly spaced. When deactivated, noteheads in cross-staff beams are 
evenly spaced, which can mean stems appear unevenly spaced.

RELATED LINKS
Layout Options dialog on page 622
Changing to optical cross-staff beam spacing on page 699
Creating cross-staff beams/tremolos on page 697
Changing the paragraph style used for lyrics on page 834
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Casting off
“Casting off” is the term used to encompass fixing the layout of pages of music, such as setting 
the number of systems per page.

When calculating how much music can fit in each system and on each page, Dorico SE considers 
multiple aspects of the layout, including note spacing and vertical spacing settings. You can 
change these settings to change the default casting off in each layout.

In Dorico SE, you can set fixed numbers of bars per system and systems per music frame 
throughout each layout independently.

You can control the casting off at a more granular level by inserting system/frame breaks.

RELATED LINKS
Per-layout note spacing options on page 533
Per-layout vertical spacing options on page 530
Margins on page 524
System breaks on page 537
Frame breaks on page 539
Allowing/Disallowing breaks within bars on page 536
Hiding/Showing blank staves after final flows on page 517

Fixing the number of bars per system
You can define a fixed number of bars you want included in each system in each layout 
independently; for example, if you want four bars per system in a lead sheet.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to fix the number of bars per 
system.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Casting Off section, activate Fixed number of bars per system.

5. Change the value in the value field.

6. Click Apply, then Close.

RESULT
The number of bars automatically contained in each system in the selected layouts is changed. 
If any of the layouts contain two-bar or four-bar repeat regions, Dorico SE automatically adjusts 
casting off to ensure phrases are not split across systems.

RELATED LINKS
Bar repeats on page 985
Inserting system breaks on page 537
Inserting frame breaks on page 539
Changing the horizontal justification of final systems on page 522
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Fixing the number of systems per frame
You can define a fixed number of systems you want included in each music frame in each layout 
independently. Because the default page templates have a single music frame per page, fixing 
the number of systems per frame usually fixes the number of systems per page.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to fix the number of systems per 
frame.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Casting Off section, activate Fixed number of systems per frame.

5. Change the value in the value field.

6. Activate/Deactivate Scale number of systems by frame height.

7. Click Apply, then Close.

RESULT
The number of systems automatically contained in each music frame in the selected layouts is 
changed.

If you activated Scale number of systems by frame height, the number of systems contained in 
each frame is adjusted according to the size of the music frame. For example, pages with smaller 
frames, such as the first page, contain fewer systems than your casting off setting.

Allowing/Disallowing breaks within bars
You can choose whether or not to allow Dorico SE to insert system/frame breaks within bars. For 
example, you might disallow breaks within bars when formatting lead sheets that only require 
breaks at barlines.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Snap system and frame breaks to barlines 
when creating in the Breaks subsection.

4. Click Apply, then Close.

RESULT
System/Frame breaks are allowed within bars when the option is activated, and disallowed when 
it is deactivated.

When breaks are disallowed within bars, inserted breaks snap to the barline before the earliest 
selected item. When making systems/frames from selections, the first break snaps to the barline 
before the earliest selected item while the second break snaps to the barline after the last 
selected item.
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RELATED LINKS
Preferences dialog on page 53
Frame breaks on page 539
Casting off on page 535

System breaks
System breaks occur when musical material reaches the right page margin and must continue on 
a new system, usually below the previous system on the same page or on a new page. Dorico SE 
automatically arranges music across systems so that notes are correctly spaced and legible, but 
you can also control system breaks manually.

System breaks that you have inserted manually are indicated by signposts, which you can hide/
show at any time. They are also layout-specific, meaning each layout can have system breaks at 
different rhythmic positions.

System break signpost, selected

NOTE

● By default, system/frame breaks snap to the barline before the earliest selected item. You 
can change whether breaks are allowed at rhythmic positions within bars.

● You can also control the content of systems by fixing the number of bars per system in each 
layout.

RELATED LINKS
Allowing/Disallowing breaks within bars on page 536
Frame breaks on page 539
Signposts on page 407
Hiding non-printing elements on page 402
Note spacing on page 533
Per-layout note spacing options on page 533
Staff spacing on page 529
Per-layout vertical spacing options on page 530
Hiding/Showing staves from system/frame breaks on page 516
Properties panel on page 560

Inserting system breaks
You can insert system breaks at any rhythmic position; for example, so that musical phrases fit in 
systems for readability.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● If you want to insert system breaks in the middle of multi-bar rests, you have either hidden 
multi-bar rests in the layout or split multi-bar rests at the required positions.
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PROCEDURE

1. In Write mode, select a note or item at the rhythmic position you want to appear at the start 
of the next system.

2. Choose Edit > System Break.

RESULT
A system break is inserted at the rhythmic position of the earliest selected item. If breaks are 
disallowed within bars, it snaps to the preceding barline. All notations after the system break are 
moved to the next system.

NOTE

If you insert a system break in the middle of a phrase in a two-bar or four-bar repeat region, 
Dorico SE does not automatically move the system break to before/after the phrase, causing it to 
be split across the system break.

RELATED LINKS
Allowing/Disallowing breaks within bars on page 536
Per-layout note spacing options on page 533
Per-layout vertical spacing options on page 530
Hiding/Showing multi-bar rests on page 1015

Hiding/Showing system break signposts
You can hide/show system break signposts at any time.

PROCEDURE

● Choose View > Signposts > System Breaks.

RELATED LINKS
Signposts on page 407
System breaks on page 537
Hiding non-printing elements on page 402
Selecting/Deselecting notes and items individually on page 387

Deleting system breaks
You can delete system breaks after you have inserted them.

PREREQUISITE
System break signposts are shown.

PROCEDURE

1. Select the system break signposts of the system breaks you want to delete.

2. Press Backspace or Delete .
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Frame breaks
Frame breaks occur when musical material reaches the right page margin at the bottom of a 
frame and must continue on a new system in the next frame in the music frame chain, which 
is usually on the next page. Dorico SE automatically arranges music in frames so that systems 
are correctly spaced and legible, but you can also control frame breaks manually; for example, to 
insert page turns at specific positions in part layouts.

Frame breaks that you have inserted manually are indicated by signposts, which you can hide/
show at any time. They are also layout-specific, meaning each layout can have frame breaks at 
different rhythmic positions.

Frame break signpost, selected

NOTE

● By default, system/frame breaks snap to the barline before the earliest selected item. You 
can change whether breaks are allowed at rhythmic positions within bars.

● You can also control the content of music frames by fixing the number of systems per music 
frame in each layout.

RELATED LINKS
Allowing/Disallowing breaks within bars on page 536
Frames on page 551
Music frame chains on page 559
Signposts on page 407
Hiding non-printing elements on page 402
Note spacing on page 533
Per-layout note spacing options on page 533
Per-layout vertical spacing options on page 530
Hiding/Showing staves from system/frame breaks on page 516
Properties panel on page 560

Inserting frame breaks
You can insert frame breaks at any rhythmic position; for example, to create page turns at 
appropriate places in the current layout.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● If you want to insert frame breaks in the middle of multi-bar rests, you have either hidden 
multi-bar rests in the layout or split multi-bar rests at the required positions.

PROCEDURE

1. In Write mode, select a note or item at the rhythmic position you want to appear at the start 
of the next frame.
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2. Choose Edit > Frame Break.

RESULT
A frame break is inserted at the rhythmic position of the earliest selected item. If breaks are 
disallowed within bars, it snaps to the preceding barline. All notations after the frame break are 
moved to the next music frame.

NOTE

If you insert a frame break in the middle of a phrase in a two-bar or four-bar repeat region, 
Dorico SE does not automatically move the frame break to before/after the phrase, causing it to 
be split across the frame break.

RELATED LINKS
Allowing/Disallowing breaks within bars on page 536
Per-layout note spacing options on page 533
Per-layout vertical spacing options on page 530
Hiding/Showing multi-bar rests on page 1015

Hiding/Showing frame break signposts
You can hide/show frame break signposts at any time.

PROCEDURE

● Choose View > Signposts > Frame Breaks.

RELATED LINKS
Signposts on page 407
Frame breaks on page 539
Hiding non-printing elements on page 402
Selecting/Deselecting notes and items individually on page 387

Deleting frame breaks
You can delete frame breaks after you have inserted them.

PREREQUISITE
Frame break signposts are shown.

PROCEDURE

1. Select the frame break signposts of the frame breaks you want to delete.

2. Press Backspace or Delete .
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Tacets
Tacet is the indication used to show that a player does not play anything in an entire flow, which 
might be a movement in a symphony or cue in a film score. In Dorico SE, you can generate tacets 
automatically.

Dorico SE shows tacets for flows in part layouts when the following conditions are met:

● You have removed the player from the flows in which they do not play.

● The flows are assigned to the part layout.

● The flows are assigned to the page template frame chain in the part layout.

● You have chosen to show tacets in the part layout.

An extract of a part layout where the player is tacet in the second flow

NOTE

We do not recommend that you use Copy Staff Spacing and Lock Frame  on pages where 
tacets are the first or last system in frames. Because tacets do not contain any bars, Dorico SE 
cannot insert system or frame breaks at the ends of tacets in order to lock the frame contents.

However, you can insert system and frame breaks at the start of tacets.

You can change the text shown in tacets and the margin above/below them in each layout 
independently.

RELATED LINKS
Assigning players to flows on page 149
Allowing/Disallowing multiple flows on the same page on page 519
Staff spacing on page 529
System breaks on page 537
Frame breaks on page 539
Flow headings on page 550
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Hiding/Showing tacets
You can hide/show tacets in each layout independently; for example, if you want to show empty 
bars or multi-bar rests in some layouts to allow those players to add in notes on those staves 
later.

PREREQUISITE

● You have removed the player from the flows in which they do not play.

● The flows are assigned to the part layout.

● The flows are assigned to the page template frame chain in the part layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show tacets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Tacets section, activate/deactivate Show tacet for flows where no players are 
assigned.

5. Click Apply, then Close.

RESULT
Tacets are shown in the selected layouts when Show tacet for flows where no players are 
assigned is activated and the prerequisite criteria are also met.

When it is deactivated, any flows to which the player is not assigned do not appear in the layout. 
When the player is assigned to those flows, all bars in the flow are shown in the part, split into 
empty bars and multi-bar rests as appropriate for the flow.

RELATED LINKS
Multi-bar rests on page 1014
Assigning players to flows on page 149
Hiding/Showing multi-bar rests on page 1015

Editing tacet text
You can change the text shown in tacets in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose tacet text you want to edit.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Tacets section, enter the text you want in the Tacet text field.
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5. Click Apply, then Close.

RESULT
The text shown in all tacets in the selected layouts is changed.

Changing the margins above/below tacets
You can change the margins both above/below tacets in each layout independently; for example, 
if you want smaller gaps between flow headings and tacets in some layouts to facilitate page 
turns better.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the margins above/below 
tacets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Tacets section, change the values for the following options, individually or together:

● Margin above tacet

● Margin below tacet

5. Click Apply, then Close.

RESULT
Changing the value for Margin above tacet increases/decreases the minimum gap between 
tacets and whatever precedes them.

Changing the value for Margin below tacet increases/decreases the minimum gap between 
tacets and whatever follows them.

RELATED LINKS
Flow headings on page 550
Margins on page 524
Per-layout vertical spacing options on page 530

Condensing
Condensing is the process of showing the music for multiple players on fewer staves than 
normal, usually by allowing multiple instruments of the same type to share a staff, such as Flutes 
1-2 or Horns 1-4.

In Dorico SE, you cannot enable automatic condensing as it is only available in Dorico Pro. 
However, if you import or open a project that contains layouts with condensing enabled, those 
staves remain condensed.

NOTE

● You cannot select anything on condensed staves.
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● Condensing is never enabled in galley view, so you can switch to galley view to see all staves 
separately. This does not disable condensing in the current layout.

● Having condensing enabled in any layout in a project can cause Dorico SE to operate more 
slowly, due to the large number of calculations involved.

RELATED LINKS
Staff labels on condensed staves on page 1038
Switching to galley/page view on page 47
Divisi on page 1047

Part formatting propagation
The propagation of part formatting involves copying the layout options and system formatting 
that determine the layouts of pages in specific part layouts and applying them to other part 
layouts. This can save time when formatting similar parts.

System formatting includes the positions of system and frame breaks, but also note spacing 
changes that affect the horizontal space that notes require.

In Dorico SE, you can copy layout options and system formatting both together and 
independently of each other from a selected source layout to other destination layouts. For 
example, for source layouts whose formatting relies primarily on their Casting Off settings in 
Layout Options, it is likely that copying only their layout options is sufficient to produce the 
required formatting in the destination layouts without adding system/frame breaks on every 
system.

You can also copy the layout-specific property settings from the layout currently open in the 
music area to all other layouts in which those items appear.

NOTE

● Part formatting propagation is only available for part layouts. You cannot propagate part 
formatting from/to full score or custom score layouts.

● We do not recommend using layouts with multiple music frame chains as either source or 
destination layouts as you can get unexpected results.

Copying part formatting to other layouts
You can copy all the formatting from one part layout to other part layouts; for example, to save 
time if multiple part layouts in your project require similar formatting. You can include layout 
options, such as page size and margins, and other page formatting, such as system and frame 
breaks.

NOTE

● Part formatting propagation is only available for part layouts. You cannot propagate part 
formatting from/to full score or custom score layouts.

● We do not recommend using layouts with multiple music frame chains as either source or 
destination layouts as you can get unexpected results.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the part layout whose part formatting you want 
to copy.
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2. In the action bar, click Layout Settings  and choose Propagate Part Formatting to open 
the Propagate Part Formatting dialog.

TIP

You can also right-click layouts and choose this option from the context menu.

3. In the Copy formatting from list, select the part layout whose part formatting you want to 
copy.

By default, the layout whose card you used to open the dialog is selected.

4. In the Propagate formatting to list, select the part layouts to which you want to copy part 
formatting.

You can use the selection options in the action bar, click and drag across multiple layouts, 
Shift -click adjacent layouts, and Ctrl/Cmd -click individual layouts.

5. Activate/Deactivate Include layout options.

6. Activate/Deactivate Include system formatting.

7. Click OK to copy part formatting to the selected layouts and close the dialog.

RESULT
Part formatting from the selected source layout is copied to the selected destination layouts.

● If you activated Include layout options, layout options are copied from the source layout to 
the destination layouts.

● If you activated Include system formatting, Dorico SE copies the distribution of bars 
in systems, systems on pages, and note spacing changes from the source layout to the 
destination layouts.

TIP

If the formatting of the source layout relies primarily on its Casting Off settings in Layout 
Options, it is likely that only activating Include layout options is sufficient to produce very 
similar formatting in the destination layouts without adding system/frame breaks on every 
system.

Propagate Part Formatting dialog
The Propagate Part Formatting dialog allows you to copy the page formatting and layout 
options from a source layout to destination layouts.

You can open the Propagate Part Formatting dialog in Setup mode in any of the following 
ways:

● In the Layouts panel, select a part layout, then click Layout Settings  in the action bar 
and choose Propagate Part Formatting. This automatically selects that layout as the source 
layout in the Copy formatting from list.

TIP

You can also right-click layouts and choose this option from the context menu.

● Choose Setup > Propagate Part Formatting.
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The Propagate Part Formatting dialog contains the following sections and options:

1 Copy formatting from list

Contains a list of all the part layouts in the project. You can only select a single part layout as 
the source layout.

2 Propagate formatting to list

Contains a list of all the part layouts in the project. You can select multiple part layouts as 
destination layouts.

3 Selection options

Allow you to select/deselect all the part layouts in the Propagate formatting to list.

4 Include layout options

Allows you to copy layout options relating to part formatting from the source layout to 
the destination layouts. These options include page size, page margins, the default page 
template set, space size, vertical spacing, note spacing, casting off, multi-bar rest settings, 
and staff labels.

5 Include system formatting

Allows you to copy the distribution of bars in systems, systems on pages, and note spacing 
changes from the source layout to the destination layouts. Dorico SE achieves this by copying 
system breaks, frame breaks, and note spacing changes, inputting additional system and 
frame breaks as required, and deleting any existing system breaks, frame breaks, and note 
spacing changes in the destination layouts.

RELATED LINKS
Layout Options dialog on page 622
Layouts panel (Setup mode) on page 101
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Copying property settings to other layouts/frame chains
Local properties are layout- and frame chain-specific, meaning that by default, changing local 
properties for an item in one layout does not affect the same item in other layouts or other 
frame chains. You can copy the properties set on notes and items to all other layouts and frame 
chains in which they appear; for example, to show gradual dynamics with the same style in part 
layouts after changing their style in the full score layout.

PROCEDURE

1. Select the notes or items whose properties you want to copy to other layouts.

2. Choose Edit > Propagate Properties.

RESULT
All properties set on the selected notes/items are copied to all layouts and frame chains in which 
those notes/items appear.

TIP

If you know in advance that you want your changes to affect all layouts and frame chains, you 
can change the property scope before changing property settings.

RELATED LINKS
Large selections on page 389
Local vs. global properties on page 561
Resetting the appearance of items on page 401
Resetting the position of items on page 401

Engrave mode
Engrave mode is not available in Dorico SE. Engrave mode provides finer controls over the 
appearance of your music, such as positioning items graphically wherever you want and 
creating/editing page templates that determine the appearance and layout of pages.

Page templates
Page templates in Dorico SE allow you to achieve consistent page formatting by applying the 
same arrangements of frames to multiple pages and in different layouts.

NOTE

You can set the page size, margins, page orientation, and staff size for each layout in Layout 
Options.

All pages in your scores and parts inherit their default formatting from page templates.

Dorico SE provides different types of page templates so that there is appropriate page 
formatting for first pages independently of subsequent pages, as the first page typically includes 
additional information, such as the title, composer, and copyright. Dorico SE uses tokens to 
display this additional information.

Page templates are contained in page template sets. By default, Dorico SE provides separate 
page template sets for full score and part layouts. Page template sets are automatically applied 
to every layout that you create.
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NOTE

● In Dorico SE, you cannot edit page templates or create new ones; this is only available in 
Dorico Pro.

● Changing individual pages in layouts is considered a page template override in Dorico SE. 
This includes, for example, editing the title or running header in Write mode. Pages with 
page template overrides are not automatically deleted, even if they are empty because the 
layout became shorter.

If you want to change the information shown at the tops of pages, that is, the title and 
running header text that you cannot select, we recommend that you do so in the Project 
Info dialog to avoid page template overrides. The big title at the top of the first page is the 
project title. The running header on subsequent pages uses the flow title for the top flow on 
that page in scores, and the layout name in parts.

RELATED LINKS
Types of page templates on page 549
Layout Options dialog on page 622
Flow headings on page 550
Project Info dialog on page 70
Tokens on page 552
Applying page template sets to layouts on page 511
Page formatting on page 508
Project templates on page 73

Page template sets
In Dorico SE, page templates are provided as parts of page template sets. Page template sets 
group page templates and flow headings together, so there is suitable page formatting available 
for all possible situations in your project.

New projects contain the following page template sets by default:

● Default Full Score: Used for full score and custom score layouts by default.

● Default Part: Used for part layouts by default.

The default page template sets contain page templates for first (First) and subsequent (Default) 
pages.

Page template sets also contain flow headings that allow you to show flow titles above the start 
of each flow automatically, including when they start on the same page as a previous flow. The 
default page template sets each contain a single flow heading.

The default page template sets are applied automatically to the appropriate layouts in each new 
project. You can apply different page template sets to each layout independently.

NOTE

In Dorico SE, you cannot edit page template sets or create new ones; this is only available in 
Dorico Pro.

RELATED LINKS
Flow headings on page 550
Applying page template sets to layouts on page 511
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Types of page templates
Page template sets contain different types of page templates, which are used in different 
circumstances. For example, First page templates are usually used for the first page of music 
in a layout.

In Dorico SE, there are the following types of page templates:

First

A page template that is usually used for the first page of music in a layout. It contains a single 
large music frame and multiple text frames to display information, such as the project title and 
composer.

First page template open in the page template editor

The First page template contains the following tokens in text frames:

1 Layout name (Default Part page template set only)

2 Project title

3 Project lyricist

4 Project composer

5 Project copyright

Default

A page template that is usually used for the second page of music onwards. It contains a single 
large music frame and text frames to show the running header and page number.
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Default page template open in the page template editor

The Default page template contains the following tokens in text frames:

1 Page number

2 Default Full Score page template set: Flow title (optionally Project title for projects created 
from the Hub with Project will use multiple flows deactivated)

Default Part page template set: Layout name

RELATED LINKS
Project Info dialog on page 70
Tokens on page 552
Page template sets on page 548
Changing when the First page template is used on page 520
Changing flow titles on page 165
Flow headings on page 550
Hub on page 64

Flow headings
Flow headings allow you to show the titles of flows immediately above their first system 
automatically. They function like templates, in much the same way as page templates, allowing 
the same flow heading formatting to be applied to multiple flows in different layouts.

Flow headings exist as part of page template sets. By default, Dorico SE provides one flow 
heading in each page template set, which contains tokens to display the flow number and flow 
title; in a new project, this appears as “1. Flow 1”. This is used automatically for all flow headings.

NOTE

In Dorico SE, you cannot edit flow headings or create new ones; this is only available in Dorico 
Pro.
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A flow heading above the third flow in a part layout

Flow headings are automatically inserted inside music frames above the first system of the flow 
to which they apply, meaning they do not have a fixed vertical position on the page like other 
frames and follow the music if it moves. They also occupy vertical space within music frames. You 
can change the margins for the space above and below flow headings.

NOTE

Changing individual flow headings in layouts is considered a page template override in Dorico 
SE. This includes, for example, deleting a token from a flow heading. Pages with page template 
overrides are not automatically deleted, even if they are empty because the layout became 
shorter.

RELATED LINKS
Tacets on page 541
Hiding/Showing flow headings on page 521
Changing the margins above/below flow headings on page 525
Hiding/Showing information in running headers above flow headings on page 521
Margins on page 524
Frames on page 551
Tokens on page 552

Frames
Dorico uses boxes called frames to position music, additional text, and graphics inside the 
margins of pages. In Dorico SE, you cannot input or edit frames, but frames on page templates 
control the formatting of pages in your project.

In Dorico SE, there are the following types of frames:

Music frames
Music frames display the music of selected players and flows or blank staves.

A music frame displaying the start of a piano piece

Text frames
Text frames display text, which you can enter directly or by using tokens.

A text frame displaying a project title, "Sechs Lieder"
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Graphics frames
Graphics frames display the images that you load into them, which can be in a variety 
of formats.

A graphics frame with image loaded

EXAMPLE

The first page of a piano piece. It contains a music frame, text frames for the title, dedication, and composer, 
a flow heading frame inside the top of the music frame, and graphics frames in the top corners.

RELATED LINKS
Flows in Dorico on page 19
Layouts in Dorico on page 23
Frame breaks on page 539
Tokens on page 552
Page templates on page 547
Flow headings on page 550
Changing page margins on page 511

Tokens
Tokens are codes that you can use as substitutes for information stored in your project, such 
as titles, composers, and the time and date. This can reduce the risk of mistakes or outdated 
information appearing in your project. Tokens are also known as “wildcards” or “text codes”.

For example, if you use a token for the title of your project, you can change the project title in the 
Project Info dialog as often as you want, and the project title in every layout in your project is 
updated automatically.

Tokens can refer to information in the Project Info dialog, including for the whole project or 
each flow individually. Tokens can also refer to the current time and date or the time and date 
the project was last saved.
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NOTE

● You can only use tokens in text frames. You cannot use tokens in text items. Full text frame 
functionality is only available in Dorico Pro, but we have included the available tokens for 
your reference.

● Flow tokens refer to the nearest flow below the top edge of their text frame and on the same 
page. When the top edge of a text frame containing a flow token is in line with or above the 
top staff line of the first staff in a system, it then refers to that flow.

You can specify the flow number to which you want flow tokens to refer, such as 
{@flow2title@}. This always shows the specified flow, regardless of the token’s position.

You can see the flow number of each flow in the Flows panel in Setup mode.

● You can access all the available tokens from the context menu when the cursor is inside a 
text frame. In the context menu, tokens are organized into submenus.

The following tokens are available in Dorico SE:

General tokens

Description Token

Project file name {@projectfilename@}

Path to the project’s save location, including 
the project file name

{@projectfilepath@}

Player tokens

Description Token

Player list {@playerlist@}

Player names {@playernames@}

Layout tokens

Description Token

Layout name {@layoutname@}

Layout number, as set in the Layouts panel in 
Setup mode

{@layoutnumber@}

Layout transposition

NOTE

Uses your instrument language setting.

{@layouttransposition@}
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Staff label tokens

Music symbol Token

Full staff labels of the players in the current 
layout

{@staffLabelsFull@}

Abbreviated staff labels of the players in the 
current layout

{@staffLabelsShort@}

NOTE

● You can use staff label tokens as an alternative way to name part layouts, instead of using 
the default {@layoutName@} token shown at the top left of the first page in part layouts.

● Staff label tokens might not exactly match the appearance of staff labels shown before initial 
barlines; however, staff label tokens respect your per-layout options for how transpositions 
appear in staff labels.

Music symbol tokens

Music symbol Token

Flat accidental: ♭ {@flat@}

Sharp accidental: ♯ {@sharp@}

Natural accidental: ♮ {@natural@}

Treble clef (G clef) {@gClef@}

Bass clef (F clef) {@fClef@}

Alto clef (C clef) {@cClef@}

Fermata above {@U+E4C0@}

TIP

● This list is not comprehensive, as you can enter the code point for any SMuFL symbol within 
a token. You can find the necessary code points in the SMuFL specification online.

● Music symbol tokens in text frames automatically use the Music text character style, which 
is set to Bravura Text by default.

● You can include music symbol tokens in fields in the Project Info dialog. For example, if you 
enter Symphony in B{@flat@} major into the Title field, the title displayed in text frames 
using the corresponding title token is Symphony in B♭ major.

● You can also enter music symbols in text items and text frames using the Insert Music Text 
dialog.
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Project/Flow information tokens

Field in the Project Info 
dialog

Token for Project page Token for Flow pages

Title {@projecttitle@} {@flowtitle@}

Subtitle {@projectsubtitle@} {@flowsubtitle@}

Dedication {@projectdedication@} {@flowdedication@}

Composer {@projectcomposer@} {@flowcomposer@}

Arranger {@projectarranger@} {@flowarranger@}

Lyricist {@projectlyricist@} {@flowlyricist@}

Artist {@projectartist@} {@flowartist@}

Copyist {@projectcopyist@} {@flowcopyist@}

Publisher {@projectpublisher@} {@flowpublisher@}

Editor {@projecteditor@} {@floweditor@}

Copyright {@projectcopyright@} {@flowcopyright@}

Work number {@projectworknumber@} {@flowworknumber@}

Composer dates {@projectcomposerdates@} {@flowcomposerdates@}

Composition year {@projectcompositionyear@} {@flowcompositionyear@}

Other information {@projectotherinfo@} {@flowotherinfo@}

Flow tokens

Per-flow token function Token

Flow number of the current flow, according to its 
position in the project

{@flownumber@}

Flow number of the current flow, according to its 
position in the current layout

{@flowInLayoutNumber@}

Flow number of the current flow shown in lower case 
Roman numerals, such as iii or xvi

{@flowNumberRomanLower@}
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Per-flow token function Token

Flow number of the current flow shown in upper case 
Roman numerals, such as III or XVI

{@flowNumberRomanUpper@}

Duration of the current flow in minutes and seconds, 
using smart quotes

{@flowDuration@}

Duration of the current flow in minutes and seconds, 
using straight quotes

{@flowDurationStraightQuotes@}

Duration of the current flow in minutes and seconds, 
using primes

{@flowDurationPrimes@}

Duration of the specified flow “n” in minutes and 
seconds, such as {@flow3Duration@}

{@flownDuration@}, 
{@flownDurationStraightQuotes@}
, or {@flownDurationPrimes@}

Page number tokens

Page number token function Token

Page number {@page@}

Total number of pages in the layout {@pageCount@}

Number of this page within the current flow, counting 
from 1 for the first page of the flow and including pages 
with no displayed page number

{@flowPage@}

Total number of pages in the current flow {@flowPageCount@}

The displayed page number on which the specified flow 
“n” begins, such as {@flow3FirstPage@}

{@flownFirstPage@}

NOTE

{@flowPage@} and {@flowPageCount@} tokens only consider the flow that is active at the 
beginning of the first system of the music frame closest to the top left corner of the page on 
which the tokens are used.

Time/Date tokens: project last saved

Time/Date description Time/Date example Token

Standard date and time string 
(locale dependent)

Sun Dec 31 11:10:12 2017 {@projectdate@}
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Time/Date description Time/Date example Token

Four-digit year 2017 {@projectdateyear@}

Two-digit year 17 {@projectdateyearshort@}

Full month name (locale 
dependent)

October {@projectdatemonth@}

Short month name (locale 
dependent)

Oct {@projectdatemonthshort@}

Month as a decimal number, 
range 1-12

10 {@projectdatemonthnum@}

Full weekday name (locale 
dependent)

Friday {@projectdateday@}

Abbreviated weekday name 
(locale dependent)

Fri {@projectdatedayshort@}

Day of month as decimal 
number, range 1-31

24 {@projectdatedaynum@}

ISO 8601 date 2017-12-31 {@projectdateymd@}

Month day, year December 31, 2017 {@projectdatemdy@}

Day month year 31 December 2017 {@projectdatedmy@}

Time representation (locale 
dependent)

11:10:12 {@projectdatetime@}

Hours:minutes, hour in 24-
hour clock range

23:10 {@projectdatetimeHHMM@}

Hours:minutes:seconds, hour 
in 24-hour clock range

13:02:24 {@projectdatetimeHHMMSS@}

Hour in 24-hour clock range 23 {@projectdatetimehour24@}

Hour in 12-hour clock range 11 {@projectdatetimehour12@}

Minute as decimal number, 
range 00-59

10 {@projectdatetimeminute@}

Second as decimal number, 
range 00-59

44 {@projectdatetimesecond@}
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Time/Date tokens: current time and date

Time/Date description Time/Date example Token

Standard date and time string 
(locale dependent)

Sun Dec 31 11:10:12 2017 {@date@}

Four-digit year 2017 {@dateyear@}

Two-digit year 17 {@dateyearshort@}

Full month name (locale 
dependent)

October {@datemonth@}

Short month name (locale 
dependent)

Oct {@datemonthshort@}

Month as a decimal number, 
range 1-12

10 {@datemonthnum@}

Full weekday name (locale 
dependent)

Friday {@dateday@}

Abbreviated weekday name 
(locale dependent)

Fri {@datedayshort@}

Day of month as decimal 
number, range 1-31

24 {@datedaynum@}

ISO 8601 date 2017-12-31 {@dateymd@}

Month day, year December 31, 2017 {@datemdy@}

Day month year 31 December 2017 {@datedmy@}

Time representation (locale 
dependent)

11:10:12 {@datetime@}

Hours:minutes, hour in 24-
hour clock range

23:10 {@datetimeHHMM@}

Hours:minutes:seconds, hour 
in 24-hour clock range

13:02:24 {@datetimeHHMMSS@}

Hour in 24-hour clock range 23 {@datetimehour24@}

Hour in 12-hour clock range 11 {@datetimehour12@}

Minute as decimal number, 
range 00-59

10 {@datetimeminute@}
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Time/Date description Time/Date example Token

Second as decimal number, 
range 00-59

44 {@datetimesecond@}

RELATED LINKS
Project Info dialog on page 70
Player, layout, and instrument names on page 158
Flow names and flow titles on page 164
Insert Music Text dialog on page 358
Renumbering layouts on page 156
Reordering flows on page 150
Instrument transpositions in staff labels on page 1033
Concert vs. transposed pitch on page 155
Editing layout transposition text on page 801

Music frame chains
A music frame chain is a collection of music frames that show the same selection of music in a 
set order, often in sequence. Music frame chains can include any number of frames, including 
only a single music frame.

The default page templates contain a single frame chain that is set to display all flows and all 
players in the layout. Therefore, Dorico SE automatically creates enough pages and frames to 
display all flows in all the layouts that use those page templates.

NOTE

In Dorico SE, you cannot create new frame chains or change the flows and players assigned to 
frame chains; this is only available in Dorico Pro.

RELATED LINKS
Page templates on page 547
Layouts in Dorico on page 23
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Properties

Properties are settings that apply to individual notes and items and allow you to edit them, such 
as by changing their appearance or position. You can access properties in the Properties panel.

Properties can affect items only in the current layout and frame chain, known as “local 
properties”, or in all layouts and frame chains, known as “global properties”.

Properties panel
The Properties panel in Write mode provides options that allow you to edit individual notes and 
notations, such as by changing their appearance or position. It is located in the lower zone at the 
bottom of the window in Write mode.

● You can show the Properties panel by showing the lower zone, then clicking Properties  in 
the lower zone toolbar.

The Properties panel contains a group of properties for each notation item. When you select a 
note or item in the music area, the Properties panel displays the groups and options that you 
might require to edit the selected note or item. If there are more available groups than can fit in 
the panel simultaneously, you can scroll to the right/left along the displayed groups.

NOTE

● If you select multiple different types of notation items, only the groups that they have in 
common are displayed. For example, if you select a slur, the Common and Slurs groups are 
displayed in the Properties panel. However, if you select a slur and a note, only the Common 
group is displayed.

● If the property scope is set to Locally, changing local properties only affects the current 
layout and frame chain. You can set the property scope to Globally if you want subsequent 
changes to local properties to affect all layouts and frame chains. You can also copy property 
changes to other layouts and frame chains later.

● You can only change the properties of complete notes and items. For example, you can only 
change the line style of whole pedal lines, even if they extend across multiple systems.

● You can activate properties by clicking their activation switch or property name.

Properties panel in Write mode, filtered by a search term

The Properties panel toolbar contains the following options:
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Search
Allows you to filter properties according to your entry.

Show (active status)
Allows you to filter properties according to their activated status.

● Active: Shows only activated properties.

● All: Shows all properties.

Show (property scope)
Allows you to filter properties according to their property scope.

● Local Only: Shows only local properties.

● Global Only: Shows only global properties.

● All: Shows all properties.

Set local properties
Allows you to change the scope of subsequent local properties you change.

● Locally: Local properties only take effect locally.

● Globally: Local properties take effect globally.

RELATED LINKS
Project window in Write mode on page 172
Hiding/Showing zones on page 41
Copying property settings to other layouts/frame chains on page 547
Changing your preferred unit of measurement on page 48
Resetting the appearance of items on page 401
Resetting the position of items on page 401

Local vs. global properties
Properties can affect items either in the current layout and frame chain only or in all layouts and 
frame chains. This allows you to have the same items appear differently in different layouts, such 
as if you want to show gradual dynamics as hairpins in part layouts but as “cresc.” text in full 
score layouts.

Local properties
Local properties are layout- and frame chain-specific. By default, changing local 
properties for an item in one layout does not affect the same item in other layouts 
or other frame chains.

You can force local properties to apply globally by changing the property scope in 
the Properties panel to Globally before changing their setting. Local properties that 
have been set globally appear with a bolder font in the Properties panel than local 
properties that have been set locally. You can also show only local properties in the 
Properties panel by using the property scope filter.

NOTE

Changing local properties with the property scope set to Globally overrides any local 
settings for those properties for the selected notes or items in other layouts.

Global properties
Global properties affect items in all layouts and frame chains, including new layouts 
you subsequently create. They appear with a bolder font in the Properties panel than 
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local properties. You can also show only global properties in the Properties panel by 
using the property scope filter.

RELATED LINKS
Layouts on page 151
Music frame chains on page 559
Copying property settings to other layouts/frame chains on page 547

Changing the property scope
You can change the property scope of local properties; for example, if you want the subsequent 
properties you change to affect all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

● In the Properties panel, choose one of the following options for Set local properties:

● Locally

● Globally

RESULT
The property scope is changed. All subsequent local properties you change take effect only in 
the current layout and frame chain if you chose Locally, or in all layouts and frame chains if you 
chose Globally.

NOTE

● This only applies to subsequent properties you change. If you want to change the property 
scope of existing properties, you can copy property settings to other layouts and frame 
chains.

● You can change the default property scope for all future projects on the Note Input and 
Editing page in Preferences.

RELATED LINKS
Copying property settings to other layouts/frame chains on page 547
Preferences dialog on page 53

Changing values in numeric value fields
You can change the values in numeric value fields in multiple different ways, such as doubling or 
halving the existing values. In Dorico SE, value fields are most commonly used in the Properties 
panel and in options dialogs.

Numeric value fields have up/down buttons. They are also known as “spin boxes”.

A numeric value field in the Properties panel
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PREREQUISITE
For value fields that are only accessible when their corresponding property/option is activated, 
you have activated their property/option.

PROCEDURE

● Change the value in numeric value fields in any of the following ways:

● Enter a number directly.

● To increase/decrease the value by 1/8 space, click the up/down buttons.

● To increase/decrease the value by 1/32 space, Ctrl/Cmd - Shift -click the up/down 
buttons.

● To increase/decrease the value by 1/2 space, Shift -click the up/down buttons.

● To increase/decrease the value by 1 space, Ctrl/Cmd -click the up/down buttons.

● To increase the current value by a specific amount, enter += followed by the amount into 
the spin box. For example, enter +=2 to increase the current value by two.

● To decrease the current value by a specific amount, enter -= followed by the amount into 
the spin box. For example, enter -=3.5 to decrease the current value by three and a half.

● To multiply the current value by a specific amount, enter * followed by the amount into 
the spin box. For example, enter *3 to triple the current value.

● To divide the current value by a specific amount, enter / followed by the amount into the 
spin box. For example, enter /2 to halve the current value.

NOTE

You must replace the existing value with your calculation entry.

RELATED LINKS
Layout Options dialog on page 622
Changing your preferred unit of measurement on page 48
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Key Editor

The Key Editor is a MIDI editor that comprises multiple components. It allows you to edit notes 
and other playback items, including note velocity, MIDI CC, and tempo. You can access the Key 
Editor in the Key Editor panel in the lower zone.

The Key Editor contains the following editors, which you can show in different combinations:

● Piano roll editor

● Percussion editor

● Playing Techniques editor

● Velocity editor

● Dynamics editor

● MIDI Pitch Bend editor

● MIDI CC editor

● Tempo editor

The Key Editor also provides different tools and controls, according to the requirements of each 
editor.

RELATED LINKS
Piano roll editor on page 575
Percussion editor on page 576
Playing Techniques editor on page 586
Velocity editor on page 587
Dynamics editor on page 590
MIDI Pitch Bend editor on page 595
MIDI CC editor on page 596
Tempo editor on page 601
Histogram tool on page 604

Key Editor panel
The Key Editor panel allows you to view and edit notes, either in a continuous piano roll for 
pitched instruments or in the percussion editor for unpitched instruments. It is located in the 
lower zone at the bottom of the window in Write mode and Play mode.

● You can show the Key Editor panel by showing the lower zone, then clicking Key Editor  in 
the lower zone toolbar.

By default, the Key Editor displays the instrument on whose staff you have selected an item. 
However, you can also select the instruments you want to show in the Key Editor manually.
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1 Key Editor panel toolbar

Contains tools that allow you to select and edit notes and items in the Key Editor.

2 Key Editor ruler

Displays bar numbers and shows beat divisions that match the current rhythmic grid 
resolution.

3 Playhead

Shows the current rhythmic position in playback.

4 Header

Displays the name of each editor and can contain further options, according to the editor.

5 Primary editor

Contains either the piano roll editor, percussion editor, or Tempo editor, depending on your 
most recent selection and whether the Key Editor is locked.

6 Playing Techniques editor

Displays where playing techniques are in use for the corresponding instrument or voice. 
Only available when a single instrument/voice is shown in the Key Editor.

7 Additional editors

You can add/close multiple additional editors below the piano roll/percussion editor, such 
as the Velocity and MIDI CC editors. You can save configurations of editors for use in other 
projects.

8 Add Editor

Allows you to add additional editors to the Key Editor.

9 Presets

Allows you to save, apply, and delete Key Editor configurations.

10 Zoom controls

Allow you to change the zoom manually, such as making notes wider and/or taller.

11 Scroll bars

Allow you to scroll vertically and horizontally in the Key Editor.

RELATED LINKS
Hiding/Showing zones on page 41
Track overview on page 440
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Voices on page 1134
Rhythmic grid on page 190
Changing the Key Editor rhythmic grid resolution on page 571
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568
Key Editor configurations on page 609
Played vs. notated note durations on page 584
Histogram tool on page 604
Transform tool on page 608

Key Editor panel toolbar
The Key Editor panel toolbar contains tools that allow you to select and edit notes and items in 
the Key Editor. It is located at the top of the Key Editor panel in the lower zone.

Select

Allows you to select items in the Key Editor, such as notes in the piano roll editor 
or velocity bars in the Velocity editor, including by clicking and dragging marquee 
selections.

You can also select Select by pressing Shift-Alt/Opt-1 .

Draw

Allows you to input notes in the piano roll and percussion editors. The end positions 
and minimum durations of notes follow the current Key Editor rhythmic grid 
resolution.

You can also select Draw by pressing Shift-Alt/Opt-2 .

Drumstick

Allows you to set a different rhythmic duration for each unpitched percussion 
instrument independently, and input sequences of notes with the corresponding 
duration by clicking and dragging in the percussion editor.

Also allows you to delete notes by clicking them.

Only available in the percussion editor.

You can also select Drumstick by pressing Shift-Alt/Opt-3  when the percussion editor 
is shown.

Line

Allows you to draw straight lines between two points. Not available in the piano roll 
editor or percussion editor.

Transform

Allows you to make Transform selections, and use Transform controls on the selected 
range. Only available in the Velocity and MIDI CC editors.
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Sync Region

Copies data from the primary track to secondary tracks. Only available in the Dynamics 
and MIDI CC editors, and when multiple instruments are shown in the Key Editor.

Delete

Deletes the selected items.

You can also delete selected items by pressing Backspace or Delete .

Played Durations

Allows you to change when notes start/end in playback without affecting their notated 
durations. Displays the played durations of notes as a rectangle, above a thinner line 
that shows their notated duration.

Notated Durations

Allows you to change the rhythmic duration of notes, which affects the position and 
notation of those notes. Displays the full, notated durations of notes as rectangles.

Rhythmic Grid

Allows you to change the rhythmic grid resolution for the Key Editor. The Key Editor 
rhythmic grid resolution affects the minimum duration of the notes you input, the 
number of grid lines, and certain aspects of inputting and editing, such as the amount 
by which you can drag notes to the right/left. The button updates to show the current 
rhythmic grid resolution.

Playing Techniques

Hides/Shows the Playing Techniques editor.

Voice selector

Allows you to select the voice whose notes you want to appear highlighted in the piano 
roll and into which you want to input notes. Automatically updates according to your 
current selection.

When multiple instruments are shown in the Key Editor, only voices belonging to the 
primary instrument are available.

Resize Lower Zone

Allows you to change the height of the lower zone.

TIP

● You can right-click and hold in the Key Editor to access tools in the quick tool selector.
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● You can also select tools by pressing Shift-Alt/Opt-1  to Shift-Alt/Opt-6 . The tool selected 
by each key command depends on the tools currently available in the Key Editor panel 
toolbar, counted from left to right.

RELATED LINKS
Notes in the Key Editor on page 575
Playing Techniques editor on page 586
Velocity editor on page 587
Dynamics editor on page 590
MIDI CC editor on page 596

Showing instruments in the Key Editor
You can show specific instruments in the Key Editor, change the primary instrument, and lock the 
Key Editor to keep those instruments in view. For example, if you want to draw MIDI points for all 
string instruments in your project simultaneously.

By default, the Key Editor is unlocked and follows the current selection in either the music area or 
track overview.

For example, if your most recent selection was a Flute note or the Flute track, that Flute is shown 
in the piano roll editor. If your most recent selection was a tempo mark or the Tempo track, the 
Tempo editor is shown in the Key Editor, provided you had not already added the Tempo editor 
manually.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Your most recently selected item belonged to an instrument, so that either the piano roll or 
percussion editor is shown in the Key Editor.

NOTE

You cannot add editors to the Key Editor when the Tempo editor is the primary editor.

PROCEDURE

1. In the piano roll/percussion editor header, click the instrument menu, then select the 
instrument you want to show as the primary instrument.

2. To lock the Key Editor and keep the selected instrument in view, click Lock Key Editor .
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3. To show multiple instruments in the Key Editor simultaneously, activate View multiple 
instruments.

NOTE

You can only show multiple pitched instruments in the Key Editor. You cannot show multiple 
unpitched percussion instruments, or unpitched percussion instruments in addition to 
pitched instruments.

4. Activate each instrument you want to show in the Key Editor.

5. Optional: Click Make Primary beside the instrument you want to designate as the new 
primary instrument.

RESULT
The Key Editor shows the selected instruments. If you locked the Key Editor, including if you 
optionally selected multiple instruments, it no longer follows your most recent selection.

TIP

You can assign key commands for the following commands on the Key Commands page in 
Preferences:

● Lock Key Editor to Selection automatically shows in the Key Editor the instruments on 
whose staves you have selected notes/items in the music area, and locks the Key Editor to 
that selection.

● Toggle Key Editor Locked View locks/unlocks the Key Editor.

AFTER COMPLETING THIS TASK

● You can view, input, and edit notes, dynamic points, and MIDI points for all the instruments 
shown in the Key Editor.

● You can copy dynamic and MIDI points from the primary instrument to secondary 
instruments.

RELATED LINKS
Hiding/Showing zones on page 41
Adding/Closing editors in the Key Editor on page 572
Piano roll editor on page 575
Percussion editor on page 576
Dynamics editor on page 590
MIDI CC editor on page 596
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MIDI Pitch Bend editor on page 595
Tempo editor on page 601
Track overview on page 440
Enabling independent voice playback on page 460
Copying dynamic points to other instruments on page 594
Copying MIDI points to other instruments on page 600

Changing the height of the Key Editor
You can change the height of the whole Key Editor and each editor within it. For example, you 
can make the piano roll editor taller when inputting notes, and make the Velocity editor taller 
when changing note velocity.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

● Do one of the following:

● To change the height of the whole Key Editor, click and drag Resize Lower Zone  or 
the top edge of the lower zone upwards/downwards.

● To change the height of individual editors, click and drag their splitters 
upwards/downwards. When the mouse pointer is in the correct position, it appears as a 
split arrow.

TIP

You can assign a key command for Cycle Lower Zone Size on the Key Commands page in 
Preferences, which makes the lower zone fill 25%, 50%, then 75% of the project window.

RELATED LINKS
Key Commands page in the Preferences dialog on page 54
Opening multiple project windows on page 46

Zooming in/out of the Key Editor
You can change the zoom level in the Key Editor; for example, you can zoom in vertically and 
horizontally to make notes appear taller and wider in the piano roll editor. This does not affect 
the height of the Key Editor.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

1. Zoom in horizontally in any of the following ways:

● Press H .

● Click Zoom In  at the bottom of the Key Editor.

● Click in the Key Editor ruler and drag upwards.
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● Ctrl/Cmd -scroll upwards in the Key Editor ruler.

2. Zoom out horizontally in any of the following ways:

● Press G .

● Click Zoom Out  at the bottom of the Key Editor.

● Click in the Key Editor ruler and drag downwards.

● Ctrl/Cmd -scroll downwards in the Key Editor ruler.

3. Zoom in vertically in any of the following ways:

● Press Ctrl/Cmd-Shift-H .

● Click Zoom In  on the right of the Key Editor.

● Ctrl/Cmd -scroll upwards in the area to the left of the piano roll/percussion editor.

4. Zoom out vertically in any of the following ways:

● Press Ctrl/Cmd-Shift-G .

● Click Zoom Out  on the right of the Key Editor.

● Ctrl/Cmd -scroll downwards in the keyboard to the left of the piano roll.

RELATED LINKS
Key Editor panel on page 564
Zooming in/out of tracks on page 455
Hiding/Showing zones on page 41

Scrolling in the Key Editor
You can scroll in any direction in the Key Editor; for example, to view higher/lower notes in the 
piano roll editor, or MIDI points in later bars in the MIDI CC editor.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

● In the Key Editor, scroll in any of the following ways:

● Click and drag the sliders on the right and bottom edges of the Key Editor.

● Swipe in any direction on a touchpad.

● To scroll vertically when using a mouse wheel, scroll upwards/downwards.

● To scroll horizontally when using a mouse wheel, Shift -scroll upwards/downwards.

Changing the Key Editor rhythmic grid resolution
You can change the rhythmic grid resolution used for the Key Editor, independently of the 
rhythmic grid used outside of the Key Editor. The Key Editor rhythmic grid resolution affects 
the minimum duration of the notes you input, the number of grid lines, and certain aspects of 
inputting and editing, such as the amount by which you can drag notes to the right/left.

PREREQUISITE

● The lower zone is shown.
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● Key Editor  is selected in the lower zone toolbar.

● If you want to use key commands, your most recent selection must have been in the Key 
Editor panel.

PROCEDURE

● Change the Key Editor rhythmic grid resolution in any of the following ways:

● In the Key Editor panel toolbar, click Rhythmic Grid  and choose the resolution you 
want.

● To decrease the rhythmic grid resolution, press Alt/Opt-] .

● To increase the rhythmic grid resolution, press Alt/Opt-[ .

RELATED LINKS
Rhythmic grid on page 190
Notes in the Key Editor on page 575

Adding/Closing editors in the Key Editor
You can add/close all types of editors in the Key Editor, excluding the piano roll and percussion 
editors. You can also change the editor type shown in an existing editor.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Your most recently selected item belonged to an instrument, so that either the piano roll or 
percussion editor is shown in the Key Editor.

NOTE

You cannot add editors to the Key Editor when the Tempo editor is the primary editor.

PROCEDURE

● Change the editors shown in the Key Editor in one of the following ways:

● To add a new editor, click Add Editor  at the bottom left of the Key Editor.

● To change the editor type shown in an existing editor, click the menu in its header and 
select an editor from the menu.

● To close editors, click Close Editor  in their headers.

AFTER COMPLETING THIS TASK
You can save Key Editor configurations for use in other projects.

Selecting items in the Key Editor
You can select notes and items, such as MIDI or dynamic points, in the Key Editor in the same 
ways.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.
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● You have selected the instruments you want to show in the Key Editor.

● You have added the editors whose points you want to select.

PROCEDURE

1. Select the Select tool in any of the following ways:

● Press Shift-Alt/Opt-1 .

● In the Key Editor panel toolbar, click Select .

● In the Key Editor, right-click and hold to show the quick tool selector, move the mouse 
pointer to Select , then release the mouse.

2. Select notes or items in any of the following ways:

● Click a single note or point.

● Ctrl/Cmd -click or Shift -click multiple notes or points.

● In one editor, click and drag across an area where you want to select everything.

A blue rectangle indicates which notes or points will be selected when you release the 
mouse. We recommend that you click in one corner of the area you want to select and 
drag diagonally across to the other corner.

Copying and pasting points in the Key Editor
You can copy and paste points in the Key Editor, including to other editors and repeating them 
directly after themselves in the same editor. For example, if you want to copy a pattern of MIDI 
points between different MIDI controllers.

NOTE

These steps describe copying/pasting points within/between editors belonging to the same 
instrument. However, you can also copy/paste dynamic and MIDI points between instruments.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the editors whose points you want to copy/paste.

PROCEDURE

1. In one of the open editors, select the points you want to copy.

2. Copy the selected points in any of the following ways:

● Press Ctrl/Cmd-C .

● Choose Edit > Copy.

3. Move the playhead to the position to which you want to paste the selected points.

4. Select the header of the editor into which you want to paste the selected points.

5. Paste the selected points in any of the following ways:

● Press Ctrl/Cmd-V .
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● Choose Edit > Paste.

RESULT
The selected points are copied to the selected position and editor, without deleting them from 
their original positions. They apply to all instruments shown in the Key Editor.

NOTE

● All the points of gradual dynamics and combined/force dynamics input in Write mode are 
copied, even if you only selected a single point.

● You can also repeat points immediately after themselves by selecting them, then pressing R . 
In each repetition, the earliest selected point replaces the last selected point.

● You can also copy points by selecting them, then Alt/Opt -dragging them to the position 
where you want to paste them.

RELATED LINKS
Showing instruments in the Key Editor on page 568
Moving the playhead on page 456
Copying dynamic points to other instruments on page 594
Copying MIDI points to other instruments on page 600

Deleting points in the Key Editor
You can delete selected points from multiple editors simultaneously.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the editors whose points you want to delete.

PROCEDURE

1. In any of the open editors, select the points you want to delete.

TIP

You can select points in multiple editors simultaneously.

2. Delete the selected points in any of the following ways:

● Press Backspace or Delete .

● In the Key Editor panel toolbar, click Delete .

RESULT
The selected points are deleted.

Deleting dynamic points that overrode dynamics input in Write mode reverts those dynamics 
to their default points. Deleting the points of dynamics input in Write mode also deletes the 
corresponding dynamics.

Deleting tempo points also deletes their corresponding tempo marks or tempo mark signposts 
from layouts.
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Notes in the Key Editor
In the Key Editor, notes appear as colored rectangles in either the piano roll editor for pitched 
instruments, or the percussion editor for unpitched percussion instruments and percussion kits.

Piano roll editor
The piano roll editor displays MIDI notes for pitched instruments in a continuous sequence. It is 
located in the Key Editor in the lower zone.

● You can show the piano roll editor by showing a pitched instrument in the Key Editor.

The piano roll editor comprises the following:

1 Instrument menu

Allows you to select the instruments you want to show in the piano roll editor, and to change 
the primary instrument when multiple instruments are shown.

2 Piano keyboard

Provides a reference for pitches.

3 Piano roll

Displays the notes belonging to the instruments shown in the Key Editor. The horizontal 
position of notes indicates their rhythm, and their width indicates their duration. The vertical 
position of notes indicates their pitch. When notes are sufficiently tall and wide, pitches are 
also displayed inside each note.

Instruments are automatically assigned a color according to their player order in the current 
layout, so that you can tell them apart more easily. This color is used consistently for the 
corresponding instrument, including in the Mixer and Key Editor.
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When multiple instruments are shown, notes belonging to the primary instrument appear 
solid and bold in the piano roll editor, while notes belonging to secondary instruments 
appear with gray outlines and pastel colors.

4 Tuplets

Bars and ratios at the top of the piano roll editor indicate tuplets in the active voice.

You can input and edit notes in the piano roll editor, including moving and transposing them. 
This also updates their notation in all applicable layouts.

RELATED LINKS
Played vs. notated note durations on page 584
Showing instruments in the Key Editor on page 568
Track overview on page 440
Mixer on page 612
Tuplets on page 1104
Voices on page 1134
Inputting notes into multiple voices on page 207
Changing the voice of existing notes on page 422

Percussion editor
The percussion editor displays MIDI notes for unpitched percussion instruments in a continuous 
sequence. It is located in the Key Editor in the lower zone.

● You can show the percussion editor by showing an unpitched percussion instrument or 
percussion kit in the Key Editor.

The percussion editor comprises the following:

1 Instrument menu

Allows you to select the instrument you want to show in the percussion editor. You can only 
show one percussion kit or individual percussion instrument at a time.
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2 Percussion instrument names and playing techniques

In the percussion editor, each unpitched percussion instrument has its own row, including 
when they are in a percussion kit. Alternative playing techniques are listed beneath the 
corresponding unpitched percussion instrument.

3 Percussion Rhythmic Grid

Allows you to set a different default note duration for each unpitched percussion instrument 
independently. Only available when the Drumstick  tool is selected.

4 Percussion editor

Displays the notes belonging to the instruments shown in the Key Editor. The vertical 
position of notes indicates their instrument and playing technique, where applicable. The 
horizontal position of notes indicates their rhythm, and their width indicates their duration.

Instruments are automatically assigned a color according to their player order in the current 
layout, so that you can tell them apart more easily. This color is used consistently for 
the corresponding instrument, including in the Mixer and Key Editor. Percussion kits are 
assigned a single color for the whole kit.

RELATED LINKS
Percussion maps on page 643
Showing instruments in the Key Editor on page 568
Inputting notes using the Drumstick tool on page 578
Track overview on page 440
Playing techniques for unpitched percussion instruments on page 1115

Inputting notes in the Key Editor
You can input notes in the Key Editor, in either the piano roll editor for pitched instruments, or in 
the percussion editor for unpitched percussion instruments and percussion kits. Notes you input 
in the Key Editor also appear in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● If you want to input notes into a specific voice for an instrument, you have created that voice 
in Write mode and input at least one note into it.

● You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. Optional: If you want to input notes into a specific voice, select it from the voice selector in 
the Key Editor panel toolbar.

2. Select the Draw tool in any of the following ways:

● Press Shift-Alt/Opt-2 .

● In the Key Editor panel toolbar, click Draw .

● In the Key Editor, right-click and hold to show the quick tool selector, move the mouse 
pointer to Draw , then release the mouse.

3. Click Rhythmic Grid  and choose the default note duration you want.

4. Input notes in any of the following ways:
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● To input single notes with the default note duration, click in the piano roll/percussion 
editor at each rhythmic position where you want to input a note.

● To input notes with any duration, click and drag horizontally in the piano roll/percussion 
editor at the required pitch position and for the required duration.

As you drag, highlights help you to reference durations against the ruler, pitches against 
the piano keyboard in the piano roll editor, and notes against instruments/playing 
techniques in the percussion editor.

RESULT
For pitched instruments, notes are input at the pitches indicated by the piano keyboard on the 
left of the piano roll, and into the active voice indicated by the voice selector in the Key Editor 
panel toolbar.

For unpitched percussion instruments and kits, notes are input into the instrument in the 
corresponding row of the percussion editor.

When you click once, notes are input with the default note duration, set by the Key Editor 
rhythmic grid resolution. When you click and drag, their duration is determined by the width of 
your drag.

AFTER COMPLETING THIS TASK
You can change both the notated and played durations of notes.

RELATED LINKS
Hiding/Showing zones on page 41
Zooming in/out of the Key Editor on page 570
Changing the height of the Key Editor on page 570
Changing the Key Editor rhythmic grid resolution on page 571
Inputting notes into multiple voices on page 207
Changing the voice of existing notes on page 422
Enabling independent voice playback on page 460
Played vs. notated note durations on page 584

Inputting notes using the Drumstick tool
The Drumstick tool allows you to input notes with a different rhythmic duration for each 
unpitched percussion instrument independently.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the unpitched percussion instrument or percussion kit you want to show 
in the Key Editor.
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PROCEDURE

1. Select the Drumstick tool in any of the following ways:

● Press Shift-Alt/Opt-3 .

● In the Key Editor panel toolbar, click Drumstick .

● In the Key Editor, right-click and hold to show the quick tool selector, move the mouse 
pointer to Drumstick , then release the mouse.

2. In the percussion editor header, click Percussion Rhythmic Grid  for each instrument and 
choose its required note duration.

For example, you might set quarter notes for the kick drum, and eighth notes for the hi-hat.

3. Input notes in any of the following ways:

● To input single notes, click in the percussion editor at each rhythmic position where you 
want to input a note.

● To input multiple notes, click and drag horizontally in the percussion editor.

RESULT
Notes are input with the note duration set for the corresponding instrument, either a single note 
per click, or to fill the region in which you clicked and dragged.

TIP

When Drumstick  is selected, you can also delete notes by clicking them.

Moving notes in the Key Editor
You can move notes rhythmically in the Key Editor. This also affects how the selected notes are 
notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In the Key Editor panel toolbar, click Notated Durations  to show notated note durations.

2. In the piano roll/percussion editor, select the notes you want to move rhythmically.

3. Move the selected notes in any of the following ways:

● To move them to the right, press Alt/Opt-Right Arrow .

● To move them to the left, press Alt/Opt-Left Arrow .

● Click and drag them to the right/left.

Key Editor
Notes in the Key Editor 

579
Dorico SE 4.3.30



TIP

As you drag, highlights help you to reference durations against the ruler, pitches against 
the piano keyboard in the piano roll editor, and notes against instruments/playing 
techniques in the percussion editor.

RESULT
The selected notes are moved to new rhythmic positions. If you selected multiple notes, they are 
moved together as a block.

Key commands move notes according to the current rhythmic grid resolution. Clicking and 
dragging moves notes according to the current Key Editor rhythmic grid resolution.

RELATED LINKS
Hiding/Showing zones on page 41
Rhythmic grid on page 190
Changing the Key Editor rhythmic grid resolution on page 571
Moving percussion notes between instruments/playing techniques on page 582

Lengthening/Shortening notes in the Key Editor
You can change the notated duration of notes in the Key Editor. This also affects how the 
selected notes are notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In the Key Editor panel toolbar, click Notated Durations  to show notated note durations.

2. In the piano roll/percussion editor, select the notes you want to lengthen/shorten.

3. Lengthen/Shorten the selected notes in any of the following ways:

● To lengthen notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To double the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Right Arrow .

● To halve the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● Click and drag the right end of one of the selected notes to the length you want.

TIP

As you drag, highlights help you to reference durations against the ruler, pitches against 
the piano keyboard in the piano roll editor, and notes against instruments/playing 
techniques in the percussion editor.
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RESULT
The selected notes are lengthened/shortened.

Key commands lengthen/shorten notes according to the current rhythmic grid resolution. 
Clicking and dragging lengthens/shortens notes according to the current Key Editor rhythmic 
grid resolution.

RELATED LINKS
Selecting items in the Key Editor on page 572
Note durations on page 235
Played vs. notated note durations on page 584
Rhythmic grid on page 190
Changing the Key Editor rhythmic grid resolution on page 571
Enabling independent voice playback on page 460

Transposing notes in the piano roll editor
You can transpose notes in the piano roll editor by moving them vertically to other pitch 
positions. This also affects how the selected notes are notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

PROCEDURE

1. In the piano roll editor, select the notes you want to transpose.

2. Transpose the notes in any of the following ways:

● To move notes up one staff position, such as from C to D, press Alt/Opt-Up Arrow .

● To move notes down one staff position, such as from D to C, press Alt/Opt-
Down Arrow .

● To transpose notes up a single octave division, such as a half-step (semitone) in 12-EDO 
or a quarter tone in 24-EDO, press Shift-Alt/Opt-Up Arrow .

● To transpose notes down a single octave division, such as a half-step (semitone) in 
12-EDO or a quarter tone in 24-EDO, press Shift-Alt/Opt-Down Arrow .

● To transpose notes up an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To transpose notes down an octave, press Ctrl/Cmd-Alt/Opt-Down Arrow .

● Click and drag them upwards/downwards.

TIP

As you drag, highlights help you to reference durations against the ruler, and pitches 
against the piano keyboard.

RESULT
The selected notes are transposed according to their new pitch positions in the piano roll editor.

RELATED LINKS
Hiding/Showing zones on page 41
Equal Division of the Octave (EDO) on page 820
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Transposing tools on page 423

Moving percussion notes between instruments/playing techniques
You can move notes to other instruments and playing techniques in the percussion editor; for 
example, if you want hi-hat notes to be played on a cymbal instead. This also affects how the 
selected notes are notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the unpitched percussion instrument or percussion kit you want to show 
in the Key Editor.

PROCEDURE

1. In the percussion editor, select the notes you want to move to other instruments/playing 
techniques.

2. Move the notes in any of the following ways:

● To move notes to the instrument above, press Alt/Opt-Up Arrow .

● To move notes to the instrument below, press Alt/Opt-Down Arrow .

● To cycle notes upwards through the playing techniques of their current instrument, 
press Shift-Alt/Opt-Up Arrow .

● To cycle notes downwards through the playing techniques of their current instrument, 
press Shift-Alt/Opt-Down Arrow .

● Click and drag them upwards/downwards.

TIP

As you drag, highlights help you to reference durations against the ruler, and notes 
against instruments/playing techniques.

RESULT
The selected notes are moved to the instrument/playing technique in the corresponding row in 
the percussion editor.

RELATED LINKS
Percussion editor on page 576
Playing techniques for unpitched percussion instruments on page 1115

Copying and pasting notes in the Key Editor
You can copy and paste notes in the piano roll and percussion editors, including to other pitched 
instruments and voices, and repeating them directly after themselves.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.
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PROCEDURE

1. In the piano roll/percussion editor, select the notes you want to copy.

2. Copy the selected notes in any of the following ways:

● Press Ctrl/Cmd-C .

● Choose Edit > Copy.

3. Move the playhead to the position to which you want to paste the selected notes.

4. Optional: If you want to paste notes to another instrument, make that instrument the 
primary instrument.

5. Optional: If you want to paste notes into another voice, select that voice from the voice 
selector in the Key Editor toolbar.

6. Paste the selected notes in any of the following ways:

● Press Ctrl/Cmd-V .

● Choose Edit > Paste.

RESULT
The selected notes are copied to the selected position, instrument, and voice, without deleting 
them from their original positions. By default, any MIDI CC points in the copied range are also 
pasted.

TIP

● You can also repeat notes immediately after themselves by selecting them, then pressing R .

● You can also copy notes by selecting them, then Alt/Opt -dragging them to the position 
where you want to paste them.

RELATED LINKS
Moving the playhead on page 456
Disabling automatic copying of MIDI data when pasting on page 417
Copying dynamic points to other instruments on page 594
Copying MIDI points to other instruments on page 600
Copying and pasting notes/items on page 414

Deleting notes in the Key Editor
You can delete notes in the Key Editor. This also removes notes from all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

PROCEDURE

1. Optional: If Select  is selected in the Key Editor panel toolbar, select the notes you want to 
delete in the piano roll/percussion editor.

2. Delete notes in any of the following ways:

● Press Backspace or Delete .

● In the Key Editor panel toolbar, click Delete .
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● In the Key Editor panel toolbar, click Drumstick , then click each note you want to 
delete in the percussion editor.

Played vs. notated note durations
In the Key Editor, you can show notes with their played duration or notated duration.

Played duration

When Played Durations  is selected in the Key Editor panel toolbar, notes in the piano roll/
percussion editor are each shown with two components:

● A filled, light-colored rectangle showing the played duration of the note.

● A thin, darker rod showing the notated duration of the note.

This allows you to change the played, sounding duration of notes. For example, notes with 
staccato articulations are played for less time than their notated duration, whereas notes under 
slurs are played for longer than their notated duration.

Notated duration

When Notated Durations  is selected in the Key Editor panel toolbar, notes in the piano roll/
percussion editor appear as single rectangles whose width corresponds to the notated duration 
of the note. This allows you to change the duration of notes.

EXAMPLE
The following examples all contain the same musical phrase, shown in different ways.

Played duration Notated duration Score

RELATED LINKS
Key Editor panel toolbar on page 566
Slurs in playback on page 1028
Articulations in playback on page 665
Changing the duration of notes on page 236
Lengthening/Shortening notes in the Key Editor on page 580

Changing the played duration of notes
You can change the played duration of notes individually, both at the start and end of notes. For 
example, you can make notes sound for longer, or start sounding later.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.
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● You have selected the instruments you want to show in the Key Editor.

PROCEDURE

1. In the Key Editor panel toolbar, click Played Durations  to show played note durations.

2. In the piano roll/percussion editor, select the notes whose played duration you want to 
change.

3. Click and drag the start or end of one of the notes to the right/left.

When the mouse pointer is in the correct position, it appears as a split arrow.

RESULT
The played duration of the selected notes is changed.

TIP

You can assign key commands for increasing/decreasing playback start/end offsets in 
Preferences > Key Commands > Note Editing. You can use these commands when Played 
Durations  is selected in the Key Editor panel toolbar.

RELATED LINKS
Selecting items in the Key Editor on page 572
Key Commands page in the Preferences dialog on page 54

Resetting playback overrides
You can remove all changes made to how individual notes play back; for example, if you 
previously changed the played duration of notes and want to revert them to their default start 
position, length, and velocity.

Removing playback overrides also removes any offsets to the start and end position of notes 
imported from MIDI files with preserved note positions.

NOTE

Any note velocities that are set on notes are reflected in playback, including from imported MIDI 
files or MIDI recording. If you want dynamics you input in Write mode to be reflected in playback 
instead, you must remove playback overrides.

PROCEDURE

1. Select the notes whose playback overrides you want to reset.

You can do this in the music area, piano roll editor, percussion editor, or Velocity editor.

2. Choose Play > Reset Playback Overrides.

RESULT
All playback overrides are removed from the selected notes.
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RELATED LINKS
Large selections on page 389
Selecting/Deselecting notes and items individually on page 387
Music area on page 32
Piano roll editor on page 575
Percussion editor on page 576
Resetting note velocity on page 589
MIDI recording on page 240
Importing MIDI on page 80
Opening projects/files on page 67

Playing Techniques editor
The Playing Techniques editor displays where playing techniques are in use for the 
corresponding instrument or voice; for example, as a result of inputting playing techniques, 
slurs, or articulations. It is located in the Key Editor in the lower zone.

● You can hide/show the Playing Techniques editor by clicking Playing Techniques  in the 
Key Editor panel toolbar.

NOTE

You can only show the Playing Techniques editor when a single instrument/voice is shown in 
the Key Editor.

The Playing Techniques editor comprises the following:

1 Editor header

Displays the name of the editor.

2 Playing technique regions

Display the playing technique and note length condition that apply to notes in the region. 
You can hover your mouse pointer over playing technique regions to see the following 
related information:

● Any playback techniques, switches, and other effects in place, such as adjustments for 
articulations

● Expression map used for the region

● Channel in the VST or MIDI instrument used for the region

● VST or MIDI instrument used for the region

NOTE

You cannot change playing techniques in the Playing Techniques editor. You can only change 
them in Write mode.
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RELATED LINKS
Hiding/Showing zones on page 41
Playing techniques on page 937
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Playback techniques on page 649
Expression maps on page 625
Showing instruments in the Key Editor on page 568
Moving percussion notes between instruments/playing techniques on page 582
Enabling independent voice playback on page 460

Velocity editor
The velocity editor allows you to view and edit the velocity of notes belonging to the instruments/
voices shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the Velocity editor by adding an editor to the Key Editor, then selecting 
Velocity from the editor menu.

Velocity is often used to control the dynamics of non-sustaining instruments.

The Velocity editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Velocity edit scope: Allows you to change the scope of changes you make to velocity 
values. Only available when Draw , Line , or Transform  is selected in the Key 
Editor panel toolbar.

● All notes: Allows you to edit the velocity of all notes shown in the Velocity editor.

● Selection: Allows you to edit the velocity of selected notes only.

● Histogram : Shows the Histogram tool in the editor.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Velocity bars

Velocities appear as vertical bars in the Velocity editor. Every note has its own velocity bar 
and a velocity value. When multiple notes exist at the same rhythmic position, such as in 
chords, the velocities for all notes appear stacked on top of each other, ordered by their 
value.

Velocity bars with higher values appear with bolder colors.

You can select velocity bars directly in the Velocity editor or by selecting their corresponding 
notes, in either the piano roll editor, percussion editor, or music area.
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TIP

● Clicking and dragging velocity bars causes a read-out to appear temporarily, showing 
their value.

● You can use the Histogram and Transform tools to change velocity values.

RELATED LINKS
Key Editor panel on page 564
Key Editor panel toolbar on page 566
Histogram tool on page 604
Transform tool on page 608
Hiding/Showing zones on page 41
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568
Inputting notes on page 197
Inputting notes into multiple voices on page 207
Inputting notes in the Key Editor on page 577
Voices on page 1134

Changing the velocity of notes
You can change the velocity of notes individually, including for a single note in a chord, or to 
create a consistent increase/decrease in velocity across a range of notes.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the Velocity editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on how you want to change velocities:

● To change the velocity of selected notes, select Select by pressing Shift-Alt/Opt-1  or 
clicking Select  in the Key Editor panel toolbar.

● To change the velocity using free shapes, select Draw by pressing Shift-Alt/Opt-2  or 
clicking Draw  in the Key Editor panel toolbar.

● To change the velocity using consistent slopes, select Line by clicking Line  in the Key 
Editor panel toolbar.

2. Optional: If you selected Select , select the notes whose velocity you want to change, such 
as individual notes in chords. This also selects their velocity bars.

3. Optional: If you selected either the Draw  tool or Line  tool, choose one of the following 
velocity edit scopes in the Velocity editor header:

● All notes

● Selection

4. In the Velocity editor, change the velocity in one of the following ways:

● If you selected Select , click and drag the top of one of the selected velocity bars 
upwards/downwards.
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● If you selected Draw , click and draw any shape across the required range.

● If you selected Line , click and drag a line across the required range.

RESULT
The velocity of the affected notes is changed. If you selected the Selection velocity edit scope, 
this only applies to selected velocity bars.

TIP

You can also use the Transform and Histogram tools to change velocities on a large scale in 
different ways.

Resetting note velocity
You can remove changes you have made to the velocity of notes and reset them to their default 
velocity. You can do this for all notes belonging to an instrument, all notes in a specific voice, or 
only selected notes.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the Velocity editor to the Key Editor.

PROCEDURE

1. In the Velocity editor header, activate Histogram  to show the Histogram tool.

2. At the top of the Histogram tool, choose one of the following filters:

● All notes

● Voice

● Selection

3. Click Reset.

RESULT
Any changes you have made to the velocity of notes in the selected filter are reset.

NOTE

This also resets the played duration of the selected notes.

RELATED LINKS
Histogram tool on page 604
Selecting items in the Key Editor on page 572
Resetting playback overrides on page 585
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Dynamics editor
The Dynamics editor allows you to view, input, and edit dynamics for the instruments/voices 
shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the Dynamics editor by adding an editor to the Key Editor, then selecting 
Dynamics from the editor menu.

The Dynamics editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Sync : Copies all points in the editor from the primary instrument to secondary 
instruments. Only available when multiple instruments are shown in the Key Editor.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Dynamic point

An immediate change in dynamic, input either in Write mode or using the Draw tool in the 
Dynamics editor. Immediate dynamic points are constant by default.

The maximum range of dynamic levels is from 8 to -8, loudest to quietest.

● Dynamic level 3 is equivalent to the dynamic .

● Dynamic level 0 is equivalent to the dynamic .

● Dynamic level -3 is equivalent to the dynamic .

NOTE

● Clicking and dragging dynamic points causes a read-out to appear temporarily, showing 
their dynamic level.

● Only points that are identical for all instruments shown in the Key Editor are editable.

4 Dynamic text

Shows the dynamic level or crescendo/diminuendo symbol of dynamics input in Write mode; 
that is, dynamic points that correspond to notation items.

5 Dynamic region

Blue highlighted regions contain multiple points, input by clicking and dragging in a single 
motion in the Dynamics editor with either the Draw tool or Line tool. By default, dynamic 
points in regions input in the Dynamics editor are linear.

Green highlighted regions represent gradual dynamics and combined/force dynamics, such 
as  and , input in Write mode.

Thin blue bars at the top of the Editor represent dynamic groups.
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NOTE

● Only points that are identical for all instruments shown in the Key Editor are editable.

● Dynamic regions that you input in the Dynamics editor override default playback 
adjustments for dynamics, such as humanization and increased dynamics for notes with 
accents. However, the dynamic curve setting still applies to dynamic regions.

● Default playback adjustments for dynamics, such as humanization and increased 
dynamics for notes with accents, still apply to notes within gradual dynamics that you 
input in Write mode.

● Start and end points for messa di voce regions are linked and always have the same 
value.

● Because the points of combined/force dynamics correspond to parameters of their 
envelopes, they function differently than other dynamic points. Combined dynamics 
have three points, while force dynamics have four points.

For example, if you change the value of the second point of a force dynamic, the third 
point also moves because it controls the duration of the second point; they always have 
the same value. Similarly, you cannot move combined/force dynamic points outside their 
regions.

6 Dynamic value line

When multiple instruments are shown in the Key Editor, a value line is shown for each 
instrument, using its color.

RELATED LINKS
Key Editor panel on page 564
Hiding/Showing zones on page 41
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568
Dynamics on page 746
Groups of dynamics on page 765
Input methods for dynamics on page 284
Changing dynamic levels on page 751
Rhythmic grid on page 190

Inputting dynamic points
You can input single dynamic points and dynamic regions in the Dynamics editor. Dynamic points 
that you input in the Dynamics editor do not appear in layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the Dynamics editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on the type of dynamic points you want to input:

● To input single dynamic points, or dynamic regions containing multiple dynamic points 
at regular intervals, select Draw by pressing Shift-Alt/Opt-2  or clicking Draw  in the 
Key Editor panel toolbar.
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● To input smooth dynamic regions, select Line by clicking Line  in the Key Editor panel 
toolbar.

2. Input dynamic points in one of the following ways:

● To input single dynamic points, click in the Dynamics editor at each position where you 
want a dynamic point.

● To input a dynamic region containing multiple dynamic points at regular intervals, click 
and drag in a single motion in the Dynamics editor.

● To input smooth dynamic regions, click and drag in the Dynamics editor from where you 
want the region to start to where you want it to end.

RESULT
Dynamic points are input for all instruments shown in the Key Editor.

● If you used the Draw tool, separate dynamic points are input at each position you clicked.

● If you clicked and dragged in a single motion using the Draw tool, dynamic points are input 
at 32nd note intervals in a dynamic region.

● If you used the Line tool, two dynamic points are input in a dynamic region, one at each end 
of the dragged range.

By default, dynamic points input using the Draw tool are constant, while dynamic points in 
dynamic regions are linear.

Dynamic regions appear with highlighted regions in the Dynamics editor.

Dynamic points input in the Dynamics editor affect playback, but are not shown in layouts.

NOTE

● Inputting dynamic points/events at the positions of dynamics input in Write mode overrides 
default playback adjustments for those dynamics. Single dynamic points only override the 
dynamic level. Dynamic regions also override, for example, humanization and increased 
dynamics for notes with accents. However, the dynamic curve setting still applies to dynamic 
regions.

● For sound libraries that use MIDI CC 1 to control dynamics, the MIDI CC editor for CC 1 
displays values from the dynamics you input, including dynamic points, combined with 
humanization.

Moving dynamic points
You can move individual dynamic points, including moving them upwards and downwards to 
change their dynamic level. For example, if you want individual dynamics to take effect slightly 
earlier, or to adjust the volume of specific existing dynamics.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added the Dynamics editor to the Key Editor.

PROCEDURE

1. In the Dynamics editor, select the dynamic points you want to move.

Key Editor
Dynamics editor 

592
Dorico SE 4.3.30



TIP

To move dynamics input in Write mode rhythmically, you can select only their start point, 
including for gradual dynamics and combined/force dynamics that have multiple points.

2. Move the selected dynamic points in any of the following ways:

● Click and drag them in any direction.

NOTE

You can only move dynamics input in Write mode either horizontally or vertically at a 
time.

● To move dynamic points to the right/left only, hold Shift  while dragging them to the 
right/left.

● To move dynamic points upwards/downwards only, hold Shift  while dragging them 
upwards/downwards.

● To move a single dynamic input in Write mode to the next notehead on the staff, press 
Alt/Opt-Right Arrow .

● To move a single dynamic input in Write mode to the previous notehead on the staff, 
press Alt/Opt-Left Arrow .

● To move dynamic points to the right according to the current rhythmic grid resolution, 
press Ctrl/Cmd-Alt/Opt-Right Arrow .

● To move dynamic points to the left according to the current rhythmic grid resolution, 
press Ctrl/Cmd-Alt/Opt-Left Arrow .

NOTE

When multiple dynamics are selected, you can only move them according to the current 
rhythmic grid resolution.

RESULT
The selected dynamic points are moved to new positions. Moving them to the right/left affects 
their rhythmic positions. Moving them upwards/downwards affects their dynamic level.

Moving the end points of gradual dynamics to the right/left lengthens/shortens the 
corresponding gradual dynamics rhythmically. Their notated length is automatically updated in 
all applicable layouts.

NOTE

● Moving dynamic points for linked dynamics affects all linked dynamics.

● You cannot drag dynamics input in Write mode beyond other existing dynamic points during 
the same move. Releasing the mouse causes the moved dynamic points to change the value 
of the existing dynamic point.

RELATED LINKS
Linked dynamics on page 767
Gradual dynamics on page 757
Changing dynamic levels on page 751
Lengthening/Shortening items on page 396
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Copying dynamic points to other instruments
When multiple instruments are shown in the Key Editor, you can copy dynamic points from the 
primary instrument to secondary instruments. You can copy only individual points and regions, 
or all points belonging to the primary instrument in the selected flow.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added the Dynamics editor to the Key Editor.

● Multiple instruments are shown in the Key Editor.

PROCEDURE

1. Optional: If you want to sync individual dynamic points or regions only, click Sync Region 
in the Key Editor panel toolbar to select Sync Region.

2. In the Dynamics editor, do one of the following:

● To copy individual dynamic points or regions, click each dynamic point and region, or 
click and drag across multiple dynamic points and regions.

● To copy all dynamic points in the current flow, click Sync  in the editor header.

RESULT
The corresponding dynamic points are copied from the primary instrument to secondary 
instruments, and become editable for all instruments shown in the Key Editor.

Existing dynamic points in the affected regions belonging to secondary instruments are 
overwritten.

TIP

When multiple instruments are shown in the Key Editor, you can input dynamic points for all 
instruments directly.

EXAMPLE

Dynamic region in primary instrument only Dynamic region copied to secondary instruments

RELATED LINKS
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568
Selecting items in the Key Editor on page 572
Switching between flows in the track overview on page 441
Copying and pasting points in the Key Editor on page 573
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MIDI Pitch Bend editor
The MIDI Pitch Bend editor allows you to view, input, and edit MIDI pitch bend controller data for 
the instruments shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the MIDI Pitch Bend editor by adding an editor to the Key Editor, then 
selecting MIDI Pitch Bend from the editor menu.

The MIDI Pitch Bend editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Sync : Copies all points in the editor from the primary instrument to secondary 
instruments. Only available when multiple instruments are shown in the Key Editor.

● Convert to Constant Point : Makes the selected points constant. Only applies to 
points in regions.

● Convert to Linear Point : Makes the selected points linear. Only applies to points in 
regions.

● Value field: Displays the value of the earliest selected MIDI point. You can change this 
value in the value field, or click and drag the point upwards/downwards in the editor. 
The available range for MIDI pitch bend is -100% to +100%.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 MIDI point

A single change to the MIDI pitch, input using the Draw tool. Individual MIDI points are 
constant by default. Only points that are identical for all instruments shown in the Key Editor 
are editable.

4 MIDI region

A highlighted region that contains multiple points, input by clicking and dragging in a single 
motion with either the Draw tool or Line tool.

By default, MIDI points in regions are linear, and the last point is constant. Only points that 
are identical for all instruments shown in the Key Editor are editable.

5 MIDI value line

When multiple instruments are shown in the Key Editor, a value line is shown for each 
instrument, using its color.
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MIDI CC editor
The MIDI CC editor allows you to view, input, and edit data in any MIDI controller for the 
instruments shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the MIDI CC editor by adding an editor to the Key Editor, then selecting a MIDI 
controller from the editor menu.

TIP

● You can add multiple MIDI CC editors to the Key Editor simultaneously; for example, to copy 
MIDI points between two MIDI controllers.

● Dorico SE displays generated values as non-editable value lines. For sound libraries that 
use MIDI CC 1 to control dynamics, the MIDI CC editor for CC 1 displays values from the 
dynamics you input, including dynamic points, combined with humanization.

The MIDI CC editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Histogram : Shows the Histogram tool in the editor.

● Sync : Copies all points in the editor from the primary instrument to secondary 
instruments. Only available when multiple instruments are shown in the Key Editor.

● Convert to Constant Point : Makes the selected points constant. Only applies to 
points in regions.

● Convert to Linear Point : Makes the selected points linear. Only applies to points in 
regions.

● Value field: Displays the value of the earliest selected MIDI point. You can change this 
value in the value field, or click and drag the point upwards/downwards in the editor. 
The available range for MIDI CC is 0 to 127.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 MIDI point

A single change to the MIDI value, input using the Draw tool. Individual MIDI points are 
constant by default. Only points that are identical for all instruments shown in the Key Editor 
are editable.

4 MIDI region

A highlighted region that contains multiple points, input by clicking and dragging in a single 
motion with either the Draw tool or Line tool.
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By default, MIDI points in regions are linear, and the last point is constant. Only points that 
are identical for all instruments shown in the Key Editor are editable.

5 MIDI value line

When multiple instruments are shown in the Key Editor, a value line is shown for each 
instrument, using its color.

TIP

● Clicking and dragging MIDI points causes a read-out to appear temporarily, showing their 
value.

● You can use the Histogram and Transform tools to change MIDI CC values.

● MIDI CC data is included when exporting MIDI files.

RELATED LINKS
Key Editor panel on page 564
Histogram tool on page 604
Transform tool on page 608
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568
MIDI Pitch Bend editor on page 595
Copying and pasting points in the Key Editor on page 573
Exporting MIDI on page 82
Dynamics on page 746
Dynamics editor on page 590
Pedal lines in playback on page 936
Dynamics in playback on page 769

Inputting MIDI points
You can input MIDI CC points into any MIDI controller, including pitch bend, in the MIDI CC and 
MIDI Pitch Bend editors.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on the MIDI points you want to input:

● To input single MIDI points, or MIDI regions containing multiple points at regular 
intervals, select Draw by pressing Shift-Alt/Opt-2  or clicking Draw  in the Key Editor 
panel toolbar.

● To input smooth MIDI regions, select Line by clicking Line  in the Key Editor panel 
toolbar.

2. Input MIDI points in one of the following ways:

● To input single MIDI points, click in the MIDI CC or MIDI Pitch Bend editor at each 
position where you want a MIDI point.
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● To input a MIDI region containing multiple MIDI points at regular intervals, click and 
drag in a single motion in the MIDI CC or MIDI Pitch Bend editor.

● To input smooth MIDI regions, click and drag in the MIDI CC or MIDI Pitch Bend editor 
from where you want the region to start to where you want it to end.

TIP

The horizontal line in the middle of the MIDI Pitch Bend editor represents the unmodified 
pitch.

RESULT
MIDI points are input for all instruments shown in the Key Editor.

● If you used the Draw tool, separate MIDI points are input at each position you clicked.

● If you clicked and dragged in a single motion using the Draw tool, MIDI points are input at 
small intervals in a MIDI region.

● If you used the Line tool, two MIDI points are input in a MIDI region, one at each end of the 
dragged range.

By default, single MIDI points are constant, MIDI points in regions are linear, and the last MIDI 
point in regions is constant.

MIDI regions appear highlighted with colored backgrounds in the MIDI CC and MIDI Pitch Bend 
editors.

Making MIDI points constant/linear
You can make selected MIDI points in regions constant or linear after they have been input; for 
example, if you want some points in a region to be constant.

By default, MIDI points are constant when you input them separately, and linear when you click 
and drag them as a region. The last MIDI point in a region is constant.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

PROCEDURE

1. In the MIDI CC or Pitch Bend editor, select the MIDI points in regions you want to make 
constant/linear.

NOTE

You can only make MIDI points in regions constant/linear.

2. Do one of the following:

● To make the selected points constant, click Convert to Constant Point  in the editor 
header.

● To make the selected points linear, click Convert to Linear Point  in the editor header.
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RESULT
The selected MIDI points become constant or linear.

Value lines always appear horizontal after constant points. Value lines appear angled after linear 
points if the next point has a different value, indicating a smooth transition between the points.

EXAMPLE

Constant points in the MIDI CC editor Linear points in the MIDI CC editor

Moving MIDI points
You can move individual MIDI points in the MIDI CC and MIDI Pitch Bend editors, including 
moving them upwards and downwards to change their values.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

PROCEDURE

1. In the MIDI CC or Pitch Bend editor, select the MIDI points you want to move.

NOTE

You can only move MIDI points in a single editor at a time.

2. Move the selected MIDI points in any of the following ways:

● Click and drag them in any direction.

● To move them upwards/downwards only, hold Shift  while dragging them upwards/
downwards.

● To move them to the right/left only, hold Shift  while dragging them to the right/left.

TIP

You can also move MIDI points according to the current rhythmic grid resolution, as 
indicated in the status bar, by pressing Alt/Opt-Right Arrow / Alt/Opt-Left Arrow .
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Copying MIDI points to other instruments
When multiple instruments are shown in the Key Editor, you can copy MIDI points from the 
primary instrument to secondary instruments. You can copy only individual points and regions, 
or all points belonging to the primary instrument in the selected flow.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

● Multiple instruments are shown in the Key Editor.

PROCEDURE

1. Optional: If you want to sync individual MIDI points or regions only, click Sync Region  in 
the Key Editor panel toolbar to select Sync Region.

2. In the MIDI CC or MIDI Pitch Bend editor, do one of the following:

● To copy individual MIDI points or regions, click each MIDI point and region, or click and 
drag across multiple MIDI points and regions.

● To copy all MIDI points in the current flow, click Sync  in the editor header.

RESULT
The corresponding MIDI points are copied from the primary instrument to secondary 
instruments, and become editable for all instruments shown in the Key Editor.

Existing MIDI points in the affected regions belonging to secondary instruments are overwritten.

TIP

When multiple instruments are shown in the Key Editor, you can input MIDI points for all 
instruments directly.

EXAMPLE

MIDI region in primary instrument only MIDI region copied to secondary instruments

RELATED LINKS
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568
Selecting items in the Key Editor on page 572
Copying and pasting points in the Key Editor on page 573
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Tempo editor
The Tempo editor allows you to view, input, and edit tempo changes. It is located in the Key 
Editor in the lower zone.

You can show the Tempo editor in any of the following ways:

● Add an editor to the Key Editor, then select Tempo from the editor menu.

● When the Key Editor is unlocked, select either a tempo mark or the Tempo track in Play 
mode.

NOTE

This shows the Tempo editor as the primary editor. To return to showing the piano roll/
percussion editor and/or other editors in the Key Editor, you must select a note/item 
belonging to an instrument in the music area.

The Tempo editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Range max. value field: Allows you to set the maximum metronome mark value in the 
editor.

● Tempo value field: Displays the metronome mark value of the earliest selected tempo 
point, without decimal places. You can change this value in the value field, or click and 
drag the point upwards/downwards in the editor.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Tempo point

An immediate change in tempo, input either in Write mode or using the Draw tool in the 
Tempo editor. Absolute tempo changes comprise a single constant point.

TIP

Clicking and dragging in the Tempo editor causes a read-out to appear temporarily, showing 
the metronome mark value of the mouse pointer position.

4 Tempo mark text

Shows the text of tempo marks input in Write mode; that is, tempo points that correspond to 
notation items.

5 Tempo region

A highlighted region with a linear point at the start and a constant point at the end, input by 
clicking and dragging in a single motion in the Tempo editor with the Line tool.
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Tempo regions can also represent gradual tempo changes input in Write mode, such as 
rallentando.

Tempo points input in the Tempo editor appear as signposts in the music. Signposts are not 
printed by default, so if you want tempo points to appear in layouts as tempo marks, we 
recommend that you show them.

All tempo points input in the Tempo editor are included when exporting MIDI files.

RELATED LINKS
Key Editor panel on page 564
Tempo track on page 450
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568
Tempo marks on page 1052
Input methods for tempo marks on page 268

Inputting tempo changes in the Tempo editor
You can input single tempo changes and tempo regions in the Tempo editor. Tempo changes 
input in the Tempo editor do not appear in layouts, but instead are shown as signposts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added the Tempo editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on the type of tempo change you want to input:

● To input single absolute tempo changes, or multiple absolute tempo changes at regular 
intervals, select Draw by pressing Shift-Alt/Opt-2  or clicking Draw  in the Key Editor 
panel toolbar.

● To input tempo regions, select Line by clicking Line  in the Key Editor panel toolbar.

2. Input tempo changes in one of the following ways:

● To input single absolute tempo changes, click in the Tempo editor at each position 
where you want a tempo change.

● To input multiple absolute tempo changes at regular intervals, click and drag in the 
Tempo editor.

● To input tempo regions, click and drag in the Tempo editor from where you want the 
region to start, to where you want it to end.

TIP

Clicking and dragging in the Tempo editor causes a read-out to appear temporarily, showing 
the metronome mark value of the mouse pointer position.

RESULT

● If you used the Draw tool and clicked multiple times, separate tempo changes are input at 
each position you clicked.
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● If you clicked and dragged in a single motion using the Draw tool, tempo changes are input 
at 32nd note intervals.

● If you used the Line tool, two tempo changes are input in a tempo region, one at each end 
of the dragged range.

This affects the speed of playback, but the tempo changes are not shown in layouts. Instead, 
they appear as signposts.

Tempo changes input in the Tempo editor are included when exporting MIDI files.

RELATED LINKS
Key Editor panel toolbar on page 566
Signposts on page 407
Hiding/Showing tempo marks on page 1058

Moving tempo changes in the Tempo editor
You can move tempo changes to new rhythmic positions in the Tempo editor. This affects their 
rhythmic position in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have added the Tempo editor to the Key Editor.

PROCEDURE

1. In the Tempo editor, select the tempo changes you want to move.

2. To move the selected tempo changes without changing their metronome mark value, hold 
Shift  while dragging them to the right/left.

NOTE

You cannot drag tempo regions and single tempo changes input in Write mode beyond 
other existing tempo changes during the same move. Releasing the mouse causes the 
moved tempo change to change the value of the existing tempo change.

RESULT
The selected tempo changes are moved rhythmically. When you move multiple selected absolute 
tempo changes, they maintain their positions relative to each other. This also affects their 
rhythmic positions in any layouts in which they appear.

AFTER COMPLETING THIS TASK
You can also move tempo changes vertically, which changes their metronome mark value.

Changing the tempo in the Tempo editor
You can change the metronome mark value of individual tempo changes in the Tempo editor, 
expressed in beats per minute.

PREREQUISITE

● The lower zone is shown.
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● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have added the Tempo editor to the Key Editor.

PROCEDURE

1. In the Tempo editor, select the tempo changes whose metronome mark values you want to 
change.

2. To change the metronome mark values of the selected tempo changes without moving them 
rhythmically, hold Shift  while dragging them upwards/downwards.

Clicking and dragging in the Tempo editor causes a read-out to appear temporarily, showing 
the metronome mark value of the mouse pointer position.

RESULT
The metronome mark values of the selected tempo changes are changed proportionally. This 
affects the speed of playback, and the displayed metronome mark of any tempo changes also 
shown in layouts.

TIP

You can also change the metronome mark value of selected tempo changes using the Tempo 
value field in the Tempo editor header.

RELATED LINKS
Selecting items in the Key Editor on page 572

Histogram tool
The Histogram tool displays velocity and MIDI CC values as a chart, with values grouped 
according to their frequency distribution. It allows you to change values on a large scale, 
including across entire tracks; for example, increasing all velocity values proportionally.

● You can show the Histogram tool in the Velocity and MIDI CC editors by clicking Histogram 
 in the corresponding editor header.

1 Chart shape

Allows you to change the shape of the Histogram chart.

● Bars : Values are displayed as bars.

● Area : Values are displayed as an area.

2 Histogram filter

Allows you to filter the values shown in the Histogram tool.
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● All/All notes: Shows all values for all instruments currently shown in the Key Editor.

● Voice: Shows only notes in the selected voice. Only available in the Velocity editor.

● Selection: Shows only values for selected items.

3 Histogram chart

Shows values according to the selected filter. The X axis represents numerical values, while 
the Y axis represents the frequency distribution of the corresponding values.

4 Histogram controls

Allow you to change the values currently in view.

5 Reset

Resets all values currently in view.

TIP

If you want to change values on a smaller scale, you can use the Transform tool.

RELATED LINKS
Key Editor panel on page 564
Hiding/Showing zones on page 41
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568
Changing the velocity of notes on page 588
Voices on page 1134
Inputting notes into multiple voices on page 207
Changing the voice of existing notes on page 422
Transform tool on page 608
Velocity editor on page 587
MIDI CC editor on page 596

Histogram controls
Histogram controls allow you to change velocity and MIDI CC values on a large scale, in different 
ways.

● You can access Histogram controls when the Histogram tool is shown in the Key Editor.

Delta

Represents the center point of values. Allows you to move all displayed values to the 
right/left. This maintains explicit gaps between values.

Scale

Proportionally scales values. This maintains proportional relationships between values; 
that is, gaps between values widen when you scale multiply to the right, and narrow 
when you scale multiply to the left.

Spread

Spreads out values to both the right and left of the center point.
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Lower Limit

Represents the lowest value. Allows you to raise low values.

Upper Limit

Represents the highest value. Allows you to lower high values.

Randomize

Allows you to randomize values by clicking on the button and dragging upwards/
downwards. The higher your mouse pointer, the wider and more extreme the 
randomization. Randomization uses standard distribution on an approximate bell-
shape.

Changing values using the Histogram tool
You can use the Histogram tool to change velocity and MIDI CC values on a large scale, including 
across entire tracks; for example, increasing all velocity values proportionally.

TIP

If you want to change values on a smaller scale, you can use the Transform tool.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the header of each editor in which you want to use the Histogram tool, activate 
Histogram  to show the Histogram tool.

2. Optional: Choose the appropriate Histogram tool filter for each editor.

3. Use the available Histogram controls as required.

For example, you can click and drag Scale  to the right to increase the values currently in 
view proportionally.

Changing the Histogram tool filter
You can change the values shown in, and therefore affected by, the Histogram tool using the 
available filters. For example, if you only want the Histogram tool to affect values you have 
already selected.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

Key Editor
Histogram tool 

606
Dorico SE 4.3.30



● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the header of each editor in which you want to use the Histogram tool, activate 
Histogram  to show the Histogram tool.

2. At the top of each Histogram tool, choose one of the following filters:

● All (MIDI CC editor) or All notes (Velocity editor)

● Voice (Velocity editor only)

● Selection

Changing the Histogram chart shape
You can switch between showing values in the Histogram tool as bars or as an area.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the header of each editor in which you want to use the Histogram tool, activate 
Histogram  to show the Histogram tool.

2. At the top of each Histogram tool, choose one of the following chart shapes:

● Bars 

● Area 

RESULT
The shape of the Histogram chart in each editor is changed.

EXAMPLE

Bars Area

RELATED LINKS
Hiding/Showing zones on page 41
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568
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Transform tool
The Transform tool allows you to change consecutive velocity and MIDI CC values within 
a selected range in a variety of ways. For example, you can increase all velocity values 
proportionally, but only in two specific bars.

● You can use the Transform tool in the Velocity and MIDI CC editors by clicking Transform 
in the Key Editor panel toolbar, then clicking and dragging in one of those editors to make a 
Transform selection.

Transform selection in the Velocity editor

TIP

If you want to change values on a larger scale, you can use the Histogram tool.

RELATED LINKS
Key Editor panel on page 564
Key Editor panel toolbar on page 566
Histogram tool on page 604
Velocity editor on page 587
MIDI CC editor on page 596

Transform controls
Transform controls allow you to change consecutive velocity and MIDI CC values within a 
Transform selection in different ways.

● You can access Transform controls when you have made a Transform selection in the Key 
Editor.

Tilt Left

Allows you to lower values according to an angled line by clicking on the button and 
dragging downwards. This lowers values on the left more than on the right.

Tilt Right

Allows you to lower values according to an angled line by clicking on the button and 
dragging downwards. This lowers values on the right more than on the left.

Delta

Represents the center point of values. Allows you to move all displayed values to 
upwards/downwards. This maintains explicit value gaps between bars.

Scale
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Proportionally moves values upwards/downwards. This maintains proportional 
relationships between bars; that is, gaps between bars widen when you scale multiply 
upwards and narrow when you scale multiply downwards.

Randomize

Allows you to randomize values by clicking on the button and dragging upwards. 
The higher your mouse pointer, the wider and more extreme the randomization. 
Randomization uses standard distribution on an approximate bell-shape.

RELATED LINKS
Histogram controls on page 605
Changing the velocity of notes on page 588

Changing values using the Transform tool
You can make Transform selections around consecutive velocity and MIDI CC values, then use 
Transform controls to change the selected values in a variety of ways; for example, increasing all 
values proportionally.

TIP

If you want to change values on a larger scale, you can use the Histogram tool.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments you want to show in the Key Editor.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the Key Editor panel toolbar, click Transform  to select the Transform tool.

2. In the editor in which you want to change values, click and drag across the required range.

3. Use the available Transform controls as required.

For example, you can click and drag Scale  upwards to increase values proportionally.

RELATED LINKS
Hiding/Showing zones on page 41
Key Editor panel toolbar on page 566
Adding/Closing editors in the Key Editor on page 572
Showing instruments in the Key Editor on page 568

Key Editor configurations
Key Editor configurations allow you to open specific combinations of editors simultaneously. This 
can be much quicker than adding/closing the required editors manually.

For example, if you regularly switch between showing the Velocity and Dynamics editors, and 
several MIDI CC editors, you can save Key Editor configurations for these combinations, then 
apply each configuration as required.
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Saving Key Editor configurations
You can save configurations of editors in the Key Editor; for example, if you regularly use the 
Velocity and Dynamics editors together. You can access Key Editor configurations in all projects 
on your computer.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added the editors you want to save in your Key Editor configuration.

PROCEDURE

1. Save the editors currently open in the Key Editor as a Key Editor configuration in one of the 
following ways:

● To save a new Key Editor configuration, click Presets  at the bottom left of the Key 
Editor, then choose Save Configuration.

● To replace an existing Key Editor configuration, click Presets  at the bottom left of the 
Key Editor, choose Replace Configuration, then select the configuration you want to 
replace.

2. If you saved a new Key Editor configuration, enter a name for the configuration in the 
Configuration Name dialog that opens.

3. Click OK to save your changes and close the dialog.

RELATED LINKS
Hiding/Showing zones on page 41
Adding/Closing editors in the Key Editor on page 572

Applying Key Editor configurations
You can apply Key Editor configurations to projects, which adds the editors saved in that 
configuration to the Key Editor and replaces any editors that were already open.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have saved at least one Key Editor configuration on your computer.

PROCEDURE

1. At the bottom left of the Key Editor, click Presets .

2. Select the configuration you want to apply.

Deleting Key Editor configurations
You can delete Key Editor configurations; for example, if you no longer require a specific 
configuration after finishing a project.

PREREQUISITE

● The lower zone is shown.
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● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

1. At the bottom left of the Key Editor, click Presets .

2. Choose Delete Configuration.

3. Select the configuration you want to delete.
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Mixer

The Mixer allows you to control the volume, panning, and sounds of channels in playback.

You can access the Mixer in the following places:

● In the Mixer panel in the lower zone

● In the Mixer window

RELATED LINKS
Mixer window on page 613
Mixer channels on page 614
Zones and panels on page 35

Mixer panel
The Mixer panel allows you to control the volume and panning of channels in playback. It is 
located in the lower zone at the bottom of the window in Write mode and Play mode.

When additional channels are available beyond those currently in view, channels at the right/left 
edges of the Mixer appear faded.

● You can show the Mixer panel by showing the lower zone, then clicking Mixer  in the lower 
zone toolbar.

The Mixer panel toolbar contains the following options:

Channel type buttons
Allow you to hide/show channels according to their type, and in any combination.

Deactivate all
Allows you to deactivate all mute  and solo  states by clicking the corresponding 
button. Indicates whether any channels have an active mute or solo state.

Resize Lower Zone

Allows you to change the height of the lower zone.

RELATED LINKS
Mixer channels on page 614
Zones and panels on page 35
Hiding/Showing zones on page 41
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Mixer window
The Mixer allows you to control the volume, panning, and sounds of channels in playback. It 
provides access to channel strips, which are not available in the Mixer panel.

You can hide/show the Mixer window in any of the following ways:

● Press F3 .

● In the toolbar, click Show Mixer .

The Mixer window comprises the following:

1 Channel type buttons

Allow you to hide/show channels according to their type, and in any combination.

2 Deactivate all

Allows you to deactivate all mute  and solo  states by clicking the corresponding button. 
Indicates whether any channels have an active mute or solo state.

3 Channel strips

Allow you to change the sound of the channel; for example, by loading inserts or changing 
its equalization.

4 Channels

Allow you to change the volume and pan position of the corresponding track or aspect of 
playback. There are audio and MIDI channels for each instrument/voice track, and additional 
channels, such as for the click and master output.

TIP

● In order to control the volume levels in your project, we recommend that you first input 
dynamics and adjust the dynamic curve to suit your project before using the track faders.

● When additional channels are available beyond those currently in view, channels at the right/
left edges of the Mixer appear faded.

Any changes you make in the Mixer window are automatically saved and applied to the project.

RELATED LINKS
Toolbar on page 28
Mixer channel strips on page 616
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Muting/Soloing tracks on page 461
Changing the volume of channels on page 618

Hiding/Showing the Mixer window
You can hide and show the Mixer window at any time; for example, if you do not want it in view 
when working on the music in the music area.

PROCEDURE

● Hide/Show the Mixer window in any of the following ways:

● Press F3 .

● In the toolbar, click Show Mixer .

● Choose Window > Mixer.

Mixer channels
Mixer channels allow the source connected to them, such as instrument tracks, to produce 
sound. You can access all channels in the Mixer panel and Mixer window, and individual channels 
in the Track Inspector for the corresponding track.

Each channel in the Mixer panel provides the following controls and displays:

1 Pan control

Allows you to position the sound/MIDI output of the channel on the stereo spectrum for 
stereo playback.

2 Fader value

Displays the current volume as a value, corresponding to the position of the fader.

● Audio channels use dB.

● MIDI channels use MIDI volume, from 0 to 127.

3 Fader

Allows you to control the volume level of the channel.
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4 Channel meter

Indicates the output volume of the channel in real time.

5 Mute

Allows you to mute the channel. Indicates whether the channel has an active mute state.

6 Solo

Allows you to solo the channel. Indicates whether the channel has an active solo state.

7 Channel name

Displays the name of the channel.

Instrument channels display the full instrument name set for that instrument in the Edit 
Instrument Names dialog and its instrument number, if applicable.

RELATED LINKS
Track Inspector on page 442
Edit Instrument Names dialog on page 161
Instrument numbering on page 115

Types of Mixer channels
There are different types of channels available in the Mixer. The channel type can affect the 
controls available for the corresponding channel.

Instruments
There is a channel for each instrument/voice track in your project. When instrument 
channels are shown, all applicable channels are included, even if they are spread 
across multiple plug-in instances.

There is an additional instrument channel named “DoricoBeep”, which allows you to 
control the volume of the metronome click.

MIDI
Every VST instrument in your project has its own MIDI channel in addition to its VST 
channel. These MIDI channels allow you to change the MIDI volume and MIDI pan of 
each instrument.

Video
Allows you to control the volume of video audio.

FX
Allows you to control the volume of send effects, such as reverb. By default, this 
channel has REVerence loaded automatically.

TIP

For more information about REVerence, see the separate document Plug-in 
Reference.

Output
Allows you to control the master output volume. The Output channel is always shown.
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Mixer channel strips
Each channel in the Mixer has its own channel strip, which contains the channel controls. 
Channel strips are located at the top of the Mixer window.

Each channel strip contains the following types of controls:

Inserts

Each channel has four slots into which you can load an insert. You can select inserts 
from the menu.

The header allows you to expand/collapse the section for all channels.

The indicator can have one of the following states:

● Disabled : No inserts are loaded into the channel.

● Enabled : At least one insert is loaded into the channel, and inserts are enabled.

● Bypassed : At least one insert is loaded into the channel, and all inserts are 
bypassed.

The following controls are available for slots with loaded inserts:

● Enable Insert : Enables/Bypasses the insert slot.

● Edit Insert : Opens the plug-in window for the loaded plug-in, which allows you 
to edit its settings.

● Insert menu : Opens the plug-in menu, which allows you to select a different 
plug-in to load into the insert slot.

TIP

● For more information about the plug-ins included with Dorico SE, see the separate 
document Plug-in Reference.

● You can access inserts for individual channels in the Track Inspector for the 
corresponding track.

EQ

Each channel has four bands for default EQ.
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The indicator allows you to enable  and disable  the section. The header allows you 
to expand/collapse the section for all channels.

The following controls are available for each EQ band:

● Enable EQ : Enables/Bypasses the corresponding band.

● Gain: Sets the amount of attenuation/boost for the corresponding band in dB.

● Frequency: Sets the frequency of the corresponding band in Hz.

● Q: Controls the width of the band; that is, how many frequencies above/below it 
also affects, and by how much.

FX

Each channel has a single FX slot. By default, it sends to the FX channel, which has 
reverb loaded on it.

The indicator allows you to enable  and disable  the section. The header allows you 
to expand/collapse the section for all channels.

RELATED LINKS
Loading inserts into channels on page 620
Track Inspector on page 442

Hiding/Showing channels
You can hide/show channels in the Mixer according to their type; for example, you can hide MIDI 
channels while working on instrument channels.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● At the top of the Mixer, activate/deactivate each channel type.

RESULT
Channels are shown in the Mixer when their type button is activated, and hidden when it is 
deactivated.

Scrolling through channels
When many channels are shown in the Mixer, you can scroll through them in order to view 
channels that do not fit in the view.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, scroll through channels in any of the following ways:
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● Scroll upwards/downwards on a mouse wheel, or swipe upwards/downwards on a 
touchpad.

● Click and drag, anywhere outside of channel faders, to the right/left.

Changing the height of channels
You can change the vertical space occupied by channels and channel strips in the Mixer window; 
for example, to make channel strips taller when loading inserts or changing EQ settings.

PREREQUISITE
The Mixer window is shown.

PROCEDURE

● In the Mixer, on the line between channel strips and channels, click and drag upwards/
downwards.

When the mouse pointer is in the correct position, it appears as a split arrow.

Changing the volume of channels
You can change and reset the volume of individual channels in the Mixer; for example, to balance 
instruments in an orchestral project.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, change the volume of channels in any of the following ways:

● To increase their volume, drag their faders upwards.

● To decrease their volume, drag their faders downwards.

● To reset their volume to the default value, Ctrl/Cmd -click or double-click their fader 
values.

Mixer
Changing the height of channels 

618
Dorico SE 4.3.30



RESULT
The volume of the corresponding channels is changed.

TIP

You can change the default output level for all future projects on the Play page in Preferences. 
By default, this is set to -6 dB to avoid clipping in projects with large ensembles.

RELATED LINKS
Mixer panel on page 612
Mixer window on page 613
Preferences dialog on page 53

Panning channels
You can change the pan position of individual channels on the stereo spectrum; for example, if 
you want the pan positions of instruments in an orchestral project to match their positions on a 
real-life stage.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, click at the required position in the pan control at the top of each channel.

You can also click and drag to the right/left in the pan control.
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Loading inserts into channels
You can load up to four inserts into each channel, excluding MIDI channels. For example, you can 
load specific EQ plug-ins instead of using the default EQ channel strips, and apply amp modeling 
plug-ins to clean guitar channels.

TIP

For more information about the plug-ins included with Dorico SE, see the separate document 
Plug-in Reference.

PREREQUISITE
The Mixer window is shown.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. Click an insert slot and select the plug-in you want to load from the menu.

3. Optional: If you want to edit settings for the new plug-in, click Edit Insert  to open its 
plug-in window.

4. Optional: If you loaded EQ plug-ins, deactivate the EQ channel strip in the corresponding 
channels.

RELATED LINKS
Mixer window on page 613
Mixer channel strips on page 616
Changing the sound used for the click on page 450

Enabling/Bypassing inserts
You can enable/bypass individual inserts without affecting their settings; for example, if you want 
to compare how a channel sounds with and without a specific insert.

PREREQUISITE
The Mixer window is shown.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. In each insert slot you want to enable/bypass, do one of the following:

● To enable/bypass individual inserts, click Enable Insert  in the corresponding slots.

● To enable/bypass all inserts for channels, click the Inserts indicator  in the 
corresponding channel strips.
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RESULT
The corresponding inserts are enabled/bypassed.

● Enabled inserts appear blue.

● Bypassed inserts appear yellow.

Removing inserts
You can remove individual inserts you have loaded into channels.

PREREQUISITE
The Mixer window is shown.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. In the slot whose insert you want to remove, click the insert menu  and select --- from the 
menu.

Changing the reverb plug-in
You can change the plug-in used for reverb on the FX channel; for example, if you want to use a 
specific reverb sound. By default, the reverb plug-in REVerence is loaded into the FX channel.

TIP

For more information about the plug-ins included with Dorico SE, see the separate document 
Plug-in Reference.

PREREQUISITE

● The Mixer window is shown.

● The FX channel is shown.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. In the FX channel strip, click the insert menu  in the REVerence insert slot, and select the 
reverb plug-in you want to use from the menu.

3. Optional: If you want to edit settings for the new plug-in, click Edit Insert  to open its 
plug-in window.

RELATED LINKS
Mixer window on page 613
Mixer channel strips on page 616
Hiding/Showing channels on page 617
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Library

In Dorico SE, the library is the total compilation of visual items and options that are available 
in all projects on your computer. It combines factory default settings, custom items/options you 
have saved as default, and items/options only available in the current project.

Layout Options dialog
The Layout Options dialog allows you to change various aspects of each layout independently. 
For example, you can change the physical properties of the layout, such as page size, staff size, 
or margins, and how the music appears and is laid out, such as note spacing or staff labels.

Options in Layout Options affect only the selected layouts but apply to all flows in those layouts.

You can open Layout Options in any of the following ways:

● Press Ctrl/Cmd-Shift-L .

● Choose Library > Layout Options.

● In Setup mode, click Layout Options  in the Layouts panel.

The Layout Options dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list
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Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match: Allows you to navigate to the previous match on the page. You can also 
navigate to the previous match by pressing Ctrl/Cmd-Shift-G .

● Next match: Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close: Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Layouts list

Contains all the layouts in your project. By default, the layout currently open in the music 
area is selected when you open the dialog. You can select multiple layouts in any of the 
following ways:

● Click one of the selection options in the action bar.

● Ctrl/Cmd -click to select multiple layouts.

● Shift -click to select multiple adjacent layouts.

● Click and drag across multiple layouts.

7 Action bar

Contains selection options that allow you to select layouts in the Layouts list according to 
their type.

● Select All: Selects all layouts, regardless of their type.

● Select All Full Score Layouts : Selects all full score layouts only.

● Select All Part Layouts : Selects all part layouts only.

● Select All Custom Score Layouts : Selects all custom score layouts only.

8 Save as Default

Saves all options currently set and applied in the dialog as the default for the selected layout 
type in new projects. For example, you can save new default settings for part layouts without 
affecting the default settings for full score layouts. Only available when a single layout is 
selected.

9 Reset to Saved Defaults
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Resets all the options in the dialog for the selected layouts back to your saved defaults, 
according to their layout type.

10 Reset to Factory

Resets all the options in the dialog for the selected layouts back to the default factory 
settings, according to their layout type. This only affects the current project and does not 
delete your saved defaults, meaning future projects still start with your saved defaults.

11 Remove Saved Defaults

Deletes your previous saved defaults for the selected layout type without resetting the 
options in the current project. After removing your saved defaults, all layouts of the selected 
type in future projects start with the default factory settings.

RELATED LINKS
Layouts on page 151
Staves on page 1040
Page formatting on page 508
Condensing on page 543
Changing your preferred unit of measurement on page 48
Changing values in numeric value fields on page 562

Music Fonts dialog
The Music Fonts dialog allows you to change the font used for notations and glyphs project-
wide. Any font you use for notations and glyphs must be SMuFL-compliant.

● You can open the Music Fonts dialog by choosing Library > Music Fonts.

The Music Fonts dialog contains all available SMuFL fonts you have installed on your computer 
that have the appropriate metadata for Dorico SE to recognize them. By default, Dorico SE comes 
with the following SMuFL-compliant fonts:

● Bravura: The default music font, inspired by traditional classical music engraving.

● Petaluma: Handwritten music font style, similar to the traditional style used for jazz music.

Changing the music font used in the Music Fonts dialog changes the fonts used for notations, 
glyphs, and other items that are not text, such as clefs, dynamics, and bold tuplet numbers/
ratios.

The Music Fonts dialog also contains the following options:
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Update text fonts when changing music fonts
Allows you to include/exclude text fonts when changing the music font. For example, 
deactivating this option allows you to change the appearance of notes and notations 
without affecting the appearance of flow titles and staff labels.

● For the Bravura music font, the equivalent text font is Academico.

● For the Petaluma music font, the equivalent text font is Petaluma Script.

Use font’s recommended engraving options
Allows you to import the default settings that come with the font.

NOTE

Certain items that are marked as optional in SMuFL fonts, such as clef changes and non-bold 
tuplet numbers/ratios, are not affected when you change the music font.

Expression maps
Expression maps tell Dorico SE how to use appropriately the patches and sounds in the VST 
instruments that you have loaded into your project.

Expressing a range of dynamics on instruments means changing the volume and attack of 
notes. Because the strength of attack changes the character of the start of sounds as well as 
their volume, loud sounds often require stronger attacks and quiet sounds often require softer 
attacks.

Different patches and instruments have different approaches to changing dynamics and volume 
in playback. For example, some patches only change the velocity whereas others use a controller 
in combination with changing the velocity.

Dorico SE also uses expression maps to specify the playback techniques that are supported by 
each patch in your project. For example, string instruments such as the violin have different 
techniques, because they can play arco, pizzicato, and col legno, and their bow position can be 
anywhere between sul ponticello and sul tasto.

In addition to the HALion Symphonic Orchestra expression maps, there are the following 
expression maps in Dorico SE:

● CC11 Dynamics: Uses MIDI controller 11 to play dynamics.

NOTE

This only applies to instruments that can change their dynamic while notes are sounding, 
such as violin or flute.

● Default: Uses note velocity to control dynamic volume.

● Modulation Wheel Dynamics: Uses a modulation wheel to control dynamic volume.

● Transpose down 1 octave: Used by some instrument patches that sound an octave higher 
than written so that they can be played without needing a full range keyboard.

● Transpose up 1 octave: Allows the bottom octave of keyboards to be used for key switches 
instead of notes, but is also used by some bass instrument patches that sound an octave 
lower than written so that they can be played without needing a full range keyboard.

You can edit, create, and import/export expression maps in the Expression Maps dialog. 
Expression maps are saved as .doricolib files.
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NOTE

Although Dorico SE approaches expression maps in a different way to Cubase, Dorico SE 
correctly imports many switches from expression maps you import from Cubase, such as 
pizzicato, harmonics, and flutter tongue.

RELATED LINKS
Percussion maps on page 643
Types of actions on page 638
Creating new expression maps on page 639

Expression Maps dialog
The Expression Maps dialog allows you to create new expression maps, edit existing expression 
maps, and import/export expression maps. You can also import expression maps made in 
Cubase.

● You can open the Expression Maps dialog by choosing Library > Expression Maps.

The Expression Maps dialog contains the following sections and options:
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Expression maps list

1 Expression maps list: Contains the expression maps currently available in your project.

2 Search field: Allows you to filter expression maps according to your entry.

3 Show only expression maps used in this project: Allows you to filter the expression maps 
list so it only includes expression maps used in the current project.

4 Expression maps list action bar: Contains the following options:

● Add Expression Map : Adds a new expression map that contains no existing settings.

● Duplicate Expression Map : Creates a copy of an existing expression map that you 
can edit separately from the original.

● Delete Expression Map : Deletes the selected expression maps.

NOTE

You can only delete custom expression maps. You cannot delete any default expression 
maps.

Expression Map Data

This section allows you to specify identifying information for the selected expression map.

You can hide/show the Expression Map Data section by clicking the section header.

The Expression Map Data section contains the following options:
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Name
Allows you to set the name of the expression map that appears in the program; for 
example, in the Endpoint Setup dialog.

ID
Allows you to set the unique ID of the expression map. You can enter any content in 
the ID field.

It can be useful to include the instrument and sound library for which you created the 
map, as well as your name; for example, xmap.user.paulsmith.hso.violinpizz.

Creator
Allows you to name the creator if you are sharing your expression map with other 
users.

Version
Allows you to indicate the expression map version, so you can identify the most recent 
one.

Plug-ins
Allows you to list the names of plug-ins to which the expression map applies, with each 
name separated by a comma. You can leave this field blank.

Allow multiple notes at same pitch
Allows you to set whether or not the plug-in can treat identical pitches in 
multiple voices belonging to the same instrument as multiple separate notes when 
independent voice playback is disabled.

Description
Allows you to add any other information about the expression map.

NOTE

All fields in the Expression Map Data section are locked by the Lock Info  button. You must 
click this button to unlock Lock Info  in order to change the information in the fields.

Base and Add-on Switches

This section allows you to view, edit, and control the switches for playback techniques in the 
selected expression map.

You can hide/show the Base and Add-on Switches section by clicking the section header.
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The Base and Add-on Switches section contains the following:

1 Switches table: Contains the switches in the currently selected expression map. Allows you 
to add new switches and edit existing ones.

2 Name: Allows you to change the name that appears for the currently selected switch in the 
Switches table; for example, so it appears the same as in your sound library.

TIP

You can still see which playback techniques are triggered by switches with custom names by 
hovering the mouse pointer over the corresponding row in the Switches table.

3 Enabled: Allows you to enable/disable the currently selected switch without removing it from 
the expression map.

4 Actions: Contains any actions required to produce the selected playback technique. Allows 
you to add new actions and edit existing ones.

5 Conditions: Contains any conditions that determine the circumstances in which the currently 
selected switch is used. Allows you to add new conditions and edit existing ones. Only 
available for Base switches.

6 Technique controls: Contains controls that affect the switch currently selected in the 
Switches table. Only available for Base switches.

Switches table

Contains the switches in the currently selected expression map.
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The Switches table comprises the following:

1 Type column: Displays the switch type. Switches can be any of the following types:

● Base

● Add-on

● Init

2 Name column: Displays the name of the switch. By default, this is the same as the playback 
technique or playback technique combination it triggers.

In simple cases, each switch triggers an individual playback technique, such as Staccato 
or Accent. However, some plug-ins have separate samples for different combinations of 
playback techniques. For example, Staccato + Accent might require a separate set of key 
switches to Staccato and Accent individually.

3 Switches table action bar: Contains the following options:

● Add Base Switch : Allows you to add a new base switch to the expression map 
by selecting the playback techniques you want the switch to trigger in the Playback 
Technique Combinations dialog that opens.

● Add Technique Add-on Switch : Allows you to add a new add-on switch to the 
expression map by selecting the playback techniques you want the switch to trigger 
in the Playback Technique Combinations dialog that opens.

● Duplicate Technique : Creates a copy of an existing switch that you can edit 
separately from the original.

● Edit Technique : Opens the Playback Technique Combinations dialog, which allows 
you to edit the combination of playback techniques triggered by the selected switch.

You can also edit the playback techniques of existing switches by double-clicking them in 
the Switches table.

● Audition : Plays two notes using the currently selected switch and any corresponding 
actions to demonstrate their effect on playback. Only available for expression maps used 
in the project.

● Transpose Up 1 Octave : Raises the octave of all key switch actions for the selected 
switch.

● Transpose Down 1 Octave : Lowers the octave of all key switch actions for the 
selected switch.
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● Delete Technique : Deletes the selected switch.

Selecting a switch in the Switches table allows you to edit its controls and actions. Different 
options are available in the Base and Add-on Switches section depending on the switch type.

NOTE

● Most instruments have a “natural” playback technique, which is the most common way 
of playing the instrument. Dorico SE requires every instrument to have a defined natural 
playback technique.

● You can only select one switch at a time in the Switches table.

Actions

Displays in a table any actions required to produce the selected playback technique. Allows you 
to determine how the switch that triggers each playback technique is controlled, either by adding 
new actions or editing existing ones.

NOTE

Depending on your plug-in, multiple types of actions can be required for each switch.

The Actions subsection comprises the following:

1 Middle C (note 60): Allows you to choose the pitch for middle C, as there are different 
conventions for this. We recommend that you consult the documentation for your sound 
libraries to check whether each one considers middle C to be C3, C4, or C5, and change this 
setting accordingly.

2 On events/Off events: Allows you to specify whether actions affect the start or end of notes. 
For example, you might want an event that resets the playback technique back to normal to 
apply only to the end of notes.

On events affects the start of notes. Off events affects the end of notes.

3 Actions table: Contains the following columns:

● First column: Displays the action type. Actions can be a control change, program change, 
or key switch.

● Second column: Controls the first parameter of the MIDI event. For key switches, this 
indicates the pitch. For control changes, this indicates the control change number. For 
program changes, this indicates the program number.

● Third column: Controls the second parameter of the MIDI event. For key switches, this 
indicates the velocity. For control changes, this indicates the amount of control change 
within the range 0 to 127. Program changes do not have a second parameter.
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NOTE

● You can change the values of cells in the Actions table by double-clicking them, or 
selecting them and pressing Return .

● You can only select one action at a time in the Actions table.

4 Actions table action bar: Contains the following options:

● Add Control Change Action : Adds a control change action with default settings.

● Add Program Change Action : Adds a program change action with default settings.

● Add Key Switch Note Action : Adds a key switch action with default settings.

● Add Absolute Channel Change Action: Adds an absolute channel change action with 
default settings.

● Add Relative Channel Change Action: Adds a relative channel change action with 
default settings.

● Duplicate Action : Creates a copy of an existing action that you can edit separately 
from the original.

● Move Action Up : Moves the selected action up the table, which changes its order in 
the message sequence.

● Move Action Down : Moves the selected action down the table, which changes its 
order in the message sequence.

● Delete Action : Deletes the selected action.

Conditions

Displays in a table any conditions that determine the circumstances in which the base switch 
currently selected in the Switches table is used. Allows you to add new conditions and edit 
existing ones. Only available for Base switches.

For example, you can set conditions instructing the expression map to use a different legato 
sound with a quicker attack for short notes than for longer notes automatically.

The Conditions subsection comprises the following:

1 Any of/All of: Allows you to set whether the switch is used when one or more conditions are 
met or only when all conditions are met.

2 Conditions table: Contains the following columns:

● First column: Displays the condition type.

● Second column: Controls how the condition type in the first column relates to the note 
length set in the third column using operators. The following operators are available:

● ==: Equal to
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● !=: Not equal to

● <: Less than

● <=: Less than or equal to

● >: More than

● >=: More than or equal to

● Third column: Controls the note length used by the condition. The following note length 
values are available:

● Very short: A dotted 16th note at 120 bpm, or 0.1875 seconds

● Short: A dotted eighth note at 120 bpm, or 0.375 seconds

● Medium: A dotted quarter note at 120 bpm, or 0.75 seconds

● Long: A dotted half note at 120 bpm, or 1.5 seconds

● Very long: Any longer duration

NOTE

● You can change the values of cells in the Conditions table by double-clicking them, 
or selecting them and pressing Return .

● You can only select one condition at a time in the Conditions table.

3 Conditions action bar: Contains the following options:

● Add Technique : Adds a new technique condition with default settings.

● Duplicate Technique : Creates a copy of an existing technique condition that you can 
edit separately from the original.

● Delete Technique : Deletes the selected technique condition.

Technique controls

Contains controls that affect the base switch currently selected in the Switches table. Only 
available for Base switches.

The following technique controls are available:

● Transpose: Allows you to set the MIDI transposition in half-steps (semitones).

● Length %: Allows you to modify played note durations, which overrides the default value; for 
example, if you want the selected switch to produce short gaps between notes.
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● For notes a quarter note or shorter in duration, the value applies to the entire note.

● For notes longer than a quarter note, the value only applies to the last quarter note of 
their overall duration.

● Volume dynamic: Allows you to choose whether the volume dynamic for the selected switch 
is controlled by its Note velocity or a Control change.

NOTE

If you choose Control change, you must specify the controller by number. You can consult 
the documentation for the VST instrument and/or MIDI controller you are using to find the 
appropriate controller number.

● Volume dynamic Min/Max: Allow you to set the minimum and maximum range for 
dynamics using either note velocity or MIDI CC, depending on the sound library.

● Use Secondary dynamic: Allows you to define an additional volume control for sound 
libraries that use both note velocity and control changes for volume dynamic.

● Secondary dynamic Min/Max: Allow you to set the minimum and maximum range for 
dynamics using either note velocity or MIDI CC, depending on the sound library.

Playback Options Overrides

Allows you to override specific playback options for the selected expression map only. Activating 
a playback option overrides it. The available playback options include the default duration of 
notes with different articulations, unmeasured tremolo notes, and the effect that beat position 
and articulations have on dynamics.

You can hide/show the Playback Options Overrides section by clicking the section header.

Mutual Exclusion Groups

Allows you to define playback techniques that are mutually exclusive; that is, cannot be in use 
concurrently. For example, players cannot play vibrato and non-vibrato at the same time. Putting 
playback techniques into the same exclusion group means only one can be used at a time.
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You can allow Dorico SE to define mutual exclusion groups automatically or define them yourself 
manually.

Mutual exclusion groups apply only to the selected expression map. This allows you to set 
different mutual exclusion groups in each expression map; for example, if one of your sound 
libraries supports a particular playback technique combination for an instrument but another 
sound library does not.

You can hide/show the Mutual Exclusion Groups section by clicking the section header.

The Mutual Exclusion Groups section contains the following options and columns:

1 Auto: Allows Dorico SE to define mutual exclusion groups automatically.

NOTE

Activating Auto permanently deletes any manual exclusion groups you have created.

2 Mutual Exclusion Groups column: Allows you to add and delete mutual exclusion groups 
manually. The action bar at the bottom of the column contains the following options:

● Add : Opens a dialog that allows you to create a new mutual exclusion group and 
enter a name for it.

● Delete : Deletes the selected mutual exclusion group.

NOTE

You can only select one mutual exclusion group at a time.

3 Has techniques column: Allows you to change the playback techniques included in the 
selected mutual exclusion group. The action bar at the bottom of the column contains the 
following options:

● Add : Opens the Playback Technique Combinations dialog that allows you to select 
playback techniques to add to the selected mutual exclusion group.

● Delete : Deletes the selected playback technique from the mutual exclusion group.

NOTE

You can only select one playback technique at a time.
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Expression map/Library management options

At the bottom of the Expression Maps dialog, there are the following expression map and library 
management options:

Reset to Library Defaults
Allows you to revert any changes you have made to the expression maps from the 
Default Library.

Import Library
Opens the File Explorer/macOS Finder, where you can select the .doricolib files that 
you want to import as expression maps.

You can also import Dorico and Cubase expression maps by dragging and dropping 
them into the Expression Maps dialog.

Export Library
Opens the File Explorer/macOS Finder, where you can select the location to which you 
want to export the currently selected expression maps as a .doricolib file. You can 
then import the .doricolib file into other projects and share it with other users.

Import Cubase Expression Map
Opens the File Explorer/macOS Finder, where you can select the 
Cubase .expressionmap files you want to import as expression maps.

NOTE

Cubase expression maps that you have imported often require some editing to 
function correctly in Dorico SE. However, switch data is preserved.

RELATED LINKS
Types of switches on page 637
Types of actions on page 638
Playback techniques on page 649
Endpoint Setup dialog on page 479
Edit Playback Techniques dialog on page 650
Enabling independent voice playback on page 460
Creating new expression maps on page 639
Adding/Editing switches in expression maps on page 640
Adding/Editing mutual exclusion groups in expression maps on page 641

Playback Technique Combinations dialog
The Playback Technique Combinations dialog allows you to create combinations of playback 
techniques that you want to apply simultaneously. Playback techniques are used by expression 
maps to assign the correct sounds to the required playing techniques in the music.

You can open the Playback Technique Combinations dialog in the following ways:

● In the Expression Maps dialog, click Add Technique  in the Switches table action bar.

● In the Expression Maps dialog, select an existing playback technique in the Switches table 
and click Edit Technique  in the Techniques action bar. You can also double-click the 
playback technique.
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1 Techniques list

Allows you to select playback techniques to include in a new switch or to change the 
playback techniques in an existing switch.

You can select multiple playback techniques to combine by Ctrl/Cmd -clicking each playback 
technique.

2 Name

Displays the name of the selected playback technique. If you select multiple playback 
techniques, each name is automatically separated by a + symbol.

NOTE

You cannot rename playback techniques or playback technique combinations in the 
Playback Technique Combinations dialog. You can rename the switches that include them 
in the Base and Add-on Switches section of the Expression Maps dialog. You can rename 
individual playback techniques in the Edit Playback Techniques dialog.

RELATED LINKS
Expression Maps dialog on page 626
Edit Playback Techniques dialog on page 650
Adding/Editing switches in expression maps on page 640

Types of switches
Switches are used in expression maps to trigger the required playback technique or combination 
of playback techniques. Dorico SE supports multiple types of switches.

Base
A fundamental change to the playing technique or articulation, such as changing from 
arco to pizzicato or unmuted to muted. Base switches are mutually exclusive, meaning 
a new base switch replaces the previous one.
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Add-on
A switch that applies in addition to the existing base switch. For example, some sound 
libraries allow you to use the same legato switch in addition to different base switches. 
Add-on switches do not remove or change base switches. Add-on switches can only 
trigger simple key switch notes and controller values.

Init
A switch that sends instructions when playback starts, such as ensuring a MIDI 
controller always starts at a set value. By default, every expression map contains an 
empty init switch. Init switches can only trigger simple key switch notes and controller 
values.

RELATED LINKS
Expression Maps dialog on page 626
Adding/Editing switches in expression maps on page 640
Adding/Editing mutual exclusion groups in expression maps on page 641

Types of actions
Actions are used in expression maps to determine how individual switches are controlled in order 
to trigger the required playback technique or combination of playback techniques. Dorico SE 
supports multiple types of actions, as different sound libraries require different actions.

Control change actions
Control change actions use MIDI CC events to modulate sounds. They are particularly 
useful when using sound libraries whose sounds can be manipulated incrementally, 
such as increasing/decreasing the string vibrato intensity.

Program change actions
Program change actions use MIDI PC events to switch to different sounds. They are 
particularly useful when using sound libraries, such as General MIDI, that use separate 
programs for each playback technique or combinations of instrument sounds and 
effects presets.

Key switch actions
Key switch actions use MIDI note events to switch to different sounds. They are 
particularly useful when recording MIDI live, as you can press the specified notes on a 
MIDI keyboard to trigger key switch actions while simultaneously playing the notes you 
want to record. Usually, key switch actions are mapped to notes in the lowest octave of 
the MIDI keyboard as they are rarely used for note input.

Key switch actions are also known as “note events”.

Absolute channel change actions
Absolute channel change actions switch to a specific, explicitly numbered channel. 
They are particularly useful for sound libraries that have separate plug-in instances for 
each individual instrument. For example, you might use an absolute channel change 
action to switch from “natural” on channel 1 to “pizzicato” on channel 2 in your viola 
section plug-in instance.

Relative channel change actions
Relative channel change actions switch to a channel numbered relative to the starting 
channel. They are particularly useful for sound libraries that have multiple instruments 
with separate playback technique channels in the same plug-in instance, as they can 
switch between playback techniques according to their relative channel number rather 
than an absolute number. For example, if you have four trumpet instruments loaded in 
the same plug-in instance, each with three channels for different playback techniques, 
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and want to use the same switches for all four trumpets, you might use a relative 
channel change action to switch from the “natural” original channel to “muted” on the 
+1 relative channel.

Relative channel numbers relate to the original channel number of the endpoint for the 
corresponding instrument. A 0 relative channel change switches back to the original 
channel.

TIP

You can add actions to individual switches in the Expression Maps dialog.

Creating new expression maps
You can create new expression maps from scratch, and you can duplicate existing expression 
maps and edit the settings; for example, when using third-party sound libraries or MIDI devices 
that do not provide expression maps.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. Create a new expression map in one of the following ways:

● To create an empty expression map, click Add Expression Map  in the expression 
maps list action bar.

● To create a copy of an existing expression map, select it in the expression maps list and 
click Duplicate Expression Map  in the action bar.

3. In the Expression Map Data section, click Lock Info  to unlock the fields.

4. In the Expression Map Data section, enter information for your expression map in the 
relevant fields.

5. Activate/Deactivate Allow multiple notes at same pitch.

6. Optional: In the Base and Add-on Switches section, add any new switches you require to 
trigger playback techniques or combinations of playback techniques.

7. In the Switches table, select a switch whose actions, conditions, and/or controls you want to 
edit.

8. Change any settings for the selected switch as required.

For example, you can add actions for all switch types or, for base switches only, choose 
whether the volume of a selected base switch is controlled by its Note velocity or a Control 
change.

9. Optional: Repeat steps 7 and 8 for all switches whose settings you want to change.

10. In the Playback Options Overrides section, activate each playback option you want to 
override for the expression map and change their values.

11. In the Mutual Exclusion Groups section, activate/deactivate Auto.

12. Optional: If you deactivated Auto, add or edit mutual exclusion groups manually.

13. Click OK to save your changes and close the dialog.

RELATED LINKS
Expression Maps dialog on page 626
Endpoint Setup dialog on page 479
Playback Technique Combinations dialog on page 636
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Adding/Editing mutual exclusion groups in expression maps on page 641

Adding/Editing switches in expression maps
You can create new and edit existing switches that trigger playback techniques or combinations 
of playback techniques in individual expression maps; for example, to add an add-on switch to an 
existing base switch, or to create a new base switch with note length conditions.

Playback technique combinations are useful for expression maps that require different sets of 
key switches for Staccato + Accent compared to Staccato and Accent individually, for example.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression map to which you want to add switches or 
whose existing switches you want to edit.

3. Optional: In the Switches table in the Base and Add-on Switches section, add a new switch 
to trigger a playback technique or playback technique combination or edit an existing one in 
one of the following ways:

● To add a new base switch, click Add Base Switch .

● To add a new add-on switch, click Add Technique Add-on Switch .

● To create a copy of an existing switch, select it and click Duplicate Technique .

● To change the playing techniques triggered by an existing switch, select it and click Edit 
Technique .

4. Optional: If you added a new base/add-on switch or edited an existing switch, select 
the playback techniques you want the switch to trigger in the Playback Technique 
Combinations dialog.

TIP

You can select a single playback technique or combine multiple playback techniques. To 
select multiple playback techniques, Ctrl/Cmd -click each playback technique.

5. Optional: Click OK to add the selected playback techniques and close the Playback 
Technique Combinations dialog.

6. In the Switches table, select the switch whose actions, conditions, and/or controls you want 
to edit.

7. In the Actions subsection, choose the event type from one of the following options:

● On events

● Off events

8. In the Actions table, add an action of the selected event type for the currently selected 
switch in one of the following ways:

● Click Add Control Change Action .

● Click Add Program Change Action .

● Click Add Key Switch Note Action .

● Click Add Absolute Channel Change Action.

● Click Add Relative Channel Change Action.

● Select an existing action and click Duplicate Action .

9. Double-click each cell whose value you want to change and change the value.
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10. Choose one of the following pitches for Middle C (note 60):

● C3

● C4

● C5

NOTE

Steps 11 to 15 only apply to base switches. For init and add-on switches, you can skip to step 
16.

11. Optional: Repeat steps 6 to 10 for each action you require for the currently selected switch.

12. In the Conditions table, add a condition for the currently selected base switch in one of the 
following ways:

● To create a new condition, click Add Technique  in the action bar.

● To create a copy of an existing condition, select it and click Duplicate Technique  in 
the action bar.

13. Double-click each cell whose value you want to change and select the required option from 
the menu.

14. Optional: Repeat steps 12 and 13 for each condition you want to add to the selected base 
switch.

15. Choose one of the following condition options:

● To use the switch when at least one condition is met, choose Any of.

● To use the switch when all conditions are met, choose All of.

16. Change any of the other settings in the Base and Add-on Switches section as required.

For example, choose whether the volume of the selected base switch is controlled by its 
Note velocity or a Control change.

17. Click OK to save your changes and close the Expression Maps dialog.

RELATED LINKS
Playback techniques on page 649
Expression Maps dialog on page 626
Playback Technique Combinations dialog on page 636

Adding/Editing mutual exclusion groups in expression maps
By default, Dorico SE automatically defines mutual exclusion groups. You can create new and edit 
existing mutual exclusion groups in individual expression maps manually.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression map to which you want to add mutual 
exclusion groups or whose existing mutual exclusion groups you want to edit.

3. Optional: If Auto is activated in the Mutual Exclusion Groups section, deactivate Auto.

4. Optional: If you want to add a new mutual exclusion group, click Add  in the Mutual 
Exclusion Groups column action bar.

5. Enter a name for the new mutual exclusion group in the dialog that opens.

6. Click OK to add the group and close the dialog.
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7. In the Mutual Exclusion Groups column, select the mutual exclusion groups whose 
playback techniques you want to change.

8. Change the playback techniques in the selected mutual exclusion group in any of the 
following ways:

● To add new playback techniques to the mutual exclusion group, click Add  in the Has 
techniques column action bar to open the Playback Technique Combinations dialog, 
select the playback techniques you want to add, then click OK.

● To remove playback techniques from the mutual exclusion group, select them in the Has 
techniques column, and click Delete  in the action bar.

9. Click OK to save your changes and close the Expression Maps dialog.

Importing expression maps
You can import expression maps into projects, including .expressionmap files exported from 
Cubase. Expression maps exported from Dorico are saved as .doricolib files.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. Click Import Library to open the File Explorer/macOS Finder.

3. Locate and select the expression map file you want to import.

4. Click Open.

RESULT
The selected expression map is imported into your project. It appears in the expression maps list.

NOTE

● You can also import Dorico and Cubase expression maps by dragging and dropping them 
into the Expression Maps dialog.

● Although Dorico SE approaches expression maps in a different way to Cubase, Dorico SE 
correctly imports many switches from expression maps you import from Cubase, such as 
pizzicato, harmonics, and flutter tongue.

Exporting expression maps
You can export expression maps for use in other projects. Expression maps are saved 
as .doricolib files.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression maps you want to export.

3. Click Export Library to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.
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RESULT
The selected expression maps are exported as a .doricolib file and saved in the selected 
location.

Percussion maps
Unpitched percussion instruments are played back using patches that map unpitched sounds 
onto different MIDI notes. The pitches required to produce different unpitched sounds vary 
by device, sound library, manufacturer, and so on, and have no connection to the position of 
percussion instruments on five-line staves.

The following list contains some examples of unpitched percussion instruments from the General 
MIDI percussion map.

● Bass drum: C2 (MIDI note 36, two octaves below middle C)

● Kick drum: D2 (MIDI note 38)

● Closed hi-hat: F♯2 (MIDI note 42)

● Cowbell: G♯3 (MIDI note 56)

● Open triangle: A5 (MIDI note 81)

Dorico SE uses percussion maps to connect the written representation of notes and playing 
techniques for percussion instruments to the samples required to play those sounds back.

NOTE

A percussion map describes which unpitched percussion instruments and their playback 
techniques are present in a particular patch, and how to play them back. For example, it 
describes which MIDI note to play, and if another MIDI note is needed as a key switch to trigger 
particular playing techniques.

A set of percussion maps for the unpitched percussion patches that are part of theHALion 
Symphonic Orchestra and HALion Sonic SE factory libraries is provided with Dorico SE. They are 
automatically chosen when you add percussion instruments to your project.

You can define custom percussion maps for third-party sound libraries or MIDI devices in the 
Percussion Maps dialog, in order to obtain correct playback.

RELATED LINKS
Unpitched percussion on page 1115
Universal Indian Drum Notation on page 1133
Importing percussion maps on page 648
Exporting percussion maps on page 648

Percussion Maps dialog
In the Percussion Maps dialog, you can define custom percussion maps for third-party sound 
libraries or MIDI devices in order to obtain correct playback.

● You can open the Percussion Maps dialog by choosing Library > Percussion Maps.
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The Percussion Maps dialog is divided into the following sections:

1 Percussion maps list

Contains the percussion maps currently available in your project.

You can add and delete percussion maps using the following buttons in the action bar at the 
bottom of the percussion maps list:

● Add Percussion Map : Adds a new percussion map that contains no existing settings.

● Duplicate Percussion Map : Creates a copy of an existing percussion map that you 
can edit separately from the original.

● Delete Percussion Map : Deletes the selected percussion maps.

NOTE

You can only delete custom percussion maps. You cannot delete any default percussion 
maps.

2 Search field

Allows you to filter percussion maps according to your entry.

3 Show only percussion maps used in this project

Allows you to filter the percussion maps list so it only includes percussion maps used in the 
current project.

4 Percussion Map Data section

Allows you to specify the following identifying information for the selected percussion map:

● Name: Allows you to specify the displayed name for the percussion map that appears in 
the Endpoint Setup dialog.
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● ID: Allows you to set the unique ID of the percussion map. You can enter any content in 
the ID field.

It can be useful to include the instrument and sound library for which you created the 
map, as well as your name; for example, xmap.user.paulsmith.hso.cowbell.

● Version: Allows you to indicate the percussion map version so you can identify the most 
recent one.

● Map defines sounds for: Allows you to choose one of the following options, as 
appropriate for the current percussion map:

● Multiple Instruments: Choose this if the patch for which you are creating a map 
contains many different percussion instruments, such as the General MIDI drum 
map.

● Single Instruments: Choose this if the patch for which you are creating a map 
contains only a single percussion instrument, perhaps with multiple playback 
techniques for that instrument. For example, a snare drumline patch in Virtual 
Drumline or another specialist sound library.

This can also be useful when your VST instrument has several patches that have the 
same playback technique mappings. For example, there are both large and small 
cymbal patches in HALion Symphonic Orchestra which provide natural strike and roll 
sounds. Creating a single individual instrument percussion map allows you to use 
the same mapping for these sounds for multiple patches.

NOTE

● ID and Version are locked by the Lock Info button. You must click this button in order to 
change the information in the fields.

● The Endpoint Setup dialog is where you set which percussion map Dorico SE uses for 
each channel on your VST instrument or MIDI output device.

5 Drum Kit Note Map section

Contains subsections that allow you to view, edit, and control the drum kit notes in the 
selected percussion map.

6 Drum Kit Note Map table

By default, the table shows the drum kit notes in use by the selected percussion map 
in numerical order. The table also contains the following columns, which display the 
corresponding available data about the selected drum kit note:

● MIDI Note: Shows the MIDI note number, such as “48”.

● Note Name: Shows the pitch and octave of the note, such as “C3”.

● Name: Shows the name of the technique, such as Snare “(long roll)”.

● Instrument: Shows the unpitched percussion instrument, such as “Snare Drum”.

● Key Switch: Shows the number of the key switch that triggers the note, such as “24”.

● Playback Techniques: Shows the playback techniques triggered by the note, such as 
“Roll”.

At the bottom of the table, there are the following options:

● Show all: Shows all MIDI notes from 0 to 127.

● Show MIDI Notes in Use: Only shows the MIDI notes in use by the selected percussion 
map.

● Add Key Switch Alternative: Duplicates the selected drum kit note.

● Clear: Deletes the selected drum kit note.
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You can change the data for the currently selected drum kit note in the Edit Drum Kit Note 
subsection.

7 Edit Drum Kit Note subsection

Allows you to specify data in the following fields for the drum kit note currently selected in 
the Drum Kit Note Map table:

● Name: The displayed name for the specific combination of instrument and playback 
technique. You may choose to input the name used in the manufacturer’s 
documentation for your VST instrument or MIDI output device.

● Instrument: Allows you to select an instrument for the drum kit note selected in the 
Drum Kit Note Map section from a list of all the unpitched percussion instruments you 
can create in Dorico SE.

● Key switches: Allows you to specify the MIDI note number of the key you want to use as 
a key switch if this sound requires another MIDI note to be played to trigger this specific 
combination of instrument and playback techniques.

NOTE

Key switches are not compulsory.

● Techniques: Allows you to select playback techniques to apply to the instrument 
selected in the Instrument field from a list of the available playback techniques.

8 Reset to Library Defaults

Allows you to revert any changes you have made to the percussion maps from the Default 
Library.

9 Import Library

Opens the File Explorer/macOS Finder, where you can select the .doricolib files that you 
want to import as percussion maps.

10 Export Library

Opens the File Explorer/macOS Finder, where you can select the location to which you want 
to export the currently selected percussion maps as a .doricolib file. You can then import 
the .doricolib file into other projects and share it with other users.

Creating new percussion maps
You can create new percussion maps from scratch and you can duplicate existing percussion 
maps and edit the settings; for example, to obtain correct playback when using third-party sound 
libraries or MIDI devices.

PROCEDURE

1. Choose Library > Percussion Maps to open the Percussion Maps dialog.

2. Create a new percussion map in any of the following ways:

● To create an empty percussion map, click Add Percussion Map  in the action bar.

● To create a copy of an existing percussion map, select it in the percussion maps list and 
click Duplicate Percussion Map  in the action bar.

3. In the Percussion Map Data section, click Lock Info  to unlock the fields.

4. Enter the display name you want for the percussion map in the Name field.

This name appears in the Endpoint Setup dialog.

5. Enter any unique identification name in the ID field.
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It can be useful to include the instrument and sound library for which you created the 
map, as well as your name, in the identification name for percussion maps; for example, 
xmap.user.paulsmith.hso.cowbell.

6. Choose one of the following options for Map defines sounds for, as appropriate for the 
current percussion map:

● Multiple Instruments

● Single Instruments

7. In the Drum Kit Note Map section, click Show all to show unmapped notes.

8. Select the row corresponding to the MIDI note for which you want to create a new mapping.

9. In the Edit Drum Kit Note subsection, click  beside the Instrument field to open a dialog 
containing a list of percussion instruments.

10. Select the instrument that corresponds to the sound produced by the selected MIDI note.

11. Click OK.

12. In the Edit Drum Kit Note subsection, click  beside the Techniques field to open the 
Playback Technique Combinations dialog.

13. Select the appropriate playback techniques for the sound produced by the selected MIDI 
note.

For example, Ctrl/Cmd -click Buzz roll and Rim.

14. Click OK.

15. In the Edit Drum Kit Note subsection, enter the display name you want for this combination 
of instrument and playing technique in the Name field.

16. Optional: If the key switch for this sound requires a MIDI note number, specify it in the Key 
switches field.

17. Click Apply.

18. Optional: Repeat these steps for each MIDI note until you have created all the required 
mappings for your project.

19. Click OK to save your changes and close the dialog.

RESULT
The new percussion map is created.

AFTER COMPLETING THIS TASK

● You must assign percussion maps to the same endpoints as the VST instruments or MIDI 
devices that provide the corresponding patches.

● You can export the percussion map if you want to use it in other projects.

RELATED LINKS
Percussion maps on page 643
Assigning expression/percussion maps to endpoints on page 485
Endpoint Setup dialog on page 479
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Importing percussion maps
You can import percussion maps into projects. Percussion maps are saved as .doricolib files.

PROCEDURE

1. Choose Library > Percussion Maps to open the Percussion Maps dialog.

2. Click Import Library to open the File Explorer/macOS Finder.

3. Locate and select the percussion map file you want to import.

4. Click Open.

RESULT
The selected percussion map is imported into your project. It appears in the percussion maps list.

Exporting percussion maps
You can export percussion maps so you can use them in other projects. Percussion maps are 
saved as .doricolib files.

PROCEDURE

1. Choose Library > Percussion Maps to open the Percussion Maps dialog.

2. In the percussion maps list, select the percussion maps you want to export.

3. Click Export Library to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The selected percussion maps are exported as a .doricolib file and saved in the selected 
location.

Defining how combinations of articulations and single-note 
tremolos sound in playback

You can define specific playback behaviors for particular combinations of articulations 
and single-note tremolos in playing technique-specific noteheads for unpitched percussion 
instruments.

PROCEDURE

1. In Setup mode, open the Percussion Instrument Playing Techniques dialog in any of the 
following ways:

● For an individual percussion instrument: In the Players panel, click the instrument menu 
 in the instrument label, and choose Edit Percussion Playing Techniques from the 

menu.

● For percussion instruments that are part of percussion kits: In the Players panel, 
click the instrument menu  in the kit instrument label and choose Edit Percussion 
Kit to open the Edit Percussion Kit dialog. In the main editing area, select the 
instrument whose playing techniques you want to edit, then click Edit Percussion 
Playing Techniques.
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2. In the list at the top of the dialog, select the playing technique-specific notehead whose 
playback behaviors you want to define.

3. Click Add Technique  in the action bar at the bottom left of the dialog.

4. Click Choose Playing Techniques  beside the Playback playing technique field to open 
the Playback Technique Combinations dialog.

5. Select the playback techniques you want.

TIP

You can select a single playback technique or combine multiple playback techniques. To 
select multiple playback techniques, Ctrl/Cmd -click each playback technique.

6. Click OK to add the selected playback techniques and close the Playback Technique 
Combinations dialog.

7. Choose one of the following options:

● Replace: Allows you to use this playing technique instead of the default playing 
technique defined for this combination of notehead and staff position.

● Add: Allows you to add this playing technique on top of the default playing technique 
defined for this combination of notehead and staff position.

8. Choose any articulations and the tremolo stroke that you want from the available options.

9. Click OK to save your changes and close the dialog.

RESULT
The behavior of the selected playing technique in playback is changed.

RELATED LINKS
Percussion Instrument Playing Techniques dialog on page 1116
Creating new playing technique-specific noteheads on page 1120
Playback Technique Combinations dialog on page 636

Playback techniques
Playback techniques link together the notations you input into your music and techniques/
articulations in sound libraries in order to produce the correct sounds in playback. They are used 
by expression and percussion maps to trigger the appropriate commands, such as key switches 
or control changes.

When you input notations, such as playing techniques, tremolos, jazz articulations, or 
articulations, the corresponding expression maps look for the appropriate playback techniques. 
For example, inputting pizz. playing techniques causes expression maps to use the Pizzicato 
playback technique to switch to the pizzicato sound for playback. If the expression map cannot 
locate the sound, the playback technique applied either remains the same as the previous 
playback technique or reverts to the natural playback technique.

Custom playing techniques that use playback techniques which do not already exist in 
expression maps do not play back automatically. In order for them to play back appropriately, 
you must add them to the expression maps for each instrument for which you want to use them. 
You must also assign an action for each custom playing technique that determines how the 
switch that triggers the technique is controlled.
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You can map playback techniques as required for different sound libraries in the Expression 
Maps dialog, including creating new combinations of existing playback techniques, such as 
Legato and Tremolo, which allows them to be used simultaneously.

You can see which playback techniques are in use at any particular rhythmic position in the 
Playing Techniques editor for the corresponding instrument/voice.

TIP

● If you have input a playing technique but cannot hear a change in the sound, you might 
be using a combination of playback techniques that the expression map does not expect. 
For example, if you input a new playing technique without cancelling an existing playing 
technique, the expression map cannot process the two corresponding playback techniques 
together if the expression map does not have an entry for those two techniques combined.

To avoid playback technique clashes, you can add playback techniques that cannot be in use 
concurrently to the same mutual exclusion group in the corresponding expression maps. 
Alternatively, you can create a combination of those playback techniques in order to use 
them simultaneously.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques, tremolos, jazz articulations, or articulations in different voices 
simultaneously.

RELATED LINKS
Expression maps on page 625
Expression Maps dialog on page 626
Playback Technique Combinations dialog on page 636
Enabling independent voice playback on page 460
Creating new expression maps on page 639
Adding/Editing mutual exclusion groups in expression maps on page 641
Playing Techniques editor on page 586
Playing techniques on page 937
Tremolos on page 1099
Jazz articulations on page 911
Articulations on page 661

Edit Playback Techniques dialog
The Edit Playback Techniques dialog allows you to define new playback techniques and edit 
existing ones. Playback techniques are used by expression maps to assign the correct sounds to 
the required notations in the music, such as playing techniques, tremolos, jazz articulations, and 
articulations.

● You can open the Edit Playback Techniques dialog by choosing Library > Playback 
Techniques.

Library
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The Edit Playback Techniques dialog contains the following sections and options:

1 Category menu

Allows you to filter the list of playback techniques by selecting a category from the menu, 
such as Techniques or Dynamics.

2 Playback techniques list

Contains all the playback techniques in the project within the currently selected category.

The action bar at the bottom of the list contains the following options:

● New : Adds a new blank playback technique.

● New from Selection : Creates a copy of an existing playback technique that you can 
edit separately from the original.

● Save as Default : Saves the selected playback technique to your user library, allowing 
you to use it in multiple projects. Appears as  for playback techniques saved as default.

● Revert to Factory : Removes all your changes to the selected playback technique, 
returning it to its saved settings.

● Delete : Deletes the selected playback technique.

NOTE

You cannot delete predefined playing techniques or any playing technique that is 
currently used in your project.

3 Name

Allows you to edit or enter the name of the playback technique. This is the name shown in 
lists in the Edit Playing Techniques, Expression Maps, Playback Technique Combinations, 
and Percussion Maps dialogs.

4 Playback options

● Alias for: Allows you to select another playback technique whose sound mapping you 
want to apply to the selected playback technique as well.

● Group: Sets the group in which this playback technique appears.

● Fallback: Allows you to specify another playback technique that can be used if the 
present one is not available.

● Articulation type: Sets the duration over which the playback technique takes effect. 
Attribute applies only to the note at the rhythmic position where the playing technique 
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is found, such as a staccato articulation, while Direction applies to all following notes 
until it is replaced by another playing technique, such as pizzicato.

RELATED LINKS
Expression Maps dialog on page 626
Playback Technique Combinations dialog on page 636
Adding/Editing mutual exclusion groups in expression maps on page 641
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Notation reference



Introduction

This notation reference contains information about the accepted conventions for presenting 
different notations and how to change their appearance and placement in Dorico SE, both for 
individual items and by changing default settings.

It also contains instructions for inputting more complex notations, such as cross-staff glissando 
lines, which are described in the corresponding chapter.

Tasks in the notation reference outline the default per-layout changes you can make in Layout 
Options, such as changing the frequency of bar numbers, and the individual changes you can 
make to items, which often involve using properties in the Properties panel.

More detailed default options, such as how notes should be beamed in different meters or 
spacing gaps between different items, are available in Dorico Pro.

You can find basic input methods for notations in the Write mode chapter.

RELATED LINKS
Write mode on page 172
Layout Options dialog on page 622
Properties panel on page 560
Notations input on page 246
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Accidentals

Accidentals are shown beside notes to indicate their pitch, both when notated on a staff and 
written out in text. In music based in Western tonality, they usually show that the pitch of a note 
has been altered so that it does not conform to the prevailing key signature.

In Dorico SE, each note has its own fixed pitch that is independent of the prevailing key 
signature, and accidentals are automatically hidden and shown as appropriate. For example, 
if you input F♮s and then add a D major key signature before them, they do not turn into F♯s; they 
remain F♮s and show natural accidentals. However, if you input the D major key signature first, 
any Fs you then input without stating an accidental are input as F♯s.

There are different conventions for accidental duration rules, such as not repeating the same 
accidental on subsequent notes of the same pitch in the same bar. In music that has no key 
signatures, some or all notes might require accidentals, depending on the notation convention in 
use.

RELATED LINKS
Accidental duration rules on page 660
Inputting notes on page 197
Inputting accidentals on page 219

Deleting accidentals
You can delete accidentals according to their type, and you can delete all accidentals from a 
selection of notes with different accidentals at the same time. This changes the pitch of the 
selected notes.

NOTE

These steps do not apply to cautionary accidentals, such as those shown on natural notes that 
follow the same notes with an accidental but in a different octave. In Dorico SE, you can only 
hide, show, or parenthesize cautionary accidentals individually.

PROCEDURE

1. In Write mode, select the notes whose accidentals you want to delete.

2. Delete accidentals in any of the following ways:

● To delete naturals, press 0 .

● To delete flats, press - .

● To delete sharps, press = .
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● In the Notes panel, click the accidentals you want to delete.

RESULT
The corresponding accidentals are deleted from the selected notes. This changes their pitch. For 
example, deleting the sharp from a G♯ turns it into G♮.
NOTE

● Deleting accidentals causes accidentals to appear on any subsequent notes of the same 
pitch in the same bar. When you select single notes or multiple notes in the same voice at 
the same rhythmic position, their pitches are shown in the status bar and as depressed keys 
in the Keyboard panel.

● To delete accidentals from a selection of notes with different accidentals, we recommend 
that you revert them all to natural by pressing 0  or clicking Natural in the Notes panel. 
This is because re-inputting an accidental over a selection of notes with different accidentals 
adds that accidental to every note in the selection. For example, two G♯s followed by two G♭s 
become four G♯s if you re-input a sharp. If you click Sharp or press =  twice, all accidentals 
are deleted.

RELATED LINKS
Inputting accidentals on page 219
Changing the pitch of individual notes on page 424
Notes panel on page 177
Status bar on page 36
Keyboard panel on page 183

Hiding/Showing or parenthesizing accidentals
You can hide/show individual accidentals, or show them in round or square brackets, including 
cautionary accidentals shown by default. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose accidentals you want to hide/show or parenthesize.

2. In the Properties panel, activate Accidental in the Notes and Rests group.

3. Select one of the following options from the menu:

● Hide

● Show

● Round brackets

● Square brackets

Accidentals
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RESULT
Accidentals on the selected notes are shown, hidden, or shown in round or square brackets. If 
the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

NOTE

● Hiding accidentals does not affect the pitch of notes in playback.

● You can assign key commands for different accidental hiding, showing, and parenthesizing 
commands on the Key Commands page in Preferences.

AFTER COMPLETING THIS TASK
You can also hide/show or parenthesize accidentals on artificial harmonics shown using diamond 
noteheads, independently of the normal noteheads that indicate the stopped pitch.

RELATED LINKS
Properties panel on page 560
Hiding/Showing zones on page 41
Hiding/Showing or parenthesizing harmonic accidentals on page 862
Preferences dialog on page 53
Ties on page 1074
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Stacking of accidentals
If multiple accidentals are required for a chord in a single voice, or for notes in multiple voices at 
the same rhythmic position, they are stacked to the left of the chord in columns.

For chords with multiple accidentals, accidentals are generally stacked as follows:

1. The highest accidental is inserted in the first column immediately to the left of the notes.

2. The lowest accidental is added to the same column, provided that it does not collide with the 
first accidental.

3. The remaining highest and lowest accidentals are alternated in successive columns located 
further left from the chord.

In Dorico SE, additional rules help to produce a stack of accidentals that uses as few columns as 
possible. The following list contains some of the rules that are applied:

● Columns closer to the notes contain more accidentals than columns further from the notes.

● Accidentals on notes that are an octave apart are stacked in the same column. This also 
applies to accidentals that are a sixth or more apart, depending on the combination of 
accidentals.

● Accidentals in the same column never collide. The minimum interval between accidentals 
that is required to prevent collisions depends on the types of accidentals.

● Accidentals that are a second apart are arranged in adjacent columns, with the higher 
accidental in the right-hand column.

These rules minimize the amount of extra space that is required between successive notes or 
chords and ensure that accidentals appear as close as possible to the noteheads to which they 
apply. At the same time, they produce a contour that resembles a C-curve on the left-hand side of 
the chord.

Accidentals
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Accidental stacking rules for dense chords

Dorico SE uses special stacking calculations in dense chords with multiple accidentals to ensure 
legibility. Chords are considered dense when they have six or more accidentals within the span of 
an octave.

For dense chords, accidentals are stacked as follows:

1. The highest accidental is inserted in the first column to the left of the notes.

2. The next accidental on a note that is located at least a seventh below the highest note 
is stacked into the same column. This continues with the remaining notes until no more 
accidentals fit into the first column.

3. Steps 1 and 2 are repeated for the following columns until all accidentals are stacked.

4. The columns are grouped, interspersed, and re-stacked. This results in a stack with 
alternating accidentals, reminiscent of the way accidentals are arranged in a key signature.

By default for dense chords, Dorico SE uses a lattice arrangement of accidentals, rather than 
the usual zig-zag arrangement. In very dense chords, the lattice arrangement can be wider and 
require more columns.

Kerning of accidental columns
Dorico SE applies kerning to accidental columns to ensure that the columns to the left of a chord 
occupy as little horizontal space as possible.

In typography, kerning adjusts the space between individual characters to increase legibility. In 
Dorico SE, as well as in music engraving in general, kerning allows accidentals to interlock.

EXAMPLE
If a low note is followed by a high note with an accidental, the accidental can be tucked above the 
low note to prevent the note spacing from being distorted.

Similarly, in the case of multiple columns of accidentals on a chord, the overall width of the stack 
of accidentals is reduced if, for example, a flat in the second column is kerned underneath a 
sharp in the first column belonging to a note a third higher. This also reduces the need to distort 
note spacing to accommodate accidentals.

Altered unisons
Altered unisons occur when two or more notes of the same name in the same octave have 
different accidentals in the same chord, such as D♯ and D♭.
In Dorico SE, this is notated with a split stem by default. Split stems show the main body of a 
chord with a stem branch coming off the main stem that connects noteheads in altered unisons 
to the chord. This allows all notes to appear with their corresponding accidental directly beside 
them. A split stem is also known as a “cherry stalk” or a “tree”.

You can show individual altered unisons with a single stem, meaning noteheads appear directly 
beside each other, and the two accidentals are shown beside each other to the left of the chord.

NOTE

If a chord contains notes a second interval apart and one of those notes has an altered unison, it 
is always shown with a split stem, regardless of your setting. This is to ensure clarity in clusters.
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EXAMPLE

A single stem altered unison A split stem altered unison

RELATED LINKS
Inputting chords on page 226

Changing how altered unisons appear
You can change how individual altered unisons appear, including within chords containing other 
altered unisons. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the altered unison notes whose appearance you want to change.

2. In the Properties panel, activate Split stem in the Notes and Rests group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected altered unison notes are shown with split stems when the checkbox is activated, 
and with single stems when the checkbox is deactivated. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

Split stem applies to individual notes. You can have altered unisons appear differently within the 
same chord by setting their properties independently.

RELATED LINKS
Properties panel on page 560
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Microtonal accidentals
Microtonal accidentals indicate pitches beyond the standard accepted chromatic scale in Western 
tonality, such as a quarter sharp or quarter flat. Microtonal accidentals are only shown in Dorico 
SE if you open a project that already contains them. They are available for input only where the 
corresponding key signature and tonality system apply.
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Accidental duration rules
Accidental duration rules determine how long accidentals apply, such as within a bar, at a 
different octave, or just for a single note. Dorico SE uses the common practice accidental 
duration rule.

Common practice

In common practice, an accidental affects all notes of the same pitch in the same octave within 
the same bar, unless it is cancelled by another accidental. If it is not cancelled, it is automatically 
cancelled in the following bar.

It is customary to show cautionary accidentals on subsequent notes in certain circumstances. For 
example, in the key of G major, an F♯ in a bar following an F♮ shows a cautionary sharp sign, 
even though the sharp is included in the key signature. Cautionary accidentals are also known as 
“courtesy accidentals”.

RELATED LINKS
Double accidental cancellation on page 660

Double accidental cancellation
There are two generally accepted practices for the cancellation of double accidentals, which are 
archaic and modern.

By default, Dorico SE uses modern cancellation. This means that if a double sharp is cancelled by 
a single sharp, or a double flat is cancelled by a single flat, then no natural sign is shown in front 
of the single sharp or single flat, as these accidentals are unambiguous.

Modern cancellation

RELATED LINKS
Accidental duration rules on page 660
Hiding/Showing or parenthesizing accidentals on page 656
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Articulations

Articulations are markings that are drawn above or below notes and chords. Articulations tell a 
performer how to attack a note or how long to play a note relative to its notated duration.

In Dorico SE, articulations are defined as something that alters the way a note is played, in a way 
that is consistent across all instruments. Because instructions like bowing directions, harmonics, 
or tonguing apply to different instrument groups, in Dorico SE such directions are defined as 
playing techniques.

A musical phrase with accent, staccato, and staccatissimo articulations

Articulations are categorized into the following types:

Articulations of force
Indicate a stronger attack at the start of notes, and include articulations such as accent 
and marcato. Marcato is also sometimes known as a “strong accent”. Dorico SE shows 
these articulations at the start of a note or tie chain by default.

Articulations of duration
Indicate a shorter duration than notated, and include articulations such as 
staccatissimo, staccato, tenuto, and staccato-tenuto. Staccato-tenuto is also sometimes 
known as a “louré”. If a note includes ties, Dorico SE shows articulations of duration 
above the last note in the chain by default.

Articulations of stress
Indicate notes that should be emphasized or not emphasized where that contradicts 
the prevailing meter, using stressed and unstressed marks. Dorico SE shows these 
articulations at the start of a note or tie chain by default.

Dorico SE positions articulations automatically on the notehead or stem side of notes and chords, 
according to the musical context. A note or chord can display one of each type of articulation.

RELATED LINKS
Inputting articulations on page 246
Articulations in playback on page 665
Positions of articulations on page 662
Changing the positions of articulations on tie chains on page 664
Playback techniques on page 649
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Deleting articulations
Individual articulation markings cannot be selected and deleted separately from their notehead 
in Write mode, so articulations must be deleted by selecting the note or notes to which they are 
attached, and deselecting the articulation.

PROCEDURE

1. In Write mode, select the notes whose articulations you want to delete.

2. Deselect the articulations in any of the following ways:

● Press the key commands of the articulations you want to delete.

● In the Notes panel, click the articulations you want to delete.

RELATED LINKS
Notes panel on page 177
Hiding/Showing zones on page 41
Key commands for articulations on page 247

Positions of articulations
There are established conventions for the position and placement of articulations relative 
to notes, the staff, and staff lines, which ensure articulations are always clearly visible. For 
the smallest articulations, such as staccato marks, correct placement relative to staff lines in 
particular is vital.

Placement of articulations

Articulations are placed on the notehead side by default, with the following exceptions:

● In single-voice contexts, marcato is always placed above the staff, regardless of the stem 
direction of the note or chord on which it is used. In multiple-voice contexts, marcato can 
also be placed below the staff.

● If multiple voices are active, articulations are placed at the end of the stem side of a note 
or chord. This clarifies which articulations belong to the up-stemmed notes and which to the 
down-stemmed notes.

● If a note is placed on the middle staff line or on the space immediately on either side, 
articulations that are less than a space in height are centered in the next unoccupied space. 
This normally only applies to staccato and tenuto. If a note in the middle of the staff has a 
staccato-tenuto articulation, the component parts of the articulation are split up and placed 
in separate spaces.

● If an articulation cannot fit within a staff space, or if the note is placed high or low on the 
staff, the articulation is placed outside the staff.

● If a note or chord is tied and the tie is placed above or below the notehead, articulations that 
are placed on the notehead side of a note or chord are offset by an additional 1/4 space in 
order to avoid the end of the tie.

Articulations on the notehead side are always centered horizontally on the notehead. This 
also applies to articulations on the stem side, except if the only articulation is a staccato or 
staccatissimo. In this case, the articulation is centered on the stem.

Articulations
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Articulations in tie chains

By default, articulations of force and stress are shown on the first note/chord in tie chains, while 
articulations of duration are shown on the last note/chord.

You can change where in tie chains articulations appear individually.

RELATED LINKS
Changing the placement of articulations relative to notes on page 664
Changing the placement of articulations relative to slurs on page 665

Order of articulations
If there are multiple articulations on the same notes, their vertical position and proximity to 
noteheads/stems depends on their type.

Articulations are positioned in the following order:

1. Articulations of duration are positioned closest to notehead/stems.

2. Articulations of force are positioned outside articulations of duration.

3. Articulations of stress are positioned furthest from noteheads/stems.

Order of articulations in relation to slurs

Articulations of duration are positioned as follows:

● Inside slurs that start/end on a note or chord with an articulation.

● Inside the curvature of a slur.

● Inside tuplet brackets.

Articulations of force are positioned as follows:

● Outside slurs that start/end on a note or chord with an articulation, except if they can be 
positioned within the staff.

● Inside the curvature of a slur if they fit between the slur and the note or stem, to which they 
belong, without colliding.

● Outside tuplet brackets.

Force and stress articulations outside the ends of the 
slur

Duration articulations inside the ends of the slur

Articulations
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Changing the positions of articulations on tie chains
You can change where in tie chains articulations appear individually. By default, articulations of 
force and stress are shown on the first note/chord in tie chains, while articulations of duration 
are shown on the last note/chord.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the tied notes/chords whose articulation position you want to change.

2. In the Articulations group of the Properties panel, activate Pos. in tie chain under the 
corresponding heading for the articulation whose position you want to change.

For example, activate Pos. in tie chain under the Articulations of force heading to change 
the position of accents.

3. Choose one of the following options:

● First note

● Last note

RESULT
The position of articulations in the selected tie chains is changed.

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560

Changing the placement of articulations relative to notes
You can change whether individual articulations are placed on the notehead side or stem side of 
notes. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/chords whose articulation placement you want to change.

2. In the Articulations group of the Properties panel, activate Placement under the 
corresponding heading for the articulations whose placement you want to change.

For example, activate Placement under the Articulations of force heading to change the 
placement of accents.

3. Select one of the following options from the menu:

● Notehead side

● Stem side
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RESULT
The articulation is placed on the selected side of the notes or chords. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain. If this 
creates a collision with other markings, such as playing techniques, Dorico SE automatically 
makes adjustments to make sure all markings are clear and legible.

Changing the placement of articulations relative to slurs
You can change whether individual articulations of duration are placed inside or outside slur 
endpoints. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

NOTE

These steps only apply to articulations of duration. They do not apply to articulations of force or 
stress.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/chords whose articulation placement you want to change.

2. In the Properties panel, activate Inside slur endpoint in the Articulations group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Articulations of duration are placed inside slur endpoints when the checkbox is activated, and 
outside slur endpoints when the checkbox is deactivated. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Slur endpoints relative to articulations on page 1019
Hiding/Showing zones on page 41
Properties panel on page 560
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Articulations in playback
Articulations affect how notes sound in playback. Depending on whether your sound library 
has specific samples for different articulations, Dorico SE changes playback in different ways to 
reflect articulations.

● If your sound library includes samples for articulations, Dorico SE loads the required samples 
using playback techniques. Additionally, Dorico SE makes notes with staccatos sound shorter 
and notes with accents sound louder.

● If your sound library does not include samples for articulations, Dorico SE adjusts notes 
according to the articulation without loading different samples. For example, making notes 
with staccatos sound shorter and notes with accents sound louder.

Articulations
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Because articulations apply to whole notes, samples are triggered at the start of notes, including 
tie chains.

TIP

You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have slurs in one voice and staccatos in 
another voice.

RELATED LINKS
Playback techniques on page 649
Enabling independent voice playback on page 460
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Bars

Bars indicate a usually regular pattern of beats, determined by the prevailing time signature. 
Bars are separated from adjacent bars by vertical barlines, and each bar has a unique bar 
number.

Dorico SE automatically numbers bars and shows barlines between bars as required for the 
prevailing time signature.

RELATED LINKS
Barlines on page 672
Bar numbers on page 677
Note and rest grouping on page 705
Time signatures on page 1084
Pick-up bars on page 1088
Input methods for bars, beats, and barlines on page 275
Input methods for time signatures and pick-up bars on page 258

Bar length
Bars usually last the same duration and start and end at the same positions for all players. 
However, some music involves bars of different lengths coinciding, and there are situations 
where some players may have no bars indicated at all.

You can change the duration of a bar by changing its time signature or, in music in open meter, 
by inputting barlines where required. You can hide time signatures you do not want to show in 
the music; for example, if you are writing music with an irregular meter and you require barlines 
only to group material together, but not to imply any sense of meter.

RELATED LINKS
Hiding/Showing time signatures on page 1096

Deleting bars/beats
You can delete whole bars and specific beats of music from your project completely by using the 
bars and barlines popover.

PROCEDURE

1. In Write mode, select one of the following:

● The first bar you want to delete, or the first note or rest in that bar.

● An item at the rhythmic position from which you want to delete beats.

2. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

3. Enter – (minus), followed by the number of bars or beats you want to delete into the 
popover.
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For example, enter –6 to delete six bars, meaning the bar you selected and the subsequent 
five bars, or -2q to delete two quarter note beats, starting from the selected rhythmic 
position.

4. Press Return  to close the popover.

RESULT
The number of bars or beats specified is deleted. Just as when Insert mode is activated, music to 
the right of the selection moves up to fill in the gap.

NOTE

● Any signposts in the selection are also deleted.

● Deleting some, but not all, beats from bars according to the prevailing time signature 
deletes the contents of those beats only. If you want to shorten a bar’s duration, such as at 
the end of flows that start with a pick-up bar, you must instead either input a time signature 
with the required number of beats then hide the time signature, or input a barline and 
delete any excess bars if necessary. You can also use the Global Adjustment of Current Bar 
Insert mode scope and delete notes/rests.

RELATED LINKS
Bars and barlines popover on page 276
Pick-up bars on page 1088
Deleting notes/items on page 412
Deleting rests on page 1012
Insert mode on page 408
Signposts on page 407
Input methods for bars, beats, and barlines on page 275
Input methods for time signatures and pick-up bars on page 258

Deleting bars/beats with the system track
You can delete whole bars and selected beats from your project completely using the system 
track.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In the system track in Write mode, select the region that you want to delete.

2. Click Delete in the system track. It can also appear above the system track if your selection is 
narrow.

Delete button in the system track The system track changes color when you hover 
over the Delete button.

RESULT
The selected region is deleted. Just as when Insert mode is activated, music to the right of the 
selection moves up to fill in the gap.
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NOTE

● Any signposts in the selection are also deleted.

● Deleting some, but not all, beats from bars according to the prevailing time signature 
deletes the contents of those beats only. If you want to shorten a bar’s duration, such as at 
the end of flows that start with a pick-up bar, you must instead either input a time signature 
with the required number of beats then hide the time signature, or input a barline and 
delete any excess bars if necessary. You can also use the Global Adjustment of Current Bar 
Insert mode scope and delete notes/rests.

RELATED LINKS
System track on page 390
Insert mode on page 408
Signposts on page 407

Deleting empty bars/beats at the end of flows
You can trim flows by deleting any empty bars or beats left at the end.

PROCEDURE

1. In Write mode, select an item in the flow you want to trim.

2. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

3. Enter trim into the popover.

4. Press Return  to close the popover.

RESULT
Empty bars/beats at the end of the selected flow are deleted.

TIP

You can also trim flows by choosing Write > Trim Flow.

RELATED LINKS
Bars and barlines popover on page 276
Splitting flows on page 432
Input methods for bars, beats, and barlines on page 275
Deleting rests on page 1012

Deleting the contents of bars
You can delete just the contents of bars without deleting barlines or the bars themselves.

PROCEDURE

1. In Write mode, select the bars whose contents you want to delete.

TIP

Notes, rests, and other objects are highlighted orange when selected.
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2. Press Backspace or Delete .

RELATED LINKS
Large selections on page 389
Filters on page 393
Insert mode on page 408

Splits in bars
You can split bars rhythmically by changing the number of beats in each bar. You can split bars 
visually across system or frame breaks, which might be required in music with an irregular meter 
or in passages of polymeter.

Splitting bars by inputting new time signatures

You can split bars into two or more bars by changing the time signature at any rhythmic 
position. New time signatures apply until the next existing time signature or the end of the 
flow, whichever comes first.

NOTE

If you change the time signature in the middle of an existing bar, we recommend inputting 
another time signature at the start of the preceding bar reflecting its new rhythmic duration to 
avoid confusion.

Splitting bars by inputting new barlines

You can also split bars by inputting new barlines that are not normal (single) barlines anywhere 
within a bar without affecting the time signature. However, inputting a normal (single) barline 
anywhere within an existing bar resets the prevailing time signature from that point onwards.

For example, selecting the third quarter note (crotchet) in a 4/4 bar and inserting a new barline 
causes a new 4/4 bar to start from the added barline. This leaves the equivalent of a 2/4 bar 
without a time signature to the left of the barline, but the bars to the right of the added 
barline are in 4/4 and continue to be in 4/4 until the next time signature or the end of the flow, 
whichever comes first.

Signposts are shown at the position of each barline that you add manually within bars.

Two 4/4 bars with quarter notes Adding a normal barline halfway through the first 
4/4 bar restarts the time signature from that point.

RELATED LINKS
Input methods for bars, beats, and barlines on page 275
Input methods for time signatures and pick-up bars on page 258
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Inserting system breaks on page 537
Inserting frame breaks on page 539
Inputting notes in Insert mode on page 212
Insert mode on page 408

Bars
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Barlines

Barlines are vertical lines that cross staves in order to show how music is divided into bars, 
according to the time signature. The most commonly used barline is the single barline between 
adjacent bars, but there are different types, such as double or repeat barlines.

The final system in a piece in 12/8 containing a key change with double barline, three normal barlines, and a 
final barline at the end

Dorico SE automatically shows barlines as required for the prevailing time signature. For 
example, Dorico SE automatically shows dashed barlines between the different meters in 
aggregate time signatures. If you change the time signature, Dorico SE moves the barlines as 
required so that subsequent music is barred correctly.

Barlines automatically extend across staff groups that are joined by a bracket or brace.

RELATED LINKS
Types of barlines on page 672
Input methods for bars, beats, and barlines on page 275
Barlines across staff groups on page 675
Repeats in playback on page 463
Repeat counts on page 983
Bars on page 667
Bar numbers on page 677
Time signatures on page 1084
Types of time signatures on page 1085
Input methods for time signatures and pick-up bars on page 258
Note and rest grouping on page 705
Deleting notes/items on page 412

Types of barlines
There are multiple types of barlines in Dorico SE, which can all be input, moved, and deleted in 
the same ways.

Normal (Single)
A standard single barline that spans the entire height of the staff. For single-line staves, 
the barline extends one space above and below the staff line by default.
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Double
A double barline consists of two lines, both the width of a single barline, positioned half 
a space apart by default. It is often used to denote significant changes in the music, or 
to mark the placement of rehearsal marks, key signature changes, and tempo changes.

Final
A final barline consists of two lines: one of normal width, the other thick. It marks 
where the music ends.

Start repeat
A start repeat line consists of a thick barline, followed by a normal barline, followed by 
one of the following arrangements of dots:

● Two dots, one each in the middle two spaces of a five-line staff

● Four dots, one each in all four spaces of a five-line staff

It shows the start of a repeated section. It is used alongside end repeat lines, which 
show the end of a repeated section.

End repeat
An end repeat line is the mirror of a start repeat line, so it consists of either two or 
four dots, followed by a normal barline, followed by a thick barline. It shows the end 
of a repeated section. It is used alongside start repeat lines, which show the start of a 
repeated section.

End/Start repeat
This line combines the start repeat and end repeat barlines, with either two single 
barlines with a single shared thick barline in the middle, or two thick barlines and no 
single barlines. On either side, there are either two or four repeat dots. It is used when 
a repeated section is immediately followed by another, separate repeated section.

RELATED LINKS
Input methods for bars, beats, and barlines on page 275
Repeats in playback on page 463
Repeat counts on page 983
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Barlines across staff groups on page 675

Changing the barline shown before repeat barlines
You can change the barline shown at the end of individual systems that are followed by start 
repeat barlines at the beginning of the next system. For example, if you want to show normal 
barlines at the end of some systems following by start repeat barlines but double barlines at the 
end of others.

These steps can also apply to barlines shown before key signature changes that coincide with 
start repeat barlines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the barlines at the end of systems followed by start repeat barlines whose barline type 
you want to change.

2. In the Properties panel, activate Barline at end of system in the Time Signatures group.

3. Select one of the following options from the menu:

● Normal

● Double

● Final

● Dashed

● Tick (top)

● Short (center)

● Thick

● Triple

● Short (top)

● Tick (bottom)

● None

RESULT
The barline type shown at the selected barlines is changed.

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Casting off on page 535
System breaks on page 537
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Barlines across staff groups
In order to make it easier to find a particular instrument within a score, barlines can extend 
across instrumental and staff groups.

Barlines across default staff groups

When a barline only appears on individual staves, it is much harder to locate individual lines at 
a glance. However, when barlines continue across instrumental groups in the score, instrument 
families are shown as blocks, which makes finding an instrument much easier.

Barlines on individual staves Barlines across instrumental groups

By default, barlines automatically extend across staff groups that are joined by a bracket or 
brace, except for vocal staves, across which barlines never automatically extend. Which staves 
are included in a bracket depends on the instrumentation and context, but usually staves for 
instruments from the same family, such as woodwind or strings, are bracketed together.

Dorico SE automatically brackets staves according to the ensemble type set for each layout.

Barlines across grand staff instruments

Dorico SE automatically joins barlines across grand staff instrument staves as they are braced. 
Because staves cannot be bracketed and braced simultaneously, grand staff instruments are 
excluded from brackets and therefore are not joined with barlines to any other staves.

Custom barline groups

You can create custom barline joins and bracket groups by manually arranging your players 
into groups. Player groups are bracketed together according to the ensemble type set for each 
layout.

RELATED LINKS
Brackets according to ensemble type on page 709
Showing barlines across all staves at time signature changes on page 676
Designating players as soloists on page 111
Adding player groups on page 145
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Adding players to groups on page 145
Deleting player groups on page 147
Player group labels on page 1036

Changing the default barline joins
You can change whether barline joins automatically extend across staff groups that are joined by 
a bracket or brace, or break between each instrument, in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default barline joins.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. In the Bracketing section, choose one of the following options for Barline joins:

● Follow primary brackets

● Separate at each instrument

5. Click Apply, then Close.

RELATED LINKS
Brackets and braces on page 707
Brackets according to ensemble type on page 709

Showing barlines across all staves at time signature changes
You can join all staves with a barline at time signature changes in individual layouts, regardless of 
your bracketing style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the time signature changes where you want to join all staves with a barline.

2. In the Properties panel, activate Barline joins all staves in the Time Signatures group.

RESULT
All staves in the layout currently open in the music area are joined by a barline at the selected 
time signature changes.

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
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Bar numbers

Bar numbers provide crucial reference points in music and make the chronological sequence 
of music clear. By providing a unique number for each bar, they enable accurate references 
to specific parts of pieces and allow players to co-ordinate themselves easily in rehearsals and 
concerts.

In Dorico SE, bar numbers appear automatically, following the most common practice of showing 
a bar number at the start of each system in all layouts by default. You can hide and show bar 
numbers in each layout independently, including showing them at a specified regular interval or 
in every bar, which is frequently used in film music scores.

TIP

The majority of options relating to bar numbers are on the Bar Numbers page in Layout 
Options. This is because it is very common to display bar numbers differently in different 
layouts, such as in every bar in full score layouts but only at the start of each system in part 
layouts.

Bar numbers shown every bar in a part layout

RELATED LINKS
Positions of bar numbers on page 681
Bar number changes on page 684
Layout Options dialog on page 622
Bars on page 667
Pick-up bars on page 1088
Barlines on page 672
Track overview on page 440

Hiding/Showing bar numbers
You can hide/show bar numbers in each layout independently, including showing them at 
different frequencies. For example, you can show bar numbers every bar in full score layouts 
but only at the start of each system in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.
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4. In the Frequency subsection, choose one of the following options for Show bar numbers:

● Every system

● Every n bars

● Every bar

● None

5. Optional: If you chose Every n bars, set a custom frequency for bar numbers by changing 
the value for Interval.

6. Click Apply, then Close.

RESULT
Bar numbers are hidden in the selected layouts when you choose None, and shown at the 
corresponding frequency when you choose any other option.

Changing the Interval value changes how frequently bar numbers are shown. For example, 
setting an interval value of 10 means that bar numbers are shown every tenth bar.

TIP

You can also hide individual bar numbers in layouts where bar numbers are shown by selecting 
them and activating Hide bar number in the Time Signatures group of the Properties panel.

RELATED LINKS
Changing the distance between bar numbers and the staff/other objects on page 682
Changing the system-relative placement of bar numbers on page 683
Hiding/Showing bar number ranges on multi-bar rests on page 679
Showing bar numbers above specific staves on page 681
Hiding/Showing guide bar numbers on page 680
Positions of bar numbers on page 681
Numbered bar regions on page 992

Hiding/Showing bar number enclosures
You can optionally show bar numbers in either a rectangular or circular enclosure in each layout 
independently; for example, if you want bar numbers to appear with rectangle enclosures in the 
full score layout, so the conductor can easily see them, but with no enclosures in part layouts, 
where pages tend to be less busy.

Bar numbers in enclosures automatically erase their backgrounds.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the bar number enclosure 
type.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Appearance subsection, choose one of the following options for Enclosure type:

Bar numbers
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● None

● Rectangle

● Circle

5. Click Apply, then Close.

RESULT
The enclosure type of all bar numbers in the selected layouts is changed.

EXAMPLE

Bar number with no enclosure Bar number with a rectangle 
enclosure

Bar number with a circle enclosure

RELATED LINKS
Layout Options dialog on page 622

Hiding/Showing bar number ranges on multi-bar rests
You can hide/show bar number ranges on multi-bar rests; for example, so it is clear in part 
layouts which bars the player does not play. Multi-bar rests can include bar repeat regions, if you 
have chosen to consolidate bar repeat regions as well as empty bars into multi-bar rests.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar number ranges on 
multi-bar rests.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Showing and Hiding subsection, activate/deactivate Show ranges of bar numbers 
under multi-bar rests and consolidated bar repeats.

5. Click Apply, then Close.

RESULT
Bar number ranges are shown beneath multi-bar rests and consolidated bar repeats in the 
selected layouts when the option is activated, and hidden when it is deactivated.

RELATED LINKS
Hiding/Showing bar numbers on page 677
Hiding/Showing multi-bar rests on page 1015
Numbered bar regions on page 992
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Hiding/Showing guide bar numbers
You can hide/show guide bar numbers on every bar and above every system in page view and 
galley view independently; for example, to make it easier to check the bar number in scores with 
many staves. Guide bar numbers are not printed.

PROCEDURE

● Hide/Show guide bar numbers in any of the following ways:

● To hide/show guide bar numbers in page view, choose View > Bar Numbers > Page 
View.

● To hide/show guide bar numbers in galley view, choose View > Bar Numbers > Galley 
View.

RESULT
Guide bar numbers are hidden/shown for every bar and above every staff in the corresponding 
view type.

EXAMPLE

Guide bar numbers shown in page view

RELATED LINKS
Switching to galley/page view on page 47

Changing the bar number paragraph style used in layouts
You can choose which paragraph style is used for bar numbers in each layout independently. By 
default, full score layouts and part layouts use different paragraph styles for bar numbers.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the paragraph style used 
for bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Appearance subsection, select a paragraph style from the Paragraph style menu.

5. Click Apply, then Close.

RESULT
The selected paragraph style is used for all bar numbers in the selected layouts.
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Positions of bar numbers
Bar numbers are typically shown at the start of each system, above the staff, and aligned with 
the initial barline.

You can change the default positions and frequency of bar numbers in each layout 
independently on the Bar Numbers page in Layout Options. For example, you might want 
to show bar numbers every bar in full score layouts but only at the start of each system in part 
layouts.

Changing the horizontal position of bar numbers
You can change the horizontal position of bar numbers in each layout independently. For 
example, you can have bar numbers centered in the middle of bars in full score layouts but 
centered on barlines in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the horizontal position of 
bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Horizontal Position subsection, choose one of the following options for Horizontal 
position:

● To show bar numbers above barlines, at the top left of the bar, choose Centered on 
barline.

● To show bar numbers above the staff, in the middle of the bar, choose Centered on bar.

5. Click Apply, then Close.

RESULT
The horizontal position of bar numbers is changed in the selected layouts.

RELATED LINKS
Showing bar numbers above specific staves on page 681

Showing bar numbers above specific staves
You can change the staves above which bar numbers appear, which allows you to show bar 
numbers at multiple vertical positions in each system. For example, in large orchestral scores, 
you might show bar numbers both at the top of the system and above the string section.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical positions of 
bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Placement subsection, activate the checkbox for each player in the Show above 
specific players list above whose top staff you want to show bar numbers.

5. Click Apply, then Close.

RESULT
The vertical positions of bar numbers are changed in the selected layouts. For players holding 
multiple instruments, bar numbers appear above their top instrument staff.

NOTE

You can change the distances between bar numbers and the staff/other objects and your vertical 
spacing settings for the gaps between staves in order to accommodate bar numbers shown 
between staves.

RELATED LINKS
Changing the default staff/system spacing on page 513
Per-layout vertical spacing options on page 530
Moving instruments on page 123

Changing the distance between bar numbers and the staff/other 
objects

You can change the minimum distance between bar numbers and the staff, and set a separate 
value for the distance between bar numbers and other objects, in each layout independently. For 
example, you can position bar numbers further from the staff/other objects in full score layouts 
than in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the minimum distance of 
bar numbers from the staff.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. Optional: In the Placement subsection, change the value for Minimum distance from staff.

5. Optional: In the Placement subsection, change the value for Minimum distance from 
other objects.

6. Activate/Deactivate Align bar numbers across width of system.

7. Click Apply, then Close.
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RESULT
Increasing the values positions bar numbers further away from the staff and/or other objects, 
either above or below the staff depending on your setting for Placement relative to staff. 
Decreasing the values positions bar numbers closer to the staff and/or other objects.

When Align bar numbers across width of system is activated, bar numbers automatically 
vertically align within systems, with their position determined by the bar number furthest from 
the staff.

NOTE

● These options affect the minimum distance between bar numbers and the staff and other 
objects, so bar numbers might be positioned further away than this to avoid collisions.

● If you want bar numbers within systems to appear closer to the staff than bar numbers at 
the start of systems, such as in part layouts with treble clefs, we recommend deactivating 
Align bar numbers across width of system.

RELATED LINKS
Hiding/Showing bar numbers on page 677

Changing the system-relative placement of bar numbers
You can show bar numbers either above or below each system in each layout independently. For 
example, bar numbers can appear below the system in full score layouts but above the system in 
individual part layouts.

NOTE

This does not affect the placement of bar numbers shown above specific staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the bar number 
placement.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Placement subsection, choose one of the following options for Placement relative to 
system:

● Show above top staff of system

● Show below bottom staff of system

5. Click Apply, then Close.

RESULT
The placement of bar numbers relative to the system is changed in the selected layouts.
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Hiding bar numbers at time signatures shown at system object 
positions

You can choose to hide bar numbers at the same rhythmic position as time signatures shown at 
system object positions, as the resulting collision can be difficult to resolve in a visually clear way 
when bar numbers are centered on barlines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide bar numbers at time 
signatures shown at system object positions.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Showing and Hiding subsection, activate/deactivate Show bar numbers at time 
signatures at system object positions.

5. Click Apply, then Close.

RESULT
Bar numbers are shown at time signatures shown at system object positions when the option is 
activated, and hidden when it is deactivated.

EXAMPLE

Bar numbers shown at time signatures at system 
object positions

Bar numbers hidden at time signatures at system 
object positions

RELATED LINKS
Time signatures on page 1084
Large time signatures on page 1089

Bar number changes
Bar numbers follow a continuous sequence, with each bar having a unique bar number that 
continues from the previous bar number. However, you can make manual changes to the bar 
number sequence, including changing to a subordinate sequence.

In Dorico SE, you can make the following types of changes to bar number sequences using the 
Insert Bar Number Change dialog:

Primary
Adds a change to the main bar number sequence, which the bars in your project follow 
in a continuous sequence in each flow separately by default.
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Subordinate
Adds a secondary bar number sequence that uses letters rather than numbers to 
indicate the sequence. This can be useful in situations where a new version of a piece 
has been created with more bars inserted, but the original bar numbers are required.

Don’t Include
Excludes the selected bar from the current bar number sequence. If bar numbers are 
shown every bar, no bar number is shown in bars in which you have chosen Don’t 
Include.

Continue Primary
Returns the bar number sequence to the Primary sequence without counting 
intervening bars; for example, after a section of bars following the Subordinate bar 
number sequence.

RELATED LINKS
Subordinate bar numbers on page 686

Adding bar number changes
You can manually add bar number changes to bar number sequences; for example, if you want 
bar numbers in the second flow in your project to appear to continue the sequence from the first 
flow, rather than start again from bar one.

PROCEDURE

1. In Write mode, select one of the following:

● An item in the bar from the beginning of which you want to change the bar number 
sequence.

● An existing bar number or barline from which you want to change the bar number 
sequence.

2. Choose Edit > Notations > Bar Numbers > Add Bar Number Change to open the Insert 
Bar Number Change dialog. You can also choose this option from the context menu.

3. Choose one of the following options for Type:

● Primary

● Subordinate

● Don’t Include

● Continue Primary

4. Optional: If you chose Primary or Subordinate, change the bar number where you want 
the bar number sequence change to start by changing the value in the corresponding value 
field.

5. Click OK to save your changes and close the dialog.

RESULT
The bar number sequence changes, starting from the beginning of the bar in which you selected 
an item, or from the position of a selected bar number or barline.

This affects the corresponding bar number sequence from the changed bar number until the 
next bar number change, or until the end of the flow.
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Deleting bar number changes
You can delete any bar number changes you have added.

PROCEDURE

1. In Write mode, select the bar number changes you want to delete.

2. Press Backspace or Delete .

RESULT
The bar number changes are deleted. Subsequent bars follow the previous bar number 
sequence until the next bar number change, or until the end of the flow.

Subordinate bar numbers
Subordinate bar numbers are useful for numbering repeat endings, and for situations when the 
music is being altered, but the original bar numbers cannot be changed.

For example, you can use subordinate bar numbers to show where music has been added if a 
previous, shorter version has already been rehearsed. In this situation, players have likely started 
to associate certain parts of the piece with particular bar numbers, so if four bars need to be 
added after bar 10, they would be numbered 10a to 10d. The bar number of the following bar 
then continues from 11 exactly as it did before the new bars were added.

They might also be useful if you want different bar numbers for a repeat ending.

Subordinate bar numbers are shown with lowercase letters.

You can show both primary bar numbers and subordinate letters or only subordinate 
alphabetical letters in subordinate bar number sequences.

Lowercase subordinate bar number

Adding subordinate bar numbers
You can create a subordinate bar number sequence that is independent of your primary bar 
number sequence. This can be useful if you want to insert new bars without changing the bar 
numbers of existing subsequent bars.

PROCEDURE

1. In Write mode, select one of the following:

● An item in the bar from the beginning of which you want subordinate bar numbers to 
start.

● An existing bar number or barline from which you want subordinate bar numbers to 
start.

2. Choose Edit > Notations > Bar Numbers > Add Bar Number Change to open the Insert 
Bar Number Change dialog. You can also choose this option from the context menu.

3. Choose Subordinate for Type to activate the Subordinate value field.
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4. Optional: If you want to change the primary bar number that accompanies subordinate bar 
numbers, activate Primary and change the value in the value field.

For example, if you want the bar number sequence 6, 7a, 7b rather than 6, 7, 7a.

5. Change the first letter in the subordinate bar number sequence by changing the value in the 
Subordinate value field.

The corresponding alphabetical letter is shown to the right of the value field. For example, 
entering 1 into the value field is shown as a, 2 appears as b, and so on.

6. Activate/Deactivate Hide primary bar numbers.

7. Click OK to save your changes and close the dialog.

RESULT
The subordinate bar number sequence starts from the bar in which you selected an item, or from 
the position of a selected bar number or barline.

● If you activated Primary and changed the value, the primary bar number shown alongside 
subordinate bar numbers is changed.

● If you deactivated Hide primary bar numbers, bar numbers in the subordinate sequence 
show both a number and an alphabetical letter. If you activated Hide primary bar numbers, 
they appear only with alphabetical letters.

For example, if you start a subordinate bar number sequence from what was originally bar 5 
without changing the Primary value, the sequence starts from 4a and continues until the next 
specified bar number change, or until the end of the flow.

Returning to the primary bar number sequence
You can specify the point where you want to return to the primary bar number sequence after a 
section of subordinate bar numbers.

PROCEDURE

1. In Write mode, select one of the following:

● An item in the bar from the beginning of which you want to return to the primary bar 
number sequence.

● An existing bar number or barline from which you want to return to the primary bar 
number sequence.

2. Choose Edit > Notations > Bar Numbers > Add Bar Number Change to open the Insert 
Bar Number Change dialog. You can also choose this option from the context menu.

3. Choose Continue Primary for Type.

Text indicating the new bar number appears below the value fields for Primary and 
Subordinate. For example, Primary sequence will continue from bar 5.

4. Click OK to save your changes and close the dialog.

RESULT
The primary bar number sequence resumes from the bar in which you selected an item, or from 
the position of a selected bar number or barline.
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TIP

You do not have to add subordinate bar number changes in chronological order. You can enter 
a return to the primary bar number sequence first, before adding the subordinate bar number 
sequence.

Bar numbers and repeats
By default in Dorico SE, repeats are not included in the bar number count. For example, if the 
first ending ends in bar 10, the second ending starts in bar 11, even though the first section is 
repeated and therefore more than ten bars have been played.

Including repeats in the bar number count, so that bar numbers reflect the total number of 
bars played rather than the number of bars written on the page, can make music with multiple 
playthroughs clearer, as you can refer to a specific bar number for each playthrough instead of, 
for example, “bar eight the third time round”.

Bar number for subsequent repeat shown in parentheses beside the initial bar number

In Dorico SE, you cannot automatically include repeats in the bar number count. However, you 
can add bar number changes manually if you want bar numbers to reflect the total number of 
bars played.

RELATED LINKS
Adding bar number changes on page 685
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Beaming

A beam is a line that connects notes with tails to show rhythmic grouping, which varies according 
to the metrical structure of the prevailing time signature.

This way of grouping notes helps performers calculate quickly exactly how to play their given 
rhythm and helps them follow both their part and, if applicable, the conductor.

If appropriate for the current meter and position in the bar, beams are automatically formed in 
Dorico SE when you input two or more adjacent notes or chords that are an eighth note (quaver) 
or shorter in duration.

Multiple beam groups in a 6/8 time signature

Dorico SE has sophisticated underlying rules for producing beam groupings that follow the 
accepted conventions of music theory, including crossing the half-bar in time signatures like 4/4, 
beaming all eighth notes together in 3/4, beam groups that include tuplets, and many other 
situations.

You can control how notes are beamed in multiple ways in Dorico SE.

● You can set beam groups by controlling subdivisions of time signatures.

● You can beam notes together and split beams manually.

RELATED LINKS
Inputting notes on page 197
Secondary beams on page 701
Tuplets within beams on page 703

Beam grouping according to meters
According to accepted conventions, notes are beamed differently in different time signatures to 
make the meter clear and easily readable. In Dorico SE, default beam groupings are determined 
by time signatures.

Dorico SE has default beaming settings for common time signatures, based on general 
conventions. For example, although the time signatures of 3/4 and 6/8 contain the same number 
of beats, they imply different meters and so are beamed differently. In 3/4, phrases of eighth 
notes are beamed together within each bar and phrases of other durations are beamed in 
quarter notes (crotchets) by default, but in 6/8, phrases are beamed in dotted quarter notes.

Default eighth note beam grouping in 3/4 Default eighth note beam grouping in 6/8
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Dorico SE groups and beams notes in irregular time signatures, such as 5/8 or 7/8, according to 
the most common practices for those time signatures.

Default beam grouping in 5/8 Default beam grouping in 7/8

For situations where you want to control the beat grouping in more detail, you can input a 
custom time signature with an explicit rhythmic subdivision. Dorico SE then automatically beams 
phrases according to this subdivision. For example, entering [7]/8 into the time signatures 
popover means all seven eighth notes (quavers) are beamed together, whereas entering 
[2+2+3]/8 subdivides the seven eighth notes into two, then two, then three.

RELATED LINKS
Note and rest grouping on page 705
Creating custom beat groupings for meters on page 705
Inputting time signatures with the popover on page 262

Beaming notes together manually
You can beam notes in the same voice together manually, including notes across barlines as 
well as system/frame breaks. For example, if you want to beam a phrase differently to how it is 
usually beamed in the prevailing time signature.

Beams by default stay within bars and systems, so to have beams cross barlines, system breaks, 
and frame breaks, you must force the phrase to beam together.

TIP

● If you want a single beam to span multiple staves, you can create cross-staff beams.

● Inputting time signatures with custom beat groupings is often the quickest and most 
consistent way to control beam grouping.

PROCEDURE

1. Select the notes you want to beam together.

2. Choose Edit > Notations > Beaming > Beam Together. You can also choose this option 
from the context menu.

RESULT
Selected notes in the same voice are beamed together, even if they cross barlines or system/
frame breaks.

If there are notes either side of the new beam group that were previously beamed to part or 
all of your selection, they either beam together as separate beams, or appear unbeamed. This 
depends on how many notes are left either side in the bar.

NOTE

● Even if part of the beamed group previously had a centered beam, the new beam is not 
centered.
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● You can assign a key command for Beam Together on the Key Commands page in 
Preferences.

EXAMPLE

Phrase with default beaming Notes in each bar beamed together

RELATED LINKS
Allowing/Disallowing tuplets to span barlines on page 1107
Changing the voice of existing notes on page 422
Centered beams on page 695
Creating cross-staff beams/tremolos on page 697
Beam grouping according to meters on page 689
Creating custom beat groupings for meters on page 705
Key Commands page in the Preferences dialog on page 54

Unbeaming notes
You can separate all notes in a beamed group so that each note shows its own tail; for example, 
if you are engraving vocal music that requires syllabic beaming.

PROCEDURE

1. Select the notes you want to make unbeamed.

2. Choose Edit > Notations > Beaming > Make Unbeamed. You can also choose this option 
from the context menu.

RESULT
The selected notes are unbeamed and show their own tails.

TIP

You can assign a key command for Make Unbeamed on the Key Commands page in 
Preferences.

EXAMPLE

Phrase with default beaming All notes unbeamed
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Splitting beam groups
You can split beams into two beam groups at specific rhythmic positions. You can also split 
secondary beams within beamed groups.

PROCEDURE

1. Select the noteheads to the right of where you want to split beams.

2. Split the beam or secondary beam in one of the following ways:

● Choose Edit > Notations > Beaming > Split Beam.

● Choose Edit > Notations > Beaming > Split Secondary Beam.

TIP

You can also choose these options from the context menu.

RESULT
Beams/Secondary beams are split to the left of each selected note, but the notes either side of 
the split remain grouped if there are at least two beamed notes on each side that can be in a 
beam group.

TIP

● To unbeam the entire selection and give all notes in the group individual tails, you can make 
all notes unbeamed.

● You can assign key commands for Split Beam and Split Secondary Beam on the Key 
Commands page in Preferences.

EXAMPLE

Phrase with default beaming Two beams split at the second 16th note

RELATED LINKS
Beam grouping according to meters on page 689
Key Commands page in the Preferences dialog on page 54

Resetting beam grouping
You can remove all changes made to the beam grouping of notes and chords. This can also be 
useful if, for example, MusicXML files you have imported have incorrect beaming.

PROCEDURE

1. Select the notes/chords whose beaming you want to reset.

2. Choose Edit > Notations > Beaming > Reset Beaming. You can also choose this option 
from the context menu.
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RESULT
Beam grouping is reset to the default settings.

Beam placement relative to the staff
The default staff-relative placement of beams is determined by the staff positions of the notes 
within the beamed group and their resulting stem directions.

This means that the note furthest from the middle line of the staff determines the placement of 
the beam, although there are exceptions to this rule and other considerations that can influence 
the staff-relative placement of beams.

Changing the staff-relative placement of beams involves changing the direction of the stems in 
the beam. Therefore, Dorico SE categorizes changing the staff-relative placement of beams as a 
stem change.

Changing the staff-relative placement of beams
You can change the side of the staff on which beams appear by forcing the stem direction to 
change. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each of the beamed phrases whose staff-relative placement you 
want to change.

2. Force the stem direction of notes in the selected beams in any of the following ways:

● Choose Edit > Notations > Stem > Force Stem Up.

● Choose Edit > Notations > Stem > Force Stem Down.

TIP

● You can also choose these options from the context menu.

● You can also change the staff-relative placement of selected beams by pressing F .

RESULT
The beam appears on the side of the staff that corresponds to its forced stem direction. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
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Removing beam placement changes
You can undo changes to the staff-relative placement of beams in order to remove the stem 
direction change. This reverts selected beams to their default placement.

PROCEDURE

1. Select at least one note in each of the beamed phrases whose staff-relative placement 
change you want to remove.

2. Choose Edit > Notations > Stem > Remove Forced Stem. You can also choose this option 
from the context menu.

RESULT
The selected beams revert to their default staff-relative placement.

Beam slants
The slant of a beam controls how steeply the beam deviates from horizontal, according to the 
pitches of the notes within the beamed group.

● When the last note of the phrase is higher than the first, the beam slants upwards.

● When the last note of the phrase is lower than the first, the beam slants downwards.

● If the group makes a concave shape, where inner notes are closer to the beam than the 
outer ones at either end of the beam, then the beaming is horizontal by default.

Beams are also horizontal if all the pitches are the same, or for certain patterns of repeated 
pitches.

When a beam is drawn inside the staff, each end of the beam, meaning the end of the stem of 
the note at either end of the beam, must be snapped to a staff line position. A beam line may 
sit on a staff line, be centered on a staff line, or hang from a staff line. Ted Ross describes these 
three positions as “sit”, “straddle”, and “hang” respectively in “Teach Yourself the Art and Practice 
of Music Engraving”.

A phrase containing multiple different beam slants and directions

The amount by which a beam slants is typically determined by the interval between the first and 
last note in the beamed group, provided the pattern of notes in the beam does not dictate a 
horizontal beam instead. Smaller intervals require a shallower slant and larger intervals require a 
steeper one.

However, the desired amount of slant is not the only factor that must be considered. The 
innermost beam line should not come too close to the innermost notehead, and the beam itself, 
if possible, should be positioned relative to the staff lines such that it does not form a wedge. A 
wedge is a tiny triangle formed by the horizontal staff line, the vertical stem, and the angled line 
of the slanted beam, which can be visually confusing.

Determination of the amount of slant for a beam is therefore a balancing act that must weigh up 
several factors: the desired amount of slant, valid snapping positions for each end of the beam, 
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ensuring a minimum distance between the note closest to the beam and the innermost beam 
line, and avoiding wedges where possible.

In Dorico SE, you can change the beam slants of individual beams.

Changing beam slants
You can change the slants, or angles, of individual beams. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each beam group whose slant you want to change.

2. In the Properties panel, activate Beam direction in the Beaming group.

3. Select one of the following options from the menu:

● Flat

● Up

● Down

RESULT
The slants of the selected beams are changed while retaining correct positions relative to staff 
lines. If the property scope was set to Locally, this change only takes effect in the current layout 
and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Centered beams
Centered beams are beams that are vertically positioned between notes within the same beamed 
group, with stems for notes above the beam pointing downwards and stems for notes below the 
beam pointing upwards.

Centered beams are also known as “kneed” or “elbowed” beams due to their often angular 
shape.

When a beamed phrase spans a large pitch range, normal beams are often positioned very close 
to some notes in the phrase but very far from other notes in the phrase, making some stems 
very long. Having a centered beam in a phrase that spans a large pitch range can reduce the 
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maximum distance between noteheads and the beam, but can also place the beam within the 
staff, which can obscure staff lines.

By default, Dorico SE allows beams that include notes on both sides of the middle staff line to 
appear centered. You can also create custom centered beams for beams that include notes only 
on one side of the middle staff line.

A phrase with high and low notes with default 
beaming

The same phrase with high and low notes, but with a 
centered beam

TIP

To center beams between the staves of grand staff instruments, you can create cross-staff 
beams.

RELATED LINKS
Changing the staff-relative placement of beams on page 693
Creating cross-staff beams/tremolos on page 697

Creating centered beams
You can center beams between the notes in the beamed group. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

NOTE

As this action requires changing the direction of some stems in order to appear correctly, it is 
located in the Stem submenu rather than the Beaming submenu.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each of the beams you want to center.

2. Create a centered beam in one of the following ways:

● If the selected beams include notes on both sides of the middle staff line, choose Edit > 
Notations > Stem > Force Centered Beam.

● If the selected beams include notes only on one side of the middle staff line, choose 
Edit > Notations > Stem > Custom Centered Beam to open the Custom Centered 
Beam dialog.

TIP

You can also choose these options from the context menu.
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3. Optional: If you created a custom centered beam, change the stem direction of each note in 
the selected beams as required in the Custom Centered Beam dialog, then click OK.

RESULT
Beams are centered between the notes in the selected beam groups. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

If you select notes in multiple beams, each beam is centered separately. If you want to create a 
single centered beam, you can beam the notes in those beam groups together. You can do this 
both before and after centering the beams.

NOTE

● Dorico SE automatically angles the beam based on the shape of the phrase, but you can 
change the angles or slants of beams manually.

● You can assign a key command for Force Centered Beam on the Key Commands page in 
Preferences.

RELATED LINKS
Beaming notes together manually on page 690
Changing beam slants on page 695
Removing stem direction changes on page 858

Removing centered beams
You can remove centered beams and revert beams to their default placements either above or 
below the phrase.

PROCEDURE

1. Select at least one note in each centered beam that you want to revert to the default 
placement.

2. Choose Edit > Notations > Stem > Remove Centered Beam. You can also choose this 
option from the context menu.

RESULT
The centered beams are removed.

TIP

You can assign a key command for Remove Centered Beam on the Key Commands page in 
Preferences.

Creating cross-staff beams/tremolos
Cross-staff beams and cross-staff tremolos work in a similar way to normal beams and tremolos, 
but allow a phrase that covers a wide pitch range to be shown on multiple staves. You can create 
cross-staff beams/tremolos by inputting all notes in the phrase on one staff and crossing some 
notes to appear on another staff.

PREREQUISITE
You have input a phrase on one staff.
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PROCEDURE

1. Select the notes you want to cross to another staff.

NOTE

You can only cross notes to other staves held by the same player.

2. Cross the notes to other staves in any of the following ways:

● To cross notes to the staff above, press N .

● To cross notes to the staff below, press M .

● Choose Edit > Notations > Cross Staff > Cross to Staff Above.

● Choose Edit > Notations > Cross Staff > Cross to Staff Below.

TIP

You can also choose these options from the context menu.

RESULT
The selected notes are shown on a different staff, with a cross-staff beam shown if the notes are 
part of a beam group. This does not change the staff to which the notes belong.

NOTE

● When crossing notes to a staff that already contains notes, the stem direction of the existing 
notes on the staff can change. This is due to how multiple voices at the same rhythmic 
position are handled. Therefore, you may have to change the stem direction of notes 
manually.

● If you want notes to belong to a different staff, you can move them to another staff.

EXAMPLE

Notes shown on their original staves Cross-staff beams created by crossing some notes to 
the other staff

RELATED LINKS
Resetting notes crossed to other staves on page 701
Moving notes/items to other staves on page 421
Moving notes/items rhythmically on page 417
Notes crossed to staves with existing notes in other voices on page 1138
Note positions in multiple-voice contexts on page 1136
Inputting notes on page 197
Stem direction on page 854
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Hiding/Showing voice colors on page 1135
Tremolos on page 1099

Changing to optical cross-staff beam spacing
You can make the stems in cross-staff beams, rather than the noteheads, evenly spaced in each 
layout independently. This can make it easier to perceive the evenness of rhythmic spacing in 
cross-staff beams than when noteheads are evenly spaced.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts that you want to change to optical cross-staff beam 
spacing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Note Spacing.

4. Activate Use optical spacing for beams between staves.

5. Click Apply, then Close.

RESULT
Optical cross-staff beam spacing is enabled in the selected layouts.

EXAMPLE

Default spacing: The distance between noteheads is 
even.

Optical spacing for cross-staff beaming: The distance 
between stems is even.

RELATED LINKS
Note spacing on page 533

Cross-staff beam placement in multiple staves
When instruments have three or more staves, cross-staff beams can be placed in multiple ways. 
For example, the beam can be placed between the top and the middle staves, and also between 
the middle and bottom staves.

If a beam only crosses two staves, the cross-staff beam goes between those two staves.
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A cross-staff beam across the upper two staves on 
an instrument with three staves

A cross-staff beam across the lower two staves on an 
instrument with three staves

If a beam group contains notes on all three staves, the placement of the beam depends on the 
stem directions of the notes in each staff.

1 If all notes in the beam group are stem-up, the beam is placed above the top staff.

2 If all notes in the beam group are stem-down, the beam is placed below the bottom staff.

3 If notes are stem-down on the top staff and stem-up on the bottom two staves, the beam is 
placed between the top and middle staves.

4 If notes are stem-down on the top two staves and stem-up on the bottom staff, the beam is 
placed between the bottom and middle staves.

NOTE

If you have not specified stem directions, Dorico SE might place the beam above/below the staff 
into which the notes were originally input, even if the stem directions mean it should be placed 
between other staves.

If you want the beam to be placed between specific staves, you can change the stem directions 
of notes in the beam group.

RELATED LINKS
Changing the stem direction of notes on page 856
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Resetting notes crossed to other staves
You can reset notes that have been crossed to other staves so that they appear on their default 
staff. We recommend resetting cross-staff notes before copying and pasting them to other 
staves to avoid unexpected beaming.

PROCEDURE

1. Select the cross-staff notes you want to reset.

2. Choose Edit > Notations > Cross Staff > Reset to Original Staff. You can also choose this 
option from the context menu.

RESULT
The selected cross-staff notes are reset and appear on their default staff.

TIP

You can assign a key command for this option on the Key Commands page in Preferences.

Beam corners
Beam corners can occur when a change of stem direction within a beam is combined with a 
break in the secondary beam group. This can be at the end of a subdivision or at a change in 
rhythmic speed.

Beam corners do not follow accepted rules regarding the order and rhythmic meaning of 
secondary beams, and can be confusing for the reader.

Dorico SE avoids beam corners by analyzing the pitches and stems within a phrase, and 
implementing stem directions that avoid a beam corner.

Secondary beams
Secondary beams are the lines that are added between the primary beam and the notehead as 
the rhythmic division gets smaller.

The primary beam is the outermost beam line that joins all of the notes in the beamed group. 
Depending on the durations of the notes in the beamed group, the primary beam may in fact be 
two or more lines; that is, for notes of a 16th or shorter in duration.

Secondary beams are additional beam lines that join only some of the notes in the group, 
creating subdivisions of the beam in order to make the metrical groupings of the beam clearer.
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A phrase of 64th notes, with secondary beams subdivided to show 16th and eighth note groups

Changing the direction of partial beams
Dorico SE automatically inputs a partial beam if one is required. You can change on which side of 
stems individual partial beams appear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the notes whose partial beam direction you want to change.

2. In the Properties panel, activate Partial beam direction in the Beaming group.

3. Choose one of the following options:

● Left

● Right

RESULT
The partial beam appears on the corresponding side of the stem.

EXAMPLE

Partial beam direction Left Partial beam direction Right

Changing the number of beam lines in secondary beams
You can change the number of beam lines shown in secondary beams individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the notes to the right of where you want to change the number of secondary beaming 
lines.

2. Optional: If any of the notes you selected do not immediately follow existing splits in the 
secondary beam, split the secondary beams in any of the following ways:

● In the Properties panel, activate Split secondary beam in the Beaming group.

Beaming
Secondary beams 
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NOTE

The Beaming group is only shown in the Properties panel if your selection only contains 
notes.

● Choose Edit > Notations > Beaming > Split Secondary Beam. You can also choose this 
option from the context menu.

3. In the Properties panel, select the note value that corresponds to the number of beam lines 
you want shown from the Split secondary beam menu.

RESULT
The number of beam lines shown immediately to the left of each selected note is changed.

NOTE

● Deactivating the property returns the selected notes to showing their default number of 
beam lines.

● The number of beam lines shown at a split in the secondary beam cannot be the same or 
greater than the number of beam lines in the secondary beam. For example, if you split a 
secondary beam containing 64th notes, the maximum number of beam lines shown at the 
split in that beam is three, the equivalent of 32nd notes.

RELATED LINKS
Resetting beam grouping on page 692

Tuplets within beams
Tuplets that contain notes that produce beams, such as eighth notes, are beamed together. 
However, special beam grouping rules apply to tuplets within beams that also contain non-tuplet 
notes.

The default setting for a tuplet in a beamed group with secondary beams is to split the secondary 
beam and to show the tuplet with a bracket. The primary beam is not split. If necessary, you can 
hide/show tuplet brackets individually.

The default setting for a tuplet in a beamed group with only a primary beam is to separate the 
tuplet entirely.

16th note triplet beamed together with non-tuplet 
16th notes

Eighth note (quaver) triplet beamed separately from 
non-tuplet eighth notes

RELATED LINKS
Tuplets on page 1104
Tuplet brackets on page 1109
Tuplet numbers/ratios on page 1112

Beaming
Tuplets within beams 
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Stemlets
Stemlets are short stems that extend from beams to rests within beam groups. They can help 
make music easier to read, as they help to maintain a regular pattern of stems within beams.

In the examples, beaming all notes and rests together to show the boundaries of quarter note 
(crotchet) beats makes the syncopation of the notes easier to read. The stemlets on the rests 
help make clear where within the quarter note beats each note occurs.

A syncopated phrase without stemlets The same phrase with stemlets

In Dorico SE, you cannot add stemlets or change where they are shown. However, stemlets are 
shown if you import or open a project that contains them.

Fanned beams
Fanned beams show either an accelerando or rallentando by having multiple beam lines either 
converging on, or diverging from, a single beam line at the other end. Fanned beams are also 
known as “feathered beams”.

A single fanned beam can have multiple changes of direction within it.

The grouping can use either two or three beams, with three beams indicating a greater change 
of speed than two beams. The slowest part of the phrase is where the beams converge, and the 
fastest is where the beams are the most spread out.

In Dorico SE, you cannot create fanned beams or change their direction. However, fanned beams 
are shown if you import or open a project that contains them.

EXAMPLE

Fanned beam accelerando with three lines

Fanned beam accelerando with two lines

Fanned beam rallentando with three lines

Fanned beam rallentando with two lines

Beaming
Stemlets 
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Note and rest grouping

There are generally accepted conventions for how notes and rests of different durations are 
notated and grouped in different contexts and meters. In Dorico SE, notes are automatically 
notated to fit within bars.

Depending on the prevailing time signature, there can be many different ways to beam notes 
together. For example, you might want to beam all notes in the bar together in time signatures 
that cannot be divided in half and are often not divided at all, such as 3/4.

A passage containing different meters. Notes are grouped and beamed differently in the different meters, 
and notes that cross beats and barlines are automatically shown as tied notes.

There are also different conventions for how notes within tie chains should be divided to indicate 
significant beat boundaries within bars, and in which contexts they can cross beat boundaries.

Similar options apply to dotted notes, which are often notated as a single dotted note if they 
start at the beginning of bars, but as a tie chain that shows significant beat boundaries in the bar 
if they start part-way through bars.

TIP

You can specify custom beat groupings within individual time signatures.

RELATED LINKS
Beaming on page 689
Beam grouping according to meters on page 689
Forcing the duration of notes/rests on page 238
Types of time signatures on page 1085
Numbered bar regions on page 992

Creating custom beat groupings for meters
If your music requires a different beat grouping for a particular meter than the default setting 
for that time signature, you can specify your preferred beat grouping within the time signature. 
You can choose whether or not the time signature shows this custom beat grouping. You can 
also input time signatures only on single staves.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature with 
custom beat grouping. If you want to input a time signature with custom beat grouping 
on a single staff, select an item that belongs to that staff only.
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2. Optional: If you want to input a time signature with custom beat grouping onto multiple 
specific staves at once, extend the caret to those staves.

3. Optional: If you want Dorico SE to add beats at the end of the region affected by the new 
time signature if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

4. Open the time signatures popover in any of the following ways:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

5. Enter the division you want in square brackets into the popover.

For example, to divide a 7/8 time signature into 2+3+2, enter [2+3+2]/8 into the popover. To 
divide a 5/4 time signature into 2+3 rather than 3+2, enter [2+3]/4 into the popover.

6. Input the time signature and close the popover in one of the following ways:

● To input a time signature on all staves, press Return .

● To input a time signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
The time signature specified is input and beam and beat grouping in subsequent bars follows the 
division you specified.

TIP

You can change the appearance of numerators in individual time signatures so that they show a 
single number or beat groups.

RELATED LINKS
Time signatures popover on page 258
Time signature styles on page 1091

Note and rest grouping
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Brackets and braces

Brackets and braces are thick straight and curved lines in the left-hand margin that show 
instrument groupings.

Brackets

A bracket is a thick black line, the width of a beam, that groups staves together, most commonly 
according to instrument family. It often has winged ends that point inwards towards the score.

It is always positioned directly to the left of a systemic barline. If secondary brackets are used 
in addition to a bracket, they are positioned further away from the start of the system to allow 
space for the bracket.

An example of a bracket, connecting instruments in the string family. A sub-bracket connects the two violin 
lines.

By default in Dorico SE, barlines join the same staves that are joined by brackets and braces, 
meaning that bracketed groups of staves and braced pairs of staves appear with barlines 
extending across the group.

Braces

A brace is a wavy or curly line that joins multiple staves belonging to the same instrument, 
usually a grand staff instrument such as the piano or harp. If necessary, a brace can extend to 
three or more staves, although two is most common.

The brace is also sometimes used instead of a sub-bracket to show groupings of identical 
instruments within a family whose staves are joined by a bracket.

It is positioned outside the systemic barline, and if used in place of a sub-bracket, outside of the 
bracket as well.
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A brace connecting two piano staves

NOTE

● Staves cannot be bracketed and braced simultaneously. Therefore, braced staves are 
excluded from bracketed groups. They also cannot show sub-brackets or sub-sub-brackets.

● System objects are only shown above instrument families that are bracketed or braced 
together.

● Blank staves can only show brackets/braces when they are shown after final flows. You 
cannot show brackets/braces on blank staves in music frames.

RELATED LINKS
Barlines across staff groups on page 675
Player groups on page 144
Adding player groups on page 145
Brackets according to ensemble type on page 709
Changing the default barline joins on page 676
System objects on page 1044
Staff labels on page 1029
Player group labels on page 1036

Changing bracket grouping according to ensemble type
You can change which staves are included in brackets by changing the ensemble type for each 
layout independently; for example, if a part layout containing all percussion players requires 
different bracketing than used for percussion staves in the full score layout.

The default setting is Orchestral. We recommend that you change this setting for projects 
containing small ensembles.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the ensemble type for 
bracket grouping.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. Choose one of the following options for Ensemble type:

● No brackets

● Orchestral

● Small ensemble

Brackets and braces
Changing bracket grouping according to ensemble type 
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● Wind band

● Big band

● British brass band

5. Click Apply, then Close.

RESULT
The default bracket grouping is changed in the selected layouts.

TIP

● There are further options for bracketing on the Brackets and Braces page, such as hiding/
showing brackets when there is only a single instrument in the bracket group and hiding/
showing braces when only a single staff is shown.

● Player groups and soloists also influence which staves are bracketed together.

● You can also input custom bracket/brace grouping for specific staves, independently of the 
bracket grouping setting in the layout. However, you cannot change brackets/braces on 
blank staves.

RELATED LINKS
Barlines across staff groups on page 675
Hiding/Showing blank staves after final flows on page 517
Player groups on page 144
Designating players as soloists on page 111
Staff labels on page 1029
Player group labels on page 1036

Brackets according to ensemble type
In Dorico SE, default staff grouping is determined by the ensemble type chosen for each layout. 
This affects which staves are bracketed together and joined by barlines.

The following ensemble types are available on the Brackets and Braces page in Layout 
Options:

No brackets
All staves appear separately, with no brackets. Grand staff instruments are still shown 
with braces.

This is the default setting for full score layouts in projects started from Solo and small 
Jazz project templates.

Orchestral
Staves are bracketed according to their instrument family. For example, adjacent string 
instruments are bracketed together separately from adjacent woodwind instruments. 
However, vocal staves are not joined by barlines.

This is the default setting for all layouts in new projects and projects started from 
Orchestral, Choral and Vocal, and Concert band project templates, and for custom 
score and part layouts in projects started from all other project templates.

Small ensemble
All staves in the project are bracketed together, regardless of their instrument family, 
excluding braced staves.

Brackets and braces
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This is the default setting for full score layouts in projects started from Chamber and 
Pit band project templates.

Wind band
Staves are bracketed according to their instrument type. For example, Flute 1 and Flute 
2 are bracketed together, but separately from the other woodwind instruments.

Big band
Staves are bracketed according to their instrument family, except for brass 
instruments, which are all bracketed according to their instrument type.

Rhythm section instruments are bracketed together.

Percussion and timpani are bracketed together.

British brass band
Brass instruments are bracketed according to their instrument type, except for horns 
and trumpets, which are bracketed together.

Any other instruments in the score are bracketed according to their instrument family.

Percussion and timpani are bracketed separately.

This is the default setting for full score layouts in projects started from the Big band 
project template.

NOTE

● Staves cannot be bracketed and braced simultaneously. Therefore, braced staves, such as 
the piano and other grand staff instruments, are excluded from brackets. They also split 
brackets if they are placed within a bracketed group.

● By default, there must be at least two adjacent instruments to show a bracket. You 
can choose to show brackets on single instruments in each layout independently on the 
Brackets and Braces page in Layout Options.

● Player groups and soloists also influence which staves are bracketed together.

● Vocal staves are never joined by barlines, even when bracketed together.

● System objects are only shown above instrument families that are bracketed or braced 
together.

RELATED LINKS
Layout Options dialog on page 622
Project templates on page 73
System objects on page 1044

Secondary brackets
Secondary brackets are a second level of staff grouping. They are positioned to the left of 
brackets and allow you to mark groups of staves within a bracketed group. In Dorico SE, 
secondary brackets can appear as a brace or as a sub-bracket.

By default, secondary brackets appear as sub-brackets: thin lines with square corners that extend 
beyond the bracket. You can change the appearance of secondary brackets and hide/show them 
for adjacent identical instruments in bracketed groups in each layout independently.

Brackets and braces
Secondary brackets 
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Secondary bracket as a sub-bracket Secondary bracket as a brace

NOTE

You cannot show sub-sub-brackets in addition to braces, you can only show sub-sub-brackets in 
addition to sub-brackets.

Hiding/Showing secondary brackets
You can hide/show secondary brackets for adjacent identical instruments in bracketed groups 
in each layout independently. You can also choose only to show secondary brackets when sub-
bracketed groups contain at least two staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show secondary brackets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. Choose one of the following options for Instruments of the same kind within a bracketed 
group:

● Use secondary brackets

● No secondary brackets

5. Choose one of the following options for When only one staff of sub-bracketed group is 
shown:

● Draw sub-bracket

● Do not draw sub-bracket

6. Click Apply, then Close.

RESULT
Secondary brackets are shown in the selected layouts when you choose Use secondary 
brackets, and hidden when you choose No secondary brackets.

If you chose Use secondary brackets and Do not draw sub-bracket, secondary brackets are 
only shown when sub-bracketed groups contain at least two staves.

Brackets and braces
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Showing secondary brackets as sub-brackets/braces
Secondary brackets extend beyond brackets, allowing you to mark groups of staves within a 
bracketed group. You can show secondary brackets as either braces positioned outside the 
bracket or as sub-brackets in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the appearance of 
secondary brackets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. Choose one of the following options for Secondary bracket appearance:

● Brace

● Sub-bracket

5. Click Apply, then Close.

RESULT
The appearance of all secondary brackets in the selected layouts is changed.

NOTE

Because you cannot show sub-sub-brackets in addition to braces, sub-sub-brackets are not 
shown in layouts where sub-brackets appear as braces.

Sub-sub-brackets
Sub-sub-brackets are a tertiary level of staff grouping with the same design as sub-brackets. They 
are positioned outside of both brackets and sub-brackets, allowing you to mark groups of staves 
within bracketed and sub-bracketed groups. Sub-sub-brackets can only appear as brackets in 
Dorico SE.

Sub-sub-brackets cannot extend beyond their sub-bracket and cannot be shown on staves with a 
brace as either the primary or secondary group.

Brackets and braces
Sub-sub-brackets 
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Chord symbols

Chord symbols describe the vertical harmony of the music at a specific moment. They 
are frequently used in jazz and pop music, where players often improvise around chord 
progressions.

Chord symbols shown above slashes on the Clarinet and Piano staves to help the players improvise around 
the notated Cornet melody.

You can input chord symbols using the chord symbols popover and you can automatically 
generate chord symbols based on existing music.

In Dorico SE, chord symbols exist globally at the corresponding rhythmic positions by default. 
This means that you only have to input chord symbols once, but they can appear above multiple 
or no staves as required. However, in some circumstances it is necessary to show different chord 
symbols for different players at the same rhythmic position. In such cases, you can input local 
chord symbols.

Dorico SE automatically shows the appropriate chord symbols for transposing instruments in 
transposing layouts, including for fretted instruments whose transposition you have changed to 
reflect a capo. You can also define capos for chord symbols and show only main chord symbols, 
only capo chord symbols, or both.

You can hide/show chord symbols project-wide above specific instrument staves, including if 
multiple instruments belong to the same player, and in different layouts. You can also show 
chord symbols only within chord symbol/slash regions and hide/show individual chord symbols.

If you have input chord symbols but no players in the current layout are set to show them, they 
are indicated by signposts.

Depending on the style of music, there are different conventions regarding how to present chord 
names.

Dorico SE provides a single default chord symbol appearance preset that applies to all chord 
symbols.

RELATED LINKS
Inputting chord symbols on page 291
Hiding/Showing chord symbols on page 714
Chord diagrams on page 727
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Capos on page 128
Capo vs. main chords on page 128
Hiding/Showing signposts on page 407
Chords track on page 452
Enabling chord symbol playback on page 453

Chord components
Chord symbols consist of a root and a quality, with intervals, alterations, and an altered bass note 
included if required.

Root
The root note of the chord, expressed either as a note name or as a specific degree of a 
scale.

Quality
Defines the type of chord, such as major, minor, diminished, augmented, half-
diminished, or with added note, such as six or nine.

Interval
Chord symbols can include one or more added intervals, such as a major seventh or 
ninth. Intervals in chord symbols are also known as “extensions”.

Alterations
Define notes in chords that are different to what is normally expected of that chord. 
For example, a sharpened fifth, flattened ninth, suspensions, or omissions.

Altered bass note
A chord symbol has an altered bass note if the lowest pitch of a chord is not its root 
note, such as Cm7♭5/E♭.

Positions of chord symbols
In layouts where chord symbols are shown, they are positioned either above all instrument 
staves set to show chord symbols or only above the top staff in each system.

By default, chord symbols are left-aligned with noteheads.

Alignment of chord symbols across the system

Chord symbols are aligned at the same vertical position across the width of the system by 
default.

RELATED LINKS
Hiding/Showing capo chord symbols on page 133
Moving notes/items rhythmically on page 417
Chord symbol regions on page 718

Hiding/Showing chord symbols
You can hide/show chord symbols above particular staves or only within chord symbol/slash 
regions project-wide on a per-player basis. By default, chord symbols appear above rhythm 
section instrument staves, such as keyboards, guitars, and bass guitars.

Any player on whose staff you input chord symbols is automatically set to show chord symbols 
for all instruments and in the current layout type.

Chord symbols
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PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to hide/show chord 
symbols.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show chord symbols above all instrument staves held by the player, choose Chord 
Symbols > Show for All Instruments.

● To show chord symbols only above rhythm section instrument staves held by the player, 
choose Chord Symbols > Show for Rhythm Section Instruments.

● To show chord symbols only in chord symbol/slash regions on instrument staves held by 
the player, choose Chord Symbols > Show in Chord Symbol and Slash Regions.

● To hide chord symbols above all instrument staves held by the player, choose Chord 
Symbols > Hide for All Instruments.

RESULT
Chord symbols are hidden/shown above the corresponding instrument staves held by the 
selected player, depending on the layouts in which chord symbols are shown for that player 
in your project.

TIP

● You can also right-click players and choose these options from the context menu.

● You can choose to show chord symbols only once at the top of each system in each layout 
independently.

● You can also hide/show individual chord symbols in layouts where chord symbols are shown 
by selecting them and activating Hidden in the Chord Symbols group of the Properties 
panel. Signposts are shown at the position of each hidden chord symbol. However, signposts 
are not printed by default.

You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Players panel on page 94
Layouts on page 151
Inputting chord symbols on page 291
Chord symbol regions on page 718
Inputting chord symbol regions on page 299
Inputting slash regions on page 384
Signposts on page 407
Hiding/Showing chord diagrams on page 728
Showing only chord symbols or chord diagrams on page 730
Showing chord symbols above one/multiple staves on page 716
Changing the staff-relative placement of chord symbols on page 717
Capo vs. main chords on page 128
Hiding/Showing capo chord symbols on page 133
Key Commands page in the Preferences dialog on page 54
Layout Options dialog on page 622

Chord symbols
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Hiding/Showing chord symbols in layouts
You can hide/show chord symbols in different types of layouts. By default, chord symbols appear 
in all applicable layouts for rhythm section instruments.

NOTE

If chord symbols are hidden for all instruments in the current layout, signposts are shown above 
the top staff.

PROCEDURE

1. In Setup mode, select a player in the Players panel.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show chord symbols for the selected player in all layouts, choose Chord Symbols > 
Show in Full Score and Parts.

● To show chord symbols for the selected player only in full score/custom score layouts 
and not in part layouts, choose Chord Symbols > Show in Full Score Only.

● To show chord symbols for the selected player only in part layouts and not in full score/
custom score layouts, choose Chord Symbols > Show in Parts Only

TIP

You can also right-click players and choose these options from the context menu.

Showing chord symbols above one/multiple staves
You can choose to show chord symbols above all instrument staves set to show chord symbols or 
only above the top staff in each system in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
chord symbols.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Symbols section, choose one of the following options for Show chord 
symbols:

● Above specific players’ staves

● Above top staff of system

5. Click Apply, then Close.

RESULT
The vertical position of chord symbols is changed in the selected layouts.

Chord symbols
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RELATED LINKS
Inputting chord symbols on page 291
Showing only chord symbols or chord diagrams on page 730
Capo vs. main chords on page 128
Hiding/Showing capo chord symbols on page 133

Changing the alignment of chord symbols relative to notes
You can change the horizontal alignment of individual chord symbols relative to notes. For 
example, you might center-align wide chord symbols to avoid collisions with barlines. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose alignment you want to change.

2. In the Properties panel, activate Alignment in the Chord Symbols group.

3. Select one of the following alignment options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the selected chord symbols is changed. Note spacing is automatically adjusted 
to avoid collisions with adjacent chord symbols.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

EXAMPLE

Left-aligned G#dim7 chord symbol 
on beat 3

Center-aligned G#dim7 chord 
symbol on beat 3

Right-aligned G#dim7 chord 
symbol on beat 3

Changing the staff-relative placement of chord symbols
You can show individual chord symbols either above or below the staff. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Chord symbols
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● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose staff-relative placement you want to change.

2. In the Properties panel, activate Placement in the Chord Symbols group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of the selected chord symbols is changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can choose to show chord symbols between the staves of grand staff instruments in each 
layout independently in Layout Options > Chord Symbols and Diagrams > Chord Symbols.

RELATED LINKS
Layout Options dialog on page 622
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Chord symbol regions
Chord symbol regions specify passages where you want to show chord symbols. They are 
particularly useful for players and layouts that do not need chord symbols for most of the project 
but have improvisation sections that require chord symbols to be shown.

Chord symbol regions allow you to show chord symbols only where players require them, instead 
of showing chord symbols throughout the project and manually hiding the ones you do not want 
to show.

When you input chord symbol regions in Dorico SE, the corresponding players are automatically 
set to show chord symbols in chord symbol/slash regions. This is because it is common to use 
both slashes and chord symbols to aid players in improvisation sections. Any chord symbols 
outside chord symbol/slash regions are automatically hidden and are indicated by signposts.

By default, chord symbol regions are highlighted with a solid colored line above the top staff line 
and a colored background. As you zoom out, the colored backgrounds become more opaque, 
which is especially useful when viewing full score layouts in galley view. These highlights are 
considered annotations, are not printed by default, and you can hide/show them.

Chord symbol region followed by chord symbol signposts after the end of the chord symbol region

Chord symbols
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In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

Handles on a selected chord symbol region

RELATED LINKS
Inputting chord symbol regions on page 299
Slash regions on page 997
Hiding/Showing chord symbols on page 714
Hiding/Showing signposts on page 407
Annotations on page 507

Hiding/Showing chord symbol region highlights
You can hide/show colored highlights for chord symbol regions at any time; for example, if you 
want to show the highlights when inputting music but hide them when engraving.

PROCEDURE

● Choose View > Highlight Chord Symbol Regions.

Transposing chord symbols
You can transpose chord symbols after you have input them, independently of any notes.

TIP

● Dorico SE automatically shows the appropriate chord symbols for transposing instruments in 
transposing layouts.

● If you want to transpose chord symbols to reflect a capo, you can instead show capo chord 
symbols.

PROCEDURE

1. In Write mode, select the chord symbols you want to transpose.

2. Choose Write > Transpose to open the Transpose dialog.

3. Adjust the parameters required for your transposition, such as interval and quality.

TIP

● We recommend using the Calculate interval section to determine your required 
settings; for example, if you want to transpose from G♭ major to G major.

● Different intervals have different possible qualities. For example, you can specify a major 
third but not a major octave. Therefore, if you want to set your transposition parameters 
manually, we recommend selecting the interval before the quality.

4. Click OK to save your changes and close the dialog.
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RESULT
The selected chord symbols are transposed.

RELATED LINKS
Transpose dialog on page 425
Concert vs. transposed pitch on page 155
Making layouts transposing/concert pitch on page 155
Capos on page 128

Respelling chord symbols
You can change the enharmonic spelling of chord symbols for transposing instruments; for 
example, to choose a simpler enharmonic equivalent spelling. This changes the enharmonic 
spelling of chord symbols in all transposing layouts and for all instruments with the same 
transposition.

PROCEDURE

1. In Write mode, open a layout with the transposition for which you want to respell chord 
symbols.

For example, to respell a chord symbol for all instruments in B♭, open the part layout for an 
instrument in B♭.

2. Select the chord symbol you want to respell.

3. Press Return  to open the chord symbols popover for the selected chord symbol.

The existing entry for the chord symbol is shown inside the popover.

4. Change the root name of the chord, but leave other details as they were, such as quality, 
interval, or alterations.

For example, change just the root of D♭maj13 from Db to C#.

5. Press Return  to close the popover.

RESULT
The spelling of the chord symbol is changed in transposing layouts for all instruments with the 
same transposition. For example, changing the spelling of a chord symbol for a Clarinet in B♭ also 
changes the spelling of that chord symbol in the part layout for a Trumpet in B♭.

RELATED LINKS
Chord symbols popover on page 293
Respelling notes on page 428
Fretted instrument tuning on page 124
Defining capos for chord symbols/diagrams on page 133
Hiding/Showing capo chord symbols on page 133

Showing chord symbols as modes
You can show individual chord symbols as their modal equivalent if one exists for that chord 
symbol.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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PROCEDURE

1. Select the chord symbols you want to show as a mode.

2. In the Properties panel, activate Show as mode in the Chord Symbols group.

3. Select the mode you want from the menu.

RESULT
The selected chord symbols are respelled according to the selected mode. This does not affect 
the notes included in the chord symbols.

Resetting the enharmonic spelling of chord symbols
You can remove enharmonic spelling overrides for chord symbols you have respelled and 
return them to their default spelling. You can remove overrides for instruments with a single 
transposition only, such as instruments in B♭, or for all instrument transpositions.

PROCEDURE

1. In Write mode, select the chord symbol whose spelling you want to reset.

● If you want to reset the enharmonic spelling of the chord symbol for a single instrument 
transposition only, select the chord symbol on a staff belonging to an instrument with 
that transposition. For example, select it on the staff of any instrument in B♭ to reset the 
chord symbol for all instruments in B♭.

● If you want to reset the enharmonic spelling of the chord symbol for all instrument 
transpositions, select the chord symbol on any staff that belongs to a transposing 
instrument.

2. Press Return  to open the chord symbols popover for the selected chord symbol.

The existing entry for the chord symbol is shown inside the popover.

3. Reset the enharmonic spelling of the chord symbol in any of the following ways:

● To reset the enharmonic spelling of the chord symbol for instruments only with the 
selected transposition, enter Alt/Opt-S  into the chord symbols popover.

● To reset the enharmonic spelling of the chord symbol for all instrument transpositions, 
enter Shift-Alt/Opt-S  into the popover.

4. Press Return  to close the popover.

RESULT
The enharmonic spelling of the selected chord symbol in transposing layouts is reset, either just 
for instruments with the specified transposition or for all transposing instruments.

Hiding/Showing the root and quality of chord symbols
You can hide the root and quality of chord symbols if they follow another chord symbol with the 
same root and quality, but have a different altered bass note.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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PROCEDURE

1. Select the chord symbols whose root and quality you want to hide.

2. In the Properties panel, activate Hide root and quality in the Chord Symbols group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The root and quality of the selected chord symbols are hidden when the checkbox is activated, 
and shown when the checkbox is deactivated.

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560

Changing the arrangement of compound chord symbols
You can change the arrangement of individual polychord and altered bass note chord symbols, 
independently of your project-wide settings. For example, if you want to show some polychord 
chord symbols stacked vertically but others in a horizontal row. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the compound chord symbols whose arrangement you want to change.

2. In the Properties panel, activate Compound chord arrangement in the Chord Symbols 
group.

3. Select one of the following options from the menu:

● Diagonal arrangement

● Stacked arrangement

● Linear arrangement

RESULT
The arrangement of the selected compound chord symbols is changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Diagonal arrangement Stacked arrangement Linear arrangement
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RELATED LINKS
Chord components on page 714
Inputting chord symbols on page 291
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Parenthesized chord symbols
Parentheses around chord symbols are often used to indicate an alternative set of chord changes 
or that chords are optional. In Dorico SE, you can show parentheses around any chord symbol 
that uses appearance presets.

A phrase containing parenthesized chord symbols

You can add chord symbol parentheses both when inputting chord symbols and by 
parenthesizing existing chord symbols.

By default, parenthesized chord symbols show parentheses on both sides. You can show only a 
single left or right parenthesis on individual parenthesized chord symbols.

RELATED LINKS
Inputting chord symbols on page 291
Bracketed noteheads on page 849
Showing single brackets on figured bass on page 774

Parenthesizing chord symbols
You can show individual chord symbols in parentheses; for example, to indicate optional chords. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

You cannot show parentheses on custom chord symbols; that is, chord symbols whose 
appearance you have overridden.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols you want to parenthesize.

2. In the Properties panel, activate Parenthesized in the Chord Symbols group.

RESULT
Parentheses are shown around each selected chord symbol. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Parenthesized removes parentheses from the selected chord symbols.
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EXAMPLE

Chord symbols without parentheses Chord symbols with parentheses

Showing single parentheses on chord symbols
You can show only a single left or right parenthesis on individual parenthesized chord symbols; 
for example, to indicate that all chord symbols between two parenthesized chord symbols are 
optional. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the parenthesized chord symbols on which you want to show a single parenthesis.

2. In the Properties panel, activate Parenthesis to show in the Chord Symbols group.

3. Choose one of the following options:

● Start

● End

RESULT
Parentheses are hidden on the corresponding side of the selected chord symbols, leaving a 
single parenthesis on the other side. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

EXAMPLE

Parentheses around all chord symbols Parentheses at the start of the first chord and end of 
the last chord

RELATED LINKS
Showing brackets around one/all noteheads in tie chains on page 851
Large selections on page 389
Properties panel on page 560
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
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Changing the style of chord symbol parentheses
You can change the parenthesis style for individual chord symbols. For example, you might show 
stacked chord symbols with slender/tall parentheses due to their height.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the parenthesized chord symbols whose parenthesis style you want to change.

2. In the Properties panel, activate Parenthesis style in the Chord Symbols group.

3. Select one of the following options from the menu:

● Thick

● Slender

● Slender/tall

RESULT
The parenthesis style of the selected parenthesized chord symbols is changed.

EXAMPLE

Thick Slender Slender/tall

Changing the size of chord symbol parentheses
You can change the size of chord symbol parentheses without changing the size of the chord 
symbols to which they apply; for example, to ensure that parentheses appear the same size on 
adjacent chord symbols with different heights. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the parenthesized chord symbols whose parenthesis size you want to change.

2. In the Properties panel, activate Parenthesis scale % in the Chord Symbols group.

3. Change the value in the value field.

The scale size is expressed as a percentage of the parenthesis glyph rather than the chord 
symbol, allowing you to create a consistent parenthesis size regardless of the chord symbol 
height.
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RESULT
The size of parentheses around the selected chord symbols is changed.

RELATED LINKS
Large selections on page 389

Chord symbols imported from MusicXML
Chord symbols are imported from MusicXML files. However, chords that specify Neapolitan, 
Italian, French, German, Pedal, Tristan, and Other values for the kind of element are ignored 
during import, as there is no information to specify what notes these chord symbols are meant 
to describe.
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Chord diagrams

Chord diagrams represent the pattern of strings and frets on fretted instruments and use dots 
to indicate the stopped finger positions required to produce the corresponding chord. This 
demonstrates the specific shape of chords in a compact way and is useful if a particular voicing is 
required.

In Dorico SE, chord diagrams are part of chord symbols, meaning you can show them below 
chord symbols wherever they are shown. For players set to show chord diagrams, you can show 
only the chord symbol or chord diagram for individual chord symbols.

You can show chord diagram shapes for any fretted instrument, including different tunings and 
string arrangements, such as guitar DADGAD tuning. This can be different to the instrument 
above which they appear; for example, if you want to show chord diagram shapes for standard 
guitar tuning above the bass staff.

You can also show chord diagrams for all chord symbols used in a flow in a grid at the start of the 
flow, as is common in lead sheets for pop and rock music. You can show used chord diagrams 
grids independently of showing them alongside chord symbols in the music.

A sequence of chord symbols with chord diagrams for banjo

The positions of stopped frets relative to each other are known as “shapes” in Dorico SE. Any 
playable shape can be re-used for other chords whose pitches match the shape, including any 
new chord diagram shapes you have created. This includes shapes being available for other 
instruments, other tunings, and other positions along the fretboard, so long as any open strings 
included in the shape can be played with a barré at other fret positions.

A single chord can appear with different chord diagram shapes for different instruments and 
tunings, as their open string pitches and the number of strings they have varies.

RELATED LINKS
Chord symbols on page 713
Hiding/Showing chord diagrams on page 728
Showing only chord symbols or chord diagrams on page 730
Hiding/Showing used chord diagrams grids on page 731
Hiding/Showing fingerings in chord diagrams on page 732
Changing the chord diagram shape on page 734
Creating new chord diagram shapes on page 735
Capos on page 128
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Chord diagram components
Chord diagrams use a combination of symbols, dots, and lines to convey the information about 
strings, fret positions, and finger positions that performers require to play the corresponding 
chord.

1 Omitted string

Indicates a string that must not sound.

2 Open string

Indicates a string that must sound but must be left open; that is, not stopped.

3 Dots

Indicate the fret positions where strings should be stopped, usually with left-hand fingers.

4 Barré

Indicates that multiple strings must be stopped with the same finger, usually pressed flat 
against the fretboard.

5 Starting fret number

Indicates the number of the highest fret in the chord diagram when this is not the first fret.

6 Nut

Represents the top of the fretboard, or “nut”, and appears in chord diagrams whose highest 
fret is the first fret.

7 Fingerings

Indicate the finger used to stop the string. Fingerings can be positioned inside dots or at the 
ends of strings.

Hiding/Showing chord diagrams
You can hide/show chord diagrams for any type of fretted instrument alongside all chord 
symbols on a per-player basis. You can also change the fretted instrument or tuning for which 
chord diagrams are shown.

NOTE

You cannot show chord diagrams when chord symbols are hidden entirely. However, you can 
show only the chord symbol or chord diagram for individual chord symbols.

Chord diagrams
Chord diagram components 

728
Dorico SE 4.3.30



PREREQUISITE

● You have input the chord symbols for which you want to show chord diagrams.

● Chord symbols are shown above the staves where you want to show chord diagrams.

● If you want to show chord diagrams using a custom fretted instrument tuning, you have 
imported the tuning or changed the tuning of a fretted instrument in the project accordingly.

PROCEDURE

1. In Setup mode, in the Players panel, select a player for whom you want to hide/show chord 
diagrams.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show chord diagrams, choose Chord Diagrams > [Fretted instrument and tuning]. 
For example, to show chord diagrams for a guitar in DADGAD tuning, choose Chord 
Diagrams > DADGAD guitar tuning.

● To hide chord diagrams, choose Chord Diagrams > No Chord Diagrams.

RESULT
Chord diagrams are shown alongside all chord symbols for the selected player, as appropriate 
for the selected fretted instrument and tuning. Dorico SE shows the simplest shape available for 
each chord; that is, shapes with the most open strings, easy barré positions, or finger positions 
closest to the nut.

If no chord diagram is available for a chord symbol, an empty chord diagram is shown.

TIP

● You can also hide/show chord diagrams by right-clicking players and choosing these options 
from the context menu.

● You can edit empty chord diagrams to save a new chord diagram shape.

EXAMPLE

Chord symbols shown but chord diagrams hidden Chord diagrams shown (standard guitar tuning)

RELATED LINKS
Players panel on page 94
Inputting chord symbols on page 291
Hiding/Showing chord symbols on page 714
Fretted instrument tuning on page 124
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Showing only chord symbols or chord diagrams
You can show only the chord symbol or chord diagram for individual chord symbols on staves set 
to show chord diagrams. For example, if you want to show both the symbol and diagram for the 
first time each chord appears but only show chord symbols for subsequent instances. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● You have shown chord diagrams for the players on whose staves you want to show only 
chord symbols or chord diagrams.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose shown symbols/diagrams you want to change.

2. In the Properties panel, activate Show only in the Chord Symbols group.

3. Choose one of the following options:

● Chord Symbol

● Chord Diagram

RESULT
The selected chord symbols show only symbols or diagrams. In systems containing both chord 
symbols and chord diagrams, chord symbols are aligned further from the staff than chord 
diagrams.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

EXAMPLE

Chord symbols shown Chord diagrams shown (standard guitar tuning)

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
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Hiding/Showing used chord diagrams grids
You can hide/show grids that contain all chord diagrams used in each flow in each layout 
independently. By default, used chord diagrams grids display standard guitar tuning chord 
diagrams but you can change this to show chord diagrams for any fretted instrument or tuning.

Used chord diagrams grids are commonly used in lead sheets for pop and rock music. They are 
typically shown instead of chord diagrams alongside chord symbols in the music to save vertical 
space and so they can appear at a larger scale size, making the details of each chord diagram 
easier to read.

PREREQUISITE

● If you want to show chord diagrams using a custom fretted instrument tuning, you have 
imported the tuning or changed the tuning of a fretted instrument in the project accordingly.

● We recommend that you have input chord symbols and changed the shape of any chord 
symbols you want to appear with a specific voicing.

NOTE

It is customary not to show chord diagrams alongside chord symbols when showing a 
used chord diagrams grid, and you cannot change the chord diagram shape when chord 
diagrams are hidden.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show used chord diagrams 
grids at the start of flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, activate/deactivate Show chord diagrams used at start of 
flow.

5. Optional: Change the settings for used chord diagrams grids as required.

For example, you can change the fretted instrument tuning for chord diagrams in the grid, 
their scale size, and the distance between chord diagrams and/or rows of chord diagrams.

6. Click Apply, then Close.

RESULT
Chord diagrams for all chord symbols used in the flow are shown in a grid above the start of each 
flow in the selected layouts, and are positioned according to the settings for the selected layouts. 
If flow headings are shown, the used chord diagrams grid appears below them. The order of 
chord diagrams in the grid is determined by the order in which they first appear in the flow. Each 
different voicing appears as a separate chord diagram but each voicing appears only once in the 
grid.

If you input more chord symbols or change the voicing of existing chord diagrams, the used 
chord diagrams grids update automatically to include them.
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NOTE

● Even if no chord symbols exist in a flow, vertical space for the used chord diagrams grid is 
added at the start of the flow.

● You cannot select or edit individual chord diagrams in used chord diagrams grids.

EXAMPLE

Used chord diagrams grid at the start of a flow

AFTER COMPLETING THIS TASK
You can change the margins of pages, music frames, and/or flow headings if required to 
accommodate used chord diagrams grids.

RELATED LINKS
Capos on page 128
Defining capos for used chord diagrams grids on page 135
Margins on page 524

Hiding/Showing fingerings in chord diagrams
You can hide/show fingerings in chord diagrams shown alongside chord symbols and in used 
chord diagrams grids independently of each other and in each layout independently. You can 
choose whether fingerings appear inside dots or at the ends of strings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show fingerings in chord 
diagrams.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, activate/deactivate the following options, individually or 
together:
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● To hide/show fingerings in chord diagrams shown alongside chord symbols, activate/
deactivate Show fingerings in chord diagrams.

● To hide/show fingerings in used chord diagrams grids, activate/deactivate Show 
fingerings in chord diagrams at start of flow.

5. Choose one of the following options for Fingerings position:

● Inside dot

● At end of string

6. Click Apply, then Close.

RESULT
Fingerings are shown in the corresponding position in chord diagrams in the selected layouts 
when the options are activated, and hidden when they are deactivated. This also affects whether 
fingerings appear in the Edit Chord Diagram dialog.

EXAMPLE

Fingerings hidden Fingerings shown inside dots Fingerings shown at the ends of 
strings

AFTER COMPLETING THIS TASK
You can change the fingerings shown in chord diagrams when editing their shape.

RELATED LINKS
Creating new chord diagram shapes on page 735
Edit Chord Diagram dialog on page 736
Fingering on page 783
Hiding/Showing fingering on page 787

Resetting chord diagram fingerings
You can reset changes you have made to fingerings in individual chord diagrams without 
resetting other changes to the shape.

PROCEDURE

1. Select the chord diagrams whose fingerings you want to reset.

2. Choose Edit > Notations > Chord Symbols and Diagrams > Reset Chord Diagram Finger 
Numbering. You can also choose this option from the context menu.
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Changing the chord diagram shape
You can change the chord diagram shape shown at individual rhythmic positions; for example, if 
you require a shape with a different voicing. Many chords have multiple playable shapes.

You can also apply your changes to all other instances of the same chord for instruments with 
compatible tunings.

PROCEDURE

1. Select the chord diagram whose shape you want to change.

NOTE

You can only change the shape of a single chord diagram at a time.

2. Change the shape in any of the following ways:

● To cycle through all the available shapes for the selected chord, press Alt/Opt-Q .

● To open the Choose Chord Diagram dialog and see all the available shapes for the 
selected chord at once, press Shift-Alt/Opt-Q .

3. Optional: In the Choose Chord Diagram dialog, select the shape you want to use.

TIP

If the shape you require is not available, you can click Edit, which allows you to create a new 
shape.

4. Click OK to save your changes and close the dialog.

5. Optional: To apply the new shape to other instances of the same chord for instruments 
with compatible tunings, choose Edit > Notations > Chord Symbols and Diagrams > Copy 
Shape to Matching Chord Symbols. You can also choose this option from the context 
menu.

RESULT
The shape shown for the selected chord diagram is changed. This also updates all other chord 
diagrams using the same fretted instrument tuning at the same rhythmic position.

Choose Chord Diagram dialog
The Choose Chord Diagram dialog allows you to view all available chord diagram shapes for the 
selected chord and select the one you want to use.

● You can open the Choose Chord Diagram dialog in Write mode by selecting a chord 
diagram and pressing Shift-Alt/Opt-Q .
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The Choose Chord Diagram dialog comprises the following:

1 Available chord diagrams

Displays all the valid chord diagram shapes for the selected chord and allows you to select a 
different shape to show at the selected rhythmic position. Shapes you have created yourself 
appear in a different color.

2 Edit

Opens the Edit Chord Diagram dialog, which allows you to edit the shape of chord 
diagrams, including changing the number of frets shown, stopped fret positions, and the 
starting fret number.

Creating new chord diagram shapes
You can create new chord diagram shapes by editing an existing one; for example, if you want 
an alternative voicing for a chord or to show a barré. Your changes to existing chord diagram 
shapes are saved as a new shape, they do not overwrite the existing one.

NOTE

In Dorico SE, you cannot start new chord diagram shapes from scratch.

PROCEDURE

1. In Write mode, select the chord diagram whose shape you want to edit.

2. Press Shift-Alt/Opt-Q  to open the Choose Chord Diagram dialog.

3. Click Edit to open the Edit Chord Diagram dialog.

4. Edit the shape and settings of the chord diagram as required.

For example, you can change open strings to omitted strings, change the stopped fret 
position on strings to change the corresponding string pitch, or change the fingering of 
individual stopped fret positions.

5. Optional: If you want the shape to be available for chords with different start fret positions, 
activate Chord may be moved along the neck.

6. Click Save, then Close.
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RESULT
The new shape is saved and is used for the selected chord diagram. The new shape also becomes 
available for any other chord for which it is valid.

Edit Chord Diagram dialog
The Edit Chord Diagram dialog allows you to edit the shape of individual chord diagrams, 
including changing the number of frets shown, stopped fret positions, and the starting fret 
number.

● You can open the Edit Chord Diagram dialog in Write mode by opening the Choose Chord 
Diagram dialog, selecting the chord diagram whose shape you want to edit, and clicking 
Edit.

The Edit Chord Diagram dialog contains the following options and sections:

1 Name

Displays the name of the chord whose chord diagram you are editing in the dialog. You 
cannot change this name.

2 Tuning

Displays the fretted instrument and tuning for the current chord diagram.

3 Chord may be moved along the neck

Allows you to specify whether or not the shape of the chord diagram can be reused at other 
fret positions; for example, by playing open strings with a barré at higher fret positions.

4 Notes not in chord diagram

Displays any pitches that are part of the chord but not currently included in the chord 
diagram.

5 Open string pitch
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Displays the open pitch of the corresponding string for reference.

6 Current string pitch

Displays the current pitch of the corresponding string if it is open or stopped. If the pitch of a 
string is not part of the chord, the string pitch appears red.

7 String status

Displays the current usage status of the corresponding string and allows you to switch the 
status of individual strings between open and omitted by clicking in this row.

● O: Open string

● X: Omitted string

● No symbol: Stopped string

8 Chord diagram shape editor

Displays the current arrangement of stopped frets using dots and allows you to change the 
chord diagram shape. You can move stopped frets by clicking at the required positions. Each 
string can only have a single stopped fret position.

If two or more strings are stopped at the same fret, you can hide/show a barré by clicking 
any of the dots at that fret position.

You can change fingerings by double-clicking them and entering a new number, including 0 
to show no fingering or T for thumb fingerings on the lowest string.

9 Action bar

Contains options that allow you to edit and change the number of frets.

● Starting fret: Changes the fret number of the highest fret in the chord diagram.

● Starting fret number offset: Changes the offset of the starting fret number. For 
example, if you want the starting fret label to appear beside the second fret down the 
chord diagram in order to include a barré.

● Add fret : Adds a fret to the bottom of the chord diagram.

● Remove fret : Removes a fret from the bottom of the chord diagram.

● Reset Chord Diagram : Removes your changes to the chord diagram and resets it to 
its default shape.

10 Save

Saves the chord diagram shape and updates the selected chord diagram in the music area. 
The shape also becomes available as an alternative shape for other compatible chords.
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Clefs

Clefs are the symbol at the start of every system that give the notes on the staff context; that is, 
the clef tells you which note of the scale applies to each line or space of the staff. To minimize 
the number of ledger lines required for notes, different clefs are typically used according to the 
register of instruments.

The common clefs are:

● Treble clef, or G clef, whose spiral shape centers around G, normally the G above middle C.

● The bass clef, or F clef, in which two dots are shown either side of the line corresponding to 
F, normally the F below middle C.

● The C clef, in which the center of the bracket to the right of the clef’s thick vertical line is 
positioned on the line that corresponds to C, normally middle C. When positioned on the 
middle line of the staff, the C clef is known as the alto clef. When positioned on the second 
staff line from the top, the C clef is known as the tenor clef.

The E below middle C 
shown in a treble clef

The E below middle C 
shown in a bass clef

The E below middle C 
shown in a C (alto) clef

The E below middle C 
shown in a C (tenor) clef

In Dorico SE, notes are automatically positioned on staves according to the prevailing clef.

Initial clefs at the start of flows and systems appear full size, while mid-system clef changes are 
automatically scaled down.

Many instruments in Dorico SE have different types that show alternative clefs by default. You 
can select the appropriate instrument type from the instrument picker when adding or changing 
instruments.

NOTE

● You can only select clefs that you have input. You cannot select initial clefs at the start of 
flows or clefs shown automatically at the start of each system.

● If you do not want to show any clef in any layout, you must input an invisible clef. You can 
also hide/show clefs according to the layout transposition.

● If clef changes occur at the start of a new system or page, a cautionary clef is shown at the 
end of the previous system. In Dorico SE, the clefs shown at the end of one system and at the 
start of the next system are the same item, not separate items. You cannot hide cautionary 
clefs.
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RELATED LINKS
Input methods for clefs and octave lines on page 299
Clefs with octave indicators on page 741
Instrument picker on page 96
Hiding/Showing clefs according to layout transpositions on page 739
Cautionary key signatures on page 818
Cautionary time signatures on page 1087

Showing clefs after grace notes
According to convention, clefs are positioned before grace notes so this is the default in Dorico 
SE. However, in some circumstances you might want to position clefs between grace notes and 
normal notes.

PROCEDURE

1. Select the clefs you want to show after grace notes.

2. Choose Edit > Notations > Clef > After Grace Notes. You can also choose this option from 
the context menu.

RESULT
The selected clefs are positioned between normal notes and grace notes.

NOTE

You can reset the position of clefs relative to grace notes by selecting the clefs whose position 
you want to reset and choosing Edit > Notations > Clef > Reset Clef Position. You can also 
choose this option from the context menu.

EXAMPLE

Treble clef before grace notes Treble clef after grace notes to align with bass clef

Hiding/Showing clefs according to layout transpositions
You can show individual clefs only in layouts that are either concert or transposed pitch. For 
example, due to their transpositions, some instruments require clef changes in concert pitch 
scores to avoid excess ledger lines, but do not require those clef changes in their transposed 
pitch parts.

By default, all clefs appear in all layouts.

Clefs
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TIP

Many instruments in Dorico SE show different clefs in full score/custom score and part layouts by 
default. You can select the appropriate instrument type from the instrument picker when adding 
or changing instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the clefs or signposts of clefs you want to hide/show according to the layout 
transposition.

2. In the Properties panel, activate Show for transposition in the Clefs group.

3. Choose one of the following options:

● Concert Pitch

● Transposing Pitch

RESULT
The selected clefs only appear in layouts with the corresponding transposition. In layouts where 
clefs are hidden, they are indicated by signposts.

Hidden clefs have no effect on note and staff spacing.

RELATED LINKS
Concert vs. transposed pitch on page 155
Making layouts transposing/concert pitch on page 155
Signposts on page 407
Input methods for clefs and octave lines on page 299
Instrument picker on page 96

Changing the octave of clefs
You can change the octave shift of individual clefs. For example, to accommodate different horn 
and bass clarinet transposition conventions. You can change the octaves of clefs in concert pitch 
and transposed pitch layouts independently.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have opened a layout with the required transposition in the music area. For example, 
if you want to change the octave of clefs in concert pitch, you have opened a concert pitch 
layout.

● If you want to change the octave of initial clefs, you have input clefs at the start of each flow.

PROCEDURE

1. Select the clefs whose octave you want to change.

2. In the Properties panel, activate Octave shift in the Clefs group.

Clefs
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3. Change the value in the value field.

RESULT
The octave of the selected clefs is changed in all layouts with the same transposition. For 
example, 1 shifts clefs up one octave, and -1 shifts clefs down one octave.

The pitches of notes on the staves of the selected clefs are adjusted automatically. For example, 
if you shift a clef up one octave, notes after the clef appear an octave lower than they do without 
the octave shift.

TIP

You can specify octave shifts when inputting clefs using the clefs and octave lines popover.

RELATED LINKS
Clefs and octave lines popover on page 300
Concert vs. transposed pitch on page 155

Clefs with octave indicators
Clefs with octave indicators indicate that notes are played in a different register to the one 
notated. An octave indicator above the clef indicates that notes are played higher than notated, 
while an octave indicator below the clef indicates that notes are played lower than notated.

Of these clefs, only the treble clef 8 below is still commonly used for tenor vocal parts.

Traditionally, clef octave indicators were used as a reminder of transposing instruments; 
however, in more recent music, some composers use clef octave indicators as an alternative 
to octave lines for extended passages. Therefore, Dorico SE ignores clef octave indicators by 
default. However, transposing instruments are always transposed correctly automatically. For 
example, notes belonging to piccolo instruments are automatically notated an octave lower than 
their pitch in playback, regardless of whether they have a clef with an octave indicator.

RELATED LINKS
Transposing instruments on page 119
Concert vs. transposed pitch on page 155
Octave lines on page 742
Changing the octave of clefs on page 740
Input methods for clefs and octave lines on page 299

Clefs
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Octave lines

Octave lines indicate where notes are played higher/lower than they appear in the score or 
part. They are dashed or dotted horizontal lines with an italic numeral at the start. The numeral 
indicates the number of pitches by which the phrase is changed, such as 8 for one octave and 15 
for two octaves.

Octave lines that indicate notes are played higher than notated are placed above the staff, while 
octave lines that indicate notes are played lower than notated are placed below the staff.

A treble clef phrase notated at 
pitch

The treble clef phrase with an 
octave above line

The treble clef phrase with a two 
octaves above line

A bass clef phrase notated at pitch The bass clef phrase with an 
octave below line

The bass clef phrase with a two 
octaves below line

In Dorico SE, pitches are adjusted automatically when an octave line is present. You do not have 
to change the register of the notes within octave lines.

Octave lines should be horizontal, meaning they can take up significant vertical space, as octave 
lines are usually placed outside all other notations. However, they can be placed within slurs and 
tuplet brackets if the slur or tuplet bracket is longer than the octave line.

Octave lines can continue across system and page breaks. It is customary to show the numeral 
again at the start of each system as a reminder. Cautionary octave line numerals are usually 
parenthesized and the suffix is optional.

RELATED LINKS
Input methods for clefs and octave lines on page 299
Clefs with octave indicators on page 741
Lines on page 946
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Positions of octave lines
By default, octave lines that indicate notes are played higher than written are placed above the 
staff, while octave lines that indicate notes are played lower than written are placed below the 
staff.

You can move octave lines to new rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

RELATED LINKS
Input methods for clefs and octave lines on page 299
Moving notes/items rhythmically on page 417

Changing the alignment of octave line numerals relative to notes
You can change whether the left edge, center, or right edge of individual octave line numerals 
is aligned with the first note to which each octave line applies. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the octave lines whose numeral alignment relative to notes you want to change.

2. In the Properties panel, activate L alignment in the Octave Lines group.

3. Select one of the following options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the numerals of the selected octave lines is changed. For example, if you select 
Right, the right edge of the selected octave line numerals is aligned with the first noteheads to 
which the octave lines apply. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the position of octave line numerals relative to accidentals
You can change whether the numerals at the start of individual octave lines are positioned on 
noteheads or accidentals. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

Octave lines
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● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the octave lines whose numeral alignment relative to accidentals you want to change.

2. In the Properties panel, activate L position in the Octave Lines group.

3. Choose one of the following options:

● Notehead

● Accidental

RESULT
The alignment of the numerals of the selected octave lines is changed. For example, if you 
choose Accidental, the octave line numerals are aligned with the accidental on the first 
noteheads to which the octave lines apply. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

Octave lines
Positions of octave lines 
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Cues

Cues are passages of music shown in instrumental parts that are played by a different player, 
usually to help orientate players before entries or solos following a significant passage of rests.

Cues can also be used to assist with co-ordination or tuning between players, or to indicate 
material that the player might be asked to double.

A cue in a timpani part showing music from the bassoons

NOTE

In Dorico SE, you cannot input or edit cues. However, cues are shown if you import or open a 
project that contains them.
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Dynamics

Dynamics indicate the loudness of the music and can be combined with expressive text to 
give further clarification about how to perform the music. Dynamics can indicate an immediate 
change in volume or a gradual change over a specified duration.

A phrase with multiple different dynamics

You can add modifiers to dynamics that can give stylistic direction context alongside the 
volume level, such as  espressivo, which indicates that a passage is played loudly but also with 
expressive feeling.

While almost all expressive text is written in italics, dynamics such as  and  use a bold italic 
font.

RELATED LINKS
Input methods for dynamics on page 284
Positions of dynamics on page 747
Gradual dynamics on page 757
Messa di voce hairpins on page 761
Niente markings on page 763
Dynamic modifiers on page 754
Voice-specific dynamics on page 754
Groups of dynamics on page 765
Linked dynamics on page 767
Dynamics editor on page 590

Types of dynamics
Dorico SE categorizes dynamics into different groups according to their function.

Immediate dynamics
Immediate dynamics apply to the note to which they are attached until the next 
dynamic marking, and indicate an immediate change from any previous dynamic. 
Immediate dynamics include dynamic symbols, such as  or , and dynamic 
modifiers, such as subito or molto.

Gradual dynamics and hairpins
Gradual dynamics indicate a change in volume that happens incrementally over the 
specified duration. They usually appear either as hairpins or as text instructions, such 
as cresc. or dim..
Gradual dynamics can also have dynamic modifiers that qualify the change in volume, 
such as poco, molto, poco a poco, and niente.
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In Dorico SE, a hairpin can be shown as messa di voce, which shows a pair of hairpins. In 
some cases, this is easier than having separate lines for each half of the pair.

Force/Intensity of attack
These dynamics, such as  and , indicate that a note has a stronger attack than is 
usually expected for the dynamic, similar to an accent articulation.

Combined dynamics
Combined dynamics, such as  or –, specify a sudden change of dynamic.

You can create custom combined dynamics in Dorico SE, and control the intensity of 
each dynamic in the pair, in the Combined Dynamics section of the Dynamics panel. 
For example, you can make dynamics such as , –, and .

NOTE

Combined dynamics must include one  level and one  level.

RELATED LINKS
Gradual dynamics on page 757
Messa di voce hairpins on page 761
Niente markings on page 763
Dynamic modifiers on page 754
Hiding/Showing immediate dynamics on page 752
Changing the appearance/position of subito modifiers on page 756
Changing the appearance of sforzando/rinforzando dynamics on page 753
Hiding/Showing combined dynamic separators on page 752

Positions of dynamics
By default, dynamics are placed below instrumental staves, where they can be read alongside the 
notes, and above vocal staves. This way, they do not clash with lyrics placed below the staff, and 
are still close enough to the notes to be read simultaneously.

Immediate dynamics, such as  or , are centered on the notehead to which they apply. 
The beginnings of gradual dynamics are centered on the notehead from which they begin, or 
immediately after an immediate dynamic at the same position. The ends of gradual dynamics are 
centered on the notehead at which they end, or immediately before an immediate dynamic at 
the same position.

The staff-relative placement of dynamics varies, depending on their function and the type of 
player. For example, dynamics are placed below instrumental staves and above vocal staves by 
default. This ensures dynamics are kept as close to the staff as possible for legibility but are not 
placed between noteheads and lyrics on vocal staves. For grand staff instruments, such as piano 
or harp, dynamics are usually placed between the two staves, but can be placed both above and 
below when each staff requires separate dynamics.

In general, dynamics are not placed within the staff, as hairpins in particular become very hard 
to read. They are also not usually placed within tuplet brackets. Dynamics are placed outside of 
notations such as slurs, which must be kept close to noteheads, but inside pedal lines, which can 
be placed further from noteheads and still be clearly understood.

You can move dynamics to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

Dynamics
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NOTE

When using the mouse, you can only move and lengthen/shorten dynamics to noteheads. When 
using the keyboard, you can move and lengthen/shorten dynamics according to the current 
rhythmic grid resolution.

RELATED LINKS
General placement conventions for hairpins relative to barlines on page 749
Changing the alignment of dynamics relative to noteheads on page 749
Moving the center of messa di voce hairpins on page 762
Changing the staff-relative placement of items on page 400
Moving notes/items rhythmically on page 417
Lengthening/Shortening items on page 396
Gradual dynamics on page 757
Messa di voce hairpins on page 761
Niente markings on page 763

Changing the horizontal beat-relative position of dynamics
You can position individual dynamics before or after the beat. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose position relative to the beat you want to change.

2. In the Properties panel, activate Beat-relative position in the Dynamics group.

3. Choose one of the following options:

● Before

● After

RESULT
The beat-relative position of the selected dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

A dynamic positioned before the beat A dynamic positioned after the beat

Dynamics
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RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the alignment of dynamics relative to noteheads
Immediate dynamics, such as  and , are usually horizontally aligned with the optical 
center of noteheads. However, you can change the horizontal alignment of immediate dynamics 
individually. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose alignment relative to noteheads you want to change.

2. In the Properties panel, activate Text alignment in the Dynamics group.

3. Choose one of the following options:

● Align optical center with notehead 

● Left-align with notehead 

● Align optical center with left of notehead 

RESULT
The alignment of the selected immediate dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

General placement conventions for hairpins relative to barlines
In Dorico SE, the ends of hairpins align with the left edge of the note to their right. This can 
include hairpins extending across barlines.

Hairpins that end on the first note of a bar extend across the preceding barline in the following 
cases:

● If there is no immediate dynamic on the first note in the next bar.

● If there is a time signature or key signature change at the barline that increases the gap 
between the end of the current bar and the first note in the new bar.

Dorico SE avoids hairpins overlapping barlines by a small amount, as this is less visually clear. 
However, this means that the same dynamic phrase on different staves can appear differently if 
one of the staves does not have a barline join extending below it.

Dynamics
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The hairpin ends are not aligned because the barline does not extend beyond the bottom staff

You can allow/disallow hairpins across barlines if the hairpin ends on the first note in the next 
bar. Disallowing hairpins across barlines ensures hairpins appear the same length on all staves.

Allowing/Disallowing hairpins across barlines
You can allow/disallow hairpins across barlines when they end on the first note in the next bar; 
for example, so all hairpins appear the same length across multiple staves that do not all have 
barline joins. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins you want to allow/disallow across barlines.

2. In the Properties panel, activate Barline interaction in the Dynamics group.

3. Choose one of the following options:

● Stop before

● Continue

RESULT
The selected hairpins are allowed across barlines when you choose Continue, and disallowed 
when you choose Stop before. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Dynamics
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Parenthesizing dynamics
You can show individual dynamics in parentheses; for example, to indicate editorial dynamics 
that were not in the original manuscript. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics you want to parenthesize.

2. In the Properties panel, activate Parenthesized in the Dynamics group.

RESULT
Parentheses are shown around each selected dynamic. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Deactivating Parenthesized removes parentheses from the selected dynamics.

Changing dynamic levels
You can change the levels of dynamics without reopening the dynamics popover and for multiple 
different dynamics simultaneously; for example, if you want to increase the dynamic level of all 
dynamics in a phrase.

PROCEDURE

1. In Write mode, select the dynamics whose dynamic level you want to change.

2. Change the dynamic level in one of the following ways:

● To increase the dynamic level, choose Edit > Notations > Dynamics > Increase 
Dynamic Intensity.

● To decrease the dynamic level, choose Edit > Notations > Dynamics > Decrease 
Dynamic Intensity.

TIP

You can also choose these options from the context menu.

RESULT
The dynamic level of the selected dynamics is increased/decreased. For example, increasing the 
dynamic level of a  dynamic changes it to .

TIP

You can assign key commands for these options on the Key Commands page in Preferences.

RELATED LINKS
Input methods for dynamics on page 284
Dynamics editor on page 590

Dynamics
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Changing existing items on page 398
Dynamic modifiers on page 754
Key Commands page in the Preferences dialog on page 54

Hiding/Showing immediate dynamics
You can hide/show individual immediate dynamics such as  and ; for example, if you 
only want to show the dynamic modifier, such as “sim.”, without its accompanying immediate 
dynamic. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the immediate dynamics you want to hide, or the signposts of immediate dynamics 
you want to show.

2. In the Properties panel, activate/deactivate Hide intensity marking in the Dynamics group.

RESULT
The selected immediate dynamics are hidden when Hide intensity marking is activated, and 
shown when it is deactivated. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

If no other dynamic exists at their rhythmic position, they are indicated by signposts. However, 
signposts are not printed by default.

RELATED LINKS
Dynamic modifiers on page 754
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Signposts on page 407
Annotations on page 507
Input methods for dynamics on page 284

Hiding/Showing combined dynamic separators
You can hide/show different separators in combined dynamics individually. For example, if you 
want to separate some  dynamics with slashes. You can do this for the current layout and 
frame chain only, or for all layouts and frame chains.

By default, only combined dynamics with at least one mezzo dynamic in the pair, such as -, 
show a separator.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

Dynamics
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PROCEDURE

1. Select the combined dynamics whose separator you want to hide/show.

2. In the Properties panel, activate Separator shown in the Dynamics group.

3. Activate/Deactivate the corresponding checkbox.

4. Optional: If you showed separators, activate Separator and select one of the following 
options from the menu:

● Hyphen

● Colon

● Space

● Slash

RESULT
Separators are shown when the Separator shown checkbox is activated, and hidden when it is 
deactivated. The separator shown follows your selection for Separator. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Types of dynamics on page 746
Changing the appearance/position of subito modifiers on page 756

Changing the appearance of sforzando/rinforzando 
dynamics

You can change the appearance of individual  and  dynamics. For example, if you want some 
 dynamics to appear as . You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

NOTE

These steps do not apply to force/intensity of attack dynamics with other intensities, such as .

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the  and/or  dynamics whose appearance you want to change.

2. In the Properties panel, activate rfz/sfz style in the Dynamics group.

3. Choose one of the following options:

●  
●  

RESULT
The appearance of the selected  and/or  dynamics is changed. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

Dynamics
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RELATED LINKS
Types of dynamics on page 746
Changing the appearance/position of subito modifiers on page 756

Voice-specific dynamics
Voice-specific dynamics only apply to a single voice on a staff, which allows you to specify 
different dynamics for each voice in multiple-voice contexts or for the separate staves of grand 
staff instruments. By default, dynamics apply to all voices on all staves belonging to a single 
instrument, including grand staff instruments.

Inputting voice-specific dynamics allows you to show different dynamics for multiple voices on a 
staff, or to highlight an inner melody voice in a piano part. Voice-specific dynamics change the 
dynamics of each voice in playback independently.

NOTE

● You can only input voice-specific dynamics when the caret is active, such as during note 
input. Voice-specific dynamics apply to the voice indicated by the quarter note symbol beside 
the caret.

● Voice-specific dynamics only affect playback automatically for sounds that use velocity to 
control dynamics. When using playback devices that control dynamics in other ways, such as 
with CC, you must enable independent voice playback to hear different dynamics in different 
voices for the same instrument.

RELATED LINKS
Input methods for dynamics on page 284
Caret on page 191
Enabling independent voice playback on page 460
Dynamics editor on page 590
Extra staves on page 1041

Dynamic modifiers
Modifiers add further detail to dynamics than simply their volume level, and can help guide how 
a player performs a note or phrase. Modifiers include poco a poco, molto and subito. They are also 
known as “expressive text”.

Modifiers accompanying immediate and gradual dynamics

In Dorico SE, modifiers must accompany either a dynamic level, such as  or , or a gradual 
dynamic.

You can input dynamic modifiers by entering them into the dynamics popover alongside an 
immediate dynamic or by clicking available options in the Dynamics panel. You can also add 
dynamic modifiers to existing dynamics.

You can add modifiers both before and after immediate dynamics. Modifiers can also appear 
either inside hairpins or above/below the start of hairpins.

Dynamics
Voice-specific dynamics 

754
Dorico SE 4.3.30



TIP

You can hide immediate dynamics if you only want to show the modifier.

RELATED LINKS
Input methods for dynamics on page 284
Hiding/Showing immediate dynamics on page 752
Adding poco a poco text to gradual dynamics on page 760
Changing the appearance/position of subito modifiers on page 756
Showing modifiers centered inside hairpins on page 756
Changing the appearance of sforzando/rinforzando dynamics on page 753

Adding modifiers to existing dynamics
You can add modifiers both before and after dynamics after they have been input; for example, if 
you want to add “sim.” instead of repeating dynamics across multiple phrases.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the dynamics to which you want to add modifiers.

2. In the Properties panel, activate the following properties, individually or together, in the 
Dynamics group:

● To add modifiers before dynamics, activate Prefix.

● To add modifiers after dynamics, activate Suffix.

3. Enter the text you want to add into the corresponding value field.

4. Press Return .

RESULT
The text you entered is added to the selected dynamics as a modifier. Text entered into the 
Prefix field appears before immediate dynamics, while text entered into the Suffix field appears 
after immediate dynamics.

Modifiers appear below hairpins placed below the staff and above hairpins placed above the 
staff, and are aligned with the start of the hairpin.

Deactivating the properties removes the corresponding modifiers from the selected dynamics.

NOTE

Deactivating properties permanently deletes any custom text entered.

AFTER COMPLETING THIS TASK
If you added modifiers to hairpins, you can show them centered inside the hairpins.

RELATED LINKS
Niente markings on page 763
Input methods for dynamics on page 284
Showing modifiers centered inside hairpins on page 756

Dynamics
Dynamic modifiers 

755
Dorico SE 4.3.30



Adding poco a poco text to gradual dynamics on page 760

Changing the appearance/position of subito modifiers
You can change the appearance and/or position of individual subito modifiers. For example, if 
you want to show subito modifiers as sub. on the left of dynamics, or  sub. dynamics as . You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose subito modifier appearance and/or position you want to change.

2. In the Properties panel, activate Subito style in the Dynamics group and choose one of the 
following options:

● subito

● sub.

3. Optional: If you selected dynamics that include at least one , activate Subito forte style and 
choose one of the following options:

● sub. 
● 

4. Activate Subito position and choose one of the following options:

● Left

● Right

RESULT
The appearance and/or position of the selected subito modifiers is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the appearance of sforzando/rinforzando dynamics on page 753
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Showing modifiers centered inside hairpins
You can show modifiers you have added to hairpins, such as poco a poco or molto, centered both 
horizontally and vertically inside hairpins. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains. By default, modifiers appear at the start of and either 
above or below hairpins.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the hairpins whose modifiers you want to show centered inside hairpins.

2. In the Properties panel, activate Modifier position in the Dynamics group.

3. Choose one of the following options:

● Above or Below

● Inside

RESULT
Modifiers on the selected hairpins appear centered inside the hairpins. They automatically erase 
their background so the text does not collide with the hairpin lines. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Modifier (molto) below a hairpin Modifier (molto) centered inside hairpin

RELATED LINKS
Adding modifiers to existing dynamics on page 755
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Gradual dynamics
Gradual dynamics indicate a change in volume that happens incrementally over the specified 
duration. They usually appear either as hairpins or as text instructions, such as cresc. or dim..

The change in volume indicated by individual hairpins is shown in the distance between the two 
diverging lines at their apertures.

Hairpins typically have a closed end and an open end. If the hairpin crosses a system or frame 
break, the closed end appears with a small gap so that the hairpin is not misread as two separate 
hairpins.

A pair of hairpins without an immediate dynamic in the middle is known as a messa di voce.

A phrase containing multiple gradual dynamics
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In Dorico SE, gradual dynamics appear as hairpins by default. You can change the appearance 
of individual gradual dynamics. For example, if you want to show a particularly long crescendo 
using cresc. text rather than a hairpin.

You can show gradual dynamic text in the following ways:

● cresc. or dim.: Abbreviated text with no continuation line

● cresc... or dim...: Abbreviated text with a dotted continuation line

● cre-scen-do or di-mi-nuen-do: The full word spread out across the duration of the gradual 
dynamic

In Write mode, ungrouped gradual dynamics each have start and end handles that show their 
duration.

NOTE

Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce hairpins 
share a single center handle.

RELATED LINKS
Input methods for dynamics on page 284
Types of dynamics on page 746
Messa di voce hairpins on page 761
Niente markings on page 763
Groups of dynamics on page 765
Changing the appearance of gradual dynamics on page 758
General placement conventions for hairpins relative to barlines on page 749
Moving the center of messa di voce hairpins on page 762
Moving notes/items rhythmically on page 417
Lengthening/Shortening items on page 396

Changing the appearance of gradual dynamics
You can change the appearance of individual gradual dynamics; for example, to show a 
particularly long crescendo using “cresc.” text rather than a hairpin. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the gradual dynamics whose appearance you want to change.

2. In the Properties panel, activate Gradual style in the Dynamics group.

3. Select one of the following options from the menu:
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● Hairpin

● cresc./dim.

● cresc...

● cre - scen - do

4. Optional: Customize the appearance of the selected gradual dynamics in one of the following 
ways, depending on their Gradual style:

● If you selected Hairpin, activate Hairpin line style and choose one of the available 
options.

● If you selected cresc./dim., cresc..., or cre - scen - do, activate Diminuendo style and 
select one of the available options from the menu.

● If you selected cresc..., activate Continuation line style and choose one of the available 
options.

RESULT
The appearance of the selected gradual dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Hairpin cresc./dim. cresc…. cre - scen - do

RELATED LINKS
Showing modifiers centered inside hairpins on page 756
Turning existing gradual dynamics into messa di voce hairpins on page 763
Adding niente markings to existing gradual dynamics on page 764

Hiding/Showing flared ends on hairpins
Flared ends are usually shown at the end of crescendo hairpins and indicate a sudden burst in 
volume at the end of the crescendo. You can hide/show flared ends on any hairpin.

NOTE

You can only show flared ends on hairpins with solid lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the hairpins on which you want to hide/show flared ends.

2. In the Properties panel, activate/deactivate Flared end in the Dynamics group.
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RESULT
A flared end is shown on the selected dynamics when Flared end is activated, and hidden when 
it is deactivated.

EXAMPLE

Crescendo hairpin with flared end hidden Crescendo hairpin with flared end shown

Adding poco a poco text to gradual dynamics
You can add poco a poco text to individual gradual dynamics after they have been input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the gradual dynamics to which you want to add poco a poco.

2. In the Properties panel, activate Poco a poco (little by little) in the Dynamics group.

RESULT
Poco a poco is shown immediately after gradual dynamic text, below hairpins placed below the 
staff, and above hairpins placed above the staff.

Deactivating Poco a poco (little by little) removes poco a poco text from the selected gradual 
dynamics.

EXAMPLE

Text gradual dynamic with poco a poco Hairpin gradual dynamic with poco a poco

AFTER COMPLETING THIS TASK
You can show poco a poco text centered inside hairpins.

RELATED LINKS
Dynamic modifiers on page 754
Showing modifiers centered inside hairpins on page 756
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Gradual dynamic spacing
Dorico SE ensures that hairpins can always be clearly distinguished by giving hairpins a minimum 
default length. However, this can affect note spacing.

The default minimum hairpin length is three spaces. When hairpins are shorter than this, they 
can sometimes be confused with the accent articulation mark. Therefore, if you add a hairpin 
to a note which would make the hairpin less than three spaces long, the spacing of the note is 
changed to ensure the hairpin meets the minimum length.

RELATED LINKS
Moving the center of messa di voce hairpins on page 762

Gradual dynamics truncated by immediate dynamics
A hairpin is automatically truncated if an immediate dynamic is positioned within its range, either 
before or after the hairpin is input.

The hairpin remains tied to its originally designated rhythmic positions, even if graphically it 
appears shorter. This means that if the immediate dynamic that truncated it is ever deleted, the 
hairpin extends up to its end or the next immediate dynamic within its range.

The examples demonstrate a crescendo hairpin that is truncated by two dynamics, but the 
hairpin extends to its total length as they are deleted. The dotted attachment line shows the link 
between the hairpin and the rhythmic position to which its end is attached.

A long hairpin truncated by a  After deleting the , the hairpin is 
now truncated by the 

Deleting both immediate 
dynamics allows the hairpin to 
extend to its full length

RELATED LINKS
Lengthening/Shortening items on page 396

Messa di voce hairpins
Messa di voce hairpins are single gradual dynamic items that appear as a pair of hairpins without 
an immediate dynamic in the middle. They indicate that within their duration, the volume either 
increases then decreases, or decreases then increases.

A phrase containing two messa di voce hairpins

In Write mode, messa di voce hairpins have three handles: one at the start, one at the end, and 
one in the center. This is different to separate, ungrouped hairpins, which each have a handle at 
the start and end.
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RELATED LINKS
Input methods for dynamics on page 284
Groups of dynamics on page 765
Note spacing on page 533

Moving the center of messa di voce hairpins
You can move the center of individual messa di voce hairpins rhythmically; for example, if you 
want them to peak on different notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the messa di voce hairpins whose center you want to move.

2. In the Properties panel, activate Messa di voce inflection in the Dynamics group.

3. Move the center of the selected messa di voce hairpins in any of the following ways:

● To move them to the right, increase the value in the left value field.

● To move them to the left, decrease the value in the left value field.

● To move them to the left to grace notes at the rhythmic position set by the left value 
field, decrease the value in the right value field.

TIP

1 represents a quarter note.

RESULT
The centers of the selected messa di voce hairpins are moved rhythmically.

TIP

In Write mode, you can also click and drag messa di voce hairpin center handles to noteheads to 
the right/left.

EXAMPLE
For example, entering 1 1/2 into the left value field and -1/2 into the right value field moves 
messa di voce hairpin centers a dotted quarter note to the right of their start position, and to the 
first of two sixteenth grace notes at that rhythmic position.

Dynamics
Messa di voce hairpins 

762
Dorico SE 4.3.30



RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Grace notes on page 803
Showing grace notes before/after barlines on page 806
Moving notes/items rhythmically on page 417
Lengthening/Shortening items on page 396

Turning existing gradual dynamics into messa di voce hairpins
You can turn existing gradual dynamics into messa di voce hairpins; for example, if you change 
your mind about the dynamic phrasing in some bars.

PROCEDURE

1. Select the gradual dynamics that you want to turn into messa di voce hairpins.

2. In the Properties panel, choose Messa di voce for Type in the Dynamics group.

RESULT
The selected gradual dynamics are turned into messa di voce hairpins. The first direction follows 
the previous overall direction of the selected gradual dynamics.

TIP

You can also turn existing gradual dynamics into messa di voce hairpins by selecting them and 
clicking the corresponding buttons in the Gradual Dynamics section of the Dynamics panel.

You can also press Shift-Alt/Opt-,  for a crescendo/diminuendo messa di voce hairpin, or Shift-
Alt/Opt-.  for a diminuendo/crescendo messa di voce hairpin.

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Dynamics panel on page 286
Inputting dynamics with the popover on page 287
Inputting dynamics with the panel on page 290
Grace notes on page 803

Niente markings
Niente markings at the start/end of gradual dynamics indicate that the dynamic either increases 
from, or decreases to, silence.

This effect works very well on strings and singers with vowels, but it cannot always be played 
literally. For example, singers with words beginning with consonants cannot begin from silence, 
nor can reed and brass instruments, as they have to achieve a certain air pressure before a note 
sounds.

Niente markings can be shown in the following ways, depending on the gradual dynamic style:
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● For hairpins, niente markings can be shown as either a circle, or the letter “n”.

● For text gradual dynamics, niente markings appear as “dal niente” for crescendos, and as “al 
niente” for diminuendos.

You can input gradual dynamics with niente markings in the same ways as inputting other 
dynamics. You can also add niente markings to existing gradual dynamics.

EXAMPLE

Circle niente marking Letter niente marking Niente marking alongside a text 
gradual dynamic

RELATED LINKS
Input methods for dynamics on page 284
Changing the appearance of niente hairpins on page 765
Lengthening/Shortening items on page 396

Adding niente markings to existing gradual dynamics
You can add niente markings to, and remove them from, existing gradual dynamics; for example, 
if you change your mind about which diminuendos should decrease to silence.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the gradual dynamics to which you want to add niente markings.

2. In the Properties panel, activate Niente in the Dynamics group.

RESULT
Niente markings are added to the selected gradual dynamics.

TIP

● Deactivating the property removes niente markings from the selected gradual dynamics.

● You can also add niente markings to, and remove them from, existing gradual dynamics by 
selecting them and clicking niente in the Gradual Dynamics section of the Dynamics panel.

AFTER COMPLETING THIS TASK
You can change the appearance of individual niente hairpins; for example, if you want to show 
some niente hairpins with a circle but others with text.

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Dynamics panel on page 286
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Changing the appearance of niente hairpins
You can show niente hairpins in two ways in Dorico SE, and you can change how they appear 
individually. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins whose niente style you want to change.

2. In the Properties panel, activate Niente style in the Dynamics group.

3. Choose one of the following options:

● Circle on hairpin 

● Text 

RESULT
The niente style of the selected hairpins is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

EXAMPLE

A niente shown as Circle on hairpin A niente shown as Text

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Groups of dynamics
Groups of dynamics are automatically aligned in a row and can be moved and edited as a group. 
When you move immediate dynamics within a group, the length of the hairpins on either side 
automatically adjust to compensate.

A group of dynamics The same group of dynamics adjusts to compensate 
when the middle dynamic moves rhythmically.
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A single dynamic, either immediate or gradual, is considered a group on its own.

Two or more dynamics are automatically grouped together if they immediately follow each 
other horizontally on the staff, were input together or in sequence, and have gradual dynamics 
between the immediate dynamics.

All of the dynamics in a group are highlighted when any of the dynamics in the group are 
selected.

NOTE

● Groups of dynamics apply project-wide, meaning you cannot have dynamics grouped one 
way in some layouts but differently in other layouts.

● As well as horizontal groups of dynamics, you can also link groups of dynamics vertically if 
you want the same dynamics to appear on multiple staves. This can be useful when multiple 
instruments play the same dynamics simultaneously and you want to make the same change 
in all staves; for example, moving the peak of a crescendo to a later beat, or changing a  to 
a .

RELATED LINKS
Linked dynamics on page 767

Grouping dynamics together
You can manually group dynamics together that were not automatically grouped when they were 
input. Grouped dynamics are automatically aligned in a row and can be moved and edited as a 
group.

PROCEDURE

1. In Write mode, select the dynamics you want to group together.

2. Choose Edit > Notations > Dynamics > Group Dynamics. You can also choose this option 
from the context menu.

RESULT
The selected dynamics are grouped together. If the first dynamic in the group is linked to other 
staves, all dynamics in the group are added to those staves. This applies to all layouts in which 
the dynamics appear.

RELATED LINKS
Linked dynamics on page 767

Ungrouping dynamics and removing dynamics from groups
You can ungroup dynamics so that all dynamics in the group become ungrouped. You can also 
remove only selected dynamics from groups while leaving other dynamics in the group.

This applies to all layouts in which the dynamics appear.
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PROCEDURE

1. In Write mode, select the dynamics you want to ungroup or remove from groups.

2. Do one of the following:

● To ungroup all dynamics in the selected groups, choose Edit > Notations > Dynamics > 
Ungroup Dynamics.

● To remove only the selected dynamics from their groups, choose Edit > Notations > 
Dynamics > Remove from Group.

TIP

You can also choose these options from the context menu.

Linked dynamics
Identical dynamics at the same rhythmic position on multiple staves can be linked together. This 
happens automatically when you copy and paste dynamics between staves.

If you select one dynamic in a linked group, all other dynamics in the linked group appear 
highlighted. If one linked dynamic is moved to a new rhythmic position, all linked dynamics 
move.

Two linked dynamics with only the top dynamic 
selected

Moving just the top dynamic of the linked group 
automatically moves the other to match its new 
position.

Similarly, if you change one linked dynamic, for example, from  to , all dynamics linked to the 
changed dynamic are also changed. If you group other dynamics to one of the linked dynamics, 
such as a hairpin, the hairpin is added at the same position in all linked staves.

If one staff has another immediate dynamic before the end of a hairpin, the hairpin is truncated 
automatically. If you delete such a dynamic, the hairpin extends automatically up to the next 
immediate dynamic or to its full length, whichever comes first.
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Two staves with linked dynamics, but the lower staff 
has another immediate dynamic that truncates the 
hairpin.

Deleting the mf at the end of the first bar in the 
second staff causes the hairpin to extend to match 
the range of the top staff.

NOTE

● If you delete only some dynamics from a group that is linked to other staves, those dynamics 
are also deleted from the linked staves. If you delete a whole dynamic group from one staff, 
this does not affect linked dynamics on other staves.

● As well as vertically linked dynamics, you can also group dynamics horizontally. This 
automatically aligns the dynamics in a row and allows them to be moved and edited as a 
group.

● Linking or unlinking dynamics applies project-wide, meaning you cannot have dynamics 
linked one way in some layouts but differently in other layouts.

RELATED LINKS
Groups of dynamics on page 765
Linked slurs on page 1027
Disabling automatic linking of dynamics and slurs when pasting on page 417

Linking dynamics together
When you copy and paste identical dynamics to the same rhythmic position on other staves, 
those dynamics are linked together automatically. You can also manually link dynamics and 
groups of dynamics together that are not automatically linked to allow simultaneous editing.

NOTE

Groups of dynamics must be the same in order to link them together. For example, you can link 
two  dynamics together if neither is part of a group, but you cannot link them together if one is 
grouped with a hairpin.

PROCEDURE

1. In Write mode, select the dynamics you want to link together.

2. Choose Edit > Notations > Dynamics > Link. You can also choose this option from the 
context menu.

RESULT
The selected dynamics are linked together. If you later change one of the linked dynamics, all 
linked dynamics are changed to match. This applies to all layouts in which the dynamics appear.

RELATED LINKS
Groups of dynamics on page 765
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Copying and pasting notes/items on page 414

Unlinking dynamics
You can unlink dynamics, including dynamics that were linked automatically. For example, if you 
want to lengthen/shorten gradual dynamics independently of each other.

PROCEDURE

1. In Write mode, select a dynamic in each linked group that you want to unlink.

2. Choose Edit > Notations > Dynamics > Unlink. You can also choose this option from the 
context menu.

RESULT
All dynamics in the linked groups are unlinked. This applies to all layouts in which the dynamics 
appear.

RELATED LINKS
Disabling automatic linking of dynamics and slurs when pasting on page 417

Dynamics in playback
The volume settings for sustaining instruments and non-sustaining instruments vary in terms of 
their control of gradual dynamics.

Sustaining instruments
Sustaining instruments include string, wind, and brass instruments, because they can 
hold a note while being in control of its volume throughout.

Dorico SE applies gradual dynamics to these instruments in playback.

Non-sustaining instruments
Non-sustaining instruments, such as piano, harp, marimba, and most percussion 
instruments, have no further control of the dynamic of notes after they have been 
struck. For this reason, non-sustaining software instruments often use note velocity for 
dynamics, because this is set at the start of the note.

TIP

You can control settings for each software instrument in the Expression Maps dialog.

RELATED LINKS
Expression Maps dialog on page 626
Dynamics editor on page 590
MIDI CC editor on page 596

VST Expression Maps for volume types
If you are using a third-party sound library, you may need to change or edit the expression map 
to make instruments respond to gradual dynamics. Otherwise, the sound library uses velocity by 
default.

The setup of the expression map for dynamics depends on how the instrument is configured. 
Consult the documentation for the sound library for further information.

Dorico SE provides the following default expression maps:
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● CC11 Dynamics for dynamics produced by changing MIDI channel expression

● Modulation Wheel Dynamics for dynamics produced by changing MIDI controller 1

TIP

You can edit expression maps in the Expression Maps dialog.
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Figured bass

Figured bass is a shorthand that uses figures to specify the harmony above the notated bass 
notes. It is particularly common in Baroque and early Classical music and in the parts of 
accompanying instruments, such as harpsichords and viols.

Figured bass informs performers about the intended harmony but allows room for 
interpretation, such as improvised arpeggiated phrases using notes from the chord.

Figures use a combination of Arabic numbers, accidentals, and horizontal hold lines to specify 
both the intervals above the bass note that make up the chord and its duration. For example, 
they show where suspensions resolve or when the bass note changes but the chord remains the 
same.

Tasto solo indications inform performers that sections should be played without harmony.

A basso continuo part with figured bass below the staff

In Dorico SE, figured bass exists globally at the corresponding rhythmic positions by default 
because most music that includes figured bass is tonal, meaning players perform notes from the 
same chord. Therefore, you only have to input figures once, but they can appear above multiple 
or no staves as required and the figures automatically update according to the notes on each 
staff. However, in some circumstances it is necessary to specify different chords for different 
players at the same rhythmic position. In such cases, you can input local figured bass.

Dorico SE calculates and saves the pitches implied by the figures you enter in relation to the 
lowest note at that rhythmic position. This semantic understanding of the harmony implied by 
figures allows Dorico SE to update the displayed figures on different staves and if you transpose 
or change the pitch of notes.

When you transpose music that includes figured bass, Dorico SE also transposes the figures 
accordingly.

Figured bass in Dorico SE uses a bold roman font by default.

You can hide or show figured bass in each layout independently and only above the staves of 
specific players. You can also change whether figured bass appears above or below staves by 
default in each layout independently. Figures appear as signposts if Dorico SE either does not 
normally show them, such as third intervals, or cannot identify the bass note for them, such as 
on a rest.

NOTE

Figured bass does not yet include notations commonly used for harmonic analysis, such as 
Roman numerals. This is planned for future versions.

RELATED LINKS
Inputting figured bass on page 363
Figured bass hold lines on page 774
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Showing figured bass on rests on page 773
Showing single brackets on figured bass on page 774
Changing the staff-relative placement of figured bass on page 778
Appearance of figured bass on page 780

Hiding/Showing figured bass in layouts
You can hide/show figured bass in each layout independently and only above the staves of 
specific players. For example, you can show figured bass in the full score and bass part layouts 
but hide figured bass in the other part layouts.

Any player on whose staff you input figured bass is automatically set to show figured bass in the 
current layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show figured bass.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Figured Bass section, activate/deactivate each player above/below which you want to 
show figured bass.

5. Click Apply, then Close.

RESULT
Figured bass is shown above/below all instruments belonging to the corresponding players in 
the selected layouts when their checkboxes are activated, and hidden when their checkboxes are 
deactivated. Figured bass is hidden completely when no checkboxes are activated.

AFTER COMPLETING THIS TASK

● You can change the staff-relative placement of figured bass.

● You can hide figured bass figures individually in layouts where figured bass is shown.

RELATED LINKS
Inputting figured bass on page 363
Changing the staff-relative placement of figured bass on page 778
Figured bass hold lines on page 774

Hiding/Showing figured bass figures individually
You can hide/show individual figured bass figures in layouts in which figured bass is shown. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains. 
However, you cannot show individual figures in layouts where figured bass is hidden.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the figured bass figures you want to hide, or the signposts of figures you want to 
show.

2. In the Properties panel, activate/deactivate Hidden in the Figured Bass group.

RESULT
The selected figured bass figures are hidden when Hidden is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden figure. However, signposts are not printed by 
default.

TIP

● You can hide/show figured bass signposts by choosing View > Signposts > Figured Bass.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Signposts on page 407
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Key Commands page in the Preferences dialog on page 54
Annotations on page 507

Showing figured bass on rests
By default, figured bass is hidden on rests because figures typically indicate harmony in relation 
to a bass note. You can show figured bass on individual rests; for example, if the harmony 
changes while the bass is resting. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

PREREQUISITE

● You have input figured bass at the positions of the rests.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the rests on which you want to show figured bass.

2. In the Properties panel, activate Show figured bass in the Notes and Rests group.

RESULT
Figured bass is shown on the selected rests. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

Deactivating Show figured bass hides figured bass on selected rests again.
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Showing single brackets on figured bass
You can show only a single left or right bracket on individual bracketed figured bass figures. For 
example, if you want to indicate that all figures between two bracketed figures are optional. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● You have input figured bass figures with brackets.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the bracketed figures on which you want to show a single bracket.

2. In the Properties panel, activate Hide single bracket in the Figured Bass group.

3. Choose one of the following options:

● Start

● End

RESULT
Brackets are hidden on the corresponding side of the selected figures, leaving a single bracket 
on the other side. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

EXAMPLE

Brackets shown on both sides of all figures Brackets shown at the start of the first figure and the 
end of the last figure only

RELATED LINKS
Inputting figured bass on page 363
Showing brackets on figured bass hold lines on page 777
Bracketed noteheads on page 849

Figured bass hold lines
Figured bass hold lines indicate that chords remain the same over changing notes in the bass.

By default, Dorico SE shows hold lines for figures that have duration, but hides lines between 
suspensions and resolutions or after resolutions. You can hide/show hold and suspension lines 
for individual suspension figures.

Figured bass
Showing single brackets on figured bass 
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Figure (selected) with no duration Figure (selected) with duration and hold line

RELATED LINKS
Grace notes on page 803

Hiding/Showing figured bass hold/suspension lines
You can hide/show suspension lines between suspension and resolution figures and hold lines 
after resolution figures, independently of each other.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the figured bass suspensions whose hold/suspension lines you want to hide/show.

2. In the Properties panel, activate the following properties, individually or together, in the 
Figured Bass group:

● Line between susp. and resolution

● Continue line after resolution

3. Activate/Deactivate the corresponding checkboxes.

RESULT
Hold lines are shown between suspension and resolution figures and/or after resolutions in 
the selected figured bass suspensions when the corresponding checkboxes are activated, and 
hidden when the checkboxes are deactivated.

EXAMPLE

Suspension and hold lines both 
hidden

Suspension line between 
suspension and resolution shown

Suspension line between 
suspension and resolution and 
hold line after resolution both 
shown

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Showing figured bass on rests on page 773
Moving figured bass resolutions on page 779

Figured bass
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Lengthening/Shortening figured bass hold lines
You can change the duration of figured bass figures after they have been input, which changes 
the length of their hold lines. Lengthening a figure that was input without duration gives it 
duration and shows a hold line. You can also change the end positions of figured bass hold lines 
relative to notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the figured bass figures you want to lengthen/shorten.

2. In the Properties panel, activate Duration in the Figured Bass group.

3. Lengthen/Shorten the selected figured bass figures in any of the following ways:

● To lengthen them, increase the value in the left value field.

● To shorten them, decrease the value in the left value field.

● To move their end to the left to a grace note at the rhythmic position set by the left value 
field, decrease the value in the right value field.

TIP

1 represents a quarter note.

4. Do one of the following:

● To position the end of hold lines to the right of noteheads and across grace notes, 
activate Draw line through figures at end.

● To position the ends of hold lines to the left of noteheads and before grace notes, 
deactivate Draw line through figures at end.

RESULT
The duration of the selected figured bass figures, and the length of their hold lines, is changed.

TIP

You can also lengthen/shorten figured bass figures in the same ways as for other items.

EXAMPLE
These examples all have an overall duration of a half note; that is, 2 entered into the left value 
field.

Draw line through figures at end 
deactivated

Draw line through figures at end 
activated

-1 1/4 entered into the right 
value field and Draw line through 
figures at end activated

Figured bass
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RELATED LINKS
Lengthening/Shortening items on page 396

Showing brackets on figured bass hold lines
You can show brackets on individual figured bass hold and suspension lines; for example, to 
indicate editorial hold lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the figured bass hold/suspension lines on which you want to show brackets.

2. In the Properties panel, activate the following properties, individually or together as 
appropriate for your selection, in the Figured Bass group:

● Bracket sus. lines

● Bracket hold lines

3. Select one of the following options from each menu:

● Both ends

● Start

● End

RESULT
Brackets are shown at the corresponding ends of the selected figured bass hold/suspension 
lines.

EXAMPLE

Both ends brackets on hold lines Start bracket on suspension lines and End bracket 
on hold lines

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Inputting figured bass on page 363
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Positions of figured bass
Figured bass is automatically organized into rows according to the number of rows required in 
each system independently. By default, rows are aligned at the top when below the staff and at 
the bottom when above the staff to minimize the gap between figured bass and the staff.

The vertical position of figured bass is determined by the staves above which they are set to 
appear and your per-layout setting for their staff-relative placement.

You can move individual figured bass figures to different rhythmic positions in Write mode. They 
are automatically positioned to avoid collisions. This includes Dorico SE’s kerning, which applies 
across whole systems to ensure all figures and alterations are legible.

RELATED LINKS
Hiding/Showing figured bass in layouts on page 772
Hiding/Showing figured bass hold/suspension lines on page 775
Lengthening/Shortening figured bass hold lines on page 776
Moving figured bass resolutions on page 779
Moving notes/items rhythmically on page 417

Changing the staff-relative placement of figured bass
You can change the default staff-relative placement of all figured bass figures in each layout 
independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff-relative 
placement of figured bass.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Figured Bass section, choose one of the following options for Default placement:

● Above staff

● Below staff

5. Click Apply, then Close.

RESULT
The default staff-relative placement of all figured bass figures in the selected layouts is changed.

TIP

You can also change the staff-relative placement of individual figured bass figures by selecting 
them and pressing F . If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

Figured bass
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EXAMPLE

Figured bass below the staff Figured bass above the staff

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Moving figured bass resolutions
You can move resolution figures rhythmically, without affecting the position of the suspension 
figure or the overall duration of the figured bass suspension; for example, if you want a 
suspension to resolve on a different note.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the resolution figures you want to move.

2. In the Properties panel, activate Resolution pos. in the Figured Bass group.

3. Move the selected resolution figures in any of the following ways:

● To move them to the right, increase the value in the left value field.

● To move them to the left, decrease the value in the left value field.

● To move them to the left to grace notes at the rhythmic position set by the left value 
field, decrease the value in the right value field.

TIP

1 represents a quarter note.

RESULT
The selected resolution figures are moved rhythmically.

TIP

In Write mode, you can also click and drag resolution figure handles to the right/left according to 
the current rhythmic grid resolution.

EXAMPLE
For example, entering 1 into the left value field and -1/2 into the right value field moves 
resolution figures a quarter note to the right of suspension figures, and to the first of two 
sixteenth grace notes at that rhythmic position.

Figured bass
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RELATED LINKS
Figured bass hold lines on page 774
Moving notes/items rhythmically on page 417
Changing the rhythmic grid resolution on page 190
Inputting figured bass on page 363

Appearance of figured bass
The appearance of individual figures is determined either by the default settings in Dorico SE or 
your popover entry, depending on whether you instructed Dorico SE to follow your entry literally 
when you input each figure.

When inputting figured bass, by default Dorico SE interprets your entries and applies its default 
settings for the appearance of figured bass to them. You can specify that you want Dorico SE to 
follow your entries exactly for individual figures; for example, if you are reproducing a piece of 
music and know in advance exactly how you want figures to appear.

You can reset individual figures that you input with the figured bass input setting Follow input 
literally so they follow the default settings, and you can fix the current appearance of individual 
figures.

Figured bass in Dorico SE uses a bold roman font by default.

Figures appear as signposts if Dorico SE either does not normally show them, such as third 
intervals, or cannot identify the bass note for them, such as on a rest.

RELATED LINKS
Inputting figured bass on page 363
Figured bass hold lines on page 774
Showing figured bass on rests on page 773
Showing single brackets on figured bass on page 774

Simplifying figured bass compound intervals
You can simplify compound intervals in individual figured bass figures; that is, figures 9 and 
above. Some editions prefer to simplify compound intervals so figures reflect the first octave and 
appear out of order in the stack.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the compound figured bass figures you want to simplify.
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2. In the Properties panel, activate Show compound intervals as simple in the Figured Bass 
group.

RESULT
The selected compound figures are simplified. Deactivating the property returns the selected 
figures to their default octave.

EXAMPLE

Figure with compound intervals Figure with simplified compound intervals

RELATED LINKS
Properties panel on page 560

Fixing the current appearance of figured bass
You can fix the current appearance of individual figured bass figures; for example, if you 
input them with the input setting Follow Engraving Options but want to keep their current 
appearance, regardless of future changes you make to figured bass engraving options.

PROCEDURE

1. Select the figured bass figures whose current appearance you want to fix.

2. Choose Edit > Notations > Figured Bass > Force Current Appearance.

RESULT
The current appearance of the selected figures is fixed, meaning they are not affected by any 
future changes to figured bass engraving options.

NOTE

● You cannot access the Engraving Options dialog in Dorico SE, as it is only available in Dorico 
Pro. However, fixing figures maintains their appearance if you share the project with other 
users who later change figured bass engraving options.

● You can assign a key command for Force Current Appearance on the Key Commands page 
in Preferences.

Resetting figured bass
You can reset individual figured bass figures; for example, if they were input with the figured 
bass input setting Follow input literally. Reset figures follow the default settings in Dorico SE.

PROCEDURE

1. Select the figured bass figures you want to reset.

2. Choose Edit > Notations > Figured Bass > Reset Figured Bass.
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RESULT
The selected figured bass figures are reset to follow the default settings. This can affect their 
appearance and suspension duration.

TIP

You can assign a key command for Reset Figured Bass on the Key Commands page in 
Preferences.

RELATED LINKS
Inputting figured bass on page 363
Key Commands page in the Preferences dialog on page 54
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Fingering

Fingerings use numbers and letters to recommend which fingers players should use for notes. 
This can be useful for music aimed at players learning the instrument and for difficult musical 
passages where certain fingering patterns make the notes much easier to play.

Fingerings are often used in keyboard music, as players can use all ten fingers to play notes, and 
in guitar music, where fingerings are often used alongside fret positions. However, fingerings 
can also be useful for other instruments; for example, to indicate that string players should 
change the finger used to stop the string while holding the note, or to instruct wind players to 
use uncommon fingerings for particular notes in order to create a special sonic effect.

Piano music containing multiple fingerings, including a substitution fingering and alternative fingerings

Dorico SE also provides fingerings for brass and fretted instruments. For example, you can 
specify which valves players should depress for instruments such as trumpet and horn, and you 
can specify the horn branch you want players to use for double horns. For fretted instruments, 
you can input fingerings for both hands.

Fingerings in Dorico SE use a bold roman font by default, following accepted conventions for the 
appearance of fingerings.

RELATED LINKS
Inputting fingerings on page 249
Fingerings popover on page 251
Fingerings for fretted instruments on page 789
Fingerings for valved brass instruments on page 794
Fingering slides on page 792
Hiding/Showing fingering on page 787
String indicators on page 797
Hiding/Showing fingerings in chord diagrams on page 732

General placement conventions for fingering
Fingerings are placed as close as possible to the notes to which they apply, so the performer can 
read them easily and clearly.

In music for grand staff instruments, such as the piano and harp, it is accepted to place 
fingerings for the right hand above the top staff, and fingerings for the left hand below the 
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bottom staff. However, in dense contrapuntal music for these instruments, fingerings can be 
placed between the staves to follow the direction of the voices to which they apply.

Different conventions apply to fingerings for fretted instruments, as they require fingerings for 
both the right and left hands.

Right-hand fingering placement

By default, all right-hand fingerings are placed outside the staff and on the notehead side of 
notes, which can be above or below the staff depending on the stem direction. When shown 
beside notes inside the staff, Dorico SE automatically joins adjacent notes with the same right-
hand fingering with a bracket.

Left-hand fingering placement

Left-hand fingerings are usually positioned inside the staff and to the left of the notes to which 
they apply. However, they also must not collide with other items, such as accidentals and rhythm 
dots. Dorico SE automatically calculates the most appropriate positions for left-hand fingerings 
and erases their backgrounds by default, which improves their readability when placed on staff 
lines.

RELATED LINKS
Fingerings for fretted instruments on page 789

Changing fingerings to substitution fingerings
Substitution fingerings indicate where players should change the finger used for the note. You 
can change existing fingerings to substitution fingerings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the fingerings you want to change to substitution fingerings.

2. In the Properties panel, activate Substitution in the Fingering and Positions group.

3. Enter the fingering you want for the substitution into the value field.

4. Press Return .

RESULT
The selected fingerings are now shown as substitution fingerings. The deferred position of the 
substitution is the same as the original fingering by default, but you can change the rhythmic 
position of substitution fingerings.

RELATED LINKS
Inputting fingerings on page 249
Fingerings popover on page 251

Fingering
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Changing the rhythmic position of substitution fingerings
Substitution fingerings are shown as immediate by default, meaning that the substitution 
takes place on the same note, but you can change the rhythmic position at which individual 
substitutions take place.

PROCEDURE

1. Select the substitution fingering whose deferred rhythmic position you want to change.

2. Change the rhythmic position of the substitution fingering in any of the following ways:

● Click and drag the circular handle to the right/left.

● Activate Substitution offset in the Fingering and Positions group of the Properties 
panel.

Change the rhythmic position of substitutions as fractions of a quarter note (crotchet) by 
entering a value into the left value field, or by clicking the arrows beside the value field. 
Increasing the value moves substitutions to later positions, decreasing the value moves 
them to earlier positions.

NOTE

The right value field is for the grace note position at which substitutions occur, if 
applicable.

RESULT
The rhythmic position of the substitution fingering is changed.

Dorico SE automatically arranges deferred substitutions so they are ordered appropriately 
alongside any fingerings that coincide with the substitution.

NOTE

You can only change the position of single substitution fingerings when dragging their handles 
with the mouse. However, you can change the positions of multiple substitution fingerings with 
Substitution offset in the Fingering and Positions group of the Properties panel.

Deferred substitutions are always shown with horizontal lines.

Changing existing fingerings
You can change fingerings after you have input them; for example, if you decide a different 
fingering would be better.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the fingerings you want to change.

2. In the Properties panel, enter the new fingering you want into the Finger or position value 
field in the Fingering and Positions group.

3. Press Return .

Fingering
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RESULT
The selected fingerings are changed.

TIP

You can also change existing fingerings in Write mode by opening the fingerings popover. Any 
existing fingerings on the selected note are shown in the popover.

RELATED LINKS
Inputting fingerings on page 249
Fingerings popover on page 251

Changing the staff-relative placement of fingerings
Dorico SE automatically follows conventions for fingering placement, but you can show individual 
fingerings belonging to non-fretted instruments either above or below the staff. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

According to convention, keyboard instrument fingering is positioned above the right-hand staff, 
and below the left-hand staff. String and brass instrument fingering is always positioned above 
the staff.

NOTE

These steps only apply to non-fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the fingerings whose staff-relative placement you want to change.

2. In the Properties panel, activate Staff-relative position in the Fingering and Positions 
group.

3. Choose one of the following options:

● Above

● Below

RESULT
The selected fingerings appear above/below the staff. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

RELATED LINKS
Fingerings for fretted instruments on page 789
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
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Showing fingerings inside the staff
You can show individual fingerings belonging to non-fretted instruments beside noteheads 
inside the staff.

NOTE

● These steps only apply to non-fretted instruments. Left-hand fingerings for fretted 
instruments are shown inside the staff by default.

● These steps do not apply to substitution fingerings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. In Write mode, select the notes whose fingerings you want to show inside the staff.

2. In the Properties panel, activate Position left of notehead in the Fingering and Positions 
group.

RESULT
Fingerings belonging to the selected notes are shown inside the staff, directly beside the 
noteheads. By default, if they belong to a note on a staff line, they erase part of the staff line to 
ensure legibility.

EXAMPLE

Hiding/Showing fingering
You can hide/show fingering in each layout independently. For example, you can show fingering 
in part layouts but hide fingering in full score layouts as conductors rarely require fingering 
information.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show fingering.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Fingering section, activate/deactivate Show fingering.

5. Click Apply, then Close.

Fingering
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RESULT
All fingerings are shown in the selected layouts when the checkbox is activated, and hidden when 
the checkbox is deactivated.

RELATED LINKS
Hiding/Showing fingerings in chord diagrams on page 732

Deleting fingerings
You can remove fingerings from notes after you have input them. However, because fingerings 
are properties of notes rather than separate items in Dorico SE, you cannot select and delete 
them as you would for other items.

PROCEDURE

1. Select the notes from which you want to remove fingerings.

2. Choose Edit > Notations > Fingering > Reset Fingering.

RESULT
All fingerings are removed from the selected notes.

TIP

You can assign a key command for Reset Fingering on the Key Commands page in 
Preferences.

RELATED LINKS
Large selections on page 389
Assigning key commands on page 58

Cautionary fingerings
Cautionary fingerings remind players that fingerings specified at previous rhythmic positions 
continue to apply to notes that are still sounding. Dorico SE automatically shows cautionary 
fingerings when you add other fingerings at rhythmic positions where notes with existing 
fingerings are still sounding.

By default, cautionary fingerings are shown enclosed in parentheses.

Cautionary fingering shown in parentheses (default)

RELATED LINKS
Inputting fingerings on page 249
Fingerings popover on page 251

Fingering
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Fingerings for fretted instruments
Fretted instruments, such as the classical guitar, require additional fingering instructions for 
both hands due to the complex nature of the music.

Fingerings for fretted instruments use the same fonts as normal fingerings.

A passage for guitar with right-hand and left-hand fingerings

Right-hand fingering
Right-hand fingerings tell the performer which finger to use to pluck the string, which 
is usually the right hand. By default, all right-hand fingerings are placed outside the 
staff, on the notehead side of notes, and follow the stem directions of voices in 
multiple-voice contexts. When the same finger plays multiple notes in a chord, you 
can show a single fingering with a bracket for the notes plucked by that finger.

Dorico SE shows “p” for right-hand thumb fingerings and “e” for right-hand fingerings 
for the pinky finger.

NOTE

In Dorico SE, we use “pinky” to refer to the smallest finger, but it can also be called 
“little” or “fifth digit”.

Left-hand fingering
Left-hand fingerings tell the performer which finger to use to stop the string, which is 
usually the left hand. In Dorico SE, left-hand fingerings are placed inside the staff and 
to the left of the notes to which they apply.

When shown inside the staff next to notes, left-hand fingering appears smaller than 
fingering shown outside the staff.

RELATED LINKS
Inputting fingerings on page 249
Fingerings popover on page 251
Adding fingerings to arpeggio signs on page 792
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Fingerings for fretted instruments 

789
Dorico SE 4.3.30



Fingering slides on page 792
String indicators on page 797
Tapping on page 905
Hammer-ons and pull-offs on page 906

Hiding/Showing brackets for right-hand fingerings
When multiple notes in the same chord are plucked by the same right-hand finger, you can show 
the same fingering multiple times, once for each note, or show a single fingering for all notes 
with a bracket spanning the notes plucked by that finger. When showing a separate fingering for 
each note, you can also choose to place each fingering either above or below the staff. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to right-hand fingerings belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select all the notes for which you want to hide/show brackets for right-hand fingerings.

2. In the Properties panel, activate Vertical position in the Plucked Fingering group.

3. Select one of the following options from the menu:

● To hide brackets and show a separate fingering for each selected note, select Above 
staff or Below staff.

● To show brackets and a single fingering for all notes in each bracket, select Next to 
note.

RESULT
Brackets on the selected right-hand fingerings are hidden/shown. If you selected Above staff or 
Below staff, their staff-relative placement is changed accordingly. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Right-hand fingerings shown next 
to notes with a bracket

Right-hand fingerings shown 
above the staff

Right-hand fingerings shown 
below the staff

Fingering
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RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the position of left-hand fingerings
You can change the position of individual left-hand fingerings. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains. By default, they are positioned 
inside the staff and to the left of the notes to which they apply.

NOTE

These steps only apply to left-hand fingerings belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the left-hand fingerings whose position you want to change.

2. In the Properties panel, activate Stopping finger position in the Fingering and Positions 
group.

3. Select one of the following options from the menu:

● Outside staff

● Left of note

● Right of note

RESULT
The position of the selected left-hand fingerings is changed. When shown outside the staff, they 
are placed above the staff by default. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

EXAMPLE

Outside staff Left of note Right of note

RELATED LINKS
General placement conventions for fingering on page 783
Inputting fingerings on page 249
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Adding fingerings to arpeggio signs
You can add fingerings to arpeggio signs to indicate which right-hand finger should be used to 
strum a chord. By default, fingerings are placed at the bottom of arpeggio signs.

NOTE

These steps only apply to arpeggio signs belonging to fretted instruments.

PREREQUISITE

● You have input the arpeggio signs to which you want to add fingerings.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the arpeggio signs belonging to fretted instruments to which you to add fingerings.

2. In the Properties panel, activate Finger in the Plucked Fingering group.

3. Enter the fingering you want into the value field.

For example, for the thumb, enter p.

RESULT
The specified fingering is added to the selected arpeggio signs. It is positioned at the bottom of 
the arpeggio signs by default.

EXAMPLE

Arpeggio signs played with the thumb

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310

Fingering slides
Fingering slides indicate that the performer should slide their finger up/down the neck of the 
instrument. They are notated as an angled line between fingerings.

The note at the start of a fingering slide is known as a source note. The note at the end of a 
fingering slide is known as the destination note.

Fingering
Fingering slides 
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A passage with fingering slides

When the source and destination notes are sufficiently close horizontally, fingering slides are 
shown between the fingerings, joining them directly in their existing positions without moving 
them. When the source and destination notes are far apart horizontally, fingering slides appear 
with a fixed length to the left of the destination note. You can change the length of individual 
fingering slides.

Fingering slides automatically avoid obstructions, such as noteheads, accidentals, and other 
fingerings.

NOTE

● Dorico SE automatically adjusts the length/angle of fingering slides when you move the 
fingerings at the start/end.

● In Dorico SE, you can only show fingering slides on staves belonging to fretted instruments. 
You can show string fingering shift indicators on staves belonging to other string 
instruments.

RELATED LINKS
Hiding/Showing string fingering shift indicators on page 795
Glissando lines on page 889
Jazz articulations on page 911

Hiding/Showing fingering slides
You can hide/show slides between notes played by the same left-hand finger on the same string 
on fretted instruments.

NOTE

These steps only apply to fingerings belonging to fretted instruments.

PREREQUISITE

● You have input the same left-hand fingering for the notes at the start and end of the slides.

● You have specified the same string for the notes at the start and end of the slides.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the destination notes before which you want to hide/show fingering slides.

2. In the Properties panel, activate/deactivate Slide in in the Fingering and Positions group.

Fingering
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RESULT
Fingering slides are shown before the selected notes when Slide in is activated, and hidden 
when it is deactivated. If the gap between the source and destination notes is small enough, 
fingering slides appear as an angled line joining the fingerings. If the gap is large, fingering 
slides appear as a fixed length angled line to the left of the destination notes.

RELATED LINKS
Inputting fingerings on page 249
Changing existing fingerings on page 785
Assigning notes to strings on page 846

Fingerings for valved brass instruments
For instruments like trumpet and horn, fingering is used to show which valves must be 
depressed to produce a specific note.

You can enter fingerings for valved brass instruments into the fingerings popover as numbers 
without any separation. For example, enter 12 for a C♯ on a trumpet to indicate that the first two 
valves must be depressed.

By default, Dorico SE automatically stacks fingerings added to notes on brass instrument staves 
vertically. They are shown with no separator by default.

RELATED LINKS
Inputting fingerings on page 249
Fingerings popover on page 251

Showing horn branch indicators
You can indicate the branch on which notes are played for double horns and triple horns by 
adding branch indicators as prefixes to horn fingerings. Some publications simply indicate “T” for 
thumb, while others more explicitly indicate which branch is to be used by specifying its pitch.

NOTE

You can only add branch indicators to notes belonging to horns in F.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the horn fingerings to which you want to add branch indicators.

2. In the Properties panel, activate Horn branch in the Fingering and Positions group.

3. Select one of the following horn branches from the menu:

● F

● B flat

● F alto

● E flat alto

● Thumb trigger

Fingering
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RESULT
Branch indicators are added to the selected fingerings.

Hiding/Showing string fingering shift indicators
You can hide/show shift indicators after individual fingerings belonging to string instruments. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

Shift indicators are angled lines that indicate the direction of movement when string players 
must shift their finger position on the fingerboard to play a higher/lower note with the same 
finger as the previous note.

NOTE

These steps do not apply to fingerings belonging to fretted instruments, which can show 
fingering slides instead.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Write mode, select the notes on string instrument staves from which you want to indicate 
a fingering shift.

2. In the Properties panel, activate/deactivate Indicate shift to next note in the Fingering and 
Positions group.

RESULT
Shift indicators are shown when the property is activated, even if neither of the notes at each 
end have explicit fingerings, and hidden when the property is deactivated. They are positioned 
between the selected notes and the notes that immediately follow them. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can specify that fingerings should show shift indicators when inputting fingerings for string 
instruments.

EXAMPLE

RELATED LINKS
Inputting fingerings on page 249
Fingering slides on page 792
Assigning notes to strings on page 846
Changing the property scope on page 562

Fingering
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Changing the direction of string fingering shift indicators
You can change the direction of individual string fingering shift indicators if they do not point in 
the direction required.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the shift indicators whose direction you want to change.

2. In the Properties panel, activate Shift direction in the Fingering and Positions group.

3. Choose one of the following options:

● Up

● Down

RESULT
The selected shift indicators are angled up/down.

NOTE

You can also affect the direction of string shift indicators by specifying the strings on which notes 
are played.

Fingerings imported from MusicXML files
Dorico SE imports fingerings that are specified using the fingering element in MusicXML files.

MusicXML files exported from Finale typically represent fingerings in the correct way. However, 
because Sibelius does not use the fingering element, Dorico SE cannot import fingerings from 
MusicXML files exported by Sibelius.

Fingering
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String indicators

String indicators are commonly used in guitar music to tell performers the string on which they 
should play a note, particularly for pitches that are possible on multiple strings.

String indicators show the string number inside a circle enclosure, optionally with a dashed line 
to indicate they apply to a range of notes. Open pitches commonly appear as a zero without an 
enclosure.

In Dorico SE, string indicators for stopped pitches appear in a plain font while string indicators 
for open strings use the fingering font.

A phrase with string indicators and left-hand fingerings

There are two types of string indicators in Dorico SE, which you input in different ways.

String indicators outside the staff
String indicators outside the staff always appear inside circle enclosures. They 
automatically show dashed duration lines when they have duration to indicate that 
multiple notes are played on that string.

In Dorico SE, string indicators outside the staff are considered playing techniques. You 
can select and delete them independently of the notes to which they apply.

String indicator outside the staff with duration line

String indicators inside the staff
String indicators inside the staff appear inside circle enclosures, except when they 
show open strings, which appear as a bold number zero without an enclosure. They 
automatically erase their backgrounds so they do not collide with staff lines. They 
appear to the left of noteheads by default but automatically appear to the right if 
left-hand fingerings are present.

The string number shown in string indicators inside the staff is calculated 
automatically, but you can also specify the string manually.

String indicators inside the staff for stopped pitches are scaled-down versions of string 
indicators outside the staff.

In Dorico SE, string indicators inside the staff are considered properties of the 
corresponding notes. You cannot select them independently of their corresponding 
notes.
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NOTE

You can only show string indicators inside the staff on notes belonging to fretted 
instruments.

String indicators inside the staff, with the last one for an open string

RELATED LINKS
Fingerings for fretted instruments on page 789
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Playing techniques on page 937
Playing technique duration on page 941
Playing technique continuation lines on page 940
Lengthening/Shortening items on page 396
Assigning notes to strings on page 846

Deleting string indicators
You can remove string indicators inside the staff from notes after you have input them. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains. However, 
because string indicators inside the staff are properties of notes rather than separate items, you 
cannot select and delete them as you would for other items.

NOTE

These steps only apply to string indicators inside the staff. You can delete string indicators 
outside the staff in the same ways as for other items.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes from which you want to remove string indicators inside the staff.

2. In the Properties panel, deactivate Show in the String Indicators group.

RESULT
String indicators inside the staff are removed from the selected notes. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Deleting notes/items on page 412
Inputting string indicators inside the staff on page 351

String indicators
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Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Positions of string indicators
String indicators outside the staff are placed above it by default. In multiple-voice contexts, 
string indicators for the up-stem voices are placed above the staff and string indicators for the 
down-stem voices are placed below the staff.

String indicators inside the staff automatically erase their backgrounds so they do not collide 
with staff lines. They appear to the left of noteheads by default but automatically appear to the 
right if left-hand fingerings are present. You can change the notehead-relative position of string 
indicators individually.

You can move string indicators outside the staff to different rhythmic positions in Write mode. 
They are automatically positioned to avoid collisions. You can also change the staff-relative 
placement of string indicators outside the staff individually, in the same ways as for playing 
techniques.

RELATED LINKS
Playing technique continuation lines on page 940
Lengthening/Shortening items on page 396
Moving notes/items rhythmically on page 417
Changing the staff-relative placement of items on page 400

Changing the notehead-relative position of string indicators
By default, string indicators inside the staff appear to the left of noteheads when there are no 
left-hand fingerings and to the right of noteheads when there are left-hand fingerings. You can 
change the side of noteheads on which string indicators inside the staff appear individually. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the string indicators inside the staff whose notehead-relative position you want to 
change.

2. In the Properties panel, activate Notehead-relative pos. in the String Indicators group.

3. Choose one of the following options:

● Left

● Right

RESULT
The notehead-relative position of the selected string indicators is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

String indicators
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EXAMPLE

String indicators to the left of noteheads String indicators to the right of noteheads

String indicators
Positions of string indicators 
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Front matter

Front matter in Dorico SE is a broad term that covers all information included before the first bar 
of music in scores.

Front matter includes musical information often added on pages before the first pages of scores, 
such as a title page, instrumentation list, program note, and performance instructions.

Front matter also includes information above the music on the first page of scores and parts, 
such as the dedication, title, subtitle, composer, and lyricist.

TIP

An efficient way of keeping information consistent across all layouts is to use tokens that refer to 
fields in the Project Info dialog. The default page templates in Dorico SE contain tokens for the 
project title, lyricist, and composer on the first pages in layouts, and the flow title (score layouts) 
or layout name (part layouts) at the top of subsequent pages. Part layouts also automatically 
show the layout name in the top left of the first page.

RELATED LINKS
Project Info dialog on page 70
Flow names and flow titles on page 164
Tokens on page 552
Page templates on page 547
Frames on page 551
Page formatting on page 508
Hiding/Showing flow headings on page 521

Editing layout transposition text
You can override layout transposition token text in each layout independently; for example, if you 
want some layouts to display “Concert Pitch” but others to display “Full Score in C”.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose layout transposition text you want to edit.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Text Tokens section, activate the following options, individually or together:

● Custom text for concert layout

● Custom text for transposed layout

5. Enter the text you want into the corresponding value fields.

6. Click Apply, then Close.
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RELATED LINKS
Tokens on page 552
Layouts on page 151
Concert vs. transposed pitch on page 155
Making layouts transposing/concert pitch on page 155

Front matter
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Grace notes

Grace notes are notes without a fixed duration, which are intended to be played quickly. They 
are scaled-down versions of normal notes, and are commonly shown with a slash through their 
stem.

Grace notes with slashed stems are known as “acciaccaturas” and are often played very fast. 
Grace notes without slashed stems are known as “appoggiaturas” and are often played slower 
than acciaccaturas. In Baroque music, appoggiaturas are often understood to last for a specific 
duration, based on the prevailing meter and the rhythmic value of the notehead to which they 
are attached. Therefore in Dorico SE, slashed and unslashed grace notes are handled differently 
in playback.

Grace notes do not take up space rhythmically, as they are intended to be fitted into the space 
before the note to which they are attached, which is the note immediately to their right.

There can be multiple grace notes before a notehead. If there are two or more grace notes 
attached to the same notehead, and they have a rhythmic value that shows a flag on the stem, 
such as eighth notes (quavers) and 16th notes (semiquavers), they are automatically beamed 
together.

Multiple grace notes before notes

In Dorico SE, grace notes are scaled to 3/5 the size of a normal notehead by default and are 
affected by your note spacing settings. There is a separate option specifically for grace note 
spacing.

You can add notations, such as slurs and articulations, to grace notes in the same ways as to 
normal notes, and you can transpose grace notes after they have been input.

RELATED LINKS
Inputting grace notes on page 225
Turning existing notes into grace notes on page 805
Grace note slashes on page 807
Grace notes in playback on page 808
Slur placement relative to grace notes on page 1017
Changing the pitch of individual notes on page 424
Inputting articulations on page 246
Inputting slurs on page 248
Note spacing on page 533
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General placement conventions for grace notes
Grace notes function like normal notes in many ways, but there are some specific conventions 
about their stem direction, position relative to noteheads, and the placement of stem slashes.

Grace notes are always positioned before a notehead, even if they are intended to be played on 
the beat rather than before the beat. They are normally placed after a barline, so they can be 
positioned directly before the notehead to which they are attached. You can show grace notes 
before barlines instead; for example, if you have a group of three or more grace notes and want 
to reduce the gap between the barline and the first beat in the bar.

Grace note stem slashes appear at the beginning of grace note beams. If there is a single grace 
note, the slash appears across its stem and flag, if applicable, and extends either side of the 
stem.

Adding accidentals causes their spacing to readjust so that the accidentals are clearly legible, 
similar to normal notes.

Articulations can be added to grace notes wherever they are most clearly legible, which is most 
likely outside the staff. Dorico SE automatically places articulations on the stem-side of grace 
notes, and outside the staff if the stem or beam is within the staff.

Grace notes in multiple-voice contexts

According to accepted notation convention, grace notes appear stem up by default when there is 
only one voice on a staff, even if the notehead to which they are attached is stem down.

However, when there are multiple voices on the staff, all notes in the upper voices appear stem 
up and all notes in the lower voices appear stem down, including grace notes. This also affects 
the curvature direction of slurs.

This adjustment happens automatically in Dorico SE, but you can also change the stem direction 
of grace notes manually.

Slurs relative to grace notes

By default, slurs starting on grace notes and ending on tie chains end on the first note of the 
tie chain. You can change the position of individual slurs relative to tie chains, including those 
starting from grace notes.

TIP

You can change the note spacing scale factor for grace notes in each layout independently on the 
Note Spacing page in Layout Options.

Grace notes
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RELATED LINKS
Showing grace notes before/after barlines on page 806
Slur placement relative to grace notes on page 1017
Slur position relative to tie chains on page 1017
Changing the stem direction of notes on page 856
Layout Options dialog on page 622

Turning existing notes into grace notes
You can turn any existing notes into grace notes; for example, if you want to edit music you input 
using MIDI recording.

PROCEDURE

1. In Write mode, select the notes that you want to turn into grace notes.

2. Optional: Change the grace note type to slashed/unslashed in any of the following ways:

● Press Alt/Opt-/ .

● In the Notes toolbox, click and hold Grace Notes , then click Unslashed Grace Notes 
 or Slashed Grace Notes .

3. Do one of the following:

● Press / .

● In the Notes toolbox, click Grace Notes .

RESULT
The selected notes are turned into grace notes with the same notated duration. However, any 
rhythm dots are removed.

By default, slashed grace notes attach to the rhythmic position following the last selected note in 
each range, while unslashed grace notes attach to the rhythmic position of the first selected note 
in each range.

TIP

You can change the default direction when turning existing notes into grace notes in 
Preferences > Note Input and Editing > Editing.

AFTER COMPLETING THIS TASK
You can change the duration of grace notes.

RELATED LINKS
Notes toolbox on page 173
Inputting grace notes on page 225
Changing the duration of notes on page 236
Changing the type of grace notes on page 807
Turning existing notes into tuplets on page 1106
Preferences dialog on page 53

Grace notes
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Turning grace notes into normal notes
You can turn any existing grace notes into normal notes starting from their original rhythmic 
position; for example, if you want to turn a run of grace notes at the start of a flow into standard 
notes in a pick-up bar.

PROCEDURE

1. In Write mode, select the grace notes you want to turn into normal notes.

2. Optional: If you want the selected grace notes to push subsequent notes to later rhythmic 
positions if required, press I  to activate Insert mode.

3. Optional: If you activated Insert mode, choose the appropriate Insert mode scope.

4. Do one of the following:

● Press / .

● In the Notes toolbox, click Grace Notes .

RESULT
The selected grace notes are turned into normal notes with the same notated duration. For 
example, an eighth grace note becomes a standard eighth note.

If Insert mode was activated, subsequent existing notes are pushed to later rhythmic positions to 
accommodate the extra rhythmic durations if required. If Insert mode was deactivated, the grace 
notes expand and overwrite subsequent notes.

RELATED LINKS
Turning tuplets into normal notes on page 1106
Pick-up bars on page 1088
Insert mode on page 408
Insert mode scopes on page 409

Showing grace notes before/after barlines
By default, grace notes are positioned after barlines and directly before the notehead to which 
they apply, including for the first note in a bar. You can position individual grace notes before 
barlines; for example, so the first normal note in the bar is not pushed too far from the barline, 
or to indicate that grace notes are played before the beat.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the grace notes whose position relative to barlines you want to change.

2. In the Properties panel, activate/deactivate Grace note before barline in the Grace Notes 
group.

RESULT
Grace notes at the selected rhythmic positions are positioned before barlines when the property 
is activated, and after barlines when the property is deactivated.

Grace notes
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NOTE

This affects all grace notes at the selected rhythmic positions.

RELATED LINKS
Barlines on page 672
Inputting grace notes on page 225

Grace note size
Grace notes are smaller versions of normal notes, and are scaled down by a ratio that is set by 
default to 3/5 of a normal note.

You can change the size of grace notes individually in the same way as for normal notes.

RELATED LINKS
Changing the size of notes/items on page 399

Grace note slashes
Slashes shown diagonally across grace note stems are often used to distinguish different types 
of grace notes. Grace notes with slashed stems are known as acciaccaturas and are often played 
very fast. Grace notes without slashed stems are known as appoggiaturas and are often played 
slower than acciaccaturas.

In Dorico SE, grace notes appear with slashed stems by default. You can change whether grace 
notes are slashed or unslashed during note input as well as by changing the type of existing 
grace notes.

Changing the type of grace notes
You can change the type of individual grace notes after they have been input. Grace notes have 
slashed stems by default, but you can change them to have unslashed stems.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the grace notes whose type you want to change.

2. In the Properties panel, choose one of the following options for Grace note type in the 
Grace Notes group:

● Slashed stem 

● Unslashed stem 

RESULT
The selected grace notes are shown with slashed/unslashed stems.
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TIP

You can also change the type of selected grace notes by pressing Alt/Opt-/  or clicking and 
holding Grace Notes  in the Notes toolbox, then clicking Unslashed Grace Notes  or 
Slashed Grace Notes .

Grace note stems
Grace notes are scaled-down notes, so the length of grace note stems is determined by the 
default settings for the stem length of all notes.

Following accepted conventions, grace notes in Dorico SE are stem up by default in any clef, 
regardless of the stem direction of the note to which they apply. The stem directions of grace 
notes are changed automatically when there are multiple voices on a staff, but you can change 
the stem direction of individual grace notes manually. You can also lengthen/shorten grace note 
stems in the same ways as for normal stems.

RELATED LINKS
Stems on page 854
Changing the stem direction of notes on page 856

Grace note beams
Dorico SE automatically beams multiple adjacent grace notes together if they are an eighth note 
(quaver) or shorter in duration.

Like all beams, grace note beams ideally follow the accepted standards for beam placement 
relative to staff lines, in order to avoid wedges. However, because grace notes are smaller than 
normal notes, this can lead to extreme slants in grace note beams.

You can adjust the slants of individual grace note beams in the same ways as for normal beams.

RELATED LINKS
Beaming on page 689

Grace notes in playback
Slashed and unslashed grace notes are handled differently in playback.

Slashed grace notes of any note duration, and unslashed grace notes a 16th note or shorter, play 
back before the beat with a single default sounding duration.

Unslashed grace notes an eighth note or longer play back on the beat. Their sounding duration 
is half the note duration of the note to which they are attached. For example, if an unslashed 
eighth note grace note is attached to a quarter note, both notes play back as if they were eighth 
notes.

RELATED LINKS
Inputting grace notes on page 225
Grace note slashes on page 807
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Holds and pauses

Different notations are used to show where the established rhythmic flow of the music is 
interrupted, either with a moment of repose or a short silence, before continuing. The most 
subtle effect is produced by a tenuto mark, with more significant effects denoted with holds and 
pauses.

The duration of the break in the music intended by the hold or pause does not need to be 
specified. This leaves significant room for interpretation, even though the different styles of 
holds and pauses normally indicate larger or smaller breaks.

In Dorico SE, there are the following types of holds and pauses:

Fermatas
Fermatas indicate that a note is held for longer than its notated length, which applies 
to the whole ensemble. In Dorico SE, fermatas exist globally at the corresponding 
rhythmic positions, meaning they are automatically shown on all staves and voices.

They are also known as “pauses” and informally sometimes called “birds’ eyes”.

Breath marks
Breath marks show suitable places for players to breathe, or suggest how the music is 
phrased to create a similar effect.

Caesuras
Caesuras indicate that a note is sustained for its full value and is followed by a break 
in sound before continuing. In Dorico SE, caesuras exist globally at the corresponding 
rhythmic positions, meaning they are automatically shown on all staves.
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NOTE

Holds and pauses do not currently have an effect in playback, but this is planned for future 
versions.

RELATED LINKS
Input methods for holds and pauses on page 306
Types of fermatas on page 810
Types of breath marks on page 811
Types of caesuras on page 811

Types of fermatas
There are different types of fermatas available in Dorico SE. Each fermata indicates a suggested 
pause duration whilst leaving room for interpretation.

Fermata Description

Very short fermata Indicates that a note is held only a fraction 
longer than the rhythm indicates.

Short fermata Indicates that a note is held a little bit longer 
than the rhythm indicates.

Short fermata (Henze) Indicates that a note is held a little bit longer 
than the rhythm indicates, as used by Hans 
Werner Henze.

Fermata Indicates that a note is held for longer than the 
rhythm indicates.

Long fermata Indicates that a note is held quite a lot longer 
than the rhythm indicates.

Long fermata (Henze) Indicates that a note is held quite a lot longer 
than the rhythm indicates, as used by Hans 
Werner Henze.

Very long fermata Indicates that a note is held for much longer 
than the rhythm indicates.

Curlew (Britten) Indicates that a note or rest is held until the 
next synchronization point in asynchronous 
music, as used by Benjamin Britten.

Fermatas can be divided into two styles. Because their meanings overlap, it can be confusing for 
players if both styles are used in a single project.

Holds and pauses
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Style Very short 
fermata

Short 
fermata

Fermata Long fermata Very long 
fermata

Standard

Henze N/A N/A

RELATED LINKS
Input methods for holds and pauses on page 306
Changing existing items on page 398

Types of breath marks
There are different types of breath marks available in Dorico SE. Breath marks indicate a suitable 
place for a player to take a breath, or create a musical effect like a breath.

Comma-like Tick-like Upbow-like Salzedo

Types of caesuras
There are different types of caesuras available in Dorico SE. All caesuras indicate a break in 
sound, but different types are often needed for different styles of musical scores.

Caesura Thick caesura Short caesura Curved caesura Single-stroke 
caesura

Two diagonal 
slashes

Two thick diagonal 
slashes

Two straight, 
vertical slashes

Two curved 
diagonal slashes

One straight, 
vertical slash

If you intend to communicate a specific length of hold or gap with each type of caesura, we 
recommend that you consider adding a legend, as different players may interpret these symbols 
differently.

RELATED LINKS
Input methods for holds and pauses on page 306
Changing existing items on page 398

Positions of holds and pauses
Holds and pauses are placed above the staff by default in single-voice contexts, and are shown 
on all staves at the closest rhythmic position available; for example, if a single staff has a fermata 
on the last beat in the bar, it is shown above the bar rests on the other empty staves. For staves 
with multiple voices, fermatas are also shown inverted below the staff.

Holds and pauses
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You can move holds and pauses to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

Fermatas

Fermatas are positioned horizontally so that they are centered on front noteheads in the first 
voice column, regardless of the stem direction of notes.

Fermatas affect the overall tempo of the piece, so all players must be able to see where 
they occur. Therefore, fermatas are shown on all staves at the same rhythmic position, or the 
rhythmic position of the note, chord, or rest that corresponds with the end of the fermata, 
including over a bar rest if a staff has no notes in that bar.

Breath marks

Breath marks are placed above the top line of the staff by default, at the end of the note to which 
they apply; that is, they appear just before the following note.

Breath marks apply only to the staff to which they were added, as they do not affect the overall 
tempo, but instead only indicate to a single player or group of players a suitable place to break 
their line in order to breathe.

Caesuras

Caesuras are positioned at the top of the staff, with the top staff line passing through the 
middle of the caesura and the bottom of the caesura resting on the second staff line. They are 
commonly placed at the end of a bar, before the barline.

Caesuras are automatically added to all staves at the same rhythmic position, immediately to the 
left of the notehead or barline to which they were input. They are not linked to noteheads, and 
adjust note spacing to create a clear gap.

RELATED LINKS
Input methods for holds and pauses on page 306
Moving notes/items rhythmically on page 417

Holds and pauses
Positions of holds and pauses 
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Multiple holds and pauses at the same rhythmic position
Because fermatas apply to all staves, only one type of fermata can exist at the same rhythmic 
position. For example, you cannot have a short fermata on one staff and a long fermata at the 
same rhythmic position on another staff.

A Britten curlew can be used at the same rhythmic position as another kind of fermata, but it 
cannot exist simultaneously with any breath mark. This is the only exception in Dorico SE.

Caesuras can co-exist with any type of breath mark, but you cannot have a caesura and a fermata 
at the same rhythmic position.

RELATED LINKS
Input methods for holds and pauses on page 306
Moving notes/items rhythmically on page 417
Rhythmic position on page 22

Changes to fermatas on single staves
Changing the type of fermata or caesura on one staff automatically changes the type on all 
staves at that rhythmic position, as a pause at one particular rhythmic position can only be of 
one duration.

However, if you override a particular fermata on one staff, for example, by changing it to a 
Britten curlew or a breath mark, changing the existing fermata on another staff does not change 
the marking on the overridden staff. Deleting the marking on the overridden staff reverts that 
marking to match the fermata on the other staves.

For example, changing a fermata to a breath mark changes the marking for only that staff. That 
note is not affected when the type of fermata on the other staves at that rhythmic position is 
changed.

The bottom staff is overridden to 
show a breath mark instead of a 
fermata.

The fermata is changed to a 
very short fermata, but the 
bottom staff is exempt as it was 
overridden to show a breath mark.

Deleting the breath mark from the 
bottom staff returns it to showing 
the fermata currently chosen for 
that rhythmic position.

Changing the number of fermatas per staff
You can change the maximum number of fermatas that appear on each staff at individual 
positions when there are multiple voices on a staff.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Holds and pauses
Positions of holds and pauses 
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PROCEDURE

1. Select the fermatas whose maximum number per staff you want to change.

2. In the Properties panel, activate Max. fermatas per staff in the Holds and Pauses group.

3. Select one of the following options from the menu:

● One per voice

● One per each side of staff

● One per staff

RESULT
The number of fermatas shown at the selected positions is changed.

Positioning fermatas on barlines
You can position individual fermatas over a barline instead of over a note to indicate a gap 
before the start of the following bar.

NOTE

Fermatas cannot be positioned on barlines if Max. fermatas per staff is also activated.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the fermatas you want to position over barlines.

2. In the Properties panel, activate Attach to barline in the Holds and Pauses group.

RESULT
The selected fermatas are positioned above the barline at the end of the bars they were in 
originally, appearing only above staves that are not joined by the barline. Depending on the 
instrumentation, this may mean they only appear at the top of the system.

Deactivating Attach to barline returns the selected fermatas to their default positions.

EXAMPLE

Fermata input on last quarter note in the bar Fermata positioned on barline

Holds and pauses
Positions of holds and pauses 
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Key signatures

Key signatures are the markings that show the current key of music by indicating which notes in 
the scale for that key are sharpened or flattened. They are shown at the start of each system on 
every applicable staff.

Traditionally, accidentals are organized following the pattern of the circle of fifths, which is 
different for sharp keys and flat keys.

Using key signatures saves space, as by indicating which notes are generally going to be sharp or 
flat in the music in one group at the start of each system, these notes do not need an accidental 
beside them every time they occur.

Once you have input a key signature, all notes you subsequently input follow the key signature; 
for example, if you input an F  after inputting a G major key signature, an F♯ is input 
automatically.

Key signatures that do not show accidentals, such as A minor or open key signatures, are 
indicated by signposts.

Instruments that do not usually have key signatures, such as timpani or horn, have a No key sig 
version in Dorico SE which never show key signatures. You can select the appropriate instrument 
type from the instrument picker when adding or changing instruments.

Flows without any key signatures are treated as if there were an open/atonal key signature 
rather than A minor or C major.

By default, key signatures apply to all staves. However, there are certain situations, such as in 
polytonal music, where some parts require their own key signature, independently of the rest of 
the ensemble. You can input key signatures that apply to all staves or only apply to single staves 
in Dorico SE.

In Dorico SE, key signatures exist within the overarching tonality system for your project. The 
only tonality system that comes as standard in Dorico SE is 12-EDO.

NOTE

● You cannot hide key signatures as they provide crucial information about the pitch of notes. 
If you do not want to see a key signature, you can input an open key signature or delete all 
key signatures from the flow or project.

● You do not have to input multiple simultaneous key signatures if you have transposing 
instruments in your score. Dorico SE handles instrument transpositions automatically.

RELATED LINKS
Input methods for key signatures on page 253
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Types of key signatures on page 817
Tonality systems on page 820
Instrument picker on page 96
Note input on page 196
Deleting notes/items on page 412
Transposing instruments on page 119
Concert vs. transposed pitch on page 155

Key signature arrangements
Dorico SE automatically follows conventions for the placement and appearance of key signatures, 
such as showing accidentals in the accepted circle of fifths order and positioning key signatures 
between clefs and time signatures.

The order in which accidentals are shown in key signatures is different for sharp keys and flat 
keys.

● For sharps: F♯, C♯, G♯, D♯, A♯, E♯, B♯
● For flats: B♭, E♭, A♭, D♭, G♭, C♭, F♭
Accidentals are arranged automatically in these orders in Dorico SE for all standard Western key 
signatures. There is an accepted pattern for the placement of accidentals in a key signature, so 
that they fit inside the staff according to the current clef. The pattern of accidentals is the same 
in all clefs, apart from the tenor clef, which requires sharp key signatures to follow a different, 
ascending pattern to ensure the accidentals fit on the staff.

Clef Arrangement of sharps Arrangement of flats

Treble

Bass

Alto

Tenor

RELATED LINKS
Positions of key signatures on page 818

Key signatures
Key signature arrangements 
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Types of key signatures
There are multiple types of key signatures in Dorico SE, which can all be input, moved, and 
deleted in the same ways.

Major and minor key signatures

The key signature for a major key appears the same as the key signature for its relative minor, 
and vice versa. For example, B♭ major has two flats in its key signature. This is the same number 
of flats as for G minor, which is the relative minor key to B♭ major. The difference is that music 
in G minor usually has sharpened Fs, as the seventh degree of the scale is raised in minor keys. 
Therefore, if you input an F♯/G♭ after a G minor key signature, Dorico SE prefers to spell it as F♯ in 
most cases, in order to follow the convention of harmonic minor keys.

A B flat major scale following a B flat major key 
signature

A G minor scale following a G minor key signature

Open key signature

Although open, or atonal, key signatures appear the same as C major or A minor key signatures 
because none shows any accidentals, open key signatures behave differently.

In an open key signature, the spelling of accidentals is based on the current direction of the 
music. If the music is rising, sharps are preferred, whereas if the music is falling, flats are 
preferred. There is no hierarchy of pitches in an open key signature, so the same pitch might be 
spelled differently each time it appears depending on its context, even within a few bars.

In a C major or A minor key signature, accidentals are spelled based on the context of the major 
or minor tonality implied. For example, in C major, sharps in general are preferred, whether the 
music is going up or going down. Similarly, in A minor, G♯ in particular is preferred, whether the 
music is going up or going down, as G♯ is the leading note in A minor.

No key signature

Some instruments are accustomed to seeing no key signatures in their parts, no matter the 
overall key of the piece. These instruments include timpani, percussion, horn, trumpet, and 
sometimes the harp. If you have added the No key sig version of these instruments, then no 
key signature is shown in their parts, even if they are a transposing instrument, such as horn or 
trumpet.

Any pitch can be input into these instruments, and they show accidentals if needed.

RELATED LINKS
Input methods for key signatures on page 253
Instrument picker on page 96
Adding instruments to players on page 120

Key signatures
Types of key signatures 
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Positions of key signatures
Key signatures are positioned between clefs and time signatures by default, and are shown 
on every staff that requires a key signature. They are not shown on staves for unpitched 
instruments.

Key signatures are shown at the start of a piece and at the start of subsequent movements, 
even if the music carries straight on and in the same key. Unlike time signatures, key signatures 
appear at the start of every system, even if the key signature has not changed. They apply until 
the end of the flow or until the next key signature change, whichever comes first.

The correct position for key signatures is between clefs and time signatures.

If a key signature change occurs during a piece or movement, it should be placed immediately 
after a barline. It is customary to have a double barline where a key signature change takes 
place, which is the default setting in Dorico SE.

Examples of key signatures positioned after double barlines

You can move key signatures to new rhythmic positions in Write mode. They are automatically 
positioned correctly.

RELATED LINKS
Cautionary key signatures on page 818
Key signature arrangements on page 816
Moving notes/items rhythmically on page 417

Cautionary key signatures
When a key signature change occurs at a system break, either in the score or in a part, the new 
key signature is shown at the end of the first system as well as at the start of the new system.

This is sometimes considered a “cautionary key signature”, as players become used to seeing the 
key signature at the start of the system and therefore may miss a change of key signature if it is 
not conspicuously shown at the end of systems.

In Dorico SE, the key signatures shown at the end of one system and at the start of the next 
system are the same item, not separate items. You cannot hide cautionary key signatures.

If the music is separate enough that you do not want to see a key signature at the end of a 
system and you cannot change where the system break occurs, you can separate the music by 
creating a new flow at the point of the system break.

RELATED LINKS
Flows on page 148
Splitting flows on page 432
System breaks on page 537
Cautionary time signatures on page 1087
Clefs on page 738

Key signatures
Positions of key signatures 
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Enharmonic equivalent key signatures
Enharmonic equivalent key signatures are keys with different names that include the same 
pitches, such as C♯ major and D♭ major. Dorico SE follows the convention for transposing to keys 
with the same type of accidental as the previous key, except where the enharmonic equivalent 
key signature has fewer accidentals.

When transposing selections of notes, Dorico SE prefers keys with the same type of accidental as 
the previous key signature. When choosing key signatures for transposing instruments, Dorico 
SE prefers key signatures with the same type of accidental as the current concert pitch key.

However, there are some instances where you might prefer to transpose to a key with a different 
type of accidental as it has fewer accidentals than the enharmonic equivalent key. For example, 
C♯ major has seven sharps, whereas the enharmonic equivalent key of D♭ major only has five 
flats. This means the player has to remember the accidentals for fewer notes.

Transposing to an enharmonic equivalent key with fewer accidentals can have the added benefit 
of improving readability by avoiding double sharps or double flats. For example, transposing 
music from F♯ to G♯ requires the leading note to be spelled as an F, but transposing to A♭ instead 
means the leading note is G♮.

G♯ major requires a double sharp leading note A♭ major, the enharmonic equivalent to G♯, does not 
require a double sharp leading note

By default, Dorico SE selects an enharmonic equivalent key signature if it has fewer accidentals.

How key signatures affect transposing instruments

If there is a key signature in the full score, it is transposed for a transposing instrument by the 
same degree as the transposing interval for the instrument. For example, in a project in E major, 
a B♭ clarinet part has a key of F♯ major, as a B♭ clarinet sounds a whole step (tone) below its 
notated pitch.

Instruments that do not show a key signature

Some instruments are accustomed to seeing no key signatures in their parts, no matter the 
overall key of the piece. These instruments include timpani, percussion, horn, trumpet, and 
sometimes the harp. If you have input the No key sig version of these instruments, then no 
key signature is shown in their parts, even if they are a transposing instrument, such as horn or 
trumpet.

You can still transpose music in the staves of these instruments, but they show accidentals as 
necessary, instead of showing a key signature.

RELATED LINKS
Transpose dialog on page 425
Transposing selections on page 424
Respelling notes on page 428
Adding instruments to players on page 120
Concert vs. transposed pitch on page 155
Transposing instruments on page 119

Key signatures
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Tonality systems

The term “tonality system” is used in Dorico SE to encompass three crucial elements that 
together make up the concept of tonality.

The three elements that make up tonality systems are:

● A number of equal divisions of the octave, or EDO. For example, standard Western scales 
with half-step (semitone) steps have 12-EDO.

● A set of accidentals. This allows you to notate how much a note is raised or lowered.

● A key signature. In Dorico SE, you can use any traditional Western key signature.

Dorico SE provides the following tonality systems in each project by default:

● Equal temperament (12-EDO): Contains twelve half-step (semitone) steps

● Equal temperament (24-EDO, Gould arrows): Contains 24 quarter tone steps and uses 
Gould arrow quarter tone accidentals

● Equal temperament (24-EDO, Stein-Zimmermann): Contains 24 quarter tone steps and 
uses Stein-Zimmermann quarter tone accidentals

You can find existing tonality systems in your project in the Tonality System section of the Key 
Signatures, Tonality Systems, and Accidentals panel.

RELATED LINKS
Key Signatures, Tonality Systems, and Accidentals panel on page 254

Equal Division of the Octave (EDO)
EDO stands for Equal Division of the Octave: the number of equal pieces, or intervals, into which 
an octave is divided.

Traditional Western harmony is based on equal temperament, another method used to describe 
tonality systems, or 12-EDO, as the traditional scale from C-C is made up of twelve steps spread 
across the seven notes in the scale.

For example, between the notes A and B there are two steps, but between B and C there is one 
step. This is because in 12-EDO, each step represents a half-step (semitone), and there are two 
half-steps between A and B according to standard equal temperament, but only one half-step 
between B and C.

Other tonality systems can have different equal divisions of the octave; for example, in 24-EDO 
each octave division is a quarter tone. However, the only tonality system in Dorico SE is 12-EDO.
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Lyrics

In Dorico SE, the term “lyrics” is used for all text that is sung by singers.

Lyrics for a soprano duet with basso continuo accompaniment

Lyrics are organized into lyric lines to ensure consistent horizontal alignment and to make 
showing verse numbers simple and accurate. There are different types of lyric lines for lyrics 
with different purposes, and the appearance of lyrics changes depending on their line type. For 
example, lyrics in chorus and translation lines are shown in an italic font by default.

In Dorico SE, lyrics were designed so that it is simple to make changes to existing lyrics without 
having to re-input new lyrics each time. For example, you can change the syllable type of lyrics so 
that they are either followed or not followed by a hyphen.

When inputting lyrics, you can use key commands to switch between lyric lines, to change on 
which side of the staff lyrics are input, and to switch the lyric style between normal lyrics, chorus 
lyrics, and translation lyrics. You can also change the type of lyrics after they have been input.

You can input multiple lines of lyrics, chorus lyrics, and translations, both above or below staves. 
You can filter existing lyrics according to their type and lyric line.

RELATED LINKS
Inputting lyrics on page 360
Positions of lyrics on page 827
Lyric line numbers on page 835
Filters for lyrics on page 826
Lyric hyphens and lyric extender lines on page 835
Exporting lyrics on page 826

Types of lyrics
Lyrics are divided into different lyric types in Dorico SE.

Lyric lines
Lyric lines contain normal lyrics and can be shown with verse numbers. They can be 
both below and above the staff.
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Chorus lines
Chorus lines contain lyrics in an italic font and are placed between lyric lines. For 
example, if there are two lyric lines, the chorus line appears between Line 1 and Line 2.

Chorus lines do not have verse numbers.

Lyric line translations
Lyric line translations show the text in lyric lines or chorus lines in different languages. 
They are placed directly below the lyric line or chorus line of which they are a 
translation. They are shown in an italic font.

Each lyric line can have its own lyric line translation, including chorus lines.

Lyric line translations do not have verse numbers, as they are part of the line of which 
they are a translation.

You can input all types of lyrics using the lyrics popover. The icon shown on the left-hand side of 
the popover indicates the type of lyric currently being input.

RELATED LINKS
Lyric line numbers on page 835
Inputting lyrics on page 360
Lyrics popover on page 361

Changing the type of individual lyrics
You can change the type of individual lyrics after they have been input. For example, you can 
change lyrics into chorus lyrics or translation lyrics.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the individual lyrics whose type you want to change.

2. In the Properties panel, activate/deactivate the following properties, individually or together, 
in the Lyrics group:

● Chorus

● Is translation

RESULT

● Activating Chorus changes the selected individual lyrics to chorus lyrics.

● Activating Is translation changes the selected lyrics to translation lyrics of the same lyric line 
number. For example, selecting lyrics in Line 2 and activating Is translation turns them into 
translation lyrics for Line 2.

● Activating both properties changes the selected lyrics to translation lyrics of the chorus.

● Deactivating both properties changes the selected lyrics to normal lyrics. Their line number 
is indicated by the number in Line number in the Lyrics group of the Properties panel.

Lyrics
Types of lyrics 
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NOTE

If other chorus lines exist at the same position on the side of the staff where you want to change 
your current selection to chorus lines, the two lines collide. To avoid this, change the type of the 
whole lyric line, which automatically avoids collisions.

RELATED LINKS
Showing lyrics in italics on page 833

Types of syllables in lyrics
There are different types of syllables in lyrics, depending on their position in words. The key you 
press to advance the popover indicates the syllable type for each lyric.

Dorico SE defines lyrics as different syllables depending on how you advance the popover when 
inputting lyrics.

Whole word
Lyrics are considered a whole word if the lyric comes after a gap and is followed by a 
gap or a period.

No hyphens are shown either side of whole word lyrics. Extender lines can be shown 
after lyrics.

Start
Lyrics are considered the start syllable in a multi-syllabic word if the lyric comes after a 
gap, but is followed by a hyphen.

Hyphens are shown after start lyrics, which can be continuation hyphens depending on 
the distance before the next lyric in the same lyric line.

Middle
Lyrics are considered the middle syllable in a multi-syllabic word if the lyric comes after 
a hyphen, and is followed by a hyphen.

Hyphens are shown after middle lyrics, which can be continuation hyphens depending 
on the distance before the next lyric in the same lyric line.

End
Lyrics are considered the end syllable in a multi-syllabic word if the lyric comes after a 
hyphen but is followed by a gap or a period.

Extender lines can be shown after end lyrics.

RELATED LINKS
Inputting lyrics on page 360
Lyric hyphens and lyric extender lines on page 835
Positions of lyrics on page 827
Changing the alignment of lyrics relative to notes on page 828

Changing the syllable type of existing lyrics
You can change the syllable type of lyrics after they have been input.

For example, if you advanced the lyrics popover to the next note by pressing Space  but you later 
want it to be followed by a hyphen, you can change its syllable type.

Lyrics
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NOTE

Changing the syllable type changes whether a hyphen is shown after the selected lyrics, not 
before them. Therefore, if you want to show a hyphen before lyrics, you must change the syllable 
type of the lyrics immediately preceding them.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the lyrics whose syllable type you want to change.

2. In the Properties panel, select one of the following options from the Syllable type menu in 
the Lyrics group:

● Whole word

● Start

● Middle

● End

RESULT
Lyrics with a syllable type of Whole word or End are followed by a space.

Lyrics with a syllable type of Start or Middle are followed by a hyphen.

Copying and pasting lyrics
You can copy and paste lyrics from both existing lyric lines in Dorico SE and from external text 
editors; for example, if you want to copy a lyric line to a player who has different rhythms to the 
source but uses the same lyrics.

When copying text from outside Dorico SE, you must format the text so it is suitably separated 
into syllables; for example, by adding hyphens in multi-syllabic words. This ensures Dorico SE 
can correctly identify the characters required for each word/syllable and therefore format the 
resulting lyrics appropriately. There are automatic hyphenation tools that you can use, but 
results from these are not always reliable. Dorico SE checks text you have copied to your 
clipboard to make sure it contains only single spaces and single hyphens for correct syllable 
input.

NOTE

You cannot currently copy and paste lyrics containing Chinese, Japanese, or Korean characters. 
This is planned for future versions.

PROCEDURE

1. Select the lyrics/text you want to copy. You can do this within Dorico SE or externally.

NOTE

● If you are copying existing lyrics/text in Dorico SE, you must be in Write mode.

Lyrics
Copying and pasting lyrics 
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● If you want to select many existing lyrics in Dorico SE, you can use filters for lyric lines or 
you can select a single lyric and press Ctrl/Cmd-Shift-A  multiple times to select the rest 
of the lyrics in the lyric line.

2. Press Ctrl/Cmd-C  to copy the selected lyrics/text.

3. In Write mode, select the first note in the voice to which you want to copy lyrics.

4. Open the lyrics popover in any of the following ways:

● Press Shift-L .

● In the Notations toolbox, click Popovers , then Lyrics .

5. Optional: Change the lyric type into which you will paste lyrics in one of the following ways:

● To change the lyric line number, press Down Arrow .

● To change to a lyric line above the staff, press Shift - Up Arrow .

● To change to a chorus line, press Up Arrow .

● To change to a translation lyric line, press Alt/Opt - Down Arrow .

6. Press Ctrl/Cmd-V  to paste the first word/syllable of the copied lyrics/text.

The lyrics popover automatically advances to the next note in the selected voice according 
to the source text. For example, for syllables followed by hyphens in the source, the popover 
advances as if you had pressed -  (hyphen), which automatically shows hyphens after those 
syllables.

7. Optional: For words/syllables that you want to apply to two or more notes, you must advance 
the popover manually in one of the following ways:

● After complete words or the final syllable in multi-syllabic words, press Space .

● After syllables that are not the final syllable in multi-syllabic words, press -  (hyphen).

● After syllables that you do not want to be followed by an extension line or hyphen, press 
Right Arrow .

8. Continue pressing Ctrl/Cmd-V  for each word/syllable you want to paste.

RESULT
The selected lyrics/text is pasted into the selected lyric line belonging to the voice in which you 
selected a note.

NOTE

Words/syllables are removed from your clipboard as you paste them. If you want to paste the 
same lyrics/text into another lyric line or staff, you must copy the source again.

RELATED LINKS
Edit Lyrics dialog on page 832
Lyric line numbers on page 835
Large selections on page 389
Inputting lyrics on page 360
Lyrics popover on page 361
Copying and pasting notes/items on page 414
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Exporting lyrics
You can export all lyrics from all flows in the project to a plain text file; for example, if you want to 
create a libretto of all the text sung in a project.

PROCEDURE

1. Choose File > Export > Lyrics to open the File Explorer/macOS Finder.

2. Specify a name and location for the text file.

3. Click Save.

RESULT
All lyrics from all flows in the project are exported to a plain text file, which opens automatically 
in your default text editor.

Dorico SE automatically removes hyphens between syllables, and adds contextual information 
for lyrics, such as their line number and the instrument to which they belong.

RELATED LINKS
File import and export on page 73
Lyric hyphens and lyric extender lines on page 835
Types of lyrics on page 821
Positions of lyrics on page 827
Exporting comments on page 437

Filters for lyrics
In Dorico SE, lyrics filters allow you to select all lyrics of a specified type across your project or 
across a specific selection.

The following lyrics filters are available:

All Lyrics
Selects all types of lyrics in the current selection, with any lyric line number and 
placement above/below the staff.

Line 1
Selects only Line 1 lyrics and translation lyrics for Line 1 in the current selection, 
including Line 1 below the staff and Line 1 above the staff.

Line 2
Selects only Line 2 lyrics and translation lyrics for Line 2 in the current selection, 
including Line 2 below the staff and Line 2 above the staff.

Line 3
Selects only Line 3 lyrics and translation lyrics for Line 3 in the current selection, 
including Line 3 below the staff and Line 3 above the staff.

Line 4
Selects only Line 4 lyrics and translation lyrics for Line 4 in the current selection, 
including Line 4 below the staff and Line 4 above the staff.

Line 5
Selects only Line 5 lyrics and translation lyrics for Line 5 in the current selection, 
including Line 5 below the staff and Line 5 above the staff.

Lyrics
Exporting lyrics 
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Above Staff
Selects all lyrics above the staff in the current selection. You can use this filter in 
addition to the other filters. For example, you can filter first by line number, and then 
filter again by staff-relative placement.

Below Staff
Selects all lyrics below the staff in the current selection. You can use this filter in 
addition to the other filters. For example, you can filter first by line number, and then 
filter again by staff-relative placement.

Chorus
Selects all chorus lyrics in the current selection.

Translations
Selects all translation lyrics in the current selection.

RELATED LINKS
Filters on page 393
Changing filters to select/deselect on page 394
Large selections on page 389

Selecting lyrics using filters
You can use lyric filters to select all lyrics of a specified type across your project or across a 
specific selection.

PREREQUISITE
You filter setting is set to Select Only.

PROCEDURE

1. In the music area, make a selection that includes all the lyrics you want to select.

For example, press Ctrl/Cmd-A  to select the whole flow.

2. Choose Edit > Filter > Lyrics > [Lyrics type].

RESULT
All lyrics of the selected type in your selection are selected. For example, if you choose Edit > 
Filter > Lyrics > Chorus, all chorus lyrics in your selection are selected.

Positions of lyrics
Dorico SE automatically positions lyrics and makes adjustments to accommodate variations in 
the length of lyrics, including adjusting the horizontal alignment of lyrics in melismatic music.

You can move lyrics to different rhythmic positions in Write mode.

Positions of syllables

Lyrics typically coincide with notes. The number of notes sung on syllables or words determines 
the alignment of lyrics relative to notes:

● Single syllables, which are whole words or parts of longer words that are sung on only one 
note, are centered on their corresponding note.

Lyrics
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● Melismata, which are syllables or words that are sung on more than one note, are left-
aligned with the left side of the first note to which they apply.

The horizontal spacing of lyrics must be wide enough so that words or syllables do not overlap 
with the words or syllables on either side. For this reason, note spacing must sometimes be 
adjusted to accommodate lyrics.

To reduce how severely the note spacing is changed to accommodate lyrics, which can distort 
the appearance of rhythms, Dorico SE allows the alignment of some lyrics to be adjusted relative 
to their corresponding notes. For example, if a long, single-syllable word on a long note follows 
another long, single-syllable word on a short note, the second word is moved a little to the right 
to give both words enough space.

In this musical phrase, the lyric "breeze" has been moved to the right to accommodate the lyric "spring" on 
the previous note.

NOTE

You can prevent Dorico SE from considering lyrics in note spacing calculations using the Make 
space for lyrics option on the Note Spacing page in Layout Options; however, we recommend 
using this option with caution.

Placement of lyric lines

Lyrics are generally placed below the staff to which they apply and relative to other lyric lines 
according to their line number. For example, lyrics in Line 1 are placed at the top, including when 
there are multiple lyric lines above the staff.

If a line of lyrics is missing across the width of a whole system, no additional gap is left between 
the remaining lines of lyrics.

EXAMPLE
You have three lines of lyrics, but one system does not have a second line of lyrics. On this 
system, the third line of lyrics is moved upwards, closer to the first line of lyrics.

If a subsequent system does not have a first line, but does have the second and third lines, then 
the second and third lines of lyrics are moved upwards. The second line of lyrics takes the place 
of the first line.

RELATED LINKS
Moving notes/items rhythmically on page 417
Changing the line number and type of lyric lines on page 836
Changing the staff-relative placement of lyric lines on page 830
Layout Options dialog on page 622
Per-layout note spacing options on page 533

Changing the alignment of lyrics relative to notes
You can change the horizontal alignment of individual lyrics relative to notes; for example, if you 
want to force lyrics at the same position on multiple staves with different default alignments to 
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have the same alignment. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

There is no default setting for the alignment of lyrics relative to notes, as Dorico SE automatically 
adjusts the horizontal position of lyrics to minimize note spacing changes. By default, lyrics on 
single noteheads are center-aligned, and lyrics spanning multiple noteheads are left-aligned.

NOTE

Changing the alignment of lyrics manually overrides Dorico SE’s automatic spacing for the 
selected lyrics, meaning that note spacing at the affected rhythmic positions might change.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics whose alignment you want to change.

2. In the Properties panel, activate Lyric text alignment in the Lyrics group.

3. Select one of the following alignment options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the selected lyrics is changed. Note spacing is automatically adjusted to avoid 
collisions with adjacent lyrics.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

EXAMPLE

Left-aligned lyric "l’aube" Center-aligned lyric "l’aube" Right-aligned lyric "l’aube"

RELATED LINKS
Types of syllables in lyrics on page 823
Hiding/Showing zones on page 41
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
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Changing the staff-relative placement of lyric lines
You can show whole lyric lines either above or below the staff after they have been input.

PROCEDURE

1. In Write mode, select a lyric in each line whose staff-relative placement you want to change.

TIP

You can also make a selection and use the lyric filters to select different lyric lines according 
to their line numbers and staff-relative placement.

2. Choose one of the following staff-relative placements:

● Choose Edit > Notations > Lyrics > Placement > Above.

● Choose Edit > Notations > Lyrics > Placement > Below.

TIP

You can also choose these options from the context menu.

RESULT
The staff-relative placement of the whole lyric lines in which you selected lyrics is changed.

NOTE

If other lyric lines with the same lyric line number exist at the same position on the side of 
the staff to which you want to change your current selection, the two lines switch sides. For 
example, if there is already a Line 2 above the staff at the position where you want to change the 
placement of Line 2 below the staff, then the existing Line 2 above the staff is placed below the 
staff to accommodate your most recent preference.

RELATED LINKS
Lyric line numbers on page 835
Filters for lyrics on page 826

Changing the staff-relative placement of individual lyrics
You can show individual lyrics either above or below the staff, independently of the staff-relative 
placement of their lyric line. For example, to clarify the lyrics for each part when two voices on 
the same staff have different rhythms.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the lyrics whose staff-relative placement you want to change.

2. In the Properties panel, choose one of the following options for Line placement in the 
Lyrics group:

● Above
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● Below

RESULT
The staff-relative placement of the selected lyrics is changed.

NOTE

If other lyric lines with the same lyric line number already exist at the same position on the same 
side of the staff, the two lines collide. To avoid this, you can change the lyric line number of one 
of the lyric lines, for example.

Lyric text editing
Proofreading lyrics can be challenging, because lyrics are spaced more widely than regular text 
and individual words are often split up over large horizontal distances. In Dorico SE, you can 
change the text and formatting of individual lyrics, including viewing entire lyric lines in a single 
dialog.

Changing the text of existing lyrics
You can change the text of lyrics after they have been input; for example, to correct misspellings.

NOTE

● You can only change one lyric at a time when following these steps. To edit multiple lyrics at 
once, you can use the Edit Lyrics dialog.

● If you want to edit the formatting of individual lyrics, you can use the Edit Lyric dialog. 
However, any edits you have made to the formatting of individual lyrics are removed when 
you change their text using the popover.

PROCEDURE

1. In Write mode, select the lyric whose text you want to change.

2. Press Return  or Shift-L  to open the lyrics popover.

3. Change the existing text in the lyrics popover.

4. Optional: If you want to change other existing lyrics, advance the popover in one of the 
following ways:

● To advance the popover to the next note if you entered a complete word, or the final 
syllable in a multi-syllabic word, press Space .

Existing lyrics are automatically selected in the popover when you press Space .

● To advance the popover to the next note if you entered one syllable of a multi-syllabic 
word, press - .

● To move the cursor one character to the right, press Right Arrow .

● To move the cursor one character to the left, press Left Arrow .

The cursor automatically moves to the next/previous lyric/note if you keep pressing the 
arrow keys.

5. Press Return  or Esc  to close the popover when you have finished changing lyrics.

The popover closes automatically when you reach the last note on the staff.
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Edit Lyrics dialog
The Edit Lyrics dialog allows you to view and edit entire lyric lines in one place and with the 
text displayed with consistent spacing. This is more convenient than changing each word/syllable 
individually alongside the music, where lyrics can be split up over large horizontal distances.

● You can open the Edit Lyrics dialog by selecting at least one lyric and choosing Edit > 
Notations > Lyrics > Edit Line of Lyrics. You can also choose this option from the context 
menu.

The dialog shows all lyrics in the same lyric line as the selected lyric and allows you to edit the 
lyrics, such as fixing misspellings, adding commas, or changing where in a word the hyphen is 
placed. If you selected multiple lyrics to open the dialog, Dorico SE populates the dialog with the 
lyric line of the earliest lyric on the highest staff you selected.

The Edit Lyrics dialog comprises the following:

1 Text editor

Allows you to edit all the lyrics in the selected lyric line in the current flow, with hyphens and 
spaces as appropriate. For example, you can add a comma after the final syllable in a line for 
a poem setting or replace a hyphen with a space.

NOTE

You cannot add, delete, or change the duration/rhythmic position of lyrics, such as the 
number of notes to which each lyric applies.

2 Zoom controls

Allow you to increase/decrease the size of text in the dialog.

3 Current number of lyrics

Displays the number of lyrics currently shown in the text editor and the target number of 
lyrics in the lyric line. The target number is the number of lyrics that already exists in the 
selected lyric line in the flow.

The current number of lyrics updates automatically as you work in the dialog. Dorico SE 
requires the current number and target number of lyrics to match before you can confirm 
the dialog.

4 OK button

Allows you to confirm your changes and close the dialog. You can only confirm the dialog 
when the current number and target number of lyrics match.
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Edit Lyric dialog
The Edit Lyric dialog allows you to edit the formatting of individual lyrics, such as making single 
characters underlined.

● You can open the Edit Lyric dialog by selecting a lyric and choosing Edit > Notations > 
Lyrics > Edit Single Lyric. You can also choose this option from the context menu.

The Edit Lyric dialog comprises the following:

1 Text editor options

Allows you to customize the font, size, and formatting of the selected part of the lyric.

2 Text editing area

Shows the current text for the lyric. You can select any part of the lyric and edit 
it independently of other parts; for example, if you want some characters to appear 
underlined.

RELATED LINKS
Text editor options in Write mode on page 357
Changing the paragraph style used for lyrics on page 834
Resetting the appearance of items on page 401

Showing lyrics in italics
You can show individual lyrics in an italic font without changing their paragraph style, lyric type, 
or staff-relative placement. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

TIP

● If you want to show lyrics in an italic font because they are intended to be either chorus lyrics 
or translation lyrics, you can change their lyric type instead.

● You can use the Edit Lyric dialog to show individual characters in lyrics in italics.

●

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the lyrics you want to show in an italic font.

2. In the Properties panel, activate Italic in the Lyrics group.

RESULT
The selected lyrics are shown in an italic font. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Types of lyrics on page 821
Lyric line numbers on page 835
Lyric hyphens and lyric extender lines on page 835
Edit Lyric dialog on page 833
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the paragraph style used for lyrics
You can change the paragraph style used for individual lyrics; for example, if you want to use 
narrower paragraph styles for lyrics on tightly spaced systems. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics whose paragraph style you want to change.

2. In the Properties panel, activate Paragraph style in the Lyrics group.

3. Select a paragraph style from the menu.

RESULT
The paragraph style used for the selected lyrics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Types of lyrics on page 821
Lyric line numbers on page 835
Lyric hyphens and lyric extender lines on page 835
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Lyric hyphens and lyric extender lines
Lyric hyphens indicate that individual lyrics are syllables within multi-syllabic words; for example, 
“Hal-le-lu-jah”. Lyric extender lines indicate that individual lyrics, either whole words or the last 
syllables in multi-syllabic words, extend across multiple notes.

A phrase containing hyphens and an extender line

Dorico SE automatically shows lyric hyphens when you advance the lyrics popover by pressing 
-  between syllables, and lyric extender lines when you advance the lyrics popover by pressing 
Space  multiple times after an entry, provided there is sufficient horizontal space between the 
end of the lyric and the end position of the extender line. Lyric extender lines end at the right 
edge of the last notehead to which they apply.

RELATED LINKS
Inputting lyrics on page 360
Navigation during lyric input on page 362

Lyric line numbers
Lyric line numbers are used to organize lyrics when a single musical passage can have different 
lyrics sung to it, such as music that contains multiple verses. In Dorico SE, you can specify the line 
number of lyrics as you input them and by changing the line number of existing lyrics.

For example, if you input lyrics in Line 3 but later want to change those lyrics to Line 4 because 
you want to input different lyrics as Line 3, you can change your current Line 3 into Line 4, and 
then input a new line of lyrics as Line 3. The spacing is automatically adjusted to show lyric lines 
in the correct order.

The start of a choral piece with three lyric lines for its three verses

In Dorico SE, you can have multiple lines of lyrics both above and below the same staff. Turning 
lyric lines into chorus lyric lines or lyric line translations changes both their placement and 
appearance as chorus lyrics generally use an italic font.

RELATED LINKS
Verse numbers on page 837
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Filters for lyrics on page 826
Positions of lyrics on page 827
Showing lyrics in italics on page 833

Changing the line number and type of lyric lines
You can change the lyric line number of whole lyric lines after they have been input. You can also 
change whole lyric lines to chorus lines and lyric line translations.

For example, you can change the existing Line 1 into a lyric translation of Line 4, or change Line 2 
into a chorus line.

TIP

To identify which line you are working on, select a syllable in the line of lyrics and check the 
number in the Line number value field in the Lyrics group of the Properties panel.

PROCEDURE

1. In Write mode, select a lyric in the line whose lyric line type you want to change. The lyric line 
can be above or below the staff.

TIP

You can also make a selection and use the lyric filters to select different lyric lines according 
to their line numbers.

2. Change the line number and/or type of the selected lyric line in one of the following ways:

● Choose Edit > Notations > Lyrics > Line > [Line number].

● Choose Edit > Notations > Lyrics > Line > Chorus.

● Choose Edit > Notations > Lyrics > Translations > [Line number Translation].

● Choose Edit > Notations > Lyrics > Translations > Chorus Translation.

TIP

You can also choose these options from the context menu.

RESULT
The line number or type of the whole lyric line of the selected lyric is changed.

NOTE

The position of the selected lyric line relative to other lyric lines at the same position might be 
changed. For example, if there were two lyric lines and you changed Line 1 to Line 3, it now 
appears below Line 2.

If a lyric line with the same number already exists at the same position on the same side of the 
staff, the two lines switch. For example, if there is already a Line 1 at the rhythmic position where 
you want to change Line 2 to Line 1, then the existing Line 1 becomes Line 2 to accommodate 
your most recent preference. The same applies to chorus lines and lyric line translations.

RELATED LINKS
Types of lyrics on page 821
Filters for lyrics on page 826
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Changing the line number of individual lyrics
You can change the lyric line number of individually selected lyrics after they have been input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the individual lyrics whose line number you want to change.

2. In the Properties panel, change the value for Lyric number in the Lyrics group.

RESULT
The line number of the selected lyrics is changed to match the value in the value field.

NOTE

The position of the selected lyrics relative to other lyric lines might be changed. For example, if 
there were two lyric lines and you changed lyrics in Line 1 to Line 3, they now appear below Line 
2.

Verse numbers
Verse numbers indicate the order in which lyrics are sung when multiple lines of lyrics share the 
same musical passage. They are commonly used in hymns and song sheets.

Depending on the type of music you are writing, verse numbers might not be appropriate. 
Therefore, hiding/showing verse numbers in Dorico SE is optional. By default, verse numbers are 
not shown. You can hide/show verse numbers on individually selected lyrics.

NOTE

Lyric line translations are part of the lyric line of which they are a translation so do not have their 
own verse number.

Hiding/Showing verse numbers
You can hide/show verse numbers on individual lyrics; for example, if you want to show the verse 
number at the start of every system.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the lyrics before which you want to hide/show verse numbers.

2. In the Properties panel, activate/deactivate Show verse number in the Lyrics group.

3. Activate/Deactivate the corresponding checkbox.
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RESULT
Verse numbers are shown before the selected lyrics when the checkbox is activated, and hidden 
when the checkbox is deactivated.

RELATED LINKS
Hiding/Showing zones on page 41
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Elision slurs
Elision slurs are used to show that two or more syllables or characters are part of the same lyric. 
Elision slurs are also sometimes used to tell singers not to breathe between the joined lyrics.

A soprano part containing multiple elision slurs

Dorico SE automatically shows elision slurs in lyrics that contain the underscore character.

RELATED LINKS
Inputting lyrics on page 360
Navigation during lyric input on page 362
Slurs on page 1016

Hiding/Showing East Asian elision slurs
You can hide/show East Asian elision slurs for individual lyrics. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics on which you want to show East Asian elision slurs.

2. In the Properties panel, activate/deactivate Show East Asian elision slur in the Lyrics group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
East Asian elision slurs are shown on the selected lyrics when the checkbox is activated, and 
hidden when the checkbox is deactivated. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.
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EXAMPLE

East Asian elision slur shown East Asian elision slur hidden
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Notes

Notes are shapes that are positioned on staves to indicate musical pitches. Notes are most 
commonly shown with oval-shaped, round noteheads that are either filled or void depending on 
their duration, but there are many different designs of noteheads that you can use.

Depending on their duration, notes can have stems that help indicate their duration.

In Dorico SE, a sequence of adjacent notes joined with ties is considered a single note of the total 
duration of the tie chain, rather than separate notes. Note grouping is automatically adjusted 
according to the prevailing beat grouping, which is normally set by the time signature.

RELATED LINKS
Inputting notes on page 197
Note spacing on page 533
Stems on page 854
Notehead sets on page 840
Changing the notehead design of individual noteheads on page 845
Note tools popover on page 233
Adding notes above/below existing notes on page 232
Bracketed noteheads on page 849
Ties on page 1074
Note and rest grouping on page 705
Beam grouping according to meters on page 689

Notehead sets
A notehead set is a collection of related noteheads that together allow you to represent all the 
different noteheads required for the different durations used in music notation.

A typical notehead set contains at least four noteheads:

● A black notehead for quarter notes (crotchets) and shorter

● A white notehead for half notes (minims)

● A wider white notehead for whole notes (semibreves)

● A wider white notehead with one or two vertical strokes on either side, or a square white 
notehead, for double whole notes (breves)

Pitch-dependent notehead sets contain noteheads that vary according to the pitch of notes 
rather than their duration.

● In pitched notehead sets, there are different noteheads for different pitches.

For example, the Pitch Names notehead set shows the letter name and any applicable 
accidental of each note within its notehead.

● In scale degree notehead sets, there is a different notehead for each scale degree, relative to 
the current key signature.

For example, the Aikin 7-shape notehead set uses a different notehead shape for each pitch.
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NOTE

● A single notehead can appear in multiple notehead sets. If you edit a notehead within one 
notehead set, your changes affect the appearance of that notehead in all notehead sets that 
contain it.

● Notehead sets can only contain noteheads of the same type. For example, you cannot use a 
normal notehead in a pitched notehead set.

● You cannot change the type of an existing notehead set or an existing notehead.

RELATED LINKS
Pitch-dependent notehead set designs on page 844

Notehead set designs
There are a number of different notehead set designs that you can use for individual noteheads 
in Dorico SE.

● You can find the available notehead designs by selecting at least one note and choosing 
Edit > Notations > Notehead > [Notehead type or design] > [Notehead design]. You can 
also choose these options from the context menu.

NOTE

Dorico SE does not offer stemless noteheads.

General noteheads

Notehead set design Notehead set name

Larger Noteheads

Default Noteheads

Large Circled Noteheads

Circled Noteheads

Slashed Noteheads (Bottom Left to Top Right)
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Notehead set design Notehead set name

Slashed Noteheads (Top Left to Bottom Right)

Cross noteheads

Notehead set design Notehead set name

Circle X Noteheads

Large X and Diamond Noteheads

Ornate X Noteheads

Plus Noteheads

With X Noteheads

X Noteheads

X and Circle X Noteheads

X and Diamond Noteheads
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Triangular noteheads

Notehead set design Notehead set name

Large Arrow Down Noteheads

Large Arrow Up Noteheads

Triangle Down Noteheads

Triangle Left Noteheads

Triangle Right Noteheads

Triangle Up Noteheads

Diamond noteheads

Notehead set design Notehead set name

Diamond Noteheads

Old-Style Diamond Noteheads

White Diamond Noteheads

Wide Diamond Noteheads
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Slash noteheads

Notehead set design Notehead set name

Muted Slash Noteheads

Oversized Slash Noteheads

Slash Noteheads

Small Slash Noteheads

Round and square noteheads

Notehead set design Notehead set name

Moon Noteheads

Rectangular Noteheads

Round White with Dot Noteheads

RELATED LINKS
Changing the notehead design of individual noteheads on page 845

Pitch-dependent notehead set designs
Pitch-dependent notehead sets use different notehead designs or different notehead colors 
depending on the pitch of notes. There are a number of different pitch-dependent notehead sets 
available in Dorico SE.

● You can find the available notehead designs by selecting at least one note and choosing 
Edit > Notations > Notehead > [Notehead type or design] > [Notehead design]. You can 
also choose these options from the context menu.
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Scale degree noteheads

Notehead set design Notehead set name

Aikin 7-shape Noteheads

Funk 7-shape Noteheads

Walker 4-shape Noteheads

Walker 7-shape Noteheads

Pitched noteheads

Notehead set design Notehead set name

Figurenotes© Noteheads

Pitch Name Noteheads

RELATED LINKS
Notehead sets on page 840
Changing the notehead design of individual noteheads on page 845

Changing the notehead design of individual noteheads
You can change the notehead design of individual noteheads, including trill auxiliary notes. For 
example, cross noteheads might be used to indicate where players should produce pitchless 
sounds, such as air sounds on wind instruments.

NOTE

● These steps do not apply to notes in slash voices.

● If you want to change the notehead design to represent different playing techniques for 
notes belonging to unpitched percussion instruments, you can instead change their playing 
technique.

● If you want to change the notehead design to represent harmonics or rhythm slashes, you 
can instead turn notes into harmonics or change them to a slash voice. You can also input 
slash regions.
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PROCEDURE

1. Select the noteheads whose design you want to change.

2. Choose Edit > Notations > Notehead > [Notehead type] > [Notehead design].

For example, to change the notehead design of the selected notes to X noteheads, choose 
Edit > Notations > Notehead > Crosses > X Noteheads.

TIP

You can also choose these options from the context menu.

RESULT
The notehead design of the selected notes is changed.

TIP

You can assign a key command for each factory default notehead design on the Key Commands 
page in Preferences.

RELATED LINKS
Rhythm slashes on page 997
Slash voices on page 1005
Slash regions on page 997
Changing the voice of existing notes on page 422
Harmonics on page 859
Turning notes into harmonics on page 860
Playing technique-specific noteheads on page 1116
Changing playing technique-specific noteheads on page 1119
Key Commands page in the Preferences dialog on page 54

Assigning notes to strings
You can change the string on which individual notes belonging to string instruments are played; 
for example, to allow you to specify the correct harmonic. Many notes can be played on multiple 
strings, depending on where along its length the string is stopped.

Assigning notes to strings can be useful for glissando lines or fingering shifts, as the string 
and finger position required to play the note affects the direction of these changes. However, 
the string number is not shown in the music. You can instead input string indicators and/or 
fingerings, which can help string players understand the string on which they should play.

NOTE

You can only change the assigned string of notes belonging to string instruments, such as violin, 
cello, or guitar.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the notes whose assigned string you want to change.
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NOTE

If selecting multiple notes at once, select notes only in staves of the same instrument type. 
For example, select multiple Cs in Violin 1 and Violin 2 staves.

2. In the Properties panel, activate String in the Notes and Rests group.

3. Select the string you want from the menu.

The string number for the instrument is shown, followed by the fundamental pitch and 
the octave number of that string in parentheses. For example, the lowest cello string is 
expressed as 4 (C2).

NOTE

The options available in the menu depend on the selected pitches and the instrument type.

RESULT
The string to which the selected notes are assigned is changed.

NOTE

If you subsequently change the pitches of notes, String is automatically deactivated for all notes 
that can no longer be played on their assigned string.

RELATED LINKS
Glissando lines on page 889
Changing the direction of string fingering shift indicators on page 796
Fingerings for fretted instruments on page 789
String indicators on page 797
Inputting string indicators inside the staff on page 351
Turning notes into harmonics on page 860
Changing the harmonic partial on page 861

Hiding/Showing colors for notes out of range
You can show colors for notes that are considered out of range, such as notes too high/low for 
the instrument to play or the voice type to sing, or pitches that do not fit with the current harp 
pedal settings. When colors for notes out of range are hidden, all notes appear black by default.

Colors for notes out of range are considered annotations and are not printed by default.

NOTE

You cannot show colors for voices and notes out of range simultaneously.

PROCEDURE

● Do one of the following:

● To show colors for notes out of range, choose View > Note And Rest Colors > Notes 
Out Of Range.

● To hide colors for notes out of range, choose View > Note And Rest Colors > None.

Notes
Hiding/Showing colors for notes out of range 

847
Dorico SE 4.3.30



RESULT
Colors for notes out of range are hidden/shown.

Notes that are considered challenging are shown in a darker red, while notes that are impossible 
or virtually impossible are shown in a bright red.

NOTE

Notes out of the fret range of the corresponding string on tablature are always shown as 
question marks, even if you do not show colors for notes out of range.

EXAMPLE

Colors for notes out of range shown. Three notes in the middle of the phrase are bright red, while the rest 
are the darker red.

AFTER COMPLETING THIS TASK
If showing colors for notes out of range reveals some notes do not fit with the current harp pedal 
settings, you can input a new pedal diagram for that passage or calculate a suitable harp pedal 
diagram.

RELATED LINKS
Changing music area colors on page 51
Inputting harp pedal diagrams on page 348
Calculating harp pedal diagrams based on existing music on page 349
Hiding/Showing voice colors on page 1135
Annotations on page 507

Notes
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Bracketed noteheads

Bracketed noteheads are often used to indicate that notes are optional, editorial, not played in all 
playthroughs in music with repeats, or pressed down but not fully struck on the piano. In Dorico 
SE, you can show brackets on any notehead.

Notehead brackets extend slightly above and below noteheads so it is clear which notes are 
included in each bracket.

A phrase containing round and square notehead brackets

You can also show brackets on noteheads on notation staves and tablature independently of 
each other.

By default, bracketed notes have reduced velocity, causing them to sound quieter in playback 
than normal notes.

The following types of notehead brackets are available in Dorico SE:

Round notehead brackets
Round notehead brackets have a similar appearance to slurs, but vertical.

NOTE

On tablature, round brackets are automatically shown around the second note/chord 
and all subsequent notes/chords in tie chains. If you show brackets around all 
noteheads in tie chains on tablature, these automatic notehead brackets are included.

Round brackets on 
single noteheads on 
a notation staff

Round bracket on a 
chord on a notation 
staff

Round brackets on 
single noteheads on 
tablature

Round bracket on a 
chord on tablature

Square notehead brackets
Square notehead brackets comprise a straight vertical line with horizontal hooks at 
the top and bottom. Dorico SE automatically adjusts the length of square brackets to 
ensure they do not end on staff lines and their hooks remain visible.
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Square brackets on 
single noteheads on 
a notation staff

Square bracket on a 
chord on a notation 
staff

Square brackets on 
single noteheads on 
tablature

Square bracket on a 
chord on tablature

RELATED LINKS
Showing brackets around one/all noteheads in tie chains on page 851
Showing notes as dead notes on page 908
Inputting notes on page 197
Ties on page 1074
Guitar bends on page 894
Guitar pre-bends and pre-dives on page 896
Vibrato bar dives and returns on page 899
Parenthesized chord symbols on page 723

Showing brackets on noteheads
You can show round or square brackets on individual noteheads, on single notes within chords, 
and on whole chords. For example, if you want to indicate that specific notes are optional or 
an editorial change, or to show notes belonging to unpitched percussion instruments as ghost 
notes.

NOTE

If you want to show brackets on noteheads to represent dead notes, you can instead show notes 
belonging to fretted instruments as dead notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the noteheads on which you want to show brackets.

NOTE

● If you want to show brackets on whole chords, you must select all notes in those chords.

● If you want to show brackets on both notation staves and tablature, you must select 
notes on both.

2. In the Properties panel, activate Bracket style in the Bracketed Noteheads group.

3. Choose one of the following options:

● Round

● Square

Bracketed noteheads
Showing brackets on noteheads 
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RESULT
The corresponding type of notehead brackets is shown on the selected notes. If you only 
selected notes on tablature, brackets are not shown on the corresponding notes on the notation 
staff, and vice versa.

If you selected notes in tie chains, only the first noteheads in the tie chains are bracketed.

If you selected all notes in chords, Dorico SE shows a single bracket for each chord unless they 
contain very large gaps, in which case Dorico SE automatically splits brackets. If you selected 
individual notes within chords, they are each shown with separate brackets.

By default, bracketed notes have reduced velocity, causing them to sound quieter in playback 
than normal notes.

TIP

● Deactivating Bracket style hides brackets on the selected notes.

● You can also hide/show brackets on noteheads by choosing Edit > Notations > Notehead > 
Toggle Round Brackets or Edit > Notations > Notehead > Toggle Square Brackets. You 
can also choose these options from the context menu.

You can assign key commands for these options on the Key Commands page in 
Preferences.

EXAMPLE

Round brackets on single 
noteheads on a notation staff

Round bracket on a chord on a 
notation staff

Split round bracket on a chord on 
a notation staff

Round brackets on single 
noteheads on tablature

Round bracket on a chord on 
tablature

Split round bracket on a chord on 
tablature

RELATED LINKS
Showing notes as dead notes on page 908
Inputting notes on page 197
Velocity editor on page 587

Showing brackets around one/all noteheads in tie chains
You can change whether brackets appear only on the first notehead in tie chains or span the 
entire duration of the tie chain; that is, with the left bracket on the first notehead and the 

Bracketed noteheads
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right bracket on the last notehead in the tie chain. By default, brackets appear only on the first 
notehead in tie chains.

PREREQUISITE

● You have shown brackets on the required notes.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the notes whose notehead bracket positions relative to tie chains you want to change.

2. In the Properties panel, activate/deactivate Bracket until end of tie chain in the Bracketed 
Noteheads group.

RESULT
Brackets appear at the start and end of the selected tie chains when Bracket until end of tie 
chain is activated, and only around the first note/chord when it is deactivated.

If you activated Bracket until end of tie chain for a single note in a bracketed chord, the bracket 
on the first chord is not split but an additional bracket appears at the end of the tie chain for 
the selected note only. If you deactivated Bracket until end of tie chain for a single note in a 
bracketed chord whose other notes are bracketed to the end of the tie chain, the bracket at the 
end of the tie chain is split.

If you selected notes on tablature, the automatic brackets shown around the second note/chord 
and all subsequent notes/chords in tie chains are updated to follow your property setting.

EXAMPLE

Brackets around only the first chords in tie chains on 
a notation staff

Brackets at the start and end of whole tie chains on a 
notation staff

Brackets around only the first chord in a tie chain, 
with automatic brackets shown on the second chord 
on tablature

Brackets around the start and end of the whole tie 
chain on tablature

RELATED LINKS
Ties on page 1074
Showing single brackets on figured bass on page 774

Bracketed noteheads
Showing brackets around one/all noteheads in tie chains 
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Splitting brackets on chords
You can split brackets on any notehead within a chord. By default, Dorico SE automatically shows 
a single bracket for all notes in a chord unless it contains very large gaps, in which case Dorico SE 
automatically splits brackets.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the individual notes in chords immediately above where you want to split brackets.

2. In the Properties panel, activate Break bracket in the Bracketed Noteheads group.

RESULT
Brackets are split immediately below the selected notes.

EXAMPLE

Chord with single round bracket Chord with split round bracket

RELATED LINKS
Inputting chords on page 226
Parenthesized chord symbols on page 723

Bracketed noteheads
Splitting brackets on chords 
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Stems

Stems are vertical lines that extend from noteheads that are a half note or shorter in duration. In 
combination with notehead design, they allow the duration of each note to be clearly identified.

For example, quarter notes (crotchets) and eighth notes (quavers) both have solid black 
noteheads and stems, but eighth notes also have flags on their stems. 16th notes have two 
flags, 32nd notes have three flags, and so on. The length of stems is determined by default in 
Dorico SE, so stems automatically adjust their length to accommodate more/fewer flags.

The stems of notes and chords can point upwards/downwards, depending on the conventions of 
music engraving and the context of the music. For example, in choral music on two staves, stems 
in the soprano and tenor lines point up, and stems in the alto and bass lines point down.

RELATED LINKS
Note and rest grouping on page 705
Altered unisons on page 658
Voices on page 1134
Inputting notes on page 197

Stem direction
In Dorico SE, the stem direction of notes and chords follows rules that are based on the 
conventions of music engraving.

Stem direction is determined automatically, but you can manually change the stem direction of 
individual notes, chords, or of an entire voice. The rules that are applied depend on the following:

● How many voices are active on the staff.

● Whether notes, chords, or beamed groups of notes are affected.

● Whether notes in the same chord or notes in the same beamed group are split between 
staves.

Single notes in single voices

On a five-line staff with only a single voice active, the default stem direction of a single note is 
determined by its staff position.

● If the note is above the middle line, its stem points downwards.

● If the note is below the middle line, its stem points upwards.

● If the note is on the middle line of the staff, its stem direction is determined by the stem 
directions of any adjacent notes, beam groups, or chords. If they both have the same 
stem direction, the note matches them. If the adjacent notes, beam groups, or chords have 
different stem directions, or if there are no adjacent notes, beam groups, or chords, the note 
follows the default stem direction.
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The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

Notes on the middle line are stem up because the 
fourth note is stem up

Notes on the middle line are stem down because the 
fourth note is stem down

By default, notes are first input into an up-stem voice, and Dorico SE treats notes as the only 
voice on the staff until you input more voices.

Single notes in multiple voices

When there are multiple voices on a staff and all voices contain notes, the stem direction of notes 
is determined by the stem direction of their voice. Notes in up-stem voices have up stems, and 
notes in down-stem voices have down stems. This applies even when the stems of notes would 
normally point in the other direction, based on their position on the staff.

NOTE

The order in which notes appear between different up-stem voices and different down-stem 
voices depends on their pitch. You can also change the voice column index of notes individually.

When there are only notes in one voice for at least a whole bar, Dorico SE automatically changes 
the directions of stems so they point in the default direction for their pitch. For example, if a 
staff contains a single up-stem voice and a single down-stem voice but only the down-stem voice 
contains notes or rests, then the stems of notes in the down-stem voice may point upwards, 
depending on the position of the notes on the staff. However, showing rests or implicit rests in 
empty voices forces the stem direction of notes to follow the stem direction of their voice.

Notes in an up-stem voice shown in 
blue.

Notes in a down-stem voice 
shown in orange.

When notes in up-stem and down-
stem voices are in the same bar, 
the stem direction is automatically 
changed.

Chords in single voices

The stem direction for a chord in a single voice is determined by the balance of notes above/
below the middle line of the staff.

● If the note furthest from the middle line is above the middle line, the stem of the chord 
points downwards.

● If the note furthest from the middle line is below the middle line, the stem of the chord 
points upwards.

● If the chord is equally balanced on either side of the middle line of the staff, the stem 
direction is determined by the stem directions of any adjacent notes, beam groups, or 
chords. If they both have the same stem direction, the chord matches them. If the adjacent 

Stems
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notes, beam groups, or chords have different stem directions, equally balanced chords 
follow the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

Beam groups in single voices

The stem direction within beam groups is determined by the balance of notes within the beam 
group that are above/below the middle line of the staff.

● If the majority of notes in the beam group are above the middle line, stems in the beam 
group point downwards.

● If the majority of notes in the beam group are below the middle line, stems in the beam 
group point upwards.

● If the beam group contains an equal number of notes either side of the middle line of the 
staff, the stem direction is determined by the stem directions of any adjacent notes, beam 
groups, or chords. If they both have the same stem direction, the beam group matches 
them. If the adjacent notes, beam groups, or chords have different stem directions, equally 
balanced beam groups follow the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

RELATED LINKS
Voice column index on page 1137
Implicit rests in multiple-voice contexts on page 1010
Hiding/Showing voice colors on page 1135
Altered unisons on page 658

Changing the stem direction of notes
You can manually change the stem direction of any note. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose stem direction you want to change.

NOTE

You can only select whole tie chains, and changing the stem direction only affects the first 
note in the tie chain.

2. Change the stem direction in one of the following ways:

● Choose Edit > Notations > Stem > Force Stem Up.

● Choose Edit > Notations > Stem > Force Stem Down.

Stems
Stem direction 
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TIP

You can also choose these options from the context menu.

RESULT
The stem direction of the selected notes is changed. The selected notes follow this stem 
direction, even if you later change their pitch to one that usually requires a different stem 
direction. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

NOTE

● This does not change the voice to which notes belong.

● You can also change the stem direction of notes by selecting them and pressing F .

EXAMPLE

Stems pointing in the same direction but in different 
voices

Stems in the same direction and in the same voice

RELATED LINKS
Changing the voice of existing notes on page 422
Changing the staff-relative placement of items on page 400
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the default stem direction of voices
You can change the default stem direction of voices after they have been input, including slash 
voices.

NOTE

This changes the implicit stem direction of the voice, but may not change the stem direction of all 
notes in single-voice contexts. Stem directions are automatically changed in Dorico SE when only 
one voice contains notes.

PROCEDURE

1. Select a note or chord in the voice whose stem direction you want to change.

2. Change the default stem direction of the selected voice in one of the following ways:

● Choose Edit > Notations > Voices > Default Stems Up.

● Choose Edit > Notations > Voices > Default Stems Down.

Stems
Stem direction 
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TIP

You can also choose these options from the context menu.

Removing stem direction changes
You can remove changes to the directions of stems and revert stems to their default directions.

PROCEDURE

1. Select the notes whose stem direction changes you want to remove.

2. Choose Edit > Notations > Stem > Remove Forced Stem. You can also choose this option 
from the context menu.

RESULT
All stem direction changes are removed from the selected notes. The stems of the selected notes 
revert to their default directions.

NOTE

Alternatively, you can change the stem direction to the opposite direction. However, notes with 
forced stems do not change automatically if, for example, you later change their pitch.

Stem length
The length of stems is determined by default in Dorico SE, according to accepted standards for 
the appearance of stems of notes at different positions on staves.

Stems
Stem length 

858
Dorico SE 4.3.30



Harmonics

Harmonics are pitches produced by touching resonating strings at specific positions along their 
length, allowing the corresponding harmonic partial to sound. Harmonics often have a high pitch 
with a glassy, purer sound than stopped pitches. There are two different types of harmonics: 
natural and artificial.

Harmonic partials are numbered according to their order in the harmonic series, which also 
correlates to the node on the string which produces them. For example, the second partial in the 
harmonic series is produced by the node halfway along a string; that is, the node that divides the 
string into two equal parts. The third partial is produced by the node that divides the string into 
thirds, and so on.

Natural harmonics
Natural harmonics are produced by touching an open string at one of its nodes and 
then bowing or plucking the string. The sounding pitch of the resulting harmonic 
varies according to the node and its corresponding partial in the harmonic series. For 
example, touching the node halfway along a string produces the second partial, which 
sounds an octave above the open string pitch.

Artificial harmonics
Artificial harmonics are produced by stopping a string fully (as if playing a normal note) 
and then touching the string at one of the nodes of its stopped length. The sounding 
pitch of the resulting harmonic varies according to the node and its corresponding 
partial in the harmonic series. For example, touching the node that is the equivalent of 
a fourth higher than the stopped pitch produces the fourth partial, which sounds two 
octaves above the stopped pitch.

To produce artificial harmonics, players must both fully stop the string and touch 
the string at the correct node. This can be more difficult to produce than natural 
harmonics.

A passage for violin alternating between artificial 
and natural harmonics on the A string

The sounding pitches of the same passage

Dorico SE supports multiple conventions for the notation of harmonics on stringed and fretted 
instruments, including for both natural and artificial harmonics. For artificial harmonics shown 
using two noteheads, one normal and one diamond, Dorico SE automatically calculates the 
correct pitch for the touched pitch diamond notehead for the second to sixth harmonic 
partials. These pitches are reflected in playback, using dedicated sounds for harmonics if the 
corresponding playback device includes them.
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Turning notes into harmonics
You can turn existing notes into artificial and natural harmonics. Harmonics can represent the 
sounding, touched, or stopped pitch.

PREREQUISITE

● You have input the notes you want to turn into harmonics. However, the pitch you should 
input depends on the harmonic type you want to use.

● For natural harmonics, we recommend that you input the desired sounding pitch.

● For artificial harmonics, we recommend that you input the stopped pitch.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the notes you want to turn into harmonics.

2. In the Properties panel, activate Type in the Harmonics group.

3. Choose one of the following options:

● Artificial

● Natural

RESULT
The selected notes are turned into harmonics of the corresponding type. If the corresponding 
playback device has dedicated sounds for harmonics, the selected notes automatically use those 
sounds. The sounding pitch of artificial harmonics in playback is also changed accordingly.

● Artificial harmonics represent the second partial by default. They are shown with a diamond 
notehead indicating the touched pitch an octave above the selected notes. On tablature, the 
stopped fret is shown on the left and the touched fret is shown on the right in parentheses.

● Natural harmonics represent the sounding pitch by default. They are shown with a circle 
symbol above the selected notes. On fretted instrument notation staves, natural harmonics 
appear as black diamond noteheads. On tablature, the fret of the touched pitch is shown, if it 
can be calculated; if it cannot be calculated, a pink question mark is shown.

EXAMPLE
The following examples show the default appearances of natural and artificial harmonics on 
different staves.

Artificial 
harmonic on 
notation staff 
(any instrument)

Artificial 
harmonic on 
tablature

Natural 
harmonic on 
non-fretted 
instrument staff

Natural 
harmonic on 
fretted 
instrument 
notation staff

Natural 
harmonic on 
tablature

Natural 
harmonic on 
tablature that 
cannot be 
calculated

Harmonics
Turning notes into harmonics 
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AFTER COMPLETING THIS TASK
You can change the partial for harmonics. You can also change the appearance of natural 
harmonics and the style of artificial harmonics.

If you want to turn harmonics back into normal notes, deactivate Type in the Harmonics group.

RELATED LINKS
Inputting notes on page 197
Appearances/Styles of harmonics on page 863
Changing music area colors on page 51
Assigning notes to strings on page 846
Tablature on page 1048

Changing the harmonic partial
By default, harmonics indicate the second partial in the harmonic series, which is an octave 
above the fundamental. You can change the partial for individual harmonics; for example, if you 
want a higher partial instead.

NOTE

Dorico SE can only correctly calculate artificial harmonic partials for nodes two to six.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the harmonics whose partial you want to change.

2. In the Properties panel, activate Partial in the Harmonics group.

3. Change the value in the value field to the node at which the string should be touched to 
produce the partial you want.

RESULT
The partial of the selected harmonics is changed. For artificial harmonics using the Normal type, 
the pitch of the white diamond notehead/parenthesized fret number is updated automatically. 
The sounding pitch of artificial harmonics in playback is also changed accordingly.

EXAMPLE

Artificial harmonic with default partial

(notation and tablature)

Partial changed to the fifth

(notation and tablature)

Harmonics
Changing the harmonic partial 
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Artificial harmonic with default partial

(notation and tablature)

Partial changed to the fifth

(notation and tablature)

Hiding/Showing or parenthesizing harmonic accidentals
You can hide/show individual harmonic accidentals, or show them in round or square brackets, 
independently of hiding/showing or parenthesizing accidentals of stopped pitch notes. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the harmonics whose accidentals you want to hide/show or parenthesize.

2. In the Properties panel, activate Accidental in the Harmonics group.

3. Select one of the following options from the menu:

● Hide

● Show

● Round brackets

● Square brackets

RESULT
Accidentals on the selected harmonics are hidden, shown, or shown in round or square brackets. 
If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

NOTE

● Hiding accidentals does not affect the pitch of notes in playback.

● You can assign key commands for Hide Accidental, Show Accidental, Show Accidental in 
Round Brackets, and Show Accidental in Square Brackets on the Key Commands page in 
Preferences.

AFTER COMPLETING THIS TASK
You can also hide/show or parenthesize accidentals on the normal noteheads that indicate the 
stopped pitch for artificial harmonics shown using diamond noteheads.

RELATED LINKS
Hiding/Showing or parenthesizing accidentals on page 656
Changing the property scope on page 562

Harmonics
Hiding/Showing or parenthesizing harmonic accidentals 
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Copying property settings to other layouts/frame chains on page 547

Appearances/Styles of harmonics
Both artificial and natural harmonics can be notated in different ways. In Dorico SE, it is possible 
to indicate the desired sounding pitch, either the stopped or touched pitch, or both stopped and 
touched pitches for individual harmonics.

In this documentation we refer to “styles” of artificial harmonics, because one artificial harmonic 
style indicates the use of a different performance technique, and “appearances” of natural 
harmonics, as their different appearances do not indicate different performance techniques.

Natural harmonics

Circle above
Shows a harmonic circle symbol on the notehead side of notes. Usually indicates the 
desired sounding pitch of the harmonic. Used for natural harmonics on staves that do 
not belong to fretted instruments by default, such as violin.

Diamond notehead
Changes the notehead of notes to a diamond notehead. The diamond notehead 
appears black/filled when the note is a quarter note or shorter, and white/unfilled 
when the note is a half note or longer. Usually indicates the touched pitch required. 
Used for natural harmonics on fretted instrument notation staves by default.

White diamond notehead
Changes the notehead of notes to a diamond notehead that is always unfilled, 
regardless of the duration of notes. Usually indicates the touched pitch required.

On tablature, the touched fret is always shown for natural harmonics, regardless of the selected 
appearance. If the touched fret cannot be calculated, a pink question mark is shown.

Harmonics
Appearances/Styles of harmonics 
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Artificial harmonics

Normal
Shows two noteheads: one indicating the stopped pitch, the other the touched pitch. 
The touched pitch is automatically calculated based on the partial; the default partial is 
the second partial. On tablature, the stopped fret is shown on the left and the touched 
fret is shown on the right in parentheses. This is the default appearance of artificial 
harmonics on all staves.

Normal artificial harmonic on notation staff Normal artificial harmonic on tablature

Pinch
Shows two noteheads: one indicating the stopped pitch, the other the sounding pitch. 
The sounding pitch is automatically calculated based on the partial; the default partial 
is the second partial. On tablature, only the stopped fret is shown.

NOTE

Intended for fretted instruments only. A pinch is produced by the performer catching 
a resonating string at a node near the pick-ups, producing a high-pitched squeal. Also 
known as a “false harmonic” or “squeal”.

Pinch harmonic on notation staff Pinch harmonic on tablature

Single notehead (sounding)
Shows a single notehead indicating the sounding pitch. On tablature, the stopped fret 
is shown on the left and the sounding pitch is shown on the right in parentheses.

Single notehead (sounding) artificial 
harmonic on notation staff

Single notehead (sounding) artificial 
harmonic on tablature

Single notehead (stopped)
Shows a single notehead indicating the stopped pitch. On tablature, the stopped fret is 
shown on the left and the touched fret is shown on the right in parentheses.

Harmonics
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Single notehead (stopped) artificial 
harmonic on notation staff

Single notehead (stopped) artificial 
harmonic on tablature

RELATED LINKS
Changing music area colors on page 51

Changing the appearance of natural harmonics
By default, natural harmonics appear as normal noteheads with a circle shown above, which 
indicates the desired sounding pitch. You can change the appearance of natural harmonics 
individually; for example, to show them as a white diamond notehead to indicate the touched 
pitch.

NOTE

These steps only apply to harmonics with the Natural type.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the natural harmonics whose appearance you want to change.

2. In the Properties panel, activate Style in the Harmonics group.

3. Select one of the following options from the menu:

● Circle above

● Diamond notehead

● White diamond notehead

RESULT
The appearance of the selected natural harmonics is changed, including on fretted instrument 
notation staves. The touched pitch shown on tablature is not changed automatically.

NOTE

● Changing the appearance of natural harmonics does not automatically change their notated 
pitch. For example, if you want to change a sounding pitch Circle above harmonic to a 
touched pitch White diamond notehead harmonic, you must also change the pitch of the 
note.

● Dorico SE automatically assigns natural harmonics with the White diamond notehead style 
to the lowest possible string for that harmonic. You can specify different strings if necessary.

● You can change the staff-relative placement of harmonic circle symbols by activating 
Placement in the Harmonics group of the Properties panel and choosing the option you 
want.

Harmonics
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RELATED LINKS
Turning notes into harmonics on page 860
Changing the pitch of individual notes on page 424
Assigning notes to strings on page 846
Tablature on page 1048

Changing the style of artificial harmonics
By default, artificial harmonics appear as two noteheads: one normal, which indicates the 
stopped pitch, and one diamond, which indicates the touched pitch. You can change the style 
of artificial harmonics individually; for example, to indicate pinch harmonics.

NOTE

These steps only apply to harmonics with the Artificial type.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the artificial harmonics whose style you want to change.

2. In the Properties panel, activate Style in the Harmonics group.

3. Select one of the following options from the menu:

● Normal

● Pinch

● Single notehead (sounding)

● Single notehead (stopped)

RESULT
The style of the selected artificial harmonics is changed.

NOTE

Pinch indicates the use of a different technique to produce the harmonic.

Harmonics
Appearances/Styles of harmonics 
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Ornaments

Ornaments are markings that indicate multiple notes are played in addition to the notated pitch. 
They are used to decorate music, such as in Baroque music, which is highly decorated with trills 
and other ornaments.

Over time, specific ways of notating how performers should play notes have developed 
and different ornament symbols indicate different patterns of decorative notes. Nonetheless, 
ornaments give some freedom to performers to embellish music in their own way.

In Dorico SE, the term “ornaments” refers to ornament symbols, including mordents and turns, 
and trill marks.

A phrase containing a turn, short trills, and a trill with extension line

NOTE

Only trills are currently reflected in playback. Playback of other ornaments is planned for future 
versions.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Grace notes on page 803
Positions of ornaments on page 868
Trills on page 870
Trills in playback on page 880

Changing ornament intervals
You can change the intervals of ornaments, both above and below the notated pitch, to 
indicate which pitches are played in the ornament. The intervals of ornaments are indicated 
by accidentals.

For some ornaments, you can only change the interval in one direction. For example, you can 
only change the interval above short trills and below mordents.

NOTE

These steps do not apply to trills.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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PROCEDURE

1. Select the ornaments whose interval you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Ornaments group, as appropriate for the selected ornaments:

● Interval above

● Interval below

3. Change the values in the value fields to the intervals you want.

● 0 or 4 and above shows no accidental.

● 1 shows a flat.

● 2 shows a natural.

● 3 shows a sharp.

RESULT
The intervals of the selected ornaments are changed.

NOTE

Some ornaments do not show accidentals either above or below, depending on their type.

EXAMPLE

No accidentals Flats above and below Naturals above and 
below

Sharps above and below

RELATED LINKS
Trill intervals on page 873
Changing vibrato bar dip intervals on page 908

Positions of ornaments
Ornaments, including trills, are placed above the notes to which they apply. They are only placed 
below the staff for down-stem voices in multiple-voice contexts.

Ornaments and trills are positioned outside of slurs by default. Similarly, they are positioned 
further from noteheads than articulations.

The center of ornaments aligns with the center of the notehead to which they apply. Trills are 
aligned differently, as the left side of trill marks aligns with the left edge of the notehead to which 
the trill applies.

Dorico SE automatically positions ornaments correctly according to their type, and attaches them 
to their notehead.

You can move ornaments to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

Ornaments
Positions of ornaments 
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RELATED LINKS
Trills on page 870
Hiding/Showing trill marks on page 870
Moving notes/items rhythmically on page 417

Changing the start position of trills
You can change whether the start position of individual trills is aligned with the notehead or with 
its accidental. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trills whose start position you want to change.

2. In the Properties panel, activate Start position in the Trills group.

3. Choose one of the following options:

● Notehead

● Accidental

RESULT
The start position of the selected trills is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Hiding/Showing trill extension lines on page 872

Ornaments
Positions of ornaments 
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Trills

Trills are fast alternations between two notes, similar to a tremolo, that were a common 
decoration in Baroque, Classical, and Romantic music. Trill marks are usually added to a single 
note, to indicate the performed notes are the notated pitch and the note either a half-step or 
whole step above, and can have extension lines to show the duration of the trill.

A phrase containing multiple trills with extension lines

Because of their legacy as an ornament, many performers interpret trills differently to tremolos: 
some players add more emphasis to the notated pitch in a trill and less on the trilled-to note but 
play both notes equally in tremolos.

The most common trills are to notes a major or minor second above, but it is also possible to 
specify other trill intervals.

In Dorico SE, you can specify any trill interval, change their appearance on notation staves, and 
hear them in playback.

On tablature, the trilled-to pitch always appears as a parenthesized fret number.

Trills on a notation staff and tablature

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Trill intervals on page 873
Changing the start position of trills on page 869
Trills in playback on page 880
Tablature on page 1048

Hiding/Showing trill marks
You can hide/show trill marks at the start of individual trills. This also hides/shows trill marks on 
all systems on which the trills extend.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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PROCEDURE

1. Select the trills whose trill marks you want to hide/show.

2. In the Properties panel, activate Show trill mark in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Trill marks are shown when the checkbox is activated, and hidden when the checkbox is 
deactivated.

When the property is deactivated, trill marks are shown by default.

RELATED LINKS
Trill interval appearance on page 878
Hiding/Showing trill interval accidentals on page 874
Hiding/Showing speed changes in trill extension lines on page 872
Hiding/Showing trill extension lines on page 872

Changing the speed of trills
You can indicate different speeds for trills, including indicating a change of speed within a single 
trill, by changing the height and frequency of wiggles in their extension lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the trills whose speed you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Trills group:

● Start speed

● End speed

3. Select one of the following options from each property menu:

● Slow

● Normal

● Fast

RESULT
The speed of the selected trills is changed. This affects both the frequency of wiggles in their 
extension lines and their playback speed.

If only Start speed is activated, the speed of the whole trill extension line is changed. If only End 
speed is activated, the speed of the end half of the trill extension line is changed.

Trills
Changing the speed of trills 
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EXAMPLE

A trill extension line starting slow and ending fast Trill with normal speed throughout

AFTER COMPLETING THIS TASK
You can customize the playback speed of trills individually.

RELATED LINKS
Changing the playback speeds of trills on page 881

Hiding/Showing speed changes in trill extension lines
You can hide/show speed changes in the extension lines for individual trills; for example, if you 
want to hear different speeds in playback but show extension lines with consistent wiggles.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the trills whose speed changes you want to hide/show.

2. In the Properties panel, activate/deactivate Suppress drawing speed changes in the Trills 
group.

RESULT
Speed changes are hidden when the property is activated, and shown when it is deactivated.

Hiding/Showing trill extension lines
You can hide/show the extension lines of individual trills. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trills whose extension lines you want to hide/show.

2. In the Properties panel, activate/deactivate Has trill line in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

Trills
Hiding/Showing speed changes in trill extension lines 
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RESULT
Trill extension lines are shown when the checkbox is activated, and hidden when the checkbox is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

When the property is deactivated, trill extension lines are only shown on tied notes by default.

RELATED LINKS
Changing the start position of trills on page 869
Changing the speed of trills on page 871
Changing the playback speeds of trills on page 881
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Trill intervals
Trill intervals tell performers which notes to play and also affect the pitches used in playback in 
Dorico SE. For example, a trill with a sharp accidental on an E indicates that the performer trills 
between E and F♯, rather than between E and F.

The different accidentals on these trills indicate changes in the trilled-to note.

If you do not specify an interval when inputting a trill, Dorico SE calculates an appropriate 
interval based on the top note in the voice to which the trill belongs, the current key signature, 
and any accidentals earlier in the bar. For example, inputting a trill on an E♮ in C major produces 
a half-step/minor second trill interval to F♮. If there were a sharp accidental on the F earlier in the 
bar, the trill interval produced is a whole step/major second between the E♮ and F♯.
In open/atonal key signatures, Dorico SE produces whole step/major second trill intervals by 
default.

You can specify trill intervals when inputting them with the popover, including at different 
noteheads in the same trill, and you can change individual trill intervals after they have been 
input. In 12-EDO, you can describe trill intervals based on their quality, such as major or minor.

When trill intervals do not require a trill interval indicator, they are indicated by signposts. 
However, trill interval signposts are hidden by default.

Trills and accidentals

If required, Dorico SE shows accidentals to clarify trill intervals. Dorico SE also automatically 
shows accidentals on other notes in the bar if they have different accidentals to any upper notes 
of trills.

By default, trill marks themselves show intervals, unless the upper note is modified by an 
accidental in the key signature. If the upper note has been modified by an accidental earlier in 
the bar, trills always show the interval. If trills modify pitches modified by an accidental in the key 
signature, any subsequent notes of that pitch show the appropriate accidental automatically. Any 
cautionary accidentals required in the current and following bars are also shown automatically.

Trills
Trill intervals 
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Microtonal trill intervals

When using other tonality systems than 12-EDO, such as 24-EDO, you must specify trill intervals 
as an interval degree, expressed as the number of staff position steps, and total number of 
octave divisions from the notated pitch. This is because specifying only the interval quality is 
insufficient in such cases.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Trill interval appearance on page 878
Inputting ornaments/trills with the popover on page 316
Ornaments popover on page 311
Signposts on page 407
Changing ornament intervals on page 867
Changing vibrato bar dip intervals on page 908

Hiding/Showing trill interval accidentals
You can hide/show accidentals for individual trill intervals; for example, if you want to show the 
accidental for the first note of a trill but hide the accidentals for subsequent notes. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

● In order to show trill interval accidentals, trills must have intervals that require accidentals.

● These steps only hide the accidentals shown in trill intervals, they do not hide auxiliary notes 
or Hollywood-style markings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trill intervals, or trill interval signposts whose accidentals you want to hide/show.

NOTE

For trills that span multiple notes and have multiple trill interval accidentals, you must select 
each accidental or signpost individually. If you select the whole trill, only the first trill interval 
accidental is changed.

2. In the Properties panel, activate Accidental in the Trills group.

3. Choose one of the following options:

● Hide

● Show

RESULT
Accidentals in the selected trill intervals are hidden when you choose Hide, and shown when 
you choose Show. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

Trills
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Signposts are shown at the position of each hidden trill interval accidental. However, trill interval 
signposts are hidden by default.

RELATED LINKS
Changing the appearance of trill intervals on page 878
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Annotations on page 507
Hiding/Showing signposts on page 407

Changing trill intervals
The default trill interval is a second, either major or minor depending on the context. In addition 
to specifying the interval when inputting trills with the ornaments popover, you can change the 
intervals of trills and existing trill intervals within their duration individually after they have been 
input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the trills, trill intervals, or trill interval signposts whose interval you want to change.

NOTE

For trills that span multiple notes and have multiple interval changes, you must select each 
trill interval you want to change individually. If you select the trill mark/extension line, only 
the first trill interval is changed.

2. In the Properties panel, activate Interval in the Trills group.

3. Change the interval degree, expressed as the number of staff position steps, by changing 
the value in the value field.

4. Change the interval quality or total number of octave divisions from the trilled note in one of 
the following ways:

● For trills in 12-EDO, select an interval quality from the menu.

● For trills in other tonality systems, select a total number of octave divisions from the 
menu.

Together, the interval degree and either interval quality or total number of octave divisions 
specify the desired note name and accidental for the trilled-to note.

RESULT
The interval of the selected trill intervals is changed. This applies from the selected trill intervals 
until the next interval change in the trill or the end of the trill, whichever comes first. For 
example, if you selected a trill with no interval changes within its duration, the interval is 
changed for the whole trill.

By default, trill intervals appear as accidentals when the interval is a second and as auxiliary 
notes for all other intervals. Signposts are shown at the position of each trill interval that does 
not require an accidental or auxiliary note. However, trill interval signposts are hidden by default.

Trills
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RELATED LINKS
Resetting trill intervals on page 877
Ornaments popover on page 311

Changing trill intervals partway through trills
You can change the intervals of existing trills at any notehead within their duration; for example, 
if you want a trill to change seamlessly from a minor second in one bar to a major second in the 
next.

PROCEDURE

1. In Write mode, select one of the following:

● The note whose trill interval you want to change.

● An item or rest on the staff where you want to specify trill intervals.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Press Right Arrow / Left Arrow  to move the caret according to the current rhythmic grid 
resolution to the notehead where you want to change the trill interval.

NOTE

You can only change trill intervals at noteheads.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the trill interval you want into the popover. For example, enter m3 for a minor third.

6. Press Return  to close the popover.

7. Optional: Repeat steps 3 to 6 to change the trill interval at other noteheads in the trill.

8. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
The trill interval is changed at the corresponding noteheads. By default, all trill intervals in the 
trill appear as accidentals when the intervals are all seconds and as auxiliary notes when the trill 
contains at least one trill interval with a different interval.

Signposts are shown at the position of each trill interval that does not require an accidental or 
auxiliary note. However, trill interval signposts are hidden by default.

Trills
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EXAMPLE

Trill with interval changes shown as accidentals Trill with interval changes shown as auxiliary notes

RELATED LINKS
Changing the appearance of trill intervals on page 878
Ornaments popover on page 311
Signposts on page 407
Hiding/Showing signposts on page 407
Notes toolbox on page 173
Rhythmic grid on page 190

Resetting trill intervals
You can reset trill intervals to the default trill interval of a second, either major or minor 
depending on the context, including resetting individual trill intervals within a single trill 
independently.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the trills, trill intervals, or trill interval signposts whose interval you want to reset.

NOTE

For trills that span multiple notes and have multiple interval changes, you must select each 
trill interval you want to reset individually. If you select the trill mark/extension line, only the 
first trill interval change is reset.

2. In the Properties panel, deactivate Interval in the Trills group.

RESULT
The interval of the selected trill intervals is reset. This applies from the selected trill intervals until 
the next interval change in the trill or the end of the trill, whichever comes first. For example, if 
you selected a trill with no interval changes within its duration, the interval is reset for the whole 
trill.

By default, trill intervals appear as accidentals when the interval is a second and as auxiliary 
notes for all other intervals. Signposts are shown at the position of each trill interval that does 
not require an accidental or auxiliary note. However, trill interval signposts are hidden by default.

RELATED LINKS
Properties panel on page 560
Signposts on page 407
Hiding/Showing signposts on page 407

Trills
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Trill interval appearance
There are different accepted ways to present trill intervals on notation staves, including 
accidental symbols and the Hollywood convention of showing “H.T.” for a half-step (semitone) 
and “W.T.” for a whole step (tone).

In Dorico SE, trill intervals can appear in the following ways on notation staves:

Accidental
Indicates the trill interval using accidentals positioned above, below, or beside the 
tr mark. This is the default trill interval appearance in Dorico SE for major or minor 
second trills.

Hollywood-style
Indicates the trill interval using text.

● H.T. for half-step/minor second trills

● W.T. for whole step/major second trills

Auxiliary note
Indicates the trill interval using a small, parenthesized, stemless notehead shown in 
the staff immediately to the right of the first note to which the trill applies, and at the 
correct staff position for the trilled-to pitch. Auxiliary notes are used for all trill intervals 
that are not a major or minor second, but are automatically hidden for unison trills if 
the notehead design of the auxiliary note has not been overridden.

NOTE

On tablature, the trilled-to pitch always appears as a parenthesized fret number.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310

Changing the appearance of trill intervals
You can change the appearance of trills with a second interval on notation staves individually; for 
example, if you want to show auxiliary notes on some trills to clarify a change in the trilled-to 
pitch.

Trills
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NOTE

You can only change the trill interval appearance of trills with a major/minor second interval.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the trills whose trill interval appearance you want to change.

2. In the Properties panel, activate Appearance in the Trills group.

3. Select one of the following options from the menu:

● Accidental

● Hollywood style

● Auxiliary note

RESULT
The appearance of the selected trill intervals on notation staves is changed. This does not affect 
their appearance on tablature.

AFTER COMPLETING THIS TASK
You can change the notehead design of individual auxiliary notes; for example, to show that the 
trilled-to note is a harmonic.

RELATED LINKS
Changing the notehead design of individual noteheads on page 845

Changing the position of trill interval indicators
You can change where trill interval indicators, such as an accidental or W.T. marking, are 
positioned relative to individual trill marks. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

NOTE

This does not affect the position of trill interval accidentals on subsequent notes over which trills 
extend.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trills whose interval indicator position you want to change.

2. In the Properties panel, activate Interval position in the Trills group.

3. Select one of the following options from the menu:

● Above

Trills
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● Below

● On the right

● Superscript

RESULT
The position of interval indicators relative to the selected trill marks is changed. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Above Below On the right Superscript

Trills in playback
Dorico SE plays back trills by using a combination of sampled trills, when available, and 
triggering multiple notes.

Dorico SE can play back sampled half-step (semitone) and whole step (tone) trills automatically if 
these playing techniques are defined in the VST expression map, which is the case for a number 
of instruments in HALion Symphonic Orchestra. For sound libraries that do not provide sampled 
trills, or for intervals beyond a whole step, Dorico SE generates trills.

When playing generated trills, Dorico SE incorporates grace notes immediately before and after 
trills. A single unslashed grace note on the initial trill note produces an appoggiatura, while 
multiple grace notes on the initial trill note are included in the trill pattern. Grace notes on the 
note immediately following a trill are also included in the trill pattern.

A trill with grace notes at both the start and end

Variable speeds within trills are included in playback, and you can change the playback speed 
of individual trills. Additionally, you can hide trill speed changes in trill extension lines whilst 
retaining the speed changes in playback.

In contemporary performance practice, trills are usually performed starting on the written note, 
while in the historical performance practice of the Baroque and Classical eras, trills are usually 
performed starting on the upper (trilled-to) note. You can change the default starting pitch for 
trills individually.

RELATED LINKS
Changing the speed of trills on page 871
Hiding/Showing speed changes in trill extension lines on page 872
Changing the starting pitch of trills on page 881

Trills
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Playback techniques on page 649
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310

Sampled vs. generated trills
Sampled trills are recorded, looped samples, whereas generated trills are produced by manually 
triggering separate notes.

Because they use fixed sounds, sampled trills typically offer no parameters that allow any kind 
of variation in the trill interpretation, such as different trill speeds or incorporating grace notes 
and termination notes into the pattern of trilled notes. By contrast, generated trills can provide 
greater flexibility but produce a less natural and realistic sound.

Changing the playback speeds of trills
In addition to changing the speed of trills, which changes both the frequency of wiggles in their 
extension lines and their playback speed, you can also change the playback speed of each speed 
variant in individual trills; for example, if you want to make the fastest part of an individual trill 
faster than your default setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the trills whose playback speeds you want to change.

2. In the Properties panel, activate any of the following properties, as appropriate for your 
selected trills:

● Slow trill speed

● Normal trill speed

● Fast trill speed

3. Change the values in the value fields.

RESULT
The playback speed of the selected trills is changed. The values in the value fields correspond to 
the number of notes sounding per second.

RELATED LINKS
Changing the speed of trills on page 871
Hiding/Showing speed changes in trill extension lines on page 872

Changing the starting pitch of trills
By default in Dorico SE, trills start on the lower note, which is usually the written note. However, 
the accepted practice in Baroque and Classical music is to start trills on the upper note. You can 
change the starting pitch of trills individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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PROCEDURE

1. Select the trills whose starting note you want to change.

2. In the Properties panel, activate Start on upper note in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected trills start on the upper note when the checkbox is activated, and on the lower note 
when the checkbox is deactivated.

Trills
Trills in playback 
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Arpeggio signs

Arpeggio signs are vertical lines that indicate chords are to be played arpeggiated, or “spread”, 
so that the notes in the chord are played very quickly one after another. Arpeggio signs are 
normally shown as vertical wavy lines.

Arpeggiated chords can be played in two directions:

● Upwards, starting from the bottom note in the chord.

● Downwards, starting from the top note in the chord.

It is most common for up arpeggio signs to have nothing at the top end, because chords are 
usually arpeggiated upwards, and for down arpeggio signs to have an arrow at the bottom, so 
these are the defaults in Dorico SE. However, it is also accepted practice to show up arpeggio 
signs with an arrow at the top if down arpeggio signs are also used in the same piece of music.

Arpeggio signs in Dorico SE automatically span the range of all notes in the voices/staves to 
which they apply.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Glissando lines on page 889
Jazz articulations on page 911
Lines on page 946

Types of arpeggio signs
There are different types of arpeggio signs to convey the different arpeggiation directions and 
techniques.

Up arpeggio

A vertical wavy line that indicates chords are to be arpeggiated from the bottom note 
upwards.
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Down arpeggio

A vertical wavy line that indicates chords are to be arpeggiated from the top note 
downwards.

Non arpeggio

A bracket with straight lines that indicates all notes in the chord are to be played 
together, not arpeggiated.

Curved arpeggio

A curved line, similar to a slur but vertical, that some composers use to indicate gentle 
or partial arpeggiation.

You can show both up and down arpeggio signs with one of the following ends in Dorico SE:

● Nothing

● Arrow

● Swash

Up arpeggio sign with nothing at 
the end

Up arpeggio sign with an arrow at 
the end

Up arpeggio sign with a swash at 
the end

Changing the type of arpeggio signs
You can change the type of arpeggio signs after they have been input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the arpeggio signs whose type you want to change.

Arpeggio signs
Types of arpeggio signs 
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2. In the Properties panel, select one of the following options from the Arpeggio type menu in 
the Arpeggios group:

● Non arpeggio

● Up arpeggio

● Down arpeggio

● Up arpeggio (curve)

RESULT
The type of the selected arpeggio signs is changed.

TIP

You can also change the arpeggio type by opening the ornaments popover and changing the 
entry.

Changing the end appearance of arpeggio signs
Down arpeggio signs have an arrowhead at the bottom of the line by default, but up arpeggio 
signs have no arrowhead by default. You can change the appearance of the ends of arpeggio 
signs individually.

NOTE

These steps only apply to up and down arpeggio signs. They do not apply to curved or non 
arpeggio signs.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the arpeggio signs of any direction whose ends you want to change.

2. In the Properties panel, activate Sign end in the Arpeggios group.

3. Select the end you want from the menu:

● Nothing

● Arrow

● Swash

RESULT
The appearance of the ends of the selected arpeggio signs is changed.

Arpeggio signs
Types of arpeggio signs 
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EXAMPLE

Up arpeggio sign with nothing at 
the end

Up arpeggio sign with an arrow at 
the end

Up arpeggio sign with a swash at 
the end

Length of arpeggio signs
The length of arpeggio signs is determined by the pitch range of notes in the voices/staves to 
which the arpeggio sign applies. Dorico SE automatically adjusts the length of arpeggio signs if 
pitches change or you add notes to, or delete notes from, chords.

General placement conventions for arpeggio signs
Arpeggio signs are positioned to the left of the notes, including any applicable accidentals, to 
which they apply, but are positioned between grace notes and normal notes. They should appear 
within the same bar as the notes to which they apply, and not on the other side of the barline.

Dorico SE makes automatic adjustments to note spacing and staff spacing to accommodate 
arpeggio signs and ensure they are positioned correctly.

Arpeggio signs should cover the whole vertical range of all notes in the chord to which they 
apply, and protrude slightly at each end. However, they do not need to cover the stems of notes. 
Dorico SE automatically creates the lengths of arpeggio signs to cover the notes in chords, and 
adjusts their lengths if the notes in chords change or are deleted.

If an arpeggiated chord spans two staves, such as in a piano part, its arpeggio sign can extend 
across both staves.

You can move arpeggio signs to different rhythmic positions in Write mode.

Showing arpeggio signs before/after grace notes
You can show arpeggio signs before/after grace notes individually. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains. By default, arpeggio 
signs are positioned immediately to the left of the notes to which they apply, and so are 
positioned between normal notes and grace notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the arpeggio signs you want to show before grace notes.

Arpeggio signs
Length of arpeggio signs 
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2. In the Properties panel, activate/deactivate Arpeggio before grace notes in the Arpeggios 
group.

RESULT
The selected arpeggio signs are shown before grace notes when the property is activated, and 
after grace notes when the property is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562

Changing arpeggio playback relative to the beat
You can change whether individual arpeggios are played before their notated position or after 
their notated position.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the arpeggio signs whose playback relative to the beat you want to change.

2. In the Properties panel, activate Playback position in the Arpeggios Playback group.

3. Choose one of the following options:

● Start on beat

● End on beat

RESULT
The beat-relative position of the selected arpeggios in playback is changed.

EXAMPLE

Arpeggio starting on the beat Arpeggio ending on the beat

Changing the playback duration of arpeggios
You can change the duration of individual arpeggios in playback.

Arpeggio signs
Changing arpeggio playback relative to the beat 
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The duration of arpeggios is expressed as a fraction of the notated rhythm of chords. For 
example, an arpeggio on a quarter note (crotchet) chord with a note offset value of 1/2 lasts an 
eighth note (quaver), whereas with a note offset value of 1/8 it lasts a 32nd note.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the arpeggio signs whose playback duration you want to change.

2. In the Properties panel, activate Note offset in the Arpeggios Playback group.

3. Change the playback duration of the selected arpeggio signs by changing the value in the 
value field.

4. Press Return .

RESULT
The playback duration of the selected arpeggios is changed.

EXAMPLE

Arpeggiated chord with a note offset value of 1/8 Arpeggiated chord with a note offset value of 1/2

Arpeggio signs
Changing the playback duration of arpeggios 
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Glissando lines

Glissando lines indicate a continuous transition between two notes, which can be smooth or 
in chromatic steps. They can have straight lines or wiggly lines, and can be shown with a text 
indication or as a line without text.

Because glissando lines are positioned between noteheads, the steepness of their angle reflects 
the interval between the notes: the steeper the angle, the greater the interval.

There are different conventions regarding the playing techniques for glissando and portamento. 
Some people understand glissando lines to indicate a chromatic scale between the two notes, 
either rising or falling in a series of half-steps (semitones), and portamento lines to indicate a 
smooth, continuous glide between the two notes. However, the terms glissando and portamento 
can be used interchangeably in other cases.

You can input both glissando lines and portamento lines in Dorico SE, and you can easily change 
their style after they have been input.

Glissando lines in Dorico SE automatically follow the notes at each end, meaning if you 
change the pitch of either note, the glissando line end positions move accordingly. Dorico SE 
automatically positions glissando lines so they do not collide with accidentals.

An example glissando line with text shown and a 
wiggly line

An example portamento line with text shown and a 
straight line

Glissando lines can cross system breaks and page breaks. If text is shown for glissando lines that 
span system or page breaks, then that text is shown on every glissando line segment. By default, 
the start and end positions of each segment match the original start and end points of the whole 
glissando line.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Changing the style of glissando lines on page 890
Arpeggio signs on page 883
Jazz articulations on page 911
Fingering slides on page 792
Playing technique continuation lines on page 940
Lines on page 946
Changing the pitch of individual notes on page 424
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Glissando lines across empty bars
In Dorico SE, you can input glissando lines between any two notes, even if there are rests 
or other notes between them, and including between notes in different voices and notes on 
different staves.

For very long glissando lines that extend across multiple bars, you might not want to show 
pitches at the start of each bar; for example, to indicate that performers do not emphasize 
pitches during the course of the glissando, or that performers can play the glissando at their own 
speed. By default, Dorico SE shows notes or rests in every bar.

Once you have input a glissando line between the selected notes, you can delete any rests 
between them.

EXAMPLE

A glissando line across multiple bars with no rests shown between the two notes

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Hiding/Showing bar rests in empty bars on page 1014
Deleting rests on page 1012
Turning explicit rests into implicit rests on page 1011

Changing the style of glissando lines
Glissando lines can be shown as straight lines or wiggly lines. You can change the glissando line 
style of glissando lines individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the glissando lines whose style you want to change.

2. In the Properties panel, activate Glissando style in the Glissando Lines group.

3. Choose one of the following options:

● Straight line 

● Wiggly line 

RESULT
The glissando line style is changed for the selected glissando lines.

TIP

● Deactivating Glissando style returns the selected glissando lines to the default style.

● You can also change the glissando style by opening the ornaments popover and changing 
the entry.

Glissando lines
Glissando lines across empty bars 
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RELATED LINKS
Ornaments popover on page 311
Changing existing items on page 398

Changing glissando line text
You can show individual glissando lines with “gliss.” text, “port.” text, or without text. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the glissando lines whose text you want to change.

2. In the Properties panel, activate Glissando text in the Glissando Lines group.

3. Select one of the following options from the menu:

● Gliss.

● Port.

● No text

RESULT
The text shown on the selected glissando lines is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310

Changing when glissando line text is shown
By default, glissando text is not shown when glissando lines are too short to accommodate the 
text. You can choose to show text on individual glissando lines always, or only if there is sufficient 
space. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

Glissando lines
Changing glissando line text 
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PROCEDURE

1. Select the glissando lines whose setting for when text is shown you want to change.

2. In the Properties panel, activate Glissando text shown in the Glissando Lines group.

3. Choose one of the following options:

● Show if sufficient space

● Always show

RESULT
When Show if sufficient space is chosen, glissando line text is not shown if the glissando line is 
too short.

When Always show is chosen, glissando line text is always shown, even if the glissando line 
is short. However, this can cause the glissando line text to collide with other items, such as 
noteheads and stems.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can increase the default gaps between noteheads by changing the default note spacing.

RELATED LINKS
Note spacing on page 533
Changing the default note spacing on page 533

Glissando lines in playback
Glissando lines are reflected in playback using a sequence of notes, all a small interval apart, 
between the start and end notes for each glissando.

Glissandos belonging to harps consider the current harp pedaling when determining the pitches 
to use in playback. Glissandos for all other instruments use the 12-EDO chromatic scale, 
regardless of the current tonality system.

When glissando lines start or end on tie chains, their playback starts on the last note in tie chains 
and ends on the first note in tie chains.

By default in playback, glissandos sound across their full duration, but you can delay the start of 
glissandos in playback individually.

NOTE

Playing back glissando lines as a continuous, smooth slide is not yet supported. This is planned 
for future versions.

RELATED LINKS
Harp pedaling on page 918

Glissando lines
Glissando lines in playback 
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Delaying the start of glissandos in playback
You can delay the start of glissandos in playback so that they start partway through their 
duration. By default, glissandos sound for their full duration in playback.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the glissando lines whose playback start you want to delay.

2. In the Properties panel, activate Delayed start in the Glissando Lines group.

3. Optional: If you want to specify exactly how far through the glissando lines playback starts, 
activate Delay and change the value in the value field.

The value represents fractions of a quarter note. For example, 1/2 delays the start of 
glissandos by an eighth note.

RESULT
If you activated Delayed start only, playback of the selected glissando lines starts halfway 
through their duration.

If you also activated Delay, playback of the selected glissando lines follows your set value.

Glissando lines
Glissando lines in playback 
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Guitar bends

The guitar bend is a technique commonly performed on electric guitars, where the performer 
pushes strings out of their normal alignment after notes start to sound. Bending strings tightens 
them, which produces the characteristic pitch fluctuation.

Performing a guitar bend often also involves sustaining the bent pitch before allowing the string 
to return to its natural position and un-bent pitch. In Dorico SE, these actions are called a “guitar 
bend hold” and “release” respectively.

A phrase containing guitar bends, a guitar bend hold, guitar pre-bends, and releases, shown on both a 
notation staff and tablature

Guitar bends and releases with bend intervals of up to a whole step (tone) are reflected in 
playback.

Guitar bends
Guitar bends indicate that the performer should bend the string after playing a note, 
so that the pitch increases while the note sounds. In Dorico SE, each guitar bend joins 
two notes: the start pitch and the pitch at the peak of the bend.

On notation staves, guitar bends are notated using an angled line between the 
noteheads at the start and end. On tablature, guitar bends are notated using an 
upwards-pointing curved line with an arrowhead at the top and a bend interval above 
the arrowhead. The fret number of the end note is hidden automatically.

Guitar bend on notation staff Guitar bend on tablature

If you input guitar bends on multiple notes in chords, their arrowheads are 
automatically aligned on tablature.
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Guitar bends on chord on notation staff Guitar bends on chord on tablature

Sequences of consecutive guitar bends are notated as bend runs on tablature.

Guitar bend runs on tablature

Guitar bend holds
Guitar bend holds indicate that the performer should maintain the pitch at the peak of 
a guitar bend. They are usually shown on tied notes.

On tablature, guitar bend holds are notated using a horizontal line. They are not 
notated on notation staves.

Guitar bend hold on tablature

Releases
Releases indicate that the performer should allow a bent string to return to its natural 
position, which decreases the pitch. In Dorico SE, each release joins two notes: the 
pitch at the peak of the bend and the end pitch.

On notation staves, releases are notated using an angled line between the noteheads 
at the start and end. On tablature, releases are notated using a downwards-pointing 
curved line with an arrowhead at the bottom and parenthesized fret numbers below 
the arrowhead to indicate the end pitches. The fret number of the start note is hidden 
automatically.

Release on notation staff Release on tablature

Guitar bends
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If you input releases on multiple notes in chords, they are notated with a single 
downwards-pointing curved line on tablature. If the bend intervals are the same for 
all notes, the end pitches are parenthesized together.

Releases on chord on notation staff Releases on chord on tablature

NOTE

● In addition to guitar bends, Dorico SE supports guitar pre-bends/pre-dives, guitar post-
bends, vibrato bar dives and returns, and other guitar techniques.

● Because you input releases in the same way as you input guitar bends, in this 
documentation, “guitar bends” refers to both guitar bend and release items in projects.

● Stems, stem flags, and beaming always appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends.

RELATED LINKS
Bend intervals on page 900
Guitar techniques on page 904
Input methods for guitar bends and guitar techniques on page 323
Tablature on page 1048
Hiding/Showing notation staves and tablature on page 1049
Bracketed noteheads on page 849
String indicators on page 797
Lines on page 946

Guitar pre-bends and pre-dives
Guitar pre-bends and pre-dives are techniques commonly performed on electric guitars, where 
the performer changes the initial sounding pitch of strings before playing notes, either by 
bending strings to tighten them or using the vibrato bar to loosen them.

A phrase containing a guitar pre-bend with release and multiple guitar pre-dives with release

In Dorico SE, guitar pre-bends and pre-dives are properties of notes belonging to fretted 
instruments, meaning they only apply to single notes.

Guitar bends
Guitar pre-bends and pre-dives 
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Guitar pre-bends
Guitar pre-bends indicate that the performer should bend the string before playing the 
note to raise the pitch; for example, to repeat a note that was at the end of a previous 
guitar bend. The pitch can then be lowered after starting to sound.

On notation staves, guitar pre-bends are notated using an angled line between the 
noteheads at the start and end. However, unlike guitar bends, the parenthesized 
auxiliary notehead at the start is shown automatically as part of the pre-bend. On 
tablature, guitar pre-bends are notated using a solid vertical line with an arrowhead at 
the top, a bend interval above the arrowhead, and a small fret number below the line 
to indicate the start pitch.

Guitar pre-bend on notation staff Guitar pre-bend on tablature

Guitar pre-dives
Guitar pre-dives indicate that the performer should use the vibrato bar to lower the 
pitch before playing the note. The pitch can then be raised after starting to sound.

On notation staves, guitar pre-dives appear the same as guitar pre-bends. On 
tablature, guitar pre-dives are notated using a dashed vertical line with an arrowhead 
at the top, a bend interval above the arrowhead, and a small fret number below the 
line to indicate the start pitch.

Guitar pre-dive on notation staff Guitar pre-dive on tablature

NOTE

Stems, stem flags, and beaming always appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends.

RELATED LINKS
Inputting guitar pre-bends/pre-dives on page 325
Tablature on page 1048

Guitar post-bends
The guitar post-bend is a technique commonly performed on electric guitars, where the 
performer pushes strings out of their normal alignment after notes start to sound. Bending 

Guitar bends
Guitar post-bends 
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strings tightens them, which produces the characteristic pitch fluctuation. Microtonal post-bends 
are particularly idiomatic in Blues music.

In Dorico SE, guitar post-bends are properties of notes belonging to fretted instruments, 
meaning they only apply to single notes. They are notated the same on notation staves and 
tablature, using an upwards-pointing curved line with an arrowhead at the top and a bend 
interval above the arrowhead.

Guitar post-bend on notation staff Guitar post-bend on tablature

Microtonal post-bend on notation staff Microtonal post-bend on tablature

If you input guitar post-bends on multiple notes in chords, their arrowheads are automatically 
aligned. On notation staves, the appropriate number of curved lines is shown according to the 
staff positions of notes in chords.

Guitar post-bends on chord on notation staff Guitar post-bends on chord on tablature

NOTE

Guitar post-bends are not currently reflected in playback. This is planned for future versions.

RELATED LINKS
Inputting guitar post-bends on page 326

Guitar bends
Guitar post-bends 
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Vibrato bar dives and returns
The vibrato bar dive and return is a technique performed on electric guitars with a vibrato bar, 
where the performer uses the vibrato bar to loosen then tighten strings after notes start to 
sound. This produces the characteristic downwards-then-upwards pitch fluctuation.

In Dorico SE, each vibrato bar dive and return comprises two vibrato bar bend items, where the 
first vibrato bar bend ends on the same note that the second vibrato bar bend starts on. Vibrato 
bar bends each join two notes.

Vibrato bar dives and returns with bend intervals of up to a whole step (tone) are reflected in 
playback.

On notation staves, vibrato bar dives and returns are notated using an angled line between the 
noteheads at the start and end, meaning they appear the same as guitar bends. On tablature, 
vibrato bar dives and returns are notated using two straight lines that form a V and a bend 
interval shown at the point. The fret number of the middle note is hidden and the fret number of 
the end note is parenthesized automatically.

Vibrato bar dive and return on notation staff Vibrato bar dive and return on tablature

Sequences of consecutive vibrato bar bends on notes with the same pitch direction, such as 
E-D-C, are notated on tablature with an additional line protrusion beyond the staff and bend 
interval for each vibrato bar bend.

Consecutive vibrato bar bends on notation staff Consecutive vibrato bar bends on tablature

If you input vibrato bar dives and returns on multiple notes in chords, a single V appears on 
tablature as long as the bend intervals are the same for all notes.

Vibrato bar dive and return on chords on notation 
staff

Vibrato bar dive and return on chords on tablature

Guitar bends
Vibrato bar dives and returns 
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RELATED LINKS
Inputting vibrato bar dives and returns with the popover on page 328
Inputting vibrato bar dives and returns with the panel on page 329
Vibrato bar techniques on page 904
Bracketed noteheads on page 849
Tablature on page 1048

Bend intervals
Bend intervals indicate the amount guitar bends, pre-bends, pre-dives, post-dives, and dives and 
returns change the pitch, expressed in relation to whole steps using text or numbers/fractions. 
Bend intervals appear only on tablature for most types of bends, except for guitar post-bends, 
whose bend intervals also appear on notation staves.

For example, full indicates a whole step guitar bend, pre-bend, or post-bend, 1/2 a half-step, and 
1 1/2 a minor third.

Bend intervals for guitar pre-dives and vibrato bar dives and returns always appear as numbers/
fractions, such as 1 for a whole step vibrato bar dive and return.

Microtonal bend intervals appear as fractions according to the prevailing tonality system, such as 
3/4. Bend intervals for microtonal post-bends appear as 1/4.

EXAMPLE

Guitar bend with whole step 
interval, displayed as full

Guitar pre-bend with 
minor third interval, 
displayed as 1 1/2

Vibrato bar dive and return 
with whole step interval, 
displayed as -1

Guitar post-bend with 
microtonal interval, 
displayed as 1/4

Bend intervals for guitar bends, pre-bends, pre-dives, and post-dives are positioned above the 
arrowhead/line for the corresponding notation. For dives and returns, bend intervals appear at 
the point of the V, either above or below the staff according to the pitch direction of notes in the 
dive and return.

Bend intervals appear only on tablature for guitar bends, pre-bends, pre-dives, and dives and 
returns. They appear on both notation staves and tablature for guitar post-bends.

RELATED LINKS
Tablature on page 1048
Changing vibrato bar dip intervals on page 908
Input methods for guitar bends and guitar techniques on page 323

Guitar bends
Bend intervals 
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Hiding/Showing guitar bend hold lines
Guitar bend hold lines indicate that the bend should be held for the duration of the note, which is 
usually a tied note. You can hide/show hold lines on guitar bends on tablature.

NOTE

These steps only apply to guitar bends. You cannot show hold lines on pre-bends or releases.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the guitar bends on which you want to hide/show hold lines. You can do this on 
notation staves and tablature.

2. In the Properties panel, activate/deactivate Show hold in the Guitar Bends group.

RESULT
Hold lines are shown on the selected bends on tablature when Show hold is activated, and 
hidden when it is deactivated.

EXAMPLE

Hold line hidden Hold line shown

Changing the direction of guitar pre-bends/pre-dives
You can change the direction of guitar pre-bends/pre-dives individually. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains. By default, guitar 
pre-bends/pre-dives are positioned on the notehead-side of notes in single-voice contexts. In 
multiple-voice contexts, they are positioned on the stem-side of notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the guitar pre-bends/pre-dives whose direction you want to change.

Guitar bends
Hiding/Showing guitar bend hold lines 
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2. In the Properties panel, activate Pre-bend direction in the Guitar Pre-bends group.

3. Choose one of the following options:

● Up

● Down

RESULT
The direction of the selected guitar pre-bends/pre-dives is changed. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the direction of guitar bends on notation staves by selecting them and pressing 
F . However, you cannot use this key command for guitar pre-bends/pre-dives.

RELATED LINKS
Changing the staff-relative placement of items on page 400
Changing vibrato bar dip intervals on page 908
Changing the staff-relative placement of guitar techniques on page 909
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Hiding/Showing accidentals on guitar pre-bends/pre-dives
You can hide/show accidentals on guitar pre-bends/pre-dives individually; for example, to save 
horizontal space in a layout that also shows the interval clearly on tablature. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the guitar pre-bends/pre-dives whose accidentals you want to hide/show.

2. In the Properties panel, activate Pre-bend accidental in the Guitar Pre-bends group.

3. Choose one of the following options:

● Hide

● Show

RESULT
Accidentals on the selected guitar pre-bends are hidden when you choose Hide, and shown 
when you choose Show. This does not affect the interval shown for the selected guitar pre-bends 
on tablature. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Guitar bends
Hiding/Showing accidentals on guitar pre-bends/pre-dives 
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Deleting guitar pre-bends, pre-dives, and post-bends
You can remove guitar pre-bends, pre-dives, and post-bends from notes after you have input 
them. However, because guitar pre-bends, pre-dives, and post-bends are properties of notes 
rather than separate items in Dorico SE, you must select and delete them differently from other 
items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove guitar pre-bends, pre-dives, 
and/or post-bends.

2. Do one of the following:

● To remove guitar pre-bends/pre-dives, deactivate Pre-bend interval in the Guitar Pre-
bends group of the Properties panel.

● To remove guitar post-bends, deactivate Post-bend interval in the Guitar Post-bends 
group of the Properties panel.

RESULT
Guitar pre-bends, pre-dives, and/or post-bends are removed from the selected notes.

RELATED LINKS
Inputting guitar pre-bends/pre-dives on page 325
Inputting guitar post-bends on page 326

Guitar bends
Deleting guitar pre-bends, pre-dives, and post-bends 
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Guitar techniques

The term “guitar techniques” covers a range of techniques typically associated with guitar music, 
such as hammer-ons, pull-offs, and pitch alterations that use the vibrato bar on electric guitars.

RELATED LINKS
Input methods for guitar bends and guitar techniques on page 323
Guitar bends on page 894
Guitar pre-bends and pre-dives on page 896
Guitar post-bends on page 897
Vibrato bar dives and returns on page 899
Bend intervals on page 900

Vibrato bar techniques
There are a number of different techniques that can be performed using the vibrato bar on 
electric fretted instruments, typically guitars. In Dorico SE, the available vibrato bar techniques 
are categorized differently.

Vibrato bar dives
Vibrato bar dives indicate that the performer should use the vibrato bar to lower 
the pitch after playing the note, so that the pitch falls after starting to sound. This 
technique is also known as a “dive bomb”.

In Dorico SE, you can notate vibrato bar dives using jazz articulations to show falling 
lines to the right of noteheads in combination with a vibrato bar indication.

Vibrato bar scoops
Vibrato bar scoops indicate that the performer should depress the vibrato bar just 
before playing the note and then release the vibrato bar quickly, so that the pitch rises 
after starting to sound.

In Dorico SE, vibrato bar scoops are properties of notes, meaning they only apply to 
single notes. By default, vibrato bar scoops only appear on notation staves and are 
placed to the left of noteheads on the staff.

Vibrato bar dips
Vibrato bar dips indicate that the performer should use the vibrato bar to lower and 
then raise the pitch by the specified interval after playing the note.

In Dorico SE, vibrato bar dips are considered ornaments. You can select and delete 
them independently of the notes to which they apply. Vibrato bar dips appear on both 
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notation staves and tablature and are placed above the staff. You can change the 
staff-relative placement of individual vibrato bar dips.

Vibrato bar indications/lines
Vibrato bar indications are text instructions that indicate that the performer should use 
the vibrato bar. When they apply to a range of notes, they typically show dashed lines.

In Dorico SE, vibrato bar indications/lines are considered playing techniques. They 
show lines when they have duration. You can select and delete them independently of 
the notes to which they apply.

NOTE

Vibrato bar techniques are not currently reflected in playback. This is planned for future versions.

RELATED LINKS
Input methods for guitar bends and guitar techniques on page 323
Inputting guitar pre-bends/pre-dives on page 325
Guitar pre-bends and pre-dives on page 896
Vibrato bar dives and returns on page 899
Jazz articulations on page 911
Ornaments on page 867
Playing techniques on page 937
Playing technique continuation lines on page 940
Playing technique duration on page 941
Lengthening/Shortening items on page 396
Changing the staff-relative placement of items on page 400
Changing the staff-relative placement of guitar techniques on page 909

Tapping
Tapping involves performers pressing the strings of fretted instruments strongly enough that the 
corresponding pitch sounds without additional striking. Tapping indications can specify whether 
the performer should use their right or left hand for individual notes. They typically appear as the 
letter T, a plus sign, or a dot.

According to convention, tapping indications for the same hand and for consecutive notes on the 
same string with different pitches are notated alongside slurs that span the tapped phrase. This 
is similar to hammer-ons and pull-offs, except tapping indications appear on every note whereas 
hammer-on and pull-off indications typically appear centered on slurs.

Guitar techniques
Tapping 
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A phrase containing right-hand and left-hand tapping

By default, tapping indications only appear on notation staves and are placed above the staff. 
You can change the staff-relative placement of individual tapping indications.

In Dorico SE, tapping indications are considered properties of notes. There are the following 
types of tapping indications:

Right-hand tapping
Right-hand tapping indications specify that the performer should tap the string at 
the specified pitch with their right hand. In Dorico SE, right-hand tapping indications 
appear as the letter T.

Right-hand tapping on notation staff

Left-hand tapping
Left-hand tapping indications specify that the performer should tap the string at the 
specified pitch with their left hand. In Dorico SE, left-hand tapping indications appear 
as a dot.

Left-hand tapping on notation staff

RELATED LINKS
Inputting tapping on page 336
Changing the staff-relative placement of guitar techniques on page 909
Fingerings for fretted instruments on page 789

Hammer-ons and pull-offs
Hammer-ons and pull-offs involve performers tapping or plucking the strings of fretted 
instruments with their left hand strongly enough that the corresponding pitch sounds without 
additional striking, producing a legato effect. Ligados are a combination of at least one hammer-
on and one pull-off in a single phrase.

Hammer-ons and pull-offs are notated as the letters H or P, respectively, combined with a 
slur spanning the corresponding notes. Dorico SE automatically centers hammer-on/pull-off 
indications on slurs. For ligados, each hammer-on/pull-off indication is centered over the range 
of notes in the corresponding direction.

Guitar techniques
Hammer-ons and pull-offs 
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A phrase containing hammer-ons, a pull-off, and a ligado

By default, hammer-ons/pull-offs appear on both notation staves and tablature and are placed 
above the staff. You can change the staff-relative placement of individual hammer-on/pull-off 
indications.

In Dorico SE, hammer-on/pull-off indications are considered properties of notes.

Hammer-ons
Hammer-ons specify that the performer should tap the string at the specified pitch 
with their left hand without restriking the string. Hammer-ons require at least two 
notes on the same string with an ascending pitch direction, such as C-D. In Dorico SE, 
hammer-ons appear as a letter H.

Hammer-ons on notation staff

Pull-offs
Pull-offs specify that the performer should pluck the string at the specified pitch with 
their left hand without restriking the string. Pull-offs require at least two notes on 
the same string with a descending pitch direction, such as D-C. In Dorico SE, pull-offs 
appear as a letter P.

Pull-off on notation staff

Ligados
Ligados specify that the performer should both hammer on and pull off notes within a 
single phrase. Ligados require at least three notes on the same string with alternating 
pitch directions, such as C-D-C. In Dorico SE, ligados comprise at least one hammer-on 
and pull-off.

Ligado on notation staff

Guitar techniques
Hammer-ons and pull-offs 
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RELATED LINKS
Inputting hammer-ons/pull-offs on page 334
Changing the staff-relative placement of guitar techniques on page 909
Fingerings for fretted instruments on page 789

Showing notes as dead notes
You can show individual notes belonging to fretted instruments as dead notes. Dead notes are 
notated with cross noteheads on notation staves and with an X on tablature.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the notes belonging to fretted instruments that you want to show as dead notes.

2. In the Properties panel, activate Dead note in the Notes and Rests group.

RESULT
The selected notes are shown as dead notes.

NOTE

This does not currently affect their sound in playback; this is planned for future versions.

EXAMPLE

Normal notes Dead notes

RELATED LINKS
Inputting notes on tablature on page 217
Bracketed noteheads on page 849
Tablature on page 1048

Changing vibrato bar dip intervals
You can change the intervals of individual vibrato bar dips. By default, vibrato bar dips have half 
step intervals.

PREREQUISITE

● The lower zone is shown.

Guitar techniques
Showing notes as dead notes 
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● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the vibrato bar dips whose interval you want to change.

2. In the Properties panel, change the value for Interval above in the Ornaments group.

For example, enter 1 for a half step interval, 2 for a whole step interval, or 3 for a minor third 
interval.

RESULT
The interval of the selected vibrato bar dips is changed.

EXAMPLE

Vibrato bar dip with half step 
interval

Vibrato bar dip with whole step 
interval

Vibrato bar dip with minor third 
interval

RELATED LINKS
Inputting vibrato bar dips with the popover on page 332
Inputting vibrato bar dips with the panel on page 332
Changing ornament intervals on page 867
Trill intervals on page 873

Changing the staff-relative placement of guitar techniques
You can show individual tapping, hammer-on, and pull-off indications either above or below the 
staff. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose guitar technique staff-relative placement you want to change.

2. In the Properties panel, activate Technique placement in the Guitar Techniques group.

3. Choose one of the following options:

● Above

● Below

Guitar techniques
Changing the staff-relative placement of guitar techniques 

909
Dorico SE 4.3.30



RESULT
The staff-relative placement of tapping, hammer-on, and pull-off indications on the selected 
notes is changed. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

TIP

You can change the staff-relative placement of vibrato bar dips and lines by selecting them and 
pressing F .

RELATED LINKS
Changing the direction of guitar pre-bends/pre-dives on page 901
Changing the staff-relative placement of items on page 400
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Deleting guitar techniques
You can remove vibrato bar scoops and tapping, hammer-on, and pull-off indications from notes 
after you have input them. However, because these guitar techniques are properties of notes 
rather than separate items in Dorico SE, you must select and delete them differently from other 
items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove guitar techniques.

2. Remove guitar techniques in any of the following ways:

● To remove tapping, hammer-on, and pull-off indications, deactivate Technique in the 
Guitar Techniques group of the Properties panel.

● To remove guitar vibrato bar scoops, deactivate Vibrato bar scoop in the Guitar 
Techniques group of the Properties panel.

RESULT
Tapping, hammer-on, and pull-off indications and/or vibrato bar scoops are removed from the 
selected notes.

Guitar techniques
Deleting guitar techniques 
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Jazz articulations

Jazz articulations in Dorico SE cover a range of note ornamentations that are idiomatic to jazz 
music, and brass instruments in particular.

Although they are often known as jazz “articulations”, these techniques function more like 
ornaments than articulations because they change the pitch rather than the duration or attack 
of notes. For this reason, they are considered ornaments in Dorico SE. They are found in the 
Ornaments panel, and you can also input them using the ornaments popover.

Jazz articulations can be shown as a curved line similar to a slur, which is called a “bend” in 
Dorico SE, and as a straight line, which can be solid, dashed, or wiggly, which is called “smooth” 
in Dorico SE.

Each note can have a single jazz articulation on each side of it, one before the note and one after. 
Jazz articulations after notes can have different lengths.

The following jazz articulations can be shown before notes:

Plop
An approach into the note from above.

Plop (bend) Plop (smooth)

Scoop/Lift
An approach into the note from below. A bend approach is a scoop, a smooth approach 
is a lift.

Scoop Lift (straight)

The following jazz articulations can be shown after notes:

Doit
A rise in pitch after the note.

Doit (bend) Doit (smooth)

Fall
A lowering of pitch after the note.
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Fall (bend) Fall (smooth)

Additionally, there are other jazz ornaments commonly used by brass instruments that you can 
add to notes in the same ways as inputting jazz articulations.

If your sound library includes samples for jazz articulations, Dorico SE loads the required samples 
using playback techniques.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Playback techniques on page 649
Glissando lines on page 889
Arpeggio signs on page 883
Fingering slides on page 792
Lines on page 946

Jazz ornaments
Jazz ornaments are notations that are commonly used in jazz music and by brass instruments, 
such as flips and smears, that are positioned outside of the staff rather than beside noteheads 
like jazz articulations.

Jazz ornaments behave more like other ornaments than jazz articulations, in that they are items 
separate from notes, and so can be selected independently of notes in Write mode and added 
to notes in addition to jazz articulations. Because they are so commonly used alongside jazz 
articulations, in Dorico SE they are also included in the Jazz section of the Ornaments panel.

You can input jazz ornaments in the same ways as inputting other ornaments rather than jazz 
articulations.

The following ornaments are considered jazz ornaments in Dorico SE:

Flip

Smear

Jazz turn/Shake

Bend

NOTE

Jazz articulations are not currently reflected in playback.

RELATED LINKS
Ornaments on page 867
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310

Jazz articulations
Jazz ornaments 
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Positions of jazz articulations
In Dorico SE, jazz articulations are automatically positioned relative to the noteheads to which 
they apply, with any other notations on those notes, such as rhythm dots, accidentals, and back 
notes, automatically considered.

When multiple notes in a chord have a jazz articulation, Dorico SE considers the best way to 
align them based on how close to the noteheads they can be positioned and how many jazz 
articulations to show in total. Dorico SE allows a maximum of one jazz articulation per space, 
meaning fewer jazz articulations than noteheads are sometimes shown on cluster chords.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 310
Deleting jazz articulations on page 914

Changing the type/length of existing jazz articulations
You can change the type and length of jazz articulations after you have input them; for example, 
if you want to change a smooth doit to a long bend doit. You can specify the type/length of jazz 
articulations when using the Ornaments panel but not when using the ornaments popover.

PROCEDURE

1. In Write mode, select the notes whose jazz articulation you want to change.

2. In the Ornaments panel, click the jazz articulation you want in the Jazz section.

RESULT
The jazz articulation shown on the selected notes is changed.

TIP

You can also change the type/duration of jazz articulations using the In and Out properties in the 
Jazz Articulations group of the Properties panel.

EXAMPLE

Short bend doit Medium bend doit Long bend doit

Changing the line style of smooth jazz articulations
You can change the line style of smooth jazz articulations individually. For example, if you want 
selected smooth falls to have straight lines instead of wavy lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Jazz articulations
Positions of jazz articulations 
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PROCEDURE

1. Select the notes with smooth jazz articulations whose line style you want to change.

NOTE

You must select notes with smooth jazz articulations on the same side; for example, only 
select notes with smooth jazz articulations before them.

2. In the Properties panel, select one of the following line styles from the In line style menu 
and/or Out line style menu in the Jazz Articulations group:

● Straight

● Wavy

● Dashed

NOTE

In line style is available when you select notes with smooth jazz articulations before them, 
and Out line style is available when you select notes with smooth jazz articulations after 
them. Both are available when you select notes with smooth jazz articulations on both sides.

RESULT
The line style of the selected smooth jazz articulations is changed.

TIP

You can reset jazz articulations back to their default line style by selecting them and choosing 
Edit > Reset Appearance.

EXAMPLE

Doit smooth with straight line Doit smooth with wavy line Doit smooth with dashed line

Deleting jazz articulations
You can remove jazz articulations from notes after you have input them. However, because jazz 
articulations are properties of notes rather than separate items in Dorico SE, you must select and 
delete them differently from other items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove jazz articulations.

2. In the Ornaments panel, click Remove in the Jazz section.

RESULT
All jazz articulations are removed from the selected notes.

Jazz articulations
Deleting jazz articulations 
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Page numbers

Page numbers are used to give each page a unique number, and indicate its position relative to 
other pages. Just as in newspapers and books, musical scores and parts use page numbers to 
make sure the music stays in the correct order.

Because you can have multiple flows in a single project in Dorico SE, you do not need to change 
page numbers manually in most cases. However, if you have separate files that together make 
up a single piece, page number changes are necessary to make sure the page numbers continue 
seamlessly from movement to movement.

In such cases, you can change the default page numbers. For example, if you want to have four 
pages of front matter before the first page of music in the score, but you want the first page of 
music in the score to be shown as page 1, you can insert a page number change on the first page 
of music.

Page numbers are layout-specific in Dorico SE, meaning you can change the page numbers in 
each layout independently. For example, you can change the page numbers in the score but 
show the default page numbers in the parts.

Page numbers in Dorico SE use a token to ensure the number is correct.

NOTE

You must have a text frame containing the page number token on every page on which you want 
page numbers to be shown.

Default page templates contain text frames with page number tokens. You can change the 
position of page number text frames in the page template editor, which changes the position of 
page numbers on all pages that use that page template. You can also move page number text 
frames on individual pages.

You can also change the type of number used to show page numbers in each layout. For 
example, if you want the front matter to use Roman numerals but the music pages to use Arabic 
numerals, you can change the type of number together with the page number.

RELATED LINKS
Page templates on page 547
Types of page templates on page 549
Tokens on page 552

Changing the page number numeral style
Page numbers can appear as Arabic or Roman numerals. You can change the numeral style of 
page numbers in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose page number numeral style you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Numbers section, select one of the following options from the Use menu:

● Number

● Roman numeral

5. Click Apply, then Close.

RESULT
The page number numeral style is changed in the selected layouts.

Hiding/Showing page numbers
You can hide/show page numbers in each layout independently, including specifying whether to 
hide/show a page number on the first page. For example, you can show page numbers on every 
page in the score but hide page numbers on the first page in the parts.

NOTE

To show page numbers, there must be a text frame containing the page number token on the 
page. The First page templates in the default page template sets do not contain text frames 
containing page number tokens, so you must add these if you want to show page numbers on 
pages that use these page templates.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show page numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Numbers section, select one of the following options from the Visibility menu:

● Always shown

● Always hidden

● Not on first page

5. Click Apply, then Close.

RESULT

● If you select Always shown, page numbers are shown on all pages that have a text frame 
containing the page number token in the selected layouts.

● If you select Always hidden, page numbers are hidden on all pages in the selected layouts, 
including on pages that have a text frame containing the page number token.

● If you select Not on first page, page numbers are hidden on the first page in the selected 
layouts, but shown on all other pages that have a text frame containing the page number 
token.

Page numbers
Hiding/Showing page numbers 
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NOTE

Your per-layout setting for whether page numbers are hidden/shown above flow headings 
affects whether page numbers are shown on pages where they are higher on the page than 
flow headings.

RELATED LINKS
Tokens on page 552
Flow headings on page 550
Hiding/Showing information in running headers above flow headings on page 521

Page numbers
Hiding/Showing page numbers 
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Harp pedaling

Harp pedaling is a broad term that covers the specific requirements for notating music for harps. 
This primarily involves harp pedal diagrams, which are often necessary due to the way in which 
modern concert harps change their tuning.

A passage with a full harp pedal diagram at the start and two subsequent partial pedal changes

Harps have seven strings in each octave, one for each diatonic pitch C-B, unlike pianos, which 
have twelve keys in each octave, one for each half-step (semitone) degree between C-B. 
Therefore, harps have a mechanical action to change their tuning that includes seven pedals, 
with each pedal controlling the pitch of the corresponding note in all octaves. These pedals are 
organized into two groups, one for each foot: three pedals for the left foot and four pedals for 
the right foot.

Each harp pedal has three possible positions:

1. Flat or highest position: lowers the pitch of the corresponding note by a half-step

2. Natural or middle position

3. Sharp or lowest position: raises the pitch of the corresponding note by a half-step

NOTE

The lowest two harp strings, C and D, are not affected by the C and D pedal positions.

There are different ways to notate the pedal settings required for a piece of music or a passage 
within a piece. In Dorico SE, you can show harp pedaling in the following ways:

Diagram

Indicates the physical positions of the seven pedals. The vertical line represents the 
split between left-foot and right-foot pedals and the horizontal line represents the 
natural position.

● Pedals below the horizontal line indicate sharpened notes.

● Pedals above the horizontal line indicate flattened notes.
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Note Names

Indicates the required accidentals for the seven diatonic pitches, arranged in two lines. 
Right-foot pedals are shown on top and left-foot pedals are shown below.

Any pitches that you input that do not fit with the current harp pedal diagram are considered out 
of range, and appear red when colors are shown for notes that are out of range. If you do not 
input any harp pedaling, Dorico SE assumes all harp pedals are in their natural setting, as they 
would be for C major.

In Dorico SE, you can input harp pedal diagrams using the playing techniques popover and 
you can automatically generate accurate harp pedal diagrams based on an entire flow or a 
specific passage of music. However, you can only input and show harp pedal diagrams on staves 
belonging to harp instruments; if you copy material from harp staves to other instruments, harp 
pedaling is automatically removed.

By default, harp pedaling is hidden in full score/custom score layouts and shown in part layouts. 
In layouts where harp pedaling is hidden, harp pedal diagrams are indicated by signposts. 
You can hide/show harp pedaling in each layout independently and hide individual harp pedal 
diagrams in layouts where harp pedaling is shown. You can also determine when to show partial 
harp pedaling, such as when only a single pedal must be changed at one time.

Harp pedal diagrams in Dorico SE affect the pitches played back in glissando lines.

RELATED LINKS
Partial harp pedaling on page 923
Inputting harp pedal diagrams on page 348
Hiding/Showing harp pedaling in layouts on page 920
Calculating harp pedal diagrams based on existing music on page 349
Hiding/Showing colors for notes out of range on page 847
Glissando lines in playback on page 892

Changing the appearance of harp pedal diagrams
Harp pedaling can be shown as a diagram or using note names. You can change the appearance 
of harp pedal diagrams individually. You can do this for the current layout and frame chain only, 
or for all layouts and frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the harp pedal diagrams whose appearance you want to change.

2. In the Properties panel, activate Appearance in the Harp Pedals group.

3. Choose one of the following options:

● Diagram

Harp pedaling
Changing the appearance of harp pedal diagrams 
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● Note Names

RESULT
The appearance of the selected harp pedal diagrams is changed in the current layout. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

TIP

You can change the default appearance of harp pedaling in each layout independently in the 
Harp Pedaling section of the Players page in Layout Options.

EXAMPLE

Harp pedaling shown as a diagram

Harp pedaling shown using note names

RELATED LINKS
Layout Options dialog on page 622
Partial harp pedaling on page 923
Inputting harp pedal diagrams on page 348
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Hiding/Showing harp pedaling in layouts
You can input and calculate harp pedaling in any layout, but by default harp pedaling is not 
shown in full score layouts, as they are usually only useful for the performer. You can hide/show 
harp pedaling in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show harp pedaling.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Harp Pedaling section, activate/deactivate Show harp pedaling.

5. Click Apply, then Close.

RESULT
Harp pedaling is shown in the selected layouts when the checkbox is activated, and hidden when 
the checkbox is deactivated.

In layouts where harp pedaling is hidden, harp pedal diagrams are indicated by signposts.

Harp pedaling
Hiding/Showing harp pedaling in layouts 

920
Dorico SE 4.3.30



NOTE

● You can hide individual harp pedal diagrams in layouts where harp pedaling is shown, but 
you cannot show individual harp pedal diagrams in layouts where harp pedaling is hidden.

● You can hide/show harp pedaling signposts by choosing View > Signposts > Harp Pedals.

Hiding/Showing harp pedal diagrams individually
You can hide/show individual harp pedal diagrams in layouts in which harp pedaling is shown. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In the music area, open the layout in which you want to hide/show individual harp pedal 
diagrams.

2. Select the harp pedal diagrams you want to hide, or the signposts of harp pedal diagrams 
you want to show.

3. In the Properties panel, activate/deactivate Hide in the Harp Pedals group.

RESULT
The selected harp pedal diagrams are hidden when Hide is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden harp pedal diagram. However, signposts are 
not printed by default.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Signposts on page 407
Annotations on page 507

Hiding/Showing borders on harp pedal diagrams
You can hide/show borders on individual note name harp pedal diagrams. For example, on 
systems with very tight vertical spacing, hiding borders on harp pedal diagrams can give you a 
little extra space.

NOTE

These steps only apply to harp pedal diagrams using note names.

Harp pedaling
Hiding/Showing borders on harp pedal diagrams 
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PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the note name harp pedal diagrams on which you want to hide/show borders.

2. In the Properties panel, activate Border in the Harp Pedals group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Borders are shown on the selected note name harp pedal diagrams when the checkbox is 
activated, and hidden when the checkbox is deactivated.

EXAMPLE

Note name harp pedal diagram with border hidden Note name harp pedal diagram with border shown

Positions of harp pedal diagrams
By default, harp pedal diagrams are centered vertically between the two staves usually shown for 
harps.

You can move harp pedal diagrams to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

RELATED LINKS
Moving notes/items rhythmically on page 417

Harp pedaling
Positions of harp pedal diagrams 
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Partial harp pedaling
Partial harp pedal diagrams only show the notes whose pedal setting must change at that 
position, rather than showing the required settings for all pedals. This can make those changes 
immediately clear to the performer, as they have fewer pedals to read.

Partial pedal diagrams for a sequence containing several quick pedal changes

You can allow partial harp pedaling for individual harp pedal diagrams and you can set a 
maximum threshold of pedal changes at a single position, above which all harp pedal diagrams 
must show all pedals. This is because performers are used to the pattern of note names in 
complete harp pedal diagrams, and if there are many changes in a partial harp pedal diagram, 
this can be harder to read than a complete one.

By default, Dorico SE shows notes in partial harp pedal diagrams on two lines with right-foot 
pedals on top and left-foot pedals below.

NOTE

Only harp pedal diagrams using note names can be shown as partial.

Allowing/Disallowing partial harp pedaling
You can allow/disallow partial harp pedaling for individual note name harp pedal diagrams. The 
default setting in Dorico SE is to allow partial harp pedaling for up to three pedal changes. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

● These steps only apply to harp pedal diagrams using note names.

● Harp pedal diagrams positioned at the very beginning of a flow can only appear as full harp 
pedal diagrams.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the note name harp pedal diagrams for which you want to allow/disallow partial harp 
pedaling.

2. In the Properties panel, activate Partial pedaling in the Harp Pedals group.

Harp pedaling
Partial harp pedaling 
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3. Activate/Deactivate the corresponding checkbox.

RESULT
Partial harp pedaling is allowed for the selected note name harp pedal diagrams when the 
checkbox is activated, and disallowed when the checkbox is deactivated. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Harp pedal diagram showing all pedals Partial harp pedal diagram

RELATED LINKS
Hiding/Showing harp pedaling in layouts on page 920
Inputting harp pedal diagrams on page 348
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Harp pedaling
Partial harp pedaling 
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Pedal lines

Pedal lines indicate to performers which piano pedals to use, and can also give performance 
instructions, such as how far down to depress the pedals and when to lift the pedal to clear the 
resonance.

Most pianos have either two or three pedals. These pedals are:

Sustain pedal
The sustain pedal controls the dampers on the piano strings, which is why it is also 
known as the “damper pedal”. It is also the most commonly used pedal. Depressing the 
sustain pedal removes the dampers, allowing the strings to resonate longer. Sustain 
pedals are usually on the right.

Sostenuto pedal
The sostenuto pedal only allows the strings of the notes currently depressed on the 
keyboard to resonate. It is also known as the “middle pedal” as it is usually in the 
middle of the other pedals.

Una corda pedal
The una corda pedal shifts the action inside the piano so that the hammers hit fewer 
strings than normal. Historically, this caused hammers only to hit one string, not the 
usual three, which is where the name comes from. Because this reduces the volume 
and impact of the sound, it is also known as the “soft pedal”.
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Dorico SE offers comprehensive notational and playback support for piano pedal lines. You 
can create pedaling for the sustain, sostenuto, and una corda pedals, with support for modern 
sustain pedaling techniques, including changing the pedal level over the course of a single pedal 
instruction.

You can change the appearance of pedal lines, including changing their start sign and 
continuation type. For example, if you want to show some pedal lines with a continuation line 
and some only with a sign at the end.

In Dorico SE, pedal lines are considered playing techniques because they alter the sound 
produced by the instrument. Therefore, pedal lines are included in the Playing Techniques panel 
in Write mode and you can input them using the playing techniques popover. However, pedal 
lines have additional, unique requirements that do not apply to other playing techniques, such as 
retakes, pedal level changes, start signs, end signs, and continuation lines.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Pedal line start signs, hooks, and continuation lines on page 930
Text pedal line signs on page 934
Pedal lines in playback on page 936
Playing technique continuation lines on page 940
Lines on page 946

Sustain pedal retakes and pedal level changes
Pedal retakes indicate where a player should lift the sustain pedal, which dampens the piano’s 
strings and clears the resonance, before depressing the pedal again. Pedal level changes indicate 
a change to how far the pedal is depressed.

Dorico SE provides clear representations of pedal retakes and level changes for pedal lines with 
the line continuation type.

NOTE

● In Dorico SE, you cannot input pedal level changes. However, pedal level changes are shown 
if you import or open a project that contains them, and you can remove them in the same 
way as removing retakes.

● You can only add pedal retakes to sustain pedal lines.

EXAMPLE

1 Ped. glyph

2 Retake

3 One quarter depressed

4 Half depressed

5 Three quarters depressed

6 Fully depressed

Pedal lines
Sustain pedal retakes and pedal level changes 
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7 Line end hook

RELATED LINKS
Changing the pedal line continuation type on page 933
Positions of pedal lines on page 927
Removing retakes and pedal level changes on page 927
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337

Removing retakes and pedal level changes
You can remove pedal retakes and level changes without deleting the sustain pedal line or 
changing its rhythmic position.

PROCEDURE

1. In Write mode, select an item on each staff and at each rhythmic position where you want to 
remove retakes or pedal level changes.

2. Remove the retakes or pedal level changes in any of the following ways:

● Open the playing techniques popover, enter nonotch into the popover, then press 
Return .

NOTE

nonotch must be spelled as one word, without a space.

● Choose Edit > Notations > Pedal Lines > Remove Retake. You can also choose this 
option from the context menu.

RESULT
The retakes or pedal level changes at each selected rhythmic position on each selected staff are 
removed. The corresponding sustain pedal lines return to their previous levels as set by either 
the start of the pedal line, or the retake or pedal level change immediately preceding the ones 
you removed.

RELATED LINKS
Playing techniques popover on page 337
Adding retakes with the popover on page 345
Adding retakes with the panel on page 347

Positions of pedal lines
The default placement of pedal lines is below the bottom staff, even if there are only notes in the 
upper staff for the right hand. They are placed outside all other notations, including octave lines, 
slurs, and articulations.

If one pedal is used, it is placed as close to the bottom of the staff as possible, while remaining 
outside of all other notations.

If multiple pedals are used simultaneously, they are organized below the bottom of the staff as 
follows:

1. Sustain pedal: closest to the staff

2. Sostenuto pedal: below the sustain pedal line

Pedal lines
Positions of pedal lines 
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3. Una corda pedal: furthest from the staff

The beginning of the glyph/text that indicates the start position of pedal lines aligns with the 
note to which it applies. If you are using a line end hook to indicate the end of pedal lines, the 
hook aligns with the note or rhythmic position to which it applies.

You can move pedal lines to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

NOTE

You cannot move retakes rhythmically. You must remove them and input a new retake at the 
position you want.

RELATED LINKS
Text pedal line signs on page 934
Pedal line start signs, hooks, and continuation lines on page 930
Sustain pedal retakes and pedal level changes on page 926
Moving notes/items rhythmically on page 417
Lengthening/Shortening items on page 396
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337

Changing the position of pedal lines relative to grace notes
You can change the start/end positions of individual pedal lines relative to grace notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the pedal lines whose position relative to grace notes you want to change.

2. In the Properties panel, activate any of the following properties in the Pedal Lines group:

● Starts before grace notes

● Ends before grace notes

3. Activate/Deactivate the corresponding checkboxes.

RESULT
When the checkboxes are activated, the corresponding parts of the selected pedal lines are 
positioned before grace notes.

When the checkboxes are deactivated, the corresponding parts of the selected pedal lines are 
positioned after grace notes.

Pedal lines
Positions of pedal lines 
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EXAMPLE

Pedal line starting/ending before grace notes Pedal line starting/ending after grace notes

Splitting pedal lines
You can split sustain pedal lines at any rhythmic position with an existing item along their length 
into two separate pedal lines.

NOTE

These steps only apply to sustain pedal lines.

PROCEDURE

1. Select an item on the staff and at the rhythmic position where you want to split the sustain 
pedal line.

NOTE

You can only split one pedal line at a time.

2. Choose Edit > Notations > Pedal Lines > Split Pedal Line. You can also choose this option 
from the context menu.

RESULT
The pedal line on the selected staff is split at the selected rhythmic position.

EXAMPLE

A single pedal line The pedal line after being split into two

AFTER COMPLETING THIS TASK
You can move, lengthen/shorten, and edit both pedal lines independently.

Pedal lines
Splitting pedal lines 
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RELATED LINKS
Moving notes/items rhythmically on page 417
Selecting/Deselecting notes and items individually on page 387
Pedal line start signs, hooks, and continuation lines on page 930
Changing the pedal line continuation type on page 933
Text pedal line signs on page 934
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337

Merging pedal lines
You can merge existing sustain pedal lines together; for example, if you want to fill in a gap 
between two sustain pedal lines.

NOTE

These steps only apply to sustain pedal lines.

PROCEDURE

1. Select the sustain pedal lines on the same staff that you want to merge together.

NOTE

You can only merge pedal lines on one staff at a time.

2. Choose Edit > Notations > Pedal Lines > Merge Pedal Lines. You can also choose this 
option from the context menu.

RESULT
The selected pedal lines are merged together into a single pedal line. If there were gaps between 
them, a continuation line is automatically shown across them.

AFTER COMPLETING THIS TASK
You can input retakes and pedal level changes; for example, if you want to show a retake at the 
position where previously one of the pedal lines started.

Pedal line start signs, hooks, and continuation lines
Pedal lines normally comprise a start sign, a continuation line, and an end hook. This indicates 
clearly to performers where to depress each type of pedal, how long to keep it depressed, and 
where to lift it.

1 Start sign

2 Continuation line

3 End hook

In Dorico SE, you can change the appearance of each part of pedal lines individually; for example, 
if you want the start sign of an individual pedal line to show text instead of a glyph.

Pedal lines
Pedal line start signs, hooks, and continuation lines 
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You can select whole pedal lines in Write mode and change most aspects of their appearance 
according to the type of pedal line, such as their continuation line or start sign.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337

Changing the start sign appearance of pedal lines
You can change the appearance of the start of pedal lines individually. Pedal line start signs can 
be shown as variations of the traditional pedal line glyph, other symbols, or text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the pedal lines whose start sign appearance you want to change.

NOTE

The pedal lines you select must be the same type; for example, only sustain pedal lines.

2. In the Properties panel, activate Sign appearance in the Pedal Lines group.

3. Select one of the options from the menu.

The options are different according to the type of pedal line selected.

RESULT
The start sign appearance of the selected pedal lines is changed.

TIP

● The end signs of una corda pedal lines automatically match their start signs.

● Deactivating Sign appearance returns the selected pedal lines to your default setting for 
start sign appearance.

EXAMPLE

Sustain 
pedal lines

Ped. Glyph Ped Glyph P Glyph Symbol Ped. Text Hook

Sostenuto 
pedal lines

Sost. Glyph S Glyph Symbol Sost. text Sostenuto 
text

Pedal lines
Pedal line start signs, hooks, and continuation lines 
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Una corda 
pedal lines

Symbol u. c. una corda

AFTER COMPLETING THIS TASK
If you selected a text sign appearance, you can edit the text shown.

RELATED LINKS
Editing pedal line start text on page 934

Changing the type of hook at the start/end of pedal lines
You can change the type of hook shown at the start/end of pedal lines individually.

NOTE

You can only change the start hook type of pedal lines that have a hook as their start sign, and 
you can only change the end hook type of pedal lines that have a continuation line.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the pedal lines whose hook type you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Pedal Lines group:

● Line start hook

● Line end hook

3. Select one of the following options from each menu:

● No Hook

● Vertical Hook

● Slant Hook

● Inverse Hook

RESULT
The hook type at the start/end of the selected pedal lines is changed.

EXAMPLE

No Hook line end Vertical Hook line end Slant Hook line end Inverse Hook line end

Pedal lines
Pedal line start signs, hooks, and continuation lines 
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Changing the pedal line continuation type
You can change the continuation type used for individual pedal lines. For example, if you want 
some pedal lines to show a dashed line and a sign at the end, but others to show a line and end 
hook.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the pedal lines whose continuation type you want to change.

2. In the Properties panel, activate Continuation type in the Pedal Lines group.

3. Select one of the following continuation types from the menu:

● Line

● Sign at End

● Sign at End and Dashed Line

● None

RESULT
The continuation type of the selected pedal lines is changed.

EXAMPLE

Line Sign at End Sign at End and Dashed Line None

RELATED LINKS
Properties panel on page 560
Sustain pedal retakes and pedal level changes on page 926
Inputting pedal lines with the popover on page 344
Editing una corda pedal line restorative text on page 936

Parenthesizing pedal line continuation signs
You can show individual pedal line continuation signs with/without parentheses. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains. 

Pedal line continuation signs are shown by default at the start of new systems when pedal lines 
continue across system/frame breaks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

Pedal lines
Pedal line start signs, hooks, and continuation lines 
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PROCEDURE

1. Select the pedal lines whose continuation sign appearance you want to change.

2. In the Properties panel, activate Show continuation sign in parentheses in the Pedal Lines 
group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Continuation signs are shown with parentheses when the checkbox is activated, and without 
parentheses when the checkbox is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

Text pedal line signs
All types of pedal lines can have text as their start signs, instead of glyphs or hooks. You can 
override the text shown at the start of pedal lines that have text start signs, you can change the 
continuation text shown at the start of new systems, and you can override the restorative text 
shown at the end of una corda pedal lines.

Pedal lines that use a text indication rather than a symbol

For pedal lines such as una corda or sustain that have text for their start sign, such as Ped. Text, 
rather than the more ornate symbol, you can override the text shown at the start of the pedal 
line and replace it with your preferred performance direction.

Continuation sign/text

When pedal lines continue onto subsequent systems, a continuation sign/text is shown in 
parentheses by default. If the pedal line is using text for their start sign, such as Ped. Text, 
rather than a symbol, you can change the text shown at the start of a new system and replace it 
with your preferred performance direction.

Una corda pedal lines

The equivalent to the final pedal lift for the una corda pedal marking is the indication to return to 
tre corde. You can override the tre corde text shown at the end of the pedal line and replace it with 
your preferred performance direction.

RELATED LINKS
Changing the start sign appearance of pedal lines on page 931
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337

Editing pedal line start text
You can change the text shown at the start of individual pedal lines that use text as their start 
sign.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Pedal lines
Text pedal line signs 
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PROCEDURE

1. Select the pedal lines whose start text you want to edit.

2. In the Properties panel, activate Text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown at the start of the selected pedal lines is changed.

Deactivating Text restores the default start text for the selected pedal lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

Editing pedal line continuation text
You can change the text shown at the start of subsequent systems when pedal lines continue 
across system/frame breaks.

NOTE

These steps only apply to pedal lines that use text as their start sign.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the pedal lines whose continuation text you want to edit.

2. In the Properties panel, activate Continuation text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The continuation text shown at the start of subsequent systems for the selected pedal lines is 
changed.

Deactivating Continuation text restores the default continuation text for the selected pedal 
lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

Pedal lines
Text pedal line signs 
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Editing una corda pedal line restorative text
The equivalent to the final pedal lift for una corda pedal lines is the indication to return to tre 
corde. You can change the tre corde text shown at the end of individual una corda pedal lines.

NOTE

These steps only apply to una corda pedal lines that use text as their start sign.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the una corda pedal lines whose restorative text you want to edit.

2. In the Properties panel, activate Restorative text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The restorative text shown at the ends of the selected una corda pedal lines is changed.

Deactivating Restorative text restores the default restorative text for the selected pedal lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

Pedal lines in playback
Pedal lines are automatically played back in Dorico SE.

The three piano pedals send MIDI controllers as follows:

● Sustain pedal lines send MIDI controller 64 (Sustain).

● Sostenuto pedal lines send MIDI controller 66 (Sostenuto).

● Una corda pedal lines send MIDI controller 67 (Soft Pedal).

Some piano VST instruments, such as Pianoteq and Garritan CFX Concert Grand, support 
partial depression of the sustain pedal. Consult the manufacturer’s documentation for more 
information.

RELATED LINKS
MIDI CC editor on page 596

Pedal lines imported from MusicXML files
Sustain pedal lines can be imported from MusicXML files. MusicXML can only describe the sustain 
pedal, and it cannot describe changes in pedal depression level.

Pedal lines
Pedal lines in playback 
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Playing techniques

The term “playing techniques” covers a wide range of instructions intended to tell performers to 
modify the sound of the notes they are playing; for example, by changing their embouchure or 
changing the position of their bow, or by modifying their instrument, such as adding a mute or 
depressing a pedal.

In Dorico SE, there are the following types of playing techniques:

Glyph playing techniques
Playing techniques that display symbols, such as up bow  or down bow  markings.

Text playing techniques
Playing techniques that display text, such as pizz. or con sordino.

You can find all available playing techniques in the Playing Techniques panel in Write mode, 
organized by instrument family. For example, you can find pedal lines in the Keyboard section of 
the Playing Techniques panel.

NOTE

Because pedal lines have additional, unique requirements that do not apply to other playing 
techniques, such as retakes, start signs, and continuation lines, they are documented separately. 
Pedal lines also have their own group of the Properties panel that is separate from the Playing 
Techniques group.

Musical phrase with glyph and text playing techniques, including grouped text playing techniques with a 
continuation line

Playing techniques can change how instruments play back. For example, inputting a pizz. playing 
technique on a violin staff activates a key switch that changes the sound produced by the VST 
instrument. Dorico SE uses playback techniques to produce the required sounds in playback 
for the playing techniques you input, provided your sound library includes the corresponding 
samples.

Many playing techniques that only appear once in the music nonetheless imply that the playing 
technique continues. For example, pizzicato usually appears once but applies until the next 
playing technique, such as arco. In Dorico SE, you can show continuation lines after and between 
playing techniques to convey clearly to performers the notes to which you want them to apply. 
You can also group multiple playing techniques together.

Playing technique texts use a plain font, neither bold nor italic, so they are not confused with 
dynamics and expressive text.

NOTE

Pedal lines use a separate font style to other playing techniques.
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RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Playback techniques on page 649
Pedal lines on page 925
String indicators on page 797
Playing technique continuation lines on page 940
Groups of playing techniques on page 943
Positions of playing techniques on page 939

Adding text to playing techniques
You can add text to playing techniques after they have been input; for example, to clarify the 
intention of the playing technique. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

NOTE

These steps do not apply to pedal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the playing techniques to which you want to add text.

2. In the Properties panel, activate Suffix in the Playing Techniques group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered is added to the selected playing techniques and appears after them. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

EXAMPLE

Playing techniques without suffixes Suffixes added to playing techniques

RELATED LINKS
Text pedal line signs on page 934
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Playing techniques
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Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337

Hiding/Showing playing techniques
You can hide/show playing techniques individually; for example, if your expression map requires 
you to input a playing technique to trigger the correct playback but you do not want that 
technique to appear in the music.You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the playing techniques you want to hide, or the signposts of playing techniques you 
want to show.

2. In the Properties panel, activate/deactivate Hidden in the Playing Techniques group.

RESULT
The selected playing techniques are hidden when Hidden is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden playing technique. However, signposts are 
not printed by default.

TIP

● You can hide/show playing technique signposts by choosing View > Signposts > Playing 
Techniques.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Expression maps on page 625
Signposts on page 407
Hiding/Showing zones on page 41
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Key Commands page in the Preferences dialog on page 54
Annotations on page 507

Positions of playing techniques
Playing techniques, both as text and symbols, are placed above the staff by default. On vocal 
staves, they are placed above the staff and below dynamics. In multiple-voice contexts, playing 

Playing techniques
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techniques for the up-stem voices are placed above the staff and playing techniques for the 
down-stem voices are automatically placed below the staff.

Glyph playing techniques are center-aligned on noteheads. Text playing techniques are left-
aligned with noteheads.

Placement of playing techniques with two voices on the same staff

You can move playing techniques to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

RELATED LINKS
Playing techniques on page 937
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Text pedal line signs on page 934
Playing technique continuation lines on page 940
Groups of playing techniques on page 943
Moving notes/items rhythmically on page 417
Changing the staff-relative placement of items on page 400

Playing technique continuation lines
Playing technique continuation lines convey exactly the notes to which playing techniques apply, 
and can also indicate a gradual transition between playing techniques.

A phrase with multiple playing technique continuation lines

In Dorico SE, there are the following types of playing technique continuation lines:

Duration line

Indicates a specific duration to which the playing technique applies. The duration line 
for most playing techniques is a solid line with a hook cap at the end.

Playing techniques show duration lines when the following conditions are met:

● The playing technique has duration.

● The continuation type for the playing technique is set to show lines.

● The playing technique is ungrouped or is the final playing technique in a group.

Playing techniques
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Transition line

Indicates that the playing technique at the start must gradually turn into the playing 
technique at the end over the duration specified by the line. The transition line for 
most playing techniques is a solid line with an arrow cap at the end.

Transition lines are automatically shown between playing techniques in groups.

NOTE

Playing technique continuation lines do not affect playback. The sounds produced in playback 
rely on the playback technique associated with the playing technique, the expression map 
settings, and the sound libraries loaded in the project.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Positions of playing techniques on page 939
Groups of playing techniques on page 943
Lengthening/Shortening items on page 396
Lines on page 946
Line components on page 948

Playing technique duration
In Dorico SE, playing techniques have an explicit duration when they apply to a specific range, 
rather than from a single rhythmic position onwards. Playing techniques with duration only 
affect playback within their duration and can show continuation lines.

In Write mode, playing techniques with duration have start and end handles that show their 
duration.

Start and end handles on a playing technique with duration

You can give duration to any playing technique in any of the following ways:

● Group playing techniques together

● Input playing techniques with an open end during note input and extend them

● Add playing techniques to a range of notes

● Lengthen playing techniques

Playing techniques
Playing technique continuation lines 
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String indicator (selected) with no duration String indicator (selected) with duration and duration 
line

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Lengthening/Shortening items on page 396
Hiding/Showing playing technique duration lines on page 942
Grouping playing techniques together on page 944
Vibrato bar techniques on page 904
String indicators on page 797

Hiding/Showing playing technique duration lines
You can hide/show duration lines for individual playing techniques. When hiding duration lines, 
you can show nothing or sim.. When showing duration lines, you can show a line or repeat the 
signs of glyph playing techniques. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

NOTE

These steps only apply to playing technique duration lines. They do not apply to playing 
technique transition lines.

PREREQUISITE

● The playing techniques whose duration lines you want to hide/show have duration.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Write mode, select the playing techniques whose duration lines you want to hide/show.

2. In the Properties panel, activate Continuation type in the Playing Techniques group.

3. Select one of the following options from the menu:

● None

● sim.

● Line

● Repeat the signs (glyph playing techniques only)

RESULT
Duration lines are hidden after the selected playing techniques when you select None. When 
you select sim., duration lines are hidden and sim. is shown once after each selected playing 
technique.

Duration lines are shown after the selected playing techniques when you select Line.

Playing techniques
Playing technique continuation lines 
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For glyph playing techniques, the playing technique is repeated for each note within the duration 
automatically when you select Repeat the signs.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

EXAMPLE

Duration line shown Duration line hidden Duration line hidden but 
sim. shown

Signs repeated on each 
note

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Groups of playing techniques
Groups of playing techniques are automatically aligned in a row and can be moved and edited 
as a group. When you move individual playing techniques within a group, the lengths of any 
continuation lines on either side automatically adjust to compensate.

A group of playing techniques The same group of playing techniques with adjusted 
transition lines after the middle playing technique 
moved rhythmically

Two or more playing techniques are automatically grouped together if they are adjoining with 
duration between them and were added to existing music together or input in sequence during 
note input.

Transition lines are automatically shown between playing techniques in groups. The final playing 
technique in playing technique groups can show a duration line if it has duration.

All of the playing techniques in a group are highlighted when any of the playing techniques in 
the group are selected.

NOTE

● You cannot group a playing technique group to another playing technique group, you can 
only group single playing techniques together or single playing techniques to an existing 
group.

Playing techniques
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● Groups of playing techniques apply project-wide, meaning you cannot have playing 
techniques grouped one way in some layouts but differently in other layouts.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Playing technique continuation lines on page 940
Playing technique duration on page 941
Lengthening/Shortening items on page 396
Moving notes/items rhythmically on page 417

Grouping playing techniques together
You can manually group playing techniques together that were not automatically grouped when 
they were input. Grouped playing techniques are automatically aligned in a row, show transition 
lines between them, and can be moved and edited as a group.

NOTE

You cannot group a playing technique group to another playing technique group, you can only 
group single playing techniques together or single playing techniques to an existing group.

If you want to group a playing technique group to another playing technique group, you must 
first ungroup them.

PROCEDURE

1. In Write mode, select the playing techniques you want to group together.

2. Choose Edit > Notations > Playing Techniques > Group Playing Techniques. You can also 
choose this option from the context menu.

RESULT
The selected playing techniques are grouped together. Their durations are extended to reach the 
next playing technique in the group, and transition lines are shown between playing techniques 
in the group.

RELATED LINKS
Playing technique continuation lines on page 940

Ungrouping playing techniques and removing playing techniques 
from groups

You can ungroup playing techniques so that all playing techniques in the group become 
ungrouped. You can also remove only selected playing techniques from groups while leaving 
other playing techniques in the group.

This applies to all layouts in which the playing techniques appear.

PROCEDURE

1. In Write mode, select the playing techniques you want to ungroup or remove from groups.

2. Do one of the following:

Playing techniques
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● To ungroup all playing techniques in the selected groups, choose Edit > Notations > 
Playing Techniques > Ungroup Playing Techniques.

● To remove only the selected playing techniques from their groups, choose Edit > 
Notations > Playing Techniques > Remove Playing Technique from Group.

TIP

You can also choose these options from the context menu.

RESULT
The selected playing techniques or all playing techniques are removed from the selected groups. 
Playing techniques that previously had transition lines now appear with duration lines.

Playing techniques
Groups of playing techniques 
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Lines

Lines can convey a variety of meanings in music, such as indicating which hand to use in piano 
music or a gradual change in bow pressure. In Dorico SE, lines can be vertical, horizontal, or 
angled between notes and have different styles and appearances.

A phrase containing horizontal and vertical lines that convey a range of meanings

NOTE

Due to their generic designs, such as a dashed line with arrow end cap, lines in Dorico SE have 
no definitive musical meaning and function primarily graphically, meaning they do not affect 
playback. Dorico SE includes dedicated features for specific notations that affect playback if 
applicable, such as dynamics, arpeggios, glissandi, and trills.

The following types of lines are available in Dorico SE:

Horizontal lines
Horizontal lines span a specified duration; that is, they start at one rhythmic position 
and end at a later rhythmic position. They might indicate a change over time, such 
as a wedge that represents bow pressure, or suggest a link between notes, such as a 
bracket spanning the theme in a fugue or a straight line between notes showing where 
a melody moves to a different staff.

By default, horizontal lines only apply to single staves. However, there are certain 
situations where you require a horizontal line to appear in all part layouts but only 
at system object positions in the full score layout. You can input horizontal lines that 
apply to all staves or only apply to single staves in Dorico SE.

Attachment types control the positions of horizontal lines and certain aspects of their 
functionality. Horizontal lines can have different attachment types at their start and 
end.

NOTE

You cannot change the attachment type of horizontal lines after they have been input.

In Dorico SE, each end of horizontal lines can have the following attachment types:

● Notehead-attached

Attached to an individual note independently of its rhythmic position, meaning 
that the ends of notehead-attached lines move with notes if you change their 
pitch or move them rhythmically. Notehead-attached lines can be both angled 
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or horizontal, as their end positions and resulting angles are determined by the 
interval between the start and end notes.

A phrase containing two notehead-attached lines, showing where the melody moves 
between piano staves

● Barline-attached

Attached to a rhythmic position and aligned with barlines, if their rhythmic 
positions coincide with barline positions. Barline-attached lines are always 
horizontal.

A barline-attached line spanning two full bars

● Rhythmic position-attached

Attached to a rhythmic position and positioned relative to notes, chords, or rests at 
those rhythmic positions.

Rhythmic position-attached lines are horizontal and placed above the staff by 
default. Their endpoints start to the left and end to the right of notes, chords, 
or rests at the corresponding rhythmic positions.

A rhythmic position-attached line spanning two full bars

Vertical lines
Vertical lines exist at a single rhythmic position and are positioned relative to notes or 
chords at that position. They might convey details about a specific moment, such as 
indicating which hand to use for specific notes in piano music.

Vertical lines indicating which notes to play with the right hand

Lines
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RELATED LINKS
Input methods for lines on page 352
Lines panel on page 353
Adding text to lines on page 958
Changing the placement of horizontal lines on page 951
Arpeggio signs on page 883
Glissando lines on page 889
Jazz articulations on page 911
Octave lines on page 742
Trills on page 870
Playing technique continuation lines on page 940
Pedal lines on page 925
Repeat endings on page 975
Guitar bends on page 894
Tuplet brackets on page 1109

Line components
In Dorico SE, lines consist of multiple components that together function as a single item.

1 Start cap

Symbol shown at the start of lines. Caps can be arrowheads, hooks, or terminal lines.

2 Line body

Horizontal or vertical line, repeating symbols, dash/dot pattern, or wedge that makes up the 
main part of a line and extends across its entire length or height.

3 Text

Text shown in addition to caps, either centered in the middle of each line segment or only at 
the start or end of lines. On vertical lines, text reads upwards by default.

4 Continuation end cap

Symbol shown at the end of segments of lines that continue across multiple systems. Caps 
can be arrowheads, hooks, or terminal lines.

5 Continuation cap

Symbol shown at the start of subsequent segments of lines that continue across multiple 
systems. Caps can be arrowheads, hooks, or terminal lines.

6 End cap

Symbol shown at the end of lines. Caps can be arrowheads, hooks, or terminal lines.

Lines
Line components 
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NOTE

Dorico Pro provides further options for customizing lines and line components, such as using 
text for caps and music symbols for annotations in the center of lines. You might encounter lines 
with different components than are available in Dorico SE if you import or open a project that 
contains them.

RELATED LINKS
Input methods for lines on page 352
Changing the body style of lines on page 956
Changing the caps of lines on page 957
Adding text to lines on page 958
Changing the position of text relative to horizontal lines on page 959
Changing the position of text relative to vertical lines on page 960
Playing technique continuation lines on page 940

Positions of lines
The position of lines relative to notes and staves depends on the line type and, for horizontal 
lines, their attachment type.

Notehead-attached horizontal lines
Notehead-attached lines are positioned in relation to the corresponding noteheads; 
that is, starting to the right of the start note and ending to the left of the end note. 
They automatically follow the notes at each end, meaning if you change the pitch 
of either note or move them rhythmically, the line end positions move accordingly. 
Because their positions depend on the pitches of notes, they can appear both inside 
and outside the staff. If they are only attached to noteheads at one end, they remain 
horizontal but follow the staff position of the note to which they are attached.

Barline-attached horizontal lines
Barline-attached horizontal lines are placed above the staff by default. Their endpoints 
align with barlines if their duration coincides with barline positions. If their endpoints 
do not coincide with barlines, they are positioned like rhythmic position-attached lines.

Rhythmic position-attached horizontal lines
Rhythmic position-attached lines are placed above the staff by default. Their endpoints 
start to the left and end to the right of notes, chords, or rests at the corresponding 
rhythmic positions.

Vertical lines
Vertical lines are positioned to the left of the notes to which they apply, including 
any applicable accidentals, but are positioned between grace notes and normal notes. 
If multiple vertical lines exist at the same rhythmic position, the most recent line is 
positioned furthest to the right; that is, directly to the left of notes or chords.

You can change the position/placement of lines in a variety of ways, such as showing vertical 
lines on the right of notes or changing the placement of horizontal lines to show them inside the 
staff.

RELATED LINKS
Changing the horizontal order of vertical lines on page 950
Showing vertical lines before grace notes on page 951
Changing the placement of horizontal lines on page 951
Input methods for lines on page 352

Lines
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Showing vertical lines on the right/left of notes
You can change the side of notes on which vertical lines appear; for example, to show selected 
vertical lines on the right side of notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the vertical lines whose horizontal position you want to change.

2. In the Properties panel, activate Side in the Vertical Lines group.

3. Choose one of the following options:

● Left

● Right

RESULT
The selected lines appear on the corresponding side of notes.

EXAMPLE

Vertical line on the left of notes Vertical line on the right of notes

AFTER COMPLETING THIS TASK
You can change the order of vertical lines when multiple vertical lines exist at the same rhythmic 
position and on the same side of notes.

Changing the horizontal order of vertical lines
You can change the horizontal order of vertical lines when multiple vertical lines exist at the 
same rhythmic position and on the same side of notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the vertical lines whose order you want to change.

2. In the Properties panel, activate Column in the Vertical Lines group.

Lines
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3. Change the value in the value field.

RESULT
The order of the selected vertical lines relative to any other vertical lines at the same rhythmic 
positions is changed. Lines with higher Column values are placed further to the left, while lines 
with lower values are placed further to the right.

Showing vertical lines before grace notes
You can position individual vertical lines so they appear to the left of grace notes. By default, 
vertical lines are positioned after grace notes; that is, between grace notes and normal notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the vertical lines you want to show before grace notes.

2. In the Properties panel, activate Line before grace notes in the Vertical Lines group.

RESULT
The selected vertical lines are positioned before grace notes.

Deactivating Line before grace notes shows the selected vertical lines after grace notes again.

EXAMPLE

Vertical line after grace notes Vertical line before grace notes

Changing the placement of horizontal lines
You can show individual horizontal lines above, below, or inside the staff. By default, horizontal 
lines are placed above the staff.

NOTE

These steps only apply to barline-/rhythmic position-attached horizontal lines.

PREREQUISITE

● The lower zone is shown.

Lines
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● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the horizontal lines whose placement you want to change.

2. In the Properties panel, activate Placement in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Above

● Below

● Inside staff

RESULT
The placement of the selected horizontal lines is changed. Horizontal lines inside the staff are 
centered on the middle staff line by default.

TIP

You can also cycle through the different placement options for selected horizontal lines by 
pressing F .

AFTER COMPLETING THIS TASK

● You can change the staff position of lines shown inside the staff.

● You can erase the background of text on lines shown inside the staff.

RELATED LINKS
Changing the staff-relative placement of items on page 400

Changing the staff position of horizontal lines inside the staff
You can change the staff position of horizontal lines shown inside the staff, including changing 
the staff position of the start/end of lines independently of each other; for example, if you want 
lines to appear angled.

PREREQUISITE

● The horizontal lines whose staff position you want to change are placed inside the staff and 
have at least one barline-/rhythmic position-attached end.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the horizontal lines placed inside the staff whose staff position you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Horizontal Lines group:

● Start position

● End position

3. Change the values in the value fields.

Lines
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RESULT
The staff positions of the corresponding ends of the selected lines are changed according to the 
new values. For example, 0 is the middle line of the staff, 4 is the top line of the staff, and -4 is the 
bottom line of the staff.

EXAMPLE

Horizontal lines inside the staff with different staff positions at their start/end

Length of lines
Dorico SE automatically calculates the appropriate length for both horizontal and vertical lines.

● The length of horizontal lines is determined by the rhythmic duration of the line. Horizontal 
lines with different attachment types are positioned differently, which can affect their 
graphical length. For example, barline-attached lines can appear longer than rhythmic 
position-attached lines with the same duration.

● The length of vertical lines is determined by the pitch range of notes in the voices/staves to 
which the line applies. Dorico SE automatically adjusts the length of vertical lines if pitches 
change or you add notes to, or delete notes from, chords.

You can lengthen/shorten both horizontal and vertical lines; for example, if you want an 
individual vertical line to extend above the top note in a chord.

Lengthening/Shortening horizontal lines
You can lengthen/shorten horizontal lines rhythmically after they have been input.

NOTE

These steps only apply to barline-/rhythmic position-attached horizontal lines. You cannot 
lengthen/shorten notehead-attached horizontal lines, except by lengthening/shortening the 
notes to which they are attached.

PROCEDURE

1. In Write mode, select the horizontal lines you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one line at a time.

2. Lengthen/Shorten the lines in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

Lines
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● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To snap the end of a single line to the next notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Right Arrow .

● To snap the end of a single line to the previous notehead, press Ctrl/Cmd-Shift-Alt/
Opt-Left Arrow .

NOTE

● When multiple lines are selected, you can only lengthen/shorten them according to 
the current rhythmic grid resolution.

● When using the keyboard, lengthening/shortening lines only moves their end. You 
can move the start of lines by moving lines rhythmically, or by clicking and dragging 
the start handle of a single line.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
Single lines are lengthened/shortened according to the current rhythmic grid resolution or to the 
next/previous notehead, whichever is closer.

Multiple lines are lengthened/shortened according to the current rhythmic grid resolution.

RELATED LINKS
Inputting horizontal lines on page 353
Moving notes/items rhythmically on page 417
Rhythmic grid on page 190

Lengthening/Shortening vertical lines
You can lengthen/shorten individual vertical lines to different staff positions. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains. By default, vertical 
lines automatically span the pitch range of notes in the voices to which they apply.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the vertical lines you want to lengthen/shorten.

2. In the Properties panel, activate the following properties, individually or together, in the 
Vertical Lines group:

● Top position

● Bottom position

3. Change the values in the value fields.

RESULT
The vertical length of the selected lines is changed. Increasing the values moves the 
corresponding end up by staff positions, decreasing the values moves the corresponding end 

Lines
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down by staff positions. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

RELATED LINKS
Inputting vertical lines on page 354
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the start/end positions of horizontal lines
By default, rhythmic position-attached horizontal lines start before notes/accidentals and end 
immediately after the last note, chord, or rest at their end rhythmic position. You can change the 
start and end positions of individual rhythmic position-attached horizontal lines independently; 
for example, if you want them to start before noteheads rather than accidentals and end 
immediately before the following note, chord, or rest.

NOTE

These steps only apply to rhythmic position-attached horizontal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the rhythmic position-attached horizontal lines whose start and/or end position you 
want to change.

2. In the Properties panel, activate Horizontal start position in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Notehead

● Notehead center

● Accidental

4. Activate Horizontal end position in the Horizontal Lines group.

5. Select one of the following options from the menu:

● End at right-hand side of final note

● End on center of final note

● End immediately before following note

RESULT
The start and/or end position of the selected rhythmic position-attached horizontal lines is 
changed.

Lines
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EXAMPLE

Horizontal line starting before the 
notehead

Horizontal line starting centered 
on the notehead

Horizontal line starting before the 
accidental

Horizontal line ending after final 
note

Horizontal line ending centered on 
the final notehead

Horizontal line ending before 
following note

Changing the body style of lines
You can change the body style of individual lines without changing their caps.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the lines whose body style you want to change.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Line body style in either the Horizontal Lines or Vertical 
Lines group.

3. Select the style you want from the menu.

RESULT
The body style of the selected lines is changed.

NOTE

This does not affect the caps of the selected lines.

RELATED LINKS
Line components on page 948
Lines panel on page 353
Input methods for lines on page 352

Lines
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Changing the caps of lines
You can change the caps of individual lines without changing their body style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the lines whose caps you want to change.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate the following properties, individually or together, in either 
the Horizontal Lines or Vertical Lines group:

● To change the cap at the start/bottom of the selected lines, activate Start cap.

● To change the cap at the end/top of the selected lines, activate End cap.

● To change the segment start cap of the selected horizontal lines on subsequent systems, 
activate Continuation cap.

● To change the segment end cap of the selected horizontal lines on previous systems to 
where the lines end, activate Continuation end cap.

3. Select the style you want from each menu.

RESULT
The corresponding caps of the selected lines are changed.

NOTE

This does not affect the body style of the selected lines.

Changing the direction of lines
You can change the direction of both horizontal and vertical lines; for example, to make a 
horizontal line with an arrow end cap point to the left, or to make a vertical line with text appear 
upside-down with its text reading downwards.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the lines whose direction you want to change.

NOTE

You must select either only horizontal lines or only vertical lines.

Lines
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2. In the Properties panel, activate Reverse in either the Horizontal Lines or Vertical Lines 
group.

RESULT
The direction of the selected lines is change. Text on vertical lines now reads downwards.

Deactivating Reverse returns the selected lines to their default direction.

EXAMPLE

Horizontal and vertical lines with default directions Reversed horizontal and vertical lines

Adding text to lines
You can add text to both horizontal and vertical lines; for example, to clarify the intention of the 
line.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the lines to which you want to add text.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Text in either the Horizontal Lines or Vertical Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered into the value field is shown centered in the middle of the selected lines. On 
vertical lines, it reads upwards.

Lines
Adding text to lines 
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EXAMPLE

Text on a horizontal line

Text on a vertical line

AFTER COMPLETING THIS TASK

● If you want text on vertical lines to read downwards, you can reverse the lines.

● You can erase the backgrounds of text on lines.

RELATED LINKS
Line components on page 948
Input methods for lines on page 352

Changing the position of text relative to horizontal lines
You can change the position of text relative to horizontal lines individually; for example, to show 
text above horizontal lines. By default, text is centered on horizontal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the horizontal lines whose text position you want to change.

2. In the Properties panel, activate Text position in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Above

● Centered

● Below

● Inside

● Outside

RESULT
The position of text relative to the selected horizontal lines is changed. When annotations are 
positioned Inside or Outside, their position relative to the line changes according to the staff-
relative placement of the line.

Lines
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EXAMPLE

Text Above Text Centered Text Below

RELATED LINKS
Changing the placement of text relative to lines on page 961

Changing the position of text relative to vertical lines
You can change the position of text relative to vertical lines individually; for example, to show text 
on the left of vertical lines. By default, text is centered on vertical lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the vertical lines whose text position you want to change.

2. In the Properties panel, activate Text position in the Vertical Lines group.

3. Select one of the following options from the menu:

● Left

● Centered

● Right

RESULT
The position of text relative to the selected vertical lines is changed.

EXAMPLE

Text Left Text Centered Text Right

Lines
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Changing the placement of text relative to lines
You can change the placement of text relative to lines individually; for example, to show text at 
the start of horizontal lines or the top of vertical lines. By default, text appears in the center of 
lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the lines whose text placement you want to change.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Text placement in either the Horizontal Lines or Vertical 
Lines group.

3. Select one of the following options from the menu:

● Start

● Center

● End

4. Optional: If you chose Start or End and want to change the offset from the corresponding 
end of the line, activate Start/end gap in either the Horizontal Lines or Vertical Lines 
group and change the value in the value field.

RESULT
The placement of text relative to the selected lines is changed. For vertical lines, Start places text 
at the bottom of the line, End places text at the top.

If you also activated Start/end gap, the gap between text on the selected lines and the 
corresponding end is changed.

RELATED LINKS
Changing the direction of lines on page 957

Forcing line text to be horizontal
You can force the text of individual lines always to appear horizontal; for example, to make text 
on vertical lines easier to read.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the lines whose text you want to keep horizontal.
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NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Keep text horizontal in either the Horizontal Lines or 
Vertical Lines group.

RESULT
Text on the selected lines always appears horizontal, even if the line is angled or vertical.

Lines
Adding text to lines 

962
Dorico SE 4.3.30



Rehearsal marks

Rehearsal marks are ordered sequences of letters or numbers that provide useful reference 
points, such as indicating significant changes in the music. They allow performers to co-ordinate 
easily in rehearsals and make the chronological sequence of the music clear.

In Dorico SE, rehearsal marks follow an automatic sequence where each rehearsal mark has a 
unique index, ensuring there are never duplicate rehearsal marks.

A rehearsal mark, showing the letter G

By default, rehearsal marks in Dorico SE appear as letters, but you can change the sequence 
type to show letters, numbers, or bar numbers. You can use all three available rehearsal mark 
sequences simultaneously.

In order to ensure they are easily noticeable, and cannot be confused with bar numbers when 
using numbers for rehearsal marks, rehearsal marks are shown in a rectangular enclosure.

In Dorico SE, rehearsal marks are categorized as system objects. Therefore, rehearsal marks 
follow your per-layout settings for the visibility and positioning of system objects.

RELATED LINKS
Inputting rehearsal marks on page 368
Changing the index of rehearsal marks on page 964
Changing the rehearsal mark sequence type on page 965
Going to rehearsal marks on page 405
Layout Options dialog on page 622
System objects on page 1044
Changing the positions of system objects on page 1045
Tempo marks on page 1052
Bar numbers on page 677

Positions of rehearsal marks
Rehearsal marks are placed outside the music, above the staff, and at the same positions as 
other system objects so they can be seen easily.

By default, rehearsal marks are positioned above barlines and to the right of clefs or key 
signatures at the start of systems. Although you can input rehearsal marks at rhythmic positions 
within a bar in Dorico SE, this is not common practice.

When rehearsal marks coincide with tempo changes, Dorico SE automatically positions tempo 
marks to the right of rehearsal marks. Dorico SE automatically adjusts staff spacing to ensure 
rehearsal marks are correctly positioned.
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You can move rehearsal marks to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

The vertical spacing between the top two staves is increased to allow room for the rehearsal mark and the 
tempo marks.

Rehearsal marks are categorized as system objects in Dorico SE, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently; for example, if you want rehearsal marks to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Inputting rehearsal marks on page 368
Input methods for bars, beats, and barlines on page 275
Changing the positions of system objects on page 1045

Changing the index of rehearsal marks
By default, the rehearsal mark sequence resets at the start of each flow. If you want the 
rehearsal mark sequence to continue across flows, for example, to avoid having multiple 
rehearsal marks with the same letter in the same project, you can change the index position 
of individual rehearsal marks.

Changing the index position changes the shown number or letter. For example, index position 1 
appears as rehearsal mark A or 1, position 2 appears as B or 2, and so on.

You can also change the index position of a rehearsal mark to avoid showing a letter that could 
easily be confused with another letter or another number, such as I or O.

NOTE

These steps do not apply to rehearsal marks using the bar number sequence type.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the rehearsal mark whose index position you want to change.

2. In the Properties panel, activate Index in the Rehearsal Marks group.

3. Change the value in the value field.

Rehearsal marks
Changing the index of rehearsal marks 
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RESULT
The selected rehearsal mark changes according to the Index value and its sequence type.

Any subsequent rehearsal marks without index changes in the same sequence follow the new 
index automatically. For example, if you changed a rehearsal mark from A to P, the next 
rehearsal mark changes from B to Q.

TIP

You can also change the sequence type of rehearsal marks; for example, if you want rehearsal 
mark C to appear as rehearsal mark 3.

Changing the rehearsal mark sequence type
Rehearsal marks can be letters, numbers, or bar numbers. You can change the sequence type of 
individual rehearsal marks, and create secondary rehearsal mark sequences.

In Dorico SE, you can use all three available rehearsal mark sequences simultaneously. For 
example, you can have the main sequence of rehearsal marks showing letters, but also have a 
secondary sequence of numbers to mark different moments, perhaps entry points for a solo line, 
and also highlight prominent bar numbers within those sections.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the rehearsal mark whose sequence type you want to change.

2. In the Properties panel, activate Sequence type in the Rehearsal Marks group.

3. Select one of the following options from the menu:

● Letters

● Numbers

● Bar numbers

RESULT
The selected rehearsal mark now displays a letter, a number, or the current bar number.

If it is the first rehearsal mark in either the letters sequence or the numbers sequence in the flow, 
it shows either A or 1. If there are already rehearsal marks in either the letters sequence or the 
numbers sequence in the flow, it shows the next letter or number according to the index.

NOTE

You can change the index of a rehearsal mark sequence independently of other rehearsal mark 
sequences. However, you cannot change the index of rehearsal marks using the bar number 
sequence type.

RELATED LINKS
Inputting rehearsal marks on page 368
Adding bar number changes on page 685

Rehearsal marks
Changing the rehearsal mark sequence type 
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Adding prefixes/suffixes to rehearsal marks
You can add both prefixes and suffixes to individual rehearsal marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the rehearsal marks to which you want to add a prefix or suffix.

2. In the Properties panel, activate the following properties, individually or together, in the 
Rehearsal Marks group:

● Prefix

● Suffix

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered into the value field is added to the selected rehearsal marks as a prefix or a 
suffix.

Rehearsal marks
Adding prefixes/suffixes to rehearsal marks 
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Markers

Markers are labels locked to a particular position in time, most commonly in relation to a video. 
They typically indicate an important moment that requires musical prominence, and composers 
often use them to help shape the writing process.

Markers on a timecode staff showing custom text and timecodes

By default, markers in Dorico SE show the default text “Marker” and also include the timecode of 
their fixed position in time.

In Dorico SE, you can use markers in any project. However, because they are most commonly 
used in conjunction with video, markers are included in the Video panel in Write mode. There is 
also a Markers track in Play mode that displays markers, and allows you to input new ones.

You can use markers to help find suitable tempos for your project, as Dorico SE can calculate 
possible tempos between important markers so that the markers occur on strong beats in the 
time signature.

You can show markers above/below the start of each system or below the timecode staff, if there 
is one, in each layout independently.

Any markers you input are automatically included when you export MIDI.

RELATED LINKS
Inputting markers/timecodes on page 369
Editing marker text on page 969
Video panel on page 370
Changing the timecodes of markers on page 969
Defining markers as important on page 970
Timecodes on page 971
Markers track on page 451

Hiding/Showing markers
By default, markers are shown in full score layouts and hidden in part layouts. You can hide 
and show markers in each layout independently; for example, if markers are helpful for the 
conductor to see but not for the players.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show markers.
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By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. Activate/Deactivate Show markers.

5. Click Apply, then Close.

RESULT
Markers are hidden/shown in the selected layouts.

Changing the vertical position of markers
You can show markers above the system, below the system, or on a separate single-line 
timecode staff above a selected bracketed instrument family group, which can make them 
clearer in the score. When markers are shown on a timecode staff, timecodes are also 
automatically shown below the timecode staff.

NOTE

You cannot show multiple timecode staves in a system.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
markers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. In the Markers subsection, choose one of the following options for Vertical position:

● Above system

● Below system

● Timecode staff

5. Optional: If you chose Timecode staff, select the bracketed instrument family above which 
you want to show the timecode staff from the Position timecode staff above bracket 
menu.

6. Click Apply, then Close.

RESULT
The vertical position of markers is changed in the selected layouts.

NOTE

● If you show markers on a timecode staff, timecodes are also shown on the staff by default. 
If you only want to show markers on a separate staff and exclude timecodes, you must then 
change Timecode frequency on timecode staff to Never.

Markers
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You can also change the vertical position of timecodes so they appear above/below the start 
of systems rather than on the timecode staff.

● You can change the default distance between the timecode staff and other staves on the 
Vertical Spacing page in Layout Options.

AFTER COMPLETING THIS TASK
You can change the frequency of timecodes on the timecode staff.

RELATED LINKS
Inputting markers/timecodes on page 369
Changing the vertical position of timecodes on page 972
Changing the timecode frequency on page 973
Layout Options dialog on page 622

Editing marker text
The default text shown in new markers is “Marker”. You can change the text shown in each 
marker individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the markers whose text you want to change.

2. In the Properties panel, activate Marker text in the Markers group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected markers is changed. It uses the Marker Text Font font style.

TIP

You can also enter custom text for markers when inputting them using the Add Marker dialog, 
and change marker text in the Markers section of the Video panel in Write mode.

RELATED LINKS
Add Marker dialog on page 369

Changing the timecodes of markers
You can change the timecodes of individual markers after they have been input; for example, if 
the video has been edited and the marker now occurs ten seconds later.

NOTE

Because this changes where markers occur in the project, this also moves markers relative to the 
notated music.

Markers
Editing marker text 
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PROCEDURE

1. In Write mode, select an item in the flow containing the markers whose timecodes you want 
to change.

2. In the Notations toolbox, click Panels , then Video  to show the Video panel.

3. In the Markers section, double-click the timecode you want to change.

4. Enter the new timecode you want into the value field.

5. Press Return .

RESULT
The timecode of the marker is changed. The marker automatically moves relative to the music to 
reflect its new time position.

RELATED LINKS
Video panel on page 370
Changing the initial timecode value on page 972

Defining markers as important
You can define individual markers as important, which allows them to be considered when 
finding suitable tempos in the Find Tempo dialog.

PROCEDURE

1. In Write mode, click Video in the Notations toolbox to show the Video panel.

2. In the Markers section, activate the checkbox in the Imp. column for each marker you want 
to define as important.

RESULT
Markers with activated checkboxes are defined as important. The Find Tempo button at the 
bottom of the Markers section becomes available.

RELATED LINKS
Find Tempo dialog on page 371

Markers
Defining markers as important 
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Timecodes

Timecodes indicate an exact position in time, usually in the context of a video. They allow precise 
synchronization between multiple elements, such as music and moving images, and can be used 
as a reference tool.

Timecodes are displayed in the format hh:mm:ss:ff, which is two-digit hours, minutes, seconds, 
and frames.

A timecode on a timecode staff

In Dorico SE, you can specify the type of timecode from the following types:

Non-drop frame timecodes
Each frame is numbered sequentially from the preceding one without skipping any 
frame numbers.

Non-drop frame timecodes are shown with the suffix fps and use a colon separator 
between seconds and frames; for example, 00:00:01:05.

Drop frame timecodes
Some frame numbers are skipped in order to accommodate the difference in frame 
rate between 29.97 fps and 30 fps. In every minute except every tenth minute, two 
timecode numbers are dropped from the frame count.

Drop frame timecodes are shown with the suffix dfps and use a semicolon separator 
between the seconds and frames; for example, 00:00:01;05.

Timecodes in Dorico SE are flow-specific, meaning you can set timecodes for each flow that are 
completely independent of the timecodes for other flows. You can set timecodes in the Video 
Properties dialog, including for flows without a video.

NOTE

The timecodes shown in flow cards in the Flows panel in Setup mode reflect the timecode at the 
start of the flow, which can be different to the timecode you set in the Video Properties dialog. 
For example, if you set the Timecode start to 02:00:00:00 but also set the Flow attachment 
position to 8 quarter note beats, and the tempo is 60 bpm, the timecode shown in the flow card 
is 01:59:52:00.

By default, timecodes appear in markers. You can show markers above/below the start of each 
system or below the timecode staff, if there is one, in each layout independently.

Additionally, you can change the time displayed in the Transport window to be the timecode 
rather than elapsed time, which is shown by default.
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RELATED LINKS
Inputting markers/timecodes on page 369
Frame rates on page 171
Video Properties dialog on page 167
Changing the timecode frequency on page 973
Changing the content shown in the transport display on page 471
Markers on page 967
Hiding/Showing markers on page 967
Changing the vertical position of markers on page 968
Changing the vertical position of timecodes on page 972

Changing the initial timecode value
You can change the timecode at which each flow in your project starts; for example, if you are 
using a separate project for the second reel of a film. You can also change the initial timecode in 
projects without videos.

PROCEDURE

1. In Write mode, select an item in the flow whose initial timecode value you want to change.

2. In the Notations toolbox, click Panels , then Video  to show the Video panel.

3. In the Video panel, click Properties to open the Video Properties dialog.

4. Change the value for Timecode start.

5. Click OK to save your changes and close the dialog.

RESULT
The initial timecode for the flow in which you selected an item is changed.

RELATED LINKS
Video panel on page 370
Changing the start position of videos on page 168
Changing the timecodes of markers on page 969

Changing the vertical position of timecodes
You can show timecodes either above/below the start of systems or on a separate single-line 
staff in each layout independently. For example, you can show timecodes and markers on a 
separate timecode staff in full score layouts but show only timecodes above the start of systems 
in part layouts.

NOTE

You cannot show timecodes on multiple staves in a system.

PREREQUISITE
If you want to show timecodes on a separate staff, you have changed the vertical position of 
markers so they appear on a separate staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

Timecodes
Changing the initial timecode value 
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2. In the Layouts list, select the layouts in which you want to change the vertical position of 
timecodes.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. In the Timecode subsection, choose one of the following options for Show timecode:

● Above or below start of system

● Below timecode staff

5. Optional: If you chose Above or below start of system, choose one of the following options 
for Timecode position relative to system:

● Above system

● Below system

6. Optional: If you chose Above or below start of system and want to change the gap 
between timecodes and the staff, change the values in the Offset at start of system value 
fields.

7. Click Apply, then Close.

RESULT
The vertical position of timecodes is changed in the selected layouts.

NOTE

Your setting for Timecode frequency on timecode staff also applies when timecodes are shown 
above/below the start of systems.

RELATED LINKS
Changing the vertical position of markers on page 968
Changing the timecode frequency on page 973

Changing the timecode frequency
You can show timecodes at different intervals in layouts in which timecodes are shown on a 
separate staff. For example, you can show timecodes every bar in full score layouts but only at 
the start of each system in part layouts.

NOTE

We do not recommend that you show timecodes every bar in layouts with multi-bar rests, as 
the result is illegible overlapping timecodes. If you want to show timecodes in part layouts with 
multi-bar rests, we recommend either showing timecodes only at the start of each system or not 
showing multi-bar rests in the layout.

PREREQUISITE
Markers are shown in the selected layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

Timecodes
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2. In the Layouts list, select the layouts in which you want to change the timecode frequency.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. Optional: If the selected layouts do not show timecodes on a separate staff, choose 
Timecode staff for Vertical position.

5. Choose one of the following options for Timecode frequency on timecode staff:

● Start of system

● Every bar

● Never

6. Click Apply, then Close.

RELATED LINKS
Hiding/Showing markers on page 967
Hiding/Showing multi-bar rests on page 1015

Timecodes
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Repeat endings

For music with repeated passages, repeat endings show which bars are played at the end of each 
repetition, with different endings each time if required. They are also known as “volta lines”, or as 
“first and second endings”, but in this documentation, we refer to them as “repeat endings”.

Repeat endings comprise two or more segments, where each segment contains a different 
possible ending. When you input repeat endings, Dorico SE automatically inputs an end repeat 
barline at the end of the first segment. Segments in repeat endings are clearly marked with solid 
lines above and numbers that indicate the playthroughs in which the segment is used.

A repeat ending with three playthroughs divided across two endings

Dorico SE allows you to create repeat endings containing any number of segments. However, 
you cannot change how playthroughs are divided across repeat ending segments.

In Dorico SE, repeat endings are categorized as system objects. Therefore, repeat endings follow 
your per-layout settings for the visibility and positioning of system objects.

RELATED LINKS
Input methods for repeats and tremolos on page 372
Layout Options dialog on page 622
System objects on page 1044
Repeats in playback on page 463
Changing the number of playthroughs at repeat barlines on page 464
Types of barlines on page 672
Lines on page 946

Changing the total number of playthroughs in repeat 
endings

By default, each segment in repeat endings is played once, so each segment shows a single 
digit that indicates the playthrough for which it is used. You can increase the total number of 
playthroughs for repeat endings individually so that segments are played more than once.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the repeat endings whose total number of playthroughs you want to change.
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2. In the Properties panel, activate No. times played in the Repeat Endings group.

3. Change the value in the value field.

NOTE

You cannot have fewer playthroughs than the number of segments.

RESULT
The total number of playthroughs in the selected repeat endings is changed. Dorico SE adds 
additional playthroughs to the last closed segment in the repeat ending.

NOTE

You cannot change how playthroughs are divided across repeat ending segments in Dorico SE.

RELATED LINKS
Repeats in playback on page 463
Changing the number of playthroughs at repeat barlines on page 464
Input methods for repeats and tremolos on page 372

Lengthening/Shortening segments in repeat endings
You can increase/decrease the number of bars included in each segment of repeat endings by 
lengthening/shortening each segment independently.

PROCEDURE

1. In Write mode, select the repeat ending you want to lengthen/shorten.

NOTE

You can only lengthen/shorten one repeat ending segment at a time.

2. Select the circular handle at the end of the segment you want to lengthen/shorten.

The selected handle in the middle has a thicker line.

3. Click and drag the handle to the right/left to snap it to the next/previous barline.

NOTE

Segments must contain at least one bar.

4. Optional: Repeat steps 1 to 3 for each segment in the repeat ending.

RESULT
The selected segment is lengthened/shortened.

Repeat endings
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NOTE

● This does not automatically input or move repeat barlines. You must input and delete repeat 
barlines as appropriate manually.

● You can also lengthen/shorten the final segment in a single repeat ending by selecting the 
repeat ending and using the following key commands:

● To lengthen the final segment, press Shift-Alt/Opt-Right Arrow .

● To shorten the final segment, press Shift-Alt/Opt-Left Arrow .

RELATED LINKS
Input methods for bars, beats, and barlines on page 275
Deleting notes/items on page 412

Positions of repeat endings
Repeat endings are placed above the staff at the same positions as other system objects, and 
their hooks align with barlines. They are commonly positioned outside of other notations, but 
some long items, such as gradual tempo changes, can be placed above repeat endings.

You can move repeat endings to different rhythmic positions in Write mode.

Repeat endings are categorized as system objects in Dorico SE, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently; for example, if you want repeat endings to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Moving notes/items rhythmically on page 417
System objects on page 1044
Input methods for repeats and tremolos on page 372

Changing the appearance of individual final repeat ending 
segments

You can change the appearance of the line ends in the final segments of individual repeat 
endings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the repeat endings whose final segment appearance you want to change.

2. In the Properties panel, activate End of line in the Repeat Endings group.

3. Select one of the following options from the menu:

● Open, short

● Open, full length

● Closed

Repeat endings
Positions of repeat endings 
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RESULT
The end of the line of the final segment in the selected repeat endings is changed.

Repeat endings in MusicXML files
All aspects of repeat endings can be imported from and exported in MusicXML files.

However, while MusicXML can represent this, segments in the middle of sets of endings cannot 
have an open right-hand end in Dorico SE.

Repeat endings
Repeat endings in MusicXML files 
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Repeat markers

Repeat markers show that musical material is to be repeated, but unlike repeat endings, repeat 
markers often involve jumping to different positions and sections in the music instead of moving 
through the music consecutively.

A mid-system coda section

In Dorico SE, repeat markers are divided into the following types:

Repeat jumps
Specify the position from which players or playback must jump, such as D.C. al Coda or 
D.S. al Fine.

Repeat jumps are right-aligned with their rhythmic position, meaning their text or 
symbol ends at that rhythmic position and extends to the left.

Repeat sections
Specify the destinations for jumps, such as segno or coda, or where the music should 
end, such as Fine. In Dorico SE, coda sections that start mid-system are automatically 
separated from the preceding music with a gap. Coda sections at the start of systems 
are indented by the same amount.

Repeat markers are left-aligned with their rhythmic position, meaning their text or 
symbol starts at that rhythmic position and extends to the right.

By default, repeat markers are shown on a single line.

RELATED LINKS
Input methods for repeats and tremolos on page 372
Hiding/Showing repeat markers on page 981
Changing the index for repeat markers on page 980
Repeats in playback on page 463
Repeat counts on page 983
Types of barlines on page 672
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Changing the index for repeat markers
You can change the index of individual repeat markers; for example, if a flow requires two 
different codas with different symbols so players can tell them apart.

By default, all repeat markers of the same type have the same appearance, even when there are 
multiple repeat markers in the flow.

NOTE

You cannot change the index of Fine or D.C. repeat markers.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the repeat marker whose index you want to change.

2. In the Properties panel, activate the following properties, individually or together as 
appropriate for your selection, in the Repeat Markers group:

● Marker index

● ‘Jump to’ index

3. Change the values in the value fields.

NOTE

You can only enter values between 1 and 3.

RESULT
Marker index changes the order of the selected repeat marker relative to other repeat markers 
of the same type.

‘Jump to’ index changes the destination of the selected repeat marker.

EXAMPLE
If you have two codas in a flow with two different D.S. al Coda markers, you might set Marker 
index to 1 for the first coda and 2 for the second, then set ‘Jump to’ index to 1 for the first D.S. al 
Coda marker and 2 for the second.

D.S. al Coda marker with default indexes D.S. al Coda marker with both indexes set to 2

RELATED LINKS
Repeats in playback on page 463
Input methods for repeats and tremolos on page 372

Repeat markers
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Editing repeat marker text
You can change the text shown in individual repeat markers; for example, if you are typesetting a 
score with an unusual repeat marker instruction.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the repeat markers whose text you want to change.

2. In the Properties panel, activate Custom text in the Repeat Markers group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected repeat markers is changed. Segno symbols and coda symbols in 
D.C./D.S. repeat jumps are removed and replaced with your custom text.

Hiding/Showing repeat markers
You can hide/show repeat markers individually; for example, if you want a separated coda 
section without showing the coda symbol and text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the repeat markers you want to hide, or the signposts of repeat markers you want to 
show.

2. In the Properties panel, activate/deactivate Hide in the Repeat Markers group.

RESULT
The selected repeat markers are hidden when Hide is activated, and shown when it is 
deactivated.

Signposts are shown at the position of each hidden repeat marker. However, signposts are not 
printed by default.

TIP

You can hide/show repeat marker signposts by choosing View > Signposts > Repeat Markers.

RELATED LINKS
Signposts on page 407
Hiding/Showing zones on page 41
Annotations on page 507

Repeat markers
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Input methods for repeats and tremolos on page 372

Positions of repeat markers
Repeat markers are placed above the staff by default, and at the same positions as other system 
objects. Coda sections are separated from the preceding music by a gap in the system.

You can move repeat markers to different rhythmic positions in Write mode.

You can change the default staff-relative placement of repeat markers in each layout 
independently in the Repeat Markers section of the Staves and Systems page in Layout 
Options.

Repeat markers are categorized as system objects in Dorico SE, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently; for example, if you want repeat markers to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Input methods for repeats and tremolos on page 372
Layout Options dialog on page 622
Changing the positions of system objects on page 1045
Changing the staff-relative placement of repeat markers on page 982
Moving notes/items rhythmically on page 417
Repeats in playback on page 463

Changing the staff-relative placement of repeat markers
You can show repeat markers either above, below, or both above and below the staff in each 
layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff-placement of 
repeat markers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Repeat Markers section, choose one of the following options for Default placement 
for repeat jumps and ‘Fine’:

● Above staff

● Below staff

● Above and below bottom staff

5. Click Apply, then Close.

RESULT
The staff-relative placement of all repeat markers is changed in the selected layouts.

Repeat markers
Positions of repeat markers 
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Repeat counts
Repeat counts at end repeat barlines tell performers how many times to play through sections of 
music. This is particularly helpful for sections played through three or more times, as end repeat 
barlines typically indicate that the preceding music is played through twice.

By default, Dorico SE shows repeat counts at system object positions for end repeat barlines set 
to have three or more playthroughs, when repeats are included in playback.

Repeat count at the end of a section, indicating it should be played four times

Repeat counts are right-aligned with their end repeat barline by default. You can change the 
location of repeat counts; for example, if you want to show repeat counts at both the start and 
end of repeated sections, or hide repeat counts entirely. Repeat counts shown at the start of 
repeated sections are left-aligned with start repeat barlines.

RELATED LINKS
Changing the number of playthroughs at repeat barlines on page 464
Repeats in playback on page 463
Input methods for bars, beats, and barlines on page 275
System objects on page 1044
Changing the application language on page 48
Bar repeat counts on page 987
Slash region counts on page 1003
Numbered bar region counts on page 993

Changing the location of repeat counts
You can change the location of individual repeat counts relative to the repeated section. For 
example, if you want to show some repeat counts at the start of repeated sections or hide some 
repeat counts entirely. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● Repeats are included in playback.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the end repeat barlines or repeat counts whose count location you want to change.

2. In the Properties panel, activate Count location in the Time Signatures group.

3. Select one of the following options from the menu:

Repeat markers
Repeat counts 
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● Start

● End

● Neither

● Both

RESULT
The location of the selected repeat counts is changed. Repeat counts shown at the start of 
repeated sections are left-aligned with the start repeat barlines that correspond to the selected 
end repeat barlines.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

EXAMPLE

Both Neither

RELATED LINKS
Repeats in playback on page 463
Hiding/Showing zones on page 41
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Repeat markers
Repeat counts 
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Bar repeats

Bar repeats indicate that the musical material in preceding bars must be repeated exactly, but 
without notating that material again. Bar repeats can comprise groups of one, two, or four bars.

For example, a one-bar repeat indicates that the material in one bar is repeated, meaning every 
bar in the region repeats the same material. A four-bar repeat indicates that the material in the 
previous four bars is repeated.

One-bar repeat region Two-bar repeat region

Four-bar repeat region

This notation short-hand can make repetitive music easier to read, as performers must only read 
the repeated phrase once and then simply count how many times they repeat it. Bar repeats can 
also save horizontal space, as bar repeat symbols are usually narrower than the equivalent fully 
written-out bars.

In Dorico SE, bar repeat regions are used to display bar repeats, meaning as many bar repeat 
symbols as necessary to fill the region are shown automatically.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

By default, bar repeat regions are highlighted with a colored background. As you zoom out, the 
highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide/show them.

You can also show adjacent bar repeat regions; for example, if you want to use a two-bar repeat 
in the first iteration of a phrase, and then a four-bar repeat to indicate the whole phrase is 
repeated. When two different bar repeat regions are adjacent, they alternate highlight colors to 
ensure the separate regions are always identifiable.

Phrase containing two adjacent bar repeat regions
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RELATED LINKS
Inputting bar repeats on page 385
Repeats popover on page 373
Bar repeat counts on page 987
Bar repeat grouping on page 990
Numbered bar regions on page 992
Slash regions on page 997
Repeat counts on page 983
Moving notes/items rhythmically on page 417
Lengthening/Shortening items on page 396
Hiding/Showing multi-bar rests on page 1015
Types of barlines on page 672
Changing the number of playthroughs at repeat barlines on page 464
Annotations on page 507

Changing the length of the repeated phrase in bar repeat 
regions

You can change the number of bars that make up the repeated phrase in individual bar repeats 
after you have input them; for example, if you want the region to repeat the previous two bars 
rather than the previous four bars.

NOTE

You cannot repeat more bars than exist before the bar repeat region. For example, if a bar 
repeat region follows the first notated bar in a flow, you cannot increase the number of bars in 
the repeated phrase.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the bar repeat regions whose phrase length you want to change.

2. In the Properties panel, select one of the following options from the No. bars menu in the 
Bar Repeat Regions group:

● One bar

● Two bars

● Four bars

RESULT
The number of bars that make up the repeated phrase in the selected bar repeat regions is 
changed. This is also reflected in playback.

TIP

● Any dynamics you add within bar repeat regions affect the playback of the repeated music.

● You can also change the length of the repeated phrase by opening the repeats popover and 
changing the entry.

Bar repeats
Changing the length of the repeated phrase in bar repeat regions 
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RELATED LINKS
Bar repeat grouping on page 990
Inputting bar repeats on page 385
Repeats popover on page 373
Changing existing items on page 398

Hiding/Showing region highlights
You can hide/show colored highlights for bar repeat and numbered bar regions at any time; 
for example, if you want to show the highlights when inputting music but hide them when 
engraving.

PROCEDURE

● Choose View > Highlight Bar Repeat Regions.

RELATED LINKS
Numbered bar regions on page 992

Bar repeat counts
Bar repeat counts are numbers shown at regular intervals either above or below bar repeats, to 
help performers keep track of how many bars have passed. The intervals are usually based on 
typical musical phrases, such as every four or eight bars.

NOTE

Bar repeat counts are only shown on one-bar repeat regions.

Because bar repeats must start with a fully notated phrase of at least one bar, the bar repeat 
count starts from the notated bar rather than the first bar in the bar repeat region. For example, 
the third bar in a bar repeat region shows the count number 4, as that bar is the fourth time the 
original notated bar is played. Each bar repeat region has its own separate count.

Bar repeat region with counts shown every four bars

In Dorico SE, you can change the start count of each bar repeat region, how frequently counts 
are shown, and whether counts are shown with parentheses, without parentheses, or hidden.

RELATED LINKS
Repeats popover on page 373
Inputting bar repeats on page 385
Bar repeat grouping on page 990
Hiding/Showing bar number ranges on multi-bar rests on page 679
Hiding/Showing multi-bar rests on page 1015
Repeat counts on page 983
Slash region counts on page 1003
Numbered bar region counts on page 993

Bar repeats
Hiding/Showing region highlights 
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Changing the start count of bar repeats
You can change the number from which individual bar repeats start; for example, if you want to 
notate the first bar in a repeated phrase at the start of each system, but show a continuous count 
across multiple bar repeats.

NOTE

● The start count applies to the first bar in the bar repeat, which is the notated bar. For 
example, changing the start count of a one-bar repeat region lasting three bars to 5, with 
bar repeat counts shown every four bars, causes the count at the end of the bar repeat 
region to show the number 8.

● Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the one-bar repeat regions whose start count you want to change.

2. In the Properties panel, activate Count from in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The start count of the selected bar repeat regions is changed. If the count frequency is every two 
bars or more, counts appear on different bars. For example, changing the start count from 1 to 
2, with counts shown every four bars, causes the count to appear on the second bar in the bar 
repeat region instead of the third.

EXAMPLE

Separate bar repeats on multiple systems in the 
same part layout with the default count

Separate bar repeats on multiple systems in the 
same part layout with their counts changed to imply 
a continuous region

Changing the bar repeat count frequency
You can change how often counts are shown on individual one-bar repeat regions; for example, if 
you want to show the count after eight bars on a single bar repeat region.

Bar repeats
Bar repeat counts 
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NOTE

Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the one-bar repeats whose count frequency you want to change.

2. In the Properties panel, activate Count frequency in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected bar repeat regions.

RELATED LINKS
Bar repeat counts on page 987
Hiding/Showing bar number ranges on multi-bar rests on page 679

Hiding/Showing or parenthesizing bar repeat counts
You can hide counts or show counts with or without parentheses for individual bar repeat 
regions. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

NOTE

Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the one-bar repeats whose counts you want to hide/show or parenthesize.

2. In the Properties panel, activate Count appearance in the Bar Repeat Regions group.

3. Select one of the following options from the menu:

● With parentheses

● Without parentheses

● Do not show

RESULT
Counts in the selected bar repeat regions are shown with parentheses, without parentheses, or 
hidden. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Bar repeats
Bar repeat counts 
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RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Bar repeat grouping
Bar repeat grouping allows you to consolidate longer bar repeat regions, which can be helpful in 
very regular music as it can simplify the overall phrasing.

The symbols shown on the staff are different for the different groupings, and two-bar and 
four-bar repeats also show a number to indicate how many bars are included in the group.

One-bar repeat symbol Two-bar repeat symbol Three-bar repeat symbol Four-bar repeat symbol

You can specify the grouping when inputting bar repeats, and you can change the grouping 
of bar repeats after they have been input. Depending on where the bar repeat region starts 
and ends relative to the written material, Dorico SE automatically adjusts the displayed symbols 
to achieve an accurate result. For example, an eight-bar phrase containing a single notated 
bar followed by seven one-bar repeats grouped every four bars is automatically shown with a 
one-bar repeat, two-bar repeat, then four-bar repeat to fill the seven bars.

Eight-bar phrase with seven one-bar repeats grouped every four bars

TIP

When showing multi-bar rests, you can also choose to consolidate one-bar repeat regions.

RELATED LINKS
Repeats popover on page 373
Inputting bar repeats on page 385
Hiding/Showing multi-bar rests on page 1015

Changing bar repeat grouping
You can change how bar repeats are grouped after they have been input; for example, if you 
want to group a region of one-bar repeats every two bars.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the bar repeat regions whose grouping you want to change.

Bar repeats
Bar repeat grouping 
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2. In the Properties panel, select one of the following options from the Group every menu in 
the Bar Repeat Regions group:

● One bar

● Two bars

● Four bars

NOTE

The options available depend on the minimum length of the selected bar repeat regions. For 
example, if you select bar repeat regions that last three bars, only One bar and Two bars are 
available in the menu.

RESULT
The grouping in the selected bar repeat regions is changed. Dorico SE automatically calculates 
the clearest way to group the region. For example, an eight-bar phrase containing a single 
notated bar followed by seven one-bar repeats grouped every four bars is automatically shown 
with a one-bar repeat, two-bar repeat, then four-bar repeat to fill the seven bars.

Bar repeats
Bar repeat grouping 
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Numbered bar regions

Numbered bar regions allow you to show bar counts in specific regions without additional 
notations. This can help performers keep track of how many bars have passed when playing 
repetitive music.

Numbered bar region spanning six bars

By default, numbered bar regions are hidden in full score/custom score layouts and shown in 
part layouts. You can hide/show numbered bar regions in each layout independently.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

By default, numbered bar regions are highlighted with a colored background. As you zoom out, 
the highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide/show them.

When two different numbered bar regions are adjacent, they alternate highlight colors to ensure 
the separate regions are always identifiable.

Phrase containing two adjacent numbered bar regions

RELATED LINKS
Inputting numbered bar regions on page 386
Hiding/Showing region highlights on page 987
Lengthening/Shortening items on page 396
Bar repeats on page 985
Slash regions on page 997
Repeat counts on page 983
Bar numbers on page 677
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Hiding/Showing numbered bar regions
You can input numbered bar regions in any layout, but by default they do not appear in full 
score layouts, as they are normally most useful in part layouts. You can hide/show numbered bar 
regions in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show numbered bar regions.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Numbered Bar Regions section, activate/deactivate Show bar count in numbered 
bar regions.

5. Click Apply, then Close.

RESULT
Numbered bar regions are shown in the selected layouts when the checkbox is activated, and 
hidden when the checkbox is deactivated.

Numbered bar region counts
Numbered bar region counts are numbers shown at regular intervals either above or below the 
staff, to help performers keep track of how many bars have passed.

By default, bar counts are shown on every bar in numbered bar regions. They are also shown on 
the last bar in each system and on the first and last bars in each region, regardless of the count 
frequency.

When numbered bar regions last four or more bars, Dorico SE adds the total range in 
parentheses to the count on the first bar, such as showing “1 (-8)” on the first bar in a numbered 
bar region lasting eight bars.

Numbered bar region with counts shown every three bars, count and range shown at the start, and 
parenthesized count shown at the end of the system

In Dorico SE, you can change the start count of each numbered bar region, how frequently 
counts are shown, their staff-relative placement, and whether counts and ranges are shown with 
parentheses, without parentheses, or hidden.

RELATED LINKS
Inputting numbered bar regions on page 386
Repeat counts on page 983
Bar repeat counts on page 987
Slash region counts on page 1003

Numbered bar regions
Hiding/Showing numbered bar regions 
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Changing the start count of numbered bar regions
You can change the number from which individual numbered bar regions start; for example, if 
you want to show a continuous count across multiple numbered bar regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the numbered bar regions whose start count you want to change.

2. In the Properties panel, activate Count from in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The start count of the selected numbered bar regions is changed. If the count frequency is every 
two bars or more, counts appear on different bars. For example, changing the start count from 
1 to 2, with counts shown every four bars, causes the count to appear on the third bar in the 
region instead of the fourth.

Changing the numbered bar region count frequency
You can change how frequently counts are shown in individual numbered bar regions; for 
example, if you want to show the count after eight bars in a single numbered bar region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the numbered bar regions whose count frequency you want to change.

2. In the Properties panel, activate Count frequency in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected numbered bar regions.

RELATED LINKS
Hiding/Showing bar number ranges on multi-bar rests on page 679

Hiding/Showing or parenthesizing numbered bar region counts
You can show counts with or without parentheses for individual numbered bar regions. You can 
also hide/show or parenthesize counts at the ends of systems and on the first and last bars in 
each region independently of each other. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

Numbered bar regions
Numbered bar region counts 
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● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the numbered bar regions whose counts you want to hide/show or parenthesize.

2. In the Properties panel, activate Count appearance in the Bar Repeat Regions group.

3. Select one of the following options from the menu:

● Without parentheses

● With parentheses

4. Activate Range appearance and select one of the following options from the menu:

● With parentheses

● Without parentheses

● No range

5. Activate the following properties, individually or together, to change the appearance of the 
corresponding count:

● Show in first bar

● Show in final bar

● Show at ends of systems

6. Select one of the following options from each menu:

● With parentheses

● Without parentheses

● Do not show

RESULT
The corresponding counts and ranges in the selected numbered bar regions are shown with 
parentheses, without parentheses, or hidden. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

EXAMPLE

Counts and range shown without parentheses Range hidden and counts shown with parentheses

RELATED LINKS
Numbered bar region counts on page 993
Inputting numbered bar regions on page 386
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Numbered bar regions
Numbered bar region counts 
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Changing the staff-relative placement of numbered bar region 
counts

You can show the counts in individual numbered bar regions either above or below the staff. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

Changing the staff-relative placement of counts affects all counts in the region. You cannot 
change the placement of a single count independently of other counts in the region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the numbered bar regions whose count staff-relative placement you want to change.

2. In the Properties panel, activate Staff-relative position in the Bar Repeat Regions group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of all counts in the selected numbered bar regions is changed. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Numbered bar regions
Numbered bar region counts 
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Rhythm slashes

Rhythm slashes are diagonal lines positioned on staves that are used to indicate that performers 
should play something, but without specifying the exact rhythms and pitches. They are often 
accompanied by chord symbols to indicate the set of notes the performer should use.

There are two different types of rhythm slashes:

Slashes with stems

Slashes with stems usually indicate the rhythm to be played, but not the pitches. Also 
known as “rhythmic notation”.

Slashes without stems

Slashes without stems do not usually indicate either rhythms or pitches. Also known as 
“slash notation”

In Dorico SE, you can present both types of rhythm slashes simultaneously by using a 
combination of slash regions and slash voices.

RELATED LINKS
Slash voices on page 1005
Inputting notes into slash voices on page 209
Chord symbols on page 713
Hiding/Showing chord symbols on page 714

Slash regions
Slash regions automatically display rhythm slashes as appropriate for the meter throughout their 
duration; for example, they show four slashes per bar in 4/4 and two slashes per bar in 6/8 by 
default. A single slash region can extend across multiple different meters.

A single slash region covering multiple different meters

Multiple slash regions can exist at the same rhythmic position. When slash regions overlap, 
Dorico SE treats this as a multiple-voice context and changes the staff position of slashes 
automatically.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.
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By default, slash regions are highlighted with a colored background. As you zoom out, the 
highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide/show them.

When two different slash regions are adjacent, they alternate highlight colors to ensure the 
separate regions are always identifiable.

Two adjacent slash regions with different highlight colors

You can use slash regions and slash voices in the same project and at the same rhythmic 
positions; for example, you can input a slash region where you do not want to be specific about 
the rhythm, then input notes in a slash voice for a single bar where you want to specify an exact 
rhythm.

TIP

Because rhythm slashes are often accompanied by chord symbols to indicate the set of notes 
the performer should use, you can hide/show chord symbols in slash/chord symbol regions on 
instrument staves where chord symbols are hidden.

RELATED LINKS
Inputting slash regions on page 384
Slash voices on page 1005
Slash region counts on page 1003
Slashes in multiple-voice contexts on page 999
Moving notes/items rhythmically on page 417
Lengthening/Shortening items on page 396
Hiding/Showing notes alongside slash regions on page 1000
Hiding/Showing chord symbols on page 714
Chord symbol regions on page 718
Numbered bar regions on page 992
Bar repeats on page 985
Repeat counts on page 983
Annotations on page 507

Hiding/Showing slash region highlights
You can hide/show the colored highlights for slash regions at any time; for example, if you want 
to show the highlights when inputting music but hide them when engraving.

PROCEDURE

● Choose View > Highlight Slash Regions.

Rhythm slashes
Slash regions 
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Slashes in multiple-voice contexts
Multiple slash regions and slash voices can exist at the same rhythmic positions. In multiple-voice 
contexts for slash voices and when slash regions overlap, Dorico SE automatically changes their 
staff position and offset to accommodate all slashes as legibly as possible.

Single slash region Two slash regions, one up-stem and one down-stem

You can also control the positions of rhythm slashes relative to each other manually by changing 
their stem/voice direction and by changing their staff position.

RELATED LINKS
Note positions in multiple-voice contexts on page 1136
Changing the voice of existing notes on page 422

Changing the voice direction of slash regions
You can change the voice direction of slash regions individually. When multiple slash regions 
overlap, this affects their stem directions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select any part of each slash region whose voice direction you want to change.

2. In the Properties panel, activate Voice direction in the Slash Regions group.

3. Choose one of the following options:

● Up

● Down

RESULT
The voice direction, and therefore stem direction, of the selected slash regions is changed.

NOTE

This only affects the direction of stems in slash regions on the middle line of the staff and when 
multiple slash regions exist at the same rhythmic position. For example, if you change the voice 
direction of a slash region on the bottom line of the staff to Down, its stem direction does not 
change if it does not overlap with another slash region.

RELATED LINKS
Stem direction on page 854

Rhythm slashes
Slashes in multiple-voice contexts 
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Changing the staff position of rhythm slashes
You can change the staff position of rhythm slashes in both slash voices and slash regions; for 
example, to accommodate other notes at the same rhythmic positions better. By default, rhythm 
slashes are positioned on the middle line of the staff.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the rhythm slashes whose staff position you want to change.

● For notes in slash voices, you must select every note whose staff position you want to 
change.

● For slash regions, you can select any part of each region whose staff position you want 
to change.

2. In the Properties panel, activate Slash pos. in the corresponding group for the type of 
rhythm slash whose staff position you want to change:

● Notes and Rests for notes in slash voices

● Slash Regions for slash regions

3. Change the value in the value field.

RESULT
The staff position of the selected rhythm slashes is changed. For example, changing the Slash 
pos. value to 4 positions rhythm slashes on the top line of a five-line staff, while -4 positions them 
on the bottom line.

If any of the rhythm slashes have stems, their stem direction is adjusted automatically.

Hiding/Showing notes alongside slash regions
You can hide/show notes at the same rhythmic positions as slash regions; for example, if you 
want to input notes to hear in playback but only want to show the slash region, or if you want to 
notate suggested notes in addition to the slash region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select any part of each slash region alongside which you want to hide/show other notes.

2. In the Properties panel, activate/deactivate Show other voices in the Slash Regions group.

RESULT
All notes in other voices present alongside the selected slash regions are shown when Show 
other voices is activated, and hidden when it is deactivated.

Rhythm slashes
Slashes in multiple-voice contexts 
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EXAMPLE

Notes hidden alongside a slash region Notes shown alongside a slash region

RELATED LINKS
Slash regions on page 997
Slash voices on page 1005
Hiding/Showing slash region highlights on page 998
Inputting slash regions on page 384

Hiding/Showing padding rests before/after slash regions
You can hide/show padding rests before/after slash regions that start partway through bars 
individually; for example, if you have other notes at those positions and the rests would be 
misleading. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

By default, Dorico SE automatically shows implicit padding rests around slash regions that 
start/end partway through bars, so that the full duration of each bar is clear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose padding rests you want to hide/show.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slash Regions group:

● Hide rests before start

● Hide rests after end

RESULT
Padding rests are hidden on the corresponding side of the selected slash regions. For example, 
activating both properties hides padding rests both before and after the selected slash regions. 
If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Implicit vs. explicit rests on page 1009
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Rhythm slashes
Slashes in multiple-voice contexts 
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Splitting slash regions
You can split slash regions after they have been input; for example, if you later want to input 
more precise notation in the middle of an existing slash region.

PROCEDURE

1. In Write mode, select a slash in each slash region you want to split, immediately to the right 
of where you want to split them.

2. Split the slash regions in any of the following ways:

● Press U .

● In the Notes toolbox, click Scissors .

RESULT
The slash regions are split immediately to the left of the selected slashes. Each part now has its 
own start/end handles, which you can use to lengthen/shorten each part independently.

RELATED LINKS
Notes toolbox on page 173
Slash regions on page 997
Changing the slash region count frequency on page 1004
Lengthening/Shortening items on page 396
Moving notes/items rhythmically on page 417

Hiding/Showing stems in slash regions
You can hide/show stems and beams, where applicable, on slashes in individual slash regions. By 
default, slashes in slash regions are shown without stems.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select any part of each slash region in which you want to hide/show stems.

2. In the Properties panel, activate Slash type in the Slash Regions group.

3. Choose one of the following options:

● With stems

● Without stems

RESULT
Stems are hidden in the selected slash regions when you choose Without stems, and shown 
when you choose With stems. If appropriate for the prevailing meter, such as 3/8, beams are 
shown in addition to stems.

Rhythm slashes
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Slash region counts
Slash region counts are numbers shown at regular intervals, either above or below slash regions, 
to help performers keep track of how many bars have passed. The intervals are usually based on 
typical musical phrases, such as every four or eight bars.

By default, slash region counts are shown in parentheses every four bars and are placed below 
the staff. Each slash region has its own separate count.

Slash region with counts shown every two bars

In Dorico SE, you can change the start count of each slash region, how frequently counts are 
shown, their staff-relative placement, and whether counts are shown with parentheses, without 
parentheses, or hidden.

RELATED LINKS
Slash regions on page 997
Repeat counts on page 983
Bar repeat counts on page 987
Numbered bar region counts on page 993

Changing the start count of slash regions
You can change the number from which individual slash region counts start; for example, if you 
want to input more precise notation between two slash regions but want the count to appear to 
continue across the regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select any part of each slash region whose start count you want to change.

2. In the Properties panel, activate Count from in the Slash Regions group.

3. Change the value in the value field.

RESULT
The start count of the selected slash regions is changed. If the count frequency is every two bars 
or more, counts appear on different bars. For example, changing the start count from 1 to 2, with 
counts shown every four bars, causes the count to appear on the third bar in the region instead 
of the fourth.

Rhythm slashes
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EXAMPLE

Two separate slash regions, where the start count in the second region has been changed so it appears to 
continue on from the first region.

Changing the slash region count frequency
You can change how frequently counts are shown on individual slash regions; for example, if you 
want to show the count after eight bars on a single slash region. By default, slash region counts 
are shown every four bars.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select any part of each slash region whose count frequency you want to change.

2. In the Properties panel, activate Count frequency in the Slash Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected slash regions.

RELATED LINKS
Splitting slash regions on page 1002
Hiding/Showing bar number ranges on multi-bar rests on page 679

Hiding/Showing or parenthesizing slash region counts
You can hide counts or show counts with or without parentheses for individual slash regions. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose counts you want to hide/show or parenthesize.

2. In the Properties panel, activate Count appearance in the Slash Regions group.

3. Select one of the following options from the menu:

● With parentheses

● Without parentheses

Rhythm slashes
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● Do not show

RESULT
Counts in the selected slash regions are shown with parentheses, without parentheses, or 
hidden. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the staff-relative placement of slash region counts
You can show the counts in individual slash regions either above or below the staff. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

Changing the staff-relative placement of counts affects all counts in the region. You cannot 
change the placement of a single count independently of other counts in the region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose count staff-relative placement you want to 
change.

2. In the Properties panel, activate Count position in the Slash Regions group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of all counts in the selected slash regions is changed. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

Slash voices
Slash voices allow you to notate specific rhythms for rhythm slashes. They behave similarly to 
normal voices as you must input notes and rhythms manually, but all notes in slash voices are 
positioned by default on the middle line of the staff, regardless of the pitches you input.

If you later change the time signature, such as from 3/4 to 6/8, Dorico SE only changes the note 
grouping to fit the meter just like for other notes; it does not change the presentation of rhythm 
in slash voices like it does for slash regions.

Rhythm slashes
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NOTE

● Because you can change notes in slash voices to normal voices and vice versa, the pitches 
you input are retained.

● Notes in slash voices are not played back.

You can have multiple slash voices active at the same time. To accommodate all slash voices in 
multiple-voice contexts, Dorico SE changes their staff position automatically. However, you can 
also change the staff position of rhythm slashes manually.

You can use slash regions and slash voices in the same project and at the same rhythmic 
positions; for example, you can input a slash region where you do not want to be specific about 
the rhythm, then input notes in a slash voice for a single bar where you want to specify an exact 
rhythm.

RELATED LINKS
Rhythm slashes on page 997
Slash regions on page 997
Slashes in multiple-voice contexts on page 999
Implicit rests in multiple-voice contexts on page 1010
Inputting notes into slash voices on page 209
Changing the voice of existing notes on page 422

Changing the slash voice type
You can change the voice type of slash voices; for example, if you want to change a slash voice 
from having stems to being stemless. You can also change the type to normal notes, which 
restores the original pitches you input, and change normal notes to rhythm slashes.

NOTE

This affects all notes in the same voice. If you only want to change the slash voice type of some 
notes, you must change the voice of those notes instead.

PROCEDURE

1. Select a note in the voice whose slash type you want to change.

2. Choose Edit > Notations > Voices > Rhythmic Slashes > [Voice type].

For example, to change a whole normal voice to a stemless slash voice, choose Edit > 
Notations > Voices > Rhythmic Slashes > Slashes without Stems.

TIP

You can also choose these options from the context menu.

RESULT
The slash voice type of all notes in the same voice and flow as the selected note is changed.

If you change normal notes to a slash voice, they are all automatically positioned on a single staff 
line. By default in single-voice contexts, this is the middle line of the staff.

If you change rhythm slashes to normal notes, their original pitches are restored, meaning their 
staff positions reflect their pitches.

Rhythm slashes
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RELATED LINKS
Inputting notes into slash voices on page 209
Changing the voice of existing notes on page 422

Adding slash voices to percussion kits
You can add slash voices to percussion kits; for example, to show the desired rhythm for a 
passage without specifying the instruments to be played. You can add multiple slash voices to 
the same kit, including slash voices with and without stems.

NOTE

Rhythm slashes in percussion kits only appear when the five-line staff presentation is used. They 
do not appear in grid or single-line instrument presentations.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the percussion kit 
to which you want to add slash voices.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. In the action bar below the five-line staff editor, click the button that corresponds to the type 
of slash voice you want to add.

● Slashes with stems 

● Slashes without stems 

RESULT
The corresponding type of slash voice is added to the kit. It is positioned on the middle line of the 
staff by default.

During note input, you can move the caret to slash voices just like moving it to other instruments 
in the kit, and input notes into slash voices just like inputting notes in percussion kit instruments.

AFTER COMPLETING THIS TASK
You can change the staff position of slash voices in the kit.

RELATED LINKS
Percussion kit presentation types on page 1126
Voices in percussion kits on page 1131
Players panel on page 94
Edit Percussion Kit dialog on page 136
Inputting notes for unpitched percussion on page 213
Changing the positions of instruments within percussion kits on page 142
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Rests

Rests are markings with a rhythmic value that indicate no note is played for that duration. Each 
note duration has an equivalent rest; for example, a quarter note rest is different to a sixteenth 
note rest.

All notes and rests within a bar must add up to the duration of the bar, according to the 
prevailing time signature. Dorico SE automatically fills the gaps between notes with implicit rests 
of the appropriate duration. Therefore, it is usually not necessary to input rests in Dorico SE.

The table shows some examples of notes and the rests with the equivalent rhythmic value.

Duration Note Rest

Half

Quarter

Eighth

Sixteenth

RELATED LINKS
Inputting rests on page 221
Deleting rests on page 1012
Inputting notes on page 197
Note and rest grouping on page 705
Implicit rests in multiple-voice contexts on page 1010
Showing figured bass on rests on page 773

General placement conventions for rests
Rests are positioned at the rhythmic position at the start of their duration, and not in the middle 
of beats as this can cause confusion over when the rest begins and ends. Rests are aligned with 
other items at the same rhythmic position.

The only exception is whole bar rests, which are positioned at the visual center of bars. This way, 
they are clearly distinguishable from half note and whole note rests that are followed by notes in 
the same bar.

Rests stay within the staff wherever possible. They do not move above or below the staff when 
the notes around them are very high or very low.
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However, on staves with multiple voices, rests are placed higher on the staff, or above the staff, 
for up-stem voices and lower on the staff, or below the staff, for down-stem voices.

Example rest positions in a multiple-voice context

Rests in multiple voices must not overlap. You can consolidate rests so that only one is shown 
when multiple voices have a rest of the same duration at the same rhythmic position.

The precise vertical positioning of rests is limited, as their detailed shapes require specific 
positions relative to staff lines and staff spaces.

RELATED LINKS
Voices on page 1134
Inputting notes into multiple voices on page 207
Creating cross-staff beams/tremolos on page 697

Implicit vs. explicit rests
Implicit rests are automatically shown between the notes you input, and their duration 
automatically follows the time signature and their position in the bar. Explicit rests are rests that 
are explicitly entered during note input by forcing their duration, or rests that were imported 
from a MusicXML file.

Dorico SE notates implicit rests according to the prevailing time signature; for example, different 
implicit rests are shown in 6/8 compared to 4/4. This also applies if you later change the time 
signature for existing notes and rests.

Therefore, it is not necessary to input rests in Dorico SE, as implicit rests are automatically shown 
around the notes that you input. You can turn implicit rests into explicit rests by forcing their 
duration to be fixed.

A quarter note input at the fourth eighth note of 
the bar in a 6/8 time signature has a dotted quarter 
implicit rest at the start of the bar.

A quarter note input at the fourth eighth note of the 
bar in a 4/4 time signature has two implicit rests, a 
quarter and an eighth, at the start of the bar.

Explicit rests cannot be suppressed when using the Starts voice and Ends voice properties to 
hide rests before the first note in voices and after the last note in voices.

You can show rest colors to see which rests are implicit and which are explicit in your project.

RELATED LINKS
Inputting rests on page 221
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Inputting notes on page 197
Deleting rests on page 1012
Forcing the duration of notes/rests on page 238
Turning explicit rests into implicit rests on page 1011
Hiding/Showing rest colors on page 1011

Implicit rests in multiple-voice contexts
In Dorico SE, implicit rests are shown automatically to fill in rhythmic positions around notes, 
including when there are multiple voices on the staff. However, in these contexts you might want 
more control over when and where rests are shown.

Usually, rests or notes are shown for whole bars when voices contain at least one note in the bar. 
This helps make the rhythmic position of every note in all voices in the bar immediately clear.

When there are multiple voices on a staff, implicit rests are shown in every bar in which there are 
notes of any duration in more than one voice. Bar rests are always shown for the first voice on a 
staff, including in bars that only contain notes in a slash voice.

However, there might be circumstances in which you do not want to show rests either before the 
first note in a voice or after the last note in a voice when there are multiple voices on the staff. 
For example, it can be useful to hide rests when a voice is being used to show passing notes 
within a bar that otherwise contains a single melodic line.

A second voice used to notate passing notes

You can also delete rests from selected passages.

TIP

By default, Dorico SE consolidates rests when multiple voices have rests of the same duration at 
the same rhythmic position.

You can show multiple rests at individual rhythmic positions by changing the vertical position of 
rests.

A phrase with multiple voices showing implicit rests. The same phrase without implicit rests.
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RELATED LINKS
Moving rests vertically on page 1012
Deleting rests on page 1012
Slash voices on page 1005

Turning explicit rests into implicit rests
Implicit rests and explicit rests behave differently. For example, you can hide implicit rests using 
the Properties panel, but you cannot hide explicit rests or rests with forced durations.

NOTE

You can only hide implicit rests using Starts voice and Ends voice in the Notes and Rests group 
of the Properties panel.

PROCEDURE

1. In Write mode, select the explicit rests you want to turn into implicit rests.

2. Press Backspace or Delete .

RESULT
The selected explicit rests are now implicit rests. You can check this by showing rest colors.

RELATED LINKS
Hiding/Showing rest colors on page 1011
Deleting rests on page 1012

Hiding/Showing rest colors
You can hide/show rest colors, which causes implicit rests and explicit rests to appear with 
different colors.

When rest colors are shown, implicit rests appear gray and explicit rests appear black. For 
example, this can help diagnose why rests do not disappear when you activate Starts voice and 
Ends voice, as these properties only hide implicit rests.

PROCEDURE

● Choose View > Note And Rest Colors > Implicit Rests.

RESULT
Rest colors are hidden/shown.

EXAMPLE

Rest colors hidden Rest colors shown

Rests
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AFTER COMPLETING THIS TASK
You can delete rests that you have identified as explicit rests. The implicit rests that replace them 
now respect the Starts voice and Ends voice properties.

Moving rests vertically
You can change the vertical position of rests individually; for example, if you want to change 
the staff line from which a whole bar rest hangs, or you want to show rests for all voices at a 
particular rhythmic position. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

Moving rests vertically shows multiple rests at that rhythmic position if more than one voice on 
the staff has a rest of the same duration. By default, Dorico SE consolidates coincident rests of 
the same duration in multiple-voice contexts and automatically positions rests in multiple-voice 
contexts to avoid collisions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the rests whose vertical positions you want to change, or rests at the rhythmic 
positions where you want to see rests for every voice.

2. In the Properties panel, activate Rest pos. in the Notes and Rests group.

3. Change the value in the value field.

RESULT
Increasing the value moves rests upwards, decreasing the value moves rests downwards. 
Position 0 is the middle line of the staff. If there are multiple voices on the staff with rests of 
the same duration at the same rhythmic position, multiple rests are now shown.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

Deactivating Rest pos. returns the selected rests to their default positions.

RELATED LINKS
Note spacing on page 533
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Deleting rests
You can delete both implicit rests and explicit rests; for example, if you want to hide rests before/
after notes in another voice used to show passing notes.

TIP

● If you want to delete rests because you want to remove the corresponding duration from the 
flow, you can instead delete bars/beats.
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● If you want to delete rests because you do not want to show bar rests in empty bars, you can 
instead hide bar rests.

PROCEDURE

1. In Write mode, select the rests you want to delete.

TIP

You can select rests individually, or make a larger selection that contains the rests you want 
to delete.

2. Choose Edit > Remove Rests.

RESULT
All rests in the selection are deleted. This is done by automatically activating Starts voice 
and Ends voice in the Notes and Rests group of the Properties panel on the notes or rests 
immediately to the right/left of deleted rests, so that no rests are shown in the selected regions.

NOTE

● You can show rests again later by selecting the notes or rests immediately to the right/left of 
deleted rests, then deactivating the corresponding Starts voice or Ends voice properties in 
the Notes and Rests group of the Properties panel.

● You can assign a key command for Remove Rests on the Key Commands page in 
Preferences.

● In layouts where no other notes, rests, or items with duration exist at rhythmic positions 
where you have deleted rests, Dorico SE has nothing to use to calculate horizontal spacing. 
Therefore, such empty bars/beats can appear narrower.

EXAMPLE

A phrase with multiple voices showing implicit rests. The same phrase after deleting the rests.

RELATED LINKS
Implicit vs. explicit rests on page 1009
Large selections on page 389
Deleting bars/beats on page 667
Note spacing on page 533
Changing the horizontal justification of final systems on page 522
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Hiding/Showing bar rests in empty bars
You can hide/show bar rests in empty bars in each layout independently. For example, you can 
hide bar rests in full score layouts but show bar rests in part layouts.

Bar rests are usually shown in empty bars in music to indicate to performers that they have 
nothing to play. However, there are contexts in which it is preferable to hide bar rests in empty 
bars, and instead leave the bar completely empty.

For example, hiding bar rests in empty bars is sometimes the preferred visual aesthetic in large 
scores, so that it is quicker to identify bars containing music. You can also hide bar rests in 
layouts where you want to include other instructions, such as verbal indications for performers 
to do something other than play notated pitches.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar rests in empty 
bars.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Bar Rests and Multi-bar Rests section, activate/deactivate Show bar rests in empty 
bars.

5. Click Apply, then Close.

RESULT
All bar rests in empty bars in the selected layouts are shown when the checkbox is activated, and 
hidden when the checkbox is deactivated.

RELATED LINKS
Hiding/Showing multi-bar rests on page 1015

Multi-bar rests
Multi-bar rests group two or more consecutive empty bars together into a single unit, commonly 
shown with a thick horizontal line positioned on the middle staff line, known as an “H-bar”. They 
can reduce the horizontal space required by multiple empty bars and make it easier for players 
to find their place in the music.

A multi-bar rest representing four empty bars
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NOTE

Multi-bar rests are automatically split by items positioned within their range, such as system-
attached text, rehearsal marks, and holds and pauses. However, if items are positioned at the 
start of the first bar in a multi-bar rest, that bar remains part of the subsequent multi-bar rest.

You can hide/show multi-bar rests in each layout independently in Dorico SE, and you can hide/
show bar number ranges below them.

By default, the multi-bar rest bar counts only appear once between the staves of grand staff 
instruments.

RELATED LINKS
Hiding/Showing bar number ranges on multi-bar rests on page 679

Hiding/Showing multi-bar rests
You can hide/show multi-bar rests in each layout independently, and choose whether or not to 
consolidate one-bar repeats. For example, you can hide multi-bar rests in full score layouts but 
show multi-bar rests in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show multi-bar rests.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Bar Rests and Multi-bar rests section, choose one of the following options for 
Consolidate:

● None

● Multi-bar Rests

● Multi-bar Rests and Bar Repeats

5. Click Apply, then Close.

RESULT

● When you choose None, no multi-bar rests are shown in the selected layouts. Each empty 
bar is shown separately.

● When you choose Multi-bar Rests, any adjacent empty bars are consolidated into multi-bar 
rests in the selected layouts. However, bar repeats prevent the consolidation of multi-bar 
rests, even if there are no other notes in those bars.

● When you choose Multi-bar Rests and Bar Repeats, any adjacent empty bars or bars that 
only contain one-bar repeats are consolidated into multi-bar rests in the selected layouts. 
Multi-bar rest counts are also shown above consolidated one-bar repeats.

RELATED LINKS
Bar repeats on page 985
Hiding/Showing bar number ranges on multi-bar rests on page 679
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Slurs

Slurs are tapered, curved lines that join notes to indicate legato articulation and phrasing.

Depending on the context and the instrument to which they apply, slurs can have additional 
meanings to simply marking phrases. For example, for wind players, a slur indicates that all the 
notes in the phrase are played in the same breath and without re-tonguing or re-articulating any 
notes. For string players, a slur indicates that all the notes in the phrase are played legato and 
under one bow. For singers, slurs indicate that more than one note is sung to the same syllable.

Slurs both above and below the staff, including a cross-staff slur

Dorico SE automatically determines the appropriate endpoint position and curvature direction 
for slurs based on the notes within their ranges, but you can change this manually.

You can input any number of nested slurs.

NOTE

Slurs must not be confused with ties, which look superficially similar, but instead join notes of 
the same pitch to indicate that they are played as a single note. In that sense, ties are part of 
rhythmic notation, while slurs are considered articulation.

RELATED LINKS
Inputting slurs on page 248
Inputting nested slurs on page 1025
Ties vs. slurs on page 1075
Cross-staff and cross-voice slurs on page 1024
Elision slurs on page 838
Slurs in playback on page 1028
Slur endpoint positions on page 1018
Slur curvature direction on page 1022
Changing the position of slurs relative to tie chains on page 1017

General placement conventions for slurs
There are different conventions for the placement, endpoint position, shape, and curvature 
direction of slurs in various contexts.

RELATED LINKS
Slur endpoint positions on page 1018
Slurs over system and frame breaks on page 1019
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Slur curvature direction on page 1022

Slur position relative to tie chains
There are different conventions for the position of slurs relative to tie chains in music for modern 
use and historical editions.

Modern practice is for slurs to start on the first note in tie chains, and end on the last note in tie 
chains. This makes the full length of the phrase visually clear to the performer, which helps their 
performance, and is the default in Dorico SE.

However, in historical editions, slurs might end on the first note in a tie chain, and start on the 
last note in a tie chain. Both of these changes save vertical space, as shorter slurs do not extend 
as far above or below a staff.

Slur starting on the first note and ending on the last 
note in tie chains

Slur starting on the last note and ending on the first 
note in tie chains

Changing the position of slurs relative to tie chains
You can change the position of individual slurs relative to tie chains, including slurs starting on 
grace notes. For example, slurs that start on the last note in tie chains and end on the first note 
in tie chains are shorter and require less vertical space.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the slurs whose position relative to tie chains you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slurs group:

● Start pos. in tie chain

● End pos. in tie chain

3. Choose one of the following options for each property:

● First note

● Last note

RESULT
The position of the selected slurs relative to tie chains is changed.

Slur placement relative to grace notes
There are specific placement rules that affect slurs when they start from a grace note and end on 
a normal note immediately following the grace note.

These rules are:

Slurs
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● Slurs connect noteheads rather than stems.

● Slurs are scaled to match the proportions of grace notes.

● Slurs must not obscure ledger lines.

● Slurs are placed above notes if they would collide with the accidental of a standard note 
when placed below the notes.

Due to the general placement conventions of grace notes, slurs in Dorico SE appear below grace 
notes and curve downwards by default. Slurs starting from grace notes only appear above notes 
and curve upwards in up-stem voices in multiple-voice contexts.

Slur curvature direction on grace notes in a single-
voice context

Slur curvature direction on grace notes in a multiple-
voice context

RELATED LINKS
Changing the curvature direction of slurs on page 1023
Changing the stem direction of notes on page 856
General placement conventions for grace notes on page 804

Slur position relative to staff lines
Slur endpoints must not touch staff lines, and the high point of the arcs of slurs should not stop 
on staff lines.

This is the convention because a slur whose arc peaks on a staff line can create the appearance 
of a triangular wedge between the staff line and the curve of the slur. If a slur peaks on a staff 
line, you can adjust its height so that it peaks either above/below the staff.

NOTE

Although Dorico SE automatically ensures slur endpoints do not touch staff lines, manual 
adjustments might be necessary to position the arcs of slurs correctly.

Slur endpoint positions
In order to avoid collisions, the default positions of slur endpoints vary depending on whether 
slurs are placed on the notehead side or stem side of notes, their position relative to staff lines, 
and whether articulations, ties, and other slurs exist at the same rhythmic position.

Slur endpoints relative to noteheads and stems

The default position of slur endpoints relative to noteheads is 1/2 space above a notehead in a 
space on the staff, and 1/4 space above a notehead on a line on the staff.

Slurs appear between the stems of unbeamed notes when placed on their stem side, and the 
default setting is for their endpoints to attach a short distance from the end of the stem.

Slurs
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Slurs between the stems of unbeamed notes

Slur endpoints relative to notes with different stem directions

For slurs between notes with different stem directions, Dorico SE positions their endpoints close 
to the notehead by default so that the shape and curvature direction of slurs reflects the rising or 
descending pitch contour of phrases, including when they span multiple staves.

Slur endpoints near noteheads Slur endpoints near stem ends

Slur endpoints relative to articulations

By default, articulations of force and stress are placed outside slur endpoints, and articulations of 
duration are placed inside slur endpoints, which automatically raises the endpoints. For example, 
accents and stress marks are placed outside the ends of slurs but staccato and tenuto marks are 
placed inside the ends of slurs.

Slurs are placed outside articulations on notes in the middle of slurs.

Slur endpoints relative to ties and other slurs

The default position of slur endpoints is 1/4 space above an existing slur that starts/ends on the 
same note.

RELATED LINKS
Cross-staff and cross-voice slurs on page 1024
Nested slurs on page 1024
Stem direction on page 854
Articulations on page 661
Changing the placement of articulations relative to slurs on page 665

Slurs over system and frame breaks
Slurs automatically cross system breaks and frame breaks, appearing in two parts on either side 
of the break.

By default, the endpoints of slurs that cross system/frame breaks are positioned at least 1/2 
space outside the outer staff line and at a suitable position based on the pitch contour of the 
phrase before/after the break; that is, indicating whether the phrase rises or falls after the break.

If multiple slurs cross the same system break or frame break, such as if a phrase split by a break 
contains nested slurs, the ends of the slurs are stacked automatically and spaced a minimum of 
1/2 space apart vertically.

Slurs
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The end of a system showing the first slur part; the 
end on the right indicates a continuation to the next 
system.

The start of the next system showing the second 
slur part; the end on the left indicates a continuation 
from the previous system.

Slur collision avoidance
By default, Dorico SE automatically adjusts the shape and position of slurs to avoid collisions with 
items under their arc.

This means that if a notehead under a slur is either higher than the others under a slur curving 
upwards, or lower than the others under a slur curving downwards, the curvature of the slur is 
adjusted to avoid the collision and keep the notehead under the slur.

Slur with collision avoidance activated (default) Slur with collision avoidance deactivated

RELATED LINKS
Cross-staff and cross-voice slurs on page 1024
Accidentals on page 655

Slur styles
There are different styles of slurs available in Dorico SE, which indicate different meanings and 
have different use cases.

The following options for slur style are available when you activate Style in the Slurs group of the 
Properties panel:

Solid
This is the default style for slurs. Slurs appear as tapered solid lines: thinner at the ends 
and thicker in the middle.

Dashed
Slurs appear as tapered dashed lines. Can be used to indicate an optional slur; for 
example, to recommend breathing/bowing patterns.

Dotted
Slurs appear as dotted lines. The dots are the same size and the same distance apart 
over the whole length of the slur.

Slurs
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Half-dashed start
The first halves of slurs appear as dashed lines, the second halves as solid lines. Used 
to denote that a slur was written incompletely in the source in critical editions.

Half-dashed end
The first halves of slurs appear as solid lines, the second halves as dashed lines. Used 
to denote that a slur was written incompletely in the source in critical editions.

Editorial
Slurs appear as solid black lines, but with a smaller vertical line intersecting them 
exactly halfway along their length, perpendicular to the curve of the slur. Used to show 
that a slur was added by the editor and was not present in the original source.

Changing the style of slurs
You can change the style of individual slurs after they have been input. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose style you want to change.

2. In the Properties panel, activate Style in the Slurs group.

3. Select one of the following options from the menu:

● Solid

● Dashed

● Dotted

● Half-dashed start

● Half-dashed end

● Editorial

RESULT
The style of the selected slurs is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562

Slurs
Slur styles 

1021
Dorico SE 4.3.30



Copying property settings to other layouts/frame chains on page 547

Changing individual slurs to flat slurs
Although they are not often used as standard, some publishers use flat slurs in order to reduce 
the vertical space occupied by slurs. You can change individual slurs to flat slurs. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

Not all slurs look good as flat slurs, but it would also be unusual only to use flat slurs once or 
twice in a project. Therefore, we recommend that you avoid changing the curvature style for only 
one or two slurs in a project.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose curvature style you want to change.

2. In the Properties panel, activate Curvature type in the Slurs group.

3. Choose one of the following options:

● Normal (curved)

● Flat

RESULT
The curvature style of the selected slurs is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Slur curvature direction
Slurs can curve upwards, downwards, or have a multi-segment S-shape. Dorico SE automatically 
determines the appropriate curvature direction for slurs based on the notes within their ranges, 
but you can change the curvature direction of slurs manually.

A slur on a single staff always curves upwards and is placed above the notes, unless all of the 
notes under the slur are up-stem, in which case it curves downwards and is placed below the 
notes. If a slur applies to a mixture of up-stem and down-stem notes, it is placed above the staff 
and curves upwards.

Examples of the slur direction changing according to the stem direction

Slurs
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The following options for slur curvature direction are available when you activate Direction in 
the Slurs group of the Properties panel:

Up

Forces slurs to curve upwards, and appear above notes.

Down

Forces slurs to curve downwards, and appear below notes.

Up/Down

Forces slurs to comprise two segments: the first curves upwards, the second curves 
downwards to create a mirrored S-shape. It is typically used when phrases start in the 
lower staff and end in the upper staff; for example, in piano parts.

Down/Up

Forces slurs to comprise two segments: the first curves downwards, the second curves 
upwards to create an S-shape. It is typically used when phrases start in the upper staff 
and end in the lower staff; for example, in piano parts.

TIP

In jazz scores, slurs are sometimes treated as an articulation, so positioning all slurs above the 
staff is preferred.

RELATED LINKS
Slurs over system and frame breaks on page 1019
Cross-staff and cross-voice slurs on page 1024

Changing the curvature direction of slurs

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose curvature direction you want to change.

2. In the Properties panel, activate Direction in the Slurs group.

3. Choose one of the following options:

● Up 

● Down 

● Up/Down  (mirrored S-shape)

● Down/Up  (S-shape)

Slurs
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RESULT
The curvature direction of the selected slurs is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Cross-staff and cross-voice slurs
Cross-staff slurs start on one staff and end on another staff, and cross-voice slurs start in one 
voice and end in another voice.

Cross-staff slurs between two piano staves

Dorico SE positions cross-staff and cross-voice slurs in the same way as it positions standard 
slurs. You can move and lengthen/shorten cross-staff and cross-voice slurs in the same ways as 
standard slurs; however, they do not behave in the same way. For example, you cannot move 
cross-voice slurs to notes on the same staff in other voices, and you cannot lengthen cross-voice 
slurs to notes on the same staff in other voices. You also cannot lengthen/shorten cross-voice 
slurs to notes in different voices to those in which the slur started/ended.

You can only move and lengthen/shorten cross-staff slurs to notes on the same staff as the 
corresponding endpoint. For example, if a cross-staff slur covers a phrase that starts on the 
bottom staff and ends on the upper staff, you can only shorten the cross-staff slur to the first 
note on the upper staff, you cannot shorten it to any notes on the bottom staff.

The different voices can be on the same staff, or on different staves.

RELATED LINKS
Inputting slurs on page 248
Lengthening/Shortening items on page 396
Slur collision avoidance on page 1020
Slur endpoint positions on page 1018
Moving notes/items rhythmically on page 417

Nested slurs
Nested slurs are two or more slurs used simultaneously, where the overarching slur shows the 
structure of the phrase and the inner slurs show the articulation within the phrase. They are also 
known as “slurs within slurs”.

Depending on the stem directions within the overarching outer slur, inner slurs may appear on 
the opposite side of the staff to the outer slur.

Slurs
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A phrase with nested slurs

You can input nested slurs in the same ways as inputting standard slurs. By default, Dorico SE 
makes automatic adjustments to their positioning to avoid collisions.

RELATED LINKS
Slur collision avoidance on page 1020

Inputting nested slurs
You can input nested slurs, both during note input and by adding them to existing notes. You 
can also add nested slurs to existing notes on multiple staves at the same time and to notes 
in different voices or on different staves belonging to the same instrument; for example, when 
phrases span both staves of grand staff instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes you want to include in the outer slur.

TIP

● If you only select a single note, the slur connects that note to the next note in the 
same voice on the staff. To input slurs between notes in different voices, you must 
select both notes; for example, by selecting the first note then Ctrl/Cmd -clicking 
the second note.

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff slurs. However, you cannot create 
cross-staff slurs between different instruments.

● You can select notes on multiple staves to input slurs on those staves 
simultaneously.

2. Optional: If you want to input slurs onto multiple staves at once, extend the caret to those 
staves.

3. Input or start the outer slur in any of the following ways:

● Press S .

● In the Notes panel, click Slur .

● In the Keyboard panel toolbar, click Slur .

4. Input the inner slur in one of the following ways:

● When adding nested slurs to existing notes: Select the notes within the outer slur that 
you want to place under an inner slur and press S  or click Slur  in the Notes panel.

Slurs
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● To start the inner slur on the same note as the outer slur during note input, press S  or 
click Slur  in the Notes panel.

● To start the inner slur on a later note during note input, input notes or advance the caret 
manually to where you want the inner slur to start, then press S  or click Slur  in the 
Notes panel.

NOTE

If you added nested slurs to existing notes, stop here.

5. During note input, input the notes you want to include in the inner slur.

The slurs extend automatically as you continue inputting notes, even if there are rests 
between the notes you input.

6. End the inner slur on the currently selected note in any of the following ways:

● Press Shift-S .

● In the Keyboard panel toolbar, click Slur .

7. Continue inputting notes.

8. Optional: Start/End other inner slurs.

9. End the outer slur on the currently selected note in any of the following ways:

● Press Shift-S .

● In the Keyboard panel toolbar, click Slur .

RESULT
During note input, slurs begin from the currently selected note on all staves across which the 
caret extends, not from the caret position. Slurs extend automatically as you input notes, and 
end on the currently selected note.

When adding slurs to existing notes, the selected notes are connected by slurs. For example, if 
you select two notes belonging to one instrument and two notes belonging to another, two slurs 
are input connecting the notes on each selected staff. If you selected notes on different staves 
belonging to the same instrument, a cross-staff slur is input.

Slurs are placed either above or below the notes, depending on the stem direction of the notes 
within the selection. Inner slurs can have different curvature directions to outer slurs. By default, 
Dorico SE makes automatic adjustments to their positioning to avoid collisions.

TIP

You can input the outer slur and inner slurs in any order as Dorico SE automatically adjusts slurs 
so that shorter slurs are positioned within longer slurs, and ensures they do not collide.

RELATED LINKS
Inputting slurs on page 248
Changing the curvature direction of slurs on page 1023
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Linked slurs
Slurs of the same duration at the same rhythmic position on multiple staves can be linked 
together. This happens automatically when you copy and paste slurs or material including slurs 
between staves, or enter them simultaneously.

If slurs are linked, moving one slur in the linked group moves any slurs linked to it in the same 
way. Similarly, lengthening or shortening a slur in a linked group lengthens or shortens any slurs 
linked to it in the same way. However, deleting one slur in a linked group only deletes the slur 
selected, not the whole group.

Linked slurs appear highlighted when any slur in the linked group is selected.

Linked slurs with the top slurs selected

You can also manually link and unlink slurs.

RELATED LINKS
Inputting slurs on page 248
Linked dynamics on page 767
Disabling automatic linking of dynamics and slurs when pasting on page 417

Linking slurs together
Dorico SE automatically links slurs of the same duration at the same rhythmic positions together 
when you copy and paste slurs or material including slurs between staves, or enter them 
simultaneously. However, you can also link slurs together manually.

PROCEDURE

1. In Write mode, select the slurs you want to link together.

NOTE

Only slurs that have the same duration and start at the same position can be linked together.

2. Choose Edit > Notations > Slurs > Link. You can also choose this option from the context 
menu.

RESULT
The selected slurs are linked together.
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Unlinking slurs
You can unlink slurs, including slurs that were linked automatically. For example, if you want to 
lengthen/shorten slurs independently of each other.

PROCEDURE

1. In Write mode, select a slur in each linked group that you want to unlink.

2. Choose Edit > Notations > Slurs > Unlink. You can also choose this option from the context 
menu.

RESULT
All slurs in the linked groups are unlinked. This applies to all layouts in which the slurs appear.

Slurs in playback
Slurs trigger the legato playing technique in playback. By default, this increases the length of the 
MIDI notes without affecting the notation of the music.

Slurred notes sound for 105% of the length indicated by their notated rhythm, as opposed to 
non-slurred notes which sound for 95% of their notated rhythm.

The final note of a slur sounds for 95% of its notated rhythm, as there is no slur after it and the 
legato technique is no longer required.

TIP

You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have slurs in one voice and staccatos in 
another voice.

The example shows how MIDI note length, indicated by the filled, light-colored rectangles, is 
increased when slurs are used. The thin, darker rod shows the notated duration of each note. 
The first three notes are non-slurred, so the MIDI length rectangle is shorter than the line of the 
notated rhythm. The last four notes are slurred together, so the MIDI length is longer than the 
notated length in order to create the legato, slurred sound. However, the last note of the slurred 
group is not longer, as the last note of a slurred phrase is treated like a normal, non-slurred note.

A phrase in an instrument staff The same phrase in the piano roll editor

RELATED LINKS
Played vs. notated note durations on page 584
Piano roll editor on page 575
Enabling independent voice playback on page 460
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Staff labels

Staff labels are used to identify the instruments playing the music on the corresponding staves, 
and are positioned to the left of systems, before the initial barline of each system. Staff labels are 
typically used in music containing multiple players.

It is usual to show instrument names in full in the staff labels for the first systems in each flow, 
and abbreviated instrument names in the staff labels of subsequent systems. Using abbreviated 
instrument names saves horizontal space, allowing you to include more music in each system.

Examples of staff labels on the first system in a flow

By default in Dorico SE, staff labels show the instrument names set for each instrument. You 
can show player names in staff labels instead for each player in each layout independently; for 
example, for percussionists who play multiple instruments.

For players holding multiple instruments and showing instrument names in staff labels, the staff 
label shows the instrument they are currently playing. If the player changes instrument partway 
through a system, the name of the new instrument is shown above the staff at its first note and 
the staff label is updated at the start of the next system.

Dorico SE includes the instrument transposition, or instrument pitch, in staff labels for 
transposing instruments by default. Transposing instruments are instruments whose sounding 
pitch is different to the notated pitch.

Part layouts by default do not show staff labels, as most parts only contain a single staff whose 
identity is clear from the context and the layout name. The layout name is shown at the top left 
of the first page in part layouts by default.

You can change when instrument transpositions, or instrument pitches, are shown in staff 
labels. You can also change whether the instrument transposition is shown before or after the 
instrument name in staff labels.

NOTE

● You do not need to number instruments in staff labels manually, as Dorico SE automatically 
numbers instruments when there are multiple players of the same type holding instruments 
with identical names.

● Layout names are different to the instrument names used for staff labels.
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● Staff labels do not show all instruments held by players; for example, in the staff label for 
the first system. You should include a comprehensive instrumentation list that shows any 
doubling at the front of your score.

Staff labels imported from MusicXML files

When exporting MusicXML files from Cubase and importing them into Dorico SE, you can 
improve the accuracy of the automatic instrument selection by changing the instrument names 
in the Cubase Score Editor to the same English instrument names that Dorico SE uses before 
exporting the file.

RELATED LINKS
Player, layout, and instrument names on page 158
Transposing instruments on page 119
Instrument numbering on page 115
Changing instrument names on page 161
Renaming players on page 159

Hiding/Showing staff labels
You can show full or abbreviated instrument names in staff labels, or hide all staff labels entirely, 
in each layout independently. The first system in each flow and all subsequent systems can have 
different staff label lengths.

By default, full staff labels are shown on the first system of each flow and abbreviated staff labels 
are shown on subsequent systems in full score layouts. In part layouts, staff labels are not shown 
on any systems.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show staff labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, choose one of the following options for Staff labels on first 
system:

● Full

● Abbreviated

● None

5. Choose one of the following options for Staff labels on subsequent systems:

● Full

● Abbreviated

● None

6. Click Apply, then Close.

Staff labels
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RESULT
Staff labels are hidden/shown on the corresponding staves in the selected layouts.

● None hides staff labels.

● Full and Abbreviated show staff labels using the corresponding instrument name length.

TIP

These settings apply to each flow in the layout, not the project as a whole.

AFTER COMPLETING THIS TASK

● You can change the full and short names for each instrument.

● You can change whether staff labels show instrument or player names for each player in 
each layout independently.

RELATED LINKS
Staff label contents on page 1032
Changing instrument names on page 161
Player, layout, and instrument names on page 158
Staff labels on condensed staves on page 1038
Staff labels for percussion kits on page 1037

Changing the minimum indent for systems with staff labels
You can change the minimum indent for all systems that show staff labels to optimize horizontal 
space in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose minimum indent for systems with staff labels 
you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, change the value for Minimum indent for systems with staff 
labels.

5. Click Apply, then Close.

RESULT
The minimum indent on all systems that show staff labels is changed in the selected layouts.

RELATED LINKS
Changing the first system indent on page 1046

Staff labels
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Staff label contents
Staff labels can show the instrument names set for each instrument or the player name of the 
corresponding player. Staff labels can show full or short names.

Instrument numbers are automatically shown in both full and abbreviated staff labels that use 
instrument names.

● Full staff labels use full instrument/player names.

● Abbreviated staff labels use short instrument/player names.

● None shows no staff labels.

NOTE

● You can change the full and short names for each instrument and player.

● Renaming instruments and players does not change the name shown at the top of each part 
layout if you have already renamed the layout. You can rename layouts separately.

RELATED LINKS
Player, layout, and instrument names on page 158
Instrument numbering on page 115
Changing instrument names on page 161
Renaming players on page 159
Renaming layouts on page 160
Instrument changes on page 117
Layout Options dialog on page 622

Showing instrument/player names in staff labels
You can change whether staff labels show instrument or player names for each player in each 
layout independently. For example, you can show the player names for percussionists in full 
score layouts and instrument names in percussion part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the contents of staff 
labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, in the Show player name instead of instrument names list, 
activate the checkbox for each player whose player name you want to show in staff labels.

5. Click Apply, then Close.

RESULT
Player names are shown for players when their checkbox is activated. Instrument names are 
shown for players when their checkbox is deactivated.

Full and short player names are used according to your staff label settings.
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AFTER COMPLETING THIS TASK
You can change the full and short names for each instrument and player.

RELATED LINKS
Percussion kit presentation types on page 1126
Renaming groups in grid presentation percussion kits on page 141

Instrument transpositions in staff labels
Instrument transpositions indicate the interval between the note an instrument plays and the 
sounding note produced. Transposing instruments, such as Horn in F and Clarinet in B♭, are 
commonly shown with their transposition, also known as their “instrument pitch”, as part of their 
instrument name or layout name.

Depending on the options set for Show transposition in the Edit Instrument Names dialog 
for each transposing instrument, they might show transpositions in staff labels even if you have 
hidden transpositions in staff labels in their layout.

Dorico SE sets common transposing instruments, such as Clarinet in B♭ and Trumpet in B♭, to 
follow your per-layout settings for hiding/showing instrument transpositions in staff labels.

To reduce the risk of confusion, uncommon transposing instruments, such as Clarinet in A or 
Trumpet in E, are set to show their transposition in staff labels always, even if you have hidden 
instrument transpositions in the layout.

RELATED LINKS
Transposing instruments on page 119
Player, layout, and instrument names on page 158
Changing instrument names on page 161
Hiding/Showing staff labels on page 1030

Hiding/Showing instrument transpositions in staff labels
You can hide/show instrument transpositions in staff labels in each layout independently. For 
example, you can hide instrument transpositions in staff labels in full score layouts but show 
them in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show instrument 
transpositions in staff labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, activate/deactivate the following options for Instrument pitch 
or transposition:

● Show in full staff labels

● Show in abbreviated staff labels

5. Click Apply, then Close.
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RESULT
Instrument transpositions are shown in staff labels of the corresponding length in the selected 
layouts when the corresponding checkbox is activated, and hidden when the corresponding 
checkbox is deactivated.

NOTE

Depending on the options set for Show transposition in the Edit Instrument Names dialog 
for each transposing instrument, they might show transpositions in staff labels even if you have 
hidden transpositions in staff labels in their layout.

Changing the appearance/position of instrument transpositions in 
staff labels

You can change the appearance and position of instrument transpositions in staff labels in each 
layout independently. For example, if you want to show instrument transpositions on a separate 
line in part layouts, but on the same line and parenthesized in full score layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose instrument transposition appearance/position 
you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, choose one of the following options for Position of instrument 
pitch in full staff labels:

● Start

● End

5. Optional: If you chose Start, enter the characters you want to appear as separators into the 
Separator between instrument pitch at start and name field.

6. Optional: If you chose End, activate/deactivate the following options:

● Show on separate line

● Show in parentheses

● Show instrument number before transposition

7. Click Apply, then Close.

RESULT
The appearance and position of instrument transpositions in staff labels is changed in the 
selected layouts.

Staff labels
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EXAMPLE

Instrument transposition 
shown at start, with 
hyphen separator

Instrument transposition 
shown at end, on 
separate line

Instrument transposition 
shown at end, in 
parentheses

Instrument transposition 
shown at end, after 
instrument number

RELATED LINKS
Instrument numbering on page 115

Hiding/Showing instrument change labels at the start of 
flows

You can hide/show instrument change labels at the start of each flow in each layout 
independently. These labels can be useful for players holding multiple instruments as a way of 
clarifying the instrument required in their part layouts, which do not normally show staff labels.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show instrument change 
labels at the start of flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, activate/deactivate Show instrument change label at 
start of flow.

5. Click Apply, then Close.

RESULT
Instrument change labels are shown in the first bar of each flow in the selected layouts when 
Show instrument change label at start of flow is activated, and hidden when it is deactivated.

RELATED LINKS
Instrument changes on page 117

Staff labels
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Player group labels
Player group labels show the names of player groups as vertical text on vertical brackets to the 
left of staff labels. They allow you to identify groups of staves and are typically used in large-scale 
works, such as for orchestra and double choir.

Player group labels to the left of staff labels, showing sections in an orchestra

Player group labels show full player group names by default. Short player group names are used 
when the full player group name is longer than the bracket.

You can show player group labels in each layout independently.

RELATED LINKS
Player groups on page 144
Renaming player groups on page 146
Brackets and braces on page 707

Hiding/Showing player group labels
You can hide/show player group labels in each layout independently. For example, if you want 
to show player group labels for choirs in the full score layout but hide them in the vocal score 
layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show player group labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

Staff labels
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4. In the Staff Labels section, activate/deactivate Show player group names.

5. Click Apply, then Close.

RESULT
Player group labels are shown in the selected layouts when Show player group names is 
activated, and hidden when it is deactivated.

Staff labels for percussion kits
The staff labels shown for percussion kit staves depend on how kits are presented in your 
project. Kits can be presented as five-line staves, grids, and as single-line instruments.

Percussion kit presentation 
type

Staff label Example

5-line staff Single instrument name using 
the instrument name of the 
percussion kit.

Grid Multiple instrument names: 
one for each kit instrument, 
positioned at the staff 
position of the corresponding 
instrument.

Group names are centered 
between instruments in each 
group.

Staff labels for individual 
instruments in grids use a 
smaller font and a different 
paragraph style than used 
for standard instrument staff 
labels. Groups in grids use the 
standard staff label paragraph 
style.

Single-line instruments Multiple instrument names: 
one for each kit instrument, 
positioned beside the 
corresponding single-line 
staff.

Staff labels for single-line 
instruments use the same font 
and paragraph style as used 
for standard instrument staff 
labels.

Staff labels
Staff labels for percussion kits 
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You can change the player names, layout names, and instrument names of percussion kits in 
the same ways as for other players and instruments. However, to change the staff labels for 
percussion kits, you must change kit instrument names in different ways for percussion kits, 
depending on your percussion kit presentation type:

● 5-line staff: Open the Edit Instrument Names dialog from the Players panel in Setup mode, 
or use the Name field in the Edit Percussion Kit dialog, to change the name of the kit.

● Grid/Single-line instruments: Open the Edit Instrument Names dialog from inside the Edit 
Percussion Kit dialog in Setup mode to change the names of individual instruments.

The same instrument name fields and options are available for kit instruments as for standard 
pitched instruments.

RELATED LINKS
Edit Instrument Names dialog on page 161
Player, layout, and instrument names on page 158
Renaming groups in grid presentation percussion kits on page 141
Edit Percussion Kit dialog on page 136
Creating groups of instruments within grid presentation percussion kits on page 140
Unpitched percussion on page 1115
Percussion kit presentation types on page 1126

Staff labels on condensed staves
Staff labels on condensed staves must reflect all the players included on the staff. Dorico SE 
automatically consolidates identical instrument names in staff labels on condensed staves but 
always shows all the required player numbers.

On condensed staves containing different types of instruments or instruments with different 
names, all required instrument names are shown.

Staff labels on condensed brass staves

Because condensing can change frequently, staff labels on condensed staves can vary from one 
system to another. The staff labels for condensed divisi staves reflect the divisions at the start of 
the system and show instrument names.

Staff labels
Staff labels on condensed staves 
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Dorico SE also shows player labels above/below condensed staves to identify the players to 
which notes on condensed staves belong, as condensing can change within a single system. For 
condensed divisi staves, Dorico SE shows the player labels “div.”, with any required qualifications, 
and your set unison indication where each division starts and ends respectively.

RELATED LINKS
Hiding/Showing staff labels on page 1030
Condensing on page 543
Player, layout, and instrument names on page 158

Staff labels
Staff labels on condensed staves 
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Staves

A staff is a line or group of lines on which musical notes are notated to indicate the pitch 
and rhythm of music. Pitched instruments use the traditional five-line staff and unpitched 
instruments often use a single-line staff.

Notes are positioned on the lines and in the spaces on five-line staves, and can also use ledger 
lines above/below the staff to represent pitches that cannot fit on the staff.

A phrase on a five-line staff The same phrase on a single-line staff

The pitch and register of notes on five-line staves are determined by clefs, which can also be 
combined with octave lines to indicate what pitches performers play.

On five-line staves for unpitched percussion instruments, the different staff positions correspond 
to different percussion instruments.

Because it is often necessary to have different staff sizes in different layouts depending on their 
type, such as having smaller staves in full score layouts than in part layouts, in Dorico SE you can 
change various aspects of staves in Layout Options.

RELATED LINKS
Page formatting on page 508
Layout Options dialog on page 622
Clefs on page 738
Octave lines on page 742
Percussion kit presentation types on page 1126
Hiding/Showing empty staves on page 515
Hiding/Showing blank staves after final flows on page 517
Adding players on page 108
Adding instruments to players on page 120
Condensing on page 543
Divisi on page 1047
System dividers on page 1042
System objects on page 1044
System indents on page 1046
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Per-layout options for staves
You can change settings that affect the staves in each layout independently.

You can change the size of staves in each layout in the Space Size section of the Page Setup 
page in Layout Options.

You can change other aspects of staves on the Staves and Systems page in Layout Options. 
For example, you can change which staff labels are shown on systems, indent the first system of 
each flow, and fix the number of bars included in each system. You can also select above which 
staves system objects appear, according to their instrument families.

NOTE

● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

● System objects are only shown above bracketed groups in your project. If you have no 
brackets, system objects only appear at the top of systems.

RELATED LINKS
Page formatting on page 508
Layout Options dialog on page 622
Staff size on page 527
System objects on page 1044
Hiding/Showing empty staves on page 515
Hiding/Showing system dividers on page 1043
Brackets and braces on page 707

Extra staves
It is sometimes necessary to add extra staves to instruments; for example, to make complex 
contrapuntal music easier to read because it is spread out across more staves than usual for that 
instrument.

In Dorico SE, you cannot add extra staves. However, extra staves are shown if you import or open 
a project that contains them.

An extract of Debussy's piano prelude "Feuilles mortes" with three staves

Staves
Per-layout options for staves 
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RELATED LINKS
Ossia staves on page 1042
Divisi on page 1047
Voice-specific dynamics on page 754
Hiding/Showing empty staves on page 515
Signposts on page 407

Ossia staves
Ossia staves are smaller staves shown above/below the main staff of an instrument. They are 
used to show alternative phrases that can be played instead of the original phrase, such as 
suggestions for ornaments, alternative notations from other sources, or an easier version.

In Dorico SE, you cannot add ossia staves. However, ossia staves are shown if you import or open 
a project that contains them.

An ossia staff below the left-hand piano staff shows an easier alternative

RELATED LINKS
Extra staves on page 1041

System dividers
System dividers are used to clarify the separation of different systems when they appear on the 
same page. They are usually shown as two thick, parallel angled lines positioned to the left of 
initial barlines.

In Dorico SE, the outer edges of system dividers are aligned with the corresponding edges of 
music frames.

Staves
Ossia staves 
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A system divider between two systems in a string quartet score

You can show system dividers in different circumstances and change their appearance in each 
layout independently.

Hiding/Showing system dividers
You can change the circumstances in which system dividers are shown, including specifying the 
minimum number of players required to show them, in each layout independently. For example, 
if you only want to show system dividers between systems that contain different numbers of 
staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show system dividers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the System Dividers section, activate/deactivate Show system dividers.

5. If you activated Show system dividers, choose one of the following options:

● To show system dividers only between systems containing more than a set number of 
staves, choose When min. staves exceeded.

● To show system dividers between all systems in flows that contain more than a set 
number of players, choose When min. players exceeded.

● To show system dividers only between systems containing different numbers of staves, 
When number of staves differs.

6. Optional: Do one of the following:

● If you chose When min. staves exceeded, change the value for Minimum number of 
staves in system.

● If you chose When min. players exceeded, change the value for Minimum number of 
players.

7. Click Apply, then Close.

RESULT

● If you deactivated Show system dividers, system dividers are hidden in the selected layouts.

● If you activated Show system dividers, system dividers are shown in the corresponding 
circumstances in the selected layouts.

Staves
System dividers 
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RELATED LINKS
Hiding/Showing empty staves on page 515

Changing the length of system dividers
You can change the length of system dividers in each layout independently; for example, if you 
want to show longer system dividers in layouts that show full staff labels.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to show system dividers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the System Dividers section, choose one of the following options for Appearance:

● Default

● Long

● Extra long

5. Click Apply, then Close.

System objects
System objects are items that apply to all staves in the system and appear in all layouts, but 
are not necessary to show on every staff in full score layouts. For example, tempo marks and 
rehearsal marks are important for all players to see in their parts, but would cause an orchestral 
full score to appear very cluttered if they were shown on every staff.

In Dorico SE, the following items are considered system objects:

● Rehearsal marks

● Repeat endings

● Repeat markers

● System-attached text

● Tempo marks

● Time signatures shown above the staff

● Horizontal lines that apply to all staves

System objects automatically appear at least once in all layouts. You can show system objects 
at multiple positions in each system by showing them above multiple instrument families. For 
example, you might show them above the woodwind, brass, percussion, and string families. In 
an orchestral full score, this would ensure system objects are spread out evenly across the page, 
meaning no staff is very far from these important markings. You can also show rehearsal marks 
and repeat endings additionally below the bottom staff.

NOTE

● System objects are only shown above instrument families that are bracketed or braced 
together. You can change bracket grouping in each layout independently.

Staves
System objects 
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● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

RELATED LINKS
Changing bracket grouping according to ensemble type on page 708
Brackets and braces on page 707
Rehearsal marks on page 963
Tempo marks on page 1052
Repeat endings on page 975
Large time signatures on page 1089
Inputting text items on page 355

Changing the positions of system objects
You can show system objects above different instrument families in each layout independently. 
Multiple items are categorized as system objects, including system-attached text, rehearsal 
marks, tempo marks, repeat markers, and repeat endings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the instrument families 
above which system objects appear.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the System Objects section, activate the checkboxes for the instrument families above 
which you want system objects to appear.

5. Activate/Deactivate the following options for Also show below bottom staff:

● Repeat endings

● Rehearsal marks

6. Click Apply, then Close.

RESULT
System objects appear above the top staff in each bracketed group you select, provided a 
bracketed group for that instrument family is included in the selected layouts. If you activated 
options for Also show below bottom staff, the corresponding notations additionally appear 
below the bottom staff.

NOTE

System objects are only shown above instrument families that are bracketed or braced together. 
You can change bracket grouping in each layout independently.

RELATED LINKS
System objects on page 1044

Staves
System objects 
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System indents
System indents control the distance between the left page margin and the start of systems of 
music. According to tradition, the first system in part layouts is indented, but in modern use this 
is not always necessary.

According to convention, coda sections at the start of new systems are also indented. Dorico SE 
uses the same gap size before the start of codas whether they occur partway through systems or 
at the start of a new system.

A violin part with the first system indented

In Dorico SE, system indents automatically adjust to accommodate staff labels. For example, if a 
system contains a staff label that is significantly longer than the minimum system indent, Dorico 
SE increases the indent on that system to ensure the staff label remains legible and is not cut off 
on the left edge or collides with the music.

You can change both the minimum indent on systems with staff labels and the first system 
indent in each layout independently. You can also adjust the system indent at both the start and 
end of individual systems, independently of your per-layout settings.

RELATED LINKS
Changing the minimum indent for systems with staff labels on page 1031
Hiding/Showing staff labels on page 1030
Changing the horizontal justification of final systems on page 522

Changing the first system indent
By default in Dorico SE, the first system of each flow is indented in part layouts. You can change 
the indent for the first system of all flows in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose first system indent you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, change the value for Indent first system of flow by.

5. Click Apply, then Close.

RESULT
The indent of the first system of all flows is changed in the selected layouts.

Staves
System indents 
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Divisi

Divisi is when players split, or “divide”, in order to play multiple lines of music, commonly for a 
limited passage, before returning to play together, or “tutti”. Divisi passages can be notated with 
all lines on a single staff or across multiple staves.

Divisi is a technique most commonly used in orchestral string writing, as the string section 
typically contains a large number of players compared to the number of staves. For example, 
large orchestras commonly have twelve first violins all playing the same part most of the time. 
Dividing those players into multiple parts allows composers to write more complex contrapuntal 
music.

An example divisi change in a Violin I part, splitting it into two sections and a solo line

If the division is relatively simple, it is possible to write all parts on the same staff and label the 
section, with an indication of how many players are required for each line if necessary. If the 
parts have different rhythms at times, you can input them into separate voices on the same staff.

However, when a section is divided into multiple parts that are too different to be clearly written 
on a single staff, it is necessary to divide them onto multiple staves. In Dorico Pro, divisi changes 
allow you not only to divide sections into any number of parts with any number of staves, but 
also to include solo lines and group staves as required.

In Dorico SE, you cannot input divisi changes. However, divisi changes are shown if you import or 
open a project that contains them.

RELATED LINKS
Extra staves on page 1041
Inputting notes into multiple voices on page 207
Condensing on page 543
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Tablature

Tablature is an alternative notation to the five-line staff, and is used for fretted instruments. On 
tablature, pitches are indicated by fret numbers positioned on lines, each of which represents a 
string on the instrument. As tablature is commonly used for guitars, it usually shows six lines.

An extract of guitar music shown on both a notation staff and tablature

In Dorico SE, you can show music for fretted instruments, such as the guitar or bass, on a regular 
notation staff and tablature together or only show one or the other. Notes and notations are 
linked between both presentations, meaning any changes you make to one, including inputting 
notes, automatically update the other.

On tablature, ties are automatically notated as round brackets around the second note/chord 
and all subsequent notes/chords in tie chains.

Any notes beyond the range of the instrument or impossible to calculate, such as below the nut 
on the lowest string or a natural harmonic without a suitable node, are shown on tablature as 
pink question marks. If two notes are allocated to the same string at the same rhythmic position, 
both notes appear beside each other and are colored green.

Note on tablature that cannot be calculated

The appropriate tablature is automatically shown for instruments according to their strings and 
tuning settings. There are default tunings stored for each instrument type in Dorico SE, which 
you can customize in the Edit Strings and Tuning dialog.

RELATED LINKS
Hiding/Showing notation staves and tablature on page 1049
Fretted instrument tuning on page 124
Edit Strings and Tuning dialog on page 124
Inputting notes on tablature on page 217
Changing music area colors on page 51
Harmonics on page 859
Guitar bends on page 894
Guitar techniques on page 904
Ties on page 1074
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Trills on page 870

Rhythms on tablature
When notation staves and tablature are both shown, it is customary only to notate rhythms on 
the notation staff. However, when only tablature is shown, it is necessary to show rhythms on 
tablature.

The following items are shown to indicate rhythms on tablature:

● Time signatures

● Stems, stem flags, and beaming

● Rhythm dots

Rhythms shown on tablature

NOTE

Stems, stem flags, and beaming always appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends.

RELATED LINKS
Inputting notes on tablature on page 217

Hiding/Showing notation staves and tablature
You can show notation staves only, tablature only, or both in each layout independently and for 
each player holding at least one fretted instrument independently. For example, you can show 
only notation staves in the full score layout, but the notation staff and tablature in a guitar part 
layout.

When tablature is shown, it can appear with or without rhythms.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show tablature.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Fretted Instruments section, choose one of the following options for each player 
holding at least one fretted instrument in your project:

● To show only notation staves and hide tablature, choose Notation only.

● To show both notation staves and tablature, choose Notation and tablature.

Tablature
Rhythms on tablature 
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● To show only tablature and hide notation staves, choose Tablature only.

5. Optional: If you chose Notation and tablature or Tablature only, activate/deactivate Show 
rhythms in tablature.

6. Click Apply, then Close.

RESULT
Notation staves and tablature are hidden/shown for the corresponding players in the selected 
layouts.

If tablature is shown, it appears with rhythms when Show rhythms in tablature is activated, and 
without rhythms when it is deactivated.

EXAMPLE

Notation only Notation and 
tablature with 
rhythms

Notation and 
tablature without 
rhythms

Tablature only with 
rhythms

Tablature only 
without rhythms

RELATED LINKS
Players on page 107
Fretted instrument tuning on page 124
Inputting notes on tablature on page 217
Guitar bends on page 894
Guitar techniques on page 904
Hiding/Showing empty staves on page 515
Changing instruments on page 122

Changing the allocated string for notes on tablature
You can change the string to which individual notes are allocated on tablature manually; for 
example, if you input the notes on the notation staff and want to change their default string 
allocation.

NOTE

You cannot allocate notes to a string on which they are impossible, such as if the note is lower 
than the open pitch of the string.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Tablature
Changing the allocated string for notes on tablature 
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PROCEDURE

1. On tablature, select the fret numbers of notes whose allocated string you want to change.

NOTE

You must select fret numbers on tablature, you cannot select the notes on notation staves.

2. Change their allocated string in any of the following ways:

● To move them up a string, press N .

● To move them down a string, press M .

● In the Properties panel, select a string from the String menu in the Notes and Rests 
group.

RESULT
The string to which the selected notes are allocated is changed. Using the key commands 
changes the string of the selected notes proportionally, whereas selecting a string from the 
String menu allocates all selected notes to the selected string.

NOTE

● If they are now allocated to the same string as another note at that rhythmic position, both 
notes appear beside each other and are colored green.

● Deactivating the property resets the selected notes to their default string.

EXAMPLE

Notes allocated to the same string After changing the strings for some notes to reduce 
the distance between frets

RELATED LINKS
Inputting notes on tablature on page 217

Tablature
Changing the allocated string for notes on tablature 
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Tempo marks

Tempo marks indicate how fast music is played, often with a combination of text instructions and 
metronome marks. They are also known as “tempo changes”, “tempo indications”, and “tempo 
markings”.

A tempo mark can show text instructions, a metronome mark, or a combination of the two.

Tempo mark containing text instruction in French and metronome mark

Text instructions are traditionally expressed in Italian, such as largo or allegretto, but other 
languages, such as English, French, and German, have become widely accepted. The text 
instruction can express simply how fast the music is played, but can also suggest its character. 
For example, grave means slow but also solemn and sad, and vivo means fast but also lively and 
sprightly.

Metronome marks show the speed of the music, indicated in beats per minute, or “bpm”. 
Metronome marks can show a fixed bpm or indicate a range of possible or acceptable values.

Gradual tempo changes indicate a change in tempo over a defined period of time. They can 
appear differently; for example, with/without a continuation line or with the text split into 
syllables and spread across their duration.

Tempo marks use a bold font with a large point size, so they are clearly noticeable on the page. 
They do not usually use an italic font.

In Dorico SE, tempo marks are categorized as system objects. Therefore, tempo marks follow 
your per-layout settings for the visibility and positioning of system objects.

By default, the tempo marks you input set the tempo for playback and MIDI recording, but 
you can change the tempo mode if, for example, you want to use a single fixed tempo when 
recording MIDI. Gradual tempo changes also affect the playback tempo, and you can change the 
final tempo at the end of gradual tempo changes; for example, if you want to reach a specific 
bpm at the end. If you do not input any tempo marks into your project, the default playback 
tempo is 120 bpm.

RELATED LINKS
Metronome marks on page 1058
Gradual tempo changes on page 1062
Tempo mark components on page 1054
Tempo track on page 450
Tempo editor on page 601
Input methods for tempo marks on page 268
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Positions of tempo marks on page 1056
System objects on page 1044
Changing the positions of system objects on page 1045
Changing the tempo mode on page 458
Layout Options dialog on page 622

Types of tempo marks
Dorico SE groups tempo marks into different types according to their function and effect on the 
music.

In Dorico SE, there are the following types of tempo marks:

Absolute Tempo Change
Indicates a defined change in tempo, and is often shown with a metronome mark. For 
example, “Adagio =76”.

Gradual Tempo Change
Indicates a change in tempo over a defined period of time, such as rallentando (slowing 
down) or accelerando (speeding up).

Relative Tempo Change
Indicates a change in tempo that is relative to the previous tempo, such as mosso 
(movement).

Relative tempo changes often include modifiers that qualify the change, such as poco 
meno mosso (a little less movement), and are not defined by a metronome mark. 
You can, however, set a relative metronome mark change as a percentage of the 
previous metronome mark that updates automatically if the previous metronome mark 
changes.

Reset Tempo
Returns the tempo to the previous tempo, such as A tempo, or a previously defined 
tempo, such as Tempo primo (return to the first tempo of the piece).

Tempo Equation
Indicates a change in the beat unit on which metronome marks are based. For 
example, if the time signature changes from 3/4 to 6/8, a tempo equation of = 
indicates the same metronome mark value that applied to the quarter note beat unit in 
3/4 now applies to the dotted quarter note beat unit in 6/8.

RELATED LINKS
Metronome marks on page 1058
Gradual tempo changes on page 1062
Tempo equations on page 1064
Input methods for tempo marks on page 268
Tempo panel on page 271
Tempo popover on page 268
Changing the relative tempo mark value on page 1060

Tempo marks
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Tempo mark components
Tempo mark components include text, metronome marks, parentheses, and approximate 
indications. Tempo marks can include different components in different combinations, 
depending on your preference or the requirements for different projects.

You can activate properties that correspond to the different components in the Tempo group of 
the Properties panel. You can activate one or more of the following tempo mark properties in any 
combination for individual absolute tempo changes:

Text shown
Shows tempo text when activated, and no tempo text when deactivated.

Metronome mark shown
Shows metronome marks when activated, and no metronome marks when 
deactivated.

Parenthesized
Shows metronome marks in parentheses when activated, and without parentheses 
when deactivated. This also applies to approximate metronome marks.

Is approximate
Shows metronome marks as approximate when activated, and absolute when 
deactivated.

Approximate appearance
Allows you to choose how approximate metronome marks appear; for example, c. or 
circa.

NOTE

This property applies specifically to approximate tempo marks, and is only available 
when Is approximate is activated.

Show equals sign
An equals sign is shown when the property and its corresponding checkbox are both 
activated. No equals sign is shown when the checkbox is deactivated.

NOTE

This property applies specifically to approximate tempo marks, and is only available 
when Is approximate is activated.

Components for gradual tempo changes

The following components only apply to gradual tempo changes, such as rallentando:

Poco a poco
Poco a poco text is shown immediately after gradual tempo change text when the 
checkbox beside the property is activated.

RELATED LINKS
Changing the order of metronome marks on page 1061
Changing tempo text on page 1056
Hiding/Showing tempo marks on page 1058
Tempo track on page 450
Tempo editor on page 601
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Changing the type and appearance of absolute tempo changes
You can change which components are included in individual absolute tempo changes, and how 
they appear. For example, if you want to show only parenthesized metronome marks in some 
tempo marks and only text in other tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the absolute tempo marks whose components you want to change.

2. In the Properties panel, activate any of the following properties in the Tempo group:

● Text shown

● Metronome mark shown

● Parenthesized

● Is approximate

● Approximate appearance (only available when Is approximate is activated)

● Show equals sign (only available when Is approximate is activated)

RESULT
The selected tempo marks are changed to include the corresponding components.

When all properties are deactivated, tempo marks are hidden and indicated by signposts.

RELATED LINKS
Hiding/Showing zones on page 41
Tempo mark components on page 1054
Signposts on page 407

Adding poco a poco text to gradual tempo changes
You can add poco a poco text immediately after individual gradual tempo changes.

NOTE

You can also enter poco a poco directly into the tempo popover. However, this means the entry 
is treated as a tempo mark rather than a gradual tempo change, which changes the properties 
you can use on it.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the gradual tempo changes to which you want to add poco a poco text.

2. In the Properties panel, activate Poco a poco in the Tempo group.
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Tempo mark components 

1055
Dorico SE 4.3.30



RESULT
Poco a poco text is shown immediately after the text in the selected gradual tempo changes.

Deactivating Poco a poco (little by little) removes poco a poco text from the selected gradual 
tempo changes.

EXAMPLE

Rallentando with poco a poco text

Positions of tempo marks
Tempo marks are placed above the staff and at the same positions as other system objects, 
because they usually apply to all staves. They are placed above notations such as slurs, ties, and 
octave lines, and are often aligned with rehearsal marks to ensure clear readability.

By default in Dorico SE, tempo marks align with either a time signature or the notehead/rest at 
the rhythmic position to which they apply. For example, if there is a notehead with an accidental 
at the rhythmic position of a tempo mark, it is convention to align the tempo mark with the 
accidental.

If a repeat mark occurs mid-system and is not treated as a barline, tempo marks are aligned with 
the repeat mark.

When a tempo mark includes both text and a metronome mark, the text appears first, followed 
by the metronome mark.

You can move tempo marks to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

Tempo marks are categorized as system objects in Dorico SE, which you can show above the 
first bracket of selected instrument families. You can change the instrument families above which 
system objects appear in each layout independently; for example, if you want tempo marks to 
appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Input methods for tempo marks on page 268
Changing the order of metronome marks on page 1061
System objects on page 1044
Changing the positions of system objects on page 1045
Moving notes/items rhythmically on page 417

Changing tempo text
You can change the text of existing tempo marks individually. For example, if you want to add “al 
fine” to a ritardando at the end of a flow.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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PROCEDURE

1. Select the tempo marks whose tempo text you want to change.

2. In the Properties panel, enter the tempo text you want into the Text field in the Tempo 
group.

3. Press Return .

RESULT
The tempo text for the selected tempo marks is changed.

TIP

You can also change the tempo text by opening the tempo popover and changing the entry.

RELATED LINKS
Properties panel on page 560
Input methods for tempo marks on page 268
Tempo popover on page 268
Changing existing items on page 398
Tempo mark components on page 1054
Changing the order of metronome marks on page 1061

Showing abbreviated tempo text
You can show individual tempo marks with custom abbreviated text in some layouts; for 
example, if a long tempo mark extends beyond the page boundary in some part layouts but 
the abbreviated version fits within the boundary.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In the music area, open the layout in which you want to show abbreviated tempo text.

2. Select the tempo marks you want to show with abbreviated text.

3. In the Properties panel, activate Abbreviation in the Tempo group.

4. Enter the text you want into the value field.

5. Activate Abbreviate in the Tempo group.

6. Activate the corresponding checkbox.

RESULT
The selected tempo marks appear with abbreviated text when Abbreviation is activated and 
Abbreviate is deactivated, or when Abbreviation and both Abbreviate and its corresponding 
checkbox are all activated. This allows you to switch between showing abbreviated/full text in 
different layouts without deleting your abbreviated text from the Abbreviation value field.

RELATED LINKS
Changing the property scope on page 562
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Copying property settings to other layouts/frame chains on page 547

Hiding/Showing tempo marks
You can hide/show the different components in individual tempo marks without changing the 
speed of playback. This affects their appearance in all layouts.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the tempo marks you want to hide, or the signposts of tempo marks you want to 
show.

2. In the Properties panel, activate/deactivate the following properties in the Tempo group:

● Text shown

● Metronome mark shown

RESULT
When at least one of the properties is activated, the selected tempo marks are shown. They 
display components according to the properties that are activated.

When neither property is activated, the selected tempo marks are hidden. Signposts are shown 
at the position of each hidden tempo mark as they still affect the speed of playback.

RELATED LINKS
Changing the type and appearance of absolute tempo changes on page 1055
Signposts on page 407
Changing the tempo mode on page 458
Muting notes/items individually on page 463

Metronome marks
Tempo marks often include a metronome mark value. Metronome marks show the speed of the 
music, indicated in beats per minute, or “bpm”. For example, a bpm of 60 means one beat per 
second. The more beats per minute, the faster the music.

A metronome mark shown as a range

Metronome marks can be precise, such as  = 176, or can indicate an acceptable range, such as 
 = 152-176. They can also be shown in parentheses, which is useful if the metronome mark is 
intended as a guide rather than a fixed value.

By default, metronome marks appear as integers and do not show decimal places. If you input 
a metronome mark with a decimal place, it is rounded to the nearest integer. Metronome marks 
that you input in the Tempo editor appear as signposts by default.

The beat unit used in metronome marks commonly relates to the meter; for example, the 
metronome mark beat unit is often a quarter note in 4/4 but a dotted quarter note in 6/8.
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In Dorico SE, metronome marks can appear as an individual value or as a range. Depending on 
the type and appearance of metronome marks, the bpm value can indicate a fixed tempo or an 
approximate tempo.

RELATED LINKS
Input methods for tempo marks on page 268
Changing the order of metronome marks on page 1061
Changing the type and appearance of absolute tempo changes on page 1055
Tempo mark components on page 1054
Tempo equations on page 1064
Tempo track on page 450
Tempo editor on page 601

Changing the metronome mark value
You can change the metronome mark value of individual absolute tempo marks after they have 
been input, including changing the beat unit.

NOTE

These steps do not apply to gradual tempo changes or reset/relative tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the absolute tempo marks whose metronome mark values you want to change.

2. In the Properties panel, change the value for Tempo (bpm) in the Tempo group.

3. Press Return .

4. Choose the appropriate note duration and rhythm dot, if applicable, for Beat unit.

RESULT
The metronome mark value and beat unit is changed for the selected absolute tempo marks. 
This affects the tempo of playback, even if no metronome mark component is shown for those 
tempo marks.

NOTE

● By default, any decimals you enter are hidden and the displayed metronome mark value 
appears as the nearest integer. However, metronome marks always reflect their exact values 
in playback.

● You can also change the metronome mark value by opening the tempo popover and 
changing the entry.

RELATED LINKS
Tempo popover on page 268
Changing existing items on page 398
Hiding/Showing zones on page 41
Properties panel on page 560
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Showing the metronome mark value as a range
You can show the metronome mark value of individual absolute tempo marks as a range. 
For example, you can use this to indicate that any speed within the given range is musically 
appropriate for the piece.

NOTE

These steps do not apply to gradual tempo changes or reset/relative tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the absolute tempo marks whose metronome mark values you want to show as a 
range.

2. In the Properties panel, activate Tempo range (bpm) in the Tempo group.

3. Change the value in the value field.

RESULT
The tempo range, expressed as beats per minute, is changed for the selected tempo marks. By 
default, metronome mark ranges use a dash separator.

NOTE

Depending on the values set for each property, both Tempo (bpm) and Tempo range (bpm) can 
be the minimum/maximum tempo in the range, as Dorico SE automatically arranges metronome 
mark ranges with the lower value first. However, the metronome mark used for playback is 
always Tempo (bpm), regardless of whether that is the higher/lower value in the range.

Changing the relative tempo mark value
You can change the tempo of individual relative tempo marks, expressed as a percentage of the 
previous tempo mark.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the relative tempo marks whose value you want to change.

2. In the Properties panel, change the value for Relative % in the Tempo group.

3. Press Return .

RESULT
The tempo at the relative tempo mark is changed. For example, if the previous tempo was 
100 bpm, and you change a relative tempo mark to 90, the new tempo is 90% of 100 bpm, which 
is 90 bpm.
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RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560

Changing the final tempo at the end of gradual tempo changes
You can change how significantly gradual tempo changes affect the tempo in playback, 
expressed as a percentage of the tempo at the start of the gradual tempo change.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the gradual tempo changes whose final tempo you want to change.

2. In the Properties panel, change the value for Final tempo % in the Tempo group.

3. Press Return .

RESULT
The final tempo at the end of the selected gradual tempo changes is changed.

For example, if you change the value to 20 on a gradual tempo change that started at 100 bpm, 
the final tempo is 20% of 100 bpm, which is 20 bpm. If you change the value to 120 on a gradual 
tempo change that started at 100 bpm, the final tempo is 120% of 100 bpm, which is 120 bpm.

Changing the order of metronome marks
You can change the order of metronome marks relative to tempo text for individual tempo 
marks. For example, if you want to show metronome marks before tempo text in some tempo 
marks but after tempo text in others.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the tempo marks whose metronome mark order you want to change.

2. In the Properties panel, activate Metronome mark order in the Tempo group.

3. Choose one of the following options:

● Before

● After

RESULT
The order of metronome marks relative to tempo text in the selected tempo marks is changed.
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EXAMPLE

Metronome mark before tempo text Metronome mark after tempo text

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Types of tempo marks on page 1053
Metronome marks on page 1058
Tempo mark components on page 1054
Positions of tempo marks on page 1056
Hiding/Showing tempo marks on page 1058

Gradual tempo changes
Gradual tempo changes indicate a change in tempo over a defined period of time, such as 
rallentando, which indicates slowing down, and accelerando, which indicates speeding up.

Rallentando with dashed line

Gradual tempo changes are considered a type of tempo mark in Dorico SE, meaning you can 
input them in the same ways as for tempo marks.

Because gradual tempo changes have a different metronome mark value at the start/end, you 
can change the final tempo at the end of individual gradual tempo changes.

In Dorico SE, you can show gradual tempo changes with different styles, such as with a 
continuation line or with syllables spread across their duration. You can also show gradual tempo 
changes with different line styles, such as dotted or dashed.

NOTE

You cannot change the angle of gradual tempo changes.

RELATED LINKS
Input methods for tempo marks on page 268
Lengthening/Shortening items on page 396
Changing the line style of gradual tempo changes on page 1063
Changing the final tempo at the end of gradual tempo changes on page 1061
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Changing the style of gradual tempo changes
You can change the style of individual gradual tempo changes. Gradual tempo changes can 
appear as text only with no continuation line, text with a continuation line, or with the word 
spread across their duration.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the gradual tempo changes whose style you want to change.

2. In the Properties panel, activate Gradual style in the Tempo group.

3. Select one of the following options from the menu:

● rit.

● rit...

● rit-e-nu-to

RESULT
The style of the selected gradual tempo changes is changed.

NOTE

Only gradual tempo changes with valid full text appear separated into syllables; for example, 
ritenuto or accelerando. Gradual tempo changes automatically have valid full text when you input 
them using the panel or select a suggested entry from the menu when using the popover. You 
can also change the text of existing gradual tempo changes, including adding hyphens manually 
to control how they are separated into syllables.

EXAMPLE

rit.: Text only rit...: Text with a continuation line rit-e-nu-to: Syllables in the text 
spread across the duration of the 
gradual tempo change

RELATED LINKS
Changing tempo text on page 1056

Changing the line style of gradual tempo changes
You can change the line style of individual gradual tempo changes whose style includes a 
continuation line.

NOTE

This does not affect the appearance of gradual tempo changes with the text-only style.
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the gradual tempo changes whose line style you want to change.

2. In the Properties panel, activate Line style in the Tempo group.

3. Select one of the following options from the menu:

● Solid

● Dotted

● Dashed

RESULT
The line style of the selected gradual tempo changes is changed.

Tempo equations
Tempo equations indicate a change in the beat unit on which metronome marks are based. They 
are often used to maintain a consistent pulse across multiple different meters.

For example, if the time signature changes from 6/8 to 3/4, a tempo equation of  = indicates the 
same metronome mark value that applied to the dotted quarter note beat unit in 6/8 now applies 
to the quarter note beat unit in 3/4.

Tempo equations are considered a type of tempo mark in Dorico SE, meaning you can input 
them in the same ways as for tempo marks.

NOTE

Tempo equations do not yet include tuplet durations. This is planned for future versions.

RELATED LINKS
Input methods for tempo marks on page 268
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Text items

Text items exist at rhythmic positions within flows and allow you to display generic text in the 
music.

You can customize the formatting of text in text items using the available text editor options, 
such as by applying different paragraph styles to each line of text and different character styles 
to each character.

A text item below a piano staff

In Dorico SE, there are the following types of text items:

Staff-attached text
Text items that apply to individual staves and only appear on those staves.

System-attached text
Text items that apply to all staves and appear in all applicable layouts. In Dorico SE, 
system-attached text is categorized as a system object. Therefore, system-attached text 
follows your per-layout settings for the visibility and positioning of system objects.

NOTE

● You can only use tokens in text frames. You cannot use tokens in text items. Full text frame 
functionality is only available in Dorico Pro.

● There are dedicated features for other types of text that often appear in musical scores, such 
as tempo marks and dynamics.

RELATED LINKS
Tokens on page 552
Inputting text items on page 355
Text editor options in Write mode on page 357
Adding borders to text items on page 1071
Hiding/Showing text items on page 1073
Aligning text items with the start of systems on page 1070
System objects on page 1044
Changing the positions of system objects on page 1045
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Types of text
Generic text in Dorico SE can exist as text items, either staff-attached or system-attached, or in 
text frames, which are fixed to the page rather than the music. There are dedicated features for 
other types of text that often appear in musical scores, such as tempo marks and dynamics.

In Dorico SE, there are the following types of text:

Text items
Text items exist at rhythmic positions within flows. They can display any text you enter, 
apart from tokens. You can customize the formatting of text in text items using the 
available text editor options, such as by applying different paragraph styles to each line 
of text and different character styles to each character.

Text items can apply either to individual staves, which is known as “staff-attached text”, 
or to all staves, which is known as “system-attached text”.

A text item below a piano staff

Text in text frames
Text frames exist on pages independently of rhythmic positions within flows. They can 
display any text you enter, including tokens. You can customize the formatting of text 
in text frames using the available text editor options, such as by applying different 
paragraph styles to each line of text and different character styles to each character.

Text frames on the first page in a piano part layout, with the project title frame selected

NOTE

The project title, page numbers, and running headers that are automatically shown in 
layouts exist in text frames. Their contents and formatting come from page templates, 
which you cannot edit or create in Dorico SE. Editing text frames in layouts is 
considered a page template override. Pages with page template overrides are not 
automatically deleted, even if they are empty because the layout became shorter.

If you want to change the information shown at the tops of pages, we recommend that 
you do so in the Project Info dialog to avoid page template overrides. The big title at 
the top of the first page is the project title. The running header on subsequent pages 
uses the flow title for the top flow on that page in scores, and the layout name in parts.
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Tempo marks
Tempo marks indicate how fast music is played, often with a combination of text 
instructions and metronome marks.

For example, A tempo, Larghetto, ritardando, and accelerando are all tempo marks.

Tempo mark containing text instruction in French and metronome mark

Rehearsal marks
Rehearsal marks are ordered sequences of letters or numbers that provide useful 
reference points. They are often shown in a rectangular enclosure.

A rehearsal mark, showing the letter G

Playing techniques
The term “playing techniques” covers a wide range of instructions intended to tell 
performers to modify the sound of the notes they are playing; for example, by 
changing their embouchure or changing the position of their bow, or by modifying 
their instrument, such as adding a mute or depressing a pedal.

For example, pizzicato, flutter-tongue, con sordino, and “snares on” are all playing 
techniques.

Dynamics
Dynamics indicate the loudness of the music and can be combined with expressive text 
to give further clarification about how to perform the music. Dynamics can indicate an 
immediate change in volume or a gradual change over a specified duration.

For example, , , and “crescendo” are all dynamics.

A phrase with multiple different dynamics
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Lyrics
In Dorico SE, the term “lyrics” is used for all text that is sung by singers. Lyrics are 
organized into lyric lines, with different types of lyric lines available for lyrics with 
different purposes. For example, lyrics in a chorus line are shown in an italic font by 
default.

Lyrics for a soprano duet with basso continuo accompaniment

Fingering
Fingerings use numbers and letters to recommend which fingers players should use 
for notes.

Piano music containing multiple fingerings, including a substitution fingering and alternative 
fingerings

Figured bass
Figured bass is a shorthand that uses figures to specify the harmony above the notated 
bass notes. Figures use a combination of Arabic numbers, accidentals, and horizontal 
hold lines to specify both the intervals above the bass note that make up the chord and 
its duration.

A basso continuo part with figured bass below the staff

Chord symbols
Chord symbols describe the vertical harmony of the music at a specific moment. They 
are frequently used in jazz and pop music, where players often improvise around chord 
progressions.

For example, “Gm7”, “Dsus4”, and “C6/9” are all chord symbols.
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Chord symbols shown above slashes on the Clarinet and Piano staves to help the players 
improvise around the notated Cornet melody.

Repeat markers
Repeat markers show that musical material is to be repeated. They often involve 
jumping to different positions and sections in the music instead of moving through 
the music consecutively.

For example, D.C. al Coda, D.S., and Fine are all repeat markers.

A mid-system coda section

Comments
Comments are notes or instructions added at precise positions in a project without 
affecting the music. They are considered annotations in Dorico SE, meaning they are 
not printed by default.

A passage with comments and replies

RELATED LINKS
Tokens on page 552
Editing text in text items on page 359
Text editor options in Write mode on page 357
Hiding/Showing text items on page 1073
Text items on page 1065
Flow headings on page 550
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Page numbers on page 915
Tacets on page 541
Tempo marks on page 1052
Rehearsal marks on page 963
Playing techniques on page 937
Dynamics on page 746
Lyrics on page 821
Fingering on page 783
Figured bass on page 771
Chord symbols on page 713
Repeat markers on page 979
Comments on page 432

Changing the paragraph style of text
You can change the paragraph style that is applied to individual text items; for example, if you 
want to use different paragraph styles according to the information included in different text 
items.

PROCEDURE

1. In Write mode, double-click the text item whose paragraph style you want to change to open 
the text editor.

2. Select a paragraph style from the paragraph style menu in the text editor.

3. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

RESULT
The paragraph style of the selected text item is changed. The formatting of the selected text item 
now follows the paragraph style, such as its font size, font style, or horizontal alignment.

Aligning text items with the start of systems
You can align individual text items whose rhythmic position is at the start of systems with the 
systemic barline rather than the first note/rest, independently of the system alignment setting 
for their paragraph style. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text items you want to align with the start of systems.

2. In the Properties panel, activate Align with system start in the Text group.

3. Activate/Deactivate the corresponding checkbox.

Text items
Changing the paragraph style of text 

1070
Dorico SE 4.3.30



RESULT
The selected text items are aligned with the start of systems when the checkbox is activated, 
and aligned with the first note/rest in systems when the checkbox is deactivated. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

When the property is deactivated, text items follow the system alignment setting of their 
paragraph style.

EXAMPLE

Text aligned with the first note in the system Text aligned with the start of the system

RELATED LINKS
Inputting text items on page 355
Hiding/Showing zones on page 41
Properties panel on page 560
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Adding borders to text items
You can add borders to individual text items; for example, if you want to make the boundaries of 
text items clear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the text items to which you want to add borders.

2. In the Properties panel, activate Border in the Text group.

RESULT
Borders are added to the selected text items.

Deactivating Border removes borders from the selected text items.
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EXAMPLE

Text with no border Text with border shown

Changing the style of text item borders
You can change the style of borders shown on individual text items; for example, if you want to 
show rectangle borders on some text items but capsule borders on others. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text items whose border style you want to change.

2. In the Properties panel, activate Border style in the Text group.

3. Select one of the following options from the menu:

● Rectangle

● Rounded rectangle

● Capsule

● Angled ends rectangle

RESULT
The border style of the selected text items is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

EXAMPLE

Rectangle Rounded rectangle Capsule Angled ends rectangle

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
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Hiding/Showing text items
You can hide/show individual text items. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains. For example, you can show specific text items in part 
layouts but hide them in full score layouts.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text items you want to hide, or the signposts of text items you want to show.

2. In the Properties panel, activate/deactivate Hide in the Text group.

RESULT
The text items are hidden when Hide is activated, and shown when it is deactivated. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Signposts are shown at the position of each hidden text item. However, signposts are not printed 
by default.

TIP

● You can hide/show text signposts by choosing View > Signposts > Text.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Signposts on page 407
Hiding/Showing zones on page 41
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547
Key Commands page in the Preferences dialog on page 54
Annotations on page 507

Text items
Hiding/Showing text items 
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Ties

A tie is a curved line that joins two notes of the same pitch. When notes are longer than the 
maximum duration of a bar in the prevailing time signature, they automatically appear in Dorico 
SE as tie chains; that is, a sequence of adjacent notes joined with ties.

Each sequence of ties, whether they join two notes or ten notes together, represents a single 
note with the duration of all the tied notes combined. A performer plays the notes as one note, 
without re-striking, re-blowing, or re-bowing the note at any point within the rhythmic duration 
of the tie chain.

A tie chain across several bars on the bottom piano staff

On tablature, ties are automatically notated as round brackets around notes/chords in 
subsequent bars. When tablature is shown with rhythms, ties within the same bar are indicated 
with stems rather than bracketed noteheads.

A phrase on tablature with some ties within bars and 
a chord tied across two bars

The same phrase on a notation staff

In Dorico SE, most ties are created automatically. Rhythms are notated according to the 
prevailing beat grouping, which is normally set by the time signature. Therefore, notes that 
cannot be notated using a single duration are automatically drawn as tie chains. For example, 
if you input a dotted whole note at the start of a bar in a 4/4 time signature, it is automatically 
notated as a whole note tied to a half note in the next bar. If the time signature changes, tie 
chains are automatically adjusted to remain correct in the new meter.

Dorico SE automatically determines the appropriate endpoint position and curvature direction 
for ties to avoid collisions, according to the context.

NOTE

● Slurs must not be confused with ties, which look superficially similar, but instead join notes 
of the same pitch to indicate that they are played as a single note. In that sense, ties are part 
of rhythmic notation, while slurs are considered articulation.

● In Write mode, you can only select whole tie chains because Dorico SE considers each tie 
chain to be a single note. Any edits you make to tie chains in Write mode affect all notes in 
them, such as changing the pitch, but only affect the first tie in the chain, such as changing 
the tie style to dashed. However, you can still input notations, such as dynamics, in the 
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middle of tie chains by activating the caret and moving it to the required rhythmic position 
within the tie chain.

● When you tie existing notes together, they might be consolidated into fewer or more notes 
within a tie chain, depending on the musical context, the time signature, and the position of 
the start of the note in the bar.

● Articulations can only appear once on each tie chain, either at the start or the end, 
depending on the type of articulation. For example, staccato marks appear at the end 
whereas accents appear at the start. You can change the positions of articulations relative to 
individual tie chains.

RELATED LINKS
Note and rest grouping on page 705
Beam grouping according to meters on page 689
Inputting notes on page 197
Forcing the duration of notes/rests on page 238
Inputting ties on page 223
Splitting tie chains on page 1083
Tie curvature direction on page 1078
Time signatures on page 1084
Notes on page 840
Bracketed noteheads on page 849
Positions of articulations on page 662
Changing the positions of articulations on tie chains on page 664
Hiding/Showing or parenthesizing accidentals on page 656
Tablature on page 1048
Caret on page 191
Input methods for dynamics on page 284
Numbered bar regions on page 992

Ties vs. slurs
Ties and slurs look superficially similar but differ in meaning.

Ties indicate that a note should not be re-struck. They are used to join notes of the same pitch 
together. For example, ties can be used to extend notes across multiple bars. Although multiple 
notes can be included in a single tie chain, each tie in the chain only joins one notehead to the 
next notehead on the staff.

Articulations on tied notes only affect the attack at the start of the tie chain and the release at the 
end of the tie chain.

Two long notes tied together Two phrases with slurs

Slurs indicate articulation, such as bowing or breathing, and normally group notes of different 
pitches together. Slurs can join two noteheads together with any number of pitches in between. 
They often indicate the shaping of phrases.

Ties
Ties vs. slurs 
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Slurs can also be used in conjunction with articulation. Unlike ties, articulation within slurs can 
affect the sound throughout the phrase. For example, staccato articulations on repeated notes of 
the same pitch within a slur indicate that notes should be played on a stringed instrument using 
the same bow direction, but stopping the bow between each note.

RELATED LINKS
Slurs on page 1016
Inputting ties on page 223
Inputting slurs on page 248

Tie styles
There are different styles of ties available in Dorico SE, which you can use to indicate different 
meanings.

Solid
This is the default style for ties. Ties appear as tapered solid lines: thinner at the ends 
and thicker in the middle.

Dashed
Ties appear as tapered dashed lines. Can be used to denote optional or suggested ties; 
for example, in vocal music where some verses have more syllables than others and 
therefore require more notes.

Dotted
Ties appear as dotted lines. The dots are the same size and the same distance apart 
over the whole length of the tie. Can also be used to denote optional or suggested ties.

Half-dashed start
The first halves of ties appear as dashed lines, the second halves as solid lines. Used to 
denote that a tie was written incompletely in the source in critical editions.

Half-dashed end
The first halves of ties appear as solid lines, the second halves as dashed lines. Used to 
denote that a tie was written incompletely in the source in critical editions.

Editorial
Ties appear as solid black lines, but with a smaller vertical line intersecting them 
exactly halfway along their length. Used to show that ties were added by the editor and 
were not present in the source.

Ties
Tie styles 
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Changing the style of ties
You can change the style of individual ties. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains. By default, all ties are solid.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the ties whose style you want to change.

NOTE

You can only select whole tie chains, and any changes to tie chains only affect the first tie in 
the chain.

2. In the Properties panel, activate Style in the Ties group.

3. Select one of the following options from the menu:

● Solid

● Dashed

● Dotted

● Half-dashed start

● Half-dashed end

● Editorial

RESULT
The style of the selected ties is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the size of dashes/dots in ties
You can change the size of the dashes/dots in dashed/dotted ties individually. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to dashed/dotted ties.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

Ties
Tie styles 
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PROCEDURE

1. Select the dashed/dotted ties whose dash/dot size you want to change.

NOTE

You can only select whole tie chains, and any changes to tie chains only affect the first tie in 
the chain.

2. In the Properties panel, activate Dash/dot in the Ties group.

3. Change the value in the value field.

RESULT
Increasing the value makes dashes/dots bigger, decreasing the value makes dashes/dots 
smaller. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Tie curvature direction
The direction of tie curvatures is determined by the stem direction of the notes/chords at each 
end of the tie, the number of notes in chords at each end, and the number of voices on the staff.

Tied single notes in single-voice contexts

If a single voice is active and a tie joins two single notes, tie curvature direction is determined by 
the stem directions of the notes at either end of the tie.

● If the stem directions match, the tie curves away from the notes and is positioned on the 
notehead side.

● If the stem directions differ, the tie curves upwards by default.

Tied chords in single-voice contexts

If a tie joins two chords, the direction of the ties is determined by the number of tied notes in the 
chords.

● For an even number, the ties are equally split between curving towards the notehead end 
and curving towards the stem end.

● For an uneven number, the majority of ties curve towards the notehead end.

Tied notes in multiple-voice contexts

Ties are positioned on the stem side and are curved as follows:

● For up-stem voices, ties curve upwards.

● For down-stem voices, ties curve downwards.

● For overlapping/interlocking pitches in multiple voices, the rules for tied chords in single-
voice contexts apply. All notes in all voices are treated as if they belong to a single voice.

Ties
Tie curvature direction 
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TIP

You can change the curvature direction of ties individually.

Changing the curvature direction of ties
You can change the curvature direction of ties individually. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the ties whose curvature direction you want to change.

NOTE

You can only select whole tie chains, and any changes to tie chains only affect the first tie in 
the chain.

2. In the Properties panel, activate Direction in the Ties group.

3. Choose one of the following options:

● Up 

● Down 

RESULT
The curvature direction of the selected ties is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Non-standard ties
Usually, ties join two notes of the same pitch in the same staff. However, ties can also cross 
system breaks and frame breaks, clef changes, or time signature changes. These types of ties are 
all positioned automatically in Dorico SE.

Ties can also join non-adjacent notes, notes in different voices, or notes in different staves 
together. In Dorico SE, you must input these types of ties manually.

Ties across system/frame breaks

The ends of ties that cross system/frame breaks are automatically positioned in Dorico SE.

Their vertical position remains the same, as both ends are centered on the noteheads to which 
they are attached. Their behavior also remains the same, as selecting one note in a tie chain that 
crosses a system/frame break in Write mode selects all notes in the tie chain.

Ties
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The horizontal space for the parts of ties shown to the left of notes at the start of new systems/
frames may not be sufficient to show an ideal tie curve.

The start of a tie chain before a system break The end of the same tie chain after a system break

Tied notes with accidentals across system/frame breaks

The ends of ties for tied notes with accidentals across system/frame breaks are also 
automatically positioned.

As tied notes in Dorico SE are treated as one note notated to fit in time signatures, cautionary 
accidentals at the start of new systems/frames are not shown by default. If you choose to show 
accidentals beside notes in tie chains at the start of new systems/frames, the position of the 
notes is changed to accommodate accidentals. However, this automatic position might not leave 
sufficient room for the part of the tie to the left of the notes to be shown with an ideal curve.

The start of a tie chain before a system break The end of the same tie chain, with a cautionary 
accidental in parentheses

Ties across time signature changes

Ties are automatically positioned between notes that span a time signature change. If ties 
crossing a time signature change are joining notes in the middle of a staff, the top or bottom of 
the time signature change is partially obscured by the ties. However, as ties are curved, the time 
signature is unlikely to be completely obscured.

Ties across clef changes

Ties are automatically positioned between notes that span a change of clef. Ties across clef 
changes are not horizontal, as the same pitch is positioned differently in each clef.

The result of cross-clef ties is likely to be visually and musically confusing, as they can be misread 
as slurs. In this case, consider moving the change of clef to before/after the tied note.

Ties between non-adjacent notes

You can input ties between notes of the same pitch that are not directly beside each other and 
between grace notes and normal notes. This can be useful when inputting ties between multiple 
notes before a chord, for example.

Ties
Non-standard ties 
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Tied notes building up a chord Notes tied to the following chord Multiple grace notes tied to 
the following chord

Ties between different voices

You can input ties between notes of the same pitch in different voices belonging to the same 
instrument.

Ties between notes on different staves

You can input ties between notes of the same pitch in different staves belonging to the same 
instrument, such as the two staves of a piano.

Laissez vibrer ties

Laissez vibrer ties are short ties that indicate a note should be left to ring, and should not be 
stopped. They extend a small amount to the right of the note to which they apply, but do not 
connect to another note.

You can add laissez vibrer ties to any note.

RELATED LINKS
Inputting ties on page 223
Hiding/Showing or parenthesizing accidentals on page 656
System breaks on page 537
Frame breaks on page 539
Note spacing on page 533

Hiding/Showing laissez vibrer ties
You can add laissez vibrer ties to any note; for example, to specify which notes must not be 
stopped after being played but instead left to ring.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the notes on which you want to add a laissez vibrer tie.

2. In the Properties panel, activate/deactivate Laissez vibrer tie in the Notes and Rests group.

RESULT
Laissez vibrer ties are added to the selected notes when the property is activated, and are 
removed when the property is deactivated. Laissez vibrer ties are positioned automatically.

Ties
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TIP

You can assign a key command for Toggle Laissez Vibrer Tie on the Key Commands page in 
Preferences.

EXAMPLE

Phrase without laissez vibrer ties Phrase with laissez vibrer ties

Deleting ties
You can delete ties without deleting the notes to which they are attached.

NOTE

Deleting ties from tie chains removes all ties in the tie chain. If you want to remove single ties 
from longer tie chains, you can split the tie chain.

PROCEDURE

1. In Write mode, select the tie chains from which you want to delete all ties.

2. Delete all ties in any of the following ways:

● Press U .

● In the Notes toolbox, click Scissors .

RESULT
All ties in the selected tie chains are deleted. Notes previously in the tie chain remain at their 
rhythmic positions.

RELATED LINKS
Notes toolbox on page 173
Changing the duration of notes on page 236

Ties
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Splitting tie chains
You can split tie chains at specified positions; for example, if you want to change the pitch 
halfway through a tie chain or delete individual ties within tie chains. This does not remove any 
other ties in the tie chain.

NOTE

If you want to split ties because Dorico SE notated notes differently than you expected, you can 
set custom beat groupings for individual time signatures.

PROCEDURE

1. In Write mode, double-click the staff where you want to split a tie chain to start note input at 
that position.

2. Optional: Move the caret to where you want to split the tie chain.

● To move the caret according to the current rhythmic grid resolution, press 
Right Arrow / Left Arrow .

● To advance the caret according to the note value currently selected, press Space  or click 
Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

3. Split the tie chain in any of the following ways:

● Press U .

● In the Notes toolbox, click Scissors .

4. Optional: If you want to split the same tie chain in multiple places, move the caret to the next 
rhythmic position where you want to split the tie chain and repeat step 3.

5. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
The tie chain is split at the caret position.

RELATED LINKS
Note and rest grouping on page 705
Beam grouping according to meters on page 689
Creating custom beat groupings for meters on page 705
Splitting notes by duration on page 238
Notes toolbox on page 173
Caret on page 191
Moving the caret manually on page 196
Rhythmic grid on page 190
Keyboard panel on page 183
Fretboard panel on page 185
Drum Pads panel on page 186

Ties
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Time signatures

Time signatures indicate the meter of music, and apply to all bars from where they first appear 
until a subsequent change of time signature. Meter describes the rhythmic pulse of music, and 
its division into beats and bars.

A time signature is made up of two parts: numerator on top, and denominator underneath. 
These are the same mathematical terms as are used for fractions due to their similar 
arrangement.

1 Numerator

Specifies the number of beats in each bar for the time signature. The duration of beats is 
specified by the denominator.

2 Denominator

Specifies the beat duration for the time signature. The denominator doubles for every 
halving of the beat duration: 1 is a whole note (breve), 2 is a half note (minim), 4 is a quarter 
note (crotchet), 8 is an eighth note (quaver), and so on.

For example, a 4/4 time signature tells you the bar is made up of four beats, and each of those 
beats is a quarter note in length. A time signature of 4/2 contains four half notes in each bar, and 
4/8 contains four eighth notes (quavers) in each bar. Both 3/4 and 6/8 contain six eighth notes, 
but it is understood that a 3/4 bar contains three quarter note beats, whereas a 6/8 bar contains 
two dotted quarter note beats.

Bars are rhythmic groups, divided according to the time signature, and they make following the 
music much more practical and easier to read. Notes are beamed differently in different time 
signatures for the same reasons.

By default, time signatures apply to all staves. However, there are certain situations, such as in 
polymetric music, where some parts require their own time signature, independently of the rest 
of the ensemble. You can input time signatures that apply to all staves or only apply to single 
staves in Dorico SE.

Time signatures apply until the next time signature change or the end of the flow, whichever 
comes first.

Time signatures traditionally use a unique, heavy font that ensures they stand out against staff 
lines, and fill the height of a single staff. For some types of music, particularly film music, it is 
typical to use large time signatures that span several staves.

NOTE

● You can input notes without inputting a time signature.

● Beat lengths are fixed across all staves in your project, regardless of the time signature. For 
example, if you have a 2/4 time signature on one staff and a 6/8 time signature on another 
staff, then one quarter note in the 2/4 time signature equals one quarter note in the 6/8 time 
signature, meaning their barlines do not match.
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● Dorico SE does not automatically add beats to fill bars when you input time signatures unless 
Insert mode is activated.

A 5/8 time signature input before an existing 4/4 time signature without Insert mode activated, leaving 
only three eighth note beats in the second 5/8 bar.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 258
Types of time signatures on page 1085
Time signature styles on page 1091
Pick-up bars on page 1088
Large time signatures on page 1089
Beam grouping according to meters on page 689
Note and rest grouping on page 705
Time Signatures (Meter) panel on page 260
Creating custom beat groupings for meters on page 705
Bars on page 667
Insert mode on page 408
Inputting notes on page 197

Types of time signatures
There are different types of time signatures, which can indicate various and complex meters.

NOTE

Dorico SE uses the definitions for meters commonly used in American English. These definitions, 
such as which meters are considered simple and compound, might be different in other 
languages.

Simple
In simple time signatures, each beat is divided by two into equal groups of notes. 
Simple time signatures can be simple duple, such as 2/4, simple triple, such as 3/4, or 
simple quadruple, such as 4/4.

Compound
In compound time signatures, each beat is divided by three into equal groups of 
dotted notes, such as 6/8, which contains two dotted quarter note beats, or 9/4, which 
contains three dotted half note beats.

Irregular
Irregular time signatures, such as 5/4 or 7/8, cannot be subdivided into equal beat 
groups. Because the numerator is odd, these time signatures must be divided into 
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unequal beat groups. For example, 5/4 usually contains a half note beat and a dotted 
half note beat.

Additive
Additive time signatures show how bars are subdivided into beat groups. You can show 
beat group numerators for any type of time signature. For example, instead of 7/8, you 
could show an additive time signature of 2+3+2/8.

Alternating
An alternating time signature indicates a regular pattern that switches every bar 
between two or more time signatures, in the indicated order. For example, for a phrase 
with twelve eighth notes that needs to be emphasized 3+3+2+2+2, an alternating time 
signature of 6/8+3/4 might allow the two meters to be read more clearly.

Interchangeable
An interchangeable time signature indicates a set of time signatures at the start of 
the piece that can be used during the piece, such as 3/4–2/4. Unlike alternating time 
signatures, interchangeable time signatures do not require a fixed pattern; any bar in 
the piece can follow any of the time signatures in the set without having to restate the 
time signature.

NOTE

You must manually input the appropriate time signatures where you want them, 
as unlike alternating time signatures, there is no fixed pattern for them. Any time 
signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

They can have different separator styles in Dorico SE, which you can change for 
individual time signatures.

Aggregate
An aggregate time signature shows two or more meters within the same bar, such as 
2/4+3/8+5/4. Dorico SE automatically shows dashed barlines to indicate the divisions 
between the different meters, but you can also specify that you do not want to show 
dashed barlines when you input aggregate time signatures with the popover.

Open
An open time signature has no restrictions on meter, beaming, or beats. Any number 
of notes can be added, with any beaming. For example, open time signatures might be 
used for cadenza passages.

Time signatures
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NOTE

In open meters, you must input barlines and add beats manually. You can also extend 
open meter bars by inputting notes with Insert mode activated and set to a global 
scope.

Non-power of two
A non-power of two time signature is one such as 5/6, which indicates five sextuplet 
quarter notes (crotchets) where the sextuplet overall equals a whole note (semibreve). 
Examples of time signatures like this can be found in the music of Adès.

NOTE

Some composers, such as Boulez, have written fractional time signatures. Dorico SE does not 
currently support fractional time signatures.

RELATED LINKS
Time signature styles on page 1091
Large time signatures on page 1089
Note and rest grouping on page 705
Input methods for time signatures and pick-up bars on page 258
Input methods for bars, beats, and barlines on page 275
Ending interchangeable time signatures on page 1097
Insert mode on page 408

Cautionary time signatures
When a time signature change occurs at a system break, either in the score or in a part, the new 
time signature is shown at the end of the first system as well as at the start of the new system.

This is sometimes considered a “cautionary time signature”, because it warns performers of an 
upcoming change of time signature before it takes effect.

In Dorico SE, the time signatures shown at the end of one system and at the start of the next 
system are the same item, not separate items. You cannot hide cautionary time signatures.

If the music is separate enough that you do not want to see a time signature at the end of a 
system and you cannot change where the system break occurs, you can separate the music by 
creating a new flow at the point of the system break.

RELATED LINKS
Flows on page 148
Adding flows on page 148
Splitting flows on page 432
System breaks on page 537
Inserting system breaks on page 537
Cautionary key signatures on page 818
Clefs on page 738
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Pick-up bars
Pick-up bars allow you to include music before the first full bar. They are also known as an 
“upbeat” or “anacrusis”. Often, pick-up bars only comprise a few beats whose main purpose is to 
lead in to the start of the piece.

Pick-up bar of four eighth notes at the start of a piece in 9/8

Pieces that start with a pick-up bar have time signatures that are positioned at the start of the 
system as normal. However, the first full bar of the time signature occurs after the first barline 
and not before. Therefore, pick-up bars do not contribute to the bar number count. Bar numbers 
are counted from the first full bar in the flow.

Because pick-up bars are linked to the number of notes/rests in the music, in Dorico SE they are 
linked to time signatures. However, you can hide time signatures you do not want to show in the 
music.

TIP

You can use the Global Adjustment of Current Bar Insert mode scope to create and delete 
pick-up bars by deleting notes/rests in the first bar in the flow. You can also use it to shorten the 
last bar in flows that start with a pick-up bar.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 258
Hiding/Showing time signatures on page 1096
Insert mode scopes on page 409
Deleting notes/items on page 412
Bars on page 667
Bar numbers on page 677
Track overview on page 440
Turning existing notes into grace notes on page 805
Turning grace notes into normal notes on page 806

Defining partial bars as pick-up bars or irregular bars
You can change whether explicit irregular bars at the start of time signatures are defined as 
pick-up bars. This affects how notes in the bars are beamed and grouped.

Notes in irregular bars defined as pick-up bars are beamed/grouped backwards from the end of 
the bar, while notes in irregular bars not defined as pick-up bars are beamed/grouped forwards 
from the start of the bar.

NOTE

You must input explicit irregular bars and pick-up bars as part of a time signature, such as by 
entering 4/4,1.5 into the time signatures popover to input a 4/4 time signature with a pick-up bar 
containing 1.5 quarter note beats, or three eighth notes.

Time signatures
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the time signatures or the signposts of time signatures starting with an explicit 
irregular bar whose pick-up definition you want to change.

2. In the Properties panel, activate Group first bar as pick-up in the Time Signatures group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Irregular bars at the start of the selected time signatures are defined as pick-up bars when 
Group first bar as pick-up and its corresponding checkbox are both activated, and defined as 
normal irregular bars when the corresponding checkbox is deactivated.

When the property is deactivated, Dorico SE uses internal heuristics to define them as either 
pick-up bars or normal irregular bars automatically.

EXAMPLE

Irregular bar defined as pick-up into common time Irregular bar defined as normal irregular bar, not a 
pick-up

Large time signatures
Large time signatures are scaled-up time signatures that appear much larger than normal 
relative to the staff size. They can be helpful in orchestral scores, as the smaller staff size in 
such scores means standard time signatures are small and harder for conductors to read.

Large time signatures are also very commonly used in film scores, as conductors rarely have 
much time to prepare the scores before recording sessions. Having large time signatures makes 
changes in meter more visually clear on the page, especially when music contains multiple 
changes in meter.

In Dorico SE, you can show large time signatures at the following positions:

● Once per bracketed group

● Above the staff and at system object positions

Time signatures shown once per bracketed group

Instead of showing a time signature on every staff that is the same height as the staff, you can 
instead show a single large time signature on each bracketed group of staves. When shown once 
per bracketed group, time signatures are scaled up in size according to the number of staves in 
the bracketed group. The largest time signatures are shown on bracketed groups containing four 
or more staves. When shown on single staves, they extend a small amount above and below the 
staff, which is commonly used for parts for film music recording sessions.

Time signatures
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Narrow, serif time signatures shown once per bracketed group

Large time signatures shown on bracketed groups occupy horizontal space, which can be a 
significant amount when they are especially large and use the standard time signature design. 
Therefore, we recommend that you use one of the narrow designs in layouts that show large 
time signatures on bracketed groups.

Time signatures shown at system object positions

Similar to showing large time signatures once per bracketed group, you can also show time 
signatures only at system object positions and above the staff. Therefore, their positions in each 
system are controlled by the same options that control the positions of other system objects, 
such as rehearsal marks and tempo marks.

Normal time signatures shown at system object positions

Time signatures shown at system object positions do not occupy horizontal space, meaning it 
is less important to use a narrow font style. This also reduces the horizontal distance between 
notes either side of time signatures. Because of this reduced disruption to note spacing, this 
placement of time signatures has become popular in contemporary art music since the 20th 
Century.

When using the note denominator style for time signatures shown at system object positions, 
the note is shown to the right of the numerator rather than below.

By default, time signatures at system object positions are twice the size of normal time 
signatures and force other items at the same position to appear to the right.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 258
Changing the design of time signatures on page 1097
System objects on page 1044
Changing the positions of system objects on page 1045
Hiding bar numbers at time signatures shown at system object positions on page 684

Time signatures
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Changing the size and position of time signatures
You can change the size of time signatures in each layout independently, including changing 
their vertical position. For example, you can show large time signatures centered on each bracket 
in full score layouts but standard-sized time signatures on each staff in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the size of time 
signatures.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Time Signatures.

4. Choose one of the following options for Time signature position and size:

● Show on every staff

● Show once per bracket

● Show at system object positions

5. Click Apply, then Close.

RESULT
The size and position of time signatures in the selected layouts is changed.

Showing large time signatures above the staff at system object positions means they do not 
occupy any rhythmic or horizontal space, whereas the other options do cause time signatures to 
occupy horizontal space.

RELATED LINKS
Large time signatures on page 1089
Positions of time signatures on page 1095
Changing the design of time signatures on page 1097
Hiding bar numbers at time signatures shown at system object positions on page 684

Time signature styles
Dorico SE allows you to show time signatures in a variety of styles. For example, you can show 
denominators as a number or as a note value.

Numerator styles
The numerator is always one or more numbers, and can either show the total number 
of beats in the bar as a single number, or show how the total duration of the bar is 
subdivided into beat groups.

Number numerator Beat group numerator

Time signatures
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Denominator styles
The denominator can appear as a number, as a note indicating the equivalent 
duration, or not appear at all.

Number denominator Note denominator None denominator

Open meter styles
Open time signatures can be shown as an X, Penderecki’s symbol, or be hidden with no 
symbol. Open time signatures with no symbol are indicated by signposts.

X open style Penderecki’s symbol open 
style

No symbol open style

Interchangeable time signature separator styles
Interchangeable time signatures can have different separator styles. You can specify 
the separator style when inputting interchangeable time signatures using the popover 
and for individual interchangeable time signatures after they have been input.

Parentheses separator Brackets separator Equals sign separator

Slash separator Space separator Hyphen separator

RELATED LINKS
Types of time signatures on page 1085
Inputting time signatures with the popover on page 262
Time signatures popover on page 258
Changing the design of time signatures on page 1097
Changing the open meter style of time signatures on page 1093
Changing the separator style of interchangeable time signatures on page 1094
Changing the appearance of common/cut common time signatures on page 1095
Signposts on page 407

Changing the numerator style of time signatures
You can choose whether the numerators of individual time signatures show the total number of 
beats in each bar, or the subdivision of beats in each bar.

Time signatures
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the time signatures whose numerator style you want to change.

2. In the Properties panel, activate Numerator style in the Time Signatures group.

3. Choose one of the following options:

● Number

● Beat group

RESULT
The numerator style of the selected time signatures is changed.

Changing the denominator style of time signatures
You can change the denominator style of individual time signatures; for example, if you want to 
show the denominator as a note instead of a number.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the time signatures whose denominator style you want to change.

2. In the Properties panel, activate Denominator style in the Time Signatures group.

3. Choose one of the following options:

● Number

● Note

● None

RESULT
The denominator style of the selected time signatures is changed.

Changing the open meter style of time signatures
You can change the open meter style of individual time signatures.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the open meter time signatures whose style you want to change.

2. In the Properties panel, choose one of the following options for Open style in the Time 
Signatures group:

Time signatures
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● No symbol 

● X 

● Penderecki’s symbol 

RESULT
The open meter style of the selected time signatures is changed. No symbol open time 
signatures are indicated by signposts.

RELATED LINKS
Time signature styles on page 1091
Input methods for time signatures and pick-up bars on page 258
Signposts on page 407

Changing the separator style of interchangeable time signatures
You can change the separator shown in interchangeable time signatures individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the interchangeable time signatures whose separator you want to change.

NOTE

In the Properties panel, Separator in the Time Signatures group is automatically activated 
for interchangeable time signatures.

2. Select one of the following options from the Separator menu:

● Parentheses 

● Brackets 

● Equals sign 

● Slash 

● Space 

● Hyphen 

RESULT
The separator style of the selected interchangeable time signatures is changed.

TIP

● You can specify the separator style when inputting interchangeable time signatures using 
the popover.

● Although they might look similar to interchangeable time signatures, aggregate time 
signatures behave differently. Aggregate time signatures are separated by a + sign, whereas 
interchangeable time signatures can be shown with six different separators but not a + sign.

Time signatures
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Therefore, although you can activate Separator and choose from the available options for 
aggregate time signatures, the property only affects the appearance of interchangeable time 
signature separators.

RELATED LINKS
Time signature styles on page 1091
Inputting time signatures with the popover on page 262
Time signatures popover on page 258

Changing the appearance of common/cut common time signatures
You can show individual common/cut common time signatures with either common/cut common 
symbols or with a numerator and denominator, such as 2/2 or 4/4.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the common/cut common time signatures whose appearance you want to change.

2. In the Properties panel, activate/deactivate Common/Cut common in the Time Signatures 
group.

RESULT
The selected time signatures appear with common/cut common symbols when Common/Cut 
common is activated, and with a numerator and denominator when it is deactivated.

EXAMPLE

Common time signature 
symbol

Cut common time 
signature symbol

Common time signature, 
appearing as 4/4

Cut common time 
signature, appearing as 
2/2

RELATED LINKS
Input methods for time signatures and pick-up bars on page 258

Positions of time signatures
Standard time signatures are positioned on staves with the middle staff line, or only staff line for 
single-line staves, passing through their center. Large time signatures can be positioned in the 
middle or at the top of bracket groups, or above staves at system object positions.

Dorico SE automatically positions time signatures after clefs, key signatures, and barlines.

You can move time signatures to different rhythmic positions in Write mode. They are positioned 
automatically to avoid collisions.

Time signatures
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You can also change the position of time signatures in each layout independently; for example, if 
you want to show time signatures above the staff and at system object positions in some layouts 
but only once per bracket in other layouts.

RELATED LINKS
System objects on page 1044
Cautionary time signatures on page 1087
Large time signatures on page 1089
Changing the positions of system objects on page 1045
Input methods for time signatures and pick-up bars on page 258

Hiding/Showing time signatures
You can hide/show time signatures without deleting them from your project. This hides/shows 
them in all layouts, not just the one currently open in the music area.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the time signatures you want to hide, or the signposts of time signatures you want to 
show.

2. In the Properties panel, activate/deactivate Hide time signature in the Time Signatures 
group.

RESULT
The selected time signatures are hidden in all layouts when Hide time signature is activated, 
and shown when it is deactivated.

Signposts are shown at the position of each hidden time signature. However, signposts are not 
printed by default.

NOTE

● Hidden time signatures do not take up any horizontal space, so hiding/showing time 
signatures affects note spacing.

● You can hide/show time signature signposts by choosing View > Signposts > Time 
Signatures.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences, which applies to chord symbols, playing techniques, figured bass, text items, 
and time signatures.

RELATED LINKS
Note spacing on page 533
Signposts on page 407
Input methods for time signatures and pick-up bars on page 258
Annotations on page 507
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Ending interchangeable time signatures
Any time signatures you input after an interchangeable time signature that are specified in 
it are hidden automatically. You can end interchangeable time signatures from selected time 
signatures, which shows them.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the barlines or signposts of time signature from which you want to end 
interchangeable time signatures.

2. In the Properties panel, activate End interchangeable in the Time Signatures group.

RESULT
Interchangeable time signatures are ended at the selected time signatures. The selected time 
signatures and all subsequent time signatures specified in the prevailing interchangeable time 
signature are shown until the next existing interchangeable time signature or the end of the 
flow, whichever comes first.

Changing the design of time signatures
You can change the design of time signatures in each layout independently, including changing 
the font style used for them; for example, if you want to use a plain font for time signatures in 
full score layouts but the standard time signature font in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the design of time 
signatures.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Time Signatures.

4. Choose one of the following options for Time signature design:

● Normal

● Narrow, serif

● Narrow, sans serif

● Plain font

5. Click Apply, then Close.

RESULT
The design of time signatures in the selected layouts is changed. If you choose Plain font, time 
signatures use a different font style than the one used for the other options.
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RELATED LINKS
Large time signatures on page 1089

Time signatures
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Tremolos

Tremolos are thick, slanted lines that cross individual stems or are positioned between multiple 
stems. They are used to indicate that notes are repeated, either individually or in sequences of 
multiple notes.

Using tremolo strokes instead of notating each notehead can save horizontal space and make 
fast passages easier to read.

The number of tremolo strokes indicates both how many times notes are repeated and how fast 
they are. In measured tremolos, for example, one tremolo stroke on the stem of a quarter note 
(crotchet) indicates two eighth notes (quavers) are played, whereas three tremolo strokes on the 
stem of a quarter note indicates eight 32nd notes are played.

Quarter note with a one-stroke single-note tremolo 
and its equivalent notation

Quarter note with a three-stroke single-note tremolo 
and its equivalent notation

There are different types of tremolos:

Single-note tremolos
Individual notes are repeated. Single-note tremolos are positioned on note stems.

Two-stroke single-note tremolos added to four quarter notes

Multi-note tremolos
Multiple notes, usually two, are played in sequence, similar to a trill. However, trills 
usually indicate a fast alternation between two adjacent notes, such as G and A, 
whereas multi-note tremolos can be between any notes, limited only by the capabilities 
of the instrument.

All notes in multi-note tremolos indicate the total duration of the tremolo. For example, 
two quarter notes joined by a multi-note tremolo both appear as half notes.

Multi-note tremolos are positioned between the stems of two or more notes.
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Four quarter notes without tremolos Multi-note tremolos input between those 
quarter notes, in two pairs

Tuplet tremolos
Multiple notes in tuplets are repeated in the notated sequence. Tuplet tremolos are 
positioned between all the notes in the tuplet.

Quarter notes in two different tuplets 
without tremolos

Multi-note tuplet tremolos input across 
those tuplets

Depending on the musical context, tremolos can be either measured or unmeasured. There is 
no visual difference between measured/unmeasured tremolos, so composers/arrangers often 
specify how they want tremolos to be played, such as an indication in the front matter of the 
score or as a text instruction in the score.

Measured tremolos
The number of tremolo strokes corresponds to a precise rhythm in the prevailing 
tempo and meter.

Unmeasured tremolos
There is no link between the number of strokes and rhythm. Instead, unmeasured 
tremolos are played as fast as possible, whatever the tempo.

Unmeasured tremolos often use three or more tremolo strokes, and can also be 
accompanied by a “trem.” text indication.

RELATED LINKS
Input methods for repeats and tremolos on page 372
Deleting tremolos on page 1102
Tremolos in tie chains on page 1101
Changing the speed of tremolos on page 1101

General placement conventions for tremolos
Single-note tremolos are positioned on note stems, whereas multi-note tremolos are positioned 
between the stems of two or more notes. When multi-note tremolos cross three or more notes, 
the tremolo strokes are positioned between all the notes.

Tremolo strokes are slightly thinner than beams, so that the gaps between strokes are large 
enough and the number of strokes can be instantly recognized.

Dorico SE automatically avoids collisions between tremolo strokes and ledger lines or stem flags.

Tremolo strokes within the staff are positioned so that they are at least one staff space clear of 
noteheads, and at valid positions relative to staff lines and staff spaces. This means that tremolo 
strokes might not move every time you change the pitch of notes.

Tremolos
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The positions of the tremolo strokes on the first two notes and the last two notes are the same, although the 
pitches are all different.

In Dorico SE, the angle of single-note tremolo strokes is always the same, no matter the direction 
of the phrase. The angles of multi-note tremolo strokes are determined by the height of the 
stems to which the multi-note tremolos apply.

Tremolos in tie chains
By default, single-note tremolos appear either on all notes in tie chains, or on all notes apart 
from the first or last note. Deleting tremolo strokes from tied notes removes tremolo strokes 
from all notes in tie chains.

In Dorico SE, we use “tremolo with attack” and “tremolo with release” to refer to single-note 
tremolos that appear on all notes in tie chains apart from the first and last note, respectively.

Single-note tremolo added to tie chain Tremolo with release added to tie chain

In Dorico SE, tremolos are considered measured by default, so the number of tremolo strokes 
shown is automatically adjusted on subsequent notes in tie chains as required. For example, if 
an eighth note with two tremolo strokes is tied to a quarter note, the quarter note has three 
tremolo strokes. This is because tremolo strokes function like beams, so two tremolo strokes and 
an eighth note stem flag is the equivalent of three tremolo strokes.

The default number of tremolo strokes in a tie chain where the second note is longer than the first.

RELATED LINKS
Ties on page 1074
Inputting tremolos with the popover on page 381
Inputting tremolos with the panel on page 383
Deleting tremolos on page 1102

Changing the speed of tremolos
You can change the speed of tremolos after they have been input by changing the number of 
strokes.

PROCEDURE

1. In Write mode, select the notes with tremolos whose speed you want to change.

The buttons with the number of tremolo strokes corresponding to your selection are 
highlighted in the Tremolos section of the Repeat Structures panel.

Tremolos
Tremolos in tie chains 
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NOTE

Select single-note tremolos and multi-note tremolos separately.

2. Click the button with the number of tremolo strokes you want in the Tremolos section of the 
Repeat Structures panel.

For example, click Two Strokes Single-note Tremolo  to input single-note tremolos with 
two strokes, or click Three Strokes Multi-note Tremolo  to input multi-note tremolos with 
three strokes.

RESULT
The number of tremolo strokes on the selected notes is changed, which changes the speed of 
the tremolos.

Deleting tremolos
You can remove single-note tremolos and multi-note tremolos from notes separately without 
affecting the notes to which they applied.

PROCEDURE

1. In Write mode, select the notes whose tremolo strokes you want to delete.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Tremolos section, click one or both of the following buttons, depending on the types 
of tremolos selected:

● Remove Single-note Tremolo 

● Remove Multi-note Tremolo 

RESULT
The corresponding types of tremolo strokes are deleted.

TIP

You can also delete tremolos by entering 0 or clear into the repeats popover.

RELATED LINKS
Notations toolbox on page 178
Repeat Structures panel on page 376
Repeats popover on page 373

Rhythmic positions of notes with tremolos
You can move notes with single-note tremolos and multi-note tremolos to new rhythmic 
positions in the same ways as normal notes. However, if you move multi-note tremolos across 
barlines, the tremolo strokes are deleted automatically.

You can move single-note tremolos to new rhythmic positions and across barlines without 
affecting their tremolo strokes. The notes are automatically respelled as tie chains if required 
by their new rhythmic positions and time signature, in the same ways as normal notes.

Tremolos
Deleting tremolos 

1102
Dorico SE 4.3.30



NOTE

If tie chains with single-note tremolos contain notes of different durations, the number of 
tremolo strokes on each note in the tie chain is different.

RELATED LINKS
Moving notes/items rhythmically on page 417

Tremolos
Rhythmic positions of notes with tremolos 
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Tuplets

Tuplets indicate where a beat is divided into a different number of subdivisions than is usually 
expected according to the current meter. They can be used to fit more notes or fewer notes in a 
beat than usually exist in a beat, according to the usual pattern of subdivision.

Because these subdivisions are not standard but tuplet notes use the same rhythmic notation as 
normal notes, tuplets must be clearly marked to show that their rhythmic duration is different. 
Tuplet numbers/ratios indicate the number of notes in the tuplet, and tuplet brackets show the 
duration of tuplets that are not joined by beams.

In Dorico SE, tuplets function like containers into which you can input notes of any duration, such 
as inputting a quarter note at the start of an eighth note triplet.

When tuplets extend across barlines, Dorico SE automatically notates them correctly, such as a 
sextuplet appearing as two triplets. You can also allow tuplets to span barlines without division.

During tuplet input, tuplets are sticky when you input notes with the keyboard, meaning that 
Dorico SE continues inputting notes as the specified tuplet until you stop tuplet input or note 
input.

You can show tuplets with different combinations of tuplet brackets and tuplet numbers/ratios. 
You can also show note symbols indicating the note value of the tuplet alongside tuplet 
numbers/ratios.

RELATED LINKS
Inputting tuplets on page 229
Tuplet brackets on page 1109
Tuplet numbers/ratios on page 1112
Allowing/Disallowing tuplets to span barlines on page 1107
Moving notes/items rhythmically on page 417

Nested tuplets
Nested tuplets are tuplets within larger tuplets that are often used to create complex rhythms. In 
Dorico SE, there is no limit to the number of levels you can have in nested tuplets.

EXAMPLE

Nested tuplets
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Inputting nested tuplets
You can input nested tuplets on empty staves and select existing tuplets and input nested tuplets 
within them.

PROCEDURE

1. In Write mode, start note input.

2. Open the tuplets popover in any of the following ways:

● Press ; .

● In the Notes toolbox, click and hold Tuplets , then click x:y .

When inputting tuplets with the keyboard, Dorico SE automatically continues inputting notes 
as the specified tuplet.

NOTE

You can skip steps 3 and 4 if you are inputting nested tuplets into existing tuplets.

3. Optional: If inputting nested tuplets on an empty staff, enter the ratio for the outer tuplet 
into the popover.

For example, enter 3:2q to input quarter note triplets.

4. Optional: Press Return  to close the popover and input the outer tuplet.

5. Press ;  to open the tuplets popover again.

6. Enter the ratio for the inner tuplet into the popover.

For example, enter 5:4e to input eighth note quintuplets.

7. Press Return  to close the popover and input the inner tuplet.

8. Input the notes you want.

When inputting tuplets with the keyboard, Dorico SE automatically continues inputting notes 
as the specified tuplet.

9. Stop inputting nested tuplets in one of the following ways:

● To stop the inner tuplet and continue inputting the outer tuplet, press :  once.

● To stop both tuplets and return to inputting normal notes, press :  twice or move the 
caret with the arrow keys.

● To stop note input completely, press Esc .

RESULT
Notes are input as nested tuplets, starting from the caret position.

If multiples of the inner tuplet fit exactly inside the outer tuplet, you can continue inputting notes 
as the specified nested tuplet until you stop the tuplets manually.

If multiples of the inner tuplet do not fit exactly inside the outer tuplet, the inner tuplet stops 
automatically at the end of the last tuplet that fits in the outer tuplet. After that, the outer tuplet 
continues until you stop it manually.

NOTE

You can also input nested tuplets by clicking and holding Tuplets  in the Notes toolbox, then 
clicking the tuplet you want. However, the inner tuplet you click must fit inside the outer tuplet, 
based on the currently selected note duration.

Tuplets
Nested tuplets 
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RELATED LINKS
Tuplets popover on page 230
Notes toolbox on page 173
Inputting notes on page 197
Selecting note/rest durations on page 235

Turning existing notes into tuplets
You can turn any existing notes into tuplets; for example, if you need to fit extra notes into an 
existing duration.

PROCEDURE

1. In Write mode, select the notes on a single staff that you want to turn into tuplets.

2. Open the tuplets popover in any of the following ways:

● Press ; .

● In the Notes toolbox, click and hold Tuplets , then click x:y .

The popover is automatically populated with a suggested ratio based on your selection.

3. Optional: Change the ratio in the popover. For example, enter 3:2 to input triplets.

4. Press Return  to close the popover.

RESULT
The selected notes are turned into tuplets according to the ratio in the popover. For example, 
if you select five eighth notes and enter 5:4 into the popover, the selected notes become 
quintuplet eighth notes.

If the selected notes fit into a single tuplet of the specified ratio, only a single tuplet is created. 
If the selected notes do not fit into a single tuplet, as many tuplets as required are created 
automatically.

TIP

You can also turn existing notes into tuplets by clicking and holding Tuplets  in the Notes 
toolbox, then clicking the tuplet you want.

RELATED LINKS
Tuplets popover on page 230
Inputting tuplets on page 229
Notes toolbox on page 173
Turning existing notes into grace notes on page 805

Turning tuplets into normal notes
You can turn any existing tuplet notes into normal notes; for example, if you want to turn tuplet 
eighth notes into standard eighth notes.

PROCEDURE

1. In Write mode, select just the brackets, numbers/ratios, or signposts of the tuplets you want 
to turn into normal notes.

Tuplets
Turning existing notes into tuplets 
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NOTE

You must not select any of the noteheads in the tuplets.

2. Optional: If you want the selected tuplets to push subsequent notes to later rhythmic 
positions if required, press I  to activate Insert mode.

3. Optional: If you activated Insert mode, choose the appropriate Insert mode scope.

4. Press Backspace or Delete .

RESULT
The selected tuplets are deleted. All notes previously in the tuplets are unscaled and appear as 
normal notes with the same notated duration; for example, a tuplet quarter note becomes a 
standard quarter note.

When Insert mode is activated, all notes in the tuplets are retained and any subsequent existing 
notes are pushed to later rhythmic positions to accommodate the extra rhythmic durations 
required. When Insert mode is deactivated, the earliest selected tuplets expand and overwrite 
subsequent notes and tuplets.

RELATED LINKS
Tuplet numbers/ratios on page 1112
Tuplet brackets on page 1109
Inputting notes on page 197
Turning grace notes into normal notes on page 806
Insert mode on page 408
Insert mode scopes on page 409

Allowing/Disallowing tuplets to span barlines
You can allow tuplets to span barlines; for example, in Renaissance music, you might want 
tuplets to span tick barlines without affecting their notation. By default, Dorico SE automatically 
splits tuplets over barlines so that both the durations of bars and the divisions in tuplets are 
clear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the tuplet brackets or tuplet numbers/ratios of the tuplets you want to allow/disallow 
to span barlines.

2. In the Properties panel, activate/deactivate Spans barline in the Tuplets group.

RESULT
The selected tuplets span barlines when Spans barline is activated, and are automatically split at 
barlines when it is deactivated.

Tuplets
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EXAMPLE

A 16th note sextuplet across a barline, notated as 
two triplets

The same sextuplet allowed to span the barline

AFTER COMPLETING THIS TASK
You can beam notes in the selected tuplets together.

RELATED LINKS
Barlines on page 672
Beaming notes together manually on page 690
Tuplet brackets on page 1109
Tuplet numbers/ratios on page 1112

Tuplet beams
Tuplet beams join notes in tuplets that can be joined with beams just like non-tuplet beams. You 
can make the same changes to tuplet beams that you can make to any other beam.

For example, duplet eighth notes do not need a bracket as they can be joined by a beam and 
notated using only a tuplet number/ratio.

A 6/8 bar with the standard subdivision of six eighth 
notes

A 6/8 bar with a subdivision of four duplet eighth 
notes in the space of six regular eighth notes

RELATED LINKS
Beaming on page 689
Tuplets within beams on page 703
Beaming notes together manually on page 690
Unbeaming notes on page 691
Splitting beam groups on page 692
Changing the direction of partial beams on page 702
Changing beam slants on page 695

Tuplets
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Tuplet brackets
Tuplet brackets show the duration of tuplets that are not joined by beams, such as triplet quarter 
notes, by showing the notes within the tuplet under a bracket.

EXAMPLE

A 4/4 bar with the standard subdivision of four 
quarter notes

A 4/4 bar with a subdivision of six triplet quarter 
notes in the space of four regular quarter notes

Tuplet bracket with tuplet number shown

NOTE

You can use properties in the Tuplets group of the Properties panel to edit individual tuplet 
brackets; however, the Tuplets group is only shown if you select tuplet numbers/ratios or 
brackets. It is not shown if you select notes within the tuplet, or notes within the tuplet and 
the tuplet number/ratio or bracket.

RELATED LINKS
Lines on page 946

Hiding/Showing tuplet brackets
You can hide/show tuplet brackets for individual tuplets, and independently of tuplet numbers/
ratios. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets you want to hide, or the signposts of tuplets whose brackets you 
want to show.

2. In the Properties panel, activate Bracket in the Tuplets group.

3. Choose one of the following options:

● Hidden 

● Shown 

Tuplets
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RESULT
Brackets on the selected tuplets are hidden/shown. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

Signposts are shown at the position of each hidden tuplet; that is, tuplets with no numbers/ratios 
or brackets shown.

AFTER COMPLETING THIS TASK
If you want to hide indications of tuplets entirely, you might also need to hide the tuplet 
numbers/ratios.

RELATED LINKS
Signposts on page 407
Hiding/Showing tuplet numbers/ratios on page 1112
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the staff-relative placement of tuplet brackets
You can show individual tuplet brackets and tuplet numbers/ratios above or below the staff or 
between staves. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets and tuplet numbers/ratios whose staff-relative placement you 
want to change.

2. In the Properties panel, activate Placement in the Tuplets group.

3. Choose one of the following options:

● Above 

● Below 

● Cross-staff above 

● Cross-staff below 

RESULT
The placement of the selected tuplet brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

TIP

● Deactivating Placement returns the selected tuplets to their default placement.

● You can also switch selected tuplets between being above/below the staff or cross-staff 
above/cross-staff below by pressing F .

RELATED LINKS
Changing the property scope on page 562
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Copying property settings to other layouts/frame chains on page 547

Changing the rhythmic end position of tuplet brackets
You can change the rhythmic end position of tuplet brackets relative to individual notes 
individually. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose end position you want to change.

2. In the Properties panel, activate End position in the Tuplets group.

3. Choose one of the following options:

● End at right-hand side of final note 

● End immediately before following note 

● End at position of final tuplet division 

RESULT
The end position for the selected tuplet brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating the property returns the selected tuplets to your default settings.

RELATED LINKS
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Forcing tuplet brackets to be horizontal
You can change the angle of individual tuplet brackets so that they appear horizontal. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose angle you want to change.

2. In the Properties panel, activate Force horizontal in the Tuplets group.

RESULT
The selected tuplet brackets appear horizontal when the property is activated. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.
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Tuplet numbers/ratios
Tuplet numbers and ratios are very similar: both indicate the number of equal notes included in 
the tuplet, such as 3 for triplets, but tuplet ratios also include the number of normal notes into 
whose duration the tuplet fits, such as 3:2 for triplets.

Additionally, tuplet ratios can include a note glyph that indicates the duration of notes in the 
tuplet.

A triplet with a ratio and note value indication

Tuplet numbers/ratios help performers quickly identify the type of tuplet and how they must fit 
the number of notes indicated into the prevailing tempo and meter.

NOTE

You can use properties in the Tuplets group of the Properties panel to edit individual tuplet 
numbers/ratios; however, the Tuplets group is only shown if you select tuplet numbers/ratios or 
brackets. It is not shown if you select notes within the tuplet, or notes within the tuplet and the 
tuplet number/ratio or bracket.

Hiding/Showing tuplet numbers/ratios
You can hide/show tuplet numbers/ratios for individual tuplets, and independently of tuplet 
brackets. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains. When showing tuplet numbers/ratios, you can choose a different type for each tuplet 
individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose numbers/ratios you want to hide/change, or the signposts 
of tuplets whose numbers/ratios you want to show.

2. In the Properties panel, activate Number in the Tuplets group.

3. Choose one of the following options:

● None 

● Number 

● Ratio 

● Ratio+note 

RESULT
The tuplet number/ratio shown for the selected tuplets is changed. If you selected None, the 
tuplet numbers/ratios for the selected tuplets are hidden. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.
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Signposts are shown at the position of each hidden tuplet; that is, tuplets with no numbers/ratios 
or brackets shown.

Deactivating Number returns the selected tuplets to the default setting.

AFTER COMPLETING THIS TASK
If you want to hide indications of tuplets entirely, you might also need to hide the tuplet brackets.

RELATED LINKS
Hiding/Showing tuplet brackets on page 1109
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Changing the position of tuplet numbers/ratios
You can show individual tuplet numbers/ratios at either the visual or rhythmic horizontal center 
of tuplets. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplets or the signposts of tuplets whose tuplet number/ratio horizontal position 
you want to change.

2. In the Properties panel, activate Center in the Tuplets group.

3. Choose one of the following options:

● Visual

● Rhythmic

RESULT
The horizontal position of tuplet numbers/ratios on the selected tuplets is changed. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

● Visual positions tuplet numbers/ratios at the visual center of the tuplet.

● Rhythmic positions tuplet numbers/ratios at the rhythmic center of the tuplet, which might 
be visually off-center.

EXAMPLE

Visual center Rhythmic center
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RELATED LINKS
Tuplet brackets on page 1109
Signposts on page 407

Tuplets
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Unpitched percussion

The term “unpitched percussion” covers all percussion instruments that are not tuned to specific 
pitches. This includes instruments such as bass drum, guiro, maracas, cymbals, and shakers.

Dorico SE provides comprehensive support for unpitched percussion notation, with flexible 
options for combining music for multiple instruments into percussion kits that can then be 
displayed differently in different layouts. You can also define percussion kits as drum sets, which 
changes the default stem directions of notes.

You can also customize and create new playing technique-specific noteheads for unpitched 
percussion. This allows you to indicate how notes are played by using different noteheads for 
different playing techniques on each instrument in percussion kits.

RELATED LINKS
Percussion kits and drum sets on page 1122
Percussion kit presentation types on page 1126
Staff labels for percussion kits on page 1037
Defining percussion kits as drum sets on page 140
Inputting notes for unpitched percussion on page 213
Playing techniques for unpitched percussion instruments on page 1115
Playing technique-specific noteheads on page 1116
Showing brackets on noteheads on page 850
Percussion editor on page 576

Playing techniques for unpitched percussion instruments
Playing techniques for unpitched percussion instruments, both as individual instruments and 
within percussion kits, can be notated in different ways, including using different notehead 
designs and positions.

You can indicate playing techniques for unpitched percussion instruments in any of the following 
ways:

● Use playing technique-specific noteheads, including positioning notes above/below their 
normal staff line

● Add articulations or single-note tremolos

● Add playing techniques in the same ways as for pitched instruments

For example, you can add open and closed techniques for hi-hats as playing techniques and use 
playing technique-specific cross noteheads for side stick notes for the snare drum.

You can select playing technique-specific noteheads for unpitched percussion instruments when 
inputting notes and change the playing technique-specific noteheads of existing notes. You can 
input playing techniques during note input and by adding them to existing music.

RELATED LINKS
Playing techniques on page 937
Articulations on page 661
Tremolos on page 1099
Edit Percussion Kit dialog on page 136
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Inputting notes for unpitched percussion on page 213
Changing playing technique-specific noteheads on page 1119
Defining how combinations of articulations and single-note tremolos sound in playback on page 
648
Exporting percussion kits on page 1123
Importing percussion kits on page 1123
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337

Playing technique-specific noteheads
Playing technique-specific noteheads use the design and position of noteheads to indicate 
different playing techniques for unpitched percussion instruments, both as individual 
instruments and within percussion kits.

For example, side stick notes on the snare drum notes are typically notated using cross 
noteheads. Other techniques might use the staff positions above or below the single-line staff to 
indicate different playing techniques.

Multiple different playing technique-specific noteheads for snare drum

You can edit the set of playing technique-specific noteheads and staff positions defined for each 
unpitched percussion instrument in the Percussion Instrument Playing Techniques dialog.

You can select playing technique-specific noteheads for unpitched percussion instruments when 
inputting notes and change the playing technique-specific noteheads of existing notes.

RELATED LINKS
Creating new playing technique-specific noteheads on page 1120
Changing playing technique-specific noteheads on page 1119
Inputting notes for unpitched percussion on page 213

Percussion Instrument Playing Techniques dialog
The Percussion Instrument Playing Techniques dialog allows you to edit the set of playing 
technique-specific noteheads defined for each unpitched percussion instrument.

You can open the Percussion Instrument Playing Techniques dialog in Setup mode in the 
following ways:

● For an individual percussion instrument: In the Players panel, click the instrument menu 
in the instrument label, and choose Edit Percussion Playing Techniques from the menu.

● For percussion instruments that are part of percussion kits: In the Players panel, click the 
instrument menu  in the kit instrument label and choose Edit Percussion Kit to open the 
Edit Percussion Kit dialog. In the main editing area, select the instrument whose playing 
techniques you want to edit, then click Edit Percussion Playing Techniques.

Unpitched percussion
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1 Playing technique-specific noteheads list

Contains the main playing technique-specific noteheads currently defined for the selected 
percussion instrument, showing the notehead set and the staff position corresponding to 
the playing technique as applicable.

You can add new playing technique-specific noteheads for unpitched percussion 
instruments. Normally, percussion instruments define at least the Natural playing 
technique, which is usually shown using the default notehead set.

2 Playback of Articulations and Tremolos

Allows you to define how combinations of articulations and tremolo strokes affect or 
override the playback of playing techniques.

For example, you can define an entirely different playing technique for a playing technique-
specific notehead for when an accent is added to it.

3 Overrides of articulations and tremolos list

Displays any overrides of articulations and tremolos you define.

EXAMPLE

Three different snare drum playing technique-specific noteheads followed by two clash cymbal playing 
technique-specific noteheads

All of these settings are saved in the percussion instrument within your project, and you can 
export them from one project and import them into others.

Unpitched percussion
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NOTE

Overrides for articulations and tremolos are not currently reflected in playback, but this is 
planned for future versions.

RELATED LINKS
Changing playing technique-specific noteheads on page 1119
Creating new playing technique-specific noteheads on page 1120
Overriding the appearance of playing technique-specific noteheads on page 1121
Defining how combinations of articulations and single-note tremolos sound in playback on page 
648
Inputting notes for unpitched percussion on page 213
Exporting percussion kits on page 1123
Importing percussion kits on page 1123

Override Percussion Noteheads dialog
The Override Percussion Noteheads dialog lists the playing technique-specific noteheads 
defined for the selected instrument in the Percussion Instrument Playing Techniques dialog, 
shows the notehead type mapped for each technique, and allows you to override those 
noteheads for five-line staff kit presentations only.

For example, the same notehead can indicate different playing techniques for different 
instruments. When those instruments are presented on the same five-line staff, this can cause 
confusion, so you can use the Override Percussion Noteheads dialog to disambiguate the 
notes for one instrument from another in five-line staff kit presentations only.

● You can open the Override Percussion Noteheads dialog by selecting an instrument in the 
Edit Percussion Kit dialog and clicking Edit Noteheads.

The Override Percussion Noteheads dialog comprises the following:

1 Instrument name

Displays the name of the percussion instrument whose noteheads are listed in the dialog.

2 Playing techniques table

Contains the noteheads for the selected percussion instrument, arranged into the following 
columns:

● Playing Technique: Displays the playing technique associated with the notehead in the 
corresponding row of the table.

Unpitched percussion
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● Default Notehead: Displays the notehead used by default for the playing technique in 
the corresponding row of the table.

● Notehead Override: Displays the notehead override used in five-line staff presentations 
for the playing technique in the corresponding row of the table. You can change the 
notehead override by clicking it and selecting another notehead from the menu.

RELATED LINKS
Overriding the appearance of playing technique-specific noteheads on page 1121
Changing playing technique-specific noteheads on page 1119
Inputting notes for unpitched percussion on page 213
Percussion kit presentation types on page 1126

Changing playing technique-specific noteheads
You can change the playing technique-specific noteheads of notes belonging to unpitched 
percussion instruments after they have been input; for example, to switch selected snare drum 
notes to the side stick technique and corresponding notehead.

PREREQUISITE
The unpitched percussion instruments whose playing techniques you want to change have at 
least two playing technique-specific noteheads defined in the Percussion Instrument Playing 
Techniques dialog.

PROCEDURE

1. In Write mode, select the notes whose playing technique-specific notehead you want to 
change.

TIP

If you select a single note in percussion kits using five-line staff or grid presentations, the 
current playing technique is shown above the rhythmic grid.

2. Cycle through the available playing techniques for the selected unpitched percussion 
instruments in any of the following ways:

● To cycle upwards, press Shift-Alt/Opt-Up Arrow .

● To cycle downwards, press Shift-Alt/Opt-Down Arrow .

RESULT
The playing techniques of the selected unpitched percussion notes are changed. Their notehead 
design and/or staff position might be changed.

RELATED LINKS
Playing technique-specific noteheads on page 1116
Playing techniques for unpitched percussion instruments on page 1115
Percussion Instrument Playing Techniques dialog on page 1116
Inputting notes for unpitched percussion on page 213
Moving notes to different instruments in percussion kits on page 1124
Percussion editor on page 576
Inputting notes using the Drumstick tool on page 578
Moving percussion notes between instruments/playing techniques on page 582
Defining how combinations of articulations and single-note tremolos sound in playback on page 
648
Playing techniques on page 937
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Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Showing brackets on noteheads on page 850
Changing the notehead design of individual noteheads on page 845

Creating new playing technique-specific noteheads
You can define new playing technique-specific noteheads for unpitched percussion instruments, 
which are saved for that type of percussion instrument in your project. You can also export 
playing technique-specific noteheads from your project and import them into other projects.

PROCEDURE

1. In Setup mode, open the Percussion Instrument Playing Techniques dialog in one of the 
following ways:

● For an individual percussion instrument: In the Players panel, click the instrument menu 
 in the instrument label, and choose Edit Percussion Playing Techniques from the 

menu.

● For percussion instruments that are part of percussion kits: In the Players panel, 
click the instrument menu  in the kit instrument label and choose Edit Percussion 
Kit to open the Edit Percussion Kit dialog. In the main editing area, select the 
instrument whose playing techniques you want to edit, then click Edit Percussion 
Playing Techniques.

2. In the playing technique-specific noteheads list, click Add Playing Technique .

3. Select the playback technique you want to use in the dialog that opens.

4. Click OK to add the selected playback technique as a new playing technique-specific 
notehead.

5. From the Notehead set menu, select the notehead you want for the playing technique-
specific notehead.

NOTE

To use the default notehead set, leave Notehead set as (Unset).

6. Choose one of the following options for Staff position:

● Below

● Line

● Above

RESULT
A new playing technique-specific notehead is added to the selected unpitched percussion 
instrument.

RELATED LINKS
Defining how combinations of articulations and single-note tremolos sound in playback on page 
648
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
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Overriding the appearance of playing technique-specific noteheads
It might be necessary to override the appearance of playing technique-specific noteheads in 
order to disambiguate the notes for one instrument from another if they share a staff position in 
five-line staff kit presentations.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit whose 
playing technique-specific noteheads you want to override.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Select the instrument whose noteheads you want to override in the main editing area of the 
dialog.

4. Click Edit Noteheads to open the Override Percussion Noteheads dialog.

5. Click in the Notehead Override column for the appropriate playing technique and select a 
new notehead type from the menu to override its notehead.

6. Click OK to save your changes and close the dialog.

RESULT
The playing technique-specific notehead is overridden for the selected instrument in five-line 
staff kit presentations.

NOTE

This does not affect the appearance of playing technique-specific noteheads in grid and single-
line instrument kit presentation types.

RELATED LINKS
Players panel on page 94
Override Percussion Noteheads dialog on page 1118

Percussion kits vs. individual percussion instruments
Percussion kits allow you to show multiple unpitched percussion instruments held by a single 
player at the same time in different ways. Multiple percussion instruments not combined into kits 
are shown on a single line that only shows the instrument currently being played by default.

One common type of percussion kit is a drum set. A drum set consists of a number of separate 
instruments mounted together on a frame, and is typically written on a regular five-line staff. 
Each instrument has its own position on the staff, and sometimes its own notehead type. 
Similarly, a pair of bongos is a percussion kit by default in Dorico SE, consisting of the two bongo 
drums, typically written on a grid with two lines: the smaller drum shown on the top line, and the 
larger drum shown on the bottom line.

Showing individual percussion instruments separately can be appropriate if a player only has one 
or two percussion instruments. However, combining percussion instruments into a kit gives you 
more flexibility over the presentation of music, which you can vary in each layout independently. 
Kits also give you greater control over the labeling of instruments.

If instrument changes are enabled on the Players page in Layout Options, Dorico SE changes 
from one instrument to the next, just as it does for pitched instruments.
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Percussion kits vs. individual percussion instruments 

1121
Dorico SE 4.3.30



NOTE

Kit instruments in player cards in the Players panel in Setup mode are colored green, whereas 
individual percussion instruments not part of percussion kits are colored the same light blue as 
all other instruments.

Percussion kits and drum sets
A percussion kit is a collection of unpitched percussion instruments that are played by a single 
player. Drum sets are a particular type of percussion kit that are often used in pop and rock 
music.

NOTE

In this documentation, we use “percussion kit” to refer to both percussion kits and drum sets.

In Dorico SE, you can present percussion kits in different ways, including as a five-line staff and 
as a grid. If you want percussion kits to behave as drum sets, you can define them as drum sets.

You can create percussion kits in Setup mode. You can combine existing unpitched percussion 
instruments into kits and add empty kits to players, to which you can then add unpitched 
percussion instruments. You can also import existing kits you have previously exported and 
saved.

You can move percussion instruments between players without affecting any music already 
added to that instrument.

NOTE

If the instrument you want to move is combined into a percussion kit, you must first remove the 
instrument from the kit before you can move it to another player.

You can change individual percussion instruments like any other instrument. However, you can 
only change unpitched percussion instruments to other unpitched percussion instruments, and 
you can only change the percussion instruments in kits within the Edit Percussion Kit dialog.

RELATED LINKS
Note input setup for percussion kits on page 215
Percussion kit presentation types on page 1126
Staff labels for percussion kits on page 1037
Universal Indian Drum Notation on page 1133
Edit Percussion Kit dialog on page 136
Combining individual percussion instruments into kits on page 121
Defining percussion kits as drum sets on page 140
Adding instruments to percussion kits on page 139
Removing individual instruments from percussion kits on page 144
Moving instruments on page 123
Inputting notes for unpitched percussion on page 213
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Exporting percussion kits
You can export percussion kits as .doricolib files. This allows you to use kits again without 
having to create them from scratch.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player whose percussion kit you 
want to export.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Export Kit at the bottom of the dialog to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The kit is exported and saved as a .doricolib file.

TIP

You can later import the .doricolib file into other projects to reuse the percussion kit.

Importing percussion kits
You can import .doricolib files containing percussion kits, which allows you to use kits again 
without having to create them from scratch.

PREREQUISITE
Your project contains at least one single player or empty-handed section player.

PROCEDURE

1. In Setup mode, in the Players panel, open the instrument picker for the player to which you 
want to assign the imported percussion kit in any of the following ways:

● Select the player and press Shift-I .

● Click the plus symbol  in the player card.

● Select the player, then click Player Settings  in the action bar and choose Add 
Instrument to Player. You can also right-click players and choose this option from the 
context menu.

2. Click Import Kit in the instrument picker to open the File Explorer/macOS Finder.

3. Locate and select the percussion kit .doricolib file you want to import.

4. Click Open.

RESULT
The selected .doricolib file is imported as a percussion kit. It is assigned to the player from 
whose card you opened the instrument picker.

RELATED LINKS
Players panel on page 94
Adding players on page 108
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Moving notes to different instruments in percussion kits
You can move notes to different instruments in the same percussion kit after they have been 
input.

NOTE

These steps do not apply in layouts using the single-line instruments kit presentation type. In 
such layouts, you can cross or move notes to other staves.

PROCEDURE

1. In Write mode, select the notes you want to move to a different instrument in the percussion 
kit.

2. Move the notes to another instrument in any of the following ways:

● To move them to the instrument above, press Alt/Opt-Up Arrow .

● To move them to the instrument below, press Alt/Opt-Down Arrow .

RESULT
The notes are moved to another instrument in the kit.

AFTER COMPLETING THIS TASK
You can change the position of each instrument in the kit.

RELATED LINKS
Edit Percussion Kit dialog on page 136
Changing the positions of instruments within percussion kits on page 142
Changing playing technique-specific noteheads on page 1119
Percussion kit presentation types on page 1126
Changing the percussion kit presentation type on page 1127
Creating cross-staff beams/tremolos on page 697
Moving notes/items to other staves on page 421

Notations on notes in percussion kits
You can add notations to notes and use different rhythms in percussion kits in the same ways as 
for normal notes; however, they can behave differently.

Articulations

You can add articulations to percussion instruments in all kit presentation types in the same ways 
as for other instruments.

However, in grid and five-line staff presentations, any articulations you add apply to all 
instruments in the same voice that have notes at that rhythmic position. For example, if both 
a snare drum and tom-tom note are at the same rhythmic position, and you add an accent, the 
accent is added to both instruments because they are both shown in the same down-stem voice 
by default.

You can see the accent applied to each note if you switch to the single-line instruments 
presentation type.
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Tuplets

When working in the grid and five-line staff kit presentation types, tuplets are added to all 
instruments in the same voice.

You can switch to the single-line instruments presentation type to input cross-rhythms on each 
instrument separately. When you switch back to the grid or five-line staff kit presentation types, 
Dorico SE attempts to resolve the rhythmic conflicts.

● Conflicting tuplets: One tuplet is moved into an extra voice for the duration of the conflict.

● Tuplet notes in one instrument and non-tuplet notes in another instrument starting at the 
same rhythmic position: The non-tuplet note is displayed as if it were part of the tuplet. This 
is because the note onset is at the same position as the start of the tuplet, so it sounds the 
same as the original notation.

● Tuplet notes in one instrument and non-tuplet notes in another instrument that do not start 
at the same rhythmic position, or other non-tuplet notes that start part-way through the 
tuplet: Non-tuplet notes are moved into an extra voice for the duration of the conflict.

NOTE

Deleting a tuplet from grid and five-line staff kit presentation types deletes the tuplet from 
all instruments whose notes contribute to the same shared voice.

Playing techniques

You can input playing techniques, such as + for closed and o for open hi-hat, during note input 
and add them later to existing music in the same ways as for other instruments.

Playing techniques are only added to the instrument to which the note you select belongs, even 
if there are other instruments in the same voice.

Percussion stickings

Dorico SE does not yet have a dedicated feature for percussion stickings. However, you can use 
lyrics to represent percussion stickings in all kit presentation types:

● Grid/Five-line staff presentation types: Select a note in the instrument in which you want to 
show stickings.

● Single-line instruments presentation type: Input lyrics directly into instruments in which you 
want to show stickings.

RELATED LINKS
Inputting articulations on page 246
Inputting tuplets on page 229
Changing the pitch of individual notes on page 424
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 337
Inputting lyrics on page 360

Dynamics in percussion kits
Unlike other items, dynamics are not shared between the grid/five-line staff presentation types 
and the single-line instruments presentation type. Any dynamics added to instruments in the 
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single-line instruments presentation type do not appear when you switch to grid/five-line 
presentations.

This is due to the complexity of combining a large number of different dynamics at the same 
rhythmic position, as allowed in the single-line instruments presentation, into the single position 
required for both the grid and five-line staff presentations. Therefore, you can add dynamics 
in the grid and five-line staff presentation types independently of the single-line instruments 
presentation type.

RELATED LINKS
Input methods for dynamics on page 284

Percussion kit presentation types
You can show percussion kits in three different presentation types, which can be different in each 
layout in your project.

NOTE

Dynamics are not shared between the grid/five-line staff presentation types and the single-
line instruments presentation type. Any dynamics added to instruments in the single-line 
instruments presentation type do not appear when you switch to grid/five-line presentations.

You can edit the appearance/structure of each presentation type independently in the Edit 
Percussion Kit dialog. For example, changing the order of instruments in the five-line staff 
presentation does not affect the order of instruments in the grid presentation of the same 
percussion kit.

5-line staff
Kit instruments are shown on a five-line staff. You can determine which instruments 
are shown on each line and in each space of the staff. A single staff label containing the 
name of the kit is shown.

The numbers down the left-hand side of the editing area in the Edit Percussion Kit 
dialog correspond to staff positions. For example, position 0 is the middle line of the 
five-line staff, position 1 is the space immediately above the middle staff line, position 
-2 is the line below the middle staff line, and so on.

Bold black lines show the five staff lines, while gray lines above and below the staff 
show nominal staff line positions. Each instrument is shown on its staff position.

Grid
Kit instruments are shown on a grid, with each instrument on its own line. You can 
customize the size of the gaps between each line. Staff labels are shown for each 
instrument in a smaller font than normal staff labels.

The numbers down the right-hand side of the editing area in the Edit Percussion Kit 
dialog correspond to the number of staff spaces between each instrument line. By 
default, all instruments in a grid are two spaces apart.

The order in which the instruments are listed matches the order in which they appear 
in the score.

Each instrument in a grid shows its own staff label by default, aligned vertically with its 
own line, but you can group adjacent instruments together and show a single label for 
each group.

Unpitched percussion
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Single-line instruments
Kit instruments are shown as individual instruments with their own lines. Normal-sized 
staff labels are shown for each instrument.

The editing area in the Edit Percussion Kit dialog lists all of the instruments in the 
order in which they appear in the score.

RELATED LINKS
Percussion kits and drum sets on page 1122
Edit Percussion Kit dialog on page 136
Staff labels for percussion kits on page 1037
Overriding the appearance of playing technique-specific noteheads on page 1121
Override Percussion Noteheads dialog on page 1118
Layout Options dialog on page 622

Changing the percussion kit presentation type
You can change the presentation type of percussion kits in each layout independently and 
independently of each other. For example, you can use a five-line staff in the full score layout 
but a grid in the percussion part layout, and have two percussion kits with different presentation 
types in the same full score layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the percussion kit 
presentation type.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Percussion section, choose one of the following options for each percussion kit in 
your project:

● 5-line Staff

● Grid

● Single-line Instruments

5. Click Apply, then Close.

RESULT
The presentation type is changed for the selected percussion kits in the selected layouts.
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Percussion legends
Percussion legends list the percussion instruments in use when using the five-line presentation 
type. Percussion legends can include all instruments that are represented on the staff, or only 
show sounding instruments in a set range to remind players which instruments to play at certain 
points.

Two sounding instrument percussion legends

By default, percussion legends appear above the staff. You can change the staff-relative 
placement of percussion legends individually.

Percussion legends appear as signposts if there are no instruments sounding at their position, 
or when the layout uses the grid presentation type. Percussion legends do not appear at all in 
layouts using the single-line instrument presentation type.

NOTE

● Percussion legends only appear in the layout in which they were added. If you want to show 
percussion legends in multiple layouts, you must add them in each layout.

● You can hide/show percussion legend signposts by choosing View > Signposts > Percussion 
Legends. Percussion legend signposts are shown when a tick is shown beside Percussion 
Legends in the menu, and hidden when no tick is shown.

RELATED LINKS
Changing the staff-relative placement of items on page 400
Edit Percussion Kit dialog on page 136
Percussion kit presentation types on page 1126
Hiding/Showing instrument change labels at the start of flows on page 1035
Staff labels for percussion kits on page 1037

Adding percussion legends to five-line staff kit presentations
You can add percussion legends at specific rhythmic positions to indicate the instruments in the 
kit. Percussion legends can show all instruments in the kit or only instruments sounding within 
the specified range.

NOTE

Percussion legends only appear when kits use the five-line staff percussion kit presentation type 
and in the layout in which they were added. If you want to show percussion legends in multiple 
layouts, you must add them in each layout.

PROCEDURE

1. In Write mode, select one of the following:
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● An item on the staff at the rhythmic position where you want to add a percussion legend 
for all instruments.

● The range of notes/items for which you want to show a percussion legend for sounding 
instruments.

2. Add a percussion legend in one of the following ways:

● Choose Edit > Notations > Percussion > Legend for All Instruments.

● Choose Edit > Notations > Percussion > Legend for Sounding Instruments.

TIP

You can also choose these options from the context menu.

RESULT
A percussion legend is added to the kit. It appears above the staff when the kit uses the five-line 
staff presentation. It lists instruments, either all instruments or just instruments with notes 
within the selected range, in the order in which they appear in the five-line staff, from highest 
down to lowest.

RELATED LINKS
Percussion kit presentation types on page 1126
Editing percussion legend text on page 1131

Changing the percussion legend type
You can change the type of percussion legends so they show all instruments or only sounding 
instruments in five-line staff presentations.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the percussion legends whose type you want to change.

2. In the Properties panel, activate Legend type in the Percussion Legends group.

NOTE

The property is already activated for sounding instrument percussion legends.

3. Choose one of the following options:

● Legend

● Sounding instruments

RESULT
The legend type of the selected legends is changed.

RELATED LINKS
Percussion legends on page 1128
Percussion kit presentation types on page 1126
Adding percussion legends to five-line staff kit presentations on page 1128
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Changing the sounding instrument percussion legend range
You can change the rhythmic range of sounding instrument percussion legends to include more/
fewer instruments in the legend, as they only show the instruments playing at the rhythmic 
positions included in the range.

PROCEDURE

1. In Write mode, select the sounding instrument percussion legend whose range you want to 
change.

2. Change the range in any of the following ways, according to the current rhythmic grid 
resolution:

● To move the whole range to the right, press Alt/Opt-Right Arrow .

● To move the whole range to the left, press Alt/Opt-Left Arrow .

● To lengthen the range, press Shift-Alt/Opt-Right Arrow .

● To shorten the range, press Shift-Alt/Opt-Left Arrow .

NOTE

Key commands lengthen/shorten items by moving their end only.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
The rhythmic range covered by the selected sounding instrument percussion legend is changed 
according to the current rhythmic grid resolution.

The instruments included in the percussion legend are automatically updated to reflect the 
instruments playing within the range.

RELATED LINKS
Rhythmic grid on page 190

Showing short instrument names in percussion legends
Percussion legends use full instrument names by default, but you can choose to use short names 
to save space.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the percussion legends whose instrument name lengths you want to change.

2. In the Properties panel, activate Use short names in the Percussion Legends group.

RESULT
Short instrument names are shown in the selected percussion legends.

Deactivating Use short names returns the selected percussion legends to showing full 
instrument names.
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RELATED LINKS
Staff labels for percussion kits on page 1037
Percussion legends on page 1128
Percussion kit presentation types on page 1126
Adding percussion legends to five-line staff kit presentations on page 1128

Editing percussion legend text
By default, percussion legends show the instrument names of percussion instruments in five-line 
staff presentations, stacked vertically. You can change the text shown in percussion legends to 
show custom text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

1. Select the percussion legends you want to edit.

2. In the Properties panel, activate Custom text in the Percussion Legends group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected percussion legends is changed.

RELATED LINKS
Hiding/Showing zones on page 41
Properties panel on page 560

Voices in percussion kits
Dorico SE automatically combines music into a smaller number of voices when multiple 
percussion instruments are presented in a five-line staff or as a grid, even if they contain 
different rhythms. By default, music is combined into one up-stem voice and one down-stem 
voice.

You can change the voice of individual notes and whole instruments in individual percussion kits.

Notes in the same voice cannot be notated using different durations and are notated using ties 
by default instead.

If one of the instruments in a percussion kit has a tuplet rhythm, other instruments can share the 
voice if their notation is compatible, such as if the tuplet structure is the same, or if they have a 
single note that coincides with the start of the tuplet. In this case, the single non-tuplet note is 
notated as the same duration of the first note of the tuplet.

If the music of the different instruments in the same voice is incompatible, Dorico SE dynamically 
creates another voice and notates the remaining music in that voice until the music is compatible 
again.

RELATED LINKS
Edit Percussion Kit dialog on page 136
Notations on notes in percussion kits on page 1124
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Defining percussion kits as drum sets on page 140
Adding slash voices to percussion kits on page 1007

Specifying the stem direction/voice of instruments in percussion kits
You can specify the stem direction for each instrument in individual percussion kits. You can also 
set which voice they are in, allowing you to control which instruments share voices in percussion 
kits.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit whose 
instrument stem directions and voices you want to specify.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. In the dialog, select an instrument whose stem direction and voice you want to specify.

4. Choose one of the following stem directions for Stem direction and voice:

● Up-stem 

● Down-stem 

5. Specify a voice by changing the value for Stem direction and voice.

NOTE

You do not have to change the voice number if you are switching between up- and down-
stem voices as the number corresponds to the voice number for each stem direction.

6. Click Apply, then Close.

RESULT
The default stem direction and voice of the selected instrument is changed.

RELATED LINKS
Players panel on page 94
Edit Percussion Kit dialog on page 136

Changing the voice of individual notes in percussion kits
You can override the default voice for individual notes in percussion kits, including drum sets.

PROCEDURE

1. Select the notes whose voice you want to override.

2. Choose Edit > Notations > Percussion > Change Voice > [Voice].

For example, to change notes to the second down-stem voice, choose Edit > Notations > 
Percussion > Change Voice > Down-stem Voice 2. You can also choose this option from the 
context menu.

RESULT
The voice of the selected notes is changed, independently of the default voice for their 
instrument and independently of your setting for voices in drum sets.
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TIP

You can reset the voice of individual notes by selecting them and choosing Edit > Notations > 
Percussion > Change Voice > Reset Note Destination Voice. You can also choose this option 
from the context menu.

Universal Indian Drum Notation
Dorico SE supports the Universal Indian Drum Notation system developed by Keda Music Ltd.

Universal Indian Drum Notation has been designed primarily for tabla, but can also be applied to 
other Indian drums with two heads, such as nagara, dhol, dholak, mridangam, and pakhawaj.

Indian drum clefs are automatically shown on the staves of tabla instruments and tabla 
percussion kits, but you can also input Indian drum clefs manually.

RELATED LINKS
Adding players on page 108
Adding instruments to players on page 120
Inputting clefs with the panel on page 303
Percussion kits and drum sets on page 1122
Percussion maps on page 643
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Voices

For many instruments, such as flute or trombone, each staff usually contains a single musical line 
in a single voice that is read from left to right along the staff. When multiple, independent lines 
must be shown in a single staff, each line can be a separate voice.

An excerpt of piano music with two voices active on each staff

One common use for showing multiple voices in a single staff is in vocal music, when the 
soprano and alto lines share a single staff and the tenor and bass lines share another staff. 
Showing each vocal line in its own voice helps to separate the lines, making the music easier to 
read and making the shape of each melodic line clear.

In Dorico SE, notes belong to voices. You can create as many voices as you like on each pitched 
instrument staff. Each voice has its own color, which you can see if you show voice colors. This 
can help you to keep track of which notes are in which voices if there are multiple overlapping 
musical lines in your project.

Voices in Dorico SE are divided into up-stem voices and down-stem voices. Stems of notes in 
up-stem voices point upwards, while stems of notes in down-stem voices point downwards. 
However, in bars where only one voice contains notes, stem directions are automatically changed 
to the directions they would have if there were only one voice on the staff. By default, the first 
voice on the staff is up-stem.

Following most notation conventions, rests are shown in bars for all voices that have notes in 
the bar. If two or more voices have a rest of the same rhythmic duration at the same rhythmic 
position, that rest is consolidated by default: instead of showing two identical rests, only one is 
shown.

RELATED LINKS
Inputting notes into multiple voices on page 207
Changing the voice of existing notes on page 422
Swapping the contents of voices on page 423
Voices in percussion kits on page 1131
Slash voices on page 1005
Adding notes above/below existing notes on page 232
Stem direction on page 854
Voice column index on page 1137
Unused voices on page 1138
Implicit rests in multiple-voice contexts on page 1010
Moving rests vertically on page 1012
Deleting rests on page 1012
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Hiding/Showing voice colors
You can show notes in different colors according to their voice; for example, to check which notes 
are in which voice. When voice colors are hidden, all notes appear black by default.

Voice colors are considered annotations and are not printed by default.

NOTE

You cannot show colors for voices and notes out of range simultaneously.

PROCEDURE

● Do one of the following:

● To show voice colors, choose View > Note And Rest Colors > Voice Colors.

● To hide voice colors, choose View > Note And Rest Colors > None.

RESULT
Voice colors are hidden/shown. The first eight voices on each staff use the colors set in 
Preferences > Colors > Voice Colors. Voice colors are automatically assigned to subsequent 
voices.

TIP

You can also identify voices by selecting individual notes and looking at the display in the status 
bar.

EXAMPLE

Voice colors shown

AFTER COMPLETING THIS TASK
If showing voice colors reveals some notes are not in the voice you want, you can change their 
voice.

RELATED LINKS
Preferences dialog on page 53
Changing music area colors on page 51
Changing the voice of existing notes on page 422
Stem direction on page 854
Hiding/Showing colors for notes out of range on page 847
Annotations on page 507
Status bar on page 36

Voices
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Note positions in multiple-voice contexts
Notes are usually placed directly above each other and at the same horizontal position, so that 
it is immediately clear which notes are played together. However, the horizontal alignment of 
notes can be different in multiple-voice contexts.

There are circumstances when some notes must be positioned slightly to one side in a different 
voice column to ensure the division of notes across the voices is clear. For example, when there 
are three or more voices in a single staff, or when notes in two voices are a second interval apart.

A phrase with multiple voice columns for some beats on the top staff

Interlocking notes in different voices can be positioned in two ways:

1. Notehead to notehead, which allows noteheads to overlap partially. This voice order often 
takes up less horizontal space than positioning notes stem to stem, as notes can overlap.

2. Stem to stem, which does not allow noteheads to overlap. This voice order keeps notes in 
different voices separate.

Dorico SE positions notes by default with the noteheads partially overlapping, in order to 
minimize the horizontal space they occupy and to maintain the clarity of the rhythm. The order 
and position of notes in different voices is also automatically adjusted so that each rhythmic 
position uses as little horizontal space as possible, while remaining clear and legible.

You can manually swap the order in which opposing voices are positioned horizontally.

RELATED LINKS
Stem direction on page 854
Slashes in multiple-voice contexts on page 999
Implicit rests in multiple-voice contexts on page 1010
Note spacing on page 533
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Voice column index
The voice column index is used to determine the positions of notes when multiple columns are 
needed; for example, when notes in two voices are a second interval apart and therefore cannot 
be placed directly above each other vertically, instead they must partially overlap.

Dorico SE automatically changes the voice column of voices according to the number of active 
voices and the pitch of notes. Dorico SE prefers showing voices with the widest pitch range 
between them on the left of the rhythmic position and voices with narrower pitch ranges to the 
right, as this produces the most balanced result, especially when there are multiple accidentals.

One voice Two voices 
horizontally aligned 
in the same voice 
column

Three voices all still 
horizontally aligned

Four voices with 
two voice columns

Five voices with two 
voice columns

Swapping the order of voices
Dorico SE automatically positions notes with the noteheads partially overlapping, in order to 
minimize the horizontal space they occupy and maintain the clarity of the rhythm. You can 
manually swap the order in which opposing voices are positioned horizontally. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE
You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose order you want to change.

2. Choose Edit > Notations > Voices > Swap Voice Order. You can also choose this option 
from the context menu.

RESULT
The voice order of the selected notes is changed by changing their voice column index. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

EXAMPLE

Interlocking notes in opposing voices positioned 
notehead to notehead.

Interlocking notes in opposing voices positioned 
stem to stem.

Voices
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RELATED LINKS
Stem direction on page 854
Implicit rests in multiple-voice contexts on page 1010
Swapping the contents of voices on page 423
Changing the voice of existing notes on page 422
Changing the property scope on page 562
Copying property settings to other layouts/frame chains on page 547

Unused voices
An unused voice is one that contains no notes anywhere in the project. Any unused voices are 
automatically deleted when you close a project, but you cannot manually delete voices once they 
have been created. You can create as many voices as you want in each staff.

NOTE

Deleting all notes in a voice does not delete the voice immediately.

If you later want to input notes in a voice that was automatically deleted when you last closed the 
project, you can create a new voice at any rhythmic position.

Notes crossed to staves with existing notes in other voices
When you create cross-staff beams by crossing notes to staves that already contain notes, the 
stem direction of the existing notes may change. This is due to how multiple voices at the same 
rhythmic position are handled in Dorico SE.

For example, if a piano part contains notes in up-stem voices on both staves, the stem direction 
of notes in both voices can change if notes from the upper staff are crossed to the lower staff. 
In this situation, the notes from the two staves are not combined, but are instead treated as two 
up-stem voices in a multiple-voice context.

Two piano staves, each with notes in a single up-
stem voice.

When the notes in the upper staff are crossed to the 
lower staff, the stem direction of the notes already in 
the lower staff changes so they point upwards.

You can change the stem direction of the notes originally in the lower staff in any of the following 
ways:

● Select the notes originally in the lower staff and change their voice to another voice, such as 
a down-stem voice.

● Select the notes originally in the lower staff and change their stem direction.

Alternatively, you can move the notes in the upper staff permanently to the lower staff.

RELATED LINKS
Creating cross-staff beams/tremolos on page 697
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Moving notes/items to other staves on page 421
Inputting notes into multiple voices on page 207
Changing the voice of existing notes on page 422
Stem direction on page 854

Voices
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Glossary

A
action (expression maps)
A control in expression maps that determines how individual switches are controlled in order to 
trigger the required playback technique or combination of playback techniques.

action (harps)
The mechanism that raises or lowers the pitch of harp strings, as controlled by the position of 
each pedal.

action (pianos)
The mechanism that allows piano hammers to strike the strings with different forces, depending 
on the strength with which the player depresses the corresponding key. It allows pianos to use a 
greater dynamic range, hence their full name “pianoforte”.

alignment relative to noteheads
When calculating the horizontal alignment of items relative to noteheads, Dorico SE uses the 
front notehead in the first voice column at the corresponding rhythmic position. The front 
notehead is the notehead on the correct side of the stem; that is, on the left of up-stems and 
on the right of down-stems. Items that can be aligned relative to noteheads include lyrics, chord 
symbols, and playing techniques.

anacrusis
See pick-up bar.

articulation (music notation)
A symbol that indicates how a note should be played, typically affecting its onset (attack), release, 
or duration. For example, staccato marks and accents.

articulation (sound libraries)
A term that refers to playing techniques generally.

attachment
The rhythmic position at which an item occurs, or to which an item applies, in the music.

B
bar
A span of music comprising a specific number of beats, as defined by the prevailing time 
signature, whose boundaries are indicated by bar lines. Also known as a “measure”, but this 
documentation uses “bar”.

C
cancellation natural
A natural accidental positioned on the staff immediately before a change in key signature or 
a single note. It indicates that the previous accidental no longer applies and can be followed 
immediately by a new accidental if applicable. Showing cancellation naturals before single 
accidentals that follow double accidentals is also known as “archaic cancellation”. Cancellation 
naturals before a change in key signature are known as “traditional” when positioned after the 
barline and “Russian” when positioned before the barline.
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caret
Shown during note input, the caret is the vertical line that extends above and below the staff and 
indicates the rhythmic position at which items are input. Also known as an “insertion point”. In 
Dorico SE, the caret, cursor, and mouse pointer are related but serve different purposes. See also 
rhythmic grid, note input, cursor, mouse pointer.

casting off
The act of fixing the layout of pages of music, such as defining a set number of systems per page 
or the number of bars per system.

cautionary accidental
A restatement of an earlier accidental to eliminate ambiguities, such as when a tied note with an 
accidental continues onto another page. Also known as a “courtesy accidental”.

CC
Short for “continuous controller” or “control change”, it is a MIDI message that combines a 
controller number and a value. The value for an individual controller can change over time, 
allowing incremental manipulation of the corresponding sound or effect, such as increasing/
decreasing the string vibrato intensity. You can specify the sound or effect that each CC switches 
to and controls in each sound library using expression maps. In Dorico SE, each instrument track 
has 127 available MIDI CCs, each with a value range from 0 to 127. Because MIDI CC does not 
use notes on a MIDI keyboard, it allows you to use the full range of MIDI keyboard notes for note 
input. However, it is therefore harder to trigger MIDI CC whilst recording notes. See also MIDI, 
PC.

channel
In MIDI, a channel determines which note, controller, or other data is played by which sound 
on which device. In Dorico SE, notes on a single staff may be played by different channels, 
depending on which playing techniques are provided by the patch assigned to each channel. See 
also MIDI, patch.

chord
Two or more notes of the same duration that start at the same rhythmic position and share a 
stem.

chord input
A variation of note input where notes are stacked on top of each other to create chords, rather 
than being input after the previous note in sequence. Notes are input at the caret position, which 
does not advance automatically. See also caret, note input, Insert mode.

collision avoidance
Automatic adjustments made by Dorico SE to ensure multiple items at the same position do not 
overlap and that all remain clearly legible. Includes changing the shape of items, such as slurs, 
and changing the vertical and/or horizontal position of items, such as accidentals in chords.

column
A vertical line representing the same horizontal position across all staves in the system. Used 
to determine the position of notes and chords for the purposes of spacing music accurately. 
Multiple columns can be used for the same rhythmic position to accommodate multiple voices, 
with notes or chords in some voices being offset horizontally from notes or chords in other 
voices.

concert pitch
All notes are written as they sound. Full scores are often notated in concert pitch, so that 
harmonies and themes are easier to identify. Also known as “sounding pitch”. See also 
transposed pitch, instrument transposition.

condensing
The process of showing the music for multiple players on fewer staves than is normal, usually 
by allowing multiple instruments of the same type to share a staff, such as Flutes 1-2 or Horns 
1-4. Most commonly used for large orchestral scores, as when there are fewer staves on a page 
it is possible to use a larger staff size, which is easier for conductors to read. See also divisi, pitch 
crossing, reducing.

Glossary
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constant point
A change in value in the Key Editor that sets a fixed value until the next point. See also point (Key 
Editor), linear point, value line.

context menu
A menu that you can access by right-clicking on a mouse or double-tapping on a touchpad. Its 
options vary by the location of the mouse pointer and what is selected when you access it, but it 
most commonly contains options also found on the Edit menu.

cursor
The vertical blinking line that appears when entering or editing text. See also caret, mouse 
pointer.

D
dead note
A note played on a fretted instrument whose sound is muted to produce a sound that is more 
percussive than pitched. Usually produced by gently resting one hand on the string. Also known 
as a “muted”, “muffled”, “ghost”, or “silenced” note. In Dorico SE, only notes belonging to fretted 
instruments, such as the guitar or banjo, can be dead notes.

disclosure arrow
A small arrow that is shown on all edges of the main window in Dorico SE. It allows you to 
hide/show the toolbar and panels individually.

divisi
Italian for “divide” or “divided”, divisi is when players split in order to play multiple lines of music. 
This commonly involves a section, such as Violin I, dividing and using two staves rather than one 
for a limited passage. Divisi passages can be notated all on the same staff, using multiple voices 
if required, or across multiple staves. See also tutti, condensing, exploding, reducing.

drum set
A particular type of percussion kit that is often used in pop and rock music. Drum sets often 
use a different arrangement of voices than percussion kits. In this documentation, references to 
“percussion kits” also apply to drum sets, as drum sets are a type of percussion kit.

E
EDO
An abbreviation for Equal Division of the Octave, it is a unit used to describe how an octave 
can be divided into equal parts, often for the purpose of defining a microtonal scale or tonality 
system. Traditional Western European music uses 12-EDO; that is, each octave is divided into 12 
equal half-steps (semitones). Music that uses equal quarter tones uses 24-EDO. See also pitch 
delta.

endpoint
The unique combination of inputs and outputs that together allow the correct sounds to be 
played for each instrument.

Engrave mode
A mode in Dorico where you can manipulate and modify every item in your project, but without 
deleting them, moving them rhythmically, or changing the pitch of notes. You can also determine 
how the pages in each layout of your project are formatted for printing or exporting. Not 
available in Dorico SE. See also modes.

enharmonic equivalent
An alternative spelling of a note that uses a different scale degree and accidental but produces 
the same sounding pitch, such as G♯ and A♭.
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ensemble
A predefined collection of players, each holding instruments that are often used together, such 
as string quartet, wind quintet, brass quintet, string ensemble, and double woodwinds.

envelope
A change in sound over time that comprises multiple stages, such as attack, sustain, and decay. 
In the Dynamics editor, envelopes are represented by highlighted regions and multiple separate 
points, each controlling a different parameter of the overall envelope. See also point (Key Editor), 
constant point, linear point, value line.

explicit rest
A rest that was deliberately input during rest input or imported from a MusicXML file. Explicit 
rests cannot be suppressed between notes in a particular voice. See also rest, implicit rest.

exploding
The process of assigning music to more instruments than it was written for originally. Exploding 
music is often a key step in arranging and orchestrating music, such as when a piano piece is 
arranged for string quartet. See also reducing, divisi.

F
family
Instruments of a similar kind that are typically bracketed together in a score, such as woodwind, 
brass, percussion, and strings.

fermata
A notation that indicates all notes at that position are held for longer than their notated length. 
It is most commonly shown as a curved line with a dot under the curve, but it can also be shown 
with a pointed arch or square shape. Also known as a “pause” or a “birds’ eye”.

flow
A self-contained span of music of any scope, such as a movement in a symphony, a song in 
an album, a number in a musical, or a short exercise in a music theory worksheet. A flow can 
contain the same players as other flows in the project or separate players just for that flow. See 
also player.

formatting
The act of determining the number of bars in a system, the number of systems on a page, and 
the distances between staves and systems.

fps
A unit of measurement, short for “frames per second”, that refers to the number of video frames 
occurring each second.

fragment
Part of a notation item. For example, fragments of a note include its notehead, rhythm dots, 
accidentals, the tip of its stem, and beam. In Write mode, selecting any part of an item also 
selects all of its fragments, so any changes you make affect the whole item. See also item, 
segment.

frame
A rectangular container for music, text, or graphics on a page.

fretted instrument
A type of instrument that in most cases has multiple strings, a neck with marked frets, and 
is played by stopping the strings at fret positions on the neck with one hand, usually the left, 
and plucking the corresponding strings with the other hand, usually the right. Common fretted 
instruments include the guitar, ukulele, and banjo.

full score
A score comprising all of the music for all of the players and their instruments, typically laid 
out in a specific order. The order used varies according to the ensemble for which the music 
is written. In full scores for orchestra, the players are typically ordered from the highest wind 
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instrument at the top of the page, such as piccolo, to the lowest string instrument at the bottom 
of the page, such as contrabass, with brass, keyboards, voices, and percussion in between.

G
galley view
A viewing option that shows music laid out as a single, infinitely wide system.

grace note
A small note, often used to show an ornament or embellishment, that is not counted towards the 
number of beats in the bar; instead, it steals from the duration of either the preceding or the 
following rhythmic notes. Also known as an “arhythmic” or “crushed” note. In common practice, a 
grace note with a slashed stem is an “acciaccatura”, which is to be played as quickly as possible, 
either immediately before or at the rhythmic position of the note or chord that follows it. A grace 
note with an unslashed stem is an “appoggiatura”, which is played as half of the written duration 
of the note or chord that follows it.

grand staff instrument
An instrument that normally uses two or more staves joined by a brace to display their notes. 
Common grand staff instruments include the piano, organ, and harp. Upper staves usually 
indicate higher notes and use the treble clef, while lower staves usually indicate lower notes and 
use the bass clef.

H
hairpin
A notation for dynamics that uses a pair of angled lines, diverging from or converging on a 
single point, to show a gradual increase or reduction in the dynamic level; that is, a crescendo or 
diminuendo.

half-bar
The rhythmic position that divides bars into two equal sections when the prevailing time 
signatures can be divided into four equal beats. In Dorico SE, specific beam grouping and note 
grouping settings apply to bars with a half-bar. Time signatures that have a half-bar include 4/4 
and 12/8.

handle
A selectable item that marks the ends of lines, the corners of frames, and other moveable 
positions, such as pedal line retakes and slur control points. In Write mode, handles are circular 
and mark rhythmic positions.

harmonic series
A naturally-occurring set of frequencies that are all related to a single pitch, known as the 
“fundamental”. When a fundamental pitch is played, the note produced contains many different 
notes within the harmonic series. These additional notes are known as “partials” or “overtones”. 
It is also possible to bring out the sound of individual partials by playing them as harmonics. 
There is a consistent pattern of intervals between partials within the harmonic series, and 
these intervals become progressively smaller the further up the harmonic series they occur. 
For example, the interval between the first and second partials is an octave whereas the interval 
between the seventh and eighth partials is only approximately a major second. At the top end of 
the harmonic series, most partials are microtones. See also partial.

hook
A short line that extends from other lines, most commonly at a right angle, that helps to clarify 
the end position of lines. In Dorico SE, hooks can be used at the end of pedal lines, octave lines, 
repeat endings, and tuplet brackets.

horizontal justification
The alignment of musical content to the left and right edges of the frame. To ensure that all 
staves in a system occupy the same width, any remaining space that is left over after the music 
is spaced is distributed evenly between all of the columns in the system. Sometimes the final 
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system of a flow is not fully justified and is allowed to end partway across the width of the frame. 
See also frame, justification.

I
implicit rest
A rest that is automatically shown around the notes you input. Its notated duration automatically 
adjusts according to the time signature and its position in the bar. Implicit rests can be 
suppressed between notes in a particular voice, which hides them. See also rest, explicit rest, 
padding rest, multi-bar rest.

Insert mode
A way of changing how notes are input. When Insert mode is activated, new notes push all 
subsequent notes in the same voice along by the input duration instead of overwriting existing 
notes. Similarly, reducing the duration of notes with Insert mode activated pulls them closer 
together without leaving rests between the notes. This also affects edits you make outside of 
note input, such as deleting notes, changing the duration of notes, or inputting time signatures. 
See also note input, chord input.

instrument
Anything that requires at least one staff to represent the sounds or music it produces. Common 
instruments include the violin, flute, tuba, and bass drum. However, human voices, computer 
triggering samples, and tape recordings can also be instruments.

instrument transposition
The interval difference between the pitch the instrument plays and the resulting sounding pitch, 
often included as part of the instrument name. For example, when a Clarinet in B♭ plays a C, the 
pitch produced is a concert B♭. Instrument transposition is also known as “instrument pitch”. See 
also concert pitch, transposed pitch.

item
Generic term for any note, rest, chord, notation, or other selectable object that appears in the 
score in Dorico SE. See also fragment, segment.

J
justification
The alignment of musical content to the edges of the frame, both horizontally and vertically. See 
also frame, horizontal justification, vertical justification.

K
key command
A set of keys that perform a defined task when pressed together. Also known as a “keyboard 
shortcut” or “hotkey”.

L
layout
A page-based presentation of the music for one or more players in one or more flows; for 
example, a full score that contains all players or an instrumental part that contains only a single 
player. See also flow, player.

layout options
Options that affect the setup of an individual layout, such as page and staff size. These options 
can be set in each layout independently in the Layout Options dialog. See also layout.
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linear point
A change in value in the Key Editor that acts as a point on a curve, setting a value for its position 
only and allowing for a smooth change in value from that position until the next point. See also 
point (Key Editor), constant point, value line.

lock duration
Functionality that allows you to change the pitches of existing music while retaining existing 
rhythms.

lyric
Any text that is intended to be sung or spoken by an individual singer or group of singers. A lyric 
can be a whole word or an individual syllable in a multi-syllabic word. Lyrics are shown at each 
rhythmic position where a new word or syllable begins. Typically, lyrics are found below the staff, 
but are sometimes placed above the staff; for example, in the case of a short score.

M
measure
See bar.

MIDI
An abbreviation for Musical Instrument Digital Interface, a standard for how electronic musical 
instruments, computers, and virtual instruments can connect to and communicate with each 
other. In Dorico SE, MIDI data can be sent to one of 16 channels, which allow either a specific 
instrument, or a specific patch on a specific instrument, to receive and respond to the data. See 
also channel, patch, CC, PC.

minor key
A key signature based on a minor scale, which has a different pattern of intervals to a major 
scale. See also minor scale.

minor scale
A sequence of notes containing the pitches of a minor key. There are three types of minor scales: 
natural, harmonic, and melodic. Natural minor scales follow the interval pattern of the Aeolian 
mode, which on a keyboard is all the white notes from A-A. Harmonic minor scales also follow 
the Aeolian mode interval pattern but the seventh degree of the scale is sharpened; for example, 
G♯ in A harmonic minor. Melodic minor scales follow different interval patterns when they are 
rising/falling: when rising, melodic minor scales have sharpened sixth and seventh degrees, but 
when falling, the sixth and seventh degrees are both natural. See also minor key.

modes
Selectable workspaces in the project window that represent different phases in the workflow of 
preparing a score. See also Setup mode, Write mode, Engrave mode, Play mode, Print mode.

mouse pointer
The icon on the screen that allows you to interact with items and the user interface, usually by 
clicking. Its position is typically controlled by an external mouse or touchpad. Its appearance 
varies depending on the context, such as appearing as a hand when it hovers over a hyperlink, 
but it most commonly appears as an arrow pointing towards the top left corner of the screen. 
Also known as a “mouse arrow”, “cursor”, or simply a “pointer” or “mouse” In this documentation, 
we use the term “mouse pointer” to differentiate from the cursor and caret. See also cursor, 
caret, touchpad.

multi-bar rest
A consolidation of multiple adjacent empty bars into a smaller unit, typically shown as a single 
bar with the total number of bars' rest written above the staff. A multi-bar rest normally shows 
an H-bar symbol, which is a thick horizontal line with vertical lines at each end. In some older 
published scores, a multi-bar rest of up to nine bars in length is shown using a combination of 
double whole and whole rests. Also known as a “multirest”.
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music area
The main part of the window in Setup mode and Write mode where you input and edit your 
music.

MusicXML
A file format designed to allow the interchange and archiving of music notation data in an open 
and non-proprietary way. It is useful for exchanging scores between different music applications.

N
node
A position along the length of a string that marks an equal division of the string, such as a 
quarter of the way along a string. Touching, but not fully stopping, a string at a node produces a 
harmonic partial. See also partial, harmonic series.

note input
The standard method of adding notes to staves in sequence that is possible when the caret is 
active. The caret automatically advances to the next rhythmic position after each note is input. 
During note input, it is also possible to input other items at the caret position. Also known as 
“step input” because notes are input step-by-step. See also caret, chord input, Insert mode.

O
octave division
A single step within an octave whose interval depends on the total number of divisions in the 
octave. For example, in 12-EDO, there are twelve octave divisions, each a half-step (semitone) 
apart. See also EDO, pitch delta.

overtone
See partial. See also harmonic series, node.

P
padding
The minimum distance/gap between two items, such as text and its enclosure. Padding values 
can be independent of other set values, such as minimum height or width.

padding rest
A rest that fills the extra rhythmic space before or after cues that start or end partway through 
bars. This shows clearly how the rhythm of the cue fits within the time signature and how it 
relates to the player’s existing material. See also implicit rest.

page break
The forced termination of a page of music at a particular rhythmic position, typically at a barline. 
Often used to ensure a convenient page turn in a part. In Dorico SE, page breaks can be achieved 
using frame breaks, which are indicated using signposts. See also system break.

page view
A viewing option that shows music laid out on a page with a fixed width and height, as it appears 
when printed. See also galley view.

panel
Wide palettes of tools on the left, right, and bottom edges of the program window that are 
available in all modes, but their content varies in each mode.

part
The music belonging to the instruments played by one or more players, shown on its own rather 
than in a full score. Performers who do not need to see the music belonging to the whole 
ensemble play from parts so they only have to read the music they play themselves. See also full 
score, layout.
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partial
A single pitch or frequency in the harmonic series, which varies in pitch according to the pitch 
of the fundamental but is always a consistent interval above the fundamental according to 
its number in the harmonic series. For example, the second partial is an octave above the 
fundamental, the third partial is an octave and a fifth above the fundamental, and the fourth 
partial is two octaves above the fundamental. Also known as simply a “harmonic” or “overtone”, 
although when described as an overtone it has a different number, as the first overtone is the 
same as the second partial. See also harmonic series.

patch
An older term for a discrete sound on a MIDI device or virtual instrument. See also channel, 
MIDI, PC.

pause (holds)
A notation that shows where the established rhythmic flow of the music is interrupted, either 
with a moment of repose or a short silence, before continuing. Also known as a “hold”, “fermata”, 
“breath mark”, and “caesura”. See also fermata.

pause (rest)
A marking with a rhythmic value that indicates no note is played for that duration. In this 
documentation, we refer to this as a “rest”. See also rest.

PC
Short for “program change” or “patch change”, it is a MIDI message that allows you to access 
different sounds by switching to the corresponding programs. Because programs can also 
include effects presets, they allow you to change to specific sounds quickly, which is particularly 
useful in live performances. You can specify the programs that each PC switches to in each sound 
library using expression maps. See also MIDI, CC, patch.

pedal level change
A change to how far a piano sustain pedal is depressed, between 1 (fully depressed) and 0 (not 
depressed). It is notated as a change to the height of a pedal line. Also known as a “pedal lift”.

pick-up bar
A note or notes played before the first full bar of a piece. Also known as an “upbeat” or 
“anacrusis”. Pick-up bars often only comprise one or two beats whose main purpose is to lead in 
to the start of the piece.

pitch crossing
A possible situation on staves containing multiple voices or parts, such as condensed staves, 
where notes in down-stem voices have higher pitches than notes in up-stem voices. See also 
condensing.

pitch delta
The number of octave divisions by which accidentals raise or lower the pitch of notes. For 
example, in 12-EDO, a pitch delta of 1 raises notes by a half-step (semitone) and is commonly 
notated using the sharp accidental (♯). See also EDO.

player
A musician who plays one or more instruments. Players are defined as either single players or 
section players and are assigned to flows and layouts. See also single player, section player, flow, 
layout.

player group
A collection of players that comprises either a subset of the main ensemble, such as a choir 
within an orchestra, or a separate group, such as an off-stage brass group or second orchestra. 
Each group of players is labeled separately in the full score and is grouped and numbered 
together in the instrument order. See also player.

playhead
A vertical line that moves alongside music during playback and when recording, showing the 
current rhythmic position. Also known as a “playback line”.
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Play mode
A mode in Dorico where you can change how your music sounds in playback, including by 
changing the playback template and assigning VST instruments, inputting automation, adjusting 
the mix, and changing the sounding duration of notes in playback without affecting their notated 
duration. See also modes.

playthrough
A single time playing from the beginning of the piece to the end. Music that contains multiple 
possible endings, such as music with repeat endings or codas, requires multiple playthroughs.

plug-in
A software program that can operate within another software program. Dorico SE supports VST 
instruments and effects and script plug-ins written in Lua.

point (Key Editor)
A change in value in the Key Editor. Points appear as squares that you can select and edit, such 
as by dragging them. Points can be constant or linear. See also constant point, linear point, value 
line.

point (size)
A unit of measurement in typography that describes the size of fonts.

pointer
See mouse pointer.

polymeter
Music containing multiple simultaneous meters; for example, one instrument in the ensemble 
plays in 6/8 and another plays in 7/4.

popover
A temporary value field that is evoked using a key command and allows you to input items using 
text entries. You can open popovers in Write mode during note input or when items are selected 
in the music area. There are dedicated popovers for different types of items.

preamble
The notations typically drawn before the first note or rest on each system of music. The preamble 
usually includes clefs, key signatures, and time signatures. In Dorico SE, the preamble is drawn 
automatically, so you cannot select any items included in it.

Print mode
A mode in Dorico that allows you to print and export the layouts in your project. See also modes.

print preview area
The main part of the window in Print mode where you can see a preview of what is going to be 
printed or exported as a graphic. See also Print mode.

project
A Dorico SE file that can contain multiple flows and layouts. See also flow and layout.

properties
The characteristics of individual items and fragments of items in your project that can be edited 
via the Properties panel. There are two types of properties: local and global. Local properties are 
layout- and frame chain-specific, meaning that by default, changing local properties for an item 
in one layout does not affect the same item in other layouts or other frame chains.

Q
quantization
In music, the act of adjusting the positions and durations of notes so they align with the nearest 
defined beat. This process eliminates small variations in rhythm and duration produced naturally 
by live performers, and can be useful when importing/exporting MIDI data as quantized music 
produces neater notation.
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R
rastral size
The size of a full five-line staff, measured from the bottom line to the top line. The term comes 
from the rastra engravers historically used to draw five-line staves on blank paper. Because the 
rastrum is a fixed object, people became used to their set sizes and Dorico SE continues this 
tradition by offering users a selection of rastral staff sizes.

reducing
The process of taking music for more than one instrument and assigning it to fewer instruments, 
such as a keyboard reduction of a choral piece. A piece of music that has been reduced is known 
as a “reduction”. See also exploding, condensing, divisi.

rest
A marking with a rhythmic value that indicates no note is played for that duration. Also known 
as a “silence” or “pause”, but in this documentation, we refer to them as “rests”. See also implicit 
rest, explicit rest, padding rest, multi-bar rest, pause (holds).

rhythmic grid
A unit of rhythmic duration whose value affects certain aspects of inputting and editing, such as 
the amount by which items move. Its current value is shown by the note value in the status bar, 
and by ruler markings indicating beat divisions and subdivisions above the staff on which the 
caret is active. See also caret.

S
score
See full score, part, layout, project.

section player
Multiple musicians who all play the same instrument and read from the same part layout; for 
example, Violin I. Section players may not play multiple different instruments, but can divide. See 
also player, single player.

segment
Part of a notation item that functions autonomously in Engrave mode. Segments can exist 
regardless of their position, such as individual ending brackets within a repeat ending, or only 
when a single item is split across a system or frame break, such as glissando lines. See also item, 
fragment.

Setup mode
A mode in Dorico where you can set up the fundamental elements of the project: instruments 
and the players that hold them, flows, layouts, and videos. You can also determine how they 
interact with each other; for example, by changing the players assigned to layouts. See also 
modes.

single player
An individual musician who can play one or more instruments; for example, a flute doubling 
piccolo. See also player, section player.

SMuFL
Short for “Standard Music Font Layout”, it is a font specification that maps all the different 
symbols required for music notation onto a standard layout. Dorico SE requires SMuFL-compliant 
fonts for certain areas of the program, such as clefs and dynamic glyphs, to ensure it can locate 
the correct symbol. SMuFL-compliant fonts include Bravura, Petaluma, and November 2.0.

space
A unit of measurement in music engraving based on the distance between the center of two 
adjacent staff lines. Practically all notation items are scaled in proportion to the size of a space; 
for example, a notehead is normally one space tall.
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spacing
The act of determining the horizontal distance between successive columns in order to format 
the music. Horizontal spacing in Dorico SE considers the graphical shape and size of notes and 
other items, such as rhythm dots and accidentals, and the note spacing values set. Full systems 
are automatically horizontally justified.

spelling
The way in which a note of a given pitch is specified by a letter name plus an accidental. For 
example, assuming the conventional 12-EDO pitch system, MIDI note 61 can be spelled as C♯, D♭, 
and B. The same pitch is normally spelled a certain way in a given key; for example, MIDI note 61 
is normally spelled as C♯ in D major, but is spelled as D♭ in A♭ major. See also EDO, MIDI.

split stem
A way of presenting altered unisons that keeps each accidental directly beside the notehead to 
which it applies. Also known as a “cherry stalk” or “tree”.

staff-relative placement
The vertical position of items relative to musical staves; that is, either above or below.

string shift indicator
An angled line that indicates the direction of movement when string players have to shift 
position on the fingerboard to play a higher/lower note with the same finger as the previous 
note.

stroke
The short line that bisects editorial slurs and ties. Also known as a “notch”.

SVG
SVG stands for Scalable Vector Graphics, which is an XML-based way of displaying and modifying 
graphics. Due to the way it is coded, it allows you to modify graphics very flexibly compared to 
other formats.

system
A horizontal span of music that is played together. Most printed music displays systems 
spanning the full width of pages. A system can contain any number of staves. For example, 
in orchestral full scores, systems typically contain staves for all instruments in the orchestra, 
meaning a single system often occupies the full height of the page. In part layouts, each system 
only contains the staves required for that player, which is often a single staff and means multiple 
systems can fit on each page. See also system break, page break, casting off.

system break
The forced termination of a system of music at a particular rhythmic position, typically at a 
barline. Indicated in Dorico SE with signposts. See also page break.

system formatting
The distribution of bars into systems and systems into frames. When copying part formatting 
between layouts, Dorico SE considers the positions of system breaks, frame breaks, and note 
spacing changes to be aspects of system formatting.

system object
An item that applies to all staves in the system, but is not necessary to show on every staff, such 
as tempo marks and rehearsal marks. In Dorico SE, you can show system objects at multiple 
positions in each system by showing them above multiple instrument families.

T
tempo track
The timing-related information included in MIDI data that affects tempo, SMPTE offsets, time 
signatures, timecodes, and markers, which can be imported independently of the rest of the data 
in MIDI files.
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token
A code used in a text string that is automatically replaced by a piece of information from 
elsewhere in the project, such as the title of the current flow, the name of the player, or the 
page number. Also known as a “wildcard” or “text code”.

touchpad
Any flat device with a tactile sensor that functions as an alternative to the traditional computer 
mouse. Commonly built into laptop computers but can also be separate appliances connected 
wirelessly or via a cable.

transport
Encompasses all options related to playback and recording.

transposed pitch
In transposed pitch, the pitches notated are the pitches that the instrument plays, rather than 
the desired sounding pitch. Instrumental parts are always in transposed pitch so that players can 
simply play the written notes, which is especially important for transposing instruments. See also 
concert pitch, instrument transposition.

tuplet
A rhythm that is performed at a fraction of its normal written duration. For example, a triplet is 
three notes of a given note value played in the time it would normally take to play two notes of 
that note value. Also known as an “irrational rhythm” or a “countermetric rhythm”.

tutti
Italian for “everyone”, tutti indicates that a passage of music is to be played by all players reading 
from that part or staff. It is most commonly used to indicate the end of a divisi passage, or for 
clarification when a staff can indicate both solos and tutti passages at different times. See also 
divisi.

U
upbeat
See pick-up bar.

V
value line
A visual representation of value over time. In Dorico SE, you typically find value lines in the Key 
Editor. Fully horizontal value lines indicate a constant value, while angled value lines indicate a 
smooth change in value within a given duration, usually between two points. See also point (Key 
Editor), constant point, linear point.

vertical justification
The spreading out of staves and systems across the full height of frames with as even a 
distribution of space as possible. If the music in the frame requires less vertical space than 
is available, the remaining space is distributed evenly between the systems, and between the 
staves of the systems. See also frame, justification.

vibrato bar
A device on electric fretted instruments, typically guitars, that allows the performer to add 
vibrato to notes and to adjust the pitch of notes, similar to a guitar bend. Also known as a 
“whammy bar”, “tremolo bar”, “tremolo arm”, or “vibrato arm”.

voice
In Dorico SE, a series of notes, chords, rests, and other notations that make up a single musical 
line and are normally played by the same instrument. Assigning notes and items to different 
voices allows multiple lines of music to be presented on the same staff as clearly as possible, 
such as in vocal music where the soprano line uses an up-stem voice and the alto line uses a 
down-stem voice. Dorico SE allows as many voices as are needed to be input onto a single staff, 
and lays them out and spaces them automatically. See also instrument.

Glossary
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VST instrument
Short for “Virtual Studio Technology instrument”, it is a digital plug-in that converts MIDI data 
into audio output. It can emulate an existing piece of studio hardware or can be an entirely new 
creation.

W
Write mode
A mode in Dorico where you can input and edit your music, including changing the rhythmic 
positions of items, changing the pitch of notes, and deleting notes and items. See also modes.

Glossary
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Index

A
abbreviated

dates 556
dynamics 746, 756
instrument names 158, 161, 1032
staff labels 136, 1030, 1032
tempo text 1057

absolute channel change actions 638
absolute tempo changes 1053

components 1054
Academico font 624
accelerando. See gradual tempo changes. See also 
tempo marks
accents. See articulations
acciaccaturas. See grace notes
accidental duration rules 660

common practice 660
accidental spelling 220

changing 428, 429, 431
resetting 431

accidentals 655
altered unisons. See altered unisons
appearance 656
arrows 820
brackets 656, 862
cancellation 660
cautionary 660
changing 219
chord symbols 128, 133, 135, 293, 719–721
chords 657
collision avoidance 657
deleting 655
duration rules. See accidental duration rules
enharmonic equivalents 428, 429, 431
figured bass 366
glissando lines 889
Gould arrows 820
guitar pre-bends 902
harmonics 862
harp pedaling. See harp pedaling
hiding 655, 656, 862, 874
inputting 204, 219
intervals 233, 312, 875
kerning 658
key signatures 655, 815, 816, 819
layout names 160
lines 955
microtonal 659
MIDI input 220
none 253, 656, 817, 862
octave divisions 820
ornaments 867, 879
panel 177, 257
parentheses 656, 862
part names 160

accidentals (continued)
piano roll editor 575, 577
pitch before duration 204
quarter tones 659, 820
respelling 428, 429, 431
restating 660
showing 655, 656, 862, 874
signposts 407
spacing 658
stacking order 657
Stein-Zimmermann 820
text 355, 358, 554
ties across breaks 656, 1080
titles 554
tokens 554
transposing 425, 819
trills 873–875, 878, 879

accolades. See braces
actions 631, 638
activating 58, 195

caret 195
channel effects 616, 620
chord input 173, 226
dotted notes 173
EQ 616
force duration 173
grace note input 173
independent voice playback 460
Insert mode 173, 212
inserts 620
lock to duration 173
mouse input 173, 205
note input 195, 197, 200
pitch before duration 173
playback 28, 457, 471, 476
player sorting 110
plug-ins 459
rest input 173
scissors 173
system track 392
tuplet input 173
VST instruments 459

adagio. See tempo marks
add intervals popover. See note tools popover
Add Marker dialog 369
add-on switches 629, 637
added notes

chord symbols 295
adding. See inputting
additional

endings 377, 379, 975
voices 207, 1134

additive time signatures. See time signatures
advanced options

hiding 40
showing 40
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advancing
caret 196
chord symbols popover 298
figured bass popover 367
hairpins 396
lyrics popover 362
slurs 396

aeolian
chord symbols 296, 720

aggregate time signatures 258, 1085
dashed barlines 258, 1085
inputting 258, 260, 262, 263

aikin noteheads 844, 845
air sounds. See playing techniques. See also diamond 
noteheads
aliases

jump bar 62, 63
alignment

arpeggio signs 886
bar numbers 681, 682
barlines 675
bars 522, 675, 1046
chord symbols 714, 717
counts 983
dynamics 748, 749, 765–768
fermatas 812–814
gradual dynamics 749
instrument names 161
lines 949, 955
lyrics 827, 828
measures 522, 1046
notes 1136, 1137. See also voice column index
octave line numerals 743
ornaments 868
pedal lines 927
playing techniques 939, 944
repeat counts 983
repeat endings 977
rests 1008
rhythm dots 1137
staff labels 161, 1031
staves 513, 522, 530, 1031, 1046
systems 513, 522, 530, 1031, 1046
tempo marks 1056
text 357, 1070
time signatures 1095
trills 869
voices 1136, 1137. See also voice column index

allegretto. See tempo marks
allowing. See activating. See also enabling
alpha channel 496, 506
alterations

chord symbols 295, 714
jazz ornaments 315

altered bass notes 295, 714, 721
arrangement 722
inputting 291, 295
separator 722

altered unisons 658
appearance 659
formatting 659
split stems 658

alternating time signatures. See time signatures

alto clef. See clefs
amp modeling 616, 620
AmpSimulator 616, 620
anacrusis. See pick-up bars
angles

beams 694, 695, 704
borders 1072
fanned beams 704
fingering slides 792
glissando lines 889
jazz articulations 913
lines 353, 946, 952
pedal lines 926, 927
slurs 1019
string shift indicators 795
tremolos 1100
tuplet brackets 1109

annotations 191, 432, 507, 948
comments 432
highlights 718, 719, 985, 987, 997, 998
lines 948
note/rest colors 51, 52, 463, 847, 1011, 1135
ornaments. See ornaments
signposts 407
voice colors 51, 1135

aperture
hairpins 757, 761, 762
messa di voce 761, 762

apostrophes 555
appearance

default settings 622
items 560
resetting 401

appending
flows 74
subito 756

applying. See assigning. See also activating
appoggiaturas. See grace notes
Arabic numerals

page numbers 915
arco. See playing techniques
areas

editing 35, 136, 1126
graphs 607
music 32
print preview 34
project start 32
selecting 389, 390, 392, 393, 572, 609
tools 35, 560

arhythmic notes. See grace notes
arms

vibrato. See vibrato bar
arpeggio signs 883, 886, 946

alignment 886
appearance 883–885
beat-relative playback 887
brackets 883
changing 398
cross-staff 318, 319
curved 313
deleting 412
direction 883
duration 887
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arpeggio signs (continued)
ends 885
filter 393
fingerings 792
formatting 884, 885
grace notes 886
handles 886
inputting 310, 313, 318, 319
length 318, 319, 886
moving 417, 421
muting in playback 463
panel 315, 319
playback 887
popover 313, 318
position 886
spacing 886
swash 883
ties 223
types 313, 884
voices 318, 319

arrangements
accidentals in key signatures 816
chord symbols 722
flows 148
movements 148
pages 39, 47

arranger 70
adding 70
tokens 555

arranging 412, 414
changing instruments 122
condensing. See condensing
copying 414–416
filters 393, 394
pasting 416
reducing 543. See also condensing
tools 412
transposing. See transposing
voices 421–423

arrows 946
accidentals 820
arpeggio signs 883
caps 957
disclosure 40
lines 948
noteheads 843, 845
panels 36, 41, 93
zones 36, 41, 93

articulations 661, 937
changing 246
collision avoidance 664
deleting 662
duration 661, 665
inputting 183, 204, 246, 247
inverting 664
jazz. See jazz articulations
key commands 247
kits 1124
moving 664, 665
notes 663
order 663
overlapping 664
panel 177

articulations (continued)
percussion 648, 1115, 1116, 1124
pitch before duration 204
placement 663–665
playback 460, 461, 626, 648–650, 665
playing technique-specific noteheads 648
position 662–664
slurs 663, 665, 1019
stems 663
ties 664, 665, 1074
tremolos 648
tuplets 246
types 661

artificial harmonics 859
accidentals 862
changing 866
hiding 860
partials 861
pitch 861
playback 859–861
showing 860
styles 863, 866

assigning 58
expression maps to endpoints 485
flows to layouts 105, 154
instruments to endpoints 484
key commands 58
MIDI commands 58
notehead designs 845
notes to strings 846
page templates 511
percussion maps to endpoints 485
players to flows 105, 149
players to layouts 105, 153
voices to endpoints 484

atonal key signatures 817
note spelling 425

attachment lines 22, 417
caesuras 310
dynamics 761
hiding 402
playing techniques 939, 941, 943
text 1066

attachment points
items 417
lines 353, 354, 946, 949

attack
articulations 661, 1075
dynamics 286, 746
playback 625
tremolos 374, 381, 383, 1101

attribute playback techniques 650
audio

buffer size 244, 245
device setup 53
dialog 87
exporting 86, 87
mixer 612, 613
outputs in mixer 479
panning 619
playback 471, 476
repeats 463
videos 170
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audio (continued)
volume 170, 612, 613, 618
warning 36

auditioning
chords 395
MIDI devices 240
notes 240, 394, 395

augmented 233
accidentals 660
chord symbols 294, 714
intervals 233, 312, 425, 660, 875, 876
trills 312, 875, 876

author name 432
changing 437

auto-save 89, 90
date and time 90
deleting projects 89
disabling 91
interval 91
recovering projects 90

automation lanes. See MIDI CC editor. See also Key 
Editor
AutoPan 616, 620
auxiliary notes 878

notehead design 845
position 879
showing 878

B
backgrounds 49

colors 50
erasing 797
gradients 50
pages 50

backups 91
auto-save. See auto-save
location 92
number 91

backwards 402
moving bars 537, 539
navigation 298, 362, 367, 403

balalaika. See fretted instruments
balance

mix. See mixer
bands 73

adding 66, 98
EQ 616
player order 94, 110
staff grouping 709
templates 66, 73

banjo. See fretted instruments
bar counts

multi-bar rests 679
bar graphs 607
bar numbers 677

alignment 682
alternative 688
appearance 677
barlines 681
brackets 688
changing 685, 686
clefs 682

bar numbers (continued)
colors 52
comments 432, 434, 435
counts 993
default settings 677
deleting 686
enclosures 678
erased backgrounds 678
font 680
frequency 677
galley view 38
gaps 682
guide 680
hiding 677, 680, 684, 686
layout options 677
moving 681, 682
multi-bar rests 679
multiple positions 681
paragraph styles 680
parentheses 688
pick-up bars 1088
position 681, 682, 996
ranges 679, 992. See also numbered bar regions
rehearsal marks 965
repeat sections 688
returning to primary sequence 687
sequence changes 684
showing 677, 680, 686
signposts 407
staff-relative placement 681, 996
subordinate 686
subsequent repeats 688
system-relative placement 683
time signatures 684
total. See counts

bar repeats 985, 1099
bar numbers 679
brackets 987, 989
casting off 535
changing 398, 986
changing number 988
colors 52
consolidating 1015
counts 987–989
deleting 412
dynamics 986
erased backgrounds 985
filter 393
font style 987
frame breaks 539
frequency 988
grouping 990
handles 396
highlights 985, 987
inputting 375, 376, 385
length 396
moving 417, 421
multi-bar rests 1015
panel 376
parentheses 987, 989
phrase length 398, 986
playback 398, 986
popover 375
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bar repeats (continued)
regions 985
symbols 990
system breaks 537
types 375
viewing options 987

bar rests 1014
counts 1015
cues 745
deleting 1010, 1012
hiding 1010, 1012, 1014
inputting 222, 276
moving 1012
multi-bar rests 1015
showing 1014
slashes 1010
voices 1010

barbershop quartet. See project templates
barline joins 675, 676, 709

default 676
barline-attached lines. See lines
barlines 672

across staves 675, 676
alignment 675
bar numbers 681
caesuras 310
changing 281, 282, 672, 674
chord symbols 717
copying 149
counts. See repeat counts
custom joins. See barline joins
dashed 672, 674
deleting 412, 676
double 672, 674
dynamics 749, 750
end barlines 674
fermatas 814
final. See final barlines
frame breaks 536
grace notes 806
grand staff instruments 675, 676
hiding 258, 674, 1085
inputting 275, 277, 278, 281, 282, 670
joins. See barline joins
key signatures 674, 818
length 675, 676
moving 412
multi-bar rests 281
none 258, 674, 1085
open meter 1085
panel 278, 282
popover 276, 277, 281
rehearsal marks 963
repeat. See repeat barlines
scale size 672
short 672, 674
signposts 281, 282, 407, 412
single 672, 674
staff grouping 675, 676, 709
system breaks 536, 674
thickness 672, 674
tick 672, 674
time signatures 676, 1095

barlines (continued)
triple 277
tuplets 1107
types 277, 672
vocal staves 675, 676

Baroque
appoggiaturas 803, 808
figured bass. See figured bass
ornaments 315, 867
trills 880, 881

barré 937
adding 735
chord diagrams 728, 736
hiding 939
inputting 337, 341, 343

bars 13, 667
alignment 522, 675, 1046
bar rests. See bar rests
beam grouping 22, 705
chord symbols 718
combining 412
deleting 276, 409, 667–669
deleting contents 669
display 468, 471
divisions 670
duration 667
expanding 278, 280, 409, 410
fixing number 535, 536
frame breaks 536, 539
gaps 1046
glissando lines 890
going to 405
graphs 607
grouping. See bar repeats. See also multi-bar rests
half-bar 705
height 512, 513, 530
inputting 275, 276, 278–280, 408
Insert mode 408
length 409, 667
moving 536, 537, 539
multi-bar rests 1014, 1015
navigation 405
note grouping 22, 705
numbers 677
panel 278, 279
pick-up bars 1088
playback 457, 468
popover 276, 278
red 410, 411
repeat 975, 979, 985
rests. See bar rests
rhythm slashes 997
selecting 387, 389, 392
size 408, 409, 512, 513, 522, 530, 533, 667, 1046
spacing 533, 1012
splitting 536, 537, 539, 670
system breaks 536, 537
timecodes 973
tuplets 1107
upbeats. See pick-up bars
vibrato. See vibrato bar. See also guitar
width 522, 533, 1012, 1046

Bars and Barlines panel 278, 279, 282
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Bartók pizzicato. See playing techniques
base switches 629, 637
baseline

instrument names 161
lyrics 833
staff labels 161
text 357

bass clef. See clefs
bass drum. See unpitched percussion
bass guitar. See fretted instruments
bass notes

altered 291, 295
figured bass. See figured bass

bassoon. See instruments
beam corners 701
beam groups 21, 689, 705

creating 690
defining 705
pick-up bars 1088
resetting 692
selecting 387
stem directions 856
time signatures 689

beam lines
direction 702
number 702

beam slants 694
changing 695
grace notes 808

beaming 689, 690, 704
angles 694, 695, 704
centered beams 695, 696
corners 701
cross-staff. See cross-staff beams
direction 693–695, 702
fanned 704
grace notes 808
grouping 689, 690, 705. See also beat groups
half-bar 705
inverting 693
large pitch ranges 808
lyrics 691
meter 705
multiple staves. See cross-staff beams
notes 690
optical cross-staff spacing 699
partial 702
placement 693, 697, 701
primary beams 701
resetting 692, 694, 697, 701
rests 690, 704
secondary beams 701, 702
slants 694, 695, 808
slashes 1002
spacing 699
splitting 692, 705
staff-relative placement 693
stem direction 693, 696, 697, 699
stemlets. See stemlets
tablature 1049
ties 223
time signatures 689, 705
tuplets 703, 705, 1108

beaming (continued)
unbeaming 691
vocal staves 691

beat groups 21, 689, 705
defining 705
numerators 1091
specifying 258
ties 1074
time signatures 1091, 1092

beat units 1058
deleting beats 276
inputting beats 276
metronome marks 398, 1059
setting 271
tempo marks 269
tuplets 232

beats
deleting 276, 409, 667–669
display 468, 471
inputting 276, 278, 280, 408, 409
Insert mode 408, 409
per minute 1058
pick-up. See pick-up bars
popover 276
recording latency 244
relative position 401
selecting 393

bend intervals 900
microtonal 900

bends
guitar. See guitar bends. See also dives
jazz. See jazz articulations. See also jazz ornaments
vibrato. See vibrato bar

big band. See bands. See also jazz
bindings. See ties. See also laissez vibrer ties
birds eyes. See fermatas
bit depths 86, 87
black and white 506
black noteheads 840, 841
blank staves

adding 108, 113, 120
after flows 517
hiding 515, 517
showing 515, 517

blog 64
blue selections 767, 1027
Blues guitar post-bends 897
body

changing 956
lines 946, 948, 956

bold text 357, 1066
bomb

dive. See dives
bongos. See unpitched percussion
booklets 501

duplex printing 502
printing 500, 501

borders 507, 1071
bar numbers 678
exporting 495
harp pedaling 921
printing 491
shape 678, 1072
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borders (continued)
style 1072
tacets 541
text 1071, 1072

bottom zone. See lower zone
bowing. See playing techniques. See also slurs
boxes. See borders. See also frames
bpm 1058

changing 603, 1059
braces 707

hiding 711
secondary brackets 710, 712
showing 711
signposts 407
staff spacing 513, 530

bracketed noteheads 849, 850, 908
changing type 850
chords 849, 850, 853
ghost notes 850
guitar bends 894, 896
hiding 850
inputting 850
percussion 850
playback 850
showing 850
splitting 853
tablature 849, 850, 894, 899
tie chains 851
ties on tablature 851, 1074
trills 878
vibrato bar dives and returns 899

brackets 707
accidentals 656, 862
arpeggio signs 883
bar numbers 688
bar repeats 987, 989, 993, 994
barlines 675, 676
chord symbols. See parenthesized chord symbols
counts 989, 994, 1004
divisi 708, 709, 711, 712, 946, 1047
dynamics 751
ensemble types 73, 709
figured bass 364, 774, 777
fingerings 249, 251, 788, 790
grouping 144, 708, 709, 1036
guitar bends 894, 896
harmonics 863
hiding 708, 711
hold lines 777
horizontal. See lines
instrument transpositions 1034
layouts 708
metronome marks 1054, 1055
noteheads. See bracketed noteheads
numbered bar regions 993, 994
pedal lines 933, 934
player groups 144, 675, 1036
project templates 73
secondary 710, 712
showing 708, 711
signposts 407
size 725
slash regions 1004

brackets (continued)
staff labels 1034
staff spacing 513, 530
staves 708, 709, 1036
sub-brackets 710, 712
sub-sub-brackets 712
tablature 863, 894, 896, 899
templates 73
tempo marks 1054, 1055
thickness 725
time signatures 258, 1089, 1091, 1094
tuplets 1109
vibrato bar dives and returns 899

brass band. See bands. See also project templates
brass instruments 114

adding 96, 98, 108, 113, 120
brackets 709, 1036
chord symbols 714
fingerings 783, 794
groups 144
horn branch indicators 794
player order 94, 110
playing techniques 340
project templates 73
system objects 1045
transposition 96, 119

Bravura music font 624
breaking

multi-bar rests 1014
notes 238
tie chains 238, 1083

breaks
frame 539
page 539
system 537

breath marks 809, 811
appearance 398
colors 52
deleting 412
inputting 307–309
moving 417, 421
multiple at same position 813
placement 812
position 812
types 398, 811

breves. See double whole notes
Brickwall Limiter 616, 620
Britten fermata. See fermatas
Broadcast WAVE format 87
broken beams 702
buffer

audio 244, 245
building ensembles 98, 114
bypassing 616, 620. See also muting

C
C clef. See clefs
cadenzas 258, 278, 280, 409, 410, 667, 1085

system dividers 1043
caesuras 809, 811

appearance 398
colors 52
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caesuras (continued)
deleting 412
gaps 812
inputting 307–310
moving 417
multiple at same position 813
placement 812
position 310, 812
types 398, 811

calando. See gradual tempo changes. See also tempo 
marks
calculating

harp pedaling 349
cancellation

accidentals 660
double accidentals 660

candidate menus
playing techniques popover 337
tempo popover 268

cantabile. See dynamic modifiers
Capo Chord Symbol Definition dialog 133
Capo Definition dialog 130
capos 128

adding 129, 130
chord symbols 128, 132–134, 136
defining 129–133, 135
deleting 131, 133
hiding 133, 134, 136
italics 128
notation staves 131, 132
partial 129, 130
tablature 128–131

caps 940, 948
arrows 957
changing 957
continuation 948
lines 948

cards
disclosure arrows 40
flows 104
layouts 101
players 94
timecodes 104

caret 191
activating 173, 195
advancing 196
chords 191, 226
color 51
deactivating 173, 195
extending 195, 210
grace notes 191, 225
inputting vs. editing 187
Insert mode 191, 212
lock to duration 191
moving 190, 196, 1105
multiple staves 195, 210
percussion kits 213
rhythmic grid 190
slash voices 191
slashes 209
tablature 191
types 191
voice indicator 191, 207, 754

casting off 535
bars per system 535
copying to other layouts 544
flows 432, 519
locking 535, 536
note spacing 533
staff spacing 513, 529, 530
systems per frame 536

categories
ensembles 98, 101, 114
lines 353, 946
noteheads 841, 844
templates 66, 73, 709

cautionary accidentals 660
hiding 656, 862
parentheses 660
showing 656, 862
tie chains 656, 862, 1080
trills 873

cautionary clefs 738
cautionary fingering 788
cautionary key signatures 818
cautionary time signatures 1087
CC64

pedal lines 244, 245
cello. See instruments
centered beams 695

creating 696
removing 697

centered text
bar numbers 681
hairpins 756

centimeters
unit of measurement 48

chains
frames 559
ties 1074

change labels
instruments 117, 118

channel change actions 479, 485, 638
channels 612, 614, 615

bypassing inserts 620
changing 484
controls 614, 616
endpoints 479
expression maps 479, 485, 638. See also channel 
change actions
height 618
hiding 617
inserts 616, 620, 621
instruments 484, 614, 615
meter 614
MIDI 614, 615
mixer 612–616
muting 461
panning 619
percussion maps 479, 485
playback 479
plug-ins 479
reverb 621
scrolling 617
setup 479
showing 617
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channels (continued)
soloing 461
strips 616
volume 618

character styles
missing fonts 69

cherry stalks. See split stems
choir templates 66, 73

staff grouping 709
Choose Chord Diagram dialog 734
choral

lyrics 821
playing techniques 340
verse numbers 837

chord brackets. See bracketed noteheads. See also 
parenthesized chord symbols
chord diagrams 713, 727

barré 728, 736
changing 734
colors 734, 736
components 728
copying shapes 734
custom 735
dots 735, 736
editing 735
fingerings 728, 732, 733, 735, 736
formatting 735, 736
fret numbers 732, 733, 735, 736
gaps 731
grid 731, 732
hiding 728, 730, 731
inputting 728, 730
nut 728
omitted strings 728, 736
open strings 728, 736
resetting 733, 736
rows 731–733
shapes 734–736
showing 728, 730, 731
size 731
symbols. See chord symbols
thumb 732, 733, 736
tuning 124, 126, 731, 734

chord input 228
activating 173, 226
arpeggio signs 318
caret 191
exploding 210
multiple staves 210
register selection 200
tablature 217, 226

chord symbol components 714
inputting 293
popover 293
types 714

chord symbol regions 718
handles 396, 718
hiding 714, 716
highlights 719
inputting 297, 299
length 396
moving 417, 421

chord symbol regions (continued)
popover 297
showing 714, 716

chord symbols 226, 713
accidentals 128, 133, 135, 293, 719, 720
added notes 295
alignment 714, 717
altered bass notes 291
barlines 717
brackets. See parenthesized chord symbols
capos 128, 133, 134, 136
changing 398
colors 52
components. See chord symbol components
copying 390, 714, 716
deleting 412, 714
diagrams. See chord diagrams
enharmonic spelling 128, 133–136, 720, 721
figured bass 363, 364
filter 393
global 713
hiding 299, 714, 716, 718, 721, 730
highlights 719
inputting 291, 293, 298, 299, 714
instruments 291, 714, 716
intervals 295
inversions 291
italics 128
layouts 716
local 713
main 128
MIDI input 291
MIDI navigation 58
modal 296, 720
moving 417, 717
MusicXML import 726
navigation during input 298
no chord 296
note spacing 717
omissions 295
parentheses. See parenthesized chord symbols
pitch 155
placement 717
playback 442, 452–454
players 291, 714, 716
polychords 291, 296
popover 293
position 714, 717
quality 291, 721
regions. See chord symbol regions
roots 291, 294, 721
selecting 387, 390, 392, 393
showing 291, 299, 714, 716, 718, 721, 730
signposts 407, 713, 718
size 399, 725
slash regions 714, 718, 997
spacing 717
spelling 128, 133–136, 720, 721
staff-relative placement 717
staves 291, 714, 716
suspensions 295
systems 716
track. See chords track
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chord symbols (continued)
transposing 128, 131–136, 155, 424, 425, 713, 719
transposing instruments 128, 155, 720, 721
types 293, 714
viewing options 719
voicing 291, 454

chords 226
accidentals 657
arpeggio signs 886
auditioning 395
bracketed noteheads 849, 850, 853
brackets 723
building 232, 234
caret 191, 196, 226
collision avoidance 657
dense 658
exploding 210
figured bass 363, 364, 771, 780
fingerings 792
guitar bends 894, 897
inputting 173, 210, 226, 232, 234
lines 210, 318–320, 353, 354
parentheses 723
playback 452, 453, 457, 460, 463
post-bends 897
register selection 200
rolled. See arpeggio signs
selecting 387
stem directions 855. See also voices
tablature 200, 217
ties 223, 1078
track. See chords track
velocity 588. See also Velocity editor
vibrato bar dives and returns 899
voices 207, 1134

chords track 452
hiding 454
showing 454

Chorus 616, 620
chorus lyrics 821

changing lines to 836
changing lyrics to 822
popover 361

chromatic glissando 889
playback 892

circle
bar number enclosures 678
hairpins. See niente
harmonics 863, 865
noteheads 841, 845, 1116, 1119, 1120
playing techniques 340, 937
string indicators 797
tapping 905

clarinet. See instruments
clash cymbals. See unpitched percussion
Classical

ornaments 315
trills 880, 881

classical guitar. See fretted instruments
clefs 738

bar numbers 682
cautionary 738
colors 52

clefs (continued)
deleting 412
filter 393
gaps 738
grace notes 739
hiding 302, 303, 739
Indian drum 303, 1133
inputting 299, 300, 302, 303
instruments 96
key signatures 818
layouts 739
moving 417, 421, 739
octave indicators 301, 740, 741
panel 303
popover 300, 302
position 739
restorative 302, 303
showing 739
signposts 407, 739
ties 1080
tokens 554
transposing instruments 96
transposition 301, 739–741
types 300

Clefs panel 302, 303
click 468

count-in 241
disabling 457
enabling 457
MIDI recording 241
mixer 612, 613
playback 450, 457
sound 450
volume 618

clipping 618
closing. See opening
CMYK processing 506
coda 979

gap 982, 1046
hiding 981
indent 982, 1046
inputting 380, 381
mid-system gap 979, 982
multiple 980
sections 979
showing 981

codec 166
codes 552

time 971
col legno. See playing techniques
collision avoidance

accidentals 657, 658
articulations 664
bar numbers 682
clefs 682
dynamics 747, 749
flow headings 524
galley view 532
margins 524
slurs 1020, 1024
staves 513, 530, 532
ties 1074
titles 524
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colon
dynamics 284, 752
tuplets 1112

colored regions 449, 719, 987, 997, 998
Dynamics editor 590
exporting 507
hiding 402
MIDI CC editor 596
MIDI Pitch Bend editor 595
percussion editor 576
piano roll editor 575
Playing Techniques editor 586
printing 507
Tempo editor 601, 602
tempo track 450
Transform tool 608

colors 49
background 50, 52
bar numbers 52
bar repeats 52, 987
breath marks 52
caesuras 52
caret 51
chord diagrams 734, 736
chord symbols 52, 719
clefs 52
comments 52
dark theme 49
dynamics 52
exporting 496
fermatas 52
graphics 496, 506
holds 52
instrument names 161
instruments 449, 575, 576
inverting 52
light theme 49
lines 52
lyrics 52
markers 52
monochrome 506
muted 463
note ranges 51, 847
noteheads 52, 844
notes 51, 52, 463, 1135
ornaments 52
pages 50, 52
pedal lines 52
piano roll editor 575, 576
Play mode 449
playhead 51
playing techniques 52
rehearsal marks 52
resetting 50–52
rests 52, 1011
rhythmic grid 51
slash regions 997, 998
slurs 52
staff labels 161
tablature 51, 52, 847, 1048, 1050
tempo marks 52
text 52, 357
tracks 449, 575, 576

colors (continued)
trills 52
tuplets 52
voices 51, 449, 575, 576, 1134, 1135
windows 49

columns
accidentals 657
figured bass 771
lines 950
markers 370
missing fonts 69
videos 370
voices 1136, 1137

combinations
part layouts 153
playback techniques 636, 640, 648
tremolos 648

combined dynamics. See dynamics
combining. See consolidation
comma

breath marks. See breath marks
commands

jump bar 60, 62
key commands 54, 58
MIDI 54, 58

Comment dialog 433
comments 407, 432, 849

adding 435, 436
authors 432, 437
bar numbers 434, 435
changing 437
colors 52
deleting 412, 434
dialog 433
exporting 434, 437, 495, 507
hiding 438
initials 432, 437
instruments 434
list 434
panel 434
printing 437, 491, 507
replying 436
showing 438

common practice
accidental duration rule 660

common time. See time signatures
components

articulations 662
chord diagrams 728
chord symbols 293, 714
lines 948
tempo marks 1054

composer 64, 70
adding 70
first pages 549, 801
flow headings 550
tokens 555

compound figured bass intervals 363, 364, 780
compound time signatures 1085

inputting 258, 260, 262, 263
note grouping 705

compressed MusicXML 79
Compressor 616, 620
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con sordino. See playing techniques
concert band. See bands. See also project templates
concert pitch 155

clefs 301, 739, 740
exporting 495
input pitch 203
instrument transpositions 1033
layouts 151, 155, 491, 495, 553, 801
printing 491
staff labels 1029, 1033
status display 36
tokens 553, 801
viewing 155

concertos
cadenzas 409, 410, 1085
movements. See flows
soloists 111

condensing 513, 515, 543, 1047
divisi 1038
extra staves 1041
fonts 1038
ossia staves 1042
paragraph styles 1038
percussion. See percussion kits
signposts 407
staff labels 1038

conditions
expression maps 632, 640

conductor score. See condensing. See also layouts
configurations

accidentals 660, 816
endpoints 479, 481–483
Key Editor 572, 609, 610
key signatures 816
playback 53, 471

connecting. See linking
consolidation 543

bar repeats 1015
bars 412
flows 74
notes 228, 422
part layouts 153
players 145, 153, 543
rests 1010, 1014, 1015
staff labels 140, 141, 1037, 1038
staves. See condensing
stems 136, 1131, 1132, 1134
voices 136, 422, 543, 1131, 1132, 1134, 1136, 1137

constant points 598, 601
inputting 591, 597, 602

contents
bars 669
front matter 801
lines 948
table 801
tempo marks 1054, 1056, 1058, 1061

continuation caps 948
continuation lines 940, 946

duration 941
dynamics 746, 750, 757, 758
figured bass 774
hiding 1063
inputting 337, 341, 343

continuation lines (continued)
pedal lines 925, 930, 933, 935, 936
playing techniques 940, 942–944
slurs across breaks 1019
tempo marks 1062, 1063

continuation signs 934
lines 948
parentheses 933
text 935

continuous
bar counts 988, 994
beams across staves 697
controller 638
rehearsal marks 964
view 38, 47, 564, 575, 576

contrabass. See instruments
contracting. See expanding
contrapuntal. See counterpoint
control change actions 631, 638
controllers

expression maps 625
MIDI. See MIDI controllers

conventions
accidentals 655, 660, 816, 820
arpeggio signs 886
breath marks 812
caesuras 812
cues 745
dynamics 747
ensembles 73
fermatas 812
fingerings 783
grace notes 804
harp pedaling 922
key signatures 816, 818
lyrics 827
ornaments 868
pauses 811
pedal lines 927
playing techniques 939
rehearsal marks 963
rests 1008
tempo marks 1056
tremolos 1100
trills 868
voices 1136

converting
grace notes into normal notes 806
layouts to graphics files 495
notes into grace notes 805
notes into tuplets 1106
PDF 495
tuplets into normal notes 1106

copies
printing multiple 491

copying 412, 414–416
barlines 149
beams 701
chord diagram shapes 734
Chord mode 228
chord symbols 390, 714, 716
dynamics 414, 417, 573, 594, 767
flows 74, 149
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copying (continued)
frames 547, 549
Insert mode 408
instruments 109
lyrics 824
MIDI 417, 573, 600
notes 414–416, 582, 701
page formatting 545
page templates 547, 549
part formatting 544
players 109
playing techniques 942
points 573
properties 547
slurs 417
system objects 390, 1045
tempo marks 414, 573
tremolos 701

copyright 70
adding 70
first pages 549
tokens 555

cor anglais. See instruments
corners

beaming 701
crop marks 507

count-in
duration 241
metronome click 241

counterpart layout 40
counterpoint 222

bar rests 222
MIDI recording 240, 241
voices 207, 1134

counts 987
bar numbers 679, 688, 1088
bar repeats 987–989
barlines 983
bars 386, 987, 992–994, 1003
frames 971
hiding 983, 989, 994, 1004
lyrics 832
moving 983, 996, 1005
multi-bar rests 1015
numbered bar regions 386, 993, 994
page numbers 556
pick-up bars 1088
placement 996, 1005
ranges 679, 993, 994
repeats 464, 688, 975, 983
rhythm slashes 1003, 1004
staff-relative placement 996, 1005
timecodes 971

cowbell. See unpitched percussion. See also playing 
technique-specific noteheads
crash cymbals. See unpitched percussion
creating. See inputting
crescendo. See gradual dynamics
crop marks 507

exporting 495
printing 491

cross noteheads 842, 845
dead notes 908
percussion 1116, 1119, 1120

cross stick. See unpitched percussion. See also playing 
technique-specific noteheads
cross-staff

arpeggio signs 318, 319
beams 697, 699, 701
lines 353, 354
resetting 701
slurs 248, 396, 417, 421, 1024
spacing 699
stems 697, 701
ties 223, 1081
tremolos 697, 701

cross-voice
arpeggio signs 318, 319
lines 353, 354
slurs 248, 396, 417, 421, 1024
ties 223, 1081

crotchets. See quarter notes
crushed notes. See grace notes
Cubase

expression maps 625, 642
instrument names 1030
staff labels 1030

cue labels
staff-relative placement 400

cues 745
deleting 412
moving 421
signposts 407
spacing 533
staves 528

cup mute. See playing techniques
curlew fermata. See fermatas
curly quotes 555
cursor

caret 191
chord symbols 298
figured bass 367
fingerings 249
lyrics 362, 831
text 552

curvature direction
grace notes 1017
guitar bends 400
guitar pre-bends 901
slurs 1017, 1022, 1023
ties 1078, 1079

curved arpeggio signs 883
duration 887
inputting 313
playback 887
popover 313

custom
barline joins 675
chord diagrams 735
endpoint configurations 481, 482
ensembles 98, 114
key commands 54, 58, 62
layouts 105
markers 369, 969
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custom (continued)
note sizes 399
page size 503
paper size 503
percussion techniques 1116, 1118–1120
playback templates 471, 474, 477
player order 110
repeat markers 981
score layouts. See layouts
staff order 110
staff size 529
tempo text 1056
trill speeds 881
tuning 124, 126, 127, 728, 731

Custom Centered Beam dialog 696
custom notehead sets

percussion 1116, 1118–1120
custom playing techniques

percussion 1116, 1118–1120
playback 649

custom score layouts. See layouts
Custom Staff Size dialog 529
custom text 1065

dynamics 754
markers 369, 969
percussion legends 1131
repeat markers 981
repeats 983

cut common time. See time signatures
cutting

bars 667–669
beats 409, 667
notes 238
selections 414, 432, 667–669
slash regions 1002
tie chains 238, 1083

D
da capo

al coda 979
al fine 979
al segno 979
hiding 981
inputting 380, 381
showing 981

dal segno 979
hiding 981
showing 981

damping. See playing techniques
dangling ties. See laissez vibrer ties
dark theme 49, 52
dashed

barlines 258, 674, 1085. See also aggregate time 
signatures
figured bass 774
guitar bend hold lines 901
hairpins 758
jazz articulations 913
lyrics 360, 362, 835
octave lines 742
pedal lines 933
slurs 1020

dashed (continued)
staff labels 1034
string indicator lines 797, 941
tempo marks 1062, 1063
ties 1076, 1077
vibrato bar lines 333, 334, 904

dashed lines
attachment 417
lines 353, 946
octave lines 742
tempo marks 1062, 1063

data
expression maps 626
library 622

date and time 
annotations 507
auto-saved projects 90
comments 432
exporting 495
printing 491
tokens 556

deactivating
caret 195
chord input 226
Insert mode 212
mouse input 205
muted tracks 462, 612, 613
note input 197, 200
player sorting 110
soloed tracks 462, 612, 613

dead notes 908
decimal places

metronome marks 273, 274, 1059
decorations. See ornaments
decrescendo. See gradual dynamics
dedications 70, 801

tokens 555
default flow headings 548, 550
default page templates 548, 549

composer 801
lyricist 801
title 801
tokens 801

default playback templates 472
default settings 17, 53, 560, 622

accidentals 204
articulations 204
beam grouping 692
dynamics 417
file names 498
flow headings 550
hand tool 37
instrument names 161, 163
key commands 25, 54, 58
layouts 157, 622
library 622
marquee tool 37
MIDI 417
mouse input 188, 189
note input options 204
note spacing 533
playback 471, 476, 618
playing techniques 940
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default settings (continued)
project templates 73
resetting 622
rhythm dots 204
selection tools 37
slurs 417
staff grouping 709
staff labels 161, 163
staff spacing 513, 530
tablature strings 197, 200
volume 618

delay
glissando line playback 893
inserts 616, 620

deleting 412, 547
accidentals 655
articulations 662
auto-saved projects 89, 90
bar number changes 686
barlines 676
bars 276, 409, 667–669
beams 691, 692
beats 276, 409, 667, 669
borders 1071
brackets 656, 723, 724, 751, 774, 777, 850
capos 131, 133
centered beams 697
chord symbols 714
comments 434
counts 983
dynamics 574
editors 572
effects 621
empty pages 24
endpoints 481, 483
fermatas 813
files 64
fingering slides 793
fingerings 787, 788
flow headings 521
flows 151, 154
frame breaks 540
frames 521
gaps between notes 236
grace notes 806
groups from percussion kits 142
guitar post-bends 903
guitar pre-bends 903
guitar techniques 910
indents 1046
Insert mode 408
inserts 621
instrument names 1030
instrument transpositions 161, 1033
instruments 112, 123, 144
jazz articulations 914
jump bar aliases 63
key commands 59, 60
Key Editor configurations 610
layouts 157
markers 370
MIDI points 574
niente markings 764

deleting (continued)
notehead brackets 850
notes 409, 583, 667
overlapping notes 236
parentheses 656, 723, 724, 751, 774, 777, 850
pedal level changes 927
pedal lines 927
pick-up bars 409
playback overrides 585
playback techniques 641, 650
players 112, 147, 149, 153
projects 64
rests 236, 667, 1012, 1014
retakes 927
rhythmic feel change 468
scoops 910
staff labels 1030
staves 515, 516
stem direction changes 858
stop positions 411
string indicators 798
strings 124
system breaks 538
system indents 1046
tapping 910
templates 610
tempo marks 574
ties 705, 1082, 1083
time 408, 409, 667–669
titles 521
tre corde 936
tremolos 1102
trill intervals 877
tuplets 1106
velocity changes 589
videos 170
voices 1138

delta 605, 606, 608
demo projects 64
denominators

styles 1091, 1093
time signatures 1084

dense chords
accidental stacking 658

depressed keys 183
depth

audio 619
nested slurs 1024
nested tuplets 1104

deselecting. See selecting
design

arrows 946, 957
grace note slashes 807
lines 946, 956, 957
noteheads 841, 844, 845
slurs 1020, 1022
time signatures 1097

designation
strings. See string indicators

destination
exporting files 497
instruments 745
notes 792
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détaché. See playing techniques. See also articulations
detecting

grace notes 81
strings 351
tuplets 81

detuned fretted instruments 128, 131, 132
devices

audio 53, 244, 245
diagonal

accidental stacking 657
chord symbols 722
lines 353, 704, 889, 911

diagrams
chords. See chord diagrams
harp pedaling. See harp pedaling. See also harp 
pedal diagrams

diamond noteheads 842, 843, 845, 937
accidentals 862
harmonics 860, 863, 865, 866
percussion 1116, 1119, 1120

diddle 197, 235, 1099, 1104
dimensions

page size 503
paper size 503

diminished. See augmented. See also intervals
diminuendo. See gradual dynamics
dips 904

inputting 332
intervals 908
popover 313

direction
arpeggio signs 883, 884
audio. See panning
beams 693, 694, 702
fanned beams 704
glissando lines 846
grace notes 805
gradual dynamics 757, 761–763
guitar bends 400
guitar pre-bends 901
hairpins 757, 761–763
lines 957
panning 619
paper orientation 503
partial beams 702
playback techniques 650
rhythm slashes 999
slur curvature 1022, 1023
stems 854, 856–858
string shift indicators 796, 846
tie curvature 1078, 1079
transposing 424, 425

disabling. See enabling. See also deactivating
disclosure arrows 40

Expression Maps dialog 626
Properties panel 36

disconnecting. See unlinking
display options 27, 38

date 556
frames 508, 559
image resolution 505
Key Editor 564
language 48

display options (continued)
layouts 31
music area 32, 39, 47
pages 508
panels 35, 41
percussion editor 576
piano roll 564, 575
playback 471
print preview 34
project window 31
tabs 42
time 30, 471, 556
transport 30
zones 35

distance
bar numbers 682
beams 704
braces 710
brackets 710, 712
breath marks 812
chord diagrams 731
fermatas 812
flow headings 525
margins 511, 524–526
noteheads 699
page edges 511, 526
staff labels 1031
staves. See staff spacing
stems 699
system indents 1031, 1046

Distortion 616, 620
distribution

bars per system 535
beats in bars 705
dynamics 758
staves per frame 513
systems per frame 536
values 604
velocity 604

dives 894, 899, 904
inputting 325, 326, 328, 329
popover 313
pre-dives. See guitar pre-bends
vibrato bar. See vibrato bar. See also guitar bends

dividers. See system dividers
dividing. See splitting
divisi 543, 1047

brackets 708, 709, 711, 712, 946, 1047
condensing 543, 1038, 1047
hiding empty staves 515–517
hiding staff labels 1030
lengthening 417, 421
moving 417, 421
playback 460, 461, 484
shortening 417, 421
signposts 407
staff labels 1030, 1038
staff size 528
staff spacing 513
staves 515–517

DJ-EQ 616, 620
djembe. See unpitched percussion
doits. See jazz articulations
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dolce. See dynamic modifiers
dorian

chord symbols 296, 720
DoricoBeep 442, 450

sound 450
dots

barlines. See repeat barlines
chord diagrams 727, 728, 735, 736
guitar tapping 905
Keyboard panel 183
rhythm. See rhythm dots. See also dotted notes

dotted
beat units 271
dynamics 746
hairpins 758
noteheads 844
notes. See dotted notes
octave lines 742
rests 173
slurs 1020
tempo marks 1062, 1063
ties 1076, 1077
tremolos 381, 383

dotted lines
attachment 417
lines 946
octave lines 742
stop positions 411
tempo marks 1062, 1063

dotted notes 205, 705
double 205
forcing 238
inputting 173, 205
note grouping 21, 705
swing playback 465, 466
tempo equations 1064
tremolos 381, 383
triple 205

double 562
accidentals 425, 428, 429, 431, 660
barlines 277, 281, 282, 672, 674
cadence. See ornaments
dotted notes 21, 205, 705
note durations 236
octaves 233
slashes 1042, 1099
stems 658, 1134. See also voices
values 562
whole notes 13, 177, 197, 200, 207, 210, 212, 213, 
217, 226, 235, 236, 238

doubling instruments 107
adding 120
inputting notes 197, 200
instrument changes 117, 118
labels 1035
moving 123
showing staves 47

down arpeggio signs. See arpeggio signs
down bow. See playing techniques
down-stem voices. See voices
downloads 64
dpi 505
draft staves. See sketch staves

dragging 37, 405, 572. See also drawing
drags. See grace notes
drawing 37, 405, 566, 572

dynamics 591
marquee selections 572, 609
MIDI 597
notes 577. See also note input
tempo 450, 601
velocity 588

drop frame timecodes 971
drops. See jazz articulations
drum editor. See percussion editor
drum kits. See percussion kits. See also drum sets
Drum Pads panel 186

key commands 41
drum rolls. See tremolos
drum sets 136, 1115, 1122

caret 213
defining kits as 140
exporting 1123
filtering instruments 136
importing 1123
inputting notes 213, 578
laissez vibrer ties 1081
naming 136
note input 215
setting up 136, 215
stem direction 140
voices 140, 1131

dry
reverb 621

DualFilter 616, 620
duplets. See tuplets
duplex printing 491, 502

booklets 501
duplicating

copying. See copying
dynamics 414, 594
expression maps 639
flows 149
items 414–416
MIDI 573, 600
notes 414–416, 582
percussion maps 646
playback templates 477
players 109
playing techniques 942
points 573, 594, 600
rehearsal marks 1045
repeat endings 1045
switches 640
tempo marks 414, 573, 1045

duration 13, 396, 941, 1008
accidentals 660
arpeggio signs 887
articulations 661, 665
audio 86, 87
bars 22, 409, 667
changing 235, 236, 238, 396
fermatas 398
figured bass 396, 774, 776, 779
flows 555, 667–669
forcing 238
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duration (continued)
grace notes 808
horizontal lines 953
jazz articulations 913
lines. See duration lines
locking 427
notated 584
notes 22, 177, 235, 236, 238, 577, 578, 580, 584
pedal lines 936
percussion 578
played 584
playing techniques 337, 341, 343, 396, 941, 944
repeat endings 976
rests 235, 238, 1008
slurs 1028
terminology 13
vibrato bar lines 904

duration before pitch note input 197
duration lines 940, 946

figured bass 774–776, 779
handles 939, 941
hiding 396, 941, 942
inputting 337, 341, 343
playing techniques 941, 943
showing 396, 941, 942
string indicators 349, 350, 797, 940

dyads. See chords. See also chord symbols
dynamic glyphs 746
dynamic levels 284, 286, 287, 290, 751

changing 592, 751
decreasing 751
increasing 751
playback 590

dynamic modifiers 746, 754, 1052, 1062
appearance 756
centered 756
hairpins 756
inputting 284, 286, 287, 290, 755
poco a poco 760
showing 752
subito 756

dynamics 746
alignment 748, 749, 765–768
appearance 753
bar repeats 986
barlines 749, 750
brackets 751
changing 398, 592, 751
colors 52
combined 746
continuation lines 746, 757
conventions 747
copying 414, 417, 573, 594, 767
crescendo. See gradual dynamics
deleting 412
diminuendo. See gradual dynamics
editing 751
editor. See Dynamics editor. See also Velocity 
editor
endpoint positions 749
expression maps 633
expressive text. See dynamic modifiers
filters 393

dynamics (continued)
flared hairpins 759
force 746
gradual. See gradual dynamics
grand staff instruments 287, 290, 754
grouping 765, 766
hairpins. See gradual dynamics
handles 396, 757, 761, 762
hiding 752, 753, 756
humanize 590
hyphens 284, 752, 758
immediate 746
inputting 284, 286, 287, 290, 591, 594
intensity 398, 592, 751
length 396, 592
levels. See dynamic levels
linking 417, 767–769
messa di voce. See messa di voce
modifiers. See dynamic modifiers
moving 417, 421, 592, 747, 756, 762, 765–768
muting in playback 394, 463
niente. See niente
non-sustaining instruments 769
overriding 591, 594
panel 290
parentheses 751
percussion kits 1125
placement 747
playback 394, 460, 461, 463, 590, 596, 633, 649, 
650, 754, 769
poco a poco 756, 760
popover 284, 287
position 747, 748
repeats 463
rfz 753
selecting 388, 393
separators 284, 752
sfz 753
showing 752
signposts 407, 752
size 399
spacing 761
staff-relative placement 400
subito 756
sustaining instruments 769
swells. See messa di voce
tempo marks 1056
text 758
ties 287, 290, 417, 747
tracks. See Dynamics editor. See also Velocity 
editor
types 284, 746
ungrouping 766
unlinking 417, 769
velocity 587, 588, 751
voice-specific 287, 290, 590, 591, 754
volume 751, 769

Dynamics editor 284, 587, 590, 746, 767
adding 572
closing 572
copying points 573
deleting points 574
height 570
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Dynamics editor (continued)
hiding 590
inputting points 591
moving points 592
selecting points 572
showing 590

dynamics lanes. See Dynamics editor
Dynamics panel 286, 290

E
East Asian elision slurs 838
edges

frames 550, 551
margins 524
pages 524

Edit Chord Diagram dialog 736
Edit Endpoint Configurations dialog 483
Edit Instrument Names dialog 161
Edit Percussion Kit dialog 136
Edit Playback Techniques dialog 650
editing 187, 395, 398

area 136, 1126
inputting vs. editing 187
items 398, 560
lyric text 831–833
mouse input 188, 189
moving. See moving
note durations 236, 396
notes 173
rhythmic grid 190

editorial
chord symbols 723, 724
dynamics 751
figured bass 774, 777
notes 849, 850
slurs 1020
ties 1076

editors 564
adding 572, 610
closing 572
configurations 609, 610
drum. See percussion editor
dynamics. See Dynamics editor
histogram. See Histogram tool
Key Editor. See Key Editor
MIDI CC. See MIDI CC editor. See also MIDI Pitch 
Bend editor
percussion. See percussion editor
piano roll. See piano roll editor
pitch bends. See MIDI Pitch Bend editor. See also 
MIDI CC editor
playing techniques. See Playing Techniques editor
saving 609, 610
scrolling 571
templates 609, 610
tempo. See Tempo editor
text 357
velocity. See Velocity editor

EDO 820

effects channels 614–616
mixer 612, 613
reverb 621
volume 618

eighth notes 13, 177, 197, 200, 210, 212, 235, 236
beaming 689
beats 276
chords 226
grace notes 225
metronome marks 269
percussion 213, 578
playback 633
rests 221, 1008
splitting notes 238
swing playback 270, 465, 466
tablature 217
tempo equations 1064
tremolos 381, 383, 1099
tuplets 229, 232
voices 207

elbowed beams. See centered beams
electric guitar. See fretted instruments
elision slurs 838

inputting 360, 362
size 838
width 827

empty bars
deleting 669
inputting 278, 279
multi-bar rests 1014, 1015
rests. See bar rests
showing 1015

empty pages
deleting 24, 1066

empty staves 515
after flows 517
hiding 515–517, 530
showing 515–517, 530
system dividers 1043
tacets 541

empty voices 1138
enabling 195

auto-save 91
channel effects 616, 620
chord symbol playback 452, 453
click during playback 457
dynamics linking 417
EQ 616
independent voice playback 460, 461
inserts 620
instrument changes 117
MIDI copying 417
MIDI devices 246
MIDI thru 240
partial harp pedaling 923
plug-ins 459
slurs linking 417
swing playback 270, 467, 468
system track 392
VST instruments 459
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enclosures
bar numbers 678
rehearsal marks 963
text 1071, 1072

end barlines 674
end repeat barlines 277, 672

counts. See repeat counts
inputting 276, 278, 281, 282
playthroughs 463, 464, 983
repeat endings 975

endings
additional 377, 379
arpeggio signs 883–885
playthroughs 975
repeat. See repeat endings

endpoint positions
arpeggio signs 886
dynamics 749
lines 949, 953, 955
octave lines 743
pedal lines 928
repeat endings 977
slurs 665, 1017–1019
staff lines 1018
trills 869
tuplet brackets 1111

Endpoint Setup dialog 479
endpoints 479

changing 484, 485
configurations 481, 482
custom 483
deleting 483
expression maps 479, 485
glissando lines 889
instruments 484
moving 396, 417
percussion maps 479, 485
plug-ins 471
renaming 483
saving 483
setup 479
voices 484

Engrave mode 547
playhead 457

engraving options
exporting 73
project templates 73

engraving tools. See properties. See also default 
settings
enharmonic spelling

accidentals 220, 428, 429, 431
chord symbols 128, 720, 721
key signatures 819
MIDI 80, 240
modes 720
notes 220, 428, 429, 431
respelling 183, 428, 429, 431

ensemble picker 98
ensembles 94, 112

adding 98, 113
brackets 708, 709, 1036
custom 98, 101, 114
divisi 1047

ensembles (continued)
groups. See player groups
language 98
saving 101, 114
staff grouping 709, 1036
templates 66, 73

envelopes
dynamics 590, 592

EnvelopeShaper 616, 620
equal division of the octave 820
equalization 616

changing 620
equations

tempo marks 271, 1064
erased backgrounds

bar numbers 678
bar repeats 985
staff lines 787
string indicators 797

erasing. See deleting
espressivo. See dynamic modifiers
even staff spacing 513
event display. See track overview
events

markers 451
exchanging. See switching
excluding 105

flows from layouts 105, 154
playback 463
players 149
players from flows 105
players from layouts 105, 153
tempo changes from playback 458

exclusion groups
expression maps 626

exercises. See flows
expanding 396

barlines 675, 676
bars 278, 280, 409, 410
caret 195, 210
duration 235, 236, 396
editors 570
flow headings 524, 525
grace notes 805, 806
items 396
Key Editor 570
margins 511, 524–526
menus 40
notes 235, 236, 805, 806, 1106
options 40
pages 510
percussion grids 143
ranges 124
selections 388, 389
slurs 1017
spacing 513, 524
staves 143, 513, 532, 1126
strings 124
systems 513, 522, 532
tuplets 1106

explicit rests 1008, 1009
colors 1011
deleting 1012
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explicit rests (continued)
hiding 1012
implicit rests 1011
showing 1012

exploding 195, 210
chords 210
note input 195, 210

exponential hairpins. See flared hairpins
Export Audio dialog 87
Export File Names dialog 498
Export Flows dialog 76
Export MIDI dialog 82
Export MusicXML dialog 79
Export Tempo Track dialog 85
exporting 73

annotations 507
arrangements 500
audio 86, 87
borders 507
color graphics 506
comments 434, 437, 507
crop marks 507
date 507
ensembles 73, 101
expression maps 642
file names 498
FLAC files 86, 87
flows 75, 76, 493, 494
fretted instrument tunings 127
key commands 54
Key Editor configurations 610
layouts 495
lyrics 826
MIDI 82
monochrome graphics 506
MP3 files 86, 87
MusicXML files 79, 978
note colors 507
options 488
output format 495
page ranges 493, 494, 500
path 497
PDF 495, 496
percussion kits 1123
percussion maps 648
playback templates 478
players 75
PNG 495, 496
repeats 463
signposts 507
stems 86, 87
SVG 495, 496
tempo tracks 85
TIFF 495, 496
time 507
voice colors 507
watermarks 507
WAV files 86, 87

expression maps 625, 626
actions 631, 640
conditions 632, 640
creating 639–641
dialog 626, 636

expression maps (continued)
dynamics 633
endpoints 479, 481, 482, 485
exporting 642
file format 625, 642
filters 626
hiding playing techniques 939
importing 642
MIDI 769
mutual exclusion groups 634, 639, 641
order 626
pitch 626, 639
playback techniques 626, 636, 640
playing techniques 649, 939
resetting 636
switches 629, 637, 640
transpose 627, 629, 633
trills 880
volume 769

Expression Maps dialog 626
expressive text. See dynamic modifiers
extended techniques

noteheads 841
extending. See expanding
extension lines

lyrics 362, 823, 835
trills 870–872

extra staves 1041
condensing 1041
divisi. See divisi
hiding 515–517
moving 417, 421
ossia staves. See ossia staves
showing 515–517
signposts 407, 1041
ties 223

extracts. See flows

F
F clef. See clefs
factory default playback templates 472
faders 612–614

moving 618
resetting 618

fallback
playback techniques 650
playback templates 474

falls. See jazz articulations
false harmonic. See pinch harmonics
families

fonts 69
instruments 96, 474, 937

fanned beams 704
direction 704

fast-forwarding 456, 468
feathered beams. See fanned beams
feedback

comments. See comments
fermatas 809, 810

appearance 398
barlines 814
changing 813
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fermatas (continued)
colors 52
deleting 412, 813
duration 398
hiding 813
inputting 306, 308, 309
moving 417, 814
multiple at same position 813
number per staff 813
placement 812
position 812
showing 813
single staves 813
stems 812
types 398, 810, 813
voices 813

figured bass 771, 774, 775
accidentals 366
appearance 780, 781
brackets 364, 774, 777
deleting 412
duration 396, 774, 776, 779
fixing 781
font 780
global 363
grace notes 776, 779
handles 396, 774, 779
hiding 772
hold lines 774, 775
input options 781
inputting 363, 364, 367
instruments 363
inverting 778
length 396, 774, 776, 779
local 363, 771
moving 417, 774, 776, 779
navigation during input 367
octaves 780
parentheses 364, 774, 777
pitches 424
placement 778
players 363, 772
popover 364
position 778
resetting 781
resolutions 363, 364, 775, 779
rests 363, 771, 773, 780
rows 778
showing 363, 772
signposts 363, 407, 771, 772, 780
simplifying 780
slashes 364
staff-relative placement 778
staves 363
suspensions 364, 774, 775
transposing 424, 427
vertical position 772

file formats 505
audio 86, 87
backups 91
expression maps 625, 642
graphics files 505
MIDI 80

file formats (continued)
MusicXML 77
PDF 505
percussion maps 648
playback templates 471
videos 166

file names 498
ingredients 498
recipes 498
setting 498
tokens 553

files 73
different Dorico versions 68
exporting 73, 495–497
importing 73
missing fonts 69
opening 67
videos 168

filled noteheads 841
films. See videos
filters 393

deselect 394
drums 136
dynamics 393
effects 616, 620, 621
ensembles 98, 113, 114
equalization 616, 620, 621
expression maps 626
frequencies 616, 620, 621
harp pedaling 393
Histogram tool 606
inserts 616, 620, 621
instruments 96, 98. See also instrument filters
Key Editor 606
lyrics 393, 826, 827
mixer 616, 617, 620, 621
notes 393
options 622
percussion 136
percussion maps 643
pitch 393
properties 560
select 394
stem direction 393
tempo marks 393
voices 393, 566, 606

final barlines 277, 672
end of systems 674
inputting 276, 278, 281, 282
number of times played 464
repeat barlines 674

final tempo 1061
Find Tempo dialog 371

important markers 970
finding. See searching
fine

barlines 674
d.c. al 979
hiding 981
inputting 380, 381
sections 979
showing 981

finger tapping. See tapping
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fingering 783
appearance 788
arpeggio signs 792
brackets 249, 251, 788, 790
cautionary 788
changing 733, 736, 785
chord diagrams 727, 728, 732, 733, 735, 736
deleting 787, 788
font styles 788
fretted instruments 789. See also tapping
hammer-ons. See hammer-ons
handles 785
hiding 732, 787
horn branch indicators 794
inputting 249, 251
inside the staff 787
inverting 786
moving 732, 791
MusicXML import 796
parentheses 249, 251, 788
placement 783, 787, 790, 791
popover 249, 251
position 732, 783
pull-offs. See hammer-ons
resetting 401
separators 794
showing 787
slides. See fingering slides
staff-relative placement 786
string shift indicators 795, 796
strings 846
substitution 784, 785
tapping. See tapping
thumb letter 732, 733, 736
types 251, 794
valved brass instruments 794

fingering slides 792
deleting 793
handles 792
hiding 793
showing 793

finials. See caret. See also annotations
first and second endings. See repeat endings
first page templates 549

assigning to pages 520
formatting 549
page numbers 916

first systems
indents 1046
page numbers 916
staff labels 1030

fit to paper 504. See also staff size
five-line staff 1040

noteheads 1118, 1121
percussion kits 136, 1126, 1127
percussion legends 1128

fixed tempo mode 458
fixing

bars 535
figured bass 781
note durations 223, 236, 238
pages 536
systems 536

FLAC files
exporting 86, 87

flageolet. See harmonics
flags

above staves. See signposts
markers. See markers
notes 854
stems 854

flams. See grace notes. See also playing technique-
specific noteheads
Flanger 616, 620
flared hairpins 759
flat

accidentals. See accidentals
beams 694, 695
slurs 1022

flipping 400, 1023
flips. See jazz ornaments
floor tom. See unpitched percussion
flow cards 105
flow headings 70, 547–550

default 550
flow titles 521
frames 550
gaps 524, 525, 731
hiding 64, 521
margins 524, 525, 731
moving 525
page numbers 521, 916
page templates 520
showing 64, 521
titles 521

Flow Import Options dialog 74
flow numbers 150

changing 70, 150
flow headings 550
tokens 555

flows 19, 105, 148
accidental duration rules 660
adding 148, 149, 432
adding players 149
adding to layouts 154
audio 86, 87
cards 104
copying 74, 149
deleting 151
deleting empty bars 669
duplicating 149
duration 555, 667–669
exporting 75, 76, 493, 494
going to 404
headings. See flow headings
hiding 154
importing 74, 77, 80
indents 1046
instrument change labels 1035
justification 522
key signatures 815
layouts 105
merging 74, 519
MIDI import 80
moving 539
multiple on pages 519
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flows (continued)
MusicXML files 79
names 164, 165
navigation 404
numbers. See flow numbers
opening 441
order 70, 150
page numbers 521, 555, 556
page templates 520
panel 104
playback 484
players 105, 149
printing 493, 494
project templates 73
rehearsal marks 964
removing from layouts 154
removing players 149
selecting 389
showing 154
sorting 150
splitting 432, 519
staff labels 1030
staff size 528
switching 441
system dividers 1043
systems 522
tacets 541, 542
tempo tracks 83
timecodes 104
titles 164, 165, 521
tokens 555
transposing 424, 425
trimming 276, 281, 282, 669
videos 104, 166, 168
voices 484

Flows panel 93, 104
flute. See instruments
flutter-tongue. See playing techniques
flz. See playing techniques
folders

backups 91, 92
export path 497

follow tempo mode 458
font styles 1066

bar repeats 987
condensing 1038
figured bass 780
glyphs 624
lyrics 821, 833, 834
missing fonts 69
music 624
notations 624
notes 624
numbered bar regions 993
PDF files 506
player group labels 1036
playing techniques 939
rhythm slashes 1003
SVG files 506
time signatures 1097

force
articulations 661
dynamics 746

force (continued)
figured bass appearance 781
horizontal 961, 1111
staff visibility 516

force duration 173, 238
activating 173
inputting notes with 238
inputting rests with 238

formats. See file formats
formatting 508

altered unisons 659
arpeggio signs 884, 885
bar numbers 677, 681
caps 957
chord diagrams 735
dynamics 758
file names 498
frames 544
front matter 801
glissando lines 890
grace notes 806
gradual dynamics 758
hairpins 758
instrument change labels 118
layouts 511, 544, 545
lines 956, 957
lyrics 833, 834
markers 369, 969
niente hairpins 765
noteheads 845
page formatting 535, 548
page templates 547
pages 508, 544, 545, 801
pedal lines 931–933
player group labels 1036
slurs 1021, 1022
systems 544
tacets 541, 542
tempo marks 1063
text 357, 359, 1066, 1070
ties 1077
tuplets 1106, 1112

forte. See dynamics
forum 64
forwards. See backwards
forzando. See dynamics
fps 171
fractions

arpeggio signs 887
figured bass 364
fingerings 785
glissando lines 893
guitar bends 900
tempo marks 273, 274, 371, 1058, 1059
time signatures 258, 1084, 1085

frame breaks 508, 535, 539
bar repeats 539
barlines 536
clefs 738
copying to other layouts 544, 545
deleting 540
divisi 1047
first page on the left 519
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frame breaks (continued)
hiding staves 516
inserting 539
key signatures 818
moving 536
playing techniques 939
repeat endings 977
signposts 407, 540
slurs 1019
staff spacing 513
staff visibility 516
ties 1079
time signatures 1087

frame chains
music. See music frame chains
properties 547, 560–562

frame rates 171
changing 167, 171
dialog 167
drop frame timecodes 971
non-drop frame timecodes 971
transport window 468, 471

frames 551, 1071
breaks 508, 539
constraints 524
copying 547, 549
dashed 550
flow headings 521, 524, 525, 550
gaps 524–526
hiding 402
margins 524, 526
moving 524, 525
padding 508, 526
running headers 521
staves 513, 522
systems 513, 522, 536
tokens 552

frequency
auto-save 91
bar numbers 677, 994
bar repeat counts 988
harmonics 859
numbered bar region counts 994
slash region counts 1004
timecodes 973
trills 871

Fretboard panel 185
key commands 41

frets 124, 1048
adding 124, 217, 736
brackets. See bracketed noteheads
capos. See capos
changing 1050
chord diagrams. See chord diagrams
deleting 124, 736
intervals 124
note input 185, 217
notes out of range 1050
parentheses. See bracketed noteheads
position 124
spacing 124
starting number 728, 735, 736
string number 846

fretted instruments 124
adding 96, 120
arpeggio fingering 792
capos. See capos
changing tuning 96, 122, 124, 126
chord diagrams 727, 728
chord symbols 128, 131, 720
detuned 128, 131, 132
exporting tunings 127
fingerings 249, 789
frets 124
guitar bends 894
guitar techniques. See guitar techniques
harmonics 859–861, 863
importing tunings 127
note input 185
open pitches 126
pinch harmonics 866
popover 252
slides 792, 793
string indicators. See string indicators
strings 124, 126, 128, 846
tablature. See tablature
thumbs 732, 733, 736
transposition 119, 124, 129–132
tuning 122, 124, 128, 131, 132, 720

front matter 801
composer 549
copyright 549
lyricist 549
page templates 547, 549
performance instructions 547, 549
player list 552
title 547, 549

full score layouts. See layouts
full screen 46
full stop. See period
fullness

pages 512, 513, 522, 527
fullness threshold

horizontal justification 522
vertical justification 513, 530

functions
key commands 57
removing key commands 59

fundamental
harmonics 859
string pitches 124

funk noteheads 844, 845
FX channels 614–616

reverb 621

G
G clef. See clefs
galley view 38, 47

bar numbers 38, 680
dragging pages 405
flows 432
instrument changes 117
instrument labels 47
staff labels 38
staff spacing 530, 532

Index
 

1178
Dorico SE 4.3.30



gaps 524
articulations 662, 664, 665
bar numbers 682
bars 1046
caesuras 812
capos 124, 129, 131, 133, 135
chord diagrams 731
clefs 738
codas 982, 1046
dynamics 747, 752
elision slurs 838
extender lines 827
fingering slides 792
flow headings 524, 525
frames 524–526
galley view 532
hyphens 827
lines 961
lyrics 827
margins 524
notes. See note spacing
ossia staves 513, 530
pedal lines 929, 930
quantization 81
removing 236
slurs 1018, 1019
staff labels 1031
staves 143, 513, 529, 530, 979, 1046
stemlets 704
stems 699
system indents 1031, 1046
systems 513, 979
tacets 543
text 961
time signatures 1095

Gate 616, 620
General MIDI 625, 638
generated trills 880, 881
generating

harp pedaling 349
ghost notes 849, 850

guitar. See dead notes. See also bracketed 
noteheads

gli altri. See divisi
glissando lines 889, 911, 946

accidentals 889
angles 889
changing 398
deleting 412
direction 846
endpoints 889
filter 393
formatting 890
guitar bends. See guitar bends
harp pedaling 892, 918
hiding 891
inputting 310, 313, 319, 320, 890
line styles 890
one note 911
panel 315, 320
playback 892, 893, 918
popover 313, 319
showing 891

glissando lines (continued)
styles 890
text 891
tie chains 892
types 313

global
chord symbols 291, 713
fermatas 809
figured bass 363, 771
key commands 56
note spacing 533
properties 547, 560–562

glockenspiel. See instruments
glyphs

accidentals 428, 429, 431
fonts 624
music symbols 355, 358, 554
pedal lines 930
playing techniques 937
text 355, 358, 554
trills 867, 868

go to. See navigation
Go To Bar dialog 405
Go To Page dialog 404
Go To Rehearsal Mark dialog 405
gongs. See unpitched percussion
Gould

accidentals 254, 820
grace notes 803

appearance 808
arpeggio signs 886
barlines 806
beams 808
caret 191, 225
clefs 739
default settings 804
deleting 412, 806
duration 225, 808
figured bass 776, 779
glissando lines 319, 320
guitar bends 324, 325
hairpins 762
inputting 81, 173, 225, 805
inverting 804
lines 951
messa di voce 762
moving 417, 421, 805, 806
pedal lines 928
pitch 424
placement 804
playback 808
position 804, 806
quantization 81
register 424
size 399, 807
slashes 804, 807
slurs 248, 804, 1017
spacing 533, 804
speed 808
stems 804, 807, 808
ties 223, 1080
transformations 805, 806
transposing 424
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grace notes (continued)
trills 880
types 807
unscaling 806
voices 804

gradient background 50
gradual dynamics 746, 757

alignment 749, 765–769
appearance 758
barlines 749, 750
centered text 756
continuation lines 758
dashed 758
dotted 758
end position 749
flared hairpins 759
grace notes 762
grouping 765, 766
handles 396
hyphens 758
inputting 284, 286, 287, 290
length 396
line style 758
linking 767–769
messa di voce 761, 762
moving 417, 747, 761, 762, 765, 767
niente. See niente
playback 769
poco a poco 756, 760
position 761
spacing 761
syllables 758
tempo marks 1056
ties 287, 290, 417
truncated 761
ungrouping 766
unlinking 769
volume 769

gradual tempo changes 880, 1053, 1062
components 1054
continuation lines 1062, 1063
drawing 601
final tempo 1061
formatting 1063
hyphens 1063
inputting 268, 271, 273, 274, 602
length 396
lines 1062, 1063
Play mode 450, 601
popover 268
style 1063
syllables 1063
Tempo editor 601
text 1056

grand staff instruments
barlines 675, 676
braces 707
brackets 709
centered beams 695
chord symbols 717
cross-staff beams 697, 699, 701
dynamics 287, 290, 747, 754
hiding staves 515–517, 530

grand staff instruments (continued)
MIDI recording 241
multi-bar rests 1014
slurs 248
staff grouping 709
staves 675
swing playback 467
ties 223
vertical justification 530
voices 191, 207, 1134

graphics
files. See graphics files

graphics files 495, 505
colors 506
exporting 495–497
file names 498
fonts 506
formats 505
image resolution 505
monochrome 506

graphs 607
green notes

Dynamics editor 590
tablature 1050

grids
chord diagrams 731, 732
gaps 143
groups 141
Hub 64
percussion kits 140, 141, 143, 1037, 1126, 1127
rhythmic 190
staff labels 1030, 1032
staves 1037, 1126

groups
bar repeats 990
beams. See beam groups
braces 707
brackets 707
dynamics 765–767
guitar bends 894
instruments. See instrument groups
notes. See note grouping
percussion kits 136, 140–142, 1037
players. See player groups
playing techniques 940, 941, 943, 944
rests. See note grouping
staff labels 1038
staff spacing 513, 530
staves 675, 676
tabs 45

guide bar numbers 47, 680
hiding 402

guide instrument labels 47, 159
guitar 904

amp modeling 616, 620, 621
bends. See guitar bends
capos. See capos
changing string for notes 1050
chord diagrams. See chord diagrams
chord symbols. See chord symbols
dead notes 908
dips 332, 904
dives 326, 328, 329, 899, 904
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guitar (continued)
fingerings 789
hammer-ons 334, 906
harmonics 859, 861, 863
lines 333, 334, 894, 899, 904
note input 217
notes out of range 847
open pitches 126
playback 453, 894, 899, 904, 908
pre-bends. See guitar pre-bends
pre-dives. See guitar pre-bends
pull-offs 334, 906
scoops 330, 331, 904
slides 792
string indicators. See string indicators
strings 126
strumming 792
tablature. See tablature
tapping 336, 905
techniques. See guitar techniques
tuning 96, 124, 126
vibrato bar. See vibrato bar

guitar bends 894, 899
chords 894, 897
deleting 412
direction 400
dives 899
groups 894
hold lines 901
holds 894, 901
inputting 313, 323–325
intervals. See bend intervals
microtonal 326, 897, 900
parentheses 894
playback 894
popover 313, 324, 325
post-bends 326, 897
pre-bends 896
releases 894
runs 894
tablature 1049

guitar post-bends 897
bend intervals 900
chords 897
deleting 903
inputting 326
microtonal 326, 897

guitar pre-bends 896
accidentals 902
bend intervals 900
deleting 903
direction 901
inputting 325

guitar pre-dives. See guitar pre-bends
guitar techniques 904–906

dead notes 908
deleting 910
inputting 313, 323, 326, 328–334, 336
intervals 908
moving 909
panel 315
popover 313
staff-relative placement 909

H
H-bars. See multi-bar rests
hairpins. See gradual dynamics
half depressed pedal lines 926
half notes 13, 177, 197, 200, 210, 212, 235, 236

beats 276
chords 226
metronome marks 269
percussion 213, 578
rests 221, 1008
splitting notes 238
tablature 217
tempo equations 1064
tremolos 381, 383, 1099
tuplets 229, 232
voices 207

half-bar
beam grouping 705
note grouping 705
ties 705

half-diminished. See scales. See also intervals
half-step trills 873, 880

appearance 878
hiding 870, 874
inputting 312, 316, 317
position 879
showing 870, 874

half-steps 13, 655
accidentals 219, 655
bend intervals 900, 908
figured bass 366
glissando lines 889
harp pedaling 918
pitch bends 595
string pitches 124
tonality systems 820
trills. See half-step trills

half-whole diminished
chord symbols 296

HALion Sonic SE
endpoints 484
independent voice playback 460
playback template 471, 472

HALion Symphonic Orchestra
endpoints 484
independent voice playback 460
playback template 471, 472

halving. See double
hammer-ons 906

deleting 910
inputting 334
moving 909
popover 313
slurs 906
staff-relative placement 909

hand tool 37
dragging pages 405

handles
arpeggio signs 886
chord symbols 718
duration 396
dynamics 757, 761, 762

Index
 

1181
Dorico SE 4.3.30



handles (continued)
figured bass 774, 779
fingerings 785
hairpins 761, 762
length 396
moving 762
numbered bar regions 992
percussion legends 1130
playing techniques 939, 941, 943
repeat endings 976, 977
string indicators 939
tempo marks 1056
tuplet brackets 1109

harmonic analysis. See figured bass
harmonic minor. See scales. See also key signatures
harmonics 859

accidentals 862
appearance 863, 865, 866
artificial 859
hiding 860
inputting 860
natural 859
noteheads 845, 860, 863
partials 861
pitch 861
playback 859–861
question marks 860
showing 860
string number 846, 1050
styles 863, 866
tablature 860, 863

harp pedal diagrams 918, 919
placement 922
position 922
showing 919

harp pedaling 918
appearance 918, 919
borders 921
calculating 349
diagrams. See harp pedal diagrams
filter 393
glissando lines 892, 918
hiding 920, 921
inputting 340, 348, 349
moving 417, 421
note names 919
notes out of range 847
partial 923
playback 918
popover 340
showing 920
signposts 407, 918, 920, 921

headers
Dynamics editor 590
editors 572
flows 550
Key Editor 564
MIDI CC editor 596
MIDI Pitch Bend editor 595
percussion editor 576
piano roll editor 568, 575
Tempo editor 601

headers (continued)
tracks 440, 442, 449–452
Velocity editor 587

heavy swing. See swing playback
height

bars 512, 513, 530
brackets 708, 709, 725, 1036
channels 618
chord symbols 725
drum pads 186
editors 570
Key Editor 566, 570
keyboard 183
lines 954
mixer 612, 618
parentheses 725
percussion editor 570
piano roll editor 570
staves 512, 513, 524, 526, 527, 530
systems 513, 530
tracks 454, 570

hemiola
forcing note durations 238
independent time signatures 262–264, 266

Henze fermatas. See fermatas
hi-hat. See unpitched percussion
hiding 41, 407, 412, 608, 1073

accidentals 655, 656, 862, 874, 902
audio outputs in mixer 479
bar numbers 677, 679, 680, 684, 686
bar repeat counts 989
bar rests 1010, 1012, 1014
barlines 258, 674, 1085
beams 1002
borders 402, 678, 921, 1071
braces 708, 711
brackets 656, 708, 711, 723, 724, 751, 774, 777, 
850, 1036
brackets on noteheads 850
capos 133, 134, 136
caret 195
cautionary accidentals 656, 862
channels 617
chord diagram fingering 732, 736
chord diagrams 728, 730, 731
chord symbol parentheses 723, 724
chord symbols 299, 714, 716, 718, 721, 730
circles 678, 764
clefs 302, 303, 739
coda 981
colors 463, 847, 987, 998, 1011, 1135
comments 438
condensing colors 402
continuation lines 942
counts 679, 983, 989, 994, 1004
da capo 981
dal segno 981
dead notes 908
divisi colors 402
divisi labels 1030
divisi staves 515–517
dynamics 752, 753, 756
Dynamics editor 572, 590
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hiding (continued)
elision slurs 838
empty staves 515
fermatas 813
figured bass 364, 772–775
figured bass brackets 774, 777
fine 981
fingering slides 793
fingerings 732, 787
flared hairpins 759
flow headings 64, 521
flow page numbers 521
flow titles 521
flows 154, 541
Flows panel 104
glissando line text 891
guitar bend hold lines 901
guitar pre-bend accidentals 902
harmonics 860
harp pedaling 920, 921, 923
highlights 402
Histogram tool 604
hold lines 774, 775, 901
hyphens 752
initial page numbers 916
instrument change labels 1035
instrument changes 117
instrument names 1030, 1032
instrument transpositions 161, 1033
interchangeable time signatures 1085
jump bar 61, 62
key signatures 96, 122, 253, 255, 257, 815, 817, 
818
laissez vibrer ties 1081
lines 396, 402, 775, 942, 1036, 1063
margins 402
markers 967
MIDI CC editor 572, 596
MIDI Pitch Bend editor 572
mixer 612–614, 617
multi-bar rests 1015
niente 764
note colors 402, 507, 847
notes 1000
numbered bar regions 993, 994
padding rests 1001
page numbers 521, 916
panels 29, 36, 40, 41, 94, 101
parentheses 656, 723, 724, 751, 774, 777, 850
partial harp pedaling 923
pedal lines 931–933
percussion legend signposts 1128
player group labels 1036
players 149, 153
playhead 457
playing techniques 939, 942
Playing Techniques editor 586
quality in chord symbols 721
rectangles 678
repeat counts 983
repeat markers 981
rest colors 1011
rests 1010, 1012, 1014, 1015

hiding (continued)
root in chord symbols 721
running headers 521
secondary brackets 711
segno 981
separators 752
signposts 402, 407, 538, 540
slash region counts 1004
staff labels 1030
staves 105, 149, 153, 154, 515–517, 1049
stems 1002
string indicators 351, 396
sub-brackets 711
symbols 939
system dividers 1043
system track 392, 402
tablature 1049
tabs 29
tacets 542
Tempo editor 572
tempo marks 1058, 1063
text 1073
text borders 1071
text on lines 958
time signatures 409, 1096, 1097
timecodes 973
toolbar 28
tracks 454, 568
transport window 468
tre corde 936
trill extension lines 872
trill intervals 874
trill marks 870
tuplets 1109, 1112
Velocity editor 572, 587
verse numbers 837
vibrato bar lines 396
video window 169
voice colors 402, 507, 1135
VST instruments 445
zones 29, 41

highlights
bar repeats 985, 987
chord symbol regions 718, 719
comments 438
dynamics 590, 591, 594
exporting 507
flags. See signposts
hiding 402
MIDI 595–597, 600
numbered bar regions 987
printing 507
search matches 53, 622
slash regions 997, 998
stop positions 410
tempo changes 450, 601, 602
tracks 440, 450

histogram editor
changing values 588

Histogram tool 604, 605, 608
area graph 607
bar graph 607
changing values 606
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Histogram tool (continued)
controls 605, 606
filter 606
graph type 607
hiding 604
showing 604

hold lines 894, 901
brackets 777
figured bass 396, 774–776, 779
hiding 774, 775, 901
length 775, 776, 779
showing 774, 775, 901

holds
colors 52

Holds and Pauses panel 309
Hollywood-style trills 878

intervals 879
position 879
showing 878

hooks
pedal lines 926, 930, 932
playing techniques 940, 942
tuplets 1109

horizontal alignment
chord symbols 722
dynamics 765, 766
instrument names 161
lyrics 827, 828
ornaments 868
staff labels 161
staves 522
systems 522
text 1070

horizontal justification
staves 522
systems 522

horizontal lines. See lines. See also glissando lines
horizontal position

accidentals 657, 658
arpeggio signs 886
bar numbers 681
chord symbols 714, 717
clefs 739
dynamics 747, 748, 756
instrument names 161
lines 417, 421, 950, 951, 955
lyrics 827, 828
modifiers 756
notes 533, 1136, 1137
ornaments 868
poco a poco 756
rehearsal marks 963
rests 1008, 1012
staff labels 161
staves 522
string indicators 799
systems 522
tempo marks 1056
text 1070
time signatures 1095
trills 868
tuplet brackets 1111
tuplets 1113

horns 114
branch indicators 794
clefs 96, 122, 301, 740
fingerings 794
key signatures 96, 122
transposition 96, 119, 122

hotkeys. See key commands
hours 30, 468, 971
HTML files

comments 437
Hub 64

opening projects 67, 68
starting projects 66
video tutorials 64

humanize
dynamics 590

hymnals
lyrics 533
note spacing 533

hyphens
dynamics 284, 752
lyrics 360, 362, 823, 835
staff labels 1034
tempo marks 1063
time signatures 1091, 1094

I
illustrations

exporting 495, 496
images

exporting 495, 496
resolution 495, 496, 505
videos 166

immediate dynamics. See dynamics
implicit rests 21, 1008, 1009

colors 1011
deleting 1012
explicit rests 1011
hiding 1010, 1012
showing 1012
voices 1010

Import Tempo Track dialog 84
important markers 371, 970
importing 73

Cubase data 625, 642
expression maps 625, 642
flows 74, 80
fretted instrument tunings 127
Key Editor configurations 610
MIDI files 80
MusicXML files 77, 78, 978
pedal lines 80, 245
percussion kits 1123
percussion maps 648
playback templates 478
tempo tracks 83, 84
tracks 80
unpitched percussion 78

inches
unit of measurement 48

including. See excluding
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indents 1046
codas 982, 1046
final systems 522
first systems 1046
removing 1046
staff labels 1031
systems 522, 1030, 1031, 1046

independent voice playback 442, 460
changing endpoints 484
disabling 461
enabling 460
inputting notes 577
piano roll editor 575
playing techniques 341, 343

index
rehearsal marks 964
tokens 552
voice columns. See voice column index

Indian drum notation 1133
indicators

audio engine 36
caret 754
clefs 741
fingerings 251, 794
horn branches 794
MIDI input 36
octaves 741
string fingerings 795, 796, 846
tempo. See tempo marks
thumbs 251
trill intervals 873, 879
voices 754

information. See project information
ingredients 498
init switches 629, 637
initial pages

left-hand page 519
page numbers 519, 916

initial trill notes 880
initials

comments 432, 437
input pitch 203
inputting 187

accidentals 204, 219, 655
additional repeat endings 377, 379
altered bass note chord symbols 291
arpeggio signs 310, 313, 318
articulations 204, 246, 247
bar number changes 685, 686
bar number counts 375, 386
bar repeats 375, 376, 385
bar rests 222, 276
barlines 275, 277, 278, 281, 282
bars 275, 276, 278–280
beams 197, 690
beats 276, 278, 280
bracketed noteheads 850
breath marks 306–309
caesuras 306–309
capos 129, 130
caret 191, 195
centered beams 696
chord diagram shapes 735

inputting (continued)
chord diagrams 714, 728, 730
chord symbol parentheses 291, 297, 723
chord symbol regions 297
chord symbols 291, 293, 298, 299
chords 173, 226, 232, 234
clefs 299, 300, 302, 303
comments 433, 435, 436
dips 332
dives 325, 326, 328, 329
dynamic modifiers 284, 286, 287, 290, 755
dynamics 284, 286, 287, 290, 591, 594, 755
editors 572, 610
elision slurs 360, 362
ensembles 98, 113, 114
expression maps 639–641
fermatas 306, 308, 309
figured bass 363, 364, 367
figured bass hold lines 363, 364, 396, 774–776
fingerings 249
flows 74, 148–150, 432
frame breaks 539
glissando lines 310, 313, 319, 320, 890
grace notes 81, 225, 805
gradual dynamics 284, 286, 287, 290
gradual tempo changes 268, 271, 273, 274, 602
guitar bend hold lines 901
guitar bends 313, 323–325
guitar dips 313, 332
guitar dives 313, 326, 328, 329
guitar lines 313, 333, 334
guitar post-bends 326
guitar pre-bends 325
guitar pre-dives 325
guitar scoops 313, 330, 331
guitar tapping 313, 336
hammer-ons 313, 334
harmonics 860
harp pedaling 340, 348, 349
hold lines 396, 774–776
inputting vs. editing 187
Insert mode 212
instrument changes 197, 200
instruments 96, 108, 120
instruments in percussion kits 139
intervals 233
jazz articulations 310, 312, 321, 322
jazz ornaments 312, 316, 317
key commands 58
Key Editor 568, 572, 577, 591, 597, 602, 610
key signatures 253–255, 257, 655
layouts 153, 157
left-hand fingerings 252
line text 958
lines 337, 341, 343, 352–354
lyrics 360, 362
markers 369, 370, 451
messa di voce 284, 286, 287, 290, 762, 763
metronome marks 268, 273, 274
MIDI 80, 240, 241, 246, 447, 471, 472, 476
MIDI points 597, 600
mouse input 188, 189, 205
mutual exclusion groups 641
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inputting (continued)
nested slurs 1025
nested tuplets 1105
niente 284, 286, 287, 290, 764
notehead brackets 850
noteheads 582, 1119, 1120
notes 196, 197, 200, 204, 210, 212, 217, 232, 234, 
238, 241, 577, 578
notes in multiple voices 207
notes in percussion kits 213, 215, 578
numbered bar regions 375, 386
octave lines 299, 301, 302, 304, 305
octaves 233
ornaments 310, 311, 316, 317
panels 178
parentheses 291, 297, 363, 364, 656, 723, 751, 774, 
777, 850, 862
pauses 306, 308, 309
pedal lines 337, 339, 344–347
percussion kits 121, 213, 577, 578, 582, 1119, 1120
percussion legends 1128
pick-up bars 258, 260, 264, 266, 409
playback techniques 640, 650
playback templates 477, 478
player groups 145
players 98, 108, 114
playing techniques 337, 341, 343, 577, 578, 582, 
1119, 1120
popovers 21, 178
position 187
post-bends 326
pull-offs 313, 334
register selection 200
rehearsal marks 368
repeat endings 373, 376–379
repeat markers 374, 376, 380, 381
rests 173, 183, 197, 221, 238
retakes 344, 345, 347
rhythm dots 197, 200, 204, 205
rhythm slashes 375, 376, 384
rhythmic feels 268, 467
rhythmic grid 190
right-hand fingerings 252
scoops 330, 331
settings 189, 204
slash regions 375, 384
slash voices 209, 1007
slurs 248, 334, 1025
soloists 111
staves 108, 113, 120, 1047
stem direction 217
stems 207, 1134. See also voices
string indicator lines 396
string indicators 340, 349–351
strings 124
swing playback 270
switches 640
system breaks 537
system-attached text 355
tablature 217, 1049
tapping 313, 336
tempo equations 268, 271, 273, 274
tempo marks 268, 271, 273, 274, 602

inputting (continued)
text 355, 958
ties 173, 223
time signatures 258, 262, 263
timecodes 369, 968, 972
tokens 552
tremolos 374–376, 381, 383
trill intervals 876
trills 312, 316, 317
tuplets 81, 229, 1105, 1106
unpitched percussion 577, 578
upbeats. See pick-up bars
velocity 588
vibrato bar 323, 325, 326
vibrato bar dips 332
vibrato bar dives 328, 329
vibrato bar lines 333, 334, 396
vibrato bar scoops 330, 331
videos 168
voices 207, 209
VST instruments 447, 471, 472, 476

Insert Bar Number Change dialog 684
Insert mode 173, 187, 408

activating 173, 212
caret 191, 212
deactivating 212
inputting notes 212
scope 409, 410
stop positions 408, 410, 411
time signatures 262–264, 266, 409, 1084
tuplets 412

Insert Music Text dialog 358
inserting. See inputting. See also Insert mode
insertion point 191
inserts 616

changing 620, 621
loading 620
removing 621

inspector. See Track Inspector. See also properties
instances

adding 447
chord symbols 713
plug-ins 442, 445

instrument change labels 114, 117
borders 117
editing 118
font style 117
hiding 1035
prefixes 118
showing 1035
suffixes 118

instrument changes 117
allowing 117
disallowing 117
inputting 120, 197, 200
labels. See instrument change labels
language 118, 161

instrument channels 612–615
instrument colors 449

Dynamics editor 590, 594
MIDI CC editor 596, 600
MIDI Pitch Bend editor 595, 600
percussion editor 576
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instrument colors (continued)
piano roll editor 575
Playing Techniques editor 586
Velocity editor 587

instrument groups 140, 144
deleting 142
labels 1036
naming 141
percussion kits 140, 1037

instrument labels
percussion kits 141

instrument names 158, 1029
abbreviated 161, 1032
alignment 161
baseline shift 161
changing 161
colors 161
Endpoint Setup dialog 479
hiding 1030, 1032
length 161, 1030
mixer 612, 613
numbering 115, 1032
overline 161
Play mode 449, 479, 613
resetting 161, 163
saving as default 161
showing 1030
solo 111
staff labels 161, 554, 1030, 1032
stretch 161
subscript 161
superscript 161
tokens 554
tracks 449. See also instrument tracks
underline 161

instrument numbering 115, 1034
instrument picker 96
instrument pitches. See instrument transpositions
instrument tracks 448, 449

automation. See MIDI CC editor
dynamics. See Dynamics editor
MIDI. See MIDI CC editor
piano roll editor 575
velocity. See Velocity editor

instrument transpositions 119, 1033
changing 96, 122
clefs 739
hiding 161, 1033
layout names 160
layouts 160
order 1034
parentheses 1034
showing 161, 1033
staff labels 161, 1033, 1034

instrumental parts. See layouts
instrumentation lists 553, 801

page templates 547, 549
instruments 20, 114

adding 96, 98, 113, 120
adding to flows 149
adding to parts 153
adding to percussion kits 139
arranging tools 412

instruments (continued)
assigning to endpoints 484
automatic numbering 115
barline joins. See barline joins
brackets 708, 709
changes. See instrument changes
changing existing 122, 139
changing transposition 122
channels 612–615
chord symbols 291, 714
clefs 96, 122
colors 449, 575, 576
combining into kits 121
comments 432, 434
copying 109
deleting 112, 123
divisi 1047
doubling 47, 120
dynamics 590, 754, 767, 769. See also Dynamics 
editor
empty staves 515
endpoints 479, 484
ensembles 112
expression maps 479, 626
figured bass 363
fretted 124
fretted fingerings 789
groups. See instrument groups
hiding 149, 153
inputting notes 197, 200
key signatures 817, 819
labels 47, 117, 118, 159
language 96, 98, 163
loading 447
MIDI 442, 446, 447
MIDI recording 240
mixer 612–615, 618
moving 123, 147
muting 461, 462, 612
names. See instrument names
non-sustaining 769
numbering 115
order 110, 111, 123, 142, 144
panning 619
part layouts. See layouts
percussion 142, 643, 1126
percussion legends 1128, 1130
percussion maps 479
Play mode 449
playback 460, 461, 471, 472, 474, 476, 479, 484, 
625, 643
players 107
Players panel 94
plucked fingerings 789
ranges 847
removing from kits 144
removing from parts 149, 153
searching 96, 98
showing 149, 153
showing staves 47
soloing 461, 462, 612
staff grouping 709
staff labels 161, 1032, 1034
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instruments (continued)
staff size 528
staves 47, 516, 517, 754, 1041, 1126
strings 124
sustaining 769
swing playback 467
tablature 1048, 1049
templates 66, 98, 101
tracks. See instrument tracks
transposing 119, 155. See also instrument 
transpositions
tuning 96, 124
velocity 587. See also Velocity editor
volume 618, 754
VST 442, 445, 447

intensity
dynamics 287, 290, 398, 590, 746, 751, 752

interactive key commands map 56
interchangeable time signatures 1085

ending 1097
inputting 258, 260, 262, 263

interface 27
interspersion

accidentals 657
intervals

accidentals 233, 312, 875
adding 226, 232, 234
auto-save 91
chord symbols 295, 714
dips 908
figured bass 780
fretted instruments 124
glissando lines 889
guitar bends. See bend intervals
harmonics 859–861, 863, 866
microtonal 233
note input 200
octave divisions 820
ornaments 867
popover 233
simplifying 780
transposing 235, 424, 425
trills 312, 316, 873–876, 879
vibrato bar dives and returns 899

inversions
chord symbols 291, 454
figured bass 363, 364, 771
playback 454

inverting 1023
articulations 664
beaming 693
colors 52
figured bass 778
fingerings 786
grace note stems 804
slurs 1017, 1022, 1023
ties 1079
tuplets 1110

invisible. See hiding
ionian

chord symbols 296, 720
irrational time signatures. See time signatures

irregular
bars as pick-up bars 1088
time signatures 1085

italics
chord symbols 128
dynamics 746
lyrics 833
player group labels 1036
staff labels 161
text 357

items 187, 387
behind other items 387
changing 398
copying 414
deselecting 394
editing 560
resetting 401
selecting 187, 387–389, 394, 403
settings. See properties

J
jazz

articulations. See jazz articulations
band templates 66, 73
glyphs 624
music font 624
staff grouping 709

jazz articulations 911, 912
appearance 913
bend 911
changing 913
deleting 914
duration 913
inputting 310, 312, 321, 322
length 913
line styles 913
moving 913
ornaments. See jazz ornaments
panel 315, 322
playback 649, 650, 911
popover 312, 321
position 913
smooth 911
types 312, 911, 913

jazz ornaments 911, 912
inputting 312, 316, 317
popover 312
types 312

jeté. See playing techniques
job types 488, 500

page ranges 493, 494
printing 500
selecting 500

joins
barlines 675, 709
beams 690–692, 697, 701
pedal lines 930
staves with barlines 676
stems 697, 701

jump bar 60
aliases 62, 63
Commands 60, 62
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jump bar (continued)
entries 60
Go To 61
showing 61, 62

jumps
hiding 981
inputting 380, 381
playback 464
rehearsal marks 405, 964
repeat 979
showing 981

justification
staves 513, 522, 530, 1046
systems 513, 522, 530, 1046
vertical 513, 530

K
kerning

accidentals 658
figured bass 778

key clicks. See playing techniques
key commands 16, 25, 54, 60

articulations 247
assigning 58, 62
defining 53
finding 57, 60
galley view 47
Key Editor 568
keyboard layouts 59
languages 59
lower zone 41
maps 56
MIDI 58
mouse input 173
muting 461, 462
navigation 34, 404, 405
notehead sets 845
page view 47
panels 41
playback 457
played duration 584
removing 59
resetting 60
searching 56, 57
soloing 461, 462
text formatting 357

Key Editor 564, 566, 596
configurations 572, 609, 610
controls 604, 605, 608
copying 573, 582
deleting notes 583
dynamics. See Dynamics editor
height 570
histogram. See Histogram tool. See also Transform 
tool
inputting notes 577
instruments 568
key commands 41, 568, 570
locking 568
MIDI CC. See MIDI CC editor
moving notes 579
note duration 577, 578, 580, 584

Key Editor (continued)
panel 564, 566
percussion. See percussion editor
piano roll. See piano roll editor
pitch bends. See MIDI Pitch Bend editor
playing techniques. See Playing Techniques editor
rhythmic grid 566, 571
scrolling 564, 571
selecting 572
selecting velocity bars 609
slurred notes 1028
tempo 601
toolbar 566
Transform tool. See Transform tool. See also 
Histogram tool
transposing notes 581, 582
tuplets 575
velocity. See Velocity editor
voices 460, 566, 568
zoom 564, 570

key signatures 815, 820
accidentals 655, 816
atonal 817
barlines 674, 818
cautionary 818
changes 674, 816, 818
changing 255, 257, 398
clefs 818
deleting 412
enharmonic equivalent 819
filter 393
hiding 96, 122, 253, 255, 257, 815, 817
inputting 253–255, 257
instruments without 96, 122, 815, 819
major 817
minor 817
moving 417, 421
multiple 815
none 817
octave divisions 820
open 817
panel 254, 257
placement 818
polytonality 255, 257, 815
popover 253, 255
position 255, 818
scales 817
selecting 387, 390, 392, 393
signposts 255, 257, 407, 815
start repeat barlines 674
tonality systems 820
transposing 424, 425
transposing instruments 155, 819
types 253, 817

Key Signatures, Tonality Systems, and Accidentals 
panel 254, 257
key switches 638

expression maps 625, 631
percussion maps 643

Keyboard panel 183
key commands 41

keyboard shortcuts. See key commands
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keyboards
inputting notes 196
key command maps 56
layouts 59

keys
major 817
minor 817
signatures. See key signatures
transposing 424, 425

kick drum. See unpitched percussion
kits. See percussion kits
kneed beams. See centered beams

L
l.v. ties. See laissez vibrer ties
labels

brackets 1036
instrument changes 117, 118
instruments 161, 1029
markers 967
percussion kits 1037, 1126
player groups 1036
staves. See staff labels

laissez vibrer ties 937, 1074, 1081
width 1081

landscape orientation 503, 504, 510
lanes. See editors. See also tracks
languages

application 48
ensembles 98
instruments 96, 98, 118, 161, 163
key commands 25, 56, 59

large
noteheads 844
selections 389
time signatures. See large time signatures

large time signatures 1089, 1091
bar numbers 684

largo. See tempo marks
latency

changing value 244
MIDI recording 240, 244

lattice arrangement
accidentals 657

layers. See voices
layout cards 101, 105

disclosure arrows 40
numbers 101. See also layout numbers
opening 101

layout names 158, 160
accidentals 160
changing 160
first pages 549
resetting 160
tokens 553

layout numbers 101
changing 156
order 156

layout options 622
bar numbers 677–679, 681
copying to other layouts 544
dialog 622

layout options (continued)
saving as default 622
searching 622

Layout Options dialog 622
layout selector 29

order of layouts 156
switching layouts 40

layouts 23, 101, 105, 151, 543
accidentals 428, 431
adding flows 154
adding players 153
bar numbers 677, 679, 680
blank staves 517
braces 708, 709, 711. See also staff grouping
brackets 708, 709, 711. See also staff grouping
cards. See layout cards
casting off 535, 536
chord symbols 716
clefs 301, 739, 740
color mode 496
comparing 45
concert pitch 155, 553, 801
condensing 543
copies 491
copying formatting 544, 545
copying properties 547
creating 153, 157
cues. See cues
custom scores 151
deleting 157
divisi 1047
empty staves 515, 517
enharmonic spelling 428, 431
exporting 495, 500
exporting audio 86
exporting MIDI 82
figured bass 772
file names 498
fingering 787
fit to paper 504
fixing 535, 536
flow headings 521, 550
flow ranges 493, 494
flows 105, 154, 519, 520
formatting 508, 544
frame breaks 539
frame chains. See music frame chains
front matter 801
full scores 151
graphics files 495, 505
harp pedaling 920
hiding staves 515–517
image resolution 496
indents 1046
instrument change labels 1035
justification 513, 522, 530
keyboard 56, 59
large time signatures 1089, 1091
Layouts panel 101
left pages 519
locking 535, 536
margins 511, 524, 526
markers 967, 968
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layouts (continued)
multi-bar rests 679, 1015
multiple windows 46
MusicXML files 79
naming 160. See also layout names
navigation 402–405
note spacing 533
note spelling 428, 431
numbered bar regions 993
numbers. See layout numbers
opening 31, 40
opening multiple 42, 45
orchestral order 110, 111, 144, 1036
order 156
orientation 503, 504, 510
page numbers 915
page ranges 493, 494, 500
page size 503, 510
page template sets 511, 548
page templates. See page templates
page turns 539
panel in Print mode 487
panel in Setup mode 101, 151
paper sizes 503
parts 151, 153, 544
percussion kit presentation 1127
percussion legends 1128
player order 110, 111, 144, 1036
players 105, 153
printing 491, 500, 504
propagating parts 544, 545
properties 547, 560–562
rehearsal marks 963, 1045
removing flows 154
removing players 153
renumbering 156
restoring 157
running headers 521
scale size 504
selecting 29
settings 622
sorting 156
staff labels 554, 1030
staff size 512
staff spacing 513, 530
staves 515–517
switching 40
system dividers 1042, 1043
system formatting 513, 522, 530, 537, 544
system objects 1044, 1045
tabs 31, 42
tacets 541–543
text 355, 549, 1065, 1073
time signatures 1089, 1091, 1097
timecodes 968, 972, 973
titles 547, 549, 550
tokens 553, 554, 801
transposing 119, 151, 155, 553, 801
vertical justification 513
view types 38
zoom 406

Layouts panel
Print mode 486, 487
Setup mode 93, 101

lead sheets
bars per system 535
capo chord symbols 133–136
chord diagrams grid 731, 732
chord symbols 713
project template 73
systems per frame 536

learning materials 64
left hand hooks. See lines
left pages

starting from 519
left zone 35, 36

hiding 41
Print mode 487
Setup mode 94
showing 41
Write mode 177

left-foot pedals. See harp pedaling. See also pedal lines
left-hand fingering 789

hammer-ons. See hammer-ons
inputting 249, 252
placement 784
popover 252
position 791
pull-offs. See hammer-ons
size 789
slides 792, 793
tapping. See tapping

left-hand guitar tapping. See tapping
legato

note durations 236
playback 633, 1028
playing technique. See playing techniques. See also 
playback techniques
slurs 1016, 1028

legends
percussion. See percussion legends

leggiero. See dynamic modifiers
length 396

arpeggio signs 318, 319, 886
audio 87
bar repeat phrases 398, 986
barlines 675, 676
bars 409, 667
chord symbol parentheses 725
continuation lines 939, 940, 943
divisi passages 417, 421
dynamics 396, 592
figured bass 774–776, 779
hairpins 750, 761
hold lines 774–776, 779
instrument names 118, 161, 1030
jazz articulations 913
laissez vibrer ties 1081
lines 353, 354, 396, 939–941, 943, 953–955
lyric extender lines 835
lyric hyphens 835
messa di voce 761
notated duration of notes 584
notes 236, 578, 580, 584
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length (continued)
octave lines 396
pedal lines 927, 930
percussion legends 1130
played duration of notes 584
player group names 146
player names 159
playing techniques 939, 940, 943
repeat endings 976
reverb tail 87
slurs 1017, 1024
staff labels 1030, 1032
stemlets 704
stems 694, 858
string indicators 939, 940
system dividers 1044
systems 522
tempo marks 1056
tuplet brackets 1109

lentando. See gradual tempo changes. See also tempo 
marks
lento. See tempo marks
let ring. See laissez vibrer ties
letter paper sizes 503
letters

rehearsal marks 965
levels

channels 612, 613, 618
dynamics. See dynamic levels
nested tuplets 1104
pedal lines 926. See also pedal level changes

libraries 622
fretted instrument tunings 127
percussion 643
project templates 73
sound 442, 445, 459, 471, 625, 626, 643

libretto
exporting 826
librettist 70, 555

lifts
jazz articulations. See jazz articulations
pedal lines. See pedal retakes

ligado. See hammer-ons
light swing. See swing playback
light theme 49
Limiter 616, 620
limits 605, 606, 608

histogram controls 605, 606, 608
Lin One Dither 616, 620
line breaks

staff labels 161, 1034
text 355

line spacing. See staff size. See also staff spacing
linear points 598, 601

inputting 591, 597, 602
lines 889, 937, 940, 946, 948

accidentals 955
alignment 955
angled 353, 946, 952
annotations 948
appearance 956, 957
arpeggio signs. See arpeggio signs
attachments 353, 946, 949

lines (continued)
bar numbers 681, 682
barlines. See barlines
beams. See beaming
brackets 707, 710, 712, 1036
caesuras. See caesuras
caps 948, 957
changing 956, 957
chords 210, 318–320, 353, 354
colors 52
columns 950
components 948
cross-staff 354
deleting 412
diagonal 353
drawing 602
duration 953, 954
dynamics 590, 591, 594
enclosures 678
end position 955
ends 948
figured bass. See figured bass
fingerings 795
glissando. See glissando lines
grace notes 807, 951
groups 1036
guitar bends. See guitar bends. See also vibrato bar
harp pedaling 918, 923
hiding 396, 775, 942
holds. See hold lines
horizontal 353, 946, 949, 950
horizontal text 961
inputting 352–354
Insert mode 410, 411
jazz articulations 911, 913
joining notes. See beams
length 953–955
lyrics 360–362, 821, 835. See also lyric extender 
lines
markers 968
MIDI 596, 597, 600
moving 417, 421, 950, 951
noteheads 841, 955, 1116
notes. See stems. See also beaming
octave lines. See octave lines
order 950
pauses. See caesuras. See also pauses
pedal. See pedal lines
placement 950–952
playback. See playhead
player groups. See player group labels
playing techniques. See playing technique lines
position 949
repeat endings. See repeat endings
reversing 957
secondary beams 702
secondary brackets 710, 712
showing 396, 775, 942
size 953
slurs 1016
staff-relative placement 951, 952
start position 955
staves 1040
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lines (continued)
stemlets. See stemlets
stop position 410, 411
string indicators 349, 350, 396
string shift indicators 796
system breaks 948
system dividers. See system dividers
tablature 1048
tempo marks 450, 601, 1062, 1063
text 948, 958–961, 1071
through noteheads 841, 1116
ties 1076, 1077
timecodes 968
trills 871, 872
tuplet brackets. See tuplet brackets
types 946, 949
velocity 588
vertical 354, 946, 949
vertical position 949, 951
vibrato bar. See vibrato bar
width 522
wiggly 871, 883

linking 767
dynamics 417, 767–769
flow names 164
flow titles 164
groups of dynamics 765, 766
Key Editor 568
MIDI 417, 600
percussion maps to VST/MIDI 485
slurs 417, 1027, 1028
staves. See brackets. See also braces
tracks 568

lists
comments 434
Hub 64
players 158, 553

little finger. See pinky finger
loading

MIDI instruments 447
playback templates 476
sounds 447, 476
video files 168
VST instruments 447

local
chord symbols 291, 713
figured bass 363, 771
properties 547, 560–562

locations
backups folder 92

lock
duration. See lock to duration
Key Editor 568

lock to duration 173, 427
loco. See octave lines
locrian

chord symbols 296, 720
lower case

flow titles 555
Roman numerals 555

lower limits. See limits

lower notes
percussion 213, 1116, 1119
trills 881

lower zone 28, 35, 182
hiding 41
key commands 41
Key Editor. See Key Editor
Mixer panel. See Mixer panel
Play mode 564, 612
Properties panel. See Properties panel
Setup mode 104
showing 41
Write mode 560, 564, 612

lute. See fretted instruments
lv ties. See laissez vibrer ties
lydian

chord symbols 296, 720
lyric extender lines 360–362, 821, 823, 835

extending 360
inputting 360, 362

lyric hyphens 823, 835
extending 360
inputting 360

lyric lines 361, 821, 835
adding 360, 361
changing 822, 836, 837
copying 824
deleting 412
navigation 362
numbers 835–837
placement 828
position 828

lyricist 70
first pages 549, 801
tokens 555

lyrics 821, 1066
alignment 827, 828
beaming 691
changing 822, 831–833, 836
chorus 361, 821, 822, 836
colors 52
copying 824
counts 832
deleting 412
East Asian elision slurs 838
editing 831–833
elision slurs 360, 362, 838
exporting 826
extender lines. See lyric extender lines
filters 393, 826, 827
font styles 833, 834
gaps 827
hyphens. See lyric hyphens
inputting 360, 362
italics 833
lines. See lyric lines. See also lyric extender lines
melismatic 360, 362, 827, 835
moving 417, 421, 828, 830, 836, 837
note spacing 533, 827, 828
paragraph styles 834
placement 827
popover 360–362
position 827
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lyrics (continued)
printing 826
saving 826
selecting 388, 393, 827
size 833, 834
spacing 533, 827, 828, 833, 834
staff-relative placement 830
syllable types 362, 823
text 831–833
translations 361, 821, 822, 836
types 361, 821, 823
verse numbers 837
vertical position 821, 822, 830, 835–837
zoom 832

M
macOS

printing 494
main chord symbols 128, 133, 134, 136

transposing 132
major

chord symbols 294, 295
intervals 233, 424, 425, 427
keys 817
scales 817

mandolin. See fretted instruments
manual staff visibility 516, 517
manuscript paper 517
maps

expression. See expression maps
key commands 56
percussion. See percussion maps

marcato. See articulations
margins 524

changing 511
chord diagrams 731
flow headings 525
hiding 402
instrument names. See staff labels
music frames 524, 526
MusicXML files 77
pages 508, 511, 524
staves 522, 524, 526, 1030, 1031, 1046
tacets 543

mark-up. See comments. See also annotations
markers 967, 971

colors 52
comments. See comments
deleting 370, 412
dialog 369
exporting 82, 87
filter 393
flags. See signposts
hiding 967, 981
important 371, 970
importing 84
inputting 369, 451
moving 417, 969
panel 370
repeats 373, 374, 979
showing 967, 981
signposts. See signposts

markers (continued)
staff 968
staff spacing 513, 530
text 84, 369, 370, 969
timecodes 369, 969
track 451, 454
vertical position 513, 530, 968

marks
rehearsal. See rehearsal marks
tempo. See tempo marks
trills 867, 868, 870, 879

marquee tool 37
Key Editor 572
using 389, 572, 609

martelé. See articulations
masking. See hiding
master output volume 612–615, 618
master pages. See page templates
matches

options search 53, 622
Maximizer 616, 620
measured tremolos. See tremolos
measurement

units 48
measures. See bars
medium swing. See swing playback
melismatic lyrics 360, 362, 827, 835
melodic minor. See scales. See also key signatures
meno. See tempo marks. See also dynamic modifiers
merging

flows 74, 519
notes 226, 228, 543
pedal lines 930
players 74, 77
projects 74
staves 543
voices 543

messa di voce 761
gaps 761
grace notes 762
handles 761, 762
inputting 284, 286, 287, 290, 763
length 761
moving 417, 747, 761, 762
showing 763
ties 287, 290, 417

meter 1084
beam grouping 689, 705
changing 398
channel levels 612, 613
irregular 667, 670
note grouping 689, 705
open 1085, 1091, 1093
rest grouping 689, 705
time signatures. See time signatures
tremolos 1099
tuplets 1104

metric modulation
tuplets 1106

metronome marks 1052, 1058
appearance 1054, 1055
beat units 269, 398, 1058, 1059
brackets 1054, 1055
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metronome marks (continued)
changing 398, 603, 1059, 1060
click 450
components 1054, 1055
decimal places 273, 274, 1059
equations 271, 1064
hiding 1058
inputting 268, 273, 274, 602
moving 417, 1061
multiple positions 1044
order 1061
parentheses 1054, 1055
playback 450, 468, 1060
popover 268
range 1060
relative tempo changes 1060
selecting 388
showing 1053, 1058
values 398, 603, 1059
vertical positions 1044

mezzo
dynamics. See dynamics

microtones 659
EDO 820
guitar bends 326, 897, 900
intervals 233, 234
transposing 235
trills 874–876

mid-system gaps
codas 979, 982

middle C
clefs 738
expression maps 631
fretted instruments 124
percussion maps 643
playback 631, 643

middle line
stem direction 854

MIDI
accidental spelling 220
channels 442, 479, 612–615
commands 54, 58
controllers. See MIDI controllers
copying 417, 573, 600
deleting 574
devices. See MIDI devices
dialog 81, 82
editor. See MIDI CC editor. See also MIDI Pitch 
Bend editor
endpoints 479, 481, 482, 484
exporting 85
expression maps 625, 626, 639, 640
fader 613
files. See MIDI files
Histogram tool 604, 606
importing 80, 81
inputting 597, 600
instruments 442, 446, 449. See also MIDI 
instruments
Key Editor 596
linking 417
loading instruments 447
markers 451

MIDI (continued)
mixer 612–615
navigation 58
note input 196, 210, 220
note range 114
opening 67
order 631
overlapping notes 236
overriding 600
pan 613, 614, 619
pedal lines 936
percussion maps 485, 643, 646
piano roll editor 575
pitch bend 596
playback 449, 479, 643
ports 442, 479
quantization 81
range 114
recording. See MIDI recording
slurs 1028
tempo 450, 458, 601
Tempo editor 601
tempo track 450
tempo tracks 83–85
thru 240
unlinking 417
values 599, 604, 605, 608
volume 769

MIDI CC editor 595, 596
adding 572, 596
closing 572, 596
constant points 598
copying points 573
deleting points 574
filter 606
height 570
Histogram controls 605
inputting points 597
linear points 598
moving points 599
pedal lines 936
selecting points 572
Transform controls 608
transformations. See Transform tool. See also 
Histogram tool
values 599, 604, 606, 608, 609
zoom 570

MIDI channels 612–615
MIDI controllers 596, 769

copying 417, 573, 600
dynamics 769
editor. See MIDI CC editor. See also MIDI Pitch 
Bend editor
inputting 572, 597, 600
pedal lines 936
Transform tool 608
transformations. See Transform tool. See also 
Histogram tool
values 599, 604–606, 608, 609

MIDI devices 246
activity 36
chord symbols 291, 442, 452, 453
disabling 246
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MIDI devices (continued)
enabling 246
expression maps 625, 639, 640
note input setup 215
percussion kits 215
percussion maps 643, 646
playback templates 471, 472
polychords 291
warning 36

MIDI files 80
dialog 82
exporting 82
grace notes 81
importing 80
opening 67
pedal lines 80, 245
playback overrides 585
quantization 80, 81
repeats 463
requantizing 243
sustain pedal controllers 245
tuplets 81

MIDI instruments 442, 446
endpoints 481, 482
instances 446
loading 447
numbering 446
panel 445

MIDI Pitch Bend editor 595, 596
adding 572
closing 572
copying points 573
deleting points 574
height 570
moving points 599
selecting points 572
transformations. See Transform tool. See also 
Histogram tool
values 599, 606, 609
zoom 570

MIDI points
copying 417
linking 417
unlinking 417

MIDI Quantize Options dialog 81
MIDI recording 240, 241

audio buffer size 244, 245
click settings 450
devices 246. See also MIDI devices
dialog 81
grace notes 81, 805
input pitch 203
latency 244
optimization 244
overlapping notes 236
pedal lines 244, 245
pitch 203
quantization 81, 241
repeats 243
requantizing 243
retrospective recording 242
setup 244
slurs 244

MIDI recording (continued)
starting 241
stopping 241
sustain pedal controllers 245
tempo mode 458
time signatures 241
transport window 468
tremolos 244
trills 244
voices 240, 241

MIDI thru 240
millimeters

unit of measurement 48
milliseconds 30, 468
mini transport 28, 30
minims. See half notes
minor

chord symbols 294, 295
intervals 233, 424, 425, 427
keys 817
scales 817

minutes 30, 468, 971
duration tokens 555

Missing Fonts dialog 69
missing sounds

loading 476
mixer 612, 613

channel strips 616
channels 612–615, 617
filters 616, 617
height 618
hiding 612–614
hiding audio outputs 479
muting tracks 461, 462, 612, 613
panning 614, 619
ports 612, 613
resetting 462, 612, 618
scrolling 617
showing 612–614
soloing tracks 461, 462, 612, 613
soundtracks 170
videos 170
volume 618

Mixer panel 612
key commands 41

mixolydian
chord symbols 296, 720

mock-ups
exporting 86

modal
chord symbols 296, 720

moderato. See tempo marks
modes 18, 28

chords 191, 720
Engrave 547
Insert 191, 212, 228, 408
jump bar 60–62
Play 439
Print 486
Setup 93
tempo 458
Write 172
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modifier keys
key commands 56
searching 56

modifiers. See dynamic modifiers
modulation wheel dynamics 769
molto

centered 756
dynamics 284, 286, 754, 756
marcato. See articulations
tempo marks 268, 271

monochrome graphics 506
MonoDelay 616, 620
monophony. See polyphony
MonoToStereo 616, 620
moon noteheads 844, 845
mordents. See ornaments
morendo. See gradual tempo changes. See also 
dynamic modifiers
MorphFilter 616, 620
mosso. See tempo marks
motors. See playing techniques
mouse input 187

activating 173, 205
deactivating 173, 205
settings 188, 189

movements 19, 148
adding 148
exporting 75, 76
flow headings 550
importing 74
multiple on pages 519
splitting 432
tacets 541

movies. See videos
moving 402, 417, 421

accents 664
arpeggio signs 886
articulations 664, 665
bar numbers 681, 682
bar rests 1012
barlines 412
bars 537, 539
braces 708, 709
brackets 708, 709, 724
breath marks 812
caesuras 812
caret 196, 229
channels 617, 618
chord diagrams 732
chord symbols 717, 724
clefs 417, 421, 739
counts 983, 996, 1005
cursor 249, 298, 362, 367
dynamics 417, 592, 747, 756, 762, 765–769
fermatas 812, 814
figured bass 774, 779
fingerings 732, 791
flow headings 525
flows 150, 539
frame breaks 536
frames 524, 525
grace notes 805, 806
gradual dynamics 417, 747

moving (continued)
hairpins 417, 747, 761, 762
hammer-ons 909
instruments 117, 123, 147
jazz articulations 913
Key Editor 571
layouts 156
lines 950, 951
lyrics 828, 830, 836, 837
marcato 664
markers 969
messa di voce 417, 761, 762
MIDI points 599
navigating. See navigation
notes 417, 422, 424, 533, 579, 581, 582, 1137
notes to other staves 421, 581, 582, 697, 701, 1124
notes to other strings 1050
numbered bar region counts 996
ornaments 868
pages 405
panning 619
parentheses 724
pedal lines 927
piano roll 571
players 110, 111, 147
playhead 405, 456
playing techniques 939
pull-offs 909
repeat counts 983
resolutions 779
rests 533, 1012
rhythm dots 1137
rhythm slashes 1000
selection. See navigation
slash region counts 1005
slurs 1024
staccato 664
staves 110, 111, 512, 513, 524, 526
stop positions 410
stress marks 664
string indicators 799, 939
subito 756
system breaks 536, 537
systems 537, 539
tablature notes 1050
tabs 45
tacets 543
tapping 909
tempo marks 603
tenuto 664
text 1070
text on lines 959–961
time signatures 1095
tremolos 1102
tuplets 421, 1113
vibrato bar 939
view 404, 405, 571, 617

mp. See dynamics
MP3 files

exporting 86, 87
muffed notes. See dead notes
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multi-bar rests 541, 985, 1014, 1015
bar numbers 679
barlines 281
hiding 1015
showing 1015
signposts 407
single bars 1015
tacets 541, 542

multi-note tremolos. See tremolos
multi-pasting 415, 416
multi-rests. See multi-bar rests
multi-staff instruments 1041

cross-staff beams 697, 699, 701
hiding staves 515–517, 530
slurs 248

multiple
bar numbers per system 681
bounce roll. See tremolos
codas 980
flows on pages 519
movements 148
segnos 980
staff input 195, 210

multiple-voice contexts 1134
articulations 662
dynamics 400, 754
fermatas 811, 813
grace notes 804, 1017
guitar pre-bends 901
inputting notes 207
note alignment 1136
notes 1138
ornaments 400, 868
rests 1008, 1010
slashes 999, 1000
slurs 1017
stem direction 804, 855, 1138
ties 1078
voice column index 1137

music
arranging. See arranging
condensing. See condensing
deleting 112, 123, 151, 409, 412, 667–669
editing 187
extracts. See flows

music area 32
making selections 389
moving music 404, 405
multiple windows 46
navigation. See navigation
opening flows 441
opening layouts 31, 40, 44
page arrangements 39, 47
panels 41
Play mode. See track overview
view options 38, 39, 47
zoom options 39, 406

music fonts 64
Music Fonts dialog 624
music frame chains 559

propagating part formatting 544

music frames 551
frame chains. See music frame chains
margins 524, 526
padding 524, 526
vertical justification 530

music symbols
inputting 355, 358, 554
text 355, 358, 554
tokens 554

MusicXML
chord symbols 726
dialog 79
exporting 79
importing 77
opening 67
pedal lines 936
percussion 78
repeat endings 978
resetting beaming 692
staff labels 1030

muted
colors 463
notes. See dead notes

mutes. See playing techniques
muting

channels 461, 614, 620
colors 463
deactivating 462, 612, 613
effects 620
inserts 620
instruments 461
items 463
notes 394, 463
slash notes 422, 1005
tracks 461, 612, 613
voices 461

mutual exclusion groups 634
editing 641

N
names

drum sets 136
flow headings 550
flows 164, 165
groups 141
instruments. See instrument names
layouts 158, 160
mixer 614
noteheads 844
percussion kits 136, 141
player groups 144, 146, 1036
players 158, 159, 161, 553, 1032
staff labels. See staff labels. See also instrument 
names
tokens 552

naming schemes
file names 498

narrow time signatures 1097
Nashville

chord symbols 294
numbers 293
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natural harmonics 859
appearance 863, 865
hiding 860
showing 860

natural minor. See scales. See also key signatures
naturale. See playing techniques
naturals

hiding 656, 862
inputting 219
parentheses 656, 862
showing 656, 862

navigation 60, 402, 403
bars 405
caret 196
chord symbols popover 298
figured bass popover 367
fingerings popover 249
flows 404
items 403
jump bar 60, 61
Key Editor 570, 571
layouts 40, 44
lyrics popover 362
mixer 617
music area 403
note input 197, 200, 217
notes 403
pages 404, 405
part layouts 40, 44, 441
percussion editor 570, 571
piano roll 570, 571
print preview area 34, 486
rehearsal marks 405
rhythmic grid 190
strings 124
Write mode 403

nested
slurs 1019, 1024, 1025
tuplets 1104, 1105

new projects 66
niente 763

circle 763, 765
deleting 764
inputting 284, 286, 287, 290, 764
moving 747
styles 765
text 763, 765

no chord symbols 296
nodes 859

changing 861
non-arpeggio signs. See arpeggio signs
non-drop frame timecodes 971
non-power of two time signatures. See time signatures
non-sustaining instruments 769

velocity 587. See also Velocity editor
non-transposing layouts 155
nonuplets. See tuplets
notated duration 584

played duration 584
requantizing 243
tool 566

notation reference 654

notation staves 1048
hiding 1049
showing 1049

notations
appearance 560
changing 398
copying 414–416
editing 560
inputting 21, 246
panels 172
percussion kits 1124
popovers 21
position 560
properties 560
selecting 388, 389
settings 622
zoom options 39, 406

Notations toolbox 178
notches

pedal lines. See pedal retakes
slurs 1020
ties 1076

note and rest colors 52, 847, 1011
changing 51, 52
exporting 495, 507
hiding 402, 463, 847, 1135
inverting 52
muted 463
notehead sets 844
notes out of range 51, 847, 1048
printing 491, 507
rests 1011
tablature 1048
voices 51, 1135

note brackets. See bracketed noteheads
note durations 13, 177, 235, 584

changing 236, 580
chords 226
different 207
expression maps 626, 640
forcing 238
hiding 177
inputting 197, 200, 235, 236, 238
inputting beats 276
Key Editor 578, 580
metronome marks 269
notated 584
percussion 213, 578, 580
playback 633
played 584
quantization 81
selecting 235, 238
showing 177
splitting 238
tablature 217
tempo equations 270
tuplets 229, 232
voices 207

note event actions. See key switches
note grouping 21, 705

beaming 689–692, 705
changing 238
hemiola 238
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note grouping (continued)
meter 689, 705
note input 21, 22
pick-up bars 1088
rests 21
ties 223
time signatures 22

note input 196, 197, 200, 577
adding notes 232, 234
caret 191, 196
chords 191, 226
Drum Pads panel 186
Fretboard panel 185
fretted instruments 185
grace notes 225
input pitch 203
inputting vs. editing 187
Insert mode 191
Keyboard panel 183
lock to duration 427
MIDI 240–242, 244
mouse input 205
multiple staves 195, 210
muting notes 394
percussion 213, 215, 217, 578
piano keyboard 183
pitch 203
playing notes back 394
register selection 200
repitching notes 427
rests 1009
retrospective recording 242
rhythmic grid 190
starting 195
stem direction 217
strings 185
tablature 200, 217
ties 223
tuplets 229
voices 207

note names
chord symbols 294–296
harp pedaling 918, 919, 923
noteheads 844

note spacing 533, 584, 699, 1012, 1136
changing 533, 1012, 1137
chord symbols 717
copying to other layouts 544
cross-staff beams 699
default 533
galley view 38
grace notes 804
justification 522
layout options 533, 622
layouts 533
lyrics 533, 827, 828
rests 1012
rhythm dots 1137
signposts 407
stems 699
systems 522
voices 1137

note spelling 428, 429
adding notes 234
automatic 429
layouts 431
resetting 431
transposing 235

note tools popover 233
adding notes 232
transposing notes 427

note values. See note durations
note velocities

MIDI import 244
notehead sets 840, 841, 844

colors 844
designs 841, 844
pitch-dependent 844
scale degree 844
types 840

notehead-attached lines. See lines
noteheads 841

aikin 844
arrows 843
articulations 664, 665
brackets. See bracketed noteheads
changing 845
circular 841
colors 52, 844
crosses 842
cues. See cues
designs 841, 844, 845. See also notehead sets
diamond 842, 843, 860, 863
dotted 844
fermatas 812
five-line staff 1118
funk 844
harmonics 860, 863
large 844
lines 955
moon 844
muted 844
note names 844
parentheses. See bracketed noteheads
percussion 213, 578, 582, 1116, 1118, 1119, 1121
pitch-dependent 844
playing techniques 582, 1116, 1118–1120
rectangular 844
sets. See notehead sets
shapes 841, 844. See also notehead sets
size 399, 745, 841
slashes 844, 997, 1005, 1116
square 844
time signatures 1093
triangular 843
types 841
unpitched percussion 1116, 1118
walker 844
wedges 843

notes 21, 840
above staves 232, 424, 697, 713, 742, 1042
accidentals 177, 219, 655
adding to existing notes 232
alignment 749
appearance 560
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notes (continued)
arpeggio signs. See arpeggio signs
articulations 177, 663, 664
auditioning 394, 395
auxiliary 878
beaming 689, 690
below staves 232, 424, 697, 713, 742, 1042
brackets. See bracketed noteheads
brass fingerings 794
changing pitch 424, 427
chord symbol alignment 717
chords 226, 228
colors 51, 52, 463, 844, 847, 1135
condensing. See condensing
copying 414–416, 582
crossing to other staves 421, 697, 701
cues. See cues
custom scale size 399
dead notes 908
deleting 409, 412, 583, 667, 1102
deselecting 394
dotted 205, 689, 705
durations 177, 235, 236, 238, 578, 580, 584
dynamics 284, 587, 590, 746. See also Dynamics 
editor
dynamics alignment 748, 749
editing 173, 560
editorial. See bracketed noteheads. See also 
comments
enharmonic spelling 428, 429, 431
filters 393
fixing duration 238
fonts 624
ghost notes 850
glissando lines. See glissando lines
grace notes 225, 803, 805
grouping 689, 705
guitar bends 324, 325, 894
guitar post-bends 326, 897
guitar pre-bends 325, 896
harmonics. See harmonics
harp pedaling 918, 919
hiding 1000
horizontal spacing. See note spacing
horn branch indicators 794
inputting 196, 197, 200, 204, 205, 212, 213, 226, 
238, 577, 578
Insert mode 212, 408
jazz articulations. See jazz articulations
Key Editor 564, 575
laissez vibrer ties 1081
length 236, 578, 580
lines. See lines. See also glissando lines
lock to duration 427
lyric alignment 828
moving 1116, 1119, 1137
moving graphically. See note spacing
moving rhythmically 417, 579
moving to other instruments 582, 1124
moving to other staves 421, 582, 697, 701
moving to other strings 1050
multiple-voice contexts 1138
muting 461, 463, 908, 937

notes (continued)
navigation 403
notated duration 22, 584
note spacing 533
notehead designs 841
notehead sets 840
order 1137
out of range 51, 847, 1050
overlapping 236, 1137
overrides 584, 585
parentheses 849, 850
partials 859
pedal lines 927
percussion editor 572, 576–580, 582
percussion kits 213, 578, 1116, 1121, 1122, 1126, 
1131, 1132
percussion maps 643
piano roll editor 564, 572, 575, 577, 579–581
pitch 424, 427
pitch-dependent noteheads 844
Play mode 577
playback 457, 460, 461, 463, 625
played duration 584, 585
popover 233
properties 560
ranges 51, 847
register 200, 424, 427
removing stem direction changes 858
repitching 427
requantizing 243
resetting 585
rests 1009
retakes 927
rhythm dots 205, 1137
rhythm slashes 1006
rhythmic grid 190
rolls. See tremolos
scale size 399
secondary beams 701
selecting 387–389, 394, 403, 572
showing 1000
size 399, 745
slash regions 1000
slashes 997, 1005
slurs 177, 1018
spacing. See note spacing
speed 235, 236, 238, 704, 1052
spelling 428, 429, 431
splitting 173, 238, 1083
staff spacing 513
stem direction 422, 854, 856, 857, 1132
stem length 858
stemlets 704
stems. See stems
string fingerings 795, 796, 846
string indicators. See string indicators
strings 1050
tablature 1050
terminology 13
ties 22, 223, 664, 1080
time signatures 1093
transposing 235, 423–425, 427, 581
tremolos. See tremolos
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notes (continued)
trill intervals 875, 876
trills 870
tuplets 1104, 1106
types 177
unbeaming 691
undamped 1081
unscaling 806, 1106
velocity 587. See also Velocity editor
voices 207, 422, 423

Notes panel 172, 177
Notes toolbox 173
November music font 624
numbered bar regions 679, 992

changing number 994
counts 993, 994
font style 993
frequency 994
handles 396, 992
hiding 993
highlights 987
inputting 386
length 396
moving 417
panel 376
parentheses 994
placement 996
popover 375
showing 993
staff-relative placement 996
systems 993

numbers
backups 91
bar repeats 987, 988
barlines 464
bars. See bar numbers
bars per system 535
beam lines 702
chord diagrams 732, 733, 735, 736
condensing 1038
figured bass. See figured bass
flows. See flow numbers
frets. See frets. See also tablature
instruments 111, 115, 1034
layouts 156
lyric lines 835–837
multi-bar rests 1014
numbered bar regions 992–994
pages 915
plug-in instances 442, 445, 446
rehearsal marks 964, 965
repeats 464
rhythm slashes 1003
slash region counts 1003
staff labels 1034, 1038
staff lines 517, 1126, 1127
staves 515, 1041, 1042
strings. See string indicators
systems per frame 536
tablature. See tablature
time signatures 1092
tuplets 1112

numbers (continued)
value fields 562
verses 837

numerators
styles 1091, 1092
time signatures 1084

numeric value fields 562
nut

chord diagrams 728
fretted instruments 124
tablature 128, 129, 1048

O
oboe. See instruments
octatonic

chord symbols 296
octave divisions 820

EDO 820
transposing 424, 425

octave lines 742
alignment 743
deleting 412
filter 393
inputting 299, 301, 302, 304, 305
length 396
moving 417, 421
panel 305
popover 300, 301, 304
position 743
selecting 388
size 399
staff-relative placement 400
types 301, 742

octave transpositions 424, 425
clefs 300, 301, 740, 741
figured bass 780
octave lines 301, 742

Octaver 616, 620
octuplets. See tuplets
odd-numbered layouts

booklets 501
printing 491, 501

offsets 562
bar numbers 681–686
chord symbols 717
fret numbers 735, 736
played duration 584, 585
rehearsal marks 964
resetting 401
rhythm dots 1137
timecodes 167, 972
tuplets 1113
videos 167
voice columns 1137

omissions
chord diagrams 728, 736
chord symbols 295

opacity 407, 496, 506
open

key signatures 817
meter 258, 262, 263, 1085, 1091, 1093
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open (continued)
strings. See open strings
time signatures 258, 262, 263, 1085, 1091, 1093

open strings 859
chord diagrams 728, 736
harmonics 859
pitches 124, 126

opening 67
auto-saved files 90
documentation 64
editors 572, 610
files 67, 90
flows 441
Key Editor 564, 572, 610
layouts 40
MIDI files 67
mixer 612–614
MusicXML files 67
panels 41
projects 66–68, 90
tabs 42, 44
templates 66
transport window 468
video tutorials 64
video window 169
windows 46
zones 41

optical spacing
cross-staff beams 699

optimized staves 513, 515. See also condensing
optional notes. See bracketed noteheads. See also 
parenthesized chord symbols
options 560

items 560
layout 622
notation 560
page sizes 504
preferences 53
properties 560
searching 53, 622
text formatting 357
toolbar 28
transport 28, 30
workspaces 28, 29
zoom 36, 39, 406

orchestral
cues. See cues
order 110, 123, 144, 156, 1036
panning 619
shorthand 98
staff grouping 709, 1036
templates 66, 73, 98

orchestrating. See arranging
order

accidentals 657, 816
actions 631
articulations 663
band 110
chord symbols 722
expression maps 626
flows 70, 150
frame chains 559
instruments 111, 115, 123, 142, 159, 1034

order (continued)
key signatures 816
layouts 156
lines 950
metronome marks 1061
MIDI messages 631
names 123, 159
notes 1137
orchestral 110, 111, 123, 144, 1036
pages 39, 47
players 110, 111, 144, 1036
rehearsal marks 964
repeat markers 980
rhythm dots 1137
score 110, 111, 144, 1036
staff labels 1034
tabs 45
tempo marks 1061
voices 1137

orientation
changing 510
exporting 504
landscape 503, 504
portrait 503, 504
printing 491, 504

ornaments 867
acciaccaturas. See grace notes
accidentals 867, 879
alignment 868
appoggiaturas. See grace notes
changing 398
colors 52
deleting 412
filter 393
inputting 310, 311, 316, 317
intervals 867
jazz 912. See also jazz articulations
length 396
moving 417, 421, 868
panel 315, 317
placement 868
popover 311, 316
position 868
selecting 388
staff-relative placement 400
trills. See trills
types 311

Ornaments panel 317, 319, 320
ossia staves 1042

condensing 1042
moving 417, 421
playback 1042
signposts 407, 1042
staff spacing 513, 530
vertical spacing 513, 529, 530

ottava lines. See octave lines
outputs

audio export 53
mixer 479, 612, 613
plug-ins 479
volume 618

overdubbing
MIDI recording 243
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overlapping
accidentals 657
articulations 664
barlines 749
dynamics 749
notes 228, 236, 407, 532, 1137
slash regions 999
slurs 1020
staves 510, 512, 513, 527, 532
text 407, 532
voices 1137

overline text 357
instrument names 161
staff labels 161

Override Percussion Noteheads dialog 1118
overrides

barlines 281, 282, 407, 674
clefs 301, 739, 740
dynamics 591, 594
endpoints 481
flow headings 550
MIDI points 600
note duration 584, 585
placement 400
playback templates 471, 472, 474, 476, 481, 482
played duration 585
removing 585
transposition 301, 739, 740
velocity 585

overscroll 405
overtones. See partials

P
padding

chord diagrams 731
frames 508
music frames 524, 526
rests. See padding rests
silence 87
time signatures 1095

padding rests 1008
hiding 1001
slash regions 1001

page arrangements 38, 39, 47
page breaks. See frame breaks
page formatting 508

bars per system 535
blank staves 517
casting off 535
divisi 1047
empty staves 515, 517
fixing 535, 536, 544, 545, 547
flow headings 508, 550
formatting 548
left pages 519
multiple flows 519
page size 510
page templates 511, 547–549
staff size 527
staff spacing 513, 529
staves 516, 517
systems 513, 536

page formatting (continued)
tacets 542
text 624
titles 547, 550

page margins 508, 524
changing 511, 526
hiding 402

page numbers 549, 915
count 556
flow headings 521, 916
flows 555
hiding 521, 916
initial 519, 916
numeral style 915
page templates 549
showing 521
tokens 555, 556
total 556

page ranges
exporting 493, 494
flows 493, 494
printing 493, 494
selecting 500

page size 503, 504
changing 510
graphics files 495
layout options 622
MusicXML files 77

page template overrides 1066
page template sets 548

applying 511
flow headings 548, 550
layouts 511

page templates 24, 547, 549
assigning to pages 520
composer 549
copying 547, 549
default 549
first 520, 549
flow headings. See flow headings
page numbers 549, 915
project templates 73
sets. See page template sets
titles 549
types 549

page turns. See frame breaks
page view 38, 47

arrangements 39, 47
flows 432
navigation 404, 405

pages
arrangements 39, 47
background color 50, 52
breaks. See frame breaks
changing view 47
color 50, 52
copying 547, 549
dragging 405
edges. See page margins
exporting 493–495, 500
formatting 801
frames. See frames
fullness 512, 513, 527
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pages (continued)
going to 404
hiding empty staves 516
layouts 508, 535, 536, 547
margins 508, 511, 524–526
multiple flows 519
navigation 404, 405
numbers. See page numbers
orientation 510
page templates 508, 547
printing 493, 494, 500, 504
ranges 500
rectangles. See frames
setup 504
size. See page size
templates 547
tokens 556
total number 556
turns. See frame breaks
view options 36

palettes. See panels
panels 35, 178

accidentals 257
arpeggio signs 315, 319
bar repeats 376
barlines 278, 282
bars 278, 279
clefs 302, 303, 305
drum pads 186
dynamics 286, 290
flows 93, 104
fretboard 185
glissando lines 315, 320
guitar techniques 315, 325, 329, 331, 332, 334
hiding 29, 40, 41
holds 309
jazz articulations 315, 322
Key Editor 564
key signatures 254, 257
keyboard 183
layouts 93, 101, 487
MIDI instruments. See track inspector
mixer 612
notations 181
notes 177
octave lines 305
ornaments 315, 317, 319, 320, 322
pauses 309
pedal lines 340, 346
Play mode 439
players 93, 94
playing techniques 340, 343, 346
Print mode 486
print options 488
properties 560
repeat endings 376
repeat markers 376
rhythm slashes 376
Setup mode 93
showing 29, 40, 41, 182
tempo 271, 274
time signatures 260, 263, 266
tonality systems 257

panels (continued)
tremolos 376, 383
VST instruments. See track inspector
Write mode 172, 177, 181, 560

panning 613, 614, 619
paper

color 50
duplex printing 502
orientation 503, 504
size 503, 504, 510

paradiddle 197, 235, 1104
paragraph styles

bar numbers 680
changing 1070
inputting text 355
lyrics 834
missing fonts 69
player group labels 1036
tacets 541

parallel
lines 689, 701, 811, 889, 940, 1042

parentheses
accidentals 656, 862
bar numbers 688
bar repeats 987, 989
chord symbols. See parenthesized chord symbols
counts 989, 993, 994, 1003, 1004
dynamics 751
figured bass 364, 774, 777
fingerings 249, 251, 788
fret numbers 894, 899
ghost notes. See bracketed noteheads
guitar bends 894, 896
harmonics 862
hiding 724
inputting 291, 297, 363, 364, 656, 723, 751, 774, 
777, 850, 862
instrument transpositions 1034
metronome marks 1054, 1055
noteheads. See bracketed noteheads
numbered bar regions 993, 994
octave line numerals 742
pedal continuation signs 933, 934
percussion notes. See bracketed noteheads
shape 725, 777, 850
showing 724
size 725
slash regions 1003, 1004
staff labels 1034
string shift indicators 846
style 725
tablature 863, 894, 896, 899
tempo marks 1054, 1055
thickness 725
tie chains 851
time signatures 258, 262, 1091, 1094
trills 878
vibrato bar dives and returns 899

parenthesized chord symbols 723, 849
showing 723
single 724
size 725
style 725
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part formatting 544, 545
system formatting 544

part layouts. See layouts
part names 158, 160
partial

beams 702
capos 129–131
harp pedaling 923

partial bars. See pick-up bars
partials 859, 861
parts. See layouts
pasting. See copying
pataflafla. See grace notes. See also sixteenth notes
patches

endpoints 479
playback 479, 625, 643

path
export 75, 79, 82, 85, 86, 497

patterns
chord diagrams 727, 734–736
repeating 414

pauses 809, 811
appearance 398
barlines 814
breath marks. See breath marks
caesuras. See caesuras
changing 813
default settings 811
deleting 412, 1012
duration 398
fermatas 810, 813
filter 393
hiding 1012
inputting 306, 308, 309
linked 813
moving 417, 814
multiple at same position 813
panel 309
playback 809
popover 306, 308
position 811
rests. See rests
selecting 388
single staves 813
staff-relative placement 811
types 306, 809

PDF files 505
color 506
exporting 495, 496
fonts 506
key commands 54
layout numbers 156
layouts 495, 496
page size 495
project preview 70

peaking 618
pedal level changes 926

removing 927
pedal lines 918, 925

alignment 927
appearance 930, 931, 933–936
brackets 933, 934
changing 398

pedal lines (continued)
colors 52
continuation lines 925, 930, 933
dashed 933
deleting 412
duration 936
end signs 932, 933
filter 393
formatting 931–933
grace notes 928
harp pedaling. See harp pedaling
hiding 931–933
hooks 930, 932
inputting 337, 339, 344, 346
length 396, 927, 930
levels. See pedal level changes
lifts 926
merging 930
MIDI controllers 936
MIDI import 80, 245
MIDI recording 244, 245
moving 417, 927
MusicXML import 936
muting in playback 463
notes 927
order 927
panel 340, 346
parentheses 933, 934
percussion 937
playback 936
popover 339, 344
position 927, 928
releases 930
removing retakes 927
retakes. See pedal retakes
signposts 407
splitting 929
staff-relative placement 927
start signs 930, 931, 934
text 934–936
types 339, 925

pedal retakes 926
inputting 339, 344–347
notes 927
removing 927

pedals
harp pedaling. See harp pedaling
piano. See pedal lines

percentages
horizontal spacing 522, 533
note duration 633, 1028
scale size 399, 491, 504, 725, 789
tempo marks 1053, 1060, 1061
vertical spacing 513, 530

percussion
adding 96, 98, 108, 120, 121
articulations 1116
drum sets. See drum sets
groups 144, 1036
instrument changes 117, 120
kits. See percussion kits
laissez vibrer ties 1081
legends. See percussion legends

Index
 

1206
Dorico SE 4.3.30



percussion (continued)
note input 213, 215, 217, 577, 578
noteheads 582, 1116, 1118–1120
part names 158, 160
pitched percussion. See instruments
playing techniques 648
rudiments 197, 235, 803, 1099, 1104
staff labels 1032, 1036, 1037
system objects 1045
tremolos 648, 1116
unpitched percussion. See unpitched percussion

percussion editor 576
copying notes 582
deleting notes 583
height 570
inputting notes 577
moving notes 579, 582
navigation 571
note duration 578, 580, 584
played vs. notated durations 584
playing techniques 576
scrolling 571
selecting notes 572
tools 566
tracks 448
zoom 570

Percussion Instrument Playing Techniques dialog 1116
percussion kits 1115, 1122

adding instruments 139
caret 213
changing instruments 139
creating 121, 139
drum sets. See drum sets
dynamics 1125
editing area 136, 1126
exporting 1123
filtering instruments 136
five-line staff 1040, 1126
gap sizes 143
grids 140–143, 1126
groups 140–142
importing 1123
individual instruments vs. kits 1121
inputting notes 213, 578
instrument order 142
legends 1128
moving notes 1124
naming 136, 140, 141
notations 1124
note input 215, 217, 577
noteheads 582, 1116, 1118, 1119
playing techniques 582, 1115, 1116, 1119
presentation types 136, 1121, 1126, 1127
removing instruments 144
rhythm slashes 1007
setting up 136, 215
single-line instruments 1126
spacing 143
staff labels 136, 140, 141, 1030, 1037, 1126
staff position 142, 215, 1116
staff-relative legend placement 400
staves 136, 1121, 1126, 1127
stem direction 136, 217, 1131, 1132

percussion kits (continued)
stickings 1125
voices 136, 1131, 1132

percussion legends 1128
adding 1128
changing 1129
handles 1130
instrument names 1130
layouts 1128
length 1130
position 1128
ranges 1128, 1130
signposts 407, 1128
sounding instruments 1130
staff-relative placement 400
text 1131
types 1128, 1129

percussion maps 643
creating 646
custom 646
dialog 643
endpoints 479, 485
exporting 648
file format 648
filters 643
importing 648
linking 485
note input 215
playback techniques 643
resetting 643

Percussion Maps dialog 643
percussion stickings 1125
perfect intervals 233, 424, 425, 427
performance instructions 547, 549, 801, 1066

adding 355
parts 355
playing techniques. See playing techniques

period 13
dynamics 756
lyrics 823
rhythm dots 173, 205
subito 756

Petaluma music font 624
Phaser 616, 620
phrases

bar repeats 398, 986
chord symbol regions 718
slurs 1016

phrygian
chord symbols 296, 720

piano 114
chord symbol playback 453
depressed notes. See bracketed noteheads
dynamics. See dynamics
hand marks. See lines
level changes 926, 927
pedal lines. See pedal lines
playback 936
retakes 926, 927
slurs 248
substitution fingering 784
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piano roll editor 575
copying notes 582
deleting notes 583
height 570
independent voice playback 575
inputting notes 577
moving notes 579
navigation 571
note duration 577, 580, 584
pitch 575, 577, 581
played vs. notated durations 584
scrolling 571
selecting notes 572
tools 566
tracks 448
transposing notes 581
tuplets 575
zoom 570

piccolo. See instruments
pick-up bars 1085, 1088

deleting beats 276, 409, 667, 668
inputting 258, 260, 264, 266, 409
turning bars into 409, 1088

pictures
videos 166

pincé. See ornaments
pinch harmonics 863, 866
PingPongDelay 616, 620
pinky finger 789

inputting 252
popover 252

pit band. See bands. See also project templates
pitch

accidentals 219, 655
bends. See pitch bends
changing 126, 423–425, 427, 581
changing string 1050
chord diagrams 735, 736
clefs 302, 303, 738
click 450
concert 155
dips 908
expression maps 626, 639
filters 393
fretted instrument strings 126
guitar strings 126
guitar techniques 908
harmonics 859–861
input 203
instruments 119, 122
jazz articulations 911
key signatures 815
metronome click 450
microtonal 233, 659, 820
note input 200, 219
noteheads 840, 844
octave lines 304, 305, 742
open strings 124, 126
ornaments 867
partials 859, 861
piano roll editor 575, 581
popover 233
ranges 847

pitch (continued)
strings 124, 126, 735, 736, 846
transposed 119, 155
transposing. See transposing. See also transposed 
pitch
trills 873, 875, 876, 878, 880, 881

pitch before duration 200
accidentals 204
activating 173
articulations 204
rhythm dots 204

pitch bends 889, 894
guitar. See guitar bends
MIDI controllers 595, 597

più. See tempo marks. See also dynamic modifiers
pizzicato. See playing techniques
placement

articulations 664, 665
breath marks 812
caesuras 812
changing 400
chord symbols 717
dynamics 747
fermatas 812
fingerings 783, 787
grace notes 804
harp pedal diagrams 922
lines 950–952
lyrics 827
ornaments 868
pauses 811
pedal lines 927
playing techniques 400, 939
rehearsal marks 963
rests 1008
slurs 1016, 1018, 1022
tempo marks 1056
ties 1078
tremolos 1100
voices 1136

plain font 1066
playing techniques 937
string indicators 797
time signatures 1097

Play mode 18, 439
channels. See channels. See also tracks
deleting notes 583
Endpoint Setup dialog 479
exporting expression maps 642
expression maps 625, 636
inputting notes 577
loading sounds 447, 459
MIDI instruments 442, 446, 447
mixer. See mixer
moving notes 579
note durations 578, 580, 584
overrides 585
panels 35, 439, 442
percussion editor 576
percussion maps 643
piano roll editor 575
playback 457
playhead. See playhead
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Play mode (continued)
switching 439
toolboxes 439
track overview 440
tracks 448
transport 30, 468
VST and MIDI panel 445
VST instruments 442, 445, 447, 459
window elements 439
zooming 455, 570

playback 457, 649, 1047
accents 665
activating 28, 457
arpeggio signs 887
articulations 460, 461, 626, 665
audio buffer size 244, 245
bar repeats 986
bracketed noteheads 850
bypassing inserts 620
changing sound libraries 477
channels. See channels. See also tracks
chord symbols 442, 452–454
chords 395
click 450, 457, 468, 601
dead notes 908
default settings 476
default tempo 412, 1052
dynamics 394, 460, 461, 590, 633, 754, 769
elapsed time 468, 471
endpoints 479, 481, 482, 484, 485
excluding items 463
exporting audio 86, 87
expression maps 625, 626
faders 612, 613, 618
fast-forwarding 456
fixed tempo 458
flows 484
follow tempo 458
ghost notes 850
glissando lines 892, 893, 918
grace notes 808
guitar bends 894
harmonics 859–861
hiding notes 1000
instruments 460, 461, 625, 643
jazz articulations 649, 911
Keyboard panel 183
legato 633, 1028
line 455
marcato 665
metronome 468
metronome click 450
MIDI controllers 596
mixer. See mixer
multiple windows 46
muting 461–463, 612
mutual exclusion groups 641
note durations 584, 633
note velocity 587
notes 394, 395, 460, 461
number of times played 464
ornaments 867
ossia staves 1042

playback (continued)
overrides 585
panning 619
patches 479
pauses 809
pedal lines 936
percussion 485, 576, 582, 643, 1115, 1116, 1118, 
1119
playhead. See playhead
playing techniques 460, 461, 640, 649, 650
playthroughs 464
plug-ins 613
preferences 53
recording notes 242
repeats 463, 464
resetting volume 618
reverb 614, 615, 621
rewinding 456
selections 457
silence playback template 471, 472
slashes 422, 1000, 1005
slurs 248, 460, 461, 1028
soloing 461, 462, 612
staccato 665
starting 457
swing 465, 467, 468
templates. See playback templates
tempo 450, 468, 601, 1059–1061
tempo equations 1064
tenuto 665
timecode 468, 471, 967, 971
transport 468, 471
tremolos 460, 461, 648
trills 880, 881
velocity 587
vibrato bar dives and returns 899
voices 460, 461, 484
volume 394, 612, 613, 618

Playback Technique Combinations dialog 636
playback techniques 479, 640, 649, 650, 661, 937

attribute 650
combinations 636, 640
creating 650
deleting 641, 650
direction 650
editing 650
endpoints 479
expression maps 625, 626
fallback 650
mutual exclusion groups 641
percussion 648
percussion maps 643
playback templates 471
resetting 650

playback templates 471, 472
changing 476
creating 477
custom 471, 474, 477
dialog 472, 474
endpoint configurations 445, 479, 481, 482
exporting 478
factory default 472
fallback 474
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playback templates (continued)
file format 471
importing 478
metronome click 450
overriding 471
resetting 476
track inspector 442

played duration 584, 808
changing 584, 585
key commands 584
notated duration 584
overrides 584, 585
resetting 585
slurs 1028
tool 566

player cards 94, 105
disclosure arrows 40

player group labels 1029, 1036
fonts 1036
hiding 1036
showing 1036

player groups 94, 144
adding players 145
bracket grouping 675
creating 145
deleting 147
ensembles 98
labels. See player group labels
moving players 147
naming 146
removing players 147

player labels
hiding 1035, 1036
showing 1035, 1036
staff labels 1029, 1032, 1036, 1038

player names 158
changing 159
groups. See player group labels
instrument tracks 449
resetting 159
staff labels 1032
tokens 553

players 19, 105, 107
adding 96, 98, 108, 113, 114, 120, 145
adding to flows 149
brackets 708, 709, 1036
cards 94
changing transposition 122
chord symbols 291, 714
clefs 739
colors 449, 575, 576
combined parts 153
condensing 543
copying 109
deleting 112, 123, 147
divisi 1047
duplicating 109
empty staves 515
ensembles 94, 112
exporting 75
exporting audio 86
exporting MIDI 82
extra staves 1041

players (continued)
figured bass 363, 772
flows 105, 149
groups. See player groups
hiding 149, 153
importing 74
instrument change labels 1035
instrument order 123
instruments 20, 47, 114, 120, 122
layouts 105, 153, 160
lists 158, 553
maximum number 107
merging 74, 77
moving 110, 147
moving between groups 147
moving instruments between 123
multiple instruments 47, 120, 159, 1032
muting 461, 462, 612
naming 158–161, 1032
numbering instruments 115
ossia staves 1042
panel 93, 94
panning 619
part layouts. See layouts
percussion kits 121
pitch 119
player names 159
position in score 110
removing from flows 149
removing from groups 147
saving 101
section players 94, 107, 108
showing 149, 153
single players 94, 107, 108
soloing 461, 462, 612
soloists 111
sorting 110
staff labels 1032
staff size 528
staves 516, 517
swing playback 467, 468
system dividers 1043
tablature 1048, 1049
tokens 553
transposition 119
volume 618, 754

Players panel 93, 94
playhead 455

color 51
fast-forwarding 456
hiding 457
moving 405, 456
playback 457, 468
position 457
repeats 463
rewinding 456
showing 457
transport 468, 471
zooming 455, 570

playing technique lines 940, 943
appearance 942
changing 944
default settings 940
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playing technique lines (continued)
duration 396, 941, 942
hiding 942
showing 942, 944

playing technique-specific noteheads 803, 937, 1115, 
1116, 1118

appearance 1121
articulations 648
changing 582, 1119
creating 1120
inputting 213, 578
playback 648

playing techniques 937
adding text 938
changing 398, 582, 1119
colors 52
combinations 636, 640, 648
continuation lines 940, 943, 944
creating 1120
deleting 412
dialog 650
divisi 1047
duplicating 942
duration 396, 941, 942, 944
editor. See Playing Techniques editor
endpoint configurations 482
expression maps 625, 626, 649
filter 393
font 937
frame breaks 939
grouping 940, 943, 944
guitar. See guitar techniques. See also vibrato bar
handles 939, 941, 943
harmonics. See harmonics
hiding 939
inputting 337, 341, 343
length 396, 939, 940
lines. See playing technique lines
moving 417, 421, 939
muting 463
noteheads 582, 648, 1116, 1118–1121
panel 340, 343
percussion 648, 1115, 1116, 1118, 1125
placement 939
playback 460, 461, 625, 626, 649, 650
popover 337, 341
position 939
repeating 942
selecting 388
showing 939
signposts 407, 939
size 399
staff-relative placement 400
system breaks 939
text 937, 938
ties 341, 343
tracks. See Playing Techniques editor
types 337, 937
ungrouping 944
voices 341, 343, 460, 461

Playing Techniques editor 586
hiding 586
showing 586

playing techniques lanes. See Playing Techniques 
editor
Playing Techniques panel 343, 346
playthroughs 975

bar numbers 688
changing 464
MIDI recording 243
optional notes. See bracketed noteheads
repeats 464
total number 975

plops. See jazz articulations
plucked instruments

arpeggio fingering 792
fingerings 249, 789
popover 252
slides 792, 793
string indicators. See string indicators
strings 846
tablature. See tablature
tuning 124

plug-ins 471
allowing 459
blocking 459
changing 471, 621
configurations 474, 479, 481–484
endpoints 471, 479, 484, 485
expression maps 485, 626
instances 442, 445
loading 447
mixer 479, 613, 616
percussion maps 485
playback 442, 445, 471, 613
reverb 621
saving 481–483

plus sign
caret 191
mutes. See playing techniques
rim shots. See playing techniques. See also playing 
technique-specific noteheads
tapping 905
time signatures 258, 1085

PNG files 505
color 506
exporting 495, 496
layout numbers 156
layouts 495, 496
project preview 70
resolution 505

poco a poco
centered 756
dynamics 284, 286, 754, 756, 760
tempo marks 1054, 1055

points
constant 598
copying 573, 594, 600
deleting 574
dynamics 590–592
linear 598
MIDI 596–599
selecting 572
tempo changes 601, 602
unit of measurement 48
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polychord chord symbols 296, 713
arrangement 722
inputting 291

polymeter 262, 263, 1084
polyphony 1134

adding voices 207
changing voices 422
condensing. See condensing
MIDI recording 240, 241

polytonality 255, 257, 815
popovers 21, 178

add intervals. See note tools popover
arpeggio signs 313, 318
bar repeats 375, 385
barlines 276–278, 281, 282
bars 276, 278
beats 276
changing items 398
chord symbols 293, 298
clefs 300, 302
commands. See jump bar
dynamics 284, 287
ensembles. See ensemble picker
figured bass 364, 367
fingerings 249, 251
glissando lines 313, 319
guitar techniques 313, 324, 326, 328, 330, 
332–334, 336
harp pedaling 340
holds 306, 308
instruments. See instrument picker
jazz articulations 312, 321
key signatures 253, 255
lyrics 360–362
metronome marks 268
note tools 232, 233, 427
numbered bar regions 375
octave lines 300, 301, 304
ornaments 311, 316, 318, 319, 321
pauses 306, 308
pedal lines 339, 344
playing techniques 337, 341, 344
repeat endings 373
repeat markers 374
repeats 373, 381, 385
rhythm slashes 375
string indicators 340
tempo 268, 273
time signatures 258, 262, 264
transpose 235
tremolos 374, 375, 381
trills 312, 876
tuplets 229, 230

port de voix. See ornaments
portamento. See glissando lines
portrait orientation 503, 504, 510
ports 442, 450, 479, 601

changing 484
chords track 442
expression maps 479, 485
instruments 484
mixer 613
percussion maps 479, 485

ports (continued)
setup 479
Tempo editor 601
tempo track 450

position
arpeggio signs 886
articulations 662, 664
dynamics 747
figured bass 778
fingerings 783
grace notes 804
gradual dynamics 761
hairpins 761
inputting 187
Insert mode 408, 410, 411
instruments in percussion kits 142
items 401, 560
jazz articulations 913
key signatures 818
lines 949
new items 187
notes in multiple-voice contexts 1136
octave lines 743
pauses 811
pedal lines 928
resetting 401
rhythmic 22
slurs 1016, 1018, 1022
stop 408, 410, 411
string indicators 799
trill intervals 879
videos 168

possibile. See dynamic modifiers
post-bends. See guitar post-bends
pre-bends. See guitar pre-bends
pre-dives. See guitar pre-bends
preamble 801

page templates 547
precipitando. See gradual tempo changes. See also 
tempo marks
preferences

colors 49
key commands 54, 58
MIDI 245
missing fonts 69
mouse input 188, 189
note input 200, 203, 204
pedal lines 245
selection tools 37
sustain pedal controllers 245
theme 49

Preferences dialog 53
prefixes

dynamics 754, 755
fingerings 794
instrument change labels 118
rehearsal marks 966

presentation types 136
changing 1127
dynamics 1125
editing area 136, 1126
percussion kits 1121, 1126
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presets
background color 50
effects 638
staff size 527
zoom 39

pressure. See playing techniques. See also lines
presto. See tempo marks
preview

color 50
file names 498
images 70, 89
note spacing 533
print preview 34, 486
projects 70, 89

previous versions 68
primary

beams 701
instruments 568, 594, 597, 600

primary bar number sequence 684
changing 685, 686
returning to 687

primes 555
Print mode 18, 486

landscape orientation 500
page setup 504
panels 35, 486–488
portrait orientation 500
printers 499
switching 486

Print Options panel 486, 488
print preview area 34

navigation 34, 486
printers 499

selecting 491
printing 486, 491

annotations 507
arrangements 500
booklets 501
borders 507
comments 437, 507
copies 491
crop marks 507
date 507
duplex 491, 502
flows 493, 494
job types 500
key commands 54
landscape 500, 503
layouts 491
lyrics 826
macOS options 494
note colors 507
options 488
orientation 503
page sizes 503, 504
paper sizes 503
PDF files 495
portrait 500, 503
preview 34, 402
ranges 491, 493, 494
scale size 491
signposts 507
spreads 500

printing (continued)
time 507
voice colors 507
watermarks 507

program change actions 625, 631, 638
Project Info dialog 70
project information 70

exporting 73
flow titles 164
page templates 549, 801
project templates 73
tokens 70, 164, 555

project templates 66, 73
categories 73
Hub 64
starting projects 66

project window 27
dark 49, 52
light 49
opening multiple 46
Play mode 439
Print mode 486
Setup mode 93
splitting 45
theme 49
Write mode 172

projects 18, 70, 73
audio 86
auto-save 89, 90
backup location 92
backups 91
different Dorico versions 68
exporting 79, 82, 85
exporting flows 75, 76
flows 74–76, 148, 165, 432
frame rates 171
full screen mode 46
Hub 64
importing flows 74, 77
layouts. See layouts
merging 74
MIDI files 82
missing fonts 69
movements 148
multiple windows 46
MusicXML files 79
opening 46, 67, 68, 90
PDF files 495, 505
preview 70
recent 68
recovering 90
settings 622
splitting flows 432
start area 32
starting 66
tabs 45
templates. See project templates
titles 165
tokens 553, 555
videos 166, 168
window 27
workspaces 40

Propagate Part Formatting dialog 545
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propagating
part formatting 544
properties 547

properties 560
copying to other layouts 547
global 561, 562
local 561, 562
notations 560
notes 560
scope 560–562
searching 560
selected items 560
values 562
videos 167

Properties panel 560
disclosure arrow 36
key commands 41
Write mode 172

pulgar. See thumbs
pull-offs. See hammer-ons
punctuation

duration 555
timecodes 971

Q
qualifiers 284, 286
quality

chord symbols 291, 294, 714, 721
intervals 233, 234
transposing 235, 424, 425

quantization 81
changing 243
grace notes 81
MIDI import 80, 81
MIDI recording 81, 241, 244
requantizing 243
splitting notes 238
tuplets 81

quarter depressed pedal lines 926
quarter notes 13, 177, 197, 200, 210, 212, 235, 236

beats 276
chords 226
grace notes 225
metronome marks 269
percussion 213, 578
playback 633
rests 221, 1008
splitting notes 238
swing playback 465, 466
tablature 217
tempo equations 1064
tremolos 381, 383, 1099
tuplets 229, 232
voices 207

quarter tones 659, 820
accidentals 659, 820
guitar bends 326, 897, 900
octave divisions 820
tonality systems 820
transposing 235

quartet templates 66, 73
staff grouping 709

quavers. See eighth notes
question marks

harmonics 860
tablature 424, 1048

quick tool selector 566
quintet templates 66, 73

staff grouping 709
quintuplets. See tuplets
quotation marks 555

R
rack. See VST and MIDI panel
rallentando. See gradual tempo changes. See also 
tempo marks
randomization 605, 606, 608
ranges

arpeggio signs 318, 319, 886
bar numbers 679, 993, 994
colors 51, 52, 847
copying notes 416
counts 993, 994
cues 745
flows 493, 494
instruments 114, 124
keys 183
lines 354, 886, 953
metronome marks 1058, 1060
notes 124, 847
numbered bar regions 993, 994
pages 491, 493, 494
percussion legends 1130
selecting 389
strings 124

rasterizing. See staff size
rastral size 527
ratamacue. See grace notes. See also tuplets
rates

frames 171
ratios

grace notes 807
note spacing 533
swing playback 466
tuplets 1112, 1113

re-strikes. See guitar pre-bends
read-only mode 67, 92, 107
recent projects 64, 68
recipes 498
recording

audio 86
click settings 450
devices 246
input pitch 203
MIDI. See MIDI recording
pedal lines 244
playing techniques 244
retrospective recording 242, 468
tempo 458

Recover Auto-saved Projects dialog 90
recovering 242

backups 91
files 89–91
notes 242
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rectangle
above systems. See system track
bar number enclosures 678
borders 1072
colored. See signposts
music. See music frames. See also frames
noteheads 844
notes 575, 576, 584
text enclosures 1071, 1072

redo 28
reducing 151, 422, 527

condensing. See condensing
note durations 236, 238

reeds 151
adding 96, 98, 108, 120
instrument changes 117
part names 158, 160
staff labels 1032
transposition 119

regions
bar repeats. See bar repeats
bars. See numbered bar regions
chord symbols. See chord symbol regions
counts 987, 993, 1003
dynamics 590
Play mode. See colored regions
slashes 997, 1002. See also rhythm slashes

register
changing 424, 425, 427
clefs 302, 303, 738, 741
note input 200
octave lines 304, 305, 742
plug-ins 459
transposing 427, 741

rehearsal marks 963
barlines 963
colors 52
deleting 412
enclosures 963
filter 393
going to 405
index 964
inputting 368
moving 417
multiple positions 963, 1044, 1045
navigation 405
order 964
placement 963
position 963
prefixes 966
selecting 387, 390, 392, 393
sequences 964, 965
size 399
staff-relative placement 963
starting number 964
suffixes 966
tempo marks 963
types 965
vertical positions 1044

relative channel change actions 638
relative tempo changes 1053, 1060

releases
guitar bends 894
tremolos 374, 381, 383, 1101

reloading
video files 168

removing. See deleting
Rename Player dialog 159
Rename Player Group dialog 146
renaming

drum sets 136
endpoints 483
files 64
flows 164
groups 141
instruments 158, 161
layouts 158, 160
percussion kits 136, 141
player groups 146
players 158, 159
staves 158, 161
titles 164

renumbering
bars 684–686
flows 150
layouts 156

repeat barlines 672, 979
counts. See repeat counts
end of systems 674
exporting 463
inputting 276–278, 281, 282
MIDI recording 243
number of times played 464
panel 278, 282
playback 463
playthroughs 464
popover 276, 277, 281
start of systems 674
text. See repeat counts

repeat counts 983
changing 464
hiding 983
location 983
moving 983
showing 983

repeat endings 975
additional endings 377, 379
alignment 977
appearance 977
bar numbers 688
deleting 412
exporting 463
filter 393
final segments 977
frame breaks 977
handles 976, 977
inputting 373, 376–379
length 976
MIDI recording 243
moving 417, 976
multiple positions 977, 1044, 1045
MusicXML files 978
number of playthroughs 975
optional notes. See bracketed noteheads
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repeat endings (continued)
panel 376, 378, 379
playback 463
playthroughs 975
popover 373, 377
position 977
segments 975, 977
selecting 387, 390, 392, 393
size 976
system breaks 977
types 373
vertical positions 1044

repeat jumps. See repeat markers
repeat markers 979

bar numbers 688
barlines 674
changing 398
deleting 412
exporting 463
filter 393
hiding 981
index 980
inputting 374, 376, 380, 381
MIDI recording 243
moving 417
multiple 980
multiple positions 982, 1044, 1045
number of times played 464
optional notes. See bracketed noteheads
order 980
panel 376, 381
playback 463, 464
popover 374, 380
position 982
showing 981
staff-relative placement 982
text 981
types 374
vertical positions 1044

repeat sections. See repeat markers
Repeat Structures panel 376
repeating. See copying. See also repeats
repeats

barlines. See repeat barlines
bars 985, 992
counts 464, 987, 993
dynamics 463
endings. See repeat endings
export 463
frequency 988, 994
grouping 990
length 398, 986
markers. See repeat markers
notes. See tremolos. See also bar repeats
numbers 464, 980, 987, 993, 1003
optional notes. See bracketed noteheads
playback 463, 464
playing techniques 942
tempo marks 463

repeats popover 373
repitching notes 427

replacing 398
fonts 69
Key Editor configurations 610

replying
comments 432, 434, 436

requantizing notes 243
resetting 412

accidentals 655
appearance 401
background color 50
bar numbers 686, 687
beaming 692, 694, 697, 701, 702
capos 131–133
chord diagrams 733, 736
chord symbol voicing 454
chord symbols 721
colors 51, 52
cross-staff beaming 697, 701
dynamics 574
expression maps 636
figured bass 781
fingerings 733, 791
instrument names 161, 163
items 401
key commands 60
layout names 160
layouts 157
mute states 462, 612
note velocity 589
options 53, 622
page color 50
page templates 520
paragraph styles 1070
part layouts 157
percussion maps 643
playback overrides 585
playback techniques 650
playback templates 476
played duration 585
player names 159
position 401
preferences 53
rests 1012
secondary beams 702
solo states 462, 612
staff labels 163
staves 516, 517
stems 858
tempo 1053
text 1070
trill intervals 877
velocity 589
voicing 454
volume 618

resolution
changing 496
figured bass 363, 364, 775, 779
images 505
rhythmic grid 36, 190, 571

respelling
accidentals 183, 428, 429, 431
chord symbols 128, 720, 721
notes 183, 428, 429, 431
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rest grouping. See note grouping
restating

accidentals 660
restorative

clefs 302, 303
pedal lines 934, 936
text 934, 936

restoring. See resetting. See also hiding
rests 21, 1008

alignment 1008
bar rests. See bar rests
beaming 690, 704
changing type 1011
colors 52, 1011. See also note and rest colors
consolidation 1010, 1014, 1015
deleting 236, 409, 667–669, 1012, 1014
durations 235
empty bars 1014
explicit 1008, 1009, 1011
figured bass 363, 771, 773, 780
filling in 236
forcing duration 238
grouping. See note grouping
H-bars. See multi-bar rests
hiding 1001, 1012, 1014, 1015
implicit 1008, 1009, 1011
inputting 173, 183, 197, 221, 222, 238
moving 533, 1012. See also note spacing
multi-bar rests. See multi-bar rests
padding 1001
placement 1008
position 1008
restoring 1012
showing 1012, 1014, 1015
spacing. See note spacing
voices 1008, 1010, 1012

retakes. See pedal retakes
retrieving. See recovering. See also retrospective 
recording
retrospective recording 242, 468
reverb 614–616

changing 621
hiding 617
showing 617
tail 87

reverb channels
mixer 613

REVerence 616, 620, 621
reverse

lines 957
printing 501, 502
stems 695–697, 701, 854, 856–858

reverting. See resetting
reviewing

comments 432
print preview 34, 402, 486

rewinding 456, 468
rfz. See dynamics
rhythm

locking 427
requantizing 243
slashes. See rhythm slashes
tablature 1049

rhythm dots 205, 705
Chord mode 228
inputting 197, 200, 204, 205, 235
Insert mode 408
moving 1137
number 205, 235
pitch before duration 204
splitting notes 238
tremolos 381, 383
voices 1137

rhythm section
brackets 709, 1036
chord symbols 714, 716
staff grouping 709, 1036

rhythm slashes 997, 1005
appearance 999
bar rests 1010
beaming 1002
caret 191, 209
changing number 1003
counts 1003, 1004
deleting 412
filter 393
font style 1003
frequency 1004
hiding rests 1001
highlights 997, 998
inputting 209, 376, 384
moving 417, 421, 1000
note grouping 705
panel 376
parentheses 1004
percussion kits 136, 142, 213, 1007
placement 1005
popover 375, 384
regions 997, 1003
rests 1001, 1010
splitting 1002
staff position 142, 1000
staff-relative placement 1005
stem direction 857, 999
stemless 191, 209
stems 1002
type 1006
vertical position 1000
viewing options 998
voices 209, 422, 999, 1005, 1006

rhythmic feel 465, 466
changing 467
default settings 466
deleting changes 468
popover 270
signposts 407, 467, 468

rhythmic grid 36, 190
changing 190
color 51
key commands 54, 58
Key Editor 566, 571
resolution 36, 190
selecting music 393

rhythmic notation 22, 997
rhythmic position 22

playback 455
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rhythmic position-attached lines. See lines
rich black 506
ride bell. See unpitched percussion. See also playing 
technique-specific noteheads
right hand hooks. See lines
right pages

starting from 519
right zone 35, 36

hiding 41
Print mode 488
Setup mode 101
showing 41
Write mode 181

right-foot pedals. See harp pedaling. See also pedal 
lines
right-hand fingering 789

arpeggio signs 792
brackets 790
inputting 249
placement 784
popover 252
tapping. See tapping

right-hand guitar tapping. See tapping
rim shots. See playing techniques. See also playing 
technique-specific noteheads
rinforzando. See dynamics
rips. See jazz articulations. See also glissando lines
ritardando. See gradual tempo changes. See also 
tempo marks
ritenuto. See gradual tempo changes. See also tempo 
marks
rolled chords. See arpeggio signs
rolls. See tremolos. See also tuplets
Roman numerals

flow numbers 555
harmonic analysis 771
page numbers 915
tokens 555

RoomWorks SE 616, 620
roots

chord symbols 291, 294, 295, 714, 721
Rotary 616, 620
rotating

text 1036
round

chord symbol parentheses 723, 725
figured bass brackets 777
notehead brackets 849, 850

rounded rectangle
borders 1072
text enclosures 1072

rows
bar numbers 682
buttons. See toolbar. See also lower zone
chord diagrams 731, 732
chord symbols 128, 133, 134, 136
dynamics 765, 766
figured bass 778

rubato
expressive text 284, 754, 755
system-attached text 355
tempo marks 268, 1052
text 355

rudimental drumming. See unpitched percussion
ruffs. See grace notes
rulers

Play mode 440
rhythmic grid 190

running headers 549
flow headings 521
hiding 521
page templates 549

runs
guitar bends 894

S
salzedo breath marks. See breath marks
sample libraries. See sound libraries
sample rate 36, 244, 245
sampled trills 880, 881
Save Endpoint Configuration dialog 483
saving 64, 89

audio 82, 86, 87
auto-save. See auto-save
backups 91
chord diagram shapes 735
comments 437
custom ensembles 101
editors 609, 610
endpoint configurations 481–483
ensembles 101
expression maps 642
folder location 92
graphics files 495, 497
instrument names as default 161
Key Editor configurations 610
layout options as default 622
lyrics 826
MIDI files 82
MusicXML files 79
PDF files 495
percussion kits 1123
percussion maps 648
playback templates 478
played notes 242
players 101
plug-in instances 481, 482
PNG files 495
settings as default 622
SVG files 495
TIFF files 495

saxophone. See instruments
scale degrees

chord symbols 293
Nashville numbers 294
noteheads 844
popover 233
trills 873, 875, 876

scale multiplication 605, 606, 608
scale size

barlines 672, 674
chord diagrams 731
cues 533
fingerings 789
grace notes 533, 803, 807
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scale size (continued)
note spacing 533
notes 399
printing 491, 503, 504
staves 527–530

scales 820
degrees 714, 844
EDO 820
exercises. See flows
key signatures 815, 817
major 817
minor 817
octave divisions 820
transposing 425
values. See scale multiplication. See also Histogram 
tool

scissors 173
activating 173
slashes 1002
ties 1083

scoops
deleting 910
inputting 321, 322, 330, 331
jazz. See jazz articulations
popover 312, 313
vibrato bar 904

scope
Insert mode 409, 410
jump bar 60
properties 561, 562

scordatura 124, 126
scores. See layouts
scrapes. See playing techniques
scroll view. See galley view
scrolling 405

Key Editor 564, 571
mixer 617
percussion editor 571
piano roll editor 571

searching 53
ensembles 98
instruments 96
key commands 54, 56, 57
layout options 622
notes 393
preferences 53
properties 560

second voices
adding 207
bar rests 222

secondary beams 701
changing 702
direction 702
lines 702
resetting 702
splitting 692

secondary brackets 710, 712
braces 712
hiding 711
showing 711
sub-brackets 712
sub-sub-brackets 712

secondary instruments 568, 594, 597, 600

seconds 30, 468, 971
duration tokens 555

section players 107
adding 108, 113, 114
divisi 1047
empty staves 515
ensembles 98, 112–114
ossia staves 1042
staff labels 1029
staves 516, 517

sections
coda 979
fine 979
hiding 40, 981
repeat 979
showing 40, 981

segments
caps 957
final 977
repeat endings 377, 379, 976, 977
tuplets 1107

segno 979
hiding 981
inputting 380, 381
multiple 980
sections 979
showing 981

selecting 37, 387, 389, 394, 402
bars 387, 390, 392
beats 393
blue 767, 1027
changing the selection. See navigation
chord symbols 390, 392, 393
chords 395
dynamics 388, 393
everything 389, 390, 392, 393
extending selection 388, 389
filters 393, 394
flows 389
items 187, 387, 389, 403, 572
items behind other items 387
Key Editor 572
key signatures 390, 392, 393
lyrics 388, 393, 827
marquee 37, 389, 572, 609
more 388, 389
notations 37, 389, 403
notes 37, 387, 389, 393–395, 403, 572
panels 178, 181, 182
playback 457, 468
points 572
rehearsal marks 390, 392, 393
repeat endings 390, 392, 393
status display 36
staves 389
system objects 390, 392, 393
system track 390
system-attached text 390, 392, 393
tempo marks 390, 392, 393
time signatures 390, 392, 393
tools 36, 37, 173, 566
transposing selections 424
velocity bars 609
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selecting (continued)
voices 388, 393, 422, 568, 572
Write mode 173

selectors
layouts 28, 29
panels 178, 181, 182

semibreves. See whole notes
semiquavers. See sixteenth notes
semitones. See half-steps
sends 616

loading 620
mixer 612, 613
removing 621

separators
beams 705
chord symbols 722
duration tokens 555
dynamics 284, 752
fingerings 794
staff labels 1034
systems. See system dividers
time signatures 1091, 1094
timecodes 971
tokens 555

septuplets. See tuplets
sequences

bar numbers 684–686
page numbers 519
rehearsal marks 964
staff labels 115
subordinate 686
types 965

sets
drum sets. See drum sets
page templates. See page template sets

setting up
audio devices 53, 244, 245
drum sets 136
duplex printing 491
key commands 58
MIDI recording 244
percussion kit note input 215
percussion kits 136
windows 40
workspaces 40

settings 622
audio 53
copying properties 547
default 53, 622
harp pedals 918
individual items. See properties
layout-specific 622
mouse input 188, 189
note input 200, 203, 204
preferences 53
properties 560–562
videos 167

Setup mode 18, 93
adding players 113
ensembles 112
flows. See flows
instruments. See instruments
layouts. See layouts

Setup mode (continued)
panels 35, 93, 94, 101, 104
percussion 136
player groups 144
players. See players
signposts 407
switching 93

sextuplets. See tuplets
sfz. See dynamics
shadow notes 187

color 51
shakes. See jazz ornaments
shape

bar number enclosures 678
beaming 694–697, 701, 704
borders 678, 1072
chord diagrams 727, 734–736
figured bass brackets 777
notehead brackets 850
noteheads 841, 844
parentheses 725, 777, 850
slurs 1019
text enclosures 1072
tuplet brackets 1109–1111

sharing staves. See condensing. See also divisi
sharps. See accidentals
shifts

clefs 301, 740
octaves 301, 424, 425, 427, 740

short
barlines 674
notes 81, 197, 200, 207, 210, 212, 213, 217, 225, 
226, 229, 235, 236, 238, 533, 578, 632, 803, 808
scores. See condensing. See also layouts
stemlets 704

shortcuts. See key commands
showing. See hiding
shrinking. See size
side stick. See unpitched percussion. See also playing 
technique-specific noteheads
signatures

annotations 507
key signatures. See key signatures
printing 507
time signatures. See time signatures

signposts 407
barlines 281, 282, 412, 670, 1097
bars 670
chord symbols 713, 714, 718
clefs 739
dynamics 752
exporting 495, 507
extra staves 1041
figured bass 363, 771, 772, 780
frame breaks 540
harp pedaling 918, 920, 921
hiding 402, 407
key signatures 255, 257, 815
ossia staves 417, 421, 1042
percussion legends 1128
playing techniques 939
printing 491, 507
showing 407
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signposts (continued)
staff changes 1041
staves 417, 421
system breaks 537, 538
tempo marks 1055, 1058
text 1073
time signatures 670, 1091, 1093, 1096, 1097
trills 873–876
tuplets 1109, 1112

silence
hairpins. See niente
missing sounds 476
muting items 463
notes 908
playback template 471, 472, 476
rests. See rests

simile
dynamics 284, 286, 754
hiding 942
playing techniques 942
showing 942

simple time signatures. See time signatures
simplifying accidentals 429
single bar rests

bar counts 1015
H-bars 1015
hiding 1014
showing 1014

single barlines 281, 282, 672, 674
single players 107, 111

adding 108, 113, 114
empty staves 515
ensembles 98, 112–114
extra staves 1041
ossia staves 1042
staff labels 1029
staff size 528
staves 516, 517

single-line
percussion kits 1126, 1127
staves 1040

single-note tremolos. See tremolos
single-sided printing 491
single-stroke caesuras 307, 811
single-voice contexts 1134

articulations 662
grace notes 804
guitar pre-bends 901
stem direction 804, 854
tie curvature direction 1078

six-line staff
tablature. See tablature

sixteenth notes 13, 177, 197, 200, 210, 212, 235, 236, 
803

beats 276
chords 226
grace notes 225
metronome marks 269
percussion 213, 578
rests 221, 1008
splitting notes 238
swing playback 270, 465, 466
tablature 217

sixteenth notes (continued)
tremolos 381, 383, 1099
tuplets 229, 232
voices 207

size 527
arpeggio sign fingerings 792
audio buffer 244, 245
barlines 675, 676
bars 408, 409, 512, 513, 522, 530, 533, 667, 1046
beams 694
brackets 708, 709, 725, 1036
channels 618
chord diagrams 731
chord symbols 399, 725
cues 745
dynamics 399
elision slurs 827, 838
fingerings 792
font styles 357, 1070
gaps 143
grace notes 399, 803, 807
Key Editor 570
laissez vibrer ties 1081
left-hand fingering 789
lyrics 832–834
measures 522, 1046
mixer 618
noteheads 745, 841
notes 399, 745
octave lines 399
pages 503, 510, 622
paper 503, 504
parentheses 725
percussion editor 570
piano roll editor 570
player group labels 1036
playing techniques 399
rastral 527
rehearsal marks 399
repeat endings 976
space 527
staves 512, 527, 528, 622
system objects 512, 528
systems 522
text 357, 1070
time signatures 1089, 1091, 1097
tracks 454, 455, 570
unit of measurement 48
video window 169

sketch staves 96, 98
slants

beams 694, 808
pedal line hooks 932

slap tongue. See playing techniques
slash notation 997
slash regions 997

beaming 1002
chord symbols 714, 718, 997
counts 1003, 1004
deleting 412
filter 393
handles 396
hiding other notes 1000
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slash regions (continued)
hiding rests 1001
highlights 997, 998
inputting 384
length 396
moving 417, 421, 1000
multiple 999
note grouping 705
overlapping 999
parentheses 1004
placement 1005
popover 375, 384
rests 1001
showing other notes 1000
staff position 1000
staff-relative placement 1005
stem direction 999
stems 1002
vertical position 1000
viewing options 998
voices 999, 1005

slash voices 1005, 1099
bar rests 1010
caret 191, 209
changing 422, 1006
inputting 209
moving 1000
multiple-voice contexts 999
percussion kits 136, 213, 1007
playback 1005
popover 375
rests 1010
staff position 1000
stem direction 857
stemless 191, 209
vertical position 1000

slashes 997
bar rests 1010
caesuras. See caesuras
chord symbols 721
double 1042, 1099
dynamics 284, 752
figured bass 364
grace notes 803, 804, 807, 808
noteheads 841, 844, 997, 1005, 1116
notes. See slash voices. See also tremolo strokes
pauses. See caesuras
percussion 1116
regions. See slash regions
rests 1010
stemless 1006
stems. See tremolo strokes
systems. See system dividers
time signatures 1091, 1094
tremolos. See tremolo strokes
triple 1099
voices. See slash voices

slides
fingerings. See fingering slides
jazz. See jazz articulations
Key Editor 564
pitch. See glissando lines. See also pitch bends

slides (continued)
tempo 30
zoom 564

slight bends. See guitar bends
slots 442, 616
slurs 937, 1016, 1075

angles 1019
arpeggio signs. See curved arpeggio signs
articulations 663, 665, 1019
collision avoidance 1020, 1024
colors 52
copying 414, 417
cross-staff 248, 1024
cross-voice 248, 1024
curvature 1017, 1022, 1023
dashed 1020
deleting 412
dotted 1020
duration 1028
East Asian elision 838
editorial 1020
elision 838
endpoints 1018, 1019
filter 393
flat slurs 1022
formatting 1021, 1022
frame breaks 1019
gaps 1019
grace notes 248, 804, 1017
guitar techniques 334
hammer-ons 334, 906
inputting 183, 248, 334, 1025
inverting 1017, 1022, 1023
length 396, 1017
linking 417, 1027
MIDI recording 244
moving 417, 421
muting 463
nested 1019
nested slurs 1024, 1025
overlapping 1020
panel 177
placement 1016–1019, 1022, 1023
playback 248, 460, 461, 1028
position 1016, 1018, 1019, 1022
pull-offs 334, 906
selecting 388, 403
shape 1019
staff lines 1018
stem direction 1019, 1022
styles 1020, 1021
system breaks 1019
ties 1017, 1019
ties vs. slurs 1075
unlinking 417, 1028
within slurs 1024, 1025

small notes 399
cues. See cues
grace notes. See grace notes
harmonics. See harmonics
staves. See staff size
trills. See trills
tuplets 1104. See also tuplet numbers
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smart quotes 555
smears. See jazz ornaments
smooth

glissando lines 889
jazz articulations 911
MIDI 598

smorzando. See gradual tempo changes. See also 
tempo marks
SMPTE. See timecodes. See also markers
SMuFL 624

accidentals 358
music symbols 358
noteheads 358
tokens 554

snap pizzicato. See playing techniques
snare drum. See unpitched percussion
snare rolls. See tremolos
solfège chord symbols 294
solid

slurs 1020
tempo marks 1063
ties 1076

solo
indication 355
players. See soloists. See also single players
staff labels 111

soloing 612, 613
channels 461, 614
deactivating 462, 612, 613
instruments 461
playback 460, 461
tracks 461
voices 461

soloists 111
sonata. See flows
songs. See flows
sordino. See playing techniques
sorting

flows 150
layouts 156
players 110, 111

sostenuto pedal 925
MIDI controller 936
start signs 931
text 934, 935

sound libraries 471, 643
changing 476, 477
expression maps 626
loading sounds 447, 471, 476
missing sounds 476
percussion maps 646
playback 625, 643
trills 880

sounding
duration 584, 808. See also played duration
percussion legend ranges 1128, 1130
pitch. See sounding pitch. See also concert pitch

sounding pitch 155, 859
harmonics 863
input pitch 203
layouts 155

sounds. See playback

soundtracks
audio 170
volume 170

source instruments 745
source notes 792
space size 512, 527, 528
spacing 513, 529, 530, 533

accidentals 657, 658
arpeggio signs 886
bars 533, 1012
caesuras 310
chord diagrams 731
chord symbols 717, 722
clefs 738
condensing 543
cross-staff beams 699
cues 533
flow headings 525
frets 124
galley view 38
grace notes 533
gradual dynamics 761
layout options 622
lyrics 533, 827, 828, 833, 834
mixer 618
notes. See note spacing
percussion 136, 143, 1127
rehearsal marks 963
rests. See note spacing
rhythm dots 1137
staff lines 136, 143, 1127
staves. See staff spacing
stems 699
systems. See system spacing. See also staff spacing
tacets 543
time signatures 1095
voice columns 1137

speech bubbles
comments. See comments

speed
arpeggio signs 887
beaming. See fanned beams
bpm 1058
changing 273, 274, 458, 602, 603, 1059, 1061
frame rates 171
grace notes 808
playback 458, 1052
swing playback 465, 466
tempo marks 1052, 1059, 1061, 1062
tremolos 1101
trills 871, 880, 881
videos 171

spelling
accidentals 220, 428, 429, 431
chord symbols 128, 713, 719, 720
notes 220, 428, 429, 431

spiccato. See playing techniques
spin boxes 562
split stems 658

appearance 659
splitting 238

barline joins 676
bars 536, 537, 539, 670
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splitting (continued)
beams 692, 705
brackets 853
flows 432
multi-bar rests 1014
notehead brackets 853
notes 173, 238, 705, 1083
pedal lines 929
phrases 422, 1047
project window 45
rests 238
slash regions 1002
staves 380, 381, 537, 539, 543, 979, 1047
ties 238, 705, 1083
tuplets 1107

spreads
histogram controls 605, 606, 608
page arrangement 39, 47, 500

square
accidental brackets 656, 862
bracketed noteheads 849, 850
brackets 710, 712, 946
figured bass brackets 777
noteheads 844

squeal. See pinch harmonics
squeezes. See jazz ornaments
staccatissimo. See articulations
staccato. See articulations. See also playback 
techniques
stacking order

accidentals 657
chord symbols 133, 134, 136, 722
lines 950
signposts 407

staff grouping
barline joins 675, 676
changing 708
default settings 73, 708, 709
ensemble types 708, 709
player groups 144

staff labels 158, 1029
alignment 161, 1031
baseline shift 161
brackets 1036
changing 161, 1032–1034
changing first system indent 1046
colors 161
condensed staves 1038
Cubase 1030
default settings 73
divisi 1038
galley view 38
grouping 140, 141, 1036–1038
hiding 1030
indents 1031, 1046
instrument change labels 1035
instrument names 140, 141, 158, 161, 163, 554, 
1030, 1032
italics 161
length 1030, 1032
line breaks 1034
MusicXML import 1030
numbering 115, 1032, 1038

staff labels (continued)
overline 161
parentheses 1034
percussion 136, 140, 141, 1032, 1037, 1126, 1130
player groups. See player group labels
player names 159, 1032
project templates 73
resetting 163
separators 1034
showing 1030
solo 111
stretch 161
subscript 161
superscript 161
tokens 554
transposing instruments 1029, 1033, 1034
underline 161

staff lines
erasing 787, 797
number 136, 517, 1126, 1127
percussion 136, 143, 1127
slurs 1018
spacing 136, 143, 1127
string indicators 797
tablature 124, 1048

staff position
lines 886, 952–954
note input 215
percussion 582, 1115, 1116, 1119, 1120
percussion kits 142, 215

staff size 504, 512, 527
changing 512, 528, 529
custom 529
dialog 529
individual staves 528
layouts 1041
MusicXML files 77
rastral size 527
space size 527

staff spacing 512, 529
changing 513, 529
condensing 543
default settings 513, 530
divisi 513
final systems 522
flow headings 525
galley view 530, 532
hiding staves 515–517
horizontal 522
justification 513, 522, 530
layout options 622
layouts 513
rehearsal marks 963

staff text. See staff-attached text
staff-attached text 1065, 1066

alignment 1070
borders 1071
formatting 357, 359, 1070
hiding 1073
inputting 355
moving 1070
paragraph styles 1070
selecting 387
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staff-attached text (continued)
showing 1073
signposts 407
staff-relative placement 400

staff-relative placement
articulations 664
bar numbers 683
beaming 693
changing 400
cue labels 400
dynamics 400, 747
figured bass 778
fingering 790
fingerings 786, 787
guitar bends 400
guitar pre-bends 901
hammer-ons 909
harmonics 865
left-hand fingerings 791
lines 951, 952
lyrics 830
numbered bar region counts 996
octave lines 400, 743
ornaments 400
pedal lines 927
percussion legends 400
playing techniques 400
pull-offs 909
rehearsal marks 963
repeat markers 982
resetting 401
slash region counts 1005
slurs 1023
string indicators 349–351, 797, 799
tapping 909
text 400
trills 400
tuplet brackets 1110

stars
pedal lines 925, 933

start area 32
start position

frames 535, 539
lines 955
pages 535, 539
playback 456
systems 535, 537
trills 869
videos 168

start repeat barlines 277, 672
counts. See repeat counts
inputting 276, 278, 281, 282
key signatures 674
playthroughs 463, 983
system breaks 674

start signs
lines 948
pedal lines 930, 931, 934

starting 195
area 32
Hub 64
interchangeable time signatures 258, 262, 263, 
1085, 1097

starting (continued)
MIDI recording 241
note input 195, 197, 200
playback 457
players 32
projects 32, 66
timecode values 972
workspaces 40

status bar 36
selection tools 37
view types 38

status display 36
staves 13, 1040

adding 108, 113, 120, 1041, 1047
arranging tools 412
bar numbers 680, 681
bar rests. See bar rests
barlines 675, 676
beaming 697, 699, 701
brackets 73, 708, 709, 1036
casting off 535, 536
chord symbols 155, 291, 714, 716–718
clefs 741
collision avoidance 513, 530, 532
color 52
comments 432, 434
condensing. See condensing
copying items 414, 415
crossing notes 697, 701
dialog 529
dividers. See system dividers. See also divide 
arrows
divisi 1047
dynamics 287, 290, 400, 754
dynamics linking 417, 767
empty. See empty staves. See also blank staves
extra 1041
fermatas 813
figured bass 363, 771
fingerings 787
five-line 1037, 1040, 1126
fixing 535, 536
galley view 47
gaps 513, 979, 1046
glissando lines 319, 320
grids 1037, 1126
groups 144, 675, 709. See also staff grouping
height 512, 513, 524, 526, 527
hiding 105, 149, 153, 154, 515–517, 1049
indents 522, 1030, 1031, 1041, 1046
inputting on multiple 195, 210
instrument change labels 1035
instrument changes 117, 118
key signatures 255, 257, 815
labels. See staff labels
large time signatures 1091
layout options 1041
margins 522, 524, 526, 1030, 1031, 1046
markers 968
moving 512, 513, 524, 526
multiple voices 207, 543
names. See staff labels. See also instrument names
notation 1048, 1049
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staves (continued)
note input 195, 210
notes 421
number 515, 517, 1041, 1042
order 110, 111
ossia staves. See ossia staves
page view 47
pauses 811
percussion 1126, 1127
pick-up bars. See pick-up bars
playback 457
rasterizing. See staff size
reducing 543
rehearsal marks 1044, 1045
renaming 161
repeat endings 1044, 1045
repeat markers 982
selecting 389
showing 47, 149, 153, 515–517
single-line 968, 972, 973, 1037, 1040, 1126
size. See staff size
slurs 1024, 1027
slurs linking 417
spacing. See staff spacing
splitting 380, 381, 979
staff labels. See staff labels
stem length 858
string indicators. See string indicators
swing playback 467
system breaks 537
system dividers 1042, 1043
system objects 1044, 1045
tablature 1048, 1049
tacets 541
tempo marks 1044
text 355, 1044
ties 223, 1081
time signatures 262–264, 266, 1044, 1084, 
1089–1091, 1095
timecodes 968, 972, 973
transposing instruments 119
tremolos 697, 701
vertical spacing. See staff spacing
voices 207
white 52
width 522

Stein-Zimmermann accidentals 254, 820
stem direction 854

beam groups 856
beam placement 693, 699
centered beams 696
changing 422, 856, 857, 999
chords 855
cross-staff beams 697
drum sets 140
filters 393
grace notes 804, 808
guitar pre-bends 901
middle line 854
multiple-voice contexts 855
notes crossed to other staves 697, 701, 1138
notes on middle line of staff 854
percussion kits 136, 140, 217, 1131, 1132

stem direction (continued)
resetting 694, 858
rhythm slashes 857, 999
single-voice contexts 854, 857
slurs 1019, 1022
staff-relative placement 693
ties 856
voices 422, 854, 857, 1134

stemless
rhythm slashes 191, 209, 1006

stemlets 704
gaps 704
length 704

stems 689, 854
altered unisons 658
articulations 664
audio 86, 87
beam placement 699
beaming 691, 694, 699
combining. See voices
cross-staff 697, 701
deleting tremolos 1102
direction. See stem direction
double 207, 658, 1134. See also voices
durations 177, 197, 235, 236, 238
fermatas 812
flags 854
gaps 699. See also note spacing
grace notes 807, 808
inputting 207, 1134. See also voices
length 694, 808, 858
percussion kits 136, 140, 217, 1131, 1132
removing direction changes 858
reverse 695–697, 701, 854, 856–858
rhythm slashes 999, 1002, 1006
slashes 1099
slurs 1018
split stems 658, 659
stemlets. See stemlets
tablature 1049
ties 856
tremolos 1099, 1102
unbeaming 691
voices 854, 857, 1137

step input. See note input
stereo pan 613, 614

changing 619
StereoEnhancer 616, 620
stickings 1125
stop positions 408

adding 410
deleting 411
moving 410

stopped pitch 859
Fretboard panel 185
harmonics 863

stopping. See starting
stopping finger. See left-hand fingering
straight lines 946

duration 555
glissando lines 889
guitar bends 894
jazz articulations 913

Index
 

1226
Dorico SE 4.3.30



straight lines (continued)
pedal lines 925
quotes 555

straight playback. See swing playback
stress marks. See articulations
stretch

instrument names 161
lyrics 833, 834
note spacing 533
pages 513, 530
staff labels 161
systems 513, 522, 530
text 357

strikethrough text 357
string designation. See string indicators
string indicators 789, 797, 846

deleting 798
duration 396, 940, 941
handles 939
horizontal position 799
inputting 337, 340, 349–351
inside staff 351, 797, 798
length 939, 940
lines 349, 350, 396, 940, 941
moving 417, 421, 799, 939
outside staff 349, 350, 797
panel 340, 350
placement 799
popover 337, 340, 349
position 799
string number 846

string instruments 114, 124
adding 96, 98, 108, 113, 120
brackets 709, 1036
chord symbols 714
fingering shifts 795
groups 144
player order 94, 110
playing techniques. See playing techniques
string number 846
substitution fingering 784
system objects 1045

string pitches
changing 126, 846
fretted instruments 126

string shift indicators 795
angles 795
direction 796, 846
inputting 249, 251, 795
thickness 795

stringendo. See gradual tempo changes. See also 
tempo marks
strings

adding 124
assigning notes to 846
bends. See guitar bends
capos. See capos
changing 846, 1050
changing pitch 124
chord diagrams 728, 736
color 51
deleting 124
fingering 789, 846. See also string indicators

strings (continued)
fretted instruments 96, 124
hammer-ons. See hammer-ons
harmonics 859
indicators. See string indicators
notes out of range 847, 1050
numbers. See string indicators
pitches 124, 846
pull-offs. See hammer-ons
ranges 124
resetting 1050
slurs. See hammer-ons
tapping. See tapping
tuning 96, 124, 846

strokes
figured bass 364
slurs 1020
ties 1076
tremolos 1099–1101

structures
documentation 14
meters 258, 689, 705, 1084, 1085
repeat 376, 463, 975, 979, 985

strumming
arpeggios. See arpeggio signs
fingering 792

styles
appearance 401
breath marks 811
caesuras 811
fermatas 810
glissando lines 889, 890
jazz articulations 913
margins 508
niente hairpins 765
parentheses 725, 777, 850
resetting 401
slurs 1020, 1021
tempo marks 1053, 1062
ties 1076, 1077
time signatures 1091, 1093, 1095

sub-brackets. See secondary brackets
sub-sub-brackets. See secondary brackets
subdivision

bars 705
tempo equations 1064
time signatures 258, 705, 1091, 1092

subito. See dynamic modifiers
subordinate bar numbers 686

adding 686
changing 686

subscript
instrument names 161
staff labels 161
text 357

subsequent repeats
bar numbers 688

substitution fingering 784
handles 785
position 785

subtitles 70, 547, 549, 550. See also flow headings
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suffixes
dynamics 754, 755
instrument changes 118
playing techniques 938
rehearsal marks 966
timecodes 971

sul ponticello. See playing techniques
sul tasto. See playing techniques
superscript

instrument names 161
staff labels 161
text 357
trill intervals 879

SuperVision 616, 620
suppressing playback 463
suspensions

brackets 777
chord symbols 295
figured bass 363, 364, 774, 775, 779

sustain pedal 925
continuation lines 933
inputting 339, 344, 346
level changes 347, 926
merging 930
MIDI controller 245, 936
MusicXML import 936
popover 339, 344
removing retakes/level changes 927
retakes 345, 347, 926
splitting 929
start signs 931
text 934, 935

sustaining instruments 769
SVG files 505

color 506
exporting 495, 496
fonts 506
layout numbers 156
layouts 495, 496

swapping. See switching
swash arpeggio signs 883, 885
swells. See messa di voce
swing playback 465, 466

disabling 468
enabling 270, 467
popover 270
ratios 466
triplets 466

Swiss army triplet. See grace notes. See also tuplets
switches 629, 637

creating 639, 640
properties 560

switching 423
flows 404, 405, 441
galley view 47
instruments. See instrument changes
layouts 28, 40, 44
notes 1124, 1137
page view 47
rehearsal marks 964
selection 387, 403
tabs 44

switching (continued)
view type 47
voices 423

syllables
beaming 691
dynamics 758
lyrics 823, 827, 828
position 827
tempo marks 1063
types 823

symbols
bar repeats 985, 990
bar rests 1012
caret 191
chords. See chord symbols. See also chord 
diagrams
coda 981
ornaments 867
pedal lines 926, 930, 933, 934
playing techniques 937
repeats. See repeat markers. See also repeat 
barlines
segno 981
speech bubbles. See comments
text 355, 358
vibrato bar 904

symphony. See flows
syncing

dynamics 594
instruments 566, 594, 600
Key Editor 566
MIDI 600
tracks 566
videos to music 168

syncopation
beat grouping 705
stemlets 704

system breaks 508, 537
automatic 535
bar repeats 535, 537
barlines 536, 674
clefs 738
copying to other layouts 544, 545
deleting 538
divisi 1047
hiding staves 516
inserting 537
key signatures 818
lines 948
moving 536
playing techniques 939
repeat endings 977
signposts 407, 537, 538
slurs 1019
staff spacing 513
staff visibility 516
ties 1079
time signatures 1087

system dividers 1042
hiding 1043
showing 1043
width 1044
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system formatting 508
casting off. See casting off
condensing. See condensing
copying to other layouts 544
frame breaks. See frame breaks
indents 1030, 1046
note spacing. See note spacing
staff labels 1030
system breaks. See system breaks
system dividers. See system dividers
system objects. See system objects

system objects 1044
copying 390
layouts 1044
lines 353, 946
positions 1045
rehearsal marks 963
repeat counts 983
repeat endings 975, 977
repeat markers 982
selecting 387, 390, 392, 393
size 512, 528, 1041
tempo marks 1052, 1056
text 355
time signatures 1090, 1095

system spacing 513, 529
changing 513
default settings 513, 530
justification 513, 530

system text. See staff-attached text
system track 390

deleting music 668
hiding 392, 402
inputting bars 280
inputting beats 280
selecting music 392, 393
stop positions 410, 411

system-attached text 1044, 1065, 1066
alignment 1070
borders 1071
copying 390
formatting 357, 359, 1070
hiding 1073
inputting 355
markers 84
moving 1070
multiple positions 1045
paragraph styles 1070
selecting 387, 390, 392, 393
showing 1073
signposts 407
staff-relative placement 400
stave positions 1044
tempo tracks 84

systemic barlines
braces 707
brackets 707
secondary brackets 710, 712
sub-brackets 710, 712
sub-sub-brackets 712
text alignment 1070

systems
alignment 513, 522
bar numbers 677, 681, 683, 993
barlines 674
breaks. See system breaks
casting off 535, 536
changing indents 1046
chord symbols 716
coda gap 982
condensed staves. See condensing
dividers. See system dividers
divisi 1047
fixing 535, 536
gaps 513, 979, 1046
height 512, 513
indents 522, 1030, 1031, 1041, 1046
justification 513, 522
length 522
lyrics 828, 835, 837
margins 522, 1030, 1031, 1046
moving 537, 539
numbered bar regions 993
rehearsal marks 963
repeat barlines 674
sections 979
selecting 388, 389
spacing. See system spacing
splitting 979
staff labels 1030, 1038, 1046
text. See system-attached text
timecodes 972, 973
tonality 820
track. See system track
trill marks 870
vertical position. See system spacing
width 522

T
tabla notation 1133
tablature 1048

beaming 1049
bend intervals 900
bends. See guitar bends
bracketed noteheads 849, 850, 894, 899
capos 128–131
caret 191
changing string for notes 1050
chords 200, 217
clefs 738
color 51
colors 52
dead notes 908
default notation 197, 200
dives 899
frets 124, 129–131
green notes 1048, 1050
guitar bends 894, 1049
harmonics 860, 863
hiding 1049
hold lines 894, 901
intervals 900
moving notes to other strings 1050
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tablature (continued)
note input 200, 217
notes out of range 424, 847, 1048, 1050
numbers 1048, 1050
open pitches 126
parenthesized fret numbers 894, 899
post-bends. See guitar post-bends
pre-bends. See guitar pre-bends
question marks 424, 1048
resetting strings 1050
rhythms 1049
showing 1049
stems 1049
strings 124, 126, 197, 200, 1050
ties 1074
trills 870
tuning 124, 127, 129–131

tables
actions 631
comments 437
conditions 632
contents. See front matter
endpoint setup 479
fonts 69
markers 370
percussion maps 643
switches 629

tabs
bar 31
closing 44
groups 45
hiding 29
layouts 40, 42, 44
moving 45
opening 42
order 45
showing 29
showing multiple 45
switching 44
view options 42

tacets 19, 541
exporting 75
formatting 541
hiding 542, 1015
margins 543
moving 543
paragraph style 541
removing players from flows 149
showing 542, 1015
text 542

tags. See signposts. See also comments
tails. See stems
tambourine. See unpitched percussion
tanto. See tempo marks
tap tempo 271
tapping 789, 905

deleting 910
inputting 336
moving 909
percussion. See grace notes. See also tuplets
popover 313
staff-relative placement 909

tasto solo 363, 364, 771

techniques 937
combinations 636, 640
endpoint configurations 482
exclusion groups 634
expression maps 626
guitar 904
percussion 643, 648, 1116, 1118
playback 636, 640, 649, 650

templates
brackets 73
categories 66
deleting 610
ensembles 98, 101, 112, 114
flow headings 550
Key Editor 572, 609, 610
new projects 64
pages. See page templates
playback 445, 471
players 98, 101, 112, 114
projects. See project templates
staff grouping 709
staves 73, 98, 114, 709
titles 550

tempo 1052
bpm 1058
changing 603
click settings 450
default 412, 1052
deleting changes 574
drawing 601
equations. See tempo equations
finding 371, 970
fixed tempo 458, 468
follow tempo 458, 468
inputting 602
marks. See tempo marks
metronome marks 1058
MIDI recording 458
muting in playback 463
Play mode 450, 601
range 1060
recording 458
tracks. See tempo tracks

tempo changes. See tempo marks
Tempo editor 450, 601

adding 568, 572
changing tempo 603
closing 568, 572
copying points 573
deleting points 574
height 570
inputting tempo changes 602
moving tempo changes 603
selecting points 572
zoom 570

tempo equations 1064
inputting 270, 271, 273, 274
panel 271
popover 270

tempo marks 601, 1052, 1062
abbreviated 1057
absolute tempo changes 271, 1053
alignment 1056

Index
 

1230
Dorico SE 4.3.30



tempo marks (continued)
appearance 1055
beat units 269, 398, 1059
brackets 1054, 1055
changing 398, 1055–1057, 1059, 1060
colors 52
components 1054, 1055, 1061
continuation lines 1052, 1062, 1063
copying 414, 573
decimal places 273, 274, 1059
deleting 412
equations. See tempo equations
filters 393
finding 371, 970
formatting 1063
gradual tempo changes 271, 1053, 1061, 1062
handles 396, 1056
hiding 1058
hyphens 1063
inputting 268, 271, 273, 274
integers 273, 274
length 396, 1056
lines 1062, 1063
metronome marks. See metronome marks
moving 417, 603, 1061
multiple positions 1044, 1045, 1056
muting in playback 463
order 1061
panel 271
parentheses 1054, 1055
placement 1056
playback 412, 463, 1052, 1060, 1061
poco a poco 1055
popover 268
position 1056
rehearsal marks 963
relative tempo changes 271, 1053, 1060
repeats 463
reset tempo 271, 1053
selecting 387, 388, 390, 392, 393
showing 1058
signposts 407, 1055, 1058
style 1063
text 398, 1053, 1056, 1057
types 268, 271, 1053
vertical positions 1044

Tempo panel 271
tempo track 450, 601

editing. See Tempo editor
editor. See Tempo editor
hiding 454, 572, 601
showing 454, 572, 601

tempo tracks 83–85, 601
dialog 84, 85
exporting 85
importing 83, 84
Play mode. See tempo track. See also Tempo editor

tenor clef. See clefs
tenuto. See articulations
terminal lines 948
terminology

British vs. American English 13
note durations 13

text 1065, 1066
abbreviated tempo text 1057
accidentals 355, 358
alignment 357, 1070
annotations 948
appearance 357
bar numbers. See bar numbers
baseline shift 357
borders 1071, 1072
codes. See tokens
color 52
colors 357
comments 432, 437
default settings 355
dynamics 754, 755, 758
editing 359, 1056, 1066
editor. See text editor
expressive 746, 754
filter 393
flow titles 165
formatting 64, 357, 1070
glissando lines 891
glyphs 355, 358, 554
hiding 983, 1073
horizontal 961
horizontal alignment 1070
inputting 355, 958
lines 948, 958–961
lyrics 823, 831–833
markers 84, 369, 370, 967, 969
missing fonts 69
moving 417, 1070
multiple positions 1044, 1045
music fonts 624
music symbols 355, 358, 554
overline 357
paragraph styles 1070
pedal lines 934–936
percussion legends 1131
playing techniques 937, 938
rehearsal marks 963
repeat markers 981
resetting 1070
restorative 934, 936
showing 983, 1073
signposts 407, 1073
spacing 357
staff labels. See staff labels. See also player group 
labels
staff-relative placement 400
stretch 357
strikethrough 357
subscript 357
superscript 357
system-attached text 355, 1044
tacet. See tacets. See also multi-bar rests
tacets 542
tempo marks 398, 1052, 1054, 1056–1058, 1062
timecodes 969
tokens. See tokens
types 1066
underline 357
vertical. See player group labels
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text editor 357, 359
comments 433
lyrics 832, 833
Write mode 357

text frames 1066
flow headings 521
identifying 1066
running headers 521
tokens 552

text items 1065, 1066
colors 52, 357
editing 359
hiding 1073
identifying 1066
inputting 355
moving 417
showing 1073
signposts 1073

text tokens. See tokens
theme 49
theorbo. See fretted instruments
thick barlines 674
thickness

brackets 710, 725
chord symbols 725
grace note slashes 807
parentheses 725
string shift indicators 795
ties 1077

three quarters depressed pedal lines 926
thru

MIDI 240
thumbs 789

chord diagrams 732, 733, 736
fingerings 789
inputting 252
popover 251, 252

tick
barlines 674
breath marks. See breath marks
played duration 584, 585

tie chains 1074
accents 664
articulations 664, 1074
bracketed noteheads 851
deleting 1082
glissando lines 892
numbering bars. See numbered bar regions
selecting 1074
slurs 1017
splitting 238, 1083
staccato 664
stem direction 856
tablature 1074
tenuto 664
tremolos 1101

ties 21, 705, 1074–1076, 1079
accents 664
accidentals 1080
appearance 1076
articulations 664, 665, 1074
bracketed noteheads 851
breaking 1083

ties (continued)
cautionary accidentals 656, 862
chains. See tie chains
chords 1078
clef changes 1080
collision avoidance 1074
cross-staff 223, 1081
cross-voice 223, 1081
curvature direction 1078, 1079
dashed 1076, 1077
deleting 705, 1082, 1083
dotted 1076, 1077
dynamics 287, 290, 417, 747, 762
editorial 1076
forcing 238
formatting 1077
frame breaks 1079
grace notes 223, 1080
guitar bends 901
hairpins 287, 290, 417, 747
half-bar 705
half-dashed 1076
inputting 173, 223
inverting 1079
laissez vibrer 1081
messa di voce 762
non-adjacent notes 223, 1080
non-standard types 1079
note grouping 238
numbering bars. See numbered bar regions
parentheses 851
pedal lines 345
placement 1078
playing techniques 341, 343
position 1017
slurs 1017, 1019
slurs vs. ties 1075
solid 1076
splitting 238, 705, 1083
staccato 664
stems 856
style 1076, 1077
system breaks 1079
tablature 1074
tenuto 664
tie chains. See tie chains
time signatures 1074, 1080
tremolos 1101
voices 223, 1078

TIFF files 505
color 506
exporting 495, 496
layout numbers 156
layouts 495, 496
resolution 505

time
deleting 408, 409, 667–669
display 468, 471
inserting 212, 278–280, 408, 409
latency 240, 244
markers 967
rhythmic position 22
signatures. See time signatures
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time (continued)
tokens 556. See also date and time
track. See tempo track. See also Tempo editor
transport window 468, 471
videos 168

time and date. See date and time
time bars. See repeat endings
time signatures 1084, 1085

above staff 1090
additive 1085
aggregate 1085
alternating 1085
appearance 1097
bar numbers 684
barlines 672, 676, 1095
beam grouping 22, 689, 705
beat groups 22, 1092
bracketed groups 1089
brackets 258, 1091, 1094
cautionary 1087
changing 212, 398, 408–410, 670
click 241
common 258, 260, 1095
compound 1085
custom 1085
cut common 258, 260, 1095
deleting 412
denominators 1084, 1091, 1093
design 1097
filter 393
font styles 1097
hiding 409, 1096, 1097
inputting 258, 262, 263
Insert mode 212, 408–410
interchangeable 1085, 1097
irregular 1085
large 1089
MIDI recording 241
moving 417, 421, 1095
multiple positions 1044, 1045
non-power of two 1085
note grouping 22, 689, 705
noteheads 1093
numerators 1084, 1091, 1092
open 1085, 1091, 1093
panel 260
parentheses 258, 262, 1091, 1094
pick-up bars 260, 264, 266, 1085, 1088
polymeter 262–264, 266, 1084
popover 258
position 262, 263, 1091, 1095
rest grouping 689, 705
selecting 387, 390, 392, 393
separators 1091, 1094
showing 1096, 1097
signposts 407, 670, 1091, 1093, 1096
simple 1085
size 1091, 1097
spacing gaps 1095
staves 1089, 1091
styles 1091, 1094
system objects 1090
ties 1074, 1080

time signatures (continued)
types 258, 1085
upbeats. See pick-up bars
vertical position 1044, 1045, 1089, 1091

Time Signatures (Meter) panel 260
timecodes 971

changing 167, 969, 972
dialog 167
drop frame 971
exporting 87
flows 104
frequency 973
inputting 369
markers 369–371
non-drop frame 971
offset 972
panel 370
staff 968, 972
staff spacing 513, 530
start values 972
tempo 371
text 969
transport window 468, 471
vertical position 972

times played 983
changing 464

timpani 114
key signatures 96
laissez vibrer ties 1081
rolls. See tremolos. See also trills

title pages 547, 801
tokens 552

titles 70, 164
accidentals 554
adding 64, 70, 1066
changing 70, 165, 1066
first pages 549, 801
flow headings 521, 550
flows 164, 165, 550
hiding 64, 521
movements 550
page templates 549
projects 164
running headers 521, 549
showing 64, 521
templates 550
tokens 552

tokens 552, 1066
accidentals 554
clefs 554
date 556
file names 498, 553
first pages 549
flows 164, 550, 555
inputting 552
music symbols 554
page numbers 556
page templates 549, 801
project information 70, 164, 555
Roman numerals 555
running headers 549
SMuFL 554
staff labels 554
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tokens (continued)
time 556
titles 164

tom-tom. See unpitched percussion
tonality systems 820

octave divisions 820
panel 257

ToneBooster 616, 620
tones

intervals. See whole steps. See also pitch
microtones. See microtones. See also quarter tones

tongue clicks. See playing techniques
toolbar 28

hiding 28
Key Editor 566
transport options 28, 30
workspace options 28, 29

toolboxes 36
Key Editor 566
Notations 172, 178
Notes 172, 173

tools 36
arranging. See arranging
editing. See properties. See also default settings
selecting 36, 37
timecodes 971

touched pitch 859
harmonics 863

Track Inspector 439, 442, 560
track overview 440

automation. See MIDI CC editor
chords track 452
dynamics. See Dynamics editor
markers track 451
MIDI CC. See MIDI CC editor
MIDI pitch bend. See MIDI Pitch Bend editor. See 
also MIDI CC editor
pitch bends. See MIDI Pitch Bend editor. See also 
MIDI CC editor
Tempo editor 601
tempo track 450. See also Tempo editor

tracks 448, 564, 612
adding 572
automation. See MIDI CC editor
chords. See chords track
colors 449, 575, 576
dynamics. See Dynamics editor
height 454, 570
hiding 454, 568, 572
independent voice playback 460, 461, 484
inputting notes 577
inserts 612, 613, 616, 620, 621
instruments. See instrument tracks
Key Editor 564
locking 568
markers 451
MIDI. See MIDI CC editor
muting 461
percussion. See percussion editor
piano roll. See piano roll editor
playing techniques. See Playing Techniques editor
showing 454, 568, 572
soloing 461

tracks (continued)
system. See system track
tempo. See tempo tracks
time. See tempo track. See also Tempo editor
types 448
unlocking 568
velocity. See Velocity editor
voices 449, 460, 461
volume 618
width 455, 570
zoom 454, 455, 570

traditional
music fonts 624
rastral size 527
tonality systems 820

transcribing
MIDI recording 240, 241, 244
voices 240, 241

Transform tool 604, 608
hiding 609
showing 609

transformations
Key Editor 604, 605, 608
MIDI CC 605
popover 233
selections 609
velocity 604, 605, 608

transition lines 940, 946
duration 941
inputting 337, 341, 343
MIDI 598
playing techniques 943
showing 944
tempo 601, 602

translation lyrics 821
changing lines to 836
changing lyrics to 822
popover 361

transport 468
basic options 28, 30
hiding 468
playhead 456
playhead position 468, 471
repeats 463
showing 468
window 468

Transpose dialog 424, 425
transposed pitch 155, 423

chord symbols 128, 155, 720, 721
clefs 301, 739, 740
exporting 495
input pitch 203
instrument transpositions 1033
layouts 155, 553, 801
note input 203
part layouts 151, 155, 491, 495
printing 491
score layouts 491, 495
showing 155
staff labels 1029, 1033
status display 36
tokens 553, 801
viewing 155
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transposing 423, 425
accidentals 425, 819
chord symbols 128, 131–133, 135, 136, 155, 424, 
425, 713, 719
clefs 96, 741
dialog 425
expression maps 625, 627, 629, 633
figured bass 424, 427
flows 424, 425
fretted instruments 124, 126–128
instruments. See transposing instruments
key signatures 424, 425, 815, 819
layouts 151, 155, 160, 553, 801
notes 235, 424, 425, 427, 581, 582
octaves 424
pitch. See transposed pitch
popover 235
selections 424
staff labels 1033
strings 128
tokens 553, 801

transposing instruments 119, 155, 1029
chord symbols 128, 720, 721
clefs 96, 739
concert pitch 155
fretted instruments 119, 131, 132
instrument transpositions 1033, 1034
key signatures 155, 815, 817, 819
layout names 160
layouts 155
staff labels 1029, 1033, 1034
transposed pitch 155

tre corde. See una corda pedal. See also pedal lines
treble clef. See clefs
trees. See split stems
tremblements. See ornaments
tremolo arm. See vibrato bar
Tremolo plug-in 616, 620
tremolo strokes 1005, 1099, 1101

changing number 1101
tremolos 1099

angles 1100
articulations 648
attack 374, 381, 383, 1101
cross-staff 697, 701
deleting 1102
inputting 374–376, 381, 383
measured 1099
MIDI recording 244
multi-note 375, 1099
panel 376, 383
percussion 1115, 1116
placement 1100
playback 460, 461, 648–650
popover 374, 375, 381
position 1100, 1102
release 374, 381, 383, 1101
single-note 374, 1099
speed 1101
strokes. See tremolo strokes
tie chains 1101
tuplets 1099

tremolos (continued)
types 374, 375, 1099
unmeasured 1099

triads. See chords. See also chord symbols
triangles

beams 694
noteheads 843, 845, 1116, 1119, 1120
percussion. See unpitched percussion
playback 643

trill intervals 873, 874, 879
accidentals 875, 878
appearance 878
auxiliary notes 878
changing 875, 876
deleting 877
hiding 874
Hollywood-style 878
indicators 873
inputting 316
microtonal 874–876
position 879
resetting 877
showing 874
signposts 407, 874

trill lines 871, 872
hiding 872
length 396
showing 872
speed 871, 872

trills 867, 870, 878, 880, 1099
accidentals 875, 878, 879
alignment 869, 872
appearance 878
auxiliary notes 878
colors 52
deleting 412
deleting intervals 877
extension lines. See trill lines
filter 393
generated 881
grace notes 880
handles 396
hiding marks 870
Hollywood-style 878
inputting 312, 316, 317
intervals 312, 873–876, 878, 879
length 396
lines. See trill lines
MIDI recording 244
moving 417, 421, 868
panel 315, 317
pitch 875, 876, 881
placement 868
playback 649, 650, 880, 881
popover 312
position 868, 869
resetting 877
sampled 881
signposts 407, 873–876
speed 871, 880, 881
staff-relative placement 400
start position 869
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trills (continued)
starting pitch 881
tablature 870

trimming flows 276, 669
triple accidentals

respelling 428, 429, 431
transposing 425

triple barlines 674
triple-dotted notes 205
triplets 1104

inputting 173, 229, 230
swing playback 465, 466

trombone. See instruments
troppo. See tempo marks
true black 506
trumpet. See instruments
tuba. See instruments
Tube Compressor 616, 620
tucking index

changing 950
chord symbols 133, 134, 136
lines 950

tuning
capos. See capos
changing 96, 124, 126
chord diagrams 731, 734, 735
custom 124, 126, 127, 728, 731
dialog 124
exporting 127
fretted instruments 96, 124, 128
guitar 96, 124, 128
importing 127
open pitches 126
strings 126
systems. See tonality systems

tuplet brackets 1109
angle 1109
end position 1111
handles 1109
hiding 1109
hooks 1109
horizontal 1111
length 1109
showing 1109

tuplet numbers 1104, 1112
appearance 1112
hiding 1112
horizontal position 1113

tuplet ratios. See tuplet numbers
tuplets 803, 1099, 1104

accidentals 219
appearance 1109, 1112
articulations 246, 663
barlines 1107
beams 703, 705, 1108
beat units 232
brackets. See tuplet brackets
colors 52
deleting 1106
end position 1111
filter 393
formatting 1112
handles 1109

tuplets (continued)
hiding 1109, 1112
hooks 1109
horizontal brackets 1111
inputting 81, 229, 1105, 1106
inverting 1110
Key Editor 575
moving 417, 421, 1113
nested tuplets 1104, 1105
notes 1106
numbers. See tuplet numbers
percussion kits 1125
piano roll editor 575
popover 229, 230
quantization 81
ratios. See tuplet numbers
showing 1112
signposts 407, 1109, 1112
slurs 248
staff-relative placement 1110
swing playback 465, 466
transformations 1106
tremolos 1099
types 230, 1104
unscaling 1106

Turkish music
octave divisions 820

turn off. See hiding. See also deactivating
turns 867

intervals 867
jazz. See jazz ornaments
pages. See frame breaks

tutorials 64
tutti 1047
two-up page arrangement 500
types

appearance 401
arpeggio signs 313
articulations 912
bar repeats 375
barlines 672
breath marks 307, 811
caesuras 307, 811
caret 191
chord symbols 293, 714
clefs 300
dynamics 284, 746
enclosures 678
fermatas 306, 810
fingerings 251, 794
glissando lines 313
grace notes 807
holds 306, 809
jazz articulations 312, 911–913
key signatures 253
lines 946, 948
lyrics 361, 821, 822
notehead sets 840
noteheads 841, 844
notes 177
octave lines 301, 742
ornaments 311, 912
page templates 549
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types (continued)
pauses 306, 809
pedal lines 339, 925
percussion legends 1129
players 107, 111
playing techniques 337, 937
rehearsal marks 965
repeat endings 373
repeat markers 374
resetting 401
rhythm slashes 1006
syllables 823
templates 73
tempo marks 268, 271, 1053
text 1066
ties 1076
time signatures 258, 1085, 1091, 1094
tracks 448
tremolos 374, 375, 1099
tuplets 230, 1104

U
ukulele. See fretted instruments
una corda pedal 925, 934

appearance 936
hiding 936
MIDI controller 936
start signs 931
text 934–936

unassigned instruments
loading sounds 476

uncompressed MusicXML 79
undamped. See playing techniques. See also laissez 
vibrer ties
underlines

instrument names 161
lyrics 833
staff labels 161
text 357

undo 28
ungrouping

dynamics 766
playing techniques 944

unisons 1047
altered. See altered unisons
stems 207
voices 207, 1137

units
beats 167, 271, 371, 398, 1058, 1059
measurement 48
metronome marks 398, 1059
quantization 81
rhythmic grid 190
swing playback 466
system track 390
tempo 271, 371
time 167, 468
tuplets 230
video 167

Universal Indian Drum Notation 1133

unlinking 767
dynamics 769
Key Editor 568
slurs 1028
tracks 568

unmeasured tremolos. See tremolos
unpitched percussion 1115

articulations 648, 1116, 1124
drags. See grace notes
drum sets. See drum sets
dynamics in kits 1125
exporting kits 1123
flams. See grace notes
ghost notes. See bracketed noteheads
grid kit presentation 140–143, 1037
groups 140, 1037
importing kits 1123
Indian drum notation 1133
individual instruments 1121
instrument order 142
Key Editor. See percussion editor
kits. See percussion kits
laissez vibrer ties 1081
legends 1128, 1130, 1131
moving notes 1124
MusicXML files 78
naming groups 141
notations 1124
note input 213, 215, 217, 577, 578
noteheads 1116, 1120
parentheses. See bracketed noteheads
percussion maps 485, 643
Play mode. See percussion editor
playback 485, 643, 648, 1115
playing techniques 582, 648, 1115, 1116, 1118, 
1119, 1125
presentation types 136, 1121, 1126, 1127
rhythm slashes 136, 1007
rudiments 197, 235, 803, 1099, 1104
scrapes. See playing techniques
staff labels 140, 141, 1037
staff position 582, 1116, 1119, 1120
staves 136, 1126, 1127
stem direction 136, 217, 1131, 1132
stickings 1125
techniques. See playing techniques
tremolos 648, 1116
tuplets 1125
voices in kits 1131, 1132

unscaling
grace notes 806
tuplets 1106

up arpeggio signs. See arpeggio signs
up bow. See playing techniques
up-bow breath marks. See breath marks
up-stem voices. See voices
upbeats. See pick-up bars
upper case

flow numbers 555
Roman numerals 555

upper limits. See limits

Index
 

1237
Dorico SE 4.3.30



upper notes
percussion 213, 1116, 1119
trills 881

used chord diagrams 731
capos 135, 136
fingerings 732

user interface 27
colors 49, 50, 52
language 48, 59
transport options 30
windows 27

user name
comments 432, 437

V
value fields 562
value line

dynamics 590
MIDI 596, 598
tempo 450, 601

values
faders 614, 618
frame rates 167
gradual tempo changes 1061
histogram controls 606
latency compensation 244
metronome marks 398, 1059–1061
MIDI CC 599, 604–606, 608, 609
notes. See note durations
properties 562
relative tempo changes 1060
rhythmic grid 36, 190, 577
timecodes 167, 972
velocity 587–589, 604–606, 608

valves
fingerings 794

velocity
bracketed noteheads 850
changing 588, 589, 604–606, 608
controls 588, 604–606, 608
editor. See Velocity editor
expression maps 633
Histogram tool 604, 605
MIDI recording 244
resetting 589
selecting 609
Transform tool 608

Velocity editor 587, 588, 590
adding 572, 587
changing velocity 588, 604–606, 608
closing 572, 587
filter 606
height 570
Histogram controls 605
resetting velocity 589
Transform controls 608
zoom 570

velocity lanes. See Velocity editor
verse numbers 837

exporting 826
hiding 837

verse numbers (continued)
lyric line numbers 835
showing 837

versions
files 68

vertical alignment
dynamics 765–769
lines 943
playing techniques 943

vertical justification
staves 513, 530
systems 513, 530

vertical lines. See lines. See also arpeggio signs
vertical position

articulations 663–665
bar numbers 681–683, 996
breath marks 812
caesuras 812
changing 400
chord symbols 714, 716, 717, 722, 730
counts 996, 1005
dynamics 747, 756
fermatas 812
figured bass 772, 778
fingerings 783, 790–792
flipping items 400
flow headings 521, 524, 525, 550
harp pedal diagrams 922
instruments 110, 111
layouts 156
lines 949, 951, 952, 954
lyrics 821, 827, 830, 835–837
markers 968
modifiers 756
ornaments 868
pauses 811
pedal lines 927
players 110, 111
playing techniques 400, 939
poco a poco 756
rehearsal marks 963, 1044, 1045
repeat endings 977, 1044, 1045
repeat markers 982, 1045
rests 1008
rhythm slashes 1000
slurs 1019, 1022
staves 110, 111, 513, 530
system objects 1045
systems 513, 530
tacets 543
tempo marks 1044, 1045, 1056
text 400, 1044, 1045
ties 1078
time signatures 1044, 1089, 1091, 1095
timecodes 968, 972
tremolos 1100
trills 868

vertical spacing
bracketed noteheads 850, 853
chord diagrams 731
ossia staves 1042
percussion kits 143
staves. See staff spacing
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vertical spacing (continued)
systems. See system spacing
tacets 543

vibrato. See playing techniques
vibrato bar 894, 899, 904

chords 899
deleting 412, 910
dips 332, 904, 908
dives 899, 904
duration 396, 941
inputting 325, 326, 328, 329, 333, 334
intervals 900, 908
length 396
lines 333, 334, 396, 904, 941
playback 899
pre-dives. See guitar pre-bends
returns 899, 904
scoops 904

Vibrato plug-in 616, 620
Video Properties dialog 167
videos 64, 166

adding 168
audio 170, 612–614, 617
channel 612–614, 617
dialog 167
flows 104
formats 166
frame rates 171
hiding 169
locating 168
markers 451, 967
mixer 612–614, 617
panel 370
reloading 168
removing 170
size 169
start position 168
syncing 168
timecodes 971, 972
tutorials 64
volume 170
window 169

view options 38, 507
background color 50
bar numbers 680
bar repeats 987
changing 36, 607
chord diagrams 728, 730, 731
chord symbols 133, 134, 136, 714, 716, 717, 719, 
730
colors 49–52
comments 432, 438
exporting 507
figured bass 780
flows 441
frame break signposts 540
full screen mode 46
galley view 38, 47
harp pedaling 847
hiding 402
histogram editor 607
Hub 64
Key Editor 564, 568, 570–572, 607

view options (continued)
language 48, 59
layouts 31, 40, 44
mixer 612, 614, 617
moving music 404, 405
music area 32, 39, 47
notes 463, 1135
notes out of range 51, 847
numbered bar regions 987
page arrangements 36, 39, 47
page color 50
page view 38, 47
panels 35, 41
percussion legends 1128
piano roll 564, 568, 570–572, 575
playhead 457, 471
print preview 402, 486
printing 507
recent projects 64
rests 1011
signposts 407
slash regions 998
system break signposts 538
system track 392
tabs 31, 40, 42, 44
time signature signposts 1096
timecode 471
tracks 454, 455, 570
transport 471
types 38
video window 169
voices 1134, 1135
windows 46
zoom 39, 406, 454, 455, 570

VintageCompressor 616, 620
violin. See instruments
vivace. See tempo marks
vocal scores. See layouts
vocal staves 73, 96, 98

barlines 675, 676
brackets 709, 1036
groups 144
staff grouping 709, 1036
syllabic beaming 691

voice colors
changing 51
exporting 507
hiding 402, 1135
printing 507
showing 1135

voice column index 1136, 1137
order 1137
rhythm dots 1137

voices 207, 658, 1134
accidental stacking order 657
adding 207
alignment 1136, 1137
articulations 662
bar rests 222
beaming 856
caret 191, 207
changing 422, 423, 1006
chord symbol playback 291, 453, 454
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voices (continued)
chords 226
colors 51, 449, 575, 576, 1134, 1135
column index 1137
copying 582
creating new 207
cues 745
deleting 1138
direction 999
divisi. See divisi. See also condensing
drum sets 140, 1122, 1131, 1132
dynamics 287, 290, 590, 754
endpoints 484
fermatas 811, 813
filters 393, 566, 606
flows 484
glissando lines 319, 320
grace notes 804
hiding 1000
Histogram tool 604, 606
identifying 36, 1135
inputting 207, 226, 577
Insert mode 212, 408
Key Editor 460, 568, 577
MIDI CC editor 596
MIDI recording 240, 241, 243, 244
mixer 612, 613, 618
moving notes 421
muting 461
octave lines 304, 305
order 1137
overlapping 1137
panning 619, 754
parts. See layouts
pasting notes into 582
percussion kits 136, 140, 1122, 1131, 1132
piano roll editor 568, 575, 577
placement 1136
playback 460, 461, 484
playing techniques 341, 343, 586
position 1136
rests 1008, 1010, 1012
rhythm dots 1137
rhythm slashes 209, 999
selecting 387–389, 393, 422, 568, 572, 577
showing 1000
slash regions 1000
slashes 209, 422, 999, 1005, 1006
slurs 1018, 1022, 1024
soloing 461
spacing. See note spacing
status bar 36
stem direction 854, 857, 1131, 1132, 1134, 1138
stems 1137
swapping contents 423
swapping order 1137
switching between 207
ties 223, 1078, 1081
tracks 442, 449, 460
velocity 587–589, 604, 606
volume 618

voicing
chord diagrams 727, 731, 734, 735
chord symbols 291, 453, 454
notes 207, 226
percussion kits 136, 140

volta lines. See repeat endings
volume

bracketed noteheads 850
channel meters 612, 613, 618
click 618
dynamics 592, 746, 751, 763, 769
MIDI 769
mixer 612, 613, 618
playback 618, 633
resetting 618
silence playback template 471, 472
swells. See messa di voce
tracks 612, 613, 618
velocity 587–589, 604, 608, 633
video audio 170

VST Amp Rack 616, 620
VST and MIDI panel 439, 445
VST Bass Amp 616, 620
VST instruments 442, 445

allowing 459
blocking 459
chord symbols 453
click 450
editing 445
endpoints 479, 481, 482
expression maps 626
instances 445
loading 447, 459
names 479
numbering 445
panel 445
percussion maps 485
playback 471, 472, 479, 625, 643
ports 442, 479

VSTDynamics 616, 620

W
w/ bar. See vibrato bar
WahWah 616, 620
walker noteheads 844, 845
warnings

audio engine 36
deleting players 94, 112
different Dorico versions 68
exporting 495
MIDI input 36
missing fonts 69
printing 491
transposition 491, 495

watermarks 507
exporting 495
printing 491

WAV files
exporting 86, 87

wavy lines. See wiggly lines. See also lines
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wedge lines 353, 946
hiding 942
inputting 353
showing 941, 942, 956

wedge noteheads 843, 845
weight

time signatures 1097
Western tonality

key signatures 816
octave divisions 820

whammy bar. See vibrato bar
whistle tones. See playing techniques. See also 
diamond noteheads
white

noteheads 840, 841, 845
pages 50, 52
staves 52

whole notes 13, 177, 197, 200, 210, 212, 235, 236
beats 276
chords 226
metronome marks 269
percussion 213, 578
rests 221, 1008
splitting notes 238
tablature 217
tremolos 381, 383, 1099
tuplets 229, 232
voices 207

whole step trills 873, 880
appearance 878
hiding 870, 874
inputting 312, 317
position 879
showing 870, 874

whole steps 655
bend intervals 900, 908
pitch bends 595
string pitches 124
tonality systems 820
transposing instruments 119, 819
trills. See whole step trills

whole tone
chord symbols 296

whole-half diminished. See scales. See also intervals
width

accidentals 658
barlines 672
bars 522, 533, 1012, 1046
braces 710
brackets 710, 712
columns 69
elision slurs 827, 838
empty bars 1012
H-bars 1014
hairpins 750, 761
Key Editor 570
keys 183
laissez vibrer ties 1081
lines 522
measures 522
messa di voce 761
note durations 533, 584. See also note spacing
noteheads 843

width (continued)
notes 570
percussion editor 570
piano roll editor 570
system dividers 1044
systems 522, 1046
time signatures 1097
tracks 455, 570

wiggly lines 889, 911, 946
glissando lines 889, 890
hiding 942
inputting 318–322, 353
jazz articulations 312, 315, 321, 322, 911, 913
showing 941, 942, 956
trills 871, 872

wildcards. See tokens
wind band. See bands. See also project templates
wind instruments. See woodwind instruments
windows

full screen 46
MIDI instruments 442
mixer 613, 614
moving tabs 45
multiple 42, 45, 46
opening 46
playback 46
project 27
splitting 45
tabs 45
transport 468
video 169
VST instruments 442, 445
workspaces 40

wizard. See hub
wood blocks 1115, 1121, 1122

adding 108, 120
click 450

woodwind instruments 114
adding 96, 98, 108, 113, 120
brackets 709, 1036
chord symbols 714
groups 144
player order 94, 110
playing techniques 340
transposition 96, 119

word spacing 357
instrument names 161
lyrics 833, 834
staff labels 161

words. See lyrics. See also text
workflow

comments 432
worksheets

colors 52, 844
extracts. See flows
note name noteheads 844
text alignment 1070

workspaces 18
key commands 25, 58
options 28, 29
preferences 53
setting up 40
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Write mode 18, 172
caret 195
inputting notations 246
inputting notes 196
inputting vs. editing 187
navigation. See navigation
panels 35, 172, 177, 181, 560
playhead 457
popovers 21
selecting 387–389, 392, 393
selecting notes 403
signposts 407
spacing 532
switching 172
system track 390
text editor 357
toolboxes 36, 172, 173, 178
Transpose dialog 425

written tempo 273, 274, 458, 1052, 1058

X
X-noteheads 842, 845

dead notes 908
percussion 213, 578, 1116, 1118–1120

xylophone. See instruments

Z
zero

bar numbers 1088
chord diagrams 727, 736
string indicators 351, 797

zig-zag
accidentals 657
lines. See lines

zones 27, 35
hiding 41
lower 560
Play mode 439, 564, 612
Print mode 486–488
Setup mode 93, 94, 101, 104
showing 41
Write mode 172, 177, 181–183, 185, 186, 560, 564, 
612

zoom 36
bar repeats 987
changing 406
chord symbols 719
Key Editor 564, 570
lyrics 832
numbered bar regions 987
options 36, 39, 406
percussion editor 570, 571
piano roll editor 570, 571
slash regions 997, 998
tracks 454, 455, 570
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